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1 Welcome to FCS Express

FCS Express is an analysis tool for flow and image cytometry data. FCS Express
gives customers the ability to graphically display data generated by any flow
cytometer that adheres to the FCS standard.  For image data, FCS Express
supports a large and growing number of formats .These graphical displays
consist of many types of plots, including one-dimensional histograms, and two-
dimensional scatter, contour and density plots, and image galleries, among
others. 
 
When loading the data, FCS Express reads numerical values for each parameter
as well as descriptive information about the parameters, and can display either
type of information at any time. In order to display the numerical values, the
values can be binned to display in plots with smaller resolutions, or displayed as
is. Sub-populations (known as gates) can be defined using graphical means, and
used to create further displays. 
 
In addition to the graphical display, FCS Express calculates descriptive statistics
based on the original data, as well as any combinations of statistics and
operations that the customer creates. 
 
These statistics can be displayed alongside the graphs in tables or embedded in
text annotations. 
 
As well as being displayed on the screen, the graphs and statistics can be
exported to many types of formats, including text files, Excel, Word, and many
image formats, and even custom formats for better integration with customers'
existing information storage systems. 

This manual applies to FCS Express 7.18.0015.

1.1 About the Manual

The following conventions are used throughout this manual:

In the text, boldface print is used to designate an actual "object" within the
program, either text that you will see on your screen, a user interface
element such as the File tab (note the File tab replaces the Applications
Button from Version 4) or Layout Navigation Toolbar, or an element of
FCS Express (e.g., Display Text token property). If the text is a hyperlink, it
will appear underlined and in blue. Hyperlinked text will not be boldface.

2577
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In the Windows operating system, the designation "left mouse button" refers
to the primary mouse button (even if you are left-handed and have switched
the buttons so that the primary mouse button is the one under your index
finger). By convention, to "right-click" always means to press the secondary
mouse button. Throughout the manual, "press the mouse button" refers to
your primary button unless the text specifically states to "right-click."

FCS Express uses the Ribbon interface where most menus and toolbars are
replaced with the File tab as well as Tabs, Groups, and Commands. The
drop-down list of commands which appear when selecting the File tab or
commands with a down-arrow icon are referred to as "galleries" when using
the Ribbon interface.

To indicate selecting a particular command, the following convention is often
used in this manual "Tab ". For example,
Home  means to select the New Page command from
the Pages Group on the Home Tab.

1.2 System Requirements

The minimum system requirements for FCS Express are as follows:

· PC

o Windows 10/Windows 11

o Intel Core-equivalent or higher

o 1 GB RAM 

o 400 MB Hard drive space 

o Recommended system: 4 GB RAM

· Mac

o  If using FCS Express 7, macOS 10.13 (High Sierra) through macOS 11.x (Big

Sur) is supported.

o  macOS 12.x (Monterey) is supported with FCS Express version 7.12.0005

and later.  

o  If using macOS Monterey 12.3 and more recent Monterey releases, FCS

Express 7 v7.12.0009 or higher is compatible.

o  macOS 13.1 & 13.2 (Ventura) are supported

§  Note, to run FCS Express 7 on macOS 13, please ensure "Stage Manager"
is turned off. Check back for updates on Stage Manager compatibility.

o  ARM-based Macs (M1 & M2 Apple Silicon) are supported with FCS Express

7.10.0007 and later when used with macOS 11.6 or higher.

o  2 GB ram 

o  Intel Core Duo

o  2 GB Hard drive space

o  Recommended system: 8 GB RAM
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Notes:

· FCS Express takes advantage of many features that are available in higher end

Intel Chips. For optimum performance, use the newest generation processors.
For example, an i7 will significantly outperform an i5 even if the number of
cores and clock speed of the processors are equivalent. 

· FCS Express can take advantage of all cores in the computer. Thus, while not

required, a multi-core computer will be significantly faster than a single core
computer for many functions.

· FCS Express (32-bit) (PC Only) will use up to 3 GB of RAM on 32-bit Windows

and 4 GB of RAM on 64-bit Windows.

· FCS Express (64-bit) (PC and Mac) will use up to 128 GB on 64-bit machines.

· Please see our topic on R Integration regarding compatibility with R software

.

1.2.1 Supported File Formats

FCS Express will read .FCS data files from any instrument and supports a broad

range of file formats used for storing flow and imaging cytometry data. 

o Supported Flow Cytometry Data Formats

o Supported Image Cytometry Data Formats

o Other Supported Data Formats

1.2.1.1 File formats for Flow Cytometry

FCS Express can read listmode (FCS and LMD) data files from all manufacturers.

FCS Express currently supports FCS Version 1 to FCS version 3.1.  Simply

transfer the files to the computer on which you are running FCS Express (either

via the network, flash drive, CD or other method) and FCS Express will be able

to load the data . FCS Express also supports some specialized data formats

native to manufacturers instruments. These specialized formats include Cytek

and Sony Spectral data files, BD Accuri C6 and C6 Plus files, and Miltenyi

MacsQuant .mqd files. 

973

26

27

29

67



Welcome to FCS Express 27

© 2023 De Novo Software

In addition, FCS Express can also import the analysis/acquisition settings (gates,

plots, markers, quadrants etc) from flow cytometers running the BD

FACSDiva  and the BD Accuri C6  software.

File Type File description File format

Sample-
based 

Listmode files *.fcs; *.lmd

BD AccuriTM C6 / C6 Plus files *.c6; *.cfl; *.ci;

Sony Spectral Data *.sraw and *.fcs

Cytek Spectral Data *.fcs

Miltenyi MacsQuant files *.mqd

Nexcelom Cellometer® Vision *.nxdat (only numerical data)

Thermofisher Attune *.tmo

Plate-
based

BD AccuriTM C6 / C6 Plus Plate
files

*.c6; *.ci;

FCS Plate folders* FCS Plate Folder (folder directory -
see below*)

Importers BD FACSDivaTM Experiment files *.xml

BD AccuriTM C6 file *.c6

* The FCS Plate Folder  format allows users to load individual .FCS files derived

from plate based experiments:

o Bio-Rad ZE5 and YETI

o BD instruments with HTS add-on

o Guava

o Coulter Quanta

o Sony

o BD Accuri

o MACSQuant

Plate based data files may be used in conjunction with the High Content Heat

Map  add-on.

1.2.1.2 File formats for Imaging Cytometry

FCS Express Image Cytometry allows access to images, numeric analysis

results, and image segmentation masks from various instruments and image

analysis tools.

1460 1467
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In some cases import compatibility with a single image analysis packages enables

compatibility with many image formats (e.g. CellProfiler using Bio-Formats). In

other cases, direct import of analysis results or links to imaging databases have

been developed with specific vendors.

File

Type Product Name File format

Image

s

Numeri

c Data

Data

Base

Link

Sample

-based

CellProfiler *.cpout Y Y NA

Chemometec *.acs Y Y NA

ImageJ files *.ijout Y Y NA

Amnis® IDEAS® Software
*.daf and

*.fcs
Y Y NA

Countstar *.ice Y Y NA

Nexcelom Cellometer® Vision
*.nxdat or

*.ice
Y Y NA

Perkin Elmer Vectra® / InForm

Software
*.tif /*.txt Y Y NA

Thermo ScientificTM Attune

CytPix

*.acs Y Y NA

TissueGnostics *.ice Y Y NA

Plate-

based

Thermo ScientificTM HCS

StudioTM 2.0 Software
*.ice Y Y NA

YokogawaTM CQ1 *.ice Y Y NA

Perkin Elmer® - Opera®,

Operetta®, Acapella®,

Harmony®, ColumbusTM

PerkinElmer®

Acapella®

Folder or

Building

Blocks Tab.

Y Y

Y -

Columbus

TM
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1.2.1.3 Other file formats

FCS Express 7 supports loading data stored as Comma Delimited files in the
format of (*.csv). Please refer to the Importing External Documents and File
Types  chapter of this manual for further information.

1.3 Purchasing and Installing FCS Express

FCS Express can be purchased from our web site at
http://www.denovosoftware.com. Simply click the Purchase menu on the top
of the homepage. You have the choice of either ordering online or contacting
sales@denovosoftware.com. 

De Novo Software
207 N. Sierra Madre Blvd
Pasadena, CA 91107
USA

We accept checks, money orders, wire transfers, purchase orders, Visa™,
MasterCard™, and American Express™. In addition to a standalone license, De
Novo Software also sells both a network license and site licenses for FCS
Express. Please contact us at sales@denovosoftware.com for site license
information.

If you purchase the software online, you will be given the option of downloading
FCS Express at the time of purchase so that you can begin using it immediately.
Whether or not you order online, we will send a CD containing FCS Express to
the address you provided. After purchasing the software, the end user will
receive a confirmation email containing your configuration file.

FCS Express is available in multiple versions to suit your needs. To learn about
the different versions, click on the Products menu on the home page. 

Information on the different licensing options is available on our web site at
Licensing Options

Complete installation instructions (including information on obtaining
configuration files, using dongles and countercodes, and site licenses) are
available on the web site at http://www.denovosoftware.com/installation-
instructions/.

1.4 New Features in FCS Express 7

In addition to the new features described in the other sections of the manual,
FCS Express has major improvements summarized below:

· Speed

1460

http://www.denovosoftware.com
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o Significantly improved speed in the loading of data files, layouts, and saving of

layouts (up to 2X increase over previous version).

· User Interface
o Live Updating Dockable Formatting Interface

§ New look for the formatting window that updates as you make changes   

o Reorganized Ribbon

§ New tools and reorganized features to improve ease of use and efficiency

o New Color Blind Color Level Option for Density and Contour Plots , Gate

Heat Maps , and Plate Heat Maps

o Refresh Data tool

o The Refresh tool is particularly useful when editing or adding

keywords , adjusting data loading  preferences, modifying parameter
labels , or any other changes where removing cached data and
replacing it with updated data from FCS Express is useful.

o System Level Audit Trails (logging/audit trails add-on only)

§ Allows users to track system level actions to an audit trail for further
improving compliance with regulatory requirements such as 21 CFR Part 11

· Pipelines
o Pipelines  in FCS Express are a set of data processing steps that stand

alone or are connected in series.  The output of a step can be applied to a
data file or utilized as the input of the next step, or series of steps, that may
be applied to your data.The vast majority of commonly used algorithms for
data analysis are actually pipelines, with tSNE (and its variants) and SPADE
being two examples. However, when those algorithms are implemented as a
one calculation, user customizations are limited to the what the specific
implementation allows. Pipelines in FCS Express increase the computational
flexibility and granularity of running algorithms and data transformations while
giving users the unique ability to create their own transformations.
§ FlowCut
§ FlowAI
§ FlowSOM
§ SPADE
§ UMAP
§ Python integration
§ Downsampling
§ Quality Controls
§ Merge to Spectra  (for virtual unmixing)
§ Ability to store transformation results within the layout when saving,

to save time when the layout is re-opened.
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§ ...and much more...

· Compensation and Unmixing
o Spectral Unmixing

§ Added the ability to perform spectral unmixing with live updating wizard

o Unmixing Visualized Matrix builder

§ The Visualized Matrix builder creates a new page showing a chart
displaying the Detector vs Intensity for each single stained control added in
the wizard, as well as a spreadsheet with the charted values (each detector
is labeled by Detector # and Wavelength).

o Improved Automatic Compensation Interface and performance

§ New options, improved workflow and live updating capabilities for automatic
compensation

o Spillover Spreading Matrix and Cross Staining Index matrix

o Improved Data Fitting for Automatic Compensation

§ Improved stained and unstained automatic peak identification 

o Automatic Data File and Parameter Matching

§ Parameters automatically matched for single stained controls

o Improved Scatter Gate Selection

§ Set default scatter gate parameters in automatic compensation setup

o Ability to Choose Multiple Internal and Universal Negative Controls

§ Select the same tube as both a stained and unstained (self as negative)
control

o Compensation Options to append or overwrite compensated

parameters
§ Added the ability to append compensated parameters to uncompensated

parameter list or overwrite existing parameters as compensated (current
and previous default)

· Batch processing
o Ability to batch process to Internal Spreadsheet 

o Ability to add Gated Data to Data List to facilitate batch processing

across gates 

· Data File Compatibility and Support
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o Instrument Specific Settings

§ Automatically recognize and set scaling for data files 

o Spectral Data Compatibility

§ Improved support for Cytek Spectral Data

o MACSQuant MQD File Compatibility

§ Load and analyze MQD files directly in FCS Express

o Support for Gating ML

o Improved support for Cytek Aurora and BioRad ZE5 volumetric

keyword concentration calculations

· New Plot Types and Enhancements
o Gates Heat maps  and Parameter Heat Maps

§ Create array style heat maps for gated populations and parameters

o Subtraction Plots

§ Allows for multiple subtraction, addition, division, and multiplication data
fitting. Replaces Histogram Subtraction Tool from previous versions. 

o Multi-plots (NxN Plots)

§ Create plots for every combination of parameters in a data file. 
§ Five new multi-plot options available: NxN Plots, NxN Plots compensated,

All Parameters by X, All Parameters by Y, Histograms for all parameters

o Parameter Overlays

§ Quickly create overlays for all parameters on a single histogram for a data
file. 

o Box and Whisker, Violin and Beeswarm Plots

§ Visualize the distribution of your data according to quartiles, where the
middle two quartiles are represented by a mean- or median-bisected box,
and the outer two by whiskers.  Individual data points within each set may
be denoted by points, and the appearance of outliers can also be visually
emphasized.

o Levey Jennings Plots

§ Visualize quality control data to ensure test metrics are stable over time
and fall within a predetermined range. 

· Data Transformations and Statistics
o Usability Improvements for Transformations
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§ New Apply to all/selected button for transformations
§ Improved PCA for data sets with more parameters than cells
§ Improved K-means clustering

o Token Multiplication Grouping

§ Improves ability to add multiple statistics from different gates, markers,
quadrants, and parameters in spreadsheets and token tables.

§ Better grouping of statistics from multiple files in spreadsheets

o Analysis of Variance or ANOVA

§ Perform single factor or one way ANOVA directly within Integrated
Spreadsheets to test for statistical differences between multiple groups

o Tukey's test

§ Ability to perform a Tukey's range test, also known as Tukey's test, directly
within the Integrated Spreadsheets.

o New Percentile Function

§ Create markers and gates for any percentile value

o Spreadsheet Formula Hints

§ When typing a formula a dialog will appear providing hints and links on how
to use available formula references

· General Usability and Tokens
o Add Blank Tubes to Data List

§ Use blank tubes as placeholders for additional samples when creating or
working with panels

o New Keyboard shortcuts

§ Change gate and plot positions with keyboard arrows
§ Flip axes with keystroke
§ Create data specific gate with keystroke

o Ability to view the Source or Formula of Tokens and Custom Tokens

o New User Options

§ Ability to choose to always create a Data Specific Gate when a gate is
moved in the Create and Edit gate options

§ Defer changes for MultiCycle plot formatting

o New Tokens

§ New token for status of iteration flags
§ New token for current time zone 
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§ New Color token  that allows users to create customized color gradients
based on the value of any token. May be used in conjunction with new
custom object background tokens .

§ New token to return whether files in the data list are empty

o Visualize any FCS file on a Spectrum Plot as a "Virtual Spectral" data file

o Single download for all versions of FCS Express (Flow, Image, Plus)

o New slider bars for biexponential transformation to adjust transitions

points

o View data specific gates and plot navigator items from the gate view

o Improvements to gates when drawn on bi-exponential scales

§ Gates no longer need to be replaced for data files where biexponential
scaling and data ranges are different. 

o Axis Scaling for parameters are retained and updated across all plots when

formatted.

o Display File and Classification Identifiers on plots

o Ability to control well/node size on Plate Heat Maps

o Improved Multicycle plot model summaries

o Edit number of decimal places for spreadsheet tokens

o Export site license and internet dongle users in CSV report format

o Ability to insert images into Standard Operating Procedure steps

o Ability to add rules to control permissions for signing/unsigning specific

signatures 

o Optionally display a dialog when creating markers to allow the user to name

the markers  

o Ability to control the "off page" color
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1.5 Upgrading From Version 6

FCS Express 7 is the result of extensive customer feedback, giving you the
features you need most . FCS Express 7 continues our tradition of innovative,
powerful software, designed to let you work in a modern PowerPointTM style
framework. Speed and general usability have been greatly enhanced in Version 7
as highlighted in the New Features in FCS Express chapter .

In addition, Version 7 continues to expand to bring the full power of flow-style
analysis to the world of image cytometry. All of the standard FCS Express
features to which you have become accustomed are available, plus new
innovative abilities, such as gating on cells in your images, gating on events in cell
galleries, using heat maps to organize your experiment, and gating on wells. 

For more details on upgrading your current FCS Express license to FCS Express
7 please contact us at support@denovosoftware.com.
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2 Learning How to Use FCS Express

In addition to this manual and the integrated help system, there are a number of
other available ways to learn to use FCS Express. These include the FCS Express
Quick Start Resources, video  and written  tutorials, and email support .
These resources may also be found in the new Welcome Screen  of FCS
Express or on the De Novo Software website at www.denovosoftware.com 

The expert staff at De Novo Software is also happy to set up short training
sessions for free;  please write to support@denovosoftware.com to request a
session.

Our staff can also be reached for questions by dialing +001 (213) 814-1240 and
leaving a message. A member of the De Novo Software team will call you back
within 24 hours (usually within the hour).

2.1 Recorded Webinars and Tutorial Videos

A good place to start learning FCS Express is with our online recorded webinars
and short instructional videos. These are accessible via the Recorded Webinars
button on the Start Up Screen  and are also available at
http://www.denovosoftware.com/full-access/videos/ and on the De Novo
Software YouTube channel. These videos provide an overview of software
features and a glimpse of the variety of data analysis possibilities in FCS Express.
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2.2 Written Tutorials

De Novo Software also provides comprehensive, step-by-step written tutorials,
which describe how to use the basic functions of FCS Express. The tutorials
are included in this manual, and are also available offline by selecting the File
tab , or at: FCS Express Tutorials. 

Sample data is provided so that you can follow along with the examples in the
tutorials. The sample data can be downloaded from the De Novo Software web
site, from the
archive:https://s3.amazonaws.com/fcsexpressdownloads/TutorialSampleDataV
7.zip

Please see our full list of available tutorials
  

2.3 Integrated Help System

FCS Express comes with a comprehensive integrated help system. The
integrated help is available by selecting File tab . You can use
this system to search for specific topics (Figure 2.1). It contains the same
information as this manual, in an easy-to-access, cross-referenced manner.

Figure 2.1 The integrated help and manual within FCS Express.

2.4 Comprehensive Manual

The FCS Express manual is a detailed explanation of all of the functions in FCS
Express. The manual is available as a .pdf file by selecting the File
tab . You can also obtain the latest version of the
manual on the De Novo Software website.
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2.5 Email Support

If you have any questions pertaining to FCS Express please do not hesitate to
contact the De Novo Software team at support@denovosoftware.com. The De
Novo Software team is also available for free live web-based training and support
at your request. Please visit http://www.denovosoftware.com/full-
access/support/ for additional details.  

mailto:support@denovosoftware.com
https://www.denovosoftware.com/full-access/support/
https://www.denovosoftware.com/full-access/support/
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3 A Quick Tour of FCS Express

The FCS Express 7 interface utilizes the Ribbon  system, similar in design to the
familiar Microsoft Office suite of programs (Office 2007 and later). The Ribbon
helps you quickly find commands that you need to complete a task. The
commands are organized into functional groups collected under Tabs.  For
example, there is a Gating tab , a Batch tab , an Insert tab , etc.

The Applications button found in Version 4 was replaced with the new File tab in
FCS Express 5 and greater, which contains actions previously found in the
Applications button.

The FCS Express User Options  can be found within the Options command
in the File tab. Clicking on the File tab Options will launch the FCS Express
User Options window, which contains the adjustable settings found in Edit
Preferences in FCS Express V4. 

3.1 Getting Started with FCS Express

When starting FCS Express, the first window to appear is the User Selection
window (Figure 3.1). In this window, you can select the user profile to be used
for the current FCS Express session. To log in with an existing user profile, select
either the Default user, or a user name that you have created, and click the
Select button.  When a user is selected, the Options previously saved for that
user are activated.  Therefore, multiple users sharing the same computer can
customize their Options independently. To create a new user, click on New
User... and enter a new user name. At the end of the session, the user profile
stores the FCS Express User Options  for each user.  To delete a user, right-
click on the user name and select Delete User from the pop-up menu. Note:
Once a user is deleted, the default Options for that user cannot be recovered. 

The Import... button at the bottom left of the User Selection window is used
for importing FCS Express Version user preference files (.fcg) from the FCS
Express V5 installation folder.

For details on changing default user Options, see the section on Customizing
Default Options . Note: An individual user’s default Options can be restored to
manufacturer default settings, by selecting the File tab 

.

If only one user will ever be using this copy of FCS Express, you can choose
Remember Me On This Computer in the User Selection window. FCS Express
will then automatically log in as that user when the program starts. To stop
logging in as the same user, you can log out  from the File
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tab System  or from the right side of
the  Layout Navigation Toolbar at the bottom of the FCS Express window . 

Figure 3.1  User Selection Dialog

Note: If you are running the security system , or are using an Internet Dongle,
FCS Express will start up with a login screen prompting you to enter your user
name and password.

Once you select a user and press OK, FCS Express will start (Figure 3.2) and the
Startup Screen  will appear. 
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Figure 3.2  Startup Screen

After choosing New Layout, a blank document (layout) will be displayed (Figure
3.3). Layouts (.fey files) are the document format of FCS Express. 
The default layout is a single page with a white background.
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Figure 3.3 Blank layout

You can open an existing layout using the File tab Open to bring up a Load
Layout dialog. You can also create a new layout from a blank document or from
a template of an existing layout, discussed in detail in Creating a New Layout .

Layouts can contain plots, pictures, text boxes, statistics windows, and data
windows. Gating definitions, parameter label sets, and other features of the
analysis are also stored directly in the layout file. In addition, .fcs data files can be
embedded directly in the layout and saved as part of the layout file.

Any number of layouts can be open at the same time.

93
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3.2 Startup Screen

The Startup Screen in FCS Express (Figure 3.4) first appears after you choose a
User  or will open automatically if you have chosen to remember a user on the
computer. 

The Startup Screen is a dashboard for quickly accessing:

· New layouts

· Saved layouts

· Recently accessed layouts

· FCS Express news and updates

· Video Guides

· Recorded webinars

· Searchable Manual

· Tutorials

· Support

· Applications Examples

· Social media sites for De Novo Software

The Startup Screen will remain open until closed or minimized and can be
dismissed for future instances of FCS Express by unchecking the box for "Show
this screen when FCS Express starts up" in the bottom left of the window. 

Once the "Show this screen when FCS Express starts up" box has been
unchecked, the option to show the startup screen upon startup can be reset in
the File tab
Again category by checking the box for "Show startup screen automatically
when FCS Express starts up".

Alternatively, the Startup screen may be opened or closed through the View
tab  button. 

Other options for the Startup screen may be changed in the File tab
 Startup category, such as Automatically close

the startup screen when opening a new or existing layout and Reopen the
startup screen after closing all layouts. 

42
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Figure 3.4  The Startup Screen

3.3 A Quick Walk through the Ribbon

The Ribbon (Figure 3.5) is at the top of the page. You can find the File tab  and
the Quick Access Toolbar at the top, left corner of the Ribbon. The  Quick
Access Toolbar is a place to put frequently used functions. You can
customize  the functions on the Quick Access Toolbar (as well as the entire
Ribbon itself ). Under the Quick Access Toolbar are multiple Tabs. Each Tab
contains command buttons organized into logical groups. Some groups contain
a Dialog Box Launcher Button with multiple formatting options.

Figure 3.5  The Ribbon
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 On the upper right portion of the ribbon you may also choose the ribbon display
options (Figure 3.6) or to close, minimize, and/or restore the current layout.

· Auto-hide Ribbon will hide the ribbon in a single band until the top band is

clicked on to display the ribbon.
· Show Tabs will only display tabs until a tab is clicked on, then commands for

each tab will be present.
· Show Tabs and Commands will show all tabs and all commands at all times. 

Figure 3.6  Ribbon Display Options

At the very bottom left of the application window is the Layout Navigation
Toolbar (Figure 3.7) used for navigating through the layout . Beneath the
Layout Navigation Toolbar is the Zoom Toolbar . To the right of the Zoom
Toolbar is a Status Bar showing the active panel, described in Working with
Panels .

Figure 3.7  Layout Navigation Toolbar with Zoom Toolbar and Status Bar

Individual commands in the groups will be enabled or disabled based upon the
current status of the layout. For instance, if no items are selected, the Cut,
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Copy, and Duplicate commands in the Clipboard group of the Home Tab will be
disabled. Brief descriptions of the features of the Ribbon are described in the
sections below.

Multicycle  and Spreadsheet  tabs are only available when a Multicycle plot
or spreadsheet has been inserted, respectively.

The Multi Plot  tab is only available when a plot is selected. The Multi Plot tab
feature is not compatible with Subtraction plots, Picture plots, Bar and Pie
Charts, Scatter plots, Scatter with Regression plots, Heat Maps and gates Heat
Maps.

· The File Tab

· The Home Tab

· The Insert Tab

· The Design Tab

· The Gating Tab

· The Batch Tab

· The Text Tab

· The Data Tab

· The Tools Tab 

· The Quality Tab

· The Multi Plot Tab

· The View Tab

· The Format Tab

· The Multicycle Tab

· The Multi Plot Tab

· The Spreadsheets Tab Group

3.3.1 The Quick Access Toolbar

With the default Quick Access Toolbar, there are icons (Figure 3.8) to Save the
current layout or to Undo and Redo the last user action. FCS Express
remembers every action that you have taken. Therefore, you can undo an
unlimited number of actions, allowing you to revert to any earlier state of your
layout.

FCS Express allows up to 30 operations to be undone or redone by default.  

Undo
To undo any changes made to a layout, select  (Undo) from the Quick Access
Toolbar. The text of the tooltip associated with the Undo icon will indicate which
operation will be reversed or undone.

You can also use the Ctrl+Z keyboard shortcut to undo the last operation you
performed.
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Redo

To redo any changes made to a layout, select the  (Redo) from the Quick
Access Toolbar. The text of the tooltip associated with the Undo icon will indicate
which operation will be reversed or undone.

You can also use the Ctrl+Y keyboard shortcut to redo the last operation you
performed.

Figure 3.8  Quick Access Toolbar Icons

Clicking the Customize command (tooltip "More Buttons") brings up a gallery
(Figure 3.9) which allows you to fully customize the interface.

Figure 3.9  Customize Menu

The Customize Quick Access Toolbar... item brings up a Customize dialog
(Figure 3.10). Commands or individual Tabs can be chosen in the left column to
be added to or removed from the Quick Access Toolbar in the right column,
where they can be rearranged.



A Quick Tour of FCS Express 51

© 2023 De Novo Software

Figure 3.10  Quick Access Toolbar Customization dialog

Under File tab System drop down, the Reset Toolbars to
Default Settings command will revert your changes to the manufacturer default
(Figure 3.11).
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Figure 3.11 - System Restore Options

3.3.1.1 Customizing the Ribbon

In addition to customizing the interface using the customize command to the
right of the Quick Access Toolbar , right-clicking on an individual command
within a group, or right-clicking on the name of a group, brings up a menu (Figure
3.12) which includes the command to Add to Quick Access Toolbar (or group
of commands) to the Quick Access Toolbar .
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Figure 3.12  Add Command to Quick Access Toolbar

The Customize the Ribbon... item brings up a Ribbon Customization dialog
(Figure 3.13).  Commands or the Home, Tools, or Custom tabs can be chosen
in the left column to be added to or removed from the Quick Access Toolbar in
the right column, where they can be rearranged or hidden by unchecking the
check boxes.

Figure 3.13 - Ribbon Customization dialog
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When the Customize dialog is open, you can perform many customizations to
the Ribbon . To remove items from the Ribbon: click on the item to remove,
hold down the mouse button, drag the item to an area within the Customize
dialog, and release the mouse. If you drag the item to another part of the
Ribbon, it will be moved to the position where you release the mouse. To add
commands to the Ribbon, select the Commands tab. Select a command from
the list and drag it to the position on the Ribbon (or Quick Access Toolbar) where
you wish it to appear.

You can reset an individual group (toolbar) to its default state by selecting the
toolbar in the Toolbars tab and pressing the Reset button in the bottom left
corner of the window.

Under the File tab System Reset Toolbars to Default
Settings command will restore all toolbars to the default settings.

3.3.2 The File Tab

The File tab  (Figure 3.14) contains multiple groups of items in a list at the left.
Clicking on any item on the left will open a new item section on the right specific
for that item. The main items and their sub items are as follows:
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Figure 3.14  File tab

 

· Save, Save as..., Open, Close, Close All, Open From, Recent, New ( )

These items allow the user to create, open, save, and close layouts. The
Open From command also allows the user to import BD FACSDiva  and BD
Accuri C6  files.
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For more details on the Recent command, please refer to the Opening a
Previously Created Layout  chapter.

· Export ( )

     The Export item allows you to export your layout to a PowerPoint
presentation  or a PDF . In addition, you can save the current page or
selected items as a Picture .

· Info ( )

This item allows you to:

o View information about the current layout

o View the log of all changes that were ever made to the layout (if you

have purchased the logging add-on) 

o Create and manage the set of electronic signatures for this layout, and

sign or unsign the layout  (if you have purchased the security add-on) 

· Print ( )

This item is used to:

o Select a printer, which pages to print, and other options before printing

o Choose to print Color or Grayscale

· Collaborate ( )

This item is for:

o Publishing your layout  using the De Novo Software Publishing service

o Managing the layouts you have published

· System ( )

With this command, you can:

o Current User

§ Import User Options from File.
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§ Export User Options to File
§ Logout the current user.

o Restore Options

§ Restore Options to Default Settings.
§ Reset Toolbars to Default Settings.
§ Clear All Recent Items.

o Show background tasks to Manage print jobs, downloads and other

tasks that are running in the background.

o Change your configuration.

Note: If security is activated, there will be an additional item available labeled
"Security".

The Options button ( ) brings up the FCS Express User Options  dialog
where you can completely customize the working environment for a selected
user by selecting the defaults (Options) for essentially every object category in
FCS Express.

The Exit button ( ) closes FCS Express. You will be prompted to save your
layout if it has changed during your session.

3.3.3 The Home Tab

The Home tab (Fig. 3.15) contains the following groups:

Figure 3.15  Home Tab

· Clipboard

o The Paste command allows you to paste something from the clipboard.

The label of the Paste command will change depending on the type of
object(s) in the clipboard.

o The precise text beside the Cut and Copy commands will change depending

on which object(s) in the layout are currently selected.
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o The Duplicate command duplicates the selected object(s). Under the

Duplicate dropdown menu are five commands: Duplicate, Duplicate and
Next, Duplicate and Prev(ious), Multiple Duplicate and Next, and
Multiple Duplicate and Prev(ious). The Next and Prev functions associated
with these commands duplicate the selected object(s) and changes them to
display the next or previous file(s) in your Data List . The Multiple
commands allow you to make more than one copy of the selected item,
changing successively to the next or previous file(s) in each instance. The
positioning of the duplicated objects can be set in the Duplicate Options
(Fig. 3.16, top)or in the default User Options :  

· Selecting radio button next to Place the duplicated objects in a

grid will allow Custom Grid settings to be enabled under Grid
Options. The duplicated objects will displayed on the following new
page(s) of the layout.

o Objects are duplicated at the size appropriate for the page

dimensions that allow for the Number of columns, rows,
and Gap mode and value specified under Custom Grid Tiling
Options (Figure below, top right).  Order specifies whether
objects are duplicated across and then down the page
("Horizontal") or down and then across ("Vertical").  Also
note that if Custom Grid is selected, the file(s) in currently
selected object(s) are duplicated as the first object(s) in the
Custom Grid.  An example of selected objects Multiple
Duplicated in a Custom Grid with the options specified below
is shown in the Figure below (bottom).

· Selecting the radio button next to Place the duplicated objects

relative to the original will place the duplicated objects on the
same page as the selected object(s) even if pages do not fit on the
page.  In order to place all duplicated objects on a page, please be
sure to check the box next to If duplicated object(s) are off the
page, put them on a new page.  Enabling this option will create
new page(s) to accommodate all the duplicated objects that do
not fit on the same page as the original object(s).
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Figure 3.16 Multiple Duplicate Options (top), including Custom Grid Tiling
Options (top right), and an example of selected objects Multiple Duplicated with

the pictured options (bottom).

o The items in the Clipboard group will operate on plot windows, text boxes,

statistics windows, and more, depending on which object(s) are currently
selected in the layout page. Items (e.g., Text Boxes) can be copied from
one layout to another. You can switch between open layouts using the
View tab Windows Switch Windows command.

· Pages

o The top half of the New Page command adds a new page to your layout.

The bottom half of the New Page command opens a gallery with numerous
choices for adding a new page with Place Holders for predefined layouts
containing various text boxes, plots, and statistics.
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o The Delete Page command deletes the current page.

· Font

o Within this group, the Font Name, Font Size, Font Color, and Font

Background Color can be changed for the selected object(s) with Bold,
Italics, and Underline options available.  Clicking the expand button will open
the Font Dialog (Fig. 3.17).

 Figure 3.17 - Home Tab Font Group to Font Dialog
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· Editing

o The Select All command selects all of the object(s) on the current page.

o The Delete command deletes the currently selected object(s).

o The Arrange command expands to allow you to Order Objects and

Group Objects. Order Objects allows you to organize which objects are
visually on top of other objects. This feature is useful when working with
multiple overlapping objects. Group Objects allows you to group several
objects together, so that selecting any one of the objects will automatically
select all items in the group. 

 
o The Align command expands to allow you to Horizontally or Vertically

align objects and Position Objects. These commands are used in aligning
the sides, tops, bottoms, centers, heights and/or widths of the selected
objects.

3.3.4 The Insert Tab

The Insert Tab (Figure 3.18) contains six groups for inserting objects on a
page:

Figure 3.18  Insert Tab

 

· General

o The Shapes command is for inserting a new shape, such as a Line, Arrow,

Ellipse, or Rectangle.

o The Text Box command inserts a new text box.

o The Gate View command allows the user to insert a Gate View window,

from which the properties of all your gates may be viewed and changed.

o The Picture command inserts a picture from a file on your computer.
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o The Data Grid  command  allows the user to view data in a table

(spreadsheet) format or work with custom data .

·  Spreadsheet

o The New Spreadsheet  command opens up a dialog window for

creating a new spreadsheet (Figure 3.19), from which data values and
statistical calculations can be plotted in FCS Express.  Selecting an
inserted spreadsheet will reveal the Spreadsheet Tab group .

Figure 3.19 - Create New Spreadsheet Dialog

· 1D Plots

o The three commands in the 1D Plot group  insert Histograms ,

Subtraction Plots , or Fit plots (i.e. Multicycle DNA histograms  and
Proliferation histograms) .

· 2D Plots

o The five commands in the 2D Plot group  insert two-dimensional Dot

plots, Color Dot plots ,  Density plots, Contour plots  and Other plot
types (i.e. Surface plots , Kinetics plots , Scatter plots  and Scatter
with Regression plots , Levey Jennings plots  ).

· Charts

o The three commands in the Charts group  insert Bar charts , Pie

charts  and the Summary charts  (i.e. Box and Whisker, Violin and
Beeswarm plots) for graphing and visualizing data from integrated
spreadsheets  and other data sources. 

· Other Plots
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o The three commands in the Other Plots  group are Picture Plots ,

Spectrum plots  and Heatmap plots (i.e. Plate Heat Map , Gates Heat
Map  and Parameter Heat Map , that allow you to perform specialized
analysis for plate based data, heat mapping by groups of gates and/or heat
mapping by groups of parameters respectively).

3.3.5 The Design Tab

The Design Tab (Figure 3.20) contains the Page Layout group, which includes
the following commands:

Figure 3.20  Design Tab

o The Page Setup command allows you to determine the page Size,

Orientation, Margins with any default or custom values as well as to choose
to Maintain the size of all objects on the layout.

o The Size command allows you to pick a page size from a list of default sizes.

o The Orientation command allows you to choose to view the layout in a

portrait or landscape mode.

o The Margins command allows you to choose from four default margin size.

o The Layout command opens a gallery for adding Place Holders for predefined

text boxes, plots, and statistics to the current page.

3.3.6 The Gating Tab

The Gating Tab (Figure 3.21) contains the following commands for working with
gates:
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Figure 3.21  Gating Tab

· Create Gates is the group under which all of the following fall:

o commands for creating gates (Ellipse, Rectangle, Polygon, Freeform,

Well ), Markers (Create Marker), and Quadrants on a plot. It also
allows you to quickly see which gate is applied to a plot. These functions
are described in more detail in the section on Using Gates .

o the Data Specific Gate command, which permits the assignment of

unique gating positions to specific data files.  Use of data specific gates is
described in more detail in the section on Data Specific Gates .  

Note: adjusting gates on a per-datafile basis during Batch Processing is still
possible in the latest release of FCS Express, as in all previous versions of
FCS Express.

3.3.7 The Batch Tab

The Batch Tab (Figure 3.22) contains two groups.

Figure 3.22 Batch tab

All of the commands associated with this Tab are described in detail in the
chapter on Batch Processing .

· Batch Processing
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o Once you have set up and verified all your batch processing options and

actions, the Run command executes all your actions including printing,
saving, and reporting across all samples.

o Within the Batch Processing command you may choose the following

options:

§ Run - Runs the batch actions with the same gates applied to all
samples.

§ Rerun - Reruns the previous batch run using any modifications made
to the layout when the batch process was run with pauses. 

§ Review - Runs a series of batch iterations over samples without
exporting any actions. 

§ The Options command brings up the Batch Processing Options 
Window where you can:

· Set the number of iterations to perform.

· Choose whether or not to run alerts before batch

processing.

· Decide if you want to pause between iterations and which

iterations to pause at if iterations are flagged or certain
conditions are met.

· Restore the original files on the layout after batch

processing.

§ The Batch Actions command brings up the Batch Actions
window where you can set various actions associated with printing,
reporting, and saving layouts (to various formats) while batch
processing.

· Organize Data Sets

o The Panels command brings up the Panel Information dialog for working

with Panels .

o In the Increment Value field, you can set the increment value, which is the

number of files to increment after each iteration in a batch process. An
increment value of 1 means to move to the next file.
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o In Number of Stationary Controls, you can set the number of files at the

top of the Data List that will not change when Batch Processing  or
changing Iterations, but will be loaded into the layout if also defined as
Stationary Controls within a Panel .

o The Data List command brings up the dockable Data List  window to

process the list of current files (or custom data).

3.3.8 The Text Tab

The Text Tab (Figure 3.23) contains four groups.

Figure 3.23  Text Tab

· Insert Text

If a text box is selected, the Insert Token command allows you to choose
the type of token to insert. The Insert Table command is used for inserting
a table into a text box and specifying its properties. The Insert Picture
command is used for inserting a picture into a text box.

· Font and Paragraph

The commands in the Font and Paragraph groups are used to format the
text manually in the current cursor position just as you would in word
processing software. If text is selected, the formatting is applied to the
selected text. You can display standard Font or Paragraph dialogs to format
multiple properties at the same time by clicking on the Dialog Box Launcher
Buttons  (little arrow icons at the bottom right) of the Font and Paragraph
 groups. While the font and paragraph commands usually apply to text
boxes, some paragraph properties can apply to non-text box options. For
instance, changing the justification of a data or stats window will change the
alignment of the text.

· Hyperlinks

The hyperlink features allows users to insert or remove hyperlinks referring to
an Existing file, URL, or Place in this layout (Figure 3.24). When Existing
file is selected, a link to external documents can be created. The link can

direct to a file (  in the figure below) or to a folder  (  in the figure below).
The link to a file, can direct to any type of document (e.g. a FCS Express
layout, a PDF, a PowerPoint, a Word document, an Excel document,...). A link
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to a URL will open a specific web page and a Place in this layout will bring
you to an object/plot within the layout.

Figure 3.24  Insert hyperlink window when Existing file option is selected

· Table

If a table has been inserted in a text box and the table is selected, the
commands in the Table group can be used to:

o Display the table properties.

o Insert rows above or below the current position.

o Insert columns to the left or right of the current position.

o Delete the last row or column of the table.

3.3.9 The Data Tab

The Data Tab (Figure 3.25) contains six groups:

Figure 3.25 - Data Tab
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· Save/Load

o The Open command brings up the Select Data File dialog (Figure 3.26)

which allows you to select a data file (e.g., an FCS file). On the left hand
side of the dialog, you can navigate to the location of the files anywhere
on your computer.  You can filter for a specific file type by selecting one
from the drop-down menu in the lower right-hand corner. Once you
have navigated to the correct folder,  highlight the file of interest and
click Open File to load the data.   

Figure 3.26 - Select a Data File Dialog

Once a data file is opened, choose which type of plot(s) to open from
the Select Plot Types ... dialog (Figure 3.27).
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Figure 3.27 - Select Plot Types Dialog

o The Refresh icon allows the user to remove data stored in memory and

reload the data anew.  The Refresh tool is particularly useful when
editing or adding keywords , adjusting data loading  preferences,
modifying parameter labels , or any other changes where removing
cached data and replacing it with updated data from FCS Express is
useful.  If multiple files need to refreshed, you can right click in the
Refresh data files window to choose Select All, Deselect All, or
individually select data files (Figure 3.28).
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Figure 3.28 - Refresh data files window

o With the Export command, you export the data from a single open

file .

o You can export data from multiple files consecutively using the Batch

Export  command.

· Data Info

o If a plot is selected, the View Header command brings up a dialog box

which displays the FCS file header information for that file. If no plot
exists on the layout, the Select Data File dialog is displayed, so you can
choose which header information to display.

o The Keywords Anonymizer  command brings up the Select

Keywords to Anonymize window, which allows you to remove any or
all keywords from a data file. 

· Organize Data Sets

o The Panels command brings up the Panel Information dialog for working

with panels .

1438

1443

1443

1435

686



A Quick Tour of FCS Express 71

© 2023 De Novo Software

o In the Increment Value field, you can set the number of files to

increment after each iteration in a batch process, or when pressing
Next/Prev on Selection or All Objects (below). An increment value of 1
means to move to the next file in the Data List. See the Organizing
Iterations in the Data List  chapter for more details.

o In Number of Stationary Controls, you can set the number of files at

the top of the Data List that to remain constant in the list as a "control"
which will also not change when running Batch Processing  or changing
Iterations. See the Organizing Iterations in the Data List  chapter for
more details. Note: Stationary Controls can be loaded into the layout
if also defined as Stationary Controls within a Panel .

o The Data List command brings up the dockable Data List window to

process the list of current data files .

 
· Change Data on Selection

o Previous loads the previous Iteration (see the Data List  chapter) on

the selected plot or plots. A shortcut for this action is also available:
Alt+Left. This action is also available upon right clicking on the selected
object(s).

o Next  loads the next Iteration (see the Data List  chapter) on the

selected plot or plots. A shortcut for this action is also available.
Alt+Right. This action is also available upon right clicking on the selected
object(s).

o Select brings up the Select Data File dialog from which you can choose

an .fcs file to display in the selected plot or plots.

· Change Data on All Objects

o Previous loads the previous Iteration (see the Data List  chapter) on

all plots. A shortcut for this action is also available: Shift+Alt+Left.
o Next loads the previous Iteration (see the Data List  chapter) on all

plots. A shortcut for this action is also available: Shift+Alt+Right.
o Select brings up the Select Data File dialog from which you can choose

an .fcs file to display in all plots.

o Flag this iteration  marks the selected file or iteration to be flagged

for review in the Batch Process or Data List.
o Iteration allows you to choose, from a drop-down menu, which

iteration to load on all plots.   
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Note: In order to use the Next/Previous functions mentioned above to
Change Data on Selected/All Objects, each of the following conditions
must be met:
· The Data List  must contain data and an active iteration is currently

selected
· The object(s) to change (e.g., a plot) are selected or in edit mode if

data sets/iterations are to be changed only for certain objects
· The selected object(s) display or are linked to a data set/iteration in the

data list
· The selected object(s), e.g., a histogram , 2D plot , and/or Token

, must have the Change data file during Next/Prev/Batch option
enabled (Figure 6.1).
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Figure 6.1 - Example of Formatting dialog for 2D plots in which
the Change data file during Next/Prev/Batch option is

selected. The same option is available for histograms and
Tokens.

3.3.10 The Tools Tab

The Tools tab (Figure 3.29) contains four groups:
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Figure 3.29 - Tools tab

· Calculate

o The Concentration Calculator command opens the Concentration

Calculator window where you can calculate the concentration of
events in a sample .

o The Channel Calibration command opens the Channel Calibration

window where you can change the axis fluorescence intensity scales
from a linear or logarithmic scale to one indication either the absolute
number of antigen molecules or the number of binding sites on the
surface of a cell .

· Labels

o The Parameter Labels opens a gallery containing Modify Labels, Load

Labels, and Save Labels commands. These items allow the user to
easily create, change, recall, and save alternate parameter labels .

· Snapshots

o The Apply Iteration Snapshot command allows you to move gates

between iterations and have the gates' new positions remembered while
navigating using the Next and Previous commands .

o The Snapshots command opens the Snapshot Navigator window

where you can take custom snapshots of your analysis on data files and
apply that analysis to other files .  For example, a snapshot of a gate
position may be taken, the gate position changed, and snapshot applied
to go back to the original gate position.

· Transformations

o The Compensation and Unmixing command opens the

Compensation and Unmixing Navigator, which allows you to display
the compensation and unmixing information on the selected file, create
new compensation and unmixing, and load or save compensation or
unmixing information .
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o The Transformations command opens the Transformations

Navigator, which allows you access K means (cluster analysis) ,
Principal Component Analysis , Parameter Math  (defines a single
or sequence of math functions, save the functions, and apply the
functions to data files ), R integration  to add new parameters or
transformations, and tSNE . 

· Override 

o The Override Authorizations command allows you to override any

Authorizations set on objects. See the Overriding Authorizations  topic
for additional details. 

3.3.11 The Quality Tab

The Quality tab (Figure 3.30) contains two groups:

Figure 3.30 - Quality tab

· SOP

o The Run SOP command begins the step wise process of running

through all of the steps defined in the SOP creation process

o The Standard Operating Procedures command opens the 

Standard Operating Procedures  navigator .

o The Permission Rules command opens the Permission Rules

Navigator where you can set available permissions  specific to a
layout.

· Alerts

o The Run Alerts command can be run once at least one alert is

created.  When clicked, FCS Express will evaluate the formulas
written in the Alerts Navigator.
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o The Alerts command opens the Alerts Navigator (only accessible

with FCS Express IVD Version) where you create True or False
statements for evaluation.

3.3.12 The View Tab

The View Tab (Figure 3.31) contains six groups:

Figure 3.31  View Tab

· Tokens

o The Custom Tokens command brings up a dockable Custom Tokens

window where you can create new custom tokens  to generate your
own custom statistics.

· Navigators

o The Layout Navigator  command brings up a dockable Layout

Navigator window listing each item in the layout.

o The Data Navigator  command brings up a dockable Data Navigator

window listing the parameters of each file referenced in the layout.

o The Gate Navigator  command brings up a dockable Gate Navigator

window describing the gates which have been defined on plots within the
layout.

o The  Notes Navigator  command brings up a dockable Note Navigator

window the allows the user to create and review notes associated with
any object within the layout.

· Multiple Pages

o In the Multiple Pages group, there are four commands [One Page,

Two Pages (Horizontal), Two Pages (Vertical), and Four Pages] for
displaying the entire layout in different views .

· Windows
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If there are multiple layouts open, the Switch Windows command allows
you to choose which layout is active.

· Show

o The Master Page command shows the Master Page.

o The Hidden Pages command is used to show pages that the user

has previously chosen to hide in the layout.

· Welcome

o The Startup Screen command allows you to view or hide the

Startup Screen. 

3.3.13 The Help tab

The Help tab (Figure 3.32) contains two groups:

Figure 3.32  Help Tab

· Manual Hhelp)

Three versions of the Users Manual are available:
o On the Web (Requires internet connection).

o On this Computer. Only available on Windows machines and can be

quickly accessed by pressing F1.
o PDF.

· Other Resources

o Videos links to web based video content.

o FAQ-Knowledge Base links to web based FCS Express frequently

asked questions and knowledge base.
o Application Examples links to web based example applications of FCS

Express
o Support links to web based information on how to access FCS

Express support
o About My License provides information about the version of FCS

Express that is running, the serial number and current subscription
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3.3.14 The Format Tab

The Format Tab (Figure 3.33) contains eight groups. The commands allow you
to change the properties of one or more selected objects. To access this tab,
one or multiple plots must first be selected. 

Figure 3.33  Format Tab

· Object Options : Each command brings up a dialog box to set object

properties. 

o The General command is for assigning or changing the object name and

the object visibility .

o With the Size command, you can change or scale the height and width of

objects. An option exists to lock the aspect ratio so that the ratio of the
height to width are kept constant.

o The Fill command is used for setting the objects background characteristics

(color, image), changing the margins of the object, and adjusting the frame.

o The Border/Lines command is used to set the style, color, and width of

lines surrounding the border of the selected object(s).

o The Authorizations  command is used to define what select and edit

actions are accessible for the object(s). 

o The Gate View Options command allows to view plot information for plots

gated on a gate within the Gate View  and/or view Data Specific Gates
within the Gate View .

o The Text Box Contents command allows editing of quadrants text boxes.

· Data Options

o The Gates to Display command is used for choosing which gates to display

in a plot or Data Grid.

o The Parameters to Display command allows you to choose which

parameters are shown in a data grid.
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o The Data Image Options command controls image placement in the cells

of a Data Grid.

· Plot Options

o The Overlays command is used to choose the characteristics of an overlay

including, x- and y-parameters, gates, compensation, color, and dot size,
among other things.

o The Axes, Title, and Legend commands allow you to format and position

the text used in these areas of the object. 

o If you are working with a histogram or surface plot, the 3D command is

used to format the properties of the display, such as zoom, rotation,
elevation, offsets, and perspective.

o The Specific Options command allows you to change specific options that

are related to the particular plot that is selected, e.g., the resolution of a
plot, and to indicate how many cells to plot.

o The Text Boxes Selection command allows you to allow or disallow

selection of text boxes from markers, gates, and quadrants when shown on
plots. 

· 1D Options

o If marker(s) have been created, the Markers command is used for

formatting the properties of the markers on single-parameter histograms.

o If a Proliferation Plot has been created, the Proliferation Fit command

allows you to access Proliferation Fit options .

o If a Proliferation Plot has been created, the Position Markers command

allows you to access Position Marker options .

· 2D Options

o With the Quadrants command, you can format the quadrants of a dual-

parameter plot.

o If you are working with a 2D color plot (e.g., color dot plot, density plot,

contour plot) the Color Levels command is used to format the properties
of the colors displayed.
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o If you are working with a Scatter with Regression plot the Regression

Fit command always you to quickly access regression model options. 

· Statistic Options

o If statistics are displayed in a default statistics window, the Statistics

command allows you to format the properties of the statistics window.
Available commands are:
· Statistics - controls general statistic formatting

· 1D Stats Options - controls options for statistics from 1D plots .

This dialog can also be opened by right-clicking on a Statistics table,
selecting Format in the right-click menu and then selecting the 1D Stats
Options category from the drop-down menu of the Formatting dialog. 
The If there are markers on plot, also show statistics for the base
overlay without the marker check box allows to display statistics for
the entire overlay with no marker applied.
The Custom Denominator Gate Options drop-down menu allows to
select the Gate to use as denominator for the % of custom
denominator gate statistics (see the Histiogram Statistics  chapter).

· 2D Stats Options - controls options for 2D plots  gate statistics.

This dialog can also be opened by right-clicking on a Statistics table,
selecting Format in the right-click menu and then selecting the 2D Stats
Options category from the drop-down menu of the Formatting dialog.
The Custom Denominator Gate Options drop-down menu available in
the 2D Stats Options panel allows to select the Gate to use as
denominator for the % of custom denominator gate statistics (see the
2D Plot Statistics  chapter).
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· Change

The Change Plot Type command allows you to change the type of a
selected plot. By clicking on the down arrow associated with the Change
Plot Type command, you expand the item to reveal all of the possible plot
types.

3.3.15 The Multicycle Tab

The Multicycle Tab  allows you to work with the Multicycle AV plugin  from
Phoenix Flow Systems.  To access this tab, a Multicycle plot must be inserted. 
When hovering over a model button, its name will appear (Figure 3.34).

Figure 3.34  Multicycle Tab with Model 1 Name while hovering

It contains two groups:

· Fit Parameters

The Autofit command automatically adjusts cycle parameters. In manual
mode, the Fit Parameters command brings up a dialog to format the Fit
Model Properties, and the Background command brings up a dialog to
format background options. The Cycle drop-down list allows you to
choose the number and kinds of populations to model.

· Model to Display

The six Model commands are used to set the currently displayed model.
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3.3.16 The Multi Plot Tab

The Multi Plot tab allows you to access multigraph plotting features  that
enable you to quickly insert an array of plots for many parameters. To access
this tab, a plot must first be selected. The Multi Plot tab feature is not
compatible with Subtraction plots, Picture plots, Bar and Pie Charts, Scatter
plots, Scatter with Regression plots, Heat Maps and gates Heat Maps.

· Multigraph - Please see our full description and examples of working

with multigraphs.

o Histograms: The Histograms option will insert 1D histograms of every

parameter in the data set 

o All Parameters by X: The All Parameters by X option will insert the

2D plot type of the parent plot with the X axis of the parent plot
consistent across all plots. The Y axis will change for each parameter in
the data set.

o All Parmaeters by Y: The All parameters by Y option will insert the

2D plot type of the parent plot with the Y axis of the parent plot
consistent across all plots. The X axis will change for each parameter in
the data set

o NxN Plots: The NxN Plots option will create multigraphs that display

combinations of all parameters (including time and scatter) versus each
other.

o NxN Plots Compensated: The NxN Plots Compensated option will

create multigraphs that display combinations of all parameters versus
each other of the parameters involved in the compensation matrix of the
parent plot.

o Color by All Parameters: The Color by All Parameters option will

create multigraphs that display plots with the color based on parameter
set for each parameter chosen. Color by All Parameters is accessible
when the source plot is either a density plot or a contour plot. It is
especially useful when performing tSNE styled analysis when it is useful
to show color based on parameters when the axis are set to tSNE X vs
tSNE Y. 
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3.3.17 The Spreadsheets Tab Group

Once you insert a Spreadsheet  from the Data tab and put it in selected mode,
the Spreadsheets tab group will appear with Layout  and Formulas  tab.

3.3.17.1 The Layout Tab

The Spreadsheets  Layout tab (Figure 3.35) contains seven groups:

Figure 3.35 - Spreadsheet Layout tab

· Font

The Font Name, Font Size, Font Color, and Font Background Color
can be changed for the selected object(s) with Bold, Italics, and
Underline options available.  

· Alignment

o  Alignments and indentations can be applied.  

o  The Wrap Text command sets text to wrap in a cell.

o  The Merge Cells drop down allows you to Merge Cells, Merge

Across, Merge and Center, or Unmerge Cells (Figure 3.36).

Figure 3.36 - Merge
Cells drop down list

· Tokens

The Insert Tokens command will open the Insert a Token dialog .

· Formatting and Sorting

416

83 89

416

1284



FCS Express 7 Manual84

© 2023 De Novo Software

o  The Conditional Formatting drop down allows you to access the

following:

§  Color Scales, Data Bars, Icon Sets, Top/Bottom Rules
(Figure 3.37),

Figure 3.37 -
Conditional

Formatting drop down
list

§   More Rules..., which opens the Conditional Formatting
Rule window  (Figure 3.38),
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Figure 3.38 - Conditional Formatting Rule window

§  and Manage Rules..., which opens the Conditional
Formatting Rule Manager (Figure 3.39) to create new rules to
be applied to the Current Selection or Sheet.
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Figure 3.39 - Conditional Formatting Rule Manager

o  The Sort A to Z command allows you to sort the selected cells in

alphabetical order.

o  The Sort Z to A command allows you to sort the selected cells in

reverse alphabetical order.

o The Spreadsheet Data command allows you to edit the data

formatting options for Spreadsheets (Figure 3.40).  By checking the
box to Use values in a first row as labels, any chart utilizing data
drawn from the Spreadsheet will display the value in the
Spreadsheet's first row as the column label on the chart's axes. Left
unchecked, charts will default to using the column letters (i.e A, B, C,
etc.) as the axis labels. 

Figure 3.40 - Spreadsheet Data Formatting Options

·  Cells
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o  The Insert Row command adds a row above the selected cell(s).

o  The Insert Column command adds a column to the left of the

selected cell(s).

o  The Delete Row command removes a row below the selected

cell(s).

o  The Delete Column command removes a column to the right of the

selected cell(s).

o  The Formatting drop down list (Figure 3.41) allows you to perform

the following:

§  AutoFit Row Height

§  AutoFit Column Width

§  Access Hide and Unhide list to Hide Rows, Hide Columns,
Unhide Rows, or Unhide Columns

Figure 3.41 - Cells Formatting drop down
list

§ Open Format Cells window (Figure 3.42)
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Figure 3.42 - Format Cells window  

·  Editing

o  The Clear drop down list allows you to Clear All, Clear

Formatting, and Clear Contents of selected cell(s) (Figure 3.43).
 

Figure 3.43 - Clear
drop down list

o  The Freeze Panes drop down list allows you to Freeze Panes,

Unfreeze Panes, Freeze First Row, and Freeze First Column
(Figure 3.44).
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Figure 3.44 - Freeze
Panes drop down list

o  The Comments drop down list allows you to add New Comment,

Edit Comment, Delete Comments, move to Next Comment or
Previous Comment, and Show/Hide Comments (Figure 3.45).

Figure 3.45 -
Comments drop down

list

· Exports

o The Export command allows you to export data contained in the

spreadsheet to various formats: .xlsx Excel workbook, .xls 97-2003
Excel Workbook, .html Web Page, .csv Comma Delimited Value
files, .xml Data and .txt tab delimited files. When exporting as to
Excel compatible formats equations and formatting from the FCS
Express spreadsheet will be retained.

3.3.17.2 The Formulas Tab

The Formulas tab (Figure 3.46) contains the Function Library group with the
following drop down lists: AutoSum, Financial, Logical, Text, Date and Time,
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Lookup and Reference, Math and Trig, Statistical, Information, and
Compatibility .

An Insert Function button is also available (See first button from the left in the
screenshot below)

Figure 3.46 - Spreadsheet Formulas tab 

Formulas can be inserted into the spreadsheet in multiple ways:
· by directly selecting the function of interest from function library drop-down

lists (screenshot above)
· by typing the formula directly in the cell of interest into the spreadsheet

· via the Insert Function button, which also allows to search among all the

available functions (Figure 3.47);

Figure 3.47 - Insert Formula Dialog
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4 Layouts

Layouts (.fey files) are the file type of FCS Express.  They are usually saved with
a link to your .fcs data files, and contain all elements of your analysis including
plots, gates, statistics, batch processes, and more.

· Introduction to the Layout

· Introduction to Docking

· Navigators

· Layout Page Features

· Using the Master Page

· Using Templates

4.1 Introduction to the Layout

The layout is the name for an FCS Express document. The layout contains and
organizes plots, regions, quadrants, statistics, text boxes, graphics, printer
settings, and more. There is no limit (other than your computer memory) to the
number of layouts that can be open at one time. It is possible to copy objects
easily from one layout to another. There are many other powerful formatting
and graphics features in FCS Express that allow you to display data exactly as
you wish.

The layout organization in FCS Express is similar to that in a Microsoft
PowerPoint® presentation. Like a presentation containing a series of slides with
text and graphics, each FCS Express layout contains a page or series of pages
with text boxes, plots, statistics, and other objects. Similar to a slide in
PowerPoint, each page in an FCS Express layout can be modified, saved, printed,
or exported. The layout itself can be set up with different background colors or
images on each page. In addition, a saved layout can be used as a template for
batch processing of selected files, or can be linked to specific data files. When a
linked layout file is reopened, the data files and plots used to create it are
displayed. This feature is useful in documenting clinical cases by providing an
archival record of the analysis, or for recreating any kind of repetitive analysis.

Any object inserted into a layout, whether it is a plot, text box, statistics window,
or graphic, can be manipulated in many different ways. Again, it is helpful to think
of objects on a layout page as if they were objects inserted onto a slide in
PowerPoint. Single or multiple objects can be selected, and once selected, the
object(s) can be formatted, moved, resized, or aligned with one another.
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4.1.1 Creating a New Layout

A new layout can be created by choosing one of the following options:

· Select the New Layout button from the Startup Screen  (Figure 4.1).

· By selecting the File tab New, you can create a new blank layout, or open

a previously created, saved layout template. A list of your previously
created templates will appear in the Recent Templates area of the gallery.
Recent templates may be pinned to the list by clicking on the pushpin icon.

Figure 4.1  Recent Templates

o Templates are very useful for setting up standard document settings,

like margins, page orientation, and page size, or analysis-specific
layout elements such as plots and statistics. A template is any
previously saved layout file that you decide to open as a template. To
create a new document from a template, use the File
tab New New From Existing... command. You can also designate
a saved layout file as your default template . When a default
template is present, FCS Express opens that template file instead of a
blank layout when using the File tab New New command.

o When FCS Express opens a new layout from a stored template, a

new layout identical to the stored template is created. However, the
new layout will contain no data files so the plots will be empty.
Therefore, when you save the new layout, you will be prompted for a
new filename to prevent overwriting the original template.
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4.1.2 Saving a Layout

Layouts can be saved in any of the following ways:

· File tab Save.

· Click the Save Current Layout icon in the Quick Access Toolbar .

· Use the Ctrl+S keyboard shortcut.

Using any of these methods will bring up the Save Layout dialog (Figure 4.2)
where you can name the layout file to be saved and choose the location to save
it.

Figure 4.2  Save Layout Dialog

When saving a layout, you have the option to save with a link, save without a
link, or embed the data files within the saved layout according to the Save as
type drop down option you choose.

• Layout Files (with linked data)(*.fey)

The position and formatting of the objects in the layout will be saved. When
the file is opened, data will appear if the data files are available or have been
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copied to the computer where the layout is being opened. However, if the
linked layout file is opened on a computer without access to the linked data
files, no data will appear in the layout plots or statistics. Linked layout files are
smaller than embedded layout files.

• Layout Files (with embedded data)(*.fey)

The position and formatting of the objects will be saved and a copy of the
actual data files is saved within the layout file. This allows anyone who opens
the layout file to see and analyze the data, without having the original data
file. Although a layout file with embedded data files can be fairly large, it is
actually only about two-thirds of the size of the original data file(s). This
makes layouts with embedded files an ideal way to send data to a
collaborator.
Note:  only .fcs files currently showing on the layout will be saved.  Files
within the Data List but not currently showing on plots will not be included.

• Layout Files (with unlinked data)(*.fey)

The position and formatting of the objects (plots, statistics boxes, as well as
the Data List options, including sorting) will be saved. No data will appear
when the unlinked layout is opened. The file sizes of unlinked layout files are
smaller than linked or embedded layout files.

4.1.3 Opening a Previously Created Layout

A previously saved layout can be opened by using either the File tab Open
command, or the File tab Open From Open command. These commands
bring up the Load Layout dialog.

Recently used documents will appear in the  File tab Recent category (Figure
4.3). To open a recently used document, simply select the document. Note that
recent Places for file locations may be accessed by using the right click menu
and selecting Open file location.  Additional options available on the right click
menu are: Open, Delete file, Copy path to clipboard, Pin from list, Remove
from list. Documents and Places in the Recent category may also be pinned
using the pushpin icons.
Recent item lists can be cleared using the File tab System Restore
Options Clear All Recent Items command.
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Figure 4.3  Recent Documents Appear on the Right

Navigate to the file you wish to open in the Load Layout dialog. Once a layout
file has been highlighted, the Layout Information at the bottom of the dialog
box displays the number of pages, the number of histograms, the number of 2D
plots, the Data Link Style , and Layout Version of the selected layout file
(Figure 4.4).

Figure 4.4  Load Layout Dialog
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If the layout you are opening has linked data and FCS Express cannot find these
.fcs file(s), you will be notified in a Select the Data Directory dialog, and will be
given the opportunity to load the file(s) from a different folder (Figure 4.5).

Figure 4.5  Missing Linked Data

4.1.4 Closing Layouts

More than one layout can be open in FCS Express at any time. There are two
methods to close the current layout:

· Activate the layout that you want to close (you can use

View Windows Switch Windows, if necessary) and select File
tab Close. If the only layout that is open is a blank layout which has not
been changed, this will close (Exit) FCS Express.

· If more than one layout file is open, you can click on the  "X" icon in the

upper right of the application window (Figure 4.6).
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Note: If more than one layout is open only the current layout will be closed.
However, if only one layout is open, clicking on the Close Program "x" will
close (Exit) FCS Express.

Figure 4.6  Close icons

· To close all of the open layout files, select the File tab Close All.  A new,

blank layout will be launched after the others are closed.

If any layout has not been saved when you try to close it, you will be prompted
to save it. It is also possible to change your default Save Options  so that the
layout will close without being prompted to save. In this case, all changes will be
discarded without altering the original layout.

4.1.5 Working with Pages

There are several ways to add a new page to a layout. The following three
methods will add a new page after the current page:

· Select Home  Page and choose the kind of page you want to

insert from the ribbon.

· Right-click on the layout and select New Page from the pop-up menu.

· Click on the Add Page tab icon  (Figure 4.7) of the Layout

Navigation Toolbar (near the bottom of the FCS Express application
window on the left).

Figure 4.7  Add Page Tab

To insert a page into the middle of an existing layout, right-click on an existing
labeled Page Tab on the Layout Navigation Toolbar (e.g., "Page 1") and
select Insert from the pop-up menu. This will insert a blank page before the
page you selected. To rearrange pages of a layout, select the tab of a page on
the Layout Navigation Toolbar and drag the tab left or right to the new
location.
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You can rename pages. To do so:

1.  Right-click anywhere on the page (or on the tab associated with the page)
and select Format from the pop-up menu, or double-click on the Page
Tab.

2.  In the Formatting Page dialog that appears, type the new name into the
Name field (located in the Name category).

The visibility of a page can be controlled from the formatting dialog.

1.  Right-click anywhere on the page and select Format from the pop-up
menu.

2.  In the Formatting Page dialog, click on Visibility (Figure 4.8). Using the
radio buttons, visibility can be set to Always visible, Never visible (i.e.,
hidden), or Custom. If you choose Custom, you can insert a token that

evaluates to a Boolean expression  (by clicking on the  button), and
the page will only be visible if the token evaluates to True.

Figure 4.8  Formatting Page Visibility

The default background of a page is the background of the master page . Each
page can have a custom background, however. To change the background of an
individual page:

1.  Right-click anywhere on the page and select Format from the pop-up
menu.

2.  In the Formatting Page dialog, navigate to the Background category
(Figure 4.9).

3.  Click on the Custom radio button.
4.  Choose the Color/Fill Pattern, Gradient, Image, or Transparent.
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Figure 4.9  Changing an Individual Page Background

The color of a page tab may be controlled from the formatting dialog based on a
series of Color Classifications.

1. In the Formatting Page dialog, click on the Color category(Figure 4.10). 
2. Using the Change the color depending on the value of: dialog you can

insert a token that evaluates to a Boolean expression  (by clicking on the 
button), and the color of the page tab will change if the token evaluates to any
of the classifications in the List of Colors section.
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Figure 4.10  Changing the Page tab Color classifiers

3. List of Colors allows you to create a series of classifications for colors by
clicking the Add button in the List of Colors dialog.

4. The Create Classification dialog will open (Figure 4.11) where you can
choose a Color for the page tab if a value, numeric or token based, falls in a
range you define.
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Figure 4.11  Adding a page tab color classifier with Color Token Bounds.

5. The Edit, Remove, Up, and Down commands in the Formatting Color dialog
allow you to adjust the List of Colors and Color Token Bounds as needed.

There are several ways to delete the current page:

· Select Home  Page.

· Right-click on the layout page and select Delete Page from the pop-up

menu.

· Right-click on a Page Tab (e.g., "Page 2") on the Layout Navigation

Toolbar and select Delete from the pop-up menu.

4.1.6 Printing Pages from a Layout

To print a page (or range of pages) from the layout, select the File tab Print
command (Figure 4.12). A standard Print gallery will appear and allow you to
select what you wish to print. The printed pages will look exactly as they appear
within the page borders on the screen.
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Figure 4.12  Print Setup Dialog

The current Printer and Printer Properties may be accessed or changed in the
Printer section. 

The sections under Settings will allow you to:

1.  Choose which layout pages to print (Print All Pages, Print Current Page,
or Custom Range).

2.  Choose to print layout pages as single or multiples per printed page(s).  With
Full Page selected, each layout page will be printed as a single page. Multiple
layout pages may be printed per page using a preset multiple page option (i.e.
3 Pages with Notes or 9 Pages Vertical) or Custom Grid Options .788
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a. To print the layout pages on fewer pages, click the down arrow to the right
to expand the dropdown list and select a multiple page option or Custom
Grid Options... to select a preset multiple page option or customize the
tiling, respectively.  When selecting Custom Grid Options, the Custom
Grid popup window will appear (Figure 4.13).

Figure 4.13 Custom Grid Options of Print Setup from File tab

b. Frame Page. Check this option to draw a frame around layout pages.

c. Scale To Fit. Will be automatically checked.  Only uncheck if it is preferred
the content from the layout page is not scaled for the paper selected for
printing.

3. Choose to print on one side or both sides of the paper.

4. Choose collated or uncollated.

5. Choose to print in color or grayscale.

4.1.7 Exporting a Page as a Picture from a Layout

A page can be exported as a picture by selecting the File tab
Current Page As... command.
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The picture can be exported as a Windows Metafile (*.emf), JPEG (*.jpg),
Bitmap (*.bmp), Windows Extended Metafile (*.emf), Portable Network Graphics
(*.png), GIF (*.gif), or TIFF (*.tif).

4.1.8 Exporting a Layout as a PowerPoint® Presentation

A layout can be directly exported as a Microsoft PowerPoint® presentation. All
plots and text boxes are inserted into the PowerPoint presentation as Windows
Metafiles and can be moved, resized, and manipulated independently within
PowerPoint. 
 

To save as a PowerPoint presentation, select the File tab  as
PowerPoint Presentation... command.

The Save as Microsoft PowerPoint Presentation dialog that appears allows
for the options described below:

· PowerPoint Options

o Presentation Filename. Use this field to select the output folder and

the name of the output file. If only the output file name is defined, with
no output folder, the resulting PowerPoint will be saved into the
Documents folder.

o Include the background (from Master Slide). Check this option to

include the background from Master Slide. If you choose to export the
background, the objects on the FCS Express Master Page will be placed
on the PowerPoint master slide. These background objects will then
appear on all of the PowerPoint slides.

o Open presentation after saving. When checked, the PowerPoint

presentation will automatically open at the end of the export procedure
by launching PowerPoint.

o Hide objects that are off the page. When checked, objects that are

not located on the white page in the layout will not be exported to
PowerPoint.

o If the presentation already exists, append to it. Check this option to

append slides to an existing PowerPoint presentation.

· Export Options
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o Quality. Set the PowerPoint quality (High, Medium, Low, On-Screen)

from the drop down list. 

o Mode. This option enables single or multiple layout pages to be exported

per slide based on selection. When Full Page is selected, each layout
page will be exported as a slide. Multiple layout pages may be exported
per slide using a preset multiple page option (i.e. 3 Pages with Notes or
9 Pages Vertical) or Custom Grid Options . To export the layout
pages on fewer slides, please select a preset multiple page option or
Custom Grid by clicking the down arrow to the right to expand the drop
down list and selecting a multiple page option or Custom Grid
Options..., respectively.  When selecting Custom Grid Options, the
Custom Grid pop up window will appear, which will contain following five
settings: 

o Frame Page. Check this option to draw a frame around pages.

o Crop To Content. Available when Mode is not set to Full Page. When

selected, empty space of the layout page(s) is cropped during the
export.

· Page Range

Choose which layout pages you wish to export.

Comparison of exports to PowerPoint using multiple page preset 4 Pages
Horizontal with or without selecting Frame Page and Crop to Content (Figure
4.14).

788



Layouts 107

© 2023 De Novo Software

Figure 4.14 Comparison of exports to PowerPoint using preset 4 Pages Horizontal.
Left: Frame Page and Crop To Content unchecked. Right: Frame Page and Crop To

Content checked 

Note about ungrouping objects in PowerPoint for PC versus PowerPoint
for Mac

Once exported to PowerPoint, layout objects can be further ungrouped into
single components in the PC version of Microsoft PowerPoint. Ungrouping
objects saved by FCS Express in PowerPoint for Mac is not supported. However,
presentations saved on a Mac may be opened on a PC and ungrouped. 

4.1.9 Exporting a Layout as a PDF File

A layout can be directly exported as an Adobe PDF file.

To save as a PDF file, select the File tab  as PDF File...
command.

The Save Layout as PDF File dialog that appears allows for different options:

· PDF Filename
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o Use this field to select the output folder and the name of the output file.

If only the output file name is defined, with no output folder, the resulting
PDF will be saved into the Documents folder.

o Open presentation after saving. When checked, the PDF file will

automatically open at the end of the export procedure.

· PDF Options

Embed fonts (will increase file size). This option ensures that all of the
font information used to make your document look the way it does is
stored in the PDF file.

· Export options

o Quality. Set the PDF quality (High, Medium, Low, On-Screen) from

the dropdown list. Higher quality documents will have better graphics, but
larger file sizes. PDF quality primarily affects the look of statistics
windows and gate views.

o Mode. This option enables single or multiple layout pages to be exported

per PDF page based on selection. When Full Page is selected, each
layout page will be exported as a PDF page. Multiple layout pages may
be exported per PDF page using a preset multiple page option (i.e. 3
Pages with Notes or 9 Pages Vertical) or Custom Grid Options .
To export the layout pages on fewer PDF pages, please select a preset
multiple page option or Custom Grid by clicking the down arrow to the
right to expand the dropdown list and selecting a multiple page option or
Custom Grid Options..., respectively.  When selecting Custom Grid
Options, the Custom Grid popup window will appear.

o Frame Page. Check this option to draw a frame around pages.

o Crop To Content. Available when Mode is not set to Full Page. When

selected, empty space of the layout page(s) is cropped during the
export.

· Page Range

Choose which layout pages you wish to export.

Comparison of exports to PDF using default Custom Grid Options with or
without selecting Frame Page and Crop to Content (Figure 4.15).

788



Layouts 109

© 2023 De Novo Software

Figure 4.15 Comparison of exports to PDF using default Custom Grid Options (top
row only displayed). Left: Frame Page and Crop To Content checked. Right: Frame

Page and Crop To Content unchecked 

4.1.10 Navigating through the Layout

There are many ways to navigate through the layout:

If the layout is larger than your screen, you can use the vertical scroll bar on the
right, or the mouse wheel, to move to different positions on the current page.

· Press the Page Down key on your keyboard to move to the next page in

the layout.

· Press the Page Up key on your keyboard to go to the previous page in the

layout.

· Right-click on the layout and choose Previous Page or Next Page from

the pop-up menu.

· Use the Layout Navigation Toolbar  (always located at the bottom left

corner of the layout). In the Layout Navigation Toolbar, you can:

o Click on the tab of a named page (e.g., "Page 2").

o Type the desired page number directly into the toolbar edit field.

o Press the arrow buttons located to the left or right of the edit field to go

to the next or previous pages. The buttons with single arrows will move
in single page increments. The buttons with the double arrows will move
to the beginning, or end, of the layout.
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4.1.11 Viewing Pages

In the View Multiple Pages group, there are four commands [One Page, Two
Pages (Horizontal), Two Pages (Vertical), and Four Pages] for displaying
the entire layout in different views (Figure 4.16).

Figure 4.16  Two Pages (Vertical) View

4.1.12 Zooming the Layout

It is possible to change the current zoom factor (in percentages) by using the
Zoom Toolbar  located below the Layout Navigation Toolbar . You can enter
the desired zoom percentage directly into the toolbar edit field on the left or
press the Zoom command (with the magnifying glass icon) to access the Zoom
window. This window allows you to choose from several predefined zoom
factors (or type in a percentage in the edit field).

4.1.13 Auto Recovery Files

FCS Express can automatically create a backup of your layout, known as an
Auto Recovery file. By default, an Auto Recovery file will be created every 5
minutes. As a user option, you can turn off this feature, or change the interval
between auto saves, by editing the Save page of the User Options  dialog. If
FCS Express is terminated suddenly, and before the layout could be saved, then
the next time you start the program, you will be asked if you want to resume
using the Auto Saved file, which will have been given a unique name so as not to
overwrite the previous user-saved file.
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4.1.14 Working with Multiple Layouts

In FCS Express, multiple layouts can be open at the same time. Each layout
opens in its own window. You can drag and drop objects (plots, data files, gates,
etc.) from one layout to another.

Use the View Windows Switch Windows command (and select the
appropriate layout from the drop-down list) to change which layout is active. 

TIP: While transformations are running in one layout, a user can work in another
layout (either a new layout or an existing layout), if either the latter, or the
Welcome screen , was already open at the time the transformation was
started.

4.1.15 Layout and Layout Performance Options

It is possible to access the Layout Options and Layout Performance Options
by selecting the File tab .
If you have security enabled , the Layout Group Security Access  category
will also be available. 

The Layout Options category (Figure 4.17):
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Figure 4.17  Layout Options Dialog

The specific options are described in the table below.

Option Explanation

Layout Options Displays information about the layout.

File Name File path for the layout.

Creator User Name of layout creator. 

Date Created Date layout was created.

Parameters
remembered by

Indicates how parameters were set to be remembered  in the
User Options when the layout was created.  
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Remember the scale
formula for manually
scaled plot
parameters in this
layout

When checked, allows you to remember the scale formula for
manually scaled plot parameters. When the axis scale is changed
to manual  for one specific parameter on a plot, all other plots
will then use the new scaling by default.

Requires Password When checked, allows you to assign a password to open the
layout.
Note: Use caution when deciding to password-protect a layout. If
you forget the password, you will not be able to open the layout.

In this layout, use
the following text for
token errors

Allows you to define which text to use for token errors. Possible
choices are: "#" or "##ERROR##" (both without quotes).

Startup Script Customize the layout startup via the Startup Script  tool.

Compensation
Options

These options allow you to chose how compensation is applied to
the current layout and whether to append or overwrite
compensated parameters.

Suffix for
Compensated Data

When analyzing compensated data, the text typed into this box
will be used as a suffix to describe the compensated data.  This
text can be viewed in the Title  of a plot when using the
keyword $FCSE_FILENAME or $FCSE_FILENAMENOPATH.

Suffix for New
Parameters

When the option to append new compensated parameters to data
after uncompensated parameters has been selected, the text
typed into this box will be used as a suffix to identify the new
compensated parameters from the uncompensated parameters.

New Compensated
Parameters Should

When applying compensation to data, FCS Express allows the new
compensated parameters to overwrite or be appended after the
original uncompensated parameters. Note these options can be
changed from the Compensation Options  in the
Compensation and Unmixing editor as well.

· Overwrite uncompensated parameters. The new
compensated parameters will appear in place of the
uncompensated parameters. No suffix will be used to denote
the new compensated parameters. The uncompensated
parameters will not be available to plot.

· Append to data after uncompensated parameters. The
new compensated parameters will appear after the
uncompensated parameters. The Suffix for New Parameters
will be appended to each new compensated parameter name
to identify the new parameter as having compensation
applied.

Compensation/Unmi
xing to use in this
layouts

Defines which compensation to use when loading files in the
current layout. Select one of the options below. See Selecting the
Default Compensation  for additional details:

· None. No compensation will be used.
· Compensation/Unmixing Default. The

Compensation/Unmixing Default is selected in the
Compensation Info window .

· FCS File. The Compensation used for acquisition will be
taken from the FCS file header.

· FCS file, then Compensation/Unmixing Default. FCS
Express will load Compensation from the FCS file. If there is
no Compensation stored in the FCS file, the

343

115

339

869

911

839



FCS Express 7 Manual114

© 2023 De Novo Software

Compensation/Unmixing Default from the Compensation Info
window will be used.

· Compensation/Unmixing Default, then FCS file. FCS
Express will load the compensation/unmixing default from the
compensations navigator by default. If a default
compensation/unmixing does not exist, the compensation
associated with the FCS file will be used. This is the default
setting in FCS Express.

If you have security enabled , additional properties will be available on the
Layout Options dialog.

The Layout Performance Options category (Figure 4.18) allows you to
choose if live updating of gates, quadrants, markers, statistics and tokens is
controlled at a global User Options  level  or at the Layout Level.
 
Choosing the Specify the value below radio button will allow you to turn the
option to Update Immediately on or off for the current open layout via the
check box. 

Figure 4.18  Layout Performance Options Dialog
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4.1.15.1 Startup Script

The Startup Script tool allows the user to customize the layout every time it is
launched and is particularly useful to adapt standardized layouts to data acquired
on different instruments with different settings for storing the data files. 

Layout customization is performed via a series of questions which appear to the
user as messages on the screen when a script is defined. The layout or plots will
be customized based on the user's answers to the scripted questions.

Possible scripting customizations are:
· Loading a specific file on specific plots and/or on specific overlays

· Change parameters on specific plots and/or on specific overlays

· Change the parameters used for a specific gate

· Change the template file for a transformation

· Replace or Add parameters to an existing transformation

The questions, and the corresponding actions, are defined via an XML script. 

If you are interested in using the scripting features in FCS Express, please contact
support@denovosoftware.com for additional information. 

4.2 Introduction to Docking

FCS Express has a flexible user interface. Dockable windows give you the ability
to customize your analysis workspace to fit your needs.

The following windows are dockable:

· Data List

· Layout Navigator

· Data Navigator

· Gate Navigator

· Compensations

· Snapshots

· Batch Actions

· Batch Run 

· Transformations

· Standard Operating Procedures

· Standard Operation Procedures Run

· Permission Rules

· Custom Tokens

· Formatting Dialog

mailto:support@denovosoftware.com
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The remaining sections of this chapter explain how to work with dockable
windows.

4.2.1 Opening a Dockable Window

Dockable windows are opened by clicking on the appropriate Ribbon
commands from the Batch Tab , the Data Tab , or the View Tab .

The commands to open the dockable windows are listed in the table below.

Dockable Window Command

Data List Data Organize Date Sets Data List or Batch Organize Date
Sets Data List

Snapshots Tools

Layout Navigator View Navigators Layout Navigator

Data Navigator View Navigators  Navigator

Gate Navigator View Navigators  Navigator

Compensations
Navigator

Tools Transformations Compensations

Formatting Dialog Format

Transformations
Navigator

Tools Transformations Transformations

Batch Actions Batch

Standard
Operating
Procedures

View

Permission Rules Quality

Custom Tokens View s

When opened, the window will first appear as a floating window, undocked, in the
center of the screen (Figure 4.19). You can leave it as a floating window, or
proceed to dock it in the location of your choice .
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Figure 4.19  Data Navigator, Floating (Undocked)

4.2.2 Docking a Window

To dock a floating window:

· Move the cursor over the title bar of the window (Figure 4.20).
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Figure 4.20  Title Bar of Floating Window

· Press and hold the mouse button over the title bar while beginning to drag

the window. Docking Zone Selectors (a group of rectangles with
arrowheads designating the upper, lower, left, and right docking zones, and
a central square) will appear on the screen (Figure 4.21).

Figure 4.21  Docking Zone Selectors
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· While keeping the mouse button down, drag the cursor over the appropriate

zone selector. Not all of the docking zone selectors may be active at all
times. When you position the cursor over an active docking zone selector, a
blue outline appears over the zone location (and a label confirms the
location). In the example (Figure 4.22), the cursor has been positioned over
the right docking zone selector. Notice the blue rectangle over the entire
right half of the screen indicating where the window will be docked (to
better illustrate the label in the lower right corner, it has been slightly
repositioned from where it will appear on your screen).
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Figure 4.22  Cursor Positioned over Right Docking Zone Selector

· When you release the button with the cursor positioned over a docking

selector, the window will dock to the location you selected (Figure 4.23).
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Figure 4.23  Data Navigator Window Docked to the Right

· If a window is already docked, and you are docking a second window,

docking zone selectors will appear in the middle of the screen and over the
docked window (Figure 4.24). In the example, the Layout Navigator is
being docked inside the already docked Data Navigator. If you dock one
window inside another, the two windows will occupy the same location, but
will be identified by tabs (Figure 4.25). If you dock two windows in the
same location but not inside each other, they will be separated by horizontal
or vertical splitter bars (Figure 4.26).
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Figure 4.24  Docking the Layout Navigator inside the Data Navigator

Figure 4.25  Docked Windows Identified by Tabs
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Figure 4.26  Docked Windows Seperated by a
Horizontal Splitter Bar

Note: Although docked windows are not part of the layout page and will not be
exported to other file formats, their location is saved along with your layout, and
they will be present when you re-open the layout.

4.2.3 Pinning a Docked Window

A docked window has a number of icons in the title bar. The pin icon (Figure
4.27) controls the Auto Hide feature.

Figure 4.27  Auto Hide Pin Icon in a Docked
Window

When the pin is pointing down, it indicates that the docked window is in the
standard configuration (unpinned). If you click on the pin icon, the Auto Hide
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property will be activated. The pin will turn to the left and a tab with the window
name will appear on the edge of the screen (Figure 4.28).

Figure 4.28  Docked Window with Auto
Hide Activated

With Auto Hide activated, the window will remain open whenever the cursor is
over the window. If you move the cursor away (or click on a different part of the
screen) the window will slide towards the edge of the screen and only the tab will
be visible (Figure 4.29). When a window is pinned, you can also hide it by clicking
on the X icon beside the pin. To open a hidden window, hover the cursor over
the tab.

Figure 4.29 
Pinned Data
Navigator

Hidden from
View

Note: A window that has been pinned cannot be undocked  or closed  until it
has been unpinned (i.e., Auto Hide has been turned off). To unpin the window,
make the window visible, and then click on the pin icon.

4.2.4 Undocking a Window

Note: A pinned window cannot be undocked until it is unpinned .

To undock an unpinned window:

· Move the cursor over the title bar  of the window.
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· While holding down the mouse button on the title bar, drag the window

away from its docked position.

4.2.5 Closing a Dockable Window

Note: A pinned window can be hidden on the edge of the screen, but cannot be
closed until it has been unpinned .

To close an unpinned, dockable window, click on the X icon on the right side of
the title bar.

4.3 Navigators

Navigators in FCS Express are dockable windows  with drag and drop
functionality to help you find and manipulate the objects in your layout , the
data sources  connected to your objects, and the gates  on your plots.

· Layout Navigator

· Data Navigator

· Gate Navigator

· Notes

4.3.1 Layout Navigator

The Layout Navigator shows a hierarchical view of all of the objects in your
layout by page. Within each page node, plots and other objects are listed with
their data source (Figure 4.30).
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Figure 4.30  Layout Navigator

The first level of the hierarchy in the Layout Navigator is the page number. The
second level is the objects on your page, such as plots, gate views, text boxes,
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and data grids. If the object contains data (e.g., a plot or data grid), the data set
is shown, as well as an indication of whether or not the data is gated.

If you select an object on your layout, the corresponding node in the Data
Navigator will be highlighted. Hovering the mouse cursor over an object in the
docked  Data Navigator displays a thumbnail view of the object. In a layout
with more than one page, clicking on a node in the Data Navigator will change
the visible layout page to the page where the corresponding object is located.

Click on a node to expand it. While holding the mouse button down, drag an
object (e.g., a plot title) stemming from the node to your layout and release the
mouse button. The results of drag and drop operations from the Layout
Navigator are described in the table below.

Drag and Drop Operation from
Layout Navigator

Function

Drag (or Copy & Paste, or Cut
& Paste) an object to an empty
part of the layout.

Moves the object to the new location. When Copy is
used, a copy of the object is created in the new location.

Drag an object onto an existing
object in the layout.

Adds the appropriate data to the existing object. You may
be prompted to choose special paste format options.

Drag (or Copy & Paste) a data
set to an empty part of the
layout.

Brings up the Select plot types...  dialog to open plot(s)
using this data set.

Drag (or Copy & Paste) a data
set to an existing plot.

Adds data to the plot. You will be prompted whether to
replace the existing data or add it as a new overlay. 

Drag a gate to a plot. Applies the gate to the plot.

Copy a gate and paste it on a
plot.

If the plot is an Histogram (i.e. 1D plot), the gate will be
applied to all the overlays on that histogram. If the plto is
a 2D plot, you will be prompted about creating a new gate
on the target plot.

Drag a plot to a text box. Prompts you to create a keyword or statistics token from
that plot in the text box.

Within the navigator, drag (or
Copy & Paste, or Cut & Paste)
an object onto another Page.

Moves the object to the new location without losing
token references. If Cut is used, the original object will be
removed. Note that token references are lost when using
cut and paste.

Within the navigator, drag and
drop a page into a new
position.

Reorder layout pages.

Within the navigator, copy a
page and past it into a new
position.

A copy of the page will be created into the new position.

Delete. This applies to either gates, pages and objects.
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4.3.2 Data Navigator

The Data Navigator shows a hierarchical view of all of the data currently
showing on your layout.  Within each data node, plots and other data grids
displaying the data are shown. (Figure 4.31).  

Figure 4.31  Data Navigator

The first level of hierarchy in the Data Navigator represents the data set nodes.
The second level is the plots and/or data grids associated with the data sets.
Hovering the mouse cursor over a plot or data grid in a docked  Data
Navigator window displays a thumbnail view of the object.

Click on a node to expand it. While holding the mouse button down, drag and
object stemming from the node to your layout and release the mouse button.
The results of drag and drop operations from the Data Navigator are described in
the table below.

In FCS Express, plots can be renamed directly in the Data Navigator by right-
clicking plot title clicking Rename (Figure 4.32).  Plot names can still be edited
using command, via the ribbon bar, or by right clicking on the
plot of interest and updating Name field.

115
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Figure 4.32 - Renaming Plot in Data Navigator

Drag and Drop Operation from
Data Navigator

Function

Drag a data set to an existing
plot in the layout (or to a plot
within the Data Navigator)

Adds data to the plot. You will be prompted whether to
replace the existing data or add it as a new overlay. If
the target plot does not support overlays, the dragged
data set be loaded in the target plot.

Drag a plot to an existing plot in
the layout (or to a plot within
the Data Navigator)

Adds data to the plot. If the target plot supports
overlays, the action brings up a Paste Special dialog to
insert data or overlays. If the target plot does not
support overlays, the data loaded in the dragged plot will
be loaded in the target plot.

Drag (or Copy & Paste) a data
set to an empty part of the
layout

Brings up the Select plot types...  dialog to open
plot(s) using this data set.

Drag (or Copy & Paste, or Cut &
Paste) an object to an empty
part of the layout

Opens a copy of the object the object in the new
location. When Cut is used, the original object is
removed.

Drag an object onto an existing
object in the layout

Adds the appropriate data to the existing object. You will
be prompted to choose special paste format options.

Cut (or Copy) a plot (from the
layout or from the data
navigator) and paste it on a
data set within the Data
Navigator

The data set loaded into the cut (copied) plot will be
loaded into all the objects currently loading the target
data set. When Cut is used, the cut plot is removed from
the Data Navigator. 

Drag a plot (from the layout or
from the data navigator) and
drop it on a data set into the
Data Navigator.

The data set loaded into the dragged plot will replace the
target data set.
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Drag and Drop Operation from
Data Navigator

Function

Cut (or Copy) a plot (from the
layout or from the data
navigator) and paste it on a
plot within the Data Navigator
(or on a plot in Edit mode within
the layout)

Adds data to the plot. If the target plot supports
overlays, the action brings up a Paste Special dialog to
insert data or overlays. If the target plot does not
support overlays, the data loaded in the dragged plot will
be loaded in the target plot. When Cut is used, the cut
plot is removed from the Data Navigator. 

Copy a data set and paste it on
a plot within the Data Navigator
(or on a plot in Edit mode within
the layout)

Adds data to the plot. If the target plot supports
overlays, the action brings up a Paste Special dialog to
insert data or overlays. If the target plot does not
support overlays, the data loaded in the dragged plot will
be loaded in the target plot.

Copy a data set and paste it on
another data set

The copied data set will be loaded into all the objects
currently loading the target data set. 

4.3.3 Gate Navigator

The Gate Navigator (Figure 4.33) shows a hierarchical view of the gates that
have been defined in your layout. The Gate Navigator opens by default pinned on
the bottom left side of the screen when new layouts are created. The default
setting for viewing and pinning the Gate Navigator can be modified in the Gates
category of the User Options . 

Using the Gate Navigator it is possible to achieve many of the same actions as
you can with the Gate View  such as:
· edit gate properties (gate name, gate color, emphasis,...)

· change hierarchies by using drag&drop

· apply gates to plots in the layout via drag&drop

· right-click menu options (Format, Add Combination Gates, Exporting to

GatingML, Link Gates, Expand/Collapse the hierarchy,Copy/Cut/Paste...)

For more details on how to perform the actions above, please refer to the Gate
View  chapter.

The difference being whilst the Gate View is an insertable object that be inserted
into the layout for printing or reporting, the Gate Navigator is a separate
dockable window . 
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Figure 4.33 Gate Navigator

There are three buttons along the top of the Gate Navigator which allow you to
customize the information displayed: 

·  Hide/Show the plots gated on each gate allows the information on plots

gated on each gate to be hidden/viewed.

It is also possible to change plot names this area. For plots, the name
property is the name of the plot to display in lists (
options ). This is used wherever the user is required to select a plot or
whenever displaying objects in different Navigators .
For convenience, hovering the mouse cursor over a plot in the docked
 Gate Navigator window, displays a thumbnail view of the plot.

·  Hide/Show Information about data-specific gates allows information

on data-specific gates and data-specific gate groups to be hidden/viewed.
For more details, please refer to the Data Specific Gates  and Data Specific
Gate Groups  chapters.

·  Hide/Show the root gate allows the root gate (named by default "No

Gate", but editable) to be hidden/viewed.
When a new layout is created, the option is defaulted to display the root gate
but the setting can be modified in the Gates category of the User Options
along with additional related options.  
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Drag and drop capability with the Gate Navigator

Click on a node to select it. While holding the mouse button down, drag the
node to your layout and release the mouse button. The results of drag and
drop operations are described in the table below.

Drag and Drop Operation Function

Drag a gate to a plot in the
layout (or to a plot within
the Gate Navigator).

Applies the gate to the plot.

Drag (or Copy & Paste, or
Cut & Paste) a plot (in the
layout or within the Gate
navigator) onto a gate of
the Gate Navigator.

The target gate will be made Data Specific for the
dragged data. If Cut is used, the cut plot will be
removed.

Drag (or Copy & Paste, or
Cut & Paste) a plot to an
empty part of the layout.

A copy of the plot will be created in the new location.
If Cut is used, the cut plot is removed.

Drag  a plot onto a plot in
the layout (or to a plot
within the Gate Navigator)

Adds the appropriate data to the existing object. If the
target plot supports overlays, the action brings up a
Paste Special dialog to insert data or overlays. If the
target plot does not support overlays, the data loaded
in the dragged plot is loaded in the target plot.

Copy and Paste (or Cut and
Paste) a plot from the Gate
Navigator onto a plot in Edit
mode within the layout

Adds data to the plot. If the target plot supports
overlays, the action brings up a Paste Special dialog
to insert data or overlays. If the target plot does not
support overlays, the data loaded in the dragged plot
will be loaded in the target plot. When Cut is used, the
cut plot is removed from the Data Navigator.

Drag and drop a gate to a
different position within the
Gate Navigator

The gate is moved into the new position in the
hierarchy. 

Gate Navigator Formatting Options

The Gate navigator window can be formatted in order to display or not display
plots on which those gates have been applied as well as data files the Data
Specific Gates are applied to. 

To format the Gate Navigator:
1. Right click on any empty part of the Gate Navigator window.
2. Select Format from the right-click menu. A Format Navigator Options
window with the following options will open (Figure 4.34):

Gate Navigator Options
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§ Show gated plots. Check the option to display the specific plots on
which gates have been applied.

§ Show data specific gates. Check the option to display any Data Specific
Gates  which have been created.

§ Show all cells root gate in the gates hierarchy. Check the option to
show the No Gate root gate in the hierarchy.

Figure 4.34  Gate Navigator Options

Display Gates Options
The Gates to Display formatting options in the Gate Navigator allows users
to choose which gates to show within the Gate Navigator. 

By default, the All Gates option is selected. However, you can select Only the
gates checked below and then select the gates you wish to display.
Alternatively, select All gates except those checked below and then choose
the gates you do not wish to display.

A right-click menu is available within the Gate to Display dialog as displayed in
Figure 4.35 below. The right click menu allows users to:

§ Expand/collapse All gates
§ Expand/Collapse All Children gates within the selected gate
§ Expand/Collapse Current Level (this expand only the first level of

children gates within the selected gate)
§ Check/Uncheck All gates
§ Check/Uncheck All Children gates within the selected gate
§ Invert Selection on All gates
§ Invert Selection on All Children gates within the selected gate

When the option Only the gates checked below is checked, the Yes option
will be the default selection for When a new gate is created on the layout,
should it be included in this Gate View?  However, you can change this
setting if preferred.

711
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Figure 4.35  Display Gates Option in the Gate Navigator

4.3.4 Notes

The Note Navigator allows the user to create, modify and review any notes
attached to objects within the layout and is a dockable window.

The user can create a note for any object.  To create a note open the Note
Navigator, select the desired object and then enter the note in the field beneath
the object number and description of the object.

All objects can have an associated note. For example, in Figure 4.36) the Note
Navigator is ready to be populated with a note for Page 1. 
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Figure 4.36  Note Navigator

The single arrow or double arrow icons can be used to move through the notes.
 The object that is associated with the note will be highlighted when the note is
being viewed.  Notes can include tokens , hyperlinks , and pictures (Figure
4.37).  Text within a note can also be formatted via the Text tab .

1284 66
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Figure 4.37  Objects are highlighted when reviewing the associated note.

4.4 Layout Page Features

Individual objects in FCS Express can be manipulated almost identically to objects
in Microsoft PowerPoint®. Not only can individual objects be stretched, resized,
and formatted, but any item on the layout can be aligned with respect to any
other item. Multiple items can be selected at once and actions can be performed
on all the selected items. Every item that can be inserted onto a Layout Page in
FCS Express has a formatting menu associated with it. To access the formatting
dialog for any object, hover the cursor over the object and right-click. When the
formatting menu appears, select the desired function.

4.4.1 Inserting Items onto a Page

Use the Insert Tab  to insert objects on the current layout page. The objects
you can insert are located in five groups:

· General

Shapes (Line, Arrow, Ellipse, Rectangle), Text Box, Gate View,
Picture, Data Grid
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· Spreadsheet

New spreadsheet

· 1D Plots

Histogram, Kinetics, Multicycle DNA, Proliferation, Bar, Pie

· 2D Plots

Dot, Density, Color Dot, Contour, Surface, Picture Plot, Scatter,
Scatter with Regression

· Other Plots

Heat Map

To insert an object on the layout page in the default size:

1.  Click on the command within the group.

2.  Position your cursor at the point on the layout page where you would like
the upper left corner of the object to be.

3.  Click on the layout page and FCS Express will position your object there.

To insert an object on the layout page in a custom size:

1.  Click on the command within the group.

2.  Drag a sizing rectangle on the layout while holding down the mouse
button.

3.  Release the mouse. The object will be inserted into the sizing rectangle.

4.4.2 Selecting Items on a Page

To work effectively with objects/items in FCS Express, you must understand the
difference between edit mode and selected mode. 

In order for an object to be manipulated, the object must first be selected. A red
border surrounding the object denotes that it is selected. Only selected items can
be moved, resized, deleted, etc.
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In order to edit items within an object, the object must first be in edit mode. For
example, to modify a gate, the plot containing the gate must be in edit mode.
When an item is in edit mode, it displays a green border.

Figure 4.38 shows one item in selected mode and one item in edit mode.

Figure 4.38  Selected and Edit
Modes

Many items can be selected at the same time, but only one item can be in edit
mode at one time.

To put an object into edit mode, click anywhere within the interior of the object.
A green border will appear around the object signifying that it is in edit mode. If
an object is in edit mode, but does not contain any items that can be selected,
the object will behave as if it is in selected mode. For more information on editing
items contained within a plot, refer to the following sections: Adding a Text Box
to a Plot , Using Gates , and Using Markers . 

To put a single item into selected mode, move the cursor over the border of the

item. The cursor will change to a 4-headed arrow . Click the border once. A
red border will be displayed around the item indicating that the item has been
selected. Alternatively, you can put an item directly into selected mode by
holding down the Shift key while clicking anywhere on the item.

There are two methods for selecting multiple specific items at the same time.
The first method uses a click and drag feature (Figure 4.39). If the items for
selection are located near one another on a page, draw a rectangle around all of
the items to be selected. Press and hold down the mouse button at the top left
of where you want the rectangle to be, then drag the cursor down and to the
right. The point that you release the button will be the bottom right corner of the
rectangle. All items inside this area will now be selected (so that they may be
manipulated together).

388 699 750
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Figure 4.39  Selecting Multiple Objects with Click and Drag

The second method of selecting multiple specific items is useful when the items
are not located in close proximity to one another. Once the first item has been
selected as a single item, place the cursor anywhere over the next item you wish
to select. Press and hold the Shift key while clicking. The second item should
now have a red border. Continue the Shift-Click selection process for each
additional item you wish to select. Once multiple objects have been selected,
they can be copied, cut, resized, moved, and aligned simultaneously as explained
in the sections below.

If you want to select all of the items on the current page, use
Home . Alternately, press Ctrl+A.

Clicking outside the selected item(s) will deselect them and put them in a neutral
state (no red or green border).

4.4.3 Overlaying Items on a Page

In addition to the edit and selected modes, FCS Express 7 introduces a third
mode called overlay.  When an object is in Overlay Mode, it is outlined in blue
(Figure 4.40).
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Figure 4.40 - Histogram in Overlay Mode

Dragging and dropping selected data file(s) from the Data List onto the following
plots, will activate overlay mode and prompt the Select Drag and Drop Action
window upon mouse release:
Histogram, Kinetics, Multicycle DNA, Proliferation, Scatter, Scatter with
Regression, Bar Chart, Pie Chart, Dot, Color Dot, Heat Map

Dragging and dropping selected data file(s) from the Data List onto the following
plots, will activate overlay mode and replace data upon mouse release:
2D Plots - Contour, Density, Surface

Dragging and dropping Gates, Markers, or Quadrants onto plots will activate
overlay mode and be applied upon mouse release.

Dragging and dropping plots onto Text boxes will activate overlay mode and
prompt Paste Special window to select Keyword or Statistic Token.

4.4.4 Grouping Items on a Page

Individual objects on a page can be grouped together. After grouping items, all
objects in the group will be selected if any one item in the group is selected.

This can be useful, for example, if several objects are in a specific relative
location to each other and you want to make sure that you cannot move one
without moving all of the others. Since when objects are grouped, selecting any
one of them will select all of them, the move operation will be applied to all the
selected objects together.
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In order to create a group, select the objects you want to group as described
under Selecting Items on a Page , then, either:

· Select the Group command from the Home  gallery, or

· Right-click when the cursor is within one of the selected objects and choose

 from the pop-up menu.

To ungroup objects, use either of the following methods:

· Select the UnGroup command from the Home  gallery,

or

· Right-click when the cursor is within one of the selected objects and choose

 from the pop-up menu.

4.4.5 Cutting, Copying, Deleting, Duplicating, and Pasting Items on
Pages

After selecting one or more objects as described under Selecting Items on a
Page , use the Home  commands or Ctrl+X (cut) or Ctrl+C
(copy) on your keyboard to perform standard word processing functions (e.g.,
Cut, Copy). Objects that have been copied to the clipboard with these functions
can be pasted onto different pages or even onto a different layout using the
Home Paste command, or Ctrl+V on your keyboard.

To delete an object, select it and use the Home  command (or
press the Delete key on your keyboard).

The Home  command duplicates the selected item(s). A
copy and paste function will be performed at the same time. By clicking on the
down arrow associated with Duplicate, the command expands to reveal five
items: Duplicate, Duplicate and Next, Duplicate and Prev(ious), Multiple
Duplicate and Next, and Multiple Duplicate and Prev(ious).

The Next and Prev functions associated with these commands duplicate the
selected object(s) and change to the next or previous file in your data list. The
Multiple commands allow you to make more than one copy of the selected
item(s). The default positioning of the duplicated objects can be set in user
options .

Note: In FCS Express, objects and text can be copied into another application
simply using the copy and paste functions, without loss of formatting
information. Text boxes, statistics tables, compensations, and other items in
tabular format can be copied from FCS Express and pasted into spreadsheet
software such as Microsoft Excel in the same format. 
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4.4.6 Moving Objects

In order to move an object, or group of objects, they must be in selected mode
(as described under Selecting Items on a Page ).

To move selected object(s), position the cursor on the "moving region" of the
selected object, i.e., the red border surrounding the object. Note: With some
objects, such as pictures, the "moving region" is the entire object. Once the

cursor is above the moving region, it changes to a four-headed arrow . When
the four-headed arrow appears, hold down the mouse button and move the
selected object(s) to the desired location. After the object is in place, release the
mouse button.

You can also move selected objects using the keyboard. When the objects are
selected, pressing the arrow keys will move items up, down, left, or right.
Holding down the Shift key when pressing the arrow keys will move the selected
objects in finer increments.

4.4.7 Resizing Objects

To resize selected object(s), position the cursor over the one of the corners of a
selected object until the cursor becomes a two-headed arrow. When the two-
headed arrow cursor is present, hold down the mouse button while moving the
cursor to resize the object. Release the mouse button once the item has
reached the desired size. If you hold down SHIFT while resizing, the aspect ratio
(height vs. width) of the selected object(s) will be maintained.

The Format tab command opens a dialog window where the desired size
can be specified by height X width, or scale (percent).

A convenient way to resize several objects to the same size is using the Align
tool .  

4.4.8 Aligning Objects

The sides, tops, bottoms, centers, heights and/or widths of objects can be easily
aligned.

To align multiple items, first select the objects you wish to align, and then go to
Home or Align. This will bring a list of the alignment tools
that can be used to align your selected objects. (Figure 4.41).

Clicking on Align, under the Position Objects section, will open the Alignment
dialog window, as seen in Figure 4.

Note: The Distribute Equally item in the Align dialog ensures that there is an
equal distance, horizontally or vertically, between all the selected objects.
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Figure 4.41  Align Menu

Objects are aligned with respect to the first item selected. For example, if you
select several items, use the Home  command, the
tops of all the items will be placed in the same position as the first selected item.
An example of objects whose horizontal centers were aligned is shown in Figure
4.42.

Figure 4.42 - Before Alignment (left); After Alignment of Tops (right)

To make multiple objects the same size:

1.  Select the object(s) you wish to resize.
2.  Ctrl + Click on the objects to be re-sized.
3.  Use both Home Editing Align Align Widths and

Home Editing Align Align Heights commands. All objects will  be re-
sized to the dimensions of the first object you selected.
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4.4.9 Ordering Objects

You can also control which object(s) are on top of other objects. This is very
useful when objects overlap each other in the layout and you wish to determine
which is on top. To change the order of selected object(s), choose
Home  and then select a command from the list in the Order
Objects portion of the gallery (or right-click on selected object(s) and choose a
menu item under Order).

The commands function as follows:

• Bring to Front

Brings the selected object(s) to the front of all overlapping objects.

• Send to Back

Sends the selected object(s) all the way to the back of all other
overlapping objects.

• Bring Forward

Brings the selected object(s) one level towards the top of all other
overlapping objects.

• Send Backward

Sends the selected object one level towards the back of all the other
overlapping objects.

Figure 4.43 demonstrates the results when you rearrange the order of the red
circle and the green rectangle.
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Figure 4.43  Ordering Objects

4.4.10 Page Layout Using Predefined Placeholders

Using the Design  command or Home
Page command, you can select and apply predefined layouts to the current page
(Figure 4.44).

Figure 4.44  Layouts Using Predefined Placeholders from Design tab (left) or Home
tab (right)

To most efficiently use this tool, look for a predefined layout containing objects
similar to the layout you would like to create. By selecting a predefined layout,
the current page is populated with placeholders. Now you can easily insert plots,
text boxes, and pictures into the Placeholders with a simple mouse click. The
placeholders behave similarly to any other object and can be moved, resized,
copied to the clipboard, and aligned. An example plot placeholder is shown in
Figure 4.45.
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Figure 4.45  An Example Plot Placeholder

4.5 Using the Master Page

The Master Page is always present in a layout and therefore does not need to be
created. Anything inserted onto the Master Page will appear by default as the
background of all pages of a layout. For example, a Text Box containing the
current date, time, and page number inserted onto the Master Page will
automatically appear on all of the pages in the layout. However, you can choose
on an individual page basis , whether or not the master page appears as the
background of that page.

To view the Master Page, select the View  command
(Figure 4.46).

Figure 4.46 - Master Page
from Ribbon

The default background that will appear on all the pages can be edited on the
Master Page as described in Changing Background Color and Design .

4.5.1 Changing Background Color and Design

To change the background of the Master Page, open the Master Page as
described in Using the Master Page , right-click anywhere on the master page,
and choose Format from the pop-up menu. When the Formatting Master
Page dialog appears, choose Background from the category at left (Figure
4.47).
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Figure 4.47  Formatting Master Page Background Screen

The Master Page default setting for background is white as a solid color. You
may choose another solid color, a color gradient, or an image for the
background. If you select an image, you will be able to stretch it over the entire
page or center it on the page.

A page with a thin black shadow will always appear around the border of the
page, unless you choose the Transparent radio button on the Format Master
Page dialog. Having a transparent page is useful if you simply want to analyze
some data and do not care about the specific layout on the page.

4.6 Using Templates

Templates allow you to set up a default look and feel for your experiment. For
instance, if you like a certain paper size, or certain margins, or wish to include
your company logo on every layout, you can do so by creating a template.

A template is nothing more than an FCS Express layout that is set up the way
that you want, providing the user with the opportunity to use a previously
created layout as a starting point for a new analysis layout. Otherwise, it is just
like any other layout. FCS Express remembers the layout as a template when
you select it using the File Tab New Layout New From Existing
command/gallery. Clicking on New From Existing will bring up a Create New
Layout from Template dialog where you can choose any existing layout. If you
have previously created one or more templates, you can also choose one from
the Recent Documents or Places area of the gallery .93
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When the new layout is opened, it will look identical to the template layout.
However it will "forget" that it came from the template, and when you save the
new layout for the first time, FCS Express will prompt you to select a new file
name.

You can also set a "default template" for use when any new layout is opened. If
a default template has been set, selecting the File Tab New Layout command
will bring up the default template instead of a blank layout. Setting the default
template is described in the section on Default Files/Directories .1637
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5 Plots and Other Objects

FCS Express allows you to create your analysis layout similar to the way you
would create a PowerPoint presentation. Objects are inserted in the layout using
the Insert Tab  of the ribbon bar and can be formatted in almost every
aspect .

Objects in FCS Express include:

Plots
1D Plots, 2D Plots, Heat Maps and Picture Plots can be used to display and
analyze data.

Pictures
Can be used to personalize your layout with logos and images. 

Text Boxes
Can be used to add text in any part of the layout.

Gate View
Together with the Gate Navigator, this object allows you to display, edit, and
manage all gates.

Data Grid
Can be used to display the raw data in a table with parameter in columns and
events in rows.

Spreadsheet and Charts
The integrated Spreadsheet, together with Charts, can be used to perform
further calculations on the statistics generated by analyzing your data.

Multi Plot
Can be used to open multiple plots at the same time, displaying different
combination of the available parameters. E.g. a single parameter versus all
others, or an NxN matrix of plots displaying all the combinations between all
parameters.

FCS Express assigns a unique name and number to each object (ie, plots, text
boxes, gate views, etc). The default name, if not modified by the user, includes a
unique numerical Id and a short description of the object.

Object names can be used to easily discriminate objects within the layout. The
object name also assists in selecting the data source  when inserting a token
on your layout or in setting up batch processing actions . Object names may
be customize via the General  formatting dialog.
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Two common places where object names are displayed:
§ Navigators
§ Hover over hints  (see figure Figure 5.1 and the paragraph below)

Figure 5.1 Example of hover hint on a plot.

Hover over hints may be visualized on every object by:
1. Clicking on an empty space on the layout so no objects are selected.
2. Hover the mouse over an object.
3. The hint will appear for 5 seconds.
4. Once the hint disappears, hover over hint viewing is then disabled for

all objects until the user repeats from step 1 above. 

5.1 Plot Types and Formatting

FCS Express has different types of plots (grouped into 1D Plots, 2D Plots,
Charts, and Other Plots on the Insert Tab) to allow you to display your data in
many different ways.

The different types of plots are:

· 1D Plots - (one-dimensional) plots allow you to display one parameter of your

data. You can also display a cumulative probability distribution of your data.
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o A Histogram  bins all of your data into a discrete number of bins, and

sums all the events that fall into the individual bins. In a Histogram, the
data is typically displayed as the data value on the X-axis and number of
events on the Y-axis.

o Multicycle DNA Plots  are a subset of one-dimensional plots that fit DNA

cell cycle statistics.

o Proliferation Plots  are a special subset of one dimensional plots that

automatically model proliferation statistics.

o Subtraction Plots  allows you to determine the percent positive on a

histogram by subtracting a negative control histogram from a sample
histogram. 

· 2D Plots - (two-dimensional) plots allow you to plot one parameter against

another parameter.

o Dot  plots represent each cell with an individual dot. Dot plots always

display the dots in the overlay color. Dot plots may also be Shaded Based
on Density .

o Color Dot  plots. In a color dot plot, the colors can mean one of two

different things. If there is only one overlay on the plot, the colors refer to
which cells fall into which gate. If there is more than one overlay on the plot,
the color refers to which overlay that dot belongs to. If one dot actually
belongs to more than one overly, the color of the dot will be randomly
chosen among the overlays. Color Dot plots may also be Shaded Based on
Density .

o Density  plots. In a density plot, the color of an area reflect how many

events are in that position of the plot. Density plots may also be set to base
color on  a different parameter and set to shade base on density . 

o Contour  plots are the same as density plots, with the exception that

contour lines represent different numbers of cells, rather than colors. A
contour plot looks very similar to a topographical map. 

o Surface  plots. Together with the two parameters on the X- and Y-axes,

the Z-axis displays the number of events.

o In a Kinetics  plot, the X-axis is the Time parameter and all of the Y-value

events are averaged for each unit of time.
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Note: Dot, Density, Contour, and Color Dot plots all bin your data into a
discrete number of bins. Therefore, the dot size of these plots is related to
the number of bins that the data is being divided into. Scatter plots do not bin
your data, but put a symbol at the location of your data value. The symbol
size is controlled by the Formatting preferences. The binned plots are a better
option when viewing data sets containing large numbers of data points (i.e.,
>5000). Scatter plots are more useful when displaying smaller numbers of
data points, where customization of the point shape and style are more
important.

· Charts

o Bar plots  can be used to graphically display statistics from plots, default

statistics or text tables, or spreadsheet .

o Pie charts  can be used to graphically display statistics from plots, default

statistics or text tables, or spreadsheet . 

o Scatter plots  can be used to graphically display custom data .

o Scatter with regression plots  can be used to graphically display custom

data  with the regression curve  automatically overlaid onto the plot
(e.g., in generating a titration curve).

o Box and Whisker plots  can be used to graphically display statistics from

plots, default statistics or text tables, or spreadsheet . 

o Violin plots  can be used to graphically display statistics from plots, default

statistics or text tables, or spreadsheet . 

o Beeswarm plots  can be used to graphically display statistics from plots,

default statistics or text tables, or spreadsheet . 

o Levey Jennings plots  can be used to graphically display custom data

with lines depicting control limits automatically overlaid onto the plot. 

· Other Plots 

o Plate Heat Maps  are displays of a microtiter plate which show statistical

values (using colors) across all the wells of the plate.

o Picture Plots  are used to display the location of cell (or other) images in

two dimensions across an entire area.
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o Spectrum plots  are a subset of one-dimensional plots to graphically

display spectral data.

o Gates Heat Map  plots can be used to create heat maps depicting

statistics from gates and comparing between different sample. E.g. a heat
map showing the % of Gated Cells, MFI, and events for each gates for a
number of different sample overlays. 

o Parameters Heat Map  plots can be used to create heat maps depicting

statistics from parameters and comparing between different samples. E.g. a
heat map showing MFI across any given parameters for a number of
different sample overlays. 

5.1.1 Inserting Plots

To insert plots on a layout page in the default size, use either of the following
three methods:

· From the Ribbon Bar: select the command associated with the plot type

you desire from the 1D Plot, 2D Plot, or Other Plot groups on the Insert
Tab. Then, click on the layout page at the point where you want the upper
left corner of the plot to be (or drag a sizing rectangle on the layout). The
file that FCS Express will associate with the plot is explained in the section
on The Current Data File .

· From the Data List: drag a file from the Data List  and drop it onto an

empty spot on your layout.  You will be prompted to select which plot type
to insert in the Select Plot Types... dialog box.

· From a plot: drag a gate from an existing plot and drop it onto an empty

spot on your layout.  A new plot of the same type but with the dragged
gate applied will appear.

To create a plot with customized size, use the first strategy above (i.e. From the
Ribbon Bar) but draw the plot on the blank page (i.e. left click on the blank page
to place the first corner of the plot, hold the mouse button, move the mouse to
define the size of the plot and release the mouse button to define the opposite
corner of the plot) instead of just clicking on it.

To change the default size for a plot, see 1D Plot Options  or 2D Plot
Options .

To change the file in a plot see Changing Data Files .
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5.1.2 1D Plots

1D Plots (one-dimensional) plots allow you to display one parameter of your
data in histograms. One dimensional histograms are available for standard
analysis of data while Proliferation Plots, Multicycle Plots, and Subtraction plots
provide mathematical modeling of data sets. 1D Plots have many shared
formatting options   as well as options that are specific for each plot type
(please refer to the chapters below for the specific options of a specific plot
type).

Please see a detailed description of each plot type below:

o Histograms

o Multicycle DNA Plots

o Proliferation Plots

o Subtraction Plots  

  

5.1.2.1 Histograms

A Histogram bins all of your data into a discrete number of bins, and sums all
the events that fall into the individual bins. In a Histogram, the data is typically
displayed as the data value on the X-axis and number of events on the Y-axis.

Jump to:
· Inserting Plots

· Formatting Histograms

5.1.2.2 Multicycle DNA Plots

FCS Express provides a complete DNA analysis solution based upon the widely
used MultiCycle AV™ DNA analysis package written by Dr. Peter Rabinovitch at
the University of Washington, and distributed by Phoenix Flow Systems
(http://www.phoenixflow.com).

From the Multicycle manual:

"DNA content histograms require mathematical analysis in order to extract
the underlying G1, S, and G2 phase distributions...The most flexible and
accurate methods of cell cycle analysis are based upon building a
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mathematical model of the DNA content distribution, and then fitting this
model to the data using curve-fitting methods." Multicycle contains "the most
well established models," like those "proposed by Dean and Jett, based upon
the prediction that the cell cycle histogram is a result of the Gaussian
broadening of the theoretically perfect distribution," and Fox, whose "model
provides a more flexible S phase shape, but still retains the smoothness of
the S phase that is characteristic of the Dean and Jett model." In addition,
"careful attention to fitting of the background aggregates and debris is also" a
feature of Multicycle "in order to maximize the reliability of cell cycle analysis
of complex histograms."

A free, limited version of Multicycle is included with FCS Express. This free version
only reports the data on a basic 1-cycle Autofit with no background correction.
When using the free version, there will be a warning message if more than one
cycle is detected in your .fcs data files, and/or if a background correction would
improve the fit. Both of these conditions require the full version of Multicycle for
accurate analysis.

The full version of Multicycle is available for purchase as an add-on. The complete
version allows 1-, 2-, and 3-cycle fits with the ability to change parameters
manually and perform background correction.

5.1.2.2.1  Multicycle

FCS Express comes with a free version of Multicycle capable of performing a 1-
cycle fit with no background correction. The full version of Multicycle may be
purchased as an add-on for FCS Express from De Novo Software, or as
standalone software from Phoenix Flow Systems
(http://www.phoenixflow.com).

The Multicycle model has been described extensively in the following publications:

· Rabinovitch, P.S. DNA content histogram and cell-cycle analysis. Methods in

Cell Biology. 41:263-296, 1994.

· Rabinovitch, P.S. Practical considerations for DNA content and cell cycle

analysis. In: Clinical Flow Cytometry: Principles and Applications (Bauer,
K.D., Duque, R.E., and Shankey, T.V., eds.) Williams and Wilkins, Baltimore,
pp. 117-142, 1992.

· Rabinovitch, P.S. DNA Histogram Analysis. In: Cell Growth and Division, 2nd

Edition. (G. Studinski, ed.). Oxford University Press, Oxford, 1996.

· Kallioniemi, O-P., Visakorpi, T., Holli, K., Isola, J.J., and Rabinovitch, P.S.

Automated peak detection and cell cycle analysis of flow cytometric
histograms. Cytometry 16:250-255, 1994.

http://www.denovosoftware.com/site/prices-flow-ruo.shtml
http://www.phoenixflow.com
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5.1.2.2.2  Inserting a DNA Histogram

DNA Histograms are inserted onto a layout page just like other histograms .

Use the Insert tab 1D Plots Multicycle DNA command and either click on the
layout page to insert a standard size histogram, or click-drag to insert a plot of
the desired size. A file dialog will then appear allowing you to select your DNA
data file. A fitted Multicycle DNA histogram will appear. A legend  can be
displayed when the standard histogram features are formatted (Figure 5.2).

Figure 5.2  Multicycle DNA Histogram with Legend

FCS Express can fit DNA curves from files generated from any cytometer (both
standard FCS list mode data files as well as uncorrelated FCS histogram files).

5.1.2.2.3  Formatting a DNA Histogram

To format a Multicycle DNA histogram, 

· Right-click on the histogram, select Format from the pop-up menu, click on

the formatting drop down, and choose one of the three DNA-specific
categories: DNA Fit , DNA Background , or Position Markers  (Figure
5.3).

· Select the Multicycle DNA Histogram and click on the Multicycle tab  to

access formatting and modeling options.
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Figure 5.3  Multicycle formatting options.

The other categories which can be formatted are described in formatting options
for standard histograms .  Note that overlays cannot be added to Multicycle
DNA histograms.

5.1.2.2.3.1  DNA Fit

The DNA Fit category contains options describing different parameters of the
DNA fit. This category allows you to choose what kind of fit you wish to apply, as
well as set specific parameters for the fit. 

FCS Express defaults to selecting the fit type automatically (the Detect fit type
automatically check box is checked). When detecting the fit type automatically,
all other options are disabled because Multicycle will calculate all the fit
parameters.

Defer changes allows you to make changes to the DNA Fit options without
applying the change immediately. If checked, click Apply to apply your changes,
or Cancel to cancel applying any changes you have made. 

To set the fitting values yourself, uncheck the Detect fit type automatically
check box. The other options will then be enabled (Figure 5.4).

186
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Figure 5.4  Formatting a DNA histogram - Cycle options

FCS Express will show different fitting options depending on which fit type is
selected from the Fit Type drop-down list. The example shows a 1 Cycle fit.
Links to a complete listing of all the supported fit types and the various
parameters that apply for those fits can be found on the FCS Express - Multicycle
knowledgebase page.

After changing the parameters for a fit, the Multicycle plot will update accordingly.
Multicycle will use the input parameters as the starting point for the fit, but may
vary the parameters while calculating the best fit. To see the final fit values that
Multicycle calculated you can open a DNA statistics window  or create Text
Boxes with DNA-specific tokens .

5.1.2.2.3.2  DNA Background

The DNA Background category (Figure 5.5) contains options which control how
Multicycle calculates the background (in order to remove debris from the sample
and calculate an accurate fit).

Defer changes allows you to make changes to the DNA Background options
without applying the change immediately. If checked, click Apply to apply your
changes, or Cancel to cancel applying any changes you have made. 
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http://www.denovosoftware.com/full-access/features/cell-cycle-analysis/
http://www.denovosoftware.com/full-access/features/cell-cycle-analysis/
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Figure 5.5  Formatting a DNA histogram - background options

The Use Background Fit check box controls whether or not Multicycle will
attempt to calculate a background and remove it from the fit data. The other
options control the specific background fitting parameters and are explained in
detail in the Multicycle manual.  Please see the FCS Express - Multicycle
knowledgebase page for additional resources.

5.1.2.2.3.3  Position Markers

The position of cell cycle parameters (e.g., the G1 mean or the background
regions) can be displayed with the use of DNA Position Markers (Figure 5.6).

http://www.denovosoftware.com/full-access/features/cell-cycle-analysis/
http://www.denovosoftware.com/full-access/features/cell-cycle-analysis/
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Figure 5.6  DNA Histogram showing Diploid G2 Position Marker (Red)
and Aneuploid G1 Position Marker (Blue)

You can show or hide a position marker by either:

· Right-clicking on the DNA Histogram, selecting DNA Position Markers from

the pop-up menu, and toggling the appropriate position marker on or off
from the submenu (Figure 5.7), or

· Right-clicking on the histogram, selecting Format from the pop-up menu,

and choose Position Markers from the formatting drop down. 
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Figure 5.7  Showing or Hiding DNA Position Markers

To adjust the visibility, style, color, and/or width of a marker, right-click on the
DNA Histogram, select Format from the pop-up menu, and choose Position
Markers from the drop down (Figure 5.8). Select the marker from the list (use
Ctrl+Click to select multiple markers). The Show position marker on the plot
check box controls the visibility of the selected marker.
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Figure 5.8  Formatting a DNA histogram - Position Markers

5.1.2.2.4  Setting Default DNA Options

The default DNA options  including general options, overlay options, and
position marker preferences for performing DNA analysis using Multicycle  are
described in the appropriate section of the chapter on formatting objects .

5.1.2.2.5  The Multicycle Tab

MultiCycle can automatically fit and analyze cell cycle histograms with multiple
models. You can control the number and type of populations to fit, the currently
displayed model, and the background options using the MultiCycle Tab (Figure
5.9). The Multicycle tab will only appear when a Multicycle DNA Analysis plot has
been selected in the layout. 
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Figure 5.9  The Multicycle Tab

To analyze a DNA histogram automatically:

1.  Insert a DNA Histogram onto your layout using the Insert 1D
Plots MultiCycle DNA command.

2.  Select the DNA Histogram and verify that the MultiCycle Fit
Parameters Autofit command is highlighted. With Autofit, MultiCycle will
choose the Cycle parameter for you.

3.  Right-click on the DNA Histogram and select Statistics DNA Cycle
Statistics from the pop-up menu. Adjust the position of the statistics
window.

4.  Right-click on the DNA Histogram and select Statistics DNA Model
Summary Statistics from the pop-up menu. Adjust the position of the
statistics window.

The current model being displayed in the DNA Cycle Statistics is highlighted in the
MultiCycle  group. To change the model, click on one of the
other five Model commands within the Model to Display group.

To change to a manual fit, click on MultiCycle Fit Parameters Autofit and
verify that the command/button is not highlighted. With a manual fit:

· To change the number of populations for the fit, or the parameters for a 1

Cycle fit, use the MultiCycle Cycle drop-down list.

· To change the Fit Model Properties, use the MultiCycle Fit

Parameters DNA Fit command to bring up the DNA Fit options (Figure
5.10). You can alter the means and CVs for populations manually. The
properties that can be adjusted will change according to the Fit Type
chosen in the drop-down list. Note that by checking the "Defer changes"
option, you can edit the fit properties and apply the changes after all edits
are complete rather than having the edits update as they are typed in. 
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Figure 5.10  Formatting Fit Model Options Dialog

· To change background parameters, select the MultiCycle

Background command to bring up the DNA
Background options (Figure 5.11). The parameters are described in the
MultiCycle manual.
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Figure 5.11  Formatting Background Options Dialog

5.1.2.2.6  DNA Statistics

To open a DNA statistics window, right-click on the DNA histogram, move the
cursor over Statistics in the pop-up menu, and select the desired type from the
submenu (Figure 5.12).



Plots and Other Objects 167

© 2023 De Novo Software

Figure 5.12  Choosing DNA Statistics

The first choice, Standard Histogram Statistics, represents the statistics
available for non-DNA histograms .

DNA Cycle Statistics describe each of the populations within your sample. The
three possible populations are Diploid, Aneuploid A (or Aneuploid 1), and
Aneuploid B (or Aneuploid 2). Each population will appear in a different row
depending on the currently applied fit. Figure 5.13 shows an example of DNA
cycle statistics for a two cycle fit. A detailed description of the different cycle
statistics can be found in the Multicycle manual.

Figure 5.13  DNA Cycle Statistics for a Two Cycle Fit

The DNA Model Summary Statistics pertain to the six different models that
Multicycle calculates each time a DNA analysis is performed. Each model will
appear in a different row. A short description of the DNA Model Summary
Statistics table and of the different DNA models can be found in the DNA Cycle
and Model Summary Reference . A detailed description of the different DNA
model statistics can be found in the Multicycle manual.

The DNA Experiment Statistics display several additional statistics as well as
an interpretation of the experiment as a whole. The interpretation, designed to
give you an estimate of the goodness of the fit, is described in more detail in the
Multicycle manual (Figure 5.14).
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Figure 5.14  DNA Interpretation and
Experiment Statistics  

Please see the FCS Express - Multicycle knowledgebase page for additional
resources.

5.1.2.2.7  DNA-Specif ic Tokens

All of the DNA statistics can be used as tokens . DNA tokens can be inserted
into text boxes , used in Custom Token  or Alert formulas, and exported to
reports during batch processing .

To insert a DNA token into a text box:

1.  Insert a text box using the Insert tab General Text Box command.
2.  Right-click on the text box and select Insert Token.
3.  Double-click Statistic to bring up the Create Statistic dialog.
4.  Choose a DNA Histogram as a Data Source.
5.  Open the Statistic category.
6.  Choose a DNA statistic  from the Select a Statistic drop-down list. If

you choose DNA Cycle Statistics, the dialog will look like Figure 5.15. If you
choose a different DNA statistic (DNA Model Summary Statistics or DNA
Experiment Statistics), the options and the specific items in the list box will
change.

7.  Click OK.
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Figure 5.15  Create Statistics Dialog - DNA Cycle Statistics

5.1.2.2.8  DNA Cycle and Model Summary Reference

MultiCycle AV for FCS Express is capable of autofitting the appropriate Cycle to
suit your data.  However, users have the ability to override the autofit and
choose a Cycle to fit to their data.

Here is a summary of the various Cycles that are available in MultiCycle AV.

Cycles

1 Cycle The most common and frequently used.  Used when there is 1
full cell cycle present.

1 Cycle
Standard
Overlay Peak

Similar to 1 Cycle.  Ideal when using a standardization tool like
chicken erythrocytes.

1 Cycle
Apoptotic
Overlay Peak

This cycle is performed when it is assumed that there is one extra
peak to the left of the G0/G1 peak.

1 Cycle
Aneuploid
Overlay Peak

This cycle is performed when there is an Aneuploid peak present
that does not contain a full cell cycle.

1 Cycle
Diploid

This cycle is performed when there is a Diploid peak that does not
contain a full cell cycle.
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Overlay Peak

2 Cycle This cycle is used when there are 2 full cell cycles present.

3 Cycle This cycle is used when there are 3 full cell cycles present.

Synchronous
S Phase

This cycle should be used when performing an experiment where
S phase is arrested, leading to a peak in S phase, rather than a
smooth gradual curve.

MultiCycle AV for FCS Express applies six different models to your data at the
same time.  

In FCS Express, you can create a DNA Model Statistics Summary box that shows
your statistics as it applies to each of the six different models (Figure 5.16).

Figure 5.16 - DNA Model Statistics

Here is a summary of the various Cycles that are available in MultiCycle AV.

Models

1) SL
S0

Most common model used.  Sliced nuclei background modeling with zero
order S phase, but without other options.  Used when debris curve looks
like a ski slope.

2)SL
CL S0

Sliced nuclei background modeling with clumping compensation with zero
order S phase.  Used if debris curve is flat and cuts into G0/G1.

3)SL
G21
S0

Sliced nuclei background modeling, plus the constraint of the G2/G1
ratio.  For 1 cycle fitting models, the G2/G1 ratio is the current default
stored within Multicycle AV.

Please note, for 2 Cycle models, the G2/G1 ratio of the diploid cycle is
constrained to be equal to the aneuploid G2/G1 ratio that resulted from
the user-chosen fitting model.
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For 3 Cycle models, the G2/G1 ratio of all 3 cell cycles is constrained to
be equal to the average of the 2 aneuploid G2/G1 ratios that resulted
from the user-chosen fitting model.

4)SL
CL
G21
S0

Sliced nuclei modeling plus aggregation modeling and addition of G2/G1
constraint, as detailed above.  Basically, this is a software version of
doublet discrimination.  This model looks at all possible combinations of
G1 and G2 stuck together and figures out the % of cells that are stuck
together.

5)SL
S1

A 1st order S phase polynomial is used with sliced nuclei background
modeling.  This model is to be used when the S phase is more in the
shape of a broadened trapezoid.

S order = 0 (broadened rectangle)
S order = 1 (broadened trapezoid)
S order = 2 (higher on the sides, lower in the middle)

6)SL
CV S1

Sliced nuclei modeling with a 1st order S phase, plus the CVs of all peaks
are constrained.  This model can be used when the G2/M peak is buried
in the S phase.

References for this information can be found at our FCS Express - Multicycle
knowledgebase page.

In cases where the data is suboptimal or the cell cycle peaks are not well defined,
users can get Intra-model or Inter-model errors.  You can find the definition for
these errors at the FCS Express - Multicycle knowledgebase page.

5.1.2.3 Proliferation Plots

The introduction of fluorescent cell staining and division tracking dyes has made it
possible to monitor the number of cell divisions during proliferation, and to
examine the relationship between proliferation and differentiation. 

Fluorescent tracking dyes can be categorized into two major groups: 

· General protein labeling

General protein labeling dyes such as carboxyfluorescein diacetate
succinimidyl ester (CFSE) act by forming random covalent bonds with
amino groups on cellular proteins resulting in a highly fluorescent
membrane impermeable marker. CFSE is highly fluorescent and when
excited with a 488 nm laser it emits in the "green" channel at 515 nm.

· General membrane labeling dyes

http://www.denovosoftware.com/full-access/features/cell-cycle-analysis/
http://www.denovosoftware.com/full-access/features/cell-cycle-analysis/
http://www.denovosoftware.com/full-access/features/cell-cycle-analysis/
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General membrane labeling dyes such as PKH and Cellvue are lipophilic
compounds that stably but non-covalently insert into the plasma
membrane. General membrane labeling dyes vary in fluorescent intensity
and can be obtained in many colors, making them useful for multi-color
experiments.

With each cell division, the dye is divided roughly equally between the two
daughter cells. Therefore, the dye fluorescence intensity is a measure of the
number of divisions any given cell has undergone.

After staining, the cell population is analyzed at regular time intervals by flow
cytometry. A histogram of the number of cells as a function of dye fluorescence
intensity is generated. Typically, cell proliferation dyes can be used to track up to
8 rounds of division before fluorescence intensity is reduced to the
autofluorescence of unstained cells. 

The FCS Express Proliferation Add-on provides curve fitting algorithms to
estimate the proliferation fraction.

For more information on proliferation analysis, please see
http://www.denovosoftware.com/proliferation-analysis.

5.1.2.3.1  Inserting a Proliferation Histogram

Proliferation histograms are a special subset of one dimensional plots that
automatically model proliferation statistics according to the fit parameters you
set.

Note: The axis scale  of Proliferation histograms should be set to Log.

Prior to inserting a Proliferation histogram for curve fitting analysis, you should
gate your cell population on the desired cells. See the proliferation tutorial   for
further information.

To insert a Proliferation histogram, use the Insert 1D Plots Proliferation
command. If necessary, change the x-axis parameter  to reflect the
appropriate parameter for the proliferation dye used in the experiment, such as
CFSE or CellTrace Violet, for example.

An example of a Proliferation histogram is shown in Figure 5.17.
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http://www.denovosoftware.com/proliferation-analysis
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Figure 5.17  Proliferation Histogram

The default colors are explained in the table below.

Color Explanation

Black Overall histogram contour. This includes all the data and does not represent an
output of the fitting algorithm.

Red Overall contour of the fitted data. This excludes what the algorithm determines
to be noise.

Light Blue This is the data that the algorithm determines to be noise, and is not included
in the statistics.

Green Modeled populations of proliferating cells. These are the actual curves fitted to
the data, representing the parent, undivided population, and all the
proliferating generations. 

5.1.2.3.2  Formatting a Proliferation Histogram

In addition to the options common to all histograms , Proliferation Histograms
have two additional property categories which can be formatted: Fit
Parameters  and Proliferation Position Markers .

5.1.2.3.2.1  Proliferation Fit Options

If the algorithm finds a significant population of events that it determines to be
noise (shown in Light Blue on the Proliferation histogram), you can try to modify
the Proliferation Fit Options in order to attempt to improve the model's fit.

To format the fit parameters of a Proliferation histogram:

1.  Right-click on the Proliferation histogram and choose Format from the
pop-up menu.

186
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2.  Click on the drop down to expand the selection in the formatting dialog.

3.  To change the fit modeling, select  Proliferation Fit (Figure 5.18).

Figure 5.18  Formatting Proliferation Fit Options

On the Proliferation Fit Options page, you can modify a number of properties
related to the fit algorithm, including:

· Maximum number of peaks to model.

· Minimum Peak Threshold. Set the minimum percentage of events

required to be considered a proliferation peak. Peaks that fall below this
threshold will be fit as noise in the model fit. For proliferating populations will
low event numbers, adjusting the threshold value to a lower number may
help improve the model fit.

· Fixed CV. Decide whether or not to use a fixed CV (defined by the user) for

all peaks. Note that, the value defined in the Fixed CV field is actually
interpreted by the software as the Standard Deviation of the peaks,
calculated, on log-transformed values, after binning.

· Same CV for All Peaks. When this option is selected, the CV, calculated on

linear-scaled data (i.e. raw data), is made the same between peaks. Note
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that the CV reported in the Proliferation Statistics table, is calculated on the
log-scaled data instead.

· Fixed Peak Ratio and/or Same Peak Ratio for All Peaks.

· Fixed Starting Generation

· Background Noise. The values defined in this field is subtracted from the

channel values prior to doing any fitting.

The following is a brief description of how the fitting algorithm works, which will
help you to set the properties:

· The fitting process starts by determining where the population of cells that

have not divided is located. The fitting process attempts to find this peak
automatically, although you can specify it manually. In some cases, you
have to specify it manually since there are no cells in the population that
have not divided.

· Once the undivided population is found, the model attempts to find

populations that have decreased in fluorescence by 50% from each other.
Since not all experiments work according to theory, the model starts
looking at the 50% point but can move left or right to find the true peak.
You can control this by using the Same Peak Ratio for All Peaks option.

· In order to find a peak, the model makes certain assumptions about the

width of each peak compared to the undivided control. You can also control
these settings using the Same CV for All Peaks option. When this options
is selected, the CV, calculated on linear-scaled data (i.e. row data), is made
the same between peaks.

· The model can also subtract background fluorescence from all the

calculations, if you provide a value for the background fluorescence.

· Since the algorithm uses the actual histogram contour to model the fit, the

histogram data should not be smoothed. Only in special cases, when the
original data is very noisy, should a little smoothing be applied to allow the
model to better fit the data.

· These options exist in order to accommodate the wide range of data

sources and biological behaviors that the model has to encompass. Thus, in
order to obtain the best fit, it is important that the correct initial settings be
selected. In practice, this is usually performed by trial and error until the
settings providing the best fit are found.

· The two ways to assess the goodness of the fit are visual inspection, which

gives a rough measure, and the proliferation fit statistics .177
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5.1.2.3.2.2  Position Markers

Position Markers can be displayed on Proliferation histograms to mark the
position of the undivided cells peak and/or the background region.

To format proliferation position markers:

1.  Right-click on the Proliferation histogram.

2.  Choose Format from the pop-up menu.

3. Click on the drop down to expand the selection in the formatting dialog.

4.  Select Position Markers.

5.  To make the position marker for a specific peak, select the peak and
check the box for Show position marker on the plot.

Select the Undivided cells peak and/or Background properties from the list
box on the left (Figure 5.19) and choose line options for the selected markers on
the right.

Figure 5.19  Formatting Proliferation Position Markers
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5.1.2.3.3  Proliferation Statistics

When performing a Proliferation Analysis, FCS Express automatically calculates
several proliferation fit  and proliferation population  statistics from your data.
 To change user preferences for which of these statistics are displayed, refer to
the Proliferation Fit Statistics preferences  and Proliferation Population Statistics
preferences  sections of the Statistic Preferences  sub chapter of the User
Default Options .

To open a Proliferation statistics window, right-click on the Proliferation
histogram, move the cursor over Statistics in the pop-up menu, and select the
desired type from the submenu (Figure 5.20).

Figure 5.20  Choosing Proliferation Statistics

The first choice, Standard Histogram Statistics, represents the statistics
available for non-Proliferation histograms .

Proliferation Fit Statistics  describe the fitted data. Figure 5.21 shows an
example of proliferation fit statistics. The statistic equations that are calculated
are shown in the table below.

Figure 5.21  Proliferation Fit Statistics

The statistics shown in this window are explained in the table below

P is the total number of peaks found (where P0 is the undivided generation). 
N is the number of cells in a generation. 
µ  is the mean of a population.
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All statistics below assume that no cell death occurred. 

Statistic Equation Description

Proliferati
on Index

The average number of cells that an
initial cell became.

Division
Index

The average number of cells that a
dividing cell became.

# of
Original
Cells

The number of cells that existed prior to
any division.

%
Divided 

The percentage of the original cells that
divided.

Peak
Ratio

The average ratio of all the peak
positions.

# of
Fitted
Cells

The total number of cells calculated by
the fitting.

Degrees
of

Freedom

N/A The number of channels minus the
number of fit parameters minus 1. 



Plots and Other Objects 179

© 2023 De Novo Software

R-Chi
Square

An estimate of the “goodness of fit” of
the model. Low values indicate good fit. 
R is the range of the data.
O(i) is the data value at i.
F(i) is the fit value at i.
σ(i) is the measurement error at i.
Measurement error is estimated by
comparing a smoothed version 
(7 point smoothing). 

RMS
Error

An estimate of the “goodness of fit” of
the model.
R is the range of the data.
O(i) is the data value at i.
F(i) is the fit value at i.

Proliferation Population Statistics  pertain to the multiple generations that
have proliferated during the experiment (Figure 5.22). The statistic equations
that are calculated are shown in the table below.

Figure 5.22  Proliferation Population Statistics

An explanation of the shown in this window is in the table below.  Note that all
statistics are generation-specific.

Statistic Description

1633
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Peak
Channel

The x-value of the peak.

Peak Value The y-value of the peak.

Log Std.
Dev.

The Standard Deviation (Std. Dev.) of the log-scaled data.  The
Std. Dev. is a measure of the variation from the average for the
events, or the square root of the variance. Log values are used
due to histogram data being binned in log space.  

Log CV The coefficient of variation (CV) of the log-scaled data. The CV is a
measure of the distribution of your data and is equal to the
standard deviation divided by the mean. Log values are used due
to histogram data being binned in log space.  

Peak Ratio The ratio of the fluorescence to the previous generation's
fluorescence.  The ideal is 0.5.

# of Cells The number of cells calculated by the fitting.

# of Orig
Cells

The number of original cells (i.e., cells prior to any cell division)
giving rise to the cells calculated by the fitting.

% of Orig
Cells

The number of original cells expressed as a percent of the total
number of original cells.

5.1.2.3.4  Proliferation-Specif ic Tokens

All of the Proliferation statistics can be used as tokens . Proliferation tokens can
be inserted into text boxes , used in Custom Token  or Alert formulas, and
exported to reports during batch processing .

To insert a Proliferation token into a text box:

1.  Insert a text box using the Insert General Text Box command.
2.  Right-click on the text box and select Insert Token.
3.  Choose Statistic and click on the Insert button to bring up the Create

Statistic dialog.
4.  Choose a Proliferation Histogram as a Data Source.
5.  Open the Statistic category.
6.  Choose either Proliferation Population Statistics or Proliferation Fit

Statistics from the Select a Statistic drop-down list. If you choose
Proliferation Population Statistics, the dialog will look like Figure 5.23.
Choose a population from the Select Population drop-down list, and one
or multiple statistics from the list box, and click OK.
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Figure 5.23  Choosing a Proliferation Population Statistic Token

5.1.2.4 Subtraction Plots

Histogram subtraction allows for the determination of the percent positive on a
histogram by subtracting a negative control histogram from a sample histogram.
 In FCS Express, this subtraction can be performed by using a Subtraction Plot.

To insert a Subtraction Plot, select the Insert tab  Plots Subtraction
command, and click once on the layout where you want the plot to be inserted. 
The Subtraction plot will default to showing the current data file  in the first
overlay, and no data file in the second overlay.  The first overlay will by definition
serve as control.  The order of the overlays can be changed via the up and down
arrows in the Overlays category of the Formatting dialog  (Figure 5.24).  

368
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Figure 5.24 .  Upper pane of the Subtraction Plot Overlays dialog.

The data files can be changed by either of the following methods:
· dragging and dropping two data files from the Data List onto the Subtraction

plot, which will replace both overlays, or
· changing each overlay to another data file by the usual methods .  

An example of a completed Subtraction Plot and its associated Histogram
Statistics window , for which there will be a row of statistics for each overlay
that is checked as "visible" , is shown below in Figure 5.25.  In addition to the
two source overlays defined by the user (i.e., the "iso.fcs" and "pos.fcs"
overlays), there are four additional overlays, defined in the Table below:

369
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Figure 5.25 .  A Subtraction Plot and its associated Histogram Statistics
window.

Overlay Description

Subtracti
on

The control histogram is subtracted from the sample histogram on a
channel by channel basis. 

Addition The control histogram is added to the sample histogram on a channel
by channel basis.

Division The sample histogram is divided by the control histogram on a channel
by channel basis.

Overton This technique is similar to the channel by channel subtraction method,
in which the control histogram is subtracted from the sample
histogram on a channel by channel basis, except that negative
differences (where the number of cells in control channel N is greater
than the number of cells in sample channel N) are added to the
positive differences in lower channels. After all channels have been
analyzed, residual negative results are set to zero, and the sum of the
positive results is divided by the total number of cells to yield a
percent positive.
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The percent positive on a histogram can also be set up to be automatically
calculated and appear in the "% Positive" column of the Histogram Statistics
window , as shown in the figure above. In this case, the Overton Subtraction
method is used.  To have the histogram subtraction automatically performed and
displayed in a histogram statistics window:

· Make sure the percent positive column is visible for the statistics window .

· Use the Format tab Plot Options Specific Options command (or right-

click on the histogram, choose Format from the pop-up menu, and select
the Specific Options category from the drop down menu). Set the Control
Histogram for Histogram Subtraction Statistics field to the appropriate
negative control, which should be the first overlay (Figure 5.26 ). Statistics
histogram subtraction always uses the Overton Subtraction method,
described in the table above.

1268

1276
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Figure 5.26 .  Setting the Control Histogram in the Formatting
Specific Options Dialog
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5.1.2.5 Formatting Options Shared by All 1D Plots

In addition to the formatting options common to all Objects , and those
common to all Plots , 1D Plots have certain properties, which can be
formatted:

· Overlays  are defined in FCS Express as a data set that is displayed on a plot.

A 1D Plot must contain one or more overlays.

· Markers  (not available for Spectrum plots and Kinetics plots).

· Magnification of a histogram  allows you to reset the minimum and

maximum axis scale and resolution to restrict your view to a certain region of
the histogram. Note that Axis Resolution cannot be manipulated on Spectrum
Plots.

· Specific options  include normalization, plot resolution, presentation choices

for multiple overlays, and the choice of a control histogram for histogram
subtraction statistics.

You can always format a plot by:
· right-clicking on it (or double-clicking on a plot that is already selected),

selecting Format from the pop-up menu, and choosing a category to format.
This method will allow you to use the Preview and the Restore buttons to see
what the changes would look like without actually accepting the changes

· select the plot and choose the desired category from the Format tab of the

Ribbon . Formatting from the ribbon will open a formatting options dialog in a
dockable window that will apply changes as they are made. 

5.1.2.5.1  Overlays

The Overlays option controls the parameter and appearance of 1D Plot
overlays.

Overlays are defined in FCS Express as a data set that is displayed on a plot. A
1D Plot must contain one or more overlays.

For single parameter Histograms , Kinetics plots  and Spectrum plots ,
an overlay consists of a data file and parameter combination. Overlays can be
added or deleted from a Histogram, a Kinetics plot or a Spectrum plot.
Furthermore, while any number of data files with parameters different from the
first overlay (also known as the base overlay) can be added to the same
histogram, the axis title and scaling will always be taken from the base overlay.
The histogram legend  is valuable for displaying and organizing multiple
overlays.

Overlays on Spectrum plots have unique options for displaying spectral data
sets that are covered in the  Formatting Overlay on Spectrum Plots  chapter.
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Multicycle plots  and Proliferation plots  usually contain multiple overlays.
The base overlay for these plots is usually the data file of interest while the
additional overlays are the curves resulting from model fitting.

Subtraction plots  contain multiple overlays associated with the histogram
subtraction performed. The base overlay and the second overlays are data files
of interest while the additional overlays display the results of histogram
subtraction calculations. 

You can add additional overlays by any of the following methods:

· Right-click on the plot and select Add overlay from the pop-up menu. This

launches either the Select Data File or the Open Data File dialog
depending on the Open Data Dialog user Options ; or 

· Right-click on the plot and select Add Overlay using Advanced Open

Data Dialog (launches the Open Data File  dialog), or 
· Drag-and-drop file(s) from the Data List  onto the plot you wish to

overlay, or
· Drag-and-drop a plot from the layout onto the plot you wish to overlay.

You can edit overlays in one of two ways:

· Select the histogram(s) and use the Format Plot Options

command. 
· Right-click on the histogram, select Format from the pop-up menu, and

choose Overlays from the drop down list. (Figure 5.27).
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Figure 5.27  Formatting Histogram Overlays Dialog
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In the dialog, a list of all the overlays on the histogram will appear in the list box
at the top. You can select one or more overlays using standard Microsoft
Windows keystroke commands, including Shift-Click and Ctrl-Click. The
properties on the bottom pertain to the currently selected overlay(s). If multiple
overlays are selected, properties that are not identical in all selected overlays will

appear blank or will display a black square in their check box ( ). If the
properties are not blank, or they are not displaying a black square in their check

box ( ), then they are identical for all selected overlays. Changing an option will
change that property for all selected overlays. For instance, if you select three
overlays and change the Gate, the Gate for all three overlays will be modified. 

To remove an overlay from a plot, select the overlay (or multiple overlays) and
press the Remove button. 

To change the order of selected overlay(s) in the legend , use the up and down

arrows ( ).

Overlay properties are explained in the table below.

Option Explanation

X Parameter Change the parameter displayed on plots.

Y Parameter Change the parameter displayed on plots.

Gate If gates are defined , select the gate that will be used to limit
the data that is displayed on the histogram.

Compensation If compensation definitions  are set, select the definition to use
when compensating the data in the overlay.

Transformation If transformations  are set, select the transformation to use for
each overlay.

Distribution Select the data to be shown. Standard displays the data in
number of events per channel, and Cumulative displays the
cumulative distribution frequency (often used for statistical
testing). Information about the cumulative distribution frequency
can be found in standard statistics textbooks.

Legend Text The text that will appear in the legend beside the symbol for the
overlay. Free text can be inserted. If this field is blank the file
name of the overlay will appear.
A dropdown menu with additional pre-customized legend content is
accessible by pressing the ellipsis button next to the legend text.
Possible choices are:
o Keyword. This can be used to insert keywords from the header

of the data file.
o Gate. This can be used to display the current gate applied to

the overlay.
o Tube Number. This can be used to display the Tube Number of

the overlay when a Panel  is active.
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Option Explanation

o Tube Name. This can be used to display the Tube Name of the

overlay when a Panel  is active.
The above mentioned Legend options apply only to Dot Plots,
Color Dot Plots, Histograms and Spectrum Plots.

Line Options Choose the overlay line style, color, and/or width.

Smoothing Set the degree of smoothing for the overlay.  The Histogram and
Proliferation plot smoothing is set to 10 by default.

Show legend
symbol as solid box

When selected, colored solid boxes will be used in the legend
instead of lines. Box colors are defined in the Line Options > Color
field (see below).

Fill the histogram
area

Enable the checkbox to fill in the overlay using the selected Fill
Style. Overlays that are filled in may look better on a 3D display
(Figure 29.1).

Fill Style The pattern that will be used to fill the histogram.

Transparency Transparency of histogram fill, where 0 is opaque and 100 is
completely transparent (invisible).

Change data file
during
Next/Prev/Batch

If this option is checked, the data file for this overlay will change
when doing batch processing , or selecting Previous File or Next
File . This option is usually only disabled for a control histogram,
where you have multiple overlays, and want the control to stay the
same all of the time.

Perform Baseline
Offset

If the value of the cell is zero, a random offset will be added so
that the dot appears off the axis. This will not affect the statistics.

Visible You can hide overlays on a histogram without removing them.
Select the overlay file from the list and uncheck Visible. Check
Visible to show the overlay again. If unchecked, Histogram
Statistics  will be hidden for the selected overlay.

Line Options (Width,
Style, Color)

Graphical options used for each overlay. These options also applies
to the legend unless the "Show legend symbol as solid box" is
enabled. In that case, the color only will apply to the legend.

Stacked Overlay
Options

Stack Position Top and Bottom values defined here (between "1"

and "0", respectively) will apply when Specific Options

Stacking Position Use Stack Position from Overlay  is
enabled for a Stacked Histogram.  Additional stacking position
options are controlled through plot formatting specific
options .

5.1.2.5.2  Markers

Markers are regions defined along a single parameter. Markers can be drawn on
all 1D plots. However, since markers on Spectrum plots and Kinetics plots, are
actually created as 1D Gates , the Marker formatting options are only available
for Histogram, Proliferation plots, Multicycle plots and Subtraction plots.

The Markers option allows the user to control the formatting of markers.

Please also see the sections on Using Markers  for additional details on
creating, editing, resizing, linking, and locking markers. 

You can edit markers in one of two ways:
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· Select the histogram(s) and use the Format  Options

command. 

· Right-click on the histogram, select Format from the pop-up menu, and

choose Markers from the drop down list.(Figure 5.28).
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Figure 5.28  Formatting Markers Dialog
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In the dialog, a list of all the markers on the histogram will appear in the Marker
list box. You can select one or more markers using standard Microsoft Windows
techniques, including Shift-Click and Ctrl-Click. The properties on the right
pertain to the currently selected marker(s). If multiple markers are selected, the
information will appear blank for those properties that are not identical in all
selected markers. If the properties are not blank, then they are identical for all
selected markers. Changing an option will change that property for all selected
markers. For instance, if you select three markers and change the Color, the
Color for all three markers will be modified. To remove a marker, select it and
press the Remove button.

Marker properties are explained in the table below.

Option Explanation

Applies to
overlay

Select which overlay(s) the marker applies to. Statistics in the Histogram
Statistics table  will be calculated for the overlay that the marker applies
to.
Note: this options only controls statistics in the Histogram Statistics table
and does not apply to statistics reported in Marker text boxes. Statistics in
Marker text boxes are independent and should be modified by formatting the
statistics tokens in them.

Name The name of the marker that appears in text boxes on a plot when the marker
name token is selected.

Low The low channel boundary of the marker. Tokens may be used to define low
bound by clicking on the T icon . The locked check box locks the low bound
position to a manually entered or token defined value. Additionally, A lock may
be overridden without accessing the formatting dialog by dragging a new
token value onto the marker endpoint. 

High The high channel boundary of the marker.Tokens may be used to define low
bound by clicking on the T icon . The locked check box locks the high
bound position to a manually entered or token defined value. Additionally, A
lock may be overridden without accessing the formatting dialog by dragging a
new token value onto the marker endpoint.

Color The color that the marker will be drawn in.

Line width The line width of the marker.

Linked
Gate

The gate that the marker is linked to . To break the link between the
marker and a gate select No Link.

Visibility Choose to show the marker "True", hide a marker without removing it "False",
or make it visible based on a conditional value "Custom". The Custom option
allows you define visibility of the marker based on a token or value that
evaluates to a conditional expression . Any tokens or values may be used
to set a conditional custom value and may be inserted  via right click in the
field, Insert Token or by clicking on the T token icon. The marker will only be
visible if the token evaluates to True.

Allow
Move

Choose to allow moving the marker "True", disallow a marker move "False", or
make moving the marker based on a conditional value "Custom". The
Custom option allows you define the move status of the marker based on a
token or value that evaluates to a conditional expression . Any tokens or
values may be used to set a conditional custom value and may be inserted
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Option Explanation

via right click in the field, Insert Token or by clicking on the T token icon.
The marker will only be allowed to move if the token evaluates to True.

Default
marker
values

When a marker is created, you can choose whether or not to show the
marker name and/or stat in a text box, and select the default line width and
color. If marker stat is enabled, you can choose which statistic to display
from the drop-down list. If Show detailed marker resizing information is
checked, the marker boundaries will appear above the marker and lines will
drop to the axes to show where the marker boundaries will be during resizing.
 If Create a linked gate is checked, when new markers are created on this
plot, a gate linked to the marker  will automatically be created.

Show
detailed
marker
resizing
informatio
n

Enables drop down lines at the end of each marker to show the position on
the axis as well as displays marker low and high boundary values.

Create a
linked
gate

When checked, any new markers created on the histogram will be
automatically converted to linked gates. Any existing markers on the plot will
still need to be manually linked to a gate . 

5.1.2.5.3  Specif ic Options

The Specific Options category contains a variety of properties that control how
data on the histogram is displayed.

Note: Please see the Spectrum Plots  chapter for unique Specific Options
associated with Spectrum plots. 

You can edit histogram specific options in one of two ways:

· Select the histogram(s) and use the Format Plot Options

Options command. 

· Right-click on the histogram, select Format from the pop-up menu, and

choose the Histogram Histogram Specific Options category (Figure
5.29).
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Figure 5.29  Formatting Histogram Specific Options
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The options are described in the table below. See Resolution Overview  for a
further description of resolution options.

Option Explanation

Normalize to If different overlays contain different numbers of events
in a channel, they may not look alike even if the data
comes from an identical population. Overlays can be
normalized based on the number of events or based on
the peak value. The reference, for both the number of
events or the peak value, can be an overlay (select the
Based on Overlay radio button and select an overlay
from the drop-down list. The number of events in other
overlays will be normalized to appear to have the same
number of events as the selected overlay.) or a custom
value (select the Based on Value radio button and
type the custom value in the corresponding field). 

Cells to Plot Options (only
available for Kinetics plots)

Control how many cells are plotted/visualized. With the
radio buttons, choose the cell number range or
number of cells plotted option. Then, select a value
from the drop-down list or enter in freetext into the
from and to boxes, as appropriate. Note that
statistics for Kinetics fitting are calculated based on
the plotted cells only.

Plot resolution In the first drop-down menu, choose whether to use
the resolution specified in the data (Derive from data
file) or select your own resolution from the second
drop-down menu. Choosing a resolution lower than the
true resolution of the plot is an effective way of
smoothing your data. When the Derive from data file
option is selected, FCS Express chooses the highest
resolution possible depending on the data with a max of
1024.

Resolution
Options (please
refer to the
Resolution
Overview
chapter for details)

Automatic
Minimum

If checked, then FCS Express will start binning the data
(dividing it into the number of bins specified by the Plot
resolution) at either 0 or the lowest data value (if the
lowest data value is below 0).

Resolution
Minimum

Specify where to start binning the data. If Automatic
Minimum is checked, then this value is ignored.

Automatic
Maximum

If checked, then FCS Express will finish binning the data
(subdividing it into the number of channels specified by
the Plot resolution) at the highest value of the true
data range.

Resolution
Maximum

Specify where to finish binning the data. If Automatic
Maximum is checked, then this value is ignored.

Include out
of range
values in
gates and

quads

If checked, data values that are outside the resolution
options of the plot will be considered to be part of the
lower or upper channels. If a gate or quadrant touches
the lower or upper channels, it will include these cells,
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Option Explanation

even though the cells are actually outside the boundary
of the gate/quadrant.

Use channel calibration on
axis

FCS Express can establish calibrated values for the
axes . If channel calibrations are defined, toggling this
checkbox will determine whether or not to use the
calibrated values in place of the generic channel
numbers.
Note that this option does not apply to Spectrum Plots.

Control Histogram for
Histogram Subtraction
Statistics

FCS Express can automatically perform histogram
subtraction  to calculate the number of positive cells.
Select which overlay is the control.

Display multiple overlay data Display overlay data in a single histogram (Overlaid) or
use a split view (Stacked). See Figure 5.30.

Figure 5.30  A Histogram with Two Overlays
in Stacked View

Stacked Y Axis Title Type If multiple overlay data is displayed Stacked, choose
the Y Axis Title to use.

Stacking Position For stacked histograms only.

· Automatic option will result in overlays of equal
height spaced equally apart from one another.  

· Overlay Scaling Factor can be set between
"0" (which will result with a 1D overlay rather than
Stacked appearance) and "3" (which will maximize the
vertical space between stacked histogram overlays). 
The default is "1", which minimizes space between
stacked overlays while avoiding overlap.  See
examples below.

1217
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Option Explanation

· Use Stack Position from Overlay allows for overlays
with unequal height and spacing.  Stack Position Top
and Bottom values define the higher and lower
bounds of each overlay within the entire graph's Y-
dimensional plotting space and must be entered as
values between "0" and "1" for each overlay in

Overlays Stacked Overlay Options .  See
example below. 

5.1.2.6 Parameter Overlays

Parameter Overlays in FCS Express allow you to display multiple parameters
from a single file onto a histogram as Overlays (Figure 5.31). Parameter
Overlays can be used to explore gated populations over multiple channels, and
are often coupled with Transformations such as tSNE for exploratory data
analysis (see image at bottom). 
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Figure 5.31 Parameter Overlays 

To add Parameter Overlays to a histogram, right-click on the histogram and
select Add Parameter Overlays (Figure 5.32). 

Figure 5.32 Add Parameter Overlays to Histogram

In the Available Parameters section of the Add Parameter Overlays window
(Figure 5.33), check the box next to each parameter to add. You may also
choose to add a legend to the plot with the parameter names, or switch the
Overlay display from Overlaid to Stacked by checking the appropriate box. 

If the Switch to stacked check box is selected, the Stacked Y Axis Title Type
options become available. You may choose to display on the Y Axis the Counts
or Legend Text (parameter name) for each parameter on the histogram. Note
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the Overlay display (stacked or overlaid) and Stacked Y Axis Title Type options
can also be changed from the Specific Options formatting category.

Figure 5.33 Add Parameter Overlays Window - Select Parameters,
Include Legend, Set Overlay Display, and Stacked Y-Axis Title

Options.  

In addition to providing a simple and fast tool to explore antibody staining
patterns of gated populations, the Parameter Overlays can also be used with
Transformations such as tSNE (Figure 5.34). In the figure below, a single tSNE
population of unknown phenotype has been gated and its staining pattern
visualized over multiple parameters using the Add Parameter Overlays feature.
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Figure 5.34 Using tSNE with Parameter Overlays for Exploratory Data Analysis

5.1.3 2D Plots

2D Plots (two-dimensional) plots allow you to plot one parameter against
another parameter. 2D Plots have many shared formatting options  as well as
options that are specific for each plot type (please refer to the chapters below
for the specific options of a specific plot type).

Please see a detailed description of each plot type below:

o Dot Plots and Color Dot Plots

o Density Plots and Contour Plots

o Surface Plots

o Kinetics Plots  

Note: Dot, Density, Contour, and Color Dot plots all bin your data into a discrete
number of bins. Therefore, the dot size of these plots is related to the number of
bins that the data is being divided into. Scatter plots do not bin your data, but put
a symbol at the location of your data value. The symbol size is controlled by the
Formatting preferences. The binned plots are a better option when viewing data
sets containing large numbers of data points (i.e., >5000). Scatter plots are
more useful when displaying smaller numbers of data points, where
customization of the point shape and style are more important.

In all cases, statistics are derived from the raw underlying data, and not the
displayed or binned values. 

5.1.3.1 Dot Plots and Color Dot Plots

Dot Plots and Color Dot Plots represent each cell with an individual dot.
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Dot plots always display the dots in the overlay color which by default is black.

With Color Dot Plots, the color can represent:

· If there is only one overlay on the plot, the colors refer to which cells fall into

which gate . If one dot belongs to more than one gate, the color of the dot
will be randomly chosen among the gate colors.

· If there is more than one overlay on the plot, the color refers to which overlay

that dot belongs to. If one dot belongs to more than one overlay, the color of
the dot will be randomly chosen among the overlays.

Dot Plots and Color Dot Plots may also be Shaded Based on Density .

All aspects of Dot Plots and Color Dot Plots may formatted. 

Please see related formatting options:
· Formatting Options Shared by All Objects  (General, Background/Fill,

Border/Line, Size)
· Formatting Features Shared by All Plots  (Title, Legend, Axes)

· Formatting Options Shared by All 2D Plots  (Quadrants, gate Display, Plot

Specific Options)
· Dot and Color Dot Plot Overlays Options

5.1.3.1.1  Dot and Color Dot Plot Overlays

All 2D plots have at least one overlay representing a file and two parameters to
display. With certain 2D plots (e.g., Dot, Color Dot and Scatter ), you can add
additional overlays, by any of the following methods:

· Right-click on the plot and select Add overlay from the pop-up menu. This

launches either the Select Data File or the Open Data File dialog
depending on the Open Data Dialog user Options ; or 

· Right-click on the plot and select Add Overlay using Advanced Open

Data Dialog (launches the Advanced Open Data File  dialog), or 
· Drag-and-drop file(s) from the Data List  onto the plot you wish to

overlay, or
· Drag-and-drop a plot from the layout onto the plot you wish to overlay.

You can always format an overlay by:
· right-clicking on a plot (or double-clicking on it if it is already selected), selecting

Format from the pop-up menu, and choosing Overlay from the drop down. 
· select the plot and choose the Overlay category from the Format tab of the

Ribbon . 
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The Formatting Overlays dialog controls the parameters and appearance of 2D
overlays.

In the Formatting Overlay dialog (Figure 5.35), a list of all the overlays on the
plot will appear in the Options box at the top. When multiple overlays are
present, you can select one or more overlays using standard Microsoft Windows
techniques, including Shift-Click and Ctrl-Click. You may also multiple select all
overlays via the Ctrl+A command, or right clicking and choosing to Select All or
Invert Selection. 

The properties on the bottom of the window pertain to the currently selected
overlay(s). If multiple overlays are selected, the information will appear blank for
those properties that are not identical in all selected overlays. If the properties
are not blank, then they are identical for all selected overlays. Changing an option
will change that property for all selected overlays. For instance, if you select
three overlays and change the Gate, the Gate for all three overlays will be
modified. 

To remove an overlay from a plot, select the overlay (or multiple overlays) and
press the Remove button. 

To change the order of selected overlay(s) in the legend , use the blue up and

down arrows ( ).

For a brief tutorial on how to use overlays, visit us at
https://youtu.be/nVqwvDo1RmA. 

For Dot plots and Color Dot plots the following overlay options are available:
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Figure 5.35  Formatting Overlays Dialog for 2D Dot
Plots

Option Explanation

X Parameter Change the parameter displayed on the X axis.

Y Parameter Change the parameter displayed on the Y axis.

Gate If gates are defined , select the gate that will be used to limit
the data that is displayed on the 2D plot.

Compensation If compensation definitions  are set, select the definition to use
when compensating the data in the overlay.

Transformation If transformations are defined , select the transformation to use
when displaying the data in the overlay.

Color The color that the overlay will be drawn in (used for dot plots and
color dot plots). The default overlay colors can be set on the 2D
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Option Explanation

plot preferences page of the FCS express User Options Dialog .

Dot Size FCS Express automatically calculates the dot size based upon the
height and width of your plot. By changing this setting, you can
force the dot size to be larger or smaller than what FCS Express
calculates by the factor chosen in the spin box. Note: If you are
using several overlays on color dot plots, and you want the
overlays to have different dot sizes, then the plot must be set with
Dither turned off .

Emphasize Low
Frequency
Populations

If the % gated  for a given gate is < 2%, the dot size for those
gated events will increase.  Only available for Dot  plots
displaying gate colors and Color Dot plots .

Legend Text The text that will appear in the legend beside the symbol for the
overlay. Free text can be inserted. If this field is blank the file
name of the overlay will appear.
A dropdown menu with additional pre-customized legend content is
accessible by pressing the ellipsis button next to the legend text.
Possible choices are:
o Keyword. This can be used to insert keywords from the header

of the data file.
o Gate. This can be used to display the current gate applied to

the overlay.
o Tube Number. This can be used to display the Tube Number of

the overlay when a Panel  is active.
o Tube Name. This can be used to display the Tube Name of the

overlay when a Panel  is active.
The above mentioned Legend options apply only to Dot Plots,
Color Dot Plots, Histograms and Spectrum Plots.

Smoothing Set the degree of smoothing for the presentation of your data.

Change data file
during
Next/Prev/Batch

If this option is checked, the data file for this overlay will change
when doing batch processing , or selecting Previous File or Next
File . This option is usually only disabled for control histograms,
where you have multiple overlays, and want the control to stay the
same all of the time.

Visible Controls whether or not to display this overlay on the 2D plot. If
unchecked, Gate and Quadrant Statistics  will be hidden for the
selected overlay.

Perform Baseline
Offset

If the value of the cell is zero, a random offset will be added so
that the dot appears off the axis. This will not affect the statistics.
 This option is typically used when analyzing LMD files from
Beckman Coulter.
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5.1.3.2 Density and Contour Plots

Density Plots and Contour Plots represent events with a density gradient or
contour gradient depending on the number of events.

Density Plots - In a density plot, the color of an area reflects how many events
are in that position of the plot. Density plots may also be formatted to base the
color gradient on  the values of a different parameters.

Contour Plots - In a contour plot, the color and distribution of lines on the plot
reflects how many events are in that position, much like a topographical map.
Contour plots may also be formatted to display multiple files or populations on a
single plot using Overlays.

All aspects of Dot Plots and Color Dot Plots may formatted.

Please see related formatting options:
· Formatting Options Shared by All Objects  (General, Background/Fill,

Border/Line, Size)
· Formatting Features Shared by All Plots  (Title, Legend, Axes)

· Formatting Options Shared by All 2D Plots  (Quadrants, gate Display, Plot

Specific Options)
· Color Levels Options

· Density and Contour Plot Overlays Options

5.1.3.2.1  Color Levels

The Color Levels options are used to control how Density and Contour plot
are colored. The significance of each color level can be displayed in the plot
legend . In FCS Express 4, 25 discrete color levels were used to generate
gradients in Density and Contour Plots.  Since FCS Express 5, Density plots are
rendered in 256 discrete color levels, resulting in a smoother color gradient.   

 You can edit the Color Levels for Density or Contour plots in one of two
ways:

· Select Density or Contour plot(s) and select Format 2D Options

Levels from the ribbon bar (Figure 5.36). 

· Right-click on a Density or Contour plot, select Format from the pop-up

menu, and choose Color Levels from the drop down. 
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Figure 5.36  Contour Level Options

For Density and Contour plots, each bin is colored based on the value that bin
has for a specific parameter. By default, both Density and Contour plot are
colored based on density, thus based on the number of events included in each
bin. However, since FCS Express 6, any parameters can also be used to
represent a density color shading. The parameter the color is based on is the one
shown in the legend  and can be changed both through the legend itself and
through the Overlay  dialog (see the Color based on  option).

Note: Colors are calculated taking into consideration both Plot Resolution  and
Smoothing . The plot legend reports the actual values used to calculate the
color.

Three options can be selected to customize the way bins are colored:

1.  Color Level

Color level options define the color palette (Figure 5.37).
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Figure 5.37 Color level choices for Density (left) and Contour (right) plots

 

The choices for Color Level differ between these plot types:

Density Plot Color Levels Contour Plot Color Levels

Absolute
B&W Stripes
Color Blind*

Flame
Green-Black-Red

Greyscale
Inferno

Inverse Greyscale
Magma

Percentile
Plasma
Rainbow

Viridis

Absolute
Black

Black & Grey - 20 level
Black & Grey - 8 level

Color Blind*
Flame

Green-Black-Red
Greyscale - 20 level
Greyscale - 50 level
Greyscale - 8 level

Inferno
Inverse Greyscale - 20 level
Inverse Greyscale - 50 level
Inverse Greyscale - 8 level

Magma
Percentile
Plasma
Rainbow

Viridis
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*Both plot types offer a Color Blind option derived from the color palettes
recommended in Getting into Visualization of Large Biological Data Sets: The 20
Imperatives of Information Design by Martin Kryzwinski et al. More options may

be added as requested.

Inferno, Magma, Plasma and Viridis color levels are inspired by the "Viridis"
palette for R.  

When you select a color level category, the colors in the chosen palette will be
displayed in the bottom half of the dialog.  In addition, the Preview and Restore
buttons  in the Format dialog provide a convenient means for evaluating each
color scheme with your data. Note that the Preview and Restore buttons  are
available only when the Format dialog is accessed by right clicking on the plot.
They are not available when the Format dialog is accessed via the Ribbon bar.

Most of the Color Level schemes are simply defined by their names, ie, Green-
Black-Red uses those colors in the scheme, but two may require further
explanation:

· Absolute. Color levels may be defined by the user based on absolute

values (see below, Color Level Properties). If Calculate Levels based
on data is checked, color levels are instead defined by the software. 

· Percentile. Color levels may be defined by the user based on percentiles

(see below, Color Level Properties). If Calculate Levels based on
data is checked, color levels are instead defined by the software.

The color for an individual level can be changed by selecting the color and
clicking the ellipsis inside the color box. A level can be added or removed by

selecting the appropriate level and pressing the  (Add) or  (Remove)
buttons.  To access these settings for plots displaying Color Levels other than
Absolute and Percentile, uncheck Calculate all levels based on data .  

When selecting greyscale, the shades of gray are automatically displayed for
you. You will not be able to edit the shades for an existing level. 

You can return to the Rainbow style (or your current default option for 2D
Contour or Density plots ) by clicking on the Restore selected level to
default values button. Clicking the Default button will also update any plots
created in a Version 4 layout to the newest default color palette for the current
version. 

2.  Style
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Style options defines how color levels are used to color the data. 

· Fixed range. The range of the data in the parameter that was selected

for the coloring is divided into evenly spaced color levels. Settings may
also be manually defined rather than based on data.

· Percentile. The range of the data in the parameter that was selected for

the coloring is divided into color levels, so that each color level contains
the same number of data causing the colors to be centered around the
median. Settings may also be manually defined rather than based on
data.

· Mean +- SD. The range of the data in the parameter that was selected

for the coloring is divided into color levels, so that the central level is
centered around the mean of the data and the color shapes are normally
distributed based on the standard deviation specified by the user.

· Threshold. The range of the data in the parameter that was selected for

the coloring is divided into only two levels regardless of the Color Level
selected. The two colors can be customized by the user. The color of
each bin will be decided based on the threshold specified by the user. 

 
3.  Color Scaling

When Logarithmic is selected, the data (i.e. bin values) are log-
transformed before dividing the range of the data into color levels. 

4.  Unchecking Calculate all levels based on data - Manual Settings
          

For Fixed range and Percentile styles you may uncheck the Calculate
all levels based on data check box to manually define your color level settings
or fix the low and high levels with two settings.

· Specify the low and high level; the rest will be calculated

automatically, Figure 5.38: User may enter any value within limits for
the low and high bounds of the color levels. Intermediate increments for
the color levels will be calculated automatically using the current Color
Level choice. This option is particularly useful when comparing plots with
tSNE transformations applied and visualizing different color based on
parameters in order to visualize color mappings within the same
range/scale. 
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Figure 5.38 - Choosing Specify the low and
high levels; the rest will be calculated

automatically allows users to set a fixed low
and high bound for color scaling. 

· Specify all levels: The user may specify any levels manually by clicking

on the green + button to add a value or the red - button to remove a
color level. Alternatively, you may click on the yellow gear icon to launch
the Increment Information dialog, Figure 5.39,  to more automatically
set increment levels based on user input of the lowest and highest color
level, and how many increments to add in between. The Increment
Information dialog will allow you to adjust the following settings in the
table below.
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Figure 5.39 - The Select an increment value dialog allows you to
automatically set increments for color levels based on the

desired low value, high value, and increment value between
discreet color levels to use. 

Setting Definition

Current value of lowest
level

the value of the lowest color level currently showing
on the plot.

The value of the lowest
level will be

the new value of the lowest color level you would like
to set.

Set the levels to
increments of

the incrementation value between discreet color
levels that you would like to set. 

Current value of highest
level

the value of the highest color level currently showing
on the plot.

The value of the highest
level will be

the new value of the highest color level you would like
to set

The color gradient created will be based on the colors of the first and
last color in the list, figure 5.40. For instance, if the first color level is
purple and the last color level is black you will arrive at a purple to black
color gradient. Clicking on ellipsis button (...) on the individual color
levels will reveal the color palette to choose which colors to use for the
first and last color level.  
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Figure 5.40 - The first and last color levels in the list will determine the beginning
and ending colors for the gradient. Clicking on the ... button within the color will

allow you to pick a new color for the color palette. 

Examples

Figure 5.41 below depicts some examples of plots colored with different
combinations of Color Levels, Styles and Color Scaling:
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Figure 5.41. Example of different color combinations. The text below each plot
reports the Color Levels, the Styles and the Color Scaling used. Additional setting

(e.g. "Calculate Levels based on data"  and "Standard Deviation") are also
reported.

5.1.3.2.2  Density and Contour Plot Overlays

All 2D plots have at least one overlay representing a file and two parameters to
display. With certain 2D plots (e.g., Dot, Color Dot, Contour and Scatter), you
can add additional overlays, by any of the following methods:

· Right-click on the plot and select Add overlay from the pop-up menu. This

launches either the Select Data File or the Open Data File dialog
depending on the Open Data Dialog user Options ; or 

· Right-click on the plot and select Add Overlay using Advanced Open

Data Dialog (launches the Open Data File  dialog), or 
· Drag-and-drop file(s) from the Data List  onto the plot you wish to

overlay, or
· Drag-and-drop a plot from the layout onto the plot you wish to overlay.

Note that Density plots only allow one overlay representing a single data file to
be displayed.
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The Formatting Overlays dialog controls the parameters and appearance of 2D
overlays. You can access the format dialog by:
· right-clicking on a plot (or double-clicking on it if it is already selected), selecting

Format from the pop-up menu, and choosing Overlay from the drop down. 
· select the plot and choose the Overlay category from the Format tab of the

Ribbon . 

In the Formatting Overlay dialog (Figure 5.42), a list of all the overlays on the
plot will appear in the Options box at the top. When multiple overlays are
present, you can select one or more overlays using standard Microsoft Windows
techniques, including Shift-Click and Ctrl-Click. You may also multiple select all
overlays via the Ctrl+A command, or right clicking and choosing to Select All or
Invert Selection. 

The properties on the bottom of the window pertain to the currently selected
overlay(s). If multiple overlays are selected, the information will appear blank for
those properties that are not identical in all selected overlays. If the properties
are not blank, then they are identical for all selected overlays. Changing an option
will change that property for all selected overlays. For instance, if you select
three overlays and change the Gate, the Gate for all three overlays will be
modified. 

To remove an overlay from a plot, select the overlay (or multiple overlays) and
press the Remove button. 

To change the order of selected overlay(s) in the legend , use the blue up and

down arrows ( ).

For a brief tutorial on how to use overlays, visit us at
https://youtu.be/nVqwvDo1RmA. 

For Contour and Density plots, the following overlay options are available (see
table below).
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Figure 5.42  Formatting Contour or Density Plots

Option Explanation

X Parameter Change the parameter displayed on the X axis.

Y Parameter Change the parameter displayed on the Y axis.

Color based on Choose from Count or available parameters to base the density
display color palette on. For instance if FSC and SSC are displayed
on the X and Y and FL1 is chosen for Color Based on then the
density display will represent the distribution of FL1 fluorescence on
the FSC vs SSC plot. Using Color Based on is a common and useful
display type for working with tSNE transformed data sets  where1002
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Option Explanation

it is useful to view tSNE X vs tSNE Y parameters on separate plots
for each measured parameter with the Color based on for each
plot representing a different parameter. The parameter used by this
option, can also be selected via the legend title .

Gate If gates are defined , select the gate that will be used to limit
the data that is displayed on the 2D plot overlay.

Compensation If compensation definitions  are set, select the definition to use
when compensating the data in the overlay.

Transformation If transformations are defined , select the transformation to use
when displaying the data in the overlay.

Legend Text The text that will appear in the legend beside the symbol for the
overlay. If this field is blank the file name of the overlay will appear.
Insert keywords from the header of the FCS file by pressing the
ellipsis next to the legend text. You can also display the current
gate applied to the overlay by inserting "<$FCSE_GATEFORMULA>"
into the legend text.

Smoothing Set the degree of smoothing for the presentation of your data.
Smoothing is performed with a box-filter algorithm. The Smoothing
parameter controls how many iterations of smoothing are
performed. 

Overlay Color
(only available for
Contour Plots)

The color that the overlay will be drawn in. The default overlay
color for the first overlay can be set on the 2D plot preferences
page of the FCS express User Options Dialog .

Outlier Display
Mode

Choose from Do not show, Use color below, Use lowest color
level. Do not show will not display any outliers; Use color below
will use the Outlier Dot Color chosen in the drop down below for
the outlier color; Use lowest color level will set the color of the
outliers to the lowest color level displayed in the density plot. 

Outlier Dot Color If Use color below is chosen then the Outlier Dot Color selected
in the color palette will be used to display outliers. 

Outlier Dot size Choose the size of the dots used to display outliers. 

Change data file
during
Next/Prev/Batch

If this option is checked, the data file for this overlay will change
when doing batch processing , or selecting Previous File or Next
File . This option is usually only disabled for control histograms,
where you have multiple overlays, and want the control to stay the
same all of the time.

Visible Controls whether or not to display this overlay on the 2D plot.

Perform Baseline
Offset

If the value of the cell is zero, a random offset will be added so
that the dot appears off the axis. This will not affect the statistics.
 This option is typically used when analyzing LMD files from
Beckman Coulter.

Examples

Figure 5.43 below depicts some examples of contour plots with different
combinations of colored overlays, based on different gates or multiple files:
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Figure 5.43. Example of Contour Plot Overlays. (Left) Each overlay represents
data from different files, with each files data colored uniquely. (Right) Each

overlay represents data from the same file, with each color corresponding to a
different gated population.

5.1.3.3 Surface Plots

Surface Plots provide users a unique way to visualize two parameters plus
counts on a single plot (Figure 5.44).

All aspects of Surface Plots may be formatted. 

Please see related formatting options:
· Formatting Options Shared by All Objects  (General, Background/Fill,

Border/Line, Size)
· Formatting Features Shared by All Plots  (Title, Legend, Axes)

· Formatting Options Shared by All 2D Plots  (Quadrants, gate Display, Plot

Specific Options)
· Surface Plot Overlay Options

· Plot 3D Options
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Figure 5.44 Example of Surface Plot.

5.1.3.3.1  Surface Plot Overlays

All 2D plots have at least one overlay representing a file and two parameters to
display.

You can format an overlay by:
· Right-clicking on a plot (or double-clicking on it if it is already selected),

selecting Format from the pop-up menu, and choosing Overlay from the
dropdown. 

· Select the plot(s) and choose the Overlay category from the Format tab of

the Ribbon . Formatting from the ribbon will open a formatting options dialog
in a dockable window that will apply changes as they are made.

The Formatting Overlays dialog controls the parameters and appearance of 2D
overlays.

For Surface plots, the following overlay options are available (Figure 5.45).
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Figure 5.45  Formatting Overlays Dialog for Surface
Plots

Option Explanation

X Parameter Change the parameter displayed on the X axis.

Y Parameter Change the parameter displayed on the Y axis.

Gate If gates are defined , select the gate that will be used to limit
the data that is displayed on the 2D plot.

Compensation If compensation definitions  are set, select the definition to use
when compensating the data in the overlay.

Transformation If transformations are defined , select the transformation to use
when displaying the data in the overlay.

Color The color that the overlay will be drawn in (used for dot plots and
color dot plots). The default overlay colors can be set on the 2D
plot preferences page of the FCS express User Options Dialog .

Legend Text The text that will appear in the legend beside the symbol for the
overlay. Free text can be inserted. If this field is blank the file
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Option Explanation

name of the overlay will appear.
A dropdown menu with additional pre-customized legend content is
accessible by pressing the ellipsis button next to the legend text.
Possible choices are:
o Keyword. This can be used to insert keywords from the header

of the data file.
o Gate. This can be used to display the current gate applied to

the overlay.
o Tube Number. This can be used to display the Tube Number of

the overlay when a Panel  is active.
o Tube Name. This can be used to display the Tube Name of the

overlay when a Panel  is active.
The above mentioned Legend options apply only to Dot Plots,
Color Dot Plots, Histograms and Spectrum Plots.

Smoothing Set the degree of smoothing for the presentation of your data.

Change data file
during
Next/Prev/Batch

If this option is checked, the data file for this overlay will change
when doing batch processing , or selecting Previous File or Next
File . This option is usually only disabled for control histograms,
where you have multiple overlays, and want the control to stay the
same all of the time.

Visible Controls whether or not to display this overlay on the 2D plot.

Perform Baseline
Offset

If the value of the cell is zero, a random offset will be added so
that the dot appears off the axis. This will not affect the statistics.
 This option is typically used when analyzing LMD files from
Beckman Coulter.

5.1.3.4 Kinetics Plots

Kinetics experiments are particularly useful for examining changes in DNA
content, antibody binding, and calcium flux over time.  For example, calcium ions
play an important role in cell signaling. The intracellular concentration of calcium
ions often show transient changes in response to external stimuli. Several
fluorescent dyes can be used to measure bound Ca++ by flow cytometry,
including Indo-1 (which requires a UV laser) and a combination such as Fluo-3
and Fura Red, which can be used in instruments limited to excitation at 488 nm.
Fluo-3 (with maximal fluorescence at 530 nm) increases its fluorescence with
increasing Ca++ concentration. Fura Red (maximal fluorescence at 650 nm)
decreases its fluorescence with increasing Ca++ concentration. The ratio of Fluo-3
to Fura Red fluorescence can be used to follow changes in Ca++ concentration
over time.

5.1.3.4.1  Inserting a Kinetics Plot

In Kinetics analysis, the X-axis value is Time. Cells are usually stimulated by
adding one or more drugs after a baseline is established at the beginning of the
experiment.
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Kinetics plots are a special subset of one dimensional plot that automatically
average all of the Y-axis values per unit of Time and displays one dot (chosen
from Mean, Geometric Mean, Median or %  Above Threshold) for each X-axis
value (along with the option of displaying the standard deviation of the Y-axis
value in color).

To insert a Kinetics plot, use the Insert 2D Plots Kinetics command. If
necessary, change the X-axis parameter to Time and format the X-axis range or
resolution to suit your experiment (right-click on the histogram, choose Format
from the pop-up menu, and select Axis from the dropdown to adjust the range
or the Binned Plot Specific Options to set the resolution).

An example of a Kinetics plot is shown in Figure 5.46.

Figure 5.46  Kinetics Histogram (Median
FL1-H vs  Time). Standard Deviation

shown in red.

5.1.3.4.2  Formatting a Kinetics Plot

All aspects of Kinetics Plots may be formatted and the Overlays category
has important properties which control their appearance.

Please see related formatting options:
· Formatting Options Shared by All Objects  (General, Background/Fill,

Border/Line, Size)
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· Formatting Features Shared by All Plots  (Title, Legend, Axes)

· Formatting Options Shared by All 2D Plots  (Quadrants, gate Display, Plot

Specific Options)
· Surface Plot Overlay Options

· Plot 3D Options

5.1.3.4.2.1  Overlays

When formatting Kinetics plots, the Overlays category has important properties
which control their appearance. You can format these properties in one of two
ways:

· Select the Kinetics plot and use the Format Plot Options Overlays

command.

· Right-click on the Kinetics plot, select Format from the pop-up menu, and

choose Overlays from the dropdown (Figure 5.47).
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Figure 5.47  Formatting Kinetics Overlays

Choose a Plotting Value, which represents either the method used to average
the Y-axis values (Mean, Geometric Mean, Median, Count) or the % Above
Threshold.  Count represents events versus Time (i.e., event rate). If there are
no problems running the sample, Count should be relatively constant.

Using % Above Threshold as a plotting value (Figure 5.48) is useful to
determine what percent of the cells responded in the kinetics analysis. A
threshold value (set in the Threshold field) can either be set manually after
determining a cut-off value from the Y-axis or by inserting one or more statistic
token(s) into a formula .1300
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Figure 5.48  Plotting the % Above
Threshold Value

The Show Standard Deviation check box controls whether or not one standard
deviation of the Y-axis value is shown (in red) around the plotted value.

5.1.3.4.3  Kinetics Statistics

To display kinetics statistics in a default statistics table(Figure 5.49), right-click on
the Kinetics plot and select Kinetics Statistics from the pop-up menu.  Kinetics
statistics can also be inserted as tokens  anywhere on your layout.

Figure 5.49  Kinetics Statistics

The default kinetics statistics are explained in the table below.  See Formatting
Statistics  to choose which statistics to display.

Statistic Explanation

Overlay Number If there are multiple overlays visible on a plot, the statistics will be
calculated for every overlay on the plot. Overlay # displays the
overlay number for that row of statistics. The overlay number
corresponds to the position in the overlay list on the Overlays page
of the Format window.

Overlay Legend The default legend is the file name. The legend can be changed in
the Legend Text field of the Overlays page of the Format window.
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Statistic Explanation

Gate The gate for which the statistics apply. This region is the 1D gate
on the time parameter.

Start Time The time at the left marker boundary, or the left boundary of the
plot if there is no gate defined.

End Time The time at the right marker boundary, or the right boundary of the
plot if there is no gate defined..

Elapsed Time End Time minus Start Time.

Peak Value The Y-axis value at the peak.

Peak Time The X-axis value (Time) at the peak.

Start to Peak
Elapsed time

Peak Time minus Start Time.

Start to Peak Slope The slope from the left marker boundary to the peak, or from the
left boundary of the plot to the peak.

Start to End Slope The slope from the left marker boundary to the right marker
boundary.

Rising Phase
Baseline

What the algorithm determined was the baseline prior to the rising
phase starting.

Start Rising Phase The time at which the algorithm determined the rising phase started.

Rise to Peak
Elapsed Time

Peak time minus Start Rising Phase.

Rise to Peak Slope The slope from Start Rising Phase to Peak Time.

Area Under the
Curve

Area under the curve in units of the Y-axis.

Kinetics statistics can be calculated and displayed for the entire plot, or for gated
events.  Drawing gates on kinetics plots is advisable when the left boundary of
the plot is not a reliable indicator of the baseline (e.g., when the signal is
unsteady at the beginning of acquisition, or when a drug is added and the return
to baseline is delayed).  In such a case, the user may wish to define the baseline
by creating a 1D gate  on the Time parameter of the Kinetics plot.  The left
boundary of the 1D gate will define the Start Time statistic and the baseline, and
the right boundary the End Time statistic.

The algorithm is designed to automatically detect the beginning of the rising
phase and the peak.

5.1.3.4.4  Kinetics-Specif ic Tokens

All of the Kinetics statistics can be used as tokens . Kinetics tokens can be
inserted into text boxes , used in Custom Token  or Alert formulas, and
exported to reports during batch processing .

To insert a Kinetics statistics token into a text box:

1.  Insert a text box using the Insert General Text Box command.
2.  Right-click on the text box and select Insert Token.
3.  Choose Statistic and click on the Insert button to bring up the Create

Statistic dialog.
4.  Choose a Kinetics plot as a Data Source.
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5.  Choose the Statistic category.
6.  Choose Kinetics Statistics from the Select a Statistic drop down. 
7.  Select the Gate, if any, (Figure 5.50). Choose one or multiple statistics

from the list box, then click OK.

Figure 5.50  Creating a Kinetics Statistics Token

5.1.3.5 Formatting Options Shared by All 2D Plots

In addition to the formatting options common to all objects , and those
common to all plots , 2D plots have certain properties which can be formatted:

· Overlays

· Quadrants

· Gates to display

· Color levels  for density and contour plots

· Specific options  

Each 2D plot type has additional options which may be formatted:

· Dot Plot and Color Dot Plot (Overlays )

· Density plots and Contour Plots (Overlays  and Color Levels )

· Surface plots (Overlays )
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You can always format a plot by:
· Right-clicking on it (or double-clicking on a plot that is already selected),

selecting Format from the pop-up menu, and choosing a category to format.
This method will allow you to use the Preview and the Restore buttons to see
what the changes would look like without actually accepting the changes

· Select the plot(s) and choose the desired category from the Format tab of the

Ribbon . Formatting from the ribbon will open a formatting options dialog in a
dockable window that will apply changes as they are made. 

5.1.3.5.1  Quadrants

The Quadrants category allows you to manipulate the quadrants on a 2D plot.
Quadrants can also be created and their positions adjusted directly from the
plot .

You can edit quadrants in one of two ways:

· Select the 2D plot(s) and use the Format  Options

command. 

· Right-click on the 2D plot, select Format from the pop-up menu, and

choose Quadrants from the dropdown (Figure 5.51).
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Figure 5.51  Formatting Quadrants dialog

The options on the left side of the dialog are explained in the table below.

Option Explanation

Type The type can be one of the following:
· Standard: All four quadrants are rectangular.
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Option Explanation

· Floating: Quadrants can be any shape
· X Percentile: The quadrants are rectangular, and the X position

of the quadrant is determined automatically based on the value in
the X Percentile edit field. Please refer to the note at the bottom
of this chapter  for details about how out of range events are
handled by percentile quadrants.

· Y Percentile: The quadrants are rectangular, and the Y position
of the quadrant is determined automatically based on the value in
the Y Percentile edit field.Please refer to the note at the bottom
of this chapter  for details about how out of range events are
handled by percentile quadrants.

· Both Percentile: The quadrants are rectangular, and the X and Y
positions of the quadrant are determined automatically based on
the value in the X Percentile and Y Percentile edit fields,
respectively. Please refer to the note at the bottom of this
chapter  for details about how out of range events are handled
by percentile quadrants.

Line color and
thickness

The color and thickness that the quadrant lines will be drawn in.

Visibility Choose to show the quad "True", hide a quad without removing it
"False", or make it visible based on a conditional value "Custom". The
Custom option allows you define visibility of the quad based on a token
or value that evaluates to a conditional expression . Any tokens or
values may be used to set a conditional custom value and may be
inserted  via right click in the field, Insert Token or by clicking on the
T token icon. The quad will only be visible if the token evaluates to
True.

Allow Move Choose to allow moving the quad "True", disallow a quad move "False",
or make moving the quad based on a conditional value "Custom". The
Custom option allows you define the move status of the quad based on
a token or value that evaluates to a conditional expression . Any
tokens or values may be used to set a conditional custom value and
may be inserted  via right click in the field, Insert Token or by
clicking on the T token icon. The quad will only be allowed to move if
the token evaluates to True.

Quadrant
vertices

The precise coordinates of the quadrant vertices. These can be entered
manually for precise control over quadrant positioning. Note: Quadrants
are stored in 256x256 resolution; therefore, not all possible values for
quad vertices will be available.

Overlay to use Which overlay to use when calculating the percentiles for the X
Percentile and Y Percentile quadrant types.

X Percentile Which percentile to use for the X Percentile and Both Percentile
quadrant types.

Y Percentile Which percentile to use for the Y Percentile and Both Percentile
quadrant types.

Quadrant Linking Options

Quadrants can either be linked to other quadrants  or to gates . You can
change the current links from the Linking Options area of the dialog.
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To change the quadrant to quadrant link, select Quad to Quad and choose the
plot you want to link to the current plot. The quadrants on the current plot will
become a "slave" to the quadrants on the linked plot, i.e., when the properties of
the quadrants on the linked plot change, the quadrants on the current plot will
also change. For example, by linking plots to an isotype control plot, the
quadrants in the linked plots will automatically adjust if the isotype control
quadrants are adjusted.

If quadrants on the plots have been converted and linked to gates , these links
can be changed or broken in the Quad to Gate dialog. The dialog will appear
similar to Figure 5.52.

Figure 5.52  Linking Quad to Gate

In order to change or break the link, select the down arrow to the right of the
drop-down list. Select No Link to break the link between the quadrant and the
region. Below the No Link item will be a list of gates previously linked to other
quadrants on this plot, and now available for linkage to the selected quadrant. A
gate can only be linked to one quadrant in a layout. If the desired gate does not
appear in the drop-down list, it is already linked to another quad on the current
plot or is not derived from these quadrants at all.

Notes regarding percentile quadrants and out of range events

Sometimes a considerable number of events are out of range for a given
parameter and thus are assigned to have the maximum value for that
parameter. If the top X% of events all equal the maximum value on the plot then
the vertex of the last X percentiles will all be set at the maximum value. For an
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example in which the top 30% of events are all set to the maximum value for a
given parameter the vertex of all the percentiles quadrants above the 70th
percentile will all be set at the maximum value (Figure 5.53 below. Note the
middle two and far right plots.).

Figure 5.53 In this FCS file more than 30% of the events are set at the maximum
value for the SSC parameter. Percentile quadrants have been set at different

percentiles of the SSC parameter. Note that the vertex of percentiles from the 70th
percentile and above are all at the maximum values for the SSC parameter.

5.1.3.5.2  Gates To Display

The Gates to Display formatting options are for setting which gates to use to
color events. Gate display functions are available for dot plots, color dot plots,
spectrum plots and scatter plots. You can also choose which gates to display in a
data grid .

You can edit the Gates to Display in one of two ways:

· Select the plot(s) and use the Format  Options

command (Figure 5.54). 

· Right-click on the plot, select Format from the pop-up menu, and choose

Gates to Display from the dropdown. 

399



Plots and Other Objects 233

© 2023 De Novo Software

Figure 5.54  Formatting Gates to Display dialog.

If you have one overlay on a dot plot, the dots are shown in the gate color. If
you have more than one overlay, the colors will reflect the different overlays,
which are specified in the Overlays  section of the Format window.

By default, the All Gates option is selected. However, you can select Only the
gates checked below and then select the gates whose colors you wish to
display. Alternatively, select All gates except those checked below and then
choose the gates whose colors you do not wish to display.
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A right-click menu is available within the Gate to Display dialog as displayed in
Figure 5.55 below. The right click menu allows users to:

§ Expand/collapse All gates
§ Expand/Collapse All Children gates within the selected gate
§ Expand/Collapse Current Level (this expand only the first level of

children gates within the selected gate)
§ Check/Uncheck All gates
§ Check/Uncheck All Children gates within the selected gate
§ Invert Selection on All gates
§ Invert Selection on All Children gates within the selected gate
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Figure 5.55  The right-click menu avaialble within the Gates to Display
dialog.

In the When a new gate is created on the layout, should the gate color be
displayed? category you can also choose how to display the gate color when a
new gate is created on the layout. Possible choices are:

· No
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· Display the gate color on a back-gated plot Only if the new gate was

created on a plot showing the same data file (as the plot where the
new gate was created),

· Display the gate color on a back-gated plot Only if the new gate was

created on a plot showing the same parameters (as the plot where
the new gate was created).

· Yes

5.1.3.5.3  Specif ic Options

The Specific Options category contains properties to control the way data is
displayed on 2D plots.

You can edit 2D plot specific options in one of two ways:

· Select the 2D plot(s) and use the Format Plot Options

command. (Figure 5.56).

· Right-click on the 2D plot, select Format from the pop-up menu, and

choose Specific Options from the dropdown.
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Figure 5.56  Formatting Binned Dot Specific Options Dialog

The options are described in the table below. See Resolution Overview  for a
further description of resolution options.

Option Explanation

Cells to Plot Options Control how many cells are plotted. If fewer cells are
plotted, the plot can draw itself faster. Typically, most
of the structure of a plot can be seen if 5000 cells are
plotted. With the radio buttons, choose the cell
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Option Explanation

number range or number of cells plotted option.
Then, select a value from the drop-down list or enter in
freetext into the from and to boxes, as appropriate.
Statistics are always calculated based upon all of the
cells in the data set, irrespective of how many are
plotted.

Use channel calibration on
axes

FCS Express can establish calibrated values for the
axes . If channel calibrations are defined, toggling this
checkbox will determine whether or not to use the
calibrated values in place of the generic channel
numbers.

Plot Resolution Choose a resolution to display the data from the drop-
down list. Lowering the resolution effectively smoothes
the data.

Axis The resolution options can be changed for the X Axis/Y
Axis, or together. To edit the options for one of the
axes, select that axis in the list, and change the
options. The edit the options for both axes
simultaneously, select both axes in the list (Shift-Click).

Resoluti
on
Options
(please
refer to
the
Resolutio
n
Overview

chapter
for
details)

Automatic Minimum If checked, then FCS Express will start binning the data
(dividing it into the number of bins specified by the Plot
resolution) at either 0 or the lowest data value (if the
lowest data value is below 0).

Resolution Minimum Specify where to start binning the data. If Automatic
Minimum is checked, then this value is ignored.

Automatic Maximum If checked, then FCS Express will finish binning the data
(subdividing it into the number of channels specified by
the Plot resolution) at the highest value of the true
data range.

Resolution Maximum Specify where to finish binning the data. If Automatic
Maximum is checked, then this value is ignored.

Include out of range
values in gates and
quads

If checked, data values that are outside the resolution
options of the plot will be considered to be part of the
lower or upper channels. If a gate or quadrant touches
the lower or upper channels, it will include these cells,
even though the cells are actually outside the boundary
of the gate/quadrant.

Dither Color Dot Plots (Dot
plots and Color Dot plots only)

Determines which color to use when two dots of
different colors overlap each other (if you have more
than one overlay or an event is located in an area
where two gates overlap). If dither is on, the color will
be chosen randomly from one of the two colors. If dither
is off, only the most recent color will be used (i.e., if
you have two gates defined, the color for gate 2 will
always have priority over the color for gate 1, unless
gate 1 is dragged below gate 2 in the Gate View .)

Shade Based on Density (Dot
plots and Color Dot plots only)

(Figure 5.57)

On Dot plots and Color Dot plots, Shade Based on
Density creates a greyscale shading pattern based on
the density of plotted data. When gates are displayed
or when checked on a color dot plot the shading pattern
will be pseudo colored to match the color of the gate
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Option Explanation

displayed. A lighter shade represents a higher density.
Note that this option will not apply if multiple overlays
are displayed on the plot.

Figure 5.57 An example of color dot and dot plots shaded based on density.

5.1.4 Resolution Overview

The following overview on plot Resolution applies to:
· Histograms

· Kinetics plots

· Dot plots and Color Dot plots

· Density plots and Contour plots

· Surface Plots

The resolution options are located in the Formatting dialog in the
 category for histograms , and the

 category for the other plot
types listed above. The properties set for each plot type slightly differ but the
functionality is similar in all cases.

What is the resolution of a plot?

The resolution of a plot is the number of bins (channels) that data for each
parameter is subdivided into. Before displaying a plot, FCS Express assesses
the data and places events into the number of bins selected by the user. The
process is known as binning. The events in each bin are displayed on the
plots. When the resolution is lower, the same data gets placed into fewer
bins, meaning that the number of events in each bin will be higher resulting in
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histograms that appear "smoother" and 2D plots that appear "blocky".
Conversely, when resolution is higher, data gets placed into more bins,
meaning the number of events in each bin will be lower. Resolution values are
set as defaults for each plot type that are generally applicable for the majority
of data sets. While decreasing the resolution may help to smooth data, you
may eventually lose the overall "shape" of the data but decreasing resolution
too much. While increasing resolution may reveal more dots in a 2D plot it
may also eventually reduce the ability to define the overall "shape" of the
data. Additionally, increasing resolution on some plots in FCS Express may
reduce performance without adding any benefit to data visualization. 

FCS Express puts the assesses and places data into the bins according to the
scale  of the data file.

Note: Statistics are always calculated on the full range of data, regardless of
how the resolution is set on a particular plot.

In FCS Express, you can set the value of the resolution, and control the range of
data (minimum and maximum) that is displayed:

· Plot Resolution 

o For histograms (Figure 5.58), you can choose the range specified in the

data you are using, or set the resolution to a specific number chosen
from the Plot resolution drop-down list.

Figure 5.58  Histogram Resolution Options

o For 2D plots (Figure 5.59), choose from the Resolution drop-down list

(32 x 32 to 1024 x 1024).
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Figure 5.59  2D Plot Resolution Options

· Resolution Options (Range of Data - Minimum and Maximum)

FCS Express gives you the option of dividing the full range of data into the
resolution (number of bins) you specify, or to "cut out" either the top end
or the low end of the data. In most cases, it is preferable to leave the
resolution maximums and minimums at the default value, i.e., automatic.
There are two reasons you might want to set the minimum or maximum. 

1. In certain cases, some instruments may store outlier values in the data.
In general, outliers will simply represent noise, not significant data. If an
outlier data point is included when the plot is calculated, information may
be lost in a significant part of the range. In these a case, you can exclude
the extreme data point by setting a minimum or maximum value to use
for significant data points. 

2. You may want to set the minimum and/or maximum to provide
detailed zooming into a small range of values. 

· Include Out of Range values in gates and quads

If you have not chosen to use an automatic resolution minimum or
maximum, there could be data that is outside the visible portion of the
plot. You can choose whether or not to include this data in gates or quads
drawn on this plot by selecting include out of range values in gates and
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quads. If this option is checked, and the gate touches the edge of the
plot, values outside the range of that edge will be included inside the gate.
Values outside the edge of the plot will also be included in the appropriate
quad. 

Technical note: Axis Resolution and Statistics

In FCS Express, all the statistics are calculated on the raw data, irrespective of
the display scaling. However, when Gates and Quadrants are created, decisions
must be made in cases when an event falls on the line of the gate or quadrant.

In FCS Express, Gates and Quadrants are calculated and drawn in a binned space
with binning dependent on both the Scaling  and the Resolution
Minimum/Maximum  of the plot. In turn, the inclusion or exclusion of an event
on the border line of a gate or in a quadrant is highly dependent on the scaling of
the plot, and on the Resolution Minimum/Maximum, of the plot the
Gate/Quadrants was drawn on. 

When adjustments to the scaling or resolution of a plot are made, an event may
then fall to a different side of the border line of the gate/quadrant, and the user
may notice very slight changes in the statistics of gated events which are usually
minimal and make no impact on the interpretation of the results. 

Please refer to the Axis Scale and Statistics  chapter for more details.

5.1.5 Charts

The Charts category allow you to plot and visualize data in Bar charts, Pie,
Scatter, Scatter with Regression, Box and Whisker, and Levey Jennings plots.
Data may be derived from integrated Spreadsheets  or raw data files. Please
see a detailed description of each chart type below:

o Bar Plots

o Pie Charts

o Scatter Plots

o Scatter with Regression Plots

o Summary Charts

· Box and Whisker Plots

· Violin Plots
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· Beeswarm Plots

o Levey Jennings Plots

5.1.6 Other Plots

The Other Plots category allow you to select plots for more specialized analysis
including plate based data sets in Plate Heat Maps, Heat Maps based on gates,
Picture Plots, and Spectrum plots. Please see the detailed description of these
plot types below:

o Spectrum Plots

o Plate Heat Map

o Gate Heat Map

o Parameters Heat Map

o Picture Plots  

5.1.6.1 Spectrum Plots

Spectral flow cytometry is used to sample more parameters per single cell or
particle than traditional flow cytometry. In contrast to conventional flow
cytometers, spectral flow analyzers and sorters substitute mirrors, optical filters,
and photomultiplier tubes (PMTs) with a spectrograph and multichannel detector
to use fluorescence or Raman spectroscopy.

FCS Express has the capability to read and display raw spectral data from Cytek
and Sony instruments  through Spectrum Plots .  Spectral data plotted in
Spectrum plots links directly the standard flow cytometry single cell
measurements to allow seamless transitions between standard flow cytometry
analysis and spectral cytometry. Cytek and Sony spectral data sets have special
preferences for loading data sets that are managed via Spectral Data Instrument
Specific Settings . 

Unmixing of data sets from spectral instruments is also supported by FCS
Express.

Supported Data Formats:

· Cytek Instruments, SpectroFlo® Version 1.0: 

o Spectral data are stored with the standard .FCS file format; however, two

files will be produced, an "unmixed" data file and a "mixed" data file. The
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unmixed data file will have the same name as the mixed data file except it will
use a suffix of "_Unmixed" in the data file name. For instance:

sample1.fcs and sample1_Unmixed.fcs

§ The file containing the suffix of "_Unmixed" contains the FCS file data that
was unmixed via the Cytek system while the file with the standard file name
remains mixed.

§ To view spectrum plots for the unmixed data set, both data files must be
placed in the same source folder with the names matching except for the
"_Unmixed" suffix. 

§ To view spectrum plots for the mixed data set, only the original file without
the "_Unmixed" suffix must be present. 

· Cytek Instruments, SpectroFlow Version 2.0: 

o Spectral data are stored with the standard .FCS file format; however, two

files will be produced, an "unmixed" data file and a "raw" data file, which will
have the identical names but saved to different data folders, "Unmixed" and
"Raw," respectively, when exported from SpectroFlo®. The folders must be
kept with the same relative paths (i.e. within the same parent folder).

§ To view spectrum plots for the unmixed data sets, both raw and unmixed
data files must be present in their respective source folders with identical
.FCS file names. For instance:

Experiment folder
Raw folder > sample1.fcs
Unmixed folder > sample1.fcs 

.
§ To view spectrum plots for the mixed data set, only the raw, or mixed, file

must be present.  

· Sony Instruments: 

o Spectral data is stored with the .SRAW file format with both an .SRAW and

.FCS file being produced. To analyze data from Sony instruments in spectrum
plots the .sraw and .fcs files produced by the instrument must be placed in
the same source folder. The names of the .SRAW and .FCS files must match.

· Custom Format for "Virtual Spectral Data":

o FCS Express allows you to visualize any .FCS data files as a "Virtual Spectral"

data file via the addition of special keywords to the data set or more easily
via use of the Merge to Spectra pipeline  step.  A virtual spectra parameter1053
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may be created by indicating the original parameter channels to use in a
spectral plot. For instance, you may choose to include FL1, FL2, FL3, FL4, etc
as the parameters used to create a virtual spectral parameter for the data
set and then use all of the standard Spectrum Plot  functionality in FCS
Express for further exploration and analysis of the data set. 

§ An Extra Keywords  file may be created to include all of the necessary
keywords to produce a virtual spectral data file and the Merge to Spectra
pipeline  step may facilitate easy creation of the needed file. 

§ Keywords necessary for creating virtual spectral data:

Please note the necessary keywords can be automatically created using the
Merge to Spectra Pipeline step  

Download Example Virtual Spectral Data extra keywords file

Keyword Explanation Examples

FCSE_SPECTRA1N
AME=

Required: Indicates the name of
the new spectral parameter.  The
value of this keyword is up to the
discretion of the user.

FCSE_SPECTRA1NAME=F
L

or

FCSE_SPECTRA1NAME=Vi
rtual Spectra

FCSE_SPECTRA1PA
RAMETERS=

Required: Indicates which
parameters to use to create the
virtual spectral parameter.

Parameters can be listed using
one of the following notations:
· Parameter Name (i.e. the $PnN

keyword)
· The label defined by your user

preferences for Keyword for
Parameter Matching. 

Mixing the two notation (i.e. using
the $PnN for some parameters
and the label defined by your user
preferences for Keyword for
Parameter Matching for some
other parameters) is also
possible.

FCSE_SPECTRA1PARAMET
ERS=FL1-H,FL2-H,FL3-H

or

FCSE_SPECTRA1PARAMET
ERS=FITC-A,PE-A,PerCP-
A,APC-A

or

FCSE_SPECTRA1PARAMET
ERS=V445-H,V530-
H,V586-H,V615-H,V660-
H

or
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For each entry in the list FCS
Express first tries to match the
$PnN keywords and, if the match
does not occur for one or more
entries, FCS Express tries to
match the label defined in the user
preferences for Keyword for
Parameter Matching. 

It is suggested to list all
parameters using the $PnN since
this will speed up the virtual
spectra creation, especially for
data with a lot of parameters.

Regular Expressions (RegEx) can
also be used to define multiple
parameters in an easier way. The
regular expression must be
entered using the RegEx:<regular
expression here> formula (please
see examples at the right).
To learn more on Regular
Expression, please refer to
https://en.wikipedia.org/wiki/Reg
ular_expression .

FCSE_SPECTRA1PARAMET
ERS=RegEx:<^FL>,SSC-
A
The regular expression
matches all the
parameters starting with
FL. The SSC-A directly
select the SSC-A
parameter. The spectra
will be made of all the FL
parameters and the SSC-
A parameter.

FCSE_SPECTRA1LA
BELS=

Required:Indicates the labels to
be used for each channel in
Spectrum Plots.

For example, the value for this
keyword can be sequential
numbers or simply the same
string of text that was entered for
FCSE_SPECTRA1PARAMETERS.

FCSE_SPECTRA1LABELS=
One,Two,Three

or

FCSE_SPECTRA1LABELS=
FITC-A,PE-A,PerCP-
A,APC-A

FCSE_COLUMNTOD
ELETE_STRICT=

Optional: Comma separated
exact list of parameters to delete
after the import process. An error
will be given if a parameter is not
found for deletion. Parameter
names must match your user
preferences for Keyword for
Parameter Matching .

FCSE_COLUMNTODELETE
_STRICT=FL1-H,FL2

FCSE_COLUMNTOD
ELETE=

Optional: Comma separated list
of parameters to delete after the

FCSE_COLUMNTODELETE
=FL1-H,FL2-H

1661

https://en.wikipedia.org/wiki/Regular_expression
https://en.wikipedia.org/wiki/Regular_expression


Plots and Other Objects 247

© 2023 De Novo Software

import process. Any parameters
not found will be ignored.
Parameter names must match
your user preferences for
Keyword To Use as Parameter
Name

Any example of creating a virtual spectral file for an original file containing FITC-A,
PerCP-Cy5-5-A, PE-Cy7-A, APC-A, APC-Cy7-a is shown below. The original FCS
file is shown on the right in a density plot and the resulting virtual spectral file for
events in Gate 1 shown in a spectrum plot is on the left (Figure 5.60). 

Figure 5.60 Example of virtual spectra data file. 

5.1.6.1.1  Inserting a Spectrum Plot

Spectrum Plots are a special subset of the one-dimensional plot type that
displays spectra for all events within a gating strategy as individual lines or an
average of all events within a gating strategy as one line. Spectral lines for cells
or particles are displayed as Counts (Y-axis) vs. wavelength (X-axis) for the
specified laser line. Compensations and Unmixing  and/or transformations
may be applied to spectra displayed.

To insert a Spectrum plot, first ensure that the .fcs file and file type encoding the
spectral data the same directory folder on your computer (details on file
formats, structure and spectral data set preferences ).  Then, use the
Insert  Plots Spectrum command (Figure 5.61). 

1661
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Figure 5.61 - Insert Spectrum Plot command

An example of a Spectrum Plot is shown below in Figure 5.62.

Figure 5.62 - Inserted Spectrum Plot 

Spectrum plot can either display the spectrum for all plotted events just a single
line representing the average of them (Format Overlays to
show All Spectrums/Average command).
When All Spectrum is selected, the Spectrum plot can either be colored based
on the spectra density (Format
Density; see picture above as an example) or each line of it can be colored
based on the gate/overlay in which the event falls (Format

).
When the Average is displayed, the color will be derived from Line options
color.

See Formatting a Spectrum Plot  for more information on these and other
formatting options.
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5.1.6.1.2  Formatting Spectrum Plots

In addition to the formatting options common to all Objects , and some of
those common to all Plots  (i.e. Axis, Titles, and Legends), Spectrum Plots
have other properties, which can be formatted:

· Overlays  are defined in FCS Express as a data set that is displayed on a plot.

A data set for a spectrum plot consists the individual spectrum from every
event. A Spectrum Plot must contain one or more overlays. Overlays can be
added or deleted from a Spectrum Plot, but the first overlay, also known as the
base overlay, cannot be removed, only reformatted or changed. Furthermore,
spectra for all events may be displayed individually (i.e. All Spectrums) or as
an average (i.e. Average with or without Showing Standard Deviation).

· Spectrum Plot Specific Options  allow you to change Resolution, Display

Mode (Color on Gated/Overlays vs. Color on Density), Shade Based on
Density, and whether or not to Interpolate Values with desired number of
Interpolation points. For example, with the Display Mode option you may
automatically match the color of the spectrum line for each event to the color
of the gate/overlay to which it belongs (i.e. Color on Gated/Overlays). These
option allow for "backgating" of spectral flow cytometry data files.
Alternatively, you may choose to display the spectral line colors on Density (i.e.
Density).

· Color Levels  options allows to customize the color levels when Density is

selected as Display Mode in the Spectrum Plot Specific Options .

· Display Gates Options  allow to define which gate to use to color spectrum.

This applies when Color on Gated/Overlays is selected as Display Mode in
the Spectrum Plot Specific Options  and All Spectrums is selected as
Overlay to Show in the Overlays  options.

You can always format a Spectrum Plot by right-clicking on the plot, selecting
Format from the pop-up menu, and choosing a category. Alternatively, once the
Spectrum Plot is selected, you can choose the desired category from the Format
tab of the Ribbon .

NOTE: Certain aspects of Spectrum Plots are managed via Cytek and Sony
Instrument Specific Settings , for instance, the Parameter Labels, Parameters
that are removed after a spectra merge, and more. 

5.1.6.1.2.1  Overlays

All Spectrum Plots have at least one overlay and a spectrum to display.
Additional overlays from the same or different spectral data files can be added in
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the same way that overlays are added to histograms and other plots in FCS
Express. Different gates can also be applied to each overlay, if desired (e.g.,
Figure 5.63).

Figure 5.63 - Spectral plot with two overlays from different spectral datafiles, each
with a different gate applied.

You can add additional overlays by any of the following methods:

· Right-click on the plot and select Add overlay from the pop-up menu. This

launches either the Select Data File or the Open Data File dialog
depending on the Open Data Dialog user Options ; or 

· Right-click on the plot and select Add Overlay using Advanced Open

Data Dialog (launches the Open Data File  dialog), or 
· Drag-and-drop file(s) from the Data List  onto the plot you wish to

overlay, or
· Drag-and-drop a plot from the layout onto the plot you wish to overlay.

The Overlays option controls the spectrum and appearance of spectrum
overlays.  The selected Overlay to show will be applied to all overlays that are
added to a spectrum plot.  For example, if Average spectrum is applied to a
spectrum plot and a new overlay is added it will also be displayed by showing the
average of all events as one line or dot. 

You can edit overlays in one of two ways:

· Select the Spectrum plot(s) and use the Format Plot Options

command in the ribbon bar. 
· Right-click on the Spectrum plot, select Format from the pop-up menu, and

choose Overlays from the drop-down at the top of the Formatting dialog
(Figure 5.64).
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Figure 5.64 - Formatting Spectrum Overlays Dialog

A list of all the overlays on the Spectrum Plot will appear in the list box at the
top. You can select one or more overlays using standard Microsoft Windows
techniques, including Shift-Click and Ctrl-Click. The properties on the bottom
pertain to the currently selected overlay(s). If multiple overlays are selected, the
information will appear blank for those properties that are not identical in all
selected overlays. If the properties are not blank, then they are identical for all
selected overlays. Changing an option will change that property for all selected
overlays. For instance, if you select three overlays and change the Gate, the
Gate for all three overlays will be modified. 
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To remove an overlay from a plot, select the overlay(s) and press the Remove
button. 

To change the order of selected overlay(s) use the up and down arrows (

). The in the legend  will authentically update accordingly.

 Overlay formatting options for Spectrum plots are explained in the table below;
additional options specific to Spectrum Plots, which can greatly aid in analysis and
report generation, are explained in detail in the Spectrum Plot Specific Options
chapter.

Option Explanation

Spectrum Change the laser line displayed on the spectrum plot.

Gate If gates are defined , select the gate that will be used to limit
the data that is displayed for each Overlay on the spectrum plot.

Overlay to show Three choices are available:
· All spectrums shows each event as an individual line or dot (left

plot below);
· Median spectrum shows the median of all events as one line or

dot;
· Average spectrum shows the average of all events as one line

or dot (plot in the middle below);

When either Median spectrum or Average spectrum is selected,
the Standard Deviation can also be displayed by checking the
Show Std Dev check box (see the Show Std Dev option below).
The Standard Deviation is plotted as a dot or line above and below
the Median (or the Average). The right plot below shows an
example of spectrum plot displaying the Average Spectrum and the
Standard Deviation lines. The color of the Std Dev dots/lines can
be customized through the Standard Deviation Color drop-down
menu (see the Standard Deviation Color option below).

Compensation If compensation definitions  are set, select the definition to use
when compensating the data in the overlay.

Transformation If transformations  are set, select the transformation to use for
each overlay.

Legend Text The text that will appear in the legend beside the symbol for the
overlay. Free text can be inserted. If this field is blank the file
name of the overlay will appear.
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Option Explanation

A dropdown menu with additional pre-customized legend content is
accessible by pressing the ellipsis button next to the legend text.
Possible choices are:
o Keyword. This can be used to insert keywords from the header

of the data file.
o Gate. This can be used to display the current gate applied to

the overlay.
o Tube Number. This can be used to display the Tube Number of

the overlay when a Panel  is active.
o Tube Name. This can be used to display the Tube Name of the

overlay when a Panel  is active.
The above mentioned Legend options apply only to Dot Plots,
Color Dot Plots, Histograms and Spectrum Plots.

Smoothing Set the degree of smoothing for the overlay.

Change data file
during
Next/Prev/Batch

If this option is checked, the data file for this overlay will change
when doing batch processing , or selecting Previous File or Next
File . This option is usually only disabled for a control spectrum,
where you have multiple overlays, and want the control to stay the
same all of the time.

Show Std Dev When this option is checked, the Standard Deviation is plotted as a
dot or line above and below the Average (this option is only
available when Average is selected as Overlay to Show, see
above). The color of the Std Dev dots/lines can be customized
through the Standard Deviation Color drop down menu.

Visible You can hide overlays on a spectrum plot without removing them.
Select the overlay file from the list and uncheck Visible. Check
Visible to show the overlay again.

Below are some example of Spectrum plot customizations.

Figure 5.65 shows a Spectrum plot with two Overlays as an Average (see the
Overlay to show option in the table above). Please note that a legend  is also
displayed.
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Figure 5.65 Example of Spectrum plot customizations.

Figure 5.66 displays a Spectrum Plot with the Display Mode option set to Color
on Density (see Spectrum Plot Specific Options )

Figure 5.66 Example of Spectrum plot customizations.

5.1.6.1.2.2  Spectrum Plot Specif ic Options

Spectrum Plot Specific Options include Y Plot Resolution, Display Mode (Color on
Gated/Overlays vs. Color on Density), Shade Based on Density, and Interpolate

254
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Values (Figure 5.67).  For details on these options, please see the table in the
Formatting a Spectrum Plot  topic.

Figure 5.67 - Formatting Spectrum Plot Specific
Options Dialog

These formatting options specific to Spectrum Plots are detailed in the table
below. Standard formatting options for Spectrum Plot overlays are listed here .

Option Explanation

Resolution Increase or decrease the display resolution, or number of bins, of the
Y-dimension of the plot.

Display Mode The colors in Color on Density mode (left) reflect population density of
events; the colors in Color on Gated/Overlays mode (center and
right) reflect the following, depending on the number of overlays :

· for plots with 1 overlay (center), the gate to which each event
belongs (only for gates selected in the Display Gates Option
) (e.g., pink for events in the "2D plot gate" below and the
base color of the overlay (e.g., blue, below) for cells not in one
of the selected gates). 

· for plots with >1 overlay (right), the overlay (e.g., red for
Overlay 1, and green for Overlay 2).
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Option Explanation

Shade Based
on Density 

Superimposes a grayscale shading pattern based on the density of
plotted data. When gates are displayed on a Spectrum Plot in the Color
on Gated/Overlay Display Mode, the shading pattern will be
pseudocolored to match the color of the gate displayed. A lighter shade
represents a higher density. Note that this option will not apply if
multiple overlays are displayed on the Spectrum Plot.

Interpolate
values 

FCS Express can interpolate values to impart a smoother look to your
data, so that each event is depicted as a continuous line rather than an
array of discrete values.  Below are examples of plots with no
interpolation (left), and 5 (center) and 50 (right) Interpolation Points
between each value.

Interpolate values is also applicable to Spectrum Plots with the Color
on Density Display Mode:

Please note that interpolation does impact the speed of displaying the
plots.  Thus, it is recommended to use the lowest interpolation value
that provides the desired plot appearance.

5.1.6.1.2.3  Color Levels

Color Level options for Spectrum Plots are enabled in Color on Density Display
Mode  only.

Color Levels for Spectrum Plots can be formatted in the same manner as for 2D-
Density Plot Color Levels . Below is an example of a plot with customized color
levels (Figure 5.68). 
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Figure 5.68 - The Spectrum Plots have customized Color Levels.

Adjusting color levels to Hide Outliers on a Spectrum Plot will allow users to
visualize data sets similar to displays found in Cytek's Spectroflo software. A
spectrum utilizing this feature can be seen below(Figure 5.69).  Please also see
the Formatting a Spectrum Plot chapter  for additional details and examples. 

(Figure 5.70) Adjusted Color Levels to  hide outliers in spectral signature.

5.1.6.1.2.4  Gates to Display

To edit the Gates to Display options, either

· Select the Spectrum Plot(s) and use the Format tab

Options  command, or

· Right-click on the Spectrum Plot, select Format from the pop-up menu, and

choose Gates to Display from the dropdown (Figure 5.71).

249
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Figure 5.69 - Spectral plot with two overlays from
different spectral datafiles, each with a different gate

applied.

If you have Average set as the Overlay to display, the lines are shown as the
Line options color. If you have All spectrums set as the Overlay to display,
the colors of each line will reflect the color of the gate in which the event falls. If
an event falls in more than one of the selected gates, then the line will be drawn
in the highest priority gate.

By default, the All Gates option is selected. However, you can select Only the
gates checked below and then select the gates whose colors you wish to
display. Alternatively, select All gates except those checked below and then
choose the gates whose colors you do not wish to display.

https://www.denovosoftware.com/site/manual/overlays3.htm
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A right-click menu is available within the Gate to Display dialog as displayed in
Figure 5.72 below. The right click menu allows users to:

· Expand/collapse All gates

· Expand/Collapse All Children gates within the selected gate

· Expand/Collapse Current Level (this expand only the first level of children

gates within the selected gate)
· Check/Uncheck All gates

· Check/Uncheck All Children gates within the selected gate

· Invert Selection on All gates

· Invert Selection on All Children gates within the selected gate
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Figure 5.70  The right-click menu avaialble within the Gates to Display
dialog.

In the When a new gate is created on the layout, should the gate color be
displayed? category you can also choose how to display the gate color when a
new gate is created on the layout. Possible choices are:

· No
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· Display the gate color on a back-gated plot Only if the new gate was

created on a plot showing the same data file (as the plot where the
new gate was created),

· Display the gate color on a back-gated plot Only if the new gate was

created on a plot showing the same parameters (as the plot where
the new gate was created).

· Yes

5.1.6.1.3  Gating and Backgating on Spectrum Plots

Gates may be created on  and applied to  Spectrum Plots, much like any
other plot type in FCS Express.  

Gating and backgating each work bidirectionally between Spectrum Plots and
other plot types.  In other words, gates can be:

· created on Spectrum Plots and applied to  / backgated onto  other

plot types (Figure 5 below Top)
· created on other plot types and applied to  / backgated onto

Spectrum Plots (Figure 5 below Bottom)

Gate created on Spectrum Plot and applied or backgated onto a Color Dot Plot.
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Gate created on Color Dot Plot and applied or backgated onto a Spectrum Plot.

5.1.6.2 Picture Plots

Picture Plots are two-dimensional displays of the morphology of cells (or other
objects). Think of them as gated collections of cell images. The location of
individual cells is shown along the x- and y-axes of the plot. Gates can be set on
individual cells or groups of cells.

5.1.6.2.1  Working w ith Picture Plots

To insert a Picture Plot on your layout, use the Insert tab Other
Plots Picture Plot command.

(Also see File  Formats for Imaging Cytometry)

To format the plot, right-click on the plot, select Format from the pop-up menu,
and choose the Overlays category. Set the Image to display and, if desired,
choose an appropriate Gate (e.g., a gate defined on a 1D- or 2D-plot , or a
single well gate that you set on the corresponding Heat Map ) using the drop-
down lists (Figure 5.73). Alternatively, you can select the Picture Plot and use
the Format tab Plot Options Overlays command.
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Figure 5.71  Formatting a Picture Plot - Overlays Category

The Picture Plot will display the images of your cells with their location in the
field (e.g., a single well that was chosen in a well gate) that was imaged (Figure
5.74). The axes are in pixels with the origin (0,0) located in the upper left corner
of  the field. You can change the parameter being displayed by clicking on the x-
axis label and choosing a new parameter from the pop-up list.
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Figure 5.72  A Picture Plot

To display the images from a different well, modify the single well gate by right-
clicking on the Heat Map, selecting Edit Gate, choosing the appropriate gate from
the submenu, and then selecting a different well .  Alternatively, you may
create additional Well Gates  and apply them to the Picture Plot using any of
the methods for applying gates  in FCS Express.

Picture Plots can be backgated just like any other color dot plot. In other words,
the events (in this case, the images of cells) can be drawn in the color of the
gate that they belong to.

To implement backgating:

1.  Right-click on the Picture Plot.
2.  Select Format from the pop-up menu.
3.  Choose Gates to Display from the drop down.
4.  Set the gates to display according to your criteria (Figure 5.75).
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Figure 5.73  Picture Plot - Display Gates Options

In the example, Cells of Interest (pink) has been chosen as the sole backgating
color. When you click OK, the objects in Cells of Interest will be colored pink
(Figure 5.76).
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Figure 5.74 Back-Gated Picture Plot. The Cells of Interest
display the Pink color of their gate.

You can also gate on a single cell or group of cells on a Picture Plot. Choose a
gate shape from the Gating tab Create Gates group and draw the gate on the
plot.

In Figure 5.77, a single cell gate (light blue) has been drawn on the Picture Plot.
You can use that gate just like any other gate in FCS Express. For example, you
can backgate a Data Grid  to show your single cell gate, or you can drag the
gate to a Data Grid or other plot to re-gate either one.

402
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Figure 5.75  Single Cell Gate Drawn on a Picture Plot

Zooming/Panning Specific Options for Picture Plots

By default, Picture plots display images at their original zoom starting from their

top-right corner.  When the original size of the picture exceeds the size of the

plot drawn, user may:

· Adjust the size of the plot using the sizing tools (Figure 5.78).
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Figure 5.76 The picture plot (left) has been resized in order to display the full
picture (right) 

· Change the zoom of the Picture plot by selecting Specific Options from the

Format tab of the ribbon bar and by either (Figure 5.79):

o Resizing the red selection rectangle

o Sliding the zoom slider

o Entering a value in the zoom field (placed at the left of the zoom slide)

Note: Should zooming not being enough, the plot may also be resized to be

made larger. 



Plots and Other Objects 269

© 2023 De Novo Software
Figure 5.77 The picture plot (top) has been zoomed through the Specific Options

dialog in order to display a larger part of the picture (bottom).
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The Specific Options dialog also lets the use define which region of the image to
display within the picture plot via panning (Figure 5.80). Panning may be used by:
· Moving the red selection rectangle within the black area (the black area

represents the full picture)
· Acting on the Pan X-Axis and the Pan Y-Axis sliders (see picture below)

Figure 5.78 Panning can be performed by either moving the red selection rectangle
or by axting on the Pan X-Axis and the Pan Y-Axis slides.

5.1.6.3 Gates Heat Maps

The Gates Heat Map plot type allows you to quickly compare gated populations
across data files in a convenient visual format, without the requirement of having
plots for each data file inserted on your layout.  Unlike regular Plate Heat Maps
, which only graph data files from multi-well plates, Gates Heat Maps can graph
data from all data files, regardless of whether they were acquired in plate format.

To insert a Gates Heat Map plot, choose the Insert tab Other Plots
Heat Map command, and click once on the layout where you want the plot to
be inserted.  Any default 2D-plot statistic  for the gates may be shown in a
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Gate Heat Map.  Below is an example where statistics for four different gates
("CD4", "CD8", "blasts", and "lymphs"), for CD16+56 PE-A median and % of
parent, are being compared across data files, in the Gates Heat Map plots at left
and right, respectively (Figure 5.81).

Figure 5.79  Examples of Gate Heat Maps (top) showing different statistics for
multiple datafiles, and the original plots on which the gates were drawn (bottom).

A Gates Heat Map Stats Grid may be inserted for any Gates Heat Map on the
layout by right-clicking inside a Text Box , and selecting 
Insert from the pop-up menu Gates Heat Map Stats Grid and
selecting the Gates Heat of interest (Figure 5.82).  The Stats Grid contains the
parametric or %-gated value for each cell that was chosen by the user in Gates
Heat Map Overlays .

Figure 5.80  Inserting a Gates Heat Map Stats Grid inside a Text Box.

1787
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Many of the formatting features in regular Heat Maps are available for Gates
Heat Maps, and these are detailed in the following sections:

· Gates Heat Map Overlays

· Gates Heat Map Color Levels

· Gates Heat Map Specific Options  

5.1.6.3.1  Creating Gates Heat Map Overlays

FCS Express allows users to view multiple gates from a high content experiment
in a single Gate Heat Map by adding each file as a new overlay. Each gate is
represented by a square with each overlay presenting in rows. 

There are four ways of adding overlay on a Gate Heat Map:

1. Drag-and-drop file(s) from the Data List  onto the Heat Map you wish
to overlay. A Select Drag and Drop Action dialog will open, asking
whether to replace the existing overlay or to add the files as new overlays.

2. Drag-and-drop a plot from the layout onto the plot you wish to overlay. A
Select Drag and Drop Action dialog will open, asking whether to replace
the existing overlay or to add the files as new overlays.

3. Right-click on the plot and select Add overlay from the pop-up menu. This
launches either the Select Data File or the Open Data File dialog
depending on the Open Data Dialog user Options . 

4. Right-click on the plot and select Add Overlay using Advanced Open
Data Dialog (launches the Open Data File  dialog).

If either Add Overlay option is used, after selecting the data file(s) to add as new
overlays, the Add overlay(s) dialog will open (Figure 5.83).
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Figure 5.81 The Gates Heat Map Add Overlays dialog.

The Add overlay(s) dialog allows users to choose, individually for each of the
data file(s) listed in the Open 2D Plot(s) for Data Files list, the Statistic
Parameter, the Gate, and the Transformation to use for the selected overlay.

The new overlay will be added to the gates heat map. The first overlay occupies
the top row, while new overlays are added beneath the last row in the plot.
(Figure 5.84). 
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Figure 5.82 Gates Heat Map with Overlays. Overlays are added to the next row in
the plot.

Multiple properties can be formatted for each overlay via the Gates Heat Maps
Overlays  dialog. However, one Color Level  will be applied globally to all
overlays of a Gate Heat Map.

5.1.6.3.2  Gates Heat Map Overlays

Additional overlays from the same or different datafiles can be added to Gates
Heat Map plots in the same way that overlays are added to histograms and
other plots in FCS Express. Please refer to the Creating Gating Heat Map
Overlays  chapter.

The Overlays formatting option controls the spectrum and appearance of Gates
Heat Map Overlays. 

You can edit Overlays (Figure 5.85) in one of two ways:

274 322
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· Select the Gates Heat Map plot(s) and use the Format Plot

Options  command in the ribbon bar. 
· Right-click on the Gates Heat Map, select Format from the pop-up menu,

then choose Overlays from the dropdown menu.

Figure 5.83  Edting Gates Heat Map Overlays.

In the dialog, a list of all the overlays on the heat map will appear in Options list
box, in the upper pane of the dialog. You can select one or more overlays using
standard Microsoft Windows techniques, including Shift-Click and Ctrl-Click. The
properties in the lower pane of the dialog pertain to the currently selected
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overlay(s). If multiple overlays are selected, the information will appear blank for
those properties that are not identical in all selected overlays. If the properties
are not blank, then they are identical for all selected overlays. Changing an option
will change that property for all selected overlays. For instance, if you select
three overlays and change the Gate, the Gate for all three overlays will be
modified. 

To remove an overlay from a plot, select the overlay (or multiple overlays) and
press the Remove button. 
To change the order of selected overlay(s) in the legend , use the up and down

arrows ( ) to the right of the Options list box.

Gates Heat Map Overlay Options are explained in the table below.

Option Explanation

Statistic
parameter

A drop-down menu to select the parameter from which a
statistic will be chosen to be displayed.

Statistic to
show

A drop-down menu to select the statistic  to show as an
overlay on the Gates Heat Map.

Compensation If compensation definitions  are set, select the definition to use
when compensating the data in the overlay.

Transformatio
n

If transformations  are applied to the data set, select the
transformation to use when transforming the data in the
overlay.

Gate If gates are defined , select the gate that will be used to limit
the data that is displayed on the Gates Heat Map.

Radius
Parameter

Optional: A drop-down menu to select the parameter from
which a Radius statistic will be chosen. A Radius parameter
must be chosen to use a Radius statistic. If enabled, the
Radius Parameter range of values will be depicted in the
Legend .

Radius
Statistic

Optional: A drop-down menu to select the statistic to adjust the
radius of each plotted statistic.

Legend Text The text that will appear in the legend beside the symbol for the
overlay. If this field is blank the file name of the overlay will
appear. Insert keywords from the header of the data file by
pressing the ellipsis next to the legend text. You can also display
the current gate applied to the overlay by typing
"<$FCSE_GATEFORMULA>" into the legend text.

Change data
file during
Next/Prev/Ba
tch

If this option is checked, the data file for this overlay will change
when doing batch processing , or selecting Previous File or
Next File .

Visible You can hide overlays on a Gates Heat Map without removing
them. Select the overlay file from the list and uncheck Visible.
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Option Explanation

Check Visible to show the overlay again.

5.1.6.3.3  Gates Heat Map Color Levels

To choose the color scheme on a Gates Heat Map, select the Gates Heat Map
plot, and either:

· Select the Format tab 2D Options Color Levels command (Figure

5.86), or

· Right-click on the Gates Heat Map, select Format from the pop-up menu,

then choose Color Levels from the dropdown menu. 

Figure 5.84  Formatting Color Levels in a Gates Heat Map.

The default settings are a Green-Red color scheme, a Style of Mean ± SD, and
3.5 standard deviations on either side of the scale. This means that gate
statistics close to the average for the statistic being displayed are colored black,
those that are +3.5 SD from the average are pure red, and those that are -3.5
SD are pure green.
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You can select another color scheme using the Selected Color Level drop-down
list.

Available color schemes are:

· Blue Gradient

· Blue-White-Red

· Color Blind

· Flame

· Green Gradient

· Green-Blue

· Green-Red

· Green-Yellow-Red

· Greyscale

· Inferno

· Inverse Greyscale

· Magma

· Plasma

· Rainbow

· Red Gradient

· Red-Green

· Red-White-Blue

· Red-Yellow-Green

· Threshold

· Viridis

The Color Blind option is derived from the color palettes recommended in
Getting into Visualization of Large Biological Dat Sets: The 20 Imperatives of
Information Design by Martin Kryzwinski et al. More options may be added as
requested.

Inferno, Magma, Plasma and Viridis color levels are inspired by the "Viridis"
palette for R. 

The Threshold scheme has specific Color Level Properties related to the
threshold value. When the Selected Color Level or Style are set to Threshold,
you can choose a token (e.g., a statistic based on a control gate statistic) to

represent the Threshold Value by clicking on the  button, or enter an arbitrary
value. Then, set the Below Threshold and Above Threshold colors using the
drop-down lists. Gate statistics whose value is below the threshold value will be
displayed in the first color, and those with a value above the threshold value will
be displayed in the other color.  In Figure 5.87 below, the threshold has been set
to 105000, and the Above Threshold Color to Red.

http://mkweb.bcgsc.ca/biovis2012/
http://mkweb.bcgsc.ca/biovis2012/
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Figure 5.85  Formatting Color Levels to Threshold Style in a Gates Heat Map.

5.1.6.3.4  Gates Heat Map Specif ic Options

Gates Heat Map Specific Options may be accessed by selecting the Heatmap,
and either:

· Select the Format tab Plot Options Specific Options command from

the ribbon bar (Figure 5.88), or

· Right-click on the Gates Heat Map, select Format from the pop-up menu,

then choose Specific Options from the dropdown menu. 
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Figure 5.86  Formatting Gates Heat Maps Specific Options.

Gates Heat Map Specific Options allow to modify three Gates Heat Map
properties:

· Orientation. This option allow to display the Heat Map with Landscape

(in which Gates are arrayed across the top of the plot from left to right,
while datafiles are arrayed along the left side of the plot, from top to
bottom) or Portrait orientation (vice-versa).

· Display space between wells.  This option, if checked, displays a small

space between adjacent wells on the Gates Heat Map.  Default is
unchecked.

· Color Level Options. This option assigns the colors from Color

Levels  on the basis of rows, columns, or the entire array of rows and
columns.

5.1.6.4 Plate Heat Maps

In high-throughput laboratories, flow cytometry and cell imaging are often done
in multiwell microtiter plates. The data from a 96-well microtiter plate, for
example, normally contains 96 separate data files. FCS Express can
automatically merge the files from any size plate into one dataset and associate
each "cell" with the particular well that it was located in. Even if samples were

277
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acquired in tubes FCS Express can merge the individual files so they may be
represented in a plate heat map or "virtual plate". 

A Plate Heat Map is a graphical representation of your data in a plate-shaped
grid with each well of the plate color-coded based on the statistic being
displayed.  This enables rapid visualization of wells and outliers by comparing the
statistical data in an individual well to the statistical data of the entire microtiter
plate. 

Plate Heat Maps also provide a visualization when SPADE  is calculated with
the Transformations  navigator and applied. Please see the Working with
SPADE Transformations  section to learn how to use Plate Heat Maps in
conjunction with SPADE transformations. 

By choosing an appropriate color scheme and statistic to display, you can get an
overview of all of the wells in your experiment or node(s) within the SPADE
tree . You can also create Well Gates  to conveniently pool your data or
identify node(s) of interest within the SPADE tree .  

5.1.6.4.1  Working w ith Plate Heat Maps

To display a Plate Heat Map:

1.  Select the Insert Other Plots Plate Heat Map command.
2.  Click (or click-drag) on your layout where you want the plate heat map to

appear.

3.  Browse to the data file you wish to insert:

i. If you are loading a list of data files collected together in a
microtiter plate (e.g., data files derived from a BD HTS
instrument), each file will likely already contain a WellID
keyword with the well position for that sample. To open
those files as a plate, choose FCS Plate folder from the
Files of type drop-down list in the Select a Data File
dialog, open the folder that contains the files, choose any
individual well's file in that folder, and click Open File.

Note: The folder containing the files should also contain an extra
keywords file  to indicate the size of the plate, if this information is
not already present as keywords  in the data files. Ready-to-use
extra keywords files indicating the size of the plate can be
downloaded from the De Novo Software web site.

ii. If you are loading a single file representing all the wells in a
plate (e.g., an Accuri .C6 or .CI file), choose the appropriate
file type from the Files of type drop-down list in the Select a
Data File  dialog (e.g., "BD Accuri .c6 Plate files"), and click
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Open File. No additional extra keyword files will be required
since both the WellID and plate size are likely already
contained in the data set.

iii.  If you would like to display a heat map for a series of files
that have not been acquired in a microtiter plate (i.e. files that
contain do not contain a WellID keyword or the plate size),
you may do so in the following  ways: 

§ If you would like to control the well which the file will be
associated with, the folder containing the files should also contain
an extra keywords file  to indicate the size of the plate and
extrakeywordstable.csv file  indicating the WellID (or $WellID)
column with the well position for each file.

§ If you do not need to control which well the file will be associated
with, you can use the Merge FCS Files loader  which will load
samples into the plate heat map in the order they were selected
during the file merge. Setting the number of columns to
display  will determine the plate format. 

iv.  If you are visualizing SPADE tree please insert a Plate Heat
Map as described in step 1 above and follow the instructions
for Working with SPADE transformations .

v.  If you are visualizing result of a k-Means clustering please
insert a Plate Heat Map as described in step 1 above and
follow the instructions for Applying a k-Means cluster
analysis .

The data in a Plate Heat Map is displayed as a two-dimensional grid of the wells
on a microtiter plate. For example, for a 96-well plate, the plate heat map
contains eight rows (labeled A through H) and 12 columns (labeled 01 through
12). The parameter being displayed  is shown as the title of the y-axis. Each
well displays a color according to the chosen color scheme , and the well's
radius can be dependent upon a chosen parameter  (Figure 5.89).

You can now create Well Gates  to pool your data from multiple wells, and
display the parameters of each event on a per-well basis in a Data Grid .
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Figure 5.87  Plate Heat Map

When a Data Grid is displayed for the Plate Heat Map, a Well column will be
present showing the well where each cell or event is located.  The example below
is from an image cytometry experiment, where the Data Grid has been
formatted as an image gallery  (Figure 5.90).410
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Figure 5.88  Data Grid with Well Column

You can insert a table displaying the actual values from each well of your Plate
Heat Map into a Text Box . For a 96-well microtiter plate, this will insert an 8 x
12 data grid. To do so, right-click on the Text Box, choose Insert Plate Heat Map
Stats Grid, and select the Plate Heat Map to use as a data source from the
menu. (Figure 5.91). Tables can be displayed in Grid Layout Stats Grid, Column
Order Stats Grid, or Row Order Stats Grid . 

Figure 5.89 - Insert Plate Heat Map Stats Grid into a Text Box

Grid Layout Stats Grid - displays the plate heat map well statistics in a table
similar to the plate heat map (Figure above).

1787
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Column Order Stats Grid - displays the plate heat map well statistics according
to the plate column order, ie, A01, B01, C01.... (Figure 5.92)
Row Order Stats Grid - displays the plate heat map well statistics according to
the plate row order, ie, A01, A02, A03.... (Figure below)

Figure 5.90 - Plate heat map stats grids displayed in
Column and Row order. 

All stats grids may be copied and pasted into Excel or the table dragged into a
batch process export action  for easy reporting. 

5.1.6.4.1.1  Choosing Parameters and Statistics

To select the parameter and statistic to display on the Plate Heat Map, use one
of the following methods:

· Select the Plate Heat Map and use the Format tab Plot

Options Overlays command (Figure 5.93), and choose from the drop-
down menus under Plate Heat Map Overlay Options.

Figure 5.91 - Plate Heat Map Overlays Command from Ribbon

796
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· Right-click on the Plate Heat Map, select Format from the pop-up menu,

and choose Overlays from the dropdown (Figure 5.94).

· Click and hold down the mouse button over the y-axis label and choose an

available parameter. Set the statistic to show using one of the above two
methods.

Figure 5.92 Plate Heat Map - Setting the Statistic Parameter and
Statistic to Show

The data that is displayed is a combination of the Statistic parameter and the
Statistic to show (e.g., Mean, Standard Deviation, CV, Median, # of events,
75%-ile) properties. FCS Express calculates the average of the statistic chosen
across all of the wells in the microtiter plate. Then, a color is displayed for each
well according to the color scheme property . The usual procedure is to assign
the color by comparing the value of the statistic in each well to either:

322
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· The mean ± SD of the entire plate.

· A predetermined threshold.

Choose the parameter from the Statistic parameter drop-down list. The list will
be populated by parameters that were measured or calculated by your
instrument. Select the Statistic to show from the predefined statistics in the
corresponding drop-down list.

Available Statistics to Show:

Min (or Max) value The Min (or Max) value is calculated for each well

# of Event The number of events is calculated for each well

% of parent For each well, the percentage of the Heatmap overlay
gate is calculated using the parent gate as reference.
This calculation is done on a per well bases. i.e. if Gate 2
is applied to the current Heatmap overlay and Gate 1 is
the parent of Gate 2, the % of parent for each well will
be calculated as the number of events in Gate 2 in a
that well, divided by the number of events of Gate 1 in
that same well, multiplied by 100. 
Note: in the previous version of FCS Express, the
calculation was not performed on a per well bases, but
on the whole plate instead. i.e. if Gate 2 was applied to
the current Heatmap overlay, the % of parent was
calculated as the number of events in Gate 2 in a given
well, divided by the number of events displayed on the
Heatmap (i.e. the total number of events in Gate 2),
multiplied by 100. 

% of grandparent Same as above but the grandparent gate is used as
reference.

% of great grandparent Same as above but the great grandparent gate is used
as reference.

% of all cells Same as above but the total number of events in the
well is used as reference.

Median (or Geometric
Mean, or Arithmetic
Mean)

The Median (or Geometric Mean, or Arithmetic Mean)
for the parameter selected in Parameter Statistics
drop-dow menu is calculated for each well.

CV (or rCV) The Coefficient of Variation (or the robust Coefficient of
Variation) for the parameter selected in Parameter
Statistics drop-dow menu is calculated for each well.

5%-ile (or, 25%-ile,
75%-ile, 95%-ile)

The selected 5th (or 25th, 75th, 95th) percentile for the
parameter selected in Parameter Statistics drop-dow
menu is calculated for each well.

Concentration The concentration in each well is calculated based on the
Concentration  tool.1231
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Standard Deviation The Standard Deviation for the parameter selected in
Parameter Statistics drop-dow menu is calculated for
each well.

BD-rSD (or BD-rCV) The BD robust Standard Deviation(or the BD robust
Coefficient of Variation) for the parameter selected in
Parameter Statistics drop-dow menu is calculated for
each well.

       Please note: If a Statistic to Show for a well cannot be calculated, for
instance, the Geometric Mean of a negative value, the well will appear          
                                          "empty" with vertical and horizontal hatch marks
as in the screen shot to the right. Choosing a different Statistic to Show
may be appropriate. 

A Plate Heat Map can have a Gate set similar to any other plot in FCS Express.
For example, you can draw a gate on a dot plot displaying the data and then
drag the gate onto the plate heat map. You can also set the gate using the drop-
down list in the Formatting window pictured above.

Radius Parameter and Statistic
FCS Express allows a statistic of a parameter be assigned to represent the well's
radius (Figure 5.95). The radius on the plate heat map can change based on the
statistic selected. Choose the parameter from the Radius Parameter drop-
down list. Then, select from the Radius Statistic drop-down list. If the Radius is
enabled, the range of values for the Radius will be depicted in the Legend .  341
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Figure 5.93 - A plate heat map using the number of events per well as the radius
statistic and the mean intensity as the heat statistic. Larger size wells represent

wells with more events present in the well. 

5.1.6.4.1.2  Well Gates

Well gates are gates that include one or more wells from a plate heat map. A
Well gate can include either contiguous and/or non contiguous wells.

There are two ways of creating well gates:
1. Creating a single well gate that includes one or multiple wells of interest

(either contiguous and/or non contiguous).
2. Create multiple well gates, one for each of the selected well of interest

(either contiguous and/or non contiguous).

The initial steps to create a Well gate are common to both scenarios above:

1. Select the Gating tab Create Gates Well command. (Alternatively,
right-click on the plate heat map and choose Create gate Well).

2. Click anywhere on the plate heat map (alternatively, click-drag the mouse
around multiple wells/clusters or around all the wells/clusters) (Figure
5.96).

· An Editing New Well Gate dialog (with instructions) for the well gate

will appear above the plate heat map.



FCS Express 7 Manual290

© 2023 De Novo Software

· A Create New Gate dialog for the well gate will appear on the screen

(Please note that by default the Gate Properties section of the dialog
is collapsed).

Figure 5.94  Setting a Well Gate. Please note that in thsi screenshoit the "Gate
Properties" section of the "Create New Gate" dialog has been expanded.

3. The Create New Gate dialog appears and allows users to create a single
Well gate, multiple individual Well gates and also to replace an existing Well
gate.

Create a new gate
named

The option allows users to create a single well gate
that includes one or multiple wells of interest (either
contiguous and/or non contiguous).
The new gate will be a child of the Overlay Gate of
the base overlay on the plot. To create the new
gate as a child of a specific gate in the hierarchy,
choose the parental gate in the hierarchy from the
Parent Gate drop-down (see below). The hierarchy
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of your gates can be adjusted at any time within the
Gate View object  as well.

Create Individual
gates for each well

The option allows users to create multiple well
gates, one for each of the selected well of interest
(either contiguous and/or non contiguous).
The new gates will be a child of the Overlay Gate of
the base overlay on the plot. To create the new
gate as a child of a specific gate in the hierarchy,
choose the parental gate in the hierarchy from the
Parent Gate drop-down (see below). The hierarchy
of your gates can be adjusted at any time within the
Gate View object  as well.

Creating individual gates for each well (or all the
wells) is especially useful when many wells must be
gated individually. The functionality can be used for
Heatmaps displaying data from a multi-well plate
and also when the Heatmap displays cluster
assignments from clustering algorithms .

When the option is selected, the user can customize
the gate names by Adding a prefix to the gate
name.

By default, the prefix is "Well" when the Heatmap
displays wells from a multiwell plate (as in the
example pictures below; left pane), or a short text
describing the transformation plotted into the
Heatmap (e.g. the classification description is
"KMeans Cluster Assignment" in case the Heatmap
displays a KMeans clustering). The prefix may be
customized by the user at their convenience
(pictures below; right pane).
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If the prefix check box is checked, the name of the
well (e.g. A01) may be replaced by an integer index
(e.g. 1; see the screenshot below) by selecting the
Use classification indexes instead of names
check box.

When multiple individual Well gates are created, user
may also want to color the individual gates with
different colors so they can more easily
discriminated via backgating. Users may click on the
Gate color drop-down menu, and by select Use
unique gate colors (Figure 5.97) to automatically
create different gate colors for each automatic well
gate created.
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Figure 5.95 The "Create New Gate" dialog with the
"Use unique gate colors" button highlighted.

Replace an existing
gate

To replace an existing gate with the newly created
gate, select the Replace an existing gate radio
button and choose the gate you wish to replace
from the drop-down list.  The new gate will replace
the old gate without affecting your gating
hierarchy .
Please see below for more details.

Gate Color Select the preferred color from the drop down
menu.

Note: When Individual Well Gates are created,
unique gate colors can be used (see above).

Parent Gate When a new gate is created, the new gate will be a
child of the Overlay Gate of the base overlay on the
plot. The Parent Gate option allows to modify this
choice and thus make the new gate a child of a
different gate.

737
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Note: when an existing gate is replaced, the parent
gate of the drawn gate will be the same parent gate
of the replaced gate.

Emphasize events
on Color Dot plots

See the Creating Gates  chapter for more details.

Always create a
Data Specific Gate
when moving this
gate

See the Creating Gates  chapter for more details.

Exclude events
inside this shape

See the Creating Gates  chapter for more details.

3. Once the Create New Gate dialog is completed, click OK to create the
Well gate and close the Create New Gate dialog.

The following steps vary based on which option has been selected in Step 3:

· Unique Well gate (or Replace an existing gate)

· Multiple individual Well gates

Unique Well gate (or Replace an existing gate)

If a unique Well gate has been created in Step 3 above (or the Replace an
existing gate has been selected), the well selected in Step 2 above will be
highlighted on the Heat Map and the Editing New Well Gate dialog, will allow
to modify the selection at the user convenience. This means that wells can be
further added or removed to the selection. This can be done by holding the Ctrl
key while clicking on individual wells of interest (or while dragging a rectangle
across a group of wells of interest).

In Figure 5.98 below, the well gate obtained by selecting wells from A02 to
A05, as a unique Well gate named Gate 1 is depicted. Well selection can be
edited when the Editing New Well Gate dialog is visible. When the selection is
completed, click Close.
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Figure 5.96 - Well Gate. Four wells are outlined in red (A02, A03, A04 and A05)

Multiple individual Well gates

If multiple individual Well gates have been created in Step 3 above, the Editing
New Well Gate dialog closes together with the Editing New Well Gate dialog.
Well gates will not be shown in the Heat Map (but may be shown by right
clicking on the Heatmap and by selecting Show gates). In the example below
(Figure 5.99), multiple individual Well gates have been created after selecting
wells from A02 to A05. The same red color has been selected for all individual
Well gates in this example. 
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Figure 5.97 - Example of multiple individual Well gates.

Replacing an existing gate

To replace an existing Well gate, simply draw a new Well gate and, in the
Create New Gate dialog, select the gate that has to be replaced from the
"Replace an existing gate" (Figure 5.100 below). After clicking OK, the
Editing New Well Gate will open and will allow you to modify the selection.
Please see the Unique Well gate (or Replace an existing gate) section
above .294
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Figure 5.98 - The Create New Gate dialog with the "Reaplce an
existing gate" option selected.

Editing an existing gate
To activate (and modify) an existing Well gate, right-click on the Plate Heat
Map, select Edit gate, and choose the gate to activate from the sub-menu
(Figure 5.101 below). Please see the Unique Well gate (or Replace an
existing gate) section above .294
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Figure 5.99 - The Edit Gate option in teh right click menu.

5.1.6.4.1.3  Creating Plate Heat Map Overlays

FCS Express allows users to view multiple statistics and parameters from a high
content experiment in a single plate heat map by adding each statistic as a new
overlay. Each well is represented by a circle with each overlay represented as a
slice similar to a pie chart. Different overlays may represent different parameters
and statistics from the same data set or multiple data sets.

Multiple properties can be formatted for each overlay via the Formatting Plate
Heat Map Overlays  dialog. However, one Color Level  will be applied globally
to all overlays of a Plate Heat Map.

There are four ways of adding overlay on a Plate Heat Map:

1. Drag-and-drop file(s) from the Data List  onto the Heat Map you wish
to overlay. A Select Drag and Drop Action dialog will open, asking
whether to replace the existing overlay or to add the files as new overlays;
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2. Drag-and-drop a plot from the layout onto the plot you wish to overlay. A
Select Drag and Drop Action dialog will open, asking whether to replace
the existing overlay or to add the files as new overlays;

3. Right-click on the plot and select Add overlay from the pop-up menu. This
launches either the Select Data File or the Open Data File dialog
depending on the Open Data Dialog user Options . 

4. Right-click on the plot and select Add Overlay using Advanced Open
Data Dialog (launches the Open Data File  dialog);

If either Add Overlay option is used, after selecting the data file(s) to add as new
overlays, the Add overlay(s) dialog will open (Figure 5.102).
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Figure 5.100 - Adding Overlay to Plate Heat Map, Steps 5-7.

  

The Add overlay(s) dialog allows users to choose, individually for each of the
data file(s) listed in the Open 2D Plot(s) for Data Files list, the X-Axis and the
Y-Axis Parameters, the Gate and the Transformation to use for the selected
overlay

The new overlay will be added to the plate heat map. The first overlay occupies
the lower-right sector of the well, while new overlays are added in a clockwise
fashion (Figure 5.103). 
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Figure 5.101 - New
overlay sectors added in

clockwise fashion to
Plate Heat Map, starting
from lower-right sector.

Please note: when visualizing SPADE , only one SPADE tree may be displayed
on a Plate Heat Map, but multiple overlays displaying the same SPADE tree may
be added. By utilizing multiple overlays, each overlay can display a different Y-
Axis parameter.

5.1.6.4.2  Working w ith Index Sort Data in Plate Heat Maps

Index sorting allows researchers to review the complete phenotype of every
single event sorted into a plate and associate that event with all sorted and non
sorted events. FCS Express allows for analysis and reporting of index sorting
data using Plate Heat Maps along with the standard plot offerings . For index
sort data, Heat maps will display the number of events (usually one) and
parameter based phenotypic data for all sorted events. Wells may be gated on
individually, or as groups, with the well gates backgated onto other plots to view
the individually sorted cells in context of the entire acquired/sorted samples.  All
plate heat map functionality is available for use with index sorting data. 

FCS Express currently supports index sorting data files from the following
instruments:

· Influx (BD Biosciences)

· Summit Software (Beckman Coulter)

· Diva (BD Biosciences)

· Chorus (BD Biosciences)

5.1.6.4.2.1  Influx Index Sorting Data Files

Influx Index Sorting Data Files contain fluorescence information on both the
sorted and unsorted events. To isolate the sorted events:
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1.  Insert a plate heat map  for the index sort data file.
2.  Select the parameter of interest on the y-axis (plate heat maps will

contain only Index Sorted Data) (Figure 5.104).  

Figure 5.102 Default Plate Heat Map with GFP Arithmetic Mean Y
Parameter

3.  Insert a Color Dot Plot .
4.  Change the axes on the color dot plot to the parameters of interest.
5.  Create a Well Gate  on all wells.
   Notes: 

o In addition to creating a gate on all wells a gate

may be created on one, or any number of wells, to
visualize the individually sorted cells. 

o Since Influx Index Sorting Data Files also

contain data for the unsorted events, we can use the
Emphasize on Plots  feature of gates to
differentiate the sorted from non sorted events
(Figure 5.105).
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Figure 5.103 Plate heat map with Well Gate created on all wells. Standard
gate is shown above while a gate with the Emphasize on Plots check box
checked is shown below.  Note that events highlighted in green fall within

the well gate and in this case represent all events that were sorted into the
plate. 

6.  Optional: Apply the Well Gate created in step 3 to the color dot plot
to only view Index Sorted Events (Figure 5.106). 
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Figure 5.104 Color Dot Plot gated on Well
Gate with events emphasized

It is possible to insert a plate heat map statistics grid  in a text box to display
statistics for each well in the plate heat map as done in Figure 5.107. 

Figure 5.105 Plate Heat Map Statistics Grid displaying statistics for the Y
parameter of the Plate Heat Map

Another useful feature for index sorting data is the Plate Heat Map Overlay
function. Plate Heat Map Overlays allow a user to view multiple statistics and
parameters on a single plate heat map by adding each statistic as a new overlay.
For instance, in Figure 5.108 left, the upper slice of the well represents PE-CY7
arithmetic mean while the lower slice represents GFP arithmetic mean so single
and double positive events can be more easily visualized. 

Additionally, users may add a Radius Statistic , which changes the size of the
well to reflect the selected parameter. For instance, in Figure 32 below (right),
the heat/color for each well is dependent on the GFP arithmetic mean while the
size of the well radius is dependent on the PE-Cy7 arithmetic mean.
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Please see the Plate Heat Map Overlay  section of the manual for full
instructions on how to create a plate heat map overlays of different parameters
and types as well as setting the radius parameter statistic. 

Figure 5.106 Custom Plate Heat Maps with Overlay (left) and Radius Parameter
(right). Standard Deviations of Color Levels was changed to 1.

5.1.6.4.2.2  Summit Index Sorting Data Files

Summit Index Sorting Data Files contain fluorescence information on both the
sorted and unsorted events. To isolate the sorted events:

1.  Insert a plate heat map  for the index sort data file.
2.  Select the parameter of interest on the y-axis (plate heat maps will

contain only Index Sorted Data) (Figure 5.109).  
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Figure 5.107 Default Plate Heat Map with FL5 Arithmetic Mean Y
Parameter

3.  Insert a Color Dot Plot .
4.  Change the axes on the color dot plot to the parameters of interest.
5.  Create a Well Gate  on all wells.
      Notes: 

o In addition to creating a gate on all wells a gate

may be created on one, or any number of wells, to
visualize the individually sorted cells. 

o Since Summit Index Sorting Data Files also

contain data for the unsorted events, we can use the
Emphasize on Plots  feature of gates to
differentiate the sorted from non sorted events
(Figure 5.110).
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Figure 5.108 Plate heat map with Well Gate created on all wells. Standard
gate is shown above while a gate with the Emphasize on Plots check box

checked is shown below. Note that events highlighted in red fall within the
well gate and in this case represent all events that were sorted into the

plate. 

6.  Optional: Apply the Well Gate created in step 3 to the color dot plot
to only view Index Sorted Events (Figure 5.111). 
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Figure 5.109 Color Dot Plot gated on Well
Gate with events emphasized

It is possible to insert a plate heat map statistics grid  in a text box to display
statistics for each well in the plate heat map as done in Figure 5.112. 

Figure 5.110 Plate Heat Map Statistics Grid displaying statistics for the Y
parameter of the Plate Heat Map

Another useful feature for index sorting data is the Plate Heat Map Overlay
function. Plate Heat Map Overlays allow a user to view multiple statistics and
parameters on a single plate heat map by adding each statistic as a new overlay.
For instance, in Figure 5.113 left, the upper slice of the well represents FL13
arithmetic mean while the lower slice represents FL5 arithmetic mean so single
and double positive events can be more easily visualized. 

Additionally, users may add a Radius Statistic , which changes the size of the
well to reflect the selected parameter. For instance, in Figure 32 below (right),
the heat/color for each well is dependent on the FL5 arithmetic mean while the
size of the well radius is dependent on the FL13 arithmetic mean.

Please see the Plate Heat Map Overlay  section of the manual for full
instructions on how to create a plate heat map overlays of different parameters
and types as well as setting the radius parameter statistic. 
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Figure 5.111 Custom Plate Heat Maps with Overlay (left) and Radius Parameter
(right). Standard Deviations of Color Levels was changed to 1.

5.1.6.4.2.3  Diva Index Sorting Data Files

Diva Index Sorting Data Files contain fluorescence information only on the
indexed sort events. A larger "master" .fcs file contains information on all of the
events collected during a sort while a single, or number of, smaller .fcs files
contain only the sorted events. See Figure 5.114 below where the master file is
354 kB in size while the file containing only sorted events is 7 kB in size. These
two files may be used individually or in conjunction via plot overlays to help
visualize index sorting data acquired with Diva.  

Figure 5.112 Diva Index Sorting Data Files. Note the larger sized "master" file that
contains all events collected and the smaller size file that only contains sorted

events. 

To analyze Index Sort Data: 
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1.  Insert a plate heat map  for the index sort data file.
2.  Select the parameter of interest on the y-axis (Figure 5.115).  

Figure 5.113 Default Plate Heat Map with FITC Arithmetic Mean Y
Parameter

3.  Insert a Color Dot Plot .
4.  Change the axes on the color dot plot to the parameters of interest.
5.  Create a Well Gate  on all wells.
   Notes: 

o  In addition to creating a gate on all wells a gate may

be created on one, or any number of wells, to
visualize the individually sorted cells. 

o  Since Diva Index Sorting Data Files only contain data

for the unsorted events, we can use the Emphasize on
Plots  feature of gates to emphasize the events that
fall within the gate (Figure 5.116).
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Figure 5.114 Plate heat map with Well Gate created on all wells. Standard
gate is shown above while a gate with the Emphasize on Plots check box

checked is shown below.  Note that events highlighted in red fall within the
well gate and in this case represent all events that were sorted into the

plate making them easier to visualize. 

6.  Optional: Create additional Well Gates to isolate an individual well
(blue event) or a group of wells (purple events) (Figure 5.117). 
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Figure 5.115 Color Dot Plot gated on Well Gate with Children Gates
Applied and Emphasized

In the event that you would like to compare the master file to the Index Sort
File, you can create a Color Dot Plot Overlay  with increased dot size for the
Index Sort Data. To do so:

1.  Insert a Color Dot Plot for the larger "master" file.
2.  Change axes to reflect parameters of interest (Figure 5.118).

202
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Figure 5.116Color dot plot of the
"master" file (largest file in the data

directory).

3.  Drag and drop index sort data file (smaller data file in the data
directory) from the data list onto the Color Dot Plot. 

4.  Select add the files to the plot as new overlays radio button
(Figure 5.119). 

Figure 5.117 Select Drag and Drop Action
Window to add Overlays to Color Dot Plot

5.  Click OK.
6.  Right click on the color dot plot.
7.  Select Format.
8.  Chose Overlays from the drop down.
9.  Select the second overlay.
10. Increase the Dot Size to 5. 
11. Click OK (Figure 5.120).
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Figure 5.118 Adding an Overlay to Color Dot Plot with increased dot size for
the index sorted data file.

It is possible to insert a plate heat map statistics grid  in a text box to display
statistics for each well in the plate heat map as done in Figure 5.121. 

Figure 5.119 Plate Heat Map Statistics Grid displaying statistics for the Y
parameter of the Plate Heat Map

Another useful feature for index sorting data is the Plate Heat Map Overlay
function. Plate Heat Map Overlays allow a user to view multiple statistics and
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parameters on a single plate heat map by adding each statistic as a new overlay.
For instance, in Figure 5.122 left, the upper slice of the well represents PE
arithmetic mean while the lower slice represents FITC arithmetic mean so single
and double positive events can be more easily visualized. 

Additionally, users may add a Radius Statistic , which changes the size of the
well to reflect the selected parameter. For instance, in Figure 32 below (right),
the heat/color for each well is dependent on the FITC arithmetic mean while the
size of the well radius is dependent on the PE arithmetic mean.

Please see the Plate Heat Map Overlay  section of the manual for full
instructions on how to create a plate heat map overlays of different parameters
and types as well as setting the radius parameter statistic. 

Figure 5.120 Custom Plate Heat Maps with Overlay (left) and Radius Parameter
(right). Standard Deviations of Color Levels was changed to 1.

5.1.6.4.2.4  Chorus Index Sorting Data Files

Chorus Index Sorting Data Files only allow for analysis on indexed sort events. 

To analyze Index Sort Data: 
 

1.  Insert a plate heat map  for the index sort data file.
2.  Select the parameter of interest on the y-axis (Figure 5.123).  
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Figure 5.121 Default Plate Heat Map with PerCP Arithmetic Mean Y
Parameter

3.  Insert a Color Dot Plot .
4.  Change the axes on the color dot plot to the parameters of interest.
5.  Create a Well Gate  on all wells.
   Note: 

o  In addition to creating a gate on all wells a gate may

be created on one, or any number of wells, to
visualize the individually sorted cells. 

o  Since Chorus Index Sorting Data Files only contain

data for the unsorted events, we can use the
Emphasize on Plots  feature of gates to emphasize
the events that fall within the gate (Figure 5.124).
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Figure 5.122 Plate heat map with Well Gate created on all wells. Standard
gate is shown above while a gate with the Emphasize on Plots check box

checked is shown below.  Note that events highlighted in red fall within the
well gate and in this case represent all events that were sorted into the

plate making them easier to visualize. 

6.  Select the Insert tab General Gate View command to insert a
Gate View .

7.  Drag and Drop the Well Gate from the Gate View to the Color Dot
Plot to apply the Well Gate (Figure 5.125).

391
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Figure 5.123 Color Dot Plot gated on Well
Gate with events emphasized

8. Optional: Create additional Well Gates to isolate any number of
individual wells (blue events below) or a group of wells (purple events
below) (Figure 5.126). 

Figure 5.124 Color Dot Plot gated on Well Gate with Children Gates
Applied and Emphasized
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It is possible to insert a plate heat map statistics grid  in a text box to display
statistics for each well in the plate heat map as done in Figure 5.127. 

Figure 5.125 Plate Heat Map Statistics Grid displaying statistics for the Y
parameter of the Plate Heat Map

Another useful feature for index sorting data is the Plate Heat Map Overlay
function. Plate Heat Map Overlays allow a user to view multiple statistics and
parameters on a single plate heat map by adding each statistic as a new overlay.
For instance, in Figure 5.128 left, the upper slice of the well represents FITC
arithmetic mean while the lower slice represents PerCP arithmetic mean so single
and double positive events can be more easily visualized. 

Additionally, users may add a Radius Statistic , which changes the size of the
well to reflect the selected parameter. For instance, in Figure 32 below (right),
the heat/color for each well is dependent on the PerCP arithmetic mean while the
size of the well radius is dependent on the FITC arithmetic mean.

Please see the Plate Heat Map Overlay  section of the manual for full
instructions on how to create a plate heat map overlays of different parameters
and types as well as setting the radius parameter statistic. 

Figure 5.126 Custom Plate Heat Maps with Overlay (left) and Radius Parameter
(right). Standard Deviations of Color Levels was changed to 1.
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5.1.6.4.3  Formatting a Plate Heat Map

All aspects of Plate Heat Maps may be formatted via the formatting options
below.

Please see related formatting options:
· Formatting Options Shared by All Objects  (General, Background/Fill,

Border/Line, Size)
· Formatting Features Shared by All Plots  (Title, Legend, Axes)

· Overlays

· Color Levels

· Plate Heat Map Specific Options

5.1.6.4.3.1  Formatting Plate Heat Map Overlays

Once overlays have been added to a Plate Heat Map (please refer to the
Creating Plate Heat Map Overlays  chapter), they may be edited similarly to 
Histogram Overlays  and 2D Plot Overlays .

Formatting Options for Heat Map overlays can be accessed via the Formatting
Options  dialog. The Formatting Options dialog can be accessed by either:

1. Selecting one or multiple Heat Map plot(s) and then using the appropriate
commands from the Format Object Options group in the ribbon  

2. Double clicking on the Heat Map plot. 
3. Right-click on a Heat Map and choose Format from the pop-up menu.

The Overlays option controls the parameter, statistics to display,
compensations, transformations, gates, and appearance of plate heat map
overlays (Figure 5.129).
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Figure 5.127 - Editing a Plate Heat Map Overlay

In the dialog, a list of all the overlays on the plate heat map will appear in the list
box on the top. You can select one or more overlays using standard Microsoft
Windows techniques, including Shift-Click and Ctrl-Click. The properties on the
bottom pertain to the currently selected overlay(s). If multiple overlays are
selected, the information will appear blank for those properties that are not
identical in all selected overlays. If the properties are not blank, then they are
identical for all selected overlays. Changing an option will change that property
for all selected overlays. For instance, if you select three overlays and change
the Gate, the Gate for all three overlays will be modified. 

To remove an overlay from a plot, select the overlay (or multiple overlays) and
press the Remove button. 
To change the order of selected overlay(s) in the legend , use the up and down

arrows ( ).
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Plate Heat Map Overlay Options are explained in the table below.

Option Explanation

Location
parameter

Is the X parameter (well parameter or classification parameter)
displayed on the plate heat map.

Statistic
parameter

A drop-down menu to select the parameter from which a
statistic will be chosen to be displayed. Please refer to the
Choosing Parameters and Statistics  chapter for more details. 

Statistic to
show

A drop-down menu to select the statistic  to show as an
overlay on the plate heat map. Please refer to the Choosing
Parameters and Statistics  chapter for more details.

Compensation If compensation definitions  are set, select the definition to use
when compensating the data in the overlay.

Transformatio
n

If transformations  are applied to the data set, select the
transformation to use when transforming the data in the
overlay.

Gate If gates are defined , select the gate that will be used to limit
the data that is displayed on the histogram.

Radius
Parameter 

Optional: A drop-down menu to select the parameter from
which a Radius statistic will be chosen. A Radius parameter
must be chosen to use a Radius statistic. 

Radius
Statistic

Optional: A drop-down menu to select the statistic to adjust the
radius of each well.

Legend Text The text that will appear in the legend beside the symbol for the
overlay. If this field is blank the file name of the overlay will
appear. Insert keywords from the header of the data file by
pressing the ellipsis next to the legend text. You can also display
the current gate applied to the overlay by typing
"<$FCSE_GATEFORMULA>" into the legend text.

Change data
file during
Next/Prev/Ba
tch

If this option is checked, the data file for this overlay will change
when doing batch processing , or selecting Previous File or
Next File . This option is usually only disabled for a control
histogram, where you have multiple overlays, and want the
control to stay the same all of the time.

Visible You can hide overlays on a heat map without removing them.
Select the overlay file from the list and uncheck Visible. Check
Visible to show the overlay again.

5.1.6.4.3.2  Formatting Plate Heat Map Color Levels

To choose the color scheme on a plate heat map, select the Plate Heat Map, and
either:
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· Select the Format tab 2D Options Color Levels command (Figure

5.130), or

· Right-click on the Plate Heat Map, select Format from the pop-up menu,

and choose Color Levels from the drop down. 

Figure 5.128  Formatting Color Level Options

The default settings are a Green-Red color scheme, a Style of Mean ± SD, and
3.5 standard deviations on either side of the scale. This means that wells close
to the average for the statistic being displayed are colored black, wells that are
+3.5 SD from the average are pure red, and wells that are -3.5 SD are pure
green.

You can select another color scheme using the Selected Color Level drop-down
list.

Available color schemes are:

· Blue Gradient
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· Blue-White-Red

· Color Blind

· Flame

· Green Gradient

· Green-Blue

· Green-Red

· Green-Yellow-Red

· Greyscale

· Inferno

· Inverse Greyscale

· Magma

· Plasma

· Rainbow

· Red Gradient

· Red-Green

· Red-White-Blue

· Red-Yellow-Green

· Threshold

· Viridis

The Color Blind option is derived from the color palettes recommended in
Getting into Visualization of Large Biological Dat Sets: The 20 Imperatives of
Information Design by Martin Kryzwinski et al. More options may be added as
requested.

Inferno, Magma, Plasma and Viridis color levels are inspired by the "Viridis"
palette for R. 

The Threshold scheme has specific Color Level Properties related to the
threshold value (Figure 5.131).

http://mkweb.bcgsc.ca/biovis2012/
http://mkweb.bcgsc.ca/biovis2012/
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Figure 5.129  Threshold Color Scheme

When the Selected Color Level or Style are set to Threshold, you can choose
a token (e.g., a statistic based on a control well) to represent the Threshold

Value by clicking on the  button, or simply type in an arbitrary free text value.
Then, set the Below Threshold and Above Threshold colors using the drop-
down lists. Wells whose value is below the threshold value will be displayed in the
first color, and wells with a value above the threshold value will be displayed in
the other color.

5.1.6.4.3.3  Formatting Plate Heat Map Specif ic Options

Plate Heat Map Specific Options may be accessed by selecting the Plate Heat
Map, and either:

· Select the Format tab Plot Options Specific command  from the ribbon

bar (Figure 5.132), or

· Right-click on the Plate Heat Map, select Format from the pop-up menu,

then choose Specific Options from the dropdown. 
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Figure 5.130 The Plate Heat Map Specific Options dialog when
accessed via the ribbon bar.

Plate Heat Map Specific Options allow to modify two Plate Heat Map properties:

· Orientation. This option allow to display the Plate Heat Map with

Landscape or Portrait orientation.  For Plate Heat Maps displaying
SPADE, do not change this setting.

· Display space between the wells. The option allows you to remove

any spacing between wells. 

· Number of columns to display. This option applies to Plate Heat Maps

that display Cluster Assignments from a k-Means transformation  and
for plate heat maps that are displaying merged files . It allows you to
specify how many columns to display for Clustering Assignment rather
than choosing a default number of well columns to display. For merged
data files it determines how many columns wide the plate heat map
should represent before "wrapping" to the next row. For instance, if 96
samples are merged together that represent a plate heat map, setting
the value to 12 would result in a plate heat map with 12 columns and 8
rows. 

· Node Size Range. This option allows to customize how the well size is

calculated. When no Radius Statistics is defined in the Formatting
Overlay Options, only the Max Size parameter is used. When a
Radius Statistic  statistics is defined in the Formatting Overlay
Options both he Min Size and the Max Size are used. In both cases,
the percentages define how smaller/larger will be the Min/Max well size
as compared to the default setting (i.e. 200% means that the well will
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be twice as large as the default size, while 50% means that well size will
be half of the default size). Some examples are depicted below in Figure
5.133.

Note: Setting the Node Size Range may be of particular use with
many of the FCS Express pipelines, including FlowSOM . 

5.1.6.5 Parameters Heat Map

The Parameters Heat Map plot type allows you to quickly compare parameters
across gated populations and data files in a convenient visual format, without the
requirement of having plots for each data file inserted on your layout.  Unlike
regular Plate Heat Maps , which only graph data files from multi-well plates,
Parameters Heat Maps can graph data from all data files, regardless of whether
they were acquired in plate format.

To insert a Parameters Heat Map plot, choose the Insert tab Other Plots
Parameters Heat Map command, and click once on the layout where you want
the plot to be inserted.  Any default 2D-plot statistic  for the parameters may
be shown in a Parameter Heat Map.  Below is an example where a statistic
(Arithmetic Mean), from four different parameters ("FITC", "PE", "PE-Cy7", and
"APC-Cy7"), is being compared across multiple data files and gates
simultaneously, using the Parameters Heat Map plots at left and right,
respectively (Figure 5.134).
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Figure 5.131  Examples of Parameters Heat Maps (top) showing different
parameters for multiple data files or gates, and the original plots on which the

gates were drawn (bottom).

A Parameters Heat Map Stats Grid may be inserted for any Parameters Heat
Map on the layout by right-clicking inside a Text Box , and selecting 
Insert from the pop-up menu  Heat Map Stats Grid
and selecting the Heat Map of interest (Figure 5.135). 

Figure 5.132  Inserting a Parameters Heat Map Stats Grid inside a Text Box.
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The Stats Grid contains the Statistic to show value for each cell that was chosen
by the user in Gates Heat Map Overlays .

Many of the formatting features in regular Heat Maps are available for
Parameters Heat Maps, and these are detailed in the following sections:

· Parameters Heat Map Overlays

· Parameters Heat Map Color Levels

· Parameters Heat Map Specific Options  

5.1.6.5.1  Creating Parameters Heat Map Overlays

FCS Express allows users to view multiple parameters from a high content
experiment in a single Parameter Heat Map by adding each file as a new overlay.
Each parameter is represented by a square with each overlay presenting in
rows. 

There are four ways of adding overlay on a Parameter Heat Map:

1. Drag-and-drop file(s) from the Data List  onto the Heat Map you wish
to overlay. A Select Drag and Drop Action dialog will open, asking
whether to replace the existing overlay or to add the files as new overlays.

2. Drag-and-drop a plot from the layout onto the plot you wish to overlay. A
Select Drag and Drop Action dialog will open, asking whether to replace
the existing overlay or to add the files as new overlays.

3. Right-click on the plot and select Add overlay from the pop-up menu. This
launches either the Select Data File or the Open Data File dialog
depending on the Open Data Dialog user Options . 

4. Right-click on the plot and select Add Overlay using Advanced Open
Data Dialog (launches the Open Data File  dialog).

If either Add Overlay option is used, after selecting the data file(s) to add as new
overlays, the Add overlay(s) dialog will open (Figure 5.136).
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Figure 5.133 The Parameters Heat Map Add Overlays dialog.

The Add overlay(s) dialog allows users to choose, individually for each of the
data file(s) listed in the Open 2D Plot(s) for Data Files list, the Gate and the
Transformation to use for the selected overlay.

The new overlay will be added to the Parameters Heat Map. The first overlay
occupies the top row, while new overlays are added beneath the last row in the
plot. (Figure 5.137). 
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Figure 5.134 Parameters Heat Map with Overlays. Overlays are added to the next
row in the plot.

Multiple properties can be formatted for each overlay via the Parameters Heat
Map Overlays  dialog. However, one Color Level  will be applied globally to
all overlays of a Parameter Heat Map.

5.1.6.5.2  Parameters Heat Map Overlays

Additional overlays from the same or different data files can be added to
Parameters Heat Map plots in the same way that overlays are added to
histograms and other plots in FCS Express. Please refer to the Creating
Parameters Heat Map Overlays  chapter.

The Overlays formatting option controls the spectrum and appearance of
Parameters Heat Map Overlays. 

You can edit Overlays (Figure 5.138) in one of two ways:

· Select the Parameters Heat Map plot(s) and use the Format Plot

Options  command in the ribbon bar. 
· Right-click on the Parameters Heat Map, select Format from the pop-up

menu, then choose Overlays from the dropdown menu.
·
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Figure 5.135  Edting Parameters Heat Map Overlays.

In the dialog, a list of all the overlays on the heat map will appear in Options list
box, in the upper pane of the dialog. You can select one or more overlays using
standard Microsoft Windows techniques, including Shift-Click and Ctrl-Click. The
properties in the lower pane of the dialog pertain to the currently selected
overlay(s). If multiple overlays are selected, the information will appear blank for
those properties that are not identical in all selected overlays. If the properties
are not blank, then they are identical for all selected overlays. Changing an option
will change that property for all selected overlays. For instance, if you select
three overlays and change the Gate, the Gate for all three overlays will be
modified. 

To remove an overlay from a plot, select the overlay (or multiple overlays) and
press the Remove button. 
To change the order of selected overlay(s) in the legend , use the up and down

arrows ( ) to the right of the Options list box.
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Note the Parameters Heat Map Overlay Options may also be set in the FCS
Express User Options.

Parameters Heat Map Overlay Options are explained in the table below.

Option Explanation

Statistic to
show

A drop-down menu to select the statistic  to show as an
overlay on the Parameters Heat Map.

Compensation If compensation definitions  are set, select the definition to use
when compensating the data in the overlay.

Transformatio
n

If transformations  are applied to the data set, select the
transformation to use when transforming the data in the
overlay.

Gate If gates are defined , select the gate that will be used to limit
the data for each overlay that is displayed on the Parameters
Heat Map.

Radius
Statistic

Optional: A drop-down menu to select the statistic to adjust the
radius of each plotted statistic. The Use Radius Statistic box
must be checked to display the Radius Statistic. It will calculate
the well sizes across an overlay.

Use Radius
Statistic

Optional: Check box to enable the use of the Radius Statistic. If
enabled, the Radius Statistic range of values will be depicted in
the Legend .

Legend Text The text that will appear in the legend beside the symbol for the
overlay. If this field is blank the label selection in the Specific
Options will appear. Insert keywords from the header of the
data file by pressing the ellipsis next to the legend text. You can
also display the current gate applied to the overlay by typing
"<$FCSE_GATEFORMULA>" into the legend text.

Change data
file during
Next/Prev/Ba
tch

If this option is checked, the data file for this overlay will change
when doing batch processing , or selecting Previous File or
Next File .

Visible You can hide overlays on a Parameters Heat Map without
removing them. Select the overlay file from the list and uncheck
Visible. Check Visible to show the overlay again.

5.1.6.5.3  Parameters Heat Map Specif ic Options

Parameters Heat Map Specific Options may be accessed by selecting the
Heat Map, and either:

· Select the Format tab Plot Options Specific Options command from

the ribbon bar (Figure 5.139), or

· Right-click on the Parameters Heat Map, select Format from the pop-up

menu, then choose Specific Options from the dropdown menu. 
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Figure 5.136  Formatting Parameters Heat Maps
Specific Options.

Parameters Heat Map Specific Options allow to modify four Parameters Heat
Map properties:

· Orientation. This option allows to display the Heat Map with Landscape

(in which Parameters are arrayed across the top of the plot from left to
right, while data files or gates are arrayed along the left side of the plot,
from top to bottom) or Portrait orientation (vice-versa).

· Display space between wells.  This option, if checked, displays a small

space between adjacent wells on the Parameters Heat Map.  Default is
unchecked.

· In the labels, display. This option changes the labels on the Heat Map

to show the Overlay name, Gate Name, or Overlay and Gate Name.
Default is Overlay Name.

· Color Level Options. This option assigns the colors from Color

Levels  on the basis of rows, columns, or the entire array of rows and
columns.

Note the Parameters Heat Map Specific Options may also be set in the FCS
Express User Options .

5.1.6.5.4  Parameters Heat Map Color Levels

To choose the color scheme on a Parameters Heat Map, select the Parameters
Heat Map plot, and either:
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· Select the Format tab 2D Options Color Levels command (Figure

5.140), or

· Right-click on the Parameters Heat Map, select Format from the pop-up

menu, then choose Color Levels from the dropdown menu. 

Figure 5.137  Formatting Color Levels in a Parameters Heat Map.

The default settings are a Green-Red color scheme, a Style of Mean ± SD, and
3.5 standard deviations on either side of the scale. This means that parameter
statistics close to the average for the statistic being displayed are colored black,
those that are +3.5 SD from the average are pure red, and those that are -3.5
SD are pure green.

You can select another color scheme using the Selected Color Level drop-down
list.

Available color schemes are:

· Blue Gradient

· Blue-White-Red
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· Color Blind

· Flame

· Green Gradient

· Green-Blue

· Green-Red

· Green-Yellow-Red

· Greyscale

· Inferno

· Inverse Greyscale

· Magma

· Plasma

· Rainbow

· Red Gradient

· Red-Green

· Red-White-Blue

· Red-Yellow-Green

· Threshold

· Viridis

The Color Blind option is derived from the color palettes recommended in
Getting into Visualization of Large Biological Dat Sets: The 20 Imperatives of
Information Design by Martin Kryzwinski et al. More options may be added as
requested.

Inferno, Magma, Plasma and Viridis color levels are inspired by the "Viridis"
palette for R. 

The Threshold scheme has specific Color Level Properties related to the
threshold value. When the Selected Color Level or Style are set to Threshold,
you can choose a token (e.g., a statistic based on a control) to represent the

Threshold Value by clicking on the  button, or enter an arbitrary value. Then,
set the Below Threshold and Above Threshold colors using the drop-down
lists. Parameter statistics whose value is below the threshold value will be
displayed in the first color, and those with a value above the threshold value will
be displayed in the other color.  In Figure 5.141 below, the threshold has been
set to 1500, and the Above Threshold Color to Red.

http://mkweb.bcgsc.ca/biovis2012/
http://mkweb.bcgsc.ca/biovis2012/
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Figure 5.138  Formatting Color Levels to Threshold Style in a Parameters Heat Map.

Note the Parameters Heat Map Color Levels may also be set in the FCS Express
User Options .

5.1.6.5.5  Parameters to Display

By default, a Parameters Heat Map displays all available parameters on the plot.
In the formatting category Parameters to Display, any parameter may be
excluded or included from the heat map by checking or un-checking the
appropriate box in the Parameter Options section (Figure 5.142). 
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Figure 5.<%C++%>. Select Parameters to Display
for Parameters Heat Map.

The Parameters To Display options include:

· All items - select this option to display all parameters available.

· Only the items checked below - select this option to display only those

parameters checked in the box below.
· All items except those checked below - select this option to exclude only those

parameters checked in the box below.

Note the Parameters to Display may also be set in the FCS Express User
Options .

5.1.7 Formatting Options Shared by All Plots

In addition to the formatting options common to all objects , all plots in FCS
Express share certain formatting features:

· Title

· Axes

· Legend

· Plot 3D Options  (available only for Histograms and Surface plots)
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Each specific plot type has additional specific options which may be adjusted.
Please refer to the plot type of interest for those options:

· 1D Plots: Common Options for All 1D Plots  (including standard

Histograms), Mulitcycle , Proliferation  and Subtraction .
· 2D Plots: Common Options for all 2D Plots , Dot Plots and Color Dot

Plots , Density and Contour Plots , Surface  and Kinetics .
· Other plots: Plate Heat Maps , Gate Heat Maps , Picture Plots  and

Spectrum Plots .

Formatting options allow the user to completely customize the look of individual
plots. If you find yourself changing formatting options often, you may want to
change the default plot options  so plots appear with the preferred
formatting automatically.

You may format a plot or object by:
· Right-clicking on it (or double-clicking on a plot that is already selected),

selecting Format from the pop-up menu, and choose a category to format
from the dropdown. 

o All changes made while formatting a plot will be displayed in real time on the

object. 

· Select the plot and choose the desired category from the Format tab of the

Ribbon . Formatting from the ribbon will open a formatting dialog in a
dockable window that will apply changes as they are made. 

5.1.7.1 Title

This category controls the default Titles Options for plots.  The options are
explained below and pictured in Figure 20.1.
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Figure 20.1  Titles Options

Visible headers are the default for plot titles, "centered" with a grey background,
no shadow, and a black border.
The first row of the header text defaults to the file name Keyword:
$FCSE_FILENAMENOPATH for plot text box ...  which represents the local
file name (no drive\folder) with compensation text that is defined in the General
section of the FCS Express User Options .
The second row of the header text defaults to the Current Gate keyword, which
displays the name of the gate that is applied to the base overlay.

The text options for titles are explained in the table and text below.

Option Explanation

Header/Foot
er

Select either a Header or Footer in the upper left corner of the dialog to
determine which title location is currently being edited. Headers and

1601
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Option Explanation

footers can co-exist.

Visible Check or uncheck the check box to turn the Header/Footer on or off.

Font Customize the header/footer font style, size, and text color.

Text Field Enter text to be displayed in the Header/Footer in this field. Keywords
chosen will appear in the text field as codes, but expand to file-specific
values in the title.

Insert Token A drop-down a list of special tokens that can be used in plot titles. The
following options are available:

· Keyword from Data. Opens the FCS keyword list for the current file.

Select keyword(s) from the list (using Ctrl to select multiple
keywords) to insert in the header/footer. 

· File name with Path. Displays the data file name including the drive
and folder.

· File name without path. Displays the data file name without the
drive\folder path.

· File name from Data. Displays the $FIL keyword (which is part of
the FCS standard and is placed into the data file header during
sample acquisition).

· Current Gate. Displays the name of the gate that is applied to the
base overlay.

· Plot number.  Displays the Plot Number of the plot (usually visible as
part of the plot name in General options ).

· Other Tokens.... Let the user insert any of the tokens available in
the layout. An Inserting Tokens  window will open upon selecting
this option.

Background
visible

Check to enable a visible background for the Title. Options for customizing
the background include color, shadow size, and shadow color options.

Background
color

Set the background color of the header/footer title.

Shadow Size Set the shadow size of the header/footer title. To remove the shadow, set
the Shadow Size to 0.

Shadow
Color

Set the shadow color of the header/footer title.

Rounded
Border

Check to display the rectangle surrounding the header/footer title with
rounded edges.

Background
Border
Visible

Check to display a visible background border for the header/footer title.

Background
Border Color

Set the color of the background border for the header/footer title.

Alignment Align the title text left, center, or right.

5.1.7.2 Legend

Legend formatting options control the appearance and position of the legend in
relation to the plot.

You can edit the Legend options in one of two ways:

· Select the plot(s) and use the Format Plot Options Legend command. 
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· Right-click on the plot, select Format from the pop-up menu, and choose

Legend from the drop down (Figure 5.143).

Figure 5.139  Formatting Legend Dialog

The options for legends are explained in the table below.

Option Explanation

Visible Check or uncheck the checkbox to turn the legend on or off.

Position Set the legend to the right, left, top, or bottom of the plot.

Margin Sets how far the legend is from the plot. Margin = 0 calculates the
margin automatically.

Top position % Sets where the top of the legend is located.

Back color Sets background color of the legend.

Shadow size and
color

The number sets the size of the shadow; use 0 for no shadow.
Choose the color from the drop-down list.

Resize chart to
accommodate
legend

Enabling the checkbox will resize the plot to accommodate the
legend. The legend and plot events will overlap if the option is
unchecked.
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Option Explanation

Title Visible Enabling the check box will display the legend title on Density and
Contour plots. The legend title is text as well as an interactive drop
down menu that allows you to easily change the parameter to use
for the Color based on  option.

Font... Customize the Legend font style, size, and text color.

5.1.7.3 Axes

The Axis options control the appearance and text of the plot axes.

You can edit the Axes options in one of two ways:

· Select the plot(s) and use the Format Plot Options  command. 

· Right-click on the plot, select Format from the pop-up menu, and choose

Axis from the drop down (Figure 5.144).
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Figure 5.140  Formatting Axes Dialog
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The options are explained in the table below. With the Visible check box, where
present, you can determine if the option is displayed or not. 

Option Explanation

Select
Axis

Select the Y Axis or X Axis to determine which axis is currently being edited.

Scale If Automatic scaling is checked, the axis will be shown in the scale chosen
automatically by FCS Express for that parameter (from the $PnE keyword).
You can override automatic scaling, and choose the axis scaling .  Manual
changes to the scale for a given plot parameter may be remembered and
applied automatically to all plots in the layout editing your layout options .

Lines
· Major

Tick Line
· Minor

Tick Line
· Grid

Lines
· Axis

Lines

Set the line visibility, width, style and color for the selected line.

Range For all axes displaying data:
· If Automatic Range is checked and the resolution options are set to

automatic , then the range will either start at 0 or the lowest data
value (a negative number) and extend to the highest data value.

· If Automatic Range is turned on, but the resolution options are not
automatic, the range will be the minimum to maximum specified in the
resolution options.

· For the count axis on a histogram, if Automatic Range is enabled, the
axis range will extend from 0 to the highest event count.

· Minimum. The minimum value to display on the axis. This option is only
meaningful if automatic range is turned off.

· Maximum. The maximum value to display on the axis. This option is only
meaningful if automatic range is turned off.

Ticks
Spacing
Style

Allows the user to customize how tick marks appear on the axis.
·  # Ticks. The number of ticks to show along the axis can be specified.
·  Interval Value. Display ticks at specific intervals i.e 10,000.
·  Automatic Interval. Display ticks at intervals automatically determined

by FCS Express.

Title Set the visibility, specific text, font style, size, color, and angle for the title of
the axis parameter.

Derive
Axis Titles
From

Choose Parameter Name, a Parameter label set  (if a label set has been
defined), or the text specified in the Text field (under Title).

Labels Set the visibility, font style, size, color, and angle for the numbers which label
the scale.

Divide by
Factor

Divide the nominal axis labels by a given factor, and choose whether or not to
show the factor in the Axis title.

Other If Display axis at zero is checked, the axis currently being edited will be
displayed at zero rather than at the plot origin.
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5.1.7.3.1  Axis Scalings

FCS data has traditionally been acquired on either a linear or logarithmic scale,
and the appropriate scaling is stored in the header of the FCS data file. Although
FCS Express has supported displaying linear data on a logarithmic scale, the data
has traditionally been displayed on the same scale as it was acquired.

The logarithmic scale has the disadvantage that it cannot display values below
zero. This is considered a limitation when performing software compensation
where it is common for a significant proportion of compensated data to appear
in a "negative" channel. When displayed on a log scale, the negative values are
placed on the axis, where they can be easily missed, leading you to
overcompensate your data.

To overcome this limitation, several additional axis scalings have been developed.
These scalings share the general characteristic that they behave linearly close to
zero, and behave logarithmically farther away from zero. These scalings also are
defined to be able to graph data below zero. Scalings that are a combination of
linear and log scalings are called hybrid scalings. More details can be found in the
following publications:

· Herzenberg LA, Tung J, Moore WA, Herzenberg LA, Parks DR. Interpreting

flow cytometry data: a guide for the perplexed. Nat Immunol 2006;7:681-
685.

· Parks DR, Roederer M, Moore WA. A New "Logicle" Display Method Avoids

Deceptive Effects of Logarithmic Scaling for Low Signals and Compensated
Data. Cytometry A 2006;69A:541-545.

· Bagwell CB. Hyperlog – A Flexible Log-like Transform for Negative, Zero,

and Positive Valued Data. Cytometry A 2005;64A:34-42.

· Battye FL. A Mathematically Simple Alternative to the Logarithmic Transform

for Flow Cytometric Fluorescence Data Displays. Cytometry A
2006;69A:413-414. 

The axis scale for a given plot can be adjusted using the Axis formatting dialog
or manual changes to the scale for a given plot parameter may be remembered
and applied automatically to all plots in the layout editing your layout options .
All data files, regardless of the scale that they were acquired with, can be
displayed in any of the scalings supported by FCS Express. The scaling only
affects the display of the data, not the statistics .

FCS Express supports the following axis scalings:
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Linear 

This is the standard linear scaling

Log

This is the standard log scaling

Log with Negative

This is a modified log scaling.

In the normal log function the zero and negative values are undefined, and
if they are obtained during compensation they are commonly represented
as events stacked on the axis, as is commonly seen in compensated data.
In the log with negative function, if negative values are encountered, the
log of its absolute value is calculated and displayed on the negative side of
the scale, effectively creating a "negative logarithm" display which is a
mirror image of its positive counterpart. Zero values are still kept on axis.

Hyperlog™ – Described in the Bagwell paper, above.

The Hyperlog scalings has a coefficient that can be adjusted. The
coefficient is called the Transition Point because it describes the transition
from the predominantly linear to predominantly log portion of the
transform. The transition parameter for the Hyperlog scaling is identical to
the b parameter in the Bagwell paper, above.
Transition values are entered in channel units, and do not have to be
scaled as described in the Bagwell paper.
Smaller transitions values result in plots which more closely resemble the
standard log plots. The precise transition value to use will depend for the
most part on your data, and generally a value of at least 30 is required.

Lin/Log

This scale is described in the Battye paper, above.
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The Lin/Log has a coefficient that can be adjusted. The coefficient is called
the Transition Point because it describes the transition from the
predominantly linear to predominantly log portion of the transform. This
transform is purely linear below the transition point and purely log above
the transition point. The a and c coefficients are matched so that the
function is continuous at the transition point.

An example of setting the Lin/Log scaling with a Transition Point of 200 is
shown in Figure 5.145. Transition values are entered in channel units, and
do not have to be scaled as described in the Bagwell paper.

Figure 5.141  Setting the Transition
Point for the Y-axis in Lin/Log Scaling

Smaller transitions values result in plots which more closely resemble the
standard log plots. The precise transition value to use will depend for the
most part on your data, and generally a value of at least 30 is required.

ArcSinh 

ArcSinh is an inverse hyperbolic function most widely used with .fcs files
generated by CyTOF Mass Cytometry. Unlike standard light based flow
cytometry, mass cytometry can produce many true zero signal ("intensity")
values. An ArcSinh transformation helps display and visualize values at or near
zero with a "spread" as we are accustomed to visualizing with standard flow
cytometry data.
ArcSinh values are calculated by dividing the raw intensity value by a cofactor
and by then applying the ArcSinh equation to the result of the division (i.e.
=Arcsinh(value/cofactor) ). The "cofactor" defines the size of the linear region
around 0, with larger cofactors corresponding to a longer linear region. The
Arcsinh formula is depicted in Figure 5.146.
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Figure 5.142 - The formula for converting to
Archsinh scaling.

Arcsinh is choosen from the Scale drop down menu. The cofactor
value determines the size of the linear region around 0.

Biexponential

The biexponential display was popularized by the BD FACSDiva software.
As a result of our close collaboration with BD, FCS Express now supports
all of the options that FACSDiva does in terms of displaying biexponential
data. In fact, we have implemented FACSDiva's proprietary algorithm for
calculating the transition point (i.e. Below Zero parameter), so the results
from FCS Express will look identical to the results from the FACSDiva
software. For more details please refer to the Biexponential Scaling
Implementation in FCS Express  chapter. 

When an FCS file that was acquired with BD FACSDiva is opened in FCS
Express you will notice that the automatic scaling in FCS Express applies
the Biexponential scaling and chooses the Below Zero Parameter (i.e.
the transition point) automatically (Figure 5.147).
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Figure 5.143  Automatic biexponential scaling in
FCS Express of a file acquired in BD FACSDiva.

The Below Zero Parameter can also be manually adjusted by unchecking
the Automatic box and selecting the Use the value radio button. The
Below Zero Parameter can then be adjusted via the slider bar or by
manually entering a value into the text box (Figure 5.148).

Figure 5.144  Manually entering a Below Zero
Parameter value with Biexponential scaling.

The Calculate automatically radio button may also be checked if you
would like to change the gate for calculating the display (Figure 5.149,
upper pane) or if you would like to change the method for calculation from
BD FACSDiva Method to Fifth Percentile (Figure below, lower pane).
The Fifth Percentile method sets the plots minimum such that the
bottom 5% of the data within the selected gate is not visible .
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Choosing a gate for calculating the biexponential
display.

Figure 5.145 Choosing the Fifth Percentile method
or BD FACSDiva Method for display.

You may also choose to Automatically set the plot's minimum value
by checking/unchecking the associated box. When the Automatically set
the plot's minimum value is checked the axis minimum is set to
optimize the display by not displaying outliers. When unchecked the entire
range of data, including outliers, will be displayed.



FCS Express 7 Manual352

© 2023 De Novo Software

5.1.7.3.1.1  Axis Scalings and Statistics

In FCS Express, all the statistics are calculated on the raw data, irrespective of
the display scaling. However, when Gates and Quadrants are created decisions
must be made in cases where an event falls on the line of the gate or quadrant.

In FCS Express, Gates and Quadrants are calculated and drawn in a binned space
with binning dependent on both the Scaling  and the Resolution
Minimum/Maximum  of the plot. In turn, the inclusion or exclusion of an event
on the border line of a gate or in a quadrant is highly dependent on the scaling of
the plot, and on the Resolution Minimum/Maximum, of the plot the
Gate/Quadrants was drawn on. 

When adjustments to the scaling or resolution of a plot are made, an event may
then fall to a different side of the border line of the gate/quadrant, and the user
may notice very slight changes in the statistics of gated events which are usually
quite minimal and make no impact on the interpretation of the results. 

To illustrate the scenario the example below use the exact same Quadrants
which have been drawn on different plots using different Scale and/or different
Resolution Minimum/Maximum values. In row 1, the three plot are using different
Scales (i.e. Log, Biexponential and Hyperlog respectively) but the same
Resolution Minimum/Maximum. In row 2, the three plots are using the same
scale (i.e. Biexponential) but different Resolution Minimum/Maximum values. In
row 3, plots are using different Scales and different Resolution
Minimum/Maximum  values.

Each of the plots below is using a different binning, thus, Quadrants drawn on
each them, will use a slightly different binning as and very slight differences in
percentages may be observed (Figure 5.150).
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Figure 5.146 The same Quadrants have been displayed on plots using different axis
scales and/or different Resolution Minimum/Maximum values. Quadrant

statitìstics are slightly different (yet statistically insignificant) because of the
different binning on the plots and the assignment of events that fall on the borders

of the quadrants. 

Although small differences exist for both Quadrants and Gates, they are usually
only visible for quadrants since they are dependent on the scaling of the plot the
quadrant is displayed on. When the axis scale changes, the Quadrant binning on
that plot updates as well.

The behavior of Gates is slightly different, as Gates retain the binning of the plot
they have been drawn on meaning that a gate can be displayed on plots using
different scales but, for consistency, it will always refer to the binning of the plot
it has been drawn on.

In the following three scenarios (Figure 5.151), the same Gate has been drawn
on a plot using a specific scale (i.e. Log scale in the first row, Biexponential scale
in the second row or Hyperlog scale in the third row). The gate has then been
displayed on plots using different scales (i.e. Log scale in the first column,
Biexponential scale in the second column or Hyperlog scale in the third column).
The Resolution Minimum/Maximum on all the plots below is set to Automatic,
thus it will vary between the three columns.
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The gate statistics are consistent within each row, because in each row the same
gate is displayed on different plots. However, small differences are visible
between different rows because the gates are using three different binnings.

Figure 5.147 The same Gate has been drawn on plots using different axis Scales
and different Resolution Minimum/Maximum (Rows 1, 2 and 3) and then displayed

on plots using different axis Scales and different Resolution Minimum/Maximum
(Columns 1, 2 and 3). Gate statitìstics are slightly different (yet statistically

insignificant)change between rows because of the different binning. Gate
statitìstics do not change between columns because Gates retain the binning of the

plot thay have been drawn on.
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5.1.7.3.1.2  Gating and Axis Scalings

When gates are drawn on a plot, the axis scaling of that plot will become the

scaling of the gate. This means that if a gate is drawn on a plot using a particular

scaling, and then the gate is displayed on a plot with a different scaling, the gate

may appear distorted. The gate may also appear distorted if it is displayed on a

plot with the same scaling, but a different transition point (e.g., a different "Below

zero" parameter for Biexponential scaling). The original scaling that was used

when then gate was drawn will be called the native scaling and the alternative

scale that it is being displayed will be called the non-native scaling.

Figure 5.152 shows an example of how the gate perimeter can appear distorted
when the gate is displayed on a non-native scale. The gate was drawn in linear
scale (shown on the left panel) and then displayed on a log scale (shown on the
right panel). Notice that the straight lines of the gate borders appear curved in
the log space. This is correct and is caused by the relative distortion introduced
by the log scaling.

Figure 5.148  Warped Gates in Different Scalings

If you move a gate  on a plot displaying a non-native space, the shape of the
perimeter of the gate may change as you move the gate, to reflect the mapping
of the scales in the different regions of the plot. There are several considerations
to take into account when moving a gate on a non-native scale. Since the gate
scale is in the native space, the gate may not be able to move to certain
positions on the non-native plot. For instance, assume you created a gate on a
log scale, which has no negative values, and you are now displaying the gate on
a "log with negative" scale, that does have negative values. You will not be able

730
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to move the gate to the area of the plot containing negative values, since the
native scaling (log) does not support negative values.

A more subtle distortion is depicted in the next figure. The gate shown in the right
panel of the figure above (Warped Gates in Different Scalings) was moved to the
position shown in Figure 5.153. It is obvious that the gate no longer appears as
a four-sided polygon.

Figure 5.149  Distorted Gate in Non-native
Space

The explanation for this can be appreciated by examining the gate in the native
space, seen in Figure 5.154. It is evident that the vertices of the gate (located
near the origins) comprise a very small area of the data space in the native
space. Thus, there is not enough resolution in the native space to accurately
draw and calculate a perimeter, and the perimeter appears distorted in the non-
native space.
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Figure 5.150  Not Enough Resolution in
Native Space

If you are displaying a gate on a non-native scale and wish to change it so that
scale becomes the native scale, simply draw a new gate on the plot with the
non-native scale and replace the existing gate (see Creating Gates ).

5.1.7.3.1.3  Quadrants and Axis Scaling

Linked quadrants  will also appear distorted if they are displayed on plots with
different scalings, as shown in Figure 5.155.

703
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Figure 5.151  Linked Quads Displayed in Non-native Space

5.1.7.3.1.4  Biexponential Scaling Implementation in FCS Express

Biexponential Scale Formula

The biexponential scale formula is defined by the equation1:

Where x is the value in scaled space, while f(x) is the value in linear space.

In order to generate a formula which is valid for all possible real numbers, we
reflect the scale formula about w when x < w (Equation 2).

By definition, , so we can simplify Equation 2.

For this equation, 

· T represents the range of the data in linear space.

· m represents the approximate number of decades of scaled space. For

FCS Express, we use the following relation to determine a reasonable
value for m:
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· w is the approximate width of the linear data range in scaled space.

o The limits of values for w are described in the second paper on the

scale formula2. 

At w = 0, the linear region of the scale formula is 0, while at w =
m/2, the linear region extends for the majority of the data range.

· p is defined by its relationship to w: 

In order to control the width parameter, w, the original paper1 introduced a
separate parameter, the “Below zero value”. This value should be equal to the
most negative values in the data set. 

In the original paper, the below zero value, R, is always negative. However, in
FCS Express, we will display the below zero value as a positive value equal to the
absolute value of the paper’s below zero value. 

In the second paper describing the biexponential scale formula2, we should pick a
value of w which is non-negative. Based on this reasoning, we can limit the
values used as the below zero value.

In a standard 18-bit data file, we have T = 262144 and m = 10.3616. In order
to have a non-negative w value, 8.2897.

Invalid below zero values:
The graph of the equation that relates w and p is shown below. 
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We can see from the graph that if we require w to be positive, then the value of
p will be greater than 1. In this graph, we can also see that if we relax the
constraint that w is non-negative we can extend the values for w down to a
global minimum at w = -0.5569290855... = wmin

Based on the relationship between R and w, we can define the minimum value of
the below zero value using the following expression. 

For example, in a standard 18-bit data file, T = 262144, m = 10.3616, and the
minimum below zero value will be approximately 2.7214. 

A graph of the relation between T and Rmin is shown below.
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5.1.7.4 Magnifying a Plot

It is possible to Magnify  a region of a histogram  or 2D plot .

Magnifying Axes is equivalent to setting the minimum and maximum axis range
for the plot .  Magnifying Resolution also resets the range of data displayed on
the plot, but also applies your Plot Resolution  to the displayed range, rather
than to the entire .fcs file.
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To magnify a histogram:

· Right-click on the histogram and select either Magnify (Resolution) or

Magnify (Axis) from the pop-up menu.
· Press and hold the mouse button down where you want the lower bound of

the magnification to be.
· Drag the cursor to where you want the upper bound of the magnification to

be.
· Release the mouse button.

An example histogram for the Magnification operation is shown in Figure 5.156.

Figure 5.152  An Example Histogram
Before Magnification

The result for Magnify (Resolution) for the region from channel 445.8 to 776.8
is shown in Figure 5.157.
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Figure 5.153  Magnify Resolution from
Channel 445.8 to 776.8

The result for Magnify (Axis) for the region from channel 445.8 to 776.8 is
shown in Figure 5.158.

Figure 5.154  Magnify Axis from Channel
445.8 to 776.8
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To release the magnification, right-click on the histogram and select UnMagnify
(Resolution) or UnMagnify (Axis) from the pop-up menu.

Magnifying a 2D plot sets the minimum and maximum values on both the X- and
Y-axis scales.

To magnify a 2D plot:

· Right-click on the 2D plot and select either Magnify (Resolution) or

Magnify (Axis) from the pop-up menu.
· Press and hold the mouse button down where you want one end of the

magnification "box" to be.
· Drag the cursor to where you want the other end of the magnification "box"

to be.
· Release the mouse button.

An example 2D plot for the Magnification operation is shown in Figure 5.159.

Figure 5.155  An Example 2D Plot Before
Magnification

The result for Magnify (Resolution) for the region with the majority of cells is
shown in Figure 5.160.
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Figure 5.156  Magnify Resolution for a 2D
Plot

The result for Magnify (Axis) for the region with the majority of cells is shown
in Figure 5.161.

Figure 5.157  Magnify Axis for a 2D Plot
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To release the magnification, right-click on the 2D plot and select UnMagnify
(Resolution) or UnMagnify (Axis) from the pop-up menu.

5.1.7.5 Changing Plot Type

Existing plot(s) on your layout may be reformatted to a different plot type at any
time, by selecting the plot(s)  and using the Change Plot Type button on the
Format tab (Figure 5.162.)

Figure 5.158  Changing the plot type from color dot to
contour.

5.1.7.6 Plot 3D Options

Even though only surface plots have typically been displayed in three dimensions
(3D), FCS Express also has the capability of rendering histograms in 3D. The
appearance of histograms with multiple, filled-in overlays may be enhanced in
3D.
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The 3D display options control the 3D plot appearance and orientation relative to
the user. You can edit the 3D display options for a surface plot or histogram in
one of two ways:

· Select the plot(s) and use the Format tab Plot Options 3D command.

· Right-click on the plot, select Format from the pop-up menu, and choose

3D from the drop down (Figure 5.163).

Figure 5.159  Formatting 3D Options for a Surface Plot

Check or uncheck View in 3 Dimensions to toggle 3D on or off.

Use the Display wall along Y-axis check box to turn on or off a yellow wall
along the Y-axis.

Depth can be controlled (from 0% to 100%) with the 3D% (for histograms) or
the Depth for surface plots spin buttons. As 3D% increases, the third
dimension z-axis widens and the single-plane events progress from dots to short
stubble to long lines. 

The other options are controlled by sliders:



FCS Express 7 Manual368

© 2023 De Novo Software

· Zoom resizes the plot within the object border from less than 100%

(smaller than current size) to 500%. As the zoom % increases, axes and
events may extend beyond the object border until the zoom is decreased
again. The zoom is reversible, i.e., no data is lost.

· Rotation pivots the plot on the vertical axis from 270 to 360 where 360 is

facing the user straight on and 270 rotates the plot clockwise (turns a 90-
degree pivot to the left), so the right-hand z-axis is facing the user straight
on.

· Elevation turns the plot on the horizontal axis from 270 to 360 where 360

is facing the user straight on and 270 tips the top edge of the plot forward
(turns a 90-degree pivot down), so the top edge z-axis is facing the user
straight on.

· Horizontal offset and Vertical offset control the position of the 3D plot on

the page.

· Perspective is a value from 0-100 that controls how far the chart appears

to be from the user.

· Tilt is a value from 0-360, indicating the number of degrees the plot will be

rotated in its 2D-space about an axis perpendicular to the screen.

5.1.8 The Current Data File

The first time you add a plot to a layout, the Select a Data File dialog (Figure
5.164) will appear. Navigate to the desired file using the File Dialog, File List, or
Active Files tabs and select Open. After choosing the data file, the plot will be
opened and that file will become the current data file. In the future, when you
open another plot, you will not be asked to select the data file. Instead, the plot
will be created using the current data file.

Every time you select an object displaying a data file, or put that object in edit
mode, its data file will become the current data file.
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Figure 5.160 - Select a Data File Dialog

You can also configure FCS Express to prompt you for a data file every time you
open a plot. To do this, go to File tab Options . In the Do Not Show
again category, check the box for prompt to select plot types to open when
dragging and dropping files. With this configuration, the Select a Data File
dialog will open every time you create or select a plot.

If a data file has been changed during your analysis (e.g.,, you have performed
parameter math to create or modify a parameter), then before that data file is
removed from memory upon closing your FCS Express layout, you will be
prompted whether or not to save the file. If you do not want this prompt to
appear, go to File tab Options Save category, and choose the Don't save
modified data files on close (see Save Options ) radio button at the bottom.

5.1.9 Changing Data Files on Plots

You can change data files on objects such as plots, data windows, and text
boxes in several ways:

· Dragging and dropping one plot from the layout (or a plot node from a

Navigator ) onto another plot in the layout. This brings up a Paste Special
dialog (Figure 5.165).
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Figure 5.161 - Paste Special Dialog

After choosing Data in the Paste Special dialog you may see a Select Drag
and Drop Action dialog (Figure 5.166) where you can choose to replace
the existing overlays on the plot or add the files to the plot as new
overlays.

Figure 5.162 - Select Drag and Drop Action Dialog
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· Right-click on the plot and select Next, Prev, or Change File from the pop-

up menu.

· Use the commands from the 

group  to change the file on the selected object (or on all objects).

In the right click pop-up menu, Next and Prev will change the data to the next
and previous files in the data list (skipping by the increment value), respectively.
Change File will bring up the Select a Data File dialog.

If you have more than just the base overlay (the base overlay is simply a term
for the first overlay) on the plot that you are trying to change, use the bottom
half of the Select a Data File dialog to choose which overlay to change (Base
overlay, All overlays, Select from the list).

5.1.10 Changing the Parameter on Plot Axes Using Keyboard Shortcuts

The axis parameters can be changed in the formatting dialogs for each plot, as
described for histogram overlays  and 2D plot overlays . You can also change
the parameters of the base overlay on each plot using the keyboard or the
mouse.

Note: For any of these methods to work, you must make sure that the plot is in
edit mode .

· Keyboard

To change the parameter displayed on the x-axis with the keyboard, press
the number corresponding to the parameter you want to display (e.g., press
3 to view parameter 3). To change the parameter displayed on the y-axis of
a 2D plot, simultaneously press the Ctrl key and the number corresponding
to the parameter to display.

· Mouse

 
To change the parameter of an axis with the mouse (the x-axis on a
histogram, either axis on a 2D plot), move the mouse cursor over the axis
label and click on the axis label. A pop-up menu will appear containing the
available parameters (if you have set the Alt+Click Required To Change
Parameters option , you will also have to press the Alt key while clicking).
From this pop-up menu, you may type in the empty field at the top or scroll
through the list using the mouse scroll wheel or arrows in the pop-up menu (if
more than 10 parameters are available). If you do not wish to change the
parameter after the list has appeared, hit ESC on the keyboard or move the
cursor anywhere outside the list and click.
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Please see the full list of keyboard short cuts  for additional information. 

5.2 Pictures

In addition to plots and text boxes, FCS Express allows you to insert pictures
into layouts. For working with images from Image Cytometry experiments
please see the topics on Picture Plots  and Image Galleries .

5.2.1 Inserting Pictures

To insert a picture onto a layout page, use the Insert
command. Click on the layout where you would like to place the picture and the
Insert Picture dialog (Figure 5.167) will appear, allowing you to select the
picture you want to insert. Once the picture has been selected, click on the arrow
located on the Open button (to the right of the file name), and choose either
Yes or No  for embedding picture. In both cases, the picture will be placed on the
current page. 

1678

262 410



Plots and Other Objects 373

© 2023 De Novo Software

Figure 5.163 -  Insert Picture Dialog

The following graphics file types are supported: Windows Bitmaps (*.bmp),
Portable Network Graphics (*.png), JPEG files (*.jpg), GIF (*.gif), Device-
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Independent Bitmaps (*.dib), PCX Images (*.pcx), TIFF (*.tif), Icons (*.ico),
Windows Metafiles (*.wmf), and Windows Extended Metafiles (*.emf).

Once a picture is selected to be inserted, an Embed Picture Message (Figure
5.168) will appear.  If you choose Yes, the picture will be saved as part of the
layout file. If you choose No, the picture will not be saved as part of the layout
and the file will be smaller. However, if the layout file is moved to another
computer, or the picture is moved to another location, the linked picture will no
longer be visible when the layout file is opened.

Figure 5.164 -  Embed Picture Message

5.2.2 Formatting Inserted Pictures

To format a picture, select the picture and choose the appropriate command
from Format . Alternatively, right-click on the Picture and select
Format from the pop-up menu to select the appropriate command from the
dropdown.

The Formatting Picture dialog (Figure 5.169)will allow you to edit the border
and size  of the image as well as general settings and formatting
authorizations.

651
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Figure 5.165 - Formatting Picture Dialog

5.3 Text Boxes

Text Boxes are used to insert text anywhere you want on the layout. Text
Boxes can be used to display text, statistics, tables, page numbers, as well as
entire paragraphs. Text boxes support all the formatting options that are
available in modern desktop publishing applications, including bullets, numbering,
paragraph alignment, and font properties.
Text Boxes can also use hyperlinks  to connect to an existing file (e.g. a Word
document, a PDF, a picture, a PowerPoint, a FCS Express layout (.fey), and any
other document), a folder, a URL, and/or a place in the layout.

5.3.1 Inserting Text Boxes onto a Page

To insert a Text Box onto a page, use the Insert
command (Figure 5.170). Immediately after placing the Text Box on the Page, it
will be in edit mode.

Figure 5.166 - Inserting a Text Box

5.3.2 Quadrant Label Text Boxes

Plots displaying quadrants have a unique type of text box displayed referred to as
a Label Text Box.  A Label Text Box may be formatted much like a normal text
box  in FCS Express, but the contents cannot be edited by clicking on and
selecting the text box as you would do with other standard text boxes in FCS
Express.
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Label Text Boxes on plots default to display the quadrant statistic defined by your
2D Plot Option User Options .  

To change the contents of a Quadrant Label Text Box please follow the steps
below.

1. Click on the quadrant Label Text Box to select it.
2. Right click in the selected Label Text Box.
3. Choose Format.
4. Choose  Text Box Contents from the dropdown (Figure 5.171).
5. Change the contents in the Text Box Contents field to your desired text,

symbols, or token . 

The Label Text Box on the plot will now reflect the entry in the Text Box
Contents field. 

Figure 5.167 -  Label Text Box (for quadrant derived text boxes) Dialog

5.3.3 Text Box Selection

Allowing the selection of text boxes derived from markers, gates, and quadrants
may be controlled on a plot by plot basis from the Format tab>Plot
Options>Text Boxes Selection command. When the Allow selection of text
boxes in markers, gates and quads (when available) check box is
unchecked, text boxes will not be selectable for editing. 

Text Box Selection may also be defined via the User Options to change the
default for allowing selection of text boxes on plots . 
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5.3.4 Entering and Formatting Text in a Text Box

In order to enter text in a Text Box, place it in edit mode  by clicking anywhere
inside it. Text boxes derived from gates, markers, and quadrants may be placed
in a mode where they are not selectable if desired . Additionally, text boxes
derived from quadrants have special formatting properties . 

The Text Box can be used just like a word processor  meaning you can:

· Cut/Copy/Paste text within the Text Box.

· Format the text (font, alignment, etc.).

· Insert numbering and bullets.

· Paste text from word processing applications.

· Copy text from a Text Box and paste it into a word processor.

· Add hyperlinks  to an existing layout file, URL, and/or a place within the

layout.
· In addition, Tokens, may be placed in text boxes.  

The most common formatting options are available on the Text  tab. Detailed
text formatting can be performed using the commands of the Text  and

 groups.
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If the text box is in edit mode, changing fonts will change the currently selected
text. If the text box is in select mode, changes to the font properties will affect
all the text in the text box. The Text Box automatically grows when the text
being entered reaches the bottom of the Text Box window.

The Font and Paragraph groups contain dialog box launchers on the lower right,

indicated by the   button.

This Font dialog (Figure 5.172) allows you to change all font properties. With the
Layout Tab options, you can change the character spacing and
subscript/superscript offset.

Figure 5.168 - Font Tab and Dialog
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To control the detailed aspects of paragraph formatting, use the Paragraph
dialog box launcher. The Paragraph dialog (Figure 5.173) allows you to change
paragraph indentation and spacing settings, including text alignment, line spacing,
and first-line indentation.

Figure 5.169 - Paragraph Dialog

In order to modify detailed aspects of the bullet and numbering styles, click on
the Bullets and Numbering button in the paragraph group while a text box is
selected. The Bullets and Numbering dialog allows you to set bullets and
numbering appearance and it provides options for creating new types of bullets
(Figure 5.174).
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Figure 5.170 - Bullets and Numbering Dialog

5.3.4.1 Inserting Tables

Tables can be inserted into a Text Box by either of the following methods:

· If the Text box is in edit mode, select the Text tab Insert Text Insert

Table command.

· Right-click in the Text Box and select Table Insert Table from the pop-up

menu.

The Insert Table dialog will appear (Figure 5.175) where you can choose the
number of rows and columns, as well as the size of the table. We recommend
keeping the setting at autosize for the best performance. To save these settings
for creating future tables, click on the Remember dimensions for new tables
checkbox.
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Figure 5.171 - Insert Table Ribbon and Dialog

Tables can also be:
· Pasted from Microsoft Word. Simply copy the table to the clipboard in Word,

then select the Home Clipboard Paste command (or use the Ctrl+V
keyboard shortcut).

· Pasted from Microsoft Excel. Simply copy the table to the clipboard in Excel,

then select the Home Clipboard Paste command (or use the Ctrl+V
keyboard shortcut)

5.3.4.2 Formatting Tables

If you click the cursor in one of the cells of a table (or select a group of cells by
dragging the cursor across the cells you want to highlight), you can choose
formatting options by one of the following methods:

· Select one of the commands from the Text Table group.

· Right-click while the cursor is in the table, select Table from the first pop-up

menu, and choose a command from the submenu.

The table below shows the formatting commands that are available.
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Command Explanation

Insert Row Above Insert a row above the cell where the cursor resides.

Insert Row Below Insert a row below the cell where the cursor resides.

Insert Column to the
Left

Insert a column to the left of the cell where the cursor resides.

Insert Column to the
Right

Insert a column to the right of the cell where the cursor resides.

Delete Rows Delete the current row or the selected rows.

Delete Columns Delete the current column or the selected columns.

Table Properties Opens a menu used to set general table properties, as well as set
properties for the selected rows and cells.

Merge Cells The text from all selected cells will be merged into one cell.

Split Cells The cell(s) will be split into multiple cells.

Note: The Merge Cells and Split Cells commands are only available through the
pop-menu.

5.3.4.2.1  Table Properties

The Table Properties window is accessed by right clicking on a
table Table Table Properties and is divided into 3 tabs as outlined below.  

· Table Tab.

These settings apply to the whole table (Figure 5.176):

382
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Figure 5.172 - Table Properties - Table Tab

o Width

Set the table width in pixels or as a percentage of Text Box width.
(Note: Most users find changing the width of individual columns
works better than using this option to determine table width.)

o Fill Color

Choose the background color of the table.

o Cell padding

Set the amount of space between the text of a cell and its border.

o Cell spacing

Set the amount of space between cells.

o Picture
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Load a picture as the background of the table.

o Table Border

Set the color and width of the table border (the outer frame of the
table).

o Cell Border

Set the color and width of the individual cell borders.

o Printing

Allows you to choose to not to allow columns to break across
pages during printing.
Allows you to choose a number of heading rows depending on your
needs. 

· Rows Tab

These settings apply to the vertical alignment, printing, and cell colors of
the selected row(s) (Figure 5.177).
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Figure 5.173 - Table Properties - Rows Tab

o Top

Align text to the top of the selected rows. 

o Center

Align text to the center of the selected rows. 

o Bottom

Align text to the bottom of the selected rows. 

· Columns Tab

These settings apply to the cell colors and banding of the selected
column(s) (Figure 5.178).



FCS Express 7 Manual386

© 2023 De Novo Software

Figure 5.174 - Table Properties - Columns Tab

· Cells Tab

These settings apply to the selected cell(s) (Figure 5.179).
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Figure 5.175 - Table Properties - Cells Tab

o Width

Set the width of the current or selected cells.

o Height

Set the height of the current or selected cells.

o Fill Color

Set the background color of the current or selected cells.

o Picture

Load a picture as the background of the current or selected cells.

o Vertical alignment

Set the vertical alignment of the current or selected cells. (Note: To
align a full Row, use the Table Properties - Rows Tab.)
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o Border

Set the color of the current or selected cell borders.

5.3.4.3 Exporting a Table to Excel

A table can be exported to Excel without formatting loss. Please refer to the
Exporting a Text Box to Excel  to perform this action.

5.3.5 Resizing Text Boxes

You can change the text box size as described in Formatting Text Box
Features . Alternately, you can resize text boxes the same way all items are
resized in FCS Express , with the following exceptions. When a text box
contains a token or table, you will not be able to make the text box narrower
than the token or table. Furthermore, you will not be able to adjust a text box
smaller than what is necessary to display the current text. In either case,
attempts to adjust a Text Box too small will cause the text box to automatically
resize to the smallest acceptable size. In addition, text boxes will automatically
become larger when you add text or insert other items (tables, tokens, etc.)
that would not otherwise fit within the current size.

5.3.6 Adding a Text Box to a Plot

You can also place a text box directly inside a plot using one of the following
methods:

· Putting the plot in Edit Mode by clicking anywhere inside it, followed by

selecting the Insert Text Box command and then clicking inside the plot.

· Right-click on a plot and select Add Text Box. A Text Box will be inserted

inside the plot borders.

These text boxes can be formatted and used like any other text box within an
FCS Express layout.  For example, a table can be added to the text box and then
Tokens  can be added to the cells of the table.

Statistics Tables  can be directly embedded into a plot through a drag and drop
process.  When this is done FCS Express will automatically create a table within
that plot (Figure 5.180).
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Figure 5.176 - Embedding a Table within a Plot by dragging and dropping from a
Statistics Table.

If you have deleted a marker, quad, or gate text box from your plot, you can
recreate them by right-clicking on the plot and choosing the appropriate
command (Recreate Marker Text Boxes (not shown in image below),
Recreate Gate Text Boxes (enclosed in red box in image below), or Recreate
Quad Text Boxes (enclosed in red box in image below) from the pop-up menu
(Figure 5.181).

Sometimes Gates and Gate Text Boxes overlap each others. If a gate text box is
behind a gate and can not be selected, right-click on the plot and choose the
Activate gate command (enclosed in the green box in image below) to select
the gate and move to desired location.
Gate, marker, and quadrant defined text boxes may be place in a mode where
they are not selectable if desired . 376
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Figure 5.177 - Right-click Pop-up
Menu wth Recreate Gate and Quad

Text Boxes Commands and Activate
Gate command.

5.3.7 Formatting Text Box Features

You can change the text box border and size, or set a background by:

· Selecting the text box and using commands from the Format Tab.

· Opening the format dialog. To open the format window, right-click on a text

box and select Format from the pop-up menu. (Note: If the text box is
inside a plot make sure that the text box is in edit mode). The format
window allows you to change the border , size , and background  of
the text box by selecting the appropriate category from the dropdwon. The
default background for a text box is transparent.

· Text boxes derived from quadrant statistics are referred to as Label Text

Boxes. Please see the section on Quadrant Label Text Boxes for formatting
instructions . 

651 652 649
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5.3.8 Adding Tokens to Text Boxes

In addition to plain text, you can also insert statistics and other information inside
a text box using tokens. The statistics or information in the token text will
update as the analysis changes. For more information on tokens, see Using
Tokens .

5.3.9 Exporting a Text Box to Excel

The content of a text box (tables included) can be completely exported to Excel

without formatting loss via the following steps:

1.  Select the entire text box (please see the Selecting Items on a Page  topic

for more information on this).

2.  Right click on the text box red border and select Copy from the right click

menu. Alternatively, press Ctrl+C on your keyboard.

3.  Open Microsoft Excel.

4.  Right click on the destination cell and select Paste from the right click menu.

Alternatively, left click on the destination cells to select it and press Ctrl+V on

your keyboard.

A part of the text box can be selectively exported to Excel via the following

steps:

1.  Select the text (or the table) of interest.

2.  Right click on the selection select Copy from the right click menu.

Alternatively, press Ctrl+C on your keyboard.

3.  Open Microsoft Excel.

4.  Right click on the destination cell and select Paste from the right click menu.

Alternatively, left click on the destination cells to select it and press Ctrl+V on

your keyboard.

5.4 Gate View

The Gate View object (Figure 5.182) is an interactive legend of all the gates in
your layout. As an object, the Gate View will be printed and displayed like any

1284
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other object. The Gate Navigator  may also be used to view/edit gate
information but the Gate Navigator will not be treated as an object and cannot
be printed or exported. 

The Gate View may be formatted in many ways to changes its aesthetics, to
display Data Specific Gates , and/or to display plot navigator items.  Please see
the chapter on Formatting the Gate View  for more information.

To insert a Gate View, select the Insert tab General Gate View command.

Figure 5.178  Gate View
Showing Hierarchy

A right-click menu is available within the Gate to Display dialog as displayed in
Figure 5.183 below. The right click menu allows users to:

· Format  the Gate View

· Add Combination Gate

· Add Combination Gate Matrix

· Create Linked gates

· Link Selected Gates

· Break Link  between linked gates

· Display Gates Hierarchically (this  is flagged by default)

· GatingML

· Gate Properties for the selected gate (see below in this page)

· Rename the selected gate

· Expand/Collapse All gates

· Expand/Collapse All Children gates within the selected gate

· Expand/Collapse Current Level (this expand only the first level of

children gates within the selected gate)
· Duplicate/Copy/Cut/Paste/Delete the Gate View or the selected gate
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Figure 5.179  The Gate View right-click menu.

Many of the actions can be performed directly from the Gate View as follows:

· To delete a gate from the entire layout, select the gate in the Gate View

and press the Delete key.

· To rename a gate, double-click the gate in the Gate View and type in the

new gate name in the Name field and press Enter.

· To edit all of the gate properties, double-click on the gate in the Gate View

to bring up the Edit Gate dialog (Figure 5.184). From the dialog you can
change the gate Name, add a Comment, change the Description, change
the Color* ,  Emphasize the gated events on plots , Adjust Line
Width , Always create a Data Specific Gate when moving this
gate , Include or Exclude the events inside the gates shape, and, if

395 704

709

714



FCS Express 7 Manual394

© 2023 De Novo Software

applicable, break the link to a quadrant or gate. If you check Alt+Click
required to select this gate, then clicking on the gate will not select the
gate unless the Alt key is being held. This will prevent accidental changing of
the gate vertices. 

§ Additionally, the ability to edit the gate is controlled through the
Allow Gate Edit section. 
· Selecting the True radio button allows edits to the gate.

· Selecting the False radio button prevents edits to the gate.

· Selecting the Custom radio button allows the user to define a

value or condition based on a token  or custom token  that
must be met in order to edit the gate. 

· To rearrange the hierarchy of the gates , drag and drop the gates within

the Gate View. For example, to make a gate a child gate of another gate,
drag the child gate onto the parent gate. Also note that a gate may be
placed in a specific position in the hierarchy at the time of creation using the
Parent Gate drop down . 

· To gate a plot on a gate, drag the gate from the Gate View onto that plot.

1284 1337
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Figure 5.180  Edit Gate Dialog  

* Note:  If Gate Color has been changed, text color within the Gate Text Box
will no longer match.  To recreate this text with the current Gate Color, right-
click on the plot and select Recreate Gate Text Boxes from the pop-up menu.

Note: The actions above may also be completed through the Gate Navigator .

5.4.1 Formatting the Gate View

The Gate View  has formatting properties that can be accessed by either:

· right-clicking on the Gate View, selecting Format from the pop-up menu, and

choosing a category from the drop-down; or
· selecting the Gate View and choosing the desired category from the Format

tab of the Ribbon.
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The Gate View shares a number of formatting options with all other objects:
· General

· Fill

· Border/Line

· Size

· Authorizations .

In addition, there are two specific options that are available to format in the Gate
View: the Gate View Options and the Gates to Display.

Gate View Options: (Figure 5.185)

The Gate View Options allow users to choose what information to display in
the Gate View.

§ Show gated plots. Check the option to display the specific plots on
which gates have been applied.

§ Show data specific gates. Check the option to display any Data Specific
Gates  which have been created.

§ Show all cells root gate in the gates hierarchy. Check the option to
show the No Gate root gate in the hierarchy.

Note: Checking all three items in the Gate View Options will result in a Gate
View that looks similar to the Gate Navigator .
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Figure 5.181  Top - Gate View Options found in the Formatting
Tab Dropdown. Bottom - A Gate View showing plot navigator

items and data specific gates.

Gates to Display: (Figure 5.186)

The Gates to Display formatting options in the Gate View allows users to
choose which gates to show within the Gate View. 

By default, the All Gates option is selected. However, you can select Only the
gates checked below and then select the gates you wish to display.
Alternatively, select All gates except those checked below and then choose
the gates you do not wish to display.

A right-click menu is available within the Gate to Display dialog as displayed in
Figure 5.187 below. The right click menu allows users to:

§ Expand/collapse All gates
§ Expand/Collapse All Children gates within the selected gate
§ Expand/Collapse Current Level (this expand only the first level of

children gates within the selected gate)
§ Check/Uncheck All gates
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§ Check/Uncheck All Children gates within the selected gate
§ Invert Selection on All gates
§ Invert Selection on All Children gates within the selected gate

When the option Only the gates checked below is checked, the No option
will be the default selection for When a new gate is created on the layout,
should it be included in this Gate View?  However, you can change this
setting if preferred.

Figure 5.182  Gates to Display Options in the Gate View Formating dropdown.
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5.5 Data Grids

FCS Express allows you to view the raw data acquired for every event or "cell" in
a data set, including cell images if applicable .

Select the Insert General Data Grid command to insert a Data Grid in the
layout to show the data from the top data set (Figure 5.188). If no data set is
open, you will be prompted to select a file.

Figure 5.183  Data Grid

To copy the raw data to the clipboard, select the cells to copy, and then use the
Home Clipboard Copy Text command. To select an entire column, click on
the column header for the parameter. To select an entire row, click in the small
grey box to the left of the cell number.

To export multiple parameters to a text file, see Exporting FCS File Data . 
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5.5.1 Formatting Data Grids and Custom Data Grids

Data Grids  have unique formatting properties that can be accessed by right-
clicking on the data grid, selecting Format from the pop-up menu, and choosing
a category from the dropdown.  Alternatively, once the Data Grid is selected,
you can choose the desired category from the Format tab of the Ribbon .

Custom Data grids have been deprecated since FCS Express 6 as the
functionality has been improved upon with the addition of Spreadsheets . Any
existing Custom Data grids saved in FCS Express 4 or FCS Express 5 layouts will
still be available and formattable in the latest release of FCS Express via the
methods in this chapter. Please contact support@denovosoftware.com if you are
having any problems working with data grids saved in a previous version of FCS
Express in the latest release of FCS Express.   

5.5.1.1 General

In addition to the usual name property (referred to as Data window name),
Data Grids have some additional General options (Figure 5.189).
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Figure 5.184 Formatting general options for Data Grids and
Custom Data Grids

Additional formatting options are described below.

Option Explanation

Use compensation Choose which compensation  matrix is applied to the
data in the grid.

Transformation Choose which transformation  is applied to the data in
the grid.

Gate The gate  applied to the data in the grid.  Note that a
range gate  can be created on and applied to Data
Grids and Custom Data Grids.
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Option Explanation

Change data file during
Next/Prev/Batch

Whether the data grid changes during batch processing
or in response to a Next/Previous  command.  It is
generally recommended to leave this unchecked (default),
as the data within the grid normally refers to plots and will
update automatically as the data in the plots are
changed.

Show the cell number
column

Whether the cell or object number (assigned by the
cytometer according to the time of sample acquisition) is
shown as a column in the Data Grid.

Number of decimals The number of decimal places listed to the right of the
decimal point.

Rounding mode The method for rounding the last digit.  Choose between
Standard, Down, Up, and Truncate.

Show trailing zeroes If checked, shows the specified number of decimals even
if the terminal digits are zeroes.

Show scientific notation If checked, shows the number in E notation: mEn which

represents m x 10n, where m and n are any real number
and E represents "exponent"

5.5.1.2 Gates To Display

The Gates to Display formatting option for Data Grids determines the
backgating information displayed within the Data Grid. The formatting option
does not apply to Custom Data Grids.

You can edit the Gates to Display in one of two ways:

· Select the Data Grid(s) and use the Format  Options

Display command. 

· Right-click on the Data Grid, select Format from the pop-up menu, and

choose Gates to Display from the dropdown (Figure 5.190).

Once the Gate to Display dialog is open, you select a gating scheme using the
radio buttons. By default, the No Gates (hide the Gates column) option is
selected. However, you can select All gates or Only the gates checked below
and then select the gates whose colors you wish to display. Alternatively, select
All gates except those checked below and then choose the gates whose
colors you do not wish to display.
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Figure 5.185 Formatting gates to display in a Data Grid

A right-click menu is available within the Gate to Display dialog as displayed in
Figure 5.191 below. Said right click menu allows to:
· Expand/collapse All gates

· Expand/Collapse All Children gates within the selected gate

· Expand/Collapse Current Level (this expand only the first level of children

gates within the selected gate)
· Check/Uncheck All gates

· Check/Uncheck All Children gates within the selected gate

· Invert Selection on All gates

· Invert Selection on All Children gates within the selected gate
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Figure 5.186  The right-click menu avaialble within the Gates to
Display dialog.

In the When a new gate is created on the layout, should the gate color be
displayed? category you can also choose how to display the gate color when a
new gate is created on the layout. Possible choices are:

· No
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· Display the gate color on a back-gated plot Only if the new gate was

created on a plot showing the same data file (as the plot where the
new gate was created),

· Display the gate color on a back-gated plot Only if the new gate was

created on a plot showing the same parameters (as the plot where
the new gate was created).

· Yes

When gates are displayed in a Data Grid, a Gates column is present. If an event
falls in one or more gates, colored bars (according to the gate colors) will be
shown in the Gates column (Figure 5.192).

Figure 5.187  Backgated Data Grid. Bars in the Gates column of some events show
in which gate(s) the cells fall.
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5.5.1.3 Parameters to Display

Each column in a Data Grid or Custom Data Grid is a parameter which can be
shown or hidden, by accessing the Parameters to Display formatting options.

You can edit the Parameters to Display in one of two ways:

· Select the Data Grid(s) and use the Format  Options Parameters

to Display command. 

· Right-click on the Data Grid, select Format from the pop-up menu, and

choose Parameters to Display from the dropdown (Figure 5.193).

Figure 5.188 Formatting parameters to display in a Data Grid

5.5.1.3.1  Formatting Data Grids to Display Only Images

In order to format a Data Grid to only display images, right-click on the Data
Grid and select Format from the pop-up menu. Choose the parameters to
show as columns in the grid by using the Parameters to Display category
(Figure 5.194). To show selected columns, choose Only the items checked
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below or All items except those checked below, and then check the
appropriate items.

For all other formatting options please see Formatting Data Grids and Custom
Data Grids .

Figure 5.189  Showing and Hiding Columns in a Data Grid to only
display images.

5.5.1.4 Data Image Options

Data Image Options formatting is available for Data Grids in FCS Express
Image or FCS Express Plus only.

If a Data Grid has been formatted to display images for at least one
parameter , these images will be viewable as an Image Gallery  within the
Data Grid.  These images can fill the grid cell or be centered within it.

You can edit these Image Options in one of two ways:

· Select the Data Grid(s) and use the Format  Options

Options command. 

· Right-click on the Data Grid, select Format from the pop-up menu, and

choose Data Image Options from the dropdown (Figure 5.195).

400
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Figure 5.190 Formatting data image options in a Data
Grid

The Options drop-down menu includes Center image in grid (on the left in the
picture below) and Fill grid cell (on the right in the picture below) (Figure
5.196).

Figure 5.191  Example Data Grid with Data Image "Option" set to either "Center
image in grid" or to "Fill grid cell"."

The background color of the columns can also be customized specifically for
either the columns that contains images (Image Columns Background) and all
the other columns (Other Columns Background). In the Data Grid below, the
color of the image columns has been set to the match the dark background of
the images (Figure 5.197).
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Figure 5.192  Example Data Grid with Image
Column Background color set to black.

5.5.2 Applying Gates to a Data Grid

Gates can be applied to data grids to show just the data within the gate. To do
so, use the Gating Create Gates group and choose a gate from the Current
Gate drop-down list.

Gates may also be applied to a Data Grid by dragging the gate and dropping it on
top of the Data Grid. Please see the section on Using Gates  for additional
details and options.

5.5.3 Creating Cell Number Gates on a Data Grid

To create a gate on a Data Grid, right-click on the grid and select Create Gate
from the pop-up menu. A new column will appear in the grid (Figure 5.198).

699
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Figure 5.193  Creating a Gate on a Data Grid

Check the events in the New Gate column that you want to include in your gate
(so-called "Cell Number gates") and click OK to bring up a Create New Gate
dialog where you can assign a name to the gate and choose the color .

You can also create a gate containing a Selection or Range using the
appropriate drop-menu items.

5.5.4 Using Data Grids as Image Galleries

If you are using FCS Express Image Cytometry or FCS Express Plus, it is possible
to use the Data Grid as an Image Gallery. Raw images associated with your
Image Cytometry experiment will be located in the last columns in the far right of
the data grid. You may also choose to select only to display the parameters with

701
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the image data from the Data Grid format screen  Figure 5.199. Multiple data
grids may be inserted in the layout  for the same or different data files to
compare results. 

Figure 5.194 An image gallery displaying
only the image parameters.

To view images of only the cells within a particular gate apply a gate  to the
Data Grid.

Single cell images may also be inserted in the layout via the following steps. 

1. Left click and hold on the image in the Data Grid.
2. Drag the image to an empty space in the layout.
3. Release the mouse button. 

The image from the data grid that was dragged onto the layout will now be
inserted as a new picture object on the page. 

5.5.5 Viewing Compensated and Transformed Values in Data Grids

Data grids may be formatted to display compensated and transformed values.
Please note only one compensation and one transformation may be applied at a
time for each plot or data grid selected.  Also, the transformation will have its
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own column(s) displayed in the data grid, the number of which are dependent
upon the transformation selected.

Compensations may be applied to data grids by any of the following commands:

· Drag and drop compensation from Compensations navigator (Figure 5.200).

Figure 5.195 - Drag compensation from Compensations navigator and drop onto
data grid (red arrow).

· Right-click data grid selecting None or one of

listed options (Figure 5.201).
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Figure 5.196 - Right-click data grid to Show Compensated Values menu.

· Access Formatting dialog for general options select compensation to use

from Use Compensation drop down list  (Figure 5.202).

400



FCS Express 7 Manual414

© 2023 De Novo Software

Figure 5.197 - Using Formatting dialog to select from Use
Compensation drop down list under Data Options.

Transformations may be applied to data grids by any of the following methods:

· Drag and drop from the Transformations navigator to the intended data grid

(Figure 5.203). 
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Figure 5.198 - Applying parameter math transformation to a plot by dragging from
the Transformations navigator to the data grid (red arrow).

· Right-click data grid Show Transformed Values select appropriate

transformation from menu.(Figure  5.204). 

Figure 5.199 - Accessing parameter math transformation by right-clicking data grid
and navigating to Show Transformed Values menu.
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· Access Formatting dialog for general options select parameter math to use

from Transformation drop down list . (Figure 5.205). 

Figure 5.200 - Applying parameter math transformation to a
data grid by selecting the parameter math in the

Transformation drop down from the Formatting Overlays
dialog.

5.6 Spreadsheets and Charts

Spreadsheets in FCS Express can be used to perform most of the operations
that Microsoft Excel provides.  In addition, values in Spreadsheet cells can be
derived directly from statistics within the layout, keywords, or from data files in

400
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the data list. Inserting statistics for data files in the data list allows additional
flexibility in analysis of many statistics for many data files that are not currently
open in the layout. 

A Spreadsheet may be added to a layout through the Insert
tab command. 

Once a spread sheet is inserted you may click on the Spreadsheet to select it
which will make the  and 
 tabs appear (figures below). 

Once data is tabulated, you can display it graphically, using Pie Charts, Bar Charts
and Scatter Plots . For example, Spreadsheets can be used to automate the
process of generating titration curves.

Spreadsheets created within FCS Express may also be exported  to various
external file formats such as .xls, .xlsx, .csv, .html, .xml and .txt.
Formulas, formatting, and references will be preserved when selecting to save in
the .xls or .xlsx file format.

Note: Spreadsheets replace Custom Data tables from previous versions of FCS
Express but have the same capabilities. If you have Custom Data tables saved
from previous versions FCS Express in your layout then FCS Express 6 will allow
you to open them for use. New tables can only be create via the Spreadsheets
feature. 
 
Jump to:
Creating a Spreadsheet
Working with Spreadsheets
Formatting Spreadsheet Cells
Using Spreadsheets to access statistics from files in the Data List
Spreadsheet Formula Definitions
Using Find and Replace
Supported Spreadsheet Keystroke Commands
List of and description Spreadsheet Statistics available via drag and drop from the
data list

The Spreadsheet Layout Tab
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The Spreadsheet Formulas tab. 

Additional Resources:
Tutorials:
· HLA Cross matching - Spreadsheet Use Case 1

o Creating a Spreadsheet for analysis

o Populating a Spreadsheet with data

o Working with Custom Tokens and Formula References in spreadsheets

o Using Conditional Formatting to Classify Data

· Antibody Titration - Spreadsheets Use Case 2

· Calibration via Regression Analysis - Spreadsheets Use Case 3

o Complete a Spreadsheet and Insert a Scatter with Regression Plot

o Working with Regression Tokens and Fit Equations

· Working with Pie, Bar, and Scatter Plots - Spreadsheets Use Case 4

5.6.1 Creating a Spreadsheet

To create a Spreadsheet, use the Insert tab command to
bring up the Create new spreadsheet dialog (Figure 5.206).

Alternatively, if a Data Navigator  is open, you can right-click on the Data
Navigator and choose Create new spreadsheet from the pop-up menu.

Figure 5.201 Creating a Spreadsheet from the Insert tab.
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· The option for Open Data Grid is selected by default.  You can additionally

choose to open the Data Navigator (Figure 5.207). If the Data Navigator is
already open then the option will be inaccessible. 

Figure 5.202  Create new spreadsheet Dialog

· When you are finished, click OK. The Create new spreadsheet dialog will

disappear. A new spreadsheet will appear on your screen, similar to the image
below.

· The cells of spreadsheet may be filled with text, numbers or tokens .

· Cells of the spreadsheet may reference each other much like Microsoft Excel

following the same conventions of Excel. 

· Formulas may be created  in the cells much like Microsoft Excel. 

New, Empty Spreadsheet
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5.6.2 Working with Spreadsheets

If you have added a Spreadsheet , the Spreadsheet will appear on the layout
and a node will appear in the Data Navigator with the name you assigned to the
spreadsheet (Figure 5.208). Spreadsheets in FCS Express share much of the
functionality included in Excel with the added benefit of live updating as statistics
or data in your layout changes. A list of some of the common features in Excel
that FCS Express will support are:

· Array Formulas

· Appearance Customization and Conditional Formatting

· Built in Operators and Functions

· Formula Creation  and AutoSum

· Formatting Cells

· Find and Replace

· Comments

· Sorting

Jump to:
· Entering text or numeric data in the spreadsheet

· Creating a formula in a spreadsheet

· Using AutoSum

· Referencing cells in a spreadsheet

· Inserting a Token or Custom Token in a cell

· Inserting Token Tables

· Formatting Spreadsheet cells

· Spreadsheet Cell Value Tokens

· Analyzing Files from the Data List with Spreadsheets

o Spreadsheet Statistics Available from Data Files
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Figure 5.203 An empty spreadsheet open and  Data Navigator with New
spreadsheet node. 

The spreadsheet may be selected, de-selected, moved, re-sized, copied, and
pasted just like any object in FCS Express . 

A spreadsheet that has been copied and pasted will create a duplicate of itself.
Any information that is entered in one of the copies will be updated in the
additional copies. The copies will be visible in the Data Navigator as separate Data
Grids/Spreadsheets under the same node (Figure 5.209)  Multiple spreadsheets
may exist in the same layout and will appear as separate nodes in the Data
Navigator (figure below). 

136
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Figure 5.204 - Working with multiple spreadsheets and
copies of spreadsheets in the Data Navigator. 

Spreadsheets in FCS Express behave very similarly to Microsoft Excel. Just as in
Excel there are countless features and options that can be performed. We will
cover a few of the basic operations and important points for working with
spreadsheets in FCS Express below.   

To enter text or numeric data in the spreadsheet:

1.  Click on the cell in the spreadsheet.
2.  Begin typing in the cell. 

To create a formula in a spreadsheet:

1.  Click on a cell in spreadsheet.
2.  Enter an equals sign "=".
3.  Enter a formula, function, or operator  to evaluate. 
4.  The cell will return the value of the information entered. 

There are multiple ways to introduce a formula, function, or operator into a
spreadsheet.

You may select a cell in the spreadsheet and click on the Spreadsheet
tab Formulas. Click on the formula or function  to use from the menu and it
will populate the chosen cell as a blank formula. 

You can enter an equals sign "=" and begin typing the formula, function, or
operator of interest i.e. "M". A drop down list will appear with all available
formulas, functions, or operators that contain the letter(s) entered.  As you
cursor over each item in the drop down list a comprehensive description will
appear (Figure 5.210).  
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Figure 5.205 - Inserting "=" followed by text into a spreadsheet cell will
open a drop down menu containing formulas, functions, and operators. 

Each item listed will display a description when the cursor is hovered
over it and item is highlighted blue.

After a formula is selected, the hint dialog box will highlight each portion of the
equation and the accompany explanation for it.  The green text is the first
required input for the equation "number1" the description below Parameters is
highlighted with green text and describes what input can be utilized and if it is
required or optional. Please see the figure below. (Figure 5.211)
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Figure 5.206.  After a function is selected, the window highlights then next
required input using green text.

Additionally, you can right click within a cell and select Insert Formula from the
right click menu.  In the Insert Function window you can select all or a specific
Category. Please click on function categories  for more information about
functions are categorized. As you cursor over each item in the drop down list, it
will be highlighted in blue and a short description of the function will appear at the
bottom of the Insert Function window (Figure 5.212).

446
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Figure 5.207.  Right clicking within a cell and select Insert Formula will open an
Insert Function window that will display short descriptions for each function

when highlighted.

AutoSum:
Alternatively, you may select a range of cells and choose a command from the
AutoSum drop down (Figure 5.213). The AutoSum command you have chosen
will be calculated across the selected range of data and appear below the final cell
in the data range. 

Available AutoSum functions are:

Sum Sums all values within a given range.

Average Calculates the average for the values within a given range.

Count
Numbers

Counts the number of cells containing numbers within a given range.
Excludes counting cells that contains text. 

Min Finds the minimum value in a given range.
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Max Find the maximum value in a given range. 

Figure 5.208 - The AutoSum feature is
a convenient tool for quickly

calculating statistics for a range of
values in a spreadsheet. 

To reference cells in a spreadsheet:

1.  Click on a cell in a spreadsheet.
2.  Enter an equals sign "=".
3.  Click on a different cell in the spreadsheet that contains data.
4.  The original cell will display the data referenced from the second cell. 

To insert a Token or Custom Token in a cell:

1.  Right click in the cell.
2.  Choose Insert Token.
3.  Select a token to insert in the same manner as inserting a token into a text

box .

Alternative 1: Drag and drop a statistic, plot, gate, marker, quadrants or other
FCS Express item from which tokens can be derived into a cell (see more about
dragging and dropping tokens and token types )

The token value, or multiple token values, will appear in one or many cells. 

Alternative 2: 
1. Click on cell in the spreadsheet.

1284
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2. Click on the Spreadsheet tab  Token. 
3. Choose the token of your choice to insert in the cell. 

Tokens that are present in cells will update in real time as data updates in plots.
Cells that reference other cells or formulas containing token values with also
calculate and update in real time. Please note that tokens can also be used
elsewhere in FCS Express to reference spreadsheet cells . 

To insert Token Tables:

Tables in FCS Express from Compensations , Signatures , SOPs , Canned
Comments, and Heat Maps  may be inserted into a spreadsheet by (Figure
5.214):

1. Right clicking in a cell.
2. Choose Insert.
3. Select a token table to insert in the same manner as inserting a token into a
text box . 

Figure 5.209 - The available options for inserting tables in a spreadsheet.

5.6.2.1 Formatting

Spreadsheets may be formatted just like any other object in FCS Express and
contain many of the same formatting options as other objects . When right
clicking on a Spreadsheet you will be presented with the option to Format or
Format Cells (Figure 5.215). The Format command will allow you to access
formatting commands for the Spreadsheet object itself for items like Name,
Visibility, Border, Size, Authorizations. 
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The Format Cells command allows you to adjust formatting options specific to a
cell or multiple cells / cell ranges. Please see the next section on Formatting
Spreadsheet cells for additional information . 

Figure 5.210 - The right click menu available with spreadsheets. 

In addition to standard object formatting options  spreadsheets have additional
formatting options under the Spreadsheet Data category to Use text in first
row as parameter labels and Use multiple rows for parameter labels when
inserting spreadsheet data with complex grouping... (Figure 5.216).
 

Figure 5.211 - Choosing to Use values in a first row as labels option. 
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When the option Use text in first row as parameter labels is turned on by
checking the box, the first row in the spreadsheet will be used as labels in any
additional graph types as in Figure 5.217 below. 

Figure 5.212 - "Use text in first row as parameter labels" enables bar plots, pie
charts, scatter plots, and scatter with regression plots to use the first row in the

spreadsheet as a data label. 

When using Token Multiplication Grouping , if you prefer the statistic labels on
the spreadsheet to display across multiple rows instead of a single row, check
the box to Use multiple rows for parameter labels when inserting
spreadsheet data with complex grouping...  (Figure 5.218). 

1304



FCS Express 7 Manual430

© 2023 De Novo Software

Figure 5.213 - "Use multiple rows for parameter labels when inserting spreadsheet
data with complex grouping..." enables labels from multiple rows note additional

header rows, top and bottom in spreadsheet image above).

Using multiple rows for parameter labels may also be used to assign freetext
from multiple spreadsheet rows to bar plot labels (Figure 5.219). 

Figure 5.214 - Using multiple rows for parameter labels:  example with
accompanying bar plot

5.6.2.1.1  Formatting Spreadsheet Cells

Formatting Spreadsheet cells:

Cells or cell ranges within a spreadsheet in FCS Express may be formatted much
as spreadsheets in Microsoft Excel (Figure 5.220). 
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Figure 5.215 - The spreadsheet layout tab provides access to a number of
formatting and specialized features for spreadsheets in FCS Express. 

The available formatting categories and options from the Layout tab are:

Font Adjust fonts, font sizes, font styles, font color, and cell borders

Alignment Adjust text alignment for horizontal and vertical placement. Indent
text. Wrap text within cells. Merge and unmerge selected cells.  

Tokens Insert any token from FCS Express.

Formattin
g and
Sorting

A range of values may be conditionally formatted  or sorted. 

Cells Insert or delete rows or columns in the data set. Format cells to
autofit contents, hide or unhide contents, and launch the Format
Cells dialog. 

Editing Clear the contents formatting or contents of cells. Add or remove
freeze panes to the spreadsheet. Create a comment to be
associated with the selected cell or cell range. 

Show Show or Hide the cell borders (Gridlines) or row / column labels
(Headers) of the spreadsheet.

Additionally, Number, Alignment, Font, Border, Fill and Protection from cells
or a range of cells may all be adjusted (Figure 5.221). Cells or cell ranges may
be formatted via a right click on the select or via the Spreadsheet tab
tab commands. To format a cell or range of cells:

1.  Select a cell or range of cells to format
2.  Right click within the range.
3.  Choose Format Cells.
4.  Choose the formatting feature you would like to adjust from the available

tabs just as you would do in Excel. 
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Figure 5.216 - The Format Cell dialog for spreadsheets in FCS Express. The
formatting contains all of the familiar features and functionality of Microsoft Excel. 

Alternatively:  
1.  Select a cell or range of cells to format
2.  Click on the Spreadsheet tab tab.
3.  Choose the formatting item you wish to apply to the cells. 
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5.6.2.1.1.1  Conditional Formatting

Conditional formatting is a tool that allows you to apply different displays in the
form of Color Scales, Data Bars, and Icon sets to a range of cell values.
Conditional formatting may be applied by:
1. Select a range of cells in a Spreadsheet.
2. Click on the Spreadsheet tab tab

drop down (Figure 5.222). 

Figure 5.217 - Choosing conditional
formatting from the Spreadsheets-->

Layout tab. 

3. Choose the type of display from Color Scales, Data Bars, and Icon Sets.
4. Choose the sub-type of conditional formatting you wish to apply. 

The conditional formatting you choose will be applied to the range of cells. Below
is an example of some conditional formatting options applied to a range of data
Figure 5.223.
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Figure 5.218 - A variety of conditional formatting options applied to a series of
data. 

The conditional formatting is based on a series of rules which may be managed
by clicking on the Spreadsheet tab tab

drop down command. From
within the Conditional Formatting Rules Manager you may select Edit Rule
to adjust how color scales, bars, and icon sets values are determined. 

5.6.2.2 Spreadsheet Cells

Cells in a spreadsheet allow you to manually enter values, text, formulas or
information derived from tokens . Individual cells or cell ranges may be
formatted and also contain properties unique to FCS Express in that tokens may
exist and be referenced within a cell . Conversely, Spreadsheet Cell Values
may be inserted and used as tokens within text boxes and batch processing . 

Values that currently exist in a cell can be easily moved to a different cell by:

1.  Click and hold on the blue square in the lower right portion of the cell
to be referenced (Figure 5.224 below).

Figure 5.219- Clicking and holding on the blue square on the bottom right of the cell
allows you to drag the cell to a new location in the spreadsheet.

2.  Drag the cell to the new cell position in the spreadsheet where you
would like it to appear. 

3.  Release the mouse button to place the cell. 
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Cell values can be copied down much as you would in Excel to quickly populate a
range of cells. To copy a cell down:

1.  Select the originating cell by clicking on it.
2.  Press Ctrl+C to copy.
3.  Select the range of cells to copy down including the originating cell.
4.  Press Ctrl+D to copy down over the range of selected cells.

Right clicking in a Spreadsheet cell reveals options to insert tokens , format
cells , and format tokens. If you have already inserted a token in a
spreadsheet cell you may format that token by:

1.  Right click in the cell that contains the token.
2.  Choose Format Token.

The token type  that is included in the cell may now be edited and changed as
desired.  

5.6.2.3 Find and Replace

Spreadsheets in FCS Express support Find and Find and Replace functionality. To
access Find and Find and Replace:
1. Click on a spreadsheet or select a range of cells. 
2. Press Control+F. 

The Find and Replace dialog will appear.

In the Find tab:
1. Enter a value or text to find within the spreadsheet or selected range. 
2. Click Find All or Find Next.

If matching values or text is found the spreadsheet will highlight the cell in which
the information has been found. 

The Options button allows you to further designate search terms and locations. 

In the Replace tab:

1. Enter a value or text to find within the spreadsheet or selected range in the
Find what area. 
2. Enter a value or text to replace the found item in the Replace with area. 
       a. Click Find All or Find Next to jump to the next found values.
       b. Click Replace All or Replace to replace the found values with the values
indicated in the Replace with area. 

The Options button allows you to further designate search terms and locations. 
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5.6.2.4 Supported Keystrokes

Supported Keystrokes

The Spreadsheets tool in FCS Express provides a familiar Excel-like environment,
including multiple corresponding keyboard support. The Spreadsheets tool
supports over 70 keys and key combinations available in Microsoft Excel. All
currently supported keyboard controls are listed in the following table: 

Key/Key
Combinati
on

Description

Arrow
Keys

Pressing an arrow key produces different effects depending on what
object is selected and/or focused (highlighted) in the Spreadsheet
control:

· If a cell is focused, pressing the Left, Up, Right, or Down key

moves focus to the left, top, right, or bottom adjacent cell;
· If a cell range is selected, pressing the Left, Up, Right, or Down

arrow key clears the selection and shifts focus by one cell in
the respective direction;

· If the focused cell is located at the left, top, right, or bottom

edge of the worksheet area, pressing the Left, Up, Right, or
Down key does not move focus;

Del Pressing the Del key destroys all cell objects within all selected areas.

End Moves focus to a cell following the rightmost cell object within the
same row. If there are no cell objects in this row, the focus is
moved to its first (i.e., the leftmost) cell.

Enter /
Shift+Ente
r

Pressing the Enter key or the Shift+Enter key combination produces
different effects depending on what object is selected and/or
focused in the Spreadsheet control: 

· If a cell is focused within a worksheet, pressing the Enter key

moves focus to the next (i.e., underlying) cell within the same
column. If the last cell in a column is focused, the Enter key
moves focus to the topmost cell in the next (i.e., the right
adjoining) column. If the last cell in the last (i.e., the
rightmost) column is focused, pressing the Enter key sets the
focus to the top cell in the worksheet's leftmost column. 

· If a cell range is selected, pressing the Enter key moves cell

focus within the range's boundaries in the same manner as
described above. In the case of multiple selected cell ranges,
the Enter key consecutively moves cell focus through all
selected areas in the ascending order of their indexes within
the worksheet's collection of selections. 

Both the Enter key and the Shift+Enter key combination close an in-
place cell editor accepting its current contents as a new cell value.
The cell focus shifts identically to the cases described above. The
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Shift+Enter key combination moves focus identically to the Enter
key but in the opposite direction.

Esc If an in-place editor is open, pressing the Esc key closes it and
discards its current value.

F2 Opens an in-place editor for the focused cell.

F9 Recalculates all formula expressions within the current spreadsheet
document.

Home Moves cell focus to the leftmost (i.e., the first) cell in the current
row.

Page
Down

Moves cell focus to the next cell containing data in the column below
the current focus. If no data is present, moves cell focus to last row
in the spreadsheet.

Page Up Moves cell focus to the next cell containing data in the column above
the current focus. If no data is present, moves cell focus to first row
in the spreadsheet.

Tab /
Shift+Tab

Pressing the Tab key or the Shift+Tab key combination produces
different effects depending on what object is selected and/or
focused in the Spreadsheet control: 

· If a cell is focused within a worksheet, pressing the Tab key

moves focus to the next (i.e., the right adjoining) cell within
the same row. If the last cell in a row is focused, the Tab key
moves focus to the first cell on the next (i.e., the lower
adjacent) row. If the last cell in the last row is focused,
pressing the Tab key sets the focus to the first cell in the
worksheet's topmost row. 

· If a cell range is selected, pressing the Tab key moves the cell

focus within the range's boundaries in the same manner as
described above. In the case of multiple selected cell ranges,
the Tab key consecutively moves the cell focus through all
selected areas in the ascending order of their indexes within
the active Table View worksheet's collection of selections.

· Both the Tab key and the Shift+Tab key combination close an

in-place cell editor, accepting its current contents as a new cell
value. The cell focus shifts identically to the cases described
above. 

The Shift+Tab key combination moves focus identically to the Tab
key but in the opposite direction.

Alt+Enter When editing the contents of a cell, starts a new line within the open
in-place cell editor.

Ctrl+; Enters the current date into the focused cell.

Ctrl+` With a cell in edit mode, switches between displaying formula
expressions and their calculated results in the active worksheet.

Ctrl+' Copies the formula expression to the focused cell from the adjacent
cell above.

Ctrl+1 Displays the Format Cells dialog for the current cell selection.
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Ctrl+2 /
Ctrl+B

Adds/removes the bold attribute to/from the font used to display
the contents of the current cell selections.

Ctrl+3 /
Ctrl+I

Adds/removes the italic attribute to/from the font used to display
the contents of the current cell selections.

Ctrl+4 /
Ctrl+U

Adds/removes the underline attribute to/from the font used to
display the contents of the current cell selections.

Ctrl+5 Adds/removes the strikeout attribute to/from the font used to
display the contents of the current cell selections.

Ctrl+9 Hides all rows that intersect the current cell selection area.

Ctrl+0 Hides all columns that intersect the current cell selection area.

Ctrl+A Selects all cells within the active worksheet.

Ctrl+Arro
w Keys

Moves focus to the nearest cell object within the current row or
column (i.e., the Ctrl+Left, Ctrl+Up, Ctrl+Right, or Ctrl+Down key
combination moves focus to the nearest cell object located to the
left, above, to the right, and below the currently focused cell). If
there are no cell objects on the supposed path of the cell focus, it is
moved to the last cell on the respective worksheet's edge (i.e., left,
top, right, or bottom, depending on a specific arrow key pressed).

Ctrl+C /
Ctrl+Inser
t

Copies the current cell selection to the clipboard. If there are multiple
selections then the full area between the top left cell of those
selections and the bottom right cell of the selections will be copied to
the clipboard.

Ctrl+D Populates the currently selected cell range with both the contents
and style of its topmost cell (if the range's width does not exceed a
single cell) or row.

Ctrl+End Cancels the current cell selection and moves cell focus to the
bottom-right corner of the Dimensions area. Previous cell focus
position is irrelevant. If there are no cell objects within the active
worksheet, pressing this key combination moves cell focus to the
topmost cell in the worksheet's first column.

Ctrl+F Invokes the Find and Replace dialog with the activated Find tab.

Ctrl+H Invokes the Find and Replace dialog with the activated Replace tab.

Ctrl+Hom
e

Cancels the current cell selection and moves the cell focus to the
upper-left (origin) cell of the active worksheet.

Ctrl+K Displays the Insert Hyperlink dialog for new hyperlinks or the Edit
Hyperlink dialog for a previously created hyperlink. You can add
hyperlinks to both the cells and floating containers, including
comments.

Ctrl+Page
Down

Switches between the currently visible worksheets, consecutively
activating their respective tabs from left to right in the caption bar. If
the rightmost worksheet tab is already active, pressing this key
combination has no effect. The Ctrl+Page Up key combination
consecutively activates the currently visible worksheets in reverse.

Ctrl+Page
Up

Switches between the currently visible worksheets, consecutively
activating their respective tabs from right to left in the caption bar. If
the leftmost worksheet tab is already active, pressing this key
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combination has no effect. The Ctrl+Page Down key combination
consecutively activates the currently visible worksheets in reverse.

Ctrl+R Populates the currently selected cell range with both the contents
and style of its leftmost cell (if the range's height does not exceed a
single cell) or column.

Ctrl+Shift
+7

Applies the outline border to the currently focused cell or selected
cell range(s). This key combination is a direct counterpart of the
Ctrl+Shift+_ key combination.

Ctrl+Shift
+_

Returns the outline border of the currently focused cell or a selected
cell range to its original state. This key combination is a direct
counterpart of the Ctrl+Shift+& key combination.

Ctrl+Shift
+~

Applies the General number format to data within the currently
focused cell or selected cell range(s).

Ctrl+Shift
+4

Applies the Currency number format to data within the currently
focused cell or selected cell range(s).

Ctrl+Shift
+5

Applies the Percentage number format to data within the currently
focused cell or selected cell range(s).

Ctrl+Shift
+6

Applies the Scientific number format to data within the currently
focused cell or selected cell range(s).

Ctrl+Shift
+3

Applies the Date number format to data within the currently focused
cell or selected cell range(s).

Ctrl+Shift
+2

Applies the Time number format to data within the currently focused
cell or selected cell range(s).

Ctrl+Shift
+1

Applies the Number format (that has two decimal places, thousands
separator, and minus sign (-) for negative values) to the data within
the currently focused cell or selected cell range(s).

Ctrl+Shift
+8

Selects the current region around the focused cell (the area enclosed
by blank rows and columns containing uninitialized cells).

Ctrl+Shift
+:

Enters the current time into the focused cell.

Ctrl+Shift
+“

Copies the value to the currently focused cell from the adjacent cell
above.

Ctrl+Shift
+End

Extends the selected cell range to the bottom-right corner of the
Dimensions area, i.e., to the cell object with the largest row and
column index values.

Ctrl+Shift
+Enter

Accepts the changes made in an in-place cell editor and closes it,
leaving the current cell focused. If an in-place editor was used to
enter a formula expression, this key combination chooses the array
formula variant of the function, if applicable.

Ctrl+Shift
+Home

Extends the selected cell range to the active worksheet's upper-left
cell.

Ctrl+Minus
(–)

Displays the Delete dialog for deleting cells, rows, and columns at the
currently focused cell or selected cell range.

Ctrl+Shift
+O

Selects all cell objects that have an associated comment container in
the currently active worksheet.
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Ctrl+Plus(
+)

Displays the Insert dialog for inserting cells, rows, and columns at
the currently focused cell or selected cell range.

Ctrl+Spac
ebar

Selects an entire column whose cell object is currently focused. This
key combination works even if there are no cell or column objects
created within the active worksheet.

Ctrl+V /
Shift+Inse
rt

Pastes the current clipboard content into the active worksheet.

Ctrl+X /
Shift+Del

Pressing this key combination results in moving (cutting) to the
clipboard both the cell data and associated styles from the currently
focused cell or a selected cell range.

Shift+Arro
w Keys

This key combination expands the currently selected cell range by
one cell, row, or column depending on the area's shape and the
actual arrow key pressed. If there are several selected cell ranges
within the active worksheet, this key combination expands only the
last selected cell or cell range.

Shift+Spa
cebar

Selects the entire row that intersects the cell selection in which the
cell focus is currently located.

5.6.3 Analyzing Files from the Data List with Spreadsheets

Spreadsheets may be used to quickly analyze and compare statistics for many
data files from the data list without opening additional plots or creating a batch
process. 

After data files have been loaded into the Data List , the data files may
individually or multiple selected in the data list,  dragged and dropped onto a
spreadsheet, and the information or statistics to display will be inserted into the
spreadsheet cells. If plots exist on the layout you may choose to derive statistics
from gates and as gates are adjusted the values in the spreadsheet will update in
real time.  

To analyze files from the data list in a Spreadsheet:
1.  Create a Spreadsheet  in the layout.
2.  Open the Data List . (Figure 5.225)
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Figure 5.220 - A layout with spreadsheet created and data list opened. 

3.  Multiple select data files from the data list.
4.  Drag and drop data files from the data list into the first cell in the spreadsheet

that you would like statistics to appear (Figure 5.226). 
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Figure 5.221 - Dragging and dropping data files from the data list into a cell in the
spreadsheet.

5.  Select Statistic Token or Keyword Token in the Paste Special dialog. In
this example, Statistic Token has been selected.

Within the Create Statistic dialog (Figure 5.227): 
6.  Select the appropriate parameter for the statistic from the Parameter list.
Note - a parameter must be selected regardless of the statistic you choose to
insert 
7.  Select a compensation or choose Default or None from the Compensation

drop down. 
Note: by setting Default from the Compensation drop down, the default option
for compensation  specified in the User Options will be used.
8. Select a transformation of interest or choose None from the Transformation

drop down. 
9.  Select a gate from the Gate list if needed.
10. Select one or multiple statistics from the Statistic list.

Please also see the section on using Token Multiplication grouping to insert and
select multiple gates, statistics, markers, and quadrants at the same time . 

NOTE: The values present in a Spreadsheet for data derived from the data
list will reflect the values associated with the data file/iteration and will update

911
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in real time. However, in some situations a "fixed" or static value from a
particular data file(s)/iteration(s) may be useful to insert in a Spreadsheet.
For instance, if you would like to derive the mean from an Isotype control or
any other statistic when batch processing. When the having a static or fixed
value from a data file or iteration is necessary, the statistics added to the
spreadsheet can be made independent from the iteration selected. In other
words, the statistics will not change while batch processing or changing
through different iterations. 
To "fix" a value in the spreadsheet to prevent allowing the value associated
with the data file/iteration to change click on the Data Source category on
the left of the Create Statistic window after dragging and dropping a data
file from the data list into the spreadsheet and uncheck the Allow the Data
file of this token to change when running Next/Prev/Batch Processing
option as seen in the image below. This option is always available for
statistics added by dragging and dropping files from the Data List to the
spreadsheet, and can be accessed by right clicking on a spreadsheet cell and
by selecting Format Token (the Edit Keywordor the Edit Statistic dialog
will open and the Data Source category will be available on the left).
However, by unchecking the option during the initial drag and drop action (i.e.
before Step 11 below), the option will apply to all of the data files/iterations
at once. 

Statistics within the spreadsheet can be made independent from the currently
loaded iteration by unchecking the "Allow the Data file of this token to change

when running Next/Prev/Batch Processing" option.
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Figure 5.222 - Selecting the parameter, compensation, and statistics to insert in
the spreadsheet cells. 

11.Click OK.

The statistics  for all of the data files you selected from the data list will appear
in the spreadsheet and will update in real-time as gates are adjusted (Figure
5.228).  

1281
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Figure 5.223 - Statistics for all of the data files selected will appear in the
spreadsheet. 

If additional statistics or statistics from different parameters are needed repeat
the steps above. In the example below additional columns were added for gated
statistics (Gate 1) and statistics from different parameters (Median CD8) (Figure
5.229).
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Figure 5.224 - Spreadsheet displaying statistics from 9 data files from different
gated populations and parameters. Statistics will update in real time as gates are

adjusted. 

5.6.4 Spreadsheet Formula Definitions

Spreadsheets in FCS Express use many of the formulas, functions, and operators
with which you are familiar in Excel. Please reference the list of functions and
operators below for use in FCS Express.  Please also note when implementing a
formula below, the delimiter used in list separation may not be a comma based
on the computer's regional settings (i.e. replacing the comma with a semi-colon
may be necessary to execute the function).

The built-in operators and functions for Spreadsheets can be divided into these
groups:

· Compatibility Functions

· Arithmetic Operators

· Logical Operators

· Logical Functions

· Lookup and Reference Functions

· Arithmetic Functions

· Financial Functions

· Statistical Functions

· Date and Time Functions

· Text Functions
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· Information Functions

· Array Formulas

 

Compatibility Functions

Compatibility functions have been replaced with new functions that may provide
improved accuracy and whose names better reflect their usage. These functions
are still available for compatibility reasons. However, if backward compatibility is
not mandatory, you should consider using the new functions from now on,
because they offer more accuracy and better functionality.

 

 

Mnemonic
s

Accepted
Parameters
(Operand
Types)

Example Explanation

 

BETADIST Accepts three
obligatory
parameters:
The value at
which the
BETADIST
function
performs
evaluation (X)
and two
parameters of
the calculated
distribution
(Alpha and
Beta).

Optionally, you
can pass the
lower and upper
bounds of the
interval as the A
and B
parameters,
respectively.

=BETADIST(X,
Alpha, Beta, [A],
[B])

Returns the beta cumulative
distribution function.

If any specified parameter is not
numeric, the BETADIST function
returns the #VALUE! error value. If
either the Alpha or Beta parameter
is not positive, BETADIST returns
the #NUM! error value. If X < A, X
> B, or A = B, BETADIST returns
the #NUM! error value. If you omit
the A and B parameter values,
BETADIST uses the standard
cumulative beta distribution, so
that A = 0 and B = 1.

BETADIST is a deprecated
function. For information about its
new version, refer to the
BETA.DIST function description.

BETAINV Accepts three
obligatory
parameters:

=BETAINV(Prob
ability, Alpha,
Beta, [A],[B])

Returns the inverse of the
cumulative distribution function for
a specified beta distribution.
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The value at
which the
BETAINV
function
performs
evaluation; and
two parameters
of the calculated
distribution
(Alpha and
Beta).

As with the
BETADIST
function, you
can also pass
the lower and
upper bounds of
the interval as
the A and B
parameters,
respectively.

If any parameter is non numeric,
the BETAINV function returns the
#VALUE! error code. If alpha or
beta are not positive, BETAINV
returns the #NUM! error code. If
Probability < 0 or Probability > 1,
BETAINV returns the #NUM! error
code. If you omit the A and B
parameter values, BETAINV uses
the standard cumulative beta
distribution, so that A = 0 and B =
1.

BETAINV is a deprecated function.
For information about its new
version, refer to the BETA.INV
function description.

BINOMDI
ST

Accepts four
obligatory
parameters:
The number of
successes in
trials
(NumberS), the
number of
independent
trials (Trials),
the probability
of success on
each trial
(ProbabilityS),
and a logical
value that
determines the
form of the
function
(Cumulative).

=BINOMDIST(Nu
mberS, Trials,
ProbabilityS,
Cumulative)

Returns the individual term
binomial distribution probability.

The NumberS and Trials
parameter values are truncated to
integers. If the NumberS, Trials, or
ProbabilityS parameter value is not
numeric, the BINOMDIST function
returns the #VALUE! error code. If
NumberS < 0 or NumberS > trials,
BINOMDIST returns the #NUM!
error code. If ProbabilityS < 0 or
ProbabilityS > 1, BINOMDIST
returns the #NUM! error code.

BINOMDIST is a deprecated
function. For information about its
new version, refer to the
BINOM.DIST function description.

CHIDIST Accepts two
obligatory
parameters: the
value at which
you want to

=CHIDIST(X,
DegFreedom)

Returns the one-tailed probability
of the chi-squared distribution.

If either parameter is not numeric,
the CHIDIST function returns the
#VALUE! error code. If X is
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evaluate the
distribution (X)
and the number
of degrees of
freedom
(DegFreedom).

negative, CHIDIST returns the
#NUM! error code. If the
DegFreedom parameter is not an
integer, it is truncated.

CHIDIST is a deprecated function.
For information about its new
versions, refer to the CHISQ.DIST
and CHISQ.DIST.RT function
descriptions.

CHIINV Accepts two
obligatory
parameters: a
probability
associated with
the chi-squared
distribution
(Probability)
and the number
of degrees of
freedom
(DegFreedom).

=CHIINV(Probab
ility,
DegFreedom)

Returns the inverse of the one-
tailed probability of the chi-squared
distribution.

If either parameter is not numeric,
the CHIINV function returns the
#VALUE! error code. If Probability
< 0 or Probability > 1, CHIINV
returns the #NUM! error code. If
the DegFreedom is not an integer,
it is truncated. If DegFreedom < 1,
CHIINV returns the #NUM! error
value.

CHIINV is a deprecated function.
For information about its new
versions, refer to the CHISQ.INV
and CHISQ.INV.RT function
descriptions.

COVAR Accepts two
obligatory
parameters: the
first and second
cell ranges of
integers (Array1
and Array2).

=COVAR(Array1
,Array2)

Returns covariance, the average of
the products of deviations for each
data point pair in two data sets.

The parameters must either be
numbers or be names, arrays, or
references that contain numbers.
If the array or reference
parameter contains text, logical
values, or empty cells, those
values are ignored; however, cells
with zero values are taken into
account.

If Array1 and Array2 have different
numbers of data points, COVAR
returns the #N/A error value.

If either Array1 or Array2 is
empty, the COVAR function
returns the #DIV/0! error code.
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COVAR is a deprecated function.
For information about its new
versions, refer to the
COVARIANCE.P and
COVARIANCE.S function
descriptions.

EXPONDIS
T

Accepts three
obligatory
parameters: the
value of the
function (X), the
Lambda
parameter, and
the logical value
that specifies
which form of
the exponential
function to
provide
(Cumulative).

=EXPONDIST(X,
Lambda,
Cumulative)

Returns the exponential
distribution.

If cumulative is TRUE,
EXPONDIST returns the
cumulative distribution function;
otherwise – returns the probability
density function.

 

If the X or Lambda parameter is
not numeric, the EXPONDIST
function returns the #VALUE!
error code.

If the X parameter is negative,
EXPONDIST returns the #NUM!
error code.

If the Lambda parameter is not
positive, EXPONDIST also
returns the #NUM! error value.

EXPONDIST is a deprecated
function. For information about
its new version, refer to the
EXPON.DIST function
description.

GAMMADI
ST

Accepts four
obligatory
parameters: the
value at which
you want to
evaluate the
distribution (X),
two parameters
of the
distribution
(Alpha and
Beta), and the
cumulative
logical value
(Cumulative).

=GAMMADIST(X
, Alpha, Beta,
Cumulative)

Returns the gamma distribution.
You can use this function to study
variables that may have a skewed
distribution. The gamma
distribution is commonly used in
queuing analysis.

If the Beta parameter is 1, the
GAMMADIST function returns the
standard gamma distribution.

If the X, Alpha, or Beta parameter
is not numeric, GAMMADIST
returns the #VALUE! error code.

If the X parameter is negative,
GAMMADIST returns the #NUM!
error code.
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If either the Alpha or Beta
parameter is not positive, the
GAMMADIST function returns the
#NUM! error code.

GAMMADIST is a deprecated
function. For information about its
new version, refer to the
GAMMA.DIST function description.

GAMMAIN
V

Accepts three
obligatory
parameters: the
probability
associated with
the gamma
distribution
(Probability),
and two
parameters of
the distribution
(Alpha and
Beta).

=GAMMAINV(Pr
obability, Alpha,
Beta)

Returns the inverse of the gamma
cumulative distribution. You can
use this function to study a
variable whose distribution may be
skewed.

If the Beta parameter is 1, the
GAMMAINV function returns the
standard gamma distribution.

If text is passed as any of the
parameters, GAMMAINV returns
the #VALUE! error code.

If Probability < 0 or Probability >
1, the GAMMAINV function returns
the #NUM! error code.

If either the Alpha or Beta
parameter is not positive, the
GAMMAINV function returns the
#NUM! error code.

GAMMAINV is a deprecated
function. For information about its
new version, refer to the
GAMMA.INV function description.

HYPGEOM
DIST

Accepts four
obligatory
parameters: the
number of
successes in the
sample
(SampleS), the
size of the
sample
(SampleSize),
the number of
successes in the
population
(PopulationS),
and the

=HYPGEOMDIST
(SampleS,
SampleSize,
PopulationS,
PopulationSize)

Returns hypergeometric
distribution. The HYPGEOMDIST
function returns the probability of a
given number of sample
successes, given the sample size,
population successes, and
population size.

All parameters are truncated to
integers.

If any parameter is non-numeric,
the HYPGEOMDIST function returns
the #VALUE! error value.

If the SampleS parameter is
negative or SampleS is greater
than the lesser of SampleSize or
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population size
(PopulationSize)
.

PopulationSize, the HYPGEOMDIST
function returns the #NUM! error
value.

If SampleS is less than the larger
of 0 or (SampleSize –
PopulationSize + PopulationS), the
HYPGEOMDIST function returns the
#NUM! error value.

If the SampleSize parameter is not
positive or SampleSize >
PopulationSize, the HYPGEOMDIST
function returns the #NUM! error
value.

If PopulationS is not positive or
PopulationS > PopulationSize,
HYPGEOMDIST returns the #NUM!
error value.

If the PopulationSize parameter is
not positive, HYPGEOMDIST
returns the #NUM! error value.

NORMDIS
T

Four obligatory
parameters: the
value for which
you want the
distribution, the
arithmetic mean
of the
distribution, the
standard
deviation of the
distribution, and
the logical value
that specifies
the form of the
function.

If cumulative =
True,
NORMDIST
returns the
cumulative
distribution
function.
Otherwise,
NORMDIST
returns the
standard normal

=NORMDIST(X,
Mean,
StandardDev,
Cumulative)

Returns the normal cumulative
distribution. This function has a
very wide range of applications in
statistics, including hypothesis
testing.

If mean or standard_dev is non-
numeric, NORMDIST returns the
#VALUE! error value.

If standard_dev is not positive,
NORMDIST returns the #NUM!
error value.

If mean = 0, standard_dev = 1,
and cumulative = True,
NORMDIST returns the standard
normal distribution, NORMSDIST.
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distribution,
NORMSDIST.

NORMSDI
ST

The value for
which you want
the distribution
is passed as the
z parameter.

=NORMSDIST(z
)

Returns the inverse of the normal
cumulative distribution. The
distribution has a mean of 0 (zero)
and a standard deviation of one.
Use this function in place of
standard normal curve areas.

If z is non-numeric, NORMSDIST
returns the #VALUE! error value.

NORMSIN
V

The probability
value
corresponding
to the normal
distribution is
passed as the
probability
parameter.

=NORMSINV(pr
obability)

Returns the inverse of the
standard normal cumulative
distribution. The distribution has a
mean of zero and a standard
deviation of one.

Given a value for probability,
NORMSINV seeks that value z that
NORMSDIST(z) = probability.
Thus, precision of NORMSINV
depends on precision of
NORMSDIST. NORMSINV uses an
iterative search algorithm. If the
search is not converged after 100
iterations, the function returns the
#N/A error value.

If probability is non-numeric,
NORMSINV returns the #VALUE!
error value.

If probability is not positive or
exceeds 1, NORMSINV returns the
#NUM! error value.

PERCENTI
LE

Two obligatory
parameters: the
array or range
of data that
defines relative
standing and the
percentile value
in the range
0..1, inclusive.

=PERCENTILE(ar
ray, k)

Returns the k-th percentile of
values in a range. You can use this
function to establish a threshold of
acceptance. For instance, you can
decide to examine candidates who
score above the 90th percentile.

If k is non-numeric, PERCENTILE
returns the #VALUE! error value.

If k < 0 or k > 1, PERCENTILE
returns the #NUM! error value.

If k is not a multiple of 1/(n – 1),
PERCENTILE interpolates to
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determine the value at the k-th
percentile.

POISSON Three obligatory
parameters: the
number of
events, the
expected
numeric value,
and the logical
value that
specifies the
form of the
probability
distribution
returned.

If cumulative is
True, POISSON
returns the
cumulative
Poisson
probability that
the number of
random events
occurring will be
between zero
and x inclusive.
Otherwise, the
POISSON
function returns
Poisson mass
function that the
number of
events occurring
will be exactly x.

=POISSON(x,
mean,
cumulative)

Returns the Poisson distribution. A
common application of the Poisson
distribution is predicting the
number of events over a specific
time, such as the number of cars
arriving at a toll plaza in 1 minute.

If x is not an integer, it is
truncated.

If x or mean is non-numeric,
POISSON returns the #VALUE!
error value.

If x is negative, POISSON returns
the #NUM! error value.

If mean is negative, POISSON
returns the #NUM! error value.

QUARTILE Two obligatory
parameters: the
array of cell
range of
numeric values
for which you
want the
quartile value,
and the quart
value that
indicates which
value to return.

=QUARTILE(arra
y, quart)

Returns the quartile of a data set.
Quartiles are often used in sales
and survey data to divide
populations into groups. For
instance, you can use QUARTILE to
find the top 25 percent of incomes
in a population.

If array is empty, QUARTILE
returns the #NUM! error value.

If quart is not an integer, it is
truncated.
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quart = 0
corresponds to
the minimum
value;

quart = 1
corresponds to
the first quartile
(25th
percentile);

quart = 2
corresponds to
the median
value (50th
percentile);

quart = 3
corresponds to
the third quartile
(75th
percentile);

quart = 4
corresponds to
the maximum
value.

If quart is negative or if quart > 4,
QUARTILE returns the #NUM! error
value.`

MIN, MEDIAN, and MAX return the
same value as QUARTILE when
quart is equal to 0 (zero), 2, and
4, respectively.

RANK Three
parameters: the
number whose
rank you want
to find, an array
of, or a
reference to, a
list of numbers.
Non-numeric
values in ref are
ignored. As an
option, you can
specify the
sorting order as
the order
parameter.

=RANK(number,
ref, [order])

Returns the rank of a number in a
list of numbers. The rank of a
number is its size relative to other
values in a list (i.e. if you were to
sort the list, the rank of the
number would be its position).

If order is 0 (zero) or omitted, the
ExpressSpreadSheet ranks
number as if ref were a list sorted
in descending order.

If order is any nonzero value, the
ExpressSpreadSheet ranks
number as if ref were a list sorted
in ascending order.

STDEV The one
obligatory
parameter: the
first number
corresponding
to a sample of a

=STDEV(number
1, [number2],
…)

Estimates standard deviation
based on a sample. The standard
deviation is a measure of how
widely values are dispersed from
the average value (the mean).
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population. As
an option, you
can specify from
2 to 255
parameters
corresponding
to a sample of a
population. It is
also possible to
use a single
array or a
reference to an
array instead of
parameters
separated by
commas.

STDEV assumes that its
parameters are a sample of the
population. If your data represents
the entire population, then
compute the standard deviation
using STDEVP.

STDEV calculates the standard
deviation by using the "n – 1"
method.

Parameters can either be numbers
or names, arrays, or references
that contain numbers.

STDEVP The one
obligatory
parameter: the
first number
corresponding
to a sample of a
population. As
an option, you
can specify from
2 to 255
parameters
corresponding
to a sample of a
population. It is
also possible to
use a single
array or a
reference to an
array instead of
parameters
separated by
commas.

=STDEVP(numb
er1, [number2],
…)

Calculates standard deviation
based on the entire population.
The standard deviation is a
measure of how widely values are
dispersed from the average value
(the mean).

STDEVP assumes that its
parameters are the entire
population. If your data represents
a sample of the population, then
compute the standard deviation
using STDEV.

STDEVP calculates the standard
deviation by using the "n" method.

Parameters can either be numbers
or names, arrays, or references
that contain numbers

TDIST Three obligatory
parameters: the
numeric value at
which to
evaluate the
distribution, the
number of
degrees of

=TDIST(x,
deg_freedom,
tails)

Returns the Percentage Points
(probability) for the Student t-
distribution where a numeric value
(x) is calculated value of t for
which the Percentage Points are to
be calculated. The t-distribution is
used in the hypothesis testing of
small sample data sets. Use this
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freedom, and
the number of
distribution tails
to return. If Tails
= 1, TDIST
returns the one-
tailed
distribution. If
Tails = 2, TDIST
returns two-
tailed
distribution.

function in place of a table of
critical values for the t-distribution.

If any parameter is non-numeric,
TDIST returns the #VALUE! error
value.

If Deg_freedom < 1, TDIST returns
the #NUM! error value.

The Deg_freedom and Tails
parameters are truncated to
integers.

If Tails is any value other than 1 or
2, TDIST returns the #NUM! error
value.

If x < 0, then TDIST returns the
#NUM! error value.

If Tails = 1, TDIST is calculated as
TDIST = P(X > x), where X is a
random variable that follows the t-
distribution. If Tails = 2, TDIST is
calculated as TDIST = P(|X| > x) =
P(X > x or X < -x).

Since the negative x values are not
allowed, to use the TDIST function
with x < 0, note that TDIST(-
x,df,1) = 1 – TDIST(x,df,1) = P(X
> -x) and TDIST(-x,df,2) =
TDIST(x,df,2)=P(|X| > x).

TINV Two obligatory
parameters: the
probability
associated with
the two-tailed
Student’s t-
distribution and
the number of
degrees of
freedom with
which to
characterize the
distribution.

=TINV(probabilit
y,
deg_freedom)

Returns the inverse of the
Student’s t-distribution.

If either parameter is non-numeric,
TINV returns the #VALUE! error
value.

If probability <= 0 or if probability
> 1, TINV returns the #NUM! error
value.

If deg_freedom < 1, TINV returns
the #NUM! error value.

TINV returns that value t, such
that P(|X| > 1) = probability
where X is a random variable that
follows the t-distribution and P(|X|
> t) = P(X < -t or X > t).

VAR The first number
parameter

=VAR(number1,
[number2],…)

Estimates variance based on a
sample.
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corresponding
to a sample of a
population is
obligatory.
Optionally, you
can specify from
to 2 to 255
number
parameters
corresponding
to a sample of a
population.

VAR assumes that its parameters
are a sample of the population. If
your data represents the entire
population, then calculate the
variance by using VARP instead.

Parameters can either be numbers
or names, arrays, or references
that contain numbers.

Logical values, and text
representations of numbers that
you type directly into the list of
parameters are counted.

If an parameter is an array or
reference, only numbers in that
array or reference are counted.
Empty cells, logical values, text, or
error values in the array or
reference are ignored.

Parameters that are error values
or text cannot be translated into
numbers cause errors.

VARP The first number
parameter
corresponding
to a sample of a
population is
obligatory.
Optionally, you
can specify from
to 2 to 255
number
parameters
corresponding
to a population.

=VARP(number1
, [number2],…)

Calculates variance based on the
entire population.

VARP assumes that its parameters
are the entire population. If your
data represents a sample of the
population, then compute the
variance by using VAR instead.

Parameters can either be numbers
or names, arrays, or references
that contain numbers.

Logical values, and text
representations of numbers that
you type directly into the list of
parameters are counted.

If an parameter is an array or
reference, only numbers in that
array or reference are counted.
Empty cells, logical values, text, or
error values in the array or
reference are ignored.

Parameters that are error values
or text that cannot be translated
into numbers cause errors.
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WEIBULL Four obligatory
parameters: the
value at which
to evaluate the
function, the
alpha and beta
parameters to
the distribution,
and the
cumulative
logical value
that determines
the form of the
function.

=WEIBULL(x,
alpha, beta,
cumulative)

Returns the Weibull distribution.
Use this distribution in reliability
analysis, such as calculating a
device’s mean time to failure.

If x, alpha, or beta is non-numeric,
WEIBULL returns the #VALUE!
error value.

If x is negative, WEIBULL returns
the #NUM! error value.

If alpha or beta is not positive,
WEIBULL returns the #NUM! error
value.

 

 
 

Arithmetic Operators

Arithmetic operators allow you to perform basic arithmetic operations (i.e.,
addition, subtraction, multiplication, division, and exponential functions).

 

 

Mnemonic
s

Operand Type Example Explanation

 

+ Two parameters = 5 + B1 Adds the first parameter’s value to
the value of the second parameter.

- Two parameters = A5 - B1 Subtracts the second parameter’s
value from the value of the first one.

* Two parameters = A2 * A3 Multiplies the first parameter’s value
by the value of the second
parameter.

/ Two parameters = A1 / PI() Divides the first parameter’s value
by the value of the second
parameter.

^ Two parameters = B1 ^ A2 Raises the first parameter’s value to
the power determined by the
second parameter’s value.

 

 
 

Logical operators
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Logical operators perform comparison operations and return a logical value
(TRUE or FALSE) as a result.

 

 

Mnemonic
s

Operand Type Example Explanation

 

= Two parameters
of logical types

= A1=A2 The equality operation. Returns
TRUE if the first parameter is equal
to the second one. Otherwise,
returns FALSE.

<> Two parameters
of logical types

= A1<>B2 The inequality operation. Returns
TRUE if values within the list are not
equal. Otherwise, returns FALSE.

< Two parameters
of logical types

= A1<B1 The "Less than" operation. Returns
TRUE if the first parameter is less
than the second one. Otherwise,
returns FALSE.

> Two parameters
of logical types

= A1>100 The "Greater than" operation.
Returns TRUE if the first parameter
is greater than the second one.
Otherwise, returns FALSE.

<= Two parameters
of logical types

= A2<=C4 The "Less than or equal to"
operation. Returns TRUE if the first
parameter is less than or equal to
the second one. Otherwise, returns
FALSE.

>= Two parameters
of logical types

= A2>=1.57 The "Greater than or equal to"
operation. Returns TRUE if the first
parameter is greater than or equal
to the second one. Otherwise,
returns FALSE.

 

 

Logical functions

Logical functions include Boolean operators, conditional tests and functions.

 

 

Mnemo
nics

Operand Type Example Explanation
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AND A list of logical
parameters

=AND(1<B4,
B4<100)

 

Logical AND operation.

Returns TRUE if all values within the
list are TRUE; returns FALSE if one
or more values within the list
evaluates to FALSE.

One common use for the AND
function is to expand the usefulness
of other functions that perform
logical tests. For example, the IF
function performs a logical test and
then returns one value if the test
evaluates to TRUE and another
value if the test evaluates to FALSE.

FALSE No parameters
required

=FALSE() Returns the logical value FALSE.

You can also type the word FALSE
directly into a worksheet cell or as a
part of a formula expression.

IF Three parameters:
the logical
expression, the
value to return if
the expression
succeeds, the value
to return if the
expression fails.

=IF(A10<=10
0, "Within
budget",
"Over
budget")

Returns the second parameter if the
logical expression evaluates to TRUE
and the third parameter otherwise.

IFERRO
R

Two parameters:
the parameter that
is checked for an
error, and the value
displayed in an error
occurs.

=IFERROR(val
ue,
value_if_error
)

Returns the value you specify if a
formula evaluates to an error.
Otherwise, returns the formula
calculation result. The IFERROR
function is particularly useful for
spreadsheet error handling.

The formula evaluates the following
error types: #N/A, #VALUE, #REF!,
#DIV/0!, #NUM!, #NAME?, and
#NULL!.

IFNA Two parameters:
the parameter that
is checked for the
#N/A error value,
and the value
returned if the error
occurs.

=IFNA(value,
value_if_na)

Returns the value you specify if the
formula returns the #N/A error
value. Otherwise, returns the result
of the formula.

NOT One parameter of
logical type

=NOT(1>D4) Logical NOT operation.

Reverses the value of its parameter.
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OR A list of logical
parameters

=OR(A1>=10
, A1<=–10)

Logical OR operation.

Returns TRUE if any parameter is
TRUE; returns FALSE if all values
within the list evaluate to FALSE.

TRUE No parameters
required.

=TRUE() Returns the logical value TRUE.

XOR The first parameter
is mandatory,
subsequent logical
values are optional.
If the specified
range contains no
logical values, the
XOR function
returns the
#VALUE! error
code.

=XOR(logical1
, logical2, …)

Returns a logical exclusive OR of all
specified parameters. The XOR
function allows you to test from 1
to 254 conditions.

The result of XOR is TRUE when the
number of TRUE inputs is odd and
FALSE when the number of TRUE
inputs is even.

 

 

Lookup and Reference Functions

A set of reference and lookup functions.

 

 

Mnemoni
cs

Operand Type Example Explanation

 

ADDRES
S

Three parameters:
the numeric value
that specifies the
row number to
use in the cell
reference, the
numeric value that
specifies the
column number to
use in the cell
reference.
Optionally, you
can add a numeric
value that
specifies the type
of reference to
return.

=ADDRESS(ro
w_num,
column_num,
[abs_num],
[a1],
[sheet_text])

Returns a reference as text to a
single cell in a worksheet.

You can use the ADDRESS function
to obtain the address of a cell in a
worksheet, given specified row and
column numbers. For instance,
ADDRESS(2, 3) returns $C$2. As
another example, ADDRESS(77,
300) returns $KN$77. You can use
other functions, such as the ROW
and COLUMN functions, to provide
the row and column number
parameters to the ADDRESS
function.
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AREAS The reference
parameter is
mandatory. It is a
reference to a cell
or cell range and
can refer to
multiple areas. If
you want to
specify several
references as a
single parameter,
include extra sets
of parentheses so
the
ExpressSpreadS
heet formula
engine will not
interpret the
comma as a field
separator.

=AREAS(refer
ence)

Returns the number of areas in a
reference. An area is a range of
continuous cells or a single cell.

For instance, the AREAS(B2:D4)
expression returns 1. As another
example, AREAS((B2:D4,E5,F6:I9))
returns 3.

CHOOSE Two mandatory
parameters. The
index_num
parameter
specifies which
value parameter is
selected. The
index_num value
must be within the
range of 1 to 254,
or a formula
expression or cell
reference
returning a value
within the same
range.

The value1
parameter is also
mandatory while
subsequent
parameters are
optional. You can
specify up to 254
value parameters
from which the
CHOOSE function

=CHOOSE(ind
ex_num,
value1,
[value2], …)

Returns a value from the list of
value parameters. You can use the
CHOOSE function to select one of
the specified values based on the
index number.

If index_num is 1, CHOOSE returns
value1. If the index value is 2, the
CHOOSE function returns value 2,
and so on.

If the index_num value is less than 1
or greater than the number of the
last provided value, the CHOOSE
function returns the #VALUE! error
value.

If the index_num parameter value is
a fraction, it is truncated to the
lowest integer before evaluation.

The value parameters can be cell
range references as well as single
values.
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selects a value or
an action to
perform based on
the index_num
parameter value.
The actual
parameters can be
numbers, cell
references,
defined names,
formulas,
functions, or text.

COLUMN The reference
parameter is
optional. If it is
omitted or refers
to a range of cells,
and if the COLUMN
function is entered
as a horizontal
array formula, the
COLUMN function
returns the
column numbers
of reference as a
horizontal array.

=COLUMN([re
ference])

Returns the column number of a
reference. For instance, the formula
=COLUMN(D10) returns 4 since
column D is the fourth column.

If the reference parameter is a
range of cells, and if the COLUMN
function is not entered as a
horizontal array formula, the
COLUMN function returns the
number of the leftmost column.

If the reference parameter is
omitted, it is assumed to be the
reference of the cell in which the
COLUMN function appears.

The reference parameter cannot
refer to multiple areas.

COLUMN
S

The array
parameter is
mandatory. It
specifies an array
or array formula,
or a reference to a
range of cells for
which you want
the number of
columns.

=COLUMNS(a
rray)

Returns the number of columns in a
reference.

FORMUL
ATEXT

The reference
parameter is
mandatory; it
specifies a
reference to a cell
or range of cells.

=FORMULATE
XT(reference)

Returns the formula at the given
reference as text.

The reference parameter can be to
another worksheet or workbook.

If the reference parameter is to
another workbook that is not open,
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FORMULATEXT returns the #N/A
error value.

If the reference parameter is to an
entire row or column, or to a range
or defined name containing more
than one cell, FORMULATEXT returns
the value in the upper leftmost cell
or the row, column, or range.

In the following cases,
FORMULATEXT returns the #N/A
error value:

The cell used as the reference
parameter does not contain a
formula;

The formula in the cell is longer than
8192 characters;

The formula cannot be displayed in
the worksheet; for example, due to
worksheet protection;

An external workbook that contains
the formula is not currently open.

Invalid data types used as inputs will
produce a #VALUE error value.

HLOOKU
P

Three mandatory
parameters: the
value to be found
in the first row of
the table, the table
of information in
which data is
looked up, and the
row number in
table_array which
the matching
value will be
returned.

You can optionally
add a logical value
that specifies
whether you want
HLOOKUP to find
an exact match or
an approximate
match.

=HLOOKUP(lo
okup_value,
table_array,
row_index_nu
m,
[range_looku
p])

Looks in the top row of an array
and returns the value of the initiated
cell. Use HLOOKUP when your
comparison values are located in a
row across the top of a table of
data, and you want to look down a
specified number of rows. Use
VLOOKUP when your comparison
values are located in a column to
the left of the data you want to find.

If HLOOKUP can’t find lookup_value,
the range_lookup is TRUE, it uses
the largest value that is less than
lookup_value.

If lookup_value is smaller than the
smallest value in the first row of
table_array, HLOOKUP returns the
#N/A error value.

If range_lookup is FALSE and
lookup_value is text, you can use
the wildcard characters, question
mark (?) and asterisk (*), in
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lookup_value. A question mark
matches any single character; an
asterisk matches any sequence of
characters. If you want to find an
actual question mark or asterisk,
type a tilde (~) before the
character.

INDEX Array form:

Two mandatory
parameters.

The array
parameter
specifies a cell
range or an array
constant. If the
specified array
contains only one
row or column,
the corresponding
row_num or
column_num
parameter is
optional. If the
array has more
than one row and
more than one
column, and only
the row_num or
column_num
parameter is
provided, the
INDEX function
returns an array of
the entire row or
column in array.

The mandatory
row_num
parameter
specifies the row
in the array from
which the INDEX
function should
return a value. If
the row_num
parameter is
omitted, the

Array form:

=INDEX(array
, row_num,
[column_num
])

 

Reference form:

=INDEX(refer
ence,
row_num,
[column_num
],
[area_num])

Returns a value or the reference to
a value from within a table or cell
range. There are two forms of the
INDEX function: the array form and
the reference form.

 

Array form:

Returns the value of an element in a
table or an array, selected by the
row and column number indexes.
Use the array from if the first
parameter of the INDEX function is
an array constant.

If both the row_num and
column_num parameters are used,
the INDEX function returns the value
in the cell at the intersection of
row_num and column_num.

If you set row_num or column_num
to 0 (zero), the INDEX function
returns the array of values for the
entire column or row, respectively.
To use values returned as an array,
enter the INDEX function as an array
formula in a horizontal range of cells
for a row, and in a vertical range of
cells for a column. In order to enter
the INDEX function as an array
formula, press the
Ctrl+Shift+Enter key combination.

The row_num and column_num
parameter values must point to a
cell within the array. Otherwise, the
INDEX function returns the #REF!
error value.

 

Reference form:
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column_num
parameter is
required instead.

The optional
column_num
parameter
specifies the
column in the
array from which
the INDEX function
should return a
value. If the
column_num
parameter is
omitted, the
row_num
parameter is
required instead.

 

Reference form:

Two mandatory
parameters.

The reference
parameter
specifies a
reference to one
or more cell
ranges. If you are
entering a
nonadjacent cell
range for the
reference, enclose
the reference in
parentheses. If
each area in the
reference
parameter
contains only one
row or column,
the row_num or
column_num
parameter
becomes optional,
respectively.

The mandatory
row_num

Returns the reference of the cell at
the intersection of a particular row
and column. If the reference
consists of nonadjacent cell ranges,
you can pick a particular range.

 

After the reference and area_num
values have been used to select a
particular range, the row_num and
column_num values are used to
select a particular cell. The row_num
value set to 1 corresponds to the
first row in the range, the
column_num value set to 1
corresponds to the first column, and
so on. The reference returned by
the INDEX function is the
intersection of the row and column
whose numbers are specified as the
row_num and column_num
parameters.

If you set the row_num or
column_num parameter to 0
(zero), the INDEX function returns
the reference for the entire column
or row, respectively.

The row_num, column_num, and
area_num parameter values must
point to a cell within the reference.
Otherwise, the INDEX function
returns the #REF! error value. If the
row_num and column_num
parameters are omitted, the INDEX
function returns the area in the
reference specified by the area_num
parameter.

The result of the INDEX function is a
reference and can be used as a
reference in other formula
expressions.
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parameter
specifies the
number of the row
in the reference
from which the
INDEX function
returns a
reference.

The optional
column_num
parameter
specifies the
number of the
column in the
reference from
which the INDEX
function returns a
reference.

The optional
area_num
parameter
specifies a range in
the reference from
which the INDEX
function returns
the intersection of
row_num and
column_num. The
first selected area
is numbered 1, the
second is 2, and
so on. If the
area_num
parameter is
omitted, the
INDEX function
uses 1 as the area
value.

INDIREC
T

One mandatory
parameter: the
reference to a cell
that contains an
A1-style
reference, an
R1C1-style
reference, a name

=INDIRECT(re
f_text, a1)

Returns the reference specified by a
text string. References are
immediately evaluated to display
their contents.

Use the INDIRECT function when
you need to change the reference to
a cell within a formula without
changing the formula itself.
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defined as a
reference, or a
reference to a cell
as a text string.

If the a1
parameter is set
to TRUE or
omitted, the
ref_text value is
interpreted as an
A1-style
reference.

If the a1
parameter is set
to FALSE, the
ref_text value is
interpreted as an
R1C1-style
reference.

If the ref_text parameter contains
no valid cell reference, the INDIRECT
function returns the #REF! error
value.

LOOKUP Vector form:

Two obligatory
parameters: the
value that
LOOKUP searches
for in the first
vector, and the
range that
contains only one
row or one
column.

Additionally, you
can specify a
range that
contains only one
row or column
(result_vector).

Array form:

Two obligatory
parameters: the
value that
LOOKUP searches
for in the array
and the range of
cells that contains
text, numbers, or

Vector form:

=LOOKUP(loo
kup_value,
lookup_vector
,
[result_vector
])

 

Array form:

=LOOKUP(loo
kup_value,
array)

Looks up values in a vector or
array. The LOOKUP function returns
a value either form a one-row or
one-column range or form an array.
The LOOKUP function has two
syntax forms: the vector form and
the array form.

Vector form:

A vector is a range of only one row
or one column. LOOKUP looks in a
one-row or one-column range
(known as a vector) for a value and
returns a value from the same
position in a second one-row or
one-column range. Use the LOOKUP
function when you want to specify
the range that contains the values
that you want to match.

If lookup_value is smaller than the
smallest value in lookup_vector,
LOOKUP returns the #N/A error
value.

Array form:

The array form of LOOKUP looks in
the first row or column of an array
for the specified value and returns a
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logical values that
you want to
compare with
lookup_value.

value from the same position in the
last row or column of the array. Use
this form of LOOKUP when the
values that you want to match are
in the first row or column of the
array. Use the other form of
LOOKUP when you want to specify
the location of the column or row. 
Press the Ctrl+Shift+Enter key
combination to execute the formula.

In general, it is best to use the
HLOOKUP or VLOOKUP function
instead of the array form of
LOOKUP. This form of LOOKUP is
provided for compatibility with other
spreadsheet programs.

MATCH Two obligatory
parameters: the
value that you
want to match in
lookup_array, and
the range of cells
being searched.

Additionally, you
can specify the
match_type which
can be the number
–1, 0, or 1. The
match_type
specifies how the
ExpressSpreadS
heet matches
lookup_value with
values in
lookup_array. The
default value for
this parameter is
1.

If match_type is 1
or omitted,
MATCH finds the
largest value that
is less than or
equal to
lookup_value.

=MATCH(look
up_value,
lookup_array,
[match_type]
)

Looks up values in a reference or
array. The MATCH function searches
for a specified item in a range of
cells, and then returns the relative
position of that item in the range.

Use MATCH instead of one of the
LOOKUP functions when you need
the position of an item in a range
instead of the item itself.

MATCH returns the position of the
matched value within lookup_array,
not the value itself. For instance,
MATCH("b",{"a","b","c"},0) returns
2 which is the relative position of "b"
within the array {"a","b","c"}.

MATCH does not distinguish
between uppercase and lowercase
letters when matching text values.

If MATCH is unsuccessful in finding a
match, it returns the #N/A error
value.

If match_type is 0, and
lookup_value is a text string, you
can use the wildcard characters –
the question mark (?) and asterisk
(*) – in the lookup_value
parameter. A question mark
matches any single character; an
asterisk matches any sequence of
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If match_type is
0, MATCH finds
the first value that
is exactly equal to
lookup_value.

If match_type is –
1, MATCH finds
the smallest value
that is greater
than or equal to
lookup_value.

characters. If you want to find an
actual question mark or asterisk,
type a tilde (~) before the
character.

OFFSET Accepts three
obligatory
parameters: the
reference from
which you want to
base the offset,
the number of
rows, up or down
that you want the
upper-left cell to
refer to, and the
number of
columns to the left
or right that you
want the upper-
left cell of the
result to refer to.

Additionally, you
can specify the
height and width
of the returned
reference. Both
the height and
width must be
positive.

=OFFSET(refe
rence, rows,
cols, [height],
[width])

Returns a reference to a range that
is the specified number of rows and
columns from a cell or cell range.
The returned reference can be a
single cell or cell range. You can
specify the number of returned rows
and/or columns.

If the offset reference is outside the
worksheet’s boundaries, the
OFFSET function returns the #REF!
error value.

If the height or width parameter is
omitted, the returned cell range has
the same height or width as the
specified reference.

The OFFSET function does not
actually move any cell or change the
selection while returning a reference.
You can use OFFSET with any
function expecting a reference
parameter. For example, the
formula expression
SUM(OFFSET(C2,1,2,3,1))
calculates the total value of a range
that is three rows in height and one
column width that is 1 row below
and 2 columns to the right of the C2
cell.

ROW The reference
parameter is
optional.

If reference is
omitted, it is
assumed to be the

=ROW([refere
nce])

Returns the row number of a
reference.
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reference of the
cell in which the
ROW function
appears.

If reference is a
range of cells, and
if ROW is entered
as a vertical array,
ROW returns the
row numbers of
reference as a
vertical array.

Reference cannot
refer to multiple
areas.

ROWS The array
parameter is
mandatory. An
array, an array
formula, or a
reference to a
range of cells for
which you want
the number of
rows.

=ROWS(array
)

Returns the number of rows in a
reference or array.

TRANSP
OSE

One obligatory
parameter: an
array or range of
cells within a
worksheet that
you want to
transpose. The
transposition of an
array is created by
using the first
column of the new
array, the second
row of the array
as the second
column of the new
array, and so on.

=TRANSPOSE
(array)

Returns a vertical range of cells as a
horizontal range, and vice versa.
You must enter the TRANSPOSE
function as an array formula in a
range that has the same number of
rows and columns, respectively, as
the source range has columns and
rows. Use TRANSPOSE to swap the
vertical and horizontal orientation of
an array or range within a
worksheet.

The steps are as follows:

1. Highlight the new area for the
transposed cells.

2. Select TRANSPOSE and
highlight the source cells so
they appear within the
parentheses of the formula.
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3. Press Ctrl+Shift+Enter key
combination to execute the
formula;  the new area will
now contain the transposed
data.

VLOOKU
P

Three obligatory
parameters: the
value to search in
the first column of
the table or range,
the range of cells
that contains the
data, and the
column number in
the table_array
parameter from
which the
matching value
must be returned.

Additionally, you
can specify the
range_lookup that
switches the
VLOOKUP finding
between an exact
match and an
approximate
match.

=VLOOKUP(lo
okup_value,
table_array,
col_index_nu
m,
[range_looku
p])

Looks in the first column of an array
and moves across the row to return
the value of a cell. You can use the
VLOOKUP function to search the first
column of a range of cells, and then
return a value from any cell on the
same row of the range. The V in
VLOOKUP stands for vertical. Use
VLOOKUP instead of HLOOKUP when
your comparison values are located
in columns to the left of the data
that you want to find.

When searching number or date
values, ensure that the data in the
first column of table_array is not
stored as text values. In this case,
VLOOKUP might return an incorrect
or unexpected value.

If range_lookup is FALSE and
lookup_value is text, you can use
the wildcard characters – the
question mark (?) and asterisk (*) –
in lookup_value. A question mark
matches any single character; an
asterisk matches any sequence of
characters. If you want to find an
actual question mark or asterisk,
type a tilde (~) preceding the
character.

 

 

Arithmetic functions

A set of mathematic and trigonometric functions, including basic arithmetic, conditional sums and
products, and trigonometric ratios. Mathematicians may also find the Statistical Functions  useful.

 

 

Mnemonic
s

Operand Type Example Explanation

 

484
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ABS One parameter
of double type.

=ABS(B6) Returns the absolute value.

ACOS One parameter
of double type.

=ACOS(B16) Returns the arccosine.

ACOSH One parameter
of double type.

=ACOSH(A1) Returns the inverse hyperbolic
cosine.

ACOT One parameter
of double type.

=ACOT(A1) Returns the principal value of the
arccotangent, or inverse cotangent,
of a number. The returned angle is
given in radians in the range 0
(zero) to pi.

ACOTH One parameter
of double type.
The absolute
value of the
parameter must
be greater than
1.

=ACOTH(A1) Returns the inverse hyperbolic
cotangent of a number. If the
absolute value of the parameter is
less than 1, the ACOT function
returns the #VALUE! error value.

ASIN One parameter
of double type.

=ASIN(B6) Returns the arcsine.

ASINH One parameter
of double type.

=ASINH(C2) Returns the inverse hyperbolic sine
of the parameter.

ATAN One parameter
of double type.

=ATAN(C5) Returns the arctangent.

ATAN2 Two parameters
of double type.

=ATAN2(A1,
A2)

Returns the arctangent using x- and
y- coordinates.

ATANH One parameter
of double type.

=ATANH(D4) Returns the inverse hyperbolic
tangent.

BASE Two parameters
of integer type:
the first is
greater than 0
and less than
2^53; the
second (radix)
must be greater
than or equal to
2 and less than
or equal to 36.
Third parameter
is optional, which

=BASE(A1,
Radix[Min_len
gth])

Converts a number into a text
representation with the given radix
(base).

If A1, Radix, or Min_length are
outside the minimum or maximum
constraints, BASE returns the
#NUM! error value.

If A1 is a non-numeric value, BASE
returns the #VALUE! error value.

Any non-integer number used as an
parameter is truncated to an
integer.

If the Min_length parameter is
included, leading zeros are added to
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must be greater
or equal to 0.

the result if the result would
otherwise be shorter than the
minimum length specified. For
example, BASE(16,2) returns
10000 but BASE(16,2,8) returns
00010000.

CEILING Two parameter
of double type

=CEILING(2.5
, 1)

Rounds the first parameter up to the
nearest multiple based on the
significance specified by the second
parameter.

CEILING.
MATH

Three
parameters. The
first parameter
must be less
than 9.99E+307
and greater than
–2.229E-308;
the second
parameter is the
multiple to which
the number is
rounded; the
optional Mode
parameter.

=CEILING.MA
TH(A1,
[significance],
[mode])

Rounds a number up to the nearest
integer or to the nearest multitude
of significance.

By default, significance is +1 for
positive numbers and –1 for
negative numbers.

By default, both positive and
negative numbers with decimal
portions are rounded up to the
nearest integer. If you specify the
Significance and Mode parameters,
you can change the direction of
rounding for negative numbers. For
example, rounding –6.3 to a
significance of 1 with a mode of 1
rounds away from 0, to –7. There
are many combinations of
Significance and Mode values that
affect rounding of negative numbers
in different ways.

The Mode parameter does not
affect positive numbers.

CEILING.P
RECISE

Two
parameters. The
first parameter is
a number of
double type. The
Significance
parameter is
optional.

=CEILING.PRE
CISE(A1,
[significance])

Returns a number that is rounded up
to the nearest integer or to the
nearest multiple of significance.
Regardless of the sign of the
number, the number is rounded up.
However, if the number or the
significance is zero,
CEILING.PRECISE returns zero. If
the Significance parameter is
omitted, its default value is 1.

CONCATE
NATE

At least one text
item is
mandatory; you

=CONCATENA
TE(text1,
[text2], …)

Joins several text items into a single
text item. The CONCATENATE
function joins up to 255 text strings
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can add more
text items, up to
a maximum of
255 items.
Commas must
separate the
specified items.

into one text string. The joined
items can be text, numbers, cell
references, or a combination of
those items.

Note that you can also use the
ampersand (&) calculation operator
instead of the CONCATENATE
function to join text items. For
instance, =A1 & B1 returns the
same value as =CONCATENATE(A1,
B1).

COS One parameter
of double type

=COS(A1) Returns the cosine.

COSH One parameter
of double type

=COSH(D7) Returns the hyperbolic cosine.

COMBIN Two parameters
of integer type.
Non-integer
numeric
parameters are
truncated to
integers.

=COMBIN(nu
mber,
number_chos
en)

Returns the number of combinations
for a given number of items. Use
COMBIN to determine the total
possible number of groups for a
given number of items.

If either parameter is non-numeric,
COMBIN returns the #VALUE! error
value.

If either parameter is negative,
COMBIN returns the #NUM! error
value.

COMBINA Two parameters
of integer type.
Non-integer
numeric
parameters are
truncated to
integers.

=COMBINA(n
umber,
number_chos
en)

Returns the number of combinations
(with repetitions) for a given
number of items.

If the value of either parameter is
outside of its constraints, COMBINA
returns the #NUM! error.

If either parameter is a non-numeric
value, COMBINA returns the
#VALUE! error value.

COT One parameter
of double type,
which should be
more than 0 and
less than 2^27.

=COT(number
)

Returns the cotangent of an angle
specified in radians.

If the specified parameter is outside
its constraints, the COT function
returns the #NUM! error value.

If the specified parameter is not a
numeric value, the COT function
returns the #VALUE! error value.
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The COT(0) expression returns the
#DIV/0! error value.

COTH One parameter
of double type,
which should be
less than 2^27.

=COTH(numb
er)

Returns the hyperbolic cotangent of
a hyperbolic angle.

If the specified parameter is outside
its constraints, the COTH function
returns the #NUM! error value.

If the specified parameter is a non-
numeric value, the COTH function
returns the #VALUE! error value.

CSC One parameter
of double type,
which should be
less than 2^27.

=CSC(number
)

Returns the cosecant of an angle
specified in radians.

If the specified parameter is outside
its constraints, the CSC function
returns the #NUM!

If the specified parameter is a non-
numeric value, the CSC function
returns the #VALUE! error value.

CSC(n) equals 1/SIN(n).

CSCH One parameter
of double type,
which should be
less than 2^27.

=CSCH(numb
er)

Returns the hyperbolic cosecant of
an angle specified in radians.

If the specified parameter is outside
its constraints, the CSCH function
returns the #NUM! error value.

If the specified parameter is a non-
numeric value, the CSCH function
returns the #VALUE! error value.

DECIMAL One parameter
is a text string
that must be
less or equal to
255 characters,
other parameter
is an integer that
must be greater
or equal to 2
and less than or
equal to 36.

=DECIMAL(te
xt, radix)

Converts a text representation of a
number in a given base into a
decimal number.

A radix greater than 10 uses the
numeric values 0 – 9 and the letters
A-Z as needed. For example, base
16 (hexadecimal) uses 0 – 9 and A
– F, and base 36 uses 0 – 9 and A –
Z.

If either parameter is outside its
constraints, DECIMAL may return
the #NUM! or #VALUE! error value.

DEGREES One parameter
of double type
that specifies
angle in radians

=DEGREES(PI
()/2)

Converts radians to degrees.
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EVEN One parameter
of double type

=EVEN(-1) Rounds the parameter up to the
nearest even integer.

EXP One parameter
of double type

=EXP(C1) Returns the exponent value of the
parameter.

FACT One non-
negative
parameter. If a
number is not an
integer, it is
truncated.

=FACT(2) Returns the factorial of the
parameter.

FACTDOU
BLE

One non-
negative
parameter. If a
number is not an
integer, it is
truncated.

=FACTDOUBL
E(number)

Returns the double factorial of a
number.

If the number is non-numeric, the
FACTDOUBLE function returns the
#VALUE! error value.

If the number is negative, the
FACTDOUBLE function returns the
#NUM! error value.

FLOOR Two parameters
of double type

=FLOOR(-2.5,
-2)

Rounds the first parameter down,
towards zero, to the nearest
multiple of the significance specified
by the second parameter.

FLOOR.MA
TH

Three
parameters: first
is the number to
be rounded
down, second is
the multiple to
which you want
to round, and
third is the
direction (either
towards or away
from 0) to round
negative
numbers.

=FLOOR.MAT
H(number,
significance,
mode)

By default, both positive and
negative numbers are rounded
down to the nearest integer. By
using 0 or a negative number as the
Mode parameter, you can change
the direction of the rounding for
negative numbers.

The Significance parameter rounds
the number down to the nearest
integer that is a multiple of the
significance specified. The exception
is where the number to be rounded
is an integer. For example, for a
Significance of 3, the number is
rounded down to the next integer
that is a multiple of 3. If Number is
divided by a Significance of 2 or
greater results in a remainder, the
result is rounded.

FLOOR.PR
ECISE

Two
parameters.
First is the

=FLOOR.PREC
ISE(number,
[significance])

Returns a number that is rounded
down to the nearest integer or to
the nearest multiple of significance.
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number to be
rounded down,
second is the
multiple to which
the number is to
be rounded. The
Significance
parameter is
optional.

Regardless of the sign of the
number, the number is rounded
down. However, if the number of
the significance is zero, zero is
returned.

If the significance is omitted, its
default value is 1.

The absolute value of the multiple is
used, so that the FLOOR.PRECISE
function returns the mathematical
floor irrespective of the signs of the
number and significance.

INT Parameter of
type double

=INT(E4) Rounds the parameter down to the
nearest integer.

ISO.CEILI
NG

Two
parameters.
First is the value
to be rounded;
second is the
optional multiple
to which the
number is to be
rounded.

=ISO.CEILING
(number,
[significance])

Returns a number that is rounded up
to the nearest integer or to the
nearest multiple of significance.
Regardless of the sign of the
number, the number is rounded up.
However, if the number or the
significance is zero, zero is returned.

If the significance is omitted, its
default value is 1.

LN One parameter
of double type

=LN(C1) Returns the natural logarithm.

LOG Two
parameters: the
number and the
base

=LOG(100,
10)

 

Returns the logarithm of a number
to the specified base.

LOG10 One parameter
of double type

=LOG10(100
0)

Returns the base-10 logarithm of
the parameter.

MMULT Two obligatory
parameters: the
arrays you want
to multiply. The
number of
columns in
array1 must be
the same as the
number of rows
in array2, and
both arrays
must contain

=MMULT(arra
y1, array2)

Returns the matrix product of two
arrays. The result is an array with
the same number of rows as array1
and the same number of columns as
array2. You must enter formulas
that return arrays only as array
formulas.

The MMULT function returns
#VALUE! error when any of the
specified cells are empty or contain
non-numeric values. If the number
of columns in array1 is different
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only numeric
values. Both
arrays can be
specified as cell
ranges, array
constants, or
references.

from the number of rows in array2,
MMULT also returns the #VALUE!
error.

MOD Two
parameters: a
number and
divisor

=MOD(4,3) Returns the remainder after the
number is divided by the divisor.

MROUND Two
parameters: the
value to be
rounded, and the
multiple to which
you want to
round the value.

=MROUND(nu
mber,
multiple)

Returns a number rounded to the
desired multiple.

MROUND rounds up, away from
zero, if the remainder of dividing the
number by the multiple is greater
than or equal to half the value of the
multiple.

ODD One parameter
of double type

=ODD(3.5) Rounds the parameter up to the
nearest odd integer.

PI No parameters
required

=PI() Returns the value of Pi.

POWER Two parameters
of double type:
the number and
the power

=POWER(A1,
4)

Raises the number to the base.

PRODUCT The first
parameter is the
number or range
that you want to
multiply.
Additional
optional
parameters that
specify additional
numbers or
ranges that you
want to multiply,
up to a
maximum of
255 parameters.

=PRODUCT(n
umber1,
[number2],
…)

The PRODUCT multiplies all the
numbers given as parameters and
returns the product. For example, if
cells A1 and A2 contain numbers,
you can use the formula
=PRODUCT(A1, A2) to multiply
those two numbers together. You
can also perform the same
operation by using the multiply (*)
mathematical operator; for
example, =A1 * A2.

The PRODUCT function is useful
when you need to multiply multiple
cells or cell ranges together. For
example, the formula
=PRODUCT(A1:A3, C1:C3) is
equivalent to = A1 * A2 * A3 * C1
* C2 * C3.
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QUOTIENT Two
parameters: the
dividend and the
divisor.

=QUOTIENT(n
umerator,
denominator)

Returns the integer portion of a
division. Use this function when you
want to discard the remainder of a
division.

RADIANS One parameter
of type double
that specifies
angle in degrees.

=RADIANS(18
0)

Converts degrees to radians.

RAND No parameters
required

=RAND() Returns a random number between
0 and 1.

RANDBET
WEEN

Two parameters
of integer type:
bottom that
specifies the
smallest
returned value,
and top that
specifies the
largest returned
value.

=RANDBETWE
EN(bottom,
top)

Returns a random integer between
the numbers you specify. A new
random integer is returned every
time the worksheet is calculated.

ROUND Two
parameters: the
number of
double type and
the number of
digits

=ROUND(20.
57, 1)

Rounds the first parameter to the
specified number of digits.

ROUNDDO
WN

Two parameters
of double type

=ROUNDDOW
N(2.75,0)

Rounds the parameter toward zero.
The first parameter specifies a
number to round up. The second
parameter defines the number of
digits to which you want to round
the first parameter.

ROUNDUP Two parameters
of double type

=ROUNDUP(-
3.42,1)

Rounds the parameter toward
infinity. The first parameter specifies
a number to round up. The second
parameter defines the number of
digits to which you want to round
the first parameter.

SEC One parameter
of double type.
Number is the
angle in radians
for which you

=SEC(number) Returns the secant of an angle.

The absolute value of the parameter
must be less than 2^27.
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want to calculate
the secant.

If the parameter is outside of its
constraints, SEC returns the #NUM!
error value.

If the parameter is a non-numeric
value, SEC returns the #VALUE!
error value.

SECH One parameter
of double type.
Number is the
angle in radians
for which you
want to calculate
the hyperbolic
secant.

=SECH(number) Returns the hyperbolic secant of an
angle.

The absolute value of the parameter
must be less than 2^27.

If the parameter is outside of its
constraints, SECH returns the
#NUM! error value.

If the parameter is a non-numeric
value, SECH returns the #VALUE!
error value.

SIGN One parameter
of double type

=SIGN(A2) Returns the sign.

SIN One parameter
of double type

=SIN(A1) Returns the sine.

SINH One parameter
of double type

=SINH(1) Returns the hyperbolic sine.

SQRT One parameter
of double type

=SQRT(B5) Returns the square root.

SQRTPI One parameter
of double type.

=SQRTPI(num
ber)

Returns the square root of (number
* pi).

If the parameter is negative, SQRTPI
returns the #NUM! error value.

SUBTOTALThe first
parameter is a
number from 1
to 11 (includes
hidden values)
or from 101 to
111 (ignores
hidden values)
that specifies
which function to
use in calculating
subtotals within
a list.

=SUBTOTAL(f
unction_num,
ref1, [ref2],
…)

Returns a subtotal in a list or
database.

If there are other subtotals within
ref1, ref2, … (or nested subtotals),
these nested subtotals are ignored
to avoid double counting.

The SUBTOTAL function ignores any
rows that are not included in the
result of a filter, no matter which
function_num value you use.

The SUBTOTAL function is designed
for columns of data, or vertical
ranges. It is not designed for rows
of data, or horizontal ranges. For
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The second
parameter is the
first named
range or
reference for
which you want
the subtotal.

Subsequent
parameters are
optional and
specify named
ranges or
references 2 to
254 for which
you want the
subtotal.

example, when you subtotal a
horizontal range using a
function_num of 101 or greater,
such as SUBTOTAL(109,B2:G2),
hiding a column does not affect the
subtotal. However, hiding a row in a
subtotal of a vertical range does
affect the subtotal.

If any of the references are 3-D
references, SUBTOTAL returns the
#VALUE! error value.

SUM A list of
parameters

=SUM(A1:C1
2)

=SUM(A1,
3.14, 1.57)

Sums all the values in the list.

SUMIF Three
parameters. The
range of cells
that you want to
evaluate by
criteria. Blank
and text values
are ignored. The
criteria in the
form of a
number,
expression, a cell
reference, text,
or a function
that defines
which cells will
be added. The
optional
sum_range
parameter that
allows you to
add more cells
to those
specified ion the

=SUMIF(rang
e, criteria,
[sum_range])

The SUMIF function is designed to
sum the values in a range that meet
a criteria you specify. For example,
suppose that in a column that
contains numbers, you want to sum
only the values that are larger than
5. You can use the following
formula:

=SUMIF(B2:B25, ">5")

In this example, the criteria is
applied the same values that are
being summed. If you want, you can
apply the criteria to one range and
sum the corresponding values in a
different range. For example, the
formula =SUMIF(B2:B5, "John",
C2:C5) sums only the values in the
range C2:C5, where the
corresponding cells in the range
B2:B5 equal "John".

Any text criteria or any criteria that
includes logical or mathematical
symbols must be enclosed in double
quotation marks ("). If the criteria is
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range
parameter.

numeric, double quotation marks
are not necessary.

You can use both the question mark
(?) and asterisk (*) – as the criteria
parameter. A question mark
matches any single character; an
asterisk matches any sequence of
characters. If you need to find an
actual question mark or asterisk,
type a tilde (~) preceding the
character.

SUMSQ A list of
parameters

=SUMSQ(B1:
D1)

=SUM(1, 2, 3,
4)

Sums the square of values in the list

TAN One parameter
of double type

=TAN(C3) Returns the tangent.

TANH One parameter
of double type

=TANH(0) Returns the hyperbolic tangent.

TRUNC One parameter
of double type

=TRUNC(PI()) Returns the integer part. Compare
this with the INT function, which
returns a double

 

 
 

Statistical functions

The ExpressSpreadSheet control provides a large selection of statistical functions, performing most of
the common statistical calculations, from basic mean, median and mode calculations to more complex
statistical distribution and probability tests.

 

 

Mnemonics Operand Type Example Explanation

 

ANOVA Please refer to the Anova - Analysis
of Variance  chapter for more
details.

AVEDEV Number1 is
required,
subsequent
parameters are
optional. You
can specify

=AVEDEV(nu
mber1,
[number2],
…)

Returns the average of the absolute
deviations of data points from their
mean. AVEDEV is a measure of the
variability in a data set.

AVEDEV is influenced by the unit of
measurement in the input data.

556
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from 1 to 255
numbers for
which you want
the average of
the absolute
deviations.
Alternatively,
you can use a
single array or
a reference to
an array
instead of
parameters
separated by
commas.

Parameters must either be numbers
or be names, arrays, or references
that contain numbers.

Logical values and text
representations of numbers that
you type directly into the list of
parameters are counted.

If an array or reference parameter
contains text, logical values, or
empty cells, those values are
ignored; however, cells with the
zero value are included.

AVERAGE A list of
parameters

=AVERAGE(A
1:A5)

=AVERAGE(1
0.3, 9.1)

Calculates the average value of
values within the list.

AVERAGEA A list of
parameters

=AVERAGEA(
A1:A5)

Calculates the average value of the
non-empty cells referenced.

AVERAGEA(range) equals
SUM(range)/COUNTA(range).

AVERAGEIF Two mandatory
parameters:
the range which
specifies one or
more cells to
average,
including
numbers or
names, arrays
or references
that contain
numbers; the
criteria in the
form of a
number,
expression, cell
reference, or
text that
defines which
cells are
averaged.

=AVERAGEIF(
range, criteria,
[average_ran
ge])

Returns the average (arithmetic
mean) of all the cells in a range that
meet a given criteria.

Cells that contain TRUE or FALSE
are ignored.

If a cell in average_range is an
empty cell, AVERAGEIF ignores it.

If range is a blank or text value,
AVERAGEIF returns the #DIV/0!
error value.

If a cell in criteria is empty,
AVERAGEIF treats it as a 0 value.

If no cells in the range meet the
criteria, AVERAGEIF returns the
#DIV/0! error value.

You can use the wildcard
characters, question mark (?) and
asterisk (*), in criteria. A question
mark matches any single character;
an asterisk matches any sequence
of characters. If you want to find an
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Additionally,
you can specify
the actual set
of cells to
average. If
omitted, the
range
parameter is
used.

actual question mark or asterisk,
type a tilde (~) before the
character.

The average_range parameter does
not have to be the same size and
shape as range. The actual cells that
are averaged are determined by
using the top, left cell in
average_range as the beginning cell,
and then including cells that
correspond in size and shape to
range.

BETA.DIST Six parameters,
the first four of
which are
mandatory: X
is the value
between A and
B at which the
function should
be evaluated;
Alpha and Beta
are parameters
of the
distribution;
Cumulative is a
logical value
that determines
the form of the
function; A and
B are lower and
higher bounds
to the interval
of X,
respectively.

=BETA.DIST(x
, alpha, beta,
cumulative,
[A], [B])

Returns the beta distribution. The
beta distribution is commonly used
to study variation in the percentage
of something across samples, such
as fraction of the day people spend
watching television.

If any parameter is non-numeric,
BETA.DIST returns the #VALUE!
error value.

If either alpha or beta is not
positive, BETA.DIST returns the
#NUM! error value.

If x < A, x > B, or A = B, BETA.DIST
returns the #NUM! error value.

If you omit values for A and B,
BETA.DIST uses the standard
cumulative beta distribution, so that
A = 0 and B = 1.

If cumulative is TRUE, BETA.DIST
returns the cumulative distribution
function; if FALSE, it returns the
probability density function.

If you omit values for A and B,
BETA.DIST uses the standard
cumulative beta distribution, so that
A = 0, and B = 1.

BETA.INV Five
parameters,
the first three
of which are
mandatory:
Probability is
the probability

=BETA.INV(pr
obability,
alpha, beta,
[A], [B])

Returns the inverse of the beta
cumulative probability density
function (BETA.DIST).

If probability = BETA.DIST(x, …
TRUE), then BETA.INV(probability,
…) = x. The beta distribution can be
used in project planning to model
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associated with
the beta
distribution;
Alpha and Beta
are parameters
of the
distribution; A
and B are lower
and higher
bounds to the
interval of X,
respectively.

probable completion times given an
expected completion time and
variability.

If any parameter is non-numeric,
BETA.INV returns the #VALUE! error
value.

If either alpha or beta is not
positive, BETA.INV returns the
#NUM! error value.

If probability is either below zero or
higher than 1, BETA.INV returns the
#NUM! error value.

If you omit values for A and B,
BETA.INV uses the standard
cumulative beta distribution, so that
A = 0 and B = 1.

Given a value for probability,
BETA.INV seeks that value x such
that BETA.DIST(x, alpha, beta,
TRUE, A, B) = probability. Thus, the
precision of BETA.INV depends on
the precision of BETA.DIST.

BINOM.DIS
T

Four obligatory
parameters:
the number of
successes in
trials, the
number of
independent
trials, the
probability of
success on
each trial, and
the logical value
that determines
the form of the
function.

If cumulative is
TRUE, then
BINOM.DIST
returns the
cumulative
distribution
function, which
is the

=BINOM.DIST
(number_s,
trials,
probability_s,
cumulative)

Returns the individual term binomial
distribution probability. Use
BINOM.DIST in problems with a
fixed number of tests or trials, when
the outcome of any trial are only
success or failure, when trials are
independent, and when the
probability of success is constant
throughout the experiment. For
example, BINOM.DIST can calculate
the probability that two of the next
three babies born are male.

The number_s and trials parameters
are truncated to integers.

If number_s, trials, or probability_s
is non-numeric, BINOM.DIST returns
the #VALUE! error value.

If number_s < 0 or number_s >
trials, BINOM.DIST returns the
#NUM! error value.

If probability_s < 0 or probability_s
> 1, BINOM.DIST returns the
#NUM! error value.
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probability that
there are at
most number_s
successes; if
FALSE, it
returns the
probability
mass function,
which is the
probability that
there are
number_s
successes.

BINOM.DIS
T.RANGE

Three
obligatory
parameters:
the number of
independent
trials, the
probability of
success in each
trial, and the
number of
successes in
trials.

Additionally,
you can provide
an additional
range bound for
the number of
successes in
trials.

=BINOM.DIST
.RANGE(trials,
probability_s,
number_s,
[number_s2])

Returns the probability of a trial
result using a binomial distribution.

If any parameters are outside of
their constraints,
BINOM.DIST.RANGE returns the
#NUM! error value:
· The trials parameter must be

greater than or equal to zero.
· The probability_s parameter must

be greater than or equal to zero
and less than or equal to 1.

· The number_s parameter must be

greater than or equal to zero and
less than or equal to trials.

· The number_s2 parameter, if

provided, must be greater or
equal to number_s, and less than
or equal to trials.

If any parameters are non-numeric
values, BINOM.DIST.RANGE returns
the #VALUE! error value.

Numeric parameters are truncated
to integers.

BINOM.INV Three
obligatory
parameters:
trials (the
number of
Bernoulli trials),
probability (the
probability of
success of each

=BINOM.INV(t
rials,
probability_s,
alpha)

Returns the smallest value for which
the cumulative binomial distribution
is greater than or equal to a
criterion value.
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trial), alpha (the
criterion value).

CHISQ.DISTThree
obligatory
parameters:
the value at
which you want
to evaluate the
distribution, the
number of
degrees of
freedom, and
the logical value
that determines
the form of the
function.

If cumulative is
TRUE,
CHISQ.DIST
returns the
cumulative
distribution
function;
otherwise, it
returns the
probability
density
function.

=CHISQ.DIST
(x,
deg_freedom,
cumulative)

Returns the cumulative beta
probability density functions. The
chi-squared distribution is
commonly used to study variation
in the percentage of something
across samples, such as the
fraction of the day people spend
watching television.

If any parameter is non-numeric,
CHISQ.DIST returns the #VALUE!
error value.

If x is negative, CHISQ.DIST returns
the #NUM! error value.

If deg_freedom is not an integer, it
is truncated.

If deg_freedom < 1 or
deg_freedom > 10^10,
CHISQ.DIST returns the #NUM!
error value.

CHISQ.DIST
.RT

Two obligatory
parameters:
the value at
which you want
to evaluate the
distribution and
the number of
degrees of
freedom.

=CHISQ.DIST.
RT(x,
deg_freedom)

Returns the one-tailed probability of
the chi-squared distribution. The chi-
squared distribution is associated
with a chi-squared test. Use the chi-
squared test to compare observed
and expected values. For instance,
a genetic experiment might
hypothesize that the next
generation of plants will exhibit a
certain set of colors. By comparing
the observed results with the
expected ones, you can decide
whether your original hypothesis is
valid.

If either parameter is non-numeric,
CHISQ.DIST.RT function returns the
#VALUE! error value.
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If deg_freedom is not an integer, it
is truncated.

If deg_freedom < 1 or
deg_freedom > 10^10,
CHISQ.DIST.RT returns the #NUM!
error value.

CHISQ.INV Two obligatory
parameters:
the probability
associated with
the chi-squared
distribution and
the number of
degrees of
freedom.

=CHISQ.INV(
probability,
deg_freedom)

Returns the inverse of the left-tailed
probability of the chi-squared
distribution. The chi-squared
distribution is commonly used to
study variation in the percentage of
something across samples, such as
the fraction of the day people spend
watching television.

If parameter is non-numeric,
CHISQ.INV returns the #VALUE!
error value.

If probability < 0 or probability > 1,
CHISQ.INV returns the #NUM! error
value.

If deg_freedom is not an integer, it
is truncated.

If deg_freedom < 1 or
deg_freedom > 10^10, CHISQ.INV
returns the #NUM! error value.

CHISQ.INV.
RT

Two obligatory
parameters:
the probability
associated with
the chi-squared
distribution and
the number of
degrees of
freedom.

=CHISQ.INV.R
T(probability,
deg_freedom)

Returns the inverse of the right-
tailed probability of the chi-squared
distribution. If probability =
CHISQ.DIST.RT(x,…), then
CHISQ.INV.RT(probability,…) = x.
Use this function to compare
observed results with expected
ones in order to decide whether
your original hypothesis is valid.

If either parameter is non-numeric,
CHISQ.INV.RT returns the #VALUE!
error value.

If probability < 0 or probability > 1,
CHISQ.INV.RT returns the #NUM!
error value.

If deg_freedom is not an integer, it
is truncated.

If deg_freedom < 1, CHISQ.INV.RT
returns the #NUM! error value.
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Given a value for probability,
CHISQ.INV.RT seeks that value x
such that CHISQ.DIST.RT(x,
deg_freedom) = probability. Thus,
precision of CHISQ.INV.RT depends
on precision of CHISQ.DIST.RT.
CHISQ.INV.RT uses an iterative
search technique. If the search has
not converged after 64 iterations,
the function returns the #N/A error
value.

CHISQ.Test Two obligatory
parameters:
array1 specifies
a cell range of
values and
array2 specifies
a second range
of values.

=CHISQ.Test(
array1,
array2)

Returns the test for independence.
CHISQ.TEST returns the value from
the chi-squared (χ2) distribution for

the statistic and the appropriate
degrees of freedom. The first
parameter is an array of observed
frequencies, the second parameter
is an array of estimated
(theoretical) frequencies.

CONDITION
NUMBER

Adds a new
spreadsheet
formula for
calculating the
matrix
condition
number. 

=CONDITION
NUMBER(<cell
range>,
[<matrix
norm>])

Returns the Condition Number (see
explanation on condition number
here:  Condition number -
Wikipedia).

<Cell range> could be any range of
spreadsheet cells, representing the
input matrix (not necessarily the
square one).

<matrix norm> is the optional
parameter indicating which matrix
norm to use and it could be "L1",
"L2", "Lfro", "Linf".  If not specified,
it uses L1-norm.

CONFIDENC
E.NORM

Three required
parameters: 
alpha (the
significance
level used to
compute the
confidence
level.  The
confidence level
equals 100*(1–

=CONFIDENC
E.NORM(alpha
,
standard_dev,
size)

Returns the confidence interval for a
population mean.

https://en.wikipedia.org/wiki/Condition_number
https://en.wikipedia.org/wiki/Condition_number
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alpha)%, or in
other words, an
alpha of 0.05
indicates a 95%
confidence
level),
standard_dev
(the population
standard
deviation for
the data range
and is assumed
to be known),
size (the
sample size).

CONFIDENC
E.T

Three required
parameters: 
alpha (the
significance
level used to
compute the
confidence
level.  The
confidence level
equals 100*(1–
alpha)%, or in
other words, an
alpha of 0.05
indicates a 95%
confidence
level),
standard_dev
(the population
standard
deviation for
the data range
and is assumed
to be known),
size (the
sample size).

=CONFIDENC
E.T(alpha,
standard_dev,
size)

Calculates the width of half the
confidence interval for a Student t's
distribution.

CORREL Two obligatory
parameters:
array1 specifies
a cell range of
values and
array2 specifies

=CORREL(arr
ay1, array2)

Returns the correlation coefficient of
the array1 and array2 cell ranges.
Use the correlation coefficient to
determine the relationship between
two properties. For example, you
can examine the relationship
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a second range
of values.

between a location’s average
temperature and the use of air
conditioners.

If an array or reference parameter
contains text, logical values, or
empty cells, those values are
ignored; however cells with the
zero value are included.

If array1 and array2 have a
different number of data points,
CORREL returns the #N/A error
value.

If either array1 or array2 is empty,
or if s (the standard deviation) of
their values equals zero, CORREL
returns the #DIV/0! error value.

COUNT A list of
parameters

=COUNT(A1:
A4)

=COUNT(1,
5, 8)

Returns the number of cells in a
given range.

COUNTA A list of
parameters

=COUNTA(A1
:A4)

Counts the number of non-empty
cells in a given range.

COUNTBLA
NK

A list of
parameters

=COUNTBLAN
K(A1:E1)

Counts the number of empty cells.

COUNTIF Two
parameters:
the range of
cells and the
condition of
type string.

=COUNTIF(A1
:A7,">2")

Counts the number of nonblank
cells within a range, which meet a
given condition.

COVARIAN
CE.P

Two obligatory
parameters:
array1 specifies
the first cell
range of
integers and
array2 specifies
the second
range of
integers.

=COVARIANC
E.P(array1,
array2)

Returns population covariance, the
average of the products of
deviations for each data point pair in
two data sets. Use covariance to
determine the relationship between
two data sets. For example, you
can examine whether greater
income accompanies greater levels
of education.

The parameters must either be
numbers or be names, arrays, or
references that contain numbers.

If an array or reference parameter
contains text, logical values, or



FCS Express 7 Manual494

© 2023 De Novo Software

empty cells, those values are
ignored; however, cells with the
zero value are included.

If array1 and array2 have different
numbers of data points,
COVARIANCE.P returns the #N/A
error value.

If either array1 or array2 is empty,
COVARIANCE.P returns the #DIV/0!
error value.

COVARIAN
CE.S

Two obligatory
parameters:
array1 specifies
the first cell
range of
integers and
array2 specifies
the second
range of
integers.

=COVARIANC
E.S(array1,
array2)

Returns the sample covariance, the
average of the products of
deviations for each data point pair in
two data sets.

The parameters must either be
numbers or be names, arrays, or
references that contain numbers.

If an array or reference parameter
contains text, logical values, or
empty cells, those values are
ignored; however, cells with the
zero value are included.

If array1 and array2 have different
numbers of data points,
COVARIANCE.S returns the #N/A
error value.

If either array1 or array2 is empty
or contains only 1 data point each,
COVARIANCE.S returns the #DIV/0!
error value.

DEVSQ The first
parameter is
required,
subsequent
numbers are
optional. You
can specify
from 1 to 255
parameters for
which you want
to calculate the
sum of squared
deviations. You
can also use a
single array or

=DEVSQ(num
ber1,
[number2],
…)

Returns the sum of squares of
deviations of data points from their
sample mean.

Parameters can either be numbers
or names, arrays, or references
that contain numbers.

Logical values and text
representations of numbers that
you type directly into the list of
parameters are counted.

If an array or reference parameter
contains text, logical values, or
empty cells, those values are
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a reference to
an array
instead of
parameters
separated by
commas.

ignored; however, cells with the
zero value are included.

Parameters that are error values or
text that cannot be translated into
numbers cause errors.

EXPON.DIS
T

Three
obligatory
parameters:
the value of the
function, the
parameter
value, and the
logical value
that indicates
which form of
the exponential
function to
provide.

If cumulative is
TRUE,
EXPON.DIST
returns the
cumulative
distribution
function;
otherwise, it
returns the
probability
density
function.

=EXPON.DIST
(x, lambda,
cumulative)

Returns the exponential distribution.
Use EXPON.DIST to model the time
between events, such as how long
an automated bank teller takes to
deliver cash. For example, you can
use EXPON.DIST to determine the
probability that the process takes at
most 1 minute.

If x or lambda is non-numeric,
EXPON.DIST returns the #VALUE!
error value.

If x < 0, EXPON.DIST returns the
#NUM! error value.

If lambda is not positive,
EXPON.DIST returns the #NUM!
error value.

F.DIST Four required
parameters:  x
(the value at
which to
evaluate the
function),
deg_freedom1
(the numerator
degrees of
freedom),
deg_freedom2
(the
denominator
degrees of
freedom),

=F.DIST(x,
deg_freedom
1,
deg_freedom
2, cumulative)

Returns the F probability
distribution.  You can use this
function to determine whether two
data sets have different degrees of
diversity.  For example, you can
examine the test scores of men and
women entering high school, and
determine if the variability in the
females is different from that found
in the males.
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cumulative (a
logical value
that determines
the form of the
function.  If
cumulative is
TRUE, F.DIST
returns the
cumulative
distribution
function;  if
FALSE, it
returns the
probability
density
function).

F.DIST.RT Three
obligatory
parameters: x
(the value at
which to
evaluate the
function),
deg_freedom1
(the numerator
degrees of
freedom),
deg_freedom2
(the
denominator
degrees of
freedom).

=F.DIST.RT(x,
deg_freedom
1,
deg_freedom
2)

Calculates the right-tailed probability
distribution (degree of diversity) for
two data sets with given input x. 
Alternately called Fisher-Snedecor
distribution or Snedecor's F
distribution.

F.INV Three
obligatory
parameters:
probability (a
probability
association with
the F
cumulative
distribution),
deg_freedom1
(the numerator
degrees of
freedom),
deg_freedom2

=F.INV(proba
bility,
deg_freedom
1,
deg_freedom
2)

Returns the inverse of the F
probability distribution.  If p =
F.DIST(x,...), then F.INV(p,...) = x. 
The F  distribution can be used in an
F-test that compares the degree of
variability in two data sets.  For
example, you can analyze income
distributions in the U.S. and Canada
to determine whether the two
countries have a similar degree of
income diversity.
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(the
denominator
degrees of
freedom).

F.INV.RT Three
obligatory
parameters:
probability (a
probability
association with
the F
cumulative
distribution),
deg_freedom1
(the numerator
degrees of
freedom),
deg_freedom2
(the
denominator
degrees of
freedom).

=F.INV.RT(pr
obability,
deg_freedom
1,
deg_freedom
2)

Calculates the inverse of the
probability distribution.  Also called
Fisher-Snedecor distribution or
Snedecor's F distribution.  

FISHER One obligatory
parameter: x
(a numeric
value for which
you want the
transformation)
.

=FISHER(x) Returns the Fisher transformation
at x.  This transformation produces
a function that is normally
distributed rather than skewed.  Use
this function to perform hypothesis
testing on the correlation
coefficient.

FISHERINV One obligatory
parameter: y
(the value at
which you want
to perform the
inverse of the
transformation)
.

=FISHERINV(
y)

Returns the inverse of the Fisher
transformation.  Use this
transformation when analyzing
correlations between ranges or
arrays of data.  If y=FISHER(x),
then FISHERINV(y)=x.

FORECAST Three
obligatory
parameters:
the data point
for which you
want to predict
a value, the
dependent

=FORECAST(
x, known_y’s,
known_x’s)

Calculates, or predicts, a future
value by using existing values. The
predicted value is a y-value for a
given x-value. The known values
are existing x-values and y-values,
and the new value is predicted by
using linear regression. You can use
this function to predict future sales,
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array or range
of data, and the
independent
array or range
of data.

inventory requirements, or
consumer trends.

If x is non-numeric, FORECAST
returns the #VALUE! error value.

If known_y’s and known_x’s are
empty or contain different number
of data points, FORECAST returns
the #N/A error value.

If the variance of known_x’s equals
zero, then FORECAST returns the
#DIV/0! error value.

F.Test Two obligatory
parameters:
array1 specifies
a cell range of
values and
array2 specifies
a second range
of values.

=F.Test(array
1,array2)

Returns the result of F-Test, the
two-tailed probability that the
variances in array 1 and array2 are
not significantly different. The
parameters are the first and second
datasets.

FREQUENCYTwo obligatory
parameters: 
data_array (an
array of or
reference to a
set of values
for which you
want to count
frequencies;  if
data_array
contains no
values,
FREQUENCY
returns an
array of zeros),
bins_array (an
array of or
reference to
intervals into
which you want
to group the
values in
data_array;  if
bins_array
contains no
values,

=FREQUENCY
(data_array,
bins_array)

The FREQUENCY function calculates
how often values occur within a
range of values, and then returns a
vertical array of numbers. For
example, use FREQUENCY to count
the number of test scores that fall
within ranges of scores. 

Because FREQUENCY returns an
array, it must be entered as an
array formula .554
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FREQUENCY
returns the
number of
elements in
data_array)

GAMMA The number
parameter is
mandatory.

=GAMMA(nu
mber)

Returns the gamma function value.

If number is not positive, GAMMA
returns the #NUM! error value.

If number contains characters that
are not valid, GAMMA returns the
#VALUE! error value.

GAMMA.DIS
T

Four
mandatory
parameters: X
– the value at
which you want
to evaluate the
distribution;
Alpha and Beta
are parameters
to the
distribution;
Cumulative is a
logical value
that determines
the form of the
function.

=GAMMA.DIS
T(x, alpha,
beta,
cumulative)

Returns the gamma distribution.
You can use this function to study
variables that may have a skewed
distribution. The gamma distribution
is commonly used in queuing
analysis.

If x, alpha, or beta is non-numeric,
GAMMA.DIST returns the #VALUE!
error value.

If x is negative, GAMMA.DIST
returns the #NUM! error value.

If either alpha or beta is not
positive, GAMMA.DIST returns the
#NUM! error value.

If beta = 1, GAMMA.DIST returns
the standard gamma distribution.

If cumulative is TRUE, GAMMA.DIST
returns the cumulative distribution
function; if FALSE, it returns the
probability density function.

GAMMA.INVThree
mandatory
parameters:
Probability is
the probability
associated with
the gamma
distribution;
Alpha and beta
are parameters
to the
distribution.

=GAMMA.INV
(probability,

alpha, beta)

Returns the inverse of the gamma
cumulative distribution. If p =
GAMMA.DIST(x, …), then
GAMMA.INV(p, …) = x. You can use
this function to study a variable
whose distribution may be skewed.

If beta = 1, GAMMA.INV returns the
standard gamma distribution.

If any parameter is a text string,
GAMMA.INV returns the #VALUE!
error value.
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If the probability is either negative
or higher than 1, GAMMA.INV
returns the #NUM! error value.

If either alpha or beta is not
positive, GAMMA.INV returns the
#NUM! error value.

Given a value for the probability,
GAMMA.INV seeks that value x such
that GAMMA.DIST(x, alpha, beta,
TRUE) = probability. Thus, the
precision of GAMMA.INV depends on
precision of GAMMA.DIST.

GAMMALN A single
mandatory
parameter of
double type,
which is the
value for which
you want to
calculate
GAMMALN.

=GAMMALN(X
)

Returns the natural logarithm of the
gamma function, G(x).

If x is non-numeric, GAMMALN
returns the #VALUE! error value.

If x is not positive, GAMMALN
returns the #NUM! error value.

The number e raised to the
GAMMALN(i) power, where i is an
integer, returns the same result as
(I – 1)!.

GAMMALN.
PRECISE

A single
mandatory
parameter of
double type,
which is the
value for which
you want to
calculate the
natural
logarithm of the
gamma
function.

=GAMMALN.P
RECISE(x)

Returns the natural logarithm of the
gamma function, G(x).

If x is non-numeric,
GAMMALN.PRECISE returns the
#VALUE! error value.

If x is not positive,
GAMMALN.PRECISE returns the
#NUM! error value.

The number e raised to the
GAMMALN.PRECISE(i) power, where
i is an integer, returns the same
result as (I – 1)!.

GAUSS The z
parameter is
mandatory and
specifies a
number.

=GAUSS(z) Calculates the probability that a
member of a standard normal
population will fall between the
mean and z standard deviations
from the mean.

If z is not a valid number, GAUSS
returns the #NUM! error value.

If z is not a valid data type, GAUSS
returns the #VALUE! error value.
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Because NORM.S.DIST(0, True)
always returns 0.5, GAUSS(z) will
always be 0.5 less than
NORM.S.DIST(z, True).

GEOMEAN Up to 255
parameters, for
which you
calculate the
mean. Only the
first parameter
is mandatory.
You can also
use a single
array instead of
number of
parameters.

=GEOMEAN(n
umber1,
[number2],
…)

Returns the geometric mean of an
array or range of positive data. For
example, you can use GEOMEAN to
calculate average growth rate given
compound interest with variable
rates.

Parameters can either be numbers
or names, arrays, or references
that contain numbers.

Logical values and text
representations of numbers that
you type directly into the list of
parameters are counted.

If an array or reference parameter
contains text, logical values, or
empty cells, those values are
ignored; however, cells with the
zero value are included.

Error values or text strings that
cannot be translated into numbers
cause errors, if you use them as
parameters.

If any data point is not positive,
GEOMEAN returns the #NUM! error
value.

Grubbs.Test One obligatory
parameter:
array1 specifies
a cell range of
data.

=GRUBBS.TE
ST(array1)

Performs the Grubbs' test for
outliers. Test is used to detect
outliers in a univariate dataset. It is
based on the assumption of
normality. That is, you should first
verify your data can be reasonably
approximated by a normal
distribution before applying the
Grubbs' test. The parameter is the
dataset.

HARMEAN One required
parameter: 
number1 (the
first value or
range of the
population)

=HARMEAN(n
umber1,
[number2], ...
)

Returns the harmonic mean of a
data set. The harmonic mean is the
reciprocal of the arithmetic mean of
reciprocals.
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One optional
parameter: 
number2
(additional
values or
ranges to
include in the
population)

HYPGEOM.D
IST

Five obligatory
parameters:
the number of
successes in
the sample, the
size of the
sample, the
number of
successes in
the population,
the population
size, and the
logical value
that determines
the form of the
function.

If cumulative is
TRUE, then
HYPGEOM.DIST
returns the
cumulative
distribution
function;
otherwise, it
returns the
probability
mass function.

=HYPGEOM.D
IST(sample_s,
number_sam
ple,
population_s,
number_pop,
cumulative)

Returns the hypergeometric
distribution. HYPGEOM.DIST returns
the probability of a given number of
sample successes, given the sample
size, population successes, and
population size. Use HYPGEOM.DIST
for problems with a finite
population, where each observation
is either a success or a failure, and
where each subset of a given size is
chosen with equal likelihood.

All parameters are truncated to
integers.

If any parameter is non-numeric,
HYPGEOM.DIST returns the
#VALUE! error value.

If sample_s < 0 or sample_s is
greater than the lesser of
number_sample or population_s,
HYPGEOM.DIST returns the #NUM!
error value.

If number_sample is not positive or
number_sample >
number_population, HYPGEOM.DIST
returns the #NUM! error value.

If population_s is not positive or
population_s > number_population,
HYPGEOM.DIST returns the #NUM!
error value.

If number_pop is not positive,
HYPGEOM.DIST returns the #NUM!
error value.

INTERCEPT Two obligatory
parameters:
the dependent

=INTERCEPT(
known_y’s,
known_x’s)

Calculates the point at which a line
will intersect the y-axis by using
existing x-values and y-values. The
intercept point is based on a best-fit
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and
independent
sets of
observations or
data.

regression line plotted through the
known x-values and known y-
values. Use the INTERCEPT function
when you want to determine the
value of the dependent variable
when the independent variable is 0
(zero). For example, you can use
the INTERCEPT function to predict a
metal’s electrical resistance at a
certain temperature when your data
points were taken at room
temperature and higher.

The parameters should be either
numbers or names, arrays, or
references that contain numbers.

If an array or reference parameter
contains text, logical values, or
empty cells, those values are
ignored; however, cells with the
zero value are included.

If known_y’s and known_x’s
contain a different number of data
points or contain no data points,
INTERCEPT returns the #N/A error
value.

KS.Test Two obligatory
parameters:
array1 specifies
a cell or cell
range of values
and array2
specifies a
second cell or
cell range of
values. Two
optional
parameters:
Tailing and
alpha
(significance).
For tailing, a
value of 0=two
tailed, 1=right
tailed, 2=left
tailed. Alpha
may be an

=KS.TEST(arr
ay1, array2)

or

=KS.TEST(arr
ay1, array2,
0|1|2, Alpha)

Performs two-sample Kolmogorov-
Smirnov goodness of fit test on
independent random samples Data1
and Data2. Test determines if Data1
and Data2 samples are drawn from
the same continuous population. 
The mandatory parameters are the
first and second data sets. The
optional parameters are tailing and
alpha (significance) 
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significance
level. 

KURT One required
parameter: 
number1 (the
first value or
range of the
dataset)

One optional
parameter: 
number2
(additional
values or
ranges to
include in the
dataset)

=KURT(numb
er1,
[number2], ...
)

Returns the kurtosis of a data set.
Kurtosis characterizes the relative
peakedness or flatness of a
distribution compared with the
normal distribution. Positive kurtosis
indicates a relatively peaked
distribution. Negative kurtosis
indicates a relatively flat distribution.

LARGE Two
parameters:
the array or
range of data
for which you
want to
determine the
k-th largest
value. K is the
position (from
the largest) in
the array or cell
range of data
to return.

=LARGE(array
, k)

Returns the k-th largest value in a
data set. You can use this function
to select a value based on its
relative standing. For example, you
can use LARGE to return the
highest, runner-up, or third-place
score.

If array is empty, LARGE returns the
#NUM! error value.

If k is not positive or if k is greater
than the number of data points,
LARGE returns the #NUM! error
value.

If n is the number of data points in a
range, then LARGE(array, 1) returns
the largest value, and LARGE(array,
n) returns the smallest value.

Lilliefors.Te
st

One obligatory
parameter:
array1 specifies
a cell range of
values.

=LILLIEFORS.
TEST(array1)

Performs the Lilliefors goodness of
fit test to a normal distribution with
unknown parameters mu and
sigma, and returns the p-value for α
= 0.05. The parameter is the data
set. A minimum of 4 values must be
present to calculate. 

LOGNORM.
DIST

Four obligatory
parameters: 
x(the value at

=LOGNORM.D
IST(x, mean,

Returns the lognormal distribution
of x, where ln(x) is normally
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which to
evaluate the
function), mean
(the mean of
ln(x)),
standard_dev
(the standard
deviation of
ln(x),
cumulative (a
logical value
that determines
the form of the
function.  If
cumulative is
TRUE,
LOGNORM.DIST
returns the
cumulative
distribution
function;  if
FALSE, it
returns the
probability
density
function).

standard_dev,
cumulative)

distributed with parameters Mean
and Standard_dev.

LOGNORM.I
NV

Three
obligatory
parameters: 
probability (a
probability
associated with
the lognormal
distribution),
 mean (the
mean of ln(x)),
standard_dev
(the standard
deviation of
ln(x).

=LOGNORM.I
NV(probability
, mean,
standard_dev
)

Returns the inverse of the 
lognormal cumulative distribution
function of x, where ln(x) is
normally distributed with
parameters Mean and
Standard_dev.  If P =
LOGNORM.DIST(x,...) then
LOGNORM.INV(p,...)=x.

MannWhitne
y.Test

Five obligatory
parameters:
array1 specifies
a cell or range
of cells for data
set 1, array2

=MANNWHIT
NEY.TEST(arr
ay1,
array2,hypoth
esis type,

Performs the non-parametric test
of the null hypothesis, that two
samples come from populations of
equal means, against an alternative
hypothesis, especially that a
particular population has a larger
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specifies a cell
or range of cells
for data set 2,
the hypothesis
type, the
significance
level, and the
approximation.

alpha,approxi
mation)

mean than the other one. It
operates under the assumption that
all the observations from both
groups are independent of each
other.  Will evaluate to TRUE when
failing to reject the null hypothesis
or FALSE when rejecting the null
hypothesis. 

(Credit: Wikipedia)

The variables for the function are as
follows:

[Array1...] - cell range of values
for first data set

[Array2...] - cell range of values
for second data set

Hypothesis Type - 0 for two-
tailed,  1 for right-tailed, or 2 for
left-tailed

Alpha - the significance level for
which to test (i.e. 0.05)

Use Normal Approximation -
True (or 1)/False (or 0)

MAX A list of
parameters

=MAX(A1:D1)

=MAX(A1,
100, C2)

Returns the largest parameter
value.

MAXA From 1 to 255
parameters.
Value1 is the
mandatory
parameter for
which you want
to find the
largest value;
the following
values from 2
to 255 are
optional
parameters for
which you want
to find the
largest value.

=MAXA(value
1, [value2],
…)

Returns the largest value in a list of
parameters. Parameters can be the
following: numbers; names, arrays,
or references that contain numbers;
text representations of numbers;
logical values, such as TRUE and
FALSE, in a reference.

Logical values and text
representations of numbers that
you type directly into the list of
parameters are counted.

If an parameter is an array or
reference, only values in that array
or reference are used. Empty cells
and text values in the array or
reference are ignored.

https://en.wikipedia.org/wiki/Mann%E2%80%93Whitney_U_test
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If the parameters contain no values,
MAXA returns 0 (zero).

If you do not want to include logical
values and text representations of
numbers in a reference s part of the
calculation, use the MAX function
instead.

MEDIAN From 1 to 255
parameters.
Only the
number1 is
required,
subsequent
numbers are
optional.

=MEDIAN(nu
mber1,
[number2],
…)

Returns the median of the given
numbers. The median is the number
in the middle of a set of numbers.

Note that the MEDIAN function
measures central tendency, which is
the location of the center of a group
of numbers in a statistical
distribution.

MIN A list of
parameters

=MIN(A1:D1)

=MIN(0, C2)

Returns the smallest parameter
value.

MINA From 1 to 255
parameters.
Only the value1
is required,
subsequent
values are
optional.

=MINA(numb
er1,
[number2],
…)

Returns the smallest value in a list
of parameters, including members,
text, and logical values. Parameters
can be the following: numbers;
names, arrays, or references that
contain numbers; text
representations of numbers; logical
values, such as TRUE and FALSE, in
a reference.

Logical values and text
representations of numbers that
you type directly into the list of
parameters are counted.

If an parameter is an array or
reference, only values in that array
or reference are used. Empty cells
and text values in the array or
reference are ignored.

If the parameters contain no values,
MINA returns 0 (zero).

If you do not want to include logical
values and text representations of
numbers in a reference s part of the
calculation, use the MIN function
instead.

NEGBINOM.
DIST

Four obligatory
parameters: 

=NEGBINOM.
DIST(number

Returns the negative binomial
distribution, the probability that
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number_f (the
number of
failures),
number_s (the
threshold
number of
successes),
probability_s
(the probability
of a success),
cumulative (a
logical value
that determines
the form of the
function. If
cumulative is
TRUE,
NEGBINOM.DIS
T returns the
cumulative
distribution
function; if
FALSE, it
returns the
probability
density
function.)

_f, number_s,
probability_s,
cumulative)

there will be Number_f failures
before the Number_s-th success,
with Probability_s probability of a
success.

NORM.DIST Four obligatory
parameters:
the value for
which you want
the distribution,
the arithmetic
mean of the
distribution, the
standard
deviation of the
distribution, and
the logical value
that determines
the form of the
function.

If cumulative is
TRUE,
NORM.DIST
returns the

=NORM.DIST(
x, mean,
standard_dev,
cumulative)

Returns the normal distribution for
the specified mean and standard
deviation. This function has a very
wide range of applications in
statistics, including hypothesis
testing.

If mean or standard_dev is non-
numeric, NORM.DIST returns the
#VALUE! error value.

If standard_dev is not positive,
NORM.DIST returns the #NUM!
error value.

If mean = 0, standard_dev = 1, and
cumulative = TRUE, NORM.DIST
returns the standard normal
distribution, NORM.S.DIST.
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cumulative
distribution
function;
otherwise, it
returns the
probability
mass function.

NORM.INV Three
mandatory
parameters:
the probability
corresponding
to the normal
distribution, the
arithmetic
mean of the
distribution, and
the standard
deviation of the
distribution.

=NORM.INV(p
robability,
mean,
standard_dev
)

Returns the inverse of the normal
cumulative distribution for the
specified mean and standard
deviation.

If any parameter is non-numeric,
NORM.INV returns the #VALUE!
error value.

If probability is not positive or if
probability > 1, NORM.INV returns
the #NUM! error value.

If standard_dev is not positive,
NORM.INV returns the #NUM! error
value.

If mean = 0 and standard_dev = 1,
NORM.INV uses the standard
normal distribution.

Given a value for probability,
NORM.INV seeks that value x such
that NORM.DIST(x, mean,
standard_dev, TRUE) = probability.
Thus, precision of NORM.INV
depends on precision of
NORM.DIST.

NORM.S.DI
ST

Two mandatory
parameters:
the value for
which you want
the distribution,
and the
cumulative
logical value
that determines
the form of the
function.

If cumulative is
TRUE,
NORM.S.DIST
returns the

=NORM.S.DIS
T(z,
cumulative)

Returns the standard normal
distribution (has a mean of zero
and a standard deviation of one).
Use this function in place of a table
of standard normal curve areas.

If z is non-numeric, NORM.S.DIST
returns the #VALUE! error value.
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cumulative
distribution
function;
otherwise, it
returns the
probability
mass function.

NORM.S.IN
V

The probability
parameter is
mandatory.

=NORM.S.INV
(probability)

Returns the inverse of the standard
normal cumulative distribution. The
distribution has a mean of zero and
a standard deviation of one.

If probability is non-numeric,
NORM.S.INV returns the #VALUE!
error value.

If probability is not positive or if
probability >= 1, NORM.S.INV
returns the #NUM! error value.

Given a value for probability,
NORM.S.INV seeks that value z that
NORM.S.DIST(z, TRUE) =
probability. Thus, precision of
NORM.S.INV depends on precision
of NORM.S.DIST. NORM.S.INV uses
an iterative search technique.

PEARSON Two mandatory
parameters:
array1 and
array2 which
represent two
sets of
independent
and dependent
values,
respectively.

=PEARSON(ar
ray1, array2)

Returns the Pearson product
moment correlation coefficient, r, a
dimensionless index that ranges
from –1.0 to 1.0 inclusive and
reflects the extent of a linear
relationship between two data sets.

The parameters must be either
numbers or names, array
constants, or references that
contain numbers.

If an array or reference parameter
contains text, logical values, or
empty cells, those values are
ignored; however, cells with the
zero value are included.

If array1 and array2 are empty or
have a different number of data
points, PEARSON returns the #N/A
error value.
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PERCENTIL
E.INC

Two mandatory
parameters:
the array or
range of data
that defines
relative
standing, and
the percentile
value in the
range 0..1,
inclusive.

=PERCENTILE.
INC(array, k)

Returns the k-th percentile of values
in a range. You can use this function
to establish a threshold of
acceptance. For example, you can
decide to examine candidates who
score above 90th percentile.

If array is empty, PERCENTILE.INC
returns the #NUM! error value.

If k is non-numeric,
PERCENTILE.INC returns the
#VALUE! error value.

If k is < 0 or if k > 1,
PERCENTILE.INC returns the #NUM!
error value.

If k is not a multiple of 1/(n – 1),
PERCENTILE.INC interpolates to
determine the value at the k-th
percentile.

PERCENTIL
E.EXC

Two mandatory
parameters:
the array or
range of data
that defines
relative
standing, and
the percentile
value in the
range 0..1,
exclusive.

=PERCENTILE.
EXC(array, k)

Returns the k-th percentile of values
in a range, where k is in the range
0..1, exclusive.

If array is empty, PERCENTILE.EXC
returns the #NUM! error value.

If k is non-numeric,
PERCENTILE.EXC returns the
#VALUE! error value.

If k is not positive or if k is equal to
or exceeds 1, PERCENTILE.EXC
returns the #NUM! error value.

If k is not a multiple of 1/(n – 1),
PERCENTILE.EXC interpolates to
determine the value at the k-th
percentile.

PERCENTILE.EXC will interpolate
when the value for the specified
percentile lies between two values
in the array. If it cannot interpolate
for the percentile, specified by the k
parameter, the
ExpressSpreadSheet returns
#NUM! error.

PERCENTIL
EPLOT

Four
mandatory
parameters:

=PERCENTILE
PLOT(plot_nu
mber,"axis",o

Returns the k-th percentile of the
distribution displayed in a plot.
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the Plot
number, the
axis (in
quotes), the
overlay
number, the
percentile
(inclusive).

verlay_numbe
r,k)

Plot_number must be an integer
value greater than, or equal to, 1.

"axis" must be a text string (in
quotes) between “X”, “X axis”,
“XAxis”, “Y”, “Y axis”, or “YAxis”.

Overlay_number must be an integer
value greater than, or equal to, 1.

k is the percentile (inclusive) and
must be an integer value between 0
and 100.

If the argument types are not
correct, the PERCENTILEPLOT
function returns the #VALUE! error
value.

PERCENTRA
NK.EXC

Two required
parameters: 
array (the array
or range of
data with
numeric values
that defines
relative
standing), x
(the value for
which you want
to know the
rank)

One optional
parameter: 
significance (a
value that
identifies the
number of
significant digits
for the returned
percentage
value. If
omitted,
PERCENTRANK.
EXC uses three
digits (0.xxx)).

=PERCENTRA
NK.EXC(array,
x,
[significance])

Returns the rank of a value in a
data set as a percentage (0..1,
exclusive) of the data set.

PERCENTRA
NK.INC

Two required
parameters: 
array (the array

=PERCENTRA
NK.INC(array,

Returns the rank of a value in a
data set as a percentage (0..1,
inclusive) of the data set.
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or range of
data with
numeric values
that defines
relative
standing), x
(the value for
which you want
to know the
rank)

One optional
parameter: 
significance (a
value that
identifies the
number of
significant digits
for the returned
percentage
value. If
omitted,
PERCENTRANK.
EXC uses three
digits (0.xxx)).

x,
[significance])

PERMUT Two mandatory
parameters:
integer values
that describe
the number of
objects and the
number of
objects in each
permutation.

=PERMUT(nu
mber,
number_chos
en)

Returns the number of
permutations for a given number of
objects that can be selected from
number objects. A permutation is
any set or subset of objects or
events where internal order is
significant. Permutations are
different from combinations, for
which the internal order is not
significant. Use this function for
lottery-style probability calculations.

Both of the accepted parameters
are truncated to integers.

If number or number_chosen is
non-numeric, PERMUT returns the
#VALUE! error value.

If number is not positive or if
number_chosen is negative,
PERMUT returns the #NUM! error
value.
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If number < number_chosen,
PERMUT returns the #NUM! error
value.

PERMUTATI
ONA

Two required
parameters: 
number (an
integer that
describes the
total number of
objects),
number_chose
n (an integer
that describes
the number of
objects in each
permutation)

=PERMUTATI
ONA(number,
number_chos
en)

Returns the number of
permutations for a given number of
objects (with repetitions) that can
be selected from the total objects.

PHI One required
parameter: X
(the number for
which you want
the density of
the standard
normal
distribution.)

=PHI(x) Returns the value of the density
function for a standard normal
distribution.

POISSON.D
IST

Three
mandatory
parameters:
the number of
events, the
expected
numeric value,
and the
cumulative
logical value
that determines
the form of the
probability
distribution
returned.

If cumulative is
TRUE,
POISSON.DIST
returns the
cumulative
Poisson

=POISSON.DI
ST(x, mean,
cumulative)

Returns the Poisson distribution. A
common application of the Poisson
distribution is predicting the number
of events over a specific time, such
as the number of cars arriving at a
toll plaza in 1 minute.

If x is not an integer, it is truncated.

If x or mean is non-numeric,
POISSON.DIST returns the #VALUE!
error value.

If x < 0, POISSON.DIST returns the
#NUM! error value.

If mean < 0, POISSON.DIST returns
the #NUM! error value.
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probability that
the number of
random events
occurring will
fall between
zero and x
inclusive;
otherwise, it
returns the
Poisson
probability
mass function
that the
number of
events
occurring will be
exactly x.

PROB Three required
parameters:  

x_range (the
range of
numeric values
of x with which
there are
associated
probabilities),
prob_range (a
set of
probabilities
associated with
values in
x_range),
lower_limit (the
lower bound on
the value for
which you want
a probability)

One optional
parameter:  

upper_limit (the
optional upper
bound on the
value for which
you want a
probability)

=PROB(x_ran
ge,
prob_range,
lower_limit,
[upper_limit])

Returns the probability that values
in a range are between two limits. If
upper_limit is not supplied, returns
the probability that values in
x_range are equal to lower_limit.
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QUARTILE.I
NC

Two mandatory
parameters:
the array or cell
range of
numeric values
for which you
want the
quartile value,
and the quart
that indicates
which value to
return.

If quart = 0,
QUARTILE.INC
returns the
minimum value.

If quart = 1,
QUARTILE.INC
returns the first
quartile (25th
percentile).

If quart = 2,
QUARTILE.INC
returns the
median value
(50th
percentile).

If quart = 3,
QUARTILE.INC
returns the
third quartile
(75th
percentile).

If quart = 4,
QUARTILE.INC
returns the
maximum
value.

=QUARTILE.IN
C(array,
quart)

Returns the quartile of a data set,
based on percentile values from
0..1, inclusive. Quartiles often are
used in sales and survey data to
divide populations into groups. For
example, you can use
QUARTILE.INC to find the top 25
percent of incomes in a population.

If array is empty, QUARTILE.INC
returns the #NUM! error value.

If quart is not an integer, it is
truncated.

If quart < 0 or if quart > 4,
QUARTILE.INC returns the #NUM!
error value.

MIN, MEDIAN, and MAX return the
same value as QUARTILE.INC when
quart is equal to 0 (zero), 2, and 4,
respectively.

QUARTILE.
EXC

Two mandatory
parameters:
the array or cell
range of
numeric values
for which you
want the

=QUARTILE.E
XC(array,
quart)

Returns the quartile of the data set,
based on percentile values from
0..1, exclusive.

If array is empty, QUARTILE.EXC
returns the #NUM! error value.

If quart is not an integer, it is
truncated.
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quartile value,
and the quart
that indicates
which value to
return.

If quart is not positive or if quart
equals to or exceeds 4,
QUARTILE.EXC returns the #NUM!
error value.

MIN, MEDIAN, and MAX return the
same value as QUARTILE.EXC when
quart is equal to 0 (zero), 2, and 4,
respectively.

RANK.AVG Two mandatory
parameters:
the number
whose rank
you want to
find, and the ref
parameter
specifies an
array of, or a
reference to, a
list of numbers.

Additionally,
you can set the
way of ranking
the number as
the order
parameter.

=RANK.AVG(n
umber, ref,
[order])

Returns the rank of a number in a
list of numbers: its size relative to
other values in the list. If more than
one value has the same rank, the
average rank is returned.

If order is 0 (zero) or omitted, the
ExpressSpreadSheet ranks
number as if ref were a list sorted in
descending order.

If order is any non-zero value, the
ExpressSpreadSheet ranks
number as if ref were a list sorted in
ascending order.

RANK.EQ Two mandatory
parameters:
the number
whose rank
you want to
find, and the ref
parameter
specifies an
array of, or a
reference to, a
list of numbers.

Additionally,
you can set the
way of ranking
the number as
the order
parameter.

=RANK.EQ(nu
mber, ref,
[order])

Returns the rank of a number in a
list of numbers. Its size is relative to
other values in the list; if more than
one value has the same rank, the
top rank of that set of values is
returned. If you were to sort the
list, the rank of the number would
be its position.

If order is 0 (zero) or omitted, the
ExpressSpreadSheet ranks
number as if ref were a list sorted in
descending order.

If order is any non-zero value, the
ExpressSpreadSheet ranks
number as if ref were a list sorted in
ascending order.

RANK.EQ gives duplicate numbers
the same rank. However, the
presence of duplicate numbers
affects the ranks of subsequent
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numbers. For example, in a list of
integers sorted in ascending order, if
the number 10 appears twice and
has a rank of 5, then 11 would
have a rank of 7 (no number would
have a rank of 6).

For some purposes one might want
to use a definition of rank that
takes ties into account. In previous
example, you would want a revised
rank of 5.5 for the number 10. This
can be done by adding the following
correction factor to the value
returned by RANK.EQ. This
correction factor is appropriate oth
for the case where rank is
calculated in descending order
(order = 0 or omitted) or ascending
order (order = non-zero value).

Correction factor for tied
ranks=[COUNT(ref) + 1 –
RANK.EQ(number, ref, 1)]/2.

REGRESSIO
NPLOTXTOY

Three
mandatory
parameters:
the Plot number
of a regression
plot (numeric),
the overlay
number of a
regression fit
(numeric) and
the X known
value
(numeric).

=REGRESSIO
NPLOTXTOY(p
lot_number,
overlay_numb
er,x_known_
value)

Returns the Y value of the
regression function given the X input
value. Only a single X value is
allowed as input. 

REGRESSIO
NPLOTYTOX

Three
mandatory
parameters:
the Plot number
of a regression
plot (numeric),
the overlay
number of a
regression fit
(numeric) and
the Y known

=REGRESSIO
NPLOTYTOX(p
lot_number,
overlay_numb
er,y_known_
value)

Returns the X value of the
regression function given the Y input
value. Only a single Y value is
allowed as input. 
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value
(numeric).

RSQ Two mandatory
parameters are
two arrays or
ranges of data
points.

=RSQ(known
_y’s,
known_x’s)

Returns the square of the Pearson
product moment correlation
coefficient through data points in
known_y’s and known_x’s. For
more information, refer to the
description of the PEARSON
function. The r-squared value can
be interpreted as the proportion of
the variance in y attributable to the
variance in x.

Parameters can either be numbers
or names, arrays, or references
that contain numbers.

Logical values and text
representations of numbers that
you type directly into the list of
parameters are counted.

If an array or reference parameter
contains text, logical values, or
empty cells, those values are
ignored; however, cells with the
zero value are included.

Parameters that are error values or
text that cannot be translated into
numbers cause errors.

If known_y’s and known_x’s are
empty or have a different number
of data points, RSQ returns the
#N/A error value.

If known_y’s and known_x’s
contain only 1 data point, RSQ
returns the #DIV/0! error value.

SKEW The SKEW
function
accepts from
one to 255
parameters for
which you want
to calculate
skewness. You
can also use a
single array or
a reference to

=SKEW(numb
er1,
[number2], ...
)

Returns the skewness of a
distribution. Skewness characterizes
the degree of asymmetry of a
distribution around its mean.
Positive skewness indicates a
distribution with an asymmetric tail
extending toward more positive
values. Negative skewness indicates
a distribution with an asymmetric
tail extending towards more
negative values.
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an array
instead of
parameters
separated by
commas.

Note that you
must specify at
least one
parameter.

Parameters can either be numbers
or names, arrays, or references
that contain numbers.

Logical values and text
representations of numbers that
you type directly into the list of
parameters are counted.

If an array or reference parameter
contains text, logical values, or
empty cells, those values are
ignored; however, cells with the
zero value are included.

Parameters that are error values or
text that cannot be translated into
numbers cause errors.

If there are fewer than three data
points, or the sample standard
deviation is zero, SKEW returns the
#DIV/0! error value.

SKEW.P The SKEW
function
accepts from
one to 255
parameters for
which you want
to calculate
skewness. You
can also use a
single array or
a reference to
an array
instead of
parameters
separated by
commas.

Note that you
must specify at
least one
parameter.

=SKEW.P(nu
mber1,
[number2],
…)

Returns the skewness of a
distribution based on a population:
a characterization of the degree of
asymmetry of a distribution around
its mean.

Parameters can either be numbers
or names, arrays, or references
that contain numbers.

Logical values and text
representations of numbers that
you type directly into the list of
parameters are counted.

If an array or reference parameter
contains text, logical values, or
empty cells, those values are
ignored; however, cells with the
zero value are included.

SKEW.P uses the standard deviation
of an entire population, not a
sample.

If parameters are values that are
not valid, SKEW.P returns the
#NUM! error value.

If parameters use data types that
are not valid, SKEW.P returns the
#VALUE! error value.
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If there are fewer than three data
points, or the sample standard
deviation is zero, SKEW.P returns
the #DIV/0! error value.

SLOPE Two mandatory
parameters: an
array or cell
range of
numeric
dependent data
points and the
set of
independent
data points.

=SLOPE(kno
wn_y’s,
known_x’s)

Returns the slope of the linear
regression line through data points
in known_y’s and known_x’s. The
slope is the vertical distance divided
by the horizontal distance between
any two points on the line, which is
the rate of change along the
regression line.

The parameters must be either
numbers or names, arrays, or
references that contain numbers.

If an array or reference parameter
contains text, logical values, or
empty cells, those values are
ignored; however, cells with the
zero value are included.

If known_y’s and known_x’s are
empty or have a different number
of data points, SLOPE returns the
#N/A value.

SMALL Two mandatory
parameters: an
array or range
of numerical
data for which
you want to
determine the
k-th smallest
value and the
position (from
the smallest) in
the array or
range of data
to return.

=SMALL(array
, k)

Returns the k-th smallest value in a
data set. Use this function to return
values with a particular relative
standing in a data set.

If array is empty, SMALL returns the
#NUM! error value.

If k is not positive or if k exceeds
the number of data points, SMALL
returns the #NUM! error value.

If n is the number of data points in
array, SMALL(array, 1) equals the
smallest value, and SMALL(array, n)
equals the largest value.

SSMD Six mandatory
parameters:
the mean of
the positive
control, the
mean of the
negative

=SSMD(mean
max,mean
min,n max,n
min,SDmax,S
Dmin)

Short for Strictly Standardized Mean
Difference. Has been used as a
ranking metric for hit selection in
high throughput screening assays.
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control, the
sample size of
the positive
control, the
sample size of
the negative
control, the
standard
deviation of the
positive control,
and the
standard
deviation of the
negative
control.

StainIndex Three
mandatory
parameters:
mean or
median of
positive
population,
mean or
median of
negative
population, and
standard
deviation of
negative
population

=STAININDEX
(mean or
median of
positive
population,me
an or median
of negative
population,sta
ndard
deviation of
negative
population)

Performs a stain index calculation
using the means/medians or
positive and negative populations
and the negative population's
standard deviation based on the
Stain Index formula of (Median of
Positive - Median of Negative) / (SD
of Negative *2).

STDEV.S This function
accepts from 1
to 255
parameters.
Only the
number1 is
required,
subsequent
values are
optional.

You can also
use a single
array or a
reference to an
array instead of
parameters

=STDEV.S(nu
mber1,
[number2],
…)

Estimates the standard deviation
based on a sample. The standard
deviation is a measure of how
widely values are dispersed from
the average value (the mean).

STDEV.S assumes that its
parameters are a sample of the
population. If your data represents
the entire population, then calculate
the standard deviation using the
STDEV.P function instead.

The standard deviation is calculated
using the "n-1" method.
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separated by
commas.

Parameters can either be numbers
or names, arrays, or references
that contain numbers.

Logical values and text
representations of numbers that
you type directly into the list of
parameters are counted.

If an parameter is an array or
reference, only numbers in that
array or reference are counted.
Empty cells, logical values, text, or
error values in the array or
reference are ignored.

Parameters that are error values or
text that cannot be converted into
numbers cause errors.

If you want to include logical values
and text representations of
numbers in a reference as part of
the calculation, use the STDEVA
function instead.

STDEV.P From 1 to 255
parameters.
Only the
number1 is
required,
subsequent
values are
optional.

You can also
use a single
array or a
reference to an
array instead of
parameters
separated by
commas.

=STDEV.P(nu
mber1,
[number2],
…)

Estimates the standard deviation
based on the entire population. The
standard deviation is a measure of
how widely values are dispersed
from the average value (the mean).

STDEV.P assumes that its
parameters are the entire
population. If you data represents a
sample of the population, then
calculate the standard deviation
using STDEV.

For large sample sizes, STDEV.S
and STDEV.P return approximately
equal values.

The standard deviation is calculated
using the "n" method.

Parameters can either be numbers
or names, arrays, or references
that contain numbers.

Logical values, and text
representations of numbers that
you type directly into the list of
parameters are counted.
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If an parameter is an array or
reference, only numbers in that
array or reference are counted.
Empty cells, logical values, text, or
error values in the array or
reference are ignored.

Parameters that are error values or
text that cannot be converted into
numbers cause errors.

If you want to include logical values
and text representations of
numbers in a reference part of the
calculation, use the STDEVPA
function instead.

STDEVA From 1 to 255
parameters.
Only the value1
is required,
subsequent
values are
optional.

You can also
use a single
array or a
reference to an
array instead of
parameters
separated by
commas.

=STDEVA(val
ue1, [value2],
…)

Estimates the standard deviation
based on a sample. The standard
deviation is a measure of how
widely values are dispersed from
the average value (the mean).

STDEVA assumes that its
parameters are a sample of the
population. If your data represents
the entire population, you must
calculate the standard deviation
using STDEVPA instead.

The standard deviation is calculated
using the "n–1" method.

Parameters can be the following:
numbers, names, arrays, or
references that contain numbers;
text representations of numbers, or
logical values, such as TRUE and
FALSE, in a reference.

Parameters that contain TRUE
evaluate as 1; parameters that
contain text or FALSE evaluate as 0
(zero).

If an parameter is an array or
reference, only values in that array
or reference are used. Empty cells
and text values in that array or
reference are ignored.

Parameters that are error values or
text that cannot be translated into
numbers cause errors.
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If you do not want to include logical
values and text representations of
numbers in a reference as part of
the calculation, use the STDEV
function instead.

STDEVPA From 1 to 255
parameters.
Only the value1
is required,
subsequent
values are
optional.

You can also
use a single
array or a
reference to an
array instead of
parameters
separated by
commas.

=STDEVPA(va
lue1,
[value2], …)

Calculates the standard deviation
based on the entire population,
including numbers, text, and logical
values. The standard deviation is a
measure of how widely values are
dispersed from the average value
(the mean).

STDEVPA assumes that its
parameters are the entire
population. If your data represents
a sample of the population, you
must calculate the standard
deviation by using the STDEVA
function.

The standard deviation is calculated
using the "n" method.

Parameters can be the following:
numbers, names, arrays, or
references that contain numbers;
text representations of numbers, or
logical values, such as TRUE and
FALSE, in a reference.

Text representations of numbers
that you type directly into the list of
parameters are counted.

Parameters that contain TRUE
evaluate as 1; parameters that
contain text or FALSE evaluate as 0
(zero).

If an parameter is an array or
reference, only values in that array
or reference are used. Empty cells
and text values in the array or
reference are ignored.

Parameters that are error values or
text that cannot be converted into
numbers cause errors.

If you do not want to include logical
values and text representations of
numbers in a reference as part of
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the calculation, use the STDEVP
function instead.

STEYX Two mandatory
parameters:
the two arrays
or ranges of
dependent and
independent
data points,
respectively.

=STEYX(know
n_y’s,
known_x’s)

Returns the standard error of the
predicted y-value for each x in the
regression. The standard error is a
measure of the amount of error in
the prediction of y for an individual
x.

Parameters can either be numbers
or names, arrays, or references
that contain numbers.

Logical values and text
representations of numbers that
you type directly into the list of
parameters are counted.

In an array or reference parameter
contains text, logical values, or
empty cells, those values are
ignored; however, cells with the
zero value are included.

Parameters that are error values or
text that cannot be converted into
numbers cause errors.

If known_y’s and known_x’s have a
different number of data points,
STEYX returns the #N/A error value.

If known_y’s and known_x’s are
empty or have less than three data
points, STEYX returns the #DIV/0!
error value.

SUM A list of
parameters

=SUM(A1:C1
2)

=SUM(A1,
3.14, 1.57)

Sums values within the list.

SUMSQ A list of
parameters

=SUMSQ(B1:
D1)

=SUMSQ(1,
2, 3, 4)

Sums squares of values within the
list.

T.DIST Three
obligatory
parameters:
the numeric
value at which
to evaluate the

=T.DIST(x,
deg_freedom,
cumulative)

Returns the Student’s left-tailed t-
distribution. The t-distribution is
used in the hypothesis testing of
small sample data sets. Use this
function in place of a table of critical
values for the t-distribution.
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distribution, the
integer value
indicating the
number of
degrees of
freedom, and
the cumulative
logical value
that determines
the form of the
function.

If cumulative is
TRUE, T.DIST
returns the
cumulative
distribution
function;
otherwise, it
returns the
probability
density
function.

If any parameter is non-numeric,
T.DIST returns the #VALUE! error
value.

If deg_freedom < 1, T.DIST returns
an error value. The deg_freedom
parameter should be at no less than
1.

T.DIST.2T Two obligatory
parameters:
the numeric
value at which
to evaluate the
distribution, and
the integer
value that
indicates the
number of
degrees of
freedom.

=T.DIST.2T(x,
deg_freedom)

Returns the two-tailed Student’s t-
distribution. The Student’s t-
distribution is used in the hypothesis
testing of small sample data sets.
Use this function in place of a table
of critical values for the t-
distribution.

If any parameter is non-numeric,
T.DIST.2T returns the #VALUE!
error value.

If deg_freedom < 1, T.DIST.2T
returns the #NUM! error value.

If x < 0, then T.DIST.2T returns the
#NUM! error value.

T.DIST.RT Two obligatory
parameters:
the numeric
value at which
to evaluate the
distribution, and
the integer
value that
indicates the

=T.DIST.RT(x,
deg_freedom)

Returns the right-tailed Student’s t-
distribution. The t-distribution is
used in the hypothesis testing of
small data sets. Use this function in
place of a table of critical values for
the t-distribution.

If any parameter is non-numeric,
T.DIST.RT returns the #VALUE!
error value.
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number of
degrees of
freedom.

If deg_freedom < 1, T.DIST.RT
returns the #NUM! error value.

T.INV Two obligatory
parameters:
the probability
associated with
the Student’s t-
distribution and
the number of
degrees of
freedom with
which to
characterize
the distribution.

=T.INV(proba
bility,
deg_freedom)

Returns the left-tailed inverse of the
student’s t-distribution.

If either parameter is non-numeric,
T.INV returns the #VALUE! error
value.

If probability <= 0 or if probability >
1, T.INV returns the #NUM! error
value.

If deg_freedom is not an integer, it
is truncated.

If deg_freedom < 1, T.INV returns
the #NUM! error value.

T.INV.2T Two obligatory
parameters:
the probability
associated with
the Student’s t-
distribution and
the number of
degrees of
freedom with
which to
characterize
the distribution.

=T.INV.2T(pr
obability,
deg_freedom)

Returns the two-tailed inverse of
the Student’s t-distribution.

If either parameter is non-numeric,
T.INV.2T returns the #VALUE! error
value.

If probability <= 0 or if probability >
1, T.INV.2T returns the #NUM!
error value.

If deg_freedom < 1, T.INV.2T
returns the #NUM! error value.

T.INV.2T returns that value t, such
that P(|X| > t) = probability where
X is a random variable that follows
the t-distribution and P(|X| > t) =
P(X < -t or X > t).

A one-tailed t-value can be returned
by replacing probability with
2*probability. For a probability of
0.05 and degrees of freedom of 10,
the two-tailed value is calculated
with T.INV.2T(0.05, 10), which
returns 2.28139. The one-tailed
value of the same probability and
degrees of freedom can be
calculated with T.INV.2T(2 * 0.05,
10), which returns 1.812462.

Given a value for probability,
T.INV.2T seeks that value x such
that T.DIST.2T(x, deg_freedom, 2)
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= probability. Thus, precision of
T.INV.2T depends on precision of
T.DIST.2T.

TRIMMEAN Two required
parameters: 
array (the array
or range of
values to trim
and average),
percent (the
fractional
number of data
points to
exclude from
the calculation.
For example, if
percent = 0.2,
4 points are
trimmed from a
data set of 20
points (20 x
0.2): 2 from
the top and 2
from the
bottom of the
set)

=TRIMMEAN(
array,
percent)

Returns the mean of the interior of
a data set. TRIMMEAN calculates
the mean taken by excluding a
percentage of data points from the
top and bottom tails of a data set.
You can use this function when you
wish to exclude outlying data from
your analysis.

T.Test Four
mandatory
parameters:
array1 specifies
a cell or range
of cells for data
set 1, array2
specifies a cell
or range of cells
for dataset2,
the hypothesis
type, and the
last to define
paired or
unpaired

=T.TEST(arra
y1,
array2,hypoth
esis type or
tails,type)

It compares Array1 mean value
with Array2 mean value. The
assumption is Number1 and
Number2 variances are equal but
unknown. 

The variables for the function are as
follows:

[Array1...] - cell range of values
for first data set

[Array2...] - cell range of values
for second data set

Hypothesis Type - 1 for one-tailed
(left-tailed) or 2 for two-tailed
Type - 1 for paired data with equal
variance (homoscedastic) (data set
size should be equal), 2 for
unpaired data with equal variance
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(homoscedastic) (data set size do
not have to be equal).

TUKEY Please refer to the Tukey's Test
chapter for more details.

UNIQUE One required
parameter: 
array (the
range or array
from which to
return unique
rows or
columns)

Two optional
parameters: 
by_col (the
by_col
argument is a
logical value
indicating how
to compare. 
TRUE will
compare
columns
against each
other and
return the
unique
columns; 
FALSE (or
omitted) will
compare rows
against each
other and
return the
unique rows).   

exactly_once
(the
exactly_once
argument is a
logical value
that will return
rows or
columns that
occur exactly

=UNIQUE(arr
ay,[by_col],
[exactly_once
])

Returns a list of unique values in a
list or range.

560
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once in the
range or array.
 This is the
database
concept of
unique.  TRUE
will return all
distinct rows or
columns that
occur exactly
once from the
range or array;
 FALSE (or
omitted) will
return all
distinct rows or
columns from
the range or
array).

VAR.P From 1 to 255
parameters.
Only the
number1 is
required,
subsequent
values are
optional.

=VAR.P(numb
er1,
[number2],
…)

Calculates variance based on the
entire population (ignores logical
values and text in the population).

VAR.P assumes that its parameters
are the entire population. If your
data represents a sample of the
population, than calculate the
variance by using the VAR.S
function instead.

Parameters can either be numbers
or names, arrays, or references
that contain numbers.

Logical values, and text
representations of numbers that
you type directly into the list of
parameters are counted.

If an parameter is an array or
reference, only numbers in that
array or reference are counted.
Empty cells, logical values, text or
error values in the array or
reference are ignored.

Parameters that are error values or
text that cannot be translated into
numbers cause errors.
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If you want to include logical values
and text representations of
numbers in a reference as part of
the calculation, use the VARPA
function instead.

VAR.S From 1 to 255
parameters.
Only the
number1 is
required,
subsequent
values are
optional.

=VAR.S(numb
er1,
[number2],
…)

Estimates variance based on a
sample (ignores logical values and
text in the sample).

VAR.S assumes that its parameters
are a sample of the population. If
your data represents the entire
population, then calculate the
variance by using the VAR.P function
instead.

Parameters can either be numbers
or names, arrays, or references
that contain numbers.

Logical values, and text
representations of numbers that
you type directly into the list of
parameters are counted.

If an parameter is an array or
reference, only numbers in that
array or reference are counted.
Empty cells, logical values, text, or
error values in the array or
reference are ignored.

Parameters that are error values or
text that cannot be translated into
numbers cause errors.

If you want to include logical values
or text representations of numbers
in a reference as part of the
calculation, use the VARA function
instead.

VARA From 1 to 255
parameters.
Only the value1
is required,
subsequent
values are
optional.

=VARA(value
1, [value2],
…)

Estimates variance based on a
sample.

VARA assumes that its parameters
are a sample of the population. If
your data represents the entire
population, you must calculate the
variance by using the VARPA
function instead.

Parameters can be the following:
numbers, names, arrays, or
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references that contain numbers;
text representations of numbers, or
logical values, such as TRUE and
FALSE, in a reference.

Logical values and text
representations of numbers that
you type directly into the list of
parameters are counted.

Parameters that contain TRUE
evaluate as 1; parameters that
contain text or FALSE evaluate as 0
(zero).

If an parameter is an array or
reference, only values in that array
or reference are used. Empty cells
and text values in the array or
reference are ignored.

Parameters that are error values or
text that cannot be translated into
numbers cause errors.

If you do not want to include logical
values and text representations of
numbers in a reference as part of
the calculation, use the VAR function
instead.

VARPA From 1 to 255
parameters.
Only the value1
is required,
subsequent
values are
optional.

=VARPA(value
1, [value2],
…)

Calculates variance based on the
entire population.

VARPA assumes that its parameters
are the entire population. If your
data represents a sample of the
population, you must calculate the
variance by using the VARA function
instead.

Parameters can be the following:
numbers, names, arrays, or
references that contain numbers;
text representations of numbers, or
logical values, such as TRUE and
FALSE, in a reference.

Logical values and text
representations of numbers that
you type directly into the list of
parameters are counted.

Parameters that contain TRUE
evaluate as 1; parameters that
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contain text or FALSE, evaluate as
0 (zero).

If an parameter is an array or
reference, only values are used in
that array or reference. Empty cells
and text values in the array or
reference are ignored.

Parameters that are error values or
text that cannot be translated into
numbers cause errors.

If you do not want to include logical
values or text representations of
numbers in a reference as part of
the calculation, use the VARP
function instead.

WEIBULL.D
IST

Four obligatory
parameters:
the value at
which to
evaluate the
function, the
alpha and beta
parameters to
the distribution,
and the
cumulative
parameter that
determines the
form of the
function.

=WEIBULL.DI
ST(x, alpha,
beta,
cumulative)

Returns the Weibull distribution. Use
this distribution in reliability analysis,
such as calculating a device’s mean
time to failure.

If x, alpha, or beta is non-numeric,
WEIBULL.DIST returns the #VALUE!
error value.

If x is negative, the WEIBULL.DIST
function returns the #NUM! error
value.

If either alpha or beta is not
positive, WEIBULL.DIST returns the
#NUM! error value.

Wilcoxon Four
mandatory
parameters:
array1 specifies
a cell or range
of cells for data
set 1, array2
specifies a cell
or range of cells
for data set 2,
hypothesis
type, and the
significance
level

 =Wilcoxon(ar
ray1,
array2,hypoth
esis
type,alpha)

Performs a non-parametric test
that compares two paired groups.
The test calculates the difference
between each set of pairs and
analyzes these differences.  The
Wilcoxon Rank Sum test can be
used to test the null hypothesis that
two populations have the same
continuous distribution. Will evaluate
to TRUE when failing to reject the
null hypothesis or FALSE when
rejecting the null hypothesis. 

(Credit: Investopedia)

http://www.investopedia.com/terms/w/wilcoxon-test.asp
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The variables for the function are as
follows:

[Array1...] - cell range of values
for first data set

[Array2...] - cell range of values
for second data set

Hypothesis Type - 0 for two-
tailed,  1 for right-tailed, or 2 for
left-tailed

Alpha - the significance level for
which to test (i.e. 0.05)

ZPrime Four
mandatory
parameters:
the mean of
the negative
control, the
standard
deviation of the
negative
control, the
mean of the
positive control,
and the
standard
deviation of the
positive control

=ZPRIME(me
an
negative,SD
negative,mea
n positive,SD
positive)

Calculates the Z Factor, which is an
attempt to quantify the suitability of
a particular assay for use in a full-
scale, high-throughput screen by
comparing the Mean and Standard
Deviation of a negative control to
the Mean and Standard Deviation of
a positive control within the
experiment.

Z.Test Two required
parameters:
array (the array
or range of
data against
which to test
x),  x (the
value to test).

One optional
parameter: 
sigma (the
population
(known)
standard
deviation. If
omitted, the
sample
standard

=Z.TEST(arra
y, x, [sigma])

Returns the one-tailed p-value of a
Z-test with standard distribution.
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deviation is
used.)

 

 

Financial functions

Financial functions are designed for financial calculations and analysis. Use them to perform many of the
commonly used financial calculations, such as the calculation of yield, interest rates, investment
valuations, internal rate of return, payments and asset depreciation.

 

 

Mnemonic
s

Operand Type Example Explanation

 

FV Three
mandatory
parameters: the
interest rate per
period, the total
number of
payment periods
in an annuity,
and the payment
made each
period; it cannot
change over the
life of the
annuity.
Typically, pmt
contains principal
and interest but
no other fees or
taxes. If pmt is
omitted, you
must specify the
pv parameter
instead.

Additionally, you
can specify the
lump-sum
amount that a
series of future
payments is
worth right now.

=FV(rate,
nper, pmt,
[pv], [type])

Returns the future value of an
investment.

Make sure that you are consistent
about the units you use for
specifying rate and nper. If you
make monthly payments on a four-
year loan at 12 percent annual
interest, use 12%/12 for rate and
4*12 for nper. If you make annual
payments on the same loan, use
12% for rate and 4 for nper.

For all parameters, cash you pay
out, such as deposits to savings, is
represented by negative numbers;
cash you receive, such as dividend
checks, is represented by positive
numbers.
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If pv is omitted,
it is assumed to
be 0 (zero), and
you must include
the pmt
parameter.

The second
optional
parameter is
type that
indicates when
payments are
due. If type is
omitted, it is
assumed to be
0.

IPMT Four mandatory
parameters
include: the
interest rate per
period, the
period for which
you want to find
the interest and
must be in the
range 1 to nper,
the total number
of payment
periods in an
annuity, and the
lump-sum that a
series of future
payments is
worth right now.

Additionally, you
can specify two
more
parameters that
include: the
future value, or
a cash balance
you want to
attain after the
last payment is
made (if this
parameter is

=IPMT(rate,
per, nper, pv,
[fv], [type])

Returns the interest payment for an
investment for a given period.

Make sure that you are consistent
about the units you use for
specifying rate and nper. If you
make monthly payments on a four-
year loan at 12 percent annual
interest, use 12%/12 for rate and
4*12 for nper. If you make annual
payments on the same loan, use
12% for rate and 4 for nper.

For all parameters, cash you pay
out, such as deposits to savings, is
represented by negative numbers;
cash you receive, such as dividend
checks, is represented by positive
numbers.
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omitted, it is
assumed to be
0), and the type
that indicates
when payments
are due (if type
is omitted, it is
assumed to be
0).

NPER Three
mandatory
parameters
include: the
interest rate per
period, the
payment made
each period
which cannot
change over the
life of annuity,
and the lump-
sum amount
that a series of
future payments
is worth right
now.

Additionally, you
can specify the
cash balance
you want to
attain after the
last payment is
made (if this
parameter is
omitted, it is
assumed to be
0), and the type
that indicates
when payments
are due.

=NPER(rate,
pmt, pv, [fv],
[type])

Returns the number of periods for
an investment based on periodic,
constant payments and a constant
interest rate.

NPV Two mandatory
parameters
include the rate
of discount over
the length of one
period and the

=NPV(rate,
value1,
[value2], …)

Calculates the net present value of
an investment by using a discount
rate and a series of future payments
(negative values) and income
(positive values).
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value1
parameter
specifies the
payments and
income. You can
specify up to
254 value
parameters.

The NPV investment begins one
period before the date of the value1
cash flow and ends with the last
cash flow in the list. The NPV
calculation is based on future cash
flows. If your first cash flow occurs
at the beginning of the first period,
the first value must be added to the
NPV result, not included in the value
parameters.

NPV is similar to the PV function
(present value). The primary
difference between PV and NPV is
that PV allows cash flows to begin
either at the end or at the beginning
of the period. Unlike the variable
NPV cash flow values, PV cash flows
must be constant throughout the
investment. For information about
annuities and financial functions,
refer to the description of the PV
function.

PMT Three
mandatory
parameters
include: the
interest rate per
period, the
payment made
each period
which cannot
change over the
life of annuity,
and the lump-
sum amount
that a series of
future payments
is worth right
now.

Additionally, you
can specify the
cash balance
you want to
attain after the
last payment is
made (if this

=PMT(rate,
nper, pv, [fv],
[type])

Calculates the payment for a loan
based on constant payments and a
constant interest rate.

The payment returned by PMT
includes principal and interest but no
taxes, reserve payments, or fees
sometimes associated with loans.

Make sure that you are consistent
about the units you use for
specifying rate and nper. If you
make monthly payments on a four-
year loan at an annual interest rate
of 12 percent, use 12%/12 for rate
and 4 * 12 for nper. If you make
annual payments on the same loan,
use 12 percent for rate and 4 for
nper.
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parameter is
omitted, it is
assumed to be
0), and the type
that indicates
when payments
are due.

PPMT Four mandatory
parameters
include: the
interest rate per
period, the
period for which
you want to find
the interest and
must be in the
range 1 to nper,
the total number
of payment
periods in an
annuity, and the
lump-sum that a
series of future
payments is
worth right now.

Additionally, you
can specify two
more
parameters that
include: the
future value, or
a cash balance
you want to
attain after the
last payment is
made (if this
parameter is
omitted, it is
assumed to be
0), and the type
that indicates
when payments
are due (if type
is omitted, it is
assumed to be
0).

=PPMT(rate,
per, nper, pv,
[fv], [type])

Returns the payment on the
principal for a given period for an
investment based on periodic,
constant payments and a constant
interest rate.

Make sure that you are consistent
about the units you use for
specifying rate and nper. If you
make monthly payments on a four-
year loan at 12 percent annual
interest, use 12%/12 for rate and
4*12 for nper. If you make annual
payments on the same loan, use
12% for rate and 4 for nper.
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PV Three
mandatory
parameters: the
interest rate per
period, the total
number of
payment periods
in an annuity,
and the payment
made each
period; it cannot
change over the
life of the
annuity.
Typically, pmt
contains principal
and interest but
no other fees or
taxes. If pmt is
omitted, you
must specify the
pv parameter
instead.

Additionally, you
can specify the
lump-sum
amount that a
series of future
payments is
worth right now.
If pv is omitted,
it is assumed to
be 0 (zero), and
you must include
the pmt
parameter.

The second
optional
parameter is
type that
indicates when
payments are
due. If type is
omitted, it is
assumed to be
0.

=PV(rate,
nper, pmt,
[fv], [type])

Returns the present value of an
investment. The present value is the
total amount that a series of future
payments is worth now. For
example, when you borrow money,
the loan amount is the present value
to the lender.

Make sure that you are consistent
about the units you use for
specifying rate and nper. If you
make monthly payments on a four-
year loan at 12 percent annual
interest, use 12%/12 for rate and
4*12 for nper. If you make annual
payments on the same loan, use
12% for rate and 4 for nper.

An annuity is a series of constant
cash payments made over a
continuous period. For example, a
car loan or a mortgage is an
annuity. For more information, refer
to the description of each annuity
function.

In annuity functions, cash you pay
out, such as a deposit to savings, is
represented by a negative number;
cash you receive, such as a dividend
check, is represented by a positive
number. For example, a $1000
deposit to the bank would be
represented by the parameter –
1000 if you are the depositor and
by the parameter 1000 if you are
the bank.
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Date and Time functions

Use this set of functions to identify the current date, extract a part of the date, convert the DateTime
values to other data types, and perform calculations with the dates.

 

 

Mnemo
nics

Operand Type Example Explanation

 

DATE Three operands
defining the year,
month and day.

=DATE(1900,1,
1)

Calculates the serial number that
represents a specified date.

DATEVAL
UE

The date_text
parameter specifies
a date in the Excel
date format, or a
reference to a cell
that contains text
that represents a
date in the Excel
date format. For
example,
"1/30/2008" or
"30-Jan-2008" are
text strings within
quotation marks
that specify dates.

=DATEVALUE(da
te_text)

The DATEVALUE function converts
a date that is stored as text to a
serial number that the
ExpressSpreadSheet recognizes
as a date.

Like Excel, the
ExpressSpreadSheet stores
dates as sequential serial numbers
so that they can be used in
calculations. By default, January 1,
1900 is a serial number 1, and
January 1, 2008 is serial number
39448 because it is 39447 days
after January 1, 1900.

Most functions automatically
convert date values to serial
numbers.

The DATEVALUE function returns
the #VALUE! error value if the
value of the date_text parameter
falls outside the range of dates
between January 1, 1900 and
December 31, 9999.

DAY One parameter
defining the serial
number of the
required date.

=DAY(TODAY()) Returns the day portion of a given
date.

DAYS Two mandatory
parameters:
start_date and

=DAYS(end_dat
e, start_date)

Returns the number of days
between two dates.
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end_date are two
dates between
which you want to
know the number
of days.

If both date parameters are
numbers, DAYS uses EndDate-
StartDate to calculate the number
of days in between both dates.

If either one of the date
parameters is text, that parameter
is treated as
DATEVALUE(date_text) and
returns an integer value instead of
a time component.

If date parameters are numeric
values that fall outside the range
of valid dates, DAYS returns the
#NUM! error value.

If date parameters are strings that
cannot be parsed as valid dates,
DAYS returns the #VALUE! error
value.

DAYS36
0

Two mandatory
parameters:
start_date and
end_date are two
dates between
which you want to
know the number
of days. If
start_date occurs
after end_date, the
DAYS360 returns a
negative number.

Additionally, you
can specify if the
ExpressSpreadSh
eet should use the
European method
instead of the U.S.
method in the
calculation.

=DAYS360(start
_date,
end_date,
[method])

The DAYS360 function returns the
number of days between two
dates based on a 360-day year
(twelve 30-day months), which is
used in some accounting
calculations. Use this function to
help calculate payments if your
accounting system is based on
twelve 30-day months.

Like Excel, the
ExpressSpreadSheet stores
dates as sequential serial numbers
so that they can be used in
calculations. By default, January 1,
1900 is a serial number 1, and
January 1, 2008 is serial number
39448 because it is 39447 days
after January 1, 1900.

EDATE Two mandatory
parameters:
start_date specifies
the start date, and
months specifies
the number of
months before or

=EDATE(start_d
ate, months)

Returns the serial number of the
date that is the indicated number
of months before or after a
specified date (the start_date).
Use EDATE to calculate maturity
dates or due dates that fall on the
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after start_date. A
positive value for
months yields a
future date; a
negative value
yields a past date.

same day of the month as the
date of issue.

Like Excel, the
ExpressSpreadSheet stores
dates as sequential serial numbers
so that they can be used in
calculations. By default, January 1,
1900 is a serial number 1, and
January 1, 2008 is serial number
39448 because it is 39447 days
after January 1, 1900.

EOMONT
H

Two mandatory
parameters:
start_date
(specifies the start
date), and months
(specifies the
number of months
before or after
start_date). A
positive value for
months yields a
future date; a
negative value
yields a past date.

=EOMONTH(sta
rt_date,
months)

Returns the serial number of the
last day of the month that is the
indicated number of months
before or after start_date. Use
EOMONTH to calculate maturity
dates or due dates that fall on the
last day of the month.

HOUR One parameter
defining the serial
number of the
required date/time
value.

=HOUR(NOW()) Returns the hour portion of a given
date/time value.

ISOWEE
KNUM

The date
parameter is the
date-time code
used by the
ExpressSpreadSh
eet for date and
time calculations.

=ISOWEEKNUM(
date)

Returns the number of ISO week
number of the year for a given
date.

MONTH One parameter
defining the serial
number of the
required date.

=MONTH(TODA
Y())

Returns the month portion of a
given date.

MINUTE One parameter
defining the serial
number of the

=MINUTE(NOW(
))

Returns the minutes portion of a
given date/time value.
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required date/time
value.

NOW No parameters
required.

=NOW() Returns the current time in general
format. You can apply further
formatting to the result of the
function.

SECOND One parameter
defining the serial
number of the
required date/time
value.

=SECOND(NOW
())

Returns the seconds portion of a
given date/time value.

TIME Three parameters
defining hour,
minute and second
parts of a time
value.

=TIME(16, 48,
10)

Returns a decimal number for a
specified time.

TIMEVAL
UE

The time_text
parameter is a text
string specifies a
time in any one of
the Microsoft
Excel® time
formats; for
example, "6:45
PM" and "18:45"
text strings within
quotation marks
that specify time.

=TIMEVALUE(ti
me_text)

Returns the decimal number of the
time represented by a text string.
The decimal number is a value
ranging from 0 (zero) to
0.99988426, representing the
times from 0:00:00 (12:00:00
AM) to 23:59:59 (11:59:59 PM).

Date information in time_text is
ignored.

Time values are a portion of a date
value and represented by a
decimal number (for example,
12:00 PM is represented as 0.5
because it is half of a day).

TODAY No parameters
required.

=TODAY() Returns the serial number of the
current date.

WEEKDA
Y

Two parameters:
the serial number
of the required
date, weekday
base.

=WEEKDAY(TOD
AY())

 

=WEEKDAY(DAT
E( 2002, 12,
1),1) returns
1(Sunday)

Returns the day of the week
corresponding to the specified
date.

The weekday base identifies the
first day of the week and
determines the return value type:

1 or omitted: the first day of the
week is Sunday. The function
returns 1 for Sunday, 2 for
Monday, etc.
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2: the first day of the week is
Monday. The function returns 1 for
Monday, 2 for Tuesday, etc.

3: the first day of the week is
Monday. The function returns 0 for
Monday, 1 for Tuesday, etc.

WEEKNU
M

The serial_number
parameter specifies
a date within the
week. Dates
should be entered
by using the DATE
function, or as
results of other
formulas or
functions.

Additionally, you
can specify the
return_type
parameter that
determines on
which day the
week begins (the
default value is 1).

=WEEKNUM(seri
al_number,
[return_type])

Returns the week number of a
specific date. For example, the
week containing January 1 is the
first week of the year, and is
numbered week 1.

YEAR One parameter
defining the serial
number of the
required date.

=YEAR(TODAY()
)

Returns the year portion of a given
date.

YEARFRA
C

Two mandatory
parameters include
start_date and
end_date that
represent start
date and end date,
respectively.

Additionally, you
can specify which
type of the day
count basis to use.

=YEARFRAC(sta
rt_date,
end_date,
[basis])

Calculates the fraction of the year
represented by the number of
whole days between two dates
(the start_date and end_date
parameters). Use the YEARFRAC
worksheet function to identify the
proportion of a whole year’s
benefits or obligations to assign to
a specific term.

 

 

Text functions

The text functions allow you to work with text strings.
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Mnemon
ics

Operand Type Example Explanation

 

&
(ampersa
nd)

Two parameters of
type string

= "Yellow
"&"river"

Concatenates specified strings.

CHAR The number
parameter allows
you to specify a
number between 1
and 255
representing the
required character.
The character is
from the character
set used by your
computer.

=CHAR(numb
er)

Returns the character specified y a
number. Use CHAR to translate
code page numbers you might get
from files on other types of
computers into characters.

CLEAN The text
parameter
specifies any
worksheet
information from
which you want to
remove non-
printable
characters.

=CLEAN(text) Removes all non-printable
characters from text. Use CLEAN on
text imported from other
applications that contains characters
that may not print with your
operating system. For example, you
can use CLEAN to remove some
low-level computer code that is
frequently at the beginning and end
of data files and cannot be printed.

The CLEAN function was designed to
remove the first 32 nonprinting
characters in the 7-bit ASCII code
(values 0 through 31) from text. In
the Unicode character set, there are
additional nonprinting characters
(values 127, 129, 141, 143, 144,
and 157). By itself, the CLEAN
function does not remove these
additional nonprinting characters.

CODE The text
parameter
specifies the text
for which you want
the code of the
first character.

=CODE(text) Returns a numeric code for the first
character in a text string. The
returned code corresponds to the
character set used by your
computer.
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CONCATE
NATE

A list of strings =CONCATENA
TE("Developer
", " Express")

Joins several text strings in one text
string. An alternative to "&".

DOLLAR Two parameters
defining the value
and the number of
digits to the right
of the decimal
point in the output
string.

=DOLLAR(957
.344, 2)

Converts the number to text using
currency format $#,##0.00_);
($#,##0.00), with the decimals
rounded to the specified number of
places.

EXACT The text1 and
text2 parameters
specify the first
and second text
strings.

=EXACT(text1
, text2)

Compares two text strings and
returns TRUE if they are exactly the
same, FALSE otherwise. EXACT is
case-sensitive but ignores
formatting differences. Use EXACT
to test text being entered into a
document.

FIND The find_text
parameter
specifies the text
you want to find,
the within_text
parameter
specifies the
source text for the
text fragment you
want to find.

Additionally, you
can specify the
character at which
to start the search
as the start_num
parameter. The
first character in
within_text is
character number
1. If you omit
start_num, it is
assumed to be 1.

=FIND(find_te
xt,
within_text,
[start_num])

FIND locates one text string within a
second text string, and returns the
number of the starting position of
the first text string from the first
character of the second text string.
FIND always counts each character,
whether single-byte or double-byte,
as 1, no matter what the default
language setting is.

FIXED The first parameter
of type double is
required. The
second parameter
of type integer is
optional (the

=FIXED(1234.
567, 1)

Rounds the first parameter to the
number of decimals determined by
the second parameter and returns it
as a string. The third parameter
specifies whether to omit commas
in the output string.
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default value is 2).
The third
parameter of type
Boolean is
optional.

LEFT The first parameter
of type string is
required. The
second parameter
of type integer is
optional.

=LEFT(A1)

=LEFT(A1, 3)

Returns the first character or
characters in a text string. The
second parameter defines the
number of characters to extract.
The default value is 1.

LEN One parameter of
type string.

=LEN("ABC") Returns the length of a given string.

LOWER One parameter of
type string.

=LOWER(A1) Converts a string to lowercase.

MID The first parameter
is of type string,
the second and the
third parameters
are of type integer.

=MID("ABC",3
,1)

Returns the substring of a given text
string. The position of the substring
is defined by the second parameter.
The third parameter specifies the
number of characters to extract.

PROPER The text
parameter of the
string type is
mandatory. Text
enclosed in
quotation marks, a
formula that
returns text, or a
reference to a cell
containing the text
you want to
partially capitalize.

=PROPER(text
)

Capitalizes the first letter in a text
string and any other letters in text
that follow any character other than
a letter. Converts all other letters to
lowercase letters.

REPLACE Four mandatory
parameters: the
text in which you
want to replace
some characters,
the position of the
character in
old_text that you
want to replace
with new_text, the
number of
characters in

=REPLACE(old
_text,
start_num,
num_chars,
new_text)

Replaces part of a text string, based
on the number of characters you
specify, with a different text string.

REPLACE always counts each
character, whether single-byte or
double-byte, as 1, no matter what
the default language setting is.
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old_text that you
want REPLACE to
replace with
new_text, and the
text that will
replace a specified
number of
characters in
old_text.

REPT Two obligatory
parameters: the
text you want to
repeat, and the
positive number of
times to repeat
text.

=REPT(text,
number_times
)

Repeats text a given number of
times. Use REPT to fill a cell with a
number of instances of a text string.

If number_times is 0 (zero), REPT
returns "" (empty string).

If number_times is not an integer, it
is truncated.

The result of the REPT function
cannot be longer than 32767
characters, otherwise REPT returns
the #VALUE! error value.

RIGHT The first parameter
of type string is
required. The
second parameter
of type integer is
optional.

=RIGHT(B2,
3)

Returns the last character or
characters in a text string. The
second parameter defines the
number of characters to extract.
The default value is 1.

SEARCH Two obligatory
parameters of
string type.

=SEARCH("n",
"printer")

The SEARCH function locates one
text string with a second text string,
and returns the number of the
starting position of the first text
string from the first character of the
second text string. For example, to
find the position of the letter "n" in
the word "printer", you can use this
function as =SEARCH("n", "printer").

SUBSTIT
UTE

Three obligatory
parameters of
string type plus an
optional
instance_num
parameter that
allows you to
specify what
instance of the old

=SUBSTITUTE
(text,
old_text,
new_text,
[instance_nu
m])

Substitutes new_text for old_text in
a text string. Use SUBSTITUTE when
you want to replace specific text in a
text string; use REPLACE when you
want to replace any text that occurs
in a specific location in a text string.
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text should be
replaced.

T One obligatory
parameter of any
type.

=T(value) Returns the text referred by value.

TEXT Two obligatory
parameters: first is
a numeric value or
a reference to a
cell containing a
numeric value;
second is a
numeric format as
a text string
enclosed in
quotation marks,
for example
"m/d/yyyy" or
"#,##0.00".

=TEXT(A1,
"$0.00")

The TEXT function converts a
numeric value to text and allows
you to specify the display formatting
by using special format strings. This
function is useful in situations where
you want to display numbers in a
more readable format, or you want
to combine numbers with text or
symbols. For example, suppose cell
A1 contains the number 23.5. To
format the number as a dollar
amount, you can use the following
formula: =TEXT(A1, "$0.00")

TRIM One parameter of
string type

=TRIM("
Express
Spread Sheet
")

Removes all spaces from text
except for single spaces between
words.

TRUNC Two parameters:
the number that is
truncated, and the
optional
num_digits
parameter that
specifies the
precision of the
truncation. The
default value for
num_digits is 0
(zero).

=TRUNC(num
ber,
[num_digits])

Truncates a number to an integer by
removing the fractional part of the
number.

UPPER One parameter of
type string.

=UPPER(A1&A
2)

Converts a string to uppercase.

VALUE One obligatory
parameter of
string type.

=VALUE(text) Converts a text string that
represents a number to a member.

Text can be in any of the constant
number, date, or time formats
recognized by the
ExpressSpreadSheet. If text is not
in one of these formats, VALUE
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returns the #VALUE! error value.
You do not generally need to use
the VALUE function in a formula
because the ExpressSpreadSheet
automatically converts text to
numbers as necessary. This function
is provided for compatibility with
other spreadsheet applications.

 

 
 

Information functions

Functions which test the type of a value and return a Boolean result.

 

 

Mnemonics Operand
Type

Example Explanation

 

HASCOMPMAT
RIXBEENCHAN
GED

Two
parameters:
PlotID the
plot identifier
assigned
when
creating the
layout.
Greater than
or equal to
1.
Compensati
on ID
Number the
number
associated
with the
order of
compensatio
ns listed in
the
compensatio
n dialog.

=HASCOMPMATRIXB
EENCHANGED(4,1)

Evaluates if the
compensation matrix has
been changed.  Reports
TRUE for a modified matrix
or FALSE for an unmodified
matrix.

ISBLANK A value of
any type.

=ISBLANK(A1) Returns TRUE if cell is empty.
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ISDATALISTITE
RATIONANDTU
BENAMEEMPTY

Two
parameters:
an integer
value
defining the
Iteration
number and
a text value
(written in
quotes; not
case
sensitive)
defining the
Tube name.

=ISDATALISTITERATI
ONANDTUBENAMEEM
PTY(5,"Tube2")

This function returns TRUE if
the specified Tube in the
specified Iteration is a Blank
tube, or, FALSE otherwise.
Tube is defined by specifying
the Tube name (written in
quotes; not case sensitive).

ISDATALISTITE
RATIONANDTU
BENUMBEREMP
TY

Two integer
parameters:
one  defining
the Iteration
number and
one defining
the Tube
number.

=ISDATALISTITERATI
ONANDTUBENUMBER
EMPTY(5,2)

This function returns TRUE if
the specified Tube in the
specified Iteration is a Blank
tube, or, FALSE otherwise.
Tube is defined by specifying
the Tube number.

ISDATALISTPOS
ITIONEMPTY

An integer
value
referring to
the nth file in
the Data
List.

=ISDATALISTPOSITIO
NEMPTY(3)

This function returns TRUE if
the specified file in the Data
List is a Blank tube, or, FALSE
otherwise.

ISERR A value of
any type.

=ISERR(H1) Returns TRUE if the cell
contains any error value
except #N/A.

ISEVEN A value of
any type.

=ISEVEN(B1) Returns TRUE if the number
is even

ISERROR A value of
any type.

=ISERROR(A7) Returns TRUE if the cell
contains any error value
(#N/A, #VALUE!, #REF!,
#DIV/0!, #NUM!, #NAME?,
or #NULL!).

ISLOGICAL A value of
any type.

=ISLOGICAL(C3) Returns TRUE if the specified
value refers to a logical
value.

ISNA A value of
any type.

=ISNA(E5) Returns TRUE if the cell
contains #N/A (value not



FCS Express 7 Manual554

© 2023 De Novo Software

available) error value.

ISNONTEXT A value of
any type.

=ISNONTEXT(D4) Returns TRUE if the cell does
not contain text. Returns
TRUE for blank cells.

ISNUMBER A value of
any type.

=ISNUMBER(A2) Returns TRUE if the cell
contains a number.

ISTEXT A value of
any type.

=ISTEXT(D1) Returns TRUE if the specified
cell contains text.

ISODD A value of
any type.

=ISODD(A2) Returns TRUE if the number
is odd.

ISTEXT A value of
any type.

=ISTEXT(A1) Returns TRUE if the value is a
text.

N A value of
any type.

=N(F7) Returns a value converted to
a number.

NA A value of
any type.

=NA(B2) Returns the error value
#N/A.

 

Array Formulas

Array formulas allows you to perform complex calculations on multiple arrays.
They are also referred to as "Ctrl-Shift-Enter" or "CSE" formulas, because you
need to press Ctrl+Shift+Enter to enter them.

FCS Express provides two types of array formulas:

Array formulas that perform several
calculations to generate a single
result

1. Click the cell in which you want to enter
the array formula.

2. Enter the formula that you want to use.
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In the example above, the array formula
multiplies each data from the first array
(e.g. A1 from array A1:A10) by the
corresponding data from the second array
(e.g. B1 from array B1:B10) and sum all the
result together.
This is an example of a single-cell array
formula because the formula lives in just
one cell.

3. Press Ctrl+Shift+Enter. The cell
selected in Step 1 will be populated with
the result of the array formula.

Array formulas that calculate
multiple results

To calculate multiple results by using an
array formula, enter the array into a range
of cells that has the exact same number of
rows and columns that you will use in the
array arguments.

1. Select the range of cells in which you
want to enter the array formula. In the
example below, a range of 10 rows have
been selected since each of the selected
arrays contain 10 rows as well.

2. Press F2 on your keyboard so that the
first cell of the selected range enters the
edit mode.

3. Enter the formula that you want to use.
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In the example above, array the formula
multiplies each data from the first array
(e.g. A1 from array A1:A10) by the
corresponding data from the second array
(e.g. B1 from array B1:B10).

4. Press Ctrl+Shift+Enter. Each of the cells
selected in Step 1 will be populated with
the result of the corresponding row.

5.6.4.1 ANOVA - Analysis of Variance

FCS Express allows you to perform single-factor Analysis of Variance (i.e.
"single-factor ANOVA" or "One-way ANOVA") directly within the Integrated
Spreadsheet .

In FCS Express there are four single-factor ANOVA functions that differ in:

416
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1.  Whether they require you to provide data in list form (i.e. ANOVA1.LIST and
ANOVA1.LIST.P functions) or matrix form (i.e. ANOVA1.MATRIX and
ANOVA1.MATRIX.P)

 and

2.  Whether they will output the full set of results one would expect from
Microsoft Excel or simply the significance of the analysis (i.e. the functions
ending in “.P” above).

ANOVA1.LIST and ANOVA1.LIST.P
These functions take either one or three comma-separated arguments in the
order below. The second and third arguments are optional, but either both must
be provided, or none. If neither is provided, the default values will be used.

1. A comma-separated list of three or more groups of data values.
2. A Boolean (“TRUE” or “FALSE”, wither with or without quotes)

indicating whether the first element in each group should be
interpreted as the label. Default is FALSE.

3. A digit (e.g. 0.123) indicating an alpha value. (Note: This is only
relevant for the ANOVA1.LIST function, as it determines the value
of Fcrit.). Default is 0.05.

Here is an example of how to use these functions:

ANOVA1.LIST or ANOVA1.LIST.P
1. If you want to use ANOVA1.LIST.P select a single cell. If you want to

use ANOVA1.LIST select a range of cells 7 columns wide and 12+n
rows tall (where n is the number of data groups). In the example
below, the ANOVA1.LIST formula is run on 3 data groups so the
range of selected cells is 7 columns wide and 15 (i.e. 12+3) rows tall.

2. Press F2 on your keyboard so that the first cell of the selected cells
enters the edit mode.

3. Enter the formula that you want to use. In the example below (Figure
5.230) the ANOVA1.LIST formula with the second and the third
arguments specified is used.
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Figure 5.225 - Example of using ANOVA1.LIST formula with multiple
arguments. 

4. Press Ctrl+Shift+Enter. The area of the spreadsheet selected in Step
1 will be populated with the ANOVA results. In the example below
(Figure 5.231) the ANOVA1.LIST formula is used, thus the full set of
results is displayed.

Figure 5.226 - Results from ANOVA1.LIST formula reference. 

ANOVA1.MATRIX and ANOVA1.MATRIX.P
These functions take either one or four comma-separated arguments in the
order below. The second, third and fourth arguments are optional, but either all
must be provided, or none. If none is provided, their default values will be used.

1. A 2D array of cells spanning at least three three or more groups of
data values (i.e. at least three rows or columns depending on how the
data are organized).  

2. A Boolean (“TRUE” or “FALSE”, either with or without quotes)
indicating whether the data are grouped by columns. Default is TRUE.
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3. A Boolean (“TRUE” or “FALSE”, either with or without quotes)
indicating whether the first element in each group should be
interpreted as the label. Default is FALSE.

4. A numerical quantity (e.g. 0.123) indicating an alpha value. (Note:
This is only relevant for the ANOVA1.MATRIX function, as it
determines the value of Fcrit.). Default is 0.05.

Here is an example of how to use these functions:

ANOVA1.MATRIX or ANOVA.MATRIX.P
1. If you want to use ANOVA1.MATRIX.P select a single cell. If you

want to use ANOVA1.MATRIX select a range of cells 7 columns wide
and 12+n rows tall (where n is the number of data groups). In the
example below, the ANOVA1.MATRIX formula is run on 3 data
groups so the range of selected cells is 7 columns wide and 15 (i.e.
12+3) rows tall.

2. Press F2 on your keyboard so that the first cell of the selected cells
enters the edit mode.

3. Enter the formula that you want to use. In the example below (Figure
5.232) the ANOVA1.MATRIX formula with the second, the third and
the fourth arguments specified is used.

Figure 5.227  - ANOVA1.MATRIX formula with arguments defined. 

4. Press Ctrl+Shift+Enter. The area of the spreadsheet selected in Step
1 will be populated with the ANOVA results. In the example below
(Figure 5.233) the ANOVA1.MATRIX formula is used, thus the full
set of results is displayed.
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Figure 5.228  - Results of ANOVA1.MATRIX forumla reference.

5.6.4.2 Tukey's Test

FCS Express allows you to perform a Tukey's range test, also known as Tukey's
test, directly within the Integrated Spreadsheet .

In FCS Express there are two Tukey's test functions that differ in whether they
require you to provide data in list form (i.e. TUKEY.LIST) or matrix form (i.e.
TUKEY.MATRIX)

TUKEY.LIST
This function will take either one or three comma-separated arguments in the
order below. The second and third arguments are optional, but either both must
be provided, or none. If neither is provided, the default values will be used.

1.  A comma-separated list of three or more groups of data values.
2.  A Boolean (“TRUE” or “FALSE”, wither with or without quotes)

indicating whether the first element in each group should be
interpreted as the label. Default is FALSE.

3.  A digit (e.g. 0.123) indicating an alpha value. (Note: This is only
relevant for the TUKEY.LIST function, as it determines the value of
Fcrit.). Default is 0.05.

Here is an example of how to use this function:

TUKEY.LIST
1. If you want to use TUKEY.LIST select a range of cells 8 columns

wide and (8+n) + (n*(n-1)/2)) rows tall (where n is the number of data

groups). In the example below, the TUKEY.LIST formula is run on 3
data groups so the range of selected cells is 8 columns wide and 14
(i.e. (8+3) + (3*(3-1)/2)) rows tall.

416
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Row Reference Table

Number of groups of data values Number of Rows

3 14

4 18

5 23

6 29

2. Press F2 on your keyboard so that the first cell of the selected cells
enters the edit mode.

3. Enter the formula that you want to use. In the example below (Figure
5.234) the TUKEY.LIST formula with the second and the third
arguments specified is used.

Figure 5.229 - Example of using TUKEY.LIST formula with multiple arguments. 

4.Press Ctrl+Shift+Enter. The area of the spreadsheet selected in Step 1
will be populated with the Tukey's test results. In the example below
(Figure 5.235) the TUKEY.LIST formula is used and the full set of results
are displayed).

Figure 5.230 - Example of results using TUKEY.LIST formula with multiple
arguments.
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TUKEY.MATRIX
This function will take either one or four comma-separated arguments in the
order below. The second, third and fourth arguments are optional, but either all
must be provided, or none. If none is provided, their default values will be used.

1. A 2D array of cells spanning at least three three or more groups of
data values (i.e. at least three rows or columns depending on how the
data are organized).  

2. A Boolean (“TRUE” or “FALSE”, either with or without quotes)
indicating whether the data are grouped by columns. Default is TRUE.

3. A Boolean (“TRUE” or “FALSE”, either with or without quotes)
indicating whether the first element in each group should be
interpreted as the label. Default is FALSE.

4. A numerical quantity (e.g. 0.123) indicating an alpha value. (Note:
This is only relevant for the TUKEY.MATRIX function, as it
determines the value of Fcrit.). Default is 0.05.

Here is an example of how to use this function:

TUKEY.MATRIX 
1.  If you want to use TUKEY.MATRIX select a range of cells 8 columns

wide and (8+n) + (n*(n-1)/2)) rows tall (where n is the number of data

groups). In the example below, the TUKEY.MATRIX formula is run on
3 data groups so the range of selected cells is 8 columns wide and 14
(i.e. (8+3) + (3*(3-1)/2)) rows tall. Please see the row reference
table  above for additional information.

2. Press F2 on your keyboard so that the first cell of the selected cells
enters the edit mode.

3. Enter the formula that you want to use. In the example below (Figure
5.236) the TUKEY.MATRIX formula with the second, the third and
the fourth arguments specified is used.

Figure 5.231 - Example of TUKEY.MATRIX formula with multiple arguments.
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4.  Press Ctrl+Shift+Enter. The area of the spreadsheet selected in
Step 1 will be populated with the Tukey's test results. In the example
below (Figure 5.237) the TUKEY.MATRIX formula is used and the full
set of results are displayed.

Figure 5.232 - Example of results using TUKEY.MATRIX formula with multiple
arguments.

5.6.5 Renaming Spreadsheets

To rename your Spreadsheet:

1.  Open the Data Navigator . 
2.  Right click on the spreadsheet to rename. 
3.  Select Rename from the list.(Figure 5.238)
4.  Enter the new name in the edit field and press Enter. 

128
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Figure 5.233  Rename a spreadsheet.

5.6.6 Deleting Spreadsheets

To delete a Spreadsheet

1.  Select the spreadsheet in the layout. 
2.  Press Delete.  If you want to immediately restore a spreadsheet that was

deleted by mistake, use the Undo command in the Quick Access Toolbar
.

Please note that the steps above will only delete the spreadsheet object from
the page but it will still remain associated with the layout in the Data
Navigator . To completely remove a spreadsheet from the layout right-click
on the spreadsheet in the Data Navigator and choose Delete from the pop-
up menu.

5.6.7 Exporting Data in Spreadsheets

Spreadsheets created within FCS Express may be exported to various external
file formats such as .xls, .xls, .csv, .html, .xml and .txt.

49
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Formulas, formatting, and references will be preserved when selecting to save in
the .xls or .xlsx file format.

To export a spreadsheet created within FCS Express:
1.  Left click within the desired spreadsheet to select it. The spreadsheet will

enter into Edit mode (green borders) and the Spreadsheet category will
appear in the Ribbon bar (Figure 5.239, Step 1).

2.  Select Spreadsheet Layout Export Export (Figure below, Step 2) in the
Ribbon. 

3. Navigate to the desired file path location in the Export Spreadsheet To
dialog (Figure below, Step 3).

4. Enter the file name to be used.
5.  Select the desired file format (Figure below, Step 4).
6. Click Save.

Figure 5.234 How to Export a Spreadsheet created whitin FCS Express.

5.6.8 Graphing Data with Pie Charts, Bar Plots, Scatter with
Regression, and Box and Whisker Plots

Data in a spreadsheet can be graphed in FCS Express as Pie Charts , Bar
Plots , Scatter Plots , Scatter with Regression Plots , Box and Whisker
Plots , and Levey Jennings Plots . Graphing data from spreadsheets in FCS
Express allows you to easily visualize trends in your data as plots update in real
time in response to gate, marker, and quadrant adjustments or as data files
update via Next/Previous  or Batch Processing . Data may also be graphed
from data files values inserted in a spreadsheet from the data list . 

· Graphing Bar Plots
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· Graphing Pie Charts

· Graphing Scatter Plots

· Scatter with Regression Plots

· Summary Charts  (i.e. Box and Whisker, Violin and Beeswarm plots)

· Levey Jennings Plots

Please note that in all graph types the first row of a corresponding spreadsheet
may be enable for use as the data label source. Please see the Formatting
Spreadsheet section for additional details . 

5.6.8.1 Pie Charts

Pie charts are a convenient means for visualizing how several statistics relate to
one another and combine to form a conceptual whole (e.g., Figure 5.240).  

Pie Charts can be inserted anywhere on your layout , and can be populated via
drag-and-drop  or from Spreadsheets  containing statistical tokens or
freetext.  They are also fully formattable .  

The appearance of Pie Charts in FCS Express is customizable via special
formatting options .

Figure 5.235 Pie Chart in FCS Express
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5.6.8.1.1  Inserting Pie Charts

Pie Charts are inserted like any other plot in FCS Express (see below). In FCS
Express, Pie Charts may be created easily by drag and drop , or from an
existing spreadsheet . 

To insert a blank Pie Chart to populate by drag and drop :

1.  Click the Insert tabCharts  command.
2.  Click on a blank space of the layout to insert the Pie Chart.

An empty Pie Chart will appear, to which you can drag and drop any statistic in
FCS Express to populate the pie .  Note: if a spreadsheet exists in your
layout, the inserted Pie Chart will be populated with its data.  Simply insert
another Pie Chart to create an empty Pie Chart for receiving the dragged and
dropped items.  The first Pie Chart may be deleted, if desired.

To insert a Pie Chart from a spreadsheet:

1.  Select a spreadsheet in the Layout .
2.  Click the Insert tab  command (Figure 5.241).
3.  Click on a blank space of the layout to insert the Pie Chart.

Note: The spreadsheet should be formatted so the first column (A) contains
the name of the series and the second column (B) contains the values to be
plotted. If the data exists in different rows the Pie Chart may be formatted to
select the appropriate columns of data.

In both cases, a new Pie Chart will appear on the layout that is populated with
the data from the spreadsheet. The Pie Chart may now be populated with the
desired parameters  and formatted as you wish .

Figure 5.236 Inserting a Pie Chart

5.6.8.1.1.1  Populating Pie Charts by Drag and Drop

Pie Charts are easy to populate through the drag-and-drop functionality in FCS
Express.  You can drag plots or gates , statistical tokens , or free text to
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create or replace sectors (slices) on a blank Pie Chart that has already been
inserted on your layout .  

When populating a previously blank Pie Chart by drag-and-drop, the following
actions are available:

· Insert a new statistic or value to be plotted as a slice in the pie chart.

· Replace the value of an existing slice in pie chart with a new value.

See the figures and steps below to learn how to populate Pie Charts by drag-
and-drop.

After inserting a blank Pie Chart , dragging and dropping gates onto it will cause
the Edit Statistic dialog to appear. The specific statistic relating to the gate can
be chosen for plotting (e.g., "% of Gated Cells" in Fig. 5.242).

Figure 5.237 Edit Statistic dialog appearing after dragging a gate to a Pie Chart
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The result of dragging and dropping a gate to a Pie Chart and choosing the
desired statistic in the Edit Statistic  dialog is shown in Fig. 5.243 below. 

Figure 5.238 Dragging a gate to a Pie Chart to add a sector (slice)

Statistical tokens or freetext from default statistics windows or text boxes on
your layout can also be dragged directly to Pie Chart. The data value must be
dropped on the plot outside of the existing pie area (if dropped on the pie area
the current value representing the slice will be replaced with the dropped value
).  In this case, the Edit Statistic dialog will not appear.  In the example below,
the selected "Gate 1, % of gated cells" statistic is dragged to an empty space on
the Pie Chart, in order to add a new sector (slice) (Fig. 5.244).

Figure 5.239 Dragging and dropping a statistic token to the Pie Chart

Dragging a plot, gate, or statistic onto an existing sector (slice) will replace it with
the desired statistic, as shown below (Fig. 5.245).
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Figure 5.240 Dragging and dropping a gate to replace an existing sector (slice) on
a Pie Chart

5.6.8.1.1.2  Populating Pie Charts from Spreadsheets

An alternative to populating Pie Charts by dragging and dropping values is to
populate a pie chart from an existing Spreadsheet .

If a Spreadsheet exists on the layout, an inserted Pie Chart  will be
automatically populated with the data from Columns A and Column B within the
Pie. Column A will be the series name and column B the value used in the Pie
Chart.  If more than one spreadsheet exists, select  that which is intended as
the data source prior to inserting the Pie Chart . 

By default, the first two columns of the Custom Data Grid for the Name- and
Value-parameters of each sector (slice) will be plotted on the Pie Chart,
respectively.  

To populate the Pie Chart with parameters other than these first two columns of
the Custom Data Grid,

1. Select the Format tab Plot Options  command (Figure 5.246)
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Figure 5.241 Choosing parameters for Pie Chart

2. Choose the Spreadsheet column intended for the value of the sector
(slice), from the Value Parameter drop-down menu.

3. Choose the Spreadsheet column intended for the name of the sector
(slice), from the Name Parameter drop-down menu.

See Formatting Pie Charts  for details on how to customize colors, legends,
rings, and more.
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5.6.8.1.2  Formatting Pie Charts

Pie Charts in FCS Express are fully formattable.  In addition to many of the
formatting options shared by all plots  (border, size, background, titles, and
legend), special formatting options are accessible from the Overlays category. 
To access these special options:

· Select the Pie Chart and use the Format tab Plot Options

command (Figure 5.247), or

· Right-click on the Pie Chart, select Format from the pop-up menu, and

choose Overlays from the dropdown.

Special formatting options for Pie Charts are pictured below and include:

· Plotting additional data as a Ring Parameter.

· Explode Parameter for exploding individual sectors (slices) for emphasis.

· Color Parameter for sector (slice) colors.

· Shadow.

· Displaying of Pie Chart as filled pie (default) or "donut".

· Caption Style.
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Figure 5.242 Special formatting options for Pie Charts  

The formatting options are described in the table below.

Option Explanation

Value Parameter The parameter (column) from the Spreadsheet  displayed as
value of the sector (slice).

Name Parameter The parameter (column) from the Spreadsheet  displayed as
name of the sector (slice).
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Option Explanation

Ring Parameter The parameter (column) from the Spreadsheet displayed as sector
values of the Ring.  See below  for more information on displaying
additional data as a Ring on Pie Charts.

Explode Parameter The parameter (column) from the Spreadsheet from which the
Explode rule derives.  A sector (slice) will explode away from the
pie for emphasis  (e.g., the yellow sector shown below ) if its
value meets the criterion defined by the Explode rule.  See
below  for more information on how to define am Explode rule.

Color Parameter The parameter (column) from the Spreadsheet defining the display
color the sector (slice). See the Pie Charts tutorial  for details.

Show Shadow Whether a shadow behind the Pie Chart is shown.

Color Scheme Any of twenty preset coloring schemes which can be applied to the
Pie Chart.

Show as "donut"
chart 

Whether the Pie Chart is shown with a hole in the center.

Hole size If the Pie Chart is shown as "donut", the size of the donut hole.

Caption Style The Name, Value, Percentage of the pie (note: "percentage of the
pie" differs from "percent gated") or any combination thereof can
be shown as text directly beside each sector of the pie or ring. The
font of that text can be customized by using the Font button.

Legend Title Text title for the Name parameters listed in the Legend.

Change data file
during
Next/Prev/Batch

Whether the Pie Chart changes during batch processing  or in
response to a Next/Previous  command.  It is generally
recommended to leave this unchecked (default), as the Pie Chart
will update automatically as the data to which it refers is changed.

Visible Whether the Pie Chart is visible within the object.

To add Ring values as additional data at the periphery of the pie  or Exploding
for emphasis  to a Pie Chart, these values must be entered into designated
columns in the Spreadsheet.  

To define values for the Ring:
1.  Go to an empty column of the Spreadsheet .
2.  Enter the value  of the Ring for each row (each row corresponds to an

individual slice, or sector, of the pie).  This value may be freetext or a
custom token .  

3.  Choose the appropriate Spreadsheet column for the Ring Parameter
(Figure above)

An example of a Pie Chart with additional Ring values (plotted at the
periphery of the Pie) and its associated Spreadsheet is shown in Figure 5.248
below.

To define an Explode rule:
1.  Go to an empty column of the Spreadsheet
2. Enter the value  of the rule for each row (each row corresponds to an

individual slice, or sector, of the pie).  The rule must be a formula
evaluating to "TRUE" or "FALSE";  if "TRUE," the sector (slice) will explode
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away from the pie.  An example of an Explode rule referring to a cell within
the Spreadsheet is shown in the Figure below.

3.  Choose the appropriate Spreadsheet column for the Explode Parameter
(Figure above)

An example of a Pie Chart with the Explode option and its associated
Spreadsheet is shown in the Figure below.

Figure 5.243 Pie Chart and associated Spreadsheet with Ring and Explode
formatting options

5.6.8.2 Bar Plots

Bar Plots are a convenient visualization tool for comparing several statistics at a
glance, whether these derive from different gates, plots, data files, ratios, or
complex statistical formulae.  Bar plots are unit-less along the X-axis, being
labeled with user-defined, nominal categories instead (e.g., Figure 5.249). Thus
bar plots are not truly bivariate, unlike scatter plots.
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Figure 5.244. Bar Plot in FCS Express

Bar Plots can be inserted anywhere on your layout , and can be populated
from Spreadsheets  or by dragging and dropping gates, plots, or statistical
tokens .  They are also fully formattable .  

5.6.8.2.1  Inserting Bar Plots

Bar Plots are inserted like any other plot in FCS Express (see below). In FCS
Express 6, Bar Plots may be created easily by drag and drop , or from a
Spreadsheet . 

To insert a blank Bar Plot to populate by drag and drop :

1.  Click the Insert tab  command (Figure 5.250).
2.  Click on a blank space of the layout to insert the Bar Chart.

An empty Bar Plot will appear, to which you can drag and drop any statistic in
FCS Express to populate the bars .  Note: if a Custom Data Grid exists in
your layout, the inserted Bar Plot will be populated with its data.  Simply insert
another Bar Plot to create an empty Bar Plot for receiving the dragged and
dropped items.  The first Bar Plot may be deleted, if desired.

To insert a Bar Plot from an existing Spreadsheet:

1.  Select a Spreadsheet in the Layout .
2.  Click the Insert tab  command.
3.  Click on a blank space of the layout to insert the Bar Plot.
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Alternatively:
1.  Drag a Spreadsheet from the Data Navigator  to an empty part of the

page.
2.  Release the mouse button.
3.  Select Bar from the Select Plot Types… dialog.

Figure 5.245 Inserting a Bar Plot

See the following sections to learn how to add data to Bar Plots:
· Populating Bar Plots by Drag-and-Drop

· Populating Bar Plots from Spreadsheets

5.6.8.2.1.1  Populating Bar Plots by Drag-and-Drop

Bar Plots are easy to populate through the drag-and-drop functionality in FCS
Express 6.  You can drag gates , statistical tokens , or freetext to create
bars on a Bar Plot that has been inserted on your layout .  

When populating a Bar Plot by drag-and-drop, the following attributes can be
controlled:

· The specific statistic  relating to the gate to be plotted.

· The position of the new bar  relative to existing bars.

· The addition of new overlays  to the Bar Plot.

· The X-axis label  for each bar.

See the figures and steps below to learn how to populate Bar Plots by drag-and-
drop.

After inserting a Bar Plot , dragging and dropping gates onto it will cause the
Edit Statistic dialog to appear. The specific statistic relating to the gate can be
chosen for plotting (e.g., "% of Gated Cells" in Fig. 5.251).
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Figure 5.246 Edit Statistic dialog appearing after dragging a gate to a Bar Plot

The result of dragging and dropping a gate to a bar plot and choosing the desired
statistic in the Edit Statistic  dialog is shown in Fig. 5.252.  

Figure 5.247 Dragging and dropping a gate onto a Bar Plot

A second gate can be dragged to the Bar Plot to open the Edit Statistic  dialog,
from which a statistic for the second bar is chosen (Fig. 5.253).
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Figure 5.248 Dragging and dropping a second gate onto a Bar Plot

Statistical tokens or freetext from default statistics windows or text boxes on
your layout can also be dragged directly to Bar Plots.  In this case, the Edit
Statistic dialog will not appear.  In the example below, the selected "CD8, % of
gated cells" statistic is dragged to the second position, to form a new bar
between the existing two (Fig. 5.254).

Figure 5.249 Dragging and dropping a statistic token to the middle position in a Bar
Plot

To add an overlay, drag the data source toward the Bar Plot and drop it below

the axis (Fig. 5.255, );  the overlay will be overlaid onto the first bar.  

To add subsequent bars, drag the data source toward the Bar Plot and drop it to

the right of the intended bar of the first overlay (Fig. (below) ). 
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Figure 5.250 Dragging and dropping an overlay to a Bar Plot

To add a descriptive X-axis label for each bar:
1. Click on the label

2. Enter freetext or tokens  (using the  button) into the label editor bar.
Fig. 5.256.

3. Click the green check mark in the label editor bar or hit Enter on the
keyboard to accept the change.  In the example below, the label for the
second bar has been edited to "population 2".
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Figure 5.251 Clicking on a Bar Plot axis label to edit it  

See the Formatting Bar Plots section  for details on how to customize colors,
bar style, error bars, and more.

5.6.8.2.1.2  Populating Bar Plots from Spreadsheets

It is generally more convenient to populate Bar Plots via drag-and-drop , but
the following situations require use of a Spreadsheet :

· Bars derived from:

o Custom Tokens  that cannot serve as a drag source during drag-and-

drop (e.g., those not visible within a text box )
o The results of Parameter Math or array formulas  calculated within a

Spreadsheet , and

· Error bars or highlighting parameters .  

Note: Bar Plots requiring these formatting elements can still be populated
with bars via drag-and-drop , but accessing the Spreadsheet is required
to add them.

If a Spreadsheet exists on the layout, an inserted Bar Plot  will be automatically
populated with the data within the Spreadsheet.  If more than one Spreadsheet
exists, select  that which is intended as the data source prior to inserting the
Bar Plot . 

By default, the Bar Plot will plot the first two columns of the Spreadsheet for the
X- and Y-parameters, respectively.  
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To populate the Bar Plot with parameters other than the first two columns of the
Spreadsheet,

1. Select the Format tab Plot Options  command (Figure
5.257).
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Fig. 5.252 Populating a Bar Plot from Spreadsheet

parameters
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2. Choose the parameter (i.e., Spreadsheet column) intended for the X-axis,
from the Bar Labels drop-down menu.

3. Choose the parameter (i.e., Spreadsheet column) intended for the Y-axis,
from the Bar Values drop-down menu.

To add an overlay to an existing Bar Plot, either

· Drag and drop a Spreadsheet onto the Bar Plot, or

· Drag and drop another Bar Plot onto the recipient Bar Plot, or

· Right-click on the Bar Plot

1. Select Add Overlay using Advanced Open Data Dialog from the
pop-up menu.

2. Select the data source in the Active Files tab of the Open Data
File dialog (Figure 5.258).

3. Click OK.

Figure 5.253 Selecting a Spreadsheet to overlay onto an existing Bar Plot
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4. Select the parameters for the new Overlay in the Add overlays
dialog.

5. Click OK (Figure 5.259).

Figure 5.254 Selecting parameters to overlay onto an existing Bar Plot

See the Formatting Bar Plots section  for details on how to customize colors,
bar style, error bars, and more.

5.6.8.2.2  Formatting Bar Plots

Bar Plots in FCS Express are fully formattable.  In addition to the formatting
options shared by all plots  (e.g., border, size, background, axis , titles, and
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legend), special formatting options are accessible from the Overlays category. 
To access these special options, either

· Select the Bar Plot and use the Format tab Plot Options

command, or

· Right-click on the Bar Plot, select Format from the pop-up menu, and

choose the Overlays category.

Special formatting options for Bar Plots are indicated by number below (Figure
5.260) and include:

· Bar color ( ), shape ( ), fill ( , ), and border ( ).

· Highlighting ( , ).

· Error bars ( , ).
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Figure 5.255 Special formatting options for Bar Plots
 

The formatting options are described in the table below.

Option Explanation

Bar Labels The parameter (column) from Spreadsheets  displayed on the X
axis.

Bar Values The parameter (column) from Spreadsheets  displayed on the Y
axis.
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Option Explanation

Error Bar Parameter The parameter (column) from the Spreadsheet displayed as error
bars.  See below  for more information on how to define the error
bars.

Highlight Param. The parameter (column) from the Spreadsheet from which the
highlighting rule derives.  Bars will be highlighted (e.g., the yellow

bar shown in this example ) in the color defined in  if their
value meets the criterion defined by the Highlighting rule.  See
below  for more information on how to define a highlighting rule.

Highlight Color The display color for highlighted bars.

Gate The gate that is applied to the Bar Plot.

Bar Color The display color for bars.

Bar Shape The shape of the bar.  Choose between rectangle (default),
pyramid, cylinder, ellipse, arrow, cone, bevel, cube, and diamond
options. 

Legend Text The text that will appear in the plot legend beside the symbol for
the overlay. 

Bar Fill Color The stripe fill color for bars with fill patterns.

Bar Fill Style The fill style of the bar. Choose between none (default), cross,
diagonal, horizontal, and vertical stripe options.

Change data file
during
Next/Prev/Batch

Whether the Bar Plot changes during batch processing  or in
response to a Next/Previous  command.  It is generally
recommended to leave this unchecked (default), as the Bar Plot will
update automatically as the data to which it refers is changed.

Visible Hides overlays without removing them. Select the overlay file from
the 2D bar Overlays list and uncheck Visible. Check Visible to
show the overlay again.

Show marks Displays the value of the bars as text directly above the bars.

Line Options for Toggle between Bar Border and Error Bar Pen editing mode.

Bar Border/Error

Bar Properties /

Width, Style (solid, dotted, and dashed options), and Color of the
Bar Border or Error Bars.

To add error bars  or highlighting  to a Bar Plot, these values must be
entered into designated columns in the Spreadsheet.  

To define values for the Error Bars, 
1. Go to an empty column of the Spreadsheet
2. Enter the value  of the error for each row (each row corresponds to an

individual bar).  This value may be freetext or a custom token .  
3. Choose the appropriate Spreadsheet column for the Error Bar Parameter

(Figure (above), ).

An example of a Bar Plot with Error Bars and its associated Spreadsheet is
shown in Figure 5.261 below.

To define a Highlighting rule, 
1. Go to an empty column of the Spreadsheet
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2. Enter the value  of the rule for each row (each row corresponds to an
individual bar).  The rule must be a formula evaluating to "TRUE" or
"FALSE";  if "TRUE," the bar will be highlighted with the color defined in the

Formatting Overlays window, , in the chart shown above.  An example
of a Highlighting rule referring to a cell within the Spreadsheet is shown
below in the Figure below.

3. Choose the appropriate Spreadsheet column for the Highlight Param. (as

shown in the Formatting Overlays window, , in the Special formatting
options figure above the chart).

An example of a Bar Plot with Highlighting and its associated Spreadsheet is
shown below.

Figure 5.256 Bar Plot and Spreadsheet with Error Bars and
Highlighting.

Note: Bar Plot Axis titles may be defined in the Axes  category of Formatting
options.
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5.6.8.3 Scatter Plots

Scatter plots facilitate the observation of relationships between two variables*. 
These variables may be native to the experiment (e.g., time and fluorescence
.fcs file parameters), simple statistical tokens  derived from different plots or
populations, or complex statistical formulae defined in Custom Tokens .  Unlike
bar plots and pie charts, scatter plots are true 2D plots.

Scatter Plots (e.g., Figure 5.262)can be inserted anywhere on your layout ,
and are populated from Spreadsheets  containing statistical tokens or freetext.
 They are also fully formattable .  

Figure 5.257. Scatter Plot in FCS
Express

* Note:  If you plan on performing a regression analysis (best-fit curve) of your
data, it is strongly recommended to insert a Scatter with Regression Plot
instead.  Scatter with Regression Plots facilitate automatic overlay of the
regression curve onto your raw data.

5.6.8.3.1  Inserting Scatter Plots

To insert a Scatter Plot:

· Use the Insert tab Charts Scatter command (Figure 5.263) and click on

a blank space of the layout

Learn more about Populating Scatter Plots from Spreadsheets
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Figure 5.258 Inserting a Scatter Plot

5.6.8.3.1.1  Populating Scatter Plots from Spreadsheets

Scatter Plots are populated from Spreadsheets .

If a Spreadsheet exists on the layout, an inserted Scatter Plot  will be
automatically populated with the data from the Spreadsheet. 

If more than one Spreadsheet exists on the layout, select the Spreadsheet
that which is intended as the data source prior to inserting the Scatter Plot . 

By default, the Scatter Plot will plot the first two columns of the Spreadsheet for
the X- and Y-parameters, respectively.  

To populate the Scatter Plot with parameters other than the first two columns of
the Spreadsheet, either:

· Click on the axis parameter name within the plot and select the intended

parameter from the list of available parameters or,
· Change the X and/or the Y Parameters from the Overlay Formatting dialog

(See instructions below)

To change the X and/or the Y parameters on the scatter plot via the Overlay
Formatting dialog:

1. Select the Format tab Plot Options  command (Figure 5.264)
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Fig. 5.259 Populating a Scatter Plot from Spreadsheet

parameters
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2. Choose the parameter (i.e., Spreadsheet column) intended for the X-axis,
from the X Parameter drop-down menu.

3. Choose the parameter (i.e., Spreadsheet column) intended for the Y-axis,
from the Y Parameter drop-down menu.

To add an overlay to an existing Scatter Plot, either

· Drag and drop a Spreadsheet onto the Scatter Plot.

· Drag and drop another Scatter Plot onto the recipient Scatter Plot.

· Right-click on the Scatter Plot.

1. Select Add Overlay using Advanced Open Data Dialog from the
pop-up menu.

2. Select the data source in the Active Files tab of the Open Data
File dialog (Figure 5.265).

Figure 5.260 Selecting a Spreadsheet to overlay onto an existing Scatter Plot

3. Click OK.
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4. Select the parameters for the new Overlay in the Add overlays
dialog.

5. Click OK (Figure 5.266).

Figure 5.261 Selecting parameters to overlay onto an existing
Scatter Plot

5.6.8.3.2  Formatting Scatter Plots

Scatter Plots in FCS Express are fully formattable.  In addition to the formatting
options shared by all plots  (e.g., border, size, background, axis , titles, and
legend), special formatting options are accessible from the Overlays category.
Additionally Display Gates Options  is accessible and set to No Gates by
default. 

338 599
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 To access Overlay formatting options for Scatter plots, either

· Select the Scatter Plot and use the Format tab Plot Options

command, or

· Right-click on the Scatter Plot, select Format from the pop-up menu, and

choose the Overlays category.

The Overlay formatting dialog for Scatter plots is displayed below in Figure
5.267:
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Figure 5.262 Special formatting options for Scatter Plots  



Plots and Other Objects 597

© 2023 De Novo Software

The formatting options are described in the table below.

Option Explanation

X Parameter The parameter (column) from the Spreadsheet  displayed on the
X axis.

Y Parameter The parameter (column) from the Spreadsheet  displayed on the
Y axis.

Error Bar Param. The parameter (column) from the Spreadsheet displayed as error
bars. See below  for more information on how to define the error
bars.

Highlight Param. The parameter (column) from the Spreadsheet from which the
highlighting rule derives. Points will be highlighted (e.g., the orange

point in the plot below ) using the color defined in  and the

border defined in  if their value meets the criterion defined by the
Highlighting rule. See below  for more information on how to
define a highlighting rule.

Gate The gate that is applied to the Scatter Plot.

Legend Text The text that will appear in the plot legend beside the symbol for
the overlay. 

Connect the points Whether the points are connected by a line. Connecting Lines can

be customized in .

Change data file
during
Next/Prev/Batch

Whether the Scatter Plot changes during batch processing  or in
response to a Next/Previous  command.  It is generally
recommended to leave this unchecked (default), as the Scatter
Plot will update automatically as the data to which it refers is
changed.

Visible Hides overlays without removing them. Select the overlay file from
the 2D Unbinned Overlays list and uncheck Visible. Check
Visible to show the overlay again.

Point Color The display color for points.

Show marks Displays the value of the points as text directly above the points.

Draw control lines
for parameter

Select which parameter(s) to draw the control lines. Control lines
can be drawn for the X parameter, Y parameter, or both X & Y
parameters simultaneously. Available control lines, and their

formatting options, are listed in .

Shapes Allows to select which shape to format with the formatting options

available in .
Available shapes are:
· Point
· Highlighted point (see the Highlight Param. option above)

Formatting options

for selected shape

The title and the content of this section update accordingly to the
selection made in.

In the picture above, "Point" is selected in  and the formatting

options for point are indeed displayed in :
· Shape. Choose between rectangle (default), triangle, circle,

cross, star, hexagon, and diamond options. 
· Color. 
· Fill Color.
· Fill Style.
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Option Explanation

· Size.

Lines Allows to select which line to format with the formatting options

available in .
Available lines are:
· Point border
· Error bar
· Connecting lines
· Highlighted Point Border
· Mean Line
· 1*SD from mean
· 2*SD from mean
· 3*SD from mean

Note: the latter four lines are the control lines to which

applies the Draw control lines for parameter option above ( ).

Formatting options

for selected line 

The title and the content of this section update accordingly to the
selection made in.

In the picture above, "Point Border" is selected in  and the

formatting options for point are indeed displayed in :
· Width.
· Style.
· Color.

Note: Connecting Lines option includes an option to Use color
from Point Options. When this option is selected, the color

selected in the Color drop-down menu ( ) for Points ( ), will be
used to color the connecting line. 

To add error bars  or highlighting  to a Scatter Plot, these values must be
entered into columns in the Spreadsheet.  

To define values for the Error Bars, 
1. Go to an empty column of the Spreadsheet
2. Enter the value  of the error for each row (each row corresponds to an

individual bar).  This value may be freetext or a custom token .   
3. Choose the appropriate Spreadsheet column for the Error Bar Param.

drop-down (see above).

An example of a Scatter Plot with Error Bars and its associated Spreadsheet is
shown in the figure below.

To define a Highlighting rule, 
1. Go to an empty column of the Spreadsheet
2. Enter the value  of the rule for each row (each row corresponds to an

individual point).  The rule must be a formula evaluating to "TRUE" or

"FALSE";  if "TRUE," the point will be highlighted with the color defined in ,

598 598

416

422

1337

416

422



Plots and Other Objects 599

© 2023 De Novo Software

,  and  above. An example of a Highlighting rule referring to a cell
within the Spreadsheet is shown below in Figure 5.268.

3. Choose the appropriate Spreadsheet column for the Highlight Param.
drop-down (see above).

An example of a Scatter Plot with Highlighting and its associated Spreadsheet
is shown in the Figure below.

Figure 5.263 Scatter Plot and associated Spreadsheet with
Error Bars and Highlighting

Note: Scatter Plot Axis titles may be defined:
§ directly in the Spreadsheet by using the column header (this require to

check the Use values in a first row as labels  option in the Spreadsheet
Formatting dialog ). 

§ in the Axes  category of Formatting options.
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5.6.8.3.3  Regression Analysis (Manually f itting data)

FCS Express has the ability to perform regression analysis on your data through
manual formulas and custom data grids or at a click through Scatter with
Regression plots .

FCS Express provides the user with many mathematical functions to create
custom tokens  and custom data  sets. These functions operate similar to
functions within Microsoft Excel™. When it comes to regression analysis there
are four basic functions that apply to all of the available equations that a
regression can be performed on. In the table below the functions are listed with
the red italic, xxx, representing the FCS Express Function name for a particular
equation  (The FCS Express Function names can be found in the Available
Equations .). A description of the function argument is given in the right side of
the table. 

Regr
essio

n
Funct

ion
Type

Descriptio
n

Arguments Result

Perfor
mxxx
Fit

Performs a
fit of the
specified X-
Y values to
a particular
equation.

([X Values],[Y Values],[SD],[Fixed Parameters])
Where X Values is a comma delimited list of X
values, generally specified by a series of tokens .
Where Y Values is a comma delimited list of Y
values, generally specified by a series of tokens .
Fixed Parameters allows you to specify variables
that should not be fit, but will be forced to use the
value that you specify. The format of the Fixed
parameters is a comma delimited list of var=value
where var is one of the available variables for that
equation  and value is the value to fix it to.
SD, or Standard Deviation, allows you to specify a
standard deviation for each list of the Y values,
generally specified by a series of tokens . The SD
value assigns a "weight" to each associated X and
Y value with a lower SD value resulting in a higher
weight and a higher SD value resulting in a lower
weight. If the SD is not specified, an SD of zero is
assumed for each Y value.

Comma
delimited
list of all of
the fit
variables
and their fit
values 

Extra
ctxxx
Result
s

Extracts a
particular
variable
from the

ExtractxxxResults([modelParameters], "Variable
1" | "Variable 2" | "Variable 3") 
Where xxx represents an equation  (ie. Linear,
Sigmoidal, Exponential, etc...).

The value
of the
specified
variable.
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result of a
Performxx
xFit
custom
token.

Where modelParameters represents a comma
delimited list of all of the fit variables and their
values, generally specified by a token  result of
the PerformxxxFit function.
Where Variable represents a variable defined by
the PerformxxxFit function and "|" represents "or"
. 
Each PerformxxxFit function will define a unique
set of variables that will replace the example of
"Variable 1, Variable 2, Variable 3" when the
function is used: ie... "m" | "b" | "r2" or "A" | "B" |
"C"| "r2" for Linear and Sigmoidal equations
respectively. Unwanted variables must be deleted
to return a result. For example:
ExtractLinearResults([modelParameters], "m") will
return the fit value result of the "m" variable
associated with the equation.

xxxXt
oY

Uses the X
values of a
given data
set and the
"Model
Parameters
" or "Fit" of
a
regression
to return
an
unknown Y
Value.

xxxXToY(X, [modelParameters]) 
Where xxx represents an equation (ie. Linear,
Sigmoidal, Exponential, etc...).
Where X is a comma delimited list of X values,
generally specified by a  token .
Where modelParameters represents a comma
delimited list of all of the fit variables and their fit
values. Generally specified by a token  result of
the PerformxxxFit function.

Comma
delimited
list of all of
the Y
values
calculated
from the
associated
equation, X
value, and
fit
variables.

xxxYt
oX

Uses the Y
values of a
given data
set and the
"Model
Parameters
" or "Fit" of
a
regression
to return
an
unknown X
Value.

xxxYToX(Y, [modelParameters]) 
Where xxx represents an equation  (ie. Linear,
Sigmoidal, Exponential, etc...)
Where Y is a comma delimited list of Y values,
generally specified by a token .
Where modelParameters represents a comma
delimited list of all of the fit variables and their fit
values. Generally specified by a token  result of
the PerformxxxFit function.

Comma
delimited
list of all of
the  X
values
calculated
from the
associated
equation, Y
value, and
fit
variables.

To view a list of all possible equations please see the topic of Available
Equations . To see an example of using these equations please see the topic of
Regression Analysis Example  or visit the Linear Regression Analysis  tutorial.
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5.6.8.3.3.1  Manual Regression Analysis Example

In order to perform a manual regression analysis, you will use a custom data set.
To demonstrate the use of this feature, we will fill a new data set with fixed
values. Normally, you would use Tokens , representing some statistic from
your analysis. Defining regressions manually is easy in FCS Express with Scatter
with Regression plots . We highly recommend you visit the Scatter with
Regression plots  chapter before proceeding with a manual fit. 

In Figure 5.269, we have a Spreadsheet , with values typed into the cells. 
Please note that these are free text values, but in practice many of these will be
tokens  derived from plots on your layout.

Figure 5.264  Spreadsheet Data for
Regression Analysis

With this data, a linear regression should yield a slope of approximately 10 and a
Y-intercept of approximately 1.

Regression analysis is performed using Custom Tokens .

1. First, create a new custom token and name it Linear Regression.

If you right-click in the formula area of the Custom Token window and choose
Insert Function, you will find a list of available regressions, each beginning with
the word Perform (Figure 5.270).
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Figure 5.265  Regression Functions

2. Start a formula with an equals sign (=), right-click to bring up the pop-up
menu, and choose Insert Function PerformLinearFit([xValues,
[yValues], [SDvalues], [fixedParameters]) (Figure 5.271).
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Figure 5.266  Linear Regression Formula

3. In the formula, highlight xValues, right-click to bring up the pop-up menu,
and choose Insert Token (Figure 5.272).

Figure 5.267  Inserting a Token into a Linear Regression Formula

An Insert a Token dialog will appear that contains a Data Parameter token
(Figure 5.273).
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Figure 5.268  Data Parameter Token

4. Select the Data Parameter token and click Insert.

5. In the Create Data Parameter dialog which appears, choose the
Spreadsheet radio button as a Data Source, and select New
Spreadsheet (Figure 5.274).



FCS Express 7 Manual606

© 2023 De Novo Software

Figure 5.269  Create Data Parameter -- Data Source

6. Then, go to the Parameter category and from the Parameter drop-
down list, choose the data in column A (Figure 5.275). Leave Macro for
the Output As drop-down selection. Choosing Data Values converts all
of the data to string values which is not efficient when there is a large
amount of data.
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Figure 5.270  Create Data Parameter -- Parameter Page

7. Repeat steps 3-6 using yValues in the formula and choosing Parameter B.

8. Highlight SDvalues and press the Del key (leaving the area between the
brackets blank. Do the same for fixedParameters (Figure 5.276).

Figure 5.271  Completed Linear Regression Formula

If the measurement in your B column was made from multiple data points and
you know the standard deviation of each of the data points, you can enter a list
of comma-delimited values in the SDvalues parameter of the linear regression
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formula. The model will weigh the points with the lower standard deviation more
strongly than the points with higher SD values.

The fixed Parameters for a linear regression are m (slope) and b (Y-intercept).
By leaving the parameter blank, the model will fit both of them. If you wanted to
force a Y-intercept of 0, for example, you could enter b=0 in fixedParameters,
and the model will fix that parameter, rather than letting it float.

9. Convert both Data Parameter values in the formula to display a numeric
result type  (they will be highlighted in blue instead of pink, as shown
below in Figure 5.277).

Figure 5.272  Completed Linear Regression Formula with result type
converted to Numeric

10. Insert a Text Box  onto your layout.

11. Drag the custom token Linear Regression into the text box. The m, b,
and r2 (r-squared) values will be displayed (Figure 5.278).

1355

375



Plots and Other Objects 609

© 2023 De Novo Software

Figure 5.273  Linear Regression Token inserted into a Text Box

The result is a comma-delimited list of every parameter that the linear regression
fit.

If you want to display just the slope of the linear regression in a text box, you
create a new custom token, and:

12. Use the function ExtractLinearResults([modelParameters], "m" |
"b" | "r2") (Figure 5.279) as in step 2.

13. Then, select modelParameters and insert the Linear Regression
token, as in step 4.

14. Delete the "b" and "r2" parameters.

15. Create a text box and insert the text: "The slope is: ".

16. Drag the Slope token into the text box (Figure below).

Figure 5.274  Slope Parameter of Linear Regression Analysis Inserted into a Text
Box as a Token
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In summary, it is a two-step process. You make one custom token for the fit,
and a second custom token for the parameter that you want to use from that
fit.

5.6.8.3.3.2  Available Equations

FCS Express has the ability to fit your data to many different types of equations.

Below you will find a table indicating the equation, the formula associated with it,
and the parameters defined in FCS Express when a fit is performed.

Equation
Name

FCS Express 
Function Name

Equation Variables

Michaelis
Menten

MichMenten Vmax, Km

TwoSiteBinding TwoSiteBinding Vmax, KM,
Vmax2, KM2

Four Parameter
Logistic (4PL)

FourParmLogisti
c 

Imax, Imin,
IC50, HillSlope

Five Parameter
Logistic (5PL)

FiveParmLogistic Imax, Imin,
IC50, HillSlope,
Asym

Four Parameter
Log Logistic

FourParmLogLo
gistic 

Imax, Imin,
Midpoint,
HillSlope

Five Parameter
Log Logistic

FiveParmLogLog
istic

Imax, Imin,
Midpoint,
HillSlope,
Asymmetry

Boltzmann Boltzmann Bottom, Top,
V50, Slope
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Exponential Exponential A, M, C

Two Phase
Exponential

TwoPhaseExpon
ential

A, M, A2, M2,
C

Exponential
Association

ExpAssociation Ymax1, K1

Two Phase
Exponential
Association

TwoPhaseExpAs
sociation

Ymax1, K1,
Ymax2, K2

Exponential
Grow

ExponentialGro
w

A, M, C

Power Power A1, B1, K

Power Series PowerSeries A1, B1, A2,
B2, K

Linear Linear m, b

Parabolic Parabolic m, b, A2

Cubic Cubic m, B, A2, A3

Sine Wave SineWave Baseline,
Amplitude,
Frequency,
Offset

Gaussian Gaussian A, SD, xMed, K

Sigmoidal Sigmoidal A, B, C

Decreasing
Sigmoidal

SigmoidalDec A, B, C
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5.6.8.4 Scatter With Regression

FCS Express can display data from a Spreadsheet  or any file as a Scatter with
Regression Plot  which automatically overlays one or multiple best-fit
regression curves of your choice  onto your data.  The resulting regression
parameters  can be extracted and added as statistical tokens  anywhere on
your layout.  The regression curve will update as you adjust your gates or
advance through your dataset, as shown in Figure 5.280 below:

Figure 5.275 Scatter with Regression Plot updating as gate is moved.

5.6.8.4.1  Scatter With Regression Plots

To insert a Scatter with Regression plot,

1.  Select the Insert Scatter with Regression command (Figure
5.281).

Fig. 5.276 Inserting a scatter with regression plot.

2.  Click (or click-drag) on your layout where you want the plot to appear. 
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Note: The plot will appear showing data from the top Spreadsheet , i.e.,
the Spreadsheet which was most recently selected or edited.  The top
Spreadsheet is the one most recently accessed. 

3.  Change the X- and Y-axes  to the desired parameters.

To Format a Scatter with Regression Plot:

1.  Right click on the plot.
2.  Choose Format to access plot formatting options .
3.  Choose Regression fit from the dropdown. 

Choose the Regression Type (Figure 5.282) from the dropdown list of
available regression curve equations  to best fit your data. 

Fig. 5.277 Formatting a scatter with regression plot.

Note that multiple fits may be added or removed by using the Add and
Remove buttons under the Regression Model List. The Regression Model
Options also allow you to see the model parameters and enter a fixed
parameter where applicable (Figure 5.283). The model parameters may later
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be added to a layout as live-updating tokens via Scatter with Regression
Tokens . 

You may also increase the Number of regression dots to give the curve a
smoother appearance, though the default of "30" is sufficient in most cases.

Fig. 5.278 Regression Model Options with a Linear and Sigmoidal fit
added to the Regression Model List for comparison. Parameters for the
regression model are displayed on the right and a fixed parameter may

be typed in the Fixed column. Note in the example that the line was
forced through zero by adding a fixed value of "0" to the column.

  

5.6.8.4.2  Formatting Scatter With Regression Plots

Scatter with Regression plots in FCS Express are fully formattable. In addition to
the formatting options shared by all plots  (e.g., border, size, background,
axis , titles, and legend), special formatting options are accessible from the
Overlays category.

Overlay formatting options for Scatter with regression plots, either:

· Select the Scatter Plot or Scatter Plot with Regression and use the Format

tab Plot Options  command, or

618
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· Right-click on the Scatter Plot or Scatter Plot with Regression, select

Format from the pop-up menu, and choose the Overlays category.

Overlay formatting options for Scatter with Regression plots allow to customize

the appearance of both the data (i.e., Overlay 1,  in Figure 5.284) and the

regression (i.e., Overlay 2,  in the figure below).

Figure 5.279 Special formatting options for Scatter with Regression Plots
 

The formatting options are described in the table below.

Option Explanation

X Parameter The parameter (column) from the Spreadsheet  displayed on the
X axis.

591
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Option Explanation

Y Parameter The parameter (column) from the Spreadsheet  displayed on the
Y axis.

Error/Weight
Param.

The parameter (column) from the Spreadsheet that has to be used
to draw the error bars and to calculate the weights for the
regression. Note, if an Error/Weights parameter is selected, a
weighted regression will be performed.
The values reported in this column of the spreadsheet (let's call it
error for the sake of simplicity) will be directly used to draw the
error bars. Said values will then be transformed with the following
formula to calculate the weights for the regression:

Weights used for the regression = 1 / error2

For the sake of simplicity, if the Error/Weights Bar Parameter
contains the following values "a, b, c, d,..." the weights that will be

used to perform the weighted regression will be "1/a2, 1/b2, 1/c2,

1/d2,...".
See below  for more information on how to define the error bars.

Highlight Param. The parameter (column) from the Spreadsheet from which the
highlighting rule derives. Points will be highlighted (e.g., the orange
point in the plot below ) in the color defined in the Highlight
Color drop down menu if their value meets the criterion defined by
the Highlighting rule.  See below  for more information on how to
define a highlighting rule.

Gate The gate that is applied to the Scatter with Regression Plot.

Legend Text The text that will appear in the plot legend beside the symbol for
the overlay. 

Connect the points Whether the points are connected by a line.

Change data file
during
Next/Prev/Batch

Whether the Scatter with Regression Plot changes during batch
processing  or in response to a Next/Previous  command.  It is
generally recommended to leave this unchecked (default), as the
Scatter with Regression Plot will update automatically as the data
to which it refers is changed.

Visible Hides overlays without removing them. Select the overlay file from
the 2D Unbinned Overlays list and uncheck Visible. Check
Visible to show the overlay again.

Show marks Displays the value of the points as text directly above the points.

Draw control lines
for parameter

Select which parameter(s) to draw the control lines. Control lines
can be drawn for the X parameter, Y parameter, or both X & Y
parameters simultaneously. Available control lines, and their

formatting options, are listed in  and .

Shapes Allows to select which shape to format with the formatting options

available in .
Available shapes are:
· Point
· Highlighted point (see the Highlight Param. option above)

Formatting options

for selected shape

The title and the content of this section update accordingly to the
selection made in.

In the picture above, "Point" is selected in  and the formatting

options for point are indeed displayed in :

591

617

618

618

768 71



Plots and Other Objects 617

© 2023 De Novo Software

Option Explanation

· Shape. Choose between rectangle (default), triangle, circle,
cross, star, hexagon, and diamond options. 

· Color. 
· Fill Color.
· Fill Style.
· Size.

Lines Allows to select which line to format with the formatting options

available in .
Available lines are:
· Point border
· Error bar
· Connecting lines
· Highlighted Point Border
· Mean Line
· 1*SD from mean
· 2*SD from mean
· 3*SD from mean

Note: the latter four lines are the control lines to which

applies the Draw control lines for parameter option above ( ).

Formatting options

for selected line 

The title and the content of this section update accordingly to the
selection made in.

In the picture above, "Point Border" is selected in  and the

formatting options for point are indeed displayed in :
· Width.
· Style.
· Color.

Note: Connecting Lines option includes an option to Use color
from Point Options. When this option is selected, the color

selected in the Color drop-down menu ( ) for Points ( ), will be
used to color the connecting line. 

To add Error/Weight bars or Highlighting to a Scatter Plot, these values must
be entered into columns in the Spreadsheet.  

To define values for the Error/Weight bars, 
1. Go to an empty column of the Spreadsheet
2. Enter the value  of the error for each row (each row corresponds to an

individual bar).  This value may be freetext or a custom token .   
3. Choose the appropriate Spreadsheet column for the Error/Weight

Param. drop-down menu (see above).

An example of a Scatter Plot with Error/Weight bars and its associated
Spreadsheet is shown in the figure below.
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To define a Highlighting rule, 
1. Go to an empty column of the Spreadsheet
2. Enter the value  of the rule for each row (each row corresponds to an

individual point).  The rule must be a formula evaluating to "TRUE" or

"FALSE";  if "TRUE," the point will be highlighted with the color defined in ,

,  and  above.  An example of a Highlighting rule referring to a cell
within the Spreadsheet is shown below in Figure 5.285.

3. Choose the appropriate Spreadsheet column for the Highlight Param.
drop-down menu (see above).

An example of a Scatter with Regression Plot with Highlighting and its
associated Spreadsheet is shown in the Figure below.

Figure 5.280 Scatter with Regression Plot and associated Spreadsheet with Error
Bars and Highlighting

Note: Scatter with Regression Plot Axis titles may be defined:
· directly in the Spreadsheet by using the column header (this require to check

the Use values in a first row as labels  option in the Spreadsheet
Formatting dialog ). 

· in the Axes  category of Formatting options.

5.6.8.4.3  Scatter w ith Regression Tokens

Scatter with Regression parameters (Regression Param Statistics) can be
extracted and used as tokens  or displayed in a default Regression Parameter
Statistics window . These tokens can be inserted into text boxes , used in
Custom Token  or any formulas, and exported to reports during batch
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processing . Regression Parameter Statistics will update in real time as
regression curves change just like any other token in FCS Express.

To insert a Regression Parameter Statistics token into a text box:

1.  Insert a text box using the Insert tab General Text Box command.
2.  Right-click on the text box and select Insert Token.
3.  Choose Statistic and click on the Insert button to bring up the Create

Statistic dialog.
4.  Choose a Scatter with Regression  plot as a Data Source from the

Select a Plot box.
5.  Open the Statistic category.
6.  Choose Regression Parameter Statistics from the Select a Statistic

dropdown list (Figure 5.286). 
7.  Choose a statistic from the Statistic list box.
8.  Click OK.

The statistic or Model name will now be displayed in the text box and will update
in real time as the regression overlay updates.

Fig. 5.281 Choosing Regression Parameter Statistics

Scatter with Regression parameters can also be displayed in a Regression
Parameter Statistics window, by right-clicking on the plot, and choosing
Statistics> Regression Parameter Statistics from the pop-up menu (Figure

810
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5.287). The tokens therein may also be dragged and dropped elsewhere in your
layout, which will result in a copy-paste operation.

Fig. 5.282 Displaying the default Regresion Parameter Statistics window from the
Scatter with Regression Plot

5.6.8.4.4  Interpolating values from Scatter w ith Regression Plots

X- or Y-values can be interpolated from Scatter with Regression Plots using the
"RegressionPlotYToX" and "RegressionPlotXtoY" functions, via the Custom
Tokens  window (Figure 5.288) or via a formula in the Spreadsheet .  See
below or this Use Case Tutorial section  for details.

Fig. 5.283 Regression Plot Interpolation Custom Token Functions

The components of the Custom Token are Plot ID (i.e., the Plot Number token
), Overlay Number for the Regression Overlay (note: the overlays are 1-based,
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so the raw data is Overlay #1, and the first regression is Overlay #2), and the X-
or Y-value from which the interpolated value will be derived.  An example of an
unfilled and filled Custom Token formula is shown below in Figure 5.289, top and
bottom, respectively.

Fig. 5.284 Interpolation Custom Token formula components unfilled (top) and filled
(bottom)

Interpolation formulas can also be entered into a Spreadsheet  from the
Spreadsheet tab Statistical group of functions, as shown in Figure
5.290.

416
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Fig. 5.285 Regression Plot Interpolation Formula (left)  inserted in Spreadsheet
(center) and with components filled (right).

5.6.8.5 Levey Jennings Plots

A Levey Jennings Plot allows you to visualize quality control data to ensure test
metrics are stable over time and fall within a predetermined range. The range,
more commonly referred to as the control limits, allows the test metric to be
assessed based on whether the values fall within the range or outside of the
range. Values falling outside of the control limits are considered "out of control"
and when occurring on consecutive measurements can indicate the accuracy of
the test metric has shifted. Special rules, called the "Westgard Rules", are often
applied to interpret the Levey Jennings Plot.

Levey Jennings Plots are built from an existing Spreadsheet  in your layout. The
Spreadsheet must contain two parameters, typically represented as the time (X
parameter) and test metric (Y parameter).

The spreadsheet can be populated by
· Manual insertion

· Inserting Tokens or Custom Tokens by dragging and dropping

plots/gates/markers/quadrants/statistics...
· Inserting Tokens by Dragging and Dropping Files from the Data List

· Batch Processing to Spreadsheet

An example of data set suitably arranged within a Spreadsheet and the resulting
Levey Jennings Plots is shown below (Figure 5.291). Please note that when
dates have to be plotted on the X axis, said dates has to be manually entered
into the spreadsheet and the cells containing said dates, have to be properly
formatted with the Date format . 
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Figure 5.286  A Spreadsheet with data for a Levey Jennings Plot

To insert a Levey Jennings Plot from an existing Spreadsheet:

1.  Select a Spreadsheet in the Layout .
2.  Click the Insert tab  command.
3.  Click on a blank space of the layout to insert the Levey Jennings Plot.

By default, the Levey Jennings Plot will plot the first two columns of the
Spreadsheet for the X Parameter and Y Parameter, respectively. To populate the
Levey Jennings Plot with parameters other than the first two columns of the
Spreadsheet, either:

· Click on the axis parameter name within the plot and select the intended

parameter from the list of available parameters or,
· Change the X and/or the Y Parameters from the Overlay Formatting dialog

(See instructions below)

To change the X and/or the Y parameters on the scatter plot via the Overlay
Formatting dialog, use the appropriately named  X (or Y) Parameter dropdown

menus shown below (Figure 5.292, ) and further described in the
accompanying table .
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Figure 5.287  Levey Jennings Plot Overlays

Additional formatting options for depicting data points, Westgard rules, In and
Out of Control Points, mean line, and control limits are described in the table
below.

Option Explanation

 Parameters The parameter (i.e., Spreadsheet column) intended for the X & Y
 parameters is set using the appropriately named  ...
Parameter dropdown menus. For Levey Jennings Plots, the Y
parameter is treated as the test metric.

 Show / Hide Test
Parameter

The points for the test metric on Levey Jennings plots have the
following options:

§ Connect the points - Draws a connecting line between
each point.

§ Visible - Show or Hide the Levey Jennings Plot.
§ Show marks - Displays the test metric value above each

point.

 Draw Control Lines Select which parameter(s) to draw the control lines. Control lines
can be drawn for the X parameter, Y parameter, or both X & Y

parameters simultaneously ( ). Available control lines, and their

formatting options, are listed in the Lines section (see below 
).
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Option Explanation

 Westgard Rules Select the Westgard rules to determine out of control events.
More than one option may be selected. Any value(s) meeting the
selected criteria for out of control events will be highlighted.
Note that the mean of the test metric (Y parameter) will be used
as the control value when applying the Westgard rules.

The following options are available:
§ 1:2s -  One value beyond +/- 2 standard deviations from

the mean.
§ 1:3s -  One value beyond +/- 3 standard deviations from

the mean.
§ 2:2s -  Two consecutive values either greater than, or less

than, 2 standard deviations from the mean.
§ r:4s -  One value beyond +2 standard deviations from

mean and the following value beyond -2 standard
deviations or vice-versa.

§ 4:1s -  Four consecutive values greater than, or less than,
one standard deviations from mean.

§ 10:x -  Ten consecutive values all greater than, or less
than, the mean.

 Shapes for Control
Points

The Shapes for the following plot elements may be defined:
§ In-Control Point:  data points which are within the control

limits according to the selected Westgard Rules.
§ Out of Control Point:  data points which are out of control

limits according to the selected Westgard Rules.

The available shapes include "Rectangle", "Triangle", "Circle",

etc., and are shown in the Shape ( ) dropdown menu. 
Choosing "Do Not Show" will result in the selected point element
not being depicted on the plot. Additional options for the point
elements of the Levey Jennings Plot include the Color, Fill
Color, and Fill Style selectable from the respective dropdown
menus, along with the adjustable point Size box.

 Lines The Lines for the following plot elements may be defined:

§ Point Border: the border line for In Control points.
§ Connecting Lines:  the line connecting all points on the

plot. The color selected for In-Control Points can be
applied using the checkbox.

§ Out of Control Point Border:  the border line for Out of
Control points.

§ Mean Line:  the line corresponding to the Y parameter
(test metric) mean value. See green solid line  above.

§ 1*SD from Mean:  the line corresponding to 1 standard
deviations from the Y parameter (test metric) mean. See
blue dashed line  above. 

§ 2*SD from Mean:  the line corresponding to 2 standard
deviations from the Y parameter (test metric) mean. See
orange dashed line  above.
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Option Explanation

§ 3*SD from Mean:  the line corresponding to 3 standard
deviation from the Y parameter (test metric) mean. See
red solid line  above.

( ) Note each line contains options for the Width, Style, and
Color selectable from the respective dropdown menu.

5.6.8.6 Summary Charts

The Summary Chart is a chart type that can be used to present and summarize
data from spreadsheets  in the layout.

A Summary chart can graph summary statistics such as the Mean or the Median,
the distribution of the data, the Outliers and Single Data Points.

Based on the summary chart style and which statistics it graphs, a summary
chart may be referred to a Box and Whisker, Violin, or Beeswarm Plot:
· Box and Whisker, when the distribution of the data is visualized according to

quartiles, where the middle two quartiles are represented by a mean- or
median-bisected box, and the outer two by whiskers.  Individual data points
within each set may also be denoted by points, and the appearance of outliers
can also be visually emphasized.

· Violin plots, when the probability density of the data at different values is

displayed, usually smoothed by a kernel density estimator. Individual data
points within each set may also be denoted by points, and the appearance of
outliers can also be visually emphasized.

· Beeswarm plots, when individual data points are displayed in a 1D scatter

plot, with a logic ensuring that plotted points do not overlap.

An example of the above mentioned Summary Charts (all displaying the same
dataset) is depicted in Figure 5.293 below:
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Fig. 5.288 Examples of Summary plots with Box and Whiskers style (upper left),
Violin style (upper right) and Beeswarm style (bottom).

FCS Express allows users to mix and match the different properties of Box and
Whisker, Violin and Beeswarm plots. For example, individual data points (which
are a typical characteristic of Beeswarm plots) can be visualized on both Box and
Whisker and Violin plot types. Similarly, a Violin distribution can be displayed on a
Box and Whisker plot. Two examples of customization are depicted in Figure
5.294 below. 
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Fig. 5.289 Examples of Summary plots with mixed style. Box and Whisker plot with
individual data points (left) and Violin plot with individual data points (right).

Next topics:
· Inserting Summary Charts

· Formatting Summary Charts

5.6.8.6.1  Inserting Summary Charts

The source data for Summary Charts in FCS Express is always a spreadsheet .
The Spreadsheet must contain at least two types of data (in two separated
columns) (figure 5 below provides an example of Category and Values columns):

· Values: the numerical freetext or token  values to be plotted for each row,

where each row corresponds to a data point.  
· Category: the column containing the primary classification labels.

Optionally, other two column with additional classification labels may be specified.
· Group: A second level of classification. When a Group parameter is defined,

the data within each Category is graphed separately accordingly to the group
classification.

· Split: A third classification level in addition to the Category and the Group

parameters that is only available for Violin plots.

Finally, two color parameters can be specified in case the shape color should be
different between Categories (available for Box and Whisker, primary Violins and
Beeswarm plot shapes) and/or Split Violins (only available when split violins are
visible):

· Color parameter:  the column of the spreadsheet containing the colors that

should be used for each Category. When the color parameter is specified,
the "Color Parameter" will be an available option in the color drop-down
menu for the element of interest (e.g. the Box, the Violin or the Beeswarm)
in the Shapes section (see the Formatting Summary Charts  chapter for
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more information). The number of color levels specified in the spreadsheet
column for this parameter, must match the number of categories.

· Split Violin Color: the column of the spreadsheet containing the colors that

should be used for each second-half of each violin. When the Split Color
parameter is specified, the "Color Parameter" will be an available option in the
color drop-down menu of the Shapes Second Violin section (see the
Formatting Summary Charts  chapter for more information). The
maximum number of color levels that can be specified in the spreadsheet
column for Split Violin Color parameter, is equal to the number of categories
multiplied by the number of groups.

An example of Box and Whisker, Violin and Beeswarm plots are depicted in
figure 5.295 below.

Note: the column header in the spreadsheet is defined by the user. In the
example below, "Values", "Category", "Group", "Split", "Color" and "Split Color"
were used as column headers.

Fig. 5.290. Example of Box and Whisker, Violin plots and Beeswarm charts.
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Summary Charts may be inserted into the layout via the ribbon bar Insert
tab , by selecting the chart of interest, or via the Data
Navigator  by drag and drop.

To create a Summary Chart via the ribbon bar:
1.  Select a Spreadsheet  containing the data intended for graphing.
2.  Click the Insert tab  command.
3.  Select between Box and Whisker, Violin and Beeswarm style.
4.  Click on a blank space of the layout to insert the chart.

To create a Summary Chart via the Data Navigator :
1.  Drag a Spreadsheet containing the data that has to be graphed from the

Data Navigator  to an empty part of the page.
2.  Release the mouse button.
3.  Select Box and Whisker, Violin or Beeswarm from the Select Plot

Types… dialog.

By default, Summary Charts plot the first two columns of the Spreadsheet for
the Category and Values parameters, respectively. To populate the Summary
Chart with parameters other than the first two columns of the Spreadsheet,
either:

· Click on the X and/or the Y axis parameter name within the plot and select

the intended parameter to use as Category and/or Values parameter
respectively; or,

· Change the Category and/or the Values parameters from the Overlay

Formatting dialog .

5.6.8.6.2  Formatting Summary Charts

The Formatting Overlay dialog is common for all Summary Charts and allows
users to define:

· Optional Group, Color, Split Violin and Split Violin Color parameters.

· Summary Shapes (e.g. Box, Violin, Beeswarm, Outliers,...) and Lines

(e.g. Box border, Whisker, Mean, Median, Violin Border...) to display on
the plot.

· Rules to define Outliers (when Outliers are visualized).

· Rules to define the Whisker extension (when Whiskers lines are

visualized).
· Kernel Density Estimation (when the Violin shape is visualized).

To access the Formatting dialog for Summary Charts (Figure 5.296 below),
either:
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· Select the Summary Chart and use the Format tab Plot

Options  command, or
· Right-click on the Summary Chart, select Format from the pop-up menu,

and choose the Overlays category.

Fig. 5.291 Box and Whiskers Plot Overlays

Option Explanation

 Overlay options
(Category, Values,
Group, Color, Split
Violin and Split Violin
Color Parameters)

The parameter (i.e., Spreadsheet column) intended for the each
of the Category, Values, Group, Color, Split Violin and Split
Violin Color Parameter is set using the appropriately named  ...

Parameter dropdown menus ( ).

Category and Values parameters are mandatory for all
Summary Charts. The other parameter are optional. The Split
Violin and Split Violin Color parameters only apply when the
Violin shape is visible (see Shapes section below).
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Option Explanation

§ Category parameter: Is the primary classification label.
This parameter is mandatory for all Summary Charts.

§ Values parameter:  The numerical freetext or token
value to be plotted for each row, where each row
corresponds to a data point.  

§ Group parameter: A second level of classification. When
a Group parameter is defined, the data within each
Category is graphed separately accordingly to the group
classification. In the examples below (Figure 5.297), the
Group parameter contains two classifications: "Ctrl" and
"Treated".

§ Color parameter:  The column of the spreadsheet
containing the colors that should be used for each
Category. When the Color parameter is specified, the
"Color Parameter" will be an available option in the color
drop-down menu for the element of interest (e.g. the Box,
the Violin or the Beeswarm) in the Shapes section (see
below). The number of color levels specified in the
spreadsheet column for this parameter, must match the
number of categories.

§ Split Violin Parameter: A third level of classification.
When the Split Violin parameter is selected, and both the
Violin and the Second Violin shapes are visible (see the
Shapes section below), each violin will be split in two
halves based on the parameter values. The split parameter
must contain no more than two different classification
labels. In the examples below, the Split Violin parameter
contains two classifications: "M" and "F".

§ Split Violin Color: The column of the spreadsheet
containing the colors that should be used for each second-
half of each violin. When the Split Violin Color parameter is
specified, the "Color Parameter" will be an available option

in the color drop-down menu of the Shapes Second
Violin section (see below). The maximum number of color
levels that can be specified in the spreadsheet column for
the Split Violin Color parameter is equal to the number of
categories multiplied by the number of groups.

 Shapes The Shapes list allows to select which element of plot shapes to
format:

§ Box: The box which outlines the middle two quartiles and
is optionally bisected by the Mean or Median Line. Box is
visible by default when a Box and Whisker plot is created,
and hidden otherwise.

§ Non-Outliers:  Data points which are not outliers
according to Outlier Options. Visible by default when a Box
and Whisker plot is created, and hidden otherwise.

§ Mild Outliers:  Data points which are mild outliers
according to Outlier Options. Visible by default when a Box
and Whisker plot is created, and hidden otherwise.

1284
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Option Explanation

§ Extreme Outliers:  Data points which are extreme outliers
according to Outlier Options. Visible by default when a Box
and Whisker plot is created, and hidden otherwise.

§ Mean Point:  The statistical mean of the dataset. Hidden
by default on all summary charts.

§ Median Point: The statistical median of the dataset.
Hidden by default on all summary charts.

§ Violin: The primary violin. Visible by default when a Violin
plot is created, and hidden otherwise.

§ Second Violin: The secondary violin plot (only available if
a Split Violin Parameter is defined; see above). Hidden by
default for both Box and Whisker and Beeswarm plots.

§ Beeswarm: Allows users to display each single data point
as a Beeswarm plot. Visible by default when a Beeswarm
plot is created, and hidden otherwise.

Formatting options for the selected element will be displayed at

the right (Figure 5 above ). Available formatting options
depend on the selected elements:

§ Shape
§ Color
§ Fill Color (not available for Violin and Second Violin shapes)
§ Fill Style (not available for Violin and Second Violin shapes)
§ Size (or Scale, for both Violin and Second Violin shapes)

If a Color Parameter has been selected in the Overlay
Options (see above) the color for the selected shape may be
set to "Color Parameter".
If a Split Violin Color Parameter has been selected in the
Overlay Options (see above) the color for the Second Violin
may be set to "Color Parameter".

 Lines The Lines list allows to select which lines to format:

§ Box Border
§ Whisker
§ Mean Line  
§ Median Line
§ Violin Border
§ Second Violin Border

The lines above are visible and formattable only when they
corresponding shape is visible. E.g. the Second Violin Border only
applies if the Second Violin shape is made visible in the Shape
section (See above).

Formatting options for the selected element will be displayed at

the right (Figure 5 above ). Available formatting options are:
Width, Style and Color.
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Option Explanation

If a Color Parameter has been selected in the Overlay
Options (see above) the color for the selected line can be set
to "Color Parameter".
If a Split Violin Color Parameter has been selected in the
Overlay Options (see above) the color for the Second Violin
Border can be set to "Color Parameter".

 Outlier Options In Outlier Options, the Lower and Upper Percentiles and
Interquartiles range factor are set in order to define the Mild
and Extreme Outliers which may be plotted according to the

Shapes settings ( ).

Outliers are visible by default when a Box and Whisker plot is
created, and hidden otherwise.

 Whisker Options In Whisker Options, whiskers may be either set to either:
§ Draw whiskers to the minimum and maximum of the

data set, or
§ Draw whiskers to the farthest point in the data set

that is not a mild outlier according to Outlier Options

(Figure 5 above ).
Whiskers are visible by default when a Box and Whisker plot is
created, and hidden otherwise.

Kernel Density
Estimation Options

The Kernel Density Estimation is used to draw the Violin shape
and may be customized by changing Resolution, Bandwidth
method and value, Clamp method and Minimum/Maximum values.

The Violin shape is visible by default when a Violin plot is
created, and hidden otherwise.

https://en.wikipedia.org/wiki/Interquartile_range
https://en.wikipedia.org/wiki/Kernel_density_estimation


Plots and Other Objects 635

© 2023 De Novo Software

Fig. 5.292. Example of Box and Whisker, Violin plots and Beeswarm charts.

5.7 Multi Plot

The Multi Plot feature in FCS Express allows a user to insert multiple plots to
display combinations of parameters and compensations with a single click. The
resulting plots are grouped together allowing them to be re-sized and formatted
individually or as a group. The plots may also be ungrouped at any time.

To use the Multi Plot tools you will need to first insert a plot into the layout.
Once the plot is selected the Plot tab will appear within the ribbon where a Multi
plot type may be selected (Figure 5.298). 
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Figure 5.293. Multigraph Options in the Ribbon.

The available multi plot displays are, Histograms, All Parameters by X, All
Parameters by Y, NxN Plots, NxN Plots Compensated, and Color by All
Parameters. The maximum number of parameters and font size can be
adjusted in User Default Options  for multiplots. 

Once a multi plot type is selected, parameters may be included or excluded from
the multi plot by checking or un-checking the appropriate box in the Select
Parameter(s) window (Figure 5.299).  Using the Filter: field a user can remove
unwanted parameters from view to simplify selection.  For example, if a user
only wanted to select area parameters typing "-A" in the field would reduce the
numbers of parameters seen in the parameter list. To select or deselect all
parameters, right-click in the window to access the pop-up menu.  Note for NxN
Plots the creation of histograms displaying each selected parameter is optional.

1620
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Figure 5.294. Select Parameter(s) window for Multi Plot's.

After creating a multi plot group, the plots making up the group will maintain the
same formatting, gates applied, gates to display, and overlays as the parent plot.
Plots can be formatted individually by selecting the individual plot or as multiple
plots by selecting the entire multi plot group and selecting each plot you wish to
format while holding the shift key. The multi plot will be a grouped object but
plots can be ungrouped at anytime. To do so, select the entire multi plot and
right click and select grouping ungroup.

Please note that creating multi plots from data sets with a large number of
parameters may reduce the performance of FCS Express due to the large
number of plots created. The default options for the maximum number of
histogram, parameters by X, and parameters by Y multi plots is 49. The default
maximum number of NxN Plots and NxN Plots Compensated is 10. The default
options may be increased via the  User Default Options  for multiplots.

· The Histograms option will insert 1D histograms of every parameter in the

data set (Figure 5.300).

1620
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Figure 5.295. Parent Plot and Histograms Multi Plot.

· All Parameters by X will insert the 2D plot type of the parent plot with the X

axis of the parent plot consistent across all plots. The Y axis will change for
each parameter in the data set (Figure 5.301).

Figure 5.296. Parent Plot and All Parameters by X Plot.

· All parameters by Y will insert the 2D plot type of the parent plot with the Y

axis of the parent plot consistent across all plots. The X axis will change for
each parameter in the data set (Figure 5.302).



Plots and Other Objects 639

© 2023 De Novo Software

Figure 5.297. Parent Plot and All Parameters by Y Plot.

· NxN Plots will create multi plots that display combinations of all parameters

(including time and scatter) versus each other (Figure 5.303). ):

Figure 5.298. NxN Plots.

NxN Plots Compensated will create Multi Plots that display combinations of
all parameters versus each other of the parameters involved in the
compensation matrix of the parent plot (Figure 5.304).  The background color
of plots will change to match the color shown for the spillover value of the Y-
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axis parameter (source) and the X-axis parameter (target) in the
Compensation/Unmixing window .

Figure 5.299. NxN Plots Compensated.

· Color by All Parameters will create Multiplots from Density, Contour and

Heat-map plots in which the color mapping is defined by the Color Based
On  selection. It is most useful for transformations such as tSNE ,
UMAP , FlowSOM  and SPADE ,... to quickly investigate the distribution
of multiple parameters of interest on the corresponding map. Figure 5.305
shows an example of Color by All Parameters Multiplot on a tSNE map
using a Density plot

839
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Figure 5.300. Color by All Parameters.

Note:  When creating the Multi Plots for a tSNE or UMAP transformation, the
source plot should be set so that tSNE-X and -Y or UMAP-1 vs -2,
respectively, are displayed on the X- and Y-axes (i.e., as shown in the plot in
the upper-left corner above). Also, ensure that the Legend  is displayed on
the Multi plot group, to denote the parameter on which the coloring is based
for each plot within the group.

Figure 5.306 shows an example of Color by All Parameters Multiplot on a
FlowSOM transformation using a Heat Map.

341
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Figure 5.301. FlowSOM transformation displayed on a multiplot colored by all
parameters.

5.8 Formatting Options

FCS Express provides users with the ability to customize virtually every aspect of
each analysis object (e.g. text boxes, plots, histograms, statistics tables,
pictures, and more).
This section discusses common formatting options available to all objects in a
layout (List 1 below). However, many of the objects in FCS Express have also
specific formatting options which you can change to bring out the important
features of your data (List 2 and List 3 below).

1.  Common Formatting Options for all objects
· General

· Fill

· Border/Line

· Size

· Authorizations
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2.  Specific Formatting Options for Plots
· Common Options for all Plots

· 1D Plots

Histograms
Mulitcycle
Proliferation
Subtraction

· 2D Plots

Common Options for all 2D Plots
Dot Plots and Color Dot Plots
Density and Contour Plots
Surface
Kinetics

3.  Specific Formatting Options for Other Plots
· Picture Plots

· Heat Maps

· Gate Heat Maps

· Spectrum

The Formatting Options dialog can be accessed in one of three ways:

1. Selecting one or multiple object(s) and then using the appropriate
commands from the Format Object Options group in the ribbon  

2. Double click on an object. 
3. Right-click on an object and choose Format from the pop-up menu.

In the Formatting Options dialog, all formatting options available for the
selected object(s) are accessible from the drop-down menu at the top of the
dialog, and are organized in different categories (e.g.  General, Fill, Border,
Size ... amongst others depending on the object being edited). 

The Formatting Options dialog will apply changes as they are made across the
selected plots. You can also restore any object to its previous state by using the
Undo button in the Quick Access Toolbar .

An example of the dockable formatting window is shown in Figure 5.307. The
dockable format window will open by default docked on the right side of the
screen if no other dockable windows are currently docked. If a window is
currently docked, the formatting window will appear as a floating window. If a
layout is saved with a dockable window opened, that position will be saved and
will be used every time that dockable window will be opened. If there is already a
window docked into the position where a newly opened window used to be, then
the newly opened window will just pop up in the middle of the screen. Users may
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open as many separate formatting windows as they would like and they may be
docked together for easy access. 

Figure 5.302  Dockable Formatting Window.

5.8.1 General

You can edit General properties in one of two ways:

· Select the object and use the Format Object Options General

command.
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· Right-click on the object, select Format from the pop-up menu, and

choose General from the dropdown.

For most objects, the only general formatting options are:
· object's name

· object visibility

Plot names assigned by default include information about the plot type , .fcs
file data, displayed parameters, and order of creation in your layout.  Plot names
appear in hovertext over the plot  (Figure 5.308) and in navigators , and
assist in selecting the data source  when inserting a token on your layout or in
setting up batch processing actions .  

Figure 5.303 Default plot name as shown in plot hovertext.

Plot names can be customized to contain free text, tokens , or a combination
thereof. The same plot's hover text is shown below in Figure 5.309 after being
changed to a combination of freetext (i.e. "control sample from mouse #5A)
and the $DATE keyword token (i.e. "27-MAR-2008").
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Fig. 5.304 Plot name changed to contain freetext and a
keyword token.

To customize the plot name, either:
· Select the plot, use the Format Object Options General command, and

edit the Plot Name, or 

· Right-click on the plot, select Format from the pop-up menu, choose

General from the drop down, and edit the Plot name.
· The Data, Layout, or Gate Navigator  may also be used to change the

Plot name by right clicking on the plot within the navigator and choosing
Rename. 

· Alternatively, a Suffix for Compensated Data may be added or removed

from the 
Data Category.

Object Name

For all objects, the name property is the label displayed as tool tip while hovering
the mouse cursor over the object. For plots, the name property is the name of
the plot to display in lists where the user is required to select a plot. The name is
also used when displaying objects in different Navigators . The name field

includes an option to insert a token as the name by clicking on the  button to
the right of the edit field.
Please note that Plots' name can be also changed from the Gate Navigator
window.

Object visibility can be set to:
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· Always visible (default) - The object is always visible in the layout.

· Never visible - The object is always hidden unless the 

Items  button of the ribbon bar is selected.
· Custom - The option allows you define visibility of the object based on a token

or value that evaluates to a conditional expression . Any tokens or values
may be used to set a conditional custom value and may be inserted  via right
click in the field, Insert Token or by clicking on the T token icon. The object
will only be visible if the token evaluates to True.

Data Grids have some extra general options (Figure 5.310).
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Figure 5.305  Formatting General Dialog for Data Grids

Besides the usual name property (referred to as Data window name), you can
also choose a compensation  definition, a transformation , a gate to display
data for, how to display the numbers in the grid, and whether or not to change
the data in the grid during batch processing  or in response to a
Next/Previous  command.

Lastly, the Show the Cell Number column checkbox controls whether the cell
or object number (assigned by the cytometer according to the time of sample
acquisition) is shown as a column in the Data grid.
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5.8.2 Background / FIll

When an object is in edit or selected mode, the background is the area within the
red or green outline.

You can format the Background Color and Image in one of two ways:

· Select the object(s) and use the Format Object Options Fill command.

· Right-click on the object, select Format from the pop-up menu, and

choose Fill from the drop down as shown in Figure 5.311.
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Figure 5.306  Formatting Background dialog for a plot

Once the dialog opens, select a background color (Solid or a Gradient of
colors). The Solid color can be selected from the Color drop down palette, or
from the Custom option.  The Custom option can use a Custom Token  to
determine whether the background turns a specific color.  For example in Figure
5.312, the dot plot will turn green if the % of Lymphocytes is greater than 10.  
Note: The output of the formula must be the regular name of a color, such as

1337
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"green" or "blue" or you can use the hex code for a color, preceeded by a $,
such as "$FF1E00." 

Figure 5.307  Custom formula determines background fill color

Alternatively, an Image can be centered, stretched, or tiled in the background.

With some objects (e.g., text boxes, gate views, or shapes) the dialog title is
Formatting Fill/Background. With these items, you can also choose a pattern
as a fill or make the background transparent. Transparency allows any object
which is behind the item to show through. Plots do not support the Transparent
option.

The Frames option (for plots) controls whether or not frame lines are Visible on
top and to the right of the plot. You can also set the Color and Size (thickness)
of the frame lines.

With the Margins options (seen when formatting plots), you can set the space
around the margin of the plot. This is most useful when the text on the right-
most x-axis label of the plot is being cut off. To correct this, increase the right
margin percentage to increase the space between the right margin and the end
of the x-axis.

5.8.3 Border / Line

The Border/Line options (Figure 5.313) allow you to adjust the border around
an object. By default, objects have no border.

When the object is in edit or selected mode, any border will appear inside and
adjacent to the red or green outline. You can customize the border/line options
in one of two ways:
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· Use the Format Object Options  command on object(s) in

edit or selected mode.

· Right-click on the object, select Format from the pop-up menu, and

choose Border/Line from the drop down.

Figure 5.308  Formatting Border/Line dialog

5.8.4 Size

The Size category (Figure 5.314) is for adjusting the current size of an object.
All sizes are specified in inches.

To change the size of an object, use the Format Object Options
command on an object in edit or selected mode, or right-click on the object,
select Format from the pop-up menu, and choose Size from the dropdown.
You can change the absolute size, or scale the object by a certain percentage.
By enabling the Lock Aspect Ratio checkbox, you ensure that the width and the
height change in the same ratio (thereby keeping the object in the same
proportion).

The Original Size is only meaningful for inserted pictures. For other objects, the
Original Size will always be the same as the current size.

Position Anchors maintain an objects' position and size within the layout. If the
selected object is a textbox within a plot, the Position Anchors options will
maintain the textbox's position and size within the plot.
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Note: When the object to be resized is a Text Box containing a token, table, or
text, you will not be able to make the text box smaller than the minimum size to
display the text or the minimum dimensions of the token or table (see Resizing
Text Boxes ).

Figure 5.309  Formatting Size dialog

5.8.5 Formatting Authorizations

The Authorizations category (Figure 5.315) may be adjusted for any object in
FCS Express. Authorizations allow user to control when objects are selected or
edited based on settings in Formatting Authorizations.  

All objects in FCS Express may be assigned Authorizations, or rights, which
allows or prevents layout users from placing objects in Select mode or Edit
mode or both. Authorizations can be set to always allow, never allow, or
always allow/do not allow based on the value of a token. For instance, a token
value can be set to allow selection of a plot if the current FCS Express user
equals a specific person or a plot can remain non-editable unless a particular
statistic value is met, e.g., the number of events for a particular gate is higher
than an arbitrary value. See the Working with Authorizations  section in the
manual for additional details on setting up these conditions.  

Authorizations allow for an additional layer of control at the layout level for any
object. 
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Figure 5.310 The Authorization feature. 

Users can access the Formatting Authorizations navigator by using the ribbon
after selecting object(s) or right-clicking selected object(s) and choosing
Format.

To access Authorizations using the ribbon:
1. Click on an object to select it. 
2. Click Format tab  command (Figure
5.316).

Figure 5.311 Accessing Authorizations for selected object(s)

The Formatting Authorizations dialog will appear allowing actions to be
formatted when allowed.

To access Formatting Authorizations via an object:

1. Right-click on a selected object(s).
2. Choose Format. 
3. Select Authorizations from the dropdown (Figure 5.317).
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Figure 5.312 Formatting Authorizations navigator via
right-clicking selected object(s)

5.8.5.1 Working with Authorizations

The Authorizations options may be accessed by formatting plots as described in
the previous section . 

Authorizations may be set for two Actions, Select and Edit. Either option may
be chosen individually in the Actions list or both Actions may be multiple
selected to change them together. Setting an Authorization for either or both
Actions will control if an object may be placed into Select mode or Edit mode
thus limiting the specific actions that may be taken with a plot. For instance, if
Never Allowed is chosen for the Select action then a plot may not be placed
into selection mode and moved or resized on the page. If Never Allowed is
chosen for the Edit action then the plot cannot be formatted, gates cannot be
created, or nor can any actions available via the right click menu. If Never
Allowed is chosen for both the Select and Edit actions then the plot cannot be
formatted or moved. 

The default status of Actions on all objects is Always Allowed. Selecting the
Never Allowed radio button will disallow access to the Select or Edit Action.
Choosing the Custom radio button will allow you to define a condition that must
be met to Allow or Never Allow the Action. For instance, in the example below,
Figure 5.318, a formula was defined in the Custom field. The chosen plot will not
be allowed to be in Select mode if the token value (highlighted in grey - 35.06))
is above the reference value (30). Any tokens may be used to set a conditional
Custom value and may be inserted  via right-click in the field, Insert Token,
by clicking on the T token icon, or by dragging and dropping a token into the edit
field. 
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Figure 5.313 - The Authorizations formatting dialog. In
the example a Select action was set to be Custom and
is only allowed if the formula returns a true result. In
this case the plot will remain not selectable because

the token value (highlighted in grey) is higher than the
reference value of 70. 

Values must be returned as "true" to be allowed / "false" to never allow. Please
note that if are evaluating a token whose result type is text, then the standard
value must exist in quotes (e.g. the "Aurora" in Figure 5.319 below). 

Figure 5.314Authorizations window showing proper syntax for text-type tokens to
return a true/false value.

Authorizations may also be overridden. Overriding Authorizations  is particularly
useful if the Edit Action is set to not be allowed but an edit or change to the plot
or Authorization is needed. 

657



Plots and Other Objects 657

© 2023 De Novo Software

5.8.5.2 Overriding Authorizations

To override authorization(s), click to select object(s) and click Tools
tab click Override Authorizations (Figure 5.320).

Figure 5.315 Override Authorizations under Format tab

Please note, for users not using the security add-on , any user can override
authorizations.  Users using the security add-on can allow or prohibit access to
Formatting Authorizations  or Override Authorizations at the User ,
Layout , or Security Group  level.
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6 The Data List

In this chapter we will cover using the Data List to manage loading and organizing
data sets.

When a new layout is created, the Data List is displayed by default at the top left
corner of the screen. Users may change the default of view the data list at
startup in the Data List User Options .

To access the Data List when it is not visible, use the Batch (or Data)
tab Organize Data Sets  List command to bring up the Data List
window (Figure 6.2). The Data List is a dockable window .

The Data List is an important dialog in FCS Express that allows users to:
· Load data

· Define the order in which data will be Batch Processed.

· Manage Iterations and Controls

Note: If changes are made to the data files, keywords, or data loading
preferences (e.g. Instrument Specific Settings ), the data stored in the
memory cache may be refreshed and reloaded using the Refresh  button in the
Data tab.
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Figure 6.2  The Data List in FCS Express is used to
load and organize data files for analysis. 

The icon buttons in the Data List window are explained in the table below.

Icon Button Explanation

Add Data File.
The Add Data File option allows users to directly add data files into the data
list through either the Select a Data File Dialog or the Advanced Open Data
Dialog .
For more details and more options on how to load data files into the data list,
please refer to the following chapters: 
o Cytometry data and merged data  (see the Supported File Formats

chapter for the supported file types, and the Batch Export  chapter to
learn how to merge data)

o Virtually Merged Data  (on-the-fly data concatenation)

o Gated data  (i.e. virtual data that contains only events within a

selected gate(s)).

Add Blank Tube allows for the addition of "blank tube(s)" place holder(s) in
the data list. Blank tubes are particularly useful with panels . 

Format. Brings up the Format Data List dialog where you can add
keywords to be used for sorting data files into the Data List , show or hide
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Icon Button Explanation

file paths, or show the Iteration Column.
Note: You can also hide file paths by default by adjusting your FCS Express
User Options .

 and 
Move selected file(s) up and down respectively.
The order in which items appear in the Data List is an important
consideration. Items are batch processed  in the order that they appear in
the list, and the Next and Prev commands  change items in the order that
they appear in the list, as well.
Please refer to the Managing Iterations and Controls in the Data List
chapter for more details on how important is to properly order data files into
the data list.

Change file drop down list to access Change Data on Selected Plots
command or Change Data on All Plots command.

Search for files using Find Data Files  dialog.

Delete the selected file(s).

Sort on All Keywords . The sort is performed based on the priority order of
the keywords in the "Selected Keywords" dialog, or on the order of the extra
keywords columns (the default order of the columns is the same order as the
selected keywords). You can change the order by dragging the columns
around.

Note, if you drag the keyword columns around, or if you click on another
column header, it turns OFF the "sort by multiple keywords" option and you
have to click it again. 

Defer layout changes . When this button is selected and used in
conjunction with Panels , FCS Express will not refresh the data within the
layout until all changes have been made and the button has been de-
selected.

Once data files are loaded into the Data List right clicking on a data file in the
Data List will launch a menu with specific actions for the list (Figure 6.3) and
explained in table below. 
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Figure 6.3  Data List Right Click Menu  

Menu
Option

 Explanation

Forma
t

Opens the Format Data List dialog, also accessible via the   icon in

the data list dialog. A user can add keywords to assist in sorting data files,
show/hide file paths, show/hide File names, or show/hide the Iteration
Column by checking or unchecking the adjacent boxes.  You can also
hide file paths by default by adjusting your FCS Express User Options .

Delete Delete a selected data file(s,), also accessible via the  icon in the data
list dialog.

Move
Up

Will move the data file up in the data list, also accessible via the  icon
in the data list dialog.

Move
Down

Will move the data file down in the data list, also accessible via the 
 icon in the data list dialog.

Create
Gate
Data

Allows the user to make new data files within FCS Express that will
contain events only within a selected gate. Please see the Adding Gated
Data  section for more details on the feature.

SearchSearch for files using Find Data Files  dialog,also accessible via the 
 icon in the data list dialog.
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Menu
Option

 Explanation

Select
All

Allows the user to select all the data files that appear in the Data List.

Clear
Selecti

on

Will deselect any data files that were selected when accessing the right
click menu.

Invert
Selecti

on

Will deselect any data files that were selected and select any data files
that were unselected when accessing the right click menu.

Hide
iterati
ons

Will hide the iteration column.

The following chapters cover all features related to loading, organizing, and
working with your data files in the data list. 

· Adding Data to the Data List:

o Cytometry data and merged data  (see the Supported File Formats

chapter for the supported file types, and the Batch Export  chapter to learn
how to merge data)

o Creating Virtually Merged Data  (on-the-fly data concatenation)

o Gated data  (i.e. virtual data that contains only events within a selected

gate(s)).
o Blank Tubes

· Organizing data files into Iterations and Controls

· Load Data Sets and Iterations in the Layout

6.1 Adding Files to the Data List

Four methods can be used to add data sets to the Data List.

Note: The list of compatible data can be found in the Supported File Formats
chapter.

1) Add files by dragging and dropping data files into the data list.

Drag data files from any location on your computer directly into the data
list and release the mouse button. 

664 26

1443

668

672

691

660

680

26



The Data List 665

© 2023 De Novo Software

2) Add files by dragging and dropping data files into the layout.

When data files are inserted in the layout by inserting a plot , the data
list will automatically populate with the data file that was inserted and all
other files that are located in the same folder as the inserted file.

3) Adding files without searching.

1.  
.

2. Click on the  button Add Data File to bring up the Select Data
File  dialog (if Standard Open Data Dialog is chosen under user
options) or the Open Data File  dialog (if Advanced Open Data
Dialog is chosen under user options).

3. Select the appropriate files and click on the Open button to add the files
to the Data List. The dialog allows you to add multiple files at once
using standard Windows commands (e.g., Shift-Click or Ctrl-Click to
select multiple files at the same time).

Note: If you have set an active Panel , you can simply choose the first
file/tube in your Panel, and FCS Express will ask if you want to automatically
load the rest of the files/tubes in the Panel.

Additionally, Click on the  Add Blank Tube to add a "placeholder"
to the data list. Blank Tubes are particularly useful when using panels .

4) Search for files or conditionally select files.

If you do not know where your data files are located, or if you wish to
select files based on one or more conditions, you can perform a search.

Note: Since FCS Express Version 4, FCS Express is no longer limited to
opening only FCS files. Therefore, to properly utilize functions which are
related to Keywords, you must highlight the appropriate data set/file (so
that FCS Express knows which type of Keywords to display) before doing a
keyword search.

1.  
.

2.  Click on the Search button   to bring up the Find Data Files dialog
(Figure 6.4).
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Figure 6.4  Find Data Files Dialog

Select one or more of the three tabs at the top of the Find Data Files dialog
to set search criteria for finding the files you want to add to the Data List. All
the search criteria work together, so you can select any combination before
clicking the Find button.

· On the Name & Location tab, click the Browse button, navigate to the

directory to search, then press the Find button. Note: Setting an
appropriate directory on the Name & Location tab first will make
searches faster even if you are using the date or keyword conditions
below.

· To search for files based on their date, click on the Date tab and enter

the search criteria. 

· To search for files based on the value of a keyword, select the

Conditions tab. (Recall that you must highlight/select a data set/file in
the Data List for Keyword searches to work properly.) By default, there
are no conditions set, so click the Add Condition button. A new line
appears in the table, and the first column will be unavailable. Click on the
button in the Keyword column and select a keyword (e.g., $TOT for
total number of events) from the Please select a keyword dialog. You
can also type in the keyword within the field.  In the Relation and Value
columns, select the keyword range to search. For example, to search
for files with more than 20000 events, select > (for less than) in the
Relation column, then enter 20000 in the Value column.

· To search for files based on more than one keyword, click on the Add

Condition button again. This time, select the Operator from the first
column. The Operator default is AND to specify both keyword conditions
must be met. Otherwise, select the operator OR to specify either
keyword condition may be met. After selecting the operator, enter the
Keyword, Relation and Value options as before.



The Data List 667

© 2023 De Novo Software

When you are ready to run the search, click on the Find button. Remember
that all of the conditions work together, so you can select a starting folder,
date criteria, and keyword conditions before starting the search.

While FCS Express is finding the files that match your search requirements,
the window will expand to include the Search Results field. As files are found,
they will be added to that field. To halt the search before it is complete, click
on the Stop button. Figure 6.5 shows a search for all files within a specified
directory with greater than 20,000 cells acquired.

Figure 6.5  Search Files by Keyword

Once all the files have been found, add the files you want to use in the Data
List. To add files individually, click on a file name to select it. To select more
files, press Ctrl (or Shift) while you click on a file name, then press OK. Once
the appropriate files have been highlighted, press the Down Arrow button. To
remove files from entry into the Data List, select the files to be removed and
click the Up Arrow button. When you have finished choosing files for the
Data List, press OK.
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If you wish to perform a second search, first add the files from the current
search, then perform subsequent searches. When files are added to the Data
List and an active Panel  is set, each group of files (representing the tubes
of the Panel) will appear in alternating colors. This makes it easier to
distinguish between the different files of a Panel.

6.2 Adding Merged Files to the Data List

Cytometry data files are typically added as separate data files in the data list.

However, multiple files may be merged together (concatenated) and loaded as a

new file using the Merge FCS Files file format from the file of type drop down. 

Once a merged data file is added to the data list it may be used in any of the

plots and analysis your perform in FCS Express. Identifiers for Merged FCS files

are controlled via instrument specific settings  and may be set as numeric

values (file identifiers) or textual (classification identifiers).

Merging data files using the Merge FCS Files file of type is a convenient way to

load and visualize multiple files on one plot, for instance, with an antibody

titration or drug treatment series, and may prove particularly useful when

performing transformations  where an algorithm must be run on a file that is

representative of all samples in the experiment. Merged files may also be

represented in a plate heat map even if they were not acquired on a plate .

When using the Merge FCS Files option there is no need to export as a new

data file as the files that are selected will be "virtually" merge on the fly. Virtually

merged files can be used as any other .FCS File would be used. They can be

displayed in any plot types  and statistics  can be derived from them as well.

Please also see the chapter on Exporting FCS File Data from Multiple Files  if

you would like to merge multiple data files and save the resulting merged data

file as a new .FCS file. 

To begin merging data files using the Merge FCS Files option:

1.  Open the Data list .

2.  Click on the  button. 

The Standard Open Data Dialog will appear as in Figure 6.6 below. 

Note: based on your User Options , the Advanced Open Data Dialog  may

appear. If the Advanced Open Data dialog appears, please select the

 button to access the Standard Open Data Dialog.
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3.  Select Merge FCS Files (*.fcs; *.lmd; *.*) from the files of type drop-

down menu (Step 1, figure below).

4.  Select multiple files from your computer (Step 2 in figure picture below).

5.  Click Open File.

Figure 6.6 - The Standard Open Data dialog

The selected files will be virtually merged / concatenated in alphabetical order and

a single file will be listed for them in the Data List (Figure 6.7).
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Figure 6.7 - The Data List with the virtually merged file loaded.

The virtually merged file is concatenated as follow:

· Files are concatenated in alphabetical order.

· The compensation matrix of the first file is applied to all the following files (the

compensation matrices of the following files are not used).

· A File Identifier  and a Classification File Identifier  are added. The first one

can be used to discriminate the merged files using 1D and 2D plots afterward.

The second one can be used to discriminate merged files using an Plate Heat

Map  plot afterward.

An example of a virtually merged file is depicted below. The File Identifier

parameter can be displayed on 1D and 2D plots. Single files can be selected by

Converting and Linking Markers  on 1D plots, or by using 1D or regular gates

on 2D plots (Figure 6.8, upper panes). The Classification File Identifier

parameter can be displayed on 1D and 2D plots.  It will display the filename of

the individual files within the merged file.  Specific files can be identified using

markers or gates as described above.  The Classification File Identifier can

also be displayed in Plate Heat Map  plots. With Plate Heat Maps, single files can

be selected by using Well Gates  (Figure below, lower pane).
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Figure 6.8 - The virtually merged file is loaded into different plots
displayin either the File Identifier or the Classificiation File Identifier
parameter. Single files are also selected by Markers (Converted and

Linked to gates), 1D Gates or Well Gates.

*Note: The x-axis labels have been formatted to be displayed at 90 degrees in
the 2D plot displayed in upper right corner of the image above.  Please see the
Axes  section for more information about formatting axis labels.

Plate Heat Map plots displaying the virtually merged files can be customized in

term of both Color Scheme  and well layout . The example below shows the

same Plate Heat Map plot above, with both the color scheme and the well

layouts customized (Figure 6.9).
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Figure 6.9 - The same Plate Heat Map plot of the
figure above, customized both in term of color

scheme and well layouts. 

Note: the virtually merged file can be exported as a merged file by using the

Single File Export tool  and by selecting the DNS data stream file (*.dns) file

type.

6.3 Adding Gated Data to the Data List

In addition to actual cytometry data files, the data list can also create "Gated
Data" files. These are virtual data files that only contain the events that are within
a user specified gate(s) from an original cytometry data file.

This can be especially useful in combination with Batch Processing. It allows the
user to perform batch processing through specified gates.

Gated data can be added to the Data List by right clicking on a data file loaded
into the Data List and selecting Create Gated Data... from the right click menu
(Figure 6.10).
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Figure 6.10 The right click menu that open after right-clicking on a
file into the datalist.

A user can select gates in the Create Gated Data dialog window (Figure 6.11).
The user can select one of three options: All gates, Only the gates checked
below, All gates except those checked below. The Gates created in the
layout will be displayed in a hierarchical format.
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Figure 6.11 the Create Gated Data window.

After clicking OK, the Data List will be populated with the Gated Data of the gates
of interest (Figure 6.12).
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Figure 6.12 The Data List populated with the gated
data of interest.

TIP: At this point, the original data file can also be removed by the Data List if
needed.

Possible applications of this feature are:

1) Batching through different files within a merged data .
This requires the user to first create gates on the File/Classification Identifier
parameter .

2) Batching through different clusters derived by a clustering algorithm .
This requires the user to first:
o Save the data with the clustering assignment embedded (see this chapter

of the manual  to learn how to save data in DNS format).
o Import the DNS data into a new layout.

o Create gates on the Cluster assignment parameter .

6.4 Organizing data files into Iterations and Controls

An Iteration is a set of one or multiple samples (e.g. FCS files) that are intended
to be simultaneously analyzed together on the same layout. For instance, an
iteration could consist of a single sample (when samples are analyzed one at a
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time) or multiple samples (when multiple samples are analyzed together at the
same time.)

Three examples of how data files may be organized into iterations are presented
in the figures below:

· Left: Example of Data List in which an Iteration contains one data file. In this

example, all samples have been stained with the same antibody panel so they
can be loaded and analyzed one-by-one, one data file per iteration, using the
same FCS Express layout/template.

· Center: Example of Data List in which an Iteration contains two data files. In

this example, each sample has been stained with two antibody panels, one for
the FMO (i.e. Fluorescence Minus One) and one for the Fully Stained. For each
sample, the FMO and the Fully Stained are loaded and analyzed together into
the layout, two samples at time, two data files per iteration. 

· Right: Example of Data List in which an Iteration contain three data files. In

this time-course experiment, each sample has been stained at three different
time points. Time points for each sample are loaded and analyzed together into
the layout, three samples at a time, two data files per iteration. Samples (i.e.
Iterations) are analyzed one-by-one.

The three examples described do not encompass all of the possible use cases of
working with iterations in the data list as experiments and layout designs will
vary. (Figure 6.13).

Figure 6.13 Examples of organizing itrations in the Data List

The order of the data files into the Data List is important for two reasons:

· The order of the data files must be consistent between iterations. This is

important so that FCS Express can load the appropriate data file (e.g. the FMO
in the picture above, Data List in the center) into the corresponding plots (i.e.
the plots in the layout which are supposed to display the FMO data).
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· The overall order of samples (i.e. Iterations). This defines the order in which

sample will be analyzed (e.g. Sample 1 in the Data List at right in the picture
above, is analyzed for first, while Sample 2 is analyzed afterward). During
Batch Processing , FCS Express will run the defined Batch Actions ,
iteration-by-iteration, in the order they appear in the data list which makes
organizing iterations properly crucial to make the most out of Batch
Processing. In addition, the Next and Prev commands  change items in the
order that they appear in the list, as well.

Since data into the Data List are usually ordered alphabetically by default, said
automatic order might not reflect the user needs. For this reason Data files in the
data list may be moved up and down the list to manually order the data files
(see green-highlighted Up and Down buttons in the figure below)).

As mentioned above, Iterations are group of data files, usually referring to the
same sample, which can be loaded and analyzed sequentially into the layout.
However, an experiment may also include control data files which are common
to all samples. When this happen, the user may want to keep that control static
in the layout, regardless which sample (i.e. Iteration) is currently loaded. To
account for this, specific data files can also be set to to be a "Control" and not
belong to any iterations so the data file will be fixed in place within the layout,
either in a plot or overlay. Control data files are referred to as Stationary
Controls within FCS Express.

The number of data files in each Iteration, and the number of Controls can be
defined in two ways:

· Using the Increment value and the # Of Stationary Controls feature in the

Data tab .

· Using Panels .

Examples of two scenarios are depicted in the figure below.

Note: If a tube is associated with the wrong data file, you can reorder the files
using the Up and Down buttons (see green-highlighted Up and Down buttons in
the figure below).
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Example of the Data List defined with 5 Stationary controls and
2-samples per iteration.       

Example of a Panel defined with 5 Stationary controls and 2-tubes per iteration.
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6.5 Sorting in the Data List

The Data List window allows you to look at the values of certain keywords, and
to sort the list based on these keywords.

To select keywords to view:

1.  
List command .

2.  Click on an appropriate entry in the Data List to let FCS Express know
which keywords to display.

3.  Click on the  (Format) button to bring up the Format File List dialog.
4.  Click on Add. The Please select one or more keywords dialog will

appear.
5.  Click on a keyword to select it. To select more keywords, press Ctrl while

you are clicking the mouse button.
6.  Once you have selected all the keywords you would like to view, press

OK.

The Data List will have a new column for each of the keywords that you
selected (Figure 6.14).

Figure 6.14  Data List with Keyword Columns

By default, the Data List is sorted in alphabetical order based on data set name.
To sort the data sets by other criteria, click on any column title. The list will be
sorted based on the values in that column. Clicking on the title once will sort in
ascending order; clicking on the title a second time will sort in descending order;
clicking on the title a third time will return the list to the previous sort criteria.
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Additionally, you may click on the Sort On All Keywords icon  to sort all
keywords according to the column order they appear in the data list. 

You can also sort individual files manually (or groups of files) without clicking on

the column titles. Click on a row in the list to select it, then press the  (Up)

button to move that file up in the list, or the  (Down) button to move it down
in the list. You can move several file rows at the same time by selecting them
together using standard Windows techniques for selecting multiple objects

(Shift-Click, Ctrl-Click), then pressing the  or  buttons.

6.6 Load Data files and Iterations in the Layout

Once the Data List is populated with Data files, the user can:

· Load a specific Data file into one or multiple plots.

o By drag and drop a data file from the Data List (or from a folder on the

computer).

o Via the "Change Data" button of the Data List.

o By double click on a data file within the Data List.

o Via the "Change Data on "

buttons in the ribbon bar.

o Via the "Change Data on " in the ribbon bar.

· Load an entire Iteration into the whole layout .

o By a single click on the Iteration number into the Data List.

o Via the "Change Data on " buttons in the ribbon

bar.

o Via the "Change Data on " drop-down menu in the

ribbon bar.

6.6.1 Load a specific Data file into one or multiple plots

A data file of interest can be loaded into one or multiple plots in the following
ways:

Like other dockable windows  in FCS
Express 7, the Data List has drag and
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By dragging and dropping a data file
from the Data List (or from a folder
on the computer)

drop functionality. You can drag a data
set directly from the Data List to
your layout to either change the data
in an existing plot, to add the data as
an overlay in an existing plot, or to
create a new plot.

The When dragging a data set onto
a plot drop-down list in the General
category of the FCS Express User
Options dialog  controls the
functionality when you drag a data set
onto an existing plot. The drag and
drop operation will either:

· Replace the current FCS file on the

plot;
· Create a new overlay with the

dragged file, or;
· Open a dialog to select one of the

first two options.

If you drag a file from the Data List
directly onto a blank area of the
layout, a Select Plot Types... dialog
will appear asking which object(s) you
wish to open (Figure 6.15).

Figure 6.15  Select Plot Types... Dialog
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One or more objects can be chosen
by checking the appropriate box(es).
Once you have chosen the object
type(s), the new object(s) will open
showing the data from the data set
that you dragged from the Data List.

Via the "Change Data" button of the
Data List.

To use the Data List to change the
files/data sets on your plots (Figure
6.16):

1.  Click on a dataset in the Data List
to highlight it.

2.  Click on the  icon to Change
Data On Selected Plots or
Change Data On All Plots from
the drop down list.

Note: New Iteration Snapshots  will
not be recorded when using Change
Data On Selected Plots, and previous
Iteration Snapshots  will be
discarded.

Figure 6.16 - Available commands from
Change File drop down list

Tip: FCS Express allows to perform
the above mentioned actions also via
the following shortcuts:

Ctrl+L Change Data On
Selected Plots

Shift+Alt+L Change Data On
All Plots

1212
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By double clicking on a data file
within the Data List.

In FCS Express, you can use the Data
List to manipulate your data within the
layout.

For example, if you wanted to change
the base overlay in all of the plots in
your layout, you can double-click on
the data file within the Data List, and
choose the appropriate action.

By double-clicking on a data file in the
Data List, you will be prompted with
the Select double click action
window, as seen below (Figure 6.17).

Figure 6.17 Select double click action
dialog window

Once a selection has been made, FCS
Express can remember your selection
and not prompt you for an action.

As your data update, any tokens that
are included in the layout will
automatically update to reflect the
new data.

Via the Change Data on Selection
buttons in the ribbon bar.

The user can move up and down
through the Data List one file at a time
by using the Previous or Next
buttons. Use the Select button to
choose a specific data file from a
known folder location. (Figure 6.18)
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Figure 6.18 Change
Data on Selection

Note: New Iteration Snapshots  will
not be recorded when using Change
Data on Selection, and previous
Iteration Snapshots  will be
discarded.

6.6.2 Load an Iteration into all plots on the layout

An Iteration can be loaded into the layout in the following ways:

By a single click on
the Iteration
number into the
Data List.

The user can navigate to an iteration of interest by
clicking on the iteration number within the Iteration
Column (Figure 6.19).

Figure 6.19 Click on the Iteration
Number to view that Iteration

1212

1212
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Via the Change
Data on All
Objects  buttons
in the ribbon bar.

The user can move up and down through the Data List
one iteration at a time by using the Previous or Next
buttons. Use the Select button to choose a specific data
file from a known folder location.  Use the Iteration
drop down menu to change to a specific iteration of
interest. (Figure 6.20). 

Figure 6.20 Change data on all objects

TIP: Data will load into each dot plot on every page of the layout, even if only
some dot plots are selected. Use the Change Data on Selection  buttons to

Load a specific data file into one or multiple plots .

6.7 Panels

In a typical experiment, you can repeat the same set of staining protocols many
different times, with different samples, but using the same number and sequence
of tubes for your experiment. This type of staining protocol is often referred to
as a Panel. You can specify the number of tubes in the panel, as well as the
name of each tube. Once you have designated an active panel, and added files to
the Data List , FCS Express will automatically determine which data file
corresponds to which tube in your panel. You can change this association from
the Data List. With an active panel, when you create plots with files from the
Data List, FCS Express will know which plots will display the proper file. When
you change the Data List, the plots will automatically update with the correct file
for that tube.

Panels can be added, deleted, edited, saved, and loaded from the Panel
Information dialog which can be opened by using the Batch Organize Data
Sets Panels command, or by clicking on the Panel status bar button (with the
test tubes icon) at the bottom of the layout.
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6.7.1 Working with Panels

The primary benefit of a panel is that it allows you to change the data on your
layout simply by changing the Data List. For example, on Day 1 you analyze
your tubes using FCS Express, creating a plot for each tube. On Day 2, you need
to load new data into the same plots that you used on Day 1. Once you set up
the Panel and the Data List correctly, the layout from Day 1 can be modified to
show the data from Day 2, simply by loading the Day 2 data into the Data List.

The following example will guide you through creating a Panel and taking
advantage of it using the Data List.

1.  Select the Data Organize Data Sets Panels command. The Panel
Information dialog, shown in Figure 6.21, will appear.

Figure 6.21  Panel Information Dialog

2.  Click on the Add button to create a blank Panel. This will bring up the Add
Panel dialog (Figure 6.22).
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Figure 6.22  Add Panel Window

3.  Fill in the Panel Information (Figure 6.23)

 Enter a name in the Panel Name field

 Select the number of tubes in the panel by clicking on the arrows to the
right of Number of Tubes.  For each tube added, a blank line appears in the
table.

 Give each tube a Name (optional), by typing the name into the Name
column.

 Enter the Number of Stationary Controls (optional).  Stationary
Controls will be loaded along with regular Tubes in the Panel, but will not
change when changing Iterations.  

 Give each Stationary Control Tube a Name (optional), by typing the
name into the Name column.

 Click OK when you have finished setting up the panel. You will be
returned to the Panel Information dialog, where you will see the newly
created panel. Panel information is saved with the layout. However, you can
save your panel for use in other layouts. The Panel Information dialog
allows you to Edit, Delete, Save, and Load panels.
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Figure 6.23  Setting up the Panel Tubes

4.  Since each layout can have only one active panel, verify that the panel
that you want to use is marked active (the box to the left will be checked).

5.  Click OK to continue. Now create plots on your layout and populate them
with data. The Data List will automatically be populated with the data files
in the current directory.

6.  Use the Data Organize Data Sets  List command to bring up the
Data List window. The first column shows the tubes from the Panel and
the second column shows each tube's associated data file. Notice how the
data files are grouped into the panel automatically. If a tube is associated
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with the wrong data file, you can reorder the files using the Up and Down
buttons (see green-highlighted Up and Down buttons in the figure below).
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Example of Panel with 2-tube iterations.       

Example of Panel with 5 Stationary controls and 2-tube iterations.
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To use the Data List in conjunction with the panel to control the data files in the
plots in your layout, do the following:

1.  Remove the data files from the Data List by selecting all the files and
clicking Remove.

2.  Click OK. The plots which previously displayed data are now empty.

3.  Return to the Data List, and add a new set of data files. To do this, click
on Add and select the data files to be added.

4.  Click OK. The previously empty plots are now displaying data from their
associated data files.

If you have a Panel applied, and are adding files to the file list, you do not have to
select all the files that you want to add. You can select the first file that you wish
to add, and FCS Express will attempt to determine how many additional files to
include (Figure 6.24).

Figure 6.24  Automatically Populating a Panel

Blank Tubes:
Additionally, if you would like to add data file(s) to the data list without adding all
tubes for the panel you may select the option to Add Blank Tube from the add
data file drop down icon (Figure 6.25)
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Figure 6.25  Adding a blank tube to the data list. 

When a Blank Tube is added to the data list it will appear in your list of files with
the name "Blank Tube" (Figure 6.26). Any number of Blank Tubes may be
added. 

Figure 6.26  A blank tube was added to the data list to
complete the panel. 
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6.7.2 Defer Layout Changes

When using the Panels feature in FCS Express, a user needs to load data into the
Data List as it pertains to the panel.

FCS Express will automatically load the data into the plots to which the files were
assigned.  If a panel set of data files were placed in the wrong order, you can

easily re-arrange the order of the tubes by selecting the file, then, clicking the 

button or the  button to place the files in the correct sequence.

However, if the data files are large in size and they needed to be moved Up or
Down in sequence, the amount of time needed for FCS Express to correctly
display the data in their proper plots and to recalculate statistics and tokens can
be significant.

Users can make changes to the sequence of tubes within their panel and have
FCS Express defer those changes until all the changes have been made rather
than recalculate each time a file is moved in the Data List.

In the example illustrated below, we can see how this tool is utilized by using a
3-tube panel dataset.

1.  Open the Data List.
2.  Load the data specific for the panel.

3.  Select the Defer Layout Changes  icon.
4.  Once the icon is selected, a grey play button icon and a red "X" will appear

next to the Defer Layout Changes icon .
5.  Move a tube within the sequence Up or Down using the arrows within the

Data List toolbar (Figure 6.27).
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Figure 6.27 - Panel Data Before Deferring Layout Changes

6.  Once the tube is moved to the correct sequence, click the blue play button

icon to accept the changes .
7.  FCS Express will now display the data in the appropriate plots (Figure 6.28).
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Figure 6.28 - Panel Data After Deferring Layout Changes
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7 Gating

FCS Express allows you to easily create Gates, Quadrants and Markers to isolate
specific populations and to retrieve statistics for them.

Gates  are used to define regions of interest on 1D and 2D plots. FCS Express
supports five types of drawing gates and another type, called combination gates,
which can combine any number of other gates to create more complex gating
strategies. Gates can be drawn with different shapes (e.g. Ellipse, Rectangle,
Polygon, Freeform), exist in one or two dimensions (i.e. 1D vs 2D gate), and
their content can be selectively displayed on new plots  for further downstream
analysis. FCS Express also includes Data Specific Gates , which are gates
assigned to specific data files allowing for different gating positions between files
for the same gate. 

Quadrants  are used to divide the plot content in 4 complimentary, and
mutually exclusive, regions. This means that the each event in the plot will be
included in a quadrant and not in another. In FCS Express, Quadrants are meant
to retrieve statistics and cannot be immediately used for downstream analysis as
gates (i.e. you cannot selectively display the content of a quadrant in a different
plot until it has been converted to a gate). However, Quadrants can be
converted to Gates  with a few clicks. When Quadrant are converted to Gates,
the events within them can be selectively analyzed for downstream analysis.

Markers  are used to select regions of interest using a single parameter (i.e.
one dimension). They can be drawn on either a 1D plot or a 2D plot (in the latter
case, the marker will be drawn using the X parameter). In FCS Express, Markers
drawn on 1D Plots are meant to retrieve statistics and cannot be immediately
used for downstream analysis as gates (i.e. you cannot selectively display the
content of a Marker drawn on a 1D Plot in a different plot until it has been
converted to a gate). However, Markers can be converted to Gates  with a
few clicks. When Markers are converted to Gates, the events within them can be
selectively analyzed for downstream analysis. Note that a marker drawn on a 2D
Plot will automatically become a 1D gate and can be immediately used for
downstream analysis.
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7.1 Gates

Gates are used to define regions of interest on 2D plots. In FCS Express gates
can be drawn with different shapes , may be assigned to any position in a
gating hierarchy  , and an unlimited number of individual gates can be created.
Gates can be hidden or shown on plots  as desired by using the right-click
formatting menu.

Importantly, gates can be used for further downstream analysis as their content
can be selectively displayed (applied)  on new plots. Gates may also be derived
from Markers  and Quadrants . Gates are manged from a Gate View
object  or the Gate Navigator .

7.1.1 Gate Types

FCS Express supports seven types of gates.

· Elliptical gates: Gates that are oval, oblong, or circular.

· Rectangular gates: Gates that are square or rectangular.

· Polygonal gates: Gates that are drawn with three or more vertices

connected by straight lines.

· Freeform gates: Gates that are drawn with various straight and/or curved

sections in an irregular shape.

· 1D gates: Gates that exist only in one dimension, i.e., a one parameter

histogram gate or an x-axis plot gate.

· Well gates : Gates that are set on a heat map display showing the wells

of a microtiter plate.

· Combination gates: Gates that are Boolean combinations of one or more of

the other six types of gates.

Examples of different gate types are shown in Figure 7.1.

699

737

733

739

764 749

391 130

289



FCS Express 7 Manual700

© 2023 De Novo Software

Figure 7.1  Examples of Different Gate Types

7.1.2 Live Updating Gates

FCS Express has the ability to have all gate, quadrant, and marker related
changes such as backgating, statistics, and gated events update in real time as
the gate is moved.

The option to update immediately, "in real time", is controlled via the FCS
Express User Options located in the File tab Options Performance 
When moving gates, quadrants and markers, update plots, statistics and
tokens immediately. (Figure 7.2). 

The option to enable live updating gating may also be defined at the layout based
level via the Layout Performance Options .111
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Figure 7.2 The option to enable or disable "real time gating" is controlled by the
When moving gates, quadrants and markers, update plots, statistics and tokens

immediately check box. 

7.1.3 Creating Gates

Gates can be created in several ways. To create a gate efficiently, first select the
plot that you would like to create the gate on, and then do one of the following:

· Select a command (e.g., Ellipse, Rectangle, Polygon, Freeform) from

Home Create Gates.

· Select your desired gate shape from the commands in Gating

Gates.
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· Right-click on the plot and then choose Create Gate and a gate type from

the pop-up menu.

To cancel the creation of a gate while you are drawing the gate, press the Esc
key on your keyboard before completing the operation.

· Elliptical or Rectangular Gates

If you choose the Ellipse or Rectangle commands, position the cursor on
the plot where you want the top left corner of the gate to be. Then, press
and hold the mouse button while dragging the cursor down and to the right
until the gate is the size you want. Release the mouse button to complete the
gate. Note: You can easily adjust the size later.

· Polygonal Gates

If you choose the Polygon command, position the cursor where you want
the first vertex to be. Then, click (and release) the mouse button. Continue
repositioning the cursor and clicking at the vertex locations. Straight lines will
connect the vertices to create the polygon. To close and complete the
polygon gate, click on the square that appeared at the first polygon vertex.
Alternatively, you can complete the polygon gate by pressing the space bar.
Pressing the space bar will cause the gate to close with a straight line
between the first vertex and the last vertex you created. When completed, in
addition to the vertices being marked, the polygon will show four outer circles
which can be used for proportional resizing.

· Freeform Gates

If you select the Freeform command, position the cursor on the plot where
you want to begin drawing the gate. Click and hold the mouse button. While
continuing to hold the mouse button down, drag the mouse to draw the
shape of the gate. The gate will be drawn along the path of the cursor. To
close and complete a Freeform gate, release the mouse button. The gate will
automatically close with a straight line connecting the first cursor position to
the cursor position when the mouse button was released. When completed,
the freeform shape will show four outer circles which can be used for
proportional resizing.

· Well Gates

If you choose the Well command, you can create a gate on one or more
wells of a Heat Map  (microtiter plate).

· 1D Gates

289
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Create a Marker on a histogram as described in Creating Markers . Then,
right-click on the plot that contains the marker and choose Convert Marker
to Gate, the Marker number, and either Convert or Convert and Link. If
you choose Convert and Link, changing the original marker changes the
corresponding 1D gate. Otherwise, moving or deleting the original marker will
have no effect on the 1D gate.

To create a 1D Gate on a 2D-plot:

o Select the Gating (or Home) Create Gates Create Marker

command.

o Right-click on the plot and select Create marker from the pop-up

menu.

Then, position the cursor where you want the left marker boundary to be,
and press and hold the mouse button down. While holding the mouse button
down, move the cursor parallel to the X- or Y-axis. Position the cursor where
you want the right marker boundary to be, and release the mouse button.

Once you have finished creating a gate, the Create New Gate dialog will appear
(Figure 7.3). By default, only the Gate Information section of the dialog will be
expanded (picture below, left pane). Expanding the Gate Properties section
(picture below, right pane) will reveal additional options.

Figure 7.3  Create New Gate Dialog

The Create New Gate Dialog provides the following options:

750
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Would you like to
create a new gate,
or replace an
existing gate?

The default selection is to Create a new gate named. The
new gate will be a child of the Overlay Gate of the base
overlay on the plot.

To create the new gate as a child of a specific gate in the
hierarchy, choose the parental gate in the hierarchy from
the Parent Gate drop-down (see below). The hierarchy of
your gates can be adjusted at any time within the Gate
View object  as well.

To replace an existing gate with the newly created gate,
select the Replace an existing gate radio button and
choose the gate you wish to replace from the drop-down
list.  The new gate will replace the old gate without affecting
your gating hierarchy .

Gate Color Select the preferred color from the drop down menu.

Parent Gate When a new gate is created, the new gate will be a child of
the Overlay Gate of the base overlay on the plot. The
Parent Gate option allows to modify this choice and thus
make the new gate a child of a different gate.

Note: when an existing gate is replaced, the parent gate of
the drawn gate will be the same parent gate of the replaced
gate.

Emphasize events
on Color Dot plots

When the Emphasize events on Color Dot plots feature
is checked FCS Express will display any events within the
gate on a Color Dot plot, or dot plots with the gate chosen
to display , as larger and bolder dots for emphasis (Figure
7.4). Emphasize on plots may also be accessed for
specific low frequency populations in overlays on 2D plots
through the Formatting 2D Plots dialog .
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Figure 7.4 - Gate 2 has been created with the Emphasize
on Plots feature selected. Notice how dots within Gate 2
appear larger and bolder than Gate 1 which was created

without the feature selected.

Always create a
Data Specific Gate
when moving this
gate

If checked, a data specific gate will always be created
when moving the gate. 

Exclude events
inside this shape

If the current gate is a child gate, the exclusion only apply to
the current gate, and not parental gates in the hierarchy.

For instance, if Gate 2 is a child of Gate 1 and Gate 2 is an
exclusion gate, Gate 2 will be equivalent to a Boolean
evaluation of  "Gate 1 AND (NOT Gate 2 )" and will contain
"Gate 1 positive / Gate 2 negative" events (blue region,
right column in the figure below).

If a "NOT (Gate 1 AND Gate 2)" gate is required, instead of
setting Gate 2 as an Exclusion Gate, a "NOT Gate 2"
Boolean gate  (where Gate 2 is an Inclusion gate child of
Gate 1) can be created (green region, left column in the
figure below).
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Gates may be copied and pasted from any plot to any other plot. The recipient
plot may or may not have the same parameters than the original plot. When a
gate is copied and pasted on another plot, you will be prompted to create a new
gate that will use the original gating coordinates with the existing parameters of
the new plot. A gate created in this way will be a new gate which is not linked to
the original gate.

Note: In FCS Express gates are universal by default. If you would like to display
an existing gate on a plot without creating a new gate, simply right click on the
plot of interest and select Show Gates from the right click menu.

Once a gate is created, it will appear in the Gate View  and in the Gate
Navigator .
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Gate properties can be modified through the Edit Gate dialog.

The Edit Gate dialog may be accessed from either the Gate View  and the
Gate Navigator  by double clicking on the gate of interest (within the Gate
View/Gate Navigator), or by right clicking on the gate of interest (within the
Gate View/Gate Navigator) and selecting Gate Properties from the right click
menu. An Edit Gate dialog will open (Figure 7.5).
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Figure 7.5  Allow gate edit dialog based on radio buttons next to
"true", "false", or "custom". The custom setting is based on if

the conditions are met.

The Edit Gate dialog contains the following options:

Name See table above 703
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Comment Adds a Comment associated with the gate.

Description or
Formula

For classical gates, the Description will be reported. For
Combination Gates  the Formula will be reported.

Color See table above

Line Width An increase in line width will result in a bolder border of the
gate displayed on a plot Figure 7.6.

Figure 7.6 - The line width for Gate 1 was adjusted to 4. 
Notice how the border of Gate 1 appears bolder than Gate1

in the image above. In this example emphasize on plots
was selected for Gate 2 and was not selected for Gate 1 to

help vizualize the difference between line width and
emphasize on plots. 

Emphasize events
on Color Dot plots

See table above

Always create a
Data Specific Gate
when moving this
gate

See table above

Exclude events
inside this shape

See table above

Alt+Click required
to select this gate

When the option is checked, pressing the Alt button on
your keyword will be require to move the gate 

Allow Gate Edit The option allows you to choose if the gate may be put
into edit mode which allows users to move, replace, and
delete the gate. Selecting the radio button for True allows
full editing, False prevents the gate from being edited.
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Custom allows the gate to be edited based on the
conditions that are set and will only allow editing if the
value evaluates to true.

   To create a Custom value, you may use the "="
followed by an input of a number manual, token or custom
token , and operators "<" or ">" may be used to specify
the condition to be less than or greater than, respectively.

When the radio button for "Custom" is selected, the gate
may be edited based on whether or not the conditions
below are met. You may use the "=" followed by an input
of a manual number, token or custom token. "<" or ">"
may also be used to specify the condition to be less than
or greater than, respectively.

For example, see Figure 7.7 below where a conditional
statement was defined in the Custom field. The Custom
field is defined as true since 18.90 is greater than 2 and will
allow gate editing.

1284
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Figure 7.7 Allow Edit Dialog-Defining the Conditions to
be met in order to Custom Allow Gate Edit 

7.1.4 Data Specific Gates

Data Specific Gates in FCS Express allow you the ability to assign gates to
specific data files that have been loaded in the data list.  Different gating positions
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between data files may be stored and automatically used when displaying plots
or making calculations when using the Data Specific Gate feature, Figure 7.8.

Figure 7.8 The Data Specific Gate button in the Gating tab is used to enable data
specific gates.

When a gate is converted to a Data Specific Gates for a given file, the shape and
position can be modified for the specific file independently from other data files.
Thus, when a Data Specific Gates is created, the original gate (here hence
referred to as "Master gate") continues to be used for all the remaining files.

Jump to:
· Creating Data Specific Gates

· Deleting/Removing Data Specific Gates

· Promoting Data Specific Gates to Master Gate

· Using Data Specific Gate Groups

An example of Data Specific Gates is given in Figure 7.9, where Gate 1 has been
converted to be a Data Specific Gates for File 4. Files 1 through 3 continue to
use the original position for Gate 1 (i.e. the Master Gate).

Figure 7.9- Example of Data Specific Gate where Gate 1 has been changed and
made specific for File 3.

Data Specific Gates can be easily tracked using the Gate Navigator  Figure
7.10 or by formatting the Gate View Options  to allow showing data specific
gates. 
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Figure 7.10 - Using the gate navigator to view which data files are assigned data
file specific gates. 

Although Data Specific Gates may appear to share some similarities with
Iteration Snapshots  and Manual Snapshots  the features are quite
different in term of their applicability:

· Data Specific Gates are specific for a data file in the data list, while Snapshot

are specific for a given iteration number in the data list. Data Specific Gates
are suitable for analyzing multiple FCS files simultaneously open in the layout,
as well as multiple FCS file using batch process while Snapshots are suitable
for analyzing multiple FCS files using the batch process.

· Data Specific Gates only account for gates and gating positions while

Snapshots are used to record marker and quadrant positions along with
gating positions.

Data
Specific
Gates

Snapsho
ts

Record the shape and
the position of

Gates Y Y

Markers N Y

Quadrants N Y

Specific for
Data Files in Data List Y N

Iteration Numbers in Data List N Y

Suitable for analyzing

Multiple FCS files simultaneously
open in the layout

Y N

Multiple FCS file using batch
process

Y Y

1212 1209



FCS Express 7 Manual714

© 2023 De Novo Software

7.1.4.1 Using Data Specific Gates

Creating Data Specific Gates

Assigning a gate to be Data Specific is accomplished in one of two ways:

Option 1:

1. Click on the Gating tab of the ribbon.

2. Click on the gate to convert to a Data Specific Gate (Figure 7.11 - Number 1)

on a plot.

3. Click on the Gating tab of the Ribbon.

4. Select Create Gates  (Figure below - Number 2).

Option 2:

1. Click on the gate to convert.

2. Hold down the Shift button and move the gate to the desired position. This

action converts any existing gate to a Data Specific Gate.

Option 3:

1. Choose Always create a Data Specific Gate when moving this gate at the time

of creating the gate . Whenever the gate is adjusted a new data specific gate

will be created. 

701



Gating 715

© 2023 De Novo Software

Figure 7.11- Data File Specific gates are created using the Data Specific Gate
button from the Gating tab > Create Gates section.

The Gate Navigator will now reflect the presence of a Data Specific Gate for File

4 (ApoMono.004 compensated) (Figure 7.12).

Figure 7.12 - The gate navigator before and after creating a data file specific gate
on File 4 (ApoMono.004). 

The shape and position of Gate 1 on File 4 can now be modified independently

from the master gate (File 1 through File 3) Figure 7.13.
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Figure 7.13 - An example of a data file specific gate for Gate 1 that has been made
Data File Specific for File 4.

Deleting Data Specific Gates

A Data Specific Gate can be reverted back to resemble the Master gate (i.e. to

loose its data specificity) in one of three ways:

Option 1:

1.  Click on the gate that need to be reverted to Master gate (Figure 7.14 -

Number 1).

2. Click on the Gating tab of the Ribbon.

3. Select Create Gates  (Figure below - Number 2).

Figure 7.14 - DSG can be deleted using the Data Specific Gate button from the
Gating > Create Gates ribbon bar.

Option 2:
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1. Select the Data Specific Gate for the File in the Gate Navigator.

2. Press Delete.  

Option 3:

4.  Right click on the Data Specific Gate in the Gate Navigator. 

5.  Select Delete Data Specific Gate(s)(Figure 7.15).

Figure 7.15 - A Data File Specific Gate can be removed using the right click menu in
the Gate Navigator.

When a Data Specific Gate is deleted the Master Gate will be used on any files

that had used the Data File Specific gate. 

Promoting a Data Specific Gate to the Master Gate

A Data Specific Gate can be promoted to be the Master gate within the Gate

Navigator:
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1. Right click on the Data Specific Gate in the Gate Navigator.

2. Select Promote Data Specific Gate to Master from the right click menu

(Figure 7.16).

(Figure 7.16) - Selecting promote data specific gate to master gate in the gate
navigator.

When promoting a Data Specific Gate to Master Gate:

· All of the files that used the original Master Gate will use the Data Specific Gate.

· The original Data Specific Gate is removed from the Gate Navigator (Figure

7.17) - left).
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Figure 7.17 - A data specifc gate was promoted to a new master gate. Note the
original data specific gate is no longer present. 

7.1.4.2 Using Data Specific Gate Groups

Data Specific Gates may be used as gate groups to specify a gating position for

multiple data files by creating a Data Specific Gate Group. 

Data Specific Gate Groups may be create in four ways:

1)Multiple Selecting Data Specific Gates

2)Dragging and Dropping within the Gate Navigator

3)Dragging and Dropping from the Gate Navigator

4)Dragging and Dropping from the Data List

Data specific gate groups may also be renamed  or removed via deletion

. 

1) Multiple Selecting Data Specific Gates to Create a New Group (Figure

7.18)

1.  Multiple select the Data Specific Gates that will constitute the Data Specific

Gate Group in the Gate Navigator.

    NOTE: The first Data Specific Gate selected will be used as reference gate for

the Data Specific Gate Group. 
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2.  Right click on any of the selected Data Specific Gate.

3.  Select Create Data Specific Gate Group from the right click menu. 

The first Data Specific Gate selected in step 1 will now be used for all other data

files specified in the group. 

Figure 7.18 - Using multiple select to create a data specific gate group for multiple
files. 

2) Dragging and Dropping to Create a Group within the Gate Navigator

(Figure 7.19)

1.  Select one or more Data Specific Gates in the gate navigator.

2.  Drag the selected Data Specific Gates and release them on top of the Data

Specific Gate file name that is intended to be used for the gate group master

position. 

 

Figure 7.19 - Creating a data specific gate group by dragging and dropping files
from in the gate navigator to the data specific gate intended as the new group

master gate. 
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3) Dragging and Dropping from the Gate Navigator (Figure 7.20)

1.  Select a Data Specific Gate from the Gate Navigator.

2.  Drag the selected Data Specific Gate and release it on top of a plot. The

following rules will be applied: 

The target plot contains a unique
dataset (i.e. one overlay)

If the dataset displayed in the target
plot is different than the dataset of the
Data Specific Gate that has been
dragged and dropped, a Data Specific
gate group containing both dataset will
be created.

If the dataset displayed in the target
plot is the same dataset of the Data
Specific Gate, no Data Specific Gate
group will be created and the the Data
Specific gate that has been dragged
and dropped will simply be applied to
the plot (i.e. it will be set as Overlay
gate on that plot).

The target plot contains multiple
datasets (i.e. one overlays)

If the dataset displayed in the base
overlay of the target plot is different
than the dataset of the Data Specific
Gate that has been dragged and
dropped, a Data Specific Gate group
containing all the dataset overlaid on
that plot will be created. In addition,
the Data Specific Gate will also be
applied to all the overlays displayed on
the target plot.

If the dataset displayed in the base
overlay of the target plot is the same
dataset of the Data Specific Gate that
has been dragged and dropped, no
Data Specific Gate group will be
created and the the Data Specific gate
that has been dragged and dropped
will simply be applied to all the
overlays displayed on the target plot.
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Figure 7.20 - Creating a Data Specific Gate group by dragging and dropping a Data
Specific Gate on a plot displaying a single dataset (i.e. a single overlay).

4) Dragging and Dropping to Create a Group from the Data List (Figure

7.21)

1.  Select one or more data files in the Data List.  

2.  Drag the selected data file(s) and release them on top of the Data Specific

Gate in the Gate Navigator that is intended to be used for the gate group

master position.

Figure 7.21 - Creating a data specific gate group by dragging and dropping files
from the data list to the data specific gate intended as the new group master gate

within the gate navigator. 

The result for the three above methods for creating a Data Specific Gate Group

is that all files within the newly created group will be unified to the Data Specific
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Gate used for reference. A new Group child will appear under the Data Specific

Gates for the gate of choice (Figure 7.22).

Figure 7.22 - A new data file specific group is created via the multiple select or
drag and drop methods for creating groups. 

Note: If the Data Specific Gate Group of interest already exists, file(s) can be

dragged and dropped on either the Data Specific Gate Group entry or on any

of the Data Specific Gates which are part of it (Figure 7.23).



FCS Express 7 Manual724

© 2023 De Novo Software

Figure 7.23 - When a DSG group is already present, file(s) can be added to the
group by dragging them from either the Data List (upper panel) or the Gate

Navigator (lower panel), and realeasing them on top of either the DSG group entry
or on top of any DSG already listed in the DSG group of interest.

Rename Data Specific Gate Groups (Figure 7.24)

Data Specific Gate groups can be renamed by:

1. Select the Data Specific Gate Group in the gate navigator.

2. Right click on the Data Specific Gate Group to rename.

3. Select Rename from the right click menu.

4. Type in a new name for the group.
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Figure 7.24 -  DSG groups can be renamed from the Gate Navigator.

Removing and Deleting a Data Specific Gate Group

An entire Data Specific Gate group can be deleted by:

1. Selecting the Data Specific Gate Group or multiple selecting the Data Specific

Gates composing it in the gate navigator. 

2. Press Delete on your keyboard.

a.  Alternatively, Right click on the selected Data Specific Gate. 

b.  Select "Delete Data Specific gate(s)" 

One Data Specific Gate can be removed from a Data Specific Gate group by:

1.  Selecting the gate within a plot displaying it (Figure 7.25) - Number 1)

2.  Click the Data Specific Gate button in the Gating tab  on the

(Figure below - Number 2)
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Figure 7.25 - Removing a data specific gate from a group by clicking the Data
Specific Gate button twice. 

7.1.5 Using Boolean Logic to Create Combination Gates

Creating Combination Gates

Combination gates consist of combinations of other gates. To combine gates,
you create a gating formula consisting of Boolean combinations of pre-
existing gates. Gating formulas are defined by either a single gate or several
gates joined by Boolean operators. The operators describe how the gating
regions should be combined and follow the rules of Boolean algebra. FCS
Express supports the following operators:

· AND

AND is represented by typing 'a',  'A', or 'and' into the gating formula. If
you enter the gating formula "Gate 1 a Gate 2" (read as, Gate 1 and
Gate 2), only events that fall into both Gate 1 and Gate 2 are selected.

· OR

OR is represented by typing 'o', 'O', or 'or' into the gating formula. If
you enter the gating formula "Gate 1 o Gate 2" (read as, Gate 1 or
Gate 2), all events that fall into either Gate 1 or Gate 2 are selected.

· NOT

NOT is represented by typing 'n', 'N', or 'not' into the gating formula. If
you enter the gating formula "n Gate 1" (read as, not Gate 1), all
events except the events in Gate 1 are selected.

· XOR

XOR is represented by typing 'x' or 'X' or 'xor' into the gating formula.
If you enter the gating formula "Gate 1 x Gate 2" (read as, Gate 1 xor
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Gate 2), only events that fall into Gate 1 or Gate 2, but not both, are
selected. Note: XOR stands for exclusive Or. The difference between
'or' and 'xor' is that with 'or' an event that falls into both regions is
selected, while with 'xor' an event that falls into both regions is
excluded from selection.

Together with the four Boolean operators, Combination Gates can be created
using parentheses. The contents of the innermost parentheses are evaluated
first, and the remainder of the equation is evaluated from left to right. This
allows you to build complex gating formulas quite easily. The following are
examples of some valid gating formulas. Note: Spaces are not required when
inputting the formula into FCS Express some people prefer to use then to
make complex formulas more readable.

· "not lymphocytes or monocytes"

Events that are not in lymphocytes or are in monocytes are
selected. The NOT is only applied to the lymphocytes if you do not
use parentheses.

· "n (lymphocytes or monocytes)"

First the "(lymphocytes or monocytes)" is evaluated, then a NOT is
applied. Now all events that are not in the lymphocytes gate and
not in the monocytes gate are selected. The formula "Not
lymphocytes And Not monocytes" would have the same result.

· "(lymphocytes and monocytes) or (granulocytes and blasts)"

Events that are in both the lymphocytes and monocytes gates, or
both the granulocytes and blasts gates are selected. Because 'and'
means events must be in both gates to be selected, the only events
that will be selected will be those that fall in the overlap between the
lymphocytes and monocytes gate OR the overlap between the
granulocytes and blasts gates.

Combination gates are created in the following way:

· After inserting a Gate View object  onto the layout

(Insert General Gate View), right-click on the Gate View and select
Add Combination Gate from the pop-up menu.

A dialog box (Figure 7.26) will appear. Select the Formula field and enter
Boolean operators and the names of preexisting gates. As you type, FCS

391
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Express will determine which gate or Boolean operator you are trying to type
and will attempt to complete the word for you via autofill. If more than one gate
or operator matches the letters you’ve typed, you can scroll through the
available matches by using the arrow keys. Press the space bar to accept the
choice.

Figure 7.26  Creating a Combination Gate

7.1.6 Adding a Combination Gate Matrix

Adding a Combination Gate Matrix

A combination gate matrix is a set of combination gates, created from one or
more previously existing gates. This set of gates contains every possible positive
and negative value for the previously existing gates. For example, if we start with
a gate labeled "CD16", and another gate labeled "CD14", select both gates, and
create a combination gate matrix from them, four new gates will be created
(Figure 7.27):

• CD16+/CD14+
• CD16-/CD14+
• CD16+/CD14-
• CD16-/CD14-
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Figure 7.27  Combination Gate Matrix Example. Left: Gates applied to select all
CD16+ or CD14+ cells. Right: Combination Gate Matrix applied to create gates

for all four combinations.

Once the new gates are created, they are treated as normal gates. Any changes
to the original gates (such as renaming) will not cause the new gates to be
renamed. The new gates can also be deleted or edited like any other
combination gate.

To add the combination gate matrix:

After inserting a Gate View object  onto the layout (Insert General Gate
View), select the gates that you want to use via SHIFT-click or Ctrl-click,
right-click on the Gate View, and select Add Combination Gate Matrix
from the pop-up menu (Figure 7.28).

391
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Figure 7.28  Adding a Combination Gate Matrix

If you selected three gates to create the matrix then, after the new matrix
has been added, eight new gates will have been created. The gate will now
look like Figure 7.29.

Figure 7.29  After Adding a
Combination Gate Matrix

7.1.7 Moving and Resizing Gates

To move or resize a gate, the gate should first be activated. This can easily be
done in either of the following two ways:

1. Left-click within the gate that you wish to move/resize, or
2. Right-click anywhere within the plot, and select Activate gate from the right-

click menu.

Once the gate is active, the cursor changes to the drag cursor and resizing
handles appear on the vertices of the gate. The gate is ready to be moved or
resized.
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Moving Gates:

Once the gate is active, it can be moved in one of two ways:

1. Click and hold down the mouse button anywhere inside the gate. Move the
cursor while the mouse button is pressed, and the gate will move with the
cursor. Release the mouse to drop the gate into the new position. 

2. Use the arrow keys on our keyboard (up, down, left, right) to reposition the
gate.

If one gate falls within the boundaries of a second gate you may right click on the
plot Activate gate select the underlying gate. The position of the underlying
gate may now be changed. 

To cancel a gate move once you have begun, press and hold the Esc key and
release the mouse button before you release the Esc key.

If you move a gate onto a blank part of a page, you will either:
· Create a new plot gated on the gate, or

· Delete the gate

According to the options you set in the Gate moving options section on the Gate
page of the Options dialog .

Resizing Gates:

Once the gate is active (please see above), move the cursor over one of the
resizing handles. You will know you are in the correct position when the cursor
changes to the resize cursor, which is a two-headed arrow. With the resize
cursor, click and hold down the left mouse button. Move the mouse to move the
cursor and the vertex will move with the cursor. Release the mouse button to
drop the vertex into the new position.

Tips: shortcuts are available to expand/shrink the active gate in a specific
direction. Please refer to the FCS Express Keyboard Shortcuts  chapter for
more details.

To cancel a gate resize once you have begun, press the Esc key before you
release the mouse button.

1635
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7.1.8 Deleting Gates

A gate can be deleted in one of two ways:

· Select the gate from a Gate View object  or the Gate Navigator  and

either: Right-click and choose Delete from the pop-up menu, as seen in
Figure 7.30 or press the Delete key on the keyboard.

Figure 7.30 - Removing a Gate from the Gate View

· A gate can also be deleted directly from the plot. To delete a gate, click the

mouse button when the cursor is in the gate you wish to delete or use the
right-click menu and select the Activate gate command. This will activate
the gate. The cursor will then change to the drag cursor and resizing handles
will appear on the vertices of the gate. Press the Delete key. A dialog box

391 130
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will appear asking whether you want to delete the gate completely, or hide
the gate  on that plot, as seen in Figure 7.31.

Figure 7.31 - Delete or Hide a Gate

7.1.9 Hiding Gates

To show or hide a gate, or to determine whether a gate is visible on a 2D plot,
right-click on the plot and select Show Gates from the pop-up menu. A
submenu will appear listing all currently defined gates. Clicking on the desired gate
in the list will toggle between showing or hiding the gate.

You can also hide a visible gate directly from a 2D plot:

1.  Activate the gate that you wish to hide, by clicking inside it or by using the
right-click menu and selecting the Activate gate command.

2.  Press the Delete key.
3.  Select the Hide button in the dialog box that appears.

Note: A 2D gate can only be displayed if the axes on the plot match the axes
that were used when the gate was first created.  However, color dot plots can
display backgated populations  for any gate in your layout.

7.1.10 Using Snapshots with Gates

Snapshots  provide a way to save multiple gate, quadrant, or marker
positions for quick access in your analysis. An unlimited number of snapshots
may be created and saved in a layout. When a snapshot is added to the
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Snapshot navigator using the green + ( ) button, FCS Express will remember
the position of a any gates, quadrants, or markers present on open plots. When
gates, quadrants, or markers are changed on open plots the saved snapshot
may be applied to the layout by dragging and dropping the snapshot from the
Snapshots navigator to any blank space on the layout. The position of the
gates, quadrants, and markers saved in the snapshot will be applied. 

In the example below (Figure 7.32) note that the snapshot for Gate Position
Number 1 is applied to Sample 1 on the left. When data was changed to Sample
2 on the right, the position of the CD4 and CD25 gates was updated by applying
the snapshot for Gate Position Number 2. In this way many positions for gates,
quadrants, or markers may be saved and easily accessed to be used as needed.

Figure 7.32 - The snapshot for Gate Position Number 1 is applied to Sample 1 on the
left. When data was changed to Sample 2 the gate positions were updated by

applying the snapshot fo Gate Position Number 2 to the layout.

Please see the Snapshots chapter for more details on creating Snapshots. 

Please see the Snapshots  and Batch Iteration Navigation chapter  for more
details on using Snapshots with a batch process and the Next / Previous
commands. 

Also see the Snapshots  Tutorial  for step by step instructions on creating
and using Snapshots.

7.1.11 Gates and the Clipboard

Gates can be copied to and pasted from the clipboard for use within FCS
Express.  This will create an identical gate with a new name that can be moved
independently of the original gate.  You can also copy all gates to another
layout  to reuse your entire gating strategy.

To show a previously created gate on another plot or on a plot on which it is
currently hidden, use the Show Gates command  instead.

· Copying a Gate to the Clipboard

827 827
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Click the mouse button when the cursor is in the gate that you wish to copy.
This will activate the gate. Select the Home Clipboard Copy Gate
command or press Ctrl+C from the keyboard. Similarly, you can select the
gate in the Gate View  or Gate Navigator  and select
Home Clipboard Copy Gate or press Ctrl+C from the keyboard.  You can
also right click on the Gate and select Copy Gate from the right click menu.

· Cutting a Gate to the Clipboard

Click the mouse button when the cursor is in the gate that you wish to cut.
This will activate the gate. Select the Home Clipboard Cut Gate command
or press Ctrl+X from the keyboard. Similarly, you can select the gate in the
Gate View  or Gate Navigator  and select the Home Clipboard Cut
Gate command or pressCtrl+X from the keyboard. If you try to cut a gate
from a plot, a dialog will appear asking if you want to delete the gate
completely or hide it in that particular plot.  You can also right click on the
Gate and select Cut Gate from the right click menu.

· Pasting a Gate from the Clipboard

Right-click on a plot, the Gate View  object, or Gate Navigator , and press
Ctrl+V on the keyboard, or select the Home Clipboard  Gate
command.  Note that in order to paste a gate as a child of another gate, the
prospective parent gate should be selected in the Gate View or Gate
Navigator first.  Alternatively, you may drag the gate into the prospective
parent Gate (see Hierarchical Gating  for details) to define it as a child gate.

· Copying All Gates to Another Layout

From the Gate View  object, or Gate Navigator , press Ctrl+A on the
keyboard to select all, and Ctrl+C to copy.  Then, in the new or second
layout, open the Gate View or Gate Navigator, and press Ctrl+V to paste.

7.1.12 Linking Gates Together

In FCS Express, you can link two or more gates of the same type together. This
will make the gates duplicates of each other. Then, moving or resizing one gate
will move all linked gates.

To link two gates:

1.  Insert a Gate View using the Insert General Gate View command on
a layout with plot(s) containing two or more gates of the same type.
Note: You can only link gates of the same type, e.g., two rectangular
gates, or two elliptical gates. You cannot link a rectangular gate to an
elliptical gate.
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2.  Select both gates in the Gate View (using Shift-Click).

3.  Right-click on one of the selected gates and choose Link Selected Gates
from the pop-up menu (Figure 7.33).

Figure 7.33  Linking Gates

In the Gate View, when one of the gates is selected, the icon for the gates
will change from a square to a chain to indicate that the gates are linked
(Figure 7.34).
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Figure 7.34  Linked Gates
with Chain Icon

To break a link:

1.  In the Gate View, right-click on one of the linked gates and select Break
Link from the pop-up menu.

You can also clone/duplicate a single gate to create linked gates:

1.  In the Gate View, right-click on the gate you want to clone and select
Create Linked Gate from the pop-up menu.

2.  In the Create Linked Gate window that appears, enter a suffix that you
want to use to recognize the linked gate (Figure 7.35).

3.  Click OK.
4.  You will see a new cloned gate added to the Gate View, with the suffix

tagged on the end.

Figure 7.35 - Creating a Linked Gate

7.1.13 Hierarchical Gating

In examining flow cytometry data, a common theme is the analysis and
comparison of cellular subsets. In practice, this results in the widespread use of
combination gates with the Boolean operator AND. For example, you may first
specify a live cell subset with the intention of examining lymphocytes,
monocytes, and granulocytes within the live cells subset. To do so, you first
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define four gates: Live cells, Lymphocytes, Monocytes, and Granulocytes.
However, the subsets you wish to examine are combination gates of the type:
Live cells and Lymphocytes, Live cells and Monocytes, and finally, Live cells and
Granulocytes. Using this Boolean combination gating method, there are now
seven gates in the gate list. Adding additional subsets, e.g., T- and B-
lymphocytes, increases the gate number further.

Hierarchical gating facilitates this type of analysis by introducing the concept of
"parent" and "child" gates, thus obviating Boolean operators in a typical gating
strategy. A parent gate can contain one or more child gates and the gating
criteria of a parent gate are passed on to the child gate. In the example we are
discussing, the use of hierarchical gating reduces the number of gates present
from seven to four and eliminates the need to manually define combination gate
formulas.

The current gating hierarchy for a layout is listed in the Gate View  or in the
Gate Navigator .

In Figure 7.36, the hierarchical gating strategy for the gates in our example are
displayed in the Gate View.

Figure 7.36  Gate View
Showing Hierarchy

Note that the Lymphocytes, Granulocytes, and Monocytes gates are children
of the parent Live cells gate. This means that if you use the Lymphocytes gate
on a plot, the plot is actually gated on Live cells AND Lymphocytes. The same will
hold true for the other two child gates.

It is possible to change the gating hierarchy at any time, simply by clicking on the
gates in the Gate View and dragging the gate to a new hierarchical position.

When creating a new gate you may also choose a specific gate in the hierarchy
as the parental gate by selecting the Parent Gate drop down .

If you create a new gate on a plot that is already gated, and the when a new
gate is created, create it hierarchically option is turned on in the gate
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options , the new gate will become a child of the plot’s current gate. Note that
this option is turned on by default in FCS Express 6.  

7.1.14 Applying Gates to Plots

There are several different ways to apply a gate to a plot such that only the
events in the applied gate will appear in the plot: 

· Create a Gate View  from the Insert General group. Press and hold the

mouse button on the gate that you want to apply. While holding the mouse
button down, drag and drop the gate from the Gate View list onto a plot.

· Open the Gate Navigator from the View tab .

Press and hold the mouse button on the gate that you want to apply. While
holding the mouse button down, drag and drop the gate from the Gate
Navigator onto a plot.

· Select a gate on a plot. While holding the mouse button down, drag and

drop the gate to another plot.  If dragged to an empty spot on the layout, a
new plot gated on that gate will be created.

· Select a plot or multiple plots  and go to the Gating Create Gates

group. Select the gate from the Current Gates drop-down list.

· Right-click on a plot and select Format from the pop-up menu. Go to the

Overlays category (see Formatting Single Parameter Histograms  or
Formatting 2D plots ) and choose the gate you want to apply from the
drop-down list.  This is a convenient for applying different gates to overlays
on the same plot.

Note:  Different overlays on a plot need not have the same gate applied.

7.1.15 GatingML

Gating-ML is an open standard developed and maintained via a collaborative and
consensus driven process under the auspice of the International Society for
Advancement of Cytometry (ISAC). Details on Gating-ML may be found at
https://www.ncbi.nlm.nih.gov/pmc/articles/PMC4874733/. FCS Express
implements Gating ML through the use of batch processing actions  and the
gate view . 

7.1.15.1 Importing and Exporting Gates with Gating ML

FCS Express allows the export and import of gates into any layout using
GatingML - a standard file format to formally describe gates and facilitate the
exchange of gating information between experiments and collaborators.
Developed by the International Society for the Advancement of Cytometry
(ISAC), the GatingML format stores a textual representation of any gate or
gating hierarchy within an experiment as an XML file. 
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The GatingML format can be imported into FCS Express to add new gates or
replace existing gates. Gates can also be saved and exported from FCS Express
in the GatingML format for later use - such as archiving gate information or
sharing gating strategies between collaborators. 

In FCS Express, the GatingML import and export options can be accessed from
the Gate View or Gate Navigator windows by right-clicking on the window or
desired gate (Figure 7.37).  
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Figure 7.37. Accessing the GatingML Import and Export Options from the Gate
View (top) or Gate Navigator (bottom) windows.

Exporting Gates with GatingML 

All Gates (complete gating hierarchy) or Selected Gates can be saved and
exported in the GatingML format. 
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To Export All Gates within a layout (Figure 7.38):

1.  Right-click on the Gate View or Gate Navigator window.
2.  Select GatingML  Export  Export All.

Figure 7.38. Export All Gates in the GatingML format.

3.  The Save As window will appear. Name the file and select the desired export
location (Figure 7.39). 

4.  Click OK to export. All Gates on the layout will be exported as a single file in
the *.GatingML format. 



Gating 743

© 2023 De Novo Software

Figure 7.39. Select Export Location for GatingML.

To Export Selected Gates within a layout (Figure 7.40):

1.  Select the desired gate(s) to export within the Gate View or Gate
Navigator window. To multiple-select gates hold down Ctrl then left-click the
gates. 

2.  Right-click on the selection. Select GatingML  Export  Export Selected
Gates.

Figure 7.40. Export Selected Gate in the GatingML format.
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3.  Name the .GatingML file and select the desired export location (see Figure
above). 

4.  Click OK to export. Only the Selected Gates will be exported as a single file in
the *.GatingML format. 

Importing Gates with GatingML

Note: A layout must be set to Remember Parameter by Name  to be able to
import gates with the GatingML format.  After a layout has been created the
Remember Parameter option cannot be changed.  A layout needs to have this
option set before any kind of FCS Express template is created.

Gates can be imported into FCS Express in the GatingML format. The following
import selections are allowed when importing gates into FCS Express (table
below, Figure 7.41):

Import Selection Description

Only Replace Existing
Gates

If a gate exists on the layout with the same name as an
imported gate, it will be replaced by the imported gate. All
other gates are unchanged.

Replace and Create
Gates

If a gate exists on the layout with the same name as an
imported gate, it will be replaced by the imported gate. If a
gate is not present on the layout, it will be created as a
new gate. All other gates are unchanged.

Create All Gates and
Rename Duplicates

If a gate is not present on the layout, it will be created as
a new gate. Imported gates will be renamed if a gate
exists on the layout with the same name. All other gates
are unchanged.

Clean and Create
New

All existing gates on the layout will be deleted. Imported
gates will be created as a new gate.

Replace, Create, and
Clean

If a gate exists on the layout with the same name as an
imported gate, it will be replaced by the imported gate. If a
gate is not present on the layout, it will be created as a
new gate. All other gates on the layout will be deleted.

111
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Figure 7.41. GatingML Import Options.

To Import Gates onto the layout (Figure 7 above):
1.  Right-click on the Gate View or Gate Navigator window. 
2.  Select GatingML  Import. Left-click on the appropriate Import Selection

(see table above).

The imported gates will appear in the Gate View and Gate Navigator. To display
the imported gates on a plot, right-click on the plot and select Show gates.
Select the desired gate. To display the Gate Text boxes, right-click on the plot
and select Recreate Gate Text Boxes  Missing.

Gates can also be exported in the GatingML format with Batch Processing .
This option should be utilized when multiple files on the layout contain Iteration
Snapshots with iteration specific gate coordinates and these iteration specific
gate coordinates need to be archived or shared for collaboration purposes. When
using Iteration Snapshots, the Re-Run mode should be utilized to preserve the
active snapshots on the layout.
NB: If Data Specific Gates  are defined for one or multiple gates in an
Iteration, only the Master Gate of those gates will be included in the Gating ML
export.

7.2 Quadrants

Quadrants are generally used to divide the plot content in 4 complimentary, and
mutually exclusive, regions. Quadrants can quickly report statistics from any 2D
plot and if desired quadrants may be converted to gates  for downstream
population analysis.  Quadrants are accessed by selecting the Gating
tab Create Gates  command and subsequently clicking on the plot
of interest.  All aspects of quadrants including color, size, visibility, linking, and
type may be controlled by using quadrant formatting .
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7.2.1 Type of Quadrants

FCS Express supports three different kinds of Quadrants : Standard, Floating,
and Percentile. The four quadrants are defined as follows: Upper Left (UL), Upper
Right (UR), Lower Left (LL), and Lower Right (LR). All aspects of quadrants
including color, size, visibility, and more may be controlled by using quadrant
formatting .

Standard quadrants are the quadrants found in most flow cytometry software
packages. All four quadrants are square or rectangular and are defined by the
central vertex. Moving the central vertex of the quadrants will redefine all four
quadrants.

Floating quadrants allow the four quadrants to be non-rectangular. When the
quadrants are floating, each quadrant can have a different shape. The outer
vertices are no longer linked to the central vertex, and each vertex can be
manipulated individually (see Floating Quads example, below). Floating quadrants
allow the user to quickly and easily get statistics on populations that cannot be
demarcated by standard quadrants. This can eliminate the need for
compensation when only percentages are needed.

Examples of Standard Quadrants and Floating Quadrants are shown in Figure
7.42.

Figure 7.42  Standard vs Floating Quads
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Percentile Quadrants are similar to standard quadrants except that the vertex of
the quadrant is automatically calculated based on the percentile entered in the
Quads page of the Format dialog . The vertices of the quadrants will
automatically update as the data on the plot changes. For instance, if you set the
percentile to be 99%, the quads will automatically update so the center quadrant
vertex is at the channel where 99% of the events are below it. It can be useful
to set Percentile Quadrants on your controls and then link those quadrants to the
plots with your sample. Quad linking is described in the section on Linking
Quadrants to Quadrants .

7.2.2 Showing Quadrants

Only one set of quadrants can exist for a plot. You can control whether
quadrants are automatically displayed by checking the Show quadrants box in
the 2D Plots page of the Options  dialog. The default behavior is for the
quadrants to be hidden when the plot is created.

You can show the quadrants on a per-plot basis using one of the following
methods:

· Right-click on the plot and select Show Quadrants from the pop-up menu.

· Select the Gating Create Gates Quadrants command and click on the

plot at the position where you want the central vertex to be located.

· Right-click on the plot and select the Format menu item. Choose

Quadrants from the dropdown list. Enable the Show quadrants checkbox.

7.2.3 Moving Quadrants

Quadrant vertices can be adjusted either by using the mouse to click and drag
the vertex on the plot, or by entering the vertex coordinates on the Quadrants
page of a Format window. Quadrants can be updated in real time if desired by
choosing the FCS Express User Option to update Gates, Markers, and Quadrants
immediately. 

· Selecting Quadrants

To select the quadrants in order to edit their position, click on the central
vertex, where all the lines meet. If a Standard Quadrant is selected, a resizing
handle will appear at the central vertex. If Floating Quadrants are selected,
resizing handles will appear over all five vertices.  Percentile Quadrants cannot
be selected, as their position is dictated by the Formatting Quadrants
dialog.

· Moving Standard Quadrants
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Click on the central vertex of the quadrant you want to move. You will know
that you clicked on the correct position when the cursor turns into a four-

headed arrow . Press and hold the mouse button while the cursor is a
four-headed arrow. While holding the mouse button down, move the cursor
to the new central vertex position. Release the mouse to move the quadrants
to the new position.

· Moving Floating Quadrants

Click on the central vertex of the quadrant you want to move. You will know
that you clicked on the correct position when the cursor turns into a four-
headed arrow. Press and hold the mouse button while the four-headed cursor
is over any of the five vertices. While holding the mouse button down, move
the cursor to the new vertex position. Release the mouse to move the vertex
to the new position. Note: Much like the Standard Quadrants, the central
vertex can move anywhere within the plot. Outer vertices will only be able to
move along their original plot edge.

To enter the vertex coordinates directly on a Format window, see the Quadrants
section under Formatting 2D Plots . Note: Format windows where you can
enter vertex coordinates can be reached in one of two ways, either: Right-click a
plot and choose Format from the pop-up menu; or, select a plot and use the
Format 2D Options Quadrants command.

To cancel moving quadrant vertices once you have started, press the Esc key at
any time.  Or, to undo a move, hit Undo on the Quick Access Toolbar  or
Ctrl+Z on the keyboard.

Notes: 
· If quadrants are linked to the quadrants on another plot , the quadrants on

the dependent plot will move automatically. 
· Percentile quadrants (see the Quadrants section under Formatting 2D Plots )

cannot be moved manually.  Instead, the percentile(s) must be redefined .

7.2.4 Hiding Quadrants

Quadrants always exist with a plot. They can never be deleted, but they can be
hidden.

There are several ways to hide quadrants:

· Right-click on the plot and deselect the Show Quadrants item on the pop-

up menu.

· Right-click on the plot and select Format from the pop-up menu. Choose

the Quadrants category. Uncheck the Show quadrants box.
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· Select the plot and use the Format tab 2D Options Quadrants

command. Uncheck the Show quadrants box. 

· Select the quadrants by clicking on the central vertex. Press the Delete key

on the keyboard, or select the Home tab Editing Delete command.

7.2.5 Linking Quadrants to Quadrants

FCS Express allows you to link quads from one plot to another. This means that
when the quads on one plot are moved, the quads on the linked plot will be
updated automatically. This is useful in circumstances when you want to create a
reference quadrant on your control, from which the quads on your sample data
update automatically as the reference control quad is adjusted. To set up linked
quadrants, see Quadrant Linking Options .

7.2.6 Linking Quadrants to Gates

In FCS Express, quadrants are not immediately defined as gates so and do not
appear in the gate hierarchy until they are converted to a gate. Gates converted
from quadrants are drawn as polygon gates with the same coordinates as the
quadrants. The resulting gates are "linked" to their source quadrant, so that,
when the quadrant is moved, the gate also reflect the movement.

You can create a gate from the Upper Left, Upper Right, Lower Left, Lower
Right, Upper (Upper Left plus Upper Right), Lower (Lower Left plus Lower
Right), Left (Upper Left plus Lower Left), or Right (Upper Right plus Lower
Right) quadrants.
 

You can create a Gate from a Quadrant by either:

· Right-click on the plot and select the Convert Quads To Gates item in the

pop-up menu. Select the quad you wish to convert to a gate from the
submenu. 

· Right-click on the plot and select Format from the pop-up menu. Select

Quadrants from the dropdown list. Choose Quad to Gate from the
Linking Options box. Select a quadrant and an existing polygon or
freeform gate from the drop-down list. The gate will be linked to the
quadrant. Further information is available in the Quadrants section under
Formatting 2D Plot . Alternatively, you can reach the format window by
selecting a plot and using the Format 2D Options Quadrants command
from the ribbon bar.

The links between the quadrants and the gate may be broken at any time, from
either the Quadrant Formatting dialog  or the Edit Gate dialog  from the Gate
View object.
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7.2.7 Using Quadrants and the Clipboard

It is possible to copy and paste quadrants to and from the clipboard.

· Copying/Cutting a quadrant to the clipboard

Select the quadrant by clicking on the central vertex. Select the
Home Clipboard Copy Quad (or Cut Quad) command, or standard
Windows Cut or Copy keyboard shortcuts (Ctrl+X or Ctrl+C). Note: Cutting
does not delete the quadrants, it merely hides them.

· Pasting a quadrant

Select the plot where you want the quadrant to be pasted. Select the
Home Clipboard Paste Quad command, or right-click on the plot and use
the standard Windows Paste keyboard shortcut (Ctrl+V).

7.3 Markers

Markers are used to select regions of interest in histograms or for the X
parameter on a 2D plot. Markers can quickly report statistics from plots and if
desired markers may be converted to gates  for downstream population
analysis. Markers are accessed by selecting the Gating tab Create Gates
Marker command and subsequently drawing a marker on a histogram of
interest. All aspects of markers including color, size, visibility, end points and
more may be controlled by using marker formatting . 

 

7.3.1 Creating Markers

To create a marker on a plot, either:

· Select the Gating (or Home) tab Create Gates Create Marker

command, or

· Right-click on the plot and select Create marker from the pop-up menu.

Then, position the cursor where you want the left marker boundary to be, and
press and hold the mouse button down. While holding the mouse button down,
move the cursor to the right until the desired right marker boundary, and release
the mouse button.  If the Marker Creation Prompt Window is enabled in the
default 1D Plot User Options , a dialog window (Figure 7.43) will appear
enabling you to name the marker, define the label in the marker text box, create
a linked gate, and define the marker line width and color, if desired; if not
enabled, these properties can be changed after marker creation via the Marker
Formatting dialog .
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Figure 7.43 - Merker Creation Prompt Window

Markers can be updated in real time if desired by choosing the FCS Express User
Option to update Gates, Markers, and Quadrants immediately. 

High and Low bounds of markers within one plot or in different plots may be
linked so they move together  when either marker is adjusted. 

7.3.2 Moving Markers

Markers can be moved by clicking and holding on the center point of the marker
using the mouse and adjusting the position of the marker.  

When the marker is selected by clicking on it, three points will appear: a resizing
handle at the left- and right-boundaries, and a point in the center for moving the
marker (Figure 7.44). Position the mouse cursor over the central point so it
turns into a four-headed arrow. While keeping the mouse button pressed, move
the marker to a new position. Release the mouse when the marker is in the new
position. To cancel moving the marker mid-way through a move, press the Esc
key before releasing the mouse button and the marker will return to its original
position before a move was attempted.
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Figure 7.44 - Histogram showing a marker. Red boxes indicate the marker resizing
handles and green box indicates the marker center point.

Please refer to the next chapter to learn how to resize a marker with handles or
move a marker by defining its boundaries .

7.3.3 Resizing Markers

Markers can be resized by either of the following ways:

1.  Using the mouse .

2.  Via the Formatting Marker dialog .

3.  By dragging and dropping tokens on marker bounds .

4.  By dragging and dropping a different marker bound to link them .

5.  By dragging and dropping a gate to choose a statistic to link.

6.  By dragging and dropping a plot to choose a statistic to link.
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7.3.3.1 Resizing marker boundaries using the mouse

Markers can be resized using the mouse in the following way:

· Click anywhere on the marker to select it.

· When the marker is selected, three points will appear: a resizing handle at the

left- and right-boundaries, and a point in the center for moving the marker
(Figure 7.45).

· Position the mouse cursor over one of the resizing handles so it turns into a

two-headed arrow.
· While holding the mouse button down, move that marker boundary to a new

position.
· Release the mouse when the marker is the desired size.

· To cancel adjustment of the marker before you have released the mouse

button, press the Esc key and the marker will return to the original position.

Figure 7.45 - Histogram showing a marker. Red boxes indicate the marker resizing
handles and green box indicates the marker center point.

7.3.3.2 Resizing the marker boundaries via the Formatting Marker dialog

Markers end points may be set and/or locked to any number or numeric token
via the Formatting Markers dialog  in the following way:

· With the plot containing the marker you want to resize in selected or edit

mode, use the Format 1D Options Markers command from the

ribbon bar (alternatively, right click on the plot, choose Format and select
the Markers category) to launch the Formatting Markers dialog .
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· In the list of Marker's highlight the marker you would like to resize by

clicking on it.
· In the Marker Options section, Low and High represent the channel

numbers of the left and right marker boundaries, respectively.
· Change the Low and/or the High value by either typing in numbers

(decimal values may also be used) or by clicking on the T icon at the right
of the bound to select a numeric token. If the T icon is selected, then
choose Statistic from the Select a Token Type dialog and select the
numeric token of interest.

· Optionally, check the Locked check box to lock the marker bound to the

specified value. When the marker bound is locked to a token, the marker
bound will automatically resize when the token value changes. When a
marker bound is locked, the marker bound will not be resizable when
attempting to move the marker endpoint with the mouse.

· Clicking OK in the Formatting dialog will apply the changes.

Please note
When a marker bound is not locked to the specified value, the marker bound
will still remain resizable by moving it using the mouse. When this happens,
the manually inserted value (or the token value, if a token is used to set the
marker bound) will be replaced with the position defined using the mouse. To
avoid this, marker bounds can be locked to the given value via the
Formatting Markers dialog .

Although marker end points can be set and locked to any numeric token, a useful
application of this feature is setting and locking marker end points together so
that moving a marker end point will automatically cause an end point on a
different marker to update accordingly while preventing additional independent
adjustments of the markers. Markers may be linked within the same plot or
between different plots using these features. 

Below is a use case examples of linking and locking markers together via the
Formatting Markers dialog . 

To link and lock two or more marker end points together:

Linking marker end points is accomplished by setting the Low or High bound for
one marker to use a token value for the Low or High bound of a separate
marker. In the following example, both markers have been created on the same
plot and we will link the High bound of Marker 1 to the Low bound of Marker 2
to create a set of markers that will define positive and negative population.
(Figure 7.46).

1.  Begin with a layout in which two markers have already been created  on
one plot. 
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2.  Double click on the plot on which the markers were created to launch the
Formatting dialog. 

3.  Choose the Markers from the dropdown list (Figure below- Number 1). 
4.  Select the first marker (Marker 1) from the Marker list (Figure below -

Number 2). 
5.  Delete the contents of the field for High in the Marker Options section

(Figure below - Number 3). 
6.  Click on the T icon to choose a token (Figure below - Number 4). 
7.  Choose Statistic from the Select a Token Type dialog. 
8.  Click Insert. The Create Statistic dialog opens.
9.  Choose the Statistic category on the left. 
10.Select M2 from the Select a marker drop down. 
11. Choose Low bound from the Statistic list. 
12. Click OK. 
13. Check the Locked box of the High bound of Marker 1 in the Marker

Options.
14. Click OK in the Formatting dialog. 

Since the Locked option has been set, when the low bound of Marker 2 is
adjusted, the high bound of Marker 1 will now adjust automatically to match.
For the same reason, the high bound of Marker 1 cannot be adjusted
independently. Please note that dragging a new token value onto the marker
will update the value without having to unlock it first.

Figure 7.46 - Formatting a marker bound to use the high or low bound of
another marker. 

7.3.3.3 Resizing marker boundaries by dragging and dropping tokens

A marker endpoint may be set and locked to a token value by dragging and
dropping a numeric token onto it. The marker endpoint will be set to the token
value and will be automatically resized as soon as the token value will change.
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Please note: The marker bound will automatically be locked to the token, thus
the marker bound will not be resizable by using the mouse. The lock can be
removed via the Formatting Markers dialog  and unchecking the Locked
check box of the boundary of interest. Additionally, dragging a new token value
to the marker end point will override the original lock and lock the newly dragged
value to the end point. 

Below are two use case examples of setting and locking marker end point to
token using drag and drop:

Using a token in a statistics table to link two markers together.
In this use case the high bound of a marker (M1) is set and locked to the low
bound of another marker (M2). The action will be performed via dragging and
dropping the token referring to the low bound of marker M2 from a statistics
table to the high bound of marker M1 (Figure 7.47).. Please note that in this
example, the two markers are within the same plot, but the same procedure
may be used for markers which reside on different plots as well.

1.  Left click the cell of the stat table containing the token of interest to select it
(Figure below - Number 1).

2.  While pressing the left mouse button drag the cell on top of the right end

point of marker M1. Note that the cursor will appear as  (Figure below -
Number 2).

3.  Release the mouse button on top of the right end point of Marker M1. The
position of the right end point of Marker 1 now matches the value of the
token (Figure below - Number 3).

4.  When token value will changes by moving the low bound of marker M2, the
right end point of marker M1 will change accordingly (Figure below - Number
4). Please note that the opposite is not true. Since the right end point of
marker M1 is automatically locked to the left end point of marker M2, the
right end point of marker M1 will not be resizable by using the mouse (Figure
below - Number 5, note the absence of the resizing handle at the right-
bound). The lock can be removed via the Formatting Markers dialog  by
unchecking the Locked check box of the boundary of interest.
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Figure 7.47. The figure shows how to set and lock two marker end points together
by dragging and droppging a token contained in a statistics table.

Using a token in a text box to link a marker to it.
In this use case example a statistic token in a text box will be dragged and
dropped to the end point of a marker (i.e. Marker M1) to set that end point to
be equal to the value of the token (Figure 7.48).. Please not that any type of
statistical tokens, included custom tokens, can be used when they exist in a text
box.

1.  Highlight the token of interest (Figure below - Number 1).
2.  Left click on the highlighted token and drag it on top of the right end point of

Marker 1. Note that the cursor will appear as  (Figure below - Number 2).
3.  Release the mouse button on top of the right end point of Marker M1. The

position of the right end point of Marker 1 now matches the value of the
token (Figure below - Number 3).
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4.  When the token value changes, the right end point of marker M1 will change
accordingly. Please note that the opposite is not true. In addition, since the
right end point of marker M1 is automatically locked to the token, the right
end point of marker M1 will not be resizable by graphically acting on it using
the mouse (Figure below - Number 4, note the absence of the resizing handle
at the right-bound). The lock can be removed via the Formatting Markers
dialog  by unchecking the Locked check box of the boundary of interest.

Figure 7.48. The figure shows how to set and lock a marker end point to a token by
dragging and dropping the token from a text box.

7.3.3.4 Resizing and linking marker boundaries by dragging and dropping marker
bounds

A marker endpoint may be set and locked to an end point of another marker by
dragging and dropping one marker endpoint onto another marker endpoint. The
dependent marker endpoint will be automatically repositioned as soon as the
independent marker endpoint changes.
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Please note: The dependent marker bound will automatically be locked to the
independent one, thus the dependent marker bound will not be resizable by using
the mouse. The lock can be removed via the Formatting Markers dialog  by
unchecking the Locked check box of the boundary of interest.

Below is a use case example of linking two marker end points together using
drag and drop:

To set and lock two marker end points together using drag and drop.
In this use case the high bound of a marker (M1) is linked to the low bound of
another marker (M2). The action will be performed via dragging and dropping the
low bound of marker M2 onto the high bound of marker M1 (Figure 7.49)..
Please note that in this example, the two markers are within the same plot, but
the same procedure may be used for markers which reside on different plots as
well.

1.  Click anywhere on Marker 2 to select it. When the marker is selected, three
points will appear: a resizing handle at the left- and right-boundaries, and a
point in the center for moving the marker .

2.  Position the mouse cursor over the left resizing handles so it turns into a
two-headed arrow.

3.  Left click to select the left resizing handles.
4. While holding the mouse button down, drag that marker boundary on top of

the right end point of marker M1(Figure below - Number 1). Note that the

cursor will appear as  (Figure below - Number 2).
5.  Release the mouse button on top of the right end point of Marker M1. The

position of the right end point of Marker 1 now matches the position of the
left end point of Marker 2 (Figure below - Number 3).

6.  When the left end point of Marker 2 will change, the right end point of marker
M1 will change accordingly (Figure below - Number 4). Please note that the
opposite is not true. Since the right end point of marker M1 is automatically
locked to the left end point of marker M2, the right end point of marker M1
will not be resizable by graphically acting on it using the mouse (Figure below -
Number 5, note the absence of the resizing handle at the right-bound). The
lock can be removed via the Formatting Markers dialog  by uncheking the
Locked check box of the boundary of interest. Additionally, dragging a new
token value onto the marker will update the value without having to unlock it
first. 
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Figure 7.49 The figure shows how to set and lock two marker end points together
by dragging and dropping one on top of the other.

7.3.3.5 By dragging and dropping a gate

A marker endpoint may be set and locked to a token value by dragging and
dropping a gate onto it. The marker endpoint will be set to the chosen token
value and will be automatically resized as when the token value changes.

Please note: The marker bound will automatically be locked to the token, thus
the marker bound will not be resizable by using the mouse. The lock can be
removed via the Formatting Markers dialog  and unchecking the Locked
check box of the marker bound of interest.

To Link and lock a marker bound to a gate statistic.
In the example below the low bound of a marker (M1) is linked and locked to the
X Median of a gate (Gate 1). The action is be performed by dragging and
dropping Gate 1 onto the low bound of marker M1 (Figure 7.50). and selecting
the X Median from the statistic list. 
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1.  Left click and hold anywhere on Gate 1 (Figure below - Number 1) and drag
Gate 1 on top of the left end point of marker M1. Note that the cursor will

appear as  (Figure below - Number 2).
2.  Release the mouse button on top of the left end point of Marker M1. An Edit

Statistic dialog will open.
3.  Select X Median from the Statistic list within the Edit Statistic window.
4.  Click OK.

The position of the lower boundary of marker M1 will now link to the X Median of
Gate 1 (Figure below - Number 3).

When Gate 1 is adjusted, the lower boundary of marker M1 will change
accordingly (Figure below - Number 4). Please note that the marker endpoint is
now locked to the gate based token and cannot be updated by adjusting the
marker itself (Figure below - Number 5, note the absence of the resizing handle
at the left-bound). The lock can be removed via the Formatting Markers
dialog  by unchecking the Locked check box of the boundary of interest.

Figure 7.50 Setting and locking a marker end point by dragging and dropping a gate
on to the marker boundary.

7.3.3.6 By dragging and dropping a plot

A marker endpoint may be set and locked to a token value by dragging and
dropping a plot onto it. The marker endpoint will be set to the chosen token
value and will be automatically resized as when the token value changes.

Please note: The marker bound will automatically be locked to the token, thus
the marker bound will not be resizable by using the mouse. The lock can be
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removed via the Formatting Markers dialog  and unchecking the Locked
check box of the marker bound of interest.

To Link and lock a marker bound to a plot statistic.
In the example below the low bound of a marker (M1) is linked and locked to the
X Median of a quadrant on another plot. The action is be performed by dragging
and dropping the plot where the quadrant is displayed onto the low bound of
marker M1 (Figure 7.51). and by then selecting the X Median of the quadrant of
interest from the statistic list. 

1.  Select the plot where quadrant is displayed by left clicking on the plot border
(Figure below - Number 1).

2.  While holding the mouse button down, drag the plot on top of the left end

point of marker M1. Note that the cursor will appear as  (Figure below -
Number 2).

3.  Release the mouse button on top of the left end point of Marker M1. A Paste
Special dialog will open.

4.  Select Statistic token from the Paste Format list.
5.  Click OK. An Edit Statistic dialog will open.
6.  Select the Lower Right quadrant from the Select a quadrant drop down

menu in the Plot Information section of the Edit Statistic dialog. 
7.  Select X Median from the Statistic list within the Edit Statistic window. 
8.  Click OK.

The position of the low bound of marker M1 will now link to the X Median of the
lower right quadrant (Figure below - Number 3). 

When the quadrant is adjusted, the low bound of marker M1 will change
accordingly (Figure below - Number 4).  Please note that the marker endpoint is
now locked to the quadrant/plot based token and cannot be updated by
adjusting the marker itself (Figure below - Number 5, note the absence of the
resizing handle at the left-bound). The lock can be removed via the Formatting
Markers dialog  by unchecking the Locked check box of the boundary of
interest.
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Figure 7.51 Setting and locking a marker end point by dragging and dropping a plot
on to the marker boundary.

7.3.4 Deleting Markers

Markers can be deleted in one of the following ways:

· To delete a marker directly from a plot, click anywhere on the marker to

select it. When the marker is selected, three points will appear:  a resizing
handle at the left- and right-boundaries, and a point in the center for moving
the marker. Press the Delete key on the keyboard or select the
Home Editing Delete command.

· With the plot containing the marker you want to delete in selected or edit

mode, use the Format 1D Options Markers command. This brings up a
Formatting Markers dialog. In the Marker list box, highlight the marker(s)
you want to delete. Click on the Remove button. Click OK.

· Right-click on the plot containing the marker and select Format from the

pop-up menu. Choose the Markers category in the formatting dialog.
Highlight the marker(s) you want to delete in the list box. Click on the
Remove button. Click OK.

7.3.5 Using Markers and the Clipboard

· Copying/Cutting a marker to the clipboard
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Click anywhere on the marker to select it (three points will appear along the
length of the marker). Use the Home Clipboard Cut Marker (or Copy
Marker) command, or standard Windows Cut or Copy keyboard shortcuts
(Ctrl+X or Ctrl+C).

· Pasting a marker

Select the plot where you want the marker to be pasted. Use the
Home Clipboard Paste Marker command, or standard Windows Paste
keyboard shortcut (Ctrl+V).

· Markers that have been copy and pasted between different plots can also be

linked together  to move in union. 

7.3.6 Linking Markers to Gates

When a marker is linked to a gate, the gate is automatically resized as the
marker is resized or moved. A marker can be linked to any existing 1D gate
using the Marker list in the Formatting Markers dialog .

You can also create a new gate from a marker and link it automatically. To do
so:

· Right-click on the histogram, select the appropriate marker, and then select

Convert Marker to Gate Convert and Link from the pop-up menu. If
the Show prompt window radio button is set in Gate creation prompt
options , you will be prompted to enter a name for the new gate.

To break a linked gate, either:

1.  Use the Format 1D Options Markers command to bring up the
Formatting Markers dialog (or right-click on the histogram, select
Format from the pop-up menu, and choose the Markers category).

2.  Select the Marker from the list on the left.
3.  In the Linked Gate drop-down list, change the selection to No Link.

or,

1.  Access the Edit Gate dialog  from the Gate View object.
2.  Uncheck the Linked to... box (Figure 7.52)
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Figure 7.52  Unlinking a gate from a marker in the Edit
Gate dialog

A 1D gate can be automatically created every time a marker is created. This
option cab be activated:
· On one or more existing histograms by checking the Create a Linked Gate

check box in the Histogram Markers  dialog of the histograms of
interest.

· By default on every new histogram by by checking the Create a Linked

Gate check box in the 1D Plot Preferences  user options.
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8 Batch Processing

Batch Processing allows you to analyze many data files consecutively in a
single layout without having to set up new plots for each file. Batch processing
also gives you the ability to print, save, or export your layout and statistics in
many different formats, including a PowerPoint presentation, a Word document,
an Excel spreadsheet, a PDF file, or a text file.

Batch processing applies the analysis on the layout to every item in the Data
List, except items set as Stationary Controls (for Stationary Controls, please
see the Data tab  and the Panels  chapters).

Note: In the Data List you can also create gated data files  and then perform
Batch Processing on them, to export information from the events that are within
a user specified gate(s) into reports.

During batch processing, FCS Express 
 to systematically increment all the data

files in your layout. The items will be incremented in their order in the Data List
by the increment value specified in the batch processing options , or the
currently active panel .

Changing the files during a batch process is called iteration. During iteration, the
FCS files on every plot will be incremented and tokens will be evaluated.

You can choose not to increment a particular overlay by disabling the Change
data file during Next/Prev/Batch option for histograms  , spectrum plots
, or 2D plots . For example, you may choose not to increment a control file in
one overlay, while allowing iteration in the other overlays. In addition, you can
choose not to increment a particular token function by disabling the Change data
file during Next/Prev/Batch function for token Data Sources .

FCS Express allows you to define batch processes that can be performed during
iteration. These processes are divided into Action or Report processes:

· Action Processes

These processes allow you to print and/or save the layout in various
formats. The following lists all print/save processes:

o Print

o Save Layout

o Save to PowerPoint

o Save as PDF

o Save as Picture

o Publish Layout
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o Save Gating ML

· Report Processes

These processes allow you to export information from your layout to:

o Integrated Spreadsheet

o Microsoft Excel

o Microsoft Word

o A PDF file

o A text file

The information you can export includes plots (as pictures), statistics (as
columns, cells, or text), and tokens (i.e., the token information displayed in the
text box). Once you have chosen where to export the data by adding a Report,
you assign items to transfer to that Report.

There are four distinct steps to using Batch Processing properly after you have
set up your analysis layout:

1.  Add the data sets you wish to analyze, in the correct order, to the Data
List .

2.  Add Batch Action and Report processes to the Batch Processing Action
Screen .

3.  Specify the Batch Processing Options .
4.  Run the Batch Process .

8.1 Adding Batch Processes

After creating the Data List, the second step in Batch Processing is to define
which processes to perform. FCS Express allows you to perform actions and
reports during the batch process .

To add actions to the batch process, use the Batch Batch Processing Batch
Actions command to bring up the dockable Batch Actions window (Figure 8.1).
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Figure 8.1  Batch Actions Window

To add a new process to the Batch Process Actions list, click on the process
from the list of available items on the left of the Batch Actions window. An
appropriate dialog box will appear to further specify the action for each process.
For example, to add a Print  action, you must specify the printer, the number
of pages, and the number of copies to print.

Once a process has been added to the Batch Process Actions list, it is
automatically set as active and will execute when running the Batch (the box to
the left of the process in the Batch Process Actions list will be checked). To
deactivate a process so that it will not execute in the Batch, uncheck the check
box to the left of the process name.

Multiple actions of the same type can be added to the Batch Process Actions
list. For example, two print processes can be active at once. The first print
process could print pages 1-5 on printer #1 and the second print process could
print pages 6-10 on printer #2.

Because both of the actions in the previous example will be listed as "Print" in the
list, it could be helpful to change the process names in a complex batch list. To
rename an action in the list:
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1.  Select the process name and press F2 (or right-click on the action and
choose Rename from the pop-up menu).

2.  Type in the new process name.
3.  Press Enter.

Figure 8.2 shows an example of a Batch Process with several actions defined.
The two active print actions have been renamed with descriptive text. The Save
Picture of Plot action has been deactivated, indicating that it will not be used the
next time the Batch Process is run.

Figure 8.2  Batch Process Actions List with Actions

Right-clicking on a process in the Batch Process Actions list brings up a pop-up
menu with the following options:

· Cut/Copy/Paste: Allows copying and pasting processes. This facilitates

moving tokens from one report to another.
· Delete: Delete the selected action.

· Rename: Enter a meaningful name for the selected action.
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· Add Items: For Reports, you can add Items that can be found in the Add

Item To Report section.
· Properties: Display the dialog box for the selected action to allow changes

to the action properties.

8.1.1 Batch Processing Actions

The Batch Processing Actions include printing a layout , saving a layout ,
saving to PowerPoint , saving to PDF , and saving as a picture . You can
also group your actions using a folder (action container)  and export a
description of your gates in the Gating ML  format.

8.1.1.1 Print

A Print action will allow you to automatically print a range of pages during a batch
process.

To create a Print Action, click on Print (in the Add Action section of the Batch
Actions window). The Create Print Action dialog (Figure 8.3) is used to set up
how the layout will be printed with each iteration of the batch process.
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Figure 8.3  Create Print Action Dialog

The properties in the Create Print Action dialog are divided into five sections:

· Printer

Select which printer to use to print the layout.
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· Print Options

o Quality. Will be set to On-screen. 

o Mode. Choose to print layout pages as single or multiples per printed

page(s).  With Full Page selected, the layout page(s) for each
iteration  will be printed as individual page(s). Multiple layout pages
may be printed per page using a preset multiple page option (i.e. 3
Pages with Notes or 9 Pages Vertical) or Custom Grid Options .
To print the layout pages on fewer pages, please select a preset multiple
page option or Custom Grid. To select a preset multiple page option or
customize the tiling, click the down arrow to the right to expand the
dropdown list and select a multiple page option or Custom Grid
Options..., respectively.  When selecting Custom Grid Options, the
Custom Grid popup window will appear.

o Frame Page. Flag this option to draw a frame around layout page(s).

o Crop To Content. Available for selection when Mode is not set to Full

Page. When selected, empty space of the layout page(s) is cropped
during the export.

· Extra Print Options

o Print Side. Choose to print One Sided, Two Sided Horizontal, or

Two Sided Vertical.
§ Select One Sided for single-sided printing.
§ Select Two Sided Horizontal for long-edge page turning.
§ Select Two Sided Vertical for short-edge page turning.

o Collate. May be set to Collated for which all pages are printed in

ordered sets or Uncollated for which all copies of the first page
followed by copies of subsequent page(s).

o Color Mode. May be set to Color or Grey Scale.

· Page Range

Choose which page(s) of the layout to print.

· Iteration options
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Choose whether to save the output of each iteration to a separate
document or combine all the iterations into a single document.  Combine
the output of all iterations into a single print task, without page
break must be selected when Mode is not set to Full Page. 

o  Print the output of each iteration separately.

§ Each iteration will be printed separately. 

o  Combine all the output from all iterations into a single print

task.
§ All iterations will be combined into one print task for printing.

o  Combine the output of all iterations into a single print task,

without page break
§ All iterations will be combined into one print task. Depending on

your Export Options Mode settings many iterations may be
combined into one page for printing.

· Copies

Designate how many copies of the layout to print.

Click OK when you have finished. At this point, the Printer action will be added to
the list of batch actions.

8.1.1.2 Save Layout

To create a Save action, click on Save Layout (in the Add Action section of the
Batch Actions window).

The Create Save Layout Action dialog (Figure 8.4) is used to set up how the
layout will be saved after each iteration.
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Figure 8.4  Create Save Layout Action Dialog

The properties are divided into three sections:

· Output File

The Output file field determines the name and location of each saved
layout. Since you will need different names for each file that is saved in
each iteration, the filename you enter must contain dynamic information
that changes for every iteration. In order to create a dynamic filename,
you have to insert a token  as part of the name. The most common
token used in conjunction with a dynamic filename in Batch Processing is
the Current iteration token.

Before you insert the token into the Output file field, make sure you have
entered a filename in the field, and then position the cursor where you
want the token text to appear. To insert a Current  Iteration token:

1.  Click on the  button to bring up the Insert a Token dialog.
2.  Click on the triangle next to Batch Processing.
3.  Select Current iteration (Figure 8.5).
4.  Click Insert.
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Figure 8.5  Insert a Current Iteration Token

Figure 8.6 shows an example of Output file, which will create a dynamic
filename using the Current iteration token.
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Figure 8.6  Example Output File with Current Iteration Token

Running the Batch with this output file would generate files such as C:
\Temp\Layout-1.fey, C:\Temp\Layout-2.fey, etc. If Ask for confirmation
before overwriting an existing file is checked, you will be prompted to
approve overwriting already existing filenames when the batch process is
run.

You do not have to use the Current iteration token. You can use any
token whose information changes with every increment. For example,
Patient ID, Sample ID, or some calculated value could all be used to
generate unique dynamic file names.

· Data Link

The options are the same as in the Save Layout dialog .

· Save Options

The Save only at the end of a batch option will save a single copy of the
layout for the last iteration in the batch process.

 
This can be a useful option if the goal is to save a single copy of the layout

that contains a saved Iteration Snapshot  for each iteration run through the
batch.

Click OK to finish editing the Save Layout properties. At this point, FCS Express
verifies that the Output file has been filled in properly. If you have left the Output
file field empty, or if the path name contains characters that are not allowed in a
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filename, then a Messages with descriptions of the errors will appear (Figure
8.7).

Figure 8.7  Batch Processing Error Messages

This dialog allows you to Save the action with the error, or to Correct it. If you
choose to save the action without correcting the error, this action will not be
executed in the Batch.

8.1.1.3 Save To PowerPoint

To create a Save To PowerPoint action, click on Save To PowerPoint (in the
Add Action section of the Batch Actions window).

The Create Export to Powerpoint Action dialog (Figure 8.8) is used to set up
how each iteration of the layout will be saved as a PowerPoint presentation file.
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Figure 8.8  Create Export to Powerpoint Action Dialog

The properties are divided into six sections:
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· Powerpoint Options

o Include background (from Master Slide). Flag this option to include

the background from Master Slide. If you choose to export the
background, the objects on the FCS Express Master Page will be placed
on the PowerPoint master slide. These background objects will then
appear on all of the PowerPoint slides.

o Open presentation after saving. When checked, the PowerPoint

presentation will be opened after the batch process has ended.

o Hide Objects that are off the page. When checked, objects that are

not located on the white page in the layout will not be exported to
PowerPoint.

· Page Range

Choose which layout pages to export.

· Export Options

o Quality. Set the PowerPoint quality (High, Medium, Low, On-Screen)

from the dropdown list. 

o Mode. This option enables single or multiple layout pages per slide based

on selection.  With Full Page selected, the layout page(s) for each
iteration  will be exported as individual slide(s). Multiple layout pages
may be printed per slide using a preset multiple page option (i.e. 3
Pages with Notes or 9 Pages Vertical) or Custom Grid Options .
To export the layout pages on fewer slides, please select a preset
multiple page option or Custom Grid by clicking the down arrow to the
right to expand the dropdown list and selecting a multiple page option or
Custom Grid Options..., respectively.  When selecting Custom Grid
Options, the Custom Grid popup window will appear. See an example
of the output below in (Figure 8.9).

o Frame Page. Flag this option to draw a frame around layout page(s).

o Crop To Content. Available for selection when Mode is not set to Full

Page. When selected, empty space of the layout page(s) is cropped
during the export.
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· Iteration options

o  Save the output of each iteration to a separate presentation.

§ Each iteration will be saved as a new PowerPoint presentation. 
o  Combine all the output from all iterations into the same

presentation.
§ All iterations will be combined into one new PowerPoint

presentation.
o  Combine the output of all iterations into a single file, without

page break. 
§ All iterations will be combined into one new PowerPoint

presentation. Depending on your Export Options Mode
settings many iterations may be combined into one PowerPoint
slide as seen in the figure below. 

· Append Options

Choose whether to export to a new file or append the output to an
existing PowerPoint presentation.

· Output file options

Click on the folder icon to choose a location on the computer or server
and create the filename for the exported PowerPoint file(s). See Save
Layout - File Options for a description of batch generated filenames .

Click OK when you are finished editing the properties.
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Figure 8.9 Custom Grid Options enabled for batch processing 9 data files for two
layout pages exported to a single PowerPoint slide.
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Note about ungrouping objects in PowerPoint for PC versus PowerPoint
for Mac

Once exported to PowerPoint, layout objects can be further ungrouped into
single components in the PC version of Microsoft PowerPoint. Ungrouping
objects saved by FCS Express in PowerPoint for Mac is not supported. However,
presentations saved on a Mac may be opened on a PC and ungrouped. 

8.1.1.4 Save To PDF

To create a Save To PDF action, click on Save To PDF (in the Add Action
section of the Batch Actions window).

The Create Export to PDF Action dialog (Figure 8.10) is used to set up how
each iteration of the layout will be saved as a PDF file.
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Figure 8.10  Create Export to PDF Action Dialog

You can choose to Open the PDF file after saving. The properties are divided into
the sections below:
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· PDF Options

Embed fonts (will increase file size). This option ensures that all of the
font information used to make your document look the way it does is
stored in the PDF file.

· Export options

o Quality. Set the PDF quality (High, Medium, Low, On-Screen) from

the dropdown list. 

o Mode. This option enables single or multiple layout pages per page based

on selection.  With Full Page selected, the layout page(s) for each
iteration  will be exported as individual slide(s). Multiple layout pages
may be printed per slide using a preset multiple page option (i.e. 3
Pages with Notes or 9 Pages Vertical) or Custom Grid Options .
To export the layout pages on fewer pages, please select a preset
multiple page option or Custom Grid by clicking the down arrow to the
right to expand the dropdown list and selecting a multiple page option or
Custom Grid Options..., respectively.  When selecting Custom Grid
Options, the Custom Grid popup window will appear, which will contain
following five settings:

o Frame Page. Check this option to draw a frame around layout page(s).

o Crop To Content. Available for selection when Mode is not set to Full

Page. When selected, empty space of the layout page(s) is cropped
during the export.

See an example of the output in Figure 8.11 below.

· Page Range

Choose which layout pages to export.

· Iteration options

o  Save the output of each iteration separately.

§ Each iteration will be saved as a new file. 
o  Combine all the output from all iterations into a single file.

§ All iterations will be combined into one new file.
o  Combine the output of all iterations into a single file, without

page break. 
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§ All iterations will be combined into one new file. Depending on
your Export Options Mode settings many iterations may be
combined into one page in the file as seen in the figure below. 

· Append Options

Choose whether to start with a new file or append the output to an
existing PDF file.

· Output file options

o Append to the file being combined with (specified above). This

option is only available when both the Combine the output from all
iterations into a single file and the Append to an existing PDF file
are selected.

o Save to a new file. Use this option to generate a new PDF file and enter

the filename for the generated PDF file. See Save Layout - File Options
for a description of batch generated filenames . 

o Ask for confirmation before overwriting an existing file. Chose this

option to be prompted about the existence of a file with the same name
before overwriting it.

o Create output folder if it does not exist. Chose this option to

automatically create the output folder if it does not exist. 

o Open the PDF file after saving. When checked, the PDF file will open at

the end of each iteration.

Click OK when you are finished editing the properties.
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Figure 8.11 Custom Grid Options enabled for batch processing 9 data files fortwo
layout pages exported to a single PDF page.

8.1.1.5 Custom Grid Options

FCS Express allows for customization of output format when printing, creating
PowerPoint documents, and generating PDF files, from the export and batch
processing  features by setting Custom Grid Options (Figure 8.12).  These
options allow you to export in a mode where multiple plots or pages are tiled in
your resulting document automatically allowing for many plots or pages to be
presented on one (or many) page(s) in your final report according to the tiling
options you have defined. The Custom Grid Options may also be enabled when
using the Multiple Duplicate and Next and Multiple Duplicate and Prev(ious)
options available from the Home tab Clipboard group Duplicate drop down
menu.  The selected plot(s) will be duplicated in a mode where the new plots will
be added to same page or other pages of the layout based upon tiling options
defined.
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Figure 8.12 Custom Grid Options

When selecting Custom Grid Options, the Custom Grid pop up window will
appear, which will contain the following five settings:

· Number of columns: define the number of layout pages displayed across the

printed page(s) or exported slide(s) or PDF page(s).

· Number of rows: define number of layout pages displayed down the printed

page(s) or exported slide(s) or PDF page(s).

· Order: arrange the layout pages across (Horizontal) or down (Vertical) the

printed page(s) or exported slide(s) or PDF page(s).

· Gap mode: select how to define horizontal distance (Gap value) between

layout pages.

· Gap value: value used for distance of Gap mode in inches; will update

automatically if Gap mode is set to Auto; will be 0.02 inches if Gap mode is
set to Minimal; can enter preferred value if Gap mode is set to Manual. 
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Example of batching a set of data files from the data list to PowerPoint using the
Custom Grid feature. Notice that one set of plots was defined in FCS Express and a
series of tiled plots have been exported to PowerPoint in one column in three rows.

8.1.1.6 Save As Picture

To create a Save As Picture action, click on Save As Picture (in the Add Action
section of the Batch Actions window).

The Create Save Picture of Plot Action dialog (Figure 8.13) is used to set up
how, in each iteration, plots or layout pages will be saved as picture files.
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Figure 8.13  Create Save Picture of Plot Action Dialog

The properties are divided into three sections:

· File Options

Enter the filename for the exported file. See Save Layout - File Options for
a description of batch generated filenames .

· Picture output options

Choose the file type (JPEG, Bitmap, Metafile, GIF, PNG, TIF) from the
drop-down list. For JPEG files, choose a picture quality using the spin
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control. Set the resolution using the radio buttons. For Metafiles, choose
whether or not to embed the plot data as a bitmap.

· Get a picture from

Choose to save a particular plot/text box or a full page in the layout using
the radio buttons. Select the plot or layout page from the list box.

Click OK when you are finished editing the properties.

8.1.1.7 Save Gating ML

To create a Save GatingML  action, click on Save GatingML (in the Add
Action section of the Batch Actions window). Note that gates can also be
exported directly from the layout  and saved in the GatingML format.

The File Options page of the Save GatingML Options dialog (Figure 8.14)
consists of one section:

o Output File Options

Enter the filename for the exported file. See Save Layout - File Options for
a description of batch generated filenames .
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Figure 8.14 Save GatingML File Options

The Export Gates Options page of the Save GatingML Options dialog (Figure
8.15) is used to select the gates on the layout to be exported. Select the radio
button for All gates to export all gates, Only the gates checked below to
export specific gates, or All gates except those checked below to exclude
specific gates from the export.
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Figure 8.15 Save GatingML Export Gates Options

The Data Source page of the Save GatingML Options dialog (Figure 8.16)
consists of three sections:

o  Data Source

Select the data source (Plot, Spreadsheet or Data File From Disk) to
export gate coordinates

o Select a Plot

Select a plot on the layout to export gate coordinates from

o Select an Overlay

Select the overlay on the plot to export gate coordinates from
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Figure 8.16. Save GatingML Data Source Options

8.1.1.8 Folders (Action Containers)

Folders (Action Containers) are used for organizational purposes. They do not
generate output by themselves. Think of them simply as a container for a group
of related actions.

The advantage of folders is that by unselecting the folder, the actions within the
folder will not be executed during the batch.

In Figure 8.17, two folders are defined. The actions in the Main Actions folder will
all be run, since the Main Actions folder is checked. However, the actions in the
Supplemental Actions folder will not be executed (even though the individual
actions are checked), because the Supplemental Actions folder is not checked.
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Figure 8.17  Folders (Action Containers)

If a folder is deleted, all its contained actions will be deleted. You can drag and
drop a folder like any other action, and all the contained actions will move with it.
If you copy a folder to the clipboard, all the contained actions will be copied.

8.1.2 Batch Processing Reports

Reports are used to export items (e.g., tokens, pictures) into Excel, Word or as
Text/PDF files. All reports can contain tokens, and Word/Excel reports can also
contain images. Exporting items using Reports is a two-step process:

1.  Add the Report type to the Batch Actions list by selecting it from the Add
Report section of the Batch Actions window.

2.  Add the item(s) to be exported to the appropriate Report process.

There are seven types of reports: 

· Spreadsheet  (text)

· Excel - Column Mode  (text)
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· Excel - Cell Mode  (text and images)

· Word Report  (text and images)

· PDF Form  (text)

· Text Report  (text)

The items which can be exported to a report are determined by the report type.
Depending on the report type, the following items may be available: 

· Regular Token  (all available tokens, including Custom tokens )

· Statistic Token

· Keyword Token

· Picture  (a plot in the layout, or an entire page of the layout, only used in

Word, Excel-Cell Mode, and DDS reports)
· Text Box  (text in a text box (e.g., canned comments) can be exported

to a column in an Excel worksheet or other location)
· Gating ML

· PDF

· Layout

· PowerPoint

· FCS File

An example of the Batch Process Actions for an Excel (Cell Mode) report is
shown in Figure 8.18. 

Figure 8.18  Batch Process Actions for Excel Report
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This report will export two statistics and a picture of a specified plot for each
iteration of the batch process. Only items that are checked will be exported.

Using the check boxes for each of the Batch Process Actions, an item can be
enabled or disabled to run with the Batch Process. If you double click on the
Batch Process Action (or right-click and choose Properties from the pop-up
menu), you can navigate to the Running Options page of the Options dialog to
control the activation state of an action (Figure 8.19). If you choose the Set the
check box from the value of the expression below radio button, you can
input a formula (using standard or custom tokens) to control the action.

Figure 8.19  Running Options

8.1.2.1 Working with Reports

To create a new report:

1.  Use the Batch Batch Processing Batch Actions command.
2.  Select the report type from the Add Report section of the Batch Actions

window. A properties dialog for that report type will appear. Once the
properties are set, the report will be added to the list of Batch Process
Actions.

 
There are seven different types of reports: 

· Spreadsheet

· Excel (Column Mode)

· Excel (Cell Mode)
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· Word

· PDF form

· Text

· Spreadsheet

All tokens contained in the Spreadsheet report will be written to the integrated
Spreadsheet  selected in the File Options (see below). Each token will be
reported in its own column. By default, the values for each iteration are written in
the same column but in new rows. An example of the output of a Spreadsheet
report is shown in Figure 8.20. The default Rows/Columns arrangement can be
transposed (see below the  Rows/Columns arrangement option).
Important Note: With the Spreadsheet Batch Report, tokens are reported into
the integrated Spreadsheet as plain text, not as actual tokens which means
statistics will not update when gates/markers/quadrants are adjusted, or when
loading a different iteration.

Figure 8.20  Example result of a Spreadsheet Batch Report

The File Options page of the Excel (Column Mode) Options dialog
(Figure 8.21) has two sections:

o Select a Spreadsheet
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The target spreadsheet can be selected between all the
spreadsheets available in the layout.

o  Row Options and Column Options

Row and Column options allow users to define at which row/column
to start populating the spreadsheet with the selected statistics.

o Rows/Columns arrangement

The Row/Column arrangement options define whether to export
Iterations in rows and Statistics in columns or vice-versa. 

o Header options

The header options allow users to define whether or not to write
the statistic header for each Row/Columns column.  
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Figure 8.21  Spreadsheet Batch Report File Options

· Excel (Column Mode)

All tokens contained in this report will be written to a Microsoft Excel file.
Pictures cannot be added to this report. Each token will be reported in its
own column. The values for each iteration are written in the same column,
but in new rows. An example of the output of an Excel (Column Mode)
report is shown in Figure 8.22.
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Figure 8.22  Excel (Column Mode) Sample Report

The File Options page of the Excel (Column Mode) Options dialog
(Figure 8.23) has two sections:

o Append Options

With the radio buttons, you can choose to Start with an empty
file or Combine the output with the data in an existing file. If
you combine data from an existing file, FCS Express will join the
Batch Processing output with the data that exists in the Excel file
(.xls) entered in the text box. The final output (new iterations plus
existing data) will be written to another worksheet.

o Output file options

When combining data with an existing file, the destination file can be
a new file (.xls) or the existing Excel worksheet.
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Figure 8.23  Excel (Column Mode) File Options

The Worksheet Options (Figure 8.24) page of the Excel (Column Mode)
Options dialog allows you to assign the name of the worksheet (optionally
using a token). You can use either a new worksheet or an existing
worksheet. If you use an existing worksheet, you can designate  Row
Options and Column Options (e.g., start at the first available row or column
or start at a particular row or column).

The Row/Column Arrangement radio button controls whether iterations
are exported as new columns or new rows within a document. 

The Header Options allow FCS Express to automatically write the Field
Label  to the result Excel document. By default, this option is enabled.812
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Figure 8.24  Worksheet Options

· Excel (Cell Mode)

The Excel (Cell Mode) report allows you to merge you data with a
preexisting spreadsheet. You select a Template Document (spreadsheet)
containing headings, fonts, and colors, and then specify the exact cell
destination for each output item, including pictures. An example is shown
in Figure 8.25.
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Figure 8.25  An Example Excel (Cell Mode) Report

The File Options page of the Excel (Cell Mode) Options dialog (Figure
8.26) has four sections:

o Template Document

Enter the filename (and path) to your preformatted Excel
workbook. The first worksheet in the workbook will be used as the
template.

o Iteration options

Output each Batch iteration to a separate file (the default), or
combine the output from all Batch iterations to a single file. In the
latter case, each iteration is written to a separate worksheet within
a single Excel workbook.

o The Append Options and Output file options are identical to those

for the Column Mode described above.
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Figure 8.26  Excel (Cell Mode) File Options

· Word Report

With this report type you can create Word files resembling Figure 8.27. A
Word Template Document contains all the headings and text formatting.
When combined with the output of the values from Batch Processing, you
can create professional quality reports. All tokens contained in a Word
Report, including pictures, will be written to a Microsoft Word file during
each iteration using the mail merge features of Word. Once each token
has been configured with a Field Name , the token value will be merged
with the Word Merge Field. Details on setting up the Word report with mail
merge fields are described under Creating Templates for Reports .

812

809
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Figure 8.27  Example Word Report
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The File Options page of the Word Report Options dialog has four
sections similar to those described for Excel (Cell Mode) reports:

o Template Document

Enter the filename (and path) to your preformatted Word
document.

o Iteration options

Output each Batch iteration to a separate file (the default), or
combine the output from all Batch iterations to a single file.

o The Append Options and Output file options are identical to those

for the Column Mode described above.

· PDF Form Report

In addition to exporting your layout directly as a standard PDF file , FCS
Express can merge your statistics with PDF Form files. PDF forms are
special PDF files that allow you to enter information in specific fields. FCS
Express will export all tokens contained in the report to the specific fields in
the PDF file. Once each token has been configured with a Field Name ,
the token values will be placed into the report fields designated in a
preformatted PDF file.

The File Options page of the Export to PDF Options dialog has four
sections similar to those described for Excel (Cell Mode) reports:

o Template Document

Enter the filename (and path) of the preformatted PDF template
document.

o Iteration options

Output each Batch iteration to a separate file (the default), or
combine the output from all Batch iterations to a single file. In the
latter case, each iteration is written to a new page in the PDF
document.

o The Append Options and Output file options are identical to those

for the Column Mode described above.

107
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· Text Report

All tokens in a Text Report will be written to a text file, with custom
separator (see below the Encoding Options). The first row of the text file
will contain the column header of each exported item (see below the
Header Options). A new row of outputted values will be created for each
iteration. Note: Pictures cannot be exported to this type of report.

The File Options page of the Text File Report Options dialog is similar
to the Excel (Column Mode) format (described above) with two sections:

o Append Options

With the radio buttons, you can choose to Start with an empty
file or Combine the output with the data in an existing file. If
you combine data from an existing file, FCS Express will join the
Batch Processing output with the data that exists in the text file
entered in the text box. The final output (new iterations plus existing
data) will be written to another text file.

o Output file options

This option goes along with the previous one.
When Start with an empty file is selected in the Append Options,
a file name must be specified. Available file extensions are .tab, .prn
and .csv. To generate a Txt file, the .txt extension needs to be
manually specified in the file name. When combining data with an
existing file, the destination file can be a new file or the existing text
file.

Two additional sections are also present:

o Encoding Options

Two drop-down menus allow to select the desired Separator (Tab,
Space or Comma) and the Encoding (ANSI or Unicode (UTF8)).

o Header Options

This check box defines whether the first exported raw will contain
the column header of each exported item.

8.1.2.2 Creating Templates for Reports

You can create templates for Excel (Cell Mode) reports, as well as PDF and Word
reports.
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· Creating Excel Templates

Excel templates are simply Excel spreadsheets. You can use any Excel
functionality in the spreadsheets that are used as templates. Simply leave
blank cells where you want FCS Express to put the data or pictures. Enter
those cells as the Cell Address on the Field page of the options dialog
corresponding to the exported item.

· Creating PDF Form Templates

When creating a PDF template, the PDF file must contain text fields (which
must be uniquely named) where FCS Express will place the data from your
layouts. PDF files containing text fields can be created with numerous PDF
creation programs, such as Adobe Acrobat®. Please refer to your PDF
creation program for instructions on how to create PDF files with text fields.

· Creating Word Templates

In order to create a report using Word, you must use the Word mail merge
functions. A brief overview of how to create mail merge templates is given
below. For more details, please consult the documentation for your version of
Microsoft Word®.

When creating a Word report template, you must enter fields into your Word
document where FCS Express will place the exported data from the layout
during batch processing. Enter those fields as the Mail Merge field name on
the Field page of the options dialog corresponding to the exported item.

Please refer to the help files in your version of Word for detailed instructions
on how to create Word documents with mail merge fields.

8.1.2.3 Adding Items to Reports

An item is something that is exported from FCS Express to a particular report.
Reports usually contain multiple items. Whenever you add an item to a report, it
is added to the bottom of the list of existing items in the report. To see all the
items contained in a report, expand the report by clicking on the + to the left of
the report name. You can reorder the items in the report  by selecting item(s)
and dragging them to a new order position. You can also drag item(s) from one
report to another.

Items can only be added to the Batch Process Actions list after a Report has
been added because the item must be added directly to a report. There are four
methods to add items to reports:

· Adding items from a Text Box or a Statistics window.

815
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If you have a layout with an open statistics window or with tokens in a
text box, you can add some or all of these items to an existing report.
Perform the steps as follows:

1.  Open the Batch Actions window by using the Batch Batch
Processing Batch Actions command.

2.  Make sure you have a report in the Batch Process Actions list.
3.  Dock the Batch Actions window (or position it such that you can

view the statistics window or Text Box in the layout).
4.  To add statistics, highlight the cell(s) in the statistics grid and drag

them onto the report in the Batch Process Actions area. When the
report is highlighted, release the mouse button.

5.  To add token(s) from a Text Box, highlight one or more tokens and
drag them onto the report in the Batch Process Actions area.
Once the report is highlighted, release the mouse button.

· Adding items from a plot, gate, marker, or quadrant.

Perform the steps as follows:

1.  Open the Batch Actions window by using the Batch Batch
Processing Batch Actions command.

2.  Make sure you have a report in the Batch Process Actions list.
3.  Click on the page of the layout containing the plot(s) from which

the items will be added.
4.  Drag and drop the plot gate, marker, or quadrant (for quadrants,

drag and drop from the center vertex) onto the report in the Batch
Process Actions area. When the report is highlighted, release the
mouse button.

5.  Select the item(s) from the Statistic list box or the Please select
one or more keywords dialog.  

Note: Multiple items may be selected and added while holding
down Ctrl on the keyboard.

· Adding items from the Add Item to Report list.

When you first open the Batch Actions window, the items in the Add
Item to Report section will be disabled. After adding a report to the Batch
Process Actions list, items appropriate to that report type will be enabled.
To add an item to a report:

1.  Open the Batch Actions window by using the Batch Batch
Processing Batch Actions command.

2.  Click on the report that will contain the item.
3.  Click on an enabled item in the Add Item to Report section.
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4.  Once an item has been added to a report, you will need to configure
the item’s "report-specific" property . This property tells FCS
Express where to insert the item in the final report.

· Adding items by right clicking on the Action (Figure 8.28).

1.  Open the Batch Actions window by using the Batch Batch
Processing Batch Actions command.

2.  Right click on the report that will contain the item.
3.  Mouse over Add Item.
4.  Choose an item from the list of available items in the drop down.

Figure 8.28) Adding items to a batch action by right clicking on the action.

8.1.2.3.1  Configuring a Report Item's Report Specif ic Property

When adding items to reports, there is a report-specific property that needs to
be set to tell FCS Express where to insert the item in the final report. This
property differs depending on report type. It is usually found on the Field page of
the report item options dialog. For example, when you add a Regular Token
from the Add Item to Report section of the Batch Actions window for either
of these two report types, after the specific token has been chosen a dialog box
will open to the Field page and the appropriate property can be entered in the
corresponding edit field. You can also reach the Field page by right-clicking on
the item in the Batch Process Actions list and selecting Properties from the
pop-up menu.

812
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· Excel (Column Mode) and Text Reports

The Column Name specifies the text that will appear in the report at the top
of each column of data. For example, if the token you are exporting displays
the number of events for a plot, a useful Column Name could be Number of
Events. In FCS Express V5 and later versions, the report-specific property of
Excel (Column Mode) and Text Reports defaults to the name of the item in
your layout (e.g., the token description in Fig. 8.29).  To change this default
behavior so that the field is left blank, see the Header Options .

Figure 8.29  Token description automatically exported to Excel as Column Name
in FCS Express V5

If you wish to manually define the report-specific property in lieu of the
default, enter it in Column Name field of the Field category (Figure 8.30). 

Figure 8.30  Manually entering the Column Name property

803
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· Excel (Cell Mode)

The report-specific property for Excel (Cell Mode) reports is set in the Cell
Address field. The Cell Address specifies the Excel cell to write the data.

· Word

The specific property for Word reports is set in the Mail Merge field name
which specifies the mail merge field in your Word template  where the
layout item will be placed. The field name must exactly match the name in the
Word document.

· PDF Form

For PDF reports, the specific property is set by editing the Field Name. This
specifies the text field in your PDF template  where the layout item will be
placed. The field name must match the corresponding field in the PDF.

8.1.2.4 Adding Pictures to a Report

A picture of a Text Box, plot, or an entire page of the Layout can be exported to
Excel (Cell Mode) and Word reports. To add a picture to a report:

1.  Click on the appropriate report type in the Add Report section of the Batch
Actions window .

2.  Highlight the appropriate report type and click on Picture in the Add Item
to Report section of the Batch Actions window.

· Excel (Cell Mode)

The Picture page of the Excel (Cell Mode) field "Picture" options dialog
will appear (Figure 8.31). This page has two sections:

o Picture output options

Choose the file format and resolution . Note: JPEG picture quality
is directly related to the size of the image; a higher quality image will
be less compressed and larger in size.

o Get the picture from

Choose whether to export an object from the layout (a plot or text
box) or to export an entire page from the layout.

809
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Figure 8.31  Excell (Cell Mode) Picture Options

· Word

The Picture page of the Word Report field "Picture" options dialog is
similar to the Excel (Cell Mode) dialog described above.

The Mail Merge field Name edit field on the Field page of the Word Report
field "Picture" options dialog is where you identify the field in the Word
template file where the picture will be inserted. The specified field name
must exactly match the corresponding field in the Word template file. See
the section on report-specific properties  for a description of the Field
Name property.

8.1.2.5 Reordering and Copying Items in Reports

In Excel (Column Mode) and Text File reports, the token order in the Batch
Actions list is significant since the values will be written to columns in the order
that they are listed within the report.

To reposition an item (e.g., a token) within a report, click on the item and drag it
to the new location in the list. As you drag the item over other items in the list,
you will see a blue line appear above the other items (Figure 8.32). Release the

812
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mouse button to place the item in the position designated by the line. If you
want to reposition the item at the end of the list, drag it onto the report name at
the top of the list. You can also select multiple items and drag them all at once.

Figure 8.32  Repositioning a Token in a Report

To move an item to a new report, drag the item from its current report to the
title of another report. This removes the item from the current report and adds it
to the end of the destination report. Alternately, right-click on the item and select
Cut BP Actions from the pop-up menu. Click on the destination report, right-
click, and select Paste BP Actions from the pop-up menu.

To copy an item to a new report, click on an item to select it, then right-click and
choose Copy BP Actions from the pop-up menu. Click on the destination
report, right-click, and select Paste BP Actions from the pop-up menu.
Alternatively, you can copy items by dragging them from one report to another
while holding down the Ctrl key.
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Note: After you have moved or copied an item from one report to another, it is
important to ensure that the report-specific properties  in the destination
report are configured correctly. FCS Express attempts to set the new properties,
but it is impossible to set them correctly in all cases programmatically. For
example, FCS Express has no way of tracking which new report cell to use for a
new token.

8.2 Batch Processing Options

To set batch processing options, use the Batch Batch Processing Options
command to bring up the Batch Processing Options dialog (Figure 8.33). With
the Batch Processing Options, you can control how many iterations are to be
performed during batch processing, whether or not to Pause during batch
processing (either conditionally or unconditionally), and how FCS Express is to
prepare the layout for the analysis of the next iteration.

812
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Figure 8.33  Batch Processing Options Dialog

The properties which can be set are as follows:

· How many iterations should be performed during batch processing?

Specify the number of iterations that the Batch will perform. Normally, you
will want to have as many iterations as can be accommodated by the
number of data sets in the Data List. If you choose Automatically
perform the maximum possible, FCS Express will determine the number
of iterations to perform based on the number of data sets in the Data List,
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the position of files in the layout, and the increment value. You can
override this by selecting Always perform this many iterations, and
entering a value in the text field.

· Increment value

The increment value is the number of data sets to increment after each
iteration of the batch process. An increment value of 1 means to move to
the next data set. An increment value of 2 means to skip over the next
data set and use the third data set. For example, if the increment value is
1 and an open plot contains the first FCS file in the Data List, the open plot
will contain the second FCS file in the list after the first iteration. If the
increment value is 2, then the plot will contain the third FCS file after the
first iteration, and the fifth file after the second iteration. If a panel  is
applied, the Batch increment value will be ignored and the iteration value
from the panel will be used to move through the data sets.

· Iteration start count

The iteration start count is the starting value for the number in the Current
Iteration token (commonly used in dynamic filenames). See Save Layout -
File Options for a description of batch generated filenames  for more
information about the Current Iteration token. The default value is 1. All
filenames generated in subsequent iterations will be incremented by 1.

· Run alerts before batch processing

If this property is checked, any alerts that you have set will be run before
each iteration is processed. If an alert does not pass the defined criteria
the user will be notified and will have the ability to continue or abort the
batch process.

 

· Pause between iterations

There are several options available in which FCS Express can pause during
batch processing to give the user an opportunity to finalize the analysis for
each iteration.  These settings allow the user to adjust gates and
quadrants as needed before the next iteration. If any of these options are
selected, a window will appear during the batching process, prompting the
user to click Continue, Run to end, or Cancel .  The options to Pause
the batch process are:

Unconditionally
pause between
iterations

If this option is enabled, you will be prompted to click
the Continue button in the Batch Run progress window
at the beginning of each iteration unconditionally.  In
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other words, FCS Express will pause between
iterations, whether or not the iteration has been
manually flagged or conditionally flagged, as
determined by the conditions set up by the user.  The
Batch will run uninterrupted if this property is
unchecked. Using the radio buttons, you can choose to
Keep the changes that were made between
iterations or Restore the state of the layout for the
next iteration.  Also, if the iteration was not flagged
previously, you can flag the iteration during the
process.

Pause if the
condition below
is met

With the option, the user can create conditions through
the use of tokens.  If the condition is True, FCS
Express will pause during batch processing at the
iteration which fulfills the condition.

Pause on
flagged
iterations (the
list is below)

If any iterations were Flagged, FCS Express will list the
iteration numbers which were flagged.  FCS Express will
also pause batch processing when the data from the
flagged iterations is currently being viewed.

Pause on specific
iterations (the
range is below)

With this option, the user can designate at which
iterations FCS Express will pause during batch
processing.  The user can enter the iteration number,
an iteration range ( for example, 1-9) or specific
iterations (for example, 1,3,5).

· Keep the changes that were made between iterations or Restore the

original FCS files on the layout after completing batch processing

When one of these options are selected, all objects on the layout will
display their original data sets at the end of the Batch Process. If
unchecked, then at the end of the batch process, the Data List and
corresponding objects will point to the last data set.

· After batch processing is complete - After FCS Express has completed

batch processing, how would you like FCS Express to treat the layout?  The
options are:

Do nothing FCS Express will do nothing and
leave the layout, as is, after the
completion of batch processing.

Restore the original data files in
the layout

After the completion of batch
processing, FCS Express will reload
the original data files that were being
viewed within the layout.

Clear the data files After the completion of batch
processing, FCS Express will clear
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the Data List of all the data files were
present within it.

Click OK to save your settings.

8.3 Running the Batch Process

Once you have set up all your actions, the Batch Processing options, and verified
that all files you want included in the Batch are listed in the Data List, then you
are ready to run the Batch. Running the Batch executes all actions, including the
Print, Save, and Report actions.

To run the Batch, use the Batch Batch Processing Run command.  The Batch
Processing Run, Rerun, and Review windows are now dockable , so that you
may perform other actions while the Batch Process runs or modify Batch
Actions, as well as keep the window open at all times if you wish.

While the Batch Process is running, a progress window will appear showing how
many iterations have passed and how many are left. If you chose to pause
between iterations, then the progress window will have 2 options from which
you can select:

1. Keep the changes - this option will keep the changes that were made
to the layout during the analysis and keep the changes for the next
iteration.

2. Restore the state of the layout before the next iteration - this
option will restore the layout to its original state, ignoring any changes
that were made to the layout during the previous batch processing
iteration.

Once a selection has been made, the user can choose to Continue running the
batch process, while pausing for each iteration, or by choosing Run to end,
where the batch process will continue to its end, without pausing (Figure 8.34). 
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Figure 8.34 Batch Processing Progress Window
showing the options that are available between

iterations.

If the Batch Process aborts for any reason, FCS Express will now save all of the
reports up until the abort (Figure 8.35). 
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Figure 8.35 If the Batch Process is cancelled you will be prompted to save the data
that was already processed.

8.4 Rerunning and Reviewing the Batch Process

After the Batch Process has been Run , the user now has the option to:

· Rerun - Reruns the previous batch process including all changes to gates,

markers, and quadrants applied during a pause of the batch by using
Iteration Snapshots . 

· Review - Reruns the previous batch process including all changes to gates,

markers, and quadrants applied during a pause of the batch by using
Iteration Snapshots  without completing the batch actions. 

To rerun the Batch, use the Batch Batch Processing Rerun command (Figure
8.36).  To review the Batch, use the Batch Batch Processing Review
command (Figure below).

Figure 8.36 Rerun or Review Batch
Processing

Rerun and Review will be dependent on the pause options that available in the
Batch Processing Options  and Flags .  If there are no pause options selected
when running in Review mode, FCS Express will display a message, prompting
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the user whether they would like to choose a pause option (Figure 8.37). 
Clicking Yes will open the Batch Processing Options window.

Figure 8.37 No pause options were set for Batch Review prompting the message to
open the options dialog.

8.4.1 Using Flags

During analysis, you will most likely encounter data that needs to be reviewed or
re-analyzed.  In FCS Express, you can designate iterations for review by Flagging
them.

You can find the Flag This Iteration button at Data tab
Objects (Figure 8.38).

Figure 8.38 The Flag Iteration Tool Showing a Flagged Iteration.

If any iterations are flagged, as seen in the above image, it is possible to review
those items during Batch Processing.

During Batch Processing, it will be possible to flag iterations from the Batch
Processing progress window (Figure 8.39). You may also report the status of
an iteration as flagged or not flagged by using the Flag Status of Current Layout
Iteration  token. 1314
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Figure 8.39 An Iteration during Batch Processing that is Unflagged (Left) and
Flagged (Right).

By adjusting the Batch Processing Options  to Pause on flagged iterations,
Batch Processing can be Run, Rerun or Reviewed for those selected items
(Figure 8.40).

Figure 8.40 Batch Processing Paused on Flagged Iteration for further review.

817
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Flagged iterations will be visible within the Data List if the option for Show
Iteration Column is checked within the Data List options.  The Data List can be

formatted to show this column by clicking on the Format  button.

After clicking on the Format button, select Show Iteration Column (Figure
8.41).

Figure 8.41 Choosing to Show the Iteration Column within the Data List.

After selecting the Show Iteration Column option, a Flag will appear in front of
the iteration that was flagged, either during Batch Processing, or from the Data
tab (Figure 8.42).



Batch Processing 827

© 2023 De Novo Software

Figure 8.42 The Data List displaying Flagged Iterations

8.4.2 Snapshots and Batch Iteration Navigation

FCS Express now has the ability to automatically take Iteration Snapshots  of
your analysis for each iteration during Batch Processing.

During Batch Processing , as gates, markers and quadrants are adjusted, an
Iteration Snapshot  is automatically captured for each iteration to store:

o all gates and their coordinates.

o all markers and their coordinates.

o all quadrants and their coordinates.

When a Pause  is enabled in the Batch Processing Options (Figure 8.43) the
user can make adjustments of all gates, markers and quadrants and record
those elements for each iteration as part of Batch Processing, through the use of
automatic Iteration Snapshots .
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Figure 8.43 Enabling Batch Processing Pause Options.

As the analysis progresses through batch processing and pauses between
iterations, gates can be adjusted manually or by applying Snapshots that were
taken with the Snapshots list.  If any iteration needs to be reviewed, a flag  can
be applied to that iteration.  You may also report the status of an iteration as

824
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flagged or not flagged by using the Flag Status of Current Layout Iteration
token. 

If the Batch Processing Options for Pause if the condition below is met is
selected, a condition, in the form of a Token, can entered into the field.  If the
condition is True for an iteration, batch processing will pause and the user will
have the opportunity to alter the gating or flag the iteration for further review. 

If the Batch Processing Options for Pause on flagged iterations  is
selected (Figure 8.44), batch processing will only stop at those iterations that
are flagged.  The iterations that have been flagged will be listed in the field below
the option.

If the Batch Processing Option for Pause on specific iterations is selected, the
user can manually list the iteration or iterations during at which batch processing
should pause.

1314
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Figure 8.44 Batch Processing Options Showing Pause for Flagged
Iterations.

Once the gates have been adjusted to their correct positions for an iteration,
click on Continue or Run to end (Figure 8.45). FCS Express will automatically
store a Snapshot of that iteration, move to the next iteration, or to complete
the sequence of iterations.
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Figure 8.45 Choosing Continue, Run to End or Cancel.

If Cancel is selected, FCS Express will prompt you whether you want to save the
data that has already been processed (Figure 8.46).
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Figure 8.46 Cancelling a batch process will prompt you with "Do You Want To Save
the Data That Has Already Been Processed?"

Once Batch Processing is complete, you can review the gating changes that were
made to an iteration during the batch by navigating to the iteration in the Data
List. You may also use the Batch Rerun or Review options  from the Batch
tab Batch Processing Run dropdown to run the batch and review your
previous changes. The gating changes that were made will be recorded and
shown with the data (Figures 8.47 below).

823
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Figure 8.47 Snapshot showing gating changes made during the batch process for
Iteration #2.

Snapshot showing gating changes made during the batch process for Iteration #3.
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9 Tools

The Tools tab contains specialized analysis tools and features as well as access
to Compensation and Unmixing . The tools tab is arranged into subsections
for:

· Calculate

o Concentration Calculator

o Channel Calibration

· Labels

o Parameter Labels

· Snapshots

o Apply Iteration Snapshot

o Snapshots

· Transformations

o Compensation and Unmixing

o Transformations

9.1 Compensation and Spectral Unmixing

FCS Express allows users of both conventional flow cytometers and spectral
cytometers to access, define, and adjust compensation and unmixing matrices.

In conventional flow cytometry
· Mirrors and filters are used to select specific bands of the optical spectrum.

· The number of bands usually matches the number of labels (i.e.

fluorochromes), with each band being a priori dedicated to mainly collect the
signal of a specific label.

In spectral cytometry
· Prisms or gratings, and arrays of detectors are used to collect a continuous,

high resolution, optical spectrum.
· The number of detectors in the array is larger than the number of labels, and

no particular detector is a priori dedicated to the measurement of any
particular label.

Data generated by both instrument types, has to be processed to account for
spillover which is the overlap of signals coming from different dyes into the same
band/detectors.

For conventional cytometers, the process is named Compensation, while for
spectral cytometers it is named Spectral Unmixing.
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Although  the above-mentioned processes share the same conceptual goal (i.e.
estimating the abundance of each label), they are based on different
mathematical calculations.

FCS Express 7 allows user to perform both Compensation  and Spectral
Unmixing  through an easy to use wizard via the Compensation and Unmixing
window .

Compensation

Ideally, when one uses a dye in an experiment, its emission spectrum will be
narrow enough that fluorescence from that dye is only detected by a single
detector in the instrument. In practice, because of the broad emission spectra
of available fluorochromes, the dye you are using will likely emit significant
amounts of fluorescence in several different detectors. In other words, the
light reaching a given detector consists of the signals from multiple
fluorochromes.

Compensation is the process of transforming the data such that the values
from a single detector come from an individual dye. In order to do this, a
percentage of the overlapping emission is subtracted from the target
emission. Traditionally, this compensation was performed by the instrument
during acquisition. However, modern instruments are capable of storing the
data in uncompensated form and compensation can be applied by the
analysis software.

Example of the calculation: Compensated Parameter 2 Fluorescence =
Observed Parameter 2 Fluorescence minus 5% of Observed Parameter 1
Fluorescence.

Compensation involves creating two matrices. The spillover matrix represents
the percentage of the signal from a given channel that spills into adjacent
channels. The compensation matrix, used to correct for the spillover, is the
inverse of the spillover matrix.

FCS Express uses the following terminology when dealing with compensation.
The target parameter is the parameter that is detecting signal (potentially
from multiple sources). The source parameter is the primary parameter that
you want the signal to be in, but that dye is also bleeding (potentially) into
multiple targets. In other words, we are subtracting the percentage of the
source that is “bleeding” into the target.

In the example given above, Parameter 2 is the target and Parameter 1 is the
source. A family of sources and targets is called a compensation definition. A
compensation definition describes all the ways that fluorescence from
different channels affect each other under a given set of conditions and is
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equivalent to a single compensation matrix. Typically, the instrument user will
set the gains for all the channels at the beginning of the experiment and use
these settings for the duration of the experiment. Thus, the compensation
definition would apply for the entire experiment.

FCS Express can store multiple compensation definitions in a single layout
which is useful when one wants to analyze data acquired on different days in
the same layout. It is likely that the gains will be different on different days
and will require a different compensation definition for each day. Each overlay
on a plot can use a different compensation definition.

In addition, the compensation definition can be assigned to a data file. This
means that when the .fcs file is loaded into a plot, it will automatically use the
proper compensation. By assigning a compensation to a data file, you do not
have to remember the appropriate compensation definition for each of your
data files.

Software Compensation Caveats
Software compensation is not a panacea for all compensation problems.
Software compensation works best on high-resolution (> 1024 channel)
linear data. Compensation must be performed on linear data. Therefore, data
that is stored in logarithmic format (as is sometimes the case with FCS 2.0
data files) must be converted to linear prior to compensation. This conversion
from logarithmic to linear can introduce rounding errors. In addition, older
data that is stored as less than 1024 channels is rarely compensated
accurately with software. However, the majority of data stored as 1024
channels or greater can be software compensated.

Additionally, certain file formats supported by FCS Express do not support
storing compensation matrices separately from the data file and the these
data sets will only display and utilize the raw data values, compensated
values, from the time of acquisition. Examples include .csv files  and .MQD
(MacsQuant) files . 

For a detailed description of how software compensation is implemented in
FCS Express, please see our Frequently Asked Questions at
https://denovosoftware.com/faq/kb-what-is-compensation/.

Spectral Unmixing

With spectral cytometry instruments, a continuous, high resolution, optical
spectrum is collected for each event in the sample. The spectrum is the sum
of the spectra derived from all the dyes present on the event of interest.
Spectral Unmixing is the process of transforming the data to determine the
contribution of each dye to the total signal.
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Several mathematical models can be used to perform the spectral unmixing
calculation. However, the most widely used calculation is the Ordinary Least
Square method. The Ordinary Least Square method assumes a linear
contribution of unchanging reference spectra to the mixture spectra of an
unknown sample. In turn, the calculation allows us to estimate the
contribution of each spectrum (i.e. each dye).

Ordinary Least Square uses a linear decomposition algorithm to solve the
equation:

Y = A x C + E

For the sake of simplicity we can put aside the term "E" , which is the random
measurement error, and focus on the remaining terms:

· Y is the measured spectrum matrix (i.e. a 1-column matrix containing the

spectrum of the event of interest).
· A is the reference spectra matrix (i.e. a n-columns matrix containing the

spectrum of each reference dye)
· C is the concentration matrix (i.e. a 1-row matrix containing the

contribution values of each dye to the total measured spectrum)

Provided a series of reference spectra (A), and a measured spectrum (Y),
this method allows to estimate the term C, an thus the contribution of each
dye to the total signal intensity of the event of interest.

9.1.1 The Compensation and Unmixing Window

To create, remove, and manage Compensation and Unmixing definitions open
the Compensation and Unmixing window by selecting  the Tools
tab Transformations Compensation and Unmixing command.

A dockable window titled Compensations and Unmixing will open. This window
lists all of the compensation definitions and all the Unmixing definitions that are
available in the layout within the Loaded automatically with data files or the
Created manually folders. (Figure 9.1).

The Loaded automatically with data files folder shows definitions that were
automatically loaded with a data file presently showing on the layout (e.g., a
compensation definition defined during acquisition and saved as metadata with a
modern FCS 3.0 or greater format .fcs data file) and the Created manually
folder shows definitions (either compensation or unmixing definitions) that have
been created manually within FCS Express.

Jump to:
· Compensation Definitions

· Unmixing Definitions

842
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Figure 9.1  Compensations dialog showing compensations available in the layout.

The Compensations and Unmixing window (Figure 9.2) is dockable and
pinnable  like many other windows in FCS Express. There are many actions you
can perform from the Compensations and Unmixing window tool bar. You can
perform the action either by pressing the appropriate button (hover the mouse
over the button for tooltip) or by right-clicking on a definition folder or sub-item.
The actions are summarized in the table below:

115
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Figure 9.2  Compensations dialog showing available commands and actions.

Action Command Explanation

Create a new
definition
(either a
compensation
or an unmixing
definition)

  or right-click on
Folder or definitions
and select New

Add a new compensation/unmixing definition. 

Import a
definition from
a file

 
Import a previously saved definition
(*.compensation or *.unmixing) file.

Export the
selected
defintion

 
Export a compensation (*.compensation) or an
unmixing (*.unmixing) definition file for use in
other layouts.

Assign this
Compensation   or right-click on a

definition 

Assign  a definition to a file or series of files.905
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/Unmixing to a
data file

file

Rename the
selected
definition

   or right-click on a
definition Rename

Renames the selected compensation definition.

Delete
  or right-click on a
definition 

Deletes a compensation definition from the
compensation window and the plots to which it
was applied.

Cut definition Right-click on a
definition 

Performs a cut command on the compensation
definition. If performed on the Compensation or
Spillover Matrix, the Matrix can be pasted into a
Text Box or other document.

Copy definitionRight-click on a
definition 

Performs a copy command on the compensation
definition.  If performed on the Compensation or
Spillover Matrix, the Matrix can be pasted into a
Text Box or other document.

Paste
definition

Right-click on a
definition 

Set as Default Right-click on a
definition 
Default

Sets the selected compensation definition as the
default compensation. The default compensation
is the one that will be used when adding new
plots.  Only Created manually compensation
definitions may be Set as Default;  however,
compensation definitions Loaded automatically
with data files may be copied into the Created
manually category for this purpose. 

Compensation definitions

If a Compensation definition is selected, the Compensations and Unmixing
window will display four tabs (Figure 9.3):
· Compensation Matrix

· Spillover Matrix

· Compensation Options

· Automatic Compensation Setup

The Compensation Matrix and Spillover Matrix tabs allow you to view and
Manually Edit a Compensation Definition . The Compensation Options  tab
allows you to chose how compensation is applied to the current layout and
whether to append or overwrite compensated parameters . The Automatic
Compensation Setup  allows you to calculate a new matrix using single
stained controls.

For both the Compensation Matrix and the Spillover Matrix you can
choose to view the Matrix Editor or List Editor from the Editor drop-down
(Figure below) to view a matrix of Source vs. Target (Figure below and left)
or to view a list of Target - % Source (Figure below and right).
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Figure 9.3  Compensations dialog showing available tabs. Matrix Editor View
(left) and List Editor View (right).

A quality control for your compensation definitions may also be run by using the
Multiplot  commands from the Plot tab Multi Plot
Compensated feature which will create multiple plots that display combinations
of all parameters versus each other of the parameters involved in the
compensation matrix of the parent plot (Figure 9.<%9F++%)>). 

635
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Figure 9.4. NxN Plots Compensated.

Unmixing Definition

If an Unmixing definition is selected, the Compensations and Unmixing
window will display three tabs (Figure 9.4):
· Unmixming Matrix

· Options

· Automatic Unmixing Setup  872
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Figure 9.5.The unmixing dialog. Tabs to view the Unmixing Matrix, Unmixing
Options, and Automatic Unmixing Setup are presented to the user. 

· The Unmixing Matrix tab shows the Endmembers of the Unmixing

definition and allows you to enable/disable specific
detectors/Endmembers by checking and unchecking the boxes
associated with detectors/Endmember. 
o Icons for Save, Load, and Delete (red highlighting in figure above)

will allow you to save, load, and delete selected endmembers in the
table. 

o The endmembers in the Unmixing Matrix can be renamed by right

clicking on the endmember and selecting rename. (Figure 9.5
(below)).

o Please see our section on Creating or Modifying an Unmixing

Definition  for additional details.

· The Options tab displays the Algorithm used to calculate the Unmixing

Definition and the parameter that has been unmixed (please refer to
Step 3 of the Automatic Unmixing Setup ). 
o The New Parameter Suffix edit box will allow you to change or

remove the suffix applied to parameters created by unmixing. 

· The Automatic Unmixing Setup  tab allows you to add, edit, and

display the steps performed in the automatic unmixing. 
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© 2023 De Novo Software(Figure 9.6) Renaming the endmember in the Unmixing Matrix. The BV750
endmember (top red highlighting) was renamed to CD3 BV750 (bottom)  Plots

will update changes and reflect the new endmember on the axis.
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Visualized Matrix
FCS Express has the capability to add a Visualized Matrix page on the layout
(Figure 9.7). The Visualized Matrix page depicts a chart displaying the Detector
vs Intensity for each single stained control added in the wizard, as well as a
spreadsheet with the charted values (each detector is labeled by Detector # and
Wavelength). Learn more about using a Visualized Matrix . 

Figure 9.6  Visualized Matrix page automatically created upon completion of the
Automatic Unmixing Setup.

 

9.1.2 Creating and Modifying a Compensation Definition

A Compensation Definition can be created from scratch using single stained
control or modified from a pre-existing compensation definition.

872
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· Manually Editing a Compensation Matrix via the Compensation Window

· Manually Editing a Compensation Matrix from a 2D Plot

· Automatically Calculating Compensation Matrices

9.1.2.1 Manually Editing a Compensation Matrix via the Compensation Window

Selecting a file within the Compensation and Unmixing window displays the
compensation definition in the tabs below. Expanding the compensation file node
will reveal the Compensation Matrix, Spillover Matrix, Compensation
Options  and Automatic Compensation Setup  items. Clicking on items in
the expanded view is just like choosing the different tabs in the lower pane of the
window (Figure 9.8). 

FCS Express has color-coding for values in compensation and spillover matrices.
 The color heat map allows users quick identification of same parameter pairings
(green) and potentially high (shades of yellow to red) or low (shades of purple to
blue) values.

You can choose to view the Matrix Editor or List Editor from the Editor drop-
down to view a matrix of Source vs. Target or to view a list of Target - %
Source, respectively.

849
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Figure 9.7 The Compensation and Unmixing dialog displaying the Compensation
Matrix in Matrix Editor View.

Compensations can be edited directly from the Compensation Matrix tab and
Spillover Matrix tab by clicking on the Target (Matrix Editor) (Figure 9.9, left)
or Value (List Editor) (Figure below and right) and using the up and down
arrows (outlined in red below) or entering a value to adjust the compensation. 

Figure 9.8 (Top) Adjusting compensation values using the compensation Matrix
(left) and List (right) Editors. Use the up and down arrows or manually enter a

value to adjust the compensation.
       

If a compensation value is manually changed, the icon for the compensation in
the Compensations window (Figure 9.10, red box at the top) will be highlighted
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with red and the text value in the Matrix Editor (Figure below, red box at the
bottom) will become bold and underlined to indicate that the values for that
compensation have been manually adjusted. 

Figure 9.9. When a compensation value is manually adjusted, the compensation
icon (red box at the top) becomes red highlighted, while the text value (red box at

the bottom) becomes bold and underlined.

Every compensation must be given a unique name. The name of your
compensation may be changed at any time by selecting the compensation and

clicking the Rename selected compensation button  or by right-clicking on
a compensation and choosing Rename.  You may find it helpful to enter the date
or experiment number as the compensation name.

Compensation must be performed on linear data. If you have stored data on a
logarithmic scale in your FCS file (common with FCS 2.0 data files), this data has
to be converted to a linear scale before compensation is applied. It is then
converted back to log for display. Depending on the resolution of your original
file, this can result in digitization errors , which can cause large numbers of
events to group in a single channel. The conversion to linear and reconversion
back to log occurs automatically during the software compensation process.
However, if you notice digitization errors, you can enter a value to spread the

1900
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grouped population out using the Range of random value to add when
converting log data field (Figure 9.11). Typically, this value should be less than
one. This will add a small random value to the linear value prior to it being
reconverted back to log. It is recommended to leave this value at zero unless
these digitization errors become apparent.

Figure 9.10 The Range of random value to add when converting log data field
allows you to easily correct for digitization errors.

9.1.2.2 Manually Editing a Compensation Matrix from a 2D Plot

It is also possible to adjust the compensation definition from a 2D plot itself.
Right-click on the plot and select Compensation from the pop-up menu. The
compensation item contains one submenu for every compensation definition that
is used on the plot (maximum one per overlay). For step-by-step instructions on
using the this feature please see our Manual Compensation Tutorial .

The first item in the Compensation submenu is Create New, which allows you
to create a new compensation definition. If you select Create New, a dialog will
appear asking you to enter a name for the new compensation as well as some
additional information (Figure 9.12). To edit an existing compensation definition,
select the appropriate submenu item.

1861
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Figure 9.11  Creating a New Compensation from a 2D Plot

After naming a new compensation and clicking OK, or selecting a compensation
definition to edit, the Edit Compensation dialog will appear (Figure 9.13). Use
this dialog to compensate the two parameters against each other on the plot.
Move the slider to either increase or decrease the amount of compensation. If
you check Automatic Preview, the plot will update with the new compensation
settings as you edit the compensation in real-time. If the Compensations
window is open and displaying the compensation currently being edited, the
Compensation Matrix and Spillover Matrix  values will update in real time, as will
plots to which the compensation has been applied. 

Click Cancel to reject the compensation changes and exit the dialog, or Restore
to discard the changes but continue editing the plot. Once you press OK, the
compensation settings for any plot on your layout to which this compensation
was applied will be changed to the new values.

849
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Figure 9.12  Edit Compensation Dialog

Note when a compensation value is manually changed, the icon for the
compensation in the Compensations window (Figure 9.14, red box at the top)
will be highlighted with red and the text value in the Matrix Editor (Figure below,
red box at the bottom) will become bold and underlined to indicate that the
values for that compensation have been manually adjusted.
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Figure 9.13. When a compensation value is manually adjusted, the compensation
icon (red box at the top) becomes red highlighted, while the text value (red box at

the bottom) becomes bold and underlined.

9.1.2.3 Automatically Calculating Compensation Matrices

Instead of manually entering a value to subtract for every target-source pair, or
"guessing" the compensation by eye using sliders ,  FCS Express utilizes a
compensation wizard calculate the entire compensation definition for you. For
step-by-step instructions on using the Automatic Compensation Setup please
see our Automatic Compensation Tutorial . To get started, use the Tools
tab Transformations Compensation and Unmixing command, open the
Compensation and Unmixing window, and add a new compensation with the

Add a new compensation button  or you can then click on the Automatic
Compensation Setup command (outlined in red below) tab to access the
automatic settings (Figure 9.15).
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Figure 9.14  The Automatic Compensation Setup tab.

The Automatic Compensation Setup tab contains 6 steps to calculate your
compensation. After adding single stained controls in Step 1, individual pages for
each compensation control will be created, gates for scatter parameters will be
created, and gates for single stained controls will be created. Additional, the
compensation matrix will be automatically created. In most cases it is
recommended that users review each page and gate automatically created by
FCS Express to ensure accuracy of "auto gating" on scatter and control
parameters.  As changes are made to gates or steps 1 through 6, the
compensation matrix will be updated in real time.

Note:  Step 4 and step 5 are optional and do not have to be completed to
generate a matrix. 
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· Step 1 - Select single-stained controls (Figure 9.16)

In order to automatically calculate a compensation definition, you will need to
provide FCS Express with a positive and a negative population for each
parameter you wish to compensate. These population can be provided as:

· an FCS file to use as common (universal) negative control and multiple FCS

files to use as single stained positive controls (one for each parameter you
wish to compensate)

· a series of single stained control FCS files (one for each parameter you wish to

compensate), each containing a negative (self negative) and a positive
population

· a mixture of the two above-mentioned scenarios

FCS Express also provides the flexibility for you to choose how to define your
positive and negative populations. By default, the main population of interest is
defined with gates on 2D Plots (for example, a Scatter Gate on FSC and SSC
parameters) while positive and negative populations are automatically defined
using markers on histograms (histogram and markers are automatically created
for each parameter after adding single stained controls). You will have the option
of using an unstained control for each parameter you wish to compensate or use
additional user-created gates in Step 4.

1.  Click the Add data for auto compensation button, , to add files
that will serve as compensation controls.

2.  Confirm the correct Parameters were automatically matched to the
appropriate data file. By default, FCS Express will use the Keyword for
Parameter Matching selected in the 
Specific Settings  to match the contents of the data file name with
the appropriate Parameter. Options for Parameter Matching include the
keywords for Name, Stain, Name and Stain, Stain and Name, and Display
Name. FCS Express will attempt matching parameters but you may need
to review or select the parameters manually via the next step. 

3.  If any Parameter does not automatically match or is incorrectly
matched, you may; 

a. Use the Parameter drop down menu to choose the correct
parameter for each single stained control or universal negative.

b. Change the data file name to include the desired Parameter Name
or Stain Keyword then re-add the data file to Step 1. 

4.  If a universal Negative Control is selected from the Parameter list in
Step 1 (image below), that file will be used by default to define the
negative control populations for each parameter.

1663



FCS Express 7 Manual858

© 2023 De Novo Software

a. If no universal negative control is selected, you may set each file as its own negative control by selecting the option to use self as negative from the Negative Control drop down menu. 
b. You will also have the option to use additional files or

populations defined in user-created gates at Step 4 to
define positive and negative populations.

Figure 9.15  Step 1 - Select single-stained controls. Add compensation control data
files and choose their respective channels from the Parameter drop down list.

5.  If there were no Errors and Warnings highlighted in red (Step 3) , the
following items will be created: (Figure 9.17):

· Scatter Plot Layout Page: A page will be created with a density

plot displaying SSC vs FSC and a Scatter Gate (see Step 2) for the
first single-stained control file. If a Universal negative is present, a
second density plot will be displayed with the same SSC vs FSC
parameters and Scatter Gate for the Universal negative. The
Scatter Gate is automatically created and used to define the "live"
cells or cells of interest in your compensation controls. 

Note:  All of the fluorescence gates are children of the Scatter Gate,
which means adjusting the Scatter Gate will cause all other gates to
update in real time. Step 2 of the automatic compensation workflow
allows the user to redefine which parameters FCS Express should use

861



Tools 859

© 2023 De Novo Software

to create the Scatter Gate. Changes made to the parameters (e.g.,
SSC-H instead of SSC-A) in Step 2 will automatically be updated on the
plots created on compensation pages.  

The Scatter Gate can be modified by moving the gate, using the
replace gate feature  or by using Data Specific Gates . To replace
the Scatter Gate with a new gate:

· Draw a gate around the population of interest.

· Choose the Replace an existing gate radio button in the

Create New Gate dialog.
·  Select Scatter Gate from the drop down menu.

·  Click OK.

(Note: These steps are also described in the Automatic
Compensation Setup  tutorial).

· Single Stained Control Layout Pages: A new page will be created

for every parameter you are compensating (e.g., "FITC-A control",
"APC-A control" in the image below). The page will display one
density plot (SSC vs FSC) for the single-stained control for that page
and include a Scatter Gate, one histogram with the stained
population marked and one histogram with the unstained population
marked. Markers will be placed based on FCS Express auto
recognition of peaks, but can be adjusted . In addition, each single-
stained control's Scatter Gate can be converted to a Data Specific
Gate  for file-specific adjustment of the gate positions. 

Note: the unstained population histogram will only appear if a
universal negative is chosen. If a universal negative is not present,
only the SSC vs FSC density plot and single histogram with two
markers (for positive and negative populations) will appear.

· Spillover Spreading Matrix page : this page depicts a

spreadsheet with the Spillover Spreading Matrix values for
every pair of dyes included in the compensation matrix.

· Cross Staining Index matrix : this page depicts a

spreadsheet with the Cross Stain Index Matrix values for
every pair of dyes included in the compensation matrix.

· Gates: New gates will be created for the Scatter Gate and each

stained and unstained set up markers will be converted and linked to
gates. After the initial "auto-gating" all the gates and markers may be
manually adjusted  as needed. (Note: A Gate View  will not
automatically be inserted.)
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Figure 9.16 Layout after Step 3 of Autocompensation setup. Note the Scatter Plot,
FITC control, and APC control pages. Also notice that a density plot for SSC vs FSC

has been created with a Scatter Gate automatically applied. Histograms with
markers for the stained and unstained populations have also been automatically

created. 

· Step 2 - Select Scatter Gate Parameters (Figure 9.18)

When building the automatic compensation, FCS Express will automatically
create a Scatter Gate to capture your population of interest (eg. stained cells or
beads). By default, the Scatter Gate is created using the first available FSC and
SSC parameters. If these parameters are not appropriate for your Scatter
Gate, or you would like to change the parameters used to create the Scatter
Gate, you can define the parameters FCS Express uses to create the Scatter
Gate on Step 2 - Select Scatter Gate Parameters. 

Adjustments made to the X and Y parameters will automatically be updated on
the axes of the plots present on the layout pages created for compensation.
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Figure 9.17  Step 2 - Select Scatter Gate Parameters. Choose the respective X and
Y Scatter Gate parameters from the dropdown menu.

· Step 3: View Errors and Warnings (Figure 9.19)

· If FCS Express finds problems with either the files or parameters you

selected in the previous steps, or in the matrix calculation, warning/error
messages will appear in the Histogram building messages and/or in
the Matrix calculation messages sections of Step 3 respectively.

To let the user know that FCS Express found issues, Step 3 will be
highlighted accordingly: yellow indicates when Warnings are present,
and red when Errors are present.

If there are no errors found, the following message will appear -
Successfully built histograms for AutoCompensation.
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Figure 9.18 Step 3: View Errors and Warnings.

In the example below, the PE control was added twice to the file list.
Step 3 is colored red and an the error appears in the Histogram
building messages section (Figure 9.20)
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Figure 9.19 Step 3: View Errors and Warnings displaying a warning for duplicated
parameter.

In the example below, the marker defining the "APC-A stained"
population was improperly placed causing the number of event in that
population being zero. As a result, Step 3 is colored red and an error
appears in the Matrix calculation messages section (Figure 9.21)
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Figure 9.20 Step 3 displaying an error in the "Matrix calcualtion messages" section.

Step 4 - Adjust parameters (optional) (Figure 9.22) is useful when you
would like to refine the populations that are used for calculating compensation.
Dragging and dropping new plots, files, or gates in this section will allow you to
override the automatic setup and use gates and plots of your choice. For
instance, if the Automatic Compensation Setup does not make a good
estimate of the population or if you would like to use a population from another
file, gate, or plot, Step 4 would be useful. Parameters may be adjusted or
changed altogether by dragging and dropping a plot or gate onto the parameter
for the Stained and Unstained columns. If a gate is dropped, the compensation
definition will be based on that gate, including its hierarchical position  visible in
the Gate View object. If a plot is dropped, the compensation definition will be
based on the entire population on the plot. 

Note:  If you have adjusted a parameter, the compensation matrix will
automatically be recalculated. 
 
 

737
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Figure 9.21 The Adjust parameters dialog displaying the currently defined
parameters, plots, and gates.

Instructions for adjusting parameters (Figure 9.23): 

1. Click and hold on a gate or plot.
2. Drag the gate or plot to appropriate cell in the Auto-compensation

controls table (red arrow).
3. Release the mouse button.

The new gate and or plot will appear by name in the appropriate cell in the Auto-
compensation controls table of the Adjust parameters pane (Figure 9 below,
green arrow).
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Figure 9.22 To change a parameter plot or gate drag the gate or plot onto the plot
you wish to change. The plot information will then update to the newly choosen

gate or plot.

· Step 5: Add extra spillover targets (optional) (Figure 9.24)

Adding extra spillover targets allows you to have other targets defined without
defining a source. This is useful if you would like to have an idea of what spillover
would look like if an extra parameter was added in future experiments. To add an
extra spillover target simply check the box for the extra target you would like to
add. Note:  extra spillover targets will only appear for parameters that were
acquired with the data.
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Figure 9.23 The Add extra spillover targets (optional) dialog. Checking a box
will calculate the spillover for targets that have no source.

· Step 6: Calculate matrices (Figure 9.25)

In step 6 the user may choose to Calculate Matrices based on the Mean or
Median depending on your preference for your data and experiment. Click on
the radio button for either choice to apply your preference.  The initial matrices
are calculated by utilizing the Median by default and will be update automatically
if Mean is selected.

By default, FCS Express will automatically calculate and recalculate the matrix as
changes are made to gates or other settings giving users "real time" feedback on
adjustments to gates. If you would like to manually choose when to calculate
the matrix, uncheck the Recalculate matrix automatically ever time
something changes box and press the Calculate Matrices button. 
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Figure 9.24 Step 6 of the Automatic Compensation Setup wizard.

The Spillover Matrix or Compensation Matrix can be viewed in the
Compensations and Unmixing window by clicking on the appropriate tab in the
navigator.  See the Spillover Matrix displayed below. (Figure 9.26).  You may
edit any of the source-target pairs  through the Compensation Matrix,
Spillover Matrix, or make new adjustments in the Automatic Compensation
Setup. In the Compensation Options  tab, you can set how the new
compensated parameters are displayed in the parameter list and whether to
retain or overwrite the original uncompensated parameters.

Figure 9.25 The Compensation Matrix after the Automatic Compensation
Setup is complete.

The automatic compensation setup settings are saved with the layout . To
create another compensation matrix from a different set of data, simply add a
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new compensation with the Create a new compensation button  and
begin the Auto compensation setup process again. 

We also suggest that you use the compensation determined in the Automatic
Compensation Setup and apply it to different layouts and files  rather than
re-creating the same compensation definition many times.

A step-by-step description of the Automatic Compensation Setup feature is
provided in our tutorials at Compensation Tutorial .

9.1.2.4 Compensation Options

The Compensation Options tab allows you to chose how compensated
parameters are displayed on plots in the layout (Figure 9.27). Users may choose
to overwrite uncompensated parameters to only view compensated parameters,
or to append compensated parameters to the list of parameters to more easily
move between compensated and uncompensated parameters, or to use
uncompensated parameters in pipeline transformations, for instance, FlowAI . 

Figure 9.26  Compensations Options tab.

The Suffix for Compensated Data applies the text typed into the box as a
suffix to describe the compensated data.  The text can be viewed in the Title
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of a plot when using the keyword $FCSE_FILENAME or
$FCSE_FILENAMENOPATH.

The Suffix for New Parameters applies the text typed into the box as a suffix
to identify the new compensated parameters from the uncompensated
parameters. This text is only applied when the option to Append to data after
uncompensated parameters has been selected. 

When applying compensation, FCS Express allows the new compensated
parameters to overwrite OR be appended after the original uncompensated
parameters. Note these options can be changed from the User Options  and
Layout Options  as well.

· Overwrite uncompensated parameters. The default setting in FCS

Express, the new compensated parameters will appear in place of the
uncompensated parameters (Figure 9.28). No suffix will be used to denote
the new compensated parameters. The uncompensated parameters will not
be available on plot. Compensation can be removed from the plot to view
uncompensated data at any time in the Overlays section of Formatting. 

Figure 9.27 Overwrite uncompensated parameters. Note the Suffix for New
Parameters is absent when this option is selected. The uncompensated

parameters are not available on the parameter list (red arrow).

· Append to data after uncompensated parameters. New compensated

parameters will appear after the uncompensated parameters in the
parameter list (Figure 9.29). The Suffix for New Parameters will be
appended to each new compensated parameter name to identify the new
parameter as having compensation applied.
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Figure 9.28 Append to data after uncompensated parameters. Note the Suffix
for New Parameters appears when this option is selected. The uncompensated

parameters appear first in the parameter list, followed by the compensated
parameters (red arrow).

The Compensation Options are applied in the following way:
· New Layouts have their Compensation Options set from the User Options .

· New Compensations, regardless of how they are added to the layout, will

inherit the Compensation Options set in the Layout Options . 

Note that each Compensation has its own unique set of Compensation Options
(i.e. changing the Compensation Options for Comp A does not affect the
Compensation Options for Comp B).

Exporting Data Files with Compensation

When exporting data files, if a compensation is set to be applied to the exported
file, the Compensation Options for that compensation will be applied to the
exported parameters (i.e. the settings for that compensation's New
Compensated Parameters will be applied). For example, if the option to
Overwrite uncompensated parameters was set all uncompensated parameters
will be overwritten and no longer available in the exported file. If the option to
Append to data after uncompensated parameters was selected, both
compensated and uncompensated parameters will be available in the exported
file.

  

9.1.3 Creating and Modifying an Unmixing Definition

An Unmixing Matrix can be created either from scratch using single stained
controls or by importing one or multiple endmembers from CSV files:
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· Creating an Unmixing Definition Using Single Stained Controls

· Creating or Modifying an Unmixing Definition by Importing Endmembers via CSV

files

9.1.3.1 Creating an Unmixing Definition Using Single Stained Controls

FCS Express can calculate the entire Unmixing definition for you.
To get started, use the Tools tab Transformations Compensations and
Unmixing command to open the Compensations and Unmixing window. Then
add a new Unmixing definition using the down arrow button next to the Add

button  (Figure 9.30).

Figure 9.29 Adding a new Unmixing definition.

The bottom pane of the Compensation and Unmixing window will
automatically display the Automatic Unmixing Setup tab. The Automatic
Unmixing Setup tab contains 6 steps to calculate your Unmixing matrix. Step 5
is optional and does not have to be completed to generate an unmixing definition
(Figure 9.31). 

· The Automatic Unmixing Setup settings are saved with the layout. To create

another unmixing matrix from a different set of data, simply add a new
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Unmixing definition using the down arrow next to Add  and begin the
Automatic Unmixing Setup process again or create a new layout. 

We also suggest that you export the unmixing definition  determined in the
Automatic Unmixing Setup and load/apply it to different layouts and files
rather than re-creating the same unmixing definition many times. Please see
the section on Using Definitions  to determine the best way to apply your
unmixing to your sample data sets. 

· The Options tab contains a New Parameter Suffix edit box which is defaulted

to Ordinary Least Squares. If you would like your newly created unmixed
parameters to use a different suffix, the default may be edited to your desired
text, or removed entirely. 

· The Unmixing Matrix tab will contain your unmixing matrix once the wizard is

completed or will display an imported matrix. 

Figure 9.30  The Automatic Unmixing Setup tab. 

· Step 1 - Select single-stained controls

In order to automatically calculate an Unmixing definition, you will need to
provide the software with a reference spectrum for each dye you wish to
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unmix. The reference spectrum for a dye is calculated by subtracting a
negative spectrum (i.e. the spectrum of an unstained population) from a
positive spectrum (i.e. the spectrum of a stained population for that dye of
interest).
The negative spectrum can derive either from an internal negative (i.e. an
unstained population present together with the positive population within the
same file) or from an external negative (i.e. an unstained population in a
different file). FCS Express is flexible with which controls you may use and
allows you to deal with either scenario. 
Different external negative controls may also be use. This is useful when
single stained control(s) are derived from different media (different cells
types, beads, etc...). FCS Express allows you to define multiple negative
controls and thus subtract the appropriate negative control from each
positive control.

Autofluorescence extraction
Autofluorescence can be unmixed just as any other actual dye. To
unmix autoflouorescence, simply add a sample containing the
population on which you want to calculate the autofluorescence and
select Autofluorescence control from the Sample Type dropdown
and set the Negative control column to No negative. Some useful
case scenarios are depicted below:

Single Stained Controls using an internal negative population - Figure
9.32

Figure 9.31  - In this case scenario, all single stained controls use an internal
negative population as negative control. 

Single Stained Controls using an external negative population -
Figure 933
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Figure 9.32  - In this case scenario, all single stained controls use an external
negative population (i.e. a population in another FCS file) as negative control. 

Single Stained Controls using multiple external negative populations
- Figure 934
TIP: When multiple negative controls are required, customizing their label
(see "Label" column in the screenshot below), will facilitate their selection
in the "Negative control" column of Step 1. 

Figure 9.33  - In this case scenario, all single stained controls use a specific
external negative population (i.e. a lymph population in another FCS file) as

negative control. The Label column can be modified to distinguish each
population.

Single Stained Controls using a mix of internal and external
negative population - Figure 9.35
TIP: When multiple negative controls are required, customizing their label
(see "Label" column in the screenshot below), will facilitate their selection
in the "Negative control" column of Step 1. 
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Figure 9.34  - In this case scenario the APC dye uses an internal negative
control, the PE-Cy7 dye uses an external negative control from the "Unstained

(Cells).fcs" file, and the PE dye uses an external negative control from the
"Unstained (Beads).fcs" file.

Note: Although the label for both the "Unstained (Cells).fcs and the "Unstained
(Beads).fcs" files was "Unstained" by default, the label has been manually

customized to  "Unstained cells and" and "Unstained beads" instead.

Autofluorescence Extraction with Single Stained Controls using a
mix of internal and external negative population - Figure 9.36

Figure 9.35 - In this scenario both the PE-Cy7 and APC dyes use an external
negative control from the "Unstained (Cells).fcs" file. The PE dye uses an

internal negative control.

Autofluorescence is extracted from  population contained in the "Unstained
(Cells).fcs" file and the negative control column is set to no negative.

Note: Although the label for the "Unstained (Cells).fcs file was "Unstained"
by default, the label has been manually customized to  "Autofluorescense"

instead.
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TIP 1: When multiple negative populations are contained in the same file (e.g. different
cells type mixed together), the easiest way to use each of those populations as a
separate negative, is to create multiple copies of the original FCS file, change the
name of the file, and then add the multiple copies as separate files in the list. Different
Scatter Gates can then be manually created and used for different single stained
controls (please see the Data Specific Gate  chapter).

TIP 2: The text in the label column (examples above) will be the final label/name for
the unmixed parameter and also the page name for the pages automatically created by
the Unmixing Wizard in Step 3. The labels may be manually customized at your
convenience by typing in the Label edit box. It is helpful to edit labels when the same
file is added multiple times for different purposes (see examples above where the
"Unstained (Cells).fcs" file has been added twice, either as Unstained control or as
Autofluroescence control.

· Step 2 - Select Scatter Gate Parameters

Step 2 of the Unmixing wizard allows to select which pairs of parameters to
use to create the Scatter Gate. By default FCS Express searches for FCS-A
and SSC-A but users may change the automatically-selected parameters and
select any parameter from the list.

· Step 3 - Select Spectral Parameters  

Step 3 step allows users to select which spectral parameter to unmix. For
example, a spectral cytometer that acquires UV, Violet, Blue, YellowGreen and
Red, the possible spectral parameter selections will be UV, Violet, Blue,
YellowGreen, Red and also the merged spectrum
UV/Violet/Blue/YellowGreen/Red. 

Usually, the merged spectrum should be used to calculate the Unmixing
Matrix.  After selecting the spectral parameter or merged spectrum to unmix,
a series of histogram and spectrum plot will be automatically be generated on
new pages. 
FCS Express will automatically define the scatter gate, the positive
populations, and the negative populations to be used to calculate the
unmixing matrix.  Automatically defined gates and markers for unmixing can
be adjusted manually as needed.

The following pages will be automatically created:
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o Scatter Plot Layout Page. A page will be created with a density plot

displaying scatter parameters selected in Step 2 and a Scatter Gate
(created on those same parameters) for the first single-stained control
file. If one or multiple Unstained Negative Controls are present, one or
multiple density plots displaying the same parameters will also be created.
On each density plot, the above mentioned Scatter Gate will also be
visible.

The Scatter Gate is automatically created and used to define the
cells/beads of interest. All of the fluorescence gates (i.e. Positive and
negative population for each dye) are children of the Scatter Gate, which
means adjusting the Scatter Gate will cause all other gates to update in
real time. 

Step 2 of the automatic Unmixing workflow prompts the user to define
which parameters FCS Express should use to create the Scatter Gate. If at
a later time changes are made to Step 2 (e.g., SSC-H is selected instead of
SSC-A), all plots created on the layout for the unmixing and the unmixing
matrix will update in real time. If the automatically determined Scatter
Gate needs to be adjusted the user can create a new gate then use the
replace gate feature . To replace the Scatter Gate with a new gate:

.  Change the X and Y axes to the correct
parameters in Step 2.

.  Draw a gate around the population of interest.

.  Choose the Replace an existing gate radio
button in the Create New Gate dialog.

.  Select Scatter Gate from the drop down menu.

.  Click OK.
    (Note: These steps are also described in the Spectral
Unmixing  tutorial).

o Control Layout Pages: A new page will be created for every control (i.e.

single stained controls, negative controls and autofluorescence controls)
selected in Step 1. The name of each control will be set as the Label
reported in the Labels column of Step 1.
Each page will display:

§ a Density plot displaying the Scatter Gate for the control for that
page. Each control's Scatter Gate may be converted to a Data
Specific Gate  for file-specific adjustment of the gate position.

§ if the control is set as Sample in Step 1 one histogram with the
stained population marked and one histogram with the unstained
population marked. The unstained population histogram will only
appear if an external negative is chosen. If an internal (self)
negative is chosen, a single histogram with two markers (for
positive and negative populations) will appear instead.
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§ if the control is set as either Negative control or
Autofluorescence control, one histogram with the stained
population marked.

§ a spectrum plot displaying the population within the Stained gate
for that control. If the control is set as Sample in Step 1 and an
internal (self) negative is chosen, a second spectrum plot
displaying the population within the Unstained gate for that control
will be visible too.

Note: FCS Express will attempt to automatically find peaks and place
markers accordingly. All of the "stained" and "unstained" markers
auto-generated by the Unmixing Wizard are automatically
converted to gate, which each of them being a child of the Scatter
Gate. After the initial "auto-gating" all of the gates and markers
created automatically by FCS Express, can be manually adjusted
.

Note: A Gate View  will not automatically be inserted but may be
inserted at any time.

Note: The detector displayed in each histogram is automatically selected
by FCS Express as the brightest detector among the ones available
(this is done in background through a virtual band-pass filter
pipeline step; see here  for more details). The wavelength or the
detector name (depending on the Instrument Specific Settings  of
the current user), for the brightest channel will be reported in the
histogram X-axis title.  If, for any reason, the choice made by FCS
Express does not suit the needs of your unmixing, you can change
the parameter displayed in the histogram (both on the Negative
and the Stained histogram) by either:
· Using Step 5 (see below).

· Selecting a different detectors directly on the histogram. This

option is only available for users who are working with Cytek data
and who have changed their User Options properly (i.e. uncheck
the "Delete fluorescence parameters after spectra merge"
check box in the Instrument Specific Settings  for your Cytek
instrument and then start a new layout).

For additional information about why detection errors occur and
how to troubleshoot these issues please see the chapter on
Spectral Unmixing Detection, Caveats, and troubleshooting .

o Visualized Mixing Matrix page : this page depicts a chart displaying the

Detector vs Normalized Intensity for each stained control added in the
wizard, as well as a spreadsheet with the charted values.
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o Spillover Spreading Matrix page : this page depicts a spreadsheet with

the Spillover Spreading Matrix values for every pair of dyes included in
the unmixing matrix.

o Cross Staining Index matrix : this page depicts a spreadsheet with the

Cross Stain Index Matrix values for every pair of dyes included in the
unmixing matrix.

· Step 4: View Errors and Warnings (Figure 9.37)

If FCS Express finds problems with either the files or parameters you selected
in the previous steps, or in the matrix calculation, warning/error messages will
appear in the Histogram building messages and/or in the Matrix
calculation messages sections of Step 4 respectively. the Scatter Plot and
the single stained control layout pages will not be created until the error is
corrected.

To let the user know that issue FCS Express found problems, Step 4 will be
highlighted accordingly: in yellow when Warnings are present, or in red when
Errors are present.

If there are no errors found, the following message will appear - Successfully
built histograms for AutoUnmixing (see the example below).

Figure 9.36 Step 4: View Errors and Warnings.
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In the example below, the "CD3 BV711" label has been used twice. Step 4 is
red colored and an the error appears in the Histogram building messages
section (Figure 9.38)

Figure 9.37 Step 4: View Errors and Warnings displaying a warning for
duplicated label.

In the example below, the marker defining the "CD4 BUV737 stained"
population was improperly placed causing the number of event in that
population being zero. As a result, Step 4 is red colored and an error appears
in the Matrix calculation messages section (Figure 9.39)
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Figure 9.38 Step 4 displaying an error in the "Matrix calcualtion messages"
section.

· Step 5 - Adjust parameters (optional).

Step 5 is useful when you would like to refine the populations that are used
for calculating unmixing and to correct for issues in automatically detecting
the brightest detectors in single stained controls. 

Please see our chapter on Spectral Unmixing Detection - Caveats and
Troubleshooting for more information . Dragging and dropping new plots or
gates in this section will allow you to override the automatic setup and use
gates and plots of your choice. 

For instance, if the Automatic Unmixing Setup does not make a good
estimate of the population and if you would like to use a population from
another gate or plot, Step 5 would be useful. Parameters may be adjusted or
changed altogether by dragging and dropping a plot or gate onto the
parameter for the Stained and Unstained columns. If a gate is dropped, the
unmixing definition will be based on that gate, including its hierarchical
position  visible in the Gate View object. If a plot is dropped, the unmixing
definition will be based on the Stained/Unstained population on that plot.

If you modify the detector using the dropdown menu, the pipeline
automatically updates the virtual band pass steps to reflect the changes
(Figure 9.40).

888

737



Tools 883

© 2023 De Novo Software

 
(Figure 9.39) The dropdown menu containing the list of detectors in Step 5 -

Adjust parameters (optional)

Note:  If you have adjusted a parameter after the matrix has been calculated
it will automatically recalculate and apply the change.

 
Instructions for adjusting parameters using Spectrum Plots (Figure
9.41): 

1.  Click on any of the auto-generated spectrum plots you would like
to use to .

2.  In the ribbon, navigate to Gating Create Gates Current Gate
and select No Gate from drop down menu. The spectrum plot will
then be ungated.

3.  Create a gate on the spectrum plot to identify the
population/detector of interest.

4.  Drag the gate and drop it on appropriate cell in the AutoUnmixing
Controls table.

5.  Release the mouse button.
6.  The new gate and or plot will appear by name in the appropriate

cell in the AutoUnmixing controls table of the Adjust
parameters pane.
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Figure 9.40 - To change a parameter or gate drag for the stained or unstained
control, drag the gate or plot to the control you wish to change. The information

in the AutoUnmixing Controls table will update accordingly. 

· Step 6: Calculate matrices

In the final step you may choose to Calculate Matrices based on the Mean
or Median depending on your preference for your data and experiment
(Figure 9.42). Click on the radio button for either choice to apply your
preference.
By default the Unmixing Matrix will be recalculated every time the gates used
in the Unmixing wizard will be adjusted. To switch off said automatic update,
simply uncheck the "Recalculate matrix automatically when something
change".

Figure 9.41 - Step 6 of the Automatic Unmixing Setup wizard.

The calculated matrix will be visible in the Unmixing Matrix tab (Figure 9.43).
Please also see the section on The Unmixing Window  to learn how to
rename, save, load, and delete specific end members of the matrix. Once the
matrix is calculated, the matrix endmembers (i.e. the normalized spectra) will
be automatically graphed in a scatter plot in the Visualized Mixing Matrix
page .
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Figure 9.42 - An example unmixing matrix after completion of Automatic Unmixing.

9.1.3.1.1  Visualized Mixing Matrix

The Visualized Matrix page depicts a chart displaying the Detector vs
Normalized Intensity for each stained control added in the wizard, as well as a
spreadsheet with the charted values (each detector is labeled by Detector # and
Wavelength). See Figure 9.44.



FCS Express 7 Manual886

© 2023 De Novo Software

Figure 9.43  Visualized Matrix page automatically created upon completion of the
Automatic Unmixing Setup.

The Visualized Mixing Matrix page can also be created manually for any
unmixing matrix added to the layout. To create the Visualized Matrix page,
after creating an unmixing or importing an unmixing matrix into the layout,
simply right-click on the desired unmixing matrix in the Compensation and
Unmixing editor and select Build Visualized Matrix (Figure 9.45). FCS Express
will automatically generate a Visualized Matrix page on the layout when clicked.
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Figure 9.44  To manually create the Visualized Matrix page, right-click the desired
unmixing matrix and select Build Matrix Visualizer. 

In case any error impedes the calculation or the display of the Matrix Visualizer,
the spreadsheet containing the values to plot will report the error accordingly.
Hovering the mouse on the spreadsheet cell reporting the error, will open a
hover-hint with additional details on the source of the error. An example of a
hover-hint is depicted in Figure 9.46 below when the error was caused by the
lack of stained events in one of the controls.
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Figure 9.45  An example of Matrix Visualizer with errors.

9.1.3.1.2  Spectral Unmixing Detection, Caveats, and troubleshooting

Spectral Unmixing  in FCS Express provides a way to easily discriminate the

individual emission spectral signature of a specific fluorochrome or dye using

single stained controls. The peak channel in the emission spectral signature is

automatically identified for each dye by when using the Spectral Unmixing

Wizard. Under some circumstances, auto-detection of peak channels in the

wizard will identify multiple dyes with the same peak channel and identify these

with a message "Duplicate brightest detector...". The information provided

below will guide you through making corrections for these auto detection and

auto fitting discrepancies. 

Multiple dyes auto-detected to share the same peak channel can occur when

performing unmixing using different populations of cells , when automatically

placed markers are not identifying the proper peak , when using a combination

of beads and cells  (mixed media), and/or when low abundance cell

populations  are attempted to be fit in the automatic setup. 
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When a duplicate brightest detector is found, FCS Express will pop up a

message window to notify the user (Figure 9.47).

(Figure 9.46)  The following message will appear when multiple dyes share the
same peak channel.

By clicking on Proceed the Automatic Unmixing Setup will continue to build

the unmixing histograms. FCS Express allows for detectors and populations to be

manually defined to ensure users can obtain an accurate and reliable unmixing

matrix. Step 5 – Adjust parameters (optional)  of the Automatic

Unmixing Setup allows users to make these manual adjustments prior to

calculating the unmixing matrix.

When two or more controls share the same detector it is important to
interrogate the scatter gate  and the stained gate created by the marker on
the histogram . (Figure 9.48) 
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(Figure 9.47) The Detector listed for APC and Alexa
Fluor 647 is R2-A in the AutoUnmixing Controls table.

In the example image below, APC and Alexa Fluor 647 appear to share the same
detector (Figure 9.49).

(Figure 9.48) APC and Alex Fluor 647 share the same detector R2-A highlighted in
the image above with the green box.

When the stained markers were investigated in both the APC and Alexa Fluor
647, it was observed that there were some "noise" events in the APC - stained
marker.  When the marker was adjusted to reduce the number of "noise" events
the spectral signal reveals that R1-A can be used for APC. (Figure 9.50)
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(Figure 9.49).  When the stained marker was adjusted for APC the spectral
signature indicated that R1-A could be selected for the APC Control.

To adjust the detector using the AutoUnmixing Controls table in Step 5 -
Adjust parameters (optional), click on the detector and use the dropdown
box to navigate to the new detector.  Select the detector and the detector will
be updated (Figure 9.51).
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(Figure 9.50) The top image displays the dropdown
list for the Detector.  The bottom image displays the

modified detector.  It was R2-A and is now R1-A.

Unmixing Detector Extraction Automated Pipelines - Virtual band pass
filters:

Virtual band pass pipeline steps will be created automatically when an
umixing matrix is created and can be viewed by clicking on the
transformations dialog. Click on the Tools tab and select Transformations
to view.  The virtual band pass steps extract the spectral signature and will
allow the software to quickly identify signatures without having to recalculate
the matrix. To modify virtual band pass pipeline steps the user will need to
make adjustments in Step 5 - Adjust parameters (optional) as
highlighted above. Adjustments to the Detector in the AutoUnmixing
Controls table will automatically update the Virtual band pass filters in the
pipeline steps. The change will be displayed in the Spectral Detector
Ranges of the Autogenerated Spectral Detector Extraction Step (Figure
9.52). Click on the Tools tab and select Transformations to view the
pipeline steps.
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(Figure 9.51).  Prior to changing the detector in the AutoUnmixing Controls table
Alexa Fluor 647 and APC shared the same Spectral Detector Ranges in the Virtual
bandpass filters automatically created as pipeline steps.  After the detector was

updated in the AutoUnmixing Controls table the virtual bandpass filter for APC was
unique  from Alexa Fluor 647.

Note: The pipeline steps can not be manually modified.  To modify the Spectral
Detector Ranges the AutoUnmixing Controls table  (i.e. Step 5 of the
Automatic Unmixing Setup) must be utilized.

· Gating for mixed media or variable cell types

When unmixing requires the user to include different cell populations and/or

beads, the universal scatter gate may not be appropriate for some single stained

control samples.  If the gate is inappropriate for a given cell population and/or

bead, this can lead to the incorrect detector being automatically selected.  Data

specific gates  or data specific gate groups  can be used to customize gates

and applying them to the spectral plots can assist in identifying if the correct

detector to select (Figure 9.53). To quickly create a data specific gate, select the

gate of interest on the plot, hold the shift key while adjusting the gate. A data

specific gate will be created.  Please see the above referenced links for more

information on data specific gate creation and management. 
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(Figure 9.52). Universal Scatter Gate is appropriate for the plot on the left. The plot
on the right shows the Unstained (Cells) control gate after applying a Data Specific

Gate.                     * Note: Gate line width is increased to 3 in above plots

 

After creating the Data Specific Gate , there is an observable difference in the

histogram (Figure 9.54).   
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(Figure 9.53) When the Universal gate is used there is a second peak displayed on
the histogram (Left).  This histogram displays a single peak when the Data Specific

Gate is applied (Right).

While in this instance it did not result in the need to change the automatically

defined detector.  In other cases (as shown above) the detector may need to be

modified, please click here  to review how to adjust the detector. Ensuring that

the gate is reflecting the appropriate population will assist in evaluating if the

proper detector is being assigned.

In this example, the importance of this adjustment is in that the unstained is

being subtracted from each fluorescent signal.  Prior to this adjustment, the

intensity of the signal is misrepresenting the population (Figure 9.55).
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(Figure 9.54) In the top plot generated from the universal gate the intensity
of the signal is significantly increased as compared to the bottom plot

generated when the  Data Specific Gate is used.

Dragging and dropping new plots or gates into AutoUnmixing Controls table will

allow you to override the automatic setup and use alternate gates and plots for
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stained or unstained populations.  A new gate can be created on the spectral plot

and used to identify stained or unstained populations (Figure 9.56).  

(Figure 9.55) The Unstained CTL gate that was drawn on the spectral plot was
dragged and dropped under unstained for the Monos Sample.

· Autofluorescence Controls

Gating is also important when incorporating Autofluorescence controls  into

your unmixing matrix.  The gate should incorporate only the cells of interest to

accurately portray the spectral signature of the population.  Under some

conditions the autofluorescence of cells may change due to sample preparation

and could vary between different cell types. 

· Low Abundance Populations

Low abundance populations can present a challenge for auto-detection.  When
the percent positive is less than 3% of the total population it is important to
confirm gating and marker placement.

In the following example, the universal gate has been made into a Data Specific
Gate to include all the cells that appear on the plot.  When all the gates are
included in the Scatter Gate the marker selects the peak that contains 8.05% of
the total cells (Figure 9.57).
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(Figure 9.56) Auto-detection when low abundance cells are evaluated.  
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When the marker placement is further investigated, it is observed that a smaller
population containing 2.04% of the cells can be found (Figure 9.58).

(Figure 9.57) Adjusting the marker reveals that there is a smaller population
present on the histogram plot that may more accurately represent the "dead"

population.

To determine if this population is real or debris, the Data Specific Gate can be
modified.  When the Data Specific Gate is modified to select a new region it
becomes apparent that the population in the adjusted marker region are
consistent with "dead" cells (Figure 9.59).

*Note: When reviewing the spectrum plot you determine the wrong detector has
been selected, please see the section adjusting parameters  for instructions on
how to adjust the detector.
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(Figure 9.58) When the Data Specific Gate is relocated the appropriate peak is
observable on the histogram.  The signal can be further evaluated to confirm the

proper detector has been assigned.
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While spectral flow cytometry expands the capabilities of analyzing samples by
detecting the differences in the spectral signatures of fluorochromes, it is
important to closely examine the single stained controls to confirm the
appropriate detector has been assigned.  The use of Data Specific Gates,
adjusting markers, and making manual changes to AutoUnmixing Controls in
Step 5 – Adjust parameters (optional)  of the Automatic Unmixing
Setup allows users to create an accurate and reliable unmixing matrix.

9.1.3.2 Creating or Modifying an Unmixing Definition by Importing Endmembers via
CSV files

An entire Unmixing table (or even single Endmembers) can be imported as a CSV
file directly into the Automatic Unmixing Setup wizard.

To import an unmixing as a CSV file:

1. Select the Unmixing Matrix tab.
2. Click on the Load endmember(s) from CSV file and add them to the end
of the matrix button (Figure 9.60).
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Figure 9.59 Loading endmembers into the unmixing matrix. 

The parameter that will be unmixed with the matrix will be the first spectral
parameter available in the file. If you would like to unmix the merged spectrum,
the Instrument Specific Settings  for the current user should be set to not
Import spectra as individual Parameters.

9.1.4 Spillover Spreading Martrix

The Spillover Spreading Matrix (SSM) values have been demonstrated to
reveal fluorescence spectrum interactions that can limit the sensitivity of a
reagent in the presence of brightly-stained cells on a different color. The SSM can
thus be a useful tool in instrument quality control to ensure consistent sensitivity
and performance. In addition, the SSM is a key element for predicting multicolor
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immunofluorescence panels, which will aid in the optimization and development
of new panels.

The Spillover Spreading Matrix page is automatically created by FCS Express
when either the Compensation or the Unmixing Matrix is calculated and depicts a
spreadsheet with the Spillover Spreading values for every pair of dyes included in
the compensation/unmixing matrix respectively (Figure 9.61).  The SSM
automatically has conditional formatting automatically applied when created.

Figure 9.60  The Spillover Spreading Matrix.

If errors are encountered when calculating the Spillover Spreading Matrix, the
spreadsheet containing SSM values will report the error accordingly. Hovering the
mouse over a spreadsheet cell reporting the error, will display a hint with
additional details on the source of the error. An example a hover over error hint
is depicted in Figure 9.62 below. In the example below the error occurred
because of a lack of stained events in one of the controls.

Figure 9.61 An example of Spillover Spreading Matrix with errors.

More details on the Spillover Spreading Matrix can be found in the

following publication:

Richard Nguyen et all,  Quantifying Spillover Spreading for Comparing

Instrument Performance and Aiding in Multicolor Panel Design. Cytometry A.

2013 March ; 83(3): 306-315. doi:10.1002/cyto.a.22251.
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9.1.5 Cross Stain Index Matrix

The Cross Stain Index (CSI) value, quantifies the spread of a given dye (i.e. the
source; reported in rows in the CSI matrix) into another dye (i.e. the target;
reported in columns into the CSI matrix), and thus quantifies the impact of the
source on the sensitivity of the target. The CSI matrix is a useful tool for the
optimization of multicolor panels.

CSI values range between 0 and 1. The higher is the CSI value for a pair of dyes,
the higher is the spread of the source dye into the target dye.

The CSI Matrix page is automatically created by FCS Express when either the
Compensation or the Unmixing Matrix is calculated and depicts a spreadsheet
with the CSI values for every pair of dyes included in the compensation/unmixing
matrix respectively (Figure 9.63). The CSI automatically has conditional
formatting automatically applied when created.

Figure 9.62  The Cross Stain Index Matrix.

If errors are encountered when calculating the Cross Staining Index Matrix, the
spreadsheet containing CSI values will report the error accordingly. Hovering the
mouse over a spreadsheet cell reporting the error will display a hint with
additional details on the source of the error. An example a hover over error hint
is depicted in Figure 9.64 below. In the example below the error occurred
because of a lack of stained events in one of the controls.

Figure 9.63 An example of Cross Stain Index matrix with errors.
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More details on the Cross Staining Index can be found in the white paper

published at https://welcome.cytekbio.com/evaluate-multicolor-performance .

9.1.6 Using Definitons

Once a Definition Matrix (either a Compensation or an Unmixing Matrix) has been
created, it can be used within the layout in several ways:

Solution Use Case How to implement
solution

Note

Apply
definition
to existing

plots
manually

To quickly apply
and visualize a
definition you have
created or edited
when you do not
intend to run a
batch or
iterate/change
between data files
in the data list (i.e.
all your files are
already loaded into
the layout).

See the Applying Definition
To Existing Plots  chapter.

If you then would like
to run a batch
process or change
between data files
using this same
definition, ensure your
Layout Options for
definition loading are
set to None (see the
Selecting the Default
Definition to Use
When Loading Data
chapter).

Set a
definition

As
Default to
automatic
ally apply it

to data
loaded in a

layout.

· You would like to

run a batch
process and/or
change between
data files using
the data list while
using a newly
defined or
customized
compensation
when loading files

· You would like

the
compensation/un
mixing definition
to be applied to
any file loaded
into that layout

· You would like

the
compensation/un

1. Move the definition of
interest into the
"Created Manually"
folder of the
Compensation and
Unmixing window. If the
definition of interest is
already in the Created
Manually folder, this step
is not required. 

2. Apply the definition to all
plots (see the Applying
Definition Matrices
chapter)

3. Right click on the
definition from the
Compensation and
Unmixing window and
select "Set As Default"

4. Change your Layout
Options to use default

If no Default
compensation is
available, FCS
Express will behave
as defined in the
Layout Options (see
the Selecting
Compensation to Use
When Loading Data
chapter).
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911

908

911

https://welcome.cytekbio.com/evaluate-multicolor-performance


FCS Express 7 Manual906

© 2023 De Novo Software

mixing definition
to be saved into
the FCS Express
layout. 

definition (see the
Selecting the Default
Definition to Use When
Loading Data
chapter).

Export
definition

as an
*.allcomp
ensation

or
*.allunmi
xing file to
apply it to

all data
files within
a folder. 

· You would like to

run a batch
process and/or
change between
data files using
the data list while
using a newly
defined or
customized
compensation/un
mixing definition.

· You would like

the
compensation/un
mixing definition
to be associated
with all files
within a folder.

· You would like

the
compensation/un
mixing definition
to exist
independently of
the layout (i.e.
the definition will
be saved into the
same folder as
the data files.

1. Export the defintiion of
interest as
*.allcompensation or
*.allunmixing file using
the Export the selected
transformation button
of the Compensation
and Unmixing window.
Be sure to select
*.allcompensation (or
*.allunmixing) as output
file format and to save
the definition in the same
folder as the data files.

2. Ensure your Layout
Options for definition
loading are set
accordingly (see the
Selecting the Default
Definition to Use When
Loading Data
chapter).

3. Create a new layout or
open a template (i.e. a
layout saved with
unlinked data), and load
your files into it.

If FCS File or FCS
File, then
Compensation
Default is specified as
the default Option for
loading definitions ,
when loading a data
file, FCS express will
look in the folder
where the file is being
loaded from for a
*.allcompensation or
a *.allunmixing file. If
the *.allcompensation
or the *.allunmixing
file is found, that
definition is used. 

If a file-specific
definition is also found
(see below) the file-
specific definition will
be used instead.

If neither a file-specific
compensation nor the
*.allcompensation
matrix is found, FCS
Express will behave
as defined in the
Layout Options (see
the Selecting
Compensation to Use
When Loading Data
chapter).

Note: Only 1
*.allcompensation or
1 *.allunmixing
definition file should
be present in a folder.
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If  two or more
definitions files exist
in the same folder,
e.g.,
type1.allcompensatio
n and
type2.allcompensatio
n, type3.allunmixing,
FCS Express will pick
one at random.

Export and
assign

definition
to specific

files by
saving it as
filename.c
ompensat

ion or
filename.
unmixing

file

· You would like to

run a batch
process and/or
change between
data files using
the data list while
using a newly
defined or
customized
compensation/un
mixing definition.

· You would like

the
compensation/un
mixing definition
to be associated
with specific files.

· You would like

the
compensation/un
mixing definition
to exist
independently of
the layout and
only apply to the
assigned file.

1. Export the definition of
interest using the Assign
this
compensation/unmixin
g to a data file button
of the Compensation
and Unmixing
window.The
filename.compensation
(or filename.unmixing)
file will be autoamtically
saved in the same folder
as the data files. 

2. Ensure your Layout
Options for definition
loading are set
accordingly (see the
Selecting the Default
Definition to Use When
Loading Data
chapter).

3. Create a new layout or
open a template (i.e. a
layout saved with
unlinked data), and load
your files into it.

If FCS File or FCS
File, then
Compensation
Default is specified as
the Default Definition
to Use when Loading
Files , when loading
a data file, FCS
express will look in
the folder where the
file is being loaded for
a file with the same
name, but ending in
.compensation (or
.unmixing). For
instance, if you are
loading sample1.fcs
then FCS Express will
look for
sample1.fcs.compens
ation or
sample1.fcs.unmixing
. If a match is found,
FCS Express will load
the definition matrix
as if it was specified
by the .fcs file itself.

If FCS Express does
not find the specific
definition file, it will
look for an
*.allcompensation (or
*.allunmixing) file
(see above) in the
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same folder as the
data file. If present,
the definitio in the
*.allcompensation (or
*.allunmixing) file will
be applied to all of the
files in that folder.

If neither the file-
specific, or the
*.allcompensation/*.
allunmixing matrix is
found, FCS Express
will use
compensations
defined in the Layout
Options (see the
Selecting the Default
Definition to Use
When Loading Data
chapter).

Note:
The extension for an individual definition matrix exported by FCS Express for use
in FCS Express is .compensation (or .unmixing). The extension is applied when
using the following two commands of the Compensation and Unnmixing
window :

o Assign this compensation/unmixing to a data file (see table above)

o Export the selected compensation/unmixing (see the Saving and Loading

Definition Matrices  chapter)

While saving a compensation using the Export the selected
compensation/unmixing command, the .allcompensation or .allunmixing
extension can also be selected (see the table above).

9.1.6.1 Applying Definitions to Existing Plots

Every plot, overlay on a plot, and every file loaded as a plate, can have a
different compensation/unmixing definition.
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To change the definition for an overlay, right-click on the plot and select Format
from the pop-up menu. Go to the Overlays category, select the overlay(s) of
interest, and select the compensation/unmixing definition you want to use.
Alternatively, you can use the Format tab Plot Options Overlays command
to edit individual or multiple plots.

There are also many drag and drop commands that can be used to apply a
definition to a plot. You can drag and drop definition from the Compensations
and Unmixing window to any plot, any layout, and from one matrix to another
to apply and edit definitions (Figure 9.65). 

To apply a definition to a plot by dragging and dropping from the
Compensations and Unmixing window, follow the steps below. 

1.  Left click and hold on a definition.
2.  Drag the Compensation/Unmixing definition to the intended plot (red arrow). 
3.  Drop the Compensation/Unmixing definition by releasing the left mouse

button. The Compensation/Unmixing defintiion will then be applied to the plot
(green arrow).

Figure 9.64 Dragging and dropping a compensation from the Compensation and
Unmixing dialog onto a plot to apply the compensation.

Compensation/Unmixing definitions may be dragged and dropped between
different layouts by dragging the definition from the Compensations and
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Unmixing window in one layout to the Compensations and Unmixing window
or plot in another layout much like Steps 1 - 3 above. This will allow you to easily
apply definitions between different layouts and experiments.

A Compensation/Unmixing definition may also be dragged and dropped onto
another Compensation/Unmixing definition. This allows you to easily copy
matrices from one definition to another. 

You can set a definition as default for the layout, so it will automatically apply to
all experimental files in your Data List as you click Next/Prev or perform a Batch
Process.  See the Automatic Compensation and Batch Processing section  of
the relevant tutorial.

You can save compensation/unmixing definitions to folders , and have them
automatically apply to the FCS files in the folder.

Compensations/Unmixing definitions may be applied to individual or multiple plots
by performing either option in the Compensations and Unmixing window
below.  Note that, if the user option Default Compensation to Use is set to
any option other than None, the compensation applied will revert to the
preference (i.e. Compensation Default or FCS file) when changing the data
displayed on the plot or during batch processing.

o Left-click to select compensation name from Loaded automatically with

data files folder or Created manually folder and click Apply to selected
plots or Apply to all plots button in top menu bar (Figure 9.66)

Figure 9.65 Compensation and
Unmixing window menu to access

options to apply selected
compensation to selected or all

plots (outlined in red) 

o Right-click compensation and click Apply to selected plot or Apply to all

plots button in pop up menu (Figure 9.67)
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Figure 9.66  Right-click popup menu to access options
to apply selected compensation to selected or all plots

(outlined in red) 

Additionally, standard copy and paste commands  may be used to move
matrices from one compensation/unmixing definition to another within the
Compensations and Unmixing window.

Note that various other functions in FCS Express allow you to apply a
compensation definition. For instance, when performing Parameter Math you can
choose whether a compensation/Unmixing definition is applied prior to
performing the math.

9.1.6.2 Selecting the Default Definiton to Use When Loading Data

FCS Express has many default options for applying compensation when loading
new data files or adding plots to your layouts. The default options for
compensation/unmixing definition are described in the table below.

Option Explanation

None When adding a new plot, no definition will be used. When changing a file
on an existing plot, the definition that was applied to the plot  before
the change will continue to be used.

Compensation
/Unmixing

The Compensation/unmixing definition that was manually "Set as Default"
will be used. To set the definition "as Default", please see the Using

1678
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Option Explanation

Default Definiton Matrices  chapter.

FCS File The definition stored with the file is automatically used when the data
file is displayed on a plot. This is commonly the compensation matrix
defined at the time of acquisition (for FCS 3.0 or later format files), or it
may be a compensation/unmixing that was Assigned to an .fcs file by
FCS Express .

FCS File, then
Compensation
/Unmixing
Default

See FCS File, above. However, if there is no FCS file definition, the
definition "Set as Default" (see above) will be applied.

Compensation
/Unmixing
Default, then
FCS File

See Compensation/Unmixing default above. However, if there is no
definition "Set as Default", the FCS file definition (see above) will be
automatically loaded.

Understanding the Default Options in FCS Express

The definition default options can be setup differently for new layouts versus
existing layouts. These two options provide you with the flexibility to define how
your compensation/unmixing is applied when first loading your data and plots
onto a new layout and the ability to change how compensation/unmixing is
applied to new data files and plots added to an existing layout at any time.

For new layouts, you can define the compensation/unmixing default options
from the User Options. These options are found on the General page of the
Options dialog (File tab Options) in the Compensation/Unmixing to use in
new layouts drop-down list. Changes to the Default Compensation/Unmixing to
Use at the User Options level will only apply to newly created layouts, and will
not change how compensation/unmixing is applied to data and plots added to an
existing layout.  

Common use-cases for changing the Default Compensation/Unmixing to Use at
the User Options level are: 
· to ensure all new layouts load compensation/unmixing in the same way - i.e.

you can set by default whether compensation/unmixing saved to a file or
layout is applied or to have no compensation/unmixing applied at all.

· to prevent compensation/unmixing from being applied inappropriately - i.e.

after creating a compensation/unmixing from single stained controls in FCS
Express (see Automatic Compensation ) and setting that
compensation/unmixing as the default on the layout (see Using Compensation
Matrices ), you can ensure the default compensation/unmixing will be used
on all new files loaded in for analysis rather than the compensation/unmixing
saved to the fcs file. 

For existing layouts, you can define the compensation/unmixing default options
from the Layout Options  (Figure 9.68). These options are found on the
Layout Options page within the Layout Options dialog (File tab
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Options) in the Compensation/unmixing to use in this layout drop-down list.
These changes at the Layout Options level apply immediately to any new file or
plot added to your analysis and will supersede the compensation/unmixing
default options set in the User Options. Note that changes at the Layout Options
level will not change the compensation/unmixing applied for any files and plots
already present on the layout.

Figure 9.67. Layout Options - Changing the compensation default options (Default
Compensation to Use).

Changing the compensation/unmixing default options at the Layout Options
level is the recommended method to control how compensation/unmixing is
applied to your data unless you are creating a brand new layout, in which case
the User Options settings will apply. For new layouts, note the
compensation/unmixing default options in the Layout Options will match those in
the User Options by default. 

Understanding How FCS Express Applies Compensation

FCS Express applies compensation/unmixing to your data files when they are
first loaded into the layout (not just in the Data List). Understanding how FCS
Express decides which compensation/unmixing to apply and when to use each
option for loading compensation/unmixing is described in the table and image
below (Figure 9.69).
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Figure 9.68 Decision tree used by FCS Express to apply compensation or unmixing
to your data based on user selected options.

9.1.7 Import and Export Definitions

Exporting Definitions

All compensation/unmixing definitions are automatically saved with the layout file
when the layout is saved. The Automatic Compensation Setup  and the
Automatic Unmixing Setup  are also saved with each compensation/unmixing
definition.

To save an individual compensation/unmixing definition (i.e. *.compensation or
*.unmixing file), open the Compensation and Unmixing window , select the
definition of interest by clicking on it, and click the Export the selected

compensation/unmixing icon . 

Importing Definitions

The compensation/unmixing definitions that were saved with the layout are
automatically loaded when the layout is loaded. You may also choose to open a
saved compensation (*.compensation) and unmixing (*.unmixing) file by

choosing the Import a transformation from a file  command, then
navigating to the compensation/unmixing file, and selecting it to be opened.  You
may also choose to import a compensation matrix exported from FlowJo in the
.csv format by the same procedure;  be sure to choose "Compensation" as the
option in the dropdown menu.

9.1.8 Reporting a definition into the layout and into Excel

Once a definition is defined, you can drag and drop its matrix (i.e.
Compensation matrix, Spillover Matrix or Unmixing Matrix):
· onto a layout
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· into a text box

· into an integrated spreadsheet

· into Microsoft Excel

The example below show how to display the raw matrix data in text boxes and
Excel (Figure 9.70).

Figure 9.69-  Drag and drop a compensation matrix from the Compensation and
Unmixing window onto a layout, into a text box, or directly into Microsoft Excel to

display the values.

A definition can also be inserted into a text box or into an integrated spreadsheet
by right clicking into the text box/Spreadsheet and by selecting Insert Insert
Compensation Matrix or Insert Insert Unmixing Table (Figure 9.71).

418
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Figure 9.70-  Right click in a text box or spreadsheet cell to insert compensation or
unmixing matrices. 

 

· When a Compensation Matrix is inserted: 

o The Compensation Matrix of interest can be selected.

o The Matrix Type (i.e. either the Compensation matrix or the Spillover matrix)

can be selected.
o Parameter names can also be used as column and row headers by checking

the Use parameter names box. 

· When an Unmixing Matrix is inserted:

o The Unmixing Matrix of interest can be selected and the Normalization

Type:
§ None = no normalization
§ Area Under Curve = the Area Under the Curve is normalized to 1
§ Peak = the highest peak is normalized to 1
§ Normalization from the Unmixing Options = the setting selected in the

Unmixing Options of the Automatic Unmixing Setup will be used

o The Active Detectors and End members Only check box allows you to

only report the active End Members (i.e. the columns) and the active
detectors (i.e. the rows) of the unmixing matrix  in the resulting table.

9.2 Transformations

The Transformations navigator is access via the Tools
tab button. The transformations
navigator (Figure 9.72) will launch and new data transformations may be added
by clicking on the down arrow next to the blue plus button. The following
transformations are currently available in FCS Express: 

· Parameter Math
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· Principal Component Analysis (PCA)

· K-Means cluster analysis  

· R Integration  for adding new parameters  and cluster transformations

· tSNE transformation

· SPADE

· Pipeline

Note: Please also note our sections on Merging / Concatenating files , which is
often used for tSNE and SPADE data sets.  

Figure 9.71 - The transformations navigator in FCS Express. Clicking on the down
arrow next to the blue plus button allows access to a variety of transformations. 

A progress bar will be visible for some transformations and will annotate the
Iteration being processed.  The progress bar allows the user to abort the
transformation by clicking on the ESC key (Figure 9.73).  

Figure 9.72 - Transformation Progress bar
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TIP: While transformations are running, a user can work in another layout
(either a new layout or an existing layout), if either the latter, or the Welcome
screen , was already open at the time the transformation was started.

9.2.1 Transformation Navigator

FCS Express allows a user to define multiple options to customize a
transformation. In the Transformations navigator there may be up to seven
sections depending on the transformation chosen:

· Transformation window  (  )  

· Run Options  (  ) 

· Gate Options  (  )

· Parameter Options  (  )

· Transformed Data Options (  )

· Sampling Options  (  )

· Transformation Options ( )

* Note: All transformations do not have all of the options listed.

 To open the Transformations navigator in a FCS Express layout: 

1.  Select the Tools tab  command. 
(Figure 9.74)

Figure 9.75. Tools tab.

2.  The Transformation navigator will open.  (Figure 9.76)

3.  Observe that all available transformations that you may have already defined

will be found in the Transformation window (  ). If no transformations have
yet to be defined the area will be empty and new transformations may be
added as per the steps below.  

4.  To add a new transformation click on the blue plus button  and select the
desired transformation.
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Figure 9.77.  Transformation Navigator.
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Sections Description

Transformati
on Window

Eight transformations can be utilized by a user in FCS Express.
· K-means

· Parameter Math

· PCA

· Pipeline

· R Add Parameters

· R Cluster Transformation

· SPADE

· tSNE

New transformations are named as New followed by the
transformation added by default.

Right click on the transformation and select Rename to
modify the name of a given transformation.

Other tools in the Transformation window Right-click Menu

(see in figure above ) are:
· New - to add a new transformation

· Copy - to copy a transformation

· Paste - to paste a copied transformation

· Delete - to remove a transformation from the list

· Set As Default - Sets a transformation as the default

transformation
· Apply to selected plots - Will only apply the

transformation to plots that have been selected by user.
· Apply to all plots - Will apply the transformation to all

plots in the layout.

Run Options Default is set to automatically calculate and update in real time
PCA, Pipeline, R, Spade, or tSNE transformations.  

A user can deselect this option and calculate the
transformation manually.  

Manual calculation is useful when changes to variables are
being made to the transformation and the user would like to
defer the transformation update until all variables have been
set. 

Gate Options Allows the user to run transformations on the events within a
specified gate.
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Parameter
Options

A user can define the Template File for a transformation by

clicking on the ellipsis to the right of the Template File text

box. 

A template file is the data file (or merged files) that is used to
provide the list of parameters and information relevant for the
transformation. The template file should be the same file you
are performing the transformation on. 

The Template File can be selected from:
· Any connected storage disk (i.e. local, network, cloud)

using the Select Template From File option.
· Any plot on the current layout using the Select

Template From Selected Plot option. A plot must be
selected to use this option.

Note: if you wish to define a transformation for an entire

experiment containing multiple data files, rather than an

individual data file, you can use a merged data file  as

the Template File.  The transformation can then be

applied to the merged data file, and events therein can be

related back to the original data files. 

A list of available parameters to perform a transformation will

populate based on available parameters from the template

file.

Parameters for the transformation can be selected by a

user.  

· Parameters can be filtered by entering unique portions

of a parameter name in Filter text box.

· Parameters can be sorted in ascending or descending

alphabetical order by right clicking near the list and select

Sort Ascending or Sort Descending.

Other tools in the Parameter Right-click Menu (see in figure

above )are:

· Select All - Selects all parameters listed.

· Deselect All - Deselects all parameters listed.

· Invert Selection - Selected parameters will be

deselected and any parameter that was NOT selected

will now be selected.
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· Unsorted - Lists the parameters in the order defined by

the flow cytometer at acquisition (shown in image

above)

Select or change to the appropriate Parameter Scaling

Options for each of the selected parameters if required to

optimize the transformation.  You can also choose to apply a

manual scaling to All or Checked parameters using the buttons

to the right of Apply scaling to.

Transformed
Data Options

The Display Name Suffix for a transformation can be
customized by the user by entering information into the
adjacent text box.  This modifies what is displayed on a plot
when a transformation is applied.

Sampling
Options

Allows a user to define Downsampling Algorithm to reduce
the sample size of a data set prior calculating a
transformation.

Available Downsampling Methods are:
· None

· Random

· Interval

· Weighted density

· Target density

Sample size can be adjusted to reduce the number of cells
used in the calculation of the transformation

Additional downsampling options are available via Pipeline
transformation steps . 

Transformati
on Options

Defined by a user to customize a transformation.

For specific transformation options for a transformation
please follow links provided above in the transformation
window section .

9.2.2 Sampling Options

Sampling is a method used to reduce the sample size of a data set prior
calculating a statistics of interest. Different sampling methods are available in FCS
Express and can be used in conjunction with several Transformation tools .

Available sampling methods are:
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· None. Sampling is not performed. All events selected in the Gate drop-down

menu of the Transformation dialog are used.

· Random. A defined number of cells (i.e. the Sample Size) is sampled from the

main population (i.e. the one selected in the Gate drop-down menu of the

Transformation dialog) according to randomly selected events.  If the

specified Sample Size is higher than the number of available events, all

available events will be considered.

· Interval. A defined number of cells (i.e. the Sample Size) is sampled from the

main population (i.e. the one selected in the Gate drop-down menu of the

Transformation dialog) according to a fixed periodic interval. This interval,

called the sampling interval, is calculated by dividing the population size by the

desired Sample Size. For example, if the main population counts 1000 events

and the Sample Size is 100, every 10th event will be selected (e.g. 1st, 11th,

21st, 31st...). If the specified Sample Size is higher than the number of

available events, all available events will be considered.

Target Density  and Weighted Density  are examples of Density Based

sampling. This means the probability that an event will be sampled (i.e. included

in the dataset for analysis) is based on the local density around that event.  The

local density of an event x is defined as the number of other events within a

certain radius around event x. The radius used is arbitrary, and properties to

control it are defined below.  

Density based sampling involves two stages. The first stage is to calculate the

local density around each cell. The second stage is to decide whether or not to

sample the cell based on the local density.

Local Density Calculation

The local density is calculated identically for both the Target Density and

Weighted Density options. In order to calculate the local density, a radius must
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be determined. In order to determine the radius, 2000 events are randomly

selected and the distance matrix of these events are calculated. The median

distance is then multiplied by the Alpha value that can be entered in the

properties to determine the radius for the local density.

Once the radius is determined as described above, the number of events within

the radius is calculated based on the Local Density Method whose options are:

· Exact - the exact number of events within the radius is determined

· Kernel - an approximation of the number of events within the radius is

determined. Generally, the kernel method is much faster than the exact

method and provides comparable results. 

Sampling Calculation

After the local density has been calculated, the cells are sampled based on the

density using two different approaches which the user can select: Target

Density  and Weighted Density .

9.2.2.1 Target Density Downsampling

Target Density downsampling is a method to discard events based on their local
density. Please read our introduction to sampling  if you have not done so
already to learn about your options for calculating local density.

Target density downsampling is implemented as originally described in Qui, P et.
al. "Extracting a Cellular Hierarchy from High-dimensional Cytometry Data with
SPADE", Nature Biotechnology, 29(10):886-891, 2011. The goal is to ensure
that the final density of the sampled population falls within a certain density
range. Events with local densities below the desired density range are discarded.
Events with the local densities within the desired range are kept. Events with local
densities above the desired range with are discarded with a probability that
depends on how much the local density is greater than the desired range. The
higher the local density is compared to the desired range, the more likely it is to
be discarded.

Target Density Downsampling has several options

Specify Density
Percentiles

By default the option is checked, and the user can define
how the density-dependent downsampling is performed by
entering Min Density and Target Density values. If the
box is unchecked, Sample Size may be defined instead of
these two values.
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Sample Size Indicates how many cells to subsample when performing
the transformation. This option becomes available when the
Specify Density Percentiles check-box is unchecked. If
using this option, the Min Density and Target Density will
be automatically estimated to select cells. If the specified
Sample Size is higher than the number of available events,
all available events will be sampled. Note that the number of
available events is dictated by the Gate option. The
minimum value that can be entered is 10.

Alpha Alpha is used to calculate the local density. Please refer to
the Local Density section of the Sampling Options
chapter  for more details.

Min Density Min Density option becomes available when the Specify
Density Percentiles check-box is checked.
If the local density of a cell is less than the Min Density
value, it will be excluded from sampling. Values range from
0 to 1. Default is 0.01.

Target Density Target Denstiy option becomes available when the Specify
Density Percentiles check-box is checked.
If the local density of a cell is greater than the Min Density
percentile and less than the Target Density, it will be
sampled.  When the Local density of a cell is greater than
the Target Density, it will be sampled randomly with a
probability equal to the ratio of Target Density/Local
density. Values range from 0 to 1. Default is 0.20.

Local Density
Method

Local Density is further described in the Local Density
section of the Sampling Options chapter .

9.2.2.2 Weighted Density Sampling

Weighted Density sampling is a method to discard events based on their local
density. Please read our introduction to sampling  if you have not done so
already to learn about your options for calculating local density.

Weighted density sampling is implemented as originally described in Kollios, G et.
al "Efficient Biased Sampling for Approximate Clustering and Outlier Detection in
Large Data Sets", IEEE Transactions on Knowledge and Data Engineering,
15(5):1170-1187, 2003.

There are several options for Weighted density sampling:

Sample Size Indicates how many events to sample.

Alpha Alpha is used to calculate the local density. Please refer to
the Local Density section of the Sampling Options
chapter  for more details.

Weight The Weight parameter controls the probability with which an
events is sampled based on the local density. Positive
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weights mean that events from higher density regions will
be preferentially sampled. Negative weights mean that
events from low density regions will be preferentially
sampled. A weight of 0 means random sampling will be
performed, with no bias for density. In general values from
-3 to 3 are appropriate. In order to mimic Target Density
sampling, positive values between 0 - 1 are generally
appropriate.

Local Density
Method

Local Density is further described in the Local Density
section of the Sampling Options chapter .

9.2.3 Parameter Math

Parameter Math is a tool that allows you to create new parameters or change
current parameters, based on mathematical combinations, or formula
sequences, of existing parameters for a data file. 

Continue to:

· Defining Parameter Math

· Applying Parameter Math  

9.2.3.1 Defining Parameter Math

Formula sequences may be single calculations or a series of calculations.  There
may be situations where you want to perform a series of parameter math
calculations. Although it is possible to perform many calculations in a single
formula , sometimes it is necessary to store and plot the intermediate results
of a calculation, which makes parameter math sequences very useful. 

To create new parameter math, complete the following commands:

1.  Select the Tools Transformations Transformations command to open
the Transformations dialog.
2.  In the Transformations dialog, click the down arrow to the right of the blue

plus  to open the drop down menu and select Parameter Math (Figure
9.78).
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Figure 9.73 - Transformation command on ribbon and Transformation Dialog with
Add New drop down menu displayed

If no plots are inserted into the layout when adding new parameter math, a
Template File  will need to be selected by clicking the ... button (outlined in
red in Figure 9.79 below) and choosing Select Template From File to open
the Select data file dialog. If the layout already contains a plot, by default,
the Template File will correspond to the data file shown on the last selected
plot. If that data file is not the correct file to perform the transformation
upon, you can change the Template File to the correct data file by:

· clicking the ... button and choosing Select Template From File to open the

Select data file dialog.
· clicking on the plot displaying the desired data file, then clicking the ... button

and choosing Select Template From Selected Plot to open the Select
data file dialog.

If preferred, a gate may also be selected in this dialog by selecting the gate of
interest from the Gate drop down list. Parameter math will only be performed
on cells that are accepted by the gating formula listed. The calculation will be
performed on all cells in the file if No Gate is selected from the drop down list.

3. The Display Name Suffix for the transformation can be customized in the
Transformed Data Options section by entering information into the text box
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(outlined in blue in Figure 9.80 below). This modifies what is displayed on a
plot when the transformation is applied.

Figure 9.74 - Select Template File from Transformations dialog

4.  Once the Template File and Gate have been selected and Display Name
Suffix has been modified if desired, click New to access Create New Sequence
Item dialog (Figure 9.81).
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Figure 9.75 - Transformations Dialog with Template File Selected

The Output Parameter field controls where the result of the calculation will
be stored. It can either be New, in which case a new parameter will be
created, or you can select a currently existing parameter, which will overwrite
that parameter (Figure 9.82 below). If you are creating a new parameter,
you can enter the name of the new parameter in the Output Parameter
Name field.
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Figure 9.76 - Output Parameter drop down list in Create New Sequence Item
dialog

There are two ways to set up a Parameter Math calculation: Single or
Formula. Click on the appropriate radio button to select either Simple or
Formula for parameter math entry.

For typical calculations, the Simple approach is usually easiest. Select the
First Input Parameter, followed by the mathematical operation [only
addition (+), subtraction (–), multiplication (*), and division (/) are
supported], and then the Second Input Parameter. The Second Input
Parameter can also be a constant, in which case an entry field will appear
below the Second Input Parameter allowing you to enter the constant
value.

A more complicated but flexible way to set up a Parameter Math calculation is
to enter a Formula directly. The formula has the advantage that you can
combine multiple parameters, including regular and custom tokens , along
with different calculations, in a single formula. Formulas are entered as
mathematical equations. Each parameter is represented by Pn, where "n" is
the parameter number. Some valid formulas are:

· P1+P2

· (P1+P2)/(P4-100)

· sin(P3)/cos(P4)
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In addition, the word Row can be used as a special keyword in Parameter
Math formulas. Row refers to the cell number column in a data grid . For
example, the formula P1+Row would add 1 to the P1 parameter value for the
first cell, 2 to the P1 parameter value for the second cell, and so on. The Row
keyword is also useful for creating parameters with increasing values, such as
a time parameter. By using the 'row' variable, you use the cell number as a
parameter and can plot fluorescence against cell number to check for uniform
flow over time. Or, if the acquisition took 5 minutes and you have 5000 cells
you could use the following formula to get the actual time (in minutes) where
that cell was acquired. Formula: =(row-1)*(5/5000) .

Functions can also be inserted in the Formula.  To enter a token or a function
into your equation, right-click on the Formula field and choose Insert Token
or Insert Function from the pop-up menu (Figure 9.83).

Figure 9.77 - Inserting a Token into a Parameter Math Formula

The Evaluate tokens before adding to data check box controls whether or
not tokens added to the formula will remain as tokens in the resulting data
parameter. If that box is checked (the default), you will only see a single,
calculated result in the new parameter column in a data grid. If it is
unchecked, the value of the individual components of the formula (e.g.,
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tokens or special keywords) will appear separately within the data grid cell, so
that you can see the contribution of each component.

A comprehensive set of all formula operators and functions  is available.
This available set is the same for Custom Tokens.

If the parameter math calculation uses a simple calculation, or if the
calculation uses a formula and the check box Evaluate tokens before
adding to data is checked, then the results of the operation will be stored as
floating point numerical values.  If the parameter math calculation uses a
formula, and the check box is unchecked, then the results will be stored as a
formula. 

Any final results that are above the maximum channel value in the FCS file are
either truncated to the maximum value or stored without truncation,
depending on the setting of the Math Range Checking option on the General
page of the FCS Express User Options dialog .

5.  To create the new sequence item, click the OK (Figure 9.84).  

Figure 9.78 - Finish calculation creation in Create New Sequence Item dialog

It will now appear in the Formula Sequence box (outlined in red in Figure
9.85 below) of the Transformations dialog.
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Figure 9.79 - Newly created calculation added to Formula Sequence box of
Transformations dialog.

You can delete a sequence: select it in the Formula Sequence box and click
the Delete button. To edit the sequence, select it and click the Edit button. 
These commands may be accessed by right-clicking within the Formula
Sequence box as well.  You may also save or load a sequence by right-clicking
within the Formula Sequence box. See right-click menu below in Figure 9.86.

After adding or selecting Parameter Math in the Transformations dialog,
the right-click in Formula Sequence box  command
brings up a standard dialog to save your Parameter Math Sequence (*.fcf).

After adding or selecting Parameter Math in the Transformations dialog,
the right-click in Formula Sequence box
command brings up a standard dialog to load a saved sequence.
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Figure 9.80 - Right-click menu for Formula Sequence box of Parameter Math in
Transformations dialog

9.2.3.2 Applying Parameter Math

The new parameters derived by Parameter Math can now be applied to any plot

or data grid in FCS Express, and they can be chosen from the list of available

parameters (Figure 9.87 below). Please note only one transformation may be

applied at a time for each plot or data grid selected.
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Figure 9.81 - Parameters created in Parameter Math can be accessed as standard
parameters

Once parameter math has been used to define new parameter(s), it may be
applied to any plot and data grid in FCS Express. Standard gating and statistics
may be used to study the result of the parameter math. 

Note: When Parameter math has been applied, the text "Parameter Math
applied" will appear in the plot title.

Parameter math may be applied to 1D and 2D plots by any of the following
methods:

· Drag and drop a parameter math from the Transformations navigator to the

intended plot (Figure 9.88). 
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Figure 9.82 - Applying parameter math to a plot by dragging from the
Transformations navigator to the plot (red arrow).

· Parameter math may be applied to individual or multiple plots by performing

either option outlined in red in the Transformations window below (Figure
9.89).

Figure 9.83  Commands to Apply
Transformation to Plot(s)

· Right-click the name of the parameter math in the Transformations window

and click Apply to selected plot or Apply to all plots button in pop up menu
(Figure 9.90).
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Figure 9.84  Commands to Apply
Transformation to Plot(s)

  
· Access the Overlays formatting dialog  and choose the parameter math to

apply from the Transformation drop down list (Figure 9.91). 
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Figure 9.85 - Applying parameter math to 1D (left) or 2D (right) plots  by selecting
the parameter math in the Transformation drop down from the Formatting

Overlays dialog.

Parameter math may be applied to data grids by any of the following methods:

· Drag and drop a parameter math from the Transformations navigator to the

intended data grid (Figure 9.92). 
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Figure 9.86 - Applying parameter math to a plot by dragging from the
Transformations navigator to the data grid (red arrow).

· Access Formatting dialog for general options . select

parameter math to use from Transformation drop down list . (Figure 
9.93). 
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Figure 9.87 - Applying parameter math to a data grid by
selecting the parameter math in the Transformation drop down

from the Formatting Overlays dialog.

· Right-click data grid Show Transformed Values select appropriate

parameter math from menu.(Figure  9.94). 
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Figure 9.88 - Accessing parameter math by right-clicking data grid and navigating
to Show Transformed Values menu.

9.2.4 Principal Component Analysis

Principal Component Analysis (PCA) is a statistical procedure that uses an
orthogonal transformation to convert a set of observations, in this case
cytometry based events, into new variables called principal components. The
transformation is defined in such a way that the first two principal components
generally define the maximum variance while each succeeding component
maximizes the variance at a 90 degree rotation. Principal components defined
and applied to a plot in FCS Express are accessible for analysis as new
parameters on plots.

To begin working with PCA analysis in FCS Express please see the topics on:

· Defining a PCA Transformation

· Applying a PCA Transformation

9.2.4.1 Defining a PCA Transformation

Principal Component Analysis is performed in FCS Express through the

Transformation window.

The steps below outline the process of creating a new PCA transformation on

your data:

1.  Open the Transformation window by selecting the Tools tab 

 command. The Transformations

window will open (Figure 9.95, Step 1).
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2.  Click on the dropdown arrow adjacent to the blue plus  button (Figure

below, Step 2).

3.  Click on PCA in the dropdown list (Figure below, Step 3). 

Figure 9.89 Initial steps to create a new PCA transformation.

The PCA dialog will now appear in the Transformation window as seen in Figure

9.96.
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Figure 9.90 The PCA dialog in the Transformations window
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The new PCA transformation is named as New PCA by default but it can be

easily renamed by either of the following methods:

· Right click on the PCA transformation that needs to be renamed Select

Rename.

· Select the PCA transformation that need to be renamed via left click and press

F2 on your keyboard.

· Select the PCA transformation that need to be renamed via left click and click

on the  button in the Transformations tool bar.

4. Choose a Template File  for the PCA transformation by clicking on the

ellipsis to the right of the Template File text box (Figure 9.97).  

    The PCA dialog will be populated with a list of available parameters to perform

a PCA transformation based on available parameters from the template file

(Figure below).
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Figure 9.91 A template file has been chosen which subsequently populates the list
of possible parameters to perform a PCA transformation.
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5. Choose the parameters to define the transformation by checking the boxes

next to the parameter names (Figure 9.98, Step 1).  Parameters  can be

filtered or sorted to assist in the selection of parameters when multiple

parameters are available in the template file.

6. Choose or change to the appropriate Parameter Scaling Options for each of

the selected parameters if required (Figure below, Step 2). By using the Apply

scaling to button All or Checked the user can define the parameters to be

scaled.
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Figure 9.92 Parameters for the PCA transformation are selected by checking the
boxes next to the parameter names.
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The PCA transformation has now been defined and automatically calculated by

default. The PCA transformation can now be applied to any plot in FCS Express

(see, Applying a PCA Transformation ).

Note the following options:

· A gate may be selected to only evaluate the matrix for events falling within the

gate from Gate dropdown menu.

·  Sampling Options (optional). Although multiple Sampling Methods are

available (please refer to the Sampling Options  chapter for more details), the

default Downsampling Algorithm for PCA is None, thus all available events

(i.e. the ones defined with the Gate drop-down menu) will be used. 

· Transformed Data Options (optional).  Allows you to customize the Display

Name Suffix for the PCA transformation by entering information into the

adjacent text box.  This modifies what is displayed on a plot when the

transformation is applied. 

· The Parameters to keep option allows you to define how many principal

components are defined for the data set (the figure below depicts an example

in which 3 parameters have been kept).

· The Output Style choices are:

o Append to initial data adds the newly created principal component (PC)

parameters to the end of the parameter list in the data file when the PCA is

applied (Figure 9.99, left).

o PCA only only displays the PC parameters on a plot when the PCA is applied

(Figure below and right).
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Figure 9.93 PCA transformation Output Styles

To defer calculating the PCA matrix, uncheck the box for Automatically

Calculate PCA Matrix. Doing so will present you with the button to Calculate

the PCA Matrix (Figure 9.100).
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Figure 9.94 Unchecking the Automatically Calculate PCA Matrix box will defer
calculating the PCA matrix.
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After pressing the button to Calculate the PCA Matrix the matrix will be

displayed in the bottom pane of the window (Figure 9.101)
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Figure 9.95 Once the Calculate PCA Matrix button is pressed the matrix will be
calculated and shown in the dialog.
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9.2.4.2 Applying a PCA Transformation

Once a PCA transformation has been defined , it may be applied to any plot in
FCS Express. Once a PCA is defined and applied to a plot, standard gating and
statistics may be used to evaluate the new principal component parameters. 

Note: When a PCA transformation has been applied, the text "PCA
transformed" will appear in the plot title.

PCA transformations may be applied to 1D and 2D plots by any of the following
methods:

· Drag and drop a PCA transformation from the Transformation window to the

intended plot (Figure 9.102). 

Figure 9.96 - Applying a PCA transformation to a plot by dragging the PCA
transformation from the Transformations navigator to the plot (green arrow).

· PCA may be applied to individual or multiple plots by performing either option

outlined in red in the Transformations window below (Figure 9.103).
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Figure 9.97  Commands to Apply
Transformation to Plot(s)

· Right-click the name of PCA in the Transformations window and click Apply

to selected plot or Apply to all plots button in pop up menu (Figure 9.104).

Figure 9.98  Commands to Apply
Transformation to Plot(s)

· Access the Overlays formatting dialog  and choose the PCA to apply from the

Transformation drop down menu (Figure 9.105). 

643



Tools 955

© 2023 De Novo Software

Figure 9.99 - Applying a PCA transformation to a plot by selecting the PCA
transformation from the Transformation dropdown in the Formatting Overlays

dialog.

The result of both method will be the following (Figure 9.106). Please note the
suffix "PCA transformed" in the plot title.
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Figure 9.100 - 1D and 2D plot with PCA transformation applied. Note the "PCA
Transofrmed" suffix in the plot title.

Principal Component will be accessible as additional or as unique plot parameters
based on the selected output style (see the previous section  for more info
about this) (Figure 9.107).

Figure 9.101 - PCA Transformation output styles.

9.2.5 K means (Cluster Analysis)

FCS Express can perform cluster analysis using k-means methodology.

Cluster analysis aims to group a set of objects/events in such a way that
objects/events in the same group (i.e. a cluster) are more similar (in some
sense or another) to each other than to those in other groups (i.e. the other
clusters).
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k-means is a partitioning-based clustering algorithm. k-means method for
clustering is an iterative process in which an initial partition of given k clusters is
then improved by applying a search algorithm to the data. Simplifying, given a
pre-defined number (k) of clusters, the algorithm:

- begins with an initial set of k cluster centers (i.e. the centroids)

- (re)assigns objects to the closest centroids

- recalculates centroids according to new memberships of the data points.

- repeats the last two steps until a consistent result is found or until the

maximum number of iterations is reached.

The whole procedure above can be repeated several times, starting from a
different set of centroids each time. When this is done, the best clustering is then
used as final result.

To compensate for the fact that K-mean is very sensitive to the initial guesses
when performing the clustering, there is the option to run KMeans multiple times
and FCS Express will automatically select the best result as the final clustering
result.

Note: the basic k-means clustering is based on a non-deterministic algorithm.
This means that running the algorithm several times on the same data, could
give different results. However, to ensure consistent results, FCS Express
performs k-means clustering using a deterministic method.

To begin working with cluster analysis in FCS Express please see the topics on:
Defining a k-means Clustering Analysis
Applying a k-means Clustering Analysis
Working with k-means parameters

9.2.5.1 Defining a k-means cluster analysis

k-means cluster analysis is performed in FCS Express through the

Transformation button within the Tools tab  The steps

below outline the process of creating a new k-means cluster analysis on your

data.

1.  Open the Transformation window by selecting the Tools

tab Transformations command (Figure below, Step 1).

2.  Click on the drop down arrow adjacent to the blue plus  button (Figure

below, Step 2).
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3.  Click on Kmeans in the drop down list  (Figure 9.108, Step 3). 

Figure 9.102 - A Kmeans transformation can be created via the Transformations
navigator.

The Kmeans dialog will now appear in the Transformation window as seen in

Figure 9.109.
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Figure 9.103 - The Kmeans dialog opens when a new k-means
transformation is created.
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The new Kmeans transformation is named as New Kmeans by default and it

can be easily renamed by either of the following methods:

· Right click on the Kmeans transformation that needs to be renamed Select

Rename.

· Select the Kmeans transformation that need to be renamed via left click and

press F2 on your keyboard.

· Select the Kmeans transformation that need to be renamed via left click and

click on the  button in the Transformations tool bar.

4.  Choose a Template File  for the k-means clustering by clicking on the

ellipsis to the right of the Template File edit box.  

    Once the file of interest has been selected, the dialog will be populated with a

list of available parameters to perform a k-means clustering based on available

parameters from the template file (Figure 9.110).
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Figure 9.104 - A template file has been loaded into the New Kmeans dialog. 
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5. Choose the parameters to define the Kmeans clustering by checking the

boxes next to the parameter names (Figure 9.111, Step 1). Parameters

can be filtered or sorted to assist in the selection of parameters when multiple

parameters are available in the template file.

6. Choose or change to the appropriate Parameter Scaling Options for each of

the selected parameters if required (Figure below, Step 2).  By using the

Apply scaling to button All or Checked the user can define the parameters

to be scaled.
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Figure 9.105 - Choosing the parameters to perform k-means cluster analysis. 
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7.  A number of options can be set at this point:

Options Description

Gate Allows the user to run k-Means only on the
events within a specific gate.

Transformed Data Options The user can customize the Display Name
Suffix for the k-means transformation by
entering information into the adjacent text box.
 This modifies what is displayed on a plot when
the transformation is applied.

Sampling Options Although multiple Sampling Methods are
available (please refer to the Sampling
Options  chapter for more details), the default
Downsampling Algorithm for k-Means is
None, thus all available events (i.e. the ones
defined with the Gate drop-down menu, see
above) will be used.

Number of Clusters It defines the number of clusters the events

should be clustered by. It's equivalent to the

number of centroids. 

Min percent Cells Per
Cluster

If in any iteration but the last one, a cluster

contain less than this amount of cells, that

centroid is dropped and it's replaced with a

different cells from the dataset.

Maximum Iterations This value indicate the maximum number of

iterations that FCS Express should perform

before quitting the clustering process.

Number of Attempts This is the number of the initial set of centroids

that should be tested.

Keep-Non-Converged Data This option defines whether or not results

obtained when the clustering does not converge

should be displayed.

Output Style  for Kmeans clustering. See below

The available choices are Clustering Assignments and Clustering

Statistics. Please see the detailed list below explaining each option. 

922



Tools 965

© 2023 De Novo Software

· Clustering Assignments: By selecting this output style, the following

statistics can be assigned to each event the cluster has been performed

on:

o Cluster Assignment: An internal label indicating the cluster membership

is automatically assigned to each event. This label is internally used by

FCS Express for heatmap representation of clusters but it is also

accessible through a Data grid .

o Distance to Cluster Centroid: The distance of a given event to the

centroid of its cluster. Values are plotted as unique histogram.

o Distance to centroid Histograms: The same as the Distance to

Cluster Centroid but in this case values are grouped, and thus plotted,

separately for each cluster. Clusters are numbered from 1 to Number

of Clusters.

o Gaussian CV SSE Scaled: In this representation each event is plotted

based on its cluster membership, thus clusters appear as separated

histograms. Given that cluster membership is an integer value that goes

from 1 to Number of Clusters, an artificial noise is introduced to

spread out the data. Gaussian SSE scaled means that the standard

deviation of the Gaussian (normal distribution) used to represent each

cluster is proportional to the Sum of Squared Error of the cluster. 

o Gaussian CV Unscaled: In this representation each event is plotted

based on its cluster membership, thus clusters appear as separated

histograms. Given that cluster membership is an integer value that goes

from 1 to Number of Clusters, an artificial noise is introduced to

spread out the data. Gaussian CV unscaled means that the standard

deviation of the Gaussian (normal distribution) used to represent each

cluster is the same among clusters.

o Gaussian Y Data: Events are plotted following a Gaussian (normal

distribution). 

399
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· Clustering Statistic: By selecting this output style, the following statistics

will be accessible through plots and Data grid :

o Kmeans Cluster ID: An integer value that goes from 0 to Number of

Clusters-1.

o Centroid coordinates: The coordinates of each centroid are given for

each of the parameters considered for the clustering.

o Sum Of Square (WCSS): The Within-Cluster Sum of Squares is

reported for each cluster.

The following table lists the objects suitable for displaying each output style:

Can be displayed as

He
at
ma
p

1D or
2D

plots

Dat
a

grid

Clusterin
g

Assignm
ents

Cluster
Assignment

Y Y

Distance to
Cluster
Centroid

Y Y

Distance to
Centroid

Histograms

Y Y

Gaussian CV
SSe Scaled

Y Y

Gaussian CV
Unscaled

Y Y

Gaussian Y
Data

Y Y

Clusterin
g

Statistic
s

Y Y

8.  The k-means clustering has now been defined and automatically calculated. k-

means clustering can now be applied to plots for display and analysis. (see

Applying a k-means Cluster Analysis ).

399
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9.2.5.2 Applying a k-means cluster analysis

Once k-means clustering has been performed, results can be accessed as 1D
plots, 2D plots , Heatmaps  and Data Grid  depending on the selected
output style (see the previous section ). The Cluster Assignments chosen to be
calculated  may be accessed on plots on which the transformation has been
applied as new parameters . 

Although clustering results are automatically displayed when inserting a Data grid,
to access clustering results as parameters in 1D plots, 2D plots and/or
Heatmaps, the k-means transformation must be applied to the plots.

k-means clustering may be applied to 1D plots, 2D plots and heatmaps by any of
the following methods:

Drag and Drop (Figure 9.112)
1.  Left click and hold on k-means clustering from the Transformations window.

 
2.  Drag the Kmeans to the intended plot.
3.  Release the mouse button.

The Kmeans will be applied to the plot and the title of the plot will now include the
text "Kmeans clustered"  to indicate the transformation has been applied. 

Figure 9.106 Applying a k-means transformation to a plot by dragging the k-means
transformation from the Transformation navigator to the plot (green arrows).

154 280 399
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Using Transformations Window Commands:
· Kmeans may be applied to individual or multiple plots by performing either

option outlined in red in the Transformations window below (Figure 9.113).

Figure 9.107  Commands to Apply
Transformation to Plot(s)

· Right-click the name of the parameter math in the Transformations window

and click Apply to selected plot or Apply to all plots button in pop up menu
(Figure 9.114).

Figure 9.108  Commands to Apply
Transformation to Plot(s)

Using the Formatting Dialog (Figure 9.115)
1.  Access the Overlays formatting dialog  (for 1D plots, 2D plots and Heat

map) or the  (for Data Grids).
2.  Choose the Kmeans to apply from the Transformation drop down.
3.  Click OK. 

643
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Figure 9.109 Applying a k-means transformation to a plot by selecting the k-means
transformation from the Formatting Overlays dialog in the Transformation

dropdown.

The result of both the previous methods is represented in Figure 9.116 below.
When a k-means clustering has been applied to a plot or to an heatmap, the
suffix "Kmeans clustered" will appear in the object title.
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Figure 9.110 The plot title contains "Kmeans clustered" suffix when a Kmeans
transformation is applied.

In the next section we will see how to work with clustering parameters .

9.2.5.3 Working with k-means parameters

Once a k-means transformation is applied to a plot, the newly created Cluster

Assignment parameters can be accessed by clicking on the axis label of the plot

Figure 9.117. Please note that heatmaps can only display Cluster

Assignments, which is automatically displayed when a k-means transformation

is applied.
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Figure 9.111 Newly created parameters can be accessed by clicking on the axis
label of the plot of interest. 

Gates  can now be created on the following Cluster Assignment parameters

to specifically select the events within one or more clusters.:

· Cluster Assignments (1D/2D plot and heatmap),

· Distance to centroid Histograms(1D/2D plot only),

· Gaussian CV SSE Scaled (1D/2D plot only), 

· Gaussian CV Unscaled (1D/2D plot only),

These gates can then be used to back gate  clustered events on non-clustering

parameters.

Here are some examples of cluster selection using the above-mentioned

parameters:

1D plots

699
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Markers can be created on 1D plot displaying clustering parameters as one would

on non-clustering parameters. After converting the marker to be a gate , that

marker can be used to back gate clustered events on non-clustering parameters

(Figure 9.118).

Figure 9.112 Markers can be used to select cluster on 1D plot displaying a
clustering parameter. Gate 1 was defined on a density plot and events within it

have been clustered. Gate 1 has also been then applied to the k-means
transformed histogram. Markers from the histogram were converted to gates and

back gated onto the CD4 vs CD3 dot plot.

2D plots

Gates can be created on 2D plots displaying clustering parameters as one would

on 2D plots displaying non-clustering parameters. In the example below gates

have been created on a 2D plot displaying clustering parameters on both X and Y

axis but please consider that a clustering parameter can be displayed together

with a non-clustering parameter as well (Figure 9.119).

Figure 9.113 Gates can be used to select clusters on 2D plot displaying one or more
clustering parameters. Gate 1 was defined on a density plot and events within it

have been clustered. Gate 1 has also been then applied to the k-means
transformed plots. In this example 1D Gates (i.e. Markers) have been used to

select Cluster 2 and Cluster 3. Events in those gates have been back gated onto
the CD4 vs CD3 dot plot.

Heatmaps
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Clustering Assignments are automatically displayed on heatmaps when a

transformation is applied to them.

Once the k-Means clustering is displayed on the Heat Map, the following actions
can be performed on the Heat Map:
· Modify the well size

· Have well size dependent on a statistic such as number of events in the

node
· Set the Parameter and Statistic for display

· Change the Color Level and Color Scheme

· Create Well gates  to select one or more clusters (i.e. wells) and use those

gates/clusters for downstream analysis.

In the following example (Figure 9.120) two well gates have been created on

cluster 2 and 3 (well gate 2 is red highlighted on the heatmap).

Figure 9.114 Well gates can be used to select clusters on heatmaps. Gate 1 was
defined on a density plot and events within it have been clustered. Gate 1 has also
been then applied to the k-means transformed plots. In this example Well Gates

have been used to select Cluster 2 and Cluster 3. Events in those gates have been
back gated onto the CD4 vs CD3 dot plot.

9.2.6 R Integration

FCS Express can integrate R scripts via the new R integration tools in the Tools

 button which will launch the

Transformations navigator. Please refer to www.r-project.org to learn more

about R. The goal of R integration and implementation in FCS Express is to allow

users to run their own R scripts and work on the resulting output directly within

FCS Express as new parameters and cluster transformations. If you have any

questions about R integration with FCS Express after reading the topic

information below do not hesitate to contact support@denovosoftware.com.  
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Note: On the PC version of FCS Express, R and any R packages required to run R

scripts, need to be installed in order to take advantage of the R integration tools

(see below how FCS Express 7 finds R executables). The MAC version of FCS

Express does not require R to be installed on the machine. However, any R

package required to run the user's R script, needs to be installed in order to take

advantage of the R integration tools. Please refer the Installing R packages on

the MAC version of FCS Express  chapter to learn more on how to install R

packages on the MAC version of FCS Express.

How FCS Express 7 finds the R executables on a PC

1.  Look for the R_HOME environment variable. If this is set, then FCS Express

will use this value for as the install path for R.

1.  If not, then FCS Express 7 we will look in the system registry for the main

installation path for R. (Found at HKEY_LOCAL_MACHINE\SOFTWARE\R-

Core\R\InstallPath or HKEY_CURRENT_USER\SOFTWARE\R-

Core\R\InstallPath). Note that this is normally set by the R installer, and the

user will not need to set that up manually.

2.  If the main registry key is not set, then FCS Express 7 will look in the

(HKEY_LOCAL_MACHINE or HKEY_CURRENT_USER)\SOFTWARE\R-Core\R

folder. Then, FCS Express 7 will find the latest installation of R in the folder and

use the InstallPath key from this installation.

If you have multiple version of R installed on your PC and you want to point FCS

Express 7 to one of them, you need to specify this in the R_HOME environment

variable.

R Compatibility with FCS Express 7

§ FCS Express 7 - 64 bit is compatible with R versions 3.0.3 and later.

§ FCS Express 7 - 32 bit is compatible with R versions 2.11.0 and later.

9.2.6.1 Enabling R integration in FCS Express

FCS Express integrates R via an External Application Bridge that can be
enabled in the Startup User Options  by going to File Options Startup and
checking the box for Start the De Novo Software External Application
Bridge on login (Figure 9.121).

977
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Figure 9.115 Enabling the External Application Bridge at the FCS Express startup to
integrate R.

FCS Express must then be closed and reopened, including the startup screen.

The next time that FCS Express is launched, a Windows Security Alert

message by Windows Firewall may pop up under Windows environment. If this

happen, please check both options in order to allow DNSEABridge to

communicate on both Private and Public Network, and the click Allow access

(Figure 9.122).
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Figure 9.116 The Windows Security Alert by Windows Firewall that may pop up
under Windows environment.

Once FCS Express will be launched, an icon referring to the External Application

Bridge will appear in your tray confirming that the External Application Bridge is

active.

The External Application Bridge icon as it
appears in the Windows tray.
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The External Application Bridge icon as it appears in the
macOS tray.

9.2.6.2 Installing R packages on the MAC version of FCS Express

MAC users running FCS Express can install R packages by running one of the

following two scripts directly within FCS Express via either the R Add

Parameters or the R Cluster Transformation module. The scripts download

and install the packages of interest and create a text log report. The log report

can be used to check that the installation worked properly and that the packages

of interest can be loaded. The name of the log report file will be in the form

"FCSExpress installation report YYYY-MM-DD.txt", where YYYY-MM-DD is the

current date. The output directory can be defined by the user (see below).

Two scripts are available base on the repository (CRAN or Bioconductor) the

package is on. Please, chose the script suitable for you.

##Bioconductor Packages Installation for MAC users
Execute <- function(mat)
{

  FCSE7_log_file <- file(paste0("A/FCSExpress installation report
",Sys.Date(),".txt"), open="wt") ##creating the file and opening it
for writing
  sink(FCSE7_log_file, type="message") ##diverting R messages to
the file
  
  ##Installing the required packages
  source("https://bioconductor.org/biocLite.R")

  biocLite("B",suppressUpdates=TRUE)

  ##Checking that the installed package can be properly loaded

  library("B")

  sink(type = "message") ## reset sink
  close(FCSE7_log_file) ##close the file
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}

##CRAN Packages Installation for MAC users
Execute <- function(mat)
{

  FCSE7_log_file <- file(paste0("A/FCSExpress installation report
",Sys.Date(),".txt"), open="wt") ##creating the file and opening it
for writing
  sink(FCSE7_log_file, type="message") ##diverting R messages to
the file
  
  ##Installing the required packages

  install.packages("B")

  ##Checking that the installed package can be properly loaded

  library("B")

  sink(type = "message") ## reset sink
  close(FCSE7_log_file) ##close the file
}

Where A and B are defined by the user as follow:

A: is the path where the text log report will be saved

(e.g. /Users/YOURNAME/Desktop). 

B: is the name of the package that need to be installed.

Please do the following before proceeding with the installation:

1.  Open a text editor (e.g. TextEdit / NotePad).

2.  Copy and past one of the scripts above into a blank page (either the

Bioconductor Packages Installation for MAC users or the CRAN

Packages Installation for MAC users).

3.  Complete the script by inserting A and B.

4.  Save the script using ".R" (without quotes) as the file extension.

Now that the R script is ready, you can run it in FCS Express via the R Integration

tools by following the next steps:

1.  Be sure that the R Integration is enabled (if not, please see the Enabling R

integration in FCS Express  section of this chapter)974
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2.  Open the Transformation window by selecting the Tools

tab Transformations command from the ribbon bar.

3.  Click on the drop down arrow adjacent to the blue plus  button.

4.  Select either the R Add Parameters or the R Cluster Transformation.

5.  Click on the ellipsis at the right of the Template File field to browse for a

template *.FCS file. The Transformation window will be populated with the

parameters contained in the selected *.FCS file.

6.  Select any of the available parameters.

7.  Click on the ellipsis at the right of the R Script File field to browse for the R

script created few steps ago.

8.  Apply the transformation to any plot of your layout. This can be done via

either Drag and Drop  or via the Formatting dialog .

9.  A text log report will be generated in the A location.

In order to check that the installed packages can be properly loaded, you can

simply open the text log report and check the output messages (if any)

generated in response to the library("B") command.

Please, do not hesitate to contact us at support@denovosoftware.com for any

question you may have.

9.2.6.3 Introduction to R integration in FCS Express

Although any R function can be run by FCS Express via the R integration tool, the

user should consider the following specifications for creating the R script

containing the function of interest:

1. The user's functions need to be included in a general function named Execut e

and defined as follow:

Execute <- function(mat) { }

2. The input of the Execut e function, mat , is an R object of class matrix  of

fluorescence values. FCS Express allows the user to select which parameters and

which events will be included the matrix, as well as the matrix orientation, thus to

988 989

1436

mailto:support@denovosoftware.com


FCS Express 7 Manual980

© 2023 De Novo Software

keep events in rows and parameter in columns (Figure 9.123, on the left) or

vice-versa (Figure below, on the right).

Please note that the name of the parameters included in the mat  matrix will be

accessible in R by using the rownames() or the colnames() functions (when

parameter are in rows and in columns respectively).

Figure 9.117 The mat matrix used as input by the Execute function.

3. The aim of the above-mentioned Execut e function is to place the user defined

data and meta data together in an S4 object suitable to be used by FCS Express.

4. The output of the Execut e function is an S4 object containing the user defined

data and the metadata. The output represents the new input for FCS Express.

The workflow of how R integration works in FCS Express is given in the figure

below (Figure 9.124).
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Figure 9.118 Simplified schematic of R integration
with FCS Express. 

FCS Express currently supports two types of S4 objects as input:

1. R Add Parameter  - The method is suitable for adding new columns to the

mat matrix. Columns must contain numeric values and can be named. 

2. R Cluster Transformation  -The method is suitable for cluster based

analysis. A column containing the cluster membership of each event is added

and clusters may be labeled.

Both input methods can be accessed by selecting the Tools

tab Transformations command to launch the

Transformations navigator. Clicking on the drop down arrow adjacent to the

983
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blue plus  button (Figure 9.125) will reveal the R Add parameters  and R

Cluster Transformation  modules described above and presented in further

detail in the next sections:

Jump to:

· R Add parameters  

· R Cluster Transformation

Figure 9.119 Selecting the input method for R integration scripts.
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9.2.6.4 R Add Parameters

New parameters can be added to a file of interest using the R Add Parameters
input method.

To be compatible with the R Add Parameters method, the Execute function

defined in the R script should result in an S4 object containing the following slots:

1.  numberOfNewParams : integer of the number of new parameters;

2.  newParamData : numeric matrix with the data for the new parameters. It

has to be oriented with events in columns and parameters in rows,

irrespective of the orientation set for the mat matrix;

3.  newParamNames : character vector containing the names of new

parameters.

A general example of an R script compatible with the R Add Parameters input

method follows:

Execute <- function(mat)

{

  setClass("TransformationResult",

            representation(

                newParamData="matrix",

                numberOfNewParams="integer",

                newParamNames="character"

                ),

            prototype(

                newParamData=c(),

                numberOfNewParams=as.integer(0),

                newParamNames=""

                )

  )

  result <- new("TransformationResult")

  

  result@numberOfNewParams <- as.integer(A)

  result@newParamData <- B

  result@newParamNames <- C

  return(result)

}
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Where A, B and C values are defined by the user. As stated above:

· A can be any integer number. Note that the as.integer() function is required

since numbers are otherwise stored as object of class numeric.

· B can be the result of any user-defined transformation. B must be an object of

class matrix with events in columns and parameters in rows. The number of

events (i.e. the number of columns) must match the number of events in the

mat matrix and the number of parameters (i.e. the number of rows) must

match the value defined in A.

· C is a vector of class character containing the names of the new parameters.

Multiple names can be specified using the c() function (e.g.

c("name1","name2","name3") ). Please also note that the name of the

parameters included in the mat  matrix are accessible in R by using the

rownames() or the colnames() functions (when parameter are in rows and in

columns respectively). Thus parameter names can be derived and used as part

of generating new parameter names. 

An R script structured as above can be integrated into FCS Express using the R

Add Parameters tools via the following steps:

1.  Open the Transformation window by selecting the Tools

tab Transformations command.

2.  Click on the drop down arrow adjacent to the blue plus  button.

3.  Select R Add Parameters. The Transformation window will appear as in the

picture below (Figure 9.126).

4.  Click on the ellipsis at the right of the Template File  field to select a

template *.fcs file (Figure below - Step 1).

921
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Figure 9.120 The transformation windows populated with a New R Add Parameter
transformation.
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The Transformation window will be populated with the parameters contained in

the selected *.FCS file (Figure 9.127).

5.  Select the parameters that will be included in the mat matrix (Figure below -

Step 2). Parameters  can be filtered or sorted to assist in the selection of

parameters when multiple parameters are available in the template file.

6.  Select or change to the appropriate Parameter Scaling Options for each of

the selected parameters if required (a scale of interest can be applied to All or

Checked parameters) (Figure below - Step 3).

7.  (Optional) Select a gate from the Gate drop down menu to only include the

events within that gate in the mat matrix (Figure below - Step 4).

8.  (Optional) The user can customize the Display Name Suffix for the k-

means transformation by entering information into the adjacent text box. 

This modifies what is displayed on a plot when the transformation is applied.

(Figure below - Step 5)

9.  (Optional) Select a Sampling Option (Figure below - Step 6). Although

multiple Sampling Methods are available (please refer to the Sampling

Options  chapter for more details), the default Downsampling Algorithm

for an R Add Parameters transformation is None, thus all available events

(i.e. the ones defined with the Gate drop-down menu) will be used. 

10. Click on the ellipsis at the right of the R Script File field to browse for an R

script file (Figure below - Step 7).

11.Select the Event Order. This option defines the orientation of the mat matrix.

If Events as Row is selected, the mat object will have events in rows and

parameters in columns. If Events as Columns is selected, the mat object will

have events as column and parameters as rows.(Figure below - Step 8).

The result of the previous steps can be seen in the Figure below:

922
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Figure 9.121 The transformation window with a fully set New R Add Parameter
transformation.
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The custom R Add Parameters transformation is now ready to be applied to

plots and Data Grids.

The R Script will be automatically run as soon as it will be applied on a plot or a

data grid, or as soon as one of the option in the Transformation dialog are

modified. To defer running the R Script, uncheck the box for Automatically Run

R Script. Doing so will present you with the button to Execute R Script (Figure

9.128) which can be pressed to calculate on demand.

Figure 9.122 Unchecking the Automatically Run R Script box will allow the user to
run the R script manually only when required.

Once an R Add Parameters transformation has been created, results can be
accessed as 1D plots, 2D plots  and Data Grid  as new parameters. In order
to do so, the R transformation must be applied to the object of interest. 

R Transformations may be applied to 1D plots, 2D plots and data grids by
either of the following methods:

Drag and Drop (Figure 9.129)

154 399
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1.  Left click and hold on New R Add Parameters from the Transformation
window.  

2.  Drag the transformation to the intended object (1D plots, 2D plots or a data
grid).

3.  Release the mouse button.

The R transformation will be applied to the object. For 1D and 2D plots the title
of the plot will now include text "R add parameters added" indicating the
transformation has been applied. 

Figure 9.123 Applying an R Add Parameters transformation to a plot by dragging
the transformation from the Transformation navigator to the plot (green arrows).

Using the Formatting Dialog (Figure 9.130)

1.  Access the Overlays formatting dialog  (for 1D and 2D plots) or the
 (for Data Grids).

2.  Choose the R Add Parameters to apply from the Transformation drop
down.

3.  Click OK. 

643
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Figure 9.124 Applying an R Add Parameters transformation to a plot by selecting
the R Add Parameters transformation from the Transformation dropdown of the

Formatting Overlays dialog.

The result of the previous methods for 1D and 2 Plots is represented in Figure
9.131 below. When an R Add Parameters has been applied to a plot, the suffix
"R Add Parameters Added" has appear in the object title.
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Figure 9.125 The plot title contains the "R Add Parameters added" suffix when an R
Add parameters transformation is applied.

Once the transformation is applied, transformation results can be accessed as

new parameters (Figure 9.132). 

Figure 9.126 When an R Add Parameter transformation is applied to a plot,
transformation results can be accessed as new parameters.

Next Topic: R Cluster Transformations 992
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9.2.6.5 R Cluster Transformation

Customized cluster analysis can be applied to a file of interest using the R
Cluster Transformation input method.
To be compatible with the method, the Execute function defined in the R script

should result in an S4 object containing the following slots:

1.  clusterAssignments : integer vector of cluster assignments;

2.  numberOfClusters : integer of the number of new clusters;

3.  clusterNames : character vector containing the names of new clusters.

A general example of an R script compatible with the R Cluster Transformation

input method follows:

Execute <- function(mat)

{

  setClass("ClusteringResult",

            representation(

                clusterAssignments="integer",

                numberOfClusters="integer",

                clusterNames="character"

                ),

            prototype(

                clusterAssignments=c(),

                numberOfClusters=integer(0),

                clusterNames=""

                )

  )

  result <- new("ClusteringResult")

  result@numberOfClusters <- as.integer(A)

  result@clusterAssignments <- as.integer(B)

  result@clusterNames <- C

  return(result)

}

Where A, B and C values are defined by the user. As stated above:

· A can be any integer number. Note that the as.integer() function is required

since numbers are otherwise stored as object of class numeric;

· B can be the membership resulting from any user-defined clustering. It must be

a vector of integer values of length equal to the number of events in the mat
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matrix.  The number of unique integer values must be equal to A. The

numbering of clusters must begin at 0. 

· C is a vector of class character containing the names of the clusters. Multiple

names can be specified using the c() function (e.g.

c("name1","name2","name3") ). The length has to be equal to A.

An R script as structured above can be integrated into FCS Express using the R

Cluster Transformation tools via the following steps:

1.  Open the transformation window by selecting the Tools

tab Transformations command.

2.  Click on the drop down arrow adjacent to the blue plus  button.

3.  Select R Cluster Transformation. The Transformation window will appear as

in the following Figure 9.133:

4. Click on the ellipsis at the right of the Template File  field to select a

template *.FCS file (Figure below - Step 1).

921
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Figure 9.127 The transformation windows populated with a New R Cluster
Transformation.
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The Transformation window will be populated with the parameters contained in

the selected *.FCS file.

5.  Select the parameters that will be included in the mat matrix (Figure below -

Step 2). Parameters  can be filtered or sorted to assist in the selection of

parameters when multiple parameters are available in the template file.

6.  Select or change to the appropriate Parameter Scaling Options for each of

the selected parameters if required (a scale of interest can be applied to All or

Checked parameters) (Figure below - Step 3).

7.  (Optional) Select a gate from the Gate drop down menu to only include the

events within that gate in the mat matrix (Figure below - Step 4).

8.  (Optional) The user can customize the Display Name Suffix for the k-

means transformation by entering information into the adjacent text box. 

This modifies what is displayed on a plot when the transformation is applied.

(Figure below - Step 5)

9.  (Optional) Select a Sampling Option (Figure below - Step 6). Although

multiple Sampling Methods are available (please refer to the Sampling

Options  chapter for more details), the default Downsampling Algorithm

for an R Cluster Transformation transformation is None, thus all available

events (i.e. the ones defined with the Gate drop-down menu) will be used. 

10. Click on the ellipsis at the right of the R Script File field to browse for an R

script file (Figure below - Step 7).

11. Select the Event Order. This option define the orientation of the mat matrix.

If Events as Row is selected, the mat object will have events in rows and

parameters in columns. If Events as Columns is selected, the mat object will

have events as column and parameters as rows (Figure below - Step 8).

12. Set the output parameters for the clustering (Figure below - Step 9). Here

are reported the available cluster output format.

o Cluster Assignment: An internal label indicating the cluster membership

assigned to each event. This label is internally used by FCS Express for

heatmap representation of clusters but it is also accessible through a

Data grid .

o Distance to Cluster Centroid: The distance of a given event to the

centroid of its cluster. Values are plotted as unique histogram.

o Distance to centroid Histograms: The same as the Distance to

Cluster Centroid but in this case values are grouped, and thus plotted,

922
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separately for each cluster. Clusters are numbered from 1 to Number

of Clusters.

o Gaussian CV SSE Scaled: In this representation each event is plotted

based on its cluster membership, thus clusters appear as separated

histograms. Given that cluster membership is an integer value that goes

from 0 to Number of Clusters-1, an artificial noise is introduced to

spread out the data. Gaussian SSE scaled means that the standard

deviation of the Gaussian (normal distribution) used to represent each

cluster is proportional to the Sum of Squared Error of the cluster. 

o Gaussian CV Unscaled: In this representation each event is plotted

based on its cluster membership, thus clusters appear as separated

histograms. Given that cluster membership is an integer value that goes

from 0 to Number of Clusters-1, an artificial noise is introduced to

spread out the data. Gaussian CV unscaled means that the standard

deviation of the Gaussian (normal distribution) used to represent each

cluster is the same among clusters.

o Gaussian Y Data: Events are plotted following a Gaussian (normal

distribution). 

The result of the steps above will be the following (Figure 9.134):
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Figure 9.128 The transformation window with a fully set New R Cluster
Transformation.
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The custom R Cluster Transformation transformation is now ready to be

applied to plots.

The R Script will be automatically run when it is applied to a Heat Map or a data

grid, or when one of the option in the Transformation dialog are modified. To

defer running the R Script, uncheck the box for Automatically Run R Script.

Doing so will present you with the button to Execute R Script (Figure 9.135)

which can be pressed to calculate on demand.

Figure 9.129 Unchecking the Automatically Run R Script box will allow the user to
run the R script  manually only when required.

Once an R Cluster Transformation transformation has been created, results
can be accessed through Heat Maps  and Data Grids . The R transformation
must be applied to the plots.

R Transformation may be applied to Heat Maps and Data grids by any of the
following methods:

Drag and Drop (Figure 9.136)

1.  Left click and hold on New R Cluster Transformation from the
Transformation window.  

2.  Drag the transformation to the intended object (Heat Map or Data Grid).
3.  Release the mouse button.

280 399
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The R transformation will be applied to the object. If the object is an Heat Map
plot, the title of the plot will now include the text "R Cluster Transformation
clustered" to indicate the transformation has been applied. 

Figure 9.130 Applying an R Cluster Transformation to a plot by dragging the
transformation from the Transformation navigator to the plot (green arrow).

Using Transformation Window Commands
· R Cluster may be applied to individual or multiple plots by performing either

option outlined in red in the Transformations window below (Figure 9.137).

Figure 9.131  Commands to Apply
Transformation to Plot(s)

· Right-click the name of the R cluster and click Apply to selected plot or Apply

to all plots button in pop up menu (Figure 9.138).
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Figure 9.132  Commands to Apply
Transformation to Plot(s)

Using the Formatting Dialog (Figure 9.139)
1.  Access the Overlays formatting dialog  (for 1D plots, 2D plots and Heat

map) or the  (for Data Grids).
2.  Choose the R Cluster Transformation to apply from the Transformation

drop down.
3.  Click OK. 
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Figure 9.133 Applying an R Cluster Transformation to a plot by selecting the R
Cluster transformation from the Transformation dropdown of the Formatting

Overlays dialog.

The result of the previous methods for 2D plot, Heat Map and 1D plot is
represented in Figure 9.140. When an R Cluster Transformation has been applied
to a 2D plot, Heat Map or 1D plot, the suffix "R Cluster Transformation
clustered" will appear in the plot title.
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Figure 9.134 The heatmap title contains the "R Cluster Transformation clustered"
siffix when an R Cluster Transformation is applied.

2D plots, 1D plots and heatmap can now be used to create gates, markers and
well gates suitable for downstream analysis (please refer to the Heat Map
section of the Working with k-means parameter  chapter for more info on
how to create well gates) (Figure 9.141).

Figure 9.135 Examples of 1D Gate ("Cluster 1" gate on the left), rectangle 2D Gate
("Cluster 2" gate on the left), Well Gate (blue well gate in the Heat map) and

Marker (M1 marker on the right).

9.2.7 tSNE (viSNE)

High-dimensional single-cell technologies, such as multicolor flow cytometry, 

mass cytometry, and image cytometry, can measure dozens of parameters at

the single-cell level. FCS Express integrates t-Distributed Stochastic Neighbor

Embedding, otherwise known as t-SNE, which is a tool that allows you to map

high-dimensional cytometry data onto a two dimension plot while conserving the

970
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original high-dimensional structure to help you visualize and analyze high-

dimensional data.

      viSNE, which uses the Barnes-Hut implementation of the t-SNE algorithm,

was developed by El-ad David Amir and colleagues in 2013 and is based on the t-

Distributed Stochastic Neighbor Embedding (t-SNE) algorithm developed by

Laurens van der Maaten and Geoffrey Hinton in 2008.

     Briefly, the optimization algorithm included in viSNE searches for the best low-

dimensional (e.g. two or three dimensions) representation of the high-

dimensional events, so that the pairwise distances between events are best

conserved between the high- and the low-dimensional space.

      The final result of the algorithms in FCS Express is a 2D plot in which the

positions of cells reflect their proximity in their original high-dimensional space.

Plots can further be colored with density or heat mapping  of each parameter

allowing for easy visualization of populations. Gates may also be used to define

populations of interest and quickly explored across each parameter using

parameter overlays on histograms . 

      Given that t-SNE is an highly demanding algorithm, in 2014 Laurens van der

Maaten developed a faster version of the tSNE algorithm exploiting the Barnes-

Hut algorithm. The Barnes-Hut method gives an approximate result of tSNE but it

is faster than the exact tSNE. FCS Express allows the user to use both the exact

tSNE algorithm and the Barnes-Hut approximation. Moreover, the developers

team at De Novo Software worked hard to make both the exact algorithm and

the Barnes-Hut approximation even faster. You can find a performance test in

the next chapter .

     In 2019, Anna Belkina and colleagues further improve the performance of t-

SNE by adjusting a series of hard-coded settings of the original algorithm

resulting in a new implementation named Opt-SNE which is available in FCS

Express .  

     For a more comprehensive understanding of t-SNE, please click here.

More details on viSNE/tSNE can be found in the following publications:

· Van der Maaten, L. Accelerating t-SNE using Tree-Based Algorithms. J. Mach.

Learn. Res. 15, 3221-3245 (2014).
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· Amir el-AD et al. viSNE enables visualization of high dimensional single-cell data

and reveals phenotypic heterogeneity of leukemia. Nat. Biotechnol. 31, 545–

552 (2013).

· Van der Maaten, L. & Hinton, G. Visualizing data using t-SNE. J. Mach. Learn.

Res. 9, 2579–2605 (2008).

· Anna C. Belkina et al., Automated optimized parameters for T-distributed

stochastic neighbor embedding improve visualization and analysis of large

datasets. Nature Communications. 10 (1), 5415 (2019)

Additional resources:
· Github by Laurens van der Maaten, co-author of original implementation:

https://lvdmaaten.github.io/tsne/
· Distill article discussing the effective use of t-SNE:

http://distill.pub/2016/misread-tsne/

To begin working with viSNE in FCS Express please see the topics on:

· t-SNE performance in FCS Express V6

· Defining a tSNE transformation

· Applying a tSNe transformation

· Working with tSNE transformations

· Saving a tSNE transformation

· t-SNE FAQ

9.2.7.1 tSNE performance in FCS Express

Given that t-SNE is an highly demanding algorithm, the development team at De
Novo Software made a great effort to improve the speed of running the
algorithm with FCS Express.

To give you an idea of how t-SNE is performing within FCS Express, a
performance test has been run comparing FCS Express and the independent R
package in running both the exact tSNE algorithm and the Barnes-Hut
approximation.

Here is a brief description of how the test was run:

File Machine FCS Express R
· FCS format

version: 3.0
· Total number of

events: 500397
(different sample
sizes were used in

· CPU: Intel Core i5-

4200M CPU
2.5GHz

· Memory: 8Gb

· Version:

6.00.0045 (64 bit)

R version 3.3.1
(2016-06-21)
R Studio Version
0.99.903
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the performance
test)

· Total number of

parameters: 40
(20 parameters
have been
selected in the
performance test)

· System type:

Windows 8.1 64
bit

The graph below (Figure 9.142) show the elapsed time (in minutes) for t-SNE
calculation (using both the exact t-SNE and the Burnes-Hut Approximation
(Amount of Approximation = 0.5)) in both FCS Express and R. A fixed
number of parameters (i.e. n=20) and different numbers of events have been
used. t-SNE was not estimated for unsampled events. Please refer to the
Defining a tSNE transformation  chapter for more information about all the
above mentioned options.

Figure 9.136 - Performance comparison between FCS Express and R in running
both the exact tSNE and the Barnes-Hut Approximation.

9.2.7.2 Defining a tSNE transformation

tSNE transformations are performed in FCS Express through the

Transformations navigator.

1005
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The steps below outline the process of creating a new tSNE transformation for

your data:

1.  Open the Transformation window by selecting the Tools tab 

 command (Figure 9.143, Step 1). The

Transformations window will open as in the figure below.

2.  Click on the drop down arrow adjacent to the blue plus  button (Figure

below, Step 2).

3.  Click on tSNE in the drop down list  (Figure below, Step 3). 
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Figure 9.137 Initial steps to create a tSNE transformation.

The tSNE dialog will now appear in the Transformation window as seen in

Figure 9.144.
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Figure 9.138 - The tSNE dialog opens when a new tSNE transformation is created.
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The new tSNE transformation is named as New tSNE by default but it can be

easily renamed by either of the following methods:

· Right click on the tSNE transformation that needs to be renamed Select

Rename.

· Select the tSNE transformation that need to be renamed via left click and press

F2 on your keyboard.

· Select the tSNE transformation that need to be renamed via left click and click

on the  button in the Transformations tool bar.

4.  Choose a Template File  for the tSNE transformation by clicking on the

ellipsis to the right of the Template File text box.  

Note: if you wish to define the tSNE transformation on your entire data

set rather than an individual data file, you can use a merged data file with a

File Identifier Column  as the Template File.  The transformation can then

be applied  to the merged data file, and events therein can be related

back to the original data files with the File Identifier Column .   

The tSNE dialog will be populated with a list of available parameters to perform a

tSNE transformation based on available parameters from the template file

(Figure 9.145).
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Figure 9.139 When a template file is selected, the possible
parameters to perform a tSNE transformation are automatically

listed in the tSNE dialog.
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5. Choose the parameters to be used in the tSNE transformation by checking the

boxes next to the parameter names (Figure 9.146 below, Point 1).

Parameters can be filtered or sorted  to assist in the selection of

parameters.

6.  Select or change to the appropriate Parameter Scaling Options for each of

the selected parameters if required (a scale of interest can be applied to All or

Checked parameters) (Figure below, Point 2).

Options can now be set to customize the transformation.

Options Description

Gate Allows the user to run tSNE only on the events
within a specific gate.

Transformed Data Options The Display Name Suffix for a transformation
can be customized by the user by entering
information into the adjacent text box. This
modifies what is displayed on a plot when a
transformation is applied.

Sampling Options tSNE can be performed on a subsample of the
data with the rest of the data subsequently
mapped to the transformed subsampled data
after the initial run (see the Estimate tSNE for
Unsampled Events option).
Although multiple Sampling Methods are available
(please refer to the Sampling Options  chapter
for more details), the default setting for a tSNE
transformation are:

Downsampling Algorithm. Default setting is
Interval.

Sample Size. This parameter indicates how
many cells to subsample and perform tSNE on. If
the specified Sample Size is higher than the
number of available events, tSNE will be run on all
available events. Note that the number of
available events is dictated by the Gate option. In
FCS Express, the default Sample Size is 100.

tSNE Method to Use Allows the user to set the method to use for

running tSNE. Possible choices are Exact tSNE

and Barnes-Hut Approximation. The Exact

tSNE is the original implementation of the

922
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algorithm and is only practical for sample sizes

less than 5000 due to speed and memory

constraints of this approach. The Barnes-Hut

method gives an approximate result of tSNE and

is faster than the exact tSNE for larger data sets

but there will be little difference in calculation

times for smaller data sets. The amount of

approximation for the Barnes-Hut method can be

specified in the Amount of Approximation

(Applies only to Barnes-Hut) field (see next

option).

In FCS Express, the default Method for tSNE is

the Barnes-Hut Approximation.

Amount of Approximation
(Applies Only to Barnes-
Hut)

Allow the user to set the Amount of
Approximation for the Barnes-Hut method. The
Amount of Approximation is a trade-off between
speed and accuracy of the approximation. The
value ranges from 0 to 1, where higher values
indicate a faster computation time but a less
accurate approximation and lower values results
in a slower computation time but a more
accurate approximation. If the approximation
value is less than 0.2, the exact tSNE method
may be used as well as the Barnes Hut
approximation may be slower than the exact
tSNE method.
In FCS Express, the default Amount of
Approximation is 0.50.

Perplexity Perplexity is a measure for information. In tSNE,
the perplexity is used to sets the number of
nearest neighbors considered.
In tSNE, typical values for the perplexity range
between 5 and 50.
In FCS Express, the default value for Perplexity
is 30.

Number of Iterations tSNE in an iterative process. This option allows
you to set the number of iteration that will be
performed by the algorithm.
In FCS Express, the default Number of
Iterations is 500.

Use Opt-SNE Opt-SNE is a variation of the original tSNE
algorithm that take advantage from optimized
hard-coded settings to improve the final tSNE
mapping. Please refer to the tSNE (viSNE) 1002
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page of the manual for the refernce to the original
article.

Estimate tSNE for
Unsampled Events

This option determines whether events that did
not participate in the tSNE calculation (if you
chose less than the total number of events in the
Sample Size option) will be mapped to the
nearest point that did participate in the tSNE
mapping. If this option is unselected, events that
did not participate in the tSNE calculation will be
have undefined values in the resulting tSNE
parameters and will not be plotted, participate in
statistical calculations of the tSNE parameters or
able to be gated based on the tSNE parameters.
In FCS Express, tSNE is Estimated by default for
Unsampled Events. 

Change Random Seed The Random Seed is a number which is used by
the random number generator to generate the N
random values which are used as input data
points for the tSNE calculation. The random
number generator will use the Random Seed
value and perform a series of math operations on
it which result in N random values. 

Since tSNE is a stochastic algorithm, a seed can
be set to make results reproducible over the time
when tSNE is applied to the same data.
Alternatively, the seed can be changed when a
different tSNE map is desired. The seed can be
changed by either clicking on the Change
Random Seed button or by manually inserting a
seed in the field.
In FCS Express, the default Random Seed is 6.

Automatically Calculate
tSNE

By default tSNE transformation is recalculated as

soon as an option in the tSNE dialog is changed.

Given that tSNE is an highly demanding algorithm

that can take several seconds to be calculate,

FCS Express allows the user to disable the

automatic calculation of tSNE and to manually

calculate tSNE only when required. To defer

calculating the tSNE algorithm, uncheck the box

for Automatically Calculate tSNE. Doing so will

present you with the button to Calculate tSNE

 which can be pressed to calculate tSNE on

demand.

Please note that this option only regulates the

auto update upon changes made within the tSNE
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dialog. If tSNE is calculated on a gate and that

gate is moved or re-sized, tSNE will be

automatically recalculated regardless this option.

If you want to avoid tSNE auto update upon gate

moving/resizing, please refer to the Live Updating

Gate  chapter of this manual.

7. (Optional) Select a gate from the Gate drop down menu to only run tSNE

transformation on the events within that gate (Figure below, Point 3).

8. (Optional) Modify the Display Name Suffix by entering information in the

adjacent text box (Figure below, Point 4).

9. (Optional) Select a Downsampling Algorithm (Figure below, Point 5).

Although multiple Sampling Methods are available (please refer to the

Sampling Options  chapter for more details), the default Downsampling

Algorithm for a tSNE transformation is Interval.

10. Enter a value in the Sample Size field by typing the number of events on

which tSNE will be performed (Figure below, Point 6).

11. Select which method to use for tSNE transformation. Exact tSNE or the

Barnes-Hut Approximation (Figure below, Point 7). 

12. If the Barnes-Hut approach is selected, set the Amount of Approximation

for the Barnes-Hut method in the Amount of Approximation (Applies only

to Barnes-Hut) field (Figure below, Point 8).

13.(Optional) Change the Perplexity by manually inserting a value in the field

(Figure below, Point 9).

 

14.(Optional) Change the Number of Iterations that will be performed by

manually inserting a value in the field (Figure below, Point 10).

15. (Optional) Select whether to use the Opt-SNE settings (Figure below, Point

11).

16.(Optional) Select whether to Estimate tSNE for Unsampled events (Figure

below, Point 12).
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17. (Optional) Change the random seed used for tSNE calculation by either

clicking on the Change Random Seed button or by manually inserting a seed

in the field (Figure below, Point 13).
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Figure 9.140 Steps to complete the tSNE dialog.
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The tSNE transformation has now been defined and will be automatically

calculated as soon as it will be applied to a plot . In addition, tSNE

transformation will be automatically recalculated as soon as an option in the

tSNE dialog will be modified.

Given that tSNE is an highly demanding algorithm that can take several seconds

to be calculate, FCS Express allows the user to disable the automatic calculation

of tSNE upon options changing and to manually calculate tSNE only when

required. To defer calculating the tSNE algorithm, uncheck the box for

Automatically Calculate tSNE. Doing so will present you with the button to

Calculate tSNE (Figure 9.147) which can be pressed to calculate on demand.

Please note that this option only regulates the auto update of tSNE upon

changes made within the tSNE dialog. If tSNE is calculated on a gate and that

gate is moved or re-sized, tSNE will be automatically recalculated regardless this

option. If you want to avoid tSNE auto update upon gate moving/resizing, please

refer to the Live Updating Gate  chapter of this manual.

Figure 9.141 Unchecking the Automatically Calculate tSNE box will allow the user to
calculate tSNE manually only when required.

The tSNE transformation can now be applied to any plot in FCS Express and the

new tSNE X and tSNE Y parameters chosen from the list of available parameters

1018
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(Figure 9.148 below). Please also see the Applying a tSNE Transformation

section for additional details on applying tSNE mapped transformations to plots. 

Figure 9.142 tSNE parameters can be accessed as standard parameters.

9.2.7.3 Applying a tSNE transformation

Once a tSNE transformation has been defined , it may be applied to any plot in
FCS Express. Once a tSNE transformation is applied to a plot, standard gating
and statistics may be used to study the result of the tSNE transformation. 

Note: When a tSNE transformation has been applied, the text "tSNE mapped"
will appear in the plot title.

tSNE transformations may be applied to 1D and 2D plots by any of the following
methods:

· Drag and drop the tSNE from the Transformation window to the intended plot

or data grid (Figure 9.149). 
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Figure 9.143 Applying a tSNE transformation to a plot by dragging the tSNE
transformation from the Trasnformations navigator to the plot (green arrow).

· tSNE may be applied to individual or multiple plots by performing either option

outlined in red in the Transformations window below (Figure 9.150).

Figure 9.144  Commands to Apply
Transformation to Plot(s)

· Right-click the name of tSNE in the Transformations window and click Apply

to selected plot or Apply to all plots button in pop up menu (Figure 9.151).

Figure 9.145  Commands to Apply
Transformation to Plot(s)

· Access the Overlays formatting dialog  and choose the tSNE transformation

to apply from the Transformation drop down menu (Figure  9.152). 
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Figure 9.146 Applying a tSNE transformation to a plot by selecting the tSNE
transformation from the Formatting Overlays dialog in the Transformation

dropdown.

The result of both methods will be plots that denote they are tSNE mapped in
the plot title (Figure 9.153). To access the tSNE parameters click and hold on the
axis of the plot and choose the appropriate tSNE X or Y parameters . 1021
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Figure 9.147 2D and 1D plot with tSNE transformation applied. Note the "tSNE
mapped" suffix in the plot title.

In the next section, we will see how to work with tSNE parameters .

9.2.7.4 Working with tSNE transformations

Once a tSNE transformation is applied to a plot , tSNE parameters can be
accessed by clicking on the axis label of the plot Figure 9.154. Gates  may be
created on any combination of standard or tSNE parameters on any plot type to
specifically select the events within one or more tSNE clusters. Jump to Gating
tSNE transformed data.
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Figure 9.148 tSNE parameters can be accesses as standard parameters.

While any plot type can display tSNE based parameters, Density and Contour

plots have a unique overlay option called Color Based on  (Figure 9.155) that

allows for the heat mapping of a density plot to be based on the heat of a

parameter in the data set. For instance, for a particular data set in which you

visualize tSNE-X and tSNE-Y parameters in two plots, the Color Based on option

may be set to FITC and PE on the two plots to quickly compare the intensity of

expression of the FITC and PE-tagged probes within different tSNE

islands/continents.  

The Color Based on option is accessed via either:

· The . The Color Based on

dropdown menu will allow you to choose from Count or any available

parameter for the data set to display as the Density or Contour map on the

plot. 

216
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Figure 9.149 The Color based on option in the
formatting>overlays category of density plots allows you to
choose a parameter that will be used to display a density or
contour map on tSNE X and tSNE Y transformed parameters. 

· The Legend title , when the plot Legend is visible (via the dropdown menus

shown in the figures below).

For tSNE transformed data sets it is useful to display tSNE X and tSNE Y

parameters on the X- and Y-axes, respectively, and visualize each additional

target parameter as a Color Based on selection. In the examples below the

same tSNE transformation for an analysis is shown in three different display

types with each plot using the Color Based on parameter indicated in the

Legend of the plot. The top example shows Density plots with the Flame Color

Level, the middle example shows Contour plots with outliers enabled, while the
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bottom plot shows Density plots with the Green-Black-Red Color Level with a

Style of Mean +/- SD and Standard Deviations set to 2.00.

Using the Color by All Parameters  Multi plot tool in FCS Express will

autogenerate a grouped array of new plots with the same parameters as the

source plot (i.e., tSNE-X vs. -Y is recommended) when the source plot is a

Density or Contour plot. By setting the source plot to display tSNE-X and tSNE-Y

parameters, the resulting target plots will quickly visualize the heat mapping for

any number of selected parameters, so this is often the most efficient way to

see the results of a highly multiparametric dataset.  The parameter for Color

Based On can be shown in the plot Legend.

Note that there are a number of options in FCS Express that may be changed to

display tSNE-transformed data in unique ways and seemingly unlimited

combinations. The following list of formatting options may be useful for reviewing

and preparing data visualizations:

Please note that reducing Smoothing  to 0 or 1 on plot overlays or reducing the

Plot Resolution  may significantly enhance your plot visualizations, especially

for plots with a low or modest number of events. 

· Overlays  - To choose the Color Based On  parameter and to show or hide

outliers and outlier coloring. 

· Color Levels  - To choose the overall color scheme and color level properties

for Density and Contour Plots. 

· Specific Options  - To choose the resolution to display plots at and the select

Shade Based on Density  if desired. 
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Color Based on parameter indicated in the Legend text of each plot. Example
above shows Density plots with the Flame Color Level.
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Color Based on parameter indicated in the Legend text of each plot. Example
above shows Contour plots with outliers enabled.
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Color Based on parameter indicated inLegend text of each plot. Example above
shows Density plots with Green-Black-Red Color Level with a Style of Mean +/- SD

and Standard Deviations set to 2.00. 

Gates  may be created on any combination of standard or tSNE parameters on

any plot type to specifically select the events within one or more tSNE

islands/continents.  Gated populations may also be used to gate or backgate

events on any tSNE transformed plot. Once gated, histograms can be used for

the quick visualization of multiple parameters within a gated tSNE cluster using

the Parameter Overlays  feature.

An example of "tSNE island..." gates drawn on a tSNE X vs Y plot, and

subsequently backgated or applied to other plots, is shown below (Figure

9.156).
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Figure 9.150 Gates have been drawn on tSNE parameters (upper panel) and have
been displayed (lower left plot) or applied (lower central, right, and far-right plots)

to other plots.

An example of multiple parameters within the "tSNE island of unknown

phenotype" gate, visualized on a histogram using the Parameter Overlays

feature , can be seen below (Figure 9.157). 

Figure 9.151 Parameter Overlays have been added to the histogram (right plot) to
visualize multiple parameters across the Unknown gated tSNE island (left plot).

9.2.7.5 Saving tSNE results with an FCS File

In FCS Express Version 7.08 and above, newly calculated tSNE X and tSNE Y
parameters are saved within the layout.  Thus, upon re-opening a layout saved in
7.08 or above in which the tSNE transformation was already calculated, there is
no wait time required to see the tSNE-X vs -Y plot parameters again.

198
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In FCS Express Version 7.06 and below, newly calculated tSNE X and tSNE Y
parameters are not saved within the layout or data file but are instead calculated
automatically (or manually)  and applied to plots/files  each time the layout is
reopened. When working with large data sets or computationally intensive
transformations the team at De Novo Software strongly recommends resaving
the layout in version 7.08 or above, so that the issue of wait time for
recalculation is obviated.  If that is not an option, then you may save/export a
new .fcs file that contains the newly calculated tSNE-X and tSNE-Y parameters to
avoid the wait time for recalculation. 

Exporting/Saving the newly create tSNE X and Y Parameters as part of a new
.FCS file is accomplished by:

1.  Apply the tSNE transformation  of interest to a given plot.
2.  Click on the plot to select it. 
3.  Click on the Data tab Save/Load Export from the ribbon to launch the

Export Data dialog. 
4.  Select the additional tSNE X and tSNE Y parameters from the list of

Parameters to Export.
5.  Perform the export normally according to the full instructions at Exporting

FCS File Data from a Single File .

It is also recommend that the layout in which the transformation was created is
saved so you may review the settings used to create the tSNE transformation at
anytime in the future. 

9.2.8 SPADE

FCS Express can perform the Spanning-tree Progression Analysis of Density-
normalized Events (SPADE) algorithm.  The transformation allows for direct
analysis and visualization for highly multiparametric single-cell flow, image, and
mass cytometry data. 

The final result of the algorithm in FCS Express is a heat map in which the
positions of cells in related nodes are positioned within a hierarchical minimum
spanning tree. Heat maps can be modified easily for improved visualization of
populations while Gates  may be created to identify node(s) of interest.

SPADE was developed at Stanford University by members of the Plevritis and
Nolan laboratories.

More details on SPADE can be found in the following publications:

· Qiu, P., et al. Extracting a cellular hierarchy from high-dimensional cytometry

data with SPADE. Nat. Biotech. 29, 886-891 (2011).
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· Qiu, P. Inferring phenotypic properties from single-cell characteristics. PLoS

One. 5, Web (2012).

To begin working with SPADE in FCS Express, please see the topics on:
Defining SPADE
Working with SPADE

9.2.8.1 Defining a SPADE transformation

SPADE is performed in FCS Express through the Transformations navigator.

The steps below outline the process of creating a new SPADE transformation for

your data:

1.  Open the Transformation navigator by selecting the Tools tab 

 command (Figure 9.158, Step 1). The

Transformations navigator will open as in the figure below.

2.  Click on the drop down arrow adjacent to the blue plus  button (Figure

below, Step 2).

3.  Click on SPADE in the drop down list  (Figure below, Step 3). 
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Figure 9.152 Initial steps to create a SPADE transformation.

The SPADE dialog will now appear in the Transformation navigator as seen in

Figure 9.159.



FCS Express 7 Manual1032

© 2023 De Novo Software

Figure 9.153 The SPADE dialog in the Transformations navigator.
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The new SPADE transformation is named as New SPADE by default, but it can

be easily renamed by any of the following methods:

· Right click on the SPADE transformation that needs to be renamed select

Rename.

· Select the SPADE transformation that need to be renamed via left click and

press F2 on your keyboard.

· Select the SPADE transformation that need to be renamed via left click and

click on the  button in the Transformations tool bar.

1.  Choose a Template File  for the SPADE transformation by clicking on the

ellipsis to the right of the Template File text box (Figure 9.160).  

    The SPADE dialog will be populated with a list of available parameters to

perform SPADE based on available parameters from the template file (Figure

below).
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Figure 9.154 When a template file is selected, the possible parameters to
perform a SPADE transformation are automatically listed in the SPADE dialog.

2. Choose the parameters to be used in the SPADE transformation by checking

the boxes next to the parameter names (Figure 9.161, Point 1).

Parameters  can be filtered or sorted to assist in the selection of parameters

when multiple parameters are available in the template file.

3. Select or change to the appropriate Parameter Scaling Options for each of

the selected parameters if required (a scale of interest can be applied to All or

Checked parameters) (Figure below, Point 2).

Options can now be set to customize the transformation.
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Options Description

Gate Allows the user to run SPADE only on the events within a
specific gate.

Transformed
Data Options

The Display Name Suffix for a transformation can be
customized by the user by entering information into the
adjacent text box.  This modifies what is displayed on a plot
when the transformation is applied.

Sampling
Options

Although multiple Sampling Methods are available (please refer
to the Sampling Options  chapter for more details), the
default setting for a SPADE transformation are:

Downsampling Algorithm. Default setting is Target
Density.

Specify Density Percentiles. By default the option is
checked, and the user can define how the density-dependent
downsampling is performed by eentering Min Density and
Target Density values. If the box is unchecked, Sample Size
may be defined instead of these two values.

Alpha. Default value is 5.

Min Density. Values range from 0 to 1. Default value is 0.01.

Target Density. Values range from 0 to 1. Default value is
0.20.

Local Density method. Default setting is Exact.

Sample Size. Since Specify Density Percentiles is checked
by default, the Sample Size field is not available by default.
This option becomes available when the Specify Density
Percentiles check-box is unchecked, . If using this option, the
Min Density and Target Density will be automatically
estimated to select cells. If the specified Sample Size is higher
than the number of available events, SPADE will be run on all
available events. Note that the number of available events is
dictated by the Gate option. The minimum value that can be
entered is 10.

Number of
Clusters

Indicates the number of nodes for the SPADE tree. 

Min Percent of
Cells Per Cluster

Defines the minimum size, by percentage, of clusters and
should be a value between 0 and 100.

Maximum
Iterations

Sets the maximum number of iterations that FCS Express
should perform before quitting the clustering process.
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Number of
Clustering
Attempts

The number of the initial set of centroids that should be

tested.

Keep Non-
Converged Data

Allows the user to keep data that has not been converged.

Graph Layout
Method

Defines the layout style used for the SPADE tree. Possible

choices are Arch (default) or Radio. This option determines

the display  style used to plot the tree, it does not affect

results.

Change Random
Seed

The Random Seed is a number which is used by the random
number generator to generate the N random values which are
used as input data points for the SPADE calculation. The
random number generator will use the Random Seed value
and perform a series of math operations on it which result in N
random values. 

Since SPADE relies on k-Means clustering, which is a stochastic
algorithm, a seed can be set to make results reproducible over
the time when SPADE is applied to the same data. The seed
can be changed by either clicking on the Change Random
Seed button or by manually inserting a seed in the field.
In FCS Express, the default Random Seed is 6.

Output The available choices are Clustering Assignments and
Clustering Statistics. Please refer to the Defining a k-Means
cluster analysis  chapter for more details on Clustering
Statistics. 

Automatically
Calculate SPADE

By default SPADE is recalculated as soon as an option in the

SPADE dialog is changed. FCS Express allows the user to

disable the automatic calculation of SPADE and to manually

calculate SPADE only when required. To defer calculating the

SPADE algorithm, uncheck the box for Automatically

Calculate SPADE. Doing so will present you with the button

to Calculate SPADE, which can be pressed to calculate

SPADE on demand.

Please note that this option only regulates the auto-update

upon changes made within the SPADE dialog. If SPADE is

calculated on a gate and that gate is moved or resized, SPADE

will be automatically recalculated regardless this option. If you

want to avoid SPADE auto-updating upon gate

moving/resizing, please refer to the Live Updating Gate

chapter of this manual.

4. (Optional) Select a gate from the Gate drop down menu to only run SPADE

on the events within that gate (Figure below, Point 3).
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5.  (Optional) Modify the Display Name Suffix by entering information in the

adjacent text box (Figure below, Point 4).

6. (Optional) Select a Downsampling Method (Figure below, Point 5). Although

multiple Sampling Methods are available (please refer to the Sampling

Options  chapter for more details), the default Downsampling Method for

a SPADE transformation is Target Density (see above for more details and

default settings).

7.  Enter value for Number of Clusters (Figure below, Point 6). 

8. (Optional) Change the value for Min Percent of Cells Per Cluster (Figure

below, Point 7).

9. Enter value for Maximum Iterations (Figure below, Point 8).

10. (Optional) Change the value for Number of Clustering Attempts (Figure

below, Point 9).

11. (Optional) Select to Keep Non-Converged Data (Figure below, Point 10).

12.Select the Graph Layout Method to be used for the SPADE tree (Figure

below, Point 11). Possible choices are Arch (default) or Radio.

10. (Optional) Change the Random Seed used for SPADE calculation by either

clicking on the Change Random Seed button or by manually inserting a seed

in the field (Figure below, Point 12).
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Figure 9.155 Steps to complete the SPADE dialog.

The SPADE transformation has now been defined and will be automatically

calculated as soon as it will be applied to a heat map . In addition, SPADE will

be automatically recalculated as soon as an option in the SPADE dialog will be

modified.

Given that SPADE is a demanding algorithm that can take several seconds to be

calculate, FCS Express allows the user to disable the automatic calculation of

SPADE upon options changing and to manually calculate SPADE only when

required. To defer calculating the SPADE algorithm, uncheck the box for

Automatically Calculate SPADE. Doing so will present you with the button to

Calculate SPADE (Figure 9.162) which can be pressed to calculate on demand.

Please note that this option only regulates the auto update of SPADE upon

changes made within the SPADE dialog. If SPADE is calculated on a gate and that

gate is moved or resized, SPADE will be automatically recalculated regardless this

option. If you want to avoid SPADE auto update upon gate moving/resizing,

please refer to the Live Updating Gate  chapter of this manual.
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Figure 9.156 Unchecking the Automatically Calculate SPADE box will allow the user
to calculate SPADE manually only when required.

For visualization of the SPADE transformation, a Heat Map  may be inserted

and modified (Figure 9.163 below). Please also see the Working with SPADE

transformations  section for additional details on applying SPADE

transformations to plots. 
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Figure 9.157 Heat Map Displaying SPADE transformation.

9.2.8.2 Working with SPADE transformations

Once SPADE has been defined , it may be applied to empty Heat Maps  in
FCS Express. Please note when inserting a Heat Map  for non-multiwell plate
data, a warning message will appear (Figure 9.164). 
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Figure 9.158 Warning message when inserting a heat map for data sets not derived
from a plate based data file. 

Click Continue and proceed to apply the SPADE transformation by any of the
methods below:

· Drag and drop SPADE from the Transformation navigator on to the intended

plot (Figure 9.165). Note that the SPADE tree can only be displayed on Heat
Map plots. However, applying the SPADE transformation on 1D and/or 2D plots
is required for downstream analysis of SPADE results (e.g. back-gating of
SPADE nodes on 1D and 2D plots).
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Figure 9.159 Drag and drop SPADE from Transformations navigator to an empty
heat map. When the transformation has been applied the heat map will populate

with SPADE nodes.

· SPADE may be applied to individual or multiple plots by performing either option

outlined in red in the Transformations window below (Figure 9.166).

Figure 9.160  Commands to Apply
Transformation to Plot(s)

· Right-click the name of SPADE in the Transformations window and click Apply

to selected plot or Apply to all plots button in pop up menu (Figure 9.167).
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Figure 9.161  Commands to Apply
Transformation to Plot(s)

· Access the Overlays formatting dialog  and choose the SPADE transformation

to apply from the Transformation drop down list (Figure below). 
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The result of both methods will be a plot that denotes SPADE tree in the title,
outlined in red below (Figure 9.168).
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Figure 9.162 Heat Map with title appended with SPADE tree, outlined in red.

Once SPADE is applied to the Heat Map, the following actions can be performed
on the Heat Map:
· Modify the well size

· Have well size dependent on a statistic such as number of events in the

node
· Set the Parameter and Statistic for display

· Change the Color Level and Color Scheme

· Create gate(s) to identify node(s) of interest, and edit other features

9.2.8.3 Saving SPADE results with a DNS file

In FCS Express Version 7.08 and above, newly calculated SPADE clustering
parameter and SPADE tree are saved within the layout. Thus, upon re-opening a
layout saved in 7.08 or above in which the SPADE transformation was already
calculated, there is no wait time required to see the SPADE tree again.

In FCS Express Version 7.06 and below, results from a SPADE transformation
are not saved within the layout or data file but are instead calculated
automatically (or manually)  and applied to plots/files  when the layout is
reopened. When working with large data sets or computationally intensive
transformations the team at De Novo Software recommends saving/exporting
SPADE results in a new file so you may more easily work with the data set
without having to recalculate the SPADE transformation. SPADE result are not
compatible with the Flow Cytometry Standard (i.e. FCS) file format and need to
be saved as De Novo Software data Stream (i.e. DNS) file format.

Exporting/Saving SPADE results as part of a new .DNS file is easily accomplished
by:

1.  Apply the SPADE transformation  of interest to a given plot.
2.  Click on the plot to select it. 
3.  Click on the Data tab Save/Load Export from the ribbon to launch the

Export Data dialog. 
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4.  Select the additional SPADE Cluster ID parameter from the list of
Parameters to Export.

5.  Perform the export normally according to the full instructions at Exporting
FCS File Data from a Single File , being sure to select DNS data Stream
file as file type for the output file.

It is also recommend that the layout in which the transformation was create is
saved so you may review the settings used to create the SPADE transformation
at anytime in the future. 

9.2.9 Pipelines

Pipelines in FCS Express are a set of data processing steps that stand alone or
are connected in series.  The output of a step can be applied to a data file or
utilized as the input of the next step, or series of steps, that may be applied to
your data.

The vast majority of commonly used algorithms for data analysis are actually
pipelines, with tSNE (and its variants) and SPADE being two examples. However,
when those algorithms are implemented as a one calculation, user
customizations are limited to the what the specific implementation allows.
Pipelines in FCS Express increase the computational flexibility and granularity of
running algorithms and data transformations while giving users the unique ability
to create their own transformations.

As mentioned above, a pipeline is made of individual data processing steps with
each step performing a specific calculation/transformation.

Pipeline steps are grouped by functionality in FCS Express.  FCS Express supports
the pipeline steps outlined in the Pipeline Steps chapter table . New steps and
functionality are being developed all the time. Please contact
support@denovosoftware.com if there is a step or algorithm you would like to
see included. 

To begin working with Pipelines in FCS Express please see the following topics:
· Setting Up Pipelines

· Available pipelines steps and algorithms

9.2.9.1 Setting Up Pipelines

Pipelines are set up and run  in FCS Express through the Transformations
navigator.
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The steps below outline the process of creating a new Pipeline transformation

for your data:

1.  To start creating a Pipeline Transformation, the main Pipeline element must
be added from the Add a new transformation button in the
Transformation window (Figure 9.169).

Figure 9.163 The Add new transformation
button in the Transformation dialog.

The main Pipeline dialog window allows you to define the template file (a file from
your experiment that contains the same parameters as others that the pipeline
will be applied to), the input parameters for the pipeline based on the template
file, and the scale that should be applied to each of parameter in the template file
and downstream analysis. Any parameters that are not selected in the main
pipeline element, will not be accessible in subsequent pipeline steps. An input gate
for the pipeline transformation may also be defined in the main pipeline element
and will be applied to other downstream steps (Figure 9.170).
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Figure 9.164 The Pipeline main body dialog.

Main Pipeline Element Options (numbers refer to screen shot above):

1. Automatically Run
Pipeline

This check box allows users to set whether or not
the Pipeline Transformation should be automatically
run every time the main pipeline element or one of
the downstream step(s) is
added/remove/customized.

If this checkbox is checked and a step is added to the
pipeline, and the pipeline is actually applied to an
object in the layout, a message will open asking
whether or not to uncheck this checkbox before
adding the step.
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2. Gate Options This section of the Pipeline Transformation allows you
to choose a Gate for which events within the gate
will be used during the transformation.

3. Template File The Template File  for the pipeline transformation

may be chosen by clicking on the ellipsis to the right

of the Template File text box. Either a File or a Plot

can be used as template file. If data is already loaded

into your layout, the data file on the last selected plot

will automatically appear as the template file.

Selecting a Plot as Template is useful when

compensated parameters are appended to non-

compensated parameter (see the New

Compensated Parameters Should setting in the

Layout Options  and Compensation Options

section of the Compensation tool) so that both

compensated and non-compensated parameters will

be available in the pipeline.

Note: if you wish to define the pipeline

transformation on your entire data set (multiple data

files) rather than an individual data file, you can use a

merged data file with a File Identifier Column  as

the Template File. The transformation may then be

applied  to the merged data file, and events therein

may be related back to the original data files via the

File Identifier Column .
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4. Select parameters to

use in the

transformation

The pipeline transformation dialog will be populated

with a list of parameters based on available

parameters from the template file (or selected plot).

By default all parameters are selected so that all of

them will be available for selection in the further

steps. Parameters that are not selected in the main

pipeline element, will not be displayed in further

pipeline steps and will not be accessible on object

displaying the pipeline result.

Users may right-click in the parameter selection area

to select all parameters, de-select all parameters,

invert the selection, and sort the parameters.

Multiple contiguous parameters can also be selected

by holding Shift: select the first item, then click on

the checkbox for the last item while holding Shift. All

parameters in between will be selected.

5. Filter A filter field is available to help search for parameters
in your template file. When you begin to type in the
filter field, FCS Express will display parameters that
meet your criteria. Once you have selected your
parameter of interest, you may delete the text in the
filter field to reveal the full parameter list again.

6. Display Name Suffix Modify the suffix that will be displayed in the plot title

when the Pipeline Transformation is applied to a plot.

Once the main Pipeline element is created, the Add Step button (blue Plus icon in
the center of the Transformations dialog) is available and will allow you to add
individual pipeline steps  (Figure 9.171).1053
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Figure 9.165The create a new pipeline step drop-down menu.

An example of a Pipeline Transformation with two steps is depicted below. Each
step in a pipeline can be activated or deactivated by the check-box placed at the

left of the step itself (Figure 9.172). If an upstream step is deactivated, the
downstream step will not include the new parameters that would be defined by

the upstream step until it is reactivated.

 

Figure 9.166 A two-steps Pipeline
Transformation. At the left o each step, a
check-box allow to activate or deactivate

the step.

Pipeline steps may be arranged and re-arrange via dragging and dropping steps
into the desired positions (Figure 9.173).
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Figure 9.167 Pipeline steps can be
reordered by drag and drop.

Steps may also be grouped in folders via the Miscellaneous Steps Pipeline
Folder. Using folders allows you to create your own groups of individual steps
which increases the readability and the usability of the transformation dialog
(Figure 9.174).

To rename a Pipeline Folder, select the folder by left clicking on it and the do
either of the following:

· Click on the  button in the Transformation dialog;

· Press F2 on the keyboard;

· Right click on the folder and select Rename.

Figure 9.168 Pipeline steps can be
organized in fodler to increase the

readability and the usability of the pipeline.
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9.2.9.2 Pipeline Steps

The pipeline steps outlined in the table below are available in FCS Express. Please
click on a step link or category to jump to a description and information on the
variables accessible in the step. 

Pipeline Step Table of Contents:

Category Step

Pre-Defined
Algorithms

FlowAI

FlowCut

FlowSOM

Phenograph

SPADE

Downsampling

Gate Downsampling

Interval Downsampling

Mask Downsampling

Random Downsampling

Target Density Downsampling

Weighted Density Downsampling

Dimensionality
Reduction

PCA

tSNE

UMAP

Clustering Batch Self-Organizing Map

1055

1056

1059

1061

1063

1066

1068

1068

1070

1072

1075

1076

1079

1082

1082

1083

1086

1089 1089
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Category Step

Consensus Clustering

Hierarchical Clustering

Kmeans

Louvain Communities

Self-Organizing Map  

Visualization

Graph layout

Minimum Spanning Tree

tSNE Layout

UMAP Layout

Mathematical

0 to 1 Scaling

Normalization

Scaling

Simple Parameter Math

Thresholding

Quality Controls

Dynamic Range Downsampling

Flow Rate Check Downsampling

Low Time Density Downsampling

Signal Acquisition Downsampling

Random Parameters Random Parameters

Feature Extraction
Binned Variance Feature Extraction

Variance Feature Extraction

1096

1099

1102

1093

1105

1113

1113

1115

1116

1119

1122

1123

1124

1126

1129

1131

1142

1142

1145

1146

1148

1133 1133

1154

1154

1155
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Category Step

Miscellaneous

Classifications Folder

Folder

Jaccard Similarity Parameter

K-Nearest Neighbors Parameter

Merge to Spectra

Parameter Removal

Python Transformation

Ramp Parameter

Unmixing

Virtual bandpass

9.2.9.2.1  Pre-defined Algorithms

Pre-Defined Algorithms are a group/folder of pipeline steps which contain the
individual components for running an algorithm. For instance, you may choose
SPADE  or tSNE  as a standard transformation from the Add
Transformation  button, but if you would like to fine tune individual components
of the algorithm, or add additional pipeline steps of your own design, using a pre-
defined step will allow you additional flexibility and granularity. 

The table below describes the pre-defined Algorithm pipeline steps that are
available in FCS Express. If you would like to recommend additional Pre-Defined
Algorithms to be provided with FCS Express, please contact
support@denovosoftware.com. 

Algorith
m

Name

Description
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Algorith
m

Name

Description

FlowAI FlowAI allows the user to perform quality control on flow cytometry
data in order to improve both manual and automated downstream
analysis. 

The algorithm removes events with anomalous values by taking into
account three aspects of a flow cytometry data file:
1.  Flow rate
2.  Signal acquisition
3.  Dynamic range

In FCS Express, the FlowAI pre-defined algorithm step automatically
creates a Pipeline Folder  that includes the steps listed below,
allowing users to easily create a pipeline to run FlowAI on the selected
input parameters and/or population/gate selected in the main pipeline
body.

Important Notes:

1.  FlowAI (and more specifically the Signal Acquisition and the Dynamic
Range Downsampling steps) is intended to be run on Linearly scaled
data. If one or multiple Scaling steps  are present in the pipeline
upstream of the FlowAI step, please be sure to select linearly scaled
parameters (e.g. unscaled parameters) as input parameters for both
the Signal Acquisition Downsampling  and the Dynamic Range
Downsampling  steps.

2.  FlowAI (and more specifically the Signal Acquisition and the Dynamic
Range Downsampling steps) is intended to be run on non-
compensated data. By default, FCS Express applies the
compensation matrix associated with the data file (or the default
compensation) every time a file is loaded into the layout. By default,
FCS Express does not display the non-compensated parameters
since usually they are not of interest as plots can easily be displayed
with or without compensation as needed. Because FlowAI requires
non-compensated data parameters, the following steps should be
preformed ahead of using FlowAI:

i. Change the New Compensated Parameters Should setting in
the Layout Options  so that compensated parameters will be
appended to the data file as new parameters. That change will
allow both compensated and non-compensated parameters to
be accessible when a file is loaded.

1053
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Name

Description

ii. In the pipeline root step, use the Select Template from
Selected Plot option to select a template dataset from a plot
existing in the layout. That will allow both compensated and
non-compensated parameters to be accessible when the data is
used the pipeline.

iii. Be sure to select non-compensated parameters as input
parameters for both the Signal Acquisition Downsampling  and
the Dynamic Range Downsampling  steps.

3.  Non-compensated parameters can be removed  after the FlowAI
step if not needed in subsequent steps of the pipeline.

4.  Pipeline steps downstream from the FlowAI step can subsequently
use scaled  and/or compensated data.

For more details on the three specific quality controls performed by
FlowAI, please refer to the links below: 

· Flow Rate Check Downsampling

· Signal Acquisition Downsampling

· Dynamic Range Downsampling

For more details on the FlowAI algorithm in general, please refer to the
original publication (G. Monaco et al, flowAI: automatic and interactive
anomaly discerning tools for flow cytometry data, Bioinformatics,
Volume 32, Issue 16, 2016)

1053
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The images provided below are an example dataset cleaned with
FlowAI. All parameters (y-axis) have been plotted against Time (x-axis)
and events having anomalous values identified by FlowAI have been
highlighted in red. 
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In the bottom panel, a representative plot of the whole dataset has
been created using all events (i.e. before the FlowAI cleaning) alongside
a plot that displays remaining events after the FlowAI cleaning (Good
Events).

FlowCu
t
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FlowCut allows the user to perform quality control on flow cytometry
data in order to improve both manual and automated downstream
analysis. 

The FlowCut pre-defined algorithm is a four step process. First, a
Scaling step is run to scale the data, which is required for FlowCut to
proceed. Select all of the fluorescence parameters in this step of the
transformation and type in a suffix for the transformed parameters. To
perform the second step FlowCut removes acquisition regions with
fewer events and then cleans the remaining data based on multiple
quality control tests. To perform the third step, FlowCut separates
events along the time axis into equally sized segments (parameter
defaults to 500 events in FCS Express) and calculates if any of the
segments should be removed because they are statistically different
than the others. The fourth step (i.e. Parameter Removal), allows to
remove any unneeded parameters the data.

In FCS Express, the FlowCut pre-defined algorithm automatically
creates a Pipeline Folder  that includes the four steps above, allowing
users to easily run FlowCut on the desired input parameters and events.
· Scaling

· Low Time Density Downsampling

· Magic Number Downsampling

· Parameter Removal

1053
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FlowSO
M

FlowSOM is a clustering and visualization tool that facilitate the analysis
of high-dimensional data.
FlowSOM clusters the input dataset using a Self-Organizing Map
 allowing users to cluster large multi-dimensional data sets in a short
time. 

The resulting clusters are then presented to the user as a Minimum
Spanning Tree  in which each clusters (depicted as a node of the tree)
are connected to the closest (i.e. more similar in term of position in the
multidimensional space) cluster.

FlowSOM also performs a second clustering step (called meta-
clustering) in which clusters, not events, are clustered together based
on their similarity. Meta-clustering is a very useful step to group similar
clusters together and find meta-clusters which better represent the
biological populations in the dataset. The meta-clustering step is
performed by running the Consensus Clustering  pipeline step in FCS
Express.

For more details on FlowSOM algorithm, please refer to the original
article publish by Sofie Van Gassen and colleagues: FlowSOM: Using
Self-Organizing Maps for Visualization and Interpretation of Cytometry
Data; Sofie Van Gassen et al, Cytometry Part A, 2015. 

The FlowSOM pre-defined algorithm step automatically creates a
Pipeline Folder with the following steps listed below, allowing the user to
easily run FlowSOM on the selected input parameters and/or
population/gate selected in the main pipeline body and allowing
additional flexibility to create supporting pipeline steps as needed. Please
refer to the links below for additional information on each step.

1. Scaling  (this step might not be required, and can be
deselected/removed, if the input parameters from FLowSOM have
been scaled with another Scaling step upstream FlowSOM)

2. Batch Self-Organizing Map
3. Minimum Spanning Tree
4. Graph Layout
5. Consensus Clustering
6. Parameter Removal  (this is optional and is intended to remove

parameters that are not required downstream FlowSOM, making the
parameter list shorter and easier to handle)
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Below is an example of FlowSOM tree. Note the meta-clusters (6 in this
example) are depicted as colored halos around the nodes. Those
sharing the same color belong to the same meta-cluster.
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Once the FlowSOM tree is displayed, the Heat Map may be formatted
to:
· Modify the well size

· Have well size dependent on a statistic such as number of events in

the node
· Set the Parameter and Statistic for display

· Change the Color Level and Color Scheme

· Create gate(s) to identify node(s) of interest, and edit other

features

Phenog
raph

Phenograph is a clustering tool that facilitates the analysis of high-
dimensional data.
Phenograph first represents the high-dimensional data set with a graph
structure. In this representation, each cell is represented as a node
and is connected to its neighbors (i.e. the cells most similar to it) via an
edge whose weight is set by the similarity between cells. Dense regions
of cells will manifest as highly interconnected (i.e. high-density of edges)
modules in this graph.
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Once constructed, the graph is partitioned into subsets of densely
interconnected modules, called communities, which represent distinct
phenotypic subpopulations.

The Phenograph process is performed through the following steps:
· K-Nearest Neighbors Parameter .

· Jaccard Similarity Parameter

· Louvain Communities

For more details on the Phenograph algorithm, please refer to the
original publication (J. Levine et al, Data-Driven Phenotypic Dissection of
AML Reveals Progenitor-like Cells that Correlate with Prognosis, Cell,
2015 Jul 2;162(1):184-97. doi: 10.1016/j.cell.2015.05.047. Epub
2015 Jun 18)
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The output of Phenograph is a cluster assignment parameter called
"Louvain Communities" that may be plotted on Histograms, 2D plots
and Plate Heat Maps . We suggest using Plate Heat Maps, since they
allow users to utilize the following features and visualizations:

· Modify the well size

280
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· Have well size dependent on a statistic such as number of events in

the node
· Set the Parameter and Statistic for display

· Change the Color Level and Color Scheme

· Create Well gates  to select one or more clusters (i.e. wells) and

use those gates/clusters for downstream analysis.

SPADE The SPADE pre-defined algorithm step automatically creates a Pipeline
Folder with the following steps listed below, allowing users to easily
create a pipeline to run SPADE on the input parameters and the input
population, and allowing additional flexibility to create supporting pipeline
steps as needed.

Please refer to the links below for additional information on each step. 

1. Target Density Downsampling
2. Kmeans
3. Minimum Spanning Tree
4. Graph Layout
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Once the SPADE tree is displayed on an Heat Map, the following actions
can be performed on the Heat Map:
· Modify the well size

· Have well size dependent on a statistic such as number of events in

the node
· Set the Parameter and Statistic for display

· Change the Color Level and Color Scheme

325

288

285

322



FCS Express 7 Manual1068

© 2023 De Novo Software

Algorith
m

Name

Description

· Create Well gates  to select one or more clusters (i.e. wells) and

use those gates/clusters for downstream analysis.

For more details on SPADE algorithm, please refer to the SPADE
chapter .

9.2.9.2.2  Dow nsampling

The table below describes the Downsampling pipeline steps that are available in
FCS Express. If you would like to recommend additional Downsampling
methods to be provided with FCS Express, please contact
support@denovosoftware.com.

Downsampling

Step Description

Gate
Downs
amplin

g

This pipeline steps allow to downsample events using a gate of interest
as selection method. This is useful when the subsequent steps of the
pipeline should be only run on the events within a specific gate of
interest.

The How should the data be downsampled option allows two
choices:
o Downsampling Existing Parameters. No mask parameter is

created and only the downsampled events will be available
downstream this pipeline step.

o Create new mask parameters(s). One (or two; see below) new

parameter is created. The name and the nature of this parameter
can be customized with the How should the new parameter be
created option (see below).

The How should the new parameters be created option allows to:
o Define the Downsampling mask names prefix. This is defaulted to

Downsampling mask but can be edited. Editing this prefix is
especially useful to distinguish mask parameters generated by
different downsampling pipeline steps.

289
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o Define whether the new parameter should contain data saved as

Classification Values. When this option is used, sampled events will
be assigned with a "Include" value in that parameter while unsampled
events will be assigned with a "Exclude" value in that parameter. The
editable field at the right of this option allows to customize the suffix
to use for this parameter.

o Define whether the new parameter should contain data saved as

Numeric (Float) Values. When this option is used, sampled events
will be assigned with a "1" value in that parameter while unsampled
events will be assigned with a "0" value in that parameter. The
editable field at the right of this option allows to customize the suffix
to use for this parameter.

Note: when both the Save as Classification Values and the Save as
Numeric (Float) value options are used, two mask parameters will be
created. 

The Gate option allows to select the gate to use for this downsampling
step.
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Interva
l

Downs
amplin

g

Performs Interval Sampling on the input population.
Please refer to the Sampling Options  chapter of the manual for more
details on interval sampling.

The How should the data be downsampled option allows two
choices:
o Downsampling Existing Parameters. No mask parameter is

created and only the downsampled events will be available
downstream this pipeline step.

o Create new mask parameters(s). One (or two; see below) new

parameter is created. The name and the nature of this parameter
can be customized with the How should the new parameter be
created option (see below).

922
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The How should the new parameters be created option allows to:
o Define the Downsampling mask names prefix. This is defaulted to

Downsampling mask but can be edited. Editing this prefix is
especially useful to distinguish mask parameters generated by
different downsampling pipeline steps.

o Define whether the new parameter should contain data saved as

Classification Values. When this option is used, sampled events will
be assigned with a "Include" value in that parameter while unsampled
events will be assigned with a "Exclude" value in that parameter. The
editable field at the right of this option allows to customize the suffix
to use for this parameter.

o Define whether the new parameter should contain data saved as

Numeric (Float) Values. When this option is used, sampled events
will be assigned with a "1" value in that parameter while unsampled
events will be assigned with a "0" value in that parameter. The
editable field at the right of this option allows to customize the suffix
to use for this parameter.

Note: when both the Save as Classification Values and the Save as
Numeric (Float) value options are used, two mask parameters will be
created. 

The Sampling Size field allows to define how many events to sample.
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Mask
Downs
amplin

g

Mask downsampling allows users to remove events with a value of
zero. This is useful if any of the upstream pipeline step generates a
Downsampling mask and events with a value of zero in that mask have
to be removed at some point of the pipeline. This step performs
downsampling on the input population, using the parameters selected in
the Parameter Options list (e.g. a Downsampling Mask parameter by
upstream steps). Using the Filter: field a user can remove unwanted
parameters from view to simplify selection.  For example, if a user only
wanted to select area parameters typing "-A" in the field would reduce
the number of parameters seen in the parameter list. Parameters can
be selected individually by clicking on the boxes or by using the right click
menu. The right click menu gives the user the option to Select All,
Deselect All, or Invert Selection.  
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The How should the data be downsampled option allows two
choices:
o Downsampling Existing Parameters. No mask parameter is

created and only the downsampled events will be available
downstream this pipeline step.

o Create new mask parameters(s). One (or two; see below) new

parameter is created. The name and the nature of this parameter
can be customized with the How should the new parameter be
created option (see below).

The How should the new parameters be created option allows to:
o Define the Downsampling mask names prefix. This is defaulted to

Downsampling mask but can be edited. Editing this prefix is
especially useful to distinguish mask parameters generated by
different downsampling pipeline steps.

o Define whether the new parameter should contain data saved as

Classification Values. When this option is used, sampled events will
be assigned with a "Include" value in that parameter while unsampled
events will be assigned with a "Exclude" value in that parameter. The
editable field at the right of this option allows to customize the suffix
to use for this parameter.

o Define whether the new parameter should contain data saved as

Numeric (Float) Values. When this option is used, sampled events
will be assigned with a "1" value in that parameter while unsampled
events will be assigned with a "0" value in that parameter. The
editable field at the right of this option allows to customize the suffix
to use for this parameter.

Note: when both the Save as Classification Values and the Save as
Numeric (Float) value options are used, two mask parameters will be
created. 

The Mask Merging Style section of the dialog allows the user to choose
between the following options:
· Cell must be non-zero in ALL selected parameter. Any values that

are a zero for the selected parameters will be excluded and only non-
zero values will be kept. If a cell has at least one zero value among
the selected parameters, then that cell is removed.

· Cell must be non-zero in ANY of the selected parameter. If a cell

has a value of zero in all the selected parameters, than that cell is
removed. If a cell has at least one value which is not zero, than the
cell is kept.
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Rando
m

Downs
amplin

g

Performs Random Downsampling on the input population.
An internal seed is set so that when reopening the layout, the same
sampled events are selected.

The How should the data be downsampled option allows two
choices:
o Downsampling Existing Parameters. No mask parameter is

created and only the downsampled events will be available
downstream this pipeline step.

o Create new mask parameters(s). One (or two; see below) new

parameter is created. The name and the nature of this parameter
can be customized with the How should the new parameter be
created option (see below).

The How should the new parameters be created option allows to:
o Define the Downsampling mask names prefix. This is defaulted to

Downsampling mask but can be edited. Editing this prefix is
especially useful to distinguish mask parameters generated by
different downsampling pipeline steps.

o Define whether the new parameter should contain data saved as

Classification Values. When this option is used, sampled events will
be assigned with a "Include" value in that parameter while unsampled
events will be assigned with a "Exclude" value in that parameter. The
editable field at the right of this option allows to customize the suffix
to use for this parameter.

o Define whether the new parameter should contain data saved as

Numeric (Float) Values. When this option is used, sampled events
will be assigned with a "1" value in that parameter while unsampled
events will be assigned with a "0" value in that parameter. The
editable field at the right of this option allows to customize the suffix
to use for this parameter.

Note: when both the Save as Classification Values and the Save as
Numeric (Float) value options are used, two mask parameters will be
created. 

The Sampling Size field allows to define how many events to sample.
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Target
Density
Downs
amplin

g

Performs Density-Dependent Downsampling on the input population,
using the parameters selected in the Parameter Options list. Using the
Filter: field a user can remove unwanted parameters from view to
simplify selection.  For example, if a user only wanted to select area
parameters typing "-A" in the field would reduce the number of
parameters seen in the parameter list. Parameters can be selected
individually by clicking on the boxes or by using the right click menu.  The
right click menu gives the user the option to Select All, Deselect All, or
Invert Selection.

Please refer to the Target Density Downsampling  chapter of the
manual for more details on the following options:
Specify Density percentiles, Sample Size, Alpha, Min Density,
Target Density,  and Local Density Method.

924
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The How should the data be downsampled option allows two
choices:
o Downsampling Existing Parameters. No mask parameter is

created and only the downsampled events will be available
downstream this pipeline step.

o Create new mask parameters(s) One (or two; see below) new

parameter is created. The name and the nature of this parameter
can be customized with the How should the new parameter be
created option (see below).

The How should the new parameters be created option allows to:
o Define the Downsampling mask names prefix. This is defaulted to

Downsampling mask but can be edited. Editing this prefix is
especially useful to distinguish mask parameters generated by
different downsampling pipeline steps.

o Define whether the new parameter should contain data saved as

Classification Values. When this option is used, sampled events will
be assigned with a "Include" value in that parameter while unsampled
events will be assigned with a "Exclude" value in that parameter. The
editable field at the right of this option allows to customize the suffix
to use for this parameter.

o Define whether the new parameter should contain data saved as

Numeric (Float) Values. When this option is used, sampled events
will be assigned with a "1" value in that parameter while unsampled
events will be assigned with a "0" value in that parameter. The
editable field at the right of this option allows to customize the suffix
to use for this parameter.

Note: when both the Save as Classification Values and the Save as
Numeric (Float) value options are used, two mask parameters will be
created. 
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Weight
ed

Density
Downs
amplin

g

Performs Weighted Density Downsampling on the input population, using
the parameters selected in the Parameter Options list. Using the
Filter: field a user can remove unwanted parameters from view to
simplify selection.  For example, if a user only wanted to select area
parameters typing "-A" in the field would reduce the number of
parameters seen in the parameter list. Parameters can be selected
individually by clicking on the boxes or by using the right click menu.  The
right click menu gives the user the option to Select All, Deselect All, or
Invert Selection.

Please refer to the Weighted Sampling Options  chapter of the manual
for more details on the following options:
Specify Sample Size, Alpha, Weight, Local Density Method.
 

The How should the data be downsampled option allows two
choices:
o Downsampling Existing Parameters. No mask parameter is

created and only the downsampled events will be available
downstream this pipeline step.

o Create new mask parameters(s). One (or two; see below) new

parameter is created. The name and the nature of this parameter
can be customized with the How should the new parameter be
created option (see below).

The How should the new parameters be created option allows to:
o Define the Downsampling mask names prefix. This is defaulted to

Downsampling mask but can be edited. Editing this prefix is
especially useful to distinguish mask parameters generated by
different downsampling pipeline steps.

o Define whether the new parameter should contain data saved as

Classification Values. When this option is used, sampled events will
be assigned with a "Include" value in that parameter while unsampled
events will be assigned with a "Exclude" value in that parameter. The
editable field at the right of this option allows to customize the suffix
to use for this parameter.

o Define whether the new parameter should contain data saved as

Numeric (Float) Values. When this option is used, sampled events
will be assigned with a "1" value in that parameter while unsampled
events will be assigned with a "0" value in that parameter. The
editable field at the right of this option allows to customize the suffix
to use for this parameter.
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Note: when both the Save as Classification Values and the Save as
Numeric (Float) value options are used, two mask parameters will be
created.
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9.2.9.2.3  Dimensionality Reduction

The table below describes the Dimensionality Reduction pipeline steps that are
available in FCS Express. If you would like to recommend additional
Dimensionality Reduction methods to be provided with FCS Express, please
contact support@denovosoftware.com. 

Dimensionality Reduction

Step Description

PCA Calculates Principal Components of the input population, using the
parameters selected in the Parameter Options list. Using the Filter:
field a user can remove unwanted parameters from view to simplify
selection.  For example, if a user only wanted to select area parameters
typing "-A" in the field would reduce the number of parameters seen in
the parameter list. Parameters can be selected individually by clicking on
the boxes or by using the right click menu. The right click menu gives
the user the option to Select All, Deselect All, or Invert Selection.

The Number of Principal Components to display can be set in the
Number of Principal Components to keep field.

The Suffix for transformed parameters filed allows to specify a suffix
to add to all the parameters generated by this pipeline step. This is
useful when multiple steps of the same type (e.g. multiple PCA steps)
are present into the same pipeline.

mailto:support@denovosoftware.com
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tSNE Performs dimensionality reduction using the tSNE algorithm on the input
population, using the parameters selected in the Parameter Options
list (see image below). Using the Filter: field a user can remove
unwanted parameters from view to simplify selection.  For example, if a
user only wanted to select area parameters typing "-A" in the field
would reduce the number of parameters seen in the parameter list.
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Parameters can be selected individually by clicking on the boxes or by
using the right click menu.  The right click menu gives the user the
option to Select All, Deselect All, or Invert Selection.

The Suffix for transformed parameters filed allows to specify a suffix
to add to all the parameters generated by this pipeline step. This is
useful when multiple steps of the same type (e.g. multiple tSNE steps)
are present into the same pipeline.

For additional detail on the tSNE algorithm please refer to the tSNE
(viSNE)  chapter of the manual.1002
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The following settings may be customized:

· tSNE Method to Use

· Amount of Approximation (Applies Only to Barnes-Hut)

· Perplexity

· Number of Iterations

· Use Opt-SNE

· Generate New Random Seed

Please refer to the Defining a tSNE transformation  chapter for
additional details on tSNE settings. 

UMAP Performs dimensionality reduction using the UMAP (Uniform Manifold
Approximation and Projection) algorithm on the input population, using
the parameters selected in the Parameter Options list (see image
below). Using the Filter: field a user can remove unwanted parameters
from view to simplify selection.  For example, if a user only wanted to
select area parameters typing "-A" in the field would reduce the number
of parameters seen in the parameter list. Parameters can be selected
individually by clicking on the boxes or by using the right click menu. 
The right click menu gives the user the option to Select All, Deselect
All, or Invert Selection.  

The Suffix for transformed parameters filed allows to specify a suffix
to add to all the parameters generated by this pipeline step. This is
useful when multiple steps of the same type (e.g. multiple UMAP steps)
are present into the same pipeline.

UMAP is a dimensionality reduction technique that allows users to create
new UMAP X and UMAP Y parameters from a high-dimensional dataset.
The two main steps of UMAP are:
1. Creation of an high-dimensional graph. A weighted graph in which a

point is linked to its nearest neighbors. The amplitude of the
neighborhood is a crucial parameter and is dictated by the Number
of neighbors parameter (see below).

2. Creation of a low-dimensional (2 dimensional) graph as similar as
possible to the high-dimensional graph resulting in UMAP X vs UMAP Y
parameters. 

The following settings may be customized by the user:
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· Number of neighbors. Sets the number of approximate nearest

neighbors used to create the initial high-dimension graph. Number
of neighbors is a crucial parameter as low values will instruct the
UMAP algorithm to focus more on local structure by constraining
the number of neighboring points considered when analyzing the
data in high dimensions, while high values will instruct the UMAP
algorithm towards representing the overall structure while
sacrificing fine detail. Minimum input is 2 and maximum input is 50.

· Min Low Dim Distance. Sets the Minimum Distance between

points in the low-dimensional map (i.e. in the UMAP map). By
setting low values, points will be clustered closer together.
Minimum input is 0.00001 and maximum input is 2.

· Number of Iterations. The number of cycles that the UMAP

algorithm performs to refine the results. This is sometimes called
"Number of Epochs". Minimum number of iterations is 1 and
Maximum number of iterations is 10,000.

· Generate New Random Seed. The UMAP algorithm is stochastic.

To make it reproducible, a fixed Seed may be set. If the same
dataset and the setting are used, by retaining the same Random
Seed value, the same result will be achieved. UMAP may be run
multiple times with different Random Seeds to evaluate the
stability and the consistency of the population separations.
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For more details on UMAP algorithm, please refer to the following
resources:

· Leland McInnes et al. UMAP: Uniform Manifold Approximation and Projection
for Dimension Reduction. 2018 arXiv:1802.03426
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· Becht E. et al. Dimensionality reduction for visualizing single-cell data using
UMAP Nat Biotechnol. 2018;10.1038

· Andy Coenen, Adam Pearce. Understanding UMAP. https://pair-
code.github.io/understanding-umap/

9.2.9.2.4  Clustering

The table below describes the Clustering pipeline steps that are available in FCS
Express. If you would like to recommend additional Clustering methods to be
provided with FCS Express, please contact support@denovosoftware.com. 

Clustering

Step Description

Batch
Self-

Organiz
ing Map

The Batch Self-Organizing Map step performs Batch SOM clustering on
the input population, using parameters selected in the Parameter
Options list (see image below). The Input parameters for the SOM step
can be selected individually by clicking on the boxes or by using the right
click menu. The right click menu gives the user the option to Select All,
Deselect All, or Invert Selection. Using the Filter field a user can
remove unwanted parameters from the view to simplify selection.  For
example, if a user only wanted to select Area parameters typing "-A" in
the field would reduce the number of parameters seen in the parameter
list.

The output of the Batch SOM (Batch Self-Organizing Map) step is a list
of Cluster Assignment, which is an internal label indicating the SOM
node membership that is automatically assigned to each event. The
cluster assignment can be displayed by the user on 1D plots, 2D plots,
Plate Heatmap plots, and Data Grid.

The output parameter of the Batch SOM pipeline step can be used as
input parameter for the Minimum Spanning Tree  pipeline step.

Once the Batch SOM clustering is displayed on the Plate Heat Map, the
following actions can be performed on the Plate Heat Map:
· Modify the well size

· Have well size dependent on a statistic such as number of events in

the node
· Set the Parameter and Statistic for display

· Change the Color Level and Color Scheme
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· Create Well gates  to select one or more clusters (i.e. wells) and use

those gates/clusters for downstream analysis.

Some background on Batch Self-Organizing Map (i.e. Batch SOM)
can be found below.

Batch SOM is a variation of the original SOM algorithm (please refer to
the SOM section for more details on Self-Organizing Maps ) with the
following advantages:
· In the Batch SOM there is no Learning Rate function so the number of

required parameters is reduced.
· The Batch SOM algorithm converges faster than the stepwise

"gradient" method.

The main difference between the classical SOM and the Batch SOM is in
the way the 2D grid is trained. With classical SOM, the 2D Grid is trained
and updated one data point at a time (i.e. one data point at every
iteration), while in the Batch SOM, the 2D Grid is trained using the entire
dataset as a single iteration then updating the 2D Grid. With every
iteration, the Winner node (also called Best Matching Unit, or "BMU") is
calculated for every data point of the dataset, not just for a single
randomly-selected data point.

That means that in every iteration and for every node, the set of data
points that have that node as their BMU is known.
With the Neighborhood function (please refer to the SOM section for
more details ), the set of data points referring to each neighborhood
can also be defined (i.e. all the data points whose BMU is a node of the
neighborhood).
In the Weight Updating phase, the location of each SOM node in the high
dimensional space is updated so that each node moves towards the
center of all the points referring to its neighborhood. The location is
calculated as the cumulative contribution of each data points properly
weighted on the high dimensional location using the neighborhood
distance between the node of interest and their BMU.

The training of the 2D Grid is performed by repeating the procedure
above several times in two subsequent training phases.

The two training phases are:

1. Coarse training phase. During this phase, the neighborhood spread
decreases (see the Training Decay Function option below) from an
initial value to a final value. The number of cycle, and both the Initial
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and Final Neighborhood Spreads values for this phase, can be defined
by the user via the Coarse Training Options fields (see image
below). Note that by default the Initial and Final Neighborhood
Spreads values are automatically calculated.

2. Fine-Tune training phase. During this phase the neighborhood
spread decreases (see the Training Decay Function option below)
from an initial value to a final value. The initial value of the
neighborhood spread can not exceed the final value of the
neighborhood spread of the coarse phase (as a recommendation, the
default initial value of the neighborhood spread for this phase should
match the final value of the neighborhood spread of the coarse
phase). Also, the final value of the neighborhood spread in this phase
cannot be less then half of its initial value in this phase (as a
recommendation, the neighborhood spread value in this phase should
be held constant). The number of cycles, and both the Initial and Final
Neighborhood Spreads values for this phase, can be defined by the
user via the Fine-Tune Training Options fields (see image below).
Note that by default the Initial and Final Neighborhood Spreads values
are automatically calculated.
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The output of the Batch SOM step is a list of Cluster Assignment,
which is an internal label indicating the SOM node membership that is
automatically assigned to each event. The cluster assignment can be
displayed by the user on 1D plots, 2D plots, Plate Heat Map plots, and
Data Grid.

The high-dimensional locations of the nodes can be used as Input
parameter for the Minimum Spanning Tree pipeline step.

The name of the new parameter created by the Batch SOM algorithm
can also be customized by the user via the "New Parameter Name"
field.

The Batch SOM algorithm is stochastic. To make it reproducible, a fixed
Seed may be set. If the same dataset and the settings are used, by
retaining the same Random Seed value, the same result will be
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achieved. SOM may be run multiple times with different Random Seeds
to evaluate the stability and the consistency of the result.

Once the Batch SOM clustering is displayed on the Plate Heat Map, the
following actions can be performed on the Plate Heat Map:
· Modify the well size

· Have well size dependent on a statistic such as number of events in

the node
· Set the Parameter and Statistic for display

· Change the Color Level and Color Scheme

· Create Well gates  to select one or more clusters (i.e. wells) and use

those gates/clusters for downstream analysis. Meta-clusters may also

be automatically gated using Heat Map Well Gates

Louvai
n

Commu
nities

The Louvain method for community detection is a method to
extract communities from large networks created by Blondel et al. from
the University of Louvain in 2008.

The input dataset is represented by a weighted network of data points
(i.e. cells) in which each data point is connected with its closest neighbor
by a weighted edge. In this representation, communities (i.e.
phenotypically-similar cells), are expected to manifest as groups of
highly-interconnected nodes. In the Louvain method, communities are
indeed defined by maximizing the local modularity, which is a parameter
that measures the relative density of connections inside communities
with respect to connections outside communities.

The process is formally executed in 3 different steps:

1) Local move phase
Each node in the network is assigned to its own community. Then,
given a node i of the network, the change in modularity is
calculated for removing i from its own community and moving it
into the community of each neighbor j of i. Once all the neighbors j
have been tested, node i is moved to the community j that ensure
the largest increase in modularity. If none of the moves increases
modularity, node i is not moved to any community.
To speed up the calculation, the process described above is not
repeated for each node of the network, but just for a subset of
them. The list of revisited nodes is indeed “pruned” from the entire
network to a much smaller group of nodes that have a high
potential to actually swap communities. This approach is called
“Louvain pruning”.
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The Local move phase stops when it is no longer possible to
increase the local modularity by performing a node move. 

2) Aggregation phase
Each community found in Step 1 is grouped into one super-node
to create a weighted network of super-nodes.

3) Repeat
The process restarts, with Step 1 being run on the network of
super-nodes generated in Step 2. The entire process repeats until
no increase in local modularity is gained.

The Louvain algorithm is a greedy heuristic algorithm. Solving the
community assignments that maximize the overall modularity is
computationally infeasible. The Louvain method acknowledges this and
attempts to find the best "local solution". It does this by randomly
selecting a path through the network in Step 1 above. The random path
impacts the final results because each time a node moves, the local
modularity profile changes accordingly. This, in turn, influences the
neighbor's decision to merge. For this reason, the overall calculation
(Steps 1-2-3) can be executed more than once, with a different
random start each time. The number of time the whole process should
restart is defined by the user with the Random Restarts option (see
picture below). 5 restarts is usually a good value to try. The best results
are then chosen using the final modularity score. The community
assignments with the highest overall modularity score are selected.

To make the process reproducible, a fixed Seed may be set. If the same
dataset and the settings are used, by retaining the same Random Seed
value, the same result will be achieved. The Louvain Community pipeline
step may be run multiple times with different Random Seeds to
evaluate the stability and the consistency of the result.

Other notes to consider:
· Convergence of the Louvain algorithm is guaranteed. 

· The first iteration of the Louvain algorithm (i.e. the first time Steps 1

and 2 are executed) takes the majority of the execution time.
However, FCS Express vastly speeds up this part by using the
“Louvain pruning” technique.

· Even very large networks tend to converge in less than 10 overall

iterations. This is because the network “shrinks” with each iteration,
so there are fewer nodes to visit for moving.
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The output of the Louvain Community pipeline step is a new parameter
called Louvain Communities defining the community assignment for
each cell of the input dataset. The "Louvain Communities" parameter
can be plotted on Histograms, 2D plots and Plate Heat Map . We
suggest using Plate Heat Maps , since it allows the following actions:
· Modification of the well size

· Well size dependent on a statistic such as number of events in the

node
· Set the Parameter and Statistic for display

· Change the Color Level and Color Scheme

· Create Well gates  to select one or more clusters (i.e. wells) and use

those gates/clusters for downstream analysis.
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Consen
sus

Clusteri
ng

Performs Consensus Clustering, on the input population, using the
parameters selected in the Parameter Options list (see image below). 
Using the Filter: field a user can remove unwanted parameters from
view to simplify selection.  For example, if a user only wanted to select
area parameters typing "-A" in the field would reduce the number of
parameters seen in the parameter list. Parameters can be selected
individually by clicking on the boxes or by using the right click menu. 
The right click menu gives the user the option to Select All, Deselect
All, or Invert Selection.

Consensus clustering is a technique to find a single clustering result (i.e.
a consensus) when many clustering runs are performed.
Consensus clustering in FCS Express is performed with the Monti
method (Monti et al. Consensus Clustering: A Resampling-Based
Method for Class Discovery and Visualization of Gene Expression
Microarray Data. Machine Learning. 52. 91-118.
10.1023/A:1023949509487). Briefly, subsets of points are sampled
from the input dataset and clustering is performed on each subset. A
pairwise consensus matrix is then created to calculate the frequency
with which every pair of points are found in the same cluster. The
consensus matrix (M) can then be converted to be a
distance/dissimilarity matrix (1-M) and further used to perform a final
clustering step, which finally give the consensus clustering.

This clustering approach is quite computationally heavy, the highest
number of objects that can be clustered is set to 8000. So, the
Consensus Clustering step is suitable to cluster clusters generated by
other clustering steps (which number is usually lower than 8000). This
procedure is also called Meta-clustering.

The output of the Consensus Clustering step is a list of Cluster
Assignment, which is an internal label indicating the cluster membership
that is automatically assigned to each event. The cluster assignment can
be displayed by the user on 1D plots, 2D plots, Plate Heatmap plots,
and Data Grid.

The Cluster Assignment can be used as Input parameter for the
Minimum Spanning Tree  pipeline step.

When the input parameter is a cluster assignment (common occurrence
with this type of clustering; see comment above), the current clustering
steps performs a meta-clustering. In this case, the following options are
particularly useful:

1053
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· Add Meta-Clustering as New Parameter. By checking this check

box, the meta-cluster assignment generated by this clustering step
can be added as new parameter and thus be displayed on 1D plots,
2D plots, Plate Heatmap plots, and Data Grids.

· Add Meta-Clustering to Selected Parameter. By checking this

check box, the meta-cluster assignment generated by this clustering
step can be visualized as a colored border around nodes, when the
input parameter is displayed on a Heatmap plot.

The following settings may also be customized by the user:
· Number of Clusters. This defines the number of clusters which

should be found.
· Sampling Percentage. This defines the fraction of events sampled at

every repetition.
· Number of Samplings. This defines the number of repetition.

· New Parameter Name. The name of the new parameter (i.e. the

one containing the cluster assignment for each input data) can be
specified in this field.

· Clustering Algorithm. This option allows a user to define whether the

consensus clustering should be performed using k-Means or
Hierarchical clustering.

· Generate New Random Seed. Setting a Seed allows to ensure

reproducibility with algorithms that rely on random initialization.
Changing the Seed is a good way to evaluate the impact of
randomness on the clustering result.
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Once the Consensus clustering is displayed on the Heat Map, the
following actions can be performed on the Heat Map:
· Modify the well size

· Have well size dependent on a statistic such as number of events in

the node
· Set the Parameter and Statistic for display

· Change the Color Level and Color Scheme

· Create Well gates  to select one or more clusters (i.e. wells) and use

those gates/clusters for downstream analysis.

Hierarc
hical

Clusteri
ng

Performs Single-linkage agglomerative clustering, on the input
population, using the parameter(s) selected in the Parameter Options
list (see image below). Using the Filter: field a user can remove
unwanted parameters from view to simplify selection.  For example, if a
user only wanted to select area parameters typing "-A" in the field
would reduce the number of parameters seen in the parameter list. 
Parameters can be selected individually by clicking on the boxes or by
using the right click menu.  The right click menu gives the user the
option to Select All, Deselect All, or Invert Selection.

This clustering approach is quite computationally heavy, the highest
number of objects that can be clustered is set to 8000. So, the
Hierarchical Clustering step is suitable to further cluster clusters
generated by other clustering steps (which number is usually lower than
8000). This procedure is also called Meta-clustering.

The output of the Hierarchical Clustering step is a list of Cluster
Assignment, which is an internal label indicating the cluster membership
that is automatically assigned to each event. The cluster assignment can
be displayed by the user on 1D plots, 2D plots, Plate Heatmap plots,
and Data Grid.

The Cluster Assignment can be used as Input parameter for the
Minimum Spanning Tree  pipeline step.

When the input parameter is a cluster assignment (common occurrence
with this type of clustering), the current clustering steps perform a
meta-clustering. In this case, the following options are particularly
useful:

· Add Meta-Clustering as New Parameter. By checking this check

box, the meta-cluster assignment generated by this clustering step

325

288

285

322

289

1053



FCS Express 7 Manual1100

© 2023 De Novo Software

Clustering

can be added as new parameter and thus be displayed on 1D plots,
2D plots, Plate Heatmap plots, and Data Grids.

· Add Meta-Clustering to Selected Parameter. By checking this

check box, the meta-cluster assignment generated by this clustering
step can be visualized as a colored border around nodes, when the
input parameter is displayed on a Heatmap plot.

The following settings may also be customized by the user:

· Number of Clusters. Defines the number of clusters to attempt to

find.
· Linkage Method. Possible options for linkage are:

o Single. The distance between two clusters is defined by the

smallest distance between a point in the first cluster and a point
in the second clusters. Also referred to as the "nearest-
neighbor" method.

o Complete. The distance between two clusters is defined by the

larger distance between a point in the first cluster and a point in
the second clusters. Also referred to as the "furthest-neighbor"
method.

o Average. The distance between two clusters is defined by the

average distance between the points in the first cluster and the
points in the second cluster.

o Ward. The Ward method (also called minimum-variance

method) minimizes the within-cluster variance. Two clusters
are merged if the variance of the resulting cluster is the
smallest variance possible as compared to the variance
resulting from merging any other pair of clusters. The Ward
method aims at finding compact, spherical clusters.
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Once the Hierarchical clustering is displayed on the Heat Map, the
following actions can be performed on the Heat Map:
· Modify the well size

· Have well size dependent on a statistic such as number of events in

the node
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· Set the Parameter and Statistic for display

· Change the Color Level and Color Scheme

· Create Well gates  to select one or more clusters (i.e. wells) and use

those gates/clusters for downstream analysis.

Kmean
s

Performs Kmeans clustering, on the input population, using the
parameter(s) selected in the Parameter Options list (see image
below). Using the Filter: field a user can remove unwanted parameters
from view to simplify selection.  For example, if a user only wanted to
select area parameters typing "-A" in the field would reduce the number
of parameters seen in the parameter list. Parameters can be selected
individually by clicking on the boxes or by using the right click menu. 
The right click menu gives the user the option to Select All, Deselect
All, or Invert Selection.

The following settings may also be customized by the user (please refer
to the Defining a k-Means cluster analysis  chapter for more details):
· Number of Clusters

· Min percent Cells Per Cluster

· Maximum Iterations

· Number of Attempts

· Keep-Non-Converged Data

The output of the Kmeans step is a list of Cluster Assignment, which
is an internal label indicating the cluster membership that is automatically
assigned to each event. The cluster assignment can be displayed by the
user on 1D plots, 2D plots, Plate Heatmap plots, and Data Grid.
The Cluster Assignment can be used as Input parameter for the
Minimum Spanning Tree  pipeline step.

When the input parameter is a cluster assignment, the current
clustering steps perform a meta-clustering. In this case, the following
options are particularly useful:

· Add Meta-Clustering as New Parameter. By checking this check

box, the meta-cluster assignment generated by this clustering step
can be added as new parameter and thus be displayed on 1D plots,
2D plots, Plate Heatmap plots and Data Grid.

· Add Meta-Clustering to Selected Parameter. By checking this

check box, the meta-cluster assignment generated by this clustering
step can be visualized as a colored border around nodes, when the
input parameter is displayed on an Heatmap plot.
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Finally, the Kmeans algorithm is stochastic. To make it reproducible, a
fixed Seed may be set. If the same dataset and the setting are used, by
retaining the same Random Seed value, the same result will be
achieved. Kmeans may be run multiple times with different Random
Seeds to evaluate the stability and the consistency of the result.
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Once the k-Means clustering is displayed on the Heat Map, the following
actions can be performed on the Heat Map:
· Modify the well size 325
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· Have well size dependent on a statistic such as number of events in

the node
· Set the Parameter and Statistic for display

· Change the Color Level and Color Scheme

· Create Well gates  to select one or more clusters (i.e. wells) and use

those gates/clusters for downstream analysis.

Self-
Organiz
ing Map

This step performs SOM clustering on the input population, using the
parameters selected in the Parameter Options list (see image below).
The Input parameters for the SOM step can be selected individually by
clicking on the boxes or by using the right click menu. The right click
menu gives the user the option to Select All, Deselect All, or Invert
Selection. Using the Filter: field a user can remove unwanted
parameters from view to simplify selection.  For example, if a user only
wanted to select area parameters typing "-A" in the field would reduce
the number of parameters seen in the parameter list.

The output of the SOM (Self-Organizing Map) step is a list of Cluster
Assignment, which is an internal label indicating the SOM node
membership that is automatically assigned to each event. The cluster
assignment can be displayed by the user on 1D plots, 2D plots, Plate
Heatmap plots, and Data Grid.

The output parameter of the SOM pipeline step can be used as input
parameter for the Minimum Spanning Tree  pipeline step.

Once the SOM clustering is displayed on the Plate Heat Map, the
following actions can be performed on the Plate Heat Map:
· Modify the well size

· Have well size dependent on a statistic such as number of events in

the node
· Set the Parameter and Statistic for display

· Change the Color Level and Color Scheme

· Create Well gates  to select one or more clusters (i.e. wells) and use

those gates/clusters for downstream analysis.

Some background on Self-Organizing Map (i.e. SOM) can be found
below, together with a description of all the settings available in
FCS Express to customize the SOM calculations.  
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Self-Organizing Map (i.e. SOM) is a special class of artificial neural
networks first introduced by Teuvo Kohonen and is used extensively as
a clustering, dimensionality-reduction and visualization tool in
exploratory data analysis.
The input and the output data are defined in the same high-dimensional
space but the number of output data k (i.e. "nodes" or "neurons") is
smaller than the number of input data n. For the sake of simplicity,
output nodes can be thought of as centroids in the k-Means clustering
and much like k-Means, output nodes for SOM are generally randomly
initialized at the initialization of the SOM process.

One of the key points of SOM is that, output nodes also exist in a bi-
dimensional space to form a grid in which each node is connected to its
neighborhood nodes. The size of the grid is defined by the user (see the
Grid Width and the Grid Height options in the image below; the default
setting for a standalone SOM step is a 7x7 grid but when the SOM step
is added via the FlowSOM pre-defined algorithm , the default setting is
a 10x10 grid).

The basic steps of Kohonen’s SOM algorithm can be summarized by the
following iterative procedure:

1. Initialization. The location in the high-dimensional space

for each of the k output nodes is initialized by picking k

random points in high dimensional space. They can be k

random locations of the space, generally chosen in a small

‘ball’, or k random points from the input dataset (see the

Cluster Centroid Initialization Method in the table

below).

2. Sampling. Randomly select a point from the input dataset

to present to the SOM nodes.

3. Similarity Matching. Compute the Euclidean distances

between the selected point and each SOM node to find the

nearest node (i.e. the winner; also called Best Matching

Unit, or BMU). 

4. Weight Updating. The location of all SOM nodes in the

high dimensional space is updated so that nodes move

towards the point sampled in Step 2. Each node is updated

by a fraction of the current sample point. Said fraction is

calculated for each node by a Learning function, which is a

function of both the 2D distance to all other nodes and a

learning rate(see below). The Learning function is a
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decreasing function which decreases at every iteration t

(see Step 5).

5. Repeat Step 2, 3 and 4 until training is complete .

The Learning function in Step 4 above defines the amplitude of the

movement for each node of the 2D grid towards the sample point (i.e.

in other words defines how the 2D grid "learns" the shape of the

multidimensional dataset). A generalized formula for this function is the

following:

Learning = DistHD * α(t) *  h(t)

Where DistHD is the distance, calculated in the high-dimensional space,

between the sample point and the node, α(t) is the Learning Rate

function and h(t) is the Neighborhood function. Both the Learning

Rate and the Neighborhood Functions exist in the range 0 to 1 and are

decreasing functions (i.e. they both decrease at every iteration t). Since

the Neighborhood function is always equal to 1 for the winner node

(see below), the Learning Rate function can be viewed as the as the

fraction of the distance covered by the winner node towards the

sampled point. For every other nodes, the distance covered towards

the sampled points will be equal to, or shorter than that (because of the

further penalty caused by h(t), which is based on distance of the nodes

to the winner node).

Parameter Options

SOM will be run on the population selected in the main pipeline body,

using the parameter(s) selected in the Parameter Options list (see

image below). Parameters can be selected individually by clicking on

the boxes or by using the right click menu. The right click menu gives

the user the option to Select All, Deselect All, or Invert Selection.

Transformation Options

Add

Meta-

The option allows users to control how the clustering
information is accessed when the clustering is performed
as Meta-Clustering (i.e. when clusters, and not single cell
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g...

events, are clustered). Two (non-mutually exclusive)
options are available:

· Add Meta-Clustering as New Parameter. By

checking this check box, the meta-cluster assignment
generated by the clustering step will be added as new
parameters and thus be displayed on 1D plots, 2D
plots, Plate Heat Maps and Data Grids.

· Add Meta-Clustering to Selected Parameter. By

checking this check box, the meta-cluster assignment
generated by the clustering step can be visualized as a
colored border around nodes, when the input
parameter is displayed on an Plate Heat Map plot.

Meta-clusters may also be automatically gated using Heat
Map Well Gates . 

Training

Set Size

Defines how many events from the dataset will be
sampled and thus how many iterations will be run.
Possible choices are:

When Absolute is selected, the defined number of
sampling will be performed (default is 1000). An number
higher than the total number of input events can also be
set.

When Percent (default) is selected, the number of
samplings is defined as a percentage of the total number
of input events (default is 100 when SOM is inserted into
a pipeline as single step, while it’s 1000 when SOM is
inserted as part of the FlowSOM Pre-Defined Algorithm
step). Values higher than 100 are allowed. E.g. 1000
means that the number of sampling will be 10 times
higher than the number of total events in the input
dataset.

SOM 2D
Grid

Defines the size of the 2D grid (see description above).

Note: In FCS Express the 2D grid is always rectangular,
which means that every node has at most 4 direct
neighbors.

Learning
Rate

This user-defined parameter (also called α; alpha) is a
main parameter controlling the learning of SOM since it
scales the contribution of the new information. Practically,
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it can be viewed as the fraction of the distance covered
by the winner node towards the sampled point.

Learning rate ranges between 0 and 1, with both the
Initial and the Final value being defined by the user.

The Learning rate decreases with time (i.e. at every
iteration t) following on a Decay Function (see below).

Neighbor
hood
Spread

This user-defined parameter (also called σ; sigma)
defines the amplitude of the neighborhood around the
winner node in the 2D grid. The Neighborhood Spread is
one of the variables of the Neighborhood Function (see
below).

Both the initial and the final value can be defined by the
user via the Neighborhood Spread fields (see image
below) or automatically calculated by checking the
Automatic Neighborhood Spread check box. The

automatic calculation uses the 67th percentile as the
initial value of the Cumulative Distribution Function for the
entire set of fixed distances on the 2D map and 0 as Final
value. Distances can be calculated using either the
Euclidean or the Chebyshev method (see 2D Grid
Distance Metric below).

As with the Learning Rate, the neighborhood spread
also decreases with time (i.e. at every iteration t)
following on a Decay Function (see below).

New
Paramete
r Name

The name of the new parameter (i.e. the one containing
the cluster assignment for each input data) can be
specified in the field.

Cluster
centroid
initializati
on
Method

Defines how the centroid initialization occurs.

When Random is selected, centroids will be initialized
with random values between 0.1 and 1. The idea of this
approach is to let mapping evolve with the data.  

When Random Cells is selected, centroids will be
initialized with random points (i.e. cells) from the input
dataset.

Training
Decay
Function

Both the Learning Rate α and the Neighborhood Spread σ
values decrease with time following this function.

When Asymptotic is selected, both α and σ decrease
proportionally to 1/t, where t is the current iteration.
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When Linear is selected, both α and σ decrease
proportionally to t/T, where t is the current iteration and
T is the total number of Iterations that has to be
performed.

2D Grid
Neighbor
hood
Function

Allows to vary the learning for the different nodes of the
2D grid based on their distance to the winner node.
Ideally, the farther a node is from the winner, the less it
will learn. The farther a node is from the winner, the lower
will be the magnitude of the movement of that node
toward the sampled point.

The 2D Grid Neighborhood Function ( h(t) ) can be
either a Gaussian or Boxcar (also known as Bubble)
function.

When Gaussian is selected the following formula will be
used:

h(t) = exp (- Dist2D
2 / 2σ(t)2 )

Where Dist2D is the distance on the 2D grid between the

node and the winner node. σ(t) is the Neighborhood
Spread, which starts at the value defined in the Initial
Neighborhood Spread field (see above) and decreases
following a Decay Function (see below) until reaching
the value defined in the Final Neighborhood Spread
field.

By carefully looking at the above formula, the user can

see that, since Dist2D is 0 for the winner node, the value

for h(t) for the winner node is always 1.

When Boxcar is selected the following formula will be
used:

h(t)=1 when Dist2D 

h(t)=0 when Dist2D >σ(t)
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Where Dist2D is still the distance on the 2D grid between

the node and the winner node and σ(t) is the
Neighborhood Spread. When using Boxcar every node
within the neighborhood will move as the winner node
does. Every node outside the neighborhood will not
move.

2D Grid
Distance
Metric

Defines the metric used to calculate distances on the 2D
grid.

Provided that two horizontally-aligned adjacent nodes, or
two vertically-aligned adjacent nodes, are 1 unit apart,
the distance between a node and every other node can
be calculated as either the Euclidean or the Chebyshev
distance. With Euclidean distance every node has at most
4 direct neighbors, while with Chebyshev distance every
node (with rectangular 2D grid) has at most 8 direct
neighbors.

Generate
New
Random
Seed

The Random Seed is a number which is used by the
random number generator to generate the N random
values. The random number generator will use the
Random Seed value and perform a series of
mathematical operations on it which result in N random
values. 

Since SOM relies on a random initialization step to
initialize the nodes into the multi-dimensional space, a
seed can be set to make results reproducible over the
time when SOM is applied to the same data. The seed
can be changed by either clicking on the Change
Random Seed button or by manually inserting a seed in
the field.
In FCS Express, the default Random Seed is 6.
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The output of the SOM step is a list of Cluster Assignment, which is
an internal label indicating the SOM node membership that is
automatically assigned to each event. The cluster assignment can be
displayed by the user on 1D plots, 2D plots, Plate Heat Map plots, and
Data Grid.

The high-dimensional locations of the nodes can be used as Input
parameter for the Minimum Spanning Tree pipeline step.

The name of the new parameter created by the SOM algorithm can also
be customized by the user via the "New Parameter Name" field.

The SOM algorithm is stochastic. To make it reproducible, a fixed Seed
may be set. If the same dataset and the settings are used, by retaining
the same Random Seed value, the same result will be achieved. SOM
may be run multiple times with different Random Seeds to evaluate
the stability and the consistency of the result.

Once the SOM clustering is displayed on the Plate Heat Map, the
following actions can be performed on the Plate Heat Map:
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· Modify the well size

· Have well size dependent on a statistic such as number of events in

the node
· Set the Parameter and Statistic for display

· Change the Color Level and Color Scheme

· Create Well gates  to select one or more clusters (i.e. wells) and use

those gates/clusters for downstream analysis. Meta-clusters may also

be automatically gated using Heat Map Well Gates

9.2.9.2.5  Visualization

The table below describes the Visualization pipeline steps that are available in
FCS Express. If you would like to recommend additional Visualization methods
to be provided with FCS Express, please contact support@denovosoftware.com.
 

Visualization

Step Description

Graph
Layout

Graph Layout allows you to change the visualization of your Minimum
Spanning Tree  (MST) on a Heat Map plot  using a MST output as
input parameter.  Using the Filter: field a user can remove unwanted
parameter options from view to simplify selection.

325
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289

289

1053 280

mailto:support@denovosoftware.com


FCS Express 7 Manual1114

© 2023 De Novo Software

Visualization

 

Two different Graph Layout Methods can be selected: Arch (also
called "U-shape") or Radio.



Tools 1115

© 2023 De Novo Software

Visualization

Once the Graph is displayed on the Heat Map, the following actions can
be performed on the Heat Map:
· Modify the well size

· Have well size dependent on a statistic such as number of events in

the node
· Set the Parameter and Statistic for display

· Change the Color Level and Color Scheme

· Create gate(s) to identify node(s) of interest, and edit other

features

Minimu
m

Spanni
ng Tree

Creates a Minimum Spanning Tree (MST) using a Cluster
Assignment as the input parameter. The Cluster Assignment
parameter can be generated with any of the clustering steps
available.  Using the Filter: field a user can remove unwanted
parameter options from view to simplify selection. 
The MST step generates a new parameter that can be visualize on an
Heat Map plot .
For more details on MST, please refer to this page on Wikipedia. 

325

288

285

322

289

1053

280

https://en.wikipedia.org/wiki/Minimum_spanning_tree


FCS Express 7 Manual1116

© 2023 De Novo Software

Visualization

tSNE
Layout

tSNE Layout allows you to change the visualization of your clustering
parameter on a Heat Map plot  using either a clustering assignment or
a Minimum Spanning Tree  as input parameter. The tSNE Layout
organizes cluster nodes with on a tSNE map. tSNE coordinates for each
cluster are calculated based on the location of each cluster in the
multidimensional space.
Using the Filter: field a user can remove unwanted parameter options
from view to simplify selection.

280

1053
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Please refer to the tSNE pipeline step  for more details on the settings
available to tune the tSNE algorithm.

In the example pipeline below, a tSNE Layout pipeline step has been
used to map clusters generated by a Batch Self-Organizing Map
clustering step .

1083

1089
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In the Heatmap below, an example of clusters mapped with a tSNE
Layout is depicted.

UMAP
Layout

UMAP Layout allows you to change the visualization of your clustering
parameter on a Heat Map plot  using either a clustering assignment or
a Minimum Spanning Tree  as input parameter. The UMAP Layout
organizes cluster nodes with on a UMAP map. UMAP coordinates for
each cluster are calculated based on the location of each cluster in the
multidimensional space. 
Using the Filter: field a user can remove unwanted parameter options
from view to simplify selection.

280

1053
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Please refer to the UMAP pipeline step  for more details on the
settings available to tune the tSNE algorithm.

In the example pipeline below, a UMAP Layout pipeline step has been
used to map clusters generated by a Batch Self-Organizing Map
clustering step .

1086

1089
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In the Heatmap below, an example of clusters mapped with a UMAP
Layout is depicted.

9.2.9.2.6  Mathematical

The table below describes the Mathematical pipeline steps that are available in
FCS Express. If you would like to recommend additional Mathematical methods
to be provided with FCS Express, please contact support@denovosoftware.com.
 

mailto:support@denovosoftware.com


Tools 1123

© 2023 De Novo Software

Mathematical

Step Description

0 to 1
Scaling

The 0 to 1 Scaling step allows users to scale the minimum of the
selected parameter to 0 and the maximum to 1.
Scaling is performed for each input parameter on the population (gate)
selected in the main pipeline body, using the parameters selected in the
Parameter Options list. Parameters can be selected individually by
clicking on the boxes or by using the right click menu.  The right click
menu gives the user the option to Select All, Deselect All, or Invert
Selection. Using the Filter: field a user can remove unwanted
parameters from view to simplify selection.  For example, if a user only
wanted to select area parameters typing "-A" in the field would reduce
the number of parameters seen in the parameter list.

Specifically, for each of the selected input parameters, the minimum is
subtracted from all the input events and the resulting values are then
divided by the maximum of that parameters.

For each of the input parameters, this step generates a new parameter
containing the scaled values. The new parameter is labeled with the 0 to
1 Scaled suffix.
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Normali
zation

The Normalization step allows users to normalize the selected input
parameters by dividing single-cell (event by event) values by:
· Standard Deviation

· Root Mean Square

· None

In addition, the Mean can also be subtracted so that data are centered
on zero. When this option is selected, the Mean is firstly subtracted by
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each values and then, if defined by the user, the division mentioned
above is performed on centered values.

The Standard Deviation, Root Mean Square, and Mean are calculated
independently for the population (gate) selected in the main pipeline
body, using the parameters selected in the Parameter Options list.
Parameters can be selected individually by clicking on the boxes or by
using the right click menu. The right click menu gives the user the option
to Select All, Deselect All, or Invert Selection. Using the Filter: field
a user can remove unwanted parameters from view to simplify
selection.  For example, if a user only wanted to select area parameters
typing "-A" in the field would reduce the number of parameters seen in
the parameter list.

For each of the input parameters, this step generates a new parameter
containing the normalized values. The new parameter is labeled with the
Normalized suffix.
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Scaling The Scaling step allows users to scale the selected input parameters  in
the Parameter Options list with any of the scales  available in FCS
Express. Parameters can be selected individually by clicking on the
boxes or by using the right click menu.  The right click menu gives the
user the option to Select All, Deselect All, or Invert Selection. Using
the Filter: field a user can remove unwanted parameters from view to

346
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simplify selection.  For example, if a user only wanted to select area
parameters typing "-A" in the field would reduce the number of
parameters seen in the parameter list.

This is useful when the downstream steps of the pipeline benefit from
input parameters to be scaled with a specific scale.

If the Automatic check box is selected, the Instrument Specific
Settings defined in the User Options will be used.
If the Automatic check box is unchecked, a scale from the available
scales  in FCS Express can be selected. The scale will be applied to all
the selected parameters.

For each of the input parameters, this step generates a new parameter
containing the scaled values. The new parameter is labeled with the
scaled suffix.

346
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Simple
Param
eter
Math

The Simple Parameter Math step is a simplified version of the
Parameter Math  transformation and is intended to perform
operations on parameter derived values (and/or on constants values)
at the single-cell (event by event) level.

926
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The two Operand drop-down menus allow users to select any of the
input parameter defined in the main pipeline step. Alternatively, the
Operands may also be constant values by selecting the constant value
radio buttons.

Allowed operations are sum, subtraction, multiplication and division(+, -,
* and / respectively).

The pipeline step generates a new parameter for which the name can be
specified in the New parameter name field with all the single-cell result
of the defined calculation.
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*Note: This Simple Parameter Math pipeline step can not use
customized equations.  Customized equations can be used in
Parameter Math transformations.  Please see Defining Parameter
Math  for step by step instructions on creating a custom formula.

Thresh
olding

The Thresholding step allows users to replace values above a defined
maximum threshold with a custom value and/or replace values below a
defined minimum threshold with a custom value. Parameters can be
selected individually by clicking on the boxes or by using the right click
menu.  The right click menu gives the user the option to Select All,
Deselect All, or Invert Selection. Using the Filter: field a user can
remove unwanted parameters from view to simplify selection.  For
example, if a user only wanted to select area parameters typing "-A" in
the field would reduce the number of parameters seen in the parameter
list.

The Max/Min thresholds values are defined with the Maximum Allowed
Value and the Minimum Allowed Value fields. Values above the
former and below the latter will be replaced with the values defined in
the Replacement Higher/lower Values with respectively.

* Note: when defining a threshold, please consider that input values
may have been scaled either in the main pipeline body and/or in a
previous Scaling step. This means that a raw values of 1,000,001
scaled with Log scale, will require a threshold of 6 (i.e. 10^6 =
1,000,000) to be entered.

926
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9.2.9.2.7  Random Parameters

The table below describes the Random Parameters pipeline steps that are
available in FCS Express. If you would like to recommend additional Random
Parameters methods to be provided with FCS Express, please contact
support@denovosoftware.com.

Each Random Parameters pipeline step generate random values based on the
corresponding distribution. The number of random values generated matches the
number of input events.

These allow the user to define distribution-specific coefficients. For example, the
Normal Distribution (see below ) can be customized for both the Mean and
the Standard Deviation.

Each Random Parameters pipeline step is also provided with a Seed field that
allows the user to change change the seed and thus the output.

The list of Random Parameters available in FCS Express 7 may be found below
with full details in Description column of the main table:

o B

Bernoulli
Distribution
Beta
Distribution
Binomial
Distribution

o C

Cauchy
Distribution
Chi-square
Distribution

o E

Erlang
Distribution
Exponential
Distribution

o G

Gamma
Distribution
Generalized
Pareto
Distribution
Geometric
Distribution
Gumbel
Distribution

o H

Hypergeomet
ric
Distribution

o L

Laplace
Distribution
Logistic
Distribution
Log-Normal
Distribution

o M

Maxwell-
Boltzmann
Distribution

o N

Negative
Binomial 
Distribution
Normal
Distribution

o P

Poisson
Distribution

o R

Rayleigh
Distribution

o S

Snedecor's
Distribution
Student's t
Distribution

o T

Triangular
Distribution

o U

Uniform
Distribution

o W

Weibull
Distribution

1139

1134 1135 1135 1136

1137 1138 1139 1139

1140 1140 1140 1141

1141

1142

mailto:support@denovosoftware.com
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Step Description

Bernoulli Distribution

Beta Distribution

Binomial Distribution
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Cauchy Distribution

Chi-square Distribution

Erlang Distribution
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Exponential Distribution

Gamma Distribution

Generalized Pareto
Distribution
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Geometric Distribution

Gumbel Distribution

Hypergeometric
Distribution
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Laplace Distribution

Logistic Distribution

Log-Normal Distribution
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Maxwell-Boltzmann
Distribution

Negative Binomial 
Distribution

Normal Distribution
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Poisson Distribution

Rayleigh Distribution

Snedecor's Distribution
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Student's t Distribution

Triangular Distribution

Uniform Distribution
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Weibull Distribution

9.2.9.2.8  Quality Controls

The table below describes the Quality Controls pipeline steps that are available
in FCS Express. If you would like to recommend additional Quality Controls
methods to be provided with FCS Express, please contact
support@denovosoftware.com.

Quality Controls

Step Description

Dynami

mailto:support@denovosoftware.com
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c
Range
Downs
amplin

g

Dynamic Range Downsampling allows users to remove events that
are equal to, or higher than, the defined upper limit, and/or to remove
events that are equal to, or lower than, the defined lower limit.

Downsampling is performed parameter-by-parameter among the
selected input parameters, on the population selected in the main
pipeline body. Parameters can be selected individually by clicking on the
boxes or by using the right click menu.  The right click menu gives the
user the option to Select All, Deselect All, or Invert Selection. Using
the Filter: field a user can remove unwanted parameters from view to
simplify selection.  For example, if a user only wanted to select area
parameters typing "-A" in the field would reduce the number of
parameters seen in the parameter list.

Note: The Dynamic Range Downsampling method is used by the
FlowAI pre-defined step  to perform the "Dynamic Range check".
When the step is run independently from the FlowAI algorithm, the
Dynamic Range Downsampling step should be run on Linearly-scaled
non-compensated data (please see the FlowAI pre-defined step
section for further details on how to use Linearly-scaled non-
compensated data as input data).

The following options are available:
· Use PnR for Upper Limit: When checked, the range (i.e. the $PnR

keyword) of the selected parameter(s) will be used as the upper limit.
When unchecked, an Upper Limit field becomes active and allows a
user defined upper range. 

· Use Z-Score for Lower Limit: When checked, the Lower Limit will be

set to be the Z-Score method published in the original FlowAI paper
(please see the FlowAI pre-defined step  for more details and the
bibliographic reference). When unchecked, a Lower Limit field
becomes active and allows a user defined the lower range. 

A new parameter, called by default "Downsampling Mask", can also be
created by selecting the Create mask parameter radio button in the
Downsampling Action section of the dialog.
If a mask parameter is created, sampled events will be assigned with a
"1" value in that parameter while unsampled events will be assigned
with a "0" value in that parameter. When no mask parameter is
created, only the downsampled events will be available as result of the
transformation.

The name of the downsampling mask parameter can be customized in
the Downsampling mask name field.

1056

1056

1056
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Flow
Rate
Check
Downs
amplin

g

With the Flow Rate Check Downsampling step the steadiness of the
flow (i.e. the number of events acquired per unit of time) can be
checked. The flow rate is reconstructed using the Time parameter and
the $TIMESTEP keyword from the data file (which is contained in all
standard FCS file with version 3.0 or higher). If the $TIMESTEP keyword
is not available, a default timestep of 1/10 second will be used to
recreate the flow rate. An anomaly detection algorithm (built upon the
generalized Extreme Studentized Deviate (ESD) test) detects and
removes the data acquired during flow rate surges and shifts from the
median value.

The algorithm is run parameter-by-parameter on the population
selected in the main pipeline body.

The Flow Rate Check Downsampling algorithms integrated in FCS
Express is based on the Flow Rate Check algorithm reported in the
original FlowAI paper (G. Monaco et al, flowAI: automatic and
interactive anomaly discerning tools for flow cytometry data,
Bioinformatics, Volume 32, Issue 16, 2016) and is indeed used by the
FlowAI pre-defined step  to perform the Flow Rate Check.

The algorithms allows two inputs from the user:
· Alpha: The the level of statistical significance used to accept

anomalies detected by the ESD method. The default value is 0.01. The
highest accepted value is 0.1.

· Max % of values that may be flagged as outliers: The highest

percentage of events allowed to be flagged as outliers. The highest
accepted value is 49.99%.

A new parameter, called by default "Downsampling Mask", can also be
created by selecting the Create mask parameter radio button in the
Downsampling Action section of the dialog.
If a mask parameter is created, sampled events will be assigned with a
"1" value in that parameter while unsampled events will be assigned
with a "0" value in that parameter. When no mask parameter is
created, only the downsampled events will be available as result of the
transformation.

The name of the downsampling mask parameter can be customized in
the Downsampling mask name field.

1056
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Downs
amplin

g

The Low Time Density Downsampling step checks the steadiness of
the flow rate (i.e. the number of events acquired per unit of time).
The Low Time Density Downsampling first reconstructs the flow rate
using a kernel density estimation function that calculate the events
density along the time.
The highest density (i.e. the peak) is then calculated and events with a
density lower than the threshold specified by the user are removed. The
threshold is defined using the "Ratio of peak density value to cut off
density value" field. The default value is 0.1, which means that events
with a density lower than, or equal to, peak*0.1 (i.e. 10% of the peak)
will be removed.

When the peak value is very high because of a spike in the Time
channel, most of the events would be removed. To avoid this, when a
spike in the Time channel is detected, the Low Time Density
Downsampling does not remove any events.
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A new parameter, named "Downsampling Mask", may also be created
by selecting the Create mask parameter radio button in the
Downsampling Action section of the dialog.
If a mask parameter is created, sampled events will be assigned with a
"1" value in that parameter while unsampled events will be assigned
with a "0" value in that parameter. When no mask parameter is
created, only the downsampled events will be available as result of the
transformation.

The name of the downsampling mask parameter can be customized in
the Downsampling mask name field.

The Low Time Density Downsampling step integrated in FCS Express
is based on the removeLowDensSections algorithm used in flowCut
(J. Meskas et al, flowCut: An R package for precise and accurate
automated removal of outlier events and flagging of files based on time
versus fluorescence analysis, bioRxiv, doi:
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https://doi.org/10.1101/2020.04.23.058545) and is also used by the
FlowCut pre-defined step .

Signal
Acquisi

tion
Downs
amplin

g

Provided that the signal intensity of a given population (i.e. median and
variance of intensity) should be constant during acquisition in the vast
majority of flow cytometry experiments (kinetics experiments are an
exception to the rule), changes in the median and/or in the variance of
the signal are usually indicators of issues with fluidics or other problems
when acquiring data. Parameters can be selected individually by clicking
on the boxes or by using the right click menu.  The right click menu
gives the user the option to Select All, Deselect All, or Invert
Selection. Using the Filter: field a user can remove unwanted
parameters from view to simplify selection.  For example, if a user only
wanted to select area parameters typing "-A" in the field would reduce
the number of parameters seen in the parameter list.

Note: The Signal Acquisition Downsampling method is used by the
FlowAI pre-defined step  to perform the "Signal Acquisition check".
When the step is run independently from the FlowAI algorithm, the
Signal Acquisition Downsampling step should be run on Linearly-
scaled on-compensated data (please see the FlowAI pre-defined step
section for further details on how to use Linearly-scaled non-
compensated data as input data).

When using Signal Acquisition Downsampling, the median and the
variance of the signal of equally-sized bins of events acquired
sequentially are calculated parameter-by-parameter on the population
selected in the main pipeline body. The number of sequentially events in
each bin is defined by the variables entered by the user (see below).

The Signal Acquisition Downsampling algorithm detects shifts in the
median and/or in the variance of the fluorescence intensity between bins
in each of the input parameters by using the Binary Segmentation
algorithm of the changepoint R package.

The algorithm allows users to customize the following options:
· Penalty Value: The value of the penalty for the changepoint

detection algorithm. The higher the penalty value the less strict is the
detection of the anomalies. The default is 500.

· Number of Events in Each Bin: The value defines the size of each

bin, i.e. the number of sequential events that each bin should contain.

1059

1056

1056
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· Max Number of Change Points: The maximum number of

changepoints (i.e. changes in the median and or in the variance
intensify) that can be detected for each channel. The default is 3.

· Min Number of Contiguous Bins: The minimum segment length (i.e.

the number of bins between changes). The default is the minimum
allowed by theory, i.e. 2.

A new parameter, called by default "Downsampling Mask", can also be
created by selecting the Create mask parameter radio button in the
Downsampling Action section of the dialog.
If a mask parameter is created, sampled events will be assigned with a
"1" value in that parameter while unsampled events will be assigned
with a "0" value in that parameter. When no mask parameter is
created, only the downsampled events will be available as result of the
transformation.

The name of the downsampling mask parameter can be customized in
the Downsampling mask name field.
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r
Downs
amplin

g

The Magic Number Downsampling pipeline step allows the user to
perform quality control on flow cytometry data in order to improve both
manual and automated downstream analysis. The quality control is
performed by default on all of the selected input parameters (please see
the Use only worst channels option for variation on this behavior).
Parameters can be selected individually by clicking on the boxes or by
using the right click menu.  The right click menu gives the user the
option to Select All, Deselect All, or Invert Selection. By using the
Filter field, a user may remove unwanted parameters from the list to
simplify selection.  For example, if a user only wanted to select area
parameters typing "-A" in the field would reduce the number of
parameters seen in the parameter list.

The Magic Number Downsampling pipeline step separates events along
the time axis into equally sized segments (the minimum number of
segments is 3; the number of events in each segment is defaulted to
500 but can be customized through the Segment size field; see
below) and calculates if any of the segments should be removed
because they are statistically different than the others.

The cleaning is performed only when any of the below thresholds are
reached:

1. MaxOfMeans: The maximum range of the means of each
segment over all channels. For each channel, the 2nd and 98th
percentile intensities are calculated. After calculating the mean
intensity for every segment, the difference between the maximum
and the minimum segment means in that channel is calculated.
This is the maximum intensity drift in that channel. If this drift is
larger than 15% of the difference between the 2nd and the 98th
percentile intensity in that channel (i.e the MaxOfMeans
threshold), then the file has to be cleaned. The MaxOfMeans value
is hard-coded to 0.15 to mimic the original FlowCut algorithm.

2. MeanOfMeans: The average range of the means of each
segment over all channels. The maximum intensity drift is
calculated for all channels and then averaged. If the average is
larger than then the MeanOfMeans threshold, then the file needs
cleaning. The MeanOfMeans value is hard-coded to 0.13 to mimic
the original FlowCut algorithm.

MeanOfMeans and MaxOfMeans thresholds essentially set a
restriction for a tolerable mean drift.
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3. MaxContin: The changes of the means between adjacent
segments in each channel. The parameter help locate abrupt mean
changes such as spikes. If adjacent segments have differences in
their means that exceed MaxContin, then the file will undergo
cleaning. The MaxContin value is hard-coded to 0.1 to mimic the
original FlowCut algorithm.

If any of the above quality controls are not passed, the dataset
undergoes the cleaning procedure as follows:

Eight measures of each segment (mean, median, 5th, 20th, 80th and
95th percentile, second moment (variance) and third moment
(skewness)) are calculated. For each segment, all said measurements
are summed all together for all channels resulting in each segment being
represented by only one statistical number (i.e. the sum of all
measurements in all channels). The density of summed measures
distribution is then calculated. The distribution, accompanied with two
hard-coded parameters (MaxValleyHgt and MaxPercCut), will
determine which segments are significantly different from the other
segments. The segments that are significantly different will have all of
their events removed.

The Magic Number Downsampling pipeline step runs by default on all
selected input parameters. However, sometimes abnormal behaviors
are only present in a few channels. The outlier events in these channels
can be washed out when taking into consideration all measures in all
channels. As a result, outliers in these channels are not properly
removed. In these cases, FCS Express can use the Use only worst
channels option to only focus on these specific channels.

A limit to the number of removed events can be set through the Max
% of events that may be marked as outliers setting.

A new parameter, called by default "Downsampling Mask", may also
be created by selecting the Create mask parameter radio button in
the Downsampling Action section of the dialog.
If a mask parameter is created, sampled events will be assigned with a
"1" value in that parameter while unsampled events will be assigned
with a "0" value in that parameter. When no mask parameter is
created, only the downsampled events will be available as result of the
transformation.

The name of the downsampling mask parameter may be customized in
the Downsampling mask name field.
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9.2.9.2.9  Feature Extraction

The table below describes the Feature Extraction pipeline steps that are
available in FCS Express. If you would like to recommend additional Feature
Extraction methods to be provided with FCS Express, please contact
support@denovosoftware.com.

Feature Extraction

Step Description

Binned
Variance
Feature
Extracti

on

The Binned Variance Feature Extraction step outputs the best
features (parameters) from the list of selected parameters.  This
enables identification of the most valuable parameters.  Briefly, this step
is similar to the Variance Feature Extraction step, except that data is
binned in terms of frequency (same number of features in each bin) or
equal width (all bins are the same size, but may have different numbers
of features), the Bins are ranked by variance-to-mean ratio, and then
the bins with the highest ratios are selected.  A hybrid Seurat algorithm
is employed;  to learn more, see Tools for Single Cell Genomics •
Seurat (satijalab.org), which is a modified implementation of Find
variable features — FindVariableFeatures • Seurat (satijalab.org). 

mailto:support@denovosoftware.com
https://satijalab.org/seurat/index.html
https://satijalab.org/seurat/index.html
https://satijalab.org/seurat/reference/findvariablefeatures
https://satijalab.org/seurat/reference/findvariablefeatures
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Variance
Feature
Extracti

on

The Variance Feature Extraction step outputs the best features
(parameters) from the list of selected parameters.  This enables
identification of the most valuable parameters.  Features (parameters)
are ranked based on variance-to-mean ratio, where the features
(parameters) with a larger variance to mean are selected first.
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9.2.9.2.10  Miscellaneous

The table below describes the Miscellaneous pipeline steps that are available in
FCS Express. If you would like to recommend additional steps to be provided
with FCS Express, please contact support@denovosoftware.com.

Miscellaneous

Step Description

Classificatio
ns Folder

The Classifications Folder allows the user to run pipeline steps for
each data file that is part of a merged data file, independently,
based on the classifications contained in a classification parameter.
Classification parameters may be derived from file merging ,
downsampling masks , clustering and other pipeline steps.

Although any pipeline step can be run within the Classifications
Folder, it is effectively used to run data pre-processing steps like
Scaling , Normalization , 0-1 Scaling , Downsampling ,

1436

1068

1126 1124 1123 1068

mailto:support@denovosoftware.com
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FlowAI , and  FlowCut  on each data file contained within a
larger merged data file.

As an example, in the pipeline below (right) a Classification
Folder has been used to run three pre-processing steps, Scaling,
Gating and Downsampling, based on the classification parameter of
a merged file (left). Note that subsequent steps, such as UMAP and
tSNE have been placed downstream of the classification folder step
so those steps will be run after pre-processing and on the merged
data. In the example below, Scaling, Gate Downsampling, and
Interval Downsampling, will be run for each of the three donor
samples, the resulting pre-processed data will then be run as an
entire merged file for uMAP and tSNE.

Folder The Folder element allows users to add a folder within the pipeline
to better organize and group steps in the pipeline.
The Pipeline Folder has a check-box that allows users to easily
activate/deactivate all the steps contained in the Pipeline Folder.

To rename a Pipeline Folder, select the folder by left clicking on it
and the do either of the following:

· Click on the  button in the Transformation dialog;

1056 1059
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· Press F2 on the keyboard;

· Right click on the folder and select Rename.

Jaccard
Similarity
Parameter

The Jaccard Similarity Parameter step calculates the Jaccard
Index (https://en.wikipedia.org/wiki/Jaccard_index) for every pair
of events provided as the input data.  The Jaccard index is a
measure of overlap between two sets, such that the Jaccard index
equals one if the sets are identical and zero if the sets do not
contain common members. This step can be used to calculate the
degree of overlap between sets of event attributes.  The input is a
two-dimensional array of event attributes.  This step should be
preceded in the Pipeline by a K-Nearest Neighbor Parameter step
(see next entry in table).  The output is a square two-dimensional
array of Jaccard index scores, J.

https://en.wikipedia.org/wiki/Jaccard_index
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K-Nearest
Neighbors
Parameter

This pipeline step allow to define the nearest neighbors for each the
input data point. The neighbors are calculated in the space defined
by the parameters selected in the Parameter Options list (see
image below).
The number of nearest neighbors to output is defined by the user
through the Number of Neighbors field.
The output of this pipeline step is a new parameter in which
nearest neighbors are listed for each input data. Said new
parameter can be visualized through the Data Grid .399
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Merge to
Spectra

The Merge to Spectra step allows users to create a virtual
spectrum parameter by combining multiple input detectors,
generally from an overdetermined system. The derived spectrum
parameter can then be displayed using a Spectrum Plot  and
results used for the Unmixing pipeline  step. Please see our
chapter on Virtual Spectrum  for more information. Parameters
can be selected individually by clicking on the boxes or by using the

243

1053

244
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right click menu.  The right click menu gives the user the option to
Select All, Deselect All, or Invert Selection. Using the Filter:
field a user can remove unwanted parameters from view to
simplify selection.  For example, if a user only wanted to select
area parameters typing "-A" in the field would reduce the number
of parameters seen in the parameter list.

The virtual spectrum parameter will be named with the text defined
in the New Spectral Parameter Name field. In the example
below, the new parameter has been named Full Spectrum.

The Merged Spectra details can also be saved as an
AllExtraKeywords.txt file and then be used to automatically
recreate the spectrum parameter without using any pipeline.
Please refer to the Virtual Spectrum  chapter for more details.244
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Parameter
Removal

The Parameter Removal step allows users to remove
parameters from the parameter list. Parameters can be selected
individually by clicking on the boxes or by using the right click
menu.  The right click menu gives the user the option to Select
All, Deselect All, or Invert Selection. Using the Filter: field a
user can remove unwanted parameters from view to simplify
selection.  For example, if a user only wanted to select area
parameters typing "-A" in the field would reduce the number of
parameters seen in the parameter list.

Parameter Removal is particularly useful when one or multiple
parameters are not useful in the analysis, or a data file for use in a
template was acquired with more parameters than the original
data file, and thus can be removed to make the parameter list
shorter or to make the data file adhere to the original template
design. 
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Python
Transformat

ion

Please refer to the Python Transformation  chapter for more
details.

1171
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Ramp
Parameter

The Ramp Parameter  step creates a new parameter when ever
events are assigned with an increasing integer number.
The Ramp Offset field allows users to define the starting value,
while the Ramp Step filed allows users to define the step between
each value.
If the Ramp Offset and the Ramp Step are set to 0 and 1
respectively, and the pipeline is applied to a population that counts
100 events, the Ramp Parameter will number events from 0 to
99.

Unmixing The Unmixing step allows a user to perform spectral unmixing on
the input spectral parameter using an unmixing matrix imported by
the user.
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The spectrum parameter may come from a data file acquired on a
compatible spectral instrument  or from a virtual spectrum
parameter created via the Merge to Spectra  step.
The unmixing matrix can also be one that was created in FCS
Express using the Unmixing wizard .

In the Options section, the user can define:
· Which algorithm use to unmix the input parameter.

· Which suffix to add to the unmixed parameters.

243

1053

872
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Virtual
Bandpass

The Virtual Bandpass step allows users to combine multiple single
detectors, generally from an overdetermined system (e.g. a
spectral instrument) to recreate a virtual bandpass filter including a
particular range of detectors. The right click menu gives the user
the option to Select All, Deselect All, or Invert Selection. Using
the Filter: field a user can remove unwanted parameters from
view to simplify selection.  For example, if a user only wanted to
select area parameters typing "UV" in the field would reduce the
number of parameters seen in the parameter list.

Compatible input parameters for the Virtual Bandpass step are
spectral parameters that are derived from a compatible spectral
data file  or from a Merge to Spectra pipeline  step. If multiple
spectral parameter are selected, the virtual band pass filter will be
applied to each of them independently.

Once the input parameters are defined, the user can specify which
detectors to combine in the Spectral Detectors Range field.
Detectors may be listed as comma separated values (e.g.
1,2,3,4,5) or with dash (e.g. 1-5 is equal to 1,2,3,4,5). Detector
numbers are associated with the order in which they appear in a
spectral plot. For instance, if your spectral plot displays FITC-A, PE-
A, PeCy7-A, APC-A, and APC-Cy7-A, the detector numbers will be
1. FITC-A, 2. PE-A, 3. PeCy7-A, 4. APC-A, and 5. APC-Cy7-A
(example below). 

The calculated values for each Virtual Bandpass Filter step will be
saved into a new parameter. The new parameter is defined by the
user in the New parameter base name field (e.g. "UV-A Virtual
bandpass").

243 1053
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Different summary statistics (i.e.: Maximum, Minimum, Average,
Average, Standard Deviation) can be selected for the calculation of
the new values.

Two suffix can be automatically added to the new parameter name
via the following check boxes:
· Add stats name to new parameter base name. When this

check box is checked, the name of the statistics selected from
the Chose stats to calculate list will be added as a suffix to the
name defined in the New parameter base name field. If
multiple statistics are selected, the name of the statistics will
always be added as a suffix. 

· Add spectra name to new parameter base name. When this

check box is checked, the name of the parameter selected from
the Parameter Options list will be added as a suffix to the name
defined in the New parameter base name field. If multiple input
parameters are selected, the name of input parameter will
always be added as a suffix. 
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9.2.9.2.10.1  Python Transformation

The Python Transformation pipeline step (Figure 9.175) allows FCS Express
and Python to communicate with each other through a text script that can be
created directly within FCS Express.

Please note that both Python and all the Python libraries required to run the
calculation/algorithm of interest have to be installed on the user computer to
allow the Python Transformation pipeline step to be run properly. Python can be
downloaded and installed via the official Python website.

https://www.python.org/
https://www.python.org/
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The Python Script dialog allows to:

1. Define the options (and their default values) that will be used to tune the
calculation. For example, if a clustering algorithm requires the user to define
the number of clusters that need to be created, the number of clusters will be
defined as a User Defined Option. A name and a default value can be
specified for each option. This action is accomplished via the
RegisterOptions() function (see below).

2. Define the output parameter(s) that needs to be re-imported from Python
into FCS Express at the end of the calculation. For example, if the calculation
runs a clustering algorithm, the output parameter that needs to be imported
into FCS Express will be the clustering assignment. A name can be assigned to
each output parameter. The name will be used by FCS Express to name that
parameter everywhere within the layout. This action is accomplished via the
RegisterParameters() function (see below).

3. Run the calculation (e.g. the clustering) on the Input Data (i.e. the events and
the parameters defined in the pipeline), using the User Defined Options, and
import the Output Parameter(s). This action is accomplished via the
Execute() function (see below).

The three actions above are executed by the three functions presented below.

RegisterOptions(params)

The RegisterOptions(params) function is used to define the options that will
be used by the user to tune the calculation. This function allows to specify a
name and a default value for each option. Registered options will appear
under the User Defined Options panel of the Python Transformation dialog
(see screenshot above) when the script is run the first time.
Once options appear in the User Defined Options panel, they can be
adjusted directly from the panel, without further action on the script. It is
suggested to not further change the default values defined in the
RegisterOptions(params) function once the script is run the first time.

The argument of this function is the {list} of the names of the parameters
currently selected in the Parameter Option panel of Python
Transformation dialog (see screenshot above). This is an object of type list.

The RegisterOptions(params) function does not generate any output, it
sends the name and the default value of each registered option to FCS
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Express so that FCS Express can populate the interactive User Defined
Options panel of the Python Transformation dialog.

Several types of options can be defined through the
RegisterOptions(params) function: 

T
y
p
e

Function to use within the
RegisterOptions(params)
function

Description

B
o
ol
e
a
n

RegisterBooleanOption(OptionN
ame: str, DefaultValue: bool)

Allows users to create a User
Defined Options that allows
True/False values as input. 

Fl
o
a
ti
n
g

RegisterFloatOption(OptionNam
e: str, DefaultValue: float,
OptionMaximum: float,
OptionMinimum: float)

Allows users to create a User
Defined Options that allows a
floating number as input.
Optionally, a maximum and a
minimum values can be
provided. Default for
OptionMaximum and
OptionMinimum is None.

I
n
t
e
g
e
r

RegisterIntegerOption(OptionN
ame: str, DefaultValue: int,
OptionMaximum: int,
OptionMinimum: int)

Allows users to create a User
Defined Options that allows an
integer number as input.
Optionally, maximum and
minimum values may be
provided. Default for
OptionMaximum and
OptionMinimum is None.

S
tr
in
g

RegisterStringOption(OptionNa
me: str, DefaultValue: str)

Allows users to create a User
Defined Options that allows a
string as input.

/ ClearOptions() This function will clear all
registered options.

/ DeleteOption(OptionName: str) This function will delete a
registered option based on
OptionName.

An example of RegisterOptions(params) function is depicted below. In this
example, six different options are defined and initialized:
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· A user option of type string named Distance Metric and initializes it to

euclidean.
· A user option of type integer named Number Initialization and initializes it

with 10.
· A user option of type integer named Number Iterations and initializes it to

 100, and sets a min/max values to 0 and 1000 respectively.
· A user option of type integer named Float without Range and initializes it

with 10.67.
· A user option of type floating named Tolerance and initializes it to 0.04,

and sets a min/max values to 0 and 1000 respectively.
· A user option of type boolean named Precompute Distances and initializes

it with True.

def RegisterOptions(params):
  RegisterStringOption("Distance Metric", "euclidean")

    RegisterIntegerOption("Number Initialization", 10)

    RegisterIntegerOption("Number Iterations", 100, 0, 1000)

    RegisterFloatOption("Float without Range", 10.67) 

    RegisterFloatOption("Tolerance", 0.004, 0.0, 1.0) 

    RegisterBooleanOption("Precompute Distances", True) 

Running the lines above will populate the User Defined Options panel as
follow:

Once options appear in the User Defined Options panel, the user will then be
able to tune each option directly through the User Defined Options panel. It
is suggested to not further change the default values defined in the
RegisterOptions(params) function once the script is run the first time.

User-defined options are imported into Python in an object of type
dictionary (see the opts argument in the RegisterParameters() and in

the Execute() functions below), with keys matching the labels defined in the
RegisterOptions() function, and values matching the value defined in the
User Defined Options panel.

This dictionary containing user-defined options is an argument of both the
RegisterParameters(opts, params) and the Execute(opts, data, res)
functions (see below).
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RegisterParameters(opts, params)

Results generated by the Python script are saved into an object of type
dictionary and then imported into FCS Express as new parameters. While

the result are imported into FCS Express, dictionary keys are used as
parameter names, and dictionary values are used as parameter values by
FCS Express.

The RegisterParameters() function allows to define the keys of the
dictionary, thus the name of the new parameters. 

Results generated by the calculation (e.g. a cluster assignment resulting from
a clustering algorithm, or a the parameters resulting from a dimensionality
reduction algorithm) will be then saved as values of each key (this is done via
the Execute() function).

Arguments:
· opts  {dict} This is the dictionary containing names and values for

each user-defined option. Names are the keys defined in the
RegisterOptions(params) function, while values are pulled down
from the User Defined Options panel;

· params {list} is the list of the input parameters selected  in the

Parameter Option panel of Python Transformation step (see
screenshot above).

Two types of parameters can be defined through the
RegisterParameters(opts, params) function: 

Typ
e

Function to use within
the
RegisterParameters(o
pts, params) function

 Description

Classific
ation
assignm
ent

RegisterClassification(
ParamName: str,
Optional Argument 1 ,
Optional Argument 2)

Register the name for a classification
parameter. The parameter should be
returned with integer values only.
Optionally, the following two optional
arguments can also be passed:
· Optional Argument 1. This should be a

string in the form of desc="". It allows

to define a description for the
classification
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· Optional Argument 2. This should be

either a list of labels in the form of
labels=[] or a single integer number

defining the number of classifications
(classification values will start from 0)
in the form of
num_class=integer_value. If the

former, the number of labels provided
should be equal to the number of
classifications. 

Floating
values

RegisterParameter(Param
Name: str)

Register the name for a floating number
parameter.

An example of RegisterParameters(opts, params) function is depicted
below. In this example, three types of results are initialized:

· A classification assignment named Cluster assignments with a

description (i.e. Kmeans Cluster assignments)
· A classification assignment named Cell Status with no description (see

the second argument which is "") and 2 classification levels (i.e. 0 and
1).

· A classification assignment named Cell type with no description (see

the second argument which is "") and 2 classification levels with
specific names (i.e. "B Cells" and "T Cells").

· A floating point parameter named Custom Parameter.

def RegisterParameters(opts,params):

RegisterClassification("Cluster assignments", "Kmeans Cluster
assignments")

RegisterClassification("Cell Status", "", 2, ["live",
"dead"])

RegisterClassification("Cell type", "", 2, ["B Cells", "T
Cells"])

RegisterParameter("Custom Parameter")

Execute(opts, data, res)

The Execute() function is used to run the calculation of interest and save the
results as dictionary values into the dictionary object defined by the

RegisterParameters() function.

    Arguments:
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· opts is an object of type {dict} containing name and value for each user-

defined option. Names are the keys defined in the RegisterOptions()
function, while values are pulled down from the User Defined Options
panel;

· data is an object of type {dict} containing the input data. Keys are

derived from the parameters selected in the Parameter Option panel of
Python Transformation step (see screenshot at the beginning of this
chapter). The length of the dictionary matches the number of selected
input parameters. The value for each key is a a list containing the values
for that parameter. The length of each list of the dictionary matches the
number of input data points for the Python Transformation step.
Spectral parameters and KNN parameters are also allowed (their value in
the dictionary object, is a list of list).

· res is an object of type {dict} with keys matching the registered

parameter names (see the RegisterParameters() function) and vales
preallocated to nan. This dictionary is setup to be used as the return value
of this method.

The function:
1. Runs the calculation of interest
2. Populates the values of the res object with the output values generated by

the calculation. Length of each value list should be equal to number of input
data points. A key should exist for each registered parameter.

3. Return the populated res object to FCS Express.

Variables

While the running the calculation of interest within the Execute(), the user
may access the following variables: 

Variable Description
NumberDataPoints
{int} [read-only]

Returns the number of cells being transformed (i.e.
the number of input events).

NumberClassifications
{dict} [read-write]

Returns a dictionary where each key is a
classification parameter registered with the
RegisterParameters function, and each value is
the number of classifications for that parameter
allowing modification to the number of
classifications after performing a given
transformation.

InputClassificationLa
bels {dict} [read-
only]

Returns a dictionary where each key is a selected
classification input parameter (i.e. selected in the
Parameter Options panel), and each value is a list
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of labels for that classification parameter. The list
may be accessed using the classification value
provided in the data dictionary. If no selected input
parameter are classification parameters, this
dictionary will be empty.

For example, let's consider the following scenario:

· CD8 APC-Cy7-A. This parameter containing

fluorescence intensity values for each data point.
· File Identifier. This parameter contain the

numerical identifier created when files are merged
together.

· SAMPLE ID. This parameter contain and

additional classification identifier defined in the
Instrument Specific Settings .

· Classification Identifier. This parameter contain

the classification identifier created when files are
merged together. 

· Kmeans 10 Cluster Assignments: This

parameter contain the classification generated by
a Kmeans pipeline step executed upstream the
Python Transformation pipeline step.

InputClassificationLabels would return an

object of type dictionary with 3 keys:

Classification Identifier, Kmeans 10 Cluster
Assignments and SAMPLE ID. The values for
each key is the list of classification labels for that
classification parameter.

OutputClassificationL
abels {dict} [read-
write]

Returns a dictionary where each key is a
classification parameter registered with the
RegisterParameters function, and each value is a
list of labels (if provided when registering, empty
otherwise) to use for the classification, allowing

1663



FCS Express 7 Manual1180

© 2023 De Novo Software

modification to the the labels after performing a
given transformation.

In the example below a registered parameter
named "Kmeans" with 5 integer cluster_labels
(from 0 to 4) is modified with the
OutputClassificationLabels function so that the new
cluster labels will be ["Cluster 1", "Cluster 2",
"Cluster 3", "Cluster 4", "Cluster 5"]. 

    OutputClassificationLabels["KMeans"] =
["Cluster {}".format(i+1)
        for i in range(max(cluster_labels)
+1)]

ClassificationCentroi
ds {dict} [read-
write]

Returns a dictionary where each key is a
classification parameter registered with the
RegisterParameters function, and each value is a
list of centroids (if provided when registering,
empty otherwise) to use for each classification, if
not automatically calculating centroids. This allows
registered classification to be used by downstream
pipeline steps that require high dimensional
information.

Importing FCS Express functions

All the  functions presented above can be loaded by running the following
command at the beginning of the script:

from FcsExpress import *

Specific functions may also be loaded. As an example, the line below loads the
RegisterStringParameter function:

from FcsExpress import RegisterStringParameter  

The function name can also be customized at the time of loading. As an
example, the line below loads the RegisterStringParameter function and will
assign a new name to it (i.e. regstr):

from FcsExpress import RegisterStringParameter as regstr



Tools 1181

© 2023 De Novo Software

Example scripts

In the following chapters some training and example scripts are provide:
· Training scripts

· Example scripts with popular algorithms

o PARC

o TriMap

o HDBSCAN

o FIt-SNE (openTSNE)

o PaCMAP

o Ivis

o PHATE

The script below are example scripts that users can use as reference to
implement their own script for many different algorithms.

Algorith
m

Name

Script

My
rookie
script

In this example script a new parameter is created via Python. The value
for this parameter is set to be the same for all input events.

In this script, four options are defined, allowing the user to:
· Name the new parameter (option of type string). A default name is

also defined.
· Define a integer value to assign to all input events (option of type

integer). A default integer is also defined.
· Define whether or not to add a constant decimal to the integer value

defined above (option of type boolean). A default boolean value is
also defined.

· Define which decimal to add (option of type floating), if any. A default

value, together with minimum/maximum allowed values are defined.

# Add Constant Parameter                                
       
from FcsExpress import *
                                                         
      
def RegisterOptions(params):                            
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Algorith
m

Name

Script

    RegisterStringOption("Constant Name", "MyConstParam")
 
    RegisterIntegerOption("Constant Value", 3)          
  
    RegisterFloatOption("Constant Decimal", 0.5, 0, 1)  
  
    RegisterBooleanOption("Add decimal?", True)         
  
                                                         
      
def RegisterParameters(opts, params):                   
  
    RegisterParameter(opts["Constant Name"])            
  
                                                         
      
def Execute(opts, data, res):                           
  
    valToSet = opts["Constant Value"]                   
       
    if opts["Add decimal?"]:                            
       
        valToSet += opts["Constant Decimal"]            
       
                                                         
      
    res[opts["Constant Name"]][:] = [valToSet] *
NumberDataPoints
    return res

 

 Using
a

Classifi
cation
Identifi

er

This script shows how a Classification Identifier parameter can be
used. Specifically, in this example the distance from the mean is
calculated for each data point. This is done independently for each
Classification Identifier label.

The parameter used for this calculation is defined by the user through
the Parameter to Calculate Statistic on option. If ANY is entered, the
first non-Classification parameter of the selected parameter list will be
used.
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Algorith
m

Name

Script

This script require the user to select a Classification Identifier parameter
and at least an additional parameter which is not a Classification
identifier parameter.

# Classification parameter input example
from FcsExpress import *
from pprint import pprint  

# swap print command for pretty version 
print = pprint 

available_options = ["mean"]
stat_option = "Statistic to Calculate
({})".format(available_options)
param_option = "Parameter to Calculate Statistic on"
default_param = "ANY"

# Could also support median without too much extra work
def RegisterOptions(ParameterNames):
    RegisterStringOption(stat_option,
available_options[0])
    RegisterStringOption(param_option, default_param)

def RegisterParameters(Options, ParameterNames):
    RegisterParameter("Distance from
{}".format(Options[stat_option]))

def Execute(Options, Parameters, Result):
    # Make sure that the stat passes in is valid
    if not Options[stat_option] in available_options:
        print(Options[stat_option])
        print("Could not calculate {0} of each
classification as {0} is an " \
              "unrecognized statistic. Please choose a
statistic from available " \
              "options: {1}".format(Options[stat_option],
available_options))
    # We have a valid stat so now proceed in calculating
for each classification
    elif (
            Options[param_option] != default_param and
            len(Parameters.keys()) < 2             and
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            not Options[param_option] in
Parameters.keys()
        ):
        print("Could not find {} in list of passed in
parameters. Please " \
              "choose a parameter selected for this step,
or use {} to " \
              "select any parameter passed
in".format(Options[param_option],
              default_param))
    else:
        output_param_name = "Distance from
{}".format(Options[stat_option])
        # Get reference to the classification parameter
we care about
        classification_name = "Classification Identifier"
        classification_values =
Parameters[classification_name]
        classification_labels =
InputClassificationLabels[classification_name]
        # Classification values are 0-based
        number_of_classification =
max(classification_values) + 1

        # Get reference to the parameter we care about
        if Options[param_option] == default_param:
            for param in Parameters.keys():
                if param != classification_name:
                    parameter_name = param
                    break
        else:
            parameter_name = Options[param_option]

        parameter_values = Parameters[parameter_name]
        # If mean was chosen then compute the mean of
each classification in parameter
        if Options[stat_option] == "mean":
            # Initialize sums with a value of 0 for each
label
            classification_sums = {label: 0 for label in
classification_labels}
            classification_counts =
classification_sums.copy()
            # Now populate all the sums
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            for index, cell in
enumerate(parameter_values):
                cur_classification_value =
classification_values[index]
                cur_label =
classification_labels[cur_classification_value]

                classification_sums[cur_label] += cell
                classification_counts[cur_label] += 1

            # Now divide the sums by the number of each
classification
            stat_of_interest = {label:
(classification_sums[label] /
                classification_counts[label]) for label
in classification_labels}

        # Now that stat_of_interest is populated, we need
to compute the difference
        # from this statistic to the value of each cell
in chosen parameter
        print("The {} of each classification in
{}:".format(Options[stat_option], parameter_name))
        print(stat_of_interest, sort_dicts=False)
        for index, cell in enumerate(parameter_values):
            cur_classification_value =
classification_values[index]
            cur_label =
classification_labels[cur_classification_value]

            Result[output_param_name][index] =
abs(stat_of_interest[cur_label] - cell)

    return Result

Using a
Spectra

l
parame

ter

Spectral parameters (either from actual spectral data or created using
the Merge To Spectra  pipeline step) can be used as input parameters
in the Python Transformation pipeline step.
Parameter selected in the Parameter Option panel of Python
Transformation step are imported into Python as a dictionary object.
Keys are derived from the names of the selected parametrs. The length
of the dictionary matches the number of selected input parameters. The

1160
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value for each key is a a list containing the values for that parameter.
The length of each list of the dictionary matches the number of input
data points for the Python Transformation step. Spectral parameters
(and KNN parameters) are also allowed (their value in the dictionary
object, is a list of list).

The script below shows how a Spectral parameter can be used.
Specifically, a user-selected statistic (e.g. sum, mean, median or max)
is calculated for each data point of each selected spectral parameter.

For each input parameter, a new parameter is created with the result of
the calculation for each data point.

This script require that only spectral parameters are selected as input.

# Spectral parameter input example
from FcsExpress import *
import statistics       

available_options = ["sum", "mean", "median", "max"]
stat_option = "Statistic to Calculate
({})".format(available_options)

stat_functions = {
    "sum": sum,
    "mean": statistics.mean,
    "median": statistics.median,
    "max": max
}
# Could also support median without too much extra work
def RegisterOptions(ParameterNames):
    RegisterStringOption(stat_option,
available_options[0])

def RegisterParameters(Options, ParameterNames):
    for param in ParameterNames:
        RegisterParameter("{} {}s".format(param,
Options[stat_option].capitalize()))

def Execute(Options, Parameters, Result):
    # Make sure that the stat passes in is valid
    if not Options[stat_option] in available_options:
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        raise RuntimeError("Could not calculate {0} of
each spectrum as {0} is an " \
              "unrecognized statistic. Please choose a
statistic from available " \
              "options: {1}".format(Options[stat_option],
available_options))
    else:
        # Make sure that the parameters selected are
spectral Parameters
        for parameter_name, parameter_values in
Parameters.items():
            # If each cell value is not a list of values
this is not a spectrum
            if not isinstance(parameter_values[0], list):
                raise RuntimeError("{} is not a spectral
parameter. Calculating {} on non-spectral " \
                      "parameters does not make sense.
Change input parameter selection."
                      .format(parameter_name,
Options[stat_option]))

            print("Processing {} which contains {}
detector values".format(parameter_name,
len(parameter_values[0])))
            output_param_name = "{} {}
s".format(parameter_name,
Options[stat_option].capitalize())

            # Now iterate over cells and calculate stat
            for index, cell_values in
enumerate(parameter_values):
                # Python < 3.10 doesn't have case
statements otherwise this would be a use case
                cell_values_stat =
stat_functions[Options[stat_option]](cell_values)
                Result[output_param_name][index] =
cell_values_stat

    return Result

Using a
KNN

KNN  parameters can be used as input parameters in the Python
Transformation pipeline step.
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Parameter selected in the Parameter Option panel of Python
Transformation step are imported into Python as a dictionary object.
Keys are derived from the names of the selected parametrs. The length
of the dictionary matches the number of selected input parameters. The
value for each key is a a list containing the values for that parameter.
The length of each list of the dictionary matches the number of input
data points for the Python Transformation step. KNN parameters
(and Spectral parameters) are also allowed (their value in the dictionary
object, is a list of list).

The script below shows how a KNN parameter can be used. Specifically,
the script below counts how many neighborhoods a cell (i.e. a data
point) participate in. The output of this script is a new parameter
reporting, for each cell, the difference between the number of
neighborhoods that cell participate in, and the average number of
neighborhoods cells participate in.
The script also generate a textual output in the Layout Messages
dialog, reporting the Minimum, the Maximum and the Average number
of neighborhoods cell participate in.

The script below require a KNN parameter  as input parameter.

# KNN parameter input example
from FcsExpress import *
from statistics import mean

def RegisterOptions(ParameterNames):
    pass

def RegisterParameters(Options, ParameterNames):
    RegisterParameter('Number of Neighborhoods')

def Execute(Options, Parameters, Result):
    # Make sure that the parameters selected are knn
Parameters
    for parameter_name, parameter_values in
Parameters.items():
        # If each cell value is not a list of values this
is not a knn
        if not isinstance(parameter_values[0], list):
            raise RuntimeError("{} is not a knn
parameter. Using non-knn " \
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                  "parameters with this does not make
sense. Change input parameter selection."
                  .format(parameter_name))

        print("Processing {} which contains {}
neighborhoods per cell.".format(parameter_name,
len(parameter_values[0])))
        output_param_name = 'Number of Neighborhoods'

        # iterate over each cells neighorhood and build
up neighbor stats into a dict
        num_neighborhoods_participating = {neighbor: 0
for neighbor in range(NumberDataPoints)}

        for neighborhood in parameter_values:
            for neighbor in neighborhood:
                num_neighborhoods_participating[neighbor]
+= 1

        neighborhood_counts =
num_neighborhoods_participating.values()
        # need to return relative differences based on
the average
        average_num_neighborhoods =
mean(neighborhood_counts)
        print("Average number of Neighborhoods Cells
Participate in (Should be K of KNN):",
average_num_neighborhoods)
        print("Max number of Neighborhoods: ",
max(neighborhood_counts))
        print("Min number of Neighborhoods: ",
min(neighborhood_counts))
        Result[output_param_name] = [num_neighborhoods -
average_num_neighborhoods for num_neighborhoods in
neighborhood_counts]

    return Result
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PARC
 
In the example script below, the Python Transformation pipeline step is
defined to run PARC (PARC: ultrafast and accurate clustering of
phenotypic data of millions of single cells; Shobana V Stassen;
Bioinformatics, Volume 36, Issue 9, 1 May 2020).

Note: to run this experiment, Python, pandas and parc should be
properly installed on the user computer.

# PARC script
from FcsExpress import *

try:
    from pandas import DataFrame
except ModuleNotFoundError:
    raise RuntimeError("Current Python distribution does
not contain Pandas. " +
        "To test this script please install pandas: " +
        "(https://pandas.pydata.org/pandas-
docs/stable/getting_started/install.html)")

try:
    import parc
except ModuleNotFoundError:
    raise RuntimeError("Current Python distribution does
not contain parc. " +
        "To test this script please install parc: " +
        "(https://github.com/ShobiStassen/PARC)")

def RegisterOptions(params):
    pass

def RegisterParameters(opts, params):
    RegisterClassification("Parc Cluster Assignments")

def Execute(opts, data, res):
    df = DataFrame(data)
    parc_obj = parc.PARC(df.to_numpy()) #initiate PARC

https://www.python.org/
https://pandas.pydata.org/pandas-docs/stable/getting_started/install.html
https://github.com/ShobiStassen/PARC
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    parc_obj.run_PARC() #run the clustering
    res["Parc Cluster Assignments"] = parc_obj.labels
#saving the cluster assignment into the res object
    return res #return the res object that will be re-
imported into FCS Express

TriMap In the example script below, the Python Transformation pipeline step is
defined to run TriMap (TriMap: Large-scale Dimensionality
Reduction Using Triplets; Ehsan Amid, Manfred K. Warmuth;
arXiv:1910.00204; submitted on 1 Oct 2019).

Note: to run this experiment, Python, pandas and trimap should be
properly installed on the user computer.

# Trimap
from FcsExpress import *
try:
    from pandas import DataFrame
except ModuleNotFoundError:
    raise RuntimeError("Current Python distribution does
not contain Pandas. " +

https://www.python.org/
https://pandas.pydata.org/pandas-docs/stable/getting_started/install.html
https://pypi.org/project/trimap/


FCS Express 7 Manual1192

© 2023 De Novo Software

Algorith
m

Name

Script

        "To test this script please install pandas: " +
        "(https://pandas.pydata.org/pandas-
docs/stable/getting_started/install.html)")

try:
    import trimap
except ModuleNotFoundError:
    raise RuntimeError("Current Python distribution does
not contain trimap. " +
        "To test this script please install trimap: " +
        "(https://pypi.org/project/trimap/)")

parameter_map = {
    "n_inliers": "Number Nearest Neighbors",
    "n_outliers": "Number Outliers",
    "n_random": "Number Random Triplets",
    "distance": "Distance Measure",
    "weight_adj": "Gamma",
    "lr": "Learning Rate",
    "n_iters": "Number Iterations"
}

def RegisterOptions(params):
    RegisterIntegerOption(parameter_map["n_inliers"], 10)
    RegisterIntegerOption(parameter_map["n_outliers"], 5)
    RegisterIntegerOption(parameter_map["n_random"], 5)
    RegisterStringOption(parameter_map["distance"],
"euclidean")
    RegisterFloatOption(parameter_map["weight_adj"],
500.0)
    RegisterFloatOption(parameter_map["lr"], 1000.0)
    RegisterIntegerOption(parameter_map["n_iters"], 400)

def RegisterParameters(opts, params):
    RegisterParameter("Trimap 1")
    RegisterParameter("Trimap 2")

def Execute(opts, data, res):
    df = DataFrame(data)
    embedding = trimap.TRIMAP(
        n_inliers=opts[parameter_map["n_inliers"]],
        n_outliers=opts[parameter_map["n_outliers"]],
        n_random=opts[parameter_map["n_random"]],
        distance=opts[parameter_map["distance"]],
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        weight_adj=opts[parameter_map["weight_adj"]],
        lr=opts[parameter_map["lr"]],
        n_iters=opts[parameter_map["n_iters"]]
    ).fit_transform(df.to_numpy())
    res["Trimap 1"] = embedding[:, 0]
    res["Trimap 2"] = embedding[:, 1]
    return res

HDBSC
AN

In this example script, the Python Transformation pipeline step is defined
to run HDBSCAN (Campello R.J.G.B., Moulavi D., Sander J. (2013)
Density-Based Clustering Based on Hierarchical Density Estimates. In:
Pei J., Tseng V.S., Cao L., Motoda H., Xu G. (eds) Advances in
Knowledge Discovery and Data Mining. PAKDD 2013. Lecture Notes in
Computer Science, vol 7819. Springer, Berlin, Heidelberg.
https://doi.org/10.1007/978-3-642-37456-2_14).

https://doi.org/10.1007/978-3-642-37456-2_14
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HDBSCAN can be useful to identify clusters on UMAP plots. When
HDBSCA is used for this purpose, creating a UMAP map with dense
clusters (i.e. keeping the UMAP "Min Low Dim Distance" value low) will
help HDBSCAN clustering.
More information on DBSCAN for Python can be found here.

Note #1: to run this experiment, Python, pandas, and hdbscan should
be properly installed on the user computer.

Note #2: If noisy data points are detected by HDBSCA, they will be
grouped under "HDBSCAN Cluster Assignment" equal to "1" in FCS
Express.

Note #3: with large dataset, HDBSCAN might return a "Could not find -
c" error. If that happens, setting core_dist_n_jobs to 1 might solve the
issue.

#HDBSCAN

from FcsExpress import *

try:
    from pandas import DataFrame
except ModuleNotFoundError:
    raise RuntimeError("Current Python distribution does not contain Pandas. " +
        "To test this script please install pandas: " +
        "(https://pandas.pydata.org/pandas-docs/stable/getting_started/install.html)")

try:
    import hdbscan
except ModuleNotFoundError:
    raise RuntimeError("Current Python distribution does not contain hdbscan. " +
    "To test this script please install hdbscan: " +
    "(https://pypi.org/project/hdbscan/)")

from collections import Counter

def RegisterOptions(params):
    RegisterIntegerOption("min_cluster_size",5)
    RegisterStringOption("min_samples","None")
    RegisterIntegerOption("core_dist_n_jobs",4)

https://hdbscan.readthedocs.io/en/latest/index.html
https://www.python.org/
https://pandas.pydata.org/pandas-docs/stable/getting_started/install.html
https://pypi.org/project/hdbscan/
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def RegisterParameters(opts, params):
    RegisterClassification("HDBSCAN Cluster Assignments")
    RegisterParameter("HDBSCAN Outlier scores")

def Execute(opts, data, res):
    df = DataFrame(data)
    
    #See if doing default min_samples
    if opts["min_samples"] == "None":
        min_samples = None # Setting n_neighbors to "None" leads to a default choice
    elif opts["min_samples"].isnumeric():
        min_samples = int(opts["min_samples"])
    else:
        raise Exception("The min_samples option only accept None or integer values")
 
    print("Running HDBSCAN on {} data points, with min_cluster_size={}, min_samples={} and core_dist_n_jobs={}".format(NumberDataPoints,opts["min_cluster_size"],min_samples,opts["core_dist_n_jobs"]))
    
    clusterer = hdbscan.HDBSCAN(min_cluster_size=opts["min_cluster_size"],
                                min_samples=min_samples,
                                core_dist_n_jobs=opts["core_dist_n_jobs"])
    cluster_labels = clusterer.fit_predict(df)
    outlier_scores=clusterer.outlier_scores_

    #Noisy data points are labelled by HDBScan with cluster assignemnt of -1.
    #FCS Express requires cluster assignment values starting from 0.
    #So, in case noisy data points are present, cluster labels are increased by 1
    if min(cluster_labels)==-1:
        noisy=Counter(cluster_labels)[-1] #number of noisy data points
        print(noisy, "noisy datapoints have been detected" +
            " and will be grouped under HDBSCAN Cluster Assignment equal to 1 in FCS Express")
        cluster_labels=cluster_labels+1 # making cluster assignment values starting at 0.

    res["HDBSCAN Cluster Assignments"] = cluster_labels
    res["HDBSCAN Outlier scores"] = outlier_scores
    return res
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FIt-
SNE

(openT
SNE)

In this example script, the Python Transformation pipeline step is defined
to run Fit-SNE (Fast interpolation-based t-SNE for improved
visualization of single-cell RNA-seq data; Linderman, G.C., Rachh, M.,
Hoskins, J.G. et al.; Nat Methods 16, 243–245 (2019).
https://doi.org/10.1038/s41592-018-0308-4) through the openTSNE
Python implementation.

Note: to run this experiment, Python, pandas and openTSNE should be
properly installed on the user computer.

#This script allow to run openTSNE as a Python
Transformation pipeline step in FCS Express 7
#Detailed info on openTSNE in Python can be found at
https://opentsne.readthedocs.io/en/latest/index.html

from FcsExpress import *

try:
    from pandas import DataFrame
except ModuleNotFoundError:
    raise RuntimeError("Current Python distribution does
not contain Pandas. " +
        "To test this script please install pandas: " +
        "(https://pandas.pydata.org/pandas-
docs/stable/getting_started/install.html)")

https://www.python.org/
https://pandas.pydata.org/pandas-docs/stable/getting_started/install.html
https://opentsne.readthedocs.io/en/latest/index.html
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try:
    from openTSNE import TSNE
except ModuleNotFoundError:
    raise RuntimeError("Current Python distribution does
not contain OpenTSNE. " +
        "To test this script please install openTSNE: " +
        "(https://opentsne.readthedocs.io/en/latest/insta
llation.html)")    

def RegisterOptions(params):
    RegisterIntegerOption("Number Iterations", 750)
    RegisterIntegerOption("Perplexity", 30)
    RegisterFloatOption("Burnes-Hut Theta", 0.5)
    RegisterIntegerOption("Learning Rate", 200)
    RegisterStringOption("Metric", "euclidean")
    RegisterIntegerOption("Random State", 42)
    RegisterIntegerOption("Number Threads", 4)

def RegisterParameters(opts, params):
    RegisterParameter("FIt-SNE 1")
    RegisterParameter("FIt-SNE 2")

def Execute(opts, data, res):
    df = DataFrame(data)
    #print(df)
    # See if doing auto learning
    if opts["Learning Rate"] < 0:
        l_rate = 'auto'
    else:
        l_rate = opts["Learning Rate"]
    # Now run TSNE
    embedding = TSNE(
        theta=opts["Burnes-Hut Theta"],
        perplexity=opts["Perplexity"],
        n_iter=opts["Number Iterations"],
        learning_rate=l_rate,
        metric=opts["Metric"],
        random_state=opts["Random State"],
        n_jobs=opts["Number Threads"]
    ).fit(df.to_numpy())
    res["FIt-SNE 1"] = embedding[:, 0]
    res["FIt-SNE 2"] = embedding[:, 1]
    return res
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PaCMA
P

In this example script, the Python Transformation pipeline step is defined
to run PaCMAP (Wang and Huang, at al., Understanding How Dimension
Reduction Tools Work: An Empirical Approach to Deciphering t-SNE,
UMAP, TriMap, and PaCMAP for Data Visualization; Journal of Machine
Learning Research 22 (2021) 1-73). More information on PaCMAP for
Python can be found here.

Note: to run this experiment, Python, pandas, and pacmap should be
properly installed on the user computer.

#This script allow to run PaCMAP as a Python
Transformation pipeline step in FCS Express 7
#Detailed info on PaCMAP in Python can be found at
https://github.com/YingfanWang/PaCMAP

from FcsExpress import *

https://github.com/YingfanWang/PaCMAP
https://www.python.org/
https://pandas.pydata.org/pandas-docs/stable/getting_started/install.html
https://github.com/YingfanWang/PaCMAP
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try:
    from pandas import DataFrame
except ModuleNotFoundError:
    raise RuntimeError("Current Python distribution does
not contain Pandas. " +
        "To test this script please install pandas: " +
        "(https://pandas.pydata.org/pandas-
docs/stable/getting_started/install.html)")
        
try:
    import pacmap
except ModuleNotFoundError:
    raise RuntimeError("Current Python distribution does
not contain Pacmap. " +
        "To test this script please install pacmap: " +
        "(https://github.com/YingfanWang/PaCMAP)") 

def RegisterOptions(params):
    RegisterIntegerOption("Number of dimensions", 2)
    RegisterStringOption("Number of neighbors", "None")
    RegisterFloatOption("MN_ratio", 0.5)
    RegisterFloatOption("FP_ratio", 2.0)
    RegisterStringOption("Initialization","random")
    RegisterIntegerOption("Random seed", 4)
    RegisterIntegerOption("Number of iterations", 450)

def RegisterParameters(opts, params):
    for dim in range(opts["Number of dimensions"]):
        RegisterParameter("PaCMAP {}".format(dim + 1))

def Execute(opts, data, res):

    #Reading data
    df = DataFrame(data)
    X = df.to_numpy()
    
    #See if doing default n_neighbors
    if opts["Number of neighbors"] == "None":
        n_neighbors = None # Setting n_neighbors to "None"
leads to a default choice    
    elif opts["Number of neighbors"].isnumeric():
        n_neighbors = int(opts["Number of neighbors"])
    else:
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        raise Exception("The Number of neighbors option
only accept None or integer values") 

    #Check initialization
    Initializations=["pca","random"]
    if opts["Initialization"] not in Initializations:
        raise Exception("The Initialization option only
accept the following values: pca, random")
    
    #Initializing the pacmap instance
    embedding = pacmap.PaCMAP(
    n_components=opts["Number of dimensions"],
    n_neighbors=n_neighbors,
    MN_ratio=opts["MN_ratio"],
    FP_ratio=opts["FP_ratio"],
    random_state=opts["Random seed"],
    num_iters=opts["Number of iterations"])

    #Running PaCMAP
    X_transformed = embedding.fit_transform(X,
init=opts["Initialization"])

    print("Running PaCMAP with {} Initialization on {}
data points, with Number of Neighbors set to
{}".format(opts["Initialization"], NumberDataPoints,
n_neighbors))   
    
    #Loop over dimensions and set results
    for dim in range(opts["Number of dimensions"]):
        res["PaCMAP {}".format(dim + 1)] =
X_transformed[:, dim]    
    
    return res
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Ivis In this example script, the Python Transformation pipeline step is defined
to run Ivis (Szubert, B., Cole, J.E., Monaco, C. et al. Structure-
preserving visualisation of high dimensional single-cell datasets. Sci Rep
9,8914 (2019). https://doi.org/10.1038/s41598-019-45301-0). More
information on Ivis for Python can be found here and here.

Note: to run this script, Python, pandas and ivis should be properly
installed on the user computer.

#This script allows you to run Ivis as a Python
Transformation pipeline step in FCS Express 7
#Detailed info on Ivis in Python can be found at
https://bering-
ivis.readthedocs.io/en/latest/python_package.html

from FcsExpress import *

try:
    from pandas import DataFrame
except ModuleNotFoundError:
    raise RuntimeError("Current Python distribution does
not contain Pandas. " +

https://github.com/beringresearch/ivis
https://bering-ivis.readthedocs.io/en/latest/
https://www.python.org/
https://pandas.pydata.org/pandas-docs/stable/getting_started/install.html
https://bering-ivis.readthedocs.io/en/latest/python_package.html
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        "To test this script please install pandas: " +
        "(https://pandas.pydata.org/pandas-
docs/stable/getting_started/install.html)")

try:
    from ivis import Ivis
except ModuleNotFoundError:
    raise RuntimeError("Current Python distribution does
not contain ivis. " +
    "To test this script please install ivis: " +
    "(https://github.com/beringresearch/ivis)")

try:
    from scipy import sparse
except ModuleNotFoundError:
    raise RuntimeError("Current Python distribution does
not contain scipy. " +
        "To test this script please install scypy: " +
        "(https://scipy.org/)")

def RegisterOptions(params):
    RegisterIntegerOption("Embedding Dimensions",2)
    RegisterIntegerOption("Number of Nearest
Neighbours",15)
    RegisterIntegerOption("Number of epochs without
progress",10)
    RegisterStringOption("Type of input", "numpy array")
    RegisterStringOption("Keras Model", "auto")

#The Number of Nearest Neighbours , the Number of epochs
without progress
#and the Keras Model are tunable parameters that should be
selected
#on the basis of dataset size and complexity.
#Please refer to https://bering-
ivis.readthedocs.io/en/latest/hyperparameters.html

def RegisterParameters(opts, params):
    for dim in range(opts["Embedding Dimensions"]):
        RegisterParameter("Ivis {}".format(dim + 1))

def Execute(opts, data, res):
    df = DataFrame(data)
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Algorith
m

Name

Script

    #Converting the input data to either numpy array or
spare matrix based on the user selection
    if opts["Type of input"]=="numpy array":
        X=df.to_numpy()
    elif opts["Type of input"]=="sparse matrix":
        X=sparse.csr_matrix(df)
    else:
        raise Exception("The Type of input option only
accept the following values: numpy array, sparse matrix")

    # Determine model. For more details, see:
    # https://bering-
ivis.readthedocs.io/en/latest/hyperparameters.html
    models = ["maaten","szubert","hinton"]
    if opts["Keras Model"]=="auto":
        if NumberDataPoints > 500000:
            keras_model = "szubert"
        else:
            keras_model = "maaten"
    elif opts["Keras Model"] in models:
        keras_model = opts["Keras Model"]
    else:
        raise Exception("The Model option only accept the
following values: auto, maaten, szubert, hinton")

    print("Running Ivis with keras model {} on {} data
points, using {} as input data type".format(keras_model,
NumberDataPoints,opts["Type of input"]))

    # Set ivis parameters
    model = Ivis(embedding_dims = opts["Embedding
Dimensions"],
                 k = opts["Number of Nearest Neighbours"],
                 n_epochs_without_progress = opts["Number
of epochs without progress"],
                 model = keras_model
                 )
    embeddings = model.fit_transform(X) # Generate
embeddings
    #Loop over dimensions and set results
    for dim in range(opts["Embedding Dimensions"]):
        res["Ivis {}".format(dim + 1)] = embeddings[:, dim]
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Algorith
m

Name

Script

    return res #return the res object that will be re-
imported into FCS Express

PHATE In this example script, the Python Transformation pipeline step is defined
to run Phate (Moon, K.R., van Dijk, D., Wang, Z. et al. Visualizing
structure and transitions in high-dimensional biological data. Nat
Biotechnol 37, 1482–1492 (2019). https://doi.org/10.1038/s41587-
019-0336-3). More information on Phate for Python can be found here.

Note: to run this script, Python, pandas and phate should be properly
installed on the user computer.

#This script allows you to run Phate as a Python
Transformation pipeline step in FCS Express 7.

#Detailed info on Phate in Python can be found at
https://pypi.org/project/phate/

from FcsExpress import *
try:
    from pandas import DataFrame
except ModuleNotFoundError:
    raise RuntimeError("Current Python distribution does
not contain Pandas. " +
        "To test this script please install pandas: " +
        "(https://pandas.pydata.org/pandas-
docs/stable/getting_started/install.html)")

try:
    import phate
except ModuleNotFoundError:
    raise RuntimeError("Current Python distribution does
not contain phate. " +
        "To test this script please install phate: " +
        "(https://pypi.org/project/phate/)")

parameter_map = {
    "knn": "Number Nearest Neighbors",
    "n_components": "Number of dimensions"
    }

https://www.krishnaswamylab.org/projects/phate
https://pypi.org/project/phate/
https://www.python.org/
https://pandas.pydata.org/pandas-docs/stable/getting_started/install.html
https://pypi.org/project/phate/
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Algorith
m

Name

Script

def RegisterOptions(params):
    #The full list of available parameters can be found at
#https://phate.readthedocs.io/en/stable/api.html
    RegisterIntegerOption(parameter_map["knn"], 5)
    RegisterIntegerOption(parameter_map["n_components"], 2)

def RegisterParameters(opts, params):
    for dim in range(opts[parameter_map["n_components"]]):
        RegisterParameter("Phate {}".format(dim + 1))

def Execute(opts, data, res):
    df = DataFrame(data)
    phate_operator = phate.PHATE(
        knn=opts[parameter_map["knn"]],
        n_components=opts[parameter_map["n_components"]]
        )

    df_phate = phate_operator.fit_transform(df)

    #Loop over dimensions and set results
    for dim in range(opts[parameter_map["n_components"]]):
        res["Phate {}".format(dim + 1)] = df_phate[:, dim]

    return res

9.3 Parameter Labels

FCS Express allows complete flexibility in labeling the plot axes with whatever
information the user desires. Typically, the plot axis labels are taken from the
FCS file header or are modified during an analysis session. However, sometimes
when acquiring data, the wrong parameter description is entered, or the default
parameter description is not modified, and you need to change the axes labels.

FCS Express allows you to create sets of alternate parameter labels associated
with the FCS file header parameters. When the new parameter label set is
selected during analysis, the alternate parameter label will display on the plot
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instead of the parameter label listed in the FCS file header. FCS Express allows
multiple parameter label sets to be defined, each of which is distinguished by a
unique name.

The advantage of a parameter label set is that it allows you to display different
axis information without changing the header of the FCS File. By changing the
plot axis options to use a parameter label set  instead of modifying the data in
the FCS File, you can customize the layout the way you want without affecting
your data.

To create a new parameter label set:

1.  Select the Tools Parameter Labels Modify Labels command.
2.  Click ... (ellipsis) button to select or change Template File used.
3.  Click the Add Set button.
4.  Enter a unique name for the new parameter set and click OK.
5.  Click the Add button.
6.  Select the parameter to modify.
7.  Enter the alternate text in the Label field.
8.  Click OK.
9.  Continue clicking the Add button to modify additional parameters for this

parameter label set. You can click on a label and modify it (or use the
Remove button to delete it).

10. Click OK to save the set

After creating the new parameter label set the data can be reloaded using the
Refresh  icon.  This will erase the data stored in the memory cache and reload
the data to reflect new changes.

Figure 9.176 shows a parameter label set named Lymphs that has been created
with eight alternate labels.

343

69
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Figure 9.170  Parameter Label Sets

If the axes are set to derive the axis labels from the Lymphs set, whenever
parameter 3 is shown on the plot, the axis label will be CD3 instead of the label
stored in the header of the FCS file. Selecting a set as the default set means that
it will appear by default in the Derive Axis Titles From Parameter label set radio
selection drop-down list of the Format Axes dialog .

Parameter Label Set Lists can be saved to and loaded from a file by selecting the
Tools Parameter Labels Save Labels or
Tools Parameter Labels Load Labels commands, respectively.
Parameter labels are automatically saved with the layout file .

9.4 Snapshots

Snapshots in FCS Express 7 provide a way to easily save multiple gate,
quadrant, or marker positions for quick access across samples in your analysis.
Snapshots can be manually defined by working with the Snapshots 
Navigator  or automatically each time a gate is moved while advancing through
the Data List using the Data tab  Next/Prev commands, or during Batch
Processing .  Automatically created Snapshots do not appear in the Snapshots
navigator. 

The Snapshots navigator can be opened from the Tools tab
category (Figure 9.177). 
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Figure 9.171 -
Snapshots Icon from

Ribbon

The Snapshots navigator (Figure 9.178) includes the following options:

· Create a new Snapshot - Creates a new Snapshot of the current gate,

marker, and quadrant positions.
· Create a new Folder - Creates a new folder in the Snapshot navigator to

organize Snapshots from the analysis.
· Delete - Deletes the selected Snapshot in the navigator.

· Rename the selected Snapshot - Renames the selected Snapshot in the

navigator.
· Apply Snapshot - Applies the selected Snapshot to the layout.

· Snapshot Date and Time - Records the Date and Time that a Snapshot of

the layout was created.
· Description - Allows user to describe selected snapshot
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Figure 9.172 The commands available in the Snapshots navigator.

9.4.1 Creating and Applying Snapshots

Snapshots provide an easy method for remembering multiple gate, marker, and
quadrant positions across different samples or analysis runs. Snapshots may be
created manual via the steps below or automatically by using Iteration
Snapshots .

To create a Snapshot on a layout containing plots and data:

1.  Open the Snapshots navigator from the Tool tab
category .

2.  Position any gates, markers, or quadrants as you would like the Snapshot to
save.

1212
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3.  Click on the green plus  button to create a new Snapshot.

4.  Enter a name for the Snapshot in the Snapshots navigator.

The position of the gates, markers, and quadrants on the layout are now saved
within the Snapshot you have created (Snapshot 1 in Figure 9.179 below). 

To create multiple Snapshots:

5.  Repeat steps 1-4 above and give the new Snapshot(s) a name (Snapshot 1,
Snapshot 2, and Snapshot 3 in Figures below).

To apply a Snapshot after the above steps 1-4 have been completed,

6.  Move gates, markers, or quadrants to a new position.

7.  Highlight the Snapshot in the Snapshots navigator that you intend to apply.
 
8.  Click the camera icon within the navigator (tooltip: "Apply Snapshot")

a.  Alternatively, drag the Snapshot name from the Snapshot navigator to a
blank space on the layout and drop it.

b.  Note in the figure below that "Snapshot 2" has been applied automatically
changing the shape of Gate 1, position of Gate 2, the Marker position, and
the position and type of Quadrant.

An unlimited number of Snapshots may be created and / or organized using the
folder icon (tooltip: "Create a new folder"). Once a folder is created you may
drag and drop any existing Snapshots into and out of the folder.
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Snapshot 1 from the Snapshot navigator is applied to the layout. Note the position
of Gate 4, the position of M1, and the position and style of the Quadrants.

Snapshot 2 from the Snapshot navigator has now been applied to the layout. Note
the changes from Snapshot 1 to the position of Gate 4, the position of M1, and the

position and style of the Quadrants.
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9.4.2 Iteration Snapshots

While analyzing your data, FCS Express automatically takes Snapshots of your

gate, marker, and quadrant positions. Snapshots are recorded automatically

when changing between iterations. For instance, by using the Next/Previous

buttons  to change data on all plots, or by clicking on an Iteration number in

the Data List  to change between iterations, or automatically while using the

Batch Processing  functionality. These automatic snapshots are referred to as

Iteration Snapshots, and do not appear in the Snapshots window .

Iteration Snapshots are always recorded but they are only applied in the

specific conditions below:

· Never applied: when Batch Processing using the Run  command.

· Always applied: when Batch Processing using the Rerun or Review mode .

· Applied, or not: depending on whether the Apply Iteration Snapshot button

is depressed or not, when loading iterations by using the Next/Previous

buttons  to change data on all plots, or by clicking on an Iteration number in

the Data List .

Note: Turning off the Apply Iteration Snapshot button will continue to record

new Iteration Snapshots but will stop applying them when changing between

iterations by using the Next/Previous buttons  to change data on all plots, or

by clicking on an Iteration number in the Data List . Importantly, this means

that, when changing between iterations, the previously recorded Iteration

Snapshots will be overwritten, and thus lost, with the current one (i.e with the

current gate, marker, and quadrant positions).

The Apply Iteration Snapshot button (Figure 9.180) is found under the Tools
tab category button.

Figure 9.173 - Apply
Iteration Snapshot

button. 
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If the Iteration Snapshot is enabled, FCS Express will take a Snapshot of each
iteration when the Previous/Next tools are used to manipulate the data in All
elements simultaneously.  The Snapshot will record all the properties of the
gating strategy.

The Figures below show how the Previous/Next buttons will advance to the
next iteration in All objects and record a Snapshot for each iteration. Notice how
the Iteration Snapshot button is depressed before clicking the Next command
(top figure). When data is changed to the next iteration (bottom figure,) new
gate, quadrant, and marker positions may be created and their positions will be
stored within that iteration. Clicking the previous button will revert the layout to
the previous file/iteration in the data list along with all of the gate, marker, and
quadrant positions remembered for that iteration.
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Depressing the Snapshot iteration button before clicking the Next button will cause
FCS Express to remember the position of any gates, quadrants, or markers before

moving to the next file/iteration in the data list.
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Taking Iteration Snapshots Using the Previous/Next Tools

In addition to using the Previous/Next button to simultaneously advance
through your data and take Snapshots, it is also possible to navigate through
your iterations by selecting the iteration number from the dropdown menu that is
located in Data tab (Figure 9.181).
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Figure 9.174 Navigating through Data Using the Iteration Number Dropdown Menu

Flagging Iterations

As you analyze your data using the Previous/Next tools, it's possible that you
might see something about your data that you would like to earmark for further
review.

In FCS Express, you can Flag an iteration by selecting the Flag this iteration
tool.  This tool can be found under Data tab (Figure
9.182).

You can also flag iterations during Batch Processing  and report the status of
an iteration as flagged or not flagged by using the Flag Status of Current Layout
Iteration  token. 
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Figure 9.175 Flag This Iteration Tool

Once an iteration is flagged, you can see which iterations are flagged in the Data
List .  Also, you will be able to review this data during Batch Processing by
adjusting the Batch Processing Options to Pause on Flagged Items .

9.5 Channel Calibration

Quantitative flow cytometry is used to determine the actual number of
fluorescent ligands (fluorochromes or fluorochrome-protein conjugate
molecules) labeling each particle. The technique requires calibration of the
fluorescence channel number with standards of known fluorochrome content.
The standards define the relationship between the observed fluorescence level
and the number of bound fluorochrome molecules.

Several companies have specially designed beads of different intensities where
the precise number of dye molecules per bead is known. By establishing a
standard curve correlating the channel number to the number of dye molecules
per bead, it is possible to determine the absolute number of molecules per cell of
antigen, antibody, and other useful markers.

This type of calibration has traditionally been a very labor intensive process,
requiring you to use your flow cytometry software to obtain a set of statistics
from the beads and the sample, then entering the statistics into a spreadsheet,

660
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creating a calibration curve, determining the standard channel values, and finally
performing more calculations using the spreadsheet to convert the statistics to
the number of binding sites per cell.

FCS Express can assist in automating the entire process for you using a weighted
linear regression. Once you have set up a channel calibration, all plots will
automatically display the calibrated axes if desired, and the statistics will be
displayed as calibrated values. Tokens may be used to monitor if a calibration
has been applied to an axis , what the last channel calibration loaded in the
layout  was, and provide detailed information about channel calibrations applied
in the layout or to a specified plot . To set up a channel calibration , you must
have a set of beads for which the number of fluorochrome molecules is precisely
known. In addition, you must know the effective fluorescence-protein ratio to
determine the number of dye molecules attached to each marker on the cells.

9.5.1 Creating a New Channel Calibration

To create a new channel calibration:

· Display the bead data in a histogram and create a marker  bounding each

bead as shown in Figure 9.183.

Figure 9.176 Setting Up Markers for Channel
Calibration

· Ensure that the plot being used as the raw data source for the calibration

does not itself have calibration applied by following Steps 11-9 of the
Channel Calibration tutorial .

· Select the Tools tab click Channel Calibration command (Figure 9.184).
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Figure 9.177 Channel Calibration Ribbon

· The Channel Calibration window  will appear (Figure 9.185).

Figure 9.178 Channel Calibration Window

· Click Add to create a new calibration. The New Calibration dialog will

appear (Figure 9.186).

1227
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Figure 9.179  New Calibration Dialog

· Select the parameter you wish to create the calibration for in the Create

calibration for drop-down list.
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· Choose the histogram which will serve as a data source for the calibration

from the Calculate regression from drop down list.

· Select the correct overlay from the histogram in the Overlay drop-down

list. When the histogram is selected, the marker box will automatically
create an entry for every marker that exists on that histogram. You can
choose to use fewer markers by changing the value in the Number of
peaks to use for regression field. You must use a minimum of three
markers to calculate the regression.

· Enter the number of molecules per bead next to the marker for that peak.

This information is supplied by the manufacturer of the beads.

· Click Calculate to calculate the new channel calibration. The equation for

the new calibration (Slope, Y Intercept, Correlation coefficient) will
appear in the Results box.

· The Dye molecules:Antibodies (also known as the F:P) ratio is typically

1:1, but you can change it to another value. The F:P ratio is supplied by the
manufacturer of the antibodies you are using in your experiment.

· Click OK to accept the new calibration.

The channel calibration may now be saved, edited, or reloaded from the
Channel Calibration dialog .

9.5.2 Using a Channel Calibration

FCS Express offers two levels of control in determining whether a parameter will
have a calibration applied to it: A global control, and an individual plot-by-plot
control.

If you do not want the calibration to be used at all, you can select the Tools
tab click Channel Calibration command and uncheck the Active checkbox
beside that calibration (Figure 9.187).

1221
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Figure 9.180 Channel Calibration Window with Active Checkbox

You can also choose which individual plots use the calibrations. The Specific
Options category of the Format window for both histograms  and 2D Plots
contains a Use channel calibrated on axis checkbox. If this checkbox is set,
calibrations will be used for any parameter that has a calibration defined. If the
Use channel calibrated on axis checkbox is not set, the calibration will not be
used, irrespective of whether or not that calibration is active (Figure 9.188).
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Figure 9.181 Channel Calibration on Axes in Formatting
Dialog

Tokens  in FCS Express also allow you to monitor if channel calibrations are
applied to any axis on your plots (below) and to monitor the last loaded
calibration file in the layout .
 
To monitor channel calibrations on either axis of a plot using the "Is channel
Calibration applied on the axis?" token type:

1.  Right click on a text box.
2.  Choose Insert Token.
3.  Choose Plot .

1284
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4.  Choose "Is channel Calibration applied on the X/Y axis?" in the Plot
Elements category.

5.  Click OK. 
6.  Click Insert. 

A new token will now be displayed in the text box indicating the calibration status
of the axis you chose for the indicated plot (Figure 9.189).

Figure 9.182 Using the "Is channel Calibration applied on the axis?" token type. The
token can be access through Plot Information>Plot Elements (red arrow). When

the token is inserted it will indicate if a channel calibration is applied on the X or Y
axis of a plot (green arrow).

To monitor the Last Loaded Channel Calibration File token type:

1.  Right click on a text box.
2.  Choose Insert Token.
3.  Choose Layout
4.  Click Insert. 

A new token will now be displayed in the text box indicating the last calibration
file that was loaded into the layout (Figure 9.190).
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Figure 9.183 Last Loaded Channel Calibration File
Token Type

Channel Calibration custom token formulas  can be utilized to extract
details of channel calibrations assigned to a layout or to a plot by via the Custom
Tokens dialog. (Figure 9.191).

1411
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Figure 9.192 Custom Token for Channel Calibration Details

The available variables to report via the custom token are listed below. Please
see the chapter on Creating Custom Tokens  to learn about using Custom
Tokens and the Channel Calibration Custom Token Formula reference
information for details on how to utilize the formula reference. 

· Antibodies - Determines the absolute value of fluorescent ligands

labeling each cell.
· Correlation - Displays how closely the equation fits the actual

data, with a value of 1 being a perfect fit.
· Decades - Represents the number of decades of dynamic range

your instrument is capable of measuring.
· Equation - is the linear regression formula that was used to

calibrate the channels.
· MinAb - Is the minimum number of fluorochromes you are able

to resolve.
· Parameter - Displays the parameter the channel calibration

applies to.
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· Ratio - Refers to the dye molecules:antibody ratio

· Status - Indicates whether this calibration is active or inactive for

the selected calibration.
· DyeMolecules - The correlation of the channel number to the

number of dye molecules per bead established from the standard
curve.

9.5.3 The Channel Calibration Window

The Channel Calibration window (Figure 9.193) shows all the current calibrations.
It is possible to have different calibrations defined for different parameters. FCS
Express will automatically use the appropriate calibration depending on which
parameters are displayed on a plot.

Figure 9.184 Channel Calibration Window

In the Channel Calibration window:

· Parameter # indicates which parameter the calibration applies to.

· Equation is the linear regression formula that will be used to calibrate the

channels.

· F:P refers to the dye molecules:antibody ratio that you selected.

· R tells you how closely your equation fit the actual data, with a value of 1

being a perfect fit.

· Min is the minimum number of fluorochromes you are able to resolve.
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· # Decades represents the number of decades of dynamic range your

instrument is capable of measuring.

· Active indicates whether this calibration will be applied for the selected

parameter.

To edit an existing calibration, click on a row (e.g., Parameter #2 above) to
highlight/select it and press Edit. This will bring up the New Calibration dialog for
that data, where you can change the values.

9.6 Concentration Calculator

Sometimes, you need to know the absolute concentration of the cells in your
sample. For example, you may be determining absolute lymphocyte counts or
counting bacterial populations. While most instruments allow for the accurate
determination of counts, they often do not report the volume of the sample that
was measured to obtain those counts.

FCS Express can calculate the sample volume from the flow rate and the sample
acquisition time, or from counts of beads added to a sample at a known
concentration.  It can also read the $VOL in FCS 3.1 files or the equivalent value
from Amnis DAF files.

FCS Express allows you to:

· Calculate individual concentrations.

· Have the concentration calculated automatically and appear directly on the

statistics window.

9.6.1 Calculating a Single Concentration

To set up the proper parameters for the concentration calculator, select the
Tools tab Calculate Concentration Calculator command.

To calculate a single concentration:

· Go to the Individual tab of the Concentration Calculator dialog (Figure

9.194).
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Figure 9.185 Concentration Calculator - Individual Tab

· Use the File to analyze drop-down list box to select the FCS file on which

you want to calculate the concentration. You can choose to calculate the
concentration for only a subset of cells by selecting a gate in the Gate to
analyze list box.
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· Select a method to calculate volume using Reference beads, acquisition

Time or Volume keyword in the data (see below).

· Press Calculate to calculate the actual concentration. The sample volume

will be displayed in the Volume Analyzed field and the concentration will be
displayed in the Sample Concentration field.

· Calculating Volume from Reference Beads

A common way to calculate the volume of a sample is to add a known
concentration of beads to your sample. By counting how many beads were
acquired in the time it took to acquire the sample, it is possible to calculate
the volume of the sample.

o Before opening the Concentration Calculator dialog, draw a gate

around your population of beads on a 2D Plot.
o Select the Reference Beads radio button.

o Select the gate created around beads from the Bead Gate drop-down

menu.
o Enter the concentration of the beads in the Bead Concentration field.

The concentration must be entered in units of beads/ml. You can enter
the concentration in scientific notation (e.g., 5 x 106/ml is entered as
5e6).

· Calculating Volume by Time

Some instrument sheath fluid flows at a well-defined rate. If you know the
flow rate, and the acquisition time, you can calculate the volume acquired.

o Enter the flow rate in the Flow Rate field in ml/min.

o The Start Time and End Time fields are automatically filled in from data

in the topmost FCS file header. If those times are not correct, you can
enter the start time and end time directly. The Total Time is calculated
as the difference between the start time and end time. You can also
enter data into the total time field directly.

· Calculating Volume by Keyword

A standardized keyword for sample volume run during acquisition ($VOL) was
introduced with the FCS 3.1 file format.  The keyword value is a floating point
number, which represents sample volume in nanoliters.  FCS Express can
read the keyword from FCS files and the equivalent from Amnis .daf files to
be used for calculating concentrations.
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o Before opening the Concentration Calculator dialog, insert a plot.  If

preferred, draw a gate around your population of interest.
o Select the Volume keyword in the data radio button.

9.6.2 Calculating Concentrations on the Statistics Page

You can also have the concentration calculated automatically on the statistics
window of a plot. In that case, you must tell FCS Express how the volume is to
be analyzed for that data file. The concentration will be calculated as the number
of cells in that statistics row divided by the volume. To set up statistics
concentration calculations, go to the Stats Window Setup tab of the
Concentration Calculator dialog (Figure 9.195) and enter the volume
parameters (by Reference Beads, Time, or Volume keyword in the data) in
a similar manner as for a single concentration .1228
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Figure 9.186 Concentration Calculator Dialog - Stats
Window Setup
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10 Quality

The Quality tab allows you to access Standard Operating Procedure features. 

Standard Operating Procedures are a tool unique to FCS Express where individual
steps may be defined for an analysis or layout. These steps allow you to create a
predetermined procedure in your FCS Express layouts in which each step can be
conditionally formatted with tokens so that a requirement must be met before
the next step is performed.

Each step may be  may be created  and permission rules  assigned to each
step. When complete, the SOP may be run from the Quality  tab.

10.1 Standard Operating Procedures

To help maximize efficiency and quality of routine analysis workflows, FCS
Express allows user to create Standard Operating Procedures (SOP's), which
are sets of step-by-step instructions and actions to perform in FCS Express.
These steps allow you to create a predetermined procedure in your FCS Express
layouts in which each step can be conditionally formatted with tokens so that a
requirement must be met before the next step is performed. For instance, a user
may not proceed to the next step unless the number of events in a gate is
above a certain threshold value or text has been entered in a field. Additionally,
hyperlinks  can be placed in the SOP to bring the user to a specific place within
the layout like a plot or other object.

Jump to:
Accessing and Navigating SOP's
Creating SOP's
Reordering SOP Steps
Deleting SOP Steps
Using SOP Permission Rules
Running SOP's
Displaying SOP information and SOP tokens
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The Standard Operating Procedure feature in FCS Express

10.1.1 Accessing and Docking SOP Navigator

To access the Standard Operating Procedures navigator, click on the Quality
tab  Standard Operating Procedures command (Figure 10.1).

Figure 10.1 Accessing SOP navigator

To dock the SOP navigator, click and drag the window's title bar to an edge of
the layout to activate docking zone sectors. Select the area by releasing mouse
on docking zone sector of choice  (Figure 10.2). See docking a window  for
more details.
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Figure 10.2 Docking SOP navigator

10.1.2 Creating the SOP

Standard Operating Procedures are created in a step-wise manner. Steps
may simply be instructions to follow in the Instructions field or may include
conditions that must be met before the next step in the SOP may be accessed. 
Conditions, can be specified in the Condition for moving to the next step field
of the SOP dialog.

For instance, in the example below, Figure 10.3, a formula was defined in the
Condition for moving to the next step field for the Beads Gate step (Step 1).
When the SOP is run, the step may not be advanced until the token value meets
the criteria of being above the reference value (0). In this case, the step is meant
to check to make sure events are present in the gate before proceeding to the
next step. Any tokens may be used to set a conditional custom value and may
be inserted  via right click in the Condition for moving to the next step field,
Insert Token. 
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Any manually entered value or token in FCS Express  may be used in the
Condition for moving to the next step. Tokens derived from the SOP itself
may also be used  and there are a number of specialized SOP functions
available within the custom token functions list . 

Values must be evaluated to "true" to allow advancing to the next step. Please
see the examples below  showing how a condition may be evaluated to allow
moving to the next step. 

Providing detailed instructions in the Instructions field is highly recommended,
so users may easily follow the necessary steps to advance when Running the
SOP . Text, tokens, and images may be inserted and used in the Instructions
field. Text may also be hyperlinked  to open additional layouts, move to a
specific object or page in the layout, or open an external URL. Hyper links are
accessed by selecting text and using the right click menu.  

Figure 10.3 An SOP has been defined where the first step is dependent on the
Condition for moving to the next step. In this example, the condition requires that

the number of events in the beads gate must be greater than 0.

To create a series of Standard Operating Procedure steps, add steps using
SOP navigator (Figure 10.4):

1.) Click  to add new step.
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2.) Rename the New SOP Step by clicking the  icon. Alternatively, right-click
on the step and select Rename, or highlight the step and press F2.
3.) Enter information into Short Description field. The text in the Short
Description field will appear in the Description area when running the SOP . 
4.) Populate Instructions field. The text in the Instructions field will appear in
the Instructions area when running the SOP .  You may also insert pictures in
the Instructions field by right-clicking  and clicking Insert Picture from the pop-
up menu, or by dragging and dropping an image from your directory folder.
    Optional: Create a token expression to control advancing to next step in SOP
if by entering an "=" sign under Condition for moving to the next step. 
5.) Right-click next to "=" sign in the field. 
6.) Choose Insert Token. 
7.) Choose a token to evaluate.
8.) Repeat steps 1-8 to add more steps until complete.
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Figure 10.4 Adding Steps to SOP

Use case examples of formulas to evaluate a result for
moving to the next step

Allow moving to the next
SOP step only if...

Condition for moving to the
next step formula

Equivalent
formula

Token1 is higher then a given
value (i.e. 50)

=Token1>50

Token1 is lower then Token2 =Token1<Token2
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Checkbox1 is checked =CheckBox1=-1 =IsTrue(Check
Box1)

Token1 and Token2 are both
higher than zero

=(Token1>0)and(Token2>0)

10.1.3 Changing Order of SOP Steps

The order of steps in an SOP may be rearranged easily by using drag and drop. 

1. Click on SOP step to highlight it.
2. Hold the left mouse button. 
3. Drag the step into the new position.
4. Release the mouse when blue line is positioned where desired (Figure 10.5).

Figure 10.5 Changing Order of Steps in SOP by clicking and dragging

The order of steps will update accordingly and may also be displayed in the
layout . 

10.1.4 Deleting SOP Step

Using the SOP navigator, steps may be deleted by:
1. Click on the step to highlight it.

2. Click on the  (Figure 10.6 left). Alternatively, right-click on the step and
choose Delete (Figure below - right).
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Figure 10.6 Deleting SOP steps.

The order of steps will update accordingly due to the deleted step and may also
be displayed in the layout . 

10.1.5 SOP Permission Rules and Authorizations

Permission Rules  and Authorizations  may be used in conjunction with
SOP's to allow or deny users of the layout to perform specific actions or to
Edit/Select objects.

Please see the Permissions Rules  section of the manual to learn more about
locking down specific actions that may be performed in the layout.

Please see the Authorizations  section of the manual to learn more about
allowing or never allowing selection or editing of plots. Authorizations may also
be conditionally formatted  to allow or never allow editing or selecting of
objects.   

10.1.6 Running SOP

The Run SOP command begins the step wise process of running through all of
the steps defined in the SOP creation process . When the Run SOP command
is selected from the  Quality tab the Standard Operating Procedure
dialog will appear (Figure 10.7) and will display the first step defined. The
Description area will display the information entered in the Short Description
field, the Instructions area will display the information entered in the
Instructions field . The current result of the condition (satisfied or not satisfied),
if any, is also reported in the SOP dialog.
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The left and right arrows in the bottom right of the dialog (figure below) will allow
the user to advance or go back through the Standard Operating Procedure
steps. If an Condition for moving to the next step  conditional statement
was defined, the user will not be able to advance until the condition is met. 

To run an SOP (Figure below):
1.) Click on the Quality tab  command to launch the Standard
Operating Procedure dialog. 
2.) Perform the instructions indicated in the Instructions area. 
3.) Click on the right arrowheads in lower right of SOP dialog to advanced
through the SOP steps. Note that if an Condition for moving to the next step
was defined the condition must be met before you are allowed to advance. 
4.) Optional: Click on the left arrowhead to go back to the previous SOP step. 

Note: The SOP Runner window is now dockable , so that you may perform
other actions while the SOP runs.

Once all SOP steps have been completed the Standard Operating Procedures
dialog will close.
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Figure 10.7 Opening SOP Window from ribbon

If the Standard Operating Procedure was run to completion previously, a
message will appear and ask if you wish to restart the SOP (Figure 10.8).
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Figure 10.8 Run SOP Message

10.1.7 Displaying SOP Information and SOP tokens

Once you have created an SOP in FCS Express, you may want to display the
details on your layout pages. 

SOP's details and status information can easily be displayed using the Insert
SOP table when right clicking in any text box  or by using tokens . 

An SOP token can display the following kinds of information:

SOP Token Type Explanation

Number of SOP
steps

The total number of steps in an SOP

Current SOP step
name

The name of the currently active step when running SOP
as defined by the user

Current SOP step
internal ID

The internal ID of the currently active step when running
SOP

Current SOP step
order number

The step order number when running SOP

Current SOP step
description

The step description when running SOP

Current SOP step
completion date

The last date the current SOP step was completed on. 

SOP step name The name of the selected step from the Create SOP
Token dialog

SOP step internal ID The internal ID of the selected step from the Create
SOP Token dialog

375 1284
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SOP step order
number

The  step order number of the selected step from the
Create SOP Token dialog

SOP step descriptionThe step description of the selected step from the
Create SOP Token dialog

SOP step completion
date

The last date the selected step from the Create SOP
Token dialog was completed on

To display the SOP tokens, you need to first create a text box .  There are two
ways to insert SOP tokens into the text box :

Using the SOP table

1. Right-click in the text box.
2. Select Insert SOP Table. 

A table will be created inside the text box, as shown below (Figure 10.9). 

Figure 10.9 Inserting the SOP Table

Using individual SOP tokens

1. Right-click in a text box.
2.  Select Insert Token . The Insert a Token  window will appear (Figure
10.10).
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Figure 10.10 Insert Individual SOP tokens

 
3. Click on the SOP node.
4. Select the type of SOP information you want to display.
5. Press Insert (in this example, we will choose  SOP step name) (Figure
10.11). The Create SOP token dialog will appear. Note: if the SOP is not
running when any of the follow tokens are inserted, "SOP is not running"  will
be the token value's display text in the text box: Current SOP step name,
Current SOP step internal ID, Current SOP step order number, Current
SOP step description, and Current SOP step completion date.
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Figure 10.11 SOP Tokens

6. Choose the SOP Information category in the Create SOP Token dialog. 
7. Select the Linked SOP step name from Token to Display drop down list.
8. Choose the step of interest from the Sop Step drop down list under Linked
SOP Step (Figure 10.12). 
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Figure 10.12 SOP Token Editor

 

9. Click OK. The token will appear in the text box (Figure 10.13). 

Figure 10.13
Text box with

Inserted Token

As with other tokens, you can change the Common Token Properties  of
Display Text and Font of individual SOP tokens in the SOP Token Editor.
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10.2 Permission Rules

Permission Rules allow you to set available permissions  specific to a layout.
They may be activated or disabled manually or via formula statements  in the
Permission Rules navigator. Please note that layout based  and user based
security group permissions will always take precedence over permission rules. 

Permission Rules can be accessed via the Quality tab SOP Permission
Rules button.(Figure 10.14).

Figure 10.14 - Accessing the Permission Rules navigator.

The Permission Rules navigator will appear (Figure 10.15) allowing you to
create and edit Permission Rules.
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Figure 10.15 - The Permission Rules navigator.

The top menu bar of the Permission Rules navigator allows you to (Figure

10.16) :

1. Create a new rule.

2. Create a new permission rule folder.

3. Delete one or more permission rules.

4. Rename the selected rule.
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5. Access the permission rule option. 

Figure 10.16 - The Permission Rules navigator menu bar. 

10.2.1 Creating a Permission Rule

To create a new Permission Rule first open the Permission Rules navigator

using the Quality tab SOP Permission Rules button. The Permission Rules

navigator will appear.

Click on the  button to create a new Permission Rule (Figure 10.17). A

New Rule will populate the Permission Rule window.
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Figure 10.17 - The Permission Rules navigator.

The new Permission Rule is named as New Rule by default but it can be easily

renamed by either of the following methods:

· Right click on the Permission Rule that needs to be renamed and select

Rename from the right click menu.
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· Select the Permission Rule that needs to be renamed via left click and press

F2 on your keyboard.

· Select the Permission Rule that needs to be renamed via left click and click on

the  button in the Permission Rule window.

A free-text description of the Permission Rule can also be added in the Rule

Description field of the Permission Rule window.

The Actions secured by this rule section of the Permission Rule window

contains the list of action that can be locked down via the permission rule. A

complete list of actions that can be secured via a Permission Rule can be found in

the Available Permission Rules section . 

The following buttons are available in the Actions secured by this rule section

of the Permission Rule window:

· Select All: to select all the available actions.

· Deselect All: to deselect all the available actions.

· Save Save Permissions to File: to export the list of secured actions as text

file (please see the  Save and Load Permission Rules Action List  topic).

· Load Save Permissions to File: to export the list of secured actions as text

file (please see the  Save and Load Permission Rules Action List  topic).

A permission rule can be turned on or off via a conditional formula. The

conditional formula a Permission Rule will be subjected to can be inserted in the

Rule Formula section of the Permission Rule window. The formula can contain

any of the operators and functions available for creating custom tokens (please

refer to the Custom Token Formula Reference  topic for the complete list of

available operators and functions). However, given that the formula has to be

conditional, one of the following operator need to be present:

· Conditional/Comparison operators.

· Logical Operators.
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· Logic (True/False) functions.

NOTE: The results of Permission Rules are dependent on the Permission Rules
Options .

10.2.2 Organizing Permission Rules in folders

Permission Rules can be organized in folders directly within the Permission Rules

window by either of the following methods:

· Right click on any empty area of the upper section of the Permission Rules

window and select New Folder from the Right Click menu.

· Right click on any Permission Rule and select New Folder from the Right Click

menu.

· Click on the  button in the Permission Rule window.

A folder can be renamed by either of the following methods:

· Right click on the folder that needs to be renamed and select Rename from

the Right Click menu.

· Select the folder that needs to be renamed via left click and press F2 on your

keyboard.

· Select the folder that needs to be renamed via left click and click on the 

button in the Permission Rule window.

10.2.3 Save and Load Permission Rules Action List

The list of actions secured by a Permission Rule  can be exported as text file in

order to be reloaded when needed.
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To export the list of actions secured by a Permission Rule:

1.  Click on the Save button of the Permission Rules window and select Save

Permission to File.

2.  A Select a file for saving permissions window opens.

3.  Select the file destination and enter a file name in the Select a file for saving

permissions window and click Save.

To Load a previously exported list of action secured by a Permission Rule:

1.  Click on the Load button of the Permission Rules window and select Load

Permission to File.

2.  A Select a file for loading permissions window opens.

3.  Select a previously exported lust of action in the Select a file for loading

permissions window and click Open.

4.  The list of actions is now loaded and displayed in the Actions secure by this

rule section of the Permission Rules window.

10.2.4 Editing a Permission Rule

To edit a Permission Rule first open the Permission Rules dialog using the Quality

tab SOP Permission Rules command. The Permission Rules dialog will

appear and will list the available Permission Rules.

Select the Permission Rule that need to be edited. The Rule Description, the list
Actions secured by this rule and the Rule Formula can now be edited.

10.2.5 Deleting a Permission Rule

To edit a Permission Rule first open the Permission Rules dialog using the Quality

tab SOP Permission Rules command. The Permission Rules dialog will

appear and will list the available Permission Rules.

A Permission Rule can be deleted by either of the following methods:

· Right click on the Permission Rule that need to be deleted and select Delete

from the Right Click menu.
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· Select the Permission Rule that need to be deleted via left click and press

Delete on your keyboard.

· Select the Permission Rule that need to be deleted via left click and click on the

 button in the Permission Rule window.

10.2.6 Permission Rules Options

Permission Rules Options can be accessed by either of the following methods:

· Click on the  button of the Permission Rules window.

· Right click on any empty area of the upper section of the Permission Rules

window and select Options from the Right Click menu.

Permission rules options defines whether the Action that are not included in

any rule will be:

· Allowed: all the actions not selected as permission rules will be allowed by

default (permissive approach).

· Not Allowed: all the action not selected as permission rules will be denied

(restrictive approach).

10.2.7 Available Permission Rules

Permission Rules allow the user to lock down one or more of the following
actions:

v Layout operations  

· Open layout
o Open

· Navigators and Other Dockable Windows
o Run Batch Processing
o Rerun Batch Processing
o Review Batch Processing
o View Batch Actions
o View Data List
o Format General
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o Format Overlays
o Format Axes
o Format Title
o Format Legend
o Format 3D
o Format Specific
o Format Size
o Format Fill
o Format Border/Line
o Format Authorizations
o Format Gate To Display
o Format Data Image
o Format Parameters To Display
o Format Markers
o Format Quadrants
o Format Color Levels
o Format Statistics
o Format Gate View
o Format Selecting Text Boxes
o Format Proliferation Fit
o Format DNA Fit
o Format DNA Background
o Format Position Markers
o Format Regression Fit
o Format Text Box Contents
o Format Spreadsheet Data
o Format 1D Stats
o View Layout Messages
o View Alers
o View Custom Tokens
o View Canned Comments
o View Compensations and Unmixing
o View Transformations
o View Run SOP
o View Snapshots
o View Standard Operating Procedures
o View Permission Rules

· Save layout

· Save layout as

· Print layout

· Clear Layout History

· Change Page Setup

· Save layout to PowerPoint

· Save PDF

· Publish Layout
v Edit operations

· Copy FCS data to the clipboard
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· View layout options

· Change layout options

· Insert new page

· Rearrange pages

· Delete page

· View page options

· Change page options

· Align objects

· Change Object Order
v Adjusting and resizing objects

· Move objects

· Resize objects

· Group objects

· Ungroup objects
v View operations

· View the layout history

· View the master page

· Change the number of visible pages

· View hidden pages
v Data file operations

· Open a Data file

· Modify the contents of a data file

· Add a column to a data file

· Delete a column from a data file

· Insert a row into a data file

· Delete a row from a data file

· Export a Data file

· Load data  that is not already loaded

· Create a new spreadsheet

· Export a spreadsheet

· Add to data list

· Search the data list

· Remove from the data list

· Format the Data List Options

· Move a file Up in the data list

· Move a file Down in the data list

· Increment/decrement file on selected/all objects

· Change file on selected/all objects

· View file header information

· Modify file header information

· Change the increment value
v Plots and other objects operations

· Insert stats window

· Insert plots and other objects
o Insert 2D Plots
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o Insert Histogram
o Insert Kinetics
o Insert Multicycle DNA
o Insert Proliferation
o Insert Subtraction
o Insert Text Box
o Insert Gate View
o Insert Picture
o Insert Data Grid
o Insert Bar
o Insert Pie
o Insert Box and Whisker
o Insert Scatter
o Insert Plate Heat Map
o Insert Gates Heat Map
o Insert Parameters Heat Map
o Insert Spectrum
o Insert Levey Jennings
o Insert AutoShapes

· Remove 2D plots

· Remove histograms

· Remove subtraction histograms

· Remove DNA histograms

· Remove Proliferation histograms

· Remove text boxes

· Remove picture

· Remove data

· Remove Gate View

· Remove AutoShape

· Remove stats window

· Change parameters on a histogram

· Change parameters on a 2D plot

· Add overlay to a histogram

· Add overlay to a 2D plot

· Copy Plot Data

· Remove overlay from a histogram

· Remove overlay from a 2D plot

· Reorder overlay in a histogram

· Reorder overlay in a 2D plot

· Edit the text on a text box

· View the format of a 2D plot

· View the format of a 1D plot

· View the format of an AutoShape

· View the format of a text box

· View the format of a picture

· View the format of a data object
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· View the format of a statistics window

· Change the format of a 2D plot

· Change the format of a 1D plot

· Change the format of an AutoShape

· Change the format of a text box

· Change the format of a picture

· Change the format of a data object

· Change the format of a statistics window

· Change the visibility of statistics

· Autosize statistics window

· Delete Table Cells

· Insert Table

· Insert Table Cells
v Gate, marker and quadrant operations

· Create a new gate

· Modify a gate

· Remove a gate

· Modify gate information

· Add a combination gate

· Change Gate Properties

· Create a new marker

· Modify a marker

· Remove a marker

· Gate fellowship Link

· Break Gate fellowship

· Show quadrants

· Hide quadrants

· Modify quadrants

· GatingML Import

· GatingML Export
v Parameter Labels operations

· View parameter label sets

· Modify parameter label sets

· Load a set

· Save the list of sets
v Batch Processing and Alerts operations

· Alerts
o Run alerts
o Add a new alert
o Delete an alert
o Edit the text in an alert
o Add token to alert formula
o View token properties for the alert formula
o Edit alert formula token properties

· Batch Processing



Quality 1261

© 2023 De Novo Software

o Flag an iteration
o View batch processing options
o Change batch processing options
o Add save batch actions

§ Add Save Layout batch action
§ Add Save PDF batch action
§ Add Save Picture batch action
§ Add Save PowerPoint batch action
§ Add Print batch action
§ Add Publish Layout batch action
§ Save Data Files

· Add Save GatingML
o Add batch folders

§ Add Folder
o Add report batch actions

§ add Export To Spreadsheet
§ add Export To Excel (Column Mode)
§ add Export To Excel (Cell Mode)
§ add Word Report
§ add PDF Form
§ add Text Report

o Add items to reports
§ add Regular Token
§ add Statistic Token
§ add Keyword Token
§ add Picture
§ add Text Box
§ add PDF
§ add Layout
§ add PowerPoint
§ add FCS File

o Rename batch actions
o Paste batch actions
o Delete batch actions
o View batch action details
o Change batch action details
o Change batch action Running Options

v Canned Comment operations

· Add a new Canned Comment

· Delete a Canned Comment

· Edit the text in a canned comment

· Add a token to a canned comment

· View canned comment token properties

· Edit canned comment formula token properties
v Channel Calibration operations

· View Channel Calibration settings

· Add a Channel Calibration
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· Delete a Channel Calibration

· Load Channel Calibration settings

· Save Channel Calibration settings

· Modify settings

· Calculate Channel Calibration

· Edit a Channel Calibration
v Compensation operations

· Modify compensation

· Import compensation

· Export compensation

· Create compensation

· Delete compensation

· Create Unmixing

· Delete Unmixing

· Assign compensation

· Run Automatic Compensation

· Apply to all plots

· Apply to selected plots
v Transformation operations

· Create Parameter Math transformation

· Create PCA transformation

· Create Pipeline Transformation

· Create Divide Mean and SD pipeline step

· Create Divide Max and Min pipeline step

· Create Thresholding pipeline step

· Create Scaling pipeline step

· Create Merge to Spectra pipeline step

· Create Python pipeline step

· Create Simple parameter math pipeline step

· Create UMAP pipeline step

· Create Downsampling pipeline step

· Create tSNE pipeline step

· Create MST pipeline step

· Create Graph Plot Layout pipeline step

· Create PCA pipeline step

· Create Parameter Removal pipeline step

· Create Unmixing pipeline step

· Create spectral extraction pipeline step

· Create flowAI pipeline step

· Create flowSOM pipeline step

· Create SPADE pipeline step

· Create SOM Pipeline step

· Create Batch SOM pipeline step

· Create Consensus pipeline step

· Create Kmeans transformation (NB: this also apply to Kmeans pipeline step)
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· Create Hierarchical pipeline step

· Create ramp parameter pipeline step

· Create Bernoulli parameter pipeline step

· Create Beta parameter pipeline step

· Create Binomial parameter pipeline step

· Create Cauchy parameter pipeline step

· Create ChiSquare parameter pipeline step

· Create Erlang parameter pipeline step

· Create Exponent parameter pipeline step

· Create FDistribution parameter pipeline step

· Create Gamma parameter pipeline step

· Create GenPareto parameter pipeline step

· Create Geometric parameter pipeline step

· Create Gumbel parameter pipeline step

· Create HyperGeometric parameter pipeline step

· Create Laplace parameter pipeline step

· Create Logistic parameter pipeline step

· Create LogNormal parameter pipeline step

· Create Maxwell parameter pipeline step

· Create NegBinomial parameter pipeline step

· Create Normal parameter pipeline step

· Create Poisson parameter pipeline step

· Create Rayleigh parameter pipeline step

· Create StudentTDist parameter pipeline step

· Create Triangular parameter pipeline step

· Create Uniform parameter pipeline step

· Create Weibull parameter pipeline step

· Create R Add Parameters  transformation

· Create R Add Clustering  transformation

· Create tSNE transformation

· Create SPADE transformation

· Modify transformation

· Load Parameter Math Sequence from file

· Save Parameter Math Sequence to file

· Delete transformation
v Other tools

· Modify Concentration calculator settings

· Concentration calculator calculate

· Histogram subtraction

· Batch export

· Diva Import

· CFlow Import
v Security Operations

· Electronic Signature operations
o View signature list



FCS Express 7 Manual1264

© 2023 De Novo Software

o Change signature list
o Sign
o Unsign

v Snapshot operations

· Add snapshot

· Edit snapshot

· Delete snapshot

· Apply snapshot
v SOP operations

· Add SOP Step

· Delete SOP Step

· Edit SOP Step

· Reset SOP Run Status

· Rerun SOP
v Permission Rule operations

· Add Permission Rule

· Delete Permission Rule

· Edit Permission Rule
v Help operations

· View help

· View tutorials

· View manual

· Go to the De Novo Software web site

· Enter countercode

· View About screen
v Panel operations

· View the panel information

· Add a panel

· Edit a panel

· Remove a panel

· Load panels from a file

· Save panels to a file

· Change the panel information

· Change the name of a panel

· Change the number of tubes in a panel
v Token operations

· Custom Tokens
o Add custom token
o Delete custom token
o Add token to custom token formula
o View custom formula token properties
o Edit custom formula token properties
o Edit the text in a custom formula

· Change Font Classification

· Add Font Classification
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· Edit Font Classification

· Reorder Font Classification

· Remove Font Classification

· Token Bounds Change

· Add Statistic Classification

· Edit Statistic Classification

· Reorder Statistic Classification

· Remove Statistic Classification

· Add Keyword

· Remove Keyword

· Add token to a text box

· View text box token properties

· Edit text box token properties
v Formatting Operations

· Bold

· Bullets

· Font

· Font Background

· Font Color

· Font Name

· Font Size

· Gate Formula Change

· Indent Text

· Italics

· Justify Text

· Underline
v Keywords Anonymizer
v Page Tab Operations

· Change Page Tab Color Classification

· Add Page Tab Color Classification

· Edit Page Tab Color Classification

· Reorder Page Tab Color Classification

· Remove Page Tab Color Classification
v Override Authorizations
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11 Statistics

FCS Express can generate any statistic that one would need for analysis of flow
cytometry data. Statistics can be calculated either from a 1D or 2D plot.
Statistics calculated base on a plot are only calculated for cells currently showing
on the plot according to the current gate . 

Statistics may be accessed in default statistics windows or tables or represented
anywhere within FCS Express as tokens . Custom statistics may also be
derived from any plot or user based input by accessing custom tokens .

FCS Express calculates statistics to be accurate to the IEEE single precision
floating point standard, as described in
http://ieeexplore.ieee.org/xpl/articleDetails.jsp?
arnumber=4610935&contentType=Standards and
http://en.wikipedia.org/wiki/Single-precision_floating-point_format. Intermediate
calculations may be performed with more precision, if available. 

More information on the default statistics available for 1D- and 2D-plots, as well
as using and formatting statistics are in the sections below:

· Histogram statistics

· 2D plot statistics

· Custom tokens  (user defined statistics and more)

· Using statistics and the clipboard

· Formatting statistics

The following newer statistics are described further in subsequent pages and are
also available to be displayed as default statistics:

o Percent of Gated - Parent

o Percent of Gated - Grandparent

o BD Robust Standard Deviation (rSD in BD FACSDiva)

o BD Robust coefficient of variation (rCV in BD FACSDiva)

11.1 Histogram Statistics

Statistics will be calculated for every overlay on the histogram. If there are
markers, statistics will be calculated for every overlay that the marker applies to
(see Creating Markers  and Histogram Markers ).

To view the histogram statistics, right-click on the plot and select Histogram

Statistics from the pop-up menu (Figure 11.1 below, ).

Individual statistics may be toggled on and off by right-clicking on the default

statistics table (Figure below, ), or from the Formatting Statistics  menu. 
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Figure 11.1  Adding a default statistics table from a histogram

The available statistics are shown in the table below.

Statistic Explanation

Histogram # If there are multiple overlays visible on a plot, then the statistics will be
calculated for every overlay. Histogram # displays the overlay number
for that row of statistics. The overlay number corresponds to the
position in the overlay list on the Overlays  page of the Format
window.

Overlay Color The color legend for the overlay(s) displayed on the histogram
Note: if you are running the latest release of FCS Express 7 and you
cannot see this option, please restore your User Options to default
values  (please consider that this procedure will restore all your User
Options to default settings)

Overlay legend
text

The text defined for the overlay in the Legend Text field of the Overlays
category .

Filename The file name of the overlay.

Parameter The parameter name for the parameter that is being displayed on the
overlay. The field that the parameter name is taken from can be set in
the FCS Express User Options Dialog under Data Loading - FCS File
Options .

Overlay Gate The name of the gate that is currently being applied to the overlay.
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Marker If there are several markers visible on a plot, then the statistics will be
calculated for each overlay that the marker applies to. Marker displays
the marker number for that row of statistics. The marker number
corresponds to the position in the marker list on the Markers page of
the Format window (see Histogram Markers ).

Low bound The channel number of the low boundary of the marker.

High bound The channel number of the high boundary of the marker.

# of Events The number of events that are accepted by the gating formula.

% of all cells The number of events that are accepted by the gating formula and are
located within the specified marker divided by the total number of
events in the FCS file.

% of gated
cells

The number of events that are accepted by the gating formula and are
inside the specified marker divided by the total number of events
displayed on the plot.

Median The median channel value of the events that are accepted by the
gating formula that fall within the specified marker.

Geometric
Mean

The geometric mean channel number of the events that are accepted
by the gating formula that fall within the specified marker. Similar to
arithmetic mean except that the numbers are multiplied and the Nth root
of the resulting product is taken.

Arithmetic
Mean

The arithmetic mean channel number of the events that are accepted
by the gating formula that fall within the specified marker.

CV (Coefficient
of Variation)

The coefficient of variation of events that are accepted by the gating
formula that fall within the specified marker. The CV is a measure of the
distribution of your data and is equal to the standard deviation divided
by the mean.

RCV (Robust CV) The Robust Coefficient of Variation of events that are accepted by the
gating formula. The RCV may be more applicable than the CV for
populations that do not follow a normal Gaussian distribution. The RCV is
equal to 0.75 multiplied by the interquartile range divided by the median.

The interquartile range is the 75th percentile channel minus the 25th

percentile channel.

5%-ile(5th

percentile)
The channel corresponding to the 5th percentile of the cells that have
been accepted by the gating formula.

95%-ile (95th

percentile)
The channel corresponding to the 95th percentile of the cells that have
been accepted by the gating formula.

25%-ile (25th

percentile)
The channel corresponding to the 25th percentile of the cells that have
been accepted by the gating formula.

75%-ile (75th

percentile)
The channel corresponding to the 75th percentile of the cells that have
been accepted by the gating formula.

Concentration The concentration of the cells that are accepted by the gating formula.
The parameters for the concentration calculation can be set up in the
Concentration Calculator .

Percent
Positive

The percentage of the cells accepted by the gating formula that are
positive with respect to the control overlay. The control overlay is set
in Histogram Specific Options . The Overton Subtraction method
statistic will be displayed.  

Standard
Deviation

A measure of the variation from the average for the events. The square
root of the variance.

% of gated -
parent

The number of events that are accepted by the gating formula and are
inside the specified marker divided by the total number of events in the
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parent gate.

% of gated -
grandparent

The number of events that are accepted by the gating formula and are
inside the specified marker divided by the total number of events in the
grandparent gate.

BD-rSD The BD Biosciences robust standard deviation. See the full description
by BD Biosciences.
*Note: To convert the BD-rSD to the MAD (Median Absolute Deviation)
BD-rSD statistic, divide the BD-rSD by 1.4826.

BD-rCV The BD Biosciences robust coefficient of variation of events that are
accepted by the gating formula that fall within the specified marker. See
the full description by BD Biosciences.

% of custom
denominator
gate

The number of events that are accepted by the gating formula and are
inside the specified marker divided by the total number of events in the
custom denominator gate defined in the 1D Stats Options  dialog.

Additional Options for 1D Statistics are available through the 1D Stats Options

dialog, e.g. the ability to display statistics for the entire overlay with no marker
applied and the ability to define the Gate to use as denominator for the % of
custom denominator gate statistics (see table above).

11.2 2D Plot Statistics

There are two kinds of statistics that can be displayed for a 2D plot (Gate
Statistics and Quadrant Statistics). The same statistics are available in either
case. 

· Gate Statistics

The statistics are calculated for every gate designated in the Gates to
Display data option for the statistics window, even if the gate is not being
displayed on the plot. The Gates to Display can be chosen from a dialog
accessible from the Format Data Options Gates To Display command,
or in the Formatting Statistics  dialog shown by right-clicking on the
statistics window and choosing Format from the pop-up menu. 

· Quadrant Statistics

The statistics are calculated for every quadrant. There will be four rows of
statistics for each overlay with each row corresponding to a different
quadrant. Quadrant statistics displayed on the plot may be changed by
formatting the Label Text Box containing the statistic . 

In order to open a statistics window, right-click on a 2D Plot and choose Gate

Statistics (Figure 11.2 below, ) or Quadrant Statistics (if quadrants are not
currently shown on the plot, this option is not enabled) from the pop-up menu. 
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Individual statistics may be toggled on and off by right-clicking on the default

statistics table (Figure below, ), or from the Formatting Statistics  menu. 

Figure 11.2  Adding a default statistics table from a 2D plot

The available statistics are shown in the table below. A region can refer to a gate
or quadrant.

Statistic Explanation

Overlay Color The color legend for the overlay(s) displayed on the plot.
Note: if you are running the latest release of FCS Express 7 and you
cannot see this option, please restore your User Options to default
values  (please consider that this procedure will restore all your User
Options to default settings)

Overlay # If there are multiple overlays visible on a plot, the statistics will be
calculated for every overlay on the plot. Overlay # displays the overlay
number for that row of statistics. The overlay number corresponds to the
position in the overlay list on the Overlays  page of the Format window.

Overlay
legend text

The text defined for the overlay in the Legend Text field of the Overlays
category .

FCS Filename The file name corresponding to the overlay number.

Gate Color The color legend for the existing gates.
Note: if you are running the latest release of FCS Express 7 and you
cannot see this option, please restore your User Options to default
values  (please consider that this procedure will restore all your User
Options to default settings)

Overlay Gate The name of the gate that is currently being applied to the overlay.
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Statistic Explanation

Gate The region for which the statistics apply. This region can be either a gate
or quadrant designation.

# of Events The total number of events in this region accepted by the gating formula.

X Geometric
Mean

The geometric mean channel number of the events on the X-axis that are
accepted by the gating formula. Similar to arithmetic mean except that
the numbers are multiplied and the Nth root of the resulting product is
taken.

Y Geometric
Mean

The geometric mean channel number of the events on the Y-axis that are
accepted by the gating formula. Similar to arithmetic mean except that
the numbers are multiplied and the Nth root of the resulting product is
taken.

X Arithmetic
Mean

The mean X-axis channel value of cells in this region that are accepted
by the gating formula.

Y Arithmetic
Mean

The mean Y-axis channel value of cells in this region that are accepted
by the gating formula.

X Median The median X-axis channel value of cells in this region that are accepted
by the gating formula.

Y Median The median Y-axis channel value of cells in this region that are accepted
by the gating formula.

X CV
(Coefficient of
Variation)

The coefficient of variation of X-axis events that are accepted by the
gating formula that fall within the specified marker. The CV is a measure
of the distribution of your data and is equal to the standard deviation
divided by the mean.

Y CV The coefficient of variation of Y-axis events that are accepted by the
gating formula that fall within the specified marker.

X RCV (Robust
CV)

The Robust Coefficient of Variation of X-axis events that are accepted by
the gating formula. The RCV may be more applicable than the CV for
populations that do not follow a normal Gaussian distribution. The RCV is
equal to 0.75 multiplied by the interquartile range divided by the median.

The interquartile range is the 75th percentile channel minus the 25th

percentile channel.

Y RCV The Robust Coefficient of Variation of Y-axis events that are accepted by
the gating formula.

% of Gated
Cells

The total events in the specified region divided by the total number of
events on the whole plot accepted by the gating formula.

% of custom
denominator
gate

The number of events that are accepted by the gating formula divided by
the total number of events in the custom denominator gate defined in the
2D Stats Options  dialog.

% of All Cells The total events in the specified region divided by the total number of
events in the FCS file.

Concentration The concentration of the cells that are accepted by the gating formula.
The parameters for the concentration calculation can be set up in the
Concentration Calculator .

X Standard
Deviation

A measure of the variation from the average for the events on the X-
axis. The square root of the variance.

Y Standard
Deviation

A measure of the variation from the average for the events on the Y-
axis. The square root of the variance.

X BD-rSD The BD Biosciences robust standard deviation for X axis events. See the
full description by BD Biosciences.
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Statistic Explanation

*Note: To convert the X BD-rSD to the MAD (Median Absolute Deviation)
X BD-rSD statistic, divide the X BD-rSD by 1.4826.

Y BD-rSD The BD Biosciences robust standard deviation for Y axis events. See the
full description by BD Biosciences.
*Note: To convert the Y BD-rSD to the MAD (Median Absolute Deviation)
Y BD-rSD statistic, divide the Y BD-rSD by 1.4826.

X BD-rCV The BD Biosciences robust coefficient of variation of X-axis events that
are accepted by the gating formula that fall within the specified marker.
See the full description by BD Biosciences.

Y BD-rCV The BD Biosciences robust coefficient of variation of Y-axis events that
are accepted by the gating formula that fall within the specified marker.
See the full description by BD Biosciences.

% of gated -
Parent

The number of events that are accepted by the gating formula and are
inside the specified gate divided by the total number of events of the
parent of the gate applied to a plot.

% of gated -
Grandparent

The number of events that are accepted by the gating formula and are
inside the specified gate divided by the total number of events of the
grandparent of the gate applied to a plot.  

11.3 Using Statistics and the Clipboard

It is possible to copy any single statistic, or a group of contiguous statistics, from
the statistics window to the clipboard. First, you must select the cells you wish to
copy by clicking. You can then paste the statistics into a text box  that will be
automatically inserted on your layout, or outside of FCS Express* (e.g, to a text
file, or a spreadsheet). Cutting cells from the statistics window is not allowed; 
instead, toggle  the desired statistic off.

To select statistics from a default statistics table: 
· Click in a cell to select it. The background of the cell will be highlighted in

blue. 
· To select a group of contiguous cells, select the first cell of the group to

highlight it. Then, while holding the Shift key, select the last cell of the
group. All of the selected cells will have a blue background.

After you have selected the cells you wish to copy, either:
· use the Home Clipboard Copy Text command (or Ctrl+C) to copy the

statistics [i.e., statistic name(s) and selected cell(s)] to the clipboard (Figure
11.3).
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· drag the statistic(s) out to an empty spot on your layout to insert them

into their own text box.

Figure 11.3
Clipboard

from Home
tab

* Note: If a large number of statistics from various plots, tables, or from multiple
.fcs data files are to be exported, Batch Processing  is a more efficient method.

Also, statistics can be embedded into a plot directly by dragging and dropping
from a Statistics table .

By selecting the statistics and then dragging them onto a plot, FCS Express will
automatically create a table that is embedded within the borders of that plot.

That table can be edited and manipulated  like any other table that is added to
a text box.

Copying Histogram Data:

The Bin and Count numbers of histogram data may be copied from any
histogram and pasted within FCS Express or any software, such as Excel, for
further review. To Copy Histogram Data (Figure. 11.4):

1.  Right click on a histogram.
2.  Choose Copy Histogram Data.
3.  Choose the Overlay to copy data from.
4.  Paste the data in FCS Express or any other software with  control+V or any

other paste command.
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Figure 11.4 Using the copy histogram data feature. Notice the red highlighted table
in which the first 5 bins of data from the histogram are displayed upon a paste

command.

11.4 Formatting Statistics

There are several options to control which statistics get displayed in any
individual statistics window.

You can change the displayed statistics in either of the following ways:

· Right-click on the statistics window. In the pop-up menu, there will be a list

of available statistics. You can individually toggle any statistic from this
menu. If the statistic is selected, a check mark will appear next to the name
(Figure 11.5).
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Figure 11.5 Toggling individual statistics on and off via the right-click menu

· Access the Formatting options for the Statistics window by either of these

two methods:
o right-click on the Statistics window and select Format. In the

pop-up window, select the Stats category from the drop down.
 

o select the Statistics window and use the Format

tab Statistics Options Statistics command.  
Then, individually select/deselect each statistic you want to display by
checking/unchecking the appropriate check box in the Select Statistics list
box.  You may also Select or Deselect All by right clicking in the Select
Statistics list (Figure 11.6).
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Figure 11.6 Select/Deselect All statistics

To format the statistics window, right-click on it and select Format from the
pop-up menu. Several categories will be available to set various options from the
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drop down, such as the size of the statistics window, border, which statistics are
available, and which gate(s) you would like to see statistics for .

To set the default statistics that appear when you first open a statistics window,
use the 1D Plot Statistics  or the 2D Plot Statistics  category in the User
Default Options. This feature is convenient if you routinely prefer to see the
same set of statistics during data analysis.

Details on statistic options and number display options may be found in the
description for 1D Plot Statistics  or the 2D Plot Statistics  as they related to
FCS Express user options. 

11.5 Percent Gated - Parent and Percent Gated -
Grandparent

The statistics % Gated - Parent and % Gated - Grandparent are available in
FCS Express.
See also % of custom denominator gate for 1D-  and 2D plots .

These are defined as follows:

% Gated -
Parent

The number of gated events divided by the number of events of the
parent of the gate that is applied to a plot, multiplied by 100.

% Gated -
Grandparent

The number of gated events divided by the number of events of the
grandparent of the gate that is applied to a plot, multiplied by
100.

We will examine these statistics in terms of real data.  Figure 11.7 represents an
analysis with sequential gating.  
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Figure 11.7 - Analysis with Sequential Gating

When observing Gate 5...  In Plot #10 (the lower right 1D histogram), there is a
Marker that was converted to Gate 5.  Gate 5 contains 40 events.

The gate that is applied to Plot #10 is Gate 4.  Therefore, the statistic for Gate 5
% Gated is defined as the number of Gate 5 events (40) divided by the number
of Gate 4 events (2203) multiplied by 100.  In this case, the numerical formula is
(40/2203)x100, which equals 1.8157.

The statistic for Gate 5 % Total is defined as the number of Gate 5 events (40)
divided by the Total Number of events collected (20,000).  The numerical
formula is (40/20000)x100, which equals 0.2.

The statistic for Gate 5 % of Gated - Parent is defined as the number of gated
events (40) divided by the number of events for the parent of the gate applied
to Plot #10.  As can be seen in Figure 11.8, Gate 4 has been applied to Plot #10.
 The parent of Gate 4 is Gate 3.  So, the statistic for Gate 5 % of Gated -
Parent is defined as the number of Gate 5 events divided by the number of Gate
3 events multiplied by 100.  The numerical formula is (40/2407)x100, which
equals 1.6618.
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Figure 11.8 - Showing the Parent and Grandparent of Gate 4

The statistic for Gate 5 % of Gated - Grandparent is defined as the number of
gated events (40) divided by the number of events for the grandparent of the
gate applied to Plot #10.  As can be seen in Figure 2, Gate 4 has been applied to
Plot #10.  The parent of Gate 4 is Gate 3.  The parent of Gate 3 is Gate 2.  So,
the statistic for Gate 5 % of Gated - Grandparent is defined as the number of
Gate 5 events divided by the number of Gate 2 events multiplied by 100.  The
numerical formula is (40/2830)x100, which equals 1.4134.

11.6 Spreadsheet Statistics from Data Files

Spreadsheets may be populated by statistics from the data files available in the
Data List  using the drag-and-drop feature.  The available statistics are shown
in the table below.

Statistic Explanation

Filename The file name of the file.

Parameter The name of the parameter selected from the Parameter drop down
menu under Data File Information within the Edit Statistic window.

Gate name The name of the gate that is currently being applied to the file.

Min value The number of the minimum value for the selected parameter from the
Parameter drop down menu under Data File Information within the
Edit Statistic window for the events in the data file that are accepted
by the gating formula.

Max value The number of the maximum value for the selected parameter from the
Parameter drop down menu under Data File Information within the
Edit Statistic window for the events in the data file that are accepted
by the gating formula.

# of Events The number of events that are accepted by the gating formula.

% of custom
denominator
gate

The number of events that are accepted by the gating formula divided
by the total number of events in the gate specified by the
Denominator Gate for Custom Percentage dropdown menu of the
Create Statistic dialog window .

% of parent The number of gated events that are accepted by the gating formula
and in the specified gate divided by the total number of events in the
parent gate of the specified gate.
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% of
grandparent

The number of gated events that are accepted by the gating formula
and are in the specified child gate divided by the total number of events
in the grandparent gate of the specified gate.

% of great
grandparent

The number of gated events that are accepted by the gating formula
and are in the specified gate divided by the total number of events in
the great grandparent gate of the specified gate.

% of all cells The number of gated events that are accepted by the gating formula
and are located within the specified gate divided by the total number of
events in the FCS file.

Median The median channel value of the events that are accepted by the
gating formula.

Geometric
Mean

The geometric mean channel number of the events that are accepted
by the gating formula that fall within the specified gate. Similar to
arithmetic mean except that the numbers are multiplied and the Nth root
of the resulting product is taken.

Arithmetic
Mean

The arithmetic mean channel number of the events that are accepted
by the gating formula that fall within the specified gate.

CV (Coefficient
of Variation)

The coefficient of variation of events that are accepted by the gating
formula that fall within the specified gate. The CV is a measure of the
distribution of your data and is equal to the standard deviation divided
by the mean.

RCV (Robust CV) The Robust Coefficient of Variation of events that are accepted by the
gating formula. The RCV may be more applicable than the CV for
populations that do not follow a normal Gaussian distribution. The RCV is
equal to 0.75 multiplied by the interquartile range divided by the median.

The interquartile range is the 75th percentile channel minus the 25th

percentile channel.

5%-ile(5th

percentile)
The value corresponding to the 5th percentile of the cells that have
been accepted by the gating formula.

95%-ile (95th

percentile)
The value corresponding to the 95th percentile of the cells that have
been accepted by the gating formula.

25%-ile (25th

percentile)
The value corresponding to the 25th percentile of the cells that have
been accepted by the gating formula.

75%-ile (75th

percentile)
The value corresponding to the 75th percentile of the cells that have
been accepted by the gating formula.

Concentration The concentration of the cells that are accepted by the gating formula.
The parameters for the concentration calculation can be set up in the
Concentration Calculator .

Standard
Deviation

A measure of the variation from the average for the events. The square
root of the variance.

BD-rSD The BD Biosciences robust standard deviation. See the full description
by BD Biosciences.
*Note: To convert the BD-rSD to the MAD (Median Absolute Deviation)
BD-rSD statistic, divide the BD-rSD by 1.4826.

BD-rCV The BD Biosciences robust coefficient of variation of events that are
accepted by the gating formula that fall within the specified marker. See
the full description by BD Biosciences.
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12 Tokens

FCS Express allows you to insert special items, called Tokens, into a Text Box.
Tokens appear as text, but are dynamically evaluated and can display
information such as plot statistics, FCS file keywords, layout properties, and
system information. For example, tokens can be used to display the number of
pages in a layout, the percentage of events in a quadrant, and the instrument
used to acquire data.

Once a token is placed in a Text Box, the displayed information acts like any
other text and can be formatted like normal text . Simply select the token text
and format it using the appropriate commands in the Text Tab, or, right-click on
the selected token text and choose the Format Token option from the pop-up
menu.

Tokens are evaluated automatically, which means that whenever the underlying
information changes, the information that the token displays will change
accordingly. For example, many tokens are used to obtain information from a
data file or from a plot on the layout. As the data changes in the plot, the token
information will update as well.

The two most commonly used tokens are Keyword tokens, which display .fcs
(or other data type) file keyword information, and Statistic tokens, which
display statistics calculated from the data. For a complete list of token types,
please refer to the Inserting Tokens  chapter. 

Note: Each .fcs file contains multiple keywords which can also be viewed from
the View Header window .

12.1 Inserting Tokens

To insert a Token in a Text Box (or any other edit field that accepts tokens), use
either of the following methods:

· Right-click in the body of the text box and select Insert Token from the

pop-up menu (or use the Text Insert Text Insert Token command).
The Insert a Token dialog will appear (Fig. 12.1):
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Figure 12.1 - Insert a Token dialog

· Drag and drop a plot into the text box.  The Paste Special dialog will

appear. Choose Statistic token or Keyword token (Fig. 12.2).  The Edit
Statistic or Edit Keyword dialog box will appear, from which token(s) can
be selected for insertion.  Multiple statistics may be chosen and inserted at
the same time by multiple selecting statistics from the Statistic category. 

§ Multiple plots may also be selected and dropped into a text box.
You will be prompted by the Paste Special dialog separately for
each plot you have selected. 
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Figure 12.2 - Paste Special dialog

·  Drag and drop a file from the Data List  into the text box. The Paste

Special dialog will appear. Choose Statistic token or Keyword token
(Figure above). The Edit Statistic or Edit Keyword dialog box will appear,
from which token(s) can be selected for insertion.  Multiple statistics may be
chosen and inserted at the same time by multiple selecting statistics from
the Statistic category. 

· Drag and drop a gate into the text box. The Edit Statistic dialog box will

appear, from which token(s) can be selected for insertion.  To select
multiple items, press Ctrl or SHIFT on the keyboard.

· Drag and drop a default statistic into a text box. With a default gate or

histogram statistics window open you can drag and drop individual statistics
or hold down shift while clicking on different statistics to multiple select
them. One or many statistics may be inserted into a new text box in this
way. 

§ When inserting a token into a text box embedded within a plot, you
may select the plot on which the token is on or from a different
plot listed for the Data Source category (Figure 12.3 below). 
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Figure 12.3 - Create Statistic dialog displaying options outline in red for selecting
plot as source for token to be inserted.

There are many kinds of tokens that may be inserted:

· Statistic

Displays plot, quadrant, and gate statistics. The value of a statistic token
updates automatically, whenever a change pertaining to that statistic is
made.

· Keyword

Displays the information which is stored in the FCS file header. Each
keyword contains a different piece of information, i.e., acquisition date,
number of events, etc.

· Statistic Classifier

1298
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Allows you to classify a statistic in terms of text, i.e., positive or negative
cells (see Statistic Classifier Tokens).

· Layout

Displays information related to the layout, including the number of pages,
the layout creation date, compensation settings, batch processing, and
gate information.

· Gate

Displays information related to gate information, such as the gate name,
comments, link description, gate points, gate wells, combination formula or
gate color.

· Signature

Displays information related to signatures such as Name, Description,
Status, Data, Time, Signer, and Stamping Notes

· Compensation

Displays information for the Spill Over or Compensation Matrices.

· Batch Processing

Displays information related to batch processing including the Current
Iteration, Number of Iterations, and Start time of the current batch
process.

· SOP (Standard Operating Procedure)

    
    Displays information related to SOP steps.

· System

Displays information related to the current user and other system-related
data.

· Plot

Displays text related to the Plot Information, such as:
1.   Title
2.   Footer
3.   X axis label
4.   Y axis label
5.   Plot Number
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6.   Plot Description
7.   Whether the plot is using channel calibration?
8.   Is channel calibration applied on the X and/or Y axis?

Plot tokens can also display information as it relates to the Center, Top,
Right, Bottom, or Left Quad Vertices in the plot.

· Data Parameter

    Provides a shortcut to a column of data in a data set. Normally used for
evaluating numeric data from a parameter in a custom token.

· Spreadsheet Cell Value  

Displays information from the specified cell address in the user-selected
spreadsheet on the layout.

· Custom Tokens  

These are tokens, which can contain user-defined formulas, that are
created from the Custom Token window . A custom token formula can
contain arithmetic operations, such as division and multiplication, and
conditional operations, such as IF … THEN … ELSE. See Custom Tokens
for a more detailed explanation. Note: Since a custom token must be
created before it can be inserted into a text box, the Custom node will not
appear in the Insert a Token dialog until one or more custom tokens have
been created.

To insert a token, select the kind of token you want and then click Insert.
Alternatively, you can double-click on the token you want to insert. After you
Insert, a dialog box may appear asking you to set the properties for that
particular token. The token properties are described under Common Token
Properties .

12.2 Viewing the Source of Tokens and the Formula of
Custom Tokens

You may view the Data Source  of Tokens and the formula of Custom
Tokens  on your layout via hyperlinks in the right-click menu, as shown below
(Fig. 12.4).
After Right-click:
· select View Data Source to highlight a Token's Data Source , or

· select View Custom Token to highlight the Custom Token's formula within the

Custom Tokens window .
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Figure 12.4 - Token and Custom Token hyperlinks to Data Source and Custom
Token formula within Custom Token window, respectively.

12.3 Token Properies

Tokens are defined by multiple properties (specific for each token type) that are
defined  when a token is created. Token properties can also be edited afterward
by either:

· Double click on the token, or

· Right-click on the token and then select Format Token.

When choosing to edit, the specific dialog for the token you are editing will open.
Each of the different categories of tokens contains a number of properties which
can be edited. Please see the chapter sections below for more details on each
token type. 

Jump to:

· Editing Statistic Tokens 1298
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· 2D Plot Statistic Token Options

· Histogram Statistic Token Options

· Editing Keyword Tokens

· Statistic Classifier Tokens

· Layout Tokens

· Inserting a Page Layout Token

· Gate Tokens

· Signature Tokens

· Compensation Tokens

· Batch Processing Tokens

· SOP Tokens

· System Tokens

· Plot Tokens

· Data Parameter Tokens

· Spreadsheet Cell Value Tokens

12.3.1 Common Token Properties

The Display Text token property and the Font token property are shared by all
tokens.

· Display Text

· Font

The Data Source token property and the Number Format token property are
shared by Statistic and Keyword tokens.

· Data Source

· Number Format

12.3.1.1 Display Text Token Property

When you insert or edit a Token in a text box, you have the option to select
what text will be displayed by changing the Display Text property. All tokens can
display one of the following three items:

· Token Value

1299

1300

1313

1314

1316

1318

1320

1320

1322

1323

1325

1327

1329

1332

1291

1294

1295

1297



FCS Express 7 Manual1292

© 2023 De Novo Software

The token value is the default setting when a token is inserted into a text box.
The token will display the current evaluated information for the selected
statistic, keyword, etc. For example:

o The "number of pages on the layout" token would display the number

"2" if the layout consisted of 2 pages. If a page was added, the number
displayed would change to "3".

o The token value representing the number of events on a particular plot

would display "3043" in the text box if there were 3043 events in that
plot.

o The token value for the data collection date (e.g., for an .fcs file on the

layout) would display "January 1, 2005" if the data was collected on the
first day of 2005.

· Token Description

Displays the description of the token rather than the value. This is the default
setting when a token is used as part of a formula, for instance when creating
custom token . For example:

o The "number of pages on the layout" token would display the description

"Number of Pages".
o The "number of events" token for the first overlay on the second plot

would display the description "Statistic: # of Events for Plot #2, overlay
#1".

· Text

Displays user-defined text for the token. For example:

o If you enter the text "apple" then the token will display "apple" in the

text box.
o If you enter the text "My first draft" then the token will display "My first

draft" in the text box.

The following example will demonstrate how to change the Display Text
property:

1.  Follow steps 1 – 5 from the example given in Inserting a Page Layout
Token .

2.  Double-click on the highlighted "1", which is the token value for the
number of pages token you inserted. The Edit Number of Pages dialog
will appear (Figure 12.5). Note that the three options are listed with the
Token Value selected by default.
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Figure 12.5  Edit Number of Pages Dialog

3.  Choose the Token Description radio button and then click OK. The token
now displays the token description, "Number of Pages" as shown in Figure
12.6 rather than the token value "1".

Figure 12.6  Display Text - Token Description

4.  Double-click on the highlighted "Number of Pages" token to return to the
Edit Number of Pages dialog.

5.  Click on the Text radio button, and then enter "# of Pages on my Layout"
in the edit field.

6.  Click OK.

The token now displays the text just entered on the previous screen (Figure
12.7).

Figure 12.7  Display Text - User Defined Text
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The Display Text option can also be changed by right-clicking on the text box
token and changing the Display Text option from the pop-up menu (Figure 12.8).
The user-defined Text option is primarily useful when creating custom tokens .

Figure 12.8  Display Text Pop-up Menu

12.3.1.2 Font Token Properties

When you insert or edit a Token in a text box, you have the option to change
how the text will be displayed by using a list of criteria to assess the value of the
token. This can be defined in the Font token properties (Figure 12.9 below).
Font token properties are shared by all tokens.

The following Font token properties can be set:

· Font Classification

This is the value that determines whether the font will be changed. It is possible
to choose the classifier token itself or enter a formula in Custom Value field,

similar to a formula you would use for a custom token . Click on the 
button to the right of the field to insert a Statistic token. The Format of the
Token (Numeric or Text) may be changed using the Format drop down menu.

· List of Fonts

These are the terms by which FCS Express evaluates the value set in the Font
Classification.  Based on these terms, the font will change accordingly as
defined by the list criteria.  Options include using the layout default font settings
or customizing by using different fonts, colors, sizes, etc. To Add, Edit, or
Remove classifications, click on the appropriate button to the right of the list. 
The order by which the classifiers are applied can be adjusted by using the up
and down arrow buttons. Whenever there is overlap in the classification
definitions, FCS Express performs the classification in the order of the entries. 
For example, if a value meets both criteria in the list, it will classify it with the
one listed first.

· Alternate Fonts
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This is the assigned font if the value in the Font Classification doesn't fit into any
of the values in the List of Fonts. A default font for the token can be entered if
none of the classifications evaluates to true. 

Figure 12.9 Font Classification Example

12.3.1.3 Data Source Token Property

The Data Source of a token is defined when the token is created , may be
edited  afterwards, and is used to define where a token derives its values and 
information.

A statistic token can obtain information from:
· a Plot

· a Spreadsheet

· a Data File From Disk
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If the data source is a plot, or a spreadsheet, then the token will update
whenever the data on that plot, or the values in the spreadsheet change.

In the example below (Figure 12.10), the Data Source of the selected Statistic
token is "Overlay 1" from plot "2 - Density - 42700040.0001.fcs compensated
(Time vs. FCS-H)".

Figure 12.10 - Example of token deriving data from a plot.

When the Data Source of a token is set to Data File from Disk data files can
also be selected from either the Select Data File or Open Data File dialog
depending on the Open Data Dialog user Options  (Figure 12.11).

Note: when the Change data file during Next/Prev/Batch check box is
checked, the token information will update when the Data Source changes.
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Figure 12.11 - Selecting a Data File as Data Source for a token, through either the
Select Data File dialog (lower left) or the Open Data File dialog (lower right) .

12.3.1.4 Number Format

The Number Format property allows users to select the number of decimals to
be displayed, the Rounding mode and whether or not to show trailing zeroes
if the value is numeric (Figure 12.12).

The options for Rounding Mode include Standard, Down, Up, and Truncate.
The default is 2 decimal places.

Flagging the Show scientific notation check box allows you to display the
statistic in the form of X.XXE+Y



FCS Express 7 Manual1298

© 2023 De Novo Software

Figure 12.12 Number Format - Number Display Options

12.3.2 Editing Statistic Tokens

The following properties can be edited for Statistic tokens

· Display Text  to define whether the token should display the Token Value

(default), Description, or a user-defined Text.
· Font  

· Data Source  to select the plot or FCS file as a source of data for the

token.
· Number Format  

· Statistic (please refer to either the 2D Plot Statistic Token Options

chapter or the Histogram Statistic Token Options  chapter)

Note: The Statistic page of the Create Statistic dialog is used to choose the
statistic to display in a statistic token. Because the Statistic property options
differ depending on the Data Source, you must select the Data Source first.
The Data Source page is the default page shown when you select Statistic
from the Insert a Token dialog.
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12.3.2.1 2D Plot Statistic Token Options

Statistic token properties vary depending on whether the Statistic token uses a
Plot or a Data File as Data Source.

If a 2D Plot is chosen as the Data Source  of a Statistic Token, the following
Statistic token properties can be set (Figure 12.13 below).

· Plot Information - Select a quadrant

Select one or more quadrants to use as a basis for your statistic. The default
selection is None which will use all events on the plot.

· Gate

Select one or more gates to use as a basis for your statistic. The default is
No Gate which will use all events on the plot.

· Statistic

Select the statistic(s) to display. Multiple statistics may be selected and
inserted together by holding down the control key while multiple selecting.
See 2D Plot Statistics  for descriptions of each specific statistic. 

· Denominator Gate for Custom Percentage

Select the gate to be used as denominator for calculating the "% of
_____" (green arrows in above figure). Note that the name of the statistics
in the Statistics section, will update according to the gate name defined. For
example, in the figure above, "No Gate" is defined as Denominator Gate for
Custom Percentage. The corresponding statistics in the Statistics section is
named "% of No Gate" accordingly.

· Token Multiplication Grouping

Select the grouping priority for your statistics, which will be used to group the
output by statistic, gate, and/or quadrant when multiple gates and/or
quadrants are selected. The default grouping priority is Stats > Gates >
Quads. The default grouping priority will group each statistic together in a
contiguous block. Within each block the output will be grouped by gate, then
by quadrant. The grouping priority can be changed by moving a selected
grouping option with the Move Up or Move Down buttons, with the highest
priority appearing at the top of the Token Multiplication Grouping selection
box.  
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Figure 12.13  Statistic Options - 2D Plot as Data Source

Note: It is also possible to insert or edit a Statistic token with an .fcs file as a
Data Source, though if the desired file is showing on your layout, it is preferable
to use a Plot as the Data Source as described above. Please refer to the Data
File Statistic Token Options  chapter for more details on the available Statistics
properties when an .fcs file is used as Data Source for a Statistic token.

12.3.2.2 Histogram Statistic Token Options

If a Histogram is the Plot type chosen for a Data Source  of a Statistic Token,
the following properties can be set (Figure 12.14). 
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Figure 12.14  Statistic Options - Histogram as Data Source

· Plot Information - Select a marker

Select one or more markers to use as a basis for your statistic. The default
selection is None which will use all events on the plot.

· Gate

Select one or more gates to use as a basis for your statistic. The default is
No Gate which will use all events on the plot.

· Statistic

Select the statistic to display. See Histogram Statistics  for descriptions of
each.

· Denominator Gate for Custom Percentage

Select the gate to be used as denominator for calculating the "% of custom
denominator gate" Statistic above. 

· Token Multiplication Grouping
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Select the grouping priority for your statistics, which will be used to group the
output by statistic, gate, and/or marker when multiple gates and/or markers
are selected. The default grouping priority is Stats > Gates > Markers. The
default grouping priority will group each statistic together in a contiguous
block. Within each block the output will be grouped by gate, then by marker.
The grouping priority can be changed by moving a selected grouping option
with the Move Up or Move Down buttons, with the highest priority appearing
at the top of the Token Multiplication Grouping selection box.  Please see the
detailed overview of token multiplication grouping for additional details . 

12.3.2.3 Data File Statistic Token

Statistic token properties vary depending on whether the Statistic token uses a
Plot or a Data File as Data Source.

If a Data File From Disk is chosen as the Data Source  of a Statistic Token,
the following properties may be set (Figure 12.15):

· Data File information

o Parameter

Allows to select the Parameter for which to calculate parameter-dependent
statistics.

o Compensation

Allows to select which compensation definition  to apply to the data
before retrieving the statistics of interest.  Possible choices are: the
compensation of the data, Default or None.
Note: by setting Default from the Compensation drop down, the default
option for compensation  specified in the User Options will be used.

· Derive Axis Titles From

Allows to define whether the axis title should be retrieved from the data file or
from a Parameter Label Set , if any.

· Gate

Select one or more gates to use as a basis for your statistic. The default is
No Gate.

· Statistic

Select the statistic to display. Multiple statistics may be selected to be
inserted together. See 2D Plot Statistics  for descriptions of each.
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· Denominator Gate for Custom Percentage

Select the gate to be used as the custom denominator  for calculating the
"% of custom denominator gate" Statistic. 

· Token Multiplication Grouping priority

Select the grouping priority for your statistics, which will be used to group the
output by statistic, gate, and/or parameter when multiple gates and/or
parameters are selected. The default grouping priority is Stats > Gates >
Parameters. This default priority will group each statistic together in a
contiguous block. Within each block the output will be grouped by gate, then
by parameter. The grouping priority can be changed by moving a selected
grouping option with the Move Up or Move Down buttons, with the highest
priority appearing at the top of the Token Multiplication Grouping selection
box.  
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Figure 12.15  Statistic Options - FCS File as a Data Source

Note: It is also possible to insert or edit a Statistic token with a Plot as a Data
Source. Please refer to the 2D Plot Statistic Token Options  chapter for more
details on the available Statistics properties when a Plot is used as Data Source
for a Statistic token.

12.3.2.4 Token Multiplication Grouping

When extracting statistic(s) from a single gate, typically performed through a
drag and drop or Insert Token  operation, FCS Express arranges the output
based on the order the statistics appear in the Create Statistic window.
However, when working with multiple samples and selecting multiple statistics
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from multiple gates/quadrants/markers, the ordering of the output becomes
important and it is often useful to define how the output will be grouped and
displayed. In FCS Express, you can define how to group your statistics with the
Token Multiplication Grouping feature.

Token Multiplication Grouping allows users to simultaneously extract and
group multiple statistics from multiple gates/quadrants/markers/parameters
based on a defined grouping priority. This feature is particularly helpful for
inserting multiple statistics from multiple samples into a spreadsheet or text box,
as it allows users to define which gate(s) and statistic(s) they would like to
obtain data from and how to group the output when extracting data for more
than one gate or statistic based on the grouping priority. The grouping priority,
defined by the user, enables users to group the output by statistic, gate, marker,
quadrant or parameter (depending on the data source, see the 2D Plot Statistic
Token Options  for more details). 
 
An example output of Token Multiplication Grouping can be seen in the figure
below (Figure 12.16). Here, multiple statistics are being extracted from one or
more gates (Cells and Gate 1) and placed into a spreadsheet. 

In Rows 1 & 2, we can see the simplest example of extracting statistics from a
single gate. The output is arranged based on the order the statistics appeared in
the Create Statistic window (as indicated previously). In Rows 4 & 5, we have
added a second gate to extract statistics from. Here the output is ordered based
on the grouping priority (Stats > Gates), which results in each stat being
grouped separately and each stat group being ordered by Gate. In Rows 7 - 10
we have expanded the previous example to included data from multiple files.
Here each row represents a different file, but the order and statistics are the
same. 
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Figure 12.16. Token Multiplication Grouping - Two Gates and Two
Stats Example

In Figure 12.17 we can see the Token Multiplication Grouping options selected
for the Two Gates and Two Stats example above using a single file. Changing the
grouping priority can have a significant effect on the final ordering of the
statistics, and will be explained in greater detail in the sections below.
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Figure 12.17. Token Multiplication Grouping Options - Two Gates and Two Stats
Example

Grouping Priority - How FCS Express Organizes Token Multiplication
Grouping Output

For 1D Plots, the default grouping priority is Stats > Gates > Markers. For 2D
Plots the default grouping priority is Stats > Gates > Quadrants. As the
grouping priority acts the same for both 1D and 2D plots, we will demonstrate
the grouping priority using only 2D Plots below.

With the default grouping priority (Stats > Gates > Quadrants), the primary
grouping option is Stats. With this selection FCS Express will output each statistic
within its own dedicated block (Figure 12.18). Within each statistic block, the
output will be further grouped by gate then by quadrant. With each additional
statistic, gate, or quadrant selected the output blocks expand horizontally. In the
figure below, we have outlined the default grouping priority using an example
with three statistics, multiple gates and a single quadrant. With the primary
grouping option set to Stats, the first output block would be Stat1 for each
quadrant all gated on Gate1. The next output block would be Stat1 for each
quadrant all gated on Gate2, and this would continue for every gate selected.
Once the Stat1 output had completed, the process would begin again with Stat2
and finally Stat3. Note that the output would expand horizontally or rightward
until all selected statistic, gate and quadrant values had been reported.
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Figure 12.18.  Token Multiplication Grouping - Default Priority Grouping for 2D Plots

In the image below (Figure 12.19) we've created a simple gating hierarchy with
three plots. We will use the plot displaying four quadrants to extract statistics and
demonstrate how the different grouping priority orders influence the resulting
output. 

Figure 12.19. Token Multiplication Grouping - 2D Plot Example with Simple Gating
Hierarchy
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For this example, we selected multiple statistics, gates, and quadrants
(highlighted in blue, Figure 12.20). In the Create Statistic window, the default
grouping priority is set (Stats > Gates > Quads). The grouping priority can be
changed by moving a selected grouping option with the Move Up or Move
Down buttons, with the highest priority appearing at the top of the Token
Multiplication Grouping selection box.  

Figure 12.20. Token Multiplication Grouping - Default Options used for 2D Plot
Example

The output can be seen in the figure below, with the default grouping priority set
as the first example (Figure 12.21). The first statistic block contains the Gate,
which is subdivided by the two selected Gates (Cells then Gate 1), with each
Gate's output arranged by Quadrant. The next statistic block contains the # of
Events, which is subdivided and arranged first by Gates then by Quadrants. The
third block follows the same pattern. In the next example, the grouping priority is
set to Stats > Quads > Gates. In this case, the first statistic block is subdivided
by Quadrant (LL and LR) with each Quadrant output arranged by Gate (Cells and
Gate 1). For each of the examples below, the change to the grouping priority
changes the output. In the final example, the grouping priority is Gates > Quads
> Stats. Here, the output is first separated by Gate, then subdivided by
Quadrant with the output arranged by Statistic. This pattern repeats for the
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second block. Note that only two blocks were used, as the original selection
contained only two Gates (see figure above).   

Figure 12.21. Token Multiplication Grouping - Output Examples for 2D Plots with
Different Grouping Priorities

We can also output these results into a spreadsheet, which allows for statistics
to be extracted simultaneously from multiple data files. The feature is particularly
useful when analyzing multiple data files from the data list in spreadsheets.
Here we are selecting multiple statistics and gates as above. Note that when
dragging and dropping multiple files into a spreadsheet to extract statistics the
data files themselves becomes the data source and one or more data
parameters must also be selected (see the 2D Plot Statistic Token Options  for
more details). These data parameters will replace quadrants as the last grouping
priority option (Figure 12.22). 
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Figure 12.22. Spreadsheet Example - Grouping Options For Multiple Data Files

The output corresponding to the figure above can be seen in the first five rows of
the spreadsheet below (Figure 12.23). In the following rows note the grouping
priority has been changed, with the new grouping order indicated in the row
immediately beneath the output.
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Figure 12.23. Spreadsheet Example - Output Example for Multiple Data Files with
Different Grouping Priorities

Note the arrangement of the labels or header row for each statistic can be
formatted to appear as a single row or across multiple rows of the spreadsheet
(Figure 12.24). See the spreadsheet formatting section  for further details.

Figure 12.24. Spreadsheet Example - The Statistic Labels for the Token
Multiplication Grouping Output can be arranged as a Single Row (bottom) or Across

Multiple Rows (top).

428



Tokens 1313

© 2023 De Novo Software

 

12.3.3 Editing Keyword Tokens

The following properties can be edited for Keyword tokens

· Display Text  - defines if the token should display the Token Value

(default), Token Description, or a user-defined Text.
· Font  

· Data Source  - allows users to select a Plot, Spreadsheet, or Data File

Disk as the source of data for the token. Please refer to the Data Source
Token Property  chapter for more information on data sources. 

· Number Format

· Keyword - The Keyword property allows users to define and edit the

keyword that will be displayed (Figure 12.25). 

Note: Because Keyword options may differ depending on the Data Source, you
must select the Data Source before navigating to the Keyword category.

Figure 12.25  Keyword Properties

The keyword name may be:

1. Manually typed in the Keyword field (  in the picture above)

2. Selected from the drop-down menu (  in the picture above). The drop-down
menu is automatically populated with the most recent keywords used. See
note below.

1291

1294

1295

1295

1297



FCS Express 7 Manual1314

© 2023 De Novo Software

3. Selected from the Keyword List (  in the picture above). To access the
Keyword list, click on the ellipsis to display the scrollable Please select a
keyword dialog (Figure 12.26). Click on the Keyword you want to display,
and then click OK to return to the Create Keyword dialog. Click OK to
complete the Keyword edit or insert procedure.

Note: Keywords selected in the Please select a keyword dialog will be
considered recent keywords and listed in the Keyword drop-down menu in the

Create Keyword dialog (  in the picture above). If the Show recent keywords
first check-box is checked in the Keyword Dialog User Options , recent
keywords will be listed first in the Please select a keyword dialog (picture
below).

Figure 12.26  Select a Keyword

For more information regarding Keywords, please watch our YouTube video that
goes into greater detail about what Keywords are and how to use them within
your analysis layout.

12.3.4 Layout Tokens

Layout Tokens display demographic information related to the layout, e.g., the
number of pages on the layout or the date the layout was created.

Layout Token Definition

Number of Pages The overall number of pages in the current layout

Current Page
Number

The page number of the layout page currently in use for the
token

Last Saved Time The time at which the layout was last saved

Last Saved Date The date on which the layout was last saved
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Created Time The time at which the layout was created

Created Date The date on which the layout was created

Number of Files in
the File List

The total current number of data files in the Data List

Current Print ID Identification number used for the print job

Print Date and
Time

The date and time when the layout was last printed

File Name The file name of the current layout

File Path The file path specific for the current layout

Current FCS File
Path

The path to the folder of the data file that was most recently
opened in a file dialog

Current User The user name of who is currently logged into FCS Express

Current Page
Name

The name of the page that is currently being viewed

Current User
Security Groups

The name of the security group to which the user belong
(Security option users only)

Last Saved
Program Version

The last version number of FCS Express used when saving
the layout

Last Saved Layout
Version

The last layout version number used when saving the layout

Last Loaded
Channel Calibration
File

The last file that was used when performing Channel
Calibration

Flag Status of
Current Layout
Iteration

For batch processing, this token displays the flag status of
the current layout iteration as "Flagged" or "Not flagged"

Number of Current
Layout Iteration

For batch processing, this token displays the current layout
iteration number

Total Number of
Layout Iterations

For batch processing, this token displays the total number of
iterations present on the layout

To edit the text format or display these properties once the token has been
created, right-click on the Layout token and select Format Token or one of the
Display Text options from the pop-up menu.  Or, double-click the Layout token
to access the Edit dialog.

The following properties can be edited for Layout tokens, by right-clicking on the
token:

· Display Text  - defines if the token should display the Token Value

(default), Token Description, or a user-defined Text.
· Font  - changes the font depending on the value of the token based on a

list of classifications
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Use case example

Please see the Inserting a Page Layout Token example  as en example of
Layout Token.

12.3.4.1 Inserting a Page Layout Token

The following is an example on inserting a Page Layout Token:

1.  Create a new layout , or open an existing one.
2.  Insert a Text Box  on the page and type in "The number of pages on this

layout is " (with the <space> after the word "is"). 
3.  Right-click near the flashing cursor in the text box, and select Insert Token

from the pop-up menu. The Insert a Token dialog will appear (Figure 12.27).
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Figure 12.27  Insert a Token Dialog

4.  Select the Number of Pages token (located under Layout) and then click
the Insert button.

5.  The text box will then look like Figure 12.28. Note how the background of the
number 1 is gray. When the Text Box is in edit mode, this signifies that the
text is actually a token rather than free text.

Figure 12.28  Number of Pages Token in a Text Box



FCS Express 7 Manual1318

© 2023 De Novo Software

6.  Insert a new page on the layout by using the Insert tab General New
Page Blank command.

7.  The FCS Express window will display the new, empty page. Return to the
page with the Text Box and Token by clicking on the Page 1 tab, located at
the bottom left of the layout screen. Since the text displayed in the token
changes as the information it is displaying changes, the token text now
displays "2" indicating the new number of pages (Figure 12.29).

Figure 12.29  Token Automatically Updates

12.3.5 Gate Tokens

Gate tokens display information related to the gates on the Layout, as shown in
Figure 12.30.  See the table for below for definitions of the Gate tokens. See
below for definitions of Gate Tokens Options:

Gate
Token

Definition

Gate
Name

This is the name that you specified when the gate was created. This
name that is used to reference the gate throughout FCS Express.

Comment This is text that you can specify when you are editing the gate from
the Gate View .

Link
Description

If the gate is linked to a quadrant or a marker, this is the information
that describes that link.

Points
(Gate
Space)

If the gate is one of the basic shapes (elliptical, rectangular,
polygonal, or freeform) and not a combination gate, then this is the
set of points that define it on the plot.

Points If the gate is one of the basic shapes (elliptical, rectangular,
polygonal, or freeform) and not a combination gate, then this is the
set of points, corresponding to the numerical space along the axis
range, that define it on the plot.

Combinati
on
Formula

If the gate is a combination gate, this is the formula that you used to
create it.

Gate Wells If the Gate is a Well Gate, this information tells you which well, or
wells, makes up the Gate.

Color This token will describe the color used for the Gate.

391
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Figure 12.30  Choose a Gate Token

When you insert or edit a Gate token, the Create Gate Token dialog appears.

The following properties can be edited for Gate Tokens, by right-clicking on the
token:
· Display Text  - defines if the token should display the Token Value

(default), Token Description, or a user-defined Text.
· Font  - changes the font depending on the value of the token based on a list

of classifications
· Number Format  - assigns the number of decimals and number display

options
· Gate Information - see below for more details.

Use the Gate information page (Figure 12.31) to choose from a list of Gate
Information to display:

1291
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Figure 12.31  Gate Token Options

12.3.6 Signature Tokens

Signature tokens are described in detail in the Displaying Signature Information
chapter.

12.3.7 Compensation Tokens

Compensation tokens allow you to insert information pertaining to the current
compensation  settings. You can choose different source and target
parameters and display either the crossover or spillover matrix values (Figure
12.32). See Compensation and Spectral Unmixing  for more information.

Gate Token Definition

Spillover Matrix
Value

Represents the percentage of the signal from a given channel
that spills into adjacent channels.

1489
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Compensation
Matrix Value

Represents the inverse of the spillover matrix. Used to correct
spillover.

Unmixing Matrix
Value

Represents the estimate the contribution of each spectrum to
the full spectra

Spillover
Spreading Matrix
Value

Represents fluorescence spectrum interactions that can limit
the sensitivity of a reagent in the presence of brightly-stained
cells on a different color. See Spillover Spreading Martrix

Cross Stain Index
Matrix Value

Represent the spread of a given fluorochrome into another
dye. See Cross Stain Index Matrix

Figure 12.32 - Compensation Tokens

The following properties can be edited for Compensation tokens, by right-
clicking on the token:

· Display Text  - defines if the token should display the Token Value

(default), Token Description, or a user-defined Text.
· Font  - changes the font depending on the value of the token based on a

list of classifications
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12.3.8 Batch Processing Tokens

Batch processing tokens allow you to insert information relating to the current
state of the batch process  (Figure 12.33. These tokens are used to create
dynamic file names that change as a batch process proceeds through a collection
of files (see Batch Processing - Save Layout ).

The options include:

Batch Processing
Token

Definition

Current batch
Iteration

This is the iteration number of the current iteration that is
being displayed within your plots during batch processing, as
defined within the Data List.

Number of batch
iterations

This is the total number of iteration numbers, as defined
within the Data List.

Start Time of the
Current Batch
Process

This will list the time at which batch processing commences.
 It will be listed in a hh:mm:ss AM/PM format.

Figure 12.33 - Batch Processing Tokens
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The following properties can be edited for Batch Processing tokens, by right-
clicking on the token:

· Display Text  - defines if the token should display the Token Value

(default), Token Description, or a user-defined Text.
· Font  - changes the font depending on the value of the token based on a

list of classifications

12.3.9 SOP Tokens

SOP (Standard Operating Procedure) tokens are described in detail in the
Displaying SOP Information  chapter. See token list and Figure 12.34.

SOP Token Definition

Number of SOP
steps

The total number of steps in an SOP

Current SOP
step name

The name of the currently active step when running SOP as
defined by the user

Current SOP
step internal ID

The internal ID of the currently active step when running SOP

Current SOP
step order
number

The step order number when running SOP

Current SOP
step description

The step description when running SOP

Current SOP
step completion
date

The last date the current SOP step was completed on. 

SOP step name The name of the selected step from the Create SOP Token
dialog

SOP step
internal ID

The internal ID of the selected step from the Create SOP
Token dialog

SOP step order
number

The  step order number of the selected step from the Create
SOP Token dialog

SOP step
description

The step description of the selected step from the Create
SOP Token dialog

SOP step
completion date

The last date the selected step from the Create SOP Token
dialog was completed on

1291
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Figure 12.34 - SOP Token List

The following properties can be edited for SOP Tokens, by right-clicking on the
token:

· Display Text  - defines if the token should display the Token Value

(default), Token Description, or a user-defined Text.
· Font  - changes the font depending on the value of the token based on a

list of classifications
· SOP Information - choose the SOP Token to display (Figure 12.35).  See

the Displaying SOP Information  chapter for more information.
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Figure 12.35 - SOP Information

12.3.10 System Tokens

System tokens allow you to insert information pertaining to the current
computer session. The current system tokens are listed in the table below and in
Figure 12.36).

System Token Definition

Current FCS Express
User

The name of the user currently logged into FCS Express.

Current Date The current date as shown on the workstation.

Current Time (without
seconds)

The current time as shown on the workstation,
displayed as HH:MM.

Current Windows User The user name for whoever is currently logged into
Windows.

Temp Folder The destination pathway for the Temporary folder.
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Desktop Folder The destination pathway for desktop folder of the user
currently logged into FCS Express.

My Documents Folder The destination pathway for the user's Documents
folder.

Common Documents
Folder

The destination pathway for the Public Documents
folder.

Configuration
Company ID

Identifier associated with license configuration file. 

Current Time Zone The current time zone as shown on the workstation.

Current Time (with
seconds)

The current time as shown on the workstation,
displayed as HH:MM:SS

Figure 12.36 - System Tokens
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The following properties can be edited for System Tokens, by right-clicking on
the token:

· Display Text  - defines if the token should display the Token Value

(default), Token Description, or a user-defined Text.
· Font  - changes the font depending on the value of the token based on a

list of classifications

12.3.11 Plot Tokens

Plot Tokens allow you to insert information pertaining to a plot selected as Data
Source  .

There are two types of Plot Tokens (Figure 12.37):
· Plot Information

· Quad Vertices

Please see below for more details on them.

Figure 12.37 - Selecting Plot Token from the Select
Token Type dialog
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Plot Information

The following properties can be edited for Plot Information tokens, by right-
clicking on the token (Figure 12.38):

· Display Text  - defines if the token should display the Token Value

(default), Token Description, or a user-defined Text.
· Font  - changes the font depending on the value of the token based on a

list of classifications.
· Data Source .

· Number Format .

· Plot Element - defines which information the token should display (see the

table below for more details).

Figure 12.38 - Plot Elements

Plot Element Definition

Title The text within the plot title .

Footer The text contained with the plot footer.

X Axis Label The label used for the X axis within the plot.

Y Axis Label The label used for the Y axis within the plot.

Plot Number The number given to the plot by FCS Express as it is
created.

Plot Description An overall description of the plot, showing the Plot Number,
Plot Type, the data file name being displayed within the plot,
and the X and Y axis parameters for the selected plot.

Use Channel
Calibration?

Has the Use Channel Calibration on Axes option been
selected for that plot? The output is Off or On .
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Is Channel
Calibration Applied
on X axis?

A description of whether or not channel calibration has been
applied to the X axis.

Is Channel
Calibration Applied
on Y axis?

A description of whether or not channel calibration has been
applied to the Y axis.

Quad Vertices

This token will display the X- and Y- coordinates for a selected vertex of a
Quadrant . 

The following properties can be edited for Quad Vertices tokens, by right-
clicking on the token:

· Display Text  - defines if the token should display the Token Value

(default), Token Description, or a user-defined Text.
· Font  - changes the font depending on the value of the token based on a

list of classifications
· Data Source  - identifies the plot that determines Token Value

· Number Format  - assigns the number of decimals and number display

options
· Quad Vertices - The options are Center, Top, Right, Bottom, Left. See

Figure 12.39.

Figure 12.39 - Quad Vertices

12.3.12 Data Parameter Tokens

Data Parameter tokens provide a shortcut to a column of data in a data set
(Figure 12.40).
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Figure 12.40 - Data Parameter Tokens

Data Parameter tokens are normally used for evaluating numeric data from a
parameter in a custom token, for instance, the mean value of a particular
parameter (Figure 12.41).
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Figure 12.41 - A Data Parameter token for Parameter 3 of plot
1 being used in a custom token formula to calculate the Mean

of Parameter 3.

Upon choosing to insert a Data Parameter token, the Create Data
Parameter dialog will open (Figure 12.42). 

The following properties can be edited for Data Parameter tokens, by right-
clicking on the token:

· Display Text  - defines if the token should display the Token Value

(default), Token Description, or a user-defined Text.
· Font  - changes the font depending on the value of the token based on a

list of classifications
· Data Source  - identifies the plot that determines Token Value

· Number Format  - assigns the number of decimals and number display

options
· Parameter
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Parameter Settings
§ Choosing Macro from the Output As drop down will retrieve all values and

input them in the function without using any text derived values.
§ Choosing Data Values from the Output As drop down will retrieve all

values and input them in the function as text derived value (Not
recommended for large data sets)

Figure 12.42 Create Data Parameter token dialog.

12.3.13 Spreadsheet Cell Value Tokens

Spreadsheet Cell Value tokens provide a shortcut to data within a cell of a
spreadsheet .  The data may be derived directly from statistics within the
layout, keywords, or from data files in the data list. Inserting statistics for data
files in the data list allows additional flexibility in analysis of many statistics for
many data files that are not currently open in the layout. Spreadsheet Cell Value
tokens may be used in text boxes or in the batch actions. 

To insert a Spreadsheet Cell Value token in a text box or layout:

Drag and Drop method:
1.    Click and hold on the blue square in the lower right portion of the cell

to be referenced (Figure 12.43 below).

416



Tokens 1333

© 2023 De Novo Software

Figure 12.43- Clicking and holding on the blue square on the bottom right of the cell
allows you to drag the cell value out of the spreadsheet to insert it as a Cell Value

Token in a text box or batch action.

2.  Drag the cursor onto a blank section of the layout. A new text box
will be created that contains the Spreadsheet Cell Value token.

3.  Alternatively, Drag the cursor into an existing text box. The
Spreadsheet Cell Value token will be inserted in the text box. 

The drag and drop method may also be used to quickly populate Batch Actions
as in Figure 12.44 below.

Figure 12.44 - Dragging and dropping a Spreadsheet Cell Value token to an Excel
(Column Mode) action.

Right click method:
1.  Right-click on a Text Box.
2.  Select Insert Token from the pop-up menu. Scroll the list box until you

see the Spreadsheet Cell Value token type, if necessary Figure 12.45.
3.  Choose the Spreadsheet Cell Value token and click the Insert button. 
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Figure 12.45 - Insert Spreadsheet Cell Value Token

Upon choosing to insert a Spreadsheet Cell Value token, the Create
Spreadsheet Cell Value dialog will open (Figure 12.46). After selecting a
spreadsheet as the Data Source , choose which Cell Address to derive the
value inserted.

1295
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Figure 12.46 - Create Spreadsheet Cell Value dialog

If a spreadsheet is not selected first as the Data Source before proceeding to
Cell Address, a warning message will appear (Figure 12.47) prompting you
Continue or Correct.
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Figure 12.47 - Spreadsheet Cell Value without dataset Message

If OK is clicked before selecting Cell Address, a warning message will appear
(Figure 12.48) prompting you Continue or Correct.

Figure 12.48 - Spreadsheet Cell Value without Cell Address Message
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12.4 Custom Tokens

Custom Tokens contain user-defined combinations of tokens and text to create
custom statistics. The custom combinations are created using mathematical
calculations and/or functional operators to define the custom token formula.
These formulas can contain any token including Statistic tokens, Keyword
tokens, or even other Custom tokens.

Once defined, custom tokens are inserted into text boxes the same way other
tokens are inserted . During data analysis, the custom token formula is
evaluated by FCS Express and the result is displayed in the text box containing
the custom token. With custom token formulas you can:

· Create mathematical expressions to combine tokens and/or text

· Create conditional statements using IF..THEN..ELSE qualifiers

· Convert a string of numeric values into a text result such as Positive or

Negative

The following sections will help you understand the power of Custom Tokens. A
comprehensive list of all Custom Token formula operators and functions  is
also provided.

Note: FCS Express uses Excel-style formula evaluation. Therefore, formulas
must start with "=".

12.4.1 Creating Custom Tokens

To create a Custom Token:

1.  Click on the View tab Tokens  command to bring up
the dockable Custom Tokens window.

2.  As with many of the functional windows in FCS Express, the Custom
Tokens window can be docked  to the sides of the screen. This helps
keep the window within reach, while not getting in the way.  Once docked,
the window can be pinned to enable the Auto Hide feature.

3. The two areas of the Custom Tokens window, the Custom Token List
(upper pane) and the Custom Token Formula Editor (lower pane), are
separated by a splitter which can be moved to re-size the areas.  (Figure
12.49)
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Figure 12.49 Docked Custom Tokens Window

3.  Click on the  (Add) icon.
4.  Give the New Custom Token a unique name.
5.  Click on the Token name in the list so that it is highlighted.
6.  Enter or edit the formula:

· Right-click in the lower pane of the Custom Tokens window, select

Insert Token from the pop-up menu, and choose a token from the
Insert a Token dialog;  alternatively, drag and drop a gate or plot from
your layout which serves as Data Source  into the lower pane of the
Custom Tokens window to access the Edit Statistic dialog.

· Modify the formula. You can use any of the operators and functions that

are available for custom tokens .

The icon buttons in the Custom Tokens window are explained in the table
below.

Icon Button Explanation

Add a new Custom Token.

Create (and name) a new folder to manage Custom Tokens. Drag & Drop
Custom Tokens into the folder once it has been created.

Delete the selected item. Note: You can undo a delete by immediately
clicking Undo in the Quick Access Toolbar .

Rename the currently selected item.

To understand how Custom Token formulas operate, and how to use them, a
number of examples are shown in the next sections of this chapter.
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12.4.2 Custom Token Example 1: Mathematical Calculation

In the first example, you will create a Custom Token with a simple formula, and
then insert it into a Text Box.

1.  Click on  (Add) in a docked Custom Token window .
2.  Edit New Custom Token to read Mathematical Calculation.
3.  In the Formula area below the splitter , enter the following: =100 * 30.
4.  Click on Mathematical Calculation to highlight/select it. Your Custom

Token window should look like Figure 12.50.

Figure 12.50  Custom Token Example 1

5.  Create a Text Box  on a layout page.
6.  In the Text Box, enter the phrase: The number of stars in the sky is:

<space>
7.  Right-click at the end of the text, and select Insert Token from the pop-up

menu.
8.  At the bottom of the Insert a Token dialog (Figure 12.51), make sure that

the Custom category is open (click on the triangle next to Custom, if
necessary), and select Mathematical Calculation.
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Figure 12.51  Insert a Token Dialog

9.  With Mathematical Calculation highlighted, Click the Insert button. The
Text Box should now read: "The number of stars in the sky is: 3000.00".
(The default numeric output for a numeric result is two decimal places. This
can be changed by right-clicking on the token in the text box, selecting
Format Token from the pop-up menu, and changing the value on the Output
Format page with the spin control). Once the Text Box is no longer in edit
mode, the Mathematical Calculation token will display its result without a gray
background.

This example demonstrates that when a Custom Token is inserted into a Text
Box, its formula is calculated and the result is displayed.

12.4.3 Custom Token Example 2: Mathematical Calculation with a
Token

The second example demonstrates how to insert tokens in your formulas to
create more complex custom tokens.

1.  Insert a plot  and a text box  on a layout page. Open the Custom Token
window  and dock  it.

2.  Click on  (Add) in the docked Custom Token window.

154 375
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3.  Edit New Custom Token to read "Math Calc with Token".
4.  Enter = in the Formula area below the splitter . Note: FCS Express 7 uses

Excel-style formula evaluation. Therefore, formulas must start with "=".
5.  Choose the Data Source  of the token by either of the following methods:

· right-click in the Formula area (lower pane of Custom Tokens window) and

choose Insert Token from the pop-up menu. Select Statistic and click on
the Insert button, and choose a plot from the Data Source category

· drag and drop the desired gate or plot from your layout into the lower pane

of the Custom Tokens window, and double-click Statistic token.
6.  From the Statistic category, highlight # of Events as the statistic. Click OK.
7.  In the Formula area, enter "/2" to the right of the token.
8.  Click on Mathematical Calculation with a Token to highlight/select it. Your

Custom Token formula should look similar to Figure 12.52.

Figure 12.52  Custom Token Example 2

9.  Insert the Custom Token you have just created into the Text Box by either of
the following methods:
· right-click on the Text Box , choose Insert Token from the pop-up

menu, select Math Calc with Token from Custom (clicking on the triangle
next to Custom to expand the list, necessary), and click the Insert button,
or

· drag and drop Math Calc with Token from the Custom Token List (upper

pane of the Custom Tokens window) to an empty spot on your layout or to
an existing Text Box.

The Text Box should now display the number of events in your dataset divided
by 2.

12.4.4 Custom Token Example 3: Appending Text

Up until now, you have seen how formulas calculate and return numeric results.
However, formulas can also be used to display text. The following example
demonstrates how to create a formula that appends text with Keyword tokens
to return information:

1.  Insert a plot  and a text box  on a layout page. Open the Custom Token
window  and dock  it.

2.  Click on  (Add) in the docked Custom Token window.
3.  Edit New Custom Token to read "Appending Text".
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4.  Choose the Data Source  of the token by either of the following methods:
· right-click in the Formula area (lower pane of Custom Tokens window),

choose Insert Token from the pop-up menu, double-click Keyword, and
choose a plot from the Data Source category

· drag and drop the desired plot from your layout into the lower pane of the

Custom Tokens window, and double-click Keyword token
5.  Select the Keyword category of the Create Keyword dialog, and click the

ellipsis to bring up the Please select a keyword dialog.
6.  Select $FIL and click OK to exit the Please select a keyword dialog and

then OK again to exit the Create Keyword dialog.
7.  Enter the following after the keyword token: <space> was created on

<space>
8.  Add the $DATE keyword (similar to steps 4–6). The Formula field should

resemble Figure 12.53.

Figure 12.53  Custom Token Example 3 Formula

9.   Insert the Custom Token you have just created into the Text Box by either
of the following methods:
· right-click on the Text Box , choose Insert Token from the pop-up

menu, select Appending Text from Custom (clicking on the triangle next
to Custom to expand the list, necessary), and click the Insert button, or

· drag and drop Appending Text from the Custom Token List (upper pane of

the Custom Tokens window) to an empty spot on your layout or to an
existing Text Box.

The Text Box should now resemble Figure 12.54.

Figure 12.54  Custom Token Example 3

12.4.5 Custom Token Example 4: Conditional Statements

This example demonstrates using conditional IF..THEN..ELSE statements in a
Custom Token formula.

1.  Insert a plot  and a text box  on a layout page. Create a gate  around
your cells of interest. 

2.  Open the Custom Token window  and dock  it.

3.  Click on  (Add) in the docked Custom Token window.
4.  Edit New Custom Token to read "Conditional Statement".
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5.  In the Formula field enter: =IF <space>
6.  Choose the Data Source  of the token by either of the following methods:

· right-click in the Formula area (lower pane of Custom Tokens window) and

choose Insert Token from the pop-up menu, and double-click Statistic.
 Choose the plot from Step 1 from the Data Source category

· drag and drop the plot from Step 1 from your layout page into the lower

pane of the Custom Tokens window, and double-click Statistic token.
7.  From the Statistic category, select the gate that you created in Step 1 from

the drop-down list in the Select Gate field. Highlight # of Events as the
statistic. Click OK.

8.  Type the following in the formula area: >2000 THEN "There are a lot of
cells." ELSE "There are very few cells". The Formula field should resemble
Figure 12.55.

Figure 12.55  Custom Token Example 4 Formula

9.   Insert the Custom Token you have just created into the Text Box by either
of the following methods:
· right-click on the Text Box , choose Insert Token from the pop-up

menu, select Conditional Statement from Custom (clicking on the triangle
next to Custom to expand the list, necessary), and click the Insert button,
or

· drag and drop Conditional Statement from the Custom Token List (upper

pane of the Custom Tokens window) to an empty spot on your layout or to
an existing Text Box.

The token will display There are a lot of cells. if the number of events in the
Plot #2 is greater than 2000 and There are very few cells. if the number of
events is less than or equal to 2000. If you move the gate, the Custom Token
formula is recalculated. Therefore, the token will display a different result if the
number of events within the gate changes from less than 2000 to greater than
2000 (or vice versa).

12.4.6 Custom Token Example 5: Hiding Signature Tokens

Once you have created and set up your signatures  in FCS Express, you may
only want to display their signing status on your layout pages if the layout is
signed and forgo signatures labeled as "unsigned" or "never signed".  

Creating a new custom token based on your signature token  will accomplish
the hiding effect.
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The custom token will take the form of a conditional statement  (IF, THEN,
ELSE statement) as follows where <signature XXXXX status> represents your
signature status  token. Use the following custom token equation to create the
token:

=if ("<signature XXXXX status>" = "Never Signed" or "<signature XXXXX
status>" = "Unsigned") then "" else "Signed"

Please note that:
1.  The custom token is case-sensitive so that Never Signed, Unsigned, and

Signed strings must be entered with capital letter when the match with the
Signature Token is evaluated (see example above).

2.  If the Signature Status token is compared to a text string as in this
example, the Signature Status token must be formatted to be a text string
by adding quotes around it (as in the example above and the screenshot
below). 

Once the new custom token has been defined you may drag and drop or insert it
anywhere in the layout and the token will only be displayed when the signing
status is "Signed".

12.4.7 More Complex Custom Token Examples

The following two examples demonstrate more complex custom token
formulas:
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· Custom Token Example 5 demonstrates the use of parentheses to control

the order in which mathematical operations are applied. The part of the
formula inside the parentheses is performed first. The Custom Token
formula in Figure 12.56 calculates the average number of events across
three plots.

Figure 12.56  Custom Token Example 5
Formula

· Custom Token Example 6 demonstrates the use of nested IF..THEN..ELSE

statements (Figure 12.57).

Figure 12.57  Custom Token Example 6 Formula

The custom token formula shown above categorizes the fluorescence of a
histogram based on the percentage of events within marker regions (Figure
12.58). If 80% of the events exist in the right marker region (M1), then the
formula returns Bright. If the middle marker region (M2) contains 80% of the
events, then Medium is returned. If 80% of the events exist in the left marker
region (M3), then Dim is returned. If none of the markers contain more than
80% of the events, then Unknown is returned.



FCS Express 7 Manual1346

© 2023 De Novo Software

Figure 12.58  Fluorescence Intensity Marker
Example

Additional conditions could be applied in Example 6. For example, if the sum of
two markers contains more than 80% of the events, then Bimodal could be
returned.

12.4.8 Inserting Functions into Formulas

A number of mathematical functions  can be inserted into custom token
formulas. To insert a function, right-click in the formula area at the point you
want the function to appear, choose Insert Function from the pop-up menu,
and select the appropriate function (Figure 12.59).
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Figure 12.59  Inserting a Function into a Formula

The available functions in each group are pictured below.

Math
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Type-Conversion

Logic
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Text Manipulation

Statistics
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Date Time

Regression
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SOP

Color

CompMatrix

Data List

System

Channel Calibration

For in-depth definitions for each non-Regression Function, please visit our
Custom Token Formula Reference .

For in-depth definitions for each Regression Function, please visit our Regression
Analysis section .  

For a table indicating the equation, the formula associated with it, and the
parameters defined in FCS Express when a fit is performed, please visit our
section on the Available Equations .

12.4.9 Editing Custom Tokens

You can edit the formula of a Custom Token directly in the Custom Tokens
window  by simply clicking on an available Custom Token from the list.

1366
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If you have already inserted a Custom Token into a text box, you can open an
Edit dialog (Figure 12.60) by either of the following methods:

· right-click on the Custom Token in the Text Box and choose Format Token

from the pop-up menu, or
· double-click on the token in the text box.

Figure 12.60  Editing a Custom Token -- Font Page

By default, Custom Tokens will contain 2 decimal places.  You can edit the
number of decimal places under the Number Format page of the dialog.  On this
page of dialog, you can also edit the Rounding Mode (from either Standard,
Down, Up, or Truncate) and whether or not the value shows trailing zeroes.

On the Font page of the dialog, you can modify which font to use for the token
depending on the value of the token or a custom value. Click Add to bring up a
Create Classification dialog (Figure 12.61). To change the font style or color
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for a range of values, select the Custom Font radio button and click the Edit
button. Then set the range and click OK. Repeat for other ranges.

Figure 12.61  Create Classification Dialog

If you edit the formula of a Custom Token in a text box (as opposed to editing it
in the Custom Token window), you will be prompted whether you want to
modify the existing token (throughout the layout), or create a new token that
only applies to that text box. If you choose Create New, a new token with a
default name will be created. To modify the default name, right-click on the new
token in the Custom Token window, select Rename from the pop-up menu,
and edit the name.

12.4.10 Custom Token Formatting

FCS Express custom token formulas must follow standard rules for
mathematical expressions in order to generate the desired token output. In
addition to standard mathematical operations, FCS Express can also perform
text manipulation, i.e., joining two text phrases together. The following table
shows examples of correct and incorrect formulas for generating text results.

Desired Output Correct Formula Incorrect Formula

There are 5000 cells "There are" + "5000 cells" "There are" + 5000 cells

4 2+2 "2"+"2"

22 "2"+"2" 2+2
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When tokens are inserted into formulas, they are considered to be one of two
types:  numeric result tokens or text result tokens. Numeric tokens have a blue
background and text tokens have a peach background when a formula is being
edited. It is possible to change the result type of a token by right-clicking on the
token and selecting the alternate result type from the drop-down menu (Figure
12.62).

Figure 12.62  Changing the Result Type in a Custom Token
Formula

When a new token is inserted into a formula, FCS Express will try to determine
the correct result type. However, some tokens can make sense either as a
number or text, depending on the context. It is up to you to ensure that the
correct type is selected. The result type is important when FCS Express is trying
to evaluate the result of a formula. Consider the case shown in the next table
where there are 5000 cells on plot 2.

Desired Output Correct Formula Incorrect Formula

There are 5000 cells
on plot 2

"There are " + 
+ " cells on plot 2"

"There are " + 
+ " cells on plot 2"

10000  * 2  * 2

  

In the first example, the incorrect formula tried to link a numeric result token
(blue) to text phrases. The correct formula contains a text result token (peach).

In the second example, the incorrect formula tried to apply a mathematical
operation to a text result token (peach). The correct formula contains a numeric
result token (blue).

An incorrect formula will display ##ERROR## if the token is placed in a text
box.
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12.4.11 Using Boolean Values in Custom Tokens

It is possible to create a custom token that returns a Boolean value. For
example, the statistic chosen in the custom token, Condition1, shown in Figure
12.63, was set on a gate drawn around the lymphocyte population. Condition1
will evaluate to TRUE or FALSE, depending on the number of cells in the
lymphocyte gate.

Figure 12.63  Token that Evaluates to TRUE or FALSE

You can use the My Condition token inside another token. To do so, set the
result type of the token to Numeric and use the IsTrue or IsFalse function , as
shown in Figure 12.64.

Figure 12.64  Using a Boolean token

12.4.12 Using Array Formulas in Custom Tokens

Several mathematical functions described in the Custom Token Formula
Reference , such as Mean, StdDev, Minimum, Maximum, and Range, work on
arrays. The arrays can contain an unlimited number of elements enclosed in
square brackets and separated by commas. These elements can be constants or
tokens.

For example:

· Using the formula =Minimum([54,36,75,89,39]) returns 36 when the

custom token is inserted in a text box.

· The formula in Figure 12.65 will return the mean of the Y Median values of

the Upper Left quadrant across four dot plots.

1366
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Figure 12.65  Using Tokens in an Array Formula

12.4.13 Deleting Custom Tokens

To delete a custom token, right-click on the token in the Custom Token window
list  and select Delete from the pop-up menu. If the deleted token is used in
the formula of another Custom Token, the remaining token will display
##ERROR## if it is used in a text box.
Also, a custom token can be deleted by selecting the token in the Custom Token

window List, and by clicking the Delete button  in the Custom Token window
toolbar.

12.4.14 Custom Token Display Types

FCS Express 7 has new custom token Display types which allow you to insert
an interactive Edit box, Check box, or Drop down list directly in a layout
(Figure 12.66). The new Display type feature can be accessed by right-clicking
on any custom token displayed on the layout and choosing Format Token
(alternatively, double click on the custom token to open the Edit custom token
dialog). Within the Edit custom token dialog click on the Display type drop
down and choose:

· Edit box  - creates an editable box directly in the layout where you can

change custom token values which will update the original custom token
and subsequently any other instance of the custom token

· Check box  - creates a check box directly in the layout that displays the

name of the custom token. Checking the box returns a "TrueValue" entry
for the custom token while unchecking the box returns a "FalseValue"
entry for the custom token. 

· Drop down list  - creates a drop down list of comma separated

choices entered in the Choices section of the Edit custom token dialog
Display category. 
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Figure 12.66 The Display type feature in FCS Express allows you to create editable
text fields, check boxes, and dropdown lists directly in your layout. 

12.4.14.
1

Edit Box Custom Tokens

The Edit box Display type allows you to create an editable box directly in the
layout where you can change Custom Token values which will update the original
Custom Token and subsequently any other instance of the Custom Token. To
create an Edit Box Custom Token:

1.  Create a new Custom Token  with or without text.  
2.  Drag and drop the Custom Token from the Custom Token window onto the

layout to insert it.
3.  Double-click the Custom Token in the layout to open the Edit custom token

dialog.
4.  Change the Display type to Edit box (Figure 12.67).

2104
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Figure 12.67 The custom token display type is set to edit box.

5.  Click OK.

An Edit box will appear within the text box in the layout where the token was
inserted (Figure 12.68). 

Figure 12.68 When the
Custom Token Display type is

set to Edit box, an editable
box will appear in the layout.
This one appears empty as
the original Custom Token

formula was not defined (i.e.,
left empty)

6.  Enter or change any text in the Edit box. 

Once a value has been entered, the custom token value in the Custom Tokens
navigator will reflect the value entered in the Edit box. The Custom Token may
then be dragged and dropped from the Custom Tokens window to any other
location in the layout. When dragging and dropping the token from the Custom
Tokens window, the default display type of "label" will be used thus displaying
only the value entered in the Edit box. When the value is updated in the Edit
box, the Custom Token will update wherever displayed. (Figure 12.69)
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Figure 12.69 The text of "John Smith" was entered in the Edit box. The
value was updated in the Custom Token window and also in the

secondary text box containing the token.

12.4.14.
2

Check Box Custom Tokens

The Check box Display type allows you to create a check box directly in the
layout that displays the name of the Custom Token. Checking the box returns a
"TrueValue" entry for the Custom Token while unchecking the box returns a
"FalseValue" entry for the custom token.  To create a Check box Custom
Token:

1.  Create a new Custom Token  with or without text.  
2.  Drag and drop the Custom Token from the Custom Token window onto the

layout to insert it.
3.  Double-click the Custom Token in the layout to open the Edit custom token

dialog.
4.  Change the Display type to Check box (Figure 12.70).
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Figure 12.70 The custom token display type is set to Check box.

5.  Click OK.

A Check box will appear within the text box in the layout where the token was
inserted (Figure 12.71). 

Figure 12.71 When the custom token
display type is set to Check box, a
check box will appear in the layout
displaying the name of the custom

token. 

6.  Check or uncheck the box next to the Custom Token name in the layout. 

Once the box has been checked, the Custom Token returns a "TrueValue" entry
for the Custom Token. Unchecking the box returns a "FalseValue" entry for the
Custom Token (Figure 12.72). The token value, "TrueValue" or "FalseValue"
may then be used in any location within FCS Express where a True or False
evaluation is made via tokens such as displaying pages or IF, THEN, ELSE
statements.  
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Figure 12.72) Once the box has been checked, the Custom Token
returns a "TrueValue" entry for the Custom Token. Unchecking the

box returns a "FalseValue" entry for the Custom Token.
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12.4.14.
3

Dropdown Custom Tokens

The Drop down list Display type allows you to create a list of comma-separated
values to appear in a drop down list within the layout. To create a Drop down
list:

1.  Create a new custom token  with or without text.  
2.  Drag and drop the custom token from the Custom Token window onto the

layout to insert it.
3.  Double-click the custom token in the layout to open the Edit custom token

dialog.
4.  Change the Display type to Drop down list.
5.  Enter a list of comma-separated choices for the list in the text field

(alternatively, choose to use any token values by clicking on the  button)
(Figure 12.73).

Figure 12.73 Enter a list of choices separated by a comma to be displayed in the
dropdown list.

6.  Click OK.

An empty box will appear within the text box in the layout where the token was
inserted (Figure 12.74). 

Figure 12.74 An empty
dropdown list box appears in

the layout where the token was
originally inserted. 
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7.  Click on the drop down arrow to reveal the contents of the Drop down list
(Figure 12.75).

Figure 12.75 Once the
dropdown arrow is pressed a
list of the comma separated
choice that were entered will

appear.

8.  Click on any of the choices in the Drop down list to fill the box (Figure 12.76).

Figure 12.76 The dropdown
list after the "De Novo
Software" choice was

selected.

Once a choice has been selected, the Custom Token value in the Custom
Tokens window will reflect the choice made in the Drop down list. The Custom
Token may then be dragged and dropped from the Custom Tokens window to
any other location in the layout. When dragging and dropping the token from the
Custom Tokens window, the default display type of "label" will be used, thus
displaying only the value chosen in the Drop down list. When the value is updated
via the Drop down list the custom token will update wherever displayed. (Figure
12.77)
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Figure 12.77 The value of "De Novo Software" was chosen from the
dropdown list. The value was updated in the Custom Token navigator

and also in the secondary text box containing the token.

12.5 Custom Token Formula Reference

The following tables are a reference of all operators and functions available for
creating custom tokens in the Custom Token Editor  and with Parameter
Math .

Note about regional settings

Array lists (i.e. lists of values within [ ]) require comma as list separator in US
settings (dot as decimal separator) and semicolon with EU settings (i.e.
comma as decimal separator). E.g.:

US settings (dot as decimal
separator)

EU settings (comma as decimal
separator)

=Mean([TOKEN1,TOKEN2]) =Mean([TOKEN1;TOKEN2])

=Minimum([TOKEN1,TOKEN2]) =Minimum([TOKEN1;TOKEN2])

=Maximum([TOKEN1,TOKEN2]) =Maximum([TOKEN1;TOKEN2])
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Non-array lists (i.e. lists of values that are not within [ ]) use comma as list
separator in both regions (EU and US). E.g.:

US settings (dot as decimal
separator)

EU settings (comma as decimal
separator)

=Min(TOKEN1,TOKEN2) =Min(TOKEN1,TOKEN2)

=Max(TOKEN1,TOKEN2) =Max(TOKEN1,TOKEN2)

 Note: when using array lists, please note that the list separator does not
automatically updated when a layout is opened on a computer using difference
regional settings. E.g. if a layout is created using US settings and thus comma
as list separator, when the layout will be opened on a computer using EU
settings, the list separator will still be comma and will have to be manually
replaced by a semicolon to make the toke being evaluated properly.

----------------------------

Arithmetic Operators

Operator Description

x+y Add x and y

x-y Subtract y from x

x*y Multiply x and y

x/y Divide x by y

x^y x to the y power

Conditional/Comparison Operators. Use these with IF..THEN..ELSE
statements.

Operator Description

x>y x is greater than y

x<y x is less than y

x=y x is equal to y

x>=y x is greater than or equal to y

x<=y x is less than or equal to y

x<>y x is not equal to y

Logical Operators. These are used in IF..THEN..ELSE statements or to combine
two equations.  

Operator Description

x OR y x OR y

x AND y x AND y

NOT (x AND y) Inverse of the value of (x AND y)

Example:  if (x>20 and y>20) then......else
If combining multiple logical operators, parenthesis must surround each operator.
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Operator Description

Example:  if ((x>20 and y>20) and (a<1 or b>10)) then......else

Math (Mathematical Functions)

Function Description

Abs(x) Absolute value of x

ArcCos(x) Arc Cosine of x

ArcCosh(x) Hyperbolic Arc Cosine of x

ArcSin(x) Arcsine of x

ArcSinh(x) Hyperbolic Arcsine of x

ArcTan(x) Arctangent of x

ArcTanh(x) Hyperbolic Arctangent of x

ConvertLinToLog(I,J,
K,L)

Converts a linearly scaled value into a logarithmically scaled value,
using the following parameters:
I = Lin value, J = # of decades, K = output range (with values of 0,
256, 512, or 1024), L = offset

This will convert a value from 1-10,000 to 0-1024.

This function can also be used in the Parameter Math tool to
convert an entire parameter. The parameter to convert should be
specified as the I term using the Pn notation (e.g. P1, P2, P3,....).

ConvertLogToLin(I,J,
K,L)

Converts a Logarithmically scaled value into a Linearly scaled value,
using the following parameters:
I = Log value, J = # of decades, K = input range, L = offset

This will convert a value from 0-1024 to 1-10,000.

This function can also be used in the Parameter Math tool to
convert an entire parameter. The parameter to convert should be
specified as the I term using the Pn notation (e.g. P1, P2, P3,....).

Cos(x) Cosine of x

Cosh(x) Hyperbolic Cosine of x

CoTan(x) Cotangent of x

Ln(x) Natural logarithm of x

Log(x,y) Logarithm of y in base x

Max(x,y) Returns the higher value of x and y.

Maximum([x,y,z...]) Returns the maximum value in the array ([x,y,z,…]). The array can
hold an unlimited number of elements.

Mean([x,y,z...]) Returns the mean of the values in the array [x,y,z,…]. The array can
hold an unlimited number of elements.

Min(x,y) Returns the lower value of x and y.

Minimum([x,y,z...]) Returns the minimum value in the array ([x,y,z,…]). The array can
hold an unlimited number of elements.

Range([x,y,z...]) Returns the result of (Maximum([x,y,z,…]) – Minimum([x,y,z,…])).

Sin(x) Sine of x

Sinh(x) Hyperbolic Sine of x

Sqr(x) x squared

Sqrt(x) Square root of x
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Function Description

StdDev([x,y,z...]) Returns the standard deviation of the values in the array [x,y,z,…].
The array can hold an unlimited number of elements.

Tan(x) Tangent of x

Type Conversion Functions. These are used in more advanced formulas, to
convert a number to text and vice versa. They are used when the value returned
by a particular token is not the type that you need, and you want to convert it to
a type that you can include in your formula. You could also change the result
type as described in Custom Token Formatting .

Function Description

NumericToString(nu
mber)

Converts number to a text string.

StringToNumeric("te
xt")

Converts the text to a number.

Logic (True/False) Functions. These functions evaluate whether the condition
defined by the variables is True or False. Some of the functions return a
numerical representation of True (-1) or of False (0).

Function Description

Between(number1,nu
mber2,number3)

Returns True if number1 is between number2 and number3
(including being equal to number2 or number3).
Otherwise, this function will return False or the numerical
equivalent, 0.

FalseValue Returns 0.

IsFalse(number) Returns True if number has a value of 0.

Typically, number will represent a condition, such as x>y.  The
Conditional/Comparison operators listed above can be used in this
context.

IsSameText([Text1,T
ext2,TextN],CaseSen
sitive)

The IsSameText function can be used in a situation where text
values need to be evaluated to see whether or not they match.

For example, this function can be used to evaluate whether a
sample identification keyword between multiple tubes within the
same panel is identical or not.

This function returns True (or -1.0) if each text value in the
sequence are the same or False (0.0) if the text values are not
the same. CaseSensitive is set to either True or False.  Please
note the brackets before the first text value and after the last text
value.  Each text value within the brackets is separated by a
comma.

If CaseSensitive is True, the words must match in case, in
addition to its content.
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Function Description

Please note that the output from this function will be either a -1.0
or 0.0.  

If the user is looking for a text output for the condition being
evaluated using this function, an IF THEN ELSE statement will need
to be created separately that evaluates the output from the
IsSameText function.

IsTrue(number) Returns True if number has a value of -1.

Typically, number will represent a condition, such as x>y.  The
Conditional/Comparison operators listed above can be used in this
context.

RegExMatch("Text","R
egular Expression")

The function RegExMatch uses a regular expression (a specific,
standard textual syntax for representing patterns for matching
text) that can be executed and matched against a string
representing the text being searched in. Please see:
https://en.wikipedia.org/wiki/Regular_expression for more
information on regular expressions in general. 

StartsWith("text1",
"text2",
CaseSensitive)

The function StartsWith evaluates whether “text1” starts with
“text2”. 

For Example:
StartsWith(“Friend”, “Fri”, True)  gives a result of -1.00 if it is True
and 0.00 if False.

TrueValue Returns -1.

Text Manipulation Functions. These functions can be used to manipulate or get
information out of existing text values.

Function Description

AreValuesInRange([nu
mber1,number2,...],tol
erance,
[name,1,name2,name3
...])

This function will determine if the numbers in
[number1,number2,...] are within a percentage of each other, as
determined by tolerance.

If the values in the array [number1,number2,...] are all within
tolerance % of each other, the function returns True. 

If a pair of values in the array are not within tolerance % of each
other, the function returns text indicating which ones are not.

For example:
=AreValuesInRange([100,105],10,["Sample 1","Sample 2"])
will return True since all 3 values are within the tolerance of 10%.

=AreValuesInRange([100,120],10,["Sample 1","Sample 2"])
will return Sample 1 is not within 10% of Sample 2.

Please note that the number of number entries and name entries
must match.

https://en.wikipedia.org/wiki/Regular_expression
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Function Description

In other words, there are 3 numbers involved in the numerical
evaluation of the function, there must be 3 corresponding name
entries.  If these do not match, the function will return The
number of elements in values array and names array is not
the same.

ChangeExtension("file_
path",
"new_extension")

This function accepts a file name and new file extension and will
return the text of the file name with the new file extension.

For example:
if a file path is C:\Data Files\FlowData1.xyz,
ChangeExtension("C:\Data Files\FlowData1.xyz","csv") will
return C:\Data Files\FlowData1.csv.   

Copy("text",number1,n
umber2)

The function Copy will copy a a string of characters from "text",
which is the full text, based on the values of number1 and
number2. 

number1 is the position to start copying text. 

number2 is the number of characters to copy from the full text.

For example: 
COPY("SheldonCooper",1,7) will return Sheldon because the
function will start at the first character of the string, denoted by
number1, and copy the characters denoted by number2,
including the character denoted by number1.

Please note that number1 can also be derived from a token or
custom token.

If the position to start copying text is based on the position of a
character, such as a delimiter, the pos("text1","text2") function
can be used to determine number1.

For example, in the image below:
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Function Description

This COPY function is using the value established from a POS
function to determine where to start the copy within the text
string Sheldon/Cooper.

The POS function is determining the position of the / within the
text string Sheldon/Cooper.  In this function, the output will be
a value of 8, since the / is the 8th character within the sting.

A +1 is added after the POS custom token to indicate that the
copy will not include the character /.

The output of this overall custom token will be Cooper since:
· the text is Sheldon/Cooper,
· the number1, along with +1, is being determined by the POS

function, indicating a value of 9 ,
· and number2 is indicating the number of characters to copy

after number1.

ExtractFilename("file_p
ath")

This function will evaluate a file name and return the text of the
data file name.  

For example:
if a file path is C:\Data Files\Today\FlowData1.fcs,
ExtractFilename("file_path")will return FlowData1.fcs.

Keyword tokens using the keywords $FIL, $FCSE_FILENAME or
$FCSE_FILENAMENOPATH can be used for this function.

ExtractFolderFromFilen
ame("file_path")

This function will evaluate a file name and return the text of the
file path of the folder in which the data is contained.  

For example: 
if a file path is C:\Data Files\Today\FlowData1.fcs,
ExtractFolderFromFilename("file_path") will return C:\Data
Files\Today.

Keyword tokens using the keyword $FCSE_FILENAME can be
used for this function.

FileExists(file_path) This function will evaluate if a file exists at a particular file path. 

For example:
If a file path is  C:\Data Files\Today\FlowData1.fcs,
FileExists($FCSE_FILENAME) will return -1.00 if the file exists
and 0.00 if the file does not exist.

If evaluating a manually entered pathway use quotations marks as
shown here =FileExists("C:\Users\Desktop\Data\Control.fcs")

Keyword token $FCSE_FILENAME may be used for this function.

FolderExists(folder_pat
h)

This function will evaluate if a folder exists at a particular file
path.
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Function Description

For example:
If evaluating the system token "Desktop Folder" in
FolderExists(Desktop Folder) the function will return -1.00 if
the folder exists and 0.00 if the folder does not exist.

If evaluating a manually entered pathway use quotations marks as
shown here =FolderExists("C:\Users\Desktop\Data")

FormatFloat("format
string",number)

FormatFloat formats the floating-point value given by Number
using the format string given by Format String. The following
format specifiers are supported in the format string: 

Specifie

r 
Represents 

0 

Digit placeholder. If the value being formatted has a digit
in the position where '0' appears in the format string,
then that digit is copied to the output string. Otherwise,
a '0' is stored in that position in the output string. 

# 

Digit placeholder. If the value being formatted has a digit
in the position where '#' appears in the format string,
then that digit is copied to the output string. Otherwise,
nothing is stored in that position in the output string. 

. 

Decimal point. The first '.' character in the format string
determines the location of the decimal separator in the
formatted value; any additional '.' characters are ignored.
The actual character used as a decimal separator in the
output string is determined by the DecimalSeparator
global variable or its equivalent. 

, 

Thousand separator. If the format string contains one or
more ',' characters, the output will have thousand
separators inserted between each group of three digits
to the left of the decimal point. The placement and
number of ',' characters in the format string does not
affect the output, except to indicate that thousand
separators are wanted. The actual character used as a
thousand separator in the output is determined by the
ThousandSeparator global variable or its equivalent. 

E+ 

Scientific notation. If any of the strings 'E+', 'E-', 'e+', or
'e-' are contained in the format string, the number is
formatted using scientific notation. A group of up to four
'0' characters can immediately follow the 'E+', 'E-', 'e+',
or 'e-' to determine the minimum number of digits in the
exponent. The 'E+' and 'e+' formats cause a plus sign to
be output for positive exponents and a minus sign to be
output for negative exponents. The 'E-' and 'e-' formats
output a sign character only for negative exponents.
Learn more about working with Scientific Notation. 

'xx'/"xx" 
Characters enclosed in single or double quotation marks
are output as such and do not affect formatting. 

; 
Separates sections for positive, negative, and zero
numbers in the format string. 

http://www.denovosoftware.com/site/kb-ScientificNotation.shtml 
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Function Description

The locations of the leftmost '0' before the decimal point in the
format string and the rightmost '0' after the decimal point in the
format string determine the range of digits that are always present
in the output string. 
The number being formatted is always rounded to as many decimal
places as there are digit placeholders ('0' or '#') to the right of the
decimal point. If the format string contains no decimal point, the
value being formatted is rounded to the nearest whole number. 
If the number being formatted has more digits to the left of the
decimal separator than there are digit placeholders to the left of
the '.' character in the format string, the extra digits are output
before the first digit placeholder. 
To allow different formats for positive, negative, and zero values,
the format string can contain between one and three sections
separated by semicolons, as follows: 

* One section: The format string applies to all values. 
* Two sections: The first section applies to positive values

and zeros, and the second section applies to negative
values. 

* Three sections: The first section applies to positive values,
the second applies to negative values, and the third applies
to zeros. 

If the section for negative values or the section for zero values is
empty, that is if there is nothing between the semicolons that
delimit the section, the section for positive values is used
instead. 
If the section for positive values is empty or if the entire format
string is empty, the value is formatted using general floating-point
formatting with 15 significant digits. General floating-point
formatting is also used if the value has more than 18 digits to the
left of the decimal point and the format string does not specify
scientific notation.

FragmentCount("text1"
,'text2")

This function returns the number of string fragments in text2
separated by text1.

Text1 will equal a delimiter, such as "\", for example.  Text2 will be
a pathway.

For example: 
FragmentCount("\","C:\Documents\Data\Sample.fcs") will
return 4, since there are 4 fragments that are delimited by "\".

Keywords that return a pathway, such as $FCSE_FILENAME, can
be used for Text2.

GetContainingFolder("fil
e_path")

Returns the name of the folder containing the file named in
file_path.

Example, if file Sample.fcs was located in the directory C:

\Program Files\De Novo Software\FCS Express 7 Plus Research
Edition/Data, the output for this function would be Data.
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GetFragment(n,
"text1", "text2")

Returns the Nth string fragment in text2, delimited by text1.

N = the nth occurrence, Text1 = a delimiter, such as "\", Text2 =
a string that uses Text1 as a delimiter.  

Some examples of Text2 could be:
§ a pathway that uses "\" as a delimiter, such as C:

\Documents\Data\Sample.fcs.
§ a name of a file where several identifiers have been

concatenated together and delimited by "_", such as
FirstnameLastname_ID1_ID2_ID3_Date.

For example, GetFragment(1, "\", "C:
\Documents\Data\Sample.fcs") will return C:.

GetFragment(2, "\", "C:\Documents\Data\Sample.fcs") will
return Documents.

If n is a positive number, the function will start evaluating the text
string from left to right.

If n is a negative number, the function will start evaluating the
text string from right to left.

For example, GetFragment(-
2,"_","SheldonCooper_ABC_DEF_GHI") will return DEF.

IncludeTrailingPathDeli
miter("file_path")

Accepts the value of file_path, while including the delimiter (\, for
example) at the end of the string.

pos("text1","text2") The pos("text1","text2") function will return the position of text
text1 in text string text2.

text1 is the text for which you are searching. text2 is the text in
which you are searching for text1.  

If text2 cannot be found in text1, the return value is 0.

For example:

pos("/" , "Sheldon/Cooper") will return an 8, since the / is the
8th character within the text string Sheldon/Cooper.
pos("/" , "SheldonCooper") will return an 0, since the / is not
found within the text string SheldonCooper.

Quotes are not needed around X or Y if X or Y are tokens that
have been formatted for a Result Type of Text.

The pos("X","Y") function is a useful function that can be used
in tandem with other text manipulation functions, such as
Copy("text",number1,number2), where the point at which the
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copy of text will start is dependent on the position of another
character within a text string.  

In this scenario, both functions should be created as their custom
token, with the custom token for the pos function being used as
the variable number1 within the COPY function.

PositionInText("text1",
"text2",startingPosition
,n)

PositionInText returns the position of a string within another
string.
Text1 = the text for which you are searching
Text2 = the text in which you are searching
startingPosition = the position at which to start searching
(1,2,3...etc.)
n = the Nth occurrence for the string for which you are searching
(1 for 1st occurrence, 2 for 2nd occurrence, etc.)

For example =PositionInText("d","abcdefgabcdefg",1,1) would
return 4 because the first occurrence (N=1) of "d" occurs at
position 4.
                 =PositionInText("d","abcdefgabcdefg",1,2) would
return 11 because the second occurrence (N=2) of "d" occurs at
position 11.

This function would return a "0" if no occurrence can be found.

RemoveExtension("filen
ame")

RemoveSpaces("text") Removes existing spaces from text and returns the resulting text.

For example:
RemoveSpaces("Sheldon Cooper") will return SheldonCooper.

RemoveText("text1","t
ext2",RemoveAll)

This function will remove the string text1 from text2. 
RemoveAll will equal True or False depending on whether only
the first occurrence is to be removed.
For example, =RemoveText("def","abcdefg",True) will return
abcg.

ReplaceText("text1","t
ext2","text3",RemoveAl
l)

This function will replace the string text1 with the string text2
located within the string text3.  RemoveAll will equal True or
False depending on whether only the first occurrence is to be
removed.
For example, =ReplaceText("def","xyz","abcdefg",True) will
return abcxyzg.

"text1"+"text2" If text1 and text2 are both text strings, this quick equation
returns the joining of text1 and text2.

For example:
="Sheldon"+"Cooper" will return SheldonCooper

Note: Token is not represented in the "Insert Function" list since
it is an general text based operation. 

Trim("text") Trim removes spaces before and after a string of text.
For example, =Trim("   abcd efgh      ") will return "abcd efgh"



Tokens 1377

© 2023 De Novo Software

Function Description

TrimLeft("text") TrimLeft removes spaces to the left of a string of text
For example, =TrimLeft("     abcd efgh     ") will return "abcd
efgh       "

TrimRight("text") TrimRight removes spaces to the right of a string of text
For example, =TrimLeft("     abcd efgh     ") will return "    abcd
efgh"

Statistical Functions

Operator Description

ANOVA([number1,...,numberX|
number1,...,numberY|
number1,...,numberZ],alpha)

Performs a single-factor Analysis of Variance
(ANOVA) of data in list form and reports the full
set of results.  The alpha is the desired
significance level; this value must range between
0 and 1.

number1,..., numberX reflect the list of data
values for one group
number1,..., numberY reflect the list of data
values for a second group
number1,..., numberZ reflect the list of data
values for a third group

The P-value is reported when using this function.

Please also see the ANOVA chapter of the
manual  for more details on additional
implementations of ANOVA via spreadsheets. 

ChiSquareTest([number1,...],
[number2,...])

Performs the Chi-squared goodness of fit test to
test if data is coming from specific distribution.
The first parameter is an array of observed
frequencies, the second parameter is an array of
estimated (theoretical) frequencies. 

This function returns the probability of observing
the given result by chance given that the null
hypothesis is true, where the null hypothesis is
that the distribution in the first array is the same
as the distribution in the second array. 

The FCS Express implementation of this function
is a right tailed test.

FTest([number1,...],[number2,...]) Performs F-Test by comparing number1 and
number2 standard deviations. The parameters
are the first and the second data set.

GrubbsTest([number1,...]) Performs the Grubbs test for outliers. Test is
used to detect outliers in a univariate data set.
It is based on the assumption of normality. That
is, you should first verify that your data can be
reasonably approximated by a normal distribution

556
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before applying the Grubbs' test.  The parameter
is the data set.

KSTest([number1,...],[number2,...]) Performs two-sample Kolmogorov-Smirnov
goodness of fit test of independent random
samples Data1 and Data2. Test determines if
Data1 and Data2 samples are drawn from the
same continuous population. The parameters are
the first and the second data set.

KSTest2([number1,...],[number1,...],
tails, significance)

Performs two-sample Kolmogorov-Smirnov
goodness of fit test of independent random
samples Data1 and Data2. Test determines if
Data1 and Data2 samples are drawn from the
same continuous population. The parameters are
the first and the second data set, the

hypothesis type ("TWO_TAILED", "LEFT_TAILED" or
"RIGHT_TAILED" (not case sensitive and requires
quotes)), and significant level for which to test.

For example, 0.05. 

LillieforsTest([number1,...]) Performs the Lilliefors goodness of fit test to a
normal distribution with unknown parameters mu
and sigma. The parameter is the data set.

MannWhitney([number1,...],
[number1,...],hypothesis type,alpha,
use normal approximation)

The Mann Whitney test is a nonparametric test
of the null hypothesis that two samples come
from populations of equal means, against an
alternative hypothesis, especially that a
particular population has a larger mean than the
other one.  It operates under the assumption
that all the observations from both groups are
independent of each other.  (Credit:  Wikipedia)

The variables for the functions are as follows:

[Number1.....] - Comma separated values from
the 1st data set.
[Number2.....] - comma separated values from
the 2nd data set.

Hypothesis Type - TWO_TAILED, LEFT_TAILED or
RIGHT_TAILED (not case sensitive)
Alpha - the significance level for which to test.  For
example, 0.05.
Use Normal Approximation - True/False

PercentilePlot(Plot Number, Axis, Overlay
Number, k-th Percentile)

Returns the k-th percentile of the distribution
displayed in a plot.
Plot Number - Must be an integer value greater
than, or equal to, 1.
Axis - Must be a text string (in quotes) between
“X”, “X axis”, “XAxis”, “Y”, “Y axis”, or “YAxis”.
Overlay Number - Must be an integer value
greater than, or equal to, 1.

https://en.wikipedia.org/wiki/Mann%E2%80%93Whitney_U_test
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Percentile - Is the percentile (inclusive) of
interest. Must be an integer value between 0
and 100.

SSMD(mean max,mean min,n max,n
min,SDmax,SDmin)

Short for Strictly Standardized Mean Difference.
 Has been used as a ranking metric for hit
selection in high throughput screening assays.

StainIndex(positive population
mean/median, negative population
mean/median, negative population
standard deviation).

Performs a stain index calculation using the
means/medians of positive and negative
populations and the negative population standard
deviation based on the Stain Index formula of
(Median of Positive - Median of Negative) / (SD
of Negative * 2).

TTest1S([number1,...],expected mean) Performs the one sample T-test. It compares
Data mean value with the expected mean. The
first parameter is the data set.

TTest2S([number1,...],
[number2,...],tails,paired)

It compares Number1 mean value with Number2
mean value. The assumption is Number1 and
Number2 variances are equal, but unknown. The
first 2 parameters are the first and the second
data sets.  Tails parameter can be 1 or 2. It is
used to define the type of null hypothesis, a
value of 1 means left tailed, a value of 2 means
two tailed.   Paired can be True or False.  If
True, it will perform Two-Sample Paired t-Test.
If False, it will perform Two-Sample Pooled
(unpaired) t-Test.

Wilcoxon([number1,...],
[number1,...],hypothesis type,alpha)

The Wilcoxon test is a nonparametric test that
compares two paired groups. The test calculates
the difference between each set of pairs and
analyzes these differences. The Wilcoxon Rank
Sum test can be used to test the null hypothesis
that two populations have the same continuous
distribution.  (credit:  Investopedia)

The variables for the functions are as follows:

[Number1.....] - Comma separated values from
the 1st data set.
[Number2.....] - comma separated values from
the 2nd data set.

Hypothesis Type - TWO_TAILED, LEFT_TAILED or
RIGHT_TAILED (not case sensitive)
Alpha - the significance level for which to test, for
example, 0.05.

ZPrime(mean negative,SD
negative,mean positive,SD positive)

The ZPrime function is used to calculate the Z
Factor.  The Z-factor is an attempt to quantify
the suitability of a particular assay for use in a
full-scale, high-throughput screen by comparing
the Mean and Standard Deviation of a negative
control to the Mean and Standard Deviation of a
positive control within the experiment.

http://www.investopedia.com/terms/w/wilcoxon-test.asp


FCS Express 7 Manual1380

© 2023 De Novo Software

Operator Description

ZTest([number1,...],expected
mean,expected SD)

Compares the normally distributed Data elements
mean value with known standard deviation
expected SD, to a mean value expected
mean. ([Number1,...]) is the data set.

Date and Time Manipulation Functions

Function Description

DateKWToDate($DATE
keyword,n)

Takes the standardized format of the $DATE keyword, which
is in either dd-mmm-yy or dd-mmm-yyyy format, and returns
mm/dd/yyyy.

If $DATE has the year listed as yy, n will be placed in front
of yy to produce yyyy.  A keyword token will be used to
insert the value of $DATE.

For example if the $DATE keyword equals 03-Nov-05,
DateKWToDate($DATE,20) will return 11/03/2005.

If the year is already formatted as yyyy, the function will still
return mm/dd/yyyy.  If the year is already formatted as
yyyy, n must still be accounted for in the function.

For example, if $DATE keyword equals 04-Jul-2008,
DateKWToDate($DATE,20) will return 07/04/2008.  Also,
DateKWToDate($DATE,0) will return 07/04/2008.

DateTimeToStrFMT(time,
format)

DateTimeToStrFMT formats the Time or Date value given by
using the format desired.

Example:  =DateTimeToStrFMT(Current Date token,
"yyyy-mm-dd") will return the Current Date in a format
showing Year-Month-Day, with 2 digits for the month and
day, and 4 digits for the year.

              =DateTimeToStrFMT(Current Time
token,"hh:mm:ss") will return the Current Time in a format
showing Hour:Minute:Second, with 2 digits for Hour, Minute
and Second.

*Please note that if using the <Current Date> token, no
quotation marks are needed, as the Result Type for this
token is Text.

Formats can use the Specifier Displays  shown below.

DaysBetween(StartDate,En
dDate)

Returns the number of days between the values entered for
the StartDate and EndDate.  

1381
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Dates in anything other than a mm/dd/yyyy format will need
to be run through DateKWToDate and/or FormatDateTime
prior to being used within this function.

FormatDateTime("format","D
ate or Time")

FormatDateTime formats the Time or Date value given by
using the format given.  

Example:  =FormatDateTime("yyyy-mm-dd",(<Current
Date token>)) will return the Current Date in a format
showing Year-Month-Day, with 2 digits for the month and
day, and 4 digits for the year.
              =FormatDateTime("hh:mm:ss",(<Current
Time token>)) will return the Current Time in a format
showing Hour:Minute:Second, with 2 digits for Hour, Minute
and Second.

*Please note that if using the <Current Date> token, no
quotation marks are needed, as the Result Type for this
token is Text.

Formats can be as follows below:

Specifier Displays :
c 
Displays the date using the format given by the
ShortDateFormat global variable, followed by the time using
the format given by the LongTimeFormat global variable. The
time is not displayed if the date-time value indicates midnight
precisely. 
d 
Displays the day as a number without a leading zero (1-31). 
dd 
Displays the day as a number with a leading zero (01-31). 
ddd 
Displays the day as an abbreviation (Sun-Sat) using the
strings given by the ShortDayNames global variable. 
dddd 
Displays the day as a full name (Sunday-Saturday) using the
strings given by the LongDayNames global variable. 
ddddd 
Displays the date using the format given by the
ShortDateFormat global variable. 
dddddd 
Displays the date using the format given by the
LongDateFormat global variable. 
e 
(Windows only) Displays the year in the current period/era as
a number without a leading zero (Japanese, Korean, and
Taiwanese locales only). 
ee 
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(Windows only) Displays the year in the current period/era as
a number with a leading zero (Japanese, Korean, and
Taiwanese locales only). 
g 
(Windows only) Displays the period/era as an abbreviation
(Japanese and Taiwanese locales only). 
gg 
(Windows only) Displays the period/era as a full name
(Japanese and Taiwanese locales only). 
m 
Displays the month as a number without a leading zero (1-
12). If the m specifier immediately follows an h or hh
specifier, the minute rather than the month is displayed. 
mm 
Displays the month as a number with a leading zero (01-12).
If the mm specifier immediately follows an h or hh specifier,
the minute rather than the month is displayed. 
mmm 
Displays the month as an abbreviation (Jan-Dec) using the
strings given by the ShortMonthNames global variable. 
mmmm 
Displays the month as a full name (January-December) using
the strings given by the LongMonthNames global variable. 
yy 
Displays the year as a two-digit number (00-99). 
yyyy 
Displays the year as a four-digit number (0000-9999). 
h 
Displays the hour without a leading zero (0-23). 
hh 
Displays the hour with a leading zero (00-23). Please note
that the default display for the hour is in a 24 hour format.
m 
Displays the minute without a leading zero (0-59). 
mm 
Displays the minute with a leading zero (00-59). 
s 
Displays the second without a leading zero (0-59). 
ss 
Displays the second with a leading zero (00-59). 
z 
Displays the millisecond without a leading zero (0-999). 
zzz 
Displays the millisecond with a leading zero (000-999). 
t 
Displays the time using the format given by the
ShortTimeFormat global variable. 
tt 
Displays the time using the format given by the
LongTimeFormat global variable. The variables t or tt are
usually used on their own as the format.
am/pm 
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Uses the 12-hour clock for the preceding h or hh specifier,
and displays 'am' for any hour before noon, and 'pm' for any
hour after noon. The am/pm specifier can use lower, upper,
or mixed case, and the result is displayed accordingly. 
a/p 
Uses the 12-hour clock for the preceding h or hh specifier,
and displays 'a' for any hour before noon, and 'p' for any hour
after noon. The a/p specifier can use lower, upper, or mixed
case, and the result is displayed accordingly. 
ampm 
Uses the 12-hour clock for the preceding h or hh specifier,
and displays the contents of the TimeAMString global variable
for any hour before noon, and the contents of the
TimePMString global variable for any hour after noon. 
/ 
Displays the date separator character given by the
DateSeparator global variable. 
: 
Displays the time separator character given by the
TimeSeparator global variable. 
'xx'/"xx" 
Characters enclosed in single or double quotation marks are
displayed as such, and do not affect formatting.

HoursBetween(start
time,end time)

Counts the number of hours between the start time and the
end time.  

The keywords $BTIM or $ETIM can be used for the start and
end times.  However, user-defined times would need to be
fed through the StrToTimeFMT function prior to use in this
function to establish the proper formatting.

MillisecondsBetween(start
time,end time)

Counts the number of milliseconds between the start time
and the end time.  

The keywords $BTIM or $ETIM can be used for the start and
end times.  However, user-defined times would need to be
fed through the StrToTimeFMT function prior to use in this
function to establish the proper formatting.

MinutesBetween(start
time,end time)

Counts the number of minutes between the start time and
the end time.  

The keywords $BTIM or $ETIM can be used for the start and
end times.  However, user-defined times would need to be
fed through the StrToTimeFMT function prior to use in this
function to establish the proper formatting.

SecondsBetween(start
time,end time)

Counts the number of seconds between the start time and
the end time.  

The keywords $BTIM or $ETIM can be used for the start and
end times.  However, user-defined times would need to be
fed through the StrToTimeFMT function prior to use in this
function to establish the proper formatting.
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StrToDateFMT(text,
"format", "delimiter")

Returns a date string in the format as defined by the user,
using the specifier displays as seen in
FormatDateTime("format","Date or Time") of ddmmyyyy  using
the delimiter designated, such as "/".

StrToTimeFMT(text, "time
delimiter", "millisecond
delimiter")

Returns a time string using a time delimiter and a millisecond
delimiter.

TimeKWToTime("TimeKeywo
rd")

Converts the value of the FCS keyword format of $BTIM or
$ETIM (HH:MM:SS, or HH:MM:SS:MSEC, or HH:MM:SS.MSEC)
to a standard time format that can be displayed flexibly using
the Windows settings.

YearsBetween(Start
Date,End Date)

Returns the number of years between the values entered for
the Start Date and End Date.  

Dates in anything other than a mm/dd/yyyy format will need
to be run through DateKWToDate and/or FormatDateTime
prior to being used within this function.

Regression. Regression functions allow a custom token to retrieve the X (or the
Y) value for a given Y (or a given X) from several regression functions, extract a
fit variable and value, and/or perform a fit of the specified X-Y values to a
particular equation.  

Function Description

BoltzmannXToY(x,
[modelParameters])

The function returns the unknown Y value of the
Boltzmann  regression fit given the X input value and
modelParameters.  

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: Bottom, Top, V50, Slope,
and r2.  It is an available Statistic Token.  It can be found
under Regression Parameter Statistics and appears as
Model Parameters.

Only a single input X value is allowed. 

BoltzmannYToX(y,
[modelParameters]) 

The function returns the unknown X value of the
Boltzmann  regression fit given the Y input value and
modelParameters. 

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: Bottom, Top, V50, Slope,
and r2. It is an available Statistic Token.  It can be found
under Regression Parameter Statistics and appears as
Model Parameters.

Only a single input Y value is allowed. 

610
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CubicXToY(x,
[modelParameters])

The function returns the unknown Y value of the Cubic
regression fit given the X input value and
modelParameters.  

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: m, b, A2, A3, and r2. It
is an available Statistic Token.  It can be found under
Regression Parameter Statistics and appears as Model
Parameters.

Only a single input X value is allowed. 

CubicYToX(y,
[modelParameters]) 

The function returns the unknown X value of the Cubic
regression fit given the Y input value and
modelParameters.  

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: m, b, A2, A3, and r2.It is
an available Statistic Token.  It can be found under
Regression Parameter Statistics and appears as Model
Parameters.

Only a single input Y value is allowed. 

ExpAssociationXToY(x,
[modelParameters])

The function returns the unknown Y value of the Exponential
Association  regression fit given the X input value and
modelParameters.  

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: Ymax1, K1, and r2. It is
an available Statistic Token.  It can be found under
Regression Parameter Statistics and appears as Model
Parameters.

Only a single input X value is allowed. 

ExpAssociationYToX(y,
[modelParameters]) 

The function returns the unknown X value of the Exponential
Association  regression fit given the Y input value and
modelParameters.  

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: Ymax1, K1, and r2. It is
an available Statistic Token.  It can be found under
Regression Parameter Statistics and appears as Model
Parameters.

Only a single input Y value is allowed. 

ExponentialGrowXToY(x,
[modelParameters])

The function returns the unknown Y value of the Exponential
Grow  regression fit given the X input value and
modelParameters.  

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: A, B, C, and r2. It is an

611
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available Statistic Token.  It can be found under
Regression Parameter Statistics and appears as Model
Parameters.

Only a single input X value is allowed. 

ExponentialGrowYToX(y,
[modelParameters]) 

The function returns the unknown X value of the Exponential
Grow  regression fit given the Y input value and
modelParameters.  

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: A, B, C, and r2. It is an
available Statistic Token.  It can be found under
Regression Parameter Statistics and appears as Model
Parameters.

Only a single input Y value is allowed. 

ExponentialXToY(x,
[modelParameters])

The function returns the unknown Y value of the
Exponential  regression fit given the X input value and
modelParameters.  

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: A, M, C, and r2. It is an
available Statistic Token.  It can be found under
Regression Parameter Statistics and appears as Model
Parameters.

Only a single input X value is allowed. 

ExponentialYToX(y,
[modelParameters])

The function returns the unknown X value of the
Exponential  regression fit given the Y input value and
modelParameters.  

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: A, M, C, and r2. It is an
available Statistic Token.  It can be found under
Regression Parameter Statistics and appears as Model
Parameters.

Only a single input Y value is allowed. 

ExtractBoltzmannResults([m
odelParameters], "Bottom" |
"Top" | "V50" | "Slope" |
"r2")

Extracts a particular variable from the custom token
modelParameters of the Boltzmann  regression fit. The fit
value of the defined variable will be reported.  "|" represents
"or" and only one variable can be used. Other variables must
be deleted.

modelParameters include: Bottom, Top, V50, Slope, and r2.
 It is an available Statistic Token.  It can be found under
Regression Parameter Statistics and appears as Model
Parameters.

For example: 

611
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ExtractBoltzmannResults([modelParameters], "Bottom") will
report the value of the Bottom variable.

ExtractCubicResults([model
Parameters], "m" | "b" |
"A2" | "A3" | "r2")

Extracts a particular variable from the custom token
modelParameters of the Cubic  regression fit. The fit
value of the defined variable will be reported.  "|" represents
"or" and only one variable can be used. Other variables must
be deleted. 

modelParameters include: m, b, A2, A3, and r2. It is an
available Statistic Token.  It can be found under
Regression Parameter Statistics and appears as Model
Parameters.

For example: 
ExtractCubicResults([modelParameters], "m") will report the
value of the m variable.

ExtractExpAssociationResult
s([modelParameters],
"Ymax1" | "K1" | "r2")

Extracts a particular variable from the custom token
modelParameters of the Exponential Association
regression fit. The fit value of the defined variable will be
reported.  "|" represents "or" and only one variable can be
used. Other variables must be deleted.

modelParameters include: Ymax1, K1, and r2. It is an
available Statistic Token.  It can be found under
Regression Parameter Statistics and appears as Model
Parameters.

For example: 
ExtractExpAssociationResults([modelParameters], "Ymax1")
will report the value of the Ymax1 variable.

ExtractExponentialGrowResu
lts([modelParameters], "A" |
"B" | "C" | "r2")

Extracts a particular variable from the custom token
modelParameters of the Exponential Grow  regression fit.
The fit value of the defined variable will be reported.  "|"
represents "or" and only one variable can be used. Other
variables must be deleted.. 

modelParameters include: Ymax1, K1, and r2. It is an
available Statistic Token.  It can be found under
Regression Parameter Statistics and appears as Model
Parameters.

For example: 
ExtractExpAssociationResults([modelParameters], "Ymax1")
will report the value of the Ymax1 variable.

ExtractExponentialResults([
modelParameters], "A" | "M"
| "C" | "r2")

Extracts a particular variable from the custom token
modelParameters of the Exponential  regression fit. The
fit value of the defined variable will be reported.  "|"
represents "or" and only one variable can be used. Other
variables must be deleted.
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modelParameters include: Ymax1, K1, and r2. It is an
available Statistic Token.  It can be found under
Regression Parameter Statistics and appears as Model
Parameters.

For example: 
ExtractExpAssociationResults([modelParameters], "Ymax1")
will report the value of the Ymax1 variable.

ExtractFiveParmLogisticRes
ults([modelParameters],
"Imin" | "Imax" | "IC50" |
"HillSlope" | "Asymmetry" |
"r2")

Extracts a particular variable from the custom token
modelParameters of the Five Parameter Logistic  (5PL)
regression fit. The fit value of the defined variable will be
reported.  "|" represents "or" and only one variable can be
used. Other variables must be deleted. 

modelParameters include: Imin, Imax, IC50, HillSlope,
Asymmetry, and r2. It is an available Statistic Token.  It can
be found under Regression Parameter Statistics and
appears as Model Parameters.

For example: 
ExtractFiveParmLogisticResults([modelParameters], "Imax")
will report the value of the Imax variable.

ExtractFiveParmLogLogistic
Results([modelParameters],
"Imin" | "Imax" | "Midpoint"
| "HillSlope" | "Asymmetry"
| "r2" | "IC50")

Extracts a particular variable from the custom token
modelParameters of the Five Parameter Log Logistic
 regression fit. The fit value of the defined variable will be
reported.  "|" represents "or" and only one variable can be
used. Other variables must be deleted. 

modelParameters include: Imin, Imax, IC50, Midpoint,
HillSlope, Asymmetry, r2 and IC50. It is an available Statistic
Token.  It can be found under Regression Parameter
Statistics and appears as Model Parameters.

For example: 
ExtractFiveParmLogisticResults([modelParameters],
"Midpoint") will report the value of the Midpoint variable.

ExtractFourParmLogisticRes
ults([modelParameters],
"Imin" | "Imax" | "IC50" |
"HillSlope" | "r2")

Extracts a particular variable from the custom token
modelParameters of the Four Parameter Logistic  (4PL)
regression fit. The fit value of the defined variable will be
reported.  "|" represents "or" and only one variable can be
used. Other variables must be deleted. 

modelParameters include: Imin, Imax, IC50, HillSlope,
Asymmetry, and r2. It is an available Statistic Token.  It can
be found under Regression Parameter Statistics and
appears as Model Parameters.

For example: 
ExtractFiveParmLogisticResults([modelParameters], "Imax")
will report the value of the Imax variable.
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ExtractFourParmLogLogistic
Results([modelParameters],
"Imin" | "Imax" | "Midpoint"
| "HillSlope" | "r2" | "IC50")

Extracts a particular variable from the custom token
modelParameters of the Four Parameter Log Logistic
 regression fit. The fit value of the defined variable will be
reported.  "|" represents "or" and only one variable can be
used. Other variables must be deleted. 

modelParameters include: Imin, Imax, IC50, Midpoint,
HillSlope, Asymmetry, r2 and IC50. It is an available Statistic
Token.  It can be found under Regression Parameter
Statistics and appears as Model Parameters.

For example: 
ExtractFiveParmLogisticResults([modelParameters],
"Midpoint") will report the value of the Midpoint variable.

ExtractGaussianResults([mo
delParameters], "A" | "SD" |
"xMed" | "K" | "r2")

Extracts a particular variable from the custom token
modelParameters of the Gaussian  regression fit. The fit
value of the defined variable will be reported.  "|" represents
"or" and only one variable can be used. Other variables must
be deleted.

modelParameters include: A, SD, xMed, K, and r2. It is an
available Statistic Token.  It can be found under
Regression Parameter Statistics and appears as Model
Parameters.

For example: 
ExtractGaussianResults([modelParameters], "A") will report
the value of the A variable.

ExtractLinearResults([model
Parameters], "m" | "b" |
"r2")

Extracts a particular variable from the custom token
modelParameters of the Linear  regression fit. The fit
value of the defined variable will be reported.  "|" represents
"or" and only one variable can be used. Other variables must
be deleted.

modelParameters include: m, b, and r2. It is an available
Statistic Token.  It can be found under Regression
Parameter Statistics and appears as Model Parameters.

For example: 
ExtractLinearResults([modelParameters], "m") will report the
value of the m variable.

ExtractMichMentenResults([
modelParameters], "Vm" |
"KM" | "r2")

Extracts a particular variable from the custom token
modelParameters of the Michaelis Menten  regression fit.
The fit value of the defined variable will be reported.  "|"
represents "or" and only one variable can be used. Other
variables must be deleted. 

modelParameters include: Vm, KM, and r2. It is an available
Statistic Token.  It can be found under Regression
Parameter Statistics and appears as Model Parameters.
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For example: 
ExtractMichMentenResults([modelParameters], "Vm") will
report the value of the Vm variable.

ExtractParabolicResults([mo
delParameters], "m" | "b" |
"A2" | "r2")

Extracts a particular variable from the custom token
modelParameters of the Parabolic  regression fit. The fit
value of the defined variable will be reported.  "|" represents
"or" and only one variable can be used. Other variables must
be deleted.

modelParameters include: m, b, and r2. It is an available
Statistic Token.  It can be found under Regression
Parameter Statistics and appears as Model Parameters.

For example: 
ExtractParabolicResults([modelParameters], "b") will report
the value of the b variable.

ExtractPowerResults([model
Parameters], "A1" | "B1" |
"K" | "r2")

Extracts a particular variable from the custom token
modelParameters of the Power  regression fit. The fit
value of the defined variable will be reported.  "|" represents
"or" and only one variable can be used. Other variables must
be deleted.

modelParameters include: A1, B1, K, and r2. It is an
available Statistic Token.  It can be found under
Regression Parameter Statistics and appears as Model
Parameters.

For example: 
ExtractPowerResults([modelParameters], "K") will report the
value of the K variable.

ExtractPowerSeriesResults([
modelParameters], "A1" |
"B1" | "K" | "A2" | "B2" |
"r2")

Extracts a particular variable from the custom token
modelParameters of the Power Series  regression fit. The
fit value of the defined variable will be reported.  "|"
represents "or" and only one variable can be used. Other
variables must be deleted. 

modelParameters include: A1, B1, K, A2, B2, and r2. It is
an available Statistic Token.  It can be found under
Regression Parameter Statistics and appears as Model
Parameters.

For example: 
ExtractPowerSeriesResults([modelParameters], "B2") will
report the value of the B2 variable.

ExtractSigmoidalDecResults(
[modelParameters], "A" |
"B" | "C" | "r2")

Extracts a particular variable from the custom token
modelParameters of the Decreasing Sigmoidal  regression
fit. The fit value of the defined variable will be reported.  "|"
represents "or" and only one variable can be used. Other
variables must be deleted. 
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modelParameters include: A, B, C, and r2. It is an available
Statistic Token.  It can be found under Regression
Parameter Statistics and appears as Model Parameters.

For example: 
ExtractSigmoidalDecResults([modelParameters], "C") will
report the value of the C variable.

ExtractSigmoidalResults([mo
delParameters], "A" | "B" |
"C" | "r2")

Extracts a particular variable from the custom token
modelParameters of the Sigmoidal  regression fit. The fit
value of the defined variable will be reported.  "|" represents
"or" and only one variable can be used. Other variables must
be deleted. 

modelParameters include: A, B, C, and r2. It is an available
Statistic Token.  It can be found under Regression
Parameter Statistics and appears as Model Parameters.

For example: 
ExtractSigmoidalResults([modelParameters], "B") will report
the value of the B variable.

ExtractSineWaveResults([m
odelParameters], "Baseline"
| "Amplitude" | "Frequency"
| "Offset" | "r2")

Extracts a particular variable from the custom token
modelParameters of the Sine Wave  regression fit. The
fit value of the defined variable will be reported.  "|"
represents "or" and only one variable can be used. Other
variables must be deleted. 

modelParameters include: Baseline, Amplitude, Frequency,
Offset and r2. It is an available Statistic Token.  It can be
found under Regression Parameter Statistics and appears
as Model Parameters.

For example: 
ExtractSineWaveResults([modelParameters], "Frequency") will
report the value of the Frequency variable.

ExtractTwoPhaseExpAssoci
ationResults([modelParamet
ers], "Ymax1" | "K1" |
"Ymax2" | "K2" | "r2")

Extracts a particular variable from the custom token
modelParameters of the Two Phase Exponential
Association  regression fit. The fit value of the defined
variable will be reported.  "|" represents "or" and only one
variable can be used. Other variables must be deleted. 

modelParameters include: Ymax1, K1, Ymax2, K2 and r2. It
is an available Statistic Token.  It can be found under
Regression Parameter Statistics and appears as Model
Parameters.

For example: 
ExtractTwoPhaseExpAssociationResults([modelParameters],
"Ymax2") will report the value of the Ymax2 variable.

ExtractTwoPhaseExponentia
lResults([modelParameters],

Extracts a particular variable from the custom token
modelParameters of the Two Phase Exponential
 regression fit. The fit value of the defined variable will be
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"A" | "M" | "C" | "A2" | "M2"
| "r2")

reported.  "|" represents "or" and only one variable can be
used. Other variables must be deleted.  

modelParameters include: A, M, C, A2, M2 and r2. It is an
available Statistic Token.  It can be found under
Regression Parameter Statistics and appears as Model
Parameters.

For example: 
ExtractTwoPhaseExponentialResults([modelParameters], "A")
will report the value of the A variable.

ExtractTwoSiteBindingResul
ts([modelParameters], "Vm"
| "KM" | "Vm2" | "KM2" |
"r2")

Extracts a particular variable from the custom token
modelParameters of the Two Phase Exponential
 regression fit. The fit value of the defined variable will be
reported.  "|" represents "or" and only one variable can be
used. Other variables must be deleted. 

modelParameters include: A, M, C, A2, M2 and r2. It is an
available Statistic Token.  It can be found under
Regression Parameter Statistics and appears as Model
Parameters.

For example: 
ExtractTwoPhaseExponentialResults([modelParameters], "A")
will report the value of the A variable.

FiveParmLogisticXToY(x,
[modelParameters])

The function returns the unknown Y value of the Five
Parameter Logistic  regression fit given the X input value
and modelParameters.  

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: Imin, Imax, IC50,
HillSlope, Asymmetry, and r2. It is an available Statistic
Token.  It can be found under Regression Parameter
Statistics and appears as Model Parameters.

Only a single input X value is allowed. 

FiveParmLogisticYToX(y,
[modelParameters]) 

The function returns the unknown X value of the Five
Parameter Logistic  regression fit given the Y input value
and modelParameters.  

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: Imin, Imax, IC50,
HillSlope, Asymmetry, and r2. It is an available Statistic
Token.  It can be found under Regression Parameter
Statistics and appears as Model Parameters.

Only a single input Y value is allowed. 

FiveParmLogLogisticXToY(x,
[modelParameters])

The function returns the unknown Y value of the Five
Parameter Log Logistic  regression fit given the X input
value and modelParameters.  
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modelParameters represent a comma delimited list of all of
the fit variables and their fit values: Imin, Imax, Midpoint,
HillSlope, Asymmetry, r2 and IC50. It is an available Statistic
Token.  It can be found under Regression Parameter
Statistics and appears as Model Parameters.

Only a single input X value is allowed.

FiveParmLogLogisticYToX(y,
[modelParameters]) 

The function returns the unknown X value of the Five
Parameter Log Logistic  regression fit given the Y input
value and modelParameters.  

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: Imin, Imax, Midpoint,
HillSlope, Asymmetry, r2 and IC50. It is an available Statistic
Token.  It can be found under Regression Parameter
Statistics and appears as Model Parameters.

Only a single input Y value is allowed.

FourParmLogisticXToY(x,
[modelParameters])

The function returns the unknown Y value of the Four
Parameter Logistic  regression fit given the X input value
and modelParameters.  

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: Imin, Imax, IC50,
HillSlope, and r2. It is an available Statistic Token.  It can be
found under Regression Parameter Statistics and appears
as Model Parameters.

Only a single input X value is allowed. 

FourParmLogisticYToX(y,
[modelParameters]) 

The function returns the unknown X value of the Four
Parameter Logistic  regression fit given the Y input value
and modelParameters.  

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: Imin, Imax, IC50,
HillSlope, and r2. It is an available Statistic Token.  It can be
found under Regression Parameter Statistics and appears
as Model Parameters.

Only a single input Y value is allowed. 

FourParmLogLogisticXToY(x,
[modelParameters])

The function returns the unknown Y value of the Four
Parameter Log Logistic  regression fit given the X input
value and modelParameters.  

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: Imin, Imax, Midpoing,
HillSlope, r2, and IC50. It is an available Statistic Token.  It
can be found under Regression Parameter Statistics and
appears as Model Parameters.
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Only a single input X value is allowed. 

FourParmLogLogisticYToX(y
, [modelParameters]) 

The function returns the unknown X value of the Four
Parameter Log Logistic  regression fit given the Y input
value and modelParameters.  

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: Imin, Imax, Midpoing,
HillSlope, r2, and IC50. It is an available Statistic Token.  It
can be found under Regression Parameter Statistics and
appears as Model Parameters.

Only a single input Y value is allowed. 

GaussianXToY(x,
[modelParameters])

The function returns the unknown Y value of the Gaussian
regression fit given the X input value and
modelParameters.  

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: A, SD, xMed, K, and r2.
It is an available Statistic Token.  It can be found under
Regression Parameter Statistics and appears as Model
Parameters.

Only a single input X value is allowed. 

GaussianYToX(y,
[modelParameters])

The function returns the unknown X value of the Gaussian
regression fit given the Y input value and
modelParameters.  

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: A, SD, xMed, K, and r2.
It is an available Statistic Token.  It can be found under
Regression Parameter Statistics and appears as Model
Parameters.

Only a single input Y value is allowed. 

LinearXToY(x,
[modelParameters])

The function returns the unknown Y value of the Linear
regression fit given the X input value and
modelParameters.  

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: m, b, and r2. It is an
available Statistic Token.  It can be found under
Regression Parameter Statistics and appears as Model
Parameters.

Only a single input X value is allowed. 

LinearYToX(y,
[modelParameters]) 

The function returns the unknown X value of the Linear
regression fit given the Y input value and
modelParameters.  
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modelParameters represent a comma delimited list of all of
the fit variables and their fit values: m, b, and r2. It is an
available Statistic Token.  It can be found under
Regression Parameter Statistics and appears as Model
Parameters.

Only a single input Y value is allowed. 

MichMentenXToY(x,
[modelParameters])

The function returns the unknown Y value of the Michaelis
Menten  regression fit given the X input value and
modelParameters.  

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: Vm, KM, and r2. It is an
available Statistic Token.  It can be found under
Regression Parameter Statistics and appears as Model
Parameters.

Only a single input X value is allowed. 

MichMentenYToX(y,
[modelParameters]) 

The function returns the unknown X value of the Michaelis
Menten  regression fit given the Y input value and
modelParameters.  

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: Vm, KM, and r2. It is an
available Statistic Token.  It can be found under
Regression Parameter Statistics and appears as Model
Parameters.

Only a single input Y value is allowed. 

ParabolicXToY(x,
[modelParameters])

The function returns the unknown Y value of the Parabolic
regression fit given the X input value and
modelParameters.  

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: m, b, A2, and r2. It is an
available Statistic Token.  It can be found under
Regression Parameter Statistics and appears as Model
Parameters.

Only a single input X value is allowed. 

ParabolicYToX(y,
[modelParameters]) 

The function returns the unknown X value of the Parabolic
regression fit given the Y input value and
modelParameters.  

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: m, b, A2, and r2. It is an
available Statistic Token.  It can be found under
Regression Parameter Statistics and appears as Model
Parameters.
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Only a single input Y value is allowed. 

PerformBoltzmannFit([xValu
es], [yValues], [SDvalues],
[fixedParameters])

This function Performs a fit of the specified X-Y values to the
Boltzmann  regression fit equation.

Where X Values is a comma delimited list of X values,
generally specified by a series of tokens .
Where Y Values is a comma delimited list of Y values,
generally specified by a series of tokens .

SD, or Standard Deviation, allows you to specify a standard
deviation for each list of the Y values, generally specified by
a series of tokens . The SD value assigns a "weight" to
each associated X and Y value with a lower SD value
resulting in a higher weight and a higher SD value resulting in
a lower weight. If the SD is not specified, an SD of zero is
assumed for each Y value.

Fixed Parameters allows you to specify variables that
should not be fit, but will be forced to use the value that you
specify. The format of the Fixed parameters is a comma
delimited list of var=value where var is one of the available
variables (Bottom, Top, V50, Slope) and value is the value to
fix it to.

All fit variables and their value will be reported.

PerformCubicFit([xValues],
[yValues], [SDvalues],
[fixedParameters])

This function Performs a fit of the specified X-Y values to the
Cubic  regression fit equation.

Where X Values is a comma delimited list of X values,
generally specified by a series of tokens .
Where Y Values is a comma delimited list of Y values,
generally specified by a series of tokens .

SD, or Standard Deviation, allows you to specify a standard
deviation for each list of the Y values, generally specified by
a series of tokens . The SD value assigns a "weight" to
each associated X and Y value with a lower SD value
resulting in a higher weight and a higher SD value resulting in
a lower weight. If the SD is not specified, an SD of zero is
assumed for each Y value.

Fixed Parameters allows you to specify variables that
should not be fit, but will be forced to use the value that you
specify. The format of the Fixed parameters is a comma
delimited list of var=value where var is one of the available
variables (m, b, A2, A3) and value is the value to fix it to.

All fit variables and their value will be reported.

PerformExpAssociationFit([x
Values], [yValues],

This function Performs a fit of the specified X-Y values to the
Exponential Association  regression fit equation.
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[SDvalues],
[fixedParameters]) Where X Values is a comma delimited list of X values,

generally specified by a series of tokens .
Where Y Values is a comma delimited list of Y values,
generally specified by a series of tokens .

SD, or Standard Deviation, allows you to specify a standard
deviation for each list of the Y values, generally specified by
a series of tokens . The SD value assigns a "weight" to
each associated X and Y value with a lower SD value
resulting in a higher weight and a higher SD value resulting in
a lower weight. If the SD is not specified, an SD of zero is
assumed for each Y value.

Fixed Parameters allows you to specify variables that
should not be fit, but will be forced to use the value that you
specify. The format of the Fixed parameters is a comma
delimited list of var=value where var is one of the available
variables (Ymax1, K1) and value is the value to fix it to.

All fit variables and their value will be reported.

PerformExponentialFit([xVal
ues], [yValues],
[SDvalues],
[fixedParameters])

This function Performs a fit of the specified X-Y values to the
Exponential  regression fit equation.

Where X Values is a comma delimited list of X values,
generally specified by a series of tokens .
Where Y Values is a comma delimited list of Y values,
generally specified by a series of tokens .

SD, or Standard Deviation, allows you to specify a standard
deviation for each list of the Y values, generally specified by
a series of tokens . The SD value assigns a "weight" to
each associated X and Y value with a lower SD value
resulting in a higher weight and a higher SD value resulting in
a lower weight. If the SD is not specified, an SD of zero is
assumed for each Y value.

Fixed Parameters allows you to specify variables that
should not be fit, but will be forced to use the value that you
specify. The format of the Fixed parameters is a comma
delimited list of var=value where var is one of the available
variables (A, M, C) and value is the value to fix it to.

All fit variables and their value will be reported.

PerformExponentialGrowFit([
xValues], [yValues],
[SDvalues],
[fixedParameters])

This function Performs a fit of the specified X-Y values to the
Exponential Grow  regression fit equation.

Where X Values is a comma delimited list of X values,
generally specified by a series of tokens .
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Where Y Values is a comma delimited list of Y values,
generally specified by a series of tokens .

SD, or Standard Deviation, allows you to specify a standard
deviation for each list of the Y values, generally specified by
a series of tokens . The SD value assigns a "weight" to
each associated X and Y value with a lower SD value
resulting in a higher weight and a higher SD value resulting in
a lower weight. If the SD is not specified, an SD of zero is
assumed for each Y value.

Fixed Parameters allows you to specify variables that
should not be fit, but will be forced to use the value that you
specify. The format of the Fixed parameters is a comma
delimited list of var=value where var is one of the available
variables (A, M, C) and value is the value to fix it to.

All fit variables and their value will be reported.

PerformFiveParmLogisticFit(
[xValues], [yValues],
[SDvalues],
[fixedParameters])

This function Performs a fit of the specified X-Y values to the
Five Parameter Logistic  regression fit equation.

Where X Values is a comma delimited list of X values,
generally specified by a series of tokens .
Where Y Values is a comma delimited list of Y values,
generally specified by a series of tokens .

SD, or Standard Deviation, allows you to specify a standard
deviation for each list of the Y values, generally specified by
a series of tokens . The SD value assigns a "weight" to
each associated X and Y value with a lower SD value
resulting in a higher weight and a higher SD value resulting in
a lower weight. If the SD is not specified, an SD of zero is
assumed for each Y value.

Fixed Parameters allows you to specify variables that
should not be fit, but will be forced to use the value that you
specify. The format of the Fixed parameters is a comma
delimited list of var=value where var is one of the available
variables (Imin, Imax, IC50, HillSlope, Asymmetry) and value
is the value to fix it to.

All fit variables and their value will be reported.

PerformFiveParmLogLogistic
Fit([xValues], [yValues],
[SDvalues],
[fixedParameters])

This function Performs a fit of the specified X-Y values to the
Five Parameter Log Logistic  regression fit equation.

Where X Values is a comma delimited list of X values,
generally specified by a series of tokens .
Where Y Values is a comma delimited list of Y values,
generally specified by a series of tokens .

1284

1284

610

1284

1284

1284

610

1284

1284



Tokens 1399

© 2023 De Novo Software

Function Description

SD, or Standard Deviation, allows you to specify a standard
deviation for each list of the Y values, generally specified by
a series of tokens . The SD value assigns a "weight" to
each associated X and Y value with a lower SD value
resulting in a higher weight and a higher SD value resulting in
a lower weight. If the SD is not specified, an SD of zero is
assumed for each Y value.

Fixed Parameters allows you to specify variables that
should not be fit, but will be forced to use the value that you
specify. The format of the Fixed parameters is a comma
delimited list of var=value where var is one of the available
variables (Imin, Imax, Midpoint, HillSlope, Asymmetry, IC50)
and value is the value to fix it to.

All fit variables and their value will be reported.

PerformFourParmLogisticFit(
[xValues], [yValues],
[SDvalues],
[fixedParameters])

This function Performs a fit of the specified X-Y values to the
Four Parameter Logistic  regression fit equation.

Where X Values is a comma delimited list of X values,
generally specified by a series of tokens .
Where Y Values is a comma delimited list of Y values,
generally specified by a series of tokens .

SD, or Standard Deviation, allows you to specify a standard
deviation for each list of the Y values, generally specified by
a series of tokens . The SD value assigns a "weight" to
each associated X and Y value with a lower SD value
resulting in a higher weight and a higher SD value resulting in
a lower weight. If the SD is not specified, an SD of zero is
assumed for each Y value.

Fixed Parameters allows you to specify variables that
should not be fit, but will be forced to use the value that you
specify. The format of the Fixed parameters is a comma
delimited list of var=value where var is one of the available
variables (Imin, Imax, IC50, HillSlope) and value is the value
to fix it to.

All fit variables and their value will be reported.

PerformFourParmLogLogistic
Fit([xValues], [yValues],
[SDvalues],
[fixedParameters])

This function Performs a fit of the specified X-Y values to the
Four Parameter Log Logistic  regression fit equation.

Where X Values is a comma delimited list of X values,
generally specified by a series of tokens .
Where Y Values is a comma delimited list of Y values,
generally specified by a series of tokens .

SD, or Standard Deviation, allows you to specify a standard
deviation for each list of the Y values, generally specified by
a series of tokens . The SD value assigns a "weight" to
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Function Description

each associated X and Y value with a lower SD value
resulting in a higher weight and a higher SD value resulting in
a lower weight. If the SD is not specified, an SD of zero is
assumed for each Y value.

Fixed Parameters allows you to specify variables that
should not be fit, but will be forced to use the value that you
specify. The format of the Fixed parameters is a comma
delimited list of var=value where var is one of the available
variables (Imin, Imax, Midpoint, HillSlope, IC50) and value is
the value to fix it to.

All fit variables and their value will be reported.

PerformGaussianFit([xValues
], [yValues], [SDvalues],
[fixedParameters])

This function Performs a fit of the specified X-Y values to the
Gaussian  regression fit equation.

Where X Values is a comma delimited list of X values,
generally specified by a series of tokens .
Where Y Values is a comma delimited list of Y values,
generally specified by a series of tokens .

SD, or Standard Deviation, allows you to specify a standard
deviation for each list of the Y values, generally specified by
a series of tokens . The SD value assigns a "weight" to
each associated X and Y value with a lower SD value
resulting in a higher weight and a higher SD value resulting in
a lower weight. If the SD is not specified, an SD of zero is
assumed for each Y value.

Fixed Parameters allows you to specify variables that
should not be fit, but will be forced to use the value that you
specify. The format of the Fixed parameters is a comma
delimited list of var=value where var is one of the available
variables (A, SD, xMed, K) and value is the value to fix it to.

All fit variables and their value will be reported.

PerformLinearFit([xValues],
[yValues], [SDvalues],
[fixedParameters])

This function Performs a fit of the specified X-Y values to the
Linear  regression fit equation.

Where X Values is a comma delimited list of X values,
generally specified by a series of tokens .
Where Y Values is a comma delimited list of Y values,
generally specified by a series of tokens .

SD, or Standard Deviation, allows you to specify a standard
deviation for each list of the Y values, generally specified by
a series of tokens . The SD value assigns a "weight" to
each associated X and Y value with a lower SD value
resulting in a higher weight and a higher SD value resulting in
a lower weight. If the SD is not specified, an SD of zero is
assumed for each Y value.
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Fixed Parameters allows you to specify variables that
should not be fit, but will be forced to use the value that you
specify. The format of the Fixed parameters is a comma
delimited list of var=value where var is one of the available
variables (m, b) and value is the value to fix it to.

All fit variables and their value will be reported.

PerformMichMentenFit([xVal
ues], [yValues],
[SDvalues],
[fixedParameters])

This function Performs a fit of the specified X-Y values to the
Michaelis Menten  regression fit equation.

Where X Values is a comma delimited list of X values,
generally specified by a series of tokens .
Where Y Values is a comma delimited list of Y values,
generally specified by a series of tokens .

SD, or Standard Deviation, allows you to specify a standard
deviation for each list of the Y values, generally specified by
a series of tokens . The SD value assigns a "weight" to
each associated X and Y value with a lower SD value
resulting in a higher weight and a higher SD value resulting in
a lower weight. If the SD is not specified, an SD of zero is
assumed for each Y value.

Fixed Parameters allows you to specify variables that
should not be fit, but will be forced to use the value that you
specify. The format of the Fixed parameters is a comma
delimited list of var=value where var is one of the available
variables (Vm, KM) and value is the value to fix it to.

All fit variables and their value will be reported.

PerformParabolicFit([xValue
s], [yValues], [SDvalues],
[fixedParameters])

This function Performs a fit of the specified X-Y values to the
Parabolic  regression fit equation.

Where X Values is a comma delimited list of X values,
generally specified by a series of tokens .
Where Y Values is a comma delimited list of Y values,
generally specified by a series of tokens .

SD, or Standard Deviation, allows you to specify a standard
deviation for each list of the Y values, generally specified by
a series of tokens . The SD value assigns a "weight" to
each associated X and Y value with a lower SD value
resulting in a higher weight and a higher SD value resulting in
a lower weight. If the SD is not specified, an SD of zero is
assumed for each Y value.

Fixed Parameters allows you to specify variables that
should not be fit, but will be forced to use the value that you
specify. The format of the Fixed parameters is a comma
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delimited list of var=value where var is one of the available
variables (m, b, A2) and value is the value to fix it to.

All fit variables and their value will be reported.

PerformPowerFit([xValues],
[yValues], [SDvalues],
[fixedParameters])

This function Performs a fit of the specified X-Y values to the
Power  regression fit equation.

Where X Values is a comma delimited list of X values,
generally specified by a series of tokens .
Where Y Values is a comma delimited list of Y values,
generally specified by a series of tokens .

SD, or Standard Deviation, allows you to specify a standard
deviation for each list of the Y values, generally specified by
a series of tokens . The SD value assigns a "weight" to
each associated X and Y value with a lower SD value
resulting in a higher weight and a higher SD value resulting in
a lower weight. If the SD is not specified, an SD of zero is
assumed for each Y value.

Fixed Parameters allows you to specify variables that
should not be fit, but will be forced to use the value that you
specify. The format of the Fixed parameters is a comma
delimited list of var=value where var is one of the available
variables (A1, B1, K) and value is the value to fix it to.

All fit variables and their value will be reported.

PerformPowerSeriesFit([xVal
ues], [yValues],
[SDvalues],
[fixedParameters])

This function Performs a fit of the specified X-Y values to the
Power Series  regression fit equation.

Where X Values is a comma delimited list of X values,
generally specified by a series of tokens .
Where Y Values is a comma delimited list of Y values,
generally specified by a series of tokens .

SD, or Standard Deviation, allows you to specify a standard
deviation for each list of the Y values, generally specified by
a series of tokens . The SD value assigns a "weight" to
each associated X and Y value with a lower SD value
resulting in a higher weight and a higher SD value resulting in
a lower weight. If the SD is not specified, an SD of zero is
assumed for each Y value.

Fixed Parameters allows you to specify variables that
should not be fit, but will be forced to use the value that you
specify. The format of the Fixed parameters is a comma
delimited list of var=value where var is one of the available
variables (A1, B1, K, A2, B2) and value is the value to fix it
to.
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All fit variables and their value will be reported.

PerformSigmoidalDecFit([xV
alues], [yValues],
[SDvalues],
[fixedParameters])

This function Performs a fit of the specified X-Y values to the
Decreasing Sigmoidal  regression fit equation.

Where X Values is a comma delimited list of X values,
generally specified by a series of tokens .
Where Y Values is a comma delimited list of Y values,
generally specified by a series of tokens .

SD, or Standard Deviation, allows you to specify a standard
deviation for each list of the Y values, generally specified by
a series of tokens . The SD value assigns a "weight" to
each associated X and Y value with a lower SD value
resulting in a higher weight and a higher SD value resulting in
a lower weight. If the SD is not specified, an SD of zero is
assumed for each Y value.

Fixed Parameters allows you to specify variables that
should not be fit, but will be forced to use the value that you
specify. The format of the Fixed parameters is a comma
delimited list of var=value where var is one of the available
variables (A, B, C) and value is the value to fix it to.

All fit variables and their value will be reported.

PerformSigmoidalFit([xValue
s], [yValues], [SDvalues],
[fixedParameters])

This function Performs a fit of the specified X-Y values to the
Sigmoidal  regression fit equation.

Where X Values is a comma delimited list of X values,
generally specified by a series of tokens .
Where Y Values is a comma delimited list of Y values,
generally specified by a series of tokens .

SD, or Standard Deviation, allows you to specify a standard
deviation for each list of the Y values, generally specified by
a series of tokens . The SD value assigns a "weight" to
each associated X and Y value with a lower SD value
resulting in a higher weight and a higher SD value resulting in
a lower weight. If the SD is not specified, an SD of zero is
assumed for each Y value.

Fixed Parameters allows you to specify variables that
should not be fit, but will be forced to use the value that you
specify. The format of the Fixed parameters is a comma
delimited list of var=value where var is one of the available
variables (A, B, C) and value is the value to fix it to.

All fit variables and their value will be reported.

PerformSineWaveFit([xValue
s], [yValues], [SDvalues],
[fixedParameters])

This function Performs a fit of the specified X-Y values to the
Sine Wave  regression fit equation.
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Where X Values is a comma delimited list of X values,
generally specified by a series of tokens .
Where Y Values is a comma delimited list of Y values,
generally specified by a series of tokens .

SD, or Standard Deviation, allows you to specify a standard
deviation for each list of the Y values, generally specified by
a series of tokens . The SD value assigns a "weight" to
each associated X and Y value with a lower SD value
resulting in a higher weight and a higher SD value resulting in
a lower weight. If the SD is not specified, an SD of zero is
assumed for each Y value.

Fixed Parameters allows you to specify variables that
should not be fit, but will be forced to use the value that you
specify. The format of the Fixed parameters is a comma
delimited list of var=value where var is one of the available
variables (Baseline, Amplitude, Frequency, Offset) and value
is the value to fix it to.

All fit variables and their value will be reported.

PerformTwoPhaseExpAssoci
ationFit([xValues],
[yValues], [SDvalues],
[fixedParameters])

This function Performs a fit of the specified X-Y values to the
Two Phase Exponential Association  regression fit equation.

Where X Values is a comma delimited list of X values,
generally specified by a series of tokens .
Where Y Values is a comma delimited list of Y values,
generally specified by a series of tokens .

SD, or Standard Deviation, allows you to specify a standard
deviation for each list of the Y values, generally specified by
a series of tokens . The SD value assigns a "weight" to
each associated X and Y value with a lower SD value
resulting in a higher weight and a higher SD value resulting in
a lower weight. If the SD is not specified, an SD of zero is
assumed for each Y value.

Fixed Parameters allows you to specify variables that
should not be fit, but will be forced to use the value that you
specify. The format of the Fixed parameters is a comma
delimited list of var=value where var is one of the available
variables (Ymax1, K1, Ymax2, K2) and value is the value to fix
it to.

All fit variables and their value will be reported.

PerformTwoPhaseExponenti
alFit([xValues], [yValues],
[SDvalues],
[fixedParameters])

This function Performs a fit of the specified X-Y values to the
Two Phase Exponential  regression fit equation.

Where X Values is a comma delimited list of X values,
generally specified by a series of tokens .

1284

1284

1284

611

1284

1284

1284

611

1284



Tokens 1405

© 2023 De Novo Software

Function Description

Where Y Values is a comma delimited list of Y values,
generally specified by a series of tokens .

SD, or Standard Deviation, allows you to specify a standard
deviation for each list of the Y values, generally specified by
a series of tokens . The SD value assigns a "weight" to
each associated X and Y value with a lower SD value
resulting in a higher weight and a higher SD value resulting in
a lower weight. If the SD is not specified, an SD of zero is
assumed for each Y value.

Fixed Parameters allows you to specify variables that
should not be fit, but will be forced to use the value that you
specify. The format of the Fixed parameters is a comma
delimited list of var=value where var is one of the available
variables (A, M, C, A2, M2) and value is the value to fix it to.

All fit variables and their value will be reported.

PerformTwoSiteBindingFit([x
Values], [yValues],
[SDvalues],
[fixedParameters])

This function Performs a fit of the specified X-Y values to the
Two Site Binding  regression fit equation.

Where X Values is a comma delimited list of X values,
generally specified by a series of tokens .
Where Y Values is a comma delimited list of Y values,
generally specified by a series of tokens .

SD, or Standard Deviation, allows you to specify a standard
deviation for each list of the Y values, generally specified by
a series of tokens . The SD value assigns a "weight" to
each associated X and Y value with a lower SD value
resulting in a higher weight and a higher SD value resulting in
a lower weight. If the SD is not specified, an SD of zero is
assumed for each Y value.

Fixed Parameters allows you to specify variables that
should not be fit, but will be forced to use the value that you
specify. The format of the Fixed parameters is a comma
delimited list of var=value where var is one of the available
variables (Vm, KM, Vm2, KM2) and value is the value to fix it
to.

All fit variables and their value will be reported.

PowerSeriesXToY(x,
[modelParameters])

The function returns the unknown Y value of the Power
Series  regression fit given the X input value and
modelParameters.  

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: A1, B1, K, A2, B2, and
r2. It is an available Statistic Token.  It can be found under
Regression Parameter Statistics and appears as Model
Parameters.
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Only a single input X value is allowed. 

PowerSeriesYToX(y,
[modelParameters]) 

The function returns the unknown X value of the Power
Series  regression fit given the Y input value and
modelParameters.  

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: A1, B1, K, A2, B2, and
r2. It is an available Statistic Token.  It can be found under
Regression Parameter Statistics and appears as Model
Parameters.

Only a single input Y value is allowed. 

PowerXToY(x,
[modelParameters])

The function returns the unknown Y value of the Power
regression fit given the X input value and
modelParameters.  

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: A1, B1, K, and r2. It is
an available Statistic Token.  It can be found under
Regression Parameter Statistics and appears as Model
Parameters.

Only a single input X value is allowed.

PowerYToX(y,
[modelParameters]) 

The function returns the unknown X value of the Power
regression fit given the Y input value and
modelParameters.  

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: A1, B1, K, and r2. It is
an available Statistic Token.  It can be found under
Regression Parameter Statistics and appears as Model
Parameters.

Only a single input Y value is allowed.

RegressionPlotXToY(Plot
Number, Overlay Number, X
Value)

This functions returns the Y value for a given Scatter with
Regression plot  fit given the X input value.

The three mandatory parameters are the Plot Number of a
regression plot (numeric), the Overlay Number of a regression
fit (numeric) and the X known value (numeric). Only a single
input X value is allowed. 

RegressionPlotYToX(Plot
Number, Overlay Number, Y
Value)

This functions returns the X value for a given Scatter with
Regression plot  fit given the Y input value.

The three mandatory parameters are the Plot Number of a
regression plot (numeric), the Overlay Number of a regression
fit (numeric) and the Y known value (numeric). Only a single
input Y value is allowed. 
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SigmoidalDecXToY(x,
[modelParameters])

The function returns the unknown Y value of the Decreasing
Sigmoidal  regression fit given the X input value and
modelParameters.  

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: A, B, C, and r2. It is an
available Statistic Token.  It can be found under
Regression Parameter Statistics and appears as Model
Parameters.

Only a single input X value is allowed.

SigmoidalDecYToX(y,
[modelParameters]) 

The function returns the unknown X value of the Decreasing
Sigmoidal  regression fit given the Y input value and
modelParameters.  

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: A, B, C, and r2. It is an
available Statistic Token.  It can be found under
Regression Parameter Statistics and appears as Model
Parameters.

Only a single input Y value is allowed.

SigmoidalXToY(x,
[modelParameters])

The function returns the unknown Y value of the Sigmoidal
regression fit given the X input value and
modelParameters.  

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: A, B, C, and r2. It is an
available Statistic Token.  It can be found under
Regression Parameter Statistics and appears as Model
Parameters.

Only a single input X value is allowed.

SigmoidalYToX(y,
[modelParameters]) 

The function returns the unknown X value of the Sigmoidal
regression fit given the Y input value and
modelParameters.  

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: A, B, C, and r2. It is an
available Statistic Token.  It can be found under
Regression Parameter Statistics and appears as Model
Parameters.

Only a single input Y value is allowed.

SineWaveXToY(x,
[modelParameters])

The function returns the unknown Y value of the Sine
Wave  regression fit given the X input value and
modelParameters.  

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: Baseline, Amplitude,
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Frequency, Offset, and r2. It is an available Statistic Token.
 It can be found under Regression Parameter Statistics
and appears as Model Parameters.

Only a single input X value is allowed.

SineWaveYToX(y,
[modelParameters]) 

The function returns the unknown X value of the Sine
Wave  regression fit given the Y input value and
modelParameters.  

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: Baseline, Amplitude,
Frequency, Offset, and r2. It is an available Statistic Token.
 It can be found under Regression Parameter Statistics
and appears as Model Parameters.

Only a single input Y value is allowed.

TwoPhaseExpAssociationXT
oY(x, [modelParameters])

The function returns the unknown Y value of the Two Phase
Exponential Association  regression fit given the X input
value and modelParameters.  

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: Ymax1, K1, Ymax2, K2,
and r2. It is an available Statistic Token.  It can be found
under Regression Parameter Statistics and appears as
Model Parameters.

Only a single input X value is allowed.

TwoPhaseExpAssociationYT
oX(y, [modelParameters]) 

The function returns the unknown X value of the Two Phase
Exponential Association  regression fit given the Y input
value and modelParameters.  

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: Ymax1, K1, Ymax2, K2,
and r2. It is an available Statistic Token.  It can be found
under Regression Parameter Statistics and appears as
Model Parameters.

Only a single input Y value is allowed.

TwoPhaseExponentialXToY(
x, [modelParameters])

The function returns the unknown Y value of the Two Phase
Exponential  regression fit given the X input value and
modelParameters.  

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: A, M, C, A2, M2, and r2.
It is an available Statistic Token.  It can be found under
Regression Parameter Statistics and appears as Model
Parameters.

Only a single input X value is allowed.
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TwoPhaseExponentialYToX(
y, [modelParameters]) 

The function returns the unknown X value of the Two Phase
Exponential  regression fit given the Y input value and
modelParameters.  

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: A, M, C, A2, M2, and r2.
It is an available Statistic Token.  It can be found under
Regression Parameter Statistics and appears as Model
Parameters.

Only a single input Y value is allowed.

TwoSiteBindingXToY(x,
[modelParameters])

The function returns the unknown Y value of the Two Site
Binding  regression fit given the X input value and
modelParameters.  

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: Vm, KM, Vm2, KM2, and
r2. It is an available Statistic Token.  It can be found under
Regression Parameter Statistics and appears as Model
Parameters.

Only a single input X value is allowed.

TwoSiteBindingYToX(y,
[modelParameters]) 

The function returns the unknown X value of the Two Site
Binding  regression fit given the Y input value and
modelParameters.  

modelParameters represent a comma delimited list of all of
the fit variables and their fit values: Vm, KM, Vm2, KM2, and
r2. It is an available Statistic Token.  It can be found under
Regression Parameter Statistics and appears as Model
Parameters.

Only a single input Y value is allowed.

SOP (Standard Operating Procedure) Functions. These functions can be
used to derive information from SOP's .

Function Description

HasSOPBeenRun Returns true or false in the form of -1 (True) or 0 (False) to
determine if any SOP has been previously run in the layout. 

IsSOPAfterStep(Ste
pID)

Returns true or false in the form of -1 (True) or 0 (False) to
determine the current SOP step is after a specific SOP Internal Step
ID. 

IsSOPBeforeStep(St
epID)

Returns true or false in the form of -1 (True) or 0 (False) to
determine the current SOP step is before a specific SOP Internal
Step ID. 

IsSOPFinished Returns true or false in the form of -1 (True) or 0 (False) to
determine if the SOP has finished running in the layout. 
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IsSOPOnStep(StepI
D)

Returns true or false in the form of -1 (True) or 0 (False) to
determine if the running SOP is currently on a specific SOP Internal
Step ID.

IsSOPRunning Returns true or false in the form of -1 (True) or 0 (False) to
determine if an SOP is currently running. 

Color Functions. 
Function Description

ConvertPlotSpilloverVal
ueToColor(Plot
Number, Overlay
Number)

Returns a color code derived from the spillover matrix.  Token is
used internally by FCS Express to color code plot backgrounds
when drawing NXN Compensated plots.

InterpolateColors("star
tColor","endColor",fract
ion)

Returns a color in Hex color code based on fraction between two
other colors. Start Color and End Color may be any written color
names, ie Red, Green, Gray, or any Hex Color Code, ie #FF0000,
#008000, #808080. The color may also be chosen from a color
palette by right clicking in the formula reference area and
choosing Insert Color.  Fraction may be any value between 0
and 1 with 0 being the start color and 1 being the end color. By
including a token such as % gated as the numerator in a formula
of (%gated/100) one can achieve a specific color associated with
a percent gated based on a gradient between the start and end
color.  The Interpolate Color result can then be used to color any
object or fill that allows a token for the color, for instance,
Background/Fill  of objects.

Compensation Matrix Functions. These functions can be used to derive
information about the compensation matrix.

Function Description

HasCompMatrixBeenChang
ed(PlotID, CompID)

Evaluates if the compensation matrix has been changed. 
Reports TRUE for a modified matrix or FALSE for an unmodified
matrix.

Data List Functions

Function Description

IsDataListIterationAndTube
NameEmpty(Iteration,
"Tube Name")

This function returns TRUE if the specified Tube in the specified
Iteration is a Blank tube, or, FALSE otherwise. Tube is defined by
specifying the Tube name (written in quotes; non case sensitive).

IsDataListIterationAndTube
NumberEmpty(Iteration,
Tube Number)

This function returns TRUE if the specified Tube in the specified
Iteration is a Blank tube, or, FALSE otherwise. Tube is defined by
specifying the Tube number.

IsDataListPositionEmpty(
Position)

This function returns TRUE if the specified file in the Data List is a
Blank tube, or, FALSE otherwise.
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System Functions. These functions can be used to derive information about the
current user's Security Group.

Function Description

IsCurrentUserMemberOf("
GroupName")

Returns true or false in the form of -1 (True) or 0 (False) to
determine if the user belongs to the defined Security Group
listed in place of "GroupName" in the parentheses.

Channel Calibration Functions. These functions can be used to derive
information about channel calibrations applied within a layout or to a specified
plot.  

Function Description

ChannelCalibrationDetailsLayout(CalibNu
m,"Details",Precision)

CalibNum is the Index number of a given
calibration as seen in the Calibration Information
dialog window.

Details are the specific pieces of information the
user can extract from a channel calibration.  The
user will enter a letter (or letters) from the list
below to define output information. Letters should
be entered between quotes in the formula with no
spacing between for multiple details, for instance
"A" will return Antibodies, "AES" will return
Antibodies|Equation|Status. 

A: Antibodies - Determines the
absolute value of fluorescent
ligands labeling each cell.

C: Correlation - Displays how
closely the equation fits the
actual data, with a value of 1
being a perfect fit.

D: Decades - Represents the
number of decades of dynamic
range your instrument is capable
of measuring.

E: Equation - is the linear regression
formula that was used to
calibrate the channels.

M: MinAb - Is the minimum number
of fluorochromes you are able
to resolve.

P: Parameter - Displays the
parameter the channel
calibration applies to.

R: Ratio - Refers to the dye
molecules:antibody ratio
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S: Status - Indicates whether this
calibration is active or inactive
for the selected calibration.

Y: DyeMolecules - The correlation
of the channel number to the
number of dye molecules per
bead established from the
standard curve.

Precision can be adjusted by the user to
determine the decimal precision of the channel
calibration output. Values should be positive
whole numbers, eg, 1, 2, 3. 

ChannelCalibrationDetailsPlot(PlotNum,"A
xis","Details",Precision)

PlotNum designates the plot by number that has
the channel calibration applied. Plot number can
be discerned by hovering the mouse over the plot
to return the plot number. 

Axis can be entered as "x" or "y" to indicate
which axis of the plot to extract information from
a parameter that currently has a calibration
applied.

Details are the specific pieces of information the
user can extract from a channel calibration.  The
user will enter a letter (or letters) from the list
below to define output information. Letters should
be entered between quotes in the formula with no
spacing between for multiple details, for instance
"A" will return Antibodies, "AES" will return
Antibodies|Equation|Status. 

A: Antibodies - Determines the
absolute value of fluorescent
ligands labeling each cell.

C: Correlation - Displays how
closely the equation fits the
actual data, with a value of 1
being a perfect fit.

D: Decades - Represents the
number of decades of dynamic
range your instrument is capable
of measuring.

E: Equation - is the linear regression
formula that was used to
calibrate the channels.

M: MinAb - Is the minimum number
of fluorochromes you are able
to resolve.



Tokens 1413

© 2023 De Novo Software

P: Parameter - Displays the
parameter the channel
calibration applies to.

R: Ratio - Refers to the dye
molecules:antibody ratio
S: Status - Indicates whether this

calibration is active or inactive
for the selected calibration.

Y: DyeMolecules - The correlation
of the channel number to the
number of dye molecules per
bead established from the
standard curve.

Precision can be adjusted by the user to
determine the decimal precision of the channel
calibration output. Values should be positive
whole numbers, eg, 1, 2, 3. 
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13 Publishing Layout Tools

FCS Express has the unique capability to share your data and analysis with other
scientists and researchers. You can share your layouts by publishing them. Once
a layout is published, it can be shared with colleagues and can be read by anyone
in the world using the FCS Express Reader , which is available free at
http://www.denovosoftware.com/full-access/features/reader/.

A published layout is a specialized FCS Express layout with embedded data and
certain restrictions about what can be changed. FCS Express Reader will allow
users to perform a complete analysis using your data (including moving gates
and creating new plots) subject to certain limitations .

13.1 Publishing a Layout

To publish a layout, use the File tab Collaborate Publish Layout... command.
The Publishing Wizard will appear to guide you through the publishing process.

You enter demographic information about your layout (Title, Author,
Organization) in the first page after the welcome screen (Figure 13.1).

Figure 13.1  Publishing Information

1420
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This information is optional and is only used for descriptive purposes. Press Next
when you are done entering the demographic information.

The next page (Figure 13.2) allows you to choose to anonymize the data by
removing keywords .  Press Next to publish your layout.

Figure 13.2 Select Keywords to Anonymize

When using the Advanced Publisher you will be presented with two additional
dialogs that are discussed in the Advanced Publishing section . 

The Publishing Wizard will ask you to enter a file name for publishing.(Figure
13.3). 

1435
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Figure 13.3 Naming Options for Publishing

Press Next after entering the required information. The final page of the wizard
shows you the file path of the file that you can distribute to have other people
view your published layout. 

13.2 Advanced Publishing

The advanced publishing module allows you to publish your layout, as well as
giving you several more options for controlling how your published layouts are
used by others. Publishing permissions may be saved just like regular
permissions and loaded from a previously saved permissions file . 

If you are using the advanced publisher, the Set permissions for the published
layout page (Figure 13.4) will be available.

1254
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Figure 13.4  Publishing Security Permissions

On this page, you can select which actions viewers of your layout will be allowed
to perform. For example, if you wish to prevent users from printing your layout,
you could disable the Print permission (located under Layout operations).
Almost every action in FCS Express has an associated permission code that you
can choose to allow or not to allow. These permissions will be respected if the
published layout is loaded both in FCS Express and FCS Express Reader. Press
Next after you have selected your permissions.

The next page (Advanced publishing options) allows you to control additional
features, including whether to include batch processing actions and/or disable
token editing in the published document.

The next page (Information for keywords anonymizing) allows you to use
the features associated with the Keyword Anonymizer  to remove any or all
keywords from the data in the published layout. 

When publishing, the next page requires you to select the file name. Your
published file will have the same extension as a standard FCS Express layout
(.fey) and the data will automatically be embedded. 

Any published layout can be opened in the FCS Express Reader.

1435
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13.3 Default Publishing Options

The Default Permissions and Publishing Options can be set in the Advanced
Publishing category of the FCS Express User Options dialog . 

13.4 Sharing Published Layouts with Others

To share your published layouts with others, they must have either FCS Express
or FCS Express Reader installed on their computer.

Simply distribute send the published .fey (layout) to your colleagues to open. 

13.5 FCS Express Reader

 With FCS Express Reader, you can:   

· See published analysis from your colleagues.

· Perform all actions that the publisher of the layout has given you access to.

· Re-analyze the data. All analysis capabilities of the FCS Express Professional

version are available.
· Find templates and demos on the web from reagent suppliers to help get

started with using their products.
· Upgrade to the full demo, or the purchased version, at any time.

13.5.1 Obtaining the FCS Express Reader

FCS Express Reader is available free at http://www.denovosoftware.com/full-
access/features/reader/.

13.5.2 FCS Express Reader Limitations

FCS Express Reader allows you to perform almost all of the analysis tasks of the
regular version of FCS Express. For example, you can add new plots, manipulate
gates, get statistics, and print. However, FCS Express Reader does have the
following limitations:

· You can only use the data files that are embedded in the published layout.

You cannot change data files, load new data files, or run batch processing
on the layout.

1658
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· There is restricted saving capability. A published layout that was saved from

FCS Express Reader can only be opened on the same computer on which it
was saved, or the computer from which it was originally published. This
allows teachers to create layouts which students can manipulate and save.
The changed layouts can then be returned to the teacher for subsequent
grading (as long as the grading occurs on the same computer which created
the published layouts).

13.5.3 Upgrading from FCS Reader to FCS Express

To upgrade from the FCS Express Reader to FCS Express, purchase the
appropriate version from http://www.denovosoftware.com. Once you have
made your purchase, you can upgrade your FCS Express Reader by selecting the
File tab System Change your configuration. (Figure 13.5) and follow the
steps in the configuration wizard.

Figure 13.5  Upgrade FCS Express Reader

http://www.denovosoftware.com




Chapter

14



FCS Express 7 Manual1424

© 2023 De Novo Software

14 Working with FCS Data Files

FCS Express gives you the power to modify .fcs data files directly. You will be
able to edit existing  or add new keywords , and export the raw data  as
modified .fcs files or other generic formats. You may also choose to merge
several FCS files into one file "on the fly" or export the merged data as a new
file. 

14.1 Viewing and Changing FCS File Headers

To view the header details of the current FCS file , use the Data tab Data
Info View Header command. The View Header window will appear (Figure
14.1). If you do not have any open .fcs files, you will be presented with a dialog
to select the desired file.

1424 1426 1438
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Figure 14.1  View Header window

Some of the more common keywords associated with each parameter are
displayed in the Parameter Information field. You can view the entire list of
keywords by pressing the All Keywords… button. A dialog listing all the
keywords in the file will appear (Figure 14.2). 

To copy all of the keywords to the clipboard in the $Keyword=Value format (for
pasting into a text document or a text box in FCS Express), press the Copy to
Clipboard button.
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To print the keywords in the $Keyword=Value format, press the Print... button.

You can modify keywords by clicking the All Keywords... button near the
bottom of the window and entering in the new Value in the designated column
(Figure below);  note that not all values can be modified.  You can also modify
any of the values in the editable free text fields in the middle of the window.  

To add keywords, click the Add Keyword button and a dialog will appear asking
you to fill in the new keyword label and value. When you press OK, your new
keyword will be added to the bottom of the list.  To efficiently add multiple
keywords to a data file or keywords to multiple files , please see instructions
on the following page .

To remove a keyword, press the Remove Keyword button. If the keyword is
required, there will be another dialog informing you that the keyword cannot be
removed. If the keyword is not required, you will see a confirmation dialog after
the change has been made.

When you have finished making your changes in the View keywords - edit
mode dialog, press OK and the changes will be saved in the FCS file header.

Figure 14.2  View Keywords - Edit Mode

14.2 Extra Keywords

FCS Express allows you to add keywords to an existing FCS File.

1426

1426



Working with FCS Data Files 1427

© 2023 De Novo Software

Adding keywords is useful in several scenarios, such as:

· adding descriptors to your data files that were not saved as metadata at the

time of sample acquisition (e.g. information describing the sample, the
experimental group, the experimental condition,...). This is also useful when
multiple files are merged together  since metadata can be used as
classification parameters. 

· adding information to your data files for loading them as a multiwell plate Heat

Map plot ,
· adding information to your data files for creating Virtual Spectral Data.

To add extrakeywords to your data, a specific text file must be created and
placed in the same folder containing the FCS files of interest.

When one of the following file types exists in the same folder as the relevant FCS
File(s), the extra keyword(s) will be accessible after the FCS file(s) is loaded into
FCS Express.

Use Case File type to create Examples

Annotate a
single data file
with one or
more
keywords.

<filename>.extrak
eywords.txt

· Example #1
In the example below a single keyword
named $PatientID, with a value of 123456
is added to file Sample1.fcs.

Sample1.fcs.extrakeywords.txt

Annotate an
entire folder of
data files with
one or more
keywords.

This is useful
when the
same
keywords,
with the same
values, have

<descriptor>.allext
rakeywords.txt

· Example #2 - Adding information about
the plate size (i.e. number or rows and
columns) to plate based data.

In the example below, two keywords,
named $PlateRows and $PlateColumns with
values of 8 and 12 respectively are added
to all the FCS files in the folder where the
"....allextrakeywords.txt" file is stored.

1436
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to be added to
all the FCS file
in a folder.

96well.plate.AllExtraKeywords.txt

· Example #3 - Adding information about

how to create virtual spectra data

with non-spectral data. 

In the example below, five keywords
(FCSE_SPECTRA1NAME,
FCSE_SPECTRA1PARAMETERS,...) are added
to all the FCS files in the folder where the
"....allextrakeywords.txt" file is stored.

VirtualSpectralExample.AllExtraKeywords.txt

Annotate
multiple files 
with any
number of
custom
keyword(s).

This is useful
when the
value for each
keyword
differs
between files.

This method
also allows the
user to create
the required
CSV file using

ExtraKeywordsTabl
e.csv

· Example #4 - Adding keywords with
different values to multiple files.

In the example below, three keywords
named ProtocolID, Sample Type and
WellID  are specifically added to the files
listed in the filename column. The value for
each keywords can vary between files.

1433
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a spreadsheet
interface.

ExtraKeywordsTable.csv

Details about each file type:

· <filename>.extrakeywords.txt

Use this if you want to add extra-keywords to one or very few files. When
extra-keywords should be added to many files, we suggest using the
ExtraKeywordsTable.csv file type instead (please see below).

How to use this:
§ Add a TXT file with the name <filename>.extrakeywords.txt to the

same folder as a data file with the name <filename>. The <filename>
must match the name of the file to which the keyword(s) will be written.

§ Once the FCS file of interest is loaded into a layout, the extra-keywords
contained in the TXT file will be accessible as any other standard
keywords .

·  <descriptor>.allextrakeywords.txt

Use this when you want to add keywords that pertain to all of the files in
the folder. For example, experiment name, protocol information, and plate
information that is relevant across an entire series of samples.

How to use this:
§ Add a TXT file with the name <descriptor>.allextrakeywords.txt to

the same folder containing your data files. The <descriptor> can be
any user-defined string (e.g. it can be a word that describes the type of
keywords that are being added to the data files, like "Plate").

§ This option will assign all keywords values within the .txt file to all files
within the folder.

1284
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§ Once any of the FCS files in the folder are loaded into a layout, the
extra-keywords contained in the TXT file will be accessible as any other
standard keywords .

Use case examples:
§ Defining the number of columns and rows in Plate based data
§ Defining new parameters in Virtual Spectral data

· ExtraKeywordsTable.csv

Use this when you want to annotate multiple files, each with different
keywords and different values.
This is like using an .extrakeywords.txt file, while allowing you the ability to
quickly add and edit many files and keyword values in one .csv document.

How to use this:
§ Add a CSV file with the name ExtraKeywordsTable.csv containing

columns for filename and extrakeyword(s) to the same folder
containing your data files. 

§ Once any of the FCS files listed in the filename column are loaded into a
layout, the corresponding extra-keywords contained in the CSV file will
be accessible as any other standard keywords .

§ The format of the CSV file should be as follows and as seen in Figure
14.3 below:
o Column A contains a header named filename. Additional rows in

column A contain the filename of the files to add the keyword value
to within the folder. The file extension (e.g. .fcs) needs to be included
in the filename. (*)

o Additional columns contain headers named with the name of the

keyword you would like to add. Additional rows under each header
contain the information for the keyword associated with each file in
text or numeric form.

Use case examples:
§ Assigning a Well ID to each Plate based file

(*) TIP: A template for creating an ExtraKeywordsTable.csv file with the
filename column automatically populated can be downloaded here. 
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Figure 14.3  ExtraKeywordsTable.csv

Note: If you add extra keywords to a data file already in use within a layout you can
utilize the Refresh  icon on the Data tab to reload the data.

Examples of common uses of Extra Keywords:

1. Plate Based Data- defining the number of columns and rows
· File type: <descriptor>.allextrakeywords.txt

· When loading data as a multiwell plate Heat Map , the size of the plate

must be specified in an extra keywords file residing in the same directory
folder as your data file(s). An example of this file is shown below in Figure
14.4. The keywords file must contain the keywords $PlateRows and
$PlateColumns. In a typical 96 well plate, that file would contain the
following text:

$PlateRows=8
$PlateColumns=12

· Extra keyword .txt files for 6-, 12-, 24-, 48-, 96- and 384- well plates

can be downloaded on the De Novo Software website.
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Figure 14.4 96well.plate.AllExtraKeywords.txt

2. Plate Based Data- assigning a Well ID to each FCS file.
· File type: ExtraKeywordsTable.csv

· In order to control the well which a file will be associated with, a WellID

($WellID) keyword must be assigned to each FCS File.
o Note: If you recorded the data on a plate-sampling instrument,

your FCS File may already contain this $WellID keyword and you
do not need to create an ExtraKeywordsTable.csv file.

· You will need to create a file called ExtraKeywordsTable.csv in Excel and

save it in the same folder that contains your associated FCS Files. An
example of this file is shown below in Figure 14.5.

o Cell A1 contains the header filename.

o The rows of Column A contain the filenames of the associated FCS

Files exactly as they are named. The file extension (i.e. .fcs) needs
to be included in the file name.

o One of the other cells in row 1 contains the header WellID.

o The rows of the WellID column contain the Well ID you want to

assign (A1, A2, A3, etc.) to the file in the same row.
o You may also define the number of columns and rows in your plate

here instead of using the file <descriptor>.allextrakeywords.txt
o You may include other columns for other keywords.
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Figure 14.5 ExtraKeywordsTable.csv

 

3. Virtual Spectral Data:  
· File type: <descriptor>.allextrakeywords.txt

Note: Please also see the chapter on Pipeline Steps for virtual Spectra
Merging  including options to automatically create the necessary extra
keywords files. The options below allow for manual creation of the necessary
file, but De Novo Software recommends the pipeline steps version for ease of
use. 

· FCS Express allows you to visualize any .FCS data files as a "Virtual

Spectral" data file via the addition of special keywords to the data set. A
virtual spectra parameter may be created by indicating the original
parameter channels to use in a spectral plot (i.e. FL1, FL2, FL3, FL4, etc).
After the virtual spectra parameter is defined for a data file, all of the
standard Spectrum Plot  functionality in FCS Express for further
exploration and analysis  of the data set.

· The <descriptor>.allextrakeywords.txt file needs to be saved in the

same folder as the associated FCS files.
· Download and Unzip Example Virtual Spectral Data extra keywords file

(shown below in Figure 14.6)
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Figure 14.6 VirtualSpectralExample.AllExtraKeywords.txt

· Keywords needed for adding a new spectral parameter:

Keyword Explanation Example

FCSE_SPECTRA1N
AME=

Required: Indicates the name of
the new spectral parameter.

FCSE_SPECTRA1NAME=F
L

FCSE_SPECTRA1PA
RAMETERS=

Required:Indicates which of the
original parameters to use to
create a new virtual spectral
parameter. Parameter names
must match your user
preferences for Keyword To Use
as Parameter Name

FCSE_SPECTRA1PARAMET
ERS=FL1-H,FL2-H,FL3-H

FCSE_SPECTRA1LA
BELS=

Required:Indicates the labels to
be used for each channel in
Spectrum Plots.

FCSE_SPECTRA1LABELS=
One,Two,Three

· Optional keywords for removing unneeded parameters:

Keyword Explanation Example

FCSE_COLUMNTOD
ELETE_STRICT=

Comma separated exact list of
parameters to delete after the
import process. An error will be
given if a parameter is not found
for deletion. Parameter names
must match your user
preferences for Keyword To Use
as Parameter Name

FCSE_COLUMNTODELETE
_STRICT=FL1-H,FL2

FCSE_COLUMNTOD
ELETE=

Comma separated list of
parameters to delete after the
import process. Any parameters
not found will be ignored.
Parameter names must match
your user preferences for

FCSE_COLUMNTODELETE
=FL1-H,FL2-H

1666
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Keyword To Use as Parameter
Name

· Please also see the chapter on Pipeline Steps for virtual Spectra

Merging  including options to automatically create the necessary extra
keywords files.

14.3 Keyword Anonymizer

The Keywords Anonymizer allows you to remove sensitive keyword information
from your data files.

Keywords are written into the file header of data files.  Many of these keywords
contain the identification of the sample or patient from which these files came. 
To maintain the privacy of these files, you can use the Keywords Anonymizer to
strip any keyword information that contains an identifiable feature.

To use the Keyword Anonymizer, go to Data tab Data Info
Anonymizer.

In the open Select Keywords to Anonymize window (Figure 14.7), you can:

· Select the Files to anonymize :

o All active files, which will anonymize all the files currently active and

displayed within the layout, or
o Only the ones selected below, which allow selection of the files to be

anonymized .

· Remove keywords :

o From this list, you can choose to remove:

§ all keywords
§ only the keywords listed below
§ all keywords except the ones listed below

· To add specific keywords to the list, click on the Get keywords 

button to open the Please select one or more keywords dialog, or

you can type the keyword into the list .

· You can select multiple keywords using the Ctrl or Shift key. 
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Figure 14.7 - The Keywords Anonymizer

Options to use the Keyword Anonymizer are also available when publishing your
layout using the advanced publisher add-on . 

14.4 Merging / Concatenating Multiple Files

FCS Express allows users to merge / concatenate multiple data files. This is
particularly useful every-time it is necessary to combined the data points across
multiple samples (e.g. different experimental conditions, different experimental
groups, different replicates,...).

Some examples for using file merging are as follows:

1418
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· To visualize changes across multiple files in one plot (see Example A in Figure

14.8 below, depicting a titration experiment);
· To easily display multiple samples not acquired in plate format using Plate Heat

Map plot (i.e. to present them in a multiwell "virtual" plate) (see Example B in
the figure below where 8 files are depicted in a multiwell plate format);

· To perform data transformations on multiple files simultaneously without

ending up with different transformation results for each file (see the Example C
below where tSNE is calculated on 9 samples).

Data file merging can be accomplished in two ways in FCS Express. 

1. Virtually Merging Files "on the fly" via the Merge FCS Files  option when
loading data files in the Data List. 

2. Merging and exporting data files as a new .FCS or file type.

Note that the above mentioned strategies are not super-imposable. The Virtual
Merge is faster but less flexible. For example, since the compensation matrix of
the first file is applied to all the subsequent files, the Virtual merge it is not
recommended if you want to use different compensation matrix for different
files. 

Figure 14.8 - Use cases examples of file merging. 
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14.5 Exporting FCS File Data

FCS Express gives you two ways to export (i.e., save) the data from an FCS file
in different formats. You can export data from a single file  or you can "batch
export" data from several files  at one time. Files may also be
Merged/Concatenated  to create one new file that can display and compare
parameters in a single plot for multiple data files. 

14.5.1 Exporting FCS File Data from a Single File

To export the data from an open FCS file:

· Select a plot displaying the file to be exported.

Note: the compensation applied to the selected plot will also be applied to the
exported data.

· Use the Data tab Save/Load Export command to bring up the Export

Data dialog (Figure 14.9).
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Figure 14.9 - Export Data dialog

You must assign a name and file type for the data you are exporting. It is
recommended to click the folder icon to the right of the Export file name field.
This will bring up a Save As dialog (Figure 14.10) where you can choose the
folder to save the data in, enter a file name, and choose the file type from a drop
down menu.
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Figure 14.10 - The file export Save As dialog. Note the files of type dropdown list.

The Options button will be activated when an .fcs file type has been selected and
populated in the Export file name field. (Figure 14.11)
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Figure 14.11 - When Export file name is populated with .fcs file
type the Options button (highlighted with red box) is activated.

Utilizing the Options button will allow you to set the specific options for the
selected data format. Figure 14.12 depicts the saving options when FCS files
(*.fcs) is selected as file type.
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Figure 14.12 - The Save Data dialog allows you to choose the format of the data file
saved.

The following table lists the options available when exporting data as FCS files.

Option Explanation

Data Format Select the data format to use: Integer or Single
Precision Floating Point. The default option is to
export the data with Single Precision Floating
Point.

Endian Format Select the Endian format to use: PC format
(little-endian) or Mac Format (big-endian). The
default option is to export the data in PC format.

FCS Version Select the Flow Cytometry Standard (FCS)
format version: 2.0 or 3.0. The default option is
to export the data as FCS 3.0.

Save the FCS v3.0 time units in Select the units to use for the Time Parameter
(it only applies if 3.0 is selected in the FCS
Version in the option above). Possible choices:
Don’t modify the FCS time parameter,
milliseconds, seconds, minutes or hours. The
default option is Don’t modify the FCS time
parameter.

In addition to the FCS file (*.fcs) format, you can export the data as a text file

(*.txt), comma separated values file (*.csv), tab separated values file
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(*.tab), space separated values file (*.prn), ICE file (*.ice), or a DNS data

stream file (*.dns). After assigning the file name and type, click Save.

The Export Data dialog allows to select also additional options:

· Export Split on Classification. Files can be split during export by selecting a

Classification Identifier from the dropdown list. The classification identifier

keyword may be set in the users options . The file name chosen for the

export will prepend to the text of the Classification Identifier. 

· Select keywords to export. Keywords can be selectively exported using the

Keywords to export button.

· Parameters to Export. Select which parameters to export in the

Parameters to Export list box.

· Export Cell Range. Choose which cells to export, by cell number in the

Export Cell Range field. The format is [first cell number-last cell number]. By

default, the numbers represent the first and last cells in the file. The events

exported will be those as indicated in the Export Cell Range field, for instance 1-

4000 will export event number 1 through event number 4000, and will not

export a randomly generated, or interval defined, set of events. 

· Export cells in Gate. Use the Export cells in Gate drop-down list, to export

cells only within the specified gate.

When you are ready to export, press OK.

14.5.2 Exporting FCS File Data from Multiple Files: Batch Export /
Merging/ Concatenation

You can export data from multiple files consecutively, or merged multiple files
into a single file, using Batch Export (Data tab Save/Load Export).
The process is also sometimes referred to as concatenation. 

Note: Utilizing the Batch Export options below will create a new data file. If
exporting a new data file is not necessary, users may also choose to
merge/concatenate data on the fly utilizing the Adding Merged Files to the Data
List  feature.

The Batch Export dialog (Figure 14.13) can be accessed by selecting the Data
tab Save/Load Export command.
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Figure 14.13  Batch Export Dialog

The batch export dialog allows users to define the following options:
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Select data file to export Click Add to select the files to export.
You can remove files from the export
list by clicking the Remove button (or
clear all files with the Clear button).

Export as Individual Files

or

Export as Merged File

Use the Export as Individual Files
radio button to export all files separately
and Export as Merged File to export
all files merged into a single file.

The options, with respect to file types,
and the choices for data to export, are
similar to those when exporting data
from a single file .

When Export as Individual Files is
selected, the output file name can
contain the original file name in it, by
using the asterisk. E.g. if a file is named
Sample1.fcs and the output file name
specified in the Export file name field is
Exported_* , the actual output file name
will be Exported_Sample1.fcs.

When Export as Merged File is
selected, you may check the Create
File Identifier column  box and/or
the Create Classification File
Identifier Column  box, which both
allow each event in the merged file to
be traced back to the original file (see
details below). 

Create File Identifier column adds a
new column (parameter) to the merged
output file.  The values for the File
Identifier parameter are incremented for
each file so that events in the merged
file may be traced back to and gated on
the original files.  In the example below
(Figure 14.14), a merged output file has
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been created from a data set containing
four original files.  Three separate gates
have been drawn on events originating
from files 1, 2, and 3 to allow for
separate analysis of these populations.

Note: In order for the File Identifier
parameter scaling to display correctly,
please ensure that the default FCS
Saving Option for Data Format  is set
to Single (default).

Figure 14.14  Merged file with File
Identifier Column, with separate gates

drawn on events from original files

Create Classification File Identifier
Column adds a new column
(parameter) to the merged output file.
The values for the Classification File
Identifier parameter are text labels
matching the filename to which each
event belongs to allowing each event in
the merged file to be traced back to and
gated per file. The difference between
the File Identifier parameter and
Classification File Identifier is that the
Classification File Identifier
parameter is compatible with Plate Heat
Map plots . Thus, each original file
may be represented as a well of an
Plate Heat Map plot. Moreover, the
Classification File Identifier
parameter reports the actual file name
instead of a number as is the case with
the File Identifier parameter.

Please note that to create the
Classification File Identifier
parameter, the DNS data Stream files
(*.dns) format must be selected as the
file of type for the output merged file
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(see the Merging / Concatenating FCS
Files - Use Case Example  chapter for
more information on how to use this
feature). 

In the example below (Figure 14.15), a
merged output file has been created
from a dataset containing four files.
Three separate well gates have been
drawn on the wells of the Plate Heat
Map plot representing files 1, 2, and 3,
to allow for separate analysis of these
populations.

Figure 14.15  Merged file with
Classification File Identifier Column, with
separate well gates drawn on the Plate

Heat Map plot to specifically select
events from original files

See an example of the Multiple File
Merging feature in the Merging /
Concatenating FCS Files - Use Case
Example .

Export with compensation Allows you to select whether data
should be exported as compensated
data or as raw data with the
compensation saved apart into a $SPILL
keyword (default is None).

Possible choices are:
· None: data are saved as

raw (uncompensated) data
and the compensation is
maintained as $SPILL
keyword in the exported
file.

· Default: the compensation

defined base on the Layout
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Options  will be applied to
the data. Data will thus be
exported as compensated
data. The compensation is
then saved just for tracking
purposes in a non-standard
keyword called
ORIGINAL_SPILL. The
original $SPILL keyword is
removed.

· A further choice will be

presented for all of the
individual compensations
currently accessible in the
layout. The compensation
definition selected will be
applied to the data
exported. Data will thus be
exported as compensated
data. The original
compensation associated
with the data file is also
saved for archiving
purposes as a new keyword
called ORIGINAL_SPILL.
The $SPILL keyword saved
at acquisition is removed.

Note: When merging multiple data files,
if a Data Specific Gate was used to
select the Cells to Export, the
compensation applied to the merged
output file must be the same
compensation used for the Data Specific
Gate. In this case, it is recommend to
select Default in the Export with
Compensation option and set the
compensation used to create the Data
Specific Gate as the Default for the
layout (see Applying Compensation
Definitions  for more information on
how to set a compensation as Default
for a layout).

Export with transformation
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Allows users to select the
Transformation  that will be applied to
the data before exporting. Default is
None.

Cells to Export The options available in this section
allows users to define how exported
events should be selected.

· Export Cell Range. Only the events

in the specified range will be exported.
Default is all cells. The events exported
will be those as indicated in the
Export Cell Range field, for instance
1-4000 will export event number 1
through event number 4000, and will
not export a randomly generated, or
interval defined, set of events.

· Export cells in gate. Only the events

within the selected gate will be
exported. Default is No gate. When
selecting a gate to export the user will
be able to visualize the gate hierarchy.
Using the right click menu the user can
Expand All, Collapse All, Expand All
Children, Collapse All Children,
Expand Current Level, or Collapse
Current Level to making it easy to
navigate through the hierarchy to find
the desired gate.  

Note: if both a Range and a Gate are
selected, the Range filter will be applied
first. E.g. if the Range is set to "1-4000"
and Gate is set to "Gate 1", only the
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Gate 1 cells within the first 4000 events
will be exported.

Use custom compensation and
transformation for gating.
This option allows users to define
whether the gate defined above should
be applied using a compensation or a
transformation different than the ones
selected in the Export with
compensation and in the Export with
transformation options.

Note that the option does not define
if a compensation or a
transformation should be applied to
the exported data (this is done
through the Export with
compensation option described
below), but only if the filter gate
should be applied to
compensated/transformed data.

If the Use custom compensation and
transformation for gating option is
not checked,  the setting defined in the
Export with compensation and in the
Export with transformation
options  will be applied.

Examples
In the examples below, events within a
gate of interest, called Gate 1, will be
exported from a file of interest.

Example #1
The Use custom compensation and
transformation for gating option is
unchecked, no custom
compensation/transformation is used
for gating, and the setting defined in
the Export with compensation and
in the Export with transformation
options will be applied to both the
exported values and the gating.

1449
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· if the Export with compensation is

set to use a compensation (e.g. a
specific compensation or the Default
one), Gate 1 will be applied to the
compensated dataset (left plot
below) and 5 events will be
exported. In the exported file,
events will also be compensated
using the compensation selected in
the Export with compensation
drop-down menu.

· if the Export with compensation is

set to None, Gate 1 will be applied
to the non-compensated dataset
(right plot below) and 2112 events
will be exported. In the exported file,
events will be saved as raw data. If
the input data contains a $SPILL
keyword, it will be maintained.

Example #2
The Use custom compensation and
transformation for gating option is
checked, the setting defined in the
Export with compensation and in
the Export with transformation
options will not be used for gating (i.e.
setting defined in the Export with
compensation will only be applied to
the exported gated events).

· if a compensation is selected in the

Use custom compensation for
gating option, then Gate 1 will be
applied to the compensated dataset
(left plot below) and 5 events will be
exported. In the exported file,
events will be compensated or not
based on the Export with
compensation setting.

· if None is selected in the Use

custom compensation for gating
option, then Gate 1 will be applied
to the non-compensated dataset
(right plot below) and 2112 events
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will be exported. In the exported file,
events will be compensated or not
based on the Export with
compensation setting.

Note for Data Specific Gates.
A Data Specific Gate is specific for the
dataset and the compensation use to
create it. To use Data Specific Gates
during Batch Export, the same
compensation used to create the Data
Specific Gate within the layout must
also be used during the Batch Export.
Setting the Export with compensation
option to Default and unchecking the
Use custom compensation and
transformation for gating, will allow
users to utilize data specific gates. 

Parameters to Export Allows users to select the parameters
to export. Default is all parameters.

Parameters can be specified by
indicating the parameter numbers to
export.

For example, if the first 4 parameters
are only to be exported, enter 1-4.

If the user is interested non-adjacent
parameters, the parameters can be
listed, each separated by a comma.
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For example, if the first, third, fifth and
seventh parameters are being exported,
enter 1,3,5,7.

Select keywords to export
Allows users to select which keywords
will be maintained or removed after the
export. Default is to export all
keywords.

14.5.2.1 Merging / Concatenating FCS Files Via Batch Export - Use Case Example

Here we will present a use case example for Merging/Concatenating Data

Files  . In the example, files from a titration experiment will be concatenated.

Briefly, each sample has been stained with a different dilution of the antibody of

interest (e.g. CD3 FITC). The file resulting from file merging will then be loaded

into FCS Express for further analysis. Both the File Identifier Column and the

Classification File Identifier Column will be created in this example. Of course,

the user can decide to create either one or both the above-mentioned Identifier

Columns.

1.  Select Data tab from the Ribbon. The Batch

Export dialog will open.

2.  Click on Add from the Select Data File to Export section of the dialog

Add using Standard Open Data Dialog or Add using Advanced Open

Data Dialog (Figure 14.16). Note: The Advanced Data Dialog allows to select

files from the Data List.
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Figure 14.16 The Batch Export Dialog displaying the different Add options.

3.  Browse and multiple select the files to merge.

4.  Check the Export as Merged File radio button.

5.  Browse to a location in the Export Filename field for the output file select

an output file name (  and  in Figure 14.17).

 a. Select DNS data Stream files as File of type (  in the figure below).

Note that this file extension is required to create the Classification File
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Identifier Column. If only the File Identifier Column has to be created,

FCS files (*.fcs) can be selected as File of type.

 b. Note: When the File Identifier Column is created, in order for the File

Identifier parameter scaling to display correctly, please ensure that the default

FCS Saving Option for Data Format  is set to Single (default). Note that this

option is only available when FCS files (*.fcs) is selected as File of type.

When working with DNS files, the plot axis displaying the File Identifier

parameter may be manually customized with regards to the Resolution

Options via the 1D plot Specific Options  or the 2D plot Specific Options .

Figure 14.17 The Save As dialog allows to specify the location, the name and the
type of the oputput file.

6.  Check the Create File Identifier Column and the Create classification File

Identifier Column check boxes (  in the Figure above).
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7.  Select which Compensation and which Transformation to apply to the data

before exporting it (  and  respectively in the Figure above). 

8.  Click Merge. The selected file will be merged/concatenated and the

corresponding merged file will be saved in the location specified in Step 5.

Note that files are merged/concatenated in the same order in which they are

listed in the Select data files to export field (Step 2).

The merged file can be now loaded into the layout using 1D plots, 2D plots, Plate

Heat Maps and Data grids. 

Below is an example of a Density plot, Contour plot and Plate Heat Map with the

newly merged file loaded. Note that the File Identifier Column and

Classification File Identifier Column created in Step 6 above can now be used

to create gates and well gates and thus to virtually separate the different merged

files (Figure 14.18).

Figure 14.18 An example of Density (left), Contour (right), and Plate Heat Map
(bottom) plots of the file resulting from the merge.
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Plots displaying the File Identifier Column and file-specific gates can be both

integrated in any of your layout as they are compatible will all functionality of FCS

Express (Figure 14.19), including Well Gates .

Figure 14.19 An example of file-specific gates drawn on the file resulting from the
merge.

Please see also the Antibody Titration Spreadsheet use Cases 2  to see how to

use spreadsheet for this type of assay.
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15 Working with Other File Types

FCS Express supports importing two external layout types:

· BD FACSDiva™ experiments

· BD Accuri™ C6 experiments

FCS Express also supports importing / loading of comma delimited files stored in
the format of (*.csv)

FCS Express Image Cytometry supports loading Amnis .DAF / .CIF file types

15.1 BD FACSDiva Files

The basic version of FCS Express can load FCS files from BD FACSDiva™
software, similar to loading data files from any other instrument. However, the
FACSDiva Importer add-on allows you to import your entire experiment
(FACSDiva version 4 and above) as well.

A FACSDiva experiment file, which has the extension .xml, is created when you
export your data using the FACSDiva software (see "Exporting Experiments" in
the FACSDiva Software Reference Manual for information). The FACSDiva
experiment file contains information on plots, gates, and compensation settings.

The following FACSDiva experiment information will be maintained when the file is
imported into FCS Express:

· All acquisition templates and analysis worksheets.

· The native, high resolution, floating point FCS data.

· All gates with the proper gating hierarchy.

· All compensation settings.

· All markers and quadrants.

Because the FACSDiva experiment file does not contain information about the
pages its plots should appear on, FCS Express needs additional data to import
the file properly. In particular, FCS Express needs to know how you want the
plots distributed across your layout pages. For example, a given FACSDiva
experiment file has three plots laid out horizontally. This file could be imported
into FCS Express such that each plot exists on its own layout page, or all three
plots could be placed on a single layout page. If you leave the size of the FCS
layout page at the standard 8.5 x 11 inches, then importing the three plots may
cause the size of the plots to shrink, in order to fit them on a single page.
However, while importing, you can configure the size of the FCS Express layout
page to contain more plots of standard size.
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Once you have set up the page size for the FACSDiva experiment file import,
along with the distribution of the plots on the layout page, you can save the
configuration for use again with other FACSDiva experiment files. The
configuration is saved to an FCS Express FACSDiva configuration file .

15.1.1 How to Import FACSDiva Experiment Files

To import a FACSDiva experiment file:

1.  Use the File tab Open From Import BD FACSDiva File... command.

2.  Browse your directories to select the FACSDiva experiment file (.xml) to
import. Click Open when you have located it.

3.  The Import BD FACSDiva File Wizard appears, beginning with the
Import Options page (Figure 15.1). The worksheets available in the
FACSDiva experiment file are displayed, including their type (either
Analysis worksheet or Acquisition template). In the Import column,
check the box for the Worksheet(s) you want to load. You will need to
select at least one Worksheet to continue.
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Figure 15.1  Import BD FACSDiva File Wizard - Import Options

4.  Towards the bottom of the window, choose whether you want to load the
FCS files corresponding to the experiment, and navigate to the folder
containing the files (if different from the .xml-containing folder). If you do
not want to load the FCS files, choose the Do not load the FCS files radio
button. Click Next to continue.

5.  The FCS Express FACSDiva configuration file page appears (Figure
15.2). You can choose to load an existing configuration file, or create a
new one. If you choose to load an existing configuration file, select the Use
an existing configuration file radio button, select the file, click Next, and
proceed to Step 8. If you choose to create a new configuration file, select
the Create a new configuration radio button, and click Next.
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Figure 15.2  Import BD FACSDiva File Wizard - Configuration File

6.  If you decided to create a new configuration, the Setting up the page
size for the layout in FCS Express (Figure 15.3) will appear. Here, you
set up how the plots from the FACSDiva experiment will be imported into
the FCS Express layout.
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Figure 15.3  Import BD FACSDiva File Wizard - Setting Page Size

The window is divided into two sections:

· Real Page Size (inches)

This section allows you to configure the page size of the layout. The
default is 8.5 x 11 inches. You can also set the margin widths.

· Logical Page Size (pixels)

This section allows you to configure how the FACSDiva experiment file
will be divided when it is imported into FCS Express. It displays all the
dot plots and histograms from the FACSDiva experiment, using mock
diagrams to represent the appropriate plot. By clicking in the
representation of the FACSDiva experiment file page, you can divide
the experiment into multiple pages. After the initial click, you will see a
dotted vertical line which represents the right side of each layout page,
and a horizontal dotted line, which represents the bottom of the layout
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page. If one of these lines is not visible, zoom in or out using the
magnifying glass buttons.  If a plot extends across more than one page
in the diagram, it will be placed on the layout page where its top-left
corner exists in the diagram. By default, the ratio of the page is locked,
which means that as the width of the page increases, so does the
height.

When you have completed setting up how the FACSDiva experiment’s plots
will be imported, click Next.

7.  The next page of the wizard, Saving the configuration, allows you to
choose whether or not to save the settings from the previous screen to a
file. Saved configuration files can be used to import other FACSDiva
experiments (in Step 5). Click Next to continue.

8.  If, in Step 3, you chose to load an Analysis worksheet, then FCS Express
will display the experiment. If you loaded an Acquisition template, along
with the FCS data files, then the Select the Specimen and Tube dialog
will appear (Figure 15.4). Expand the name headings, as appropriate, and
select one FCS file from the list. After highlighting an FCS file name, click
OK. If FCS Express cannot find the file, you will be prompted to locate it.
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Figure 15.4  Selecting FCS File Data for an Imported FACSDiva Experiment

9.  For each worksheet with an acquisition template you selected in Step 3,
you will see the above dialog to load FCS data file.
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FCS Express will then display the imported FACSDiva experiment, which can be
treated like any other layout.

15.1.2 Tips for Importing FACSDiva Experiments

The following tips are valuable when considering importing FACSDiva experiment
files into FCS Express.

When importing FACSDiva experiments into FCS Express, all plots in the
experiment will be recreated on your layout. Although each plot can be
reformatted using standard FCS Express techniques , it is useful to remember
that the default format (i.e., fonts, axes labels, plot resolution, overlay settings,
etc.) can be defined before a plot is created, in FCS Express User Options . To
ensure that imported plots are displayed in the manner that you prefer, it is
recommended that you take advantage of the default options before you import
FACSDiva experiments. For convenience, you can create a user  (e.g.,
"FACSDiva Import"), under whom the specific default options may be defined
without affecting your default settings for working with other types of data files.

Among the plot settings that you will most likely want to configure are:

· Legend visibility

Displaying the legend takes away viewable space from the plot. Therefore,
you should consider hiding the legend  if your FACSDiva experiment
displays many plots on a page.

· Histogram resolution

Typically, the histogram resolution is set to be derived from the FCS File.
In high resolution data with lots of channels, there are likely to be very few
events in each channel. Lowering the resolution to 1024 channels may
improve the appearance of the histograms.

· Scaling the Axes

When you import your experiment into FCS Express, your plots are
displayed with the axes scale settings that are stored in the experiment
file. You are not obligated to keep these axes scales, however. For
example, if an imported plot is displayed with five decades, you may
decide that it is better displayed with only four decades. You can also
change the scale between linear, logarithmic, and biexponential .

15.2 BD Accuri CFlow and C6 Files

The BD Accuri™ C6 and C6 Plus are bench-top systems that deliver performance
and features similar to those of the market-leading flow cytometers, yet the
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instruments and the C6 software that controls the C6 are easy to use and allow
even a novice to quickly set up an experiment and acquire data.

FCS Express is pleased to provide the BD Accuri C6 importer, which allows you
to apply the sophisticated analysis features of FCS Express to the data acquired
using C6. FCS Express will import all of the experiment information from the C6
file, including: 

· All plots on the Collect and Analyze tab.

· The native, high resolution, 24-bit FCS data.

· All gates with the proper gating hierarchy.

· All compensation settings.

· All markers and quadrants.

· All plot formatting settings.

Once your experiment is loaded into FCS Express, you can treat your plots just
like a plot created in FCS Express.

If you have purchased the Heat Map add-on  with FCS Express you may load
any .C6 file in FCS Express as a 96 well plate heat map regardless if it was collect
from a plate. Simply insert a plate heat map and choose BD Accuri C6 Plate
files (*.c6, *.ci) from the files of type drop down list. 

15.2.1 How to Import CFlow Experiment Files

To import a CFlow experiment file:

1.  Use the File tab  command.

2.  Browse your directories to select the C6 experiment file (*.c6; *.ci)to
import. Click Open when you have located it.

3.  The Import BD Accuri C6 File Wizard appears, beginning with the
Import Selections page (Figure 15.5). On this page, you can choose to
import plots from the C6 Collect and/or Analyze tabs.

4.  If you choose to import plots from the Collect tab, select the data file to
use from the drop-down list.

5.  Click Next to continue.
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Figure 15.5  Import BD Accuri CFlow File Wizard - Import Selections

The Page Layout Options page (Figure 15.6) will appear. Here, you
configure how the plots from the C6 experiment will be imported into FCS
Express.
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Figure 15.6  Import BD Accuri CFlow File Wizard - Page Layout Options

6.  Under the Page Size section, you can select a standardized size from the
drop down menu, or you can manually enter a Width or Height. You are
also able to adjust the Margins, Page Orientation and whether or not
FCS Express is to Maintain the size of all objects on the layout. 
Underneath the Plot Layout Options section, you can set the Plot width,
Plot height, Number of rows per page, and Number of columns per page. A
preview of your layout is shown on the right. Click Finish when you are
ready. FCS Express will now create an exact copy of the C6 workspace
displayed as an FCS Express layout. The plots will all be scaled and zoomed
the same way in FCS Express as in C6. All regions, markers, and gating are
retained. Parameter names and compensation settings are also applied.

15.2.2 Tips for Importing CFlow Experiments

The following tips and instructions will aid in importing and using Accuri CFlow
experiments:
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· Recommended settings in FCS Express to help improve performance when

importing BD Accuri C6 experiments.

1.  Open the Options dialog using the  command.

2.  Select the  category. Make sure that
Allow Multiple Datasets is unchecked. Although this setting is not
necessary for loading a C6 data file, it will allow you to add files to the
data list, which is necessary for batch processing.

       
 

· Loading BD Accuri C6 software data into FCS Express plots.

1.  Insert a plot  from the Insert Tab. When the Select a Data File dialog
opens, change the file type to C6 files (*.c6; *.cfl; *.ci).

   
2.  Navigate to the BD Accuri C6 software file that you want to open, and

double-click on it. The dialog will then display all of the fcs files contained
inside the C6 file. Select the one that you are looking for.

       
3.  Press Open.

15.3 Comma Separated Value / Delimited (.csv) Files

FCS Express supports loading data stored as Comma Delimited files in the
format of (*.csv). 

Data files stored in the .csv format must contain a header row for each
parameter that contains a parameter descriptor as well as a comma-separated
list of values for each parameter created as seen in Figure 15.7.
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Figure 15.7 - A comma-separated value (.csv) file created in the proper format for
import to FCS Express Version 5.

Comma Delimited files may be opened and used in FCS Express by choosing
Comma Delimited files (*.csv) from the Files of type drop down list in any
Select a Data File dialog (Figure 15.8.).
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Figure 15.8 - Choosing the Comma Delimited files (*.csv) file type in the select a
data file dialog.

Once a file is selected it may be inserted as a plot in FCS Express for analysis
(Figure 15.9).
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Figure 15.9 - A comma delimited value file opened in a histogram and dot plot.

15.4 Working with Amnis .DAF files

FCS Express 6 Image Cytometry and Plus are directly compatible with the Amnis
*.daf file format to allow loading of native .daf files and the images associated
with them (in .cif format) in FCS Express. 

Amnis .daf files behave just like any other data file in FCS Express for inserting
plots , creating, gates, and deriving statistics. Single cell images may be
accessed via a Data Grid  which serves as an Image Gallery just as with any
other image cytometry data file formats in FCS Express. 

Please note that .DAF files can be loaded with images or without image (numeric
data only) via the FCS Express User Options  depending on the needs of your
analysis. By default, if an Amnis .cif file with the same name as the corresponding
Amnis .daf file are located in the same folder, images will be loaded. If no Amnis
.cif file was created, or if the .daf files have been moved to a different folder
location than the .cif files, images will not be loaded. 

Please see the following topics for working with data in FCS Express:

Inserting plots
Using Data Grids as Image Galleries
Applying Gates to a Data Grid (Image Gallery)
Creating Gates on a Data Grid (Image Gallery)
Backgating on a Data Grid (Image Gallery)

To open an Amnis .DAF file in FCS Express:

1.  Choose to insert a plot  or add a data file to the data list . 
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2.  Click on the Files of type drop down in the Select a Data File dialog
(Figure 15.10)

3.  Choose Amnis DAF File (*.daf) from the list. 
4.  Select the Amnis .daf file you wish to use.
5.  Press OK. 

Figure 15.10 - Selecing the Amnis DAF File of type from the Select a Data File
dialog.
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16 Electronic Signatures

FCS Express supports a comprehensive set of features to allow you to manage
and record electronic signatures.

Electronic signatures generally work in conjunction with the security features .
With the security features activated, a new Electronic Signatures gallery will be
present when you select File tab Info  (Figure 16.1).

Figure 16.1  Electronic Signatures Gallery
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Click on the black triangle to Sign, Unsign or to view the Signature List . 
The number and types of signatures can be completely defined by the user. If the
logging features are activated, FCS Express will keep a record of all signing and
unsigning events.

16.1 Maintaining Signatures

Signatures can be maintained from the Signature List dialog (Figure 16.2) by
selecting the File tab Info Electronic Signatures  command.

Figure 16.2  Signature List Dialog

When you are finished adding , modifying , or deleting  signatures, press
OK to save your changes or Cancel to discard them.
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16.1.1 Adding Signatures

To add a new signature:

1.  Use the File tab Info Signature List command
to bring up the Signature List dialog.

2.  Press the Add button. A new signature will appear in the list box on the
left (Figure 16.3).

3.  Type a name for the signature into the Signature Name field.
4.  Under the Allow signature for section, select the User Group  for which

the signature is to be enabled.

Figure 16.3  Adding a New Signature

The signature properties are described in the section on Modifying Signatures .
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16.1.2 Saving and Loading Signatures

An electronic signature list can be exported from a layout and imported into a
layout.

This is helpful in a number of situations.

For example:
1. if you have many signatures within a layout and would like to maintain

the same signatures in a different layout, or,
2. if you need to restore the signatures within a current layout.

To Save a Signature List:

1. Open the Signature List from the File tab Info
Signature List.

2. Click Save.
3. Browse to a location where the resulting XML file will be saved.



FCS Express 7 Manual1482

© 2023 De Novo Software

To Load a Signature List:

1.   Open the Signature List from the File tab Info
Signature List.

2.   Click Load.
3.   Browse to the location to select the Signature List file.
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4.  Select the Signature List and then click Open.
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5.  The Signature List in its entirety will be restored.
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16.1.3 Modifying Signatures

To modify an existing signature:

1.  Use the File tab Info Signature List command to
bring up the Signature List dialog (if it isn't already visible).

2.  Select the signature to modify in the list box on the left. The properties for
that signature will appear in the Signature Properties, Allow Signing, and
Allow Unsigning portions of the window (Figure 16.4).
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Figure 16.4  Modifying a Signature

Signature Properties are defined in the table below.

Property Explanation

Signature Name The name of the signature as it will appear in a token in the layout.
It usually corresponds to the specific state of the layout (e.g.,
under review, approved, etc.).

Allow signature for Only users who are members of the security groups  that are
checked will be allowed to sign under this signature.

Description A short description of the signature. This is used for reference
purposes only.

Notes Notes associated with the signature

1512
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Signature Order

Signatures can be set to allow or not allow manual signing and unsigning.
Signatures can also be allowed or not allowed based on a token. This feature can
be used to enforce a Signature Order where a signature from one particular
signature group must be signed before a signature from another signature group
is allowed. By utilizing the Allow authorized user to sign / unsign based on a
token feature, and using the Signature Status of particular signature groups to
evaluate the token to true or fales, signature orders may be enforced . The
Allow Signing / Allow Unsigning options are defined in the table below.

Property Explanation

Manually allow
signing / unsigning

Allows users to manually sign / unsign the signature.

Allow authorized
users to sign /
unsign

Allows the signature to be signed / unsigned. If unchecked, the
signature will not appear in the Signature List of the Sign / Unsign
window.

Allow authorized
users to sign /
unsign based on
token

Allows access to the signature for authorized users based on a
token or custom token. This allows signatures to be enabled or
disabled based on the status of other signatures or tokens. See the
use case example below for more details on this feature.

Signature Order example

In the example below, two signatures have been defined:

· Signature 1 (left pane in the screenshot below)

· Signature 2 (right pane in the screenshot below)



FCS Express 7 Manual1488

© 2023 De Novo Software

The Signature Order options have been used for Signature 2 so that Signature
2 can only bie signed when Signature 1 is also signed. Signature order
enforcement was done by creating a condition in the Allow authorized users to
sign field. In this example, the condition uses the Signature Status token for
Signature 1. If the Signature status for Signature 1 equals "Signed", signature 2
would then be allowed to co-sign the document.   

16.1.4 Deleting Signatures

To delete a signature:

1.  Use the File tab Info Signature List command
to bring up the Signature List dialog.

2.  Select the signature from the list on the left.
3.  Press the Delete button.

16.2 Signing Layouts

To sign a layout, use the File tab Info Sign command
to bring up the Sign dialog (Figure 16.5).

Figure 16.5  Signing a Layout

The list on the left will show signatures that are allowed, based upon the current
user’s security group.
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If no signature are listed, either no signatures have been defined for the current
security group or, no signature are currently allowed based on the Signature
Order option . 

Press the Sign button to sign the layout. An optional note or comment can be
entered in the Notes field. After pressing Sign, the user will be required to
confirm their password.

16.3 Unsigning Layouts

To unsign an already signed layout, use the File tab Info
 command to bring up the Unsign dialog (Figure 16.6).

Figure 16.6  Unsigning a Layout

The list on the left will contain the current user's signatures for the present
layout. Select the signature you wish to remove and press the Unsign button.
An optional note can be entered in the Notes field. After pressing the Unsign
button, the user will be required to confirm their password.

16.4 Displaying Signature Information

Once you have created and set up your signatures  in FCS Express, you may
want to display their details and signing status  on your layout pages. 
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By default, the signature  details and status do not appear on a layout page.
However, you can easily display the information about the signatures  using
signature tokens . 

A signature token can display the following kinds of information (Figure 16.7):

1. Signature
Name
2. Signature
Description
3. Signature
Status
      Never
Signed|
Signed|
Unsigned
4. Signature
Date
5. Signature
Time
6. Signature
Signer
      Never
Signed or
Name
7. Signature
Stamping
Notes

Figure 16.7 Signature tokens available in FCS Express.

To display the signature tokens, you need to first create a text box . Once you
have the text box , there are two ways to insert signature tokens into the text
box :

1. Using the signature table

Right-click in the text box, and select Insert Signature Table. A table will
be created inside the text box, as shown below (Figure 16.8). 
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Figure 16.8 Inserting a signature
table.

2. Using individual signature tokens

a.  Right-click in the text box, and select Insert Token . The Insert a
Token  window will appear (Figure 16.9).

Figure 16.9 The insert token window.
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b. In the Insert a Token  window, expand the Signature  node then
select the type of signature  information you want to display, and press
Insert (in this example we will choose Signature Name) (Figure 16.10).
The token editor will appear.

Figure 16.10 Inserting a token.

c.  In the token editor click on the Signature information category to
confirm your choice (Figure 16.11).

1284 1479

1479
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Figure 16.11 Signature information in the Create Signature Token window.

Note: You will notice in the Signature information category you have the
option to choose any defined signature from the Signature drop down. You can
choose which signature token you would like to insert from the Token Type
radio buttons. This is useful if you would like to edit or change the token in the
layout without deleting and inserting a new token.

d.  Click OK to insert the token. The new signature token will appear in the
text box (Figure 16.12).

Figure 16.12 The signature token
inserted in a text box.

As with other tokens, you can change the formatting of individual signature
tokens, for instance to mimic a typical signature section on a printed report.
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16.4.1 Signature Status

Once you have created and set up your signatures  in FCS Express, you may
want to display their signing status on your layout pages. 

Signature Status can be designated as:

· Never Signed - Indicates the signature has never been signed.

· Signed - Indicates the signature is currently signed.

· Unsigned - Indicates that the signature has been signed at least once and is

currently unsigned.

You may also create a custom signing status using custom tokens  to hide the
signature status if the layout has never been signed or has been unsigned. A
custom token  of this type will therefore only display the signature status when
the layout has been signed. Instructions for creating this type of custom token
can be found in the hiding signature tokens  section of the  custom tokens
chapter.

Note: If you would like to have a pre-defined order of signing based on
Signature Status (e.g. a technician must sign before a reviewer is allowed to
sign too), please refer to Signature Order options . 
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17 Layout History

If the Logging/Audit Trail add-on is purchased, FCS Express tracks every action
performed by a user on a layout. 
(Additionally, System Level Audits  will track system level events)

To view the layout history, use the File tab Info View Layout History
command to bring up the Layout History Viewer window (Figure 17.1).

Figure 17.1  Layout History Viewer

Every action performed contains the following information:

· In the Action column, there is a description of the action performed.

1557
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· If security is enabled, the User Name column lists the name of the user

who performed the action.
· The Date column shows the date when the action was performed.

· The Time column contains the time the action was performed.

Note that dates and times are stored internally as UTC (Coordinated
Universal Time) and converted to the zone used on the local computer for
display. 

Some actions also cause other actions to be performed. For example, when
creating a gate, a text box is also automatically created. All of the associated
actions are grouped under a single entry. In the figure, the Open Dot entry at
the top of the list box contains two history sub-entries, Compensation Create
and Open 2D Plot. To view all history entries for an action, click on the + to the
left of the text of the action. The lower text region of the Layout History
Viewer contains more details about the currently selected action.

You can Print the layout history or Save it as a PDF.

The Layout History may also be cleared:
· Select Clear Layout History at the bottom of the Layout History Viewer

dialog (Figure 17.2 Step 1).
· Enter a Note and press OK (Figure Below, Step 2) in the Clear Layout

History dialog.
·  The Layout History will be cleared and a single action referring to the clearance

will be listed in it (Figure Below, Step 3).

Figure 17.2 Layout History can be cleared via the Clear Layout History button.
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18 Security

FCS Express has a comprehensive security system that allows you to restrict
access to various functions to particular users via the security add-on for
network licenses or via internet dongle licenses and site licenses. Security
systems are used for Internet Dongle and Site licenses  to administrate users. 
 Network Licenses can use the security add-on for helping to ensure the integrity
of your data analysis and to conform with certain government regulations such
as 21 CFR Part 11. FCS Express offers multiple layers of security, described in
the remaining sections of this chapter. 

Security settings such as password limits, mail notifications and online
registration (internet dongle and site licenses) are maintained through the
Security Configuration  dialog. 

With any license in which security is enabled reports may be generated, viewed
and saved.

Additionally, LDAP and Single Sign-on  can be configured for licenses with
security enabled. 

18.1 Security Package for Network Licenses

Network Licenses can use the security add-on for helping to ensure the integrity
of your data analysis and to conform with certain government regulations such
as 21 CFR Part 11. FCS Express offers multiple layers of security at the User
and Layout  levels. The following chapter details all features and options
relevant for Network License Security and associated Databases . 

18.1.1 User-Based Security

The first level of security is based on restricting functionality based on a particular
user. When security is activated, each user must log in to FCS Express with a
user name and password (Figure 18.1).
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Figure 18.1  Security Login

Users are created and managed  from the Security
command within FCS Express (Figure 18.2). 
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Figure 18.2  Security Gallery

Each user is also assigned to a User Security Group  and can only
performfunctions that are allowed by that group . Hence, if Group A does not
allow its members to print layouts, then any user who is a member of Group A
will not be allowed to print layouts.

18.1.2 Layout-Based Security

The second level of security is based on restricting functionality for particular
layouts. Every layout has a Layout Security Group  assigned to it. Only the
functions allowed by the Layout Security Group  can be performed on that
layout. These functions are identical to the ones that can be assigned to a User
Security Group . For example, if the layout security was set to a Layout
Security Group that did not allow printing, then any user (regardless of their User
Security Group permissions) would not be able to print that layout.

In addition to having security permissions for each action  on the layout, a
password can be specified for the layout. You will not be able to open the layout
without entering the password. The password is stored in an encrypted format. If
the password is lost, the only way to open the layout is to send it to De Novo
Software.

1512

1520

1518

1518

1512

1520



Security 1503

© 2023 De Novo Software

18.1.3 Working with User-Based Security

FCS Express comes with one default user, the Administrator. The default Login
name for the Administrator is admin. The default Password for the Administrator
is password. 

Note: This password should be changed immediately after using FCS Express the
first time.

Changing a user’s password is described in Editing a User . The Administrator is
part of the Administrator Security Group. For more information on Security
Groups, see Working with Security Groups . By definition, the Administrator
Security Group can perform every action and cannot be deleted.

Users may be sorted by Name or Last Name by clicking on the Up or Down
arrows in the column headers. 

To manage users, use the File tab Security User Administration command.
This will bring up the User Administration dialog (Figure 18.3). Users are listed in
alphabetical order by last name.

Figure 18.3  User Administration Dialog
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Clicking on the Show Active Logins button will bring up the Active Logins
dialog (Figure 18.4) which will display all of the currently active users. To logout a
user, highlight the user and press the Logout button.

Figure 18.4  Active Logins Dialog

Note: If a user is logged out while they are currently using the software, all
functionality will be disabled and they will only be able to Save or Exit.

Please see the Internet Dongle and Site License Knowledgebase page for more
information on working with user-based security for these license types.

18.1.3.1 Creating a User

To create a new user:

1.  Use the File tab Security User Administration command.
2.  Click on the Add button in the User Administration dialog (Figure 18.5).

http://www.denovosoftware.com/full-access/knowledge-base/#InternetDongle
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Figure 18.5 The Add button in the User
Administration dialog.

The Edit User Information dialog will appear (Figure 18.6).
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Figure 18.6 Edit User Information Dialog

All of the fields except for Employee ID and Lab Name are mandatory. The
Login Name field must be unique (no two users in FCS Express can have the
same Login Name).  The Lab Name field allow to assign the user to a specific
lab. Previously inserted Lab Names will be available in the Lab Name drop down
menu. The Lab Name is used to organize users in the Billing Report .
 

The Allow Log In check box determines whether that user can log in. The Allow
self-logout check box determines if a user can log themselves out from a

1578
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remote location. The Require password change during next login check box
will prompt the user to change his or her password during the next login.

At least one option must be selected in the Groups box for the user.
Customers who hold the Security add-on, can manage Security Groups via the
Security Group Definitions tools (see Working with Security Groups) . 

The user may be restricted to defined MAC address(es) as well.  Clicking Include
this machine button will populate the Restrict to MAC Addresses (one per
line): box with the MAC address from the computer used to create the user
(Figure 18.7).

  

Figure 18.7 Restrict User to Defined MAC Address(es) in User
Information Dialog
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Multiple user can be automatically added to the database via the Add from CSV
button. The CSV file can be either a comma-delimited or a semicolon-delimited
file and has to contain the following columns:

Column Header Specific requirements Example

LoginName None JohnSmith

Password None password123

FirstName None John

LastName None Smith

Email None John.Smith@DNS.com

EmployeeID None 123456

LabName None Flow Lab

CanLogin Enter: T or F or True or
False

True

CanLogMyselfOut Enter: T or F or True or
False

F

ForcePasswordExpire
d

Enter: T or F or True or
False

T

SecurityGroups For internet dongle user
types:
Administrator,
Standard User or User
Administrator (see
above for additional
details).
User group names can be
inserted as comma-
delimited list. For
comma-delimited CSV
files, said list has to be
surrounded by quotes.
If a group name include
comma in it, that name
has to be included in
double quotes for both
comma-delimited and
semicolon-delimited CSV
files.

Note: If MS Excel is used
to edit the CSV files, user
group names can be
simply listed as comma-
delimited list with a single

Standard User

or

Comma delimited:
"Group 1, Group 2, Group 3"
                 or
"Group 1, ""Group,2"", Group
3"

Semicolon-delimited CSV file:
Group 1, Group 2, Group 3
                  or
Group 1, ""Group, 2"", Group 3
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quote character around
any group names that
have commas in them.

RestrictToMACAddres
ses

N/A N/A

Example of .CSV import in Excel below. A template for the .CSV file import may
also be downloaded for use. 

18.1.3.2 Editing a User

To edit an existing user:

1.  Use the File tab  command.
2.  Either double-click on the user, or select the user and click on the Edit

button in the User Administration dialog.
3.  Edit the information and Click OK.

The currently logged in user can change their own password by selecting the File
tab System Edit Information for Current User command. The Edit User
Information dialog will appear, but only the password field will be enabled
(Figure 18.8).

Please note that for the User to be able to change their password, the User must
have the permission for Security Options Current User Operations enabled
for the User Group to which they belong.

https://fcsexpressdownloads.s3.amazonaws.com/SiteLicenseImportTemplate.csv
https://fcsexpressdownloads.s3.amazonaws.com/SiteLicenseImportTemplate.csv
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Figure 18.8  Change Current User Password

18.1.3.3 Deleting a User

To delete a user:

1.  Use the File tab Security User Administration command.
2.  Select one or multiple users, and click on the Remove button in the User

Administration dialog (Figure 18.9).
3.  A message will ask for confirmation for the deletion. Click Yes to confirm

or No to avoid deleting the selected user(s). 

FCS Express will not allow you to delete the last administrator who can log in.
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Note: You cannot undelete a user, so please use this feature with caution.

Figure 18.9 Removing a Security User

18.1.3.4 Exporting User List

To export a list of users:

1.  Use the File tab Security User Administration command.
2.  Click on the Export All to CSV button in the User Administration dialog

(Figure 18.10).
3.  A Save As dialog will appear. Choose the directory and enter a File name

to save the comma-delimited file. 
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Figure 18.10  Exporting a User List

The user list can be opened with Microsoft Excel (Figure 18.11), Notepad, and
other word processing programs.

Figure 18.11  Exported User List View in Microsoft Excel

18.1.4 Working with Security Groups

Every action in FCS Express has a corresponding Permission. Security Groups
contain lists of Permissions that are allowed to be performed. The Permissions
are grouped in logical categories, as shown in Figure 18.12.
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Figure 18.12  Security Group Definition Dialog

You can choose to include all checked permissions, or, if you only want to
exclude a few permissions, include all permissions except those checked in the
list. Once a Security Group is created, a user may be assigned to it . The user
will only be allowed to perform the actions for which they have permission from
the security group(s).

FCS Express comes with the Administrator group, which permits all actions and
cannot be deleted.

1509
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The following example illustrates how permissions behave when a user logs in:

A user is assigned to a Group which can perform all actions, except for
viewing the security group list. The user logs in to FCS Express. They are able
to load a layout, and make changes to it. However, when the user attempts
to change the security group list, they will see the message shown in Figure
18.13. This notifies the user that they are unable to perform the action.

Figure 18.13  Operation Not Allowed

18.1.4.1 Creating a User Security Group

To create a new Security Group, use the File tab Security Security Group
Definitions command. The Security Group Definitions dialog will appear
(Figure 18.14).

Figure 18.14  Security Group Definitions Dialog
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The security groups are listed in alphabetical order. Click on the Add button to
create a new group and bring up the Security Group Definition dialog (Figure
18.15).

Figure 18.15  Adding a New Security Group

Assign a Name and optional Description to the Group. To select all permissions
associated within a category, click on the check box next to the title. To view all
associated permissions within a category, click on the triangle next to the check
box. To select an individual permission, check the check box to the left of the
permission. Using the radio buttons, you can choose to either include all checked
permissions, or include all permissions except those that are checked. When you
are finished defining the group permissions, click OK.
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To view a list of Available Security Group Permissions in FCS Express, click
here .

18.1.4.2 Editing a Security Group

To edit a Security Group, use the File tab Security Security Group
Definitions command, and either double-click on the group, or select the group
and click the Modify button. That will bring up the Security Group Definition
dialog , where you can then modify the groups permissions.

Permissions are only applied when the user logs in. If a user’s permissions
change while they are logged in, the new permissions will only be effective after
the user logs out and in again. 

Please note that the Administrator security group can not be modified.

18.1.4.3 Duplicating a Security Group

Duplicating a group allows you to easily create similar Security Groups. To
duplicate a group, use the File tab Security Security Group Definitions
command. Select the group to be copied, and click the Duplicate button. A new
group will be created which has the same name as the original group, but with
the "(copy)" added to it.

You then can select the new group, click the Modify button, rename it, describe
it, and set the exact permissions you need. 

18.1.4.4 Deleting a Security Group

To delete a group, use the File tab Security Security Group Definitions
command. Select the group to be deleted and click the Remove button.

FCS Express will not delete a group which still has users assigned to it. Once all
users who are assigned to this Security Group are assigned to another group,
FCS Express will allow the group to be deleted.

18.1.4.5 Loading and Saving Security Group and Layout Status

Security Permissions, Groups, and Layout Status Definitions may be saved to a
.txt file for quick access and loading or saved as a convenient text report.

To save security Permissions, Groups, or Layout Status Definitions to a file or
report:

1.  Choose the File tab Security.
2.  Choose Security Group Definitions (Figure below left) or Layout Status

Definitions (Figure below, right).
3.  Click on Add or Modify.
4.  Click on the Save drop down.
5.  Choose Save Permissions To File, Save Group To File, or Save Group as

Report from the drop down menu.

1520
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6.  Browse to a location to save the file in the Select a file for saving
permissions window.

7.  Enter a file name for the .txt file.
8.  Click Save. 

The text file then will be saved in the location specified. Permissions or Group
Files may be loaded in the following steps listed below  or Group Reports may
be opened for review. Note the permission files created in the steps below may
also be used when creating Permission Rules for the Standard Operating
Procedure features . 

Choosing to Save Security Group Permissions, Groups, and Reports (left)
and Choosing to Save Layout Status Definition Permissions, Groups, and

Reports (right).

To load security Permissions, Groups, or Layout Status Definitions files:

1.  Choose the File tab Security.
2.  Choose Security Group Definitions (Figure below, left) or Layout Status

Definitions (Figure below, right).
3.  Click on Add or Modify.
4.  Click on the Load drop down.
5.  Choose Load Permissions From File or Load Group From File from the

drop down menu.
6.  Browse to the location of the saved file in the Select a file for loading

permissions window. 
7.  Enter a file name for the .txt file.

1517
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8.  Click Open.
9.  Click OK. 

The previously saved security permission or group will now be loaded.

Choosing to Load Security Group Permissions or Groups (left) and
Choosing to Load Layout Status Definition Permissions or Groups (right).

18.1.5 Working with Layout Security Groups

A layout security group behaves in the same way as a user security group .
However, the permissions associated with the layout security group apply to a
particular layout file (as opposed to a user). User based security group
permissions will always take precedence over layout based security permissions.
 Layout security groups are managed in a manner identical to user security
groups.

In order to manage a layout security group, use the File tab Security
Status Definitions command to bring up the Layout Status Definitions dialog
(Figure 18.16).

1512
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Figure 18.16  Layout Status Definitions Dialog

Layout security groups are modified , added , and deleted  in the same
manner as user security groups. Layout security groups may also be saved and
loaded .

In the event that the current layout belongs to a layout security group that
restricts a certain action, but the current user is part of a user security group that
has permission to perform that action, that action will not be allowed. Therefore,
both user permissions and layout permissions must be allowed for a particular
action to be performed.

To associate a layout with a particular security group, use the File
tab Info Layout Options  command (Figure
18.17). The default group is Unrestricted. This means that all actions can be
performed on this layout. To change the group, select a different one from the
list box.

1516 1514 1516
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Figure 18.17  Assigning a Layout to a Security Group

The Layout Options window shows other pertinent information related to the
layout. The file name, the name of the user who created the layout, and the date
it was created is shown. Password protection can be enabled on the layout here,
as well. If password protection is enabled, when the layout file is loaded, the user
will be prompted to enter the password. If the password is not correct, the file
will not open.

18.1.6 Managing the Databases

Regular maintenance of the database is not required. However, in the rare
occurrence that the database becomes corrupt, or is accidentally deleted, there
are tools to help maintain the databases. Please contact De Novo Software at
support@denovosoftware.com prior to performing maintenance to ensure that
this is required in your case.

18.1.7 Available Security Group Permissions

v Application Level operations 

· Login

· Edit preferences

· Restore preferences to default values

· Import user options from file

· Export user options to file
v Layout operations  

· Create New Layout

· Open layout
o Open

· Navigators and Other Dockable Windows
o Run Batch Processing
o Rerun Batch Processing
o Review Batch Processing

mailto:support@denovosoftware.com
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o View Batch Actions
o View Data List
o Format General
o Format Overlays
o Format Axes
o Format Title
o Format Legend
o Format 3D
o Format Specific
o Format Size
o Format Fill
o Format Border/Line
o Format Authorizations
o Format Gate To Display
o Format Data Image
o Format Parameters To Display
o Format Markers
o Format Quadrants
o Format Color Levels
o Format Statistics
o Format Gate View
o Format Selecting Text Boxes
o Format Proliferation Fit
o Format DNA Fit
o Format DNA Background
o Format Position Markers
o Format Regression Fit
o Format Text Box Contents
o Format Spreadsheet Data
o Format 1D Stats
o Format 2D Stats
o View Layout Messages
o View Alerts
o View Custom Tokens
o View Canned Comments
o View Compensations and Unmixing
o View Transformations
o View Run SOP
o View Snapshots
o View Standard Operating Procedures
o View Permission Rules

· Save layout

· Save layout as

· Print layout

· Clear Layout History

· Change Page Setup

· Save layout to PowerPoint
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· Save PDF

· Publish Layout
v Edit operations

· View layout options

· Change layout options

· Insert new page

· Rearrange pages

· Delete page

· View page options

· Change page options

· Align objects

· Change Object Order
v Adjusting and resizing objects

· Move objects

· Resize objects

· Group objects

· Ungroup objects
v View operations

· View the layout history

· View the master page

· Change the number of visible pages

· View hidden pages
v Data file operations

· Open a Data file

· Modify the contents of a data file

· Add a column to a data file

· Delete a column from a data file

· Insert a row into a data file

· Delete a row from a data file

· Export a Data file

· Load data  that is not already loaded

· Create a new spreadsheet

· Export a Spreadsheet

· Add to data list

· Search the data list

· Remove from the data list

· Format the Data List Options

· Move a file Up in the data list

· Move a file Down in the data list

· Increment/decrement file on selected/all objects

· Change file on selected/all objects

· View file header information

· Modify file header information

· View files in memory

· Change the increment value
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v Plots and other objects operations

· Insert stats window

· Insert plots and other objects
o Insert 2D Plots
o Insert Histogram
o Insert Kinetics
o Insert Multicycle DNA
o Insert Proliferation
o Insert Subtraction
o Insert Text Box
o Insert Gate View
o Insert Picture
o Insert Data Grid
o Insert Bar
o Insert Pie
o Insert Box and Whisker
o Insert Scatter
o Insert Plate Heat Map
o Insert Gates Heat Map
o Insert Parameters Heat Map
o Insert Spectrum
o Insert Levey Jennings
o Insert AutoShapes

· Copy Data Grids

· Remove 2D plots

· Remove histograms

· Remove subtraction histograms

· Remove DNA histograms

· Remove Proliferation histograms

· Remove text boxes

· Remove picture

· Remove data

· Remove Gate View

· Remove AutoShape

· Remove stats window

· Change parameters on a histogram

· Change parameters on a 2D plot

· Add overlay to a histogram

· Add overlay to a 2D plot

· Copy Plot Data

· Remove overlay from a histogram

· Remove overlay from a 2D plot

· Reorder overlay in a histogram

· Reorder overlay in a 2D plot

· Edit the text on a text box

· View the format of a 2D plot
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· View the format of a 1D plot

· View the format of an AutoShape

· View the format of a text box

· View the format of a picture

· View the format of a data object

· View the format of a statistics window

· Change the format of a 2D plot

· Change the format of a 1D plot

· Change the format of an AutoShape

· Change the format of a text box

· Change the format of a picture

· Change the format of a data object

· Change the format of a statistics window

· Change the visibility of statistics

· Autosize statistics window

· Delete Table Cells

· Insert Table

· Insert Table Cells
v Gate, marker and quadrant operations

· Create a new gate

· Modify a gate

· Remove a gate

· Modify gate information

· Add a combination gate

· Change Gate Properties

· Create a new marker

· Modify a marker

· Remove a marker

· Gate fellowship Link

· Break Gate fellowship

· Show quadrants

· Hide quadrants

· Modify quadrants

· GatingML Import

· GatingML Export
v Parameter Labels operations

· View parameter label sets

· Modify parameter label sets

· Load a set

· Save the list of sets
v Batch Processing and Alerts operations

· Alerts
o Run alerts
o Add a new alert
o Delete an alert
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o Edit the text in an alert
o Add token to alert formula
o View token properties for the alert formula
o Edit alert formula token properties

· Batch Processing
o Flag an iteration
o View batch processing options
o Change batch processing options
o Add save batch actions

§ Add Save Layout batch action
§ Add Save PDF batch action
§ Add Save Picture batch action
§ Add Save PowerPoint batch action
§ Add Print batch action
§ Add Publish Layout batch action
§ Save Data Files

· Add Save GatingML
o Add batch folders

§ Add Folder
o Add report batch actions

§ add Export To Spreadsheet
§ add Export To Excel (Column Mode)
§ add Export To Excel (Cell Mode)
§ add Word Report
§ add PDF Form
§ add Text Report

o Add items to reports
§ add Regular Token
§ add Statistic Token
§ add Keyword Token
§ add Picture
§ add Text Box
§ add PDF
§ add Layout
§ add PowerPoint
§ add FCS File

o Rename batch actions
o Paste batch actions
o Delete batch actions
o View batch action details
o Change batch action details
o Change batch action Running Options

v Canned Comment operations

· Add a new Canned Comment

· Delete a Canned Comment

· Edit the text in a canned comment

· Add a token to a canned comment
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· View canned comment token properties

· Edit canned comment formula token properties
v Channel Calibration operations

· View Channel Calibration settings

· Add a Channel Calibration

· Delete a Channel Calibration

· Load Channel Calibration settings

· Save Channel Calibration settings

· Modify settings

· Calculate Channel Calibration

· Edit a Channel Calibration
v Compensation operations

· Modify compensation

· Import compensation

· Export compensation

· Create compensation

· Delete compensation

· Create Unmixing

· Delete Unmixing

· Assign compensation

· Run Automatic Compensation

· Apply to all plots

· Apply to selected plots
v Transformation operations

· Create Parameter Math transformation

· Create PCA transformation

· Create Pipeline Transformation

· Create Divide Mean and SD pipeline step

· Create Divide Max and Min pipeline step

· Create Thresholding pipeline step

· Create Scaling pipeline step

· Create Merge to Spectra pipeline step

· Create Python pipeline step

· Create Simple parameter math pipeline step

· Create UMAP pipeline step

· Create Downsampling pipeline step

· Create tSNE pipeline step

· Create MST pipeline step

· Create Graph Plot Layout pipeline step

· Create PCA pipeline step

· Create Parameter Removal pipeline step

· Create Unmixing pipeline step

· Create spectral extraction pipeline step

· Create flowAI pipeline step

· Create flowSOM pipeline step
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· Create SPADE pipeline step

· Create SOM Pipeline step

· Create Batch SOM pipeline step

· Create Consensus pipeline step

· Create Kmeans transformation (NB: this also apply to Kmeans pipeline step)

· Create Hierarchical pipeline step

· Create ramp parameter pipeline step

· Create Bernoulli parameter pipeline step

· Create Beta parameter pipeline step

· Create Binomial parameter pipeline step

· Create Cauchy parameter pipeline step

· Create ChiSquare parameter pipeline step

· Create Erlang parameter pipeline step

· Create Exponent parameter pipeline step

· Create FDistribution parameter pipeline step

· Create Gamma parameter pipeline step

· Create GenPareto parameter pipeline step

· Create Geometric parameter pipeline step

· Create Gumbel parameter pipeline step

· Create HyperGeometric parameter pipeline step

· Create Laplace parameter pipeline step

· Create Logistic parameter pipeline step

· Create LogNormal parameter pipeline step

· Create Maxwell parameter pipeline step

· Create NegBinomial parameter pipeline step

· Create Normal parameter pipeline step

· Create Poisson parameter pipeline step

· Create Rayleigh parameter pipeline step

· Create StudentTDist parameter pipeline step

· Create Triangular parameter pipeline step

· Create Uniform parameter pipeline step

· Create Weibull parameter pipeline step

· Create R Add Parameters  transformation

· Create R Add Clustering  transformation

· Create tSNE transformation

· Create K-Nearest Neighbors parameter pipeline step

· Create Jaccard Similarity pipeline step

· Create SPADE transformation

· Modify transformation

· Load Parameter Math Sequence from file

· Save Parameter Math Sequence to file

· Delete transformation
v Other tools

· Modify Concentration calculator settings

· Concentration calculator calculate
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· Histogram subtraction

· Batch export

· Diva Import

· CFlow Import
v Security Operations

· Current user operations
o View information for the current user
o Change information for the current user

· Security System operations
o View Security System configuration
o Change Security System configuration
o Security System configuration - SMTP

· All user operations
o View information for all users
o Add a user
o Modify a user
o Duplicate a user
o Remove a user
o Can Log Any User Out

· Reports
o All Events
o Billing Information
o user Billing Information
o Failed Logins
o Full Sessions
o Remote Logouts

· Layout Status Definitions
o View Layout Status List
o Add new Layout Status
o View and modify a Layout Status
o Duplicate a Layout Status
o Remove a Layout Status

· Security Group Definitions
o View Security Group List
o Add new Security Group
o View and modify a Security Group
o Duplicate a Security Group
o Remove a Security Group

· Database maintenance operations

· Electronic Signature operations
o View signature list
o Change signature list
o Sign
o Unsign

v Snapshot operations

· Add snapshot
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· Edit snapshot

· Delete snapshot

· Apply snapshot
v SOP operations

· Add SOP Step

· Delete SOP Step

· Edit SOP Step

· Reset SOP Run Status

· Rerun SOP
v Permission Rule operations

· Add Permission Rule

· Delete Permission Rule

· Edit Permission Rule
v Help operations

· View help

· View tutorials

· View manual

· Go to the De Novo Software web site

· Enter countercode

· View About screen
v Panel operations

· View the panel information

· Add a panel

· Edit a panel

· Remove a panel

· Load panels from a file

· Save panels to a file

· Change the panel information

· Change the name of a panel

· Change the number of tubes in a panel
v Token operations

· Custom Tokens
o Add custom token
o Delete custom token
o Add token to custom token formula
o View custom formula token properties
o Edit custom formula token properties
o Edit the text in a custom formula

· Change Font Classification

· Add Font Classification

· Edit Font Classification

· Reorder Font Classification

· Remove Font Classification

· Token Bounds Change

· Add Statistic Classification
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· Edit Statistic Classification

· Reorder Statistic Classification

· Remove Statistic Classification

· Add Keyword

· Remove Keyword

· Add token to a text box

· View text box token properties

· Edit text box token properties
v Formatting Operations

· Bold

· Bullets

· Font

· Font Background

· Font Color

· Font Name

· Font Size

· Gate Formula Change

· Indent Text

· Italics

· Justify Text

· Underline
v Keywords Anonymizer
v Page Tab Operations

· Change Page Tab Color Classification

· Add Page Tab Color Classification

· Edit Page Tab Color Classification

· Reorder Page Tab Color Classification

· Remove Page Tab Color Classification
v Override Authorizations

18.1.8 Security Database Options

If you purchase FCS Express with the Security add-on, you have the choice of
two database options

· Microsoft SQL Server

· Elevate DB Local Server

Click here for more information about compatibility requirements for Microsoft
SQL Server.

We strongly recommend Microsoft SQL Server for your production environment.

Please note that before or after you purchase the security add-on, you must
inform sales@denovosoftware which database option you would like. We can
then customize the configuration file for your license. 

http://www.denovosoftware.com/system-requirements/
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Microsoft SQL Server

Microsoft SQL Server is the most robust database option available for FCS
Express. This option is ideal if your organization already has an SQL Server
installation and has experience with it. It is also ideal if you will be running several
network installations of FCS Express, or many standalone licenses, or any
combination of network and standalone licenses. Each of those installations will
be able to use the same configuration , and share the same security system.
Note that to use FCS Express with SQL Server, you must purchase your own
license for SQL Server.

Elevate DB local server

The Elevate DB local server is a database that does not require a database
server to be installed on any computer. The database files reside in a shared
folder, and each FCS Express client accesses the database files directly. Multiple
instances of FCS Express can access the database at the same time. This is the
simplest option as it requires no extra installation of an additional database
server. It does suffer from performance issues inherent to non-client server
architectures, however, the security databases are quite simple and this may not
have a practical impact in your organization. This option can be provided for free
with purchase of your security system.

Because Elevate DB is not a client-server database, it is critical that you perform
regular backup and restore tests in the event of data corruption. This is one of
the reasons we recommend SQL Server, since it is much less prone to data
corruption. Instructions regarding backing up your databases can be found
here .

18.1.9 Configuring MS SQL Server to host Security Databases

Microsoft SQL Server is one of several database options supported by FCS
Express for hosting your security system. This option is ideal if your organization
already has an SQL Server installation and has experience with it. 

To configure FCS Express to use SQL Server, a text file will need to be created to
define the connection string.  This can be done through the Windows application,
NotePad.
Please follow the procedure below to start the configuration process between
FCS Express and SQL Server.

1.  Create a database in the SQL server instance. This will be the database that
FCS Express will use.  FCS Express does not create a database.  A database
will need to be created prior to use with FCS Express.  This will most likely
need to be coordinated with your DBA team.

1531
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2.  Create a text file containing the connection information to the database. This
text file can either be stored in plain text, or encrypted using the
FCSEDBINIFileEditor.exe application noted below. 
a. If you want to store the database details and login credentials in a plain text

file, create a text file called FCSEDB.ini and start editing it in notepad. 
i. In the first line, type [SecurityMSSQL]
ii. In the second line, type ConnectionString=

1. The connection string itself will be placed immediately following the
equal sign (=).  

2. The format of the connection string can be seen in the samples below.
iii.  On the next line add: Dialect=MSSQL
iv.  On the last line add: Manager=UniDAC

b. If you want to encrypt the database details and login credentials, run the
program FCSEDBIniFileEditor.exe. You will find this program in the same
folder as FCS Express.exe
i. This will create an encrypted INI file that will end in a .CINI extension.  
ii. This file will be password protected.  Please record the password of the

encrypted INI file.  De Novo Software will not be able to recover any
password set for the encrypted INI file.

c. To summarize:
i. if you want to create a plain text file, the INI can be created in NotePad.  
ii. If you need to create an encrypted INI, use FCSEDBIniFileEditor.exe. 

Please note that the encrypted file will have a .CINI extension.
iii. The connection string includes information about the type of connection

to create, the server where the database is located, the name of the
database, and user id / password details.

3. The following samples provide examples for how the connection string can be
written.

· Sample connection string if you will be using an
ADO connection:

Provider=SQLOLEDB.1;Integrated Security=SSPI;Persist Security
Info=False;Initial Catalog=<database>;Data Source=<database
host>\<database instance>

Modify the text above so that it uses your database information.  <Database>
should be replaced with the name of database you created in step #1 above.
<Database host> should be replaced with the IP address or path to your SQL
Server instance. <Database instance> will be the instance on the database
host, and may not be required, depending on your database installation. 

Note that this connection string assumes integrated (ie Windows login) security.
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If you would prefer to set it up with a named SQL user, update the text above so
that it includes the user name and password, and removes the Integrated
Security value. For example, it might look like:

Provider=SQLOLEDB.1;Initial Catalog=<database>;Data
Source=<Database Host>\<Database Instance>;User ID=<user
name>;Password=<password>

· Sample connection string if you will be using an
ODBC connection

Provider=MSDASQL.1;Persist Security Info=False;User ID=<user
name>;Password=<password>;Data Source=<Data Source Name
created with ODBC Manager>;Initial Catalog=<database>

Modify the text above so that it uses your database information.  <User name>
should be replaced with the SQL Server user name, <password> replaced with
the password for the SQL Server login. <Data Source Name created with ODBC
Manager> should be replaced with the ODBC connection name and <database>
should be replaced with the name of the database you created in step #1 above.

4. After you have entered the connection string, save the file. 
a. Select the menu item File->Save in either notepad or the

FCSEDBIniFileEditor. Then navigate to the same folder where your
configuration file is stored, and enter a file name.  

b. If you are using a plain text file, the file name must be FCSEDB.ini. It is
possible The .TXT extension of the text file can be replaced with .INI.

c. If you are using the FCSEDBIniFileEditor, the file name must be FCSEDB.cini.
d. The .INI or .CINI file must be saved in the same installation folder as your

license configuration file.
e. When using FCSEDBIniFileEditor, only the Provider line is needed.

i.  For example, Provider=SQLOLEDB.1;Integrated
Security=SSPI;Persist Security Info=False;Initial
Catalog=<database>;Data Source=<database host>\<database
instance>  or Provider=SQLOLEDB.1;Initial
Catalog=<database>;Data Source=<Database Host>\<Database
Instance>;User ID=<user name>;Password=<password> can be
copied and pasted into the Connection String field, filling in the variables
with the respective values for your institution.

ii. A password will be needed to create the encrypted CINI file.  Please write
down and take note of this password.  De Novo Software will not be
able to recover the password to your encrypted connection string.

Please note:  when creating the connection string in the .INI file, the
"<>" are not needed and should not be included.  They are being used in
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this text to denote a placeholder for a custom value that needs to be
entered by the user or administrator.

When FCS Express starts, it will read the information in the file,  connect to your
database, and automatically create all the required tables and indices.  

At this point, it is extremely important that users have the proper SQL Server
permissions to be able to make the database connection.  

Please refer to the next section for information regarding SQL Server Database
Roles .

18.1.10 MS SQL Server Database User Permissions

The permissions that are applied to users trying to access a SQL Server database
can be critical.

As a guideline, we suggest the following:

1. For regular users, FCS Express will require that the users have
SELECT,UPDATE,INSERT, and DELETE permissions.

a) Since there is not a defined role within SQL Server that contains the
SELECT,UPDATE,INSERT, and DELETE permissions together, regular users
can use both the db_datareader and db_datawriter roles to give those
permissions.

b) db_datareader includes the SELECT permission.
c) db_datawriter includes the UPDATE,INSERT, and DELETE permissions.

2. For admin users that need to perform upgrades, the user will need the full
CONTROL permission on the FCS Express security database. An example of a
role that gives this permission is the db_owner role.

A summary of the various MS SQL Server roles and the permissions that are
defined for those roles can be found on the Microsoft web site at
https://docs.microsoft.com/en-us/previous-versions/sql/sql-server-
2005/ms189612%28v%3dsql.90%29.

18.1.11 Backing up the Databases

We recommend that you perform regular backups of your database, as well as
regular tests where you restore from backups. 

SQL Server
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There are several ways to back up and restore SQL Server databases, and we
do not recommend any particular ones. Please consult your SQL Server
administrator for the best choice for your environment. 

Elevate DB Local Server

Elevate DB Local Server stores data in a set of files located in a subfolder of the
program folder. The subfolder is called ElevateDBData. In order to back it up,
please perform the following steps:

1.  Make sure everyone is logged out of FCS Express, and that the program is
shut down on every computer. 

2.  Copy the folder ElevateDBData to your backup storage location.

To restore, simply copy the backed up folder back to the original location.

18.1.12 Preparing for Database Updates

For certain releases, FCS Express will update the structure of the security
database. After the database is updated, previous releases of FCS Express will no
longer be able to use it. Because of this, we recommend the following:

1. Before installing a version of FCS Express which will update the database,
perform a backup of the existing database. Please see the topic Backing up
the Databases  for details. To determine whether a specific release will
update the database, please check the release notes on the download page. 

2.  If you plan on testing the new FCS Express release before switching to using
it, then perform the following steps

a.  Create a new database for testing, and initialize it with the contents of the
backup from step 1. 

b.  Install the new release to a new folder

c.  Copy the file FCSEdb.ini from your previous installation to the new folder,
and edit it so that it refers to the database you created in step 1. 

d.  Run FCS Express, and perform your testing. The user names and
permissions will be the same as in your original databases. Note that since
you are now using a new database, any changes you make will not be
propagated back to the previous release. 

1534
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3.  Install the new release to the same folder as the previous release, and run. 

18.2 Internet Dongle and Site License Security and User
Management

Internet Dongle licenses and Site Licenses utilize a security system to manage
adding , editing , and removing  users from the system. Additionally, these
license types may also utilize the Security Configuration features to manage
password settings , online registration , and mail notifications .
Administrators may also choose to enable the Online Registration system  for
their license so end users can self register for accounts on your license. 

18.2.1 Editing Security Configurations

Under File tab , users can find the Edit
Security Configuration dialog (Figure 18.18) which is used to manage:

· General (Institution name)

· Password Policies

· SMTP Servers

· E-Mail Notifications

· Online Registration   (Internet dongle and site license customers only)

· LDAP configuration (only available when the LDAP add-on is purchased with

FCS Express)
· System Level Audits  (only available when the logging add-on is purchased

with FCS Express)
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Figure 18.18 Navigating to the Edit Security Configuration dialog

18.2.1.1 Managing Password Configurations

To manage your Password Policies navigate to the File tab Edit
Security Configuration.

The Edit Security Configuration dialog will appear as in Figure 18.19 below.
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Figure 18.19 The Password Policies Dialog

The options for password policies allow you to define:

Password Policy Option Notes

Number of days before users
must change password

A value of 0 (zero) means the user never has
to change their password.

Number of failed login
attempts before user account
is locked

A value of 0 (zero) indicates the account will
never lock upon any number of failed attempts

Prohibiting passwords from
being reused

Checking this option will determine the number
of days before a password may be reused. A
value of 0 (zero) means that the user can
reuse their password at any time.

Idle time in seconds before
user is logged out

A value of 0 (zero) indicates the user will never
be logged out upon software idling

The time between pings to
the database for keeping user
session alive

Determines how often an FCS Express session
communicates back to the server that it is still
active. When a new user logs in, the software
checks for any sessions that have not
communicated back within this period and
cancels that session. Smaller values indicate
that a session can be reused more quickly in
the event of an unexpected program halt (such
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as a power failure or crash). The maximum
value is 300 seconds.

Password policies also allows to define password complexity requirements:
§ Number of Required Uppercase Characters
§ Number of Required Lowercase Characters
§ Number of Required Numeric Characters
§ Number of Required Special Characters
§ Minimum Password Length
§ Disallow Username in Password

Once your Password Policies are defined click OK to apply them or continue to
setup the SMTP Server  or Mail Notifications .

Note: In previous releases FCS Express used an XML file to manage password
configurations. Upon updating and running the latest release of FCS Express for
the first time the values from your XML file will automatically be imported and
the original XML file will then be ignored.

18.2.1.2 Mail Notifications

The Mail Notification dialog (Figure 18.20) can be accessed through the File
tab Edit Security Configuration .

Mail Notifications allow notifications to be sent to a specific email address when
certain events happen within FCS Express. A list of available notifications can be
found in the table below.

1541 1539
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Figure 18.20 Mail Notifications Dialog

To setup a mail notification:

1. Configure your SMTP Server .
2. Check boxes for each notification trigger you would like to be notified about.
3. Enter the email address to receive the notification in the Email to Notify box.
4. Click on Send Test Mail to confirm your selection.
5. Click OK.

When a notification is triggered you will receive an email at the specified email
address.

Available Notifications:

Mail Notification Notes

FCSE session started Notification when the software is started

Invalid Username Notification when an invalid User Name is
entered

Invalid Password Notification when an invalid Password is
entered 

1541
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Too many users Notification when a user tries to log in and there
were too many other users already logged in

Too many users in the same
account

Notification when a user tries to log in and there
are too many users are logged into the same
account

User account is disabled Notification if a user account is disabled because
of too many invalid login attempts

Too many failed login
attempts

Notification if the number of failed login
attempts allowed is exceeded

Password expired Notification if a password is determined to be
expired

Successful Login Notification of a successful login

Unexpected Logout Notification of an unexpected logout. This
occurs if the program shuts down unexpectedly
and the sessions times out.

Remote Logout Notification if a user is logged out remotely by
another user

Logout Notification of a regular logout

FCSE session ended Notification if FCSE session is ended

FCSE session left open Notification if FCSE session is left open

Event message notification
sent

Confirmation notification of message sent

Event message notification
failed to deliver

Notification when a message fails to deliver

User was logged out by idle
timeout

Notification if user was automatically logged out
by idle timeout

18.2.1.3 SMTP Server

The SMTP Server dialog (Figure 18.21) can be accessed through the File
tab Edit Security Configuration .

Enter the SMTP Server information for your preferred email provider in this
category to allow Mail Notifications  to be sent out.1539
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Figure 18.21 The SMTP Server Dialog

18.2.1.4 Online Registration

The Online Registration dialog (Figure 18.22) can be accessed through the File
tab Edit Security Configuration .

The Online Registration dialog will only be available to you if you are an FCS
Express Internet Dongle or Site License customer and have Administrator
privileges assigned  to your user in FCS Express. 

Online registration will allow you to set up a web link and signup code customized
to your institutions needs for allowing FCS Express end user registration.
Registration can be set up to allow users to register with or without approval.
Multiple levels of approval may be assigned and custom registration email
messages may be created directly within FCS Express. 

1504
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Figure 18.22 - The Online Registration dialog in FCS Express is available to site
license adminstrators. 

To enable Online Registration for your users:

1.  Click on the General category in the Edit Security Configuration dialog. 
2.  Enter the name of your institution. The name entered here will appear to end

users when accessing a your site license configuration file through the wizard
as in the image below where "Your Institution Name Here" was entered
(Figure 18.23). 
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Figure 18.23 - The institution name showing in the configuration wizard dialog. 

 
3.  Check the box for Allow new users to be registered through the De

Novo Software website. 
4.  You may also enter a unique Signup Code which will allow users to self

register via their De Novo Software account in the Register for Site License
section.  

5.  Click on or copy the web address provided to access the web page (please
note it will not be active until you click OK in the next step). 

6.  Click OK to save your changes. 

The web link provided is unique to your license. You can distribute the web link to
any prospective users of FCS Express to allow them to register as an end user of
your license. Users must have a De Novo Software account to access the site
license. For users that do not yet have an account please have them register at
https://.denovosoftware.com/register/ . Alternatively, users that already have a
De Novo Software account maybe sent to
https://denovosoftware.com/RegisterForSiteLicense and asked to enter the
unique signup code. 

There are a number of customizations including access controls and custom
messages that are outlined in the table below. 

All emails sent to users, approvers, and admins will originate from
denovosoftware@denovosoftware.com. Please ensure your institution and users
can receive messages from that email address. The inbox for
denovosoftware@denovosoftware.com is not monitored, please do not reply
directly to this email address but use support@denovosoftware.com. 

Option Action when checked

Allow new users to be registered
through the De Novo Software

Makes a website active that is unique to
and associated with your license so end

https://denovosoftware.com/myaccount/
https://.denovosoftware.com/register/
https://denovosoftware.com/RegisterForSiteLicense
mailto:support@denovosoftware.com
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website users can self-register. The link provided in
the dialog may be provided to end users to
self register.

Signup Code A customizable code that may be
distributed to potential site license users to
enter in their De Novo Software
account>Register for Site License section.

New users must be confirmed by an
approver

When new users register a field will be
present on the registration form for
"Approval email address". The email
address associated with the approval email
address field will be sent an email message
to approve the user via a web link. If
Require administrator confirmation (below)
is not checked, the end user will be
approved immediately. If Require
administrator confirmation is checked, a
subsequent approval request will be send to
the license admin email. 

Require administrator confirmation When checked the email address entered in
the Admin email field will be sent an email
message to approve the user via a web
link.  

Website Registration Form and Customizations

When users click on the unique registration URL they will be directed to the De
Novo Software website and be prompted to login with their De Novo Software
account credentials and then be directed to the Register for a Site License
form (Figure 18.24). The unique signup code used will automatically be filled in
the site license code field and users should click on Register to register for their
site license account.  Alternatively, if users already have a De Novo Software
account you may ask them to visit
https://denovosoftware.com/RegisterForSiteLicense and enter the unique signup
code manually. 

https://denovosoftware.com/myaccount/
https://denovosoftware.com/myaccount/
https://denovosoftware.com/RegisterForSiteLicense
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 Figure 18.24 - The online site license registration form. 

Note that the Email Address of the Approver* field (Figure above) will be
displayed only when choosing the option for "New users must be confirmed
by an approver" in the Online Registration options. The Approval email address
should be the email address of the person who will be providing approval of the
user. If only "New users must be confirmed by an approver" is checked, they
will be the final level of approval for user creation. If "Require administrator
confirmation" is also checked then the Approval email address will first be
messaged for approval before sending a subsequent message to the Admin
email for final approval. 

Custom Registration Messages
Custom registration messages can be defined for the web form and emails sent
at various points in the registration process. Custom registration messages may
be set by clicking on the -- Custom registration messages -- drop down as
seen in figure 18.25 below. 

· The Open button will allow you to import a message as a text file.

· The Save As button will allow you to save a message as a text file. 

· The Insert Field drop down will allow you to automatically populate the

message via a field from the User's information entered in the form (figure
below-right). For instance, if users have questions regarding their account you
might consider including the Administrator email address in the User registration
complete message. Or if an approver needs to easily access the Lab name or
requesting users email address it may be included in the Approver and
Administrator confirmation emails.
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18.25 - The custom registration message
dialog. 

Custom
Registratio
n Message

Option

Dialog box and text in FCS Express Form on custom web
page or email

delivered to end user
/ approver / admin

approver

Initial
registration
instructions

Site License Self
Registration form will
contain the entered
text. 

User email
verification

Email sent to
user/approver
(yellow indicates
location of custom
text)
First Name Last Name,

Thank you for
registering for an FCS
Express account at
Your Institution Name
Here. Please verify
you email address.

Please confirm your email
address by clicking this link: 

Approver
confirmatio
n email

Email sent to
user/approver
(yellow indicates
location of custom
text)
First Name Last Name
wants to register a
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Custom
Registratio
n Message

Option

Dialog box and text in FCS Express Form on custom web
page or email

delivered to end user
/ approver / admin

approver

new FCS Express
account, with you as
their reference.

Account name: CellDye
Email address: email
address here  Billing
code: 

Enter text for your
Approver confirmation
email.

To approve this
registration, please
click this link: 

Administrat
or
confirmatio
n email

Email sent to
user/approver
(yellow indicates
location of custom
text)
First Name Last Name
wants to register a
new FCS Express
account.

Account name: CellDye
Email address: email
address here  Billing
code: 
Approved by: email
address here 
Enter text for your
Administrator
confirmation email.

To approve this
registration, please
click this link: 

User
registration
complete

Email sent to
user/approver
(yellow indicates
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Custom
Registratio
n Message

Option

Dialog box and text in FCS Express Form on custom web
page or email

delivered to end user
/ approver / admin

approver

location of custom
text)
First Name Last Name,

Your FCS Express
account "CellDye" is
now active. You can
log in at any time with
the password you
created during
registration.

Enter your text for
completion of the
registration process.

18.2.1.5 LDAP and Single Sign On

Lightweight Directory Access Protocol (LDAP) (also known as Active Directory or
Directory Server) with Single Sign On capability is currently available in FCS
Express. To request access and pricing for LDAP integration please contact
support@denovosoftware.com. LDAP in FCS Express is only supported for
Simple Bind configurations. 

The LDAP dialog (Figure 18.26) can be accessed through the File
tab Edit Security Configuration tab.

If you are attempting to edit the security configuration for LDAP you must be
connected to the LDAP server. 

mailto:support@denovosoftware.com
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Figure 18.26 The LDAP Dialog

LDAP Authentication may be configured via the LDAP dialog via the
options listed in the dialog and as follows:

· When the check box for Enable LDAP Authentication is checked FCS Express

will attempt to auto fill the LDAP Default Domain and Distinguished Name
Root. If a different LDAP Default Domain and Distinguished Name Root are
required you may enter them manually. 

· The LDAP Hostname must be entered by the end user setting up LDAP.

· The Autodetect button (below) will attempt to automatically determine the

LDAP Hostname, LDAP Default Domain, and Distinguished Name Root.
The Autodetect button will work for most simple LDAP setups but manually
entry may still be required for more complex systems. 

 
· When the Auto-Detect check boxes to the right of LDAP Hostname, LDAP

Default Domain, and Distinguished Name Root options are checked, the
fields will become greyed out. FCS Express will attempt to auto-detect the
correct settings from your currently connected LDAP environment rather than
using values entered in the fields. The use of the Auto-Detect check boxes is
particularly useful in environments where settings are complex or variable.

Note: The Auto-Detect check boxes make use of the LDAP system and
environment variables of the local computer running FCS Express. When using
auto-detection, administrators of the system and environment should ensure
that the local computer systems and group policies have been appropriately
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configured to prevent local users from changing system settings associated with
LDAP. 

· The Enable Single Sign On check box will control if Single Sign On should be

used by FCS Express when opening the software. 

§ If Enable Single Sign On is unchecked, then the user will be prompted
via a log in dialog to enter their credentials.  

o The user name may be entered as the domain user name or with the

domain plus user name. For instance, JQFlow or
FlowCytometry\JQFlow where JQFlow is the user name and the domain
is FlowCytometry. 

§ If Enable Single Sign On is checked, and the end user of FCS Express is
assigned as a user of FCS Express, the end user will not be prompted to log
into FCS Express as long as they are already signed on to the system. 

o If a user would like to force a sign in prompt, for instance, to switch to a

different domain user to access FCS Express, you may hold down the
Control, or Alt, or Shift key immediately after running FCS Express
until the log in dialog appears. 

 
o Users may also force a sign in prompt if they switch to another user by

logging out of FCS Express. To logout, click on the Logged in as: drop
down in the bottom bar of FCS Express (Figure 18.27) or from the File
tab System Current User Logout Current User.



FCS Express 7 Manual1552

© 2023 De Novo Software

Figure 18.27 Logging out via the logout current user drop
down in the bottom bar of FCS Express. 

See the next chapter for Creating and Administering LDAP Users .

18.2.1.5.1  Creating and Administering LDAP Users

FCS Express users may be added from the LDAP server from the File
tab User Administration  button (Figure 18.28). 
Users added via LDAP may utilize all of the security group  and electronic
signature  features available in FCS Express.  

1552

1512

1478



Security 1553

© 2023 De Novo Software

Figure 18.28 The User Administration Dialog with Add from
LDAP highlighted. 

Click on the Add from LDAP button to launch the Select Users dialog (Figure
18.29).
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Figure 18.29 The Select Users dialog for LDAP user selection in FCS Express. 

The Select Users dialog will all you to add users by entering the user names in
the Enter the object names to select (examples): field. 
The field is searchable by clicking on the Check Names button after entering
text. For instance, if a user on the system existed as joeflow@cytometry.com
you could simply type Joe and click Check Names to find the user. If multiple
users appeared in the search a Multiple Names Found dialog will appear
allowing you to select one or multiple users. 

If multiple users need to be added to the system at the same time you may
separate user names or search terms with a semi-colon. For instance, Joe;Jane
will search for any users in the system by those names. If users are found, the
full user name will appear separated by a semi colon in the dialog. If multiple
users are selected in the Multiple Names Found dialog they will appear in the
Enter the object names to select (examples): dialog separated by a semi-
colon. 

An Advanced user selection dialog (Figure 18.30) may be launched by clicking on
the Advanced... button which will allow you to use additional tools to search for
and select users. 
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Figure 18.30 The advanced Select Users dialog. 

Once a user is selected and added all fields except Employee ID and Lab Name
will be grayed out since they are being populated by LDAP (Figure 18.31). If a
change is made to the user via LDAP, for instance, the password has changed,
FCS Express will only update after the user logs out and logs back into FCS
Express. 
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Please note that Permissions and Groups for each user added to FCS Express
via LDAP must be updated manually when adding a single user, or by selecting
the user from the User Administration User List and clicking on the Edit
button when adding multiple users. 

Figure 18.31 The Edit User Information dialog after a single user has been added
via LDAP. 
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Notes:
1. Please note that if you receive a message like the one below when attempting

to add users via the LDAP tools "The program cannot open the required
dialog box because no locations can be found. Close this message, and
try again" it means that FCS Express cannot connect to the Domain Name
Server (DNS). If you receive this message please ensure you computer is
connected to the DNS and attempt to add a user again. If you cannot resolve
the connection issue please contact support@denovosoftware.com for
additional assistance. 

2. FCS Express requires the following LDAP user fields to be filled out in order to
create an LDAP user. If you receive an error message from FCS Express when
trying to add an LDAP user that indicates there is no first name, last name, or
email field for the LDAP user, you must contact your IT department to add at
least the minimum set of user fields to the LDAP user. 

OBJECTGUID
MAIL
GIVENNAME
SN

18.2.1.6 System Level Audits

System Level Audits  allows users to track system level actions to an audit
trail for further improving compliance with regulatory requirements such as 21
CFR Part 11.

The System Levels Audits feature is only available when the Logging/Audit Trail
add-on has been purchased/enabled.

To enable System Level Audits, go to File tab Edit Security
Configuration  and check the Enable System Level
Audits check box (Figure 18.32).

1576

mailto:support@denovosoftware.com
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When Enable System Level Audits is checked, a second check box, named
Require a Reason for Change, will be available. When the Require a Reason
for Change check box is activated, the user will be prompted to insert a reason
for change to justify that specific action when a system level event is changed.
For more information on System Level Audits, for a full list of audited actions,
and a full list of actions that can be set to require a reason for change, please
refer to the All System Level Audits Report  chapter.

Figure 18.32 The System Level Audits Dialog

18.2.2 Internet Dongle and Site License Access and Security

The first level of license security is based on restricting functionality for a
particular user. When an internet dongle or site license is used, each user must
log into FCS Express with a user name and password (Figure 18.33), which will
be the email address and password created when registering for a De Novo
Software account at https://www.denovosoftware.com/register/.

1576

https://www.denovosoftware.com/register/
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Figure 18.33  Security Login

Users may be created and managed from the File tab Security
Administration command within FCS Express (Figure 18.34). 
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Figure 18.34  Security Gallery

Each user is also assigned to a User Security Group  of:

o Administrator: User assigned to this group will be able to use the software

to analyze data, to add, edit and delete users, to view Security Reports
and to edit the Security Configuration . 

o Standard user:User assigned to this group will only be able to analyze data.

o User Administrator: User assigned to this group will only be able to to add,

edit and delete users, to view Security Reports  and to edit the Security
Configuration .

18.2.3 User Administration

FCS Express uses your De Novo Software account credentials, email address
and password, when logging into the software. 

Please note, by default, another administrator account is created with your
license, DeNovo Administrator, to assist with administration and gather usage
information for billing purposes. This is the service login for a De Novo Software
representative.  Do not remove this login.  

1565
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Users can be added to an FCS Express internet dongle license in different ways:

· Manually, by following the instructions found here.

· Through Online Registration.  Instructions to set up Online Registration

can be found here.
o Online Registration can be useful if you have a large number of

prospective users that need to be added to a license.
o Online Registration will allow you to create a web link through which users

can register for a seat on your license through their De Novo Software
account.

o For security, the online registration can be set up so that each user needs

to be approved by a license administrator before they can start using the
license.

· Through the online De Novo Software account for the registered end-user

for a license at https://denovosoftware.com/myaccount/.
o In My Account, the license administrator can select the Manage Site

Licenses and Internet Dongles section.
o Within this section, users can be added by:

§ selecting the license,
§ clicking Add,
§ entering the De Novo Software account for the user being added,
§ clicking OK to complete the process.

Changing a user’s password is described in Editing a User . By definition, the
Administrator can perform every action and cannot be deleted.

Users may be sorted by Name or Last Name by clicking on the Up or Down
arrows in the column headers. 

To manage users, use the File tab Security User Administration command.
This will bring up the User Administration dialog (Figure 18.35).

1567

https://fcsexpressdownloads.s3.amazonaws.com/manual/manual_WIN_RUO/index.html?creating_a_user_2.htm
https://fcsexpressdownloads.s3.amazonaws.com/manual/manual_WIN_RUO/index.html?online_registration.htm
https://denovosoftware.com/myaccount/
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Figure 18.35  User Administration Dialog

Clicking on the Show Active Logins button will bring up the Active Logins
dialog (Figure 18.36) which will display all of the currently active users. To logout
a user, highlight the user and press the Logout button.

Figure 18.36  Active Logins Dialog
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Note: If a user is logged out while using the software, all functionality will be
disabled, except the ability to Save or Exit.

Please see the Internet Dongle and Site License Knowledgebase FAQ for more
information on working with user-based security for these license types.

18.2.3.1 Creating an Internet Dongle or Site License User

Before proceeding with the instructions below, please note that each user must
first create a free account on the De Novo Software website with their email
address (https://denovosoftware.com/register/).

To create a new user:

1.  Use the File tab Security User Administration command.
2.  Click on the Add button in the User Administration dialog (Figure

18.37).

Figure 18.37 The Add button in the User
Administration dialog.

The Edit User Information dialog will appear (Figure 18.38).

https://support.denovosoftware.com/
https://denovosoftware.com/register/)
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Figure 18.38  Edit User Information Dialog

The Denovosoftware.com User Account field must be an email address
associated with a valid account at https://www.denovosoftware.com.  The First
Name, Last Name, and Email fields will be populated based on the information
provided for the De Novo Software website account.  The Employee ID and
Lab Name fields are optional. Previously added Lab Names will be available in the
Lab Name drop down menu. The Lab Name is used to organize users in the
Billing Report .
 
The Allow Log In checkbox determines whether that user can log in. The Allow
self-logout checkbox determines if a user can log themselves out remotely.

At least one option must be selected in the Groups box for the user. Internet
Dongle and Site License customers have the ability to assign the user to one of
the following pre-defined user groups:

1578

http://www.denovosoftware.com
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o Administrator: User assigned to this group will be able to use the software

to analyze data, to add, edit and delete users, to view Security Reports
and to edit the Security Configuration . 

o Standard user:User assigned to this group will only be able to analyze data.

o User Administrator: User assigned to this group will only be able to add,

edit and delete users, to view Security Reports  and to edit the Security
Configuration .

The user may be restricted to defined MAC address(es) as well.  Clicking Include
this machine button will populate the Restrict to MAC Addresses (one per
line): box with the MAC address from the computer used to create the user
(Figure 18.39).

The Register Online Account button will direct the person to
https://www.denovosoftware.com/register/ to create a new user account,
which will be associated with the license.

Figure 18.39 Restrict User to Defined MAC Address(es) in User
Information Dialog

1570
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Multiple users can be automatically added to the database via the Add from CSV
button (see User Administration dialog, first figure above). The CSV file can be
either a comma-delimited or a semicolon-delimited file and must contain the
following columns:

Column Header Specific requirements Example

LoginName Must be email of valid
account registered at
https://www.denovosoft
ware.com/register/

John.Smith@DNS.com

Password Must use
"denovosoftware.com
user" 

FlowTest123

FirstName Must match first name
used for valid account
registered at
https://www.denovosoft
ware.com/register/

John

LastName Must match last name
used for valid account
registered at
https://www.denovosoft
ware.com/register/

Smith

EmployeeID None 123456

Email Must match email used
for valid account
registered at
https://www.denovosoft
ware.com/register/

John.Smith@DNS.com

LabName None Flow Lab

CanLogin Enter: T or F or True or
False

True

CanLogMyselfOut Enter: T or F or True or
False

F

ForcePasswordExpire
d

Enter: T or F or True or
False

T

SecurityGroups For internet dongle user
types:
Administrator,
Standard User or User
Administrator (see
above for additional
details).

Standard User

or

Comma delimited:
"Group 1, Group 2, Group 3"
                 or
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User group names can be
inserted as comma-
delimited list. For
comma-delimited CSV
files, said list has to be
surrounded by quotes.
If a group name include
comma in it, that name
has to be included in
double quotes for both
comma-delimited and
semicolon-delimited CSV
files.

Note: If MS Excel is used
to edit the CSV files, user
group names can be
simply listed as comma-
delimited list with a single
quote character around
any group names that
have commas in them.

"Group 1, ""Group,2"", Group
3"

Semicolon-delimited CSV file:
Group 1, Group 2, Group 3
                  or
Group 1, ""Group, 2"", Group 3

RestrictToMACAddres
ses

N/A N/A

Example of .CSV import in Excel below. A template for the CSV file import may
be downloaded for use here. 

18.2.3.2 Editing an Internet Dongle or Site License User

To edit an existing user's Employee ID or Lab Name:

1.  Use the File tab  command.
2.  Either double-click on the user, or select the user and click on the Edit

button, in the User Administration dialog.
3.  Edit the information and Click OK.

Users may edit passwords through their respective De Novo Software accounts
at https://www.denovosoftware.com/myaccount/. The Edit User Information
dialog will appear, but only the Employee ID, and Lab Name fields will be
enabled (Figure 18.40).

https://fcsexpressdownloads.s3.amazonaws.com/SiteLicenseImportTemplateV7.csv
https://fcsexpressdownloads.s3.amazonaws.com/SiteLicenseImportTemplateV7.csv
https://www.denovosoftware.com/myaccount/
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Figure 18.40  Edit User Information

18.2.3.3 Deleting an Internet Dongle or Site License User

To delete a user:

1.  Use the File tab Security User Administration command.
2.  Select one or multiple users, and click on the Remove button in the User

Administration dialog (Figure 18.41).
3.  A message will ask for confirmation for the deletion. Click Yes to confirm

or No to avoid deleting the selected user(s). 

FCS Express will not allow you to delete the last administrator who can log in.

Note: You cannot undelete a user, so please use this feature with caution.
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Figure 18.41 Removing a Security User

18.2.3.4 Exporting User List

To export a list of users:

1.  Use the File tab Security User Administration command.
2.  Click on the Export All to CSV button in the User Administration dialog

(Figure 18.42).
3.  A Save As dialog will appear. Choose the directory and enter a File name

to save the comma-delimited file. 
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Figure 18.42  Exporting a User List

The user list can be opened with Microsoft Excel (Figure 18.43), Notepad, and
other word processing programs.

Figure 18.43  Exported User List View in Microsoft Excel

18.3 Security Reports

FCS Express allows you to view and manage reports for user activity. Reports
can be accessed from the File tab gallery (Figure 18.44). 
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Figure 18.44 Navigating to the Security Reports Gallery

Four types of reports are available (click on each link for more details):

· All Events Report  - Lists a history of all logging events 

· Failed Logins Report  - Reports a list of failed logins and the reason for

failure

· Full Sessions Report  -  Reports a list of all full sessions in FCS Express

· All Remote Logouts Report  - Reports a list of all logouts from a remote

location

· All System Level Audit  - Reports of history of events that occur at the

system level.
o This report is typically used to further improve compliance with regulatory

requirements such as 21 CFR Part 11.
o For system level history to be recorded, the Enable System Level Audits

option in the Security Configuration needs to be enabled.
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· Billing Report  - Reports a list of Unique Users that accessed the software

and the corresponding Quarters Billed. Users are grouped based on the Lab
they belong to.  

· User Billing Report  - Reports a list of Unique Users that accessed the

software and the corresponding Quarters Billed. Users are listed independently.

All security reports contain a list of columns that can be arranged  or
grouped  as well as the option to define Filter Criteria  and Refresh the
Report for the new filter (Figure 18.45). You also have the option to export the
report  in the following formats:

· TXT

· HTML

· XML + XSL

· XLS

Figure 18.45 - Example of Security Report dialog.

18.3.1 All Events Report

All Events Report can be accessed from the File tab
Events Report.

Choosing an All Events Report (Figure 18.46) will allow you to see the date
and time of all session actions and user logging event activity.

The report can be arranged, grouped, and filtered  according to your needs.
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Figure 18.46 The All Events Report Dialog

18.3.2 Failed Logins Report

Failed Logins Report can be accessed from the File
tab .

Being able to track failed logins in a requirement of the 21 CFR Part 11.  

Choosing a Failed Logins Report (Figure 18.47) will allow you to view:

· Date and Time of failed login 

· Reason for failure

· User Name when failure occurred

· Login Name when failure occurred 

· Windows User Name when failure occurred

· Computer name on which failure occurred

· IP Address used to access server at time of failure

· First Name of user associated with failure

· Last Name of user associated with failure

The report can be arranged, grouped, and filtered  according to your needs.

1587
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Figure 18.47 The Failed Logins Report Dialog

18.3.3 Full Sessions Report

Full Sessions Report can be accessed from the File
tab .

Choosing a Full Sessions Report (Figure 18.48) will allow you to view:

· Date and Time of Connection 

· Windows User Name during sessions

· Computer name on which session occurred

· IP Address used to access server for session

· Session Login time

· Session Login Name

· First Name of user associated with session

· Last Name of user associated with session

· Logout date and time

· Logout Reason status

· Time of disconnection

· Disconnection reason status

· Session Time (in hours) of each session

The report can be arranged, grouped, and filtered  according to your needs.

Figure 18.48 The Full Session Report Dialog

18.3.4 All Remote Logouts Report

All Remote Logouts Report can be accessed from the File
tab .

1579
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Choosing a All Remote Logouts Report (Figure 18.49) will allow you to view:

· For the User who was logged out

o Logout Time 

o Login Time 

o Login Name of the user

o First Name of user associated with session

o Last Name of user associated with session

o Windows User Name for the session

o Computer Name  for the session

o IP Address used to access server for session

· For the User who requested the logout

o Login Name of the user

o First Name of user associated with session

o Last Name of user associated with session

o Windows User Name for the logout

o Computer Name for the logout

o IP Address used to access server for the logout

The report can be arranged, grouped, and filtered  according to your needs.

Figure 18.49 The Remote Logouts Report Dialog

18.3.5 Report Unique Users

The total number of Unique Users can be viewed in the footer of the Full
Sessions Report (Figure 18.50, red arrow), which is accessible from the File
tab .  Note that filter criteria  may
be used to return the results for a specific date range.

Figure 18.50 Number of Unique Users displayed in footer of Full Sessions report

1579
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By dragging the Login Name column header to the shaded gray area at the top
of the report , the activity per user (by Login Name), can be reported.  This
includes the sum of all hours logged in (SumHours), the number of logins (Qty),
and average length of session (AvgHours) (Figure 18.51).

Figure 18.51 Activity Per User Report

18.3.6 All System Level Audits Report

The All System Levels Audits report allows users to track system level actions
in an audit trail for further improving compliance with regulatory requirements
such as 21 CFR Part 11.

The All System Levels Audit report dialog (Figure 18.52)can be accessed from
the File tab .

Figure 18.52 The All System level Report Dialog

The following information will be listed for each of the tracked actions:

Informa
tion

Description

Date/Ti
me

The date time the event occurred

1581
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Event Short description of the event that occurred

UserNa
me

The FCS Express user name of the user that performed the event

Target Short description of the entity that is being changed:
· If the entity being changed is a layout file, the Target will contain the

filename (with full path as reflected in the user’s computer who is
performing the action) of the layout.

· If the entity being changed is a user, the Target will contain the user

name.
· If the entity being changed is a Security Group Definition  or a

Layout Status Definition , the Target will be the Security Group
Definition name or the Layout Status Definition name.

Details The Details field reports all the additional relevant details for event
before and after a change.
For example:
· If a user is added, the field reports the user information of the new

user
· If a user is edited, the filed reports the old and the new values of the

property that has been edited.
· If a layout is exported, the filed report the filename (with full path as

reflected in the user’s computer who is performing the action) of the
output file.

Reason
for
Change

The Reason for Change field contains the custom comment (reason
for change) entered when the change occurred.
To enable the Reason for Change field, the Reason For Change
option must be activated in the Security Configuration .

The information in presented in the All System Level Audits report in can be
arranged, grouped, and filtered  according to your needs.

Report information may also be directly exported to TXT, HTML, XML+XSL, and
XLS format . 

The following events are tracked by the System Level Audits:
o User management: adding, removing and editing users

o Changes to the following Security Configuration  categories: General,

Password Policies, SMTP Server, Email Notification, LDAP and All System Level
Audits.

o Changes to Layout Status Definitions

o Changes to the Security Group Definitions

o Layout actions: Open, Save, Save As, Close without saving, print, Export to

PDF, Export to PowerPoint

1512
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The following actions, can also be set to require a Reason For Change :
o User management : adding, removing and editing users

o Changes to the following Security Configuration  categories: General,

Password Policies, SMTP Server, Email Notification, LDAP and All System Level
Audits.

o Changes to the Layout Status Definitions

o Changes to the Security Group Definitions

18.3.7 Billing Report

Billing Report can be accessed from the File tab
Report.

Choosing a Billing Report (Figure 18.53) will allow you to see the number of
Unique Users and the total of Quarters Billed for each Lab group.

The report can be arranged, grouped, and filtered  according to your needs.

An example of Billing report is depicted in the figure below. Three unique users
have been created under the Joe Flow group, and another three under the Jane
Cytometry group. Only one unique user from the Joe Flow name group accessed
the software during the quarter, while all three users from the Jane Cytometry
group accessed the software during the quarter. In total four active accessed the
software during the quarter each, thus billing for four quarters would be
assessed. 

Figure 18.53 The Billing Report Dialog
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18.3.8 User Billing Report

The User Billing Report can be accessed from the File
tab .

Choosing a User Billing Report (Figure 18.54) will allow you to see the total of
Quarters Billed for each user.

The report can be arranged, grouped, and filtered  according to your needs.

An example of User Billing Report is depicted in the figure below. The Admin
user, from the "Core Facility" Lab, accessed the software during a single
quarter. Similarly, also the first.las@email.com user, from the "Joe Flow" lab,
accessed the software only for one quarter.

Figure 18.54 The User Billing Report Dialog

18.3.9 Arranging, Grouping, and Filtering Reports

All security reports contain a list of columns that can be arranged  or
grouped  as well as the option to define Filter Criteria  (for a date range) and
Refresh the Report for the new filter.

Please see the following topics for details:
· Arranging Columns

· Grouping Reports

· Filtering on a Date Range
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18.3.9.1 Arranging Columns in Reports

Columns for any report can easily be rearranged.

To rearrange columns:

1. Click on the column header to select it.
2. Click and hold on the column header.
3. Drag the column header to a new location (green arrows will indicate where

the column will be placed) (Figure 18.55).
§ In the example below the column header for Windows User Name was

dragged between IP Address and Login.

Figure 18.55 Dragging a column to a new location.

4.  Drop the column header by releasing the mouse button (Figure 18.56).

Figure 18.56 The report after the column has been moved.
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Date range filtering may also be done on any column, group, or custom filter
using the Filter Criteria  button.

18.3.9.2 Grouping and Filtering Reports

Reports can be arranged into groups based on column headers.

To create a grouped report:

1. Click on a column header to select it.
2. Click and hold on the column header.
3. Drag the column header to the grey area just above the header (green arrows

and the text "Drag a column header here to group by that column" will
indicate where the column header will be placed) (Figure 18.57).
§ In the example below the column header for Connection was dragged to

the grouping area.

Figure 18.57 Dragging a column header into the grouping area

4. Drop the column header by releasing the mouse button (Figure 18.58).

Figure 18.58 A report after being grouped by Connection

Subgrouping of the report is also possible.

1585
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To create subgroups:

1. Click on a column header to select it.
2. Click and hold on the column header.
3. Drag the column header to the grey area just above the header (green arrows

and the text "Drag a column header here to group by that column" will
indicate where the column header will be placed) (Figure 18.59).
§ In the example below the column header for Computer Name and IP

Address were subsequently was dragged to the grouping area.

4. Drop the column header by releasing the mouse button.

The hierarchy of subgroups can also be changed by dragging and dropping a sub-
grouped item before or after another grouped or sub-grouped item.

Figure 18.59 Using the grouping feature to create sub-groups

Grouped items can also be further filtered by clicking on the group or sub-
grouped heading and checking the box for the sub-group classification (Figure
18.60).
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Figure 18.60 Using a check box to further classify a group or sub-group

If the (Custom...) category is chosen (Figure 18.61), you will be prompted with
the Custom Filter dialog. 
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Figure 18.61 Using a custom classification for reports

The Custom Filter dialog (Figure 18.62) allows you to define a custom
classification for your reports grouping. 

Figure 18.62 Choosing a custom classification for reports

Date range filtering may also be done on any column, group, or custom filter
using the Filter Criteria  button.1585
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Filters may also be saved by clicking on the Save As... button (Figure 18.63
below). The Save the active filter to file dialog will appear where you may
save your Filters (*.flt) file to be used again at a later date by clicking Save. 

Figure 18.63 Saving a customized filter.

18.3.9.3 Filtering on a Date Range

All reports can be further classified by using Filter Criteria to choose a date and
time range.

To define the Filter Criteria:

1. Click on the Filter Criteria button.
2. Enter a date and time range in the Time Interval Filter dialog (Figure 18.64).
3. Click OK.
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Figure 18.64 Choosing the date and time Filter Criteria

4. Click on the Refresh Report button to apply the new Filter Criteria to the
report (Figure 18.65).

Figure 18.65 Choosing to refresh the report to the new Filter Criteria

18.3.10 Exporting Reports

 You have the option to export any report in the following formats:

· TXT

· HTML

· XML + XSL
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· XLS

To export a report:

1. Click on the button for the export type you want (Export to HTML in this
examples) (Figure 18.66).

Figure 18.66 Choosing to export the report as an HTML file

2. Choose a location and name for the file on your drive (Figure 18.67).

3. Click Save.

Figure 18.67 The export to HTML file dialog

18.4 Layout and Data Security

To help you fulfill your requirements under 21 CFR Part 11, 11.10(c), FCS
Express provides Record Protection. This is implemented in two forms:
 
1. Your layouts are stored in an encrypted format, and require the correct
encryption key to open. This holds true whether or not any data has been
embedded in the layout. If the layout has been tampered with, or corrupted in
any way, FCS Express will not be able to decrypt it, and will inform you that the
layout cannot be opened.   

Note that we encourage you to retain secure backups of your layouts if the
above situation were to ever occur, so that you would be able to retrieve your
analysis.
 

http://www.denovosoftware.com/full-access/features/cfrpart11/


FCS Express 7 Manual1588

© 2023 De Novo Software

2. When data is loaded in a layout, FCS Express makes a digital signature of the
data, and stores it in the layout. After the analysis is completed, if in the future
someone attempts to open the layout to look at your analysis, then the layout
will only display the data if the digital signature is still the same. In other words, if
the data has changed, the person will not be able to see that data in your
analysis, and all plots will appear blank. This holds true whether the data was
saved embedded in the layout, or is stored separately on disk. 
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19 Proxy Support

By default, FCS Express uses ProxyMode=0 (see below for details about this
setting ). To assign FCS Express to connect to the internet via a proxy or
directly, you may specify this in the InternetSettings.ini file with a Proxy Mode. If
login credentials are required for your proxy, you may specify those credentials in
the InternetSettings.ini file with a Proxy Authentication Mode.
Note: On Mac OS, only ProxyMode=0 and ProxyMode=1 are supported.

Creating the InternetSettings.ini file
· Open Notepad to create a new txt file

· Click File  Save As

· Save the txt file in the same location as FCS Express.exe

o On a PC, this is typically in C:\ProgramFiles\De Novo Software\FCS Express...

o On Mac OS, this is typically in /Applications/FCS Express 7

Research.app/Contents/SharedSupport/fcsexpress7researchbeta/support/FC
SExpress/drive_c/Program Files/De Novo Software/FCS Express 5 Plus Beta
Research Edition

· Name the txt file InternetSettings.ini

· In the first line of the InternetSettings.ini file, type [InternetSettings]

· In the subsequent line(s), type the appropriate expression(s), as described

below

Proxy Modes

1591
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FCS Express supports 6 proxy modes. The ProxyMode is used to specify the
location of your proxy server.

Proxy
Mode

Description Example

ProxyMode
=0

(Automatic
)

Default

FCS Express will
automatically

attempt to handle
failover between
multiple proxies,
different proxy

configurations and
authentication. 

This is the default
setting and will be

used if no
InternetSettings.ini

file is present.

ProxyMode
=1

(Custom)

For this Proxy
Mode, a proxy

server and proxy
bypass should be

included in the
InternetSettings.ini

file using the
following settings:
ProxyServer=<ent

er your proxy
server name here>
ProxyBypass=<ent

er your proxy
bypass here>

ProxyMode
=2

(None)

FCS Express will
bypass any proxies
and try to connect

to the internet
directly.
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ProxyMode
=3

(Automatic
WPAD

Protocol)

If your
organization's

internal network is
configured to use
Web Proxy Auto-

Discovery Protocol
(WPAD) with an
automatically
assigned PAC
(Proxy Auto-

Configuration) file,
you may use this
Proxy Mode. FCS

Express will
attempt to use the

WPAD protocol
using DHCP and

DNS-based auto-
detection. The

proxy configuration
should be in a PAC
file that is provided
either by the DHCP

server or by the
DNS server.

ProxyMode
=4

(Automatic
WPAD

Protocol
using

Internet
Settings)

FCS Express will
attempt to use a
PAC (Proxy Auto-
Configuration) file
as specified in the
WPAD protocol by

looking in the
Windows Internet

Options.
This information
can be set by

going to Windows
Control Panel 
Network and
Internet 

Internet Options,
choosing the

Connections tab,
and then pressing
the LAN settings

button.
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ProxyWPA
D Auto
Proxy

Custom
Address =

<enter
your

custom
PAC file
URL>

When included, the
ProxyWPADAutoPr
oxyCustomAddres
s will override the
ProxyMode setting

and force FCS
Express to use the

provided PAC
(Proxy Auto-

Configuration) file
URL (web address)
as specified in the

WPAD protocol. Do
not include

quotation marks
around the URL.

Proxy Authentication Modes
FCS Express supports 6 proxy authentication modes. The Proxy Authentication
Mode is used to specify how to log into your proxy server. If no proxy server is
used, ProxyWinHttpAuthMode should not be included in the InternetSettings.ini.

Proxy
Mode

Description Example

ProxyWinHt
tpAuthMode

=0
(None)
Default

FCS Express will
connect to the
proxy server

without specifying
any user

credentials. This is
the default setting
and will be used if

no
InternetSettings.in

i file is present.
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ProxyWinHt
tpAuthMode

=1
(Basic

Authenticati
on)

The username and
password should
be included in the
InternetSettings.in

i file using the
following settings:
ProxyUserName=
<enter your proxy
username here>
ProxyPassword=
<enter your proxy
password here>

ProxyWinHt
tpAuthMode

=2
(NTLM

Authenticati
on)

FCS Express will
attempt to use

NTLM
authentication
with the proxy

server.
A username can
be included in the
InternetSettings.in

i file using:
ProxyUserName=
<enter your proxy
username here>

The currently
logged in user will

be used if a
username is not

provided.

ProxyWinHt
tpAuthMode

=3
(Microsoft
Passport

Authenticati
on)

If your
organization's

internal network is
already using

WinHTTP passport
authentication,

you may choose
this setting. FCS
Express will use

Microsoft
Passport for

authentication on
the proxy server.

Microsoft
Passport 1.4 must
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be already
configured on the

environment
(both the client

and the server). 
For more

information on
Passport

Authentication,
click here.

ProxyWinHt
tpAuthMode

=4
(Digest

Authenticati
on)

If your proxy
server has already
been configured
to accept digest
authentication,

you may choose
this setting. FCS
Express will use

digest
authentication.

The username and
password should
be included in the
InternetSettings.in

i file using the
following settings:
ProxyUserName=
<enter your proxy
username here>
ProxyPassword=
<enter your proxy
password here>

 For more
information on

Digest
Authentication,

click here.

https://learn.microsoft.com/en-us/windows/win32/winhttp/passport-authentication-in-winhttp
https://learn.microsoft.com/en-us/iis/configuration/system.webserver/security/authentication/digestauthentication
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ProxyWinHt
tpAuthMode

=5
(Negotiate
Authenticati

on)

FCS Express will
use either

Kerberos or NTLM
authentication.

This is also
referrred to as

integrated
Windows

authentication. A
username can be

included in the
InternetSettings.in

i file using:
ProxyUserName=
<enter your proxy
username here>

The currently
logged in user will

be used if a
username is not

provided.
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20 User Default Options

FCS Express contains many options that allow you to completely customize
your working environment. You can save time by creating a new user name to
save your common options rather than changing the default settings each time
you start the program. The settings for these options are called the FCS Express
User Options. These user options range from default sizes and formatting
options for plots to the way FCS Express copies data to the clipboard.

All FCS Express User Options can be customized and saved under a unique user
name. Any changes to the user options during a session will be saved for that
user only and will not affect any other user. To customize the Preferences for the
current user, select File tab Options. The FCS Express User Options dialog

(Figure 20.2) contains many categories , each of which groups several types

of preferences together . The specific categories are discussed in other
sections of this chapter.

A tutorial  exists with step-by-step instructions for changing commonly edited
FCS Express User Options.

2716
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Figure 20.2  FCS Express user options overview

20.1 General Options

The General category of the FCS Express User Options dialog (Figure 20.3) is
used to control the overall functioning of FCS Express.
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Figure 20.3  General options

The specific options are described in the table below.

Option Explanation

Show Full Path Under some circumstances, file names are displayed in FCS
Express. This option allows you to choose whether the entire
directory path and file name are displayed or only the file name.

Math Range CheckingWhen performing parameter math, it is possible for the result of a
mathematical operation to exceed the allowed range of the file.
Storing out-of-range values may cause improper results to be
displayed when using data analysis packages other than FCS
Express. If Math Range Checking is on, values greater than the
maximum allowed value will be stored as the maximum allowed
value. If Math Range Checking is off, the real out-of-range value
will be stored.
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When dragging a
data set onto a plot

When dragging a dataset onto a plot, one of three possible
actions will occur: replace existing overlays with the file being
dragged onto the plot; add overlays to append the FCS file to
the plot; or, prompt me to ask the user what action to take. To
set the action, choose it from the drop-down list.

In new layouts,
remember
parameters by

FCS Express can remember the arrangement of parameters in the
plots displaying data by their Parameter Number (Parameter 1,
Parameter 2, P1, P2, etc.) or by their Parameter Name (FITC-A,
FL2-H, etc.). 

The Parameter Number refers to the numerical sequence that the
parameters have been written to the data file by the acquisition
software.  

If the Number option is used, FCS Express will remember the
Parameter Number for the parameters displayed within a plot and
will use the same parameter numbers when the next file is loaded
into a plot.

The Number option is a good option to use if your data is
collected consistently with the same number of parameters in the
same sequence within each data file.

The Name option will remember the exact text that is used for
the X and Y labels and is used in tandem with the Keyword for
Parameter Matching  option found within the Instrument Specific
Settings.

The Name option is a good option to use if the total number of
parameters collected or the sequence of parameters collected is
not consistent from data file to data file, however, the text used
to describe a parameter is consistent between data files.

The default option in FCS Express is Number.  If a user prefers to
use Name, this option must be set prior to building the layout. 
This option cannot be changed after a layout has been created
and saved.

In new layouts,
remember the scale
formula for manually
scaled plot
parameters

If checked, manual changes to the scale for a given plot
parameter will be remembered and applied automatically to all
plots in the layout.  See Axis formatting  for details.

Show Hints on layout When this check box is enabled, a hint will appear showing the
plot ID and names of the files currently displayed when the mouse
is hovering over the plot.

Maintain aspect ratio
of layout objects
after Maximize

When this check box is enabled, the aspect ratio (height vs.
width) of objects will be maintained.

Measurement Units
to Use

Choose Inches, Centimeters, or Millimeters from the drop-down
list.

Allow multiple format
windows for objects

When this option is selected, multiple format windows can be
opened from the Format tab for objects on the current page.

1666
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that are on-page

In new layouts, use
this text for token
errors

Add custom text as the output for token errors. TIP: A shorter
phrase or character (such as #) will help maintain table sizes
when multiple token errors occur and after they are resolved.
##ERROR## is the default but any text can be used.

Compensation
Options

These options allow you to chose how compensation is applied to
new layouts and whether to append or overwrite compensated
parameters.

Suffix for
Compensated Data

When analyzing compensated data, the text typed into this box
will be used as a suffix to describe the compensated data.  This
text can be viewed in the Title  of a plot when using the
keyword $FCSE_FILENAME or $FCSE_FILENAMENOPATH.

Suffix for New
Parameters

When the option to append new compensated parameters to data
after uncompensated parameters has been selected, the text
typed into this box will be used as a suffix to identify the new
compensated parameters from the uncompensated parameters.

New Compensated
Parameters Should

When applying compensation to data, FCS Express allows the new
compensated parameters to overwrite or be appended after the
original uncompensated parameters. Note these options can be
changed from the Compensation Options  in the
Compensation and Unmixing editor as well.

· Overwrite uncompensated parameters. The new
compensated parameters will appear in place of the
uncompensated parameters. No suffix will be used to denote
the new compensated parameters. The uncompensated
parameters will not be available to plot.

· Append to data after uncompensated parameters. The
new compensated parameters will appear after the
uncompensated parameters. The Suffix for New Parameters
will be appended to each new compensated parameter name
to identify the new parameter as having compensation
applied.

Compensation/Unmi
xing to use in new
layouts

To set Compensation for new overlays, select one of the options
below. See Selecting the Default Compensation  for additional
details:

· None. No compensation will be used.
· Compensation/Unmixing Default. The

Compensation/Unmixing Default is selected in the
Compensation Info window .

· FCS File. The Compensation used for acquisition will be
taken from the FCS file header.

· FCS file, then Compensation/Unmixing Default. FCS
Express will load Compensation from the FCS file. If there is
no Compensation stored in the FCS file, the
Compensation/Unmixing Default from the Compensation Info
window will be used.

· Compensation/Unmixing Default, then FCS file. FCS
Express will load the compensation/unmixing default from the
compensations navigator by default. If a default
compensation/unmixing does not exist, the compensation
associated with the FCS file will be used. This is the default
setting in FCS Express.
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Appearance Options These options allow you to chose the border colors for selected
objects and objects that are being edited.

Default Zoom You can customize the default zoom for your layouts.  Also, you
can choose to Apply after opening saved layouts by default.

Apply after opening
saved layouts

Applies the chosen default zoom level to layouts that were

originally saved with a different zoom level. 
Border color for
selected objects

Choose the color of the border displayed when an object is
selected from the drop-down color pallet.

Border color for
object being edited

Choose the color of the border displayed when an object is being
edited from the drop-down color pallet.

Off Page Color Choose the color of the background surrounding the page.

Print black and white
inverted for plots
with black
background

When this option is selected, when displaying plots with black
backgrounds, those plots will print out white, rather than black.

Picture output
options

These options allow you to choose the format, quality, and
resolution of images of a plot copied to the clipboard for future
use.

Use the screen
resolution

Uses the resolution of the picture on the screen for an exported or
copied picture.

Allow metafiles when
copying into
clipboard

When this option is checked, FCS Express will create both bitmap
and metafiles when generating images for the clipboard. If left
unchecked, FCS Express will only generate a bitmap file.

Use this resolution Uses a manually inputted value (in pixels) for the resolution of an
exported or copied picture.

JPEG picture quality Determines the quality of an exported or copied JPEG picture (Max
of 100).

Duplicate object
options

These options control where duplicated objects are placed after
they are duplicated.

Place the duplicated
objects in a grid

When this option is selected, duplicated objects will be placed in a
Custom Grid according to the Grid Options selected.

Grid Options Sets the Tiling Options for the Custom Grid. See Custom Grid
Options  for additional details.

Place the duplicated
objects relative to
the original

When this options is selected, allows the position of the
duplicated object to be set relative to the original object position.

The position of the
duplicated object is

Determines the position of a duplicated object relative to the
original object using the drop-down list to define the position.

Distance between
original and
duplicated object(s)

Defines the space (in inches) between a duplicated object and the
original object after duplication.

If duplicated
object(s) are off the
page, put them on a
new page

If a duplicated object falls off of the page a new page will be
created containing the duplicated object.

20.2 Plot Options

The Plots FCS Express User Options category (Figure 20.4) lets the user
customize:

788
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1. Plot Generic Options.
2. Plot Parameter Options.
3. Plot Theme.

Figure 20.4 - The Plots category in the FCS Express User Options.

1. Plot Theme. This option set how plots appear when they are first opened.
Almost any option that can be set on a plot can be set as a default value
including size, color, font, background, etc.

Alternately, you can either:
· right-click on a plot and select Set as Default from the pop-up menu. The

plot options selected for that plot will be used as the default options for all
plots opened in the future, or

· right-click on a plot and select Save as Plot Theme from the pop-up

menu, enter a Theme Name in the Add Theme Name dialog box, and
click OK (Figure 20.5, top).  Those plot options can then be set as the
default via Plot Theme Options (Figure 8.4, bottom) and will take effect on
subsequently inserted plots.  The Manage User Themes button enables
renaming and deleting of user-defined Themes.
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Figure 20.5  Plot Theme options

In most cases, the general FCS Express User Options settings mirror the specific
plot FCS Express User Options, as described in Formatting Features Shared by All
Plots . The option for Fill overlay area is discussed in Overlays  (Formatting
Single Parameter Histograms). Other discrepancies are described below.

2. Plot Generic Options. This option allows to set whether the Plot Formatting
dialog can be accessed by double click.

3. Plot Parameter Options. This options allows to set whether the parameter
list accessible on plot axes will appear as Scrollable list with a search filter
or as a Multi-column list. When scrollable list with a search filter is selected
you may drop down the parameter list and start typing a parameter name to
quickly access the parameter. Additionally, parameter lists can be sorted
based on the parameter number (default) or in alphabetical order by choosing
the Sort parameters alphabetically option.

20.2.1 Borders

This category controls the default Border/Line Options around a plot.  The
options are explained below and pictured in Figure 20.6.
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Figure 20.6  Borders Options

Option Explanation

Line Options Controls the appearance of all plot borders. 

Width Set the line width for plot borders.

Style Set the line style for plot borders. Line style options include no line,
solid, or dashed. 

Color Set the line color for the plot border.

20.2.2 Titles

This category controls the default Titles Options for plots.  The options are
explained below and pictured in Figure 20.7.
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Figure 20.7  Titles Options

Visible headers are the default for plot titles, "centered" with a grey background,
no shadow, and a black border.
The first row of the header text defaults to the file name Keyword:
$FCSE_FILENAMENOPATH for plot text box ...  which represents the local
file name (no drive\folder) with compensation text that is defined in the General
section of the FCS Express User Options .
The second row of the header text defaults to the Current Gate keyword, which
displays the name of the gate that is applied to the base overlay.

The text options for titles are explained in the table and text below.

Option Explanation

Header/Foot
er

Select either a Header or Footer in the upper left corner of the dialog to
determine which title location is currently being edited. Headers and

1601
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Option Explanation

footers can co-exist.

Visible Check or uncheck the check box to turn the Header/Footer on or off.

Font Customize the header/footer font style, size, and text color.

Text Field Enter text to be displayed in the Header/Footer in this field. Keywords
chosen will appear in the text field as codes, but expand to file-specific
values in the title.

Insert Token A drop-down a list of special tokens that can be used in plot titles. The
following options are available:

· Keyword from Data. Opens the FCS keyword list for the current file.

Select keyword(s) from the list (using Ctrl to select multiple
keywords) to insert in the header/footer. 

· File name with Path. Displays the data file name including the drive
and folder.

· File name without path. Displays the data file name without the
drive\folder path.

· File name from Data. Displays the $FIL keyword (which is part of
the FCS standard and is placed into the data file header during
sample acquisition).

· Current Gate. Displays the name of the gate that is applied to the
base overlay.

· Plot number.  Displays the Plot Number of the plot (usually visible as
part of the plot name in General options ).

· Other Tokens.... Let the user insert any of the tokens available in
the layout. An Inserting Tokens  window will open upon selecting
this option.

Background
visible

Check to enable a visible background for the Title. Options for customizing
the background include color, shadow size, and shadow color options.

Background
color

Set the background color of the header/footer title.

Shadow Size Set the shadow size of the header/footer title. To remove the shadow, set
the Shadow Size to 0.

Shadow
Color

Set the shadow color of the header/footer title.

Rounded
Border

Check to display the rectangle surrounding the header/footer title with
rounded edges.

Background
Border
Visible

Check to display a visible background border for the header/footer title.

Background
Border Color

Set the color of the background border for the header/footer title.

Alignment Align the title text left, center, or right.

20.2.3 Axis Options

This category controls the default Axis Options for plots. The options are
explained below and pictured in Figure 20.8. If you commonly work with data
files in both the FCS 2.0 and FCS 3.0 standards, you may also need to set
different default options for each of these file types. These default options can be
found in the Instrument Specific Settings . 

644
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Figure 20.8  Edit Preferences - Axis Options

By default, clicking on the axis label of a plot will allow you to change the
parameter for that axis . While this is convenient for users who are designing
layouts, parameters may be accidentally changed on occasion. You can force the
Alt key to be required to change parameters by checking the Alt+Click
Required To Change Axis Parameters check box.

Technical note: Axis Scale and Statistics

371
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In FCS Express, all the statistics are calculated on the raw data, irrespective of
the display scaling. However, when Gates and Quadrants are created decisions
must be made in cases where an event falls on the line of the gate or quadrant.

In FCS Express, Gates and Quadrants are calculated and drawn in a binned space
with binning dependent on both the Scaling  and the Resolution
Minimum/Maximum  of the plot. In turn, the inclusion or exclusion of an event
on the border line of a gate or in a quadrant is highly dependent on the scaling of
the plot, and on the Resolution Minimum/Maximum, of the plot the
Gate/Quadrants was drawn on. 

When adjustments to the scaling or resolution of a plot are made, an event may
then fall to a different side of the border line of the gate/quadrant, and the user
may notice very slight changes in the statistics of gated events which are usually
quite minimal and make no impact on the interpretation of the results. 

Please refer to the Axis Scale and Statistics  chapter for more details.

20.2.4 Background Options

This category controls the default background appearance of plots.  The options
are explained below and pictured in Figure 20.9.
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Figure 20.9 Background Options

Option Explanation

Background
color and image

Controls whether plots will appear with a white, other solid color, or
gradient background.  Images on your computer can also be stretched,
centered, or tiled as background.

Frames Options for adding frames of desired color and thickness appear on the
border of the plotted area.

Margins Add predefined margins of white space around the plot within each
object.

20.2.5 Legend Options

This category controls the default behavior and appearance of plot legends.  The
options are explained below and pictured in Figure 20.10.
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Figure 20.10 Legend Options

Option Explanation

Legend Options If Visible is checked, the legend will appear by default.  If unchecked,
it must be added via Formatting options  on a per-plot basis.
Position:  This defines the position of the legend within the plot. 
Options are Left, Right, Top, Bottom.
Margin:  This defines how much space is available between the legend
and the plotted data.
Top Position:  This defines the distance of the legend from the top of
the plot.
Back Color:  This defines that color that is applied to the background
of the legend.
Shadow Size:  This defines the degree to which a shadow is applied to
a legend.  A larger number applies a more intense shadow.  A value of
zero applies no shadow.
Shadow Color:  This defines the color of the shadow.

341
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Option Explanation

Resize chart to accommodate legend:  This defines whether or not
the plotted area will resize itself to accommodate the size of the
legend.
Title Visible: Enabling the check box will display the legend title on
Density and Contour plots. The legend title is text as well as an
interactive drop down menu that allows you to easily change the
parameter to use for the Color based on  option.

Legend Font
Style

Defines the default font of legend text.

20.2.6 1D Plot Options

The 1D Plot options are shown in Figure 20.11.

Figure 20.11  1D Plot Options

The options that are specific for 1D plots are described in the table below.

Option Explanation

When creating
a marker on a

When a marker is created, you can choose whether or not to show the
marker name and/or stat in a text box. If marker stat is enabled , you

216
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Option Explanation

plot can choose which statistic to display from the drop-down list.

Create a linked
gate

If this check-box is checked, when a new marker is created on the
histogram, a gate linked to the marker  will automatically be created.
Markers existing prior to activating this setting will still need to be
manually linked to a gate , if desired. 

Default marker
line width

This option allows the user to set the default marker line width.

Default marker
line color

This option allows the user to set the default marker line color.

Show detailed
marker resizing
information

If this check-box is checked, the marker boundaries will appear above
the marker and lines will drop to the axes to show where the marker
boundaries will be during resizing. 

Marker Creation
Prompt Window

If Show prompt window is selected, a dialog window will appear upon
marker creation that allows the user to name the marker, define the
label in the marker text box, create a linked gate, and define the marker
line width and color, if desired.  If the default of Don't show prompt
window is selected, defaults for these marker properties will apply, and
can be changed later on demand via the Marker Formatting dialog .

Default Size The default size of 1D Plots.

 

20.2.7 2D Plot Options

The 2D Plot options category (Figure 20.12) contains items that are specific for
all 2D plots.
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Figure 20.12  2D Plot Options

The 2D plot options are described in the table below.

Option Explanation

Quadrant
Options

The default preferences for the quadrants. The Default Quad Stat
option allows you to set which statistic appears in a text box in all four
quadrants when the quadrants are first inserted.

Font to Use in
Quad Text
Boxes

The default font to use for Quad Text Boxes on 2D plots showing
quadrants.

Default Size The default size of 2D Plots.

20.2.8 Text Boxes Selection Options

This category (Figure. 20.13) controls whether text boxes derived from
markers, gates, and quads within plots can be selected  for moving, resizing,
deleting, etc.  If the check box is checked, these text boxes may be selected .

1684
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Figure 20.13  Text box selection options

20.2.9 DNA Options

The DNA options refer to general , overlay , and position marker options
for performing DNA analysis using Multicycle .

· General

The General category of DNA Options (Figure 20.14) are miscellaneous
properties dealing with the Multicycle fit model and the parameter to plot on
DNA histograms.

Figure 20.14  DNA General Options

1618 1619 1620
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The properties are described in the table below.

Option Explanation

Fit Model to show When Multicycle performs a fit, it calculates six different variations
on that fit. You can choose which variation to display using this
option. The six variations are described in the Multicycle manual.

Parameter Options Select the parameter to display when changing data files. Use
"Prompt when needed" to be prompted for the parameter every time
you change a data file. The "Use parameter below" option always
displays the parameter you set in the spin control.

· Overlays

The Overlays category of DNA preferences (Figure 20.15) allows the user to
set up how the calculated overlays look on the DNA histogram. 

Figure 20.15  DNA Overlays Options

Select one or more overlays from the Select DNA Overlay list box on the
left of the Overlays page to change the look and feel of that overlay. The
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visual properties that can be changed are similar to those for regular
histogram overlays .

· Position Markers

Position markers  can be displayed on DNA histograms to mark the position
of cell cycle components such as the G1 mean or the background region. The
Position Markers category for DNA Options allows the user to set the default
properties for these markers.

Select one or more categories from the list box on the left (Figure 20.16) and
choose line options for the markers on the right.

Figure 20.16  DNA Position Markers Options

20.2.10 Multi Plot Options

The Muli Plot options refer to setting the font size if the source plot has a
larger font, Maximum number of parameters, and Maximum number of
parameters for NxN when inserting multiple plots to display combinations of
parameters and compensations in an FCS Express layout.

The Multi Plot Options (Figure 20.17) found in the FCS Express User Options
are displayed below.
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Figure 20.17  Multi Plot Options

The properties are described in the table below.

Option Explanation

Use the selected
font size if the
source plot has a
larger font

Allows the user to define the font size used for multiplots to optimize
the appearance of displayed titles when the source plot has a larger
font size.

Maximum number
of parameters

Defines the number of parameters that can be displayed on the
multiplot displays Histograms, All Parameters by X, All
Parameters by Y, Color by All Parameters.

Maximum number
of parameters for
NxN

Define the number of parameters that can be displayed on the
multiplot displays NxN Plots, NxN Plots Compensated.
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20.3 Statistic Options

The Statistics category of the FCS Express User Options, and its subcategories,
allow the user to select the default format and statistics items to list when
statistics windows are opened. 

In the main Statistic category (Figure 20.18), the following options are
available:

· When copying stats from a statistics grid to clipboard, include column

headings. This check box  controls whether or not the description of the
statistic is also copied by default.

· How should population-dependent statistics be calculated when the

population has zero events? This drop-down menu allows to choose the
default return for a statistic that has zero events. Possible choices are "As
error" and "As zero". 

Figure 20.18  Statistics Options

In the Statistic subcategories (please see links below and the following pages),
options for different types of statistics windows are further described:
· 1D Plot Statistics

· 2D Plot Statistics

· DNA Cycle Statistics

· DNA Model Statistics

· DNA Experiment Statistics

· Proliferation Fit Statistics

· Proliferation Population Statistics

1625
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20.3.1 Statistics Naming Options

The Statistics naming Options (Figure 20.19) determines how statistics are
named within the layout and when exported to external documents (e.g. Excel,
CSV,...).

General Naming Options

Parameters - The Parameters option defines how parameters are named for
parameter-dependent statistics (e.g. Median, Arithmetic Mean, Geometric
Mean, CV where values are defined from a particular parameter like FL1-CD3,
etc).

Available Options Description Example
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Prepend statistics
with "X" or "Y"

The parameter will be named and pre-
pended with "X" or "Y" depending on the plot
axis displaying it. 

X Median / Y
Median

Append statistic
with parameter
name

The actual parameter name will be appended
to the statistic name. The parameter name is
defined by the Keyword To use as
Parameter Name option in the Instrument
Specific Setting .

Median FITC /
Median PE

Prepend statistic
with parameter
name

The actual parameter name will be
prepended to the statistic name. The
parameter name is defined by the Keyword
To use as Parameter Name option in the
Instrument Specific Setting .

FITC Median /
PE Median

Denominator Gates - The Denominator Gates option defines how
denominator gates are reported in the statistics name: 

Available Options Description Example

Include hierarchical
pathway description

The hierarchical description (e.g. % of
gated cells (from plot), % of gated -
parent (from plot), % of gated -
grandparent (from plot)) will be used.

% of gated cells
(from plot)

Include
denominator gate
name

The name of denominator gate is
reported without its hierarchy.

% of parent

Include
denominator gate
name with
hierarchy

The name of denominator gate is
reported with its entire hierarchy.

% of Gate
1\Gate 2\Gate
3

· Custom Denominator Gates - The Custom Denominator Gates option

defines how the custom denominator gates are reported in the statistics
name when the denominator gate is set to be a custom denominator gate in
the Create Statistic dialog. The available options are the same as described
above for "Denominator Gates".
Tips: The custom denominator gate option is available from many dialogs
within FCS Express. Please see information  on accessing custom
denominator statistics to learn more about accessing these features. 

Population of Interest Description Options

Available
Options

Description Example

Populatio
ns of

Defines whether the population-of-interest
description should be Omitted, Prepended or

1663
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interest Appended to the statistics description. The
population-of-interest description can be
customized for gates, markers and quadrants
as below. Options below will become available
when Append or Prepend is selected from the
drop down. Once Append or Prepend is
selected, users must define what options to
include below or Omit will be used as the
default.

N/A

Gate
names

Defines whether the name of the population of
interest should be Omitted or whether it should
be reported with the name of the gate (with or
without its full hierarchy)

without full
hierarchy: # of
Events in Gate 3
with full
hierarchy: # of
Events in Gate 1\
Gate 2\  Gate 3

Marker
names

Defines whether the name of the population of
interest should be Omitted or whether it should
be reported with the name of the marker.

# of Events in M1

Quadrant
names

Defines whether the name of the population of
interest should be Omitted or whether it should
be reported by:
· Include quadrant name short description (e.g.

UL, LL, UR, LR,...) 
· Include quadrant name long description (e.g.

Upper Left, Right,...) 
· Include parameter descriptor (e.g. FL1+FL2-,

FL1-FL2-,...)

short: UL,LL, UR
long: Upper Left,
Lower Left, Upper
Right
Parameter
description:
FL1+FL2-, FL1-
FL2-, FL1-FL2+

Source Plot Description Options

· Overlay number - Defines whether the overlay number defined by the plot

should be Omitted or Included.

20.3.2 1D Plot Statistics

The 1D Plot Statistics options (Figure 20.20) determine the default visibility and
display for 1D plot statistics.  
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Figure 20.19  1D Plot Statistics Options

The options are explained in the table below.

Option Explanation

Select Statistics The check box determines whether or not statistic items are displayed
when a statistics window is first opened. The individual statistics items
are explained in the statistics section of the chapter on analysis of FCS
data . 

Number Display
Options

· Number of decimals indicates the number of decimal places listed to
the right of any decimal point.

· Rounding mode indicates the method for rounding the last digit. 
Options include Standard, Down, Up, and Truncate.
o Standard rounds values half way from zero (i.e. 85.55 rounds to

85.60).
o Down rounds values always down (i.e. 85.54 rounds to 85.50).

o Up rounds values always up (i.e. 85.55 rounds to 85.60).

o Truncate rounds values always towards zero (i.e. 85.55 rounds to

85.50).
· Show trailing zeroes, if checked, shows the specified number of

decimals even if the terminal digits are zeroes.

1268
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Option Explanation

· Show scientific notation, if checked, shows the number in E

notation: mEn which represents m x 10n, where m and n are any real
number and E represents "exponent"

Font The default font to use when displaying the statistics.

Default Size Sets the default size of the statistics window. If Size window
automatically is checked, size will automatically adjust if data is added
that extends beyond the window borders.

20.3.3 2D Plot Statistics

The 2D Plot Statistics options (Figure 20.21) determine the default visibility and
display for 2D plot statistics. 

Figure 20.20  2D Plot Statistics Options

The options are explained in the table below.

Option Explanation

Select Statistics The check box determines whether or not statistic items are displayed
when a statistics window is first opened. The individual statistics items
are explained in the statistics section of the chapter on analysis of FCS
data . 1268
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Option Explanation

Number Display
Options

· Number of decimals iindicates the number of decimal places listed to
the right of any decimal point.

· Rounding mode indicates the method for rounding the last digit. 
Choose between Standard, Down, Up, and Truncate.
o Standard rounds values half way from zero (i.e. 85.55 rounds to

85.60).
o Down rounds values always down (i.e. 85.54 rounds to 85.50).

o Up rounds values always up (i.e. 85.55 rounds to 85.60).

o Truncate rounds values always towards zero (i.e. 85.55 rounds to

85.50).
· Show trailing zeroes, if checked, shows the specified number of

decimals even if the terminal digits are zeroes.
· Show scientific notation, if checked, shows the number in standard

form or standard index form: m x 10n, where m is any real number
times ten raised to the n power.

Font The default font to use when displaying the statistics.

Default Size Sets the default size of the statistics window. If Size window
automatically is checked, size will automatically adjust if data is added
that extends beyond the window borders.

20.3.4 DNA Cycle Statistics

The DNA Cycle Statistics FCS Express User Options (Figure 20.22) control
which statistics are displayed by default when DNA Cycle Statistics windows are
opened.
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Figure 20.21  DNA Cycle Statistics Options

The options are explained in the table below.

Option Explanation

Select Statistics The check box determines whether or not statistic items are displayed
when a statistics window is first opened. See the FCS Express
knowledgebase page on DNA Analysis and Modeling with Multicycle AV
for links to information on individual statistics.

Number Display
Options

· Number of decimals indicates the number of decimal places listed to
the right of any decimal point.

· Rounding mode indicates the method for rounding the last digit. 
Choose between Standard, Down, Up, and Truncate.

· Show trailing zeroes, if checked, shows the specified number of
decimals even if the terminal digits are zeroes.

· Show scientific notation, if checked, shows the number in E

notation: mEn which represents m x 10n, where m and n are any real
number and E represents "exponent"

Font The default font to use when displaying the statistics.

Default Size Sets the default size of the statistics window. If Size window
automatically is checked, size will automatically adjust if data is added
that extends beyond the window borders.

http://www.denovosoftware.com/full-access/features/cell-cycle-analysis/
http://www.denovosoftware.com/full-access/features/cell-cycle-analysis/
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20.3.5 DNA Model Statistics

The DNA Model Statistics FCS Express User Options (Figure 20.23) control
which statistics are displayed by default when DNA Model Summary Statistics
windows are opened.

Figure 20.22  DNA Model Statistics Options

The options are explained in the table below.

Option Explanation

Select Statistics The check box determines whether or not statistic items are displayed
when a statistics window is first opened. See the FCS Express
knowledgebase page on DNA Analysis and Modeling with Multicycle AV
for links to information on individual statistics.

Number Display
Options

· Number of decimals indicates the number of decimal places listed to
the right of any decimal point.

· Rounding mode indicates the method for rounding the last digit. 
Choose between Standard, Down, Up, and Truncate.

· Show trailing zeroes, if checked, shows the specified number of
decimals even if the terminal digits are zeroes.

· Show scientific notation, if checked, shows the number in E

notation: mEn which represents m x 10n, where m and n are any real
number and E represents "exponent".

Font The default font to use when displaying the statistics.

Default Size Sets the default size of the statistics window. If Size window
automatically is checked, size will automatically adjust if data is added

http://www.denovosoftware.com/full-access/features/cell-cycle-analysis/
http://www.denovosoftware.com/full-access/features/cell-cycle-analysis/
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Option Explanation

that extends beyond the window borders.

20.3.6 DNA Experiment Statistics

The DNA Experiment Statistics FCS Express User Options (Figure 20.24)
control which statistics are displayed by default when DNA Experiment Statistics
windows are opened.

Figure 20.23  DNA Experiment Statistics options

The options are explained in the table below.

Option Explanation

Select Statistics The check box determines whether or not statistic items are displayed
when a statistics window is first opened. See the FCS Express
knowledgebase page on DNA Analysis and Modeling with Multicycle AV
for links to information on individual statistics.

Number Display
Options

· Number of decimals indicates the number of decimal places listed to
the right of any decimal point.

· Rounding mode indicates the method for rounding the last digit. 
Choose between Standard, Down, Up, and Truncate.

· Show trailing zeroes, if checked, shows the specified number of
decimals even if the terminal digits are zeroes.

http://www.denovosoftware.com/full-access/features/cell-cycle-analysis/
http://www.denovosoftware.com/full-access/features/cell-cycle-analysis/
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Option Explanation

· Show scientific notation, if checked, shows the number in E

notation: mEn which represents m x 10n, where m and n are any real
number and E represents "exponent"

Font The default font to use when displaying the statistics.

Default Size Sets the default size of the statistics window. If Size window
automatically is checked, size will automatically adjust if data is added
that extends beyond the window borders.

20.3.7 Proliferation Fit Statistics

The Proliferation Fit Statistics FCS Express User Options (Figure 20.25)
control which statistics are displayed by default when Proliferation Fit Statistics
windows are opened.

Note: Please refer to the Proliferation Statistics  topic for explanations of each
statistic and for a list of statistical formulas .

Figure 20.24  Proliferation Fit Statistics options

The options are explained in the table below.

Option Explanation

Select Statistics The check box determines whether or not statistic items are displayed
when a statistics window is first opened. Please refer to the

177

177
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Option Explanation

Proliferation Statistics  topic for explanations of each statistic and for
a list of statistical formulas .

Number Display
Options

· Number of decimals indicates the number of decimal places listed to
the right of any decimal point.

· Rounding mode indicates the method for rounding the last digit. 
Choose between Standard, Down, Up, and Truncate.

· Show trailing zeroes, if checked, shows the specified number of
decimals even if the terminal digits are zeroes.

· Show scientific notation, if checked, shows the number in E

notation: mEn which represents m x 10n, where m and n are any real
number and E represents "exponent"

Font The default font to use when displaying the statistics.

Default Size Sets the default size of the statistics window. If Size window
automatically is checked, size will automatically adjust if data is added
that extends beyond the window borders.

Note: Please refer to the Proliferation Statistics  topic for explanations of each
statistic and for a list of statistical formulas .

20.3.8 Proliferation Population Statistics

The Proliferation Population Statistics FCS Express User Options (Figure
20.26) control which population statistics  are displayed when the proliferation
population statistics window is opened.

Note: Please refer to the Proliferation Statistics  topic for explanations of each
statistic and for a list of statistical formulas .

177
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Figure 20.25  Proliferation Population Statistics options

The options are explained in the table below.

Option Explanation

Select Statistics The check box determines whether or not statistic items are displayed
when a statistics window is first opened. Please refer to the
Proliferation Statistics  topic for explanations of each statistic and for
a list of statistical formulas .

Number Display
Options

· Number of decimals indicates the number of decimal places listed to
the right of any decimal point.

· Rounding mode indicates the method for rounding the last digit. 
Choose between Standard, Down, Up, and Truncate.

· Show trailing zeroes, if checked, shows the specified number of
decimals even if the terminal digits are zeroes.

· Show scientific notation, if checked, shows the number in E

notation: mEn which represents m x 10n, where m and n are any real
number and E represents "exponent"

Font The default font to use when displaying the statistics.

Default Size Sets the default size of the statistics window. If Size window
automatically is checked, size will automatically adjust if data is added
that extends beyond the window borders.

177
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20.4 Startup Options

The Startup FCS Express User Options (Figure 20.27) allow the user to control
the behavior of FCS Express at startup.

Figure 20.26 Startup screen options

By checking or unchecking the check box, you can choose whether or not to:

· Automatically close the Startup Screen  when opening a new or existing

layout

· Reopen the Startup Screen after closing all layouts

· Automatically download any new updates

If checked,  latest updates to FCS Express will be automatically
downloaded when available.  They can also be downloaded manually from
the De Novo Software website.

· Start the De Novo Software External Application Bridge on login. The De

Novo Software External Application Bridge is required for the R Integration
features of FCS Express .

20.5 Gate Options

The FCS Express User Options Gate category (Figure 20.28) lets the user select
the default FCS Express User Options for Gate View , Gate Navigator  and
gates.

46
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http://www.denovosoftware.com/full-access/download-landing/
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Figure 20.27  Gate options

These options are described in the table below.

Option Explanation

Gate View
and Gate
Navigator
options

· Name of the root gate that has all cells. This is the name

that will be assigned to the root gate containing all cells in new
layouts. Default is No Gate.

· When renaming the all cells root gate in the layout, update the

name in the User Options. This allow to automatically update
the file above (i.e. Name of the root gate that has all
cells) when the root gate is renamed in either the Gate View
or the Gate Navigator.

· Show root gate that has all cells in the Gate View. This

applies to new layout.
· Show root gate that has all cells in the Gate Navigator.

This applies to new layout.
· Show Gate Navigator when opening a new layout. If

checked, the Gate Navigator will be displayed automatically
whena  enw layout is created.

Gate options · Choose to use hierarchical gating  as the default logic for new
gates.

· Choose to automatically create Data Specific Gates  when moving
gates.
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Option Explanation

· Set the default gate colors, which apply to gates according to the
order of creation.

· Set the width of the line used to draw the outline of the gate on a
plot.

Gate Text
Box options

· Determine whether or not to insert a gate name in the Gate Text
Box.

· Determine whether to show a gate statistic in the Gate Text Box. 
From the drop down menu, choose from several default gate
statistics .

· Define the default position of the Gate Text Box.
· Determine number of decimal places.
· Move the text box associated with a gate/marker when the gate or

marker is moved.
· Recreate the gate's text box when selecting Show Gate  from the

plot's context menu.

Gate Moving
options

When moving a gate onto a blank part of the page, choose whether to
Create a new plot on the gate or to Delete the gate.

Gate Creation
Prompt
options

Choose prompt window options that appear when creating a gate ,
depending on whether an existing gate is selected or not.

20.6 Files/Directories

The Files/Directories FCS Express User Options category allows the user to
select default directories and files for various aspects of FCS Express (Figure
20.29). For example, if you routinely open the same template to create new
layouts, the default directory you set here will automatically open your preferred
template.
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Figure 20.28  Files/Directories options

These options are described in the table below.

Option Explanation

Default Template File
for creating a new
layout

If you typically create the same type of layout, this default will
automatically open your preferred Template File when creating
new layouts. See Using Templates  for more information.

Default directory for
data files

When an FCS Express layout is first opened and a data file is first
required, FCS Express will look in this directory for the data files.

Default directory for
layouts

When you first open a layout , the Open Layout dialog will first
start in this directory.

Default FCS Express
FACSDiva
configuration file

This is the default FACSDiva configuration file .

When creating a new
plot,
always display the
selection dialog

If the check box is checked, you will always be prompted to
choose the file when creating a new plot.  If unchecked, the plot
will be loaded with the current data file .

20.7 Data List

The Data List FCS Express User Options category (Figure 20.30) allows the
user to control the default display and behavior of the Data List .  
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Figure 20.29  Data List options

The options are described in the table below.

Option Explanation

Selected Keywords Add or remove keywords by which to identify or sort  files.

Data List Options · Show or hide the Full Path of data files.
· Show or hide the Iteration Column.
· Show or hide the File Name Column.
· Show or hide the Flagged Column.
· Show Data List when opening a new layout. When this option is

checked, the Data List will be automatically displayed at the top
left part of the screen when a new layout is opened.

Action for Drag and
Drop

Choose which action to take when dragging and dropping a file
from windows explorer on top of an existing file in the Data List.

679
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Option Explanation

· Replace removes the existing file from the data list and
replaces it with the newly dropped file. 

· Insert before places the newly dropped file before the
existing file in the data list.

· Insert after - inserts the newly dropped file after the
existing file in the data list.

Double-click Options Choose which of the following actions to take when double-
clicking on a file in the Data List.

· Change all overlays on all objects to selected file.
· Change all overlays on selected objects to selected file.
· Change base overlay on all objects to selected file.
· Change base overlay on selected objects to selected file.
· Open new plot with selected file.

20.8 Dialogs Options

Some dialog windows appear automatically in FCS Express. Within the Dialogs
category of user options, there are three subcategories for which you can
customize the appearance and behavior of some of these windows: Keyword
Dialog , Open Data Dialog , and Do Not Show Again  (Figure 20.31)
and are described on the following pages.

Figure 20.30 - Subcategories for Dialogs outlined in red
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20.8.1 Keyword Dialog

The Keyword Dialog is used throughout FCS Express whenever you are
required to select a keyword. For instance, keywords can be selected for
insertion in plot titles  and in text boxes  as keyword tokens .

Since many keywords are included with data files, the Dialogs Keyword Dialog
FCS Express User Options allow you to specify which keywords appear in the
keyword dialog (Figure 20.32), providing the user with the opportunity to filter
on the keywords that are used the most. 

Figure 20.31  Keyword Dialog Preferences

You can choose one of the following:

· Show all keywords.

· Show only keywords listed below; in the Keyword Filter List.

· Exclude the keywords listed below; in the Keyword Filter List.

If you do not choose Show all keywords, you must enter keywords into the
Keyword Filter List list box. Enter one keyword per line. Case/capitalization are
ignored. You can also use the wild card "*" to denote any characters. For

339 375 1313



FCS Express 7 Manual1642

© 2023 De Novo Software

instance, to only display keywords starting with the letter "P", first select the
Show only the keywords listed below option, and then type in "P*" in the
keyword list.

Recent Keywords

The Show Recent keywords first check-box allows to sort the keyword list in
the Please select a keyword  dialog, so that most recent keywords are
always listed first.

20.8.2 Open Data Dialog

The Open Data Dialog is the dialog that allows to select data files in a wide
variety of scenarios (see the Accessing the Open Data Dialog  for more details
on this).

The Open Data Dialog can be displayed as Standard Open Data Dialog or
Advanced Open Data Dialog (see Figure 20.33, description below and
following pages for more details). 

Figure 20.32 - Open Data Dialog with Standard Open Data Dialog Overlay Options
Displayed
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When the Standard Open Data Dialog is selected, the Select data file dialog
(Figure 20.34) will be used for data file selection. 

Figure 20.33 - Select data file dialog

When the Advanced Open Data Dialog is selected, the Open Data File dialog
with five tabs  (Figure 20.35) will be used for data file selection.1645
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Figure 20.34 - Open Data File dialog

20.8.2.1 Accessing the Open Data Dialog

The Open Data Dialog can be accessed through the following actions:

· creating statistics ,

· editing statistics ,

· adding files  to the Data List , 

· adding and changing overlays on histograms , spectrum plots , 2D

plots , Gate Heatmap , Paramater Heatmap , Plate Heatmap , 

· changing data by using Data tab Data on Selection or Change

Data on All Objects group Select command (Figure 20.36). 
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Figure 20.35 - Select command outlined in red from Change Data
groups within Data tab on ribbon

· changing data by using Data tab Data on Selection or Change

Data on All Objects group Select drop down list command (Figure
20.37).

Figure 20.36 - Select dropdown command outlined in red from Change Data
groups within Data tab on ribbon

20.8.2.2 Advanced Open Data Dialog Tabs

The four tabs for the Advanced Open Data Dialog are listed and explained below.
 If the check box Show full path is checked for Selected Files under any of the
first three tabs, the full pathway will be displayed for each file instead of only the
filename.

· File Dialog is the first tab and from the user may click Select data file

button (outlined in red in Figure 20.38 below) to access the Select data
file window to access file(s) on workstation or network.
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Figure 2037 - File tab to Select data file dialog

· Data List is the second tab from which the user may select file(s) currently

added to the Data List for the layout (Figure 20.39).

Figure 20.38 - Advanced Open Data Dialog Data List tab

· Active Files is the third tab from which the user may select file(s) currently

used within the layout (Figure 20.40).
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Figure 20.39 - Active Files tab

· Building Blocks is the fourth tab from which the user may select file(s) to

Load cell images, Load Background Images, and Arrange fields by
physical position (Figure 20.41).  Arranging fields by physical position
allows you to use the position of the fields to populate regions of a picture
plot.  You can also define the default cell width and height as well as the
plane and timepoint. The Building Blocks tab is only available in FCS
Express Image or Plus. 
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Figure 20.40 - Building Blocks tab

20.8.3 Do Not Show Again

Some dialog windows appear automatically in FCS Express.  With Do Not Show
Again options, you can uncheck those which you wish to not automatically
appear as prompts.  The dialog windows are listed and explained below (Figure
20.42).  The options may be selected or deselected individually or simultaneously
using Select All or Deselect All.



User Default Options 1649

© 2023 De Novo Software

Figure 20.41 - Do Not Show Again options

· Warning dialog when saving a layout last saved in FCS Express Version

4 or 5.
o Saving a legacy layout in a current version of FCS Express will prevent it from

opening in the earlier version.  Leave this option checked to be warned when
saving such a layout. 

· Warning dialog when opening a layout created with a different version of

FCS Express.
o Leave this option checked to be warned opening a layout created in a

different version of FCS Express.  

· Selected plot types to open when dragging and dropping files.

o Leave this option checked to have the Select Plot Types... dialog appear

when dragging and dropping files onto the layout.

· Action when dropping a file on a data identifier in the Data List.

o Leave this option checked to have Choose Action for Drag and Drop dialog

to appear when dragging and dropping a file from Windows explorer on top of
a file in the data list. 

· Action when double clicking a data identifier in the Data List.

o Leave this option checked to have the Select double click action dialog

appear when double clicking on a file in the data list. 
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· Show startup screen automatically when FCS Express starts up.

o Leave this option checked to show the Startup Screen  when FCS Express

starts up. 

· Warning message when turning off iteration snapshots.

o Leave this option checked to show warning message when turning off

iteration snapshots. 

· Question about embedding/linking when inserting a picture.

o Leave this option checked to show question when inserting a picture. 

20.9 Save Options

The Save category (Figure 20.43) lets the user select how layout files are
saved. 

46



User Default Options 1651

© 2023 De Novo Software

Figure 20.42  Save options

These FCS Express User Options are described in the table below.

Option Explanation

Data Files Layout linking and embedding are described in Saving a
Layout .

Autosave Options The layout is automatically saved to the designated
location at the specified interval. You may specify the
number of saved files to keep. Auto recovery files are
described here .
If the "Specified folder" radio button is selected, and the
user has no write permission to the folder defined in the
"Specified folder" field, or the folder is not accessible,
FCS Express will use the System temporary folder instead. 
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Option Explanation

Path Options When layout files are saved with the data files linked, FCS
Express has to remember the specific disk location of the
data files (see Saving a Layout ).

When the Save absolute paths radio button is chosen,
the full path of the data files is stored. If the layout is
moved, the data files do not need to be moved as well,
since the layout will remember their original location.

Choosing the Save relative paths radio button will store
the relative path. As long as the data and the layout file
are in the same relative directories on the hard drive or CD,
the files will be loaded into the layout. If you check this
option, when you move the layout, you should move the
data such that the data is in the same relative location to
the layout as it was before.

Example: Assume that your layout and data files were in
C:\data. If you saved the layout with Save Absolute
Paths selected, then the layout will remember to look in C:
\data for the data files. If you saved the layout with Save
Relative Paths selected, the layout will only remember to
look for the data files in the same folder as the layout is in,
since that is the current relative location of the data files
to the layout (remember, they are both/ in C:\data). If you
move the layout to another location (C:\data1), and leave
the data files in C:\data, the layout saved with Save
Absolute Paths will still be able to find the data files,
since that layout remembers that the data files were in C:
\data. The layout saved with Save Relative Paths will not
find the data in this case, because it will be looking in C:
\data1, since all it remembers is to look for the data in the
same folder as the layout is in.

Save Relative Paths is useful if you are going to be
moving the data onto another computer, or external media
such as flash drive or CD, because as long as you move
the data and the layout together, the layout will be able to
find the data when it is opened.

Prompt to save/Don't save
modified data files on close

Data file header information can be changed and new
parameters can be created . These actions create a
modified .fcs data file different from the original. Choosing
the Prompt to save modified data files on close radio
button will prompt you with the choice to save the
modified files when the layout is closed. If you choose
Don’t save modified data files on close, the modified
files will not be saved when the layout is closed and the
modifications will be discarded.

History Options FCS Express can keep a copy of the old versions of FCS
Express layout files as a backup when saving.  These files
will be stored in a "History" subfolder within your original
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Option Explanation

folder. This option defaults to "1", which means that one
old copy of the layout will be maintain.

20.10 Security Options

The Security FCS Express User Options allow the user to set a password to
prohibit others from modifying the Options  of the current user (Figure 20.44).

Note: If you forget this password, there will be no way to retrieve the password-
protected user options.

Figure 20.43  Security options

20.11 Spreadsheet Data

The Spreadsheet Data category (Figure 20.45) allows users to configure the
default Spreadsheet Data Options.

1600
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Figure 20.44 Spreadsheet Data Options

When charting data within spreadsheets in FCS Express, the default setting is to
"Use the values in the first row as labels". By unchecking this box, FCS Express
will use the default column headers (i.e. A, B, C) as labels instead. 

For spreadsheet data with complex grouping, FCS Express allows multiple rows
to be used as the header. By default, this option is disabled and can be re-
enabled by checking the box next to "Allow program using multiple rows...".

20.12 Text Boxes Options

The Text Box FCS Express User Options category allows the user to configure
the default appearance for text boxes (Figure 20.46).



User Default Options 1655

© 2023 De Novo Software

Figure 20.45  Text Boxes options

The default background is Transparent. You can choose to fill the background
with a color and/or fill pattern, color gradient, or an image. You can also set the
default size.

20.13 User Information

Under user information (Figure 20.47), you can set an e-mail address, author
name, and organization for the user.
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Figure 20.46  User Information options

20.14 Performance

These options allow you to define preferences that may increase the performance speed
of FCS Express.

Figure 20.47 Performance Options.
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When moving gates,
quadrants, and
markers, update
plots statistics and
tokens immediately

When checked, all gated events, backgating, and statistics
associated with gates, quadrants, and markers will update
immediately ("in real time") when gate, quadrant, or marker
positions are changed.

Maximum Number of
Undo Items

Sets the maximum number of undo items.

Maximum memory
image cache

Determines how much memory can be allocated to cache images
when picture plots are used. A higher value will increase
performance until your computer's memory limit is reached.

Under Performance , you can set limits for the maximum number of
parameters used to create multi plot and NxN multi plots(Figure 20.48). The
option is useful to change if working with data sets that have enough parameters
where creating a large number of plots would significantly decrease the
performance of FCS Express. 

Figure 20.48 Multi Plot Performance Options.

20.15 Customer Experience Program

The De Novo Software Customer Experience Program (Figure 20.49) is an
optional program designed to anonymously track the actions of users within FCS
Express. This information will help us understand which actions are being
commonly used in FCS Express so that we can better improve our software. To
opt-out of the Customer Experience Program, uncheck the box next to Join.
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Figure 20.49  Customer Experience Program

20.16 Advanced Publishing Preferences

There are two subcategories for Advanced Publishing  options: Default
Permissions and Publishing Options.

The Default Permissions page allows you to limit what others who view your
published layout will be able to do in terms of modifying and saving your layout.
Checking the box allows the function. The permission to perform almost every
feature available in FCS Express can be customized (Figure 20.50).
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Figure 20.50  Advanced Publishing Default Permissions

The Publishing Options page allows you to control whether or not batch
processing actions are available in your published layout. In addition, you can
decide whether or not to hide objects that are outside of layout pages, and
enable or disable token editing in the published layout (Figure 20.51).

Figure 20.51  Advanced Publishing Options
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20.17 Data Saving

There are two subcategories of Data Saving FCS Express User Options: Save
as Text Format and FCS Format.

When saving data as a text file, the Save as Text Format default options allow
you to choose a delimiter ('comma' is the default) and decide whether to Save
Headers (Figure 20.52).

Figure 20.52  Data Saving - Save as Text Format options

You can also set default options for Data Format, Endian Format, and FCS
Version when saving files in FCS Format (Figure 20.53).
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Figure 20.53  Data Saving - FCS Format options

20.18 Data Loading

The Data Loading category contains FCS File Options , as well as properties
for different instrument data sets including ICE Format, ImageXPress Velos,
CellProfiler, Perkin Elmer Acapella, Building Blocks, Life Technologies Tali,
Nexcelom, ImageJ, IDEAS, Amnis DAF Reader, and Perkin Elmer Vectra

Users may also define their own Instrument Specific Settings , which can be
used to set the default axis range, scaling, and division factors for scatter and
fluorescence parameters on an instrument-specific basis.    

After defining new Instrument Specific Settings, the data may be reloaded
using the Refresh  icon which will clear the memory cache of data and reload
the data to reflect new changes. 

Note: Different choices may appear in the data loading options category
depending on whether you are using FCS Express Flow, FCS Express Image, or
FCS Express Plus.

20.18.1 FCS File Options

This option only appears if you are using FCS Express Flow or FCS Express Plus.

The FCS File Options category (Figure 20.54, upper panels) allows you to select
how FCS Files will appear in data selection dialogs (e.g., when changing files ,
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adding files to the Data List , or inserting new plots ). The FCS Express User
Options are described in the table below.

Figure 20.54   FCS File Options dialog

Users may also define their own Instrument Specific Settings , which can be
used to set the default Name and Stain that appears on plot axis, keyword to
use for parameter matching, axis range, scaling, and division factors for scatter
and fluorescence parameters on an instrument-specific basis.    

Option Explanation

Dataset Name
Keyword

Select the keyword to use as the default data set name when
selecting from multiple data sets. Allow Multiple Data sets must be
checked.

Allow Multiple Data
sets

Some FCS files contain multiple data sets. If this option is checked,
you can select one of the embedded data sets.  The user option to
use Advanced Open Data Dialog  also must be enabled to be
prompted to select which data set upon loading the data files.
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Default data set to
use

This option specifies which data set should be loaded by default
when Allow Multiple Data sets is not checked. In that case, when
you select a file in the dialog that has multiple data sets, will load
the data set number corresponding to the value selected instead of
displaying a list of data sets. If the data set does not exist, FCS
Express will load the first data set in the file.

FCS v3.0 $TIMESTEP
units

Choose a unit to use when displaying a Time parameter in FCS
Express from the drop-down list. The Default time option leaves
the time parameter at the same raw value as is stored in the FCS
file. Choosing a unit from the drop-down list will use the $TIMESTEP
keyword to convert the raw value to the specified unit from the
list.

Allow opening BD
FACSDiva data files
that were
generated by
exporting a
FACSDiva
Experiment

Check this box to allow opening data files that were exported from
BD FACSDiva together with the experiment. See
https://denovosoftware.com/faq/kb-why-do-i-get-the-message-
that-a-data-file-exported-from-a-facsdiva-experiment-is-invalid/
for a detailed explanation. Re-exporting the files is a better option
if you have access to FACSDiva and the experiment data is still
available.

Plate Folder Import
Options

These options allow users to automatically create the File
Identifier (i.e. numeric) and/or the Classification  (i.e. file names)
Columns when FCS files are loaded as an FCS Plate Folder (see
the Working with Heat Map  chapter of the manual for more
details on the FCS Plate Folder format).
An additional Classification Keyword can also be added using any
of the keywords available in the loaded files. If a keyword is
specified and multiple files share the same value for that keyword,
events from those files will be grouped together in the same well.

20.18.1.
1

Instrument Specific Settings

The FCS File Options  category (Figure 20.55
(This option only appears if you are using FCS Express Flow or FCS Express
Plus.) ) allows the user to set default preferences based on specific settings
associated with specific date file types and instruments. Identification rules,
generally based on a keyword stored in and recognized from the data file, trigger
FCS Express to use a specific set of preferences when visualizing data sets on
plots. 

Instrument specific settings control the Keyword to use as the parameter name
on plot axis , the keyword to use for parameter matching , axis range,
scaling, and division factors  for scatter and fluorescence parameters, and
Merged FCS File Import Options. They also control settings associated with
spectral data sets from Cytek and Sony instruments. A set of default
Instrument Specific Settings is provided with FCS Express for instruments
that generally require customizations to preferences to improve the display of
data so it matches data displays from the acquisition software. Additional
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settings may be added at any time and the default settings may be adjusted or
disabled if required. 

Instrument Specific Settings will first try to identify if the data set loaded matches
any identification rules part of any specific settings. FCS Express will attempt to
match and give priority to the instrument specific settings based on the order of
settings in the Instrument Specific Settings list. As an example, data from a
FACScan instrument may be identified by both the Default FCS 2.0 and FACScan
settings.  If the FACScan setting is higher in the Instrument Specific Settings list
than the Default FCS 2.0 setting, it will be applied and vice versa. 

If no matches are found, the Default FCS 2.0 or Default FCS 3.0 settings will be
used. Please note that the default FCS 2.0 and FCS 3.0 Instrument Name and
Identification Rules are the only ones that may not be modified, however, the
individual settings as part of these defaults may be changed. 

Figure 20.55   FCS File Options> Instrument Specific Settings dialog (top portion).
Settings show are explained in table below. 

Instrument Specific Settings dialog options:

Option Explanation

Restore
Default
Settings 

Restores the list of Instruments and Instrument Specific Settings back
to the default set and settings provided with FCS Express. 

NOTE: when updating to a new release of FCS Express from an
existing release, new ISS that have been added to an update may
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Option Explanation

require the user to restore the default ISS settings to enable the new
ISS that were provided in an update. Any custom ISS that you have
previously created will need to be recreated after restoring the default
settings.

Duplicat
e 

When an instrument specific settings is selected from the list, pressing
Duplicate will create a copy of the setting. The copy maybe be
renamed in the Instrument Name section and new identification
rules and settings may be defined. 

Add The add button will allow you to create your own customized
instrument specific setting from scratch. When the Add button is
clicked a dropdown menu will appear allowing the choice of:
· General

· Cytek

· Sony

· Merged FCS Files

Choose from one of the options in the list to best match the data
source type you intend to create an instrument specific settings for. 

Remove When an instrument specific settings is selected from the list, pressing
Remove, will remove the setting from the list. Please note that
Default FCS 2.0 and Default FCS 3.0 settings may not be removed.
 

Up and
Down
Arrows

When an instrument specific settings is selected from the list, pressing
the Up or Down arrows will move the setting up or down the list.
Settings higher in the list will be given priority over those lower in the
list. 

Instrument Specific Setting Options shared by all default settings and choices:

Option Explanation

Instrum
ent
Name

Controls the name displayed in the Instrument Specific Settings list for
the setting currently selected. Note this may not be changed for
Default FCS 2.0 and Default FCS 3.0 settings.

Identific
ation
Rule

The instrument origin of data files will generally be recognized by the
cytometer ($CYT) keyword , or a formula which evaluates multiple
keywords, that are recorded as metadata by the cytometer at the
time of acquisition.  Several Instrument-Specific Settings and
Identification Rules have been included by default. Identification
rules may be edited or added following the syntax with quotes (with
$CYT as an example):  "<$CYT>" = "value of the $CYT keyword for
your data files".  Operators such as OR, AND, NOT, and other common
operators , may also be used. For instance '("<$CYT>" = "Accuri
C6") or ("<$CYT>" = "BD Accuri C6")' 

General Options:
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Option Explanation

 Value to start
for log
parameters

Choose the starting value for parameters displayed in the log
scale from the drop-down list.

Keyword To
Use as
Parameter
Name

Choose a keyword (or combination of keywords) to use as
parameter display names from the drop-down list.  This option
will define how the X and Y axis labels are displayed within a
plot.

The options are Name, Stain, Name and Stain, or Stain and
Name.  These options are specifically referring to the keyword
values for $PnN and $PnS.  These keywords designate the
Parameter Name and Parameter Stain keywords written to file
by the acquisition software.

For example, if choosing to display the 3rd parameter written
within a data file and the value of the Stain and Name keywords
are as follows:

· $P3N = FITC - A

· $P3S = CD3

The Name option will display FITC - A.
The Stain option will display CD3.
The Stain and Name option will display CD3 FITC - A.
The Name and Stain option will display FITC - A CD3.

Keyword for
Parameter
Matching

This option is used when the In new layouts, remember
parameters  by option has been set to Name and will define
the text that FCS Express uses when matching the parameters
to be displayed within a plot.

The options are Same as Display Name, Name, Stain,
Name and Stain, or Stain and Name. 

Please note that the text has to be an exact match between
files for FCS Express to properly know which parameter to
display when a new data file is loaded into a plot.

For example, if this option is set to Name and your data has a
$PnN value of FITC - A, the next data file loaded into a plot
needs to have a corresponding parameter with the exact $PnN
text match of FITC - A to properly display axis labels.

If this option is set to Stain and Name and your data has a
$PnS value of CD3 and a $PnN value of FITC - A, the next
data file loaded into a plot needs to have a corresponding
match with the exact $PnS text match of CD3 and $PnN text
match of FITC - A to properly display axis labels.
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Option Explanation

When FCS Express attempts to match parameters, for
instance, when defining compensation controls , these
settings will be also be used to attempt matching. 

Merge FCS File Import Options:

Option Explanation

Merge FCS File
Import Options

These options allow to automatically create the File Identifier
(i.e. numeric) and/or the Classification  (i.e. file names)
Columns when FCS files are loaded as Merged FCS File (see
the Adding Merged Files to the Data List  and the  Working
with Heat Map  chapter of the manual for more details on the
Merge FCS File format).
Additional Classification keywords  can also be added using
any of the keywords available in the loaded files. Multiple
keywords can be specified as comma-separated. If a keyword
is specified and multiple files share the same value for that
keyword, events from those files will be grouped together
under the corresponding classification parameter.

Scatter Parameters and Fluorescence Parameters Options:

Option Explanation

Range
Options 

Default Range Options may be specified for Scatter and/or
Fluorescence Parameters.  You may choose from four mutually
exclusive options:

· Automatic:  FCS Express will set the plot Range  according

to the Minimum and/or Maximum specified by the metadata
(keywords)  in the data file.  This is the default behavior of
FCS Express, if no Instrument-Specific Settings are defined for
the data files specified in Instrument Specific Settings >
Condition.  

· Based on data:  Let FCS Express detect the actual minimum

and maximum of your data for each parameter, and set the
plot Range  accordingly (a margin will be added so that data
does not appear cut off on the plot boundaries). 

· Percentile:  FCS Express will set the plot Range  according

to the specified Percentile.  This is a convenient way to
automatically not plot outliers which may located far beyond
the data of interest.  In effect, your plots will already be
zoomed into your highest-level region of interest.

· Manual:  specify a Minimum and Maximum for the plot

Range .

Scale
Options 

When the Automatic check box is checked FCS Express will
automatically apply a predefined scale specific for the selected
instrument. To manually specify a scaling option, first uncheck the
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Option Explanation

Automatic box then select the default scaling  you wish to apply
from the drop down menu which will appear. 

Division
Factor 

The Division Factor  may be specified for Scatter and/or
Fluorescence Parameters by adjusting the numeric value in the
Divide Axis Labels Factor text box.  In addition, the user may
specify Do not perform scaling, Scale by factor, Scale to a
maximum value. These may be specified for both Scatter and
Fluorescence parameters.  The Do not perform scaling does not
make any adjustments to scaling. The Scale by factor allows for
the data to be displayed with a different resolution (# of channels)
than its native resolution.  The Scale to a maximum value drop
down menu contains common display scales.

Special Instrument Specific Settings for Spectral Data Sets

Cytek - SpectroFlo Specific Options

Option Explanation

Import
spectra as
individual
Parameters

When checked, Spectrum plots  will allow the user to select any
individual laser spectra and a merged spectra as a parameter, for
instance, Violet, Blue, Red and Violet\Blue\Red will all be available.
If unchecked, only one merged parameter for all laser spectra will
be displayed, for instance, only one parameter for Violet\Blue\Red
will be available. 

Import
spectra as
Single
Merged
Parameter

When checked, a single merged parameter for all laser spectra will
be available for selection. For instance, if Violet, Blue, and Red
were collected, a new merged parameter for Violet\Blue\Red will
be available. If unchecked, only individual spectra will be accessible
as long as Import Spectra as individual Parameters is checked
(above). 

Spectra
Parameter
Label

The options allows users to define which Spectra Parameter to
use as a label on spectrum plots, either Wavelengths or
Parameter Names. If Wavelengths are selected, Spectrum plots
will support displaying the numeric wavelength on the X axis, if
Parameter Names is selected, Spectrum plots will support
displaying the parameter names on the X axis, for instance, V1-A,
V2-A, V3-A. 

Delete
fluorescenc
e
parameters
after
spectra
merge

If checked, additional spectra parameters (for instance V1-A, V2-
A, V3-A) will be removed when visualizing data in 2D and 1D plots.
If unchecked, individual spectra parameters will be accessible in 2D
and 1D plots at the end of the standard parameter list. 

Merge Raw
and

When checked, if raw and unmixed data files exist in the
appropriate file structure , and the unmixed data file is loaded
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Option Explanation

Unmixed
Cytek Files
during
import

into any plot(s), a resulting spectrum plot inserted for the data set
will visualize all spectral parameters. If unchecked, when loading an
unmixed data file, a spectrum plot for the data set will not be
accessible since raw spectral data will not be merged with the
unmixed results. When loading a raw data file, only scatter
parameters will be accessible on 2D and 1D plots but the raw
spectral data will be accessible in a spectrum plot. 

Cytek File
Merge Rule

Four options are available and described below:
Load User Selection: Uses the check box option set above for
"Merge Raw and Unmixed Cytek Files during import"
Load both Raw and Unmixed Always: Loads both Raw and
Unmixed into a merged data file for use in 2D, 1D, and spectrum
plots regardless of the check box option set above for "Merge
Raw and Unmixed Cytek Files during import"
Load Unmixed Only: Loads only the Unmixed version (no
spectral parameters) of the data set when loading data.
Load Raw Only: Loads only the Raw version of the data set (only
spectral parameters) when loading data. 

Sony Specific Options

Option Explanation

Spectrum
Parameters
to Read

The options allows users to define which Spectrum Parameters
to Read, and to display on a Spectrum plot , either
Wavelengths or Channels or both (one choice must be
selected). If Wavelengths are selected, Spectrum plots will
support displaying the wavelength on the X axis, if Channels is
selected, Spectrum plots will support displaying the Channels on
the X axis. If both are selected, Spectrum plots will support
displaying both Wavelength and Channels on the X axis. 

20.18.2 Image XPress Velos Options

This option only appears in FCS Express Image Cytometry and FCS Express Plus.

When loading Image Xpress Velos data, you can choose whether to Load cell
images, Load as Plate, and Load Background Images. (Figure 20.56).
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Figure 20.56  IsoCyte Data Loading Options

20.18.3 CellProfiler Options

This option only appears in FCS Express Image Cytometry and FCS Express Plus.

When loading files from CellProfiler, you can choose the format (File delimiter),
either character separated values (.csv) or tab-delimited files. You can also
choose whether to Load Images, Load path names from Cell Profiler table
of contents file, and/or Load Background Images (Figure 20.57).

If Load path names from CellProfiler table of contents file is checked, then
FCS Express will try to load the images from the folder specified in the CellProfiler
table of contents file. If it is unchecked, then FCS Express will try to load the
images from the same folder as the CellProfiler file.

Figure 20.57  Cell Profiler Data Loading Options
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20.18.4 ICE Format Options

This option only appears in FCS Express Image Cytometry and FCS Express Plus.

When loading .ICE files you can choose whether to Load cell images and Load
Background Images (Figure 20.58). 

Figure 20.58  ICE Format options

20.18.5 PerkinElmer Acapella Options

This option only appears in FCS Express Image Cytometry and FCS Express Plus.

When loading Perkin Elmer Acapella Reader files you can choose whether to
Load cell images, Load Background Images, and Arrange fields by physical
position (Figure 20.59). Arranging fields by physical position allows you to use
the position of the fields to populate regions of a picture plot.

Figure 20.59  Perkin Elmer options
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20.18.6 Building Blocks Options

This option only appears in FCS Express Image Cytometry and FCS Express Plus.

When loading Building Blocks files you can choose whether to Load cell images,
Load Background Images, and Arrange fields by physical position (Figure
20.60). Arranging fields by physical position allows you to use the position of the
fields to populate regions of a picture plot.  You can also define the default cell
width and height.

Figure 20.60  Building Blocks options

20.18.7 Life Technologies Tali Options

This option only appears in FCS Express Image Cytometry and FCS Express Plus.

When loading Life Technologies Tali data files, you can choose whether to Load
cell images and Load Background Images (Figure 20.61). The default length
of the sides of the square around each cell can also be changed.
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Figure 20.61  LifeTechnologies Tali options

20.18.8 Nexcelom Options

This option only appears in FCS Express Flow RUO, FCS Express Image
Cytometry and FCS Express Plus.

When loading .nxdat files, you can choose whether the to import the original X
and Y pixels (Figure 20.62). 

Figure 20.62  Nexcelom options

20.18.9 ImageJ Options

This option only appears in FCS Express Image Cytometry and FCS Express Plus.
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When loading .ijout files you can choose whether to Load cell images, Load
Background Images, and Load path names from the ImageJ table of
contents file (Figure 20.63). 

Figure 20.63  ImageJ options

20.18.1
0

Amnis DAF Reader Options

This option only appears in FCS Express Image Cytometry and FCS Express
Plus. 

When loading Amnis *.daf files  you have the option to load data with or
without images (Figure 20.64). Unchecking the Load images box will load *.daf
files without the associated images from the relevant *.cif file.  Resulting plots will
only display number data and data grids will not have columns present for single
cell images. 
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Figure 20.64  IDEAS options

20.18.1
1

Perkin Elmer Vectra Options

This option only appears in FCS Express Image Cytometry and FCS Express Plus.

When loading Vectra files (*.tif, *.txt) you have the option to Load images, Use
Default Image Resolution when loading composite TIFF images, and select
which segmentation image/map from the Segmentation Cell Type options.
(Figure 20.65). 

The Load images box will be checked by default, and unchecking this box will
load Vectra files without any associated images. When unchecked,  Picture
Plots  will not be allowed to be inserted and data grids will not have columns
present for single cells images. However, all numeric data may be plotted in any
other plot type available.

When the Use Default Image Resolution box is checked, the user can set the
Default Image Resolution for composite TIFF images loaded into FCS Express.
Check this box only if you are loading composite TIFF images
(*_composite_image.tif), as these images are exported from the Vectra without
the image resolution data necessary for tiling the different images into a single
field of view. For component TIFF images (*_component_data.tif), you may
leave this box unchecked.
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Figure 20.65 Vectra Format options

Please see https://denovosoftware.com/faq/kb-can-i-work-with-data-from-
perkinelmer-instruments/ for instructions on exporting data from the Vectra /
InForm software for use in FCS Express. 

https://denovosoftware.com/faq/kb-can-i-work-with-data-from-perkinelmer-instruments/
https://denovosoftware.com/faq/kb-can-i-work-with-data-from-perkinelmer-instruments/
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21 FCS Express Keyboard Shortcuts

FCS Express contains many shortcut keystroke combinations to make
navigating and working within the software easier. The table below summarizes
the available short cut keys.

Shortcut Command Applies To

Ctrl+C Copy Objects on layout, tokens, text,
items into navigator views

Ctrl+V Paste Objects on layout, tokens, text,
items into navigator views

Ctrl+X Cut Objects on layout, tokens, text,
items into navigator views

Shift+Del Secondary shortcut
for Cut

Objects on layout, tokens, text,
items into navigator views

Ctrl+Ins Secondary shortcut
for Copy

Objects on layout, tokens, text,
items into navigator views

Shift+Ins Secondary shortcut
for Paste

Objects on layout, tokens, text,
items into navigator views

Ctrl+Z Undo Any action in the layout

Ctrl+Y Redo Any action in the layout

Ctrl+B Bold Text in text boxes and labels in
selected plots

Ctrl+I Italic Text in text boxes and labels in
selected plots

Ctrl+U Underline Text in text boxes and labels in
selected plots

F2 Rename Items in navigator views and
batch actions and items 

Ctrl+A Select all Objects on layout, text, data list,
batch actions, custom tokens,
canned comment, and alerts
navigator

Del Delete Selected object on layout,
selected item in navigator views,
selected text, selected user in non
secure login mode

Ctrl+D Duplicate Selected object on layout,
selected gate, custom tokens,
canned comments and  alerts in
navigator views

PgDn Switch to next page in
layout

Layouts with multiple pages
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PgUp Switch to previous
page in layout

Layouts with multiple pages

Ctrl+N Open new layout Any layout

Ctrl+O Open layout Any layout

Ctrl+S Save current layout Any layout

Ctrl+Shift+S Save current layout AsAny layout

Ctrl+P Print current layout Any layout

Ctrl+Shift+P Print Setup Any layout

Ctrl+W Close current layout Any layout

F1 Show help Any layout

Up Scroll up / Move gate
up

Layout or selected object or gate

Down Scroll down / Move
gate down

Layout or selected object or gate

Left Scroll left / Move gate
left

Layout or selected object or gate

Right Scroll right / Move
gate right

Layout or selected object or gate

Esc Cancel adding or
editing

Plots, shapes and gates

Space Finish creating a
polygon gate

Creating polygon gates

Click on Gate +F5
+ arrow key

The gate will expand in
the direction of the

pressed key

Gates

Click on Gate +F6
+ arrow key

The gate will shrink in
the direction of the

pressed key

Gates

Shift + move
quadrants

Quadrants can only
moves in the X

direction

Quadrants

Alt + move
quadrants

Quadrants can only
moves in the Y

direction

Quadrants

Ctrl+Alt+D Duplicate and PreviousPlots and data grid

Shift+Ctrl+D Duplicate and Next Plots and data grid

Alt+Left Previous on selected
objects

Plots and data grid

Shift+Alt+Left Previous on all objectsPlots and data grid

Alt+Right Next on selected
objects

Plots and data grid

Shift+Alt+Right Next on all objects Plots and data grid

Ctrl+L Change data file for
selected plot

Plots and data grid
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Shift+Alt+L Change data file for all
plots

Plots and data grid

Ctrl+Alt+E Multiple duplicate and
previous

Plots and data grid

Shift+Ctrl+E Multiple duplicate and
next

Plots and data grid

Ctrl+E Edit user name User profiles from User Selection
window

Ctrl+F Edit format Objects, Text Boxes, Plots, Data
Grids, and Shapes

        1-9 Change x parameter
for selected plot

Plots

Shift+1-9 Change y parameter
for selected plot

Plots

Ctrl+M Maximize/Restore
from the plot's menu

Plots

Ctrl+Shift+F Switch the X and Y
Axes

Plots

Double Click on Plot Opens Format Dialog Plots

Double Click on Page
Tab

Opens Format Dialog Page tabs

Hold Alt key Command keys
highlight on ribbon -
pressing highlighted

command keys
activates action

Ribbon

Hold Shift key click
on object

Put object in selection
mode without allowing

moving

Objects, Text Boxes, Plots, Data
Grids, and Shapes

Click on Gate + Shift
+ Move Mouse

Convert gate to data-
specific gate

Creating data-specific gates

Select Range + Shift
+ Click

Check/Uncheck all
boxes within the
selected range

Checkboxes
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22 Tutorials

This chapter contains detailed tutorials of the functions of FCS Express to make
learning commonly used features as easy as possible.

Sample data is provided so that you can follow along with the examples in the
tutorials. The sample data can be downloaded from the archive on the De Novo
Software website:

https://s3.amazonaws.com/fcsexpressdownloads/TutorialSampleDataV7.zip

After downloading the archive, you may extract the contents anywhere you like,
for example, in My Documents.

These tutorials are currently available:

· Using Objects

· Inserting Plots

· Formatting Plots

· Gating

· Text Boxes and Tokens

· Quadrants

· Quadrant/Marker to Gate Linking

· Compensation

· Snap Shots

· Batch Processing

· Creating and Using Panels

· Docking

· Data Navigator

· Gate Navigator

· Layout Navigator

· Spreadsheets Use Case 1 - Working with Custom Tokens, Formula

References, and Conditional Formatting
· Spreadsheets Use Case 2 - Creating a regression analysis with an Antibody

Titration Series
· Spreadsheets Use Case 3 - Performing Channel Calibration and Regression

Analysis
· Spreadsheets Use Case 4 - Creating and working with Pie, Bar and Scatter

Plots
· High Content Flow

· DNA Analysis

· Proliferation

· Kinetics  

· Cell Concentration

· Channel Calibration
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· CellProfiler Export

· ImageJ Export

· Exporting from IsoCyte

· Picture Plots

· Introduction to FCS Express Image Cytometry  

· Immunophenotyping

· Changing Common Preferences

· Cluster Analysis

· Cytek Aurora Spectral Data Analysis

· Spectral Unmixing

· Fluidigm CyTOF Data Analysis

22.1 Using Objects

Objects (e.g., plots, text boxes, statistic tables, and pictures) are items that are
placed onto an FCS Express document (called a layout). Objects in FCS Express
can be manipulated similarly to objects in Microsoft PowerPoint, which means
they can be moved, resized, deleted, grouped, aligned, cut, copied, and
duplicated. In order for an object to be manipulated, the object must first be
selected. A red border surrounding the object denotes a selected object. An
object can also be in edit mode, which is denoted by a green border. Edit mode
will be described in detail later.

The first section of this tutorial will describe Inserting an Object .

22.1.1 Inserting an Object

To insert an object on a page, simply choose the object from the Insert tab on
the Ribbon. In the following example, we will insert a picture.

To insert a Picture:

1.  Select Insert tab command  (Figure T1.1). 

2.  Click the mouse where you want the top-left corner of the picture to
appear on the page. A file selection dialog will appear to allow you to
choose the picture file you wish to insert.
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Figure T1.1  Insert Picture

3.  Select the file Logo.png found in the Tutorial Sample Data files as shown in
Figure T1.2 (we will use the De Novo Software Logo as an example for the
rest of the tutorial). If Logo.png is not available, you can use any picture
file.

Figure T1.2  De Novo Software Logo  

The red border around the object signifies that the object is selected. For more
information on selected and edit modes, refer to the Layout Page Features
section in the FCS Express manual.

In the next section, we will practice selecting and deselecting objects . 

22.1.2 Selecting and Deselecting Objects

Clicking anywhere outside the object on the layout background will deselect the
object. To select the object again:

1.  Move the mouse until it is on the border of the object.

2.  Click on the border. You will know the cursor is in the right place because
the cursor will change to a four-headed arrow.

Now, we will resize an object .

22.1.3 Resizing an Object

Once an object is selected, you can resize it by moving the cursor to one of the
resizing handles (red circles, Figure T1.3) along the border of the object.

136
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The example below shows how to resize the object both horizontally and
vertically at the same time:

1. Move the cursor above the resized handle on the bottom right hand
corner of the object until the arrow cursor changes to a two-headed
diagonal arrow cursor.

2. Press and hold down the left mouse button while moving the cursor to an
appropriate position. A transparent preview image of the object will appear
showing the new size as you move the mouse. You can maintain the
aspect ratio of an object by holding down the Shift key while you resize
the object.

3. Release the mouse button and the object will resize to the size of the
preview image.

Figure T1.3  Resizing an
Object

We will now learn to move an object .

22.1.4 Moving an Object

To move an object (Figure T1.4): 

1. Move the cursor along the border until a four-headed arrow cursor
appears.

2. Press and hold down the left mouse button.

3. Move the mouse while holding down the button. A transparent preview
image showing the new position of the object will appear as you move the
mouse.

4. Continue moving the mouse until the preview image is in the desired
location.
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5. Release the mouse button. The object will now move to the new location.

Figure T1.4  Moving an Object

Alternatively, you can move the object by selecting it and pressing the arrow
keys on the keyboard (up, down, left, right). To move the object in smaller
increments using the keyboard, hold down the Shift key while pressing the
arrow keys.

The next topic is deleting an object .

22.1.5 Deleting an Object

To delete an object: 

1. Select the object as described previously .

2. Press the Delete key on the keyboard

OR

3. Select the Home tab command (Figure T1.5).

Figure T1.5  Deleting an Object

1686
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If you decide that you didn't want to delete the object, you can undo or redo
your changes in the next section.

22.1.6 Undoing and Redoing Changes

FCS Express allows for any number of previous operations to be undone and
redone.

To undo or redo any changes:

1. Click the Undo button in the Quick Access Toolbar (Figure T1.6). The
text on the Undo menu item will change to inform you which operation
can be undone. For example, to undo the delete of the picture in the step
above , click the Undo button. You can also press Ctrl+Z to undo
changes.

2. Click the Redo button in the Quick Access Toolbar. The text on the Redo
menu item will change to inform you which operation can be undone. You
can also press Ctrl+Y to redo changes. 

Figure T1.6  Undo
Command on

ribbon

The next topic is duplicating objects .

22.1.7 Duplicating Objects

To duplicate an object: 

1. Select the object as described previously .

2. Select the Home tab command or press Ctrl+D.
The new object will appear offset slightly lower and to the right of the
original object (Figure T1.7).  The default position of the duplicated object
may be customized in user options.
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Figure T1.7  Duplicating an Object

In the next section, we will select multiple objects .

22.1.8 Selecting Multiple Objects

To select multiple objects using the mouse (Figure T1.8):

1. Place the cursor outside the border region near a corner of one of the
objects you would like to select.

2. Press and hold the left mouse button.

3. Move the cursor. A gray highlighted box will appear as you move the
cursor around the layout.

4. Size the gray highlighted box until all the objects to be selected are
contained within the box.
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5. Release the left mouse button.

All of the objects will now be selected as seen by the presence of a red border
around each one.

Figure T1.8  Selecting mulitple Objects

To select multiple objects using the keyboard: 

1. Hold down the Control or Shift key on the keyboard.

2. Click inside or on the border of an object that you want to select. When
the object is selected the border will change to red.

3. Continue holding down Control or Shift and move the cursor to another
object you want to select.

4. Click inside or on the border of this object. You may also deselect during
this multiple selection process by shift-clicking an already selected object.

5. Continue following steps 3 & 4 until all the objects that you want to select
are selected.

6. Release the Control or Shift key. All the objects you have selected will
have a red border.

To select all objects using the keyboard:

1.  Hold down the Control and A key on the keyboard.

2.  All objects in the layout will be selected and have a red border.

The next section is copying objects .1690
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22.1.9 Copying Objects

FCS Express allows you to copy one or more objects to the clipboard and paste
them onto the same or a different layout page. 

To Copy objects:

1. Select the object or objects to be copied as described previously .

2. Select the Copy Picture command (Figure T1.9), from the Clipboard
Group on the Home tab. The text of the Copy menu item will inform you
which object will be copied. Alternatively, you can use the Ctrl+C shortcut.

Figure T1.9 
Copying an Object

We will now proceed to pasting objects .

22.1.10 Pasting Objects

To paste objects that are on the clipboard: 

1. Select the Paste command (Figure T1.10) from the Clipboard group on
the Home tab. The text of the Paste menu item will inform you which
object will be pasted. Alternatively, you can use the Ctrl+V shortcut.

Figure T1.10  
Pasting an Object

In the next step, we will learn to group objects .
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22.1.11 Grouping Objects

Individual objects on a page can be grouped together. This means that as soon
as one object in the group is selected, all of the objects in the group will become
selected. This is useful, for example, if several objects are in a specific relative
location to each other and you want to make sure that you cannot move one
without moving all of the others. 

To group several objects together:

1. Select the objects that you want to group, as described above .

2. Select Group from the Home tab group command
drop-down list (Figure T1.11).

Figure T1.11  Grouping Objects

3. Click on a blank area of the layout to unselect all the objects.

4. Click on the border of one of the grouped objects. They should all become
selected.

To ungroup grouped objects:

1. Select the group of objects you want to ungroup, as described above.

1684
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2. Select Ungroup from the Home tab group command
drop-down list.

In the next section, we will learn to align objects .

22.1.12 Aligning Objects

FCS Express allows both horizontal and vertical alignment of objects by their
sides, tops, bottoms or centers. This alignment feature also allows you to resize
an object's height or width with respect to another object's size. 

Note: Objects are always aligned with respect to the first object selected.

To horizontally align multiple objects: 

1. Select  all of the objects you want to align.

2. Select Align from the Home tab group command drop-
down list (Figure T1.12).  An Alignment drop-down list will appear.

3. Select Centers from the horizontal alignment list (Figure T1.12).

Figure T1.12  Aligning Objects (Step 2)
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The selected objects are now horizontally aligned (Figure T1.13).

Figure T1.13  Objects before (left) and after (right) alignment

To make several objects have the same height and width:

1. Select the object that is the size you wish all the other objects to be. 

2. Select the objects you wish to resize.

3. Select Align from the Home tab group drop-down list
(Figure T1.14a).

4. An Alignment dialog box will appear in the center of the layout (Figure
T1.14b).

5. Select Widths from the horizontal alignment list.

6. Select Heights from the vertical alignment list. 

7. Press the OK button.
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Figure T1.14a Equalize Height and Width

Figure T1.14b  Alignment Dialog Box
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All of the selected objects are now the same size as the first object selected
(Figure T1.15). Alternatively, the height and width could have been aligned
separately.

Figure T1.15  Objects before (left) and after (right) aligning Height and
Width

In the last section of this tutorial, we will set the order of different objects .

22.1.13 Ordering Objects

FCS Express allows for explicit placement of objects in front or behind other
objects. 

To move an object in front of another one:

1. Select the object that you want to move in front, as described
previously .

2. Select Bring to Front from the Home tab group
command drop-down list (Figure T1.16).
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Figure T1.16  Ordering Objects

The selected object will be brought to the front (Figure T1.17).

Figure T.17  Ordering Objects

22.2 Inserting Plots

In the course of this example, we will:

· Learn how to insert plots on a layout.

The basic way to insert a plot is to click the Insert tab and make selection from
the 1D Plots, 2D Plots, Charts, or Other Plots groups.

Although any data files of your own can be used to follow along, you have the
option of using the same sample data files used in this tutorial. The sample data
files are located in the Tutorial Sample Data archive . The files GFPcontrol.001
and GFPsample.002 are used here.
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We will start by inserting a 2D plot .

22.2.1 Inserting a 2D Plot

To insert a 2D plot:

1. Select the Insert tab group  command (Figure T2.1, red
outlines).

Figure T2.1  Inserting a 2D Dot Plot from Ribbon

2. Move the mouse to a place on the layout where you would like the top-
left corner of the plot to be located. 

3. Click the mouse on the page where you want the top-left corner of the
plot to appear. 

A Select data file dialog box will appear (Figure T2.2). 

Figure T2.2  Select data file Dialog
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4. Navigate to Tutorial Sample Data and select the GFPcontrol.001 data file
from the FCS Express Sample Data directory (Figure T2.2).  

5. Press the Open file button.

The newly inserted 2D dot plot will now appear in the layout with a default
size (Figure T2.3). You can change the default size by placing the cursor over
any of the red handles on the selected plot and adjusting as necessary. Refer
to the tutorial on using objects for more information on resizing objects .

Figure T2.3  2D Dot Plot Inserted on Layout

Note:  Please save this layout to your desktop if unable to complete the next
tutorial section.

Next, we will insert a histogram .

22.2.2 Inserting a Histogram

To demonstrate inserting a 1D plot in a custom size, we will add one to the
layout made in the previous section.

1. Select Insert tab group  command (Figure T2.4).
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Figure T2.4  Insert Histogram Command

2. Move the mouse to a place on the layout where you would like the top-
left corner of the plot to be located. 

3. Press and hold the left mouse button down.

4. Move the cursor, while holding the mouse button down, until the sizing
rectangle is the size you want the histogram to be (Figure T2.5).
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Figure T2.5  Insert Histogram - bottom image shown
with placeholder of where histogram will be drawn.

5. Release the mouse button, and the histogram will be inserted in the place
of the sized rectangle (Figure T2.6).
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Figure T2.6  Inserted Histogram

Note: when inserting the histogram, you were not prompted to select a file. This
is because FCS Express uses the most recent data file when adding a new plot.
You are only prompted to select a data file if no data files have been opened, or
you select the When inserting a plot or displaying information from a data
file, always display the selection dialog preference from the FCS Express
User Options (described here ).

Plots can also be inserted .

1705

1702



FCS Express 7 Manual1702

© 2023 De Novo Software

22.2.3 Inserting from the Data Tab with the Open Command

To insert a plot:

1. Select the Data tab group  command (Figure T2.7,
red outlines).

Figure T2.7  Open Command

A Select a Data File dialog will open as previously shown in Figure T2.2 . 

2. Select the GFPcontrol.001 data file from the FCS Express Sample Data
directory.  

3. Select Open.

A Select Plot Types... dialog will appear (Figure T2.8).
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Figure T2.8  Select Plot Types... Dialog

4. Select Dot as the Plot Type to open.

5. Select OK.

A 2D dot plot  now appears on the layout (with a red border to indicate it is in
selected mode) as previously shown in Figure T2.3 .

You also can insert plots from the Data List  with drag-and-drop .

22.2.4 Inserting from the Data List

To insert a plot:

1. Drag and drop sample by File Name from the Data List to layout (Figure
T2.9).
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Figure T2.9  Inserting a Plot from Data List

A Select Plot Types... dialog will appear as previously shown in Figure T2.8 .

2. Select Dot as the Plot Type to open.

3. Select OK.

A 2D dot plot now appears on the layout as previously shown in Figure T2.3 .

Next, we will insert plots from Windows Explorer .

22.2.5 Inserting from Windows Explorer

FCS Express provides a variety of ways to open and select data files for plots.
These options allow you to choose your preferred method of opening a plot
from a file. In addition to the methods described above, you can select files
directly from Windows Explorer and then plot them with FCS Express.

Note:  Files must be extracted from zipped (compressed) folders.

Opening a new plot with a file from Windows Explorer:

1. Open Windows Explorer.

1702

1697

1704



Tutorials 1705

© 2023 De Novo Software

2. Navigate to the FCS Express Sample Data directory using Windows
Explorer.

3. Select the file GFPcontrol.001 in Windows Explorer.

4. Press and hold down the left mouse button and drag the file
GFPcontrol.001 onto the layout in FCS Express.

5. Release the mouse button.

The Select Plot Types... dialog appears.

6. Select Dot from the Choose Plot Type(s) to open window on the
Select Plot Types... dialog.

7. Click OK.

Figure T2.10  Dragging and dropping data file from Windows Explorer onto the
layout

A 2D Dot Plot of GFPcontrol.001 will now appear on the layout using default
settings as previously shown in Figure T2.3 .

You can force the display of the selection dialog  using by setting a user
preference.

22.2.6 Always Display Selection Dialog

When the default preferences are used, inserting a plot will insert the same data
file as previously selected.  To select alternate files, the When inserting a plot
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or displaying information from a data file, always display the selection
dialog preference can be set in Options.

1. Select the File tab (Figure T2.11, red outline).

Figure T2.11  File Tab from
ribbon

2. Select Options (shown near bottom of Figure T2.12).
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Figure T2.12  Options from
File Tab
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The FCS Express User Options dialog will appear (Figure T2.13).  

Note: options may be accessed from the secondary toolbar at the bottom of
the FCS Express window by clicking Logged in as [...] > Options (Figure
T2.13).

Figure T2.13  Accessing Options from secondary toolbar

3. Select the Files/Directories category from the left column. 

4. Check the box next to When inserting a plot or displaying information
from a data file, always display the selection dialog (Figure T2.14, red
outline). 

Figure T2.14  Files/Directories category of User Options  

5. Click OK.

Now, we will open a data file and insert a 2D plot.
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6. Select the Insert tab group  command.

The Select data file dialog box will appear, as previously shown in Figure T2.2
.

7. Select the file GFPsample.002 from the Select data file dialog.

8. Select Open file. 

An Open 2D Plots dialog for file GFPsample.002 appears (Figure T2.15).  This is
where you can select the desired X and Y parameters for the 2D plot.

9. Select OK to select the default parameters on the Open 2D Plots dialog
box.

1697
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Figure T2.15  Open 2D Plots Dialog
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The 2D dot plot of GFPsample.002 will now appear on the layout as shown in
Figure T2.16.

Figure T2.16  Inserted Plot after editing User
Options

Note: This user preference will be stored.  Enabling this feature all inserted plots
or displaying information from a data file will open a dialog box.   To disable this
feature uncheck the box next to When inserting a plot or displaying
information from a data file, always display the selection dialog (Figure
T2.14, red outline).

22.3 Formatting Plots

All plot types share basic formatting options that include altering the titles, axes,
background, legend, and 3D presentation. These options allow you to customize
the look of your plots.

Although any data files of your own can be used to follow along, you have the
option of using the same sample data files used in this tutorial. The sample data
files are located in the Tutorial Sample Data archive . The layout section4.fey
and the ApoMono.001, ApoMono.002 data files will be used here.
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We will start by using the pop-up menu to format plots .

22.3.1 Formatting Plots Using the Pop-up Menu

In the course of this example, we will:

· Open a Layout file.

· Insert data into a plot.

· Format a plot using the pop-up menu.

1. Select File tab (Figure T3.1).

Figure T3.1  File Tab and Open Command

2. Select the section4.fey layout file located in the Tutorial Sample Data
archive  from the Load Layout dialog (Figure T3.2).

1712
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Figure T3.2  Load Layout Dialog

The layout should have a single blank plot (Figure T3.3).
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Figure T3.3  Section 4 Layout

3. Select the Data tab group and click
Select button to insert a data file into the plot (Figure T3.4).

Figure T3.4  Select Command (Change Data on All Objects)

 

4. Select the ApoMono.001 FCS file located in the Tutorial Sample Data
archive . 

5.  Click Open.

6.  Right-click on the plot so the pop up menu appears (Figure T3.5).
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7.  Select Format from the pop up menu. 

Figure T3.5  Accessing Format Dialog by Right-Clicking Plot

Although we have shown this example using a 2D plot, all objects in FCS Express
have an associated pop up menu and are formatted in a similar manner. Right-
click any object and select Format from the pop up menu.

The Formatting dialog will appear, docked to the right side of the layout (Figure
T3.6).
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Figure T3.6  Pinned Format Dialog

Objects in FCS Express often share several common features, which are
accessible from the drop-down list of the Formatting dialog. This list organizes
all of the different options for a particular object. The specific categories in the list
change depending on which object(s) are chosen to be formatted. When you
select a formatting category, the options displayed below it will show the specific
options that pertain to that category.

Note:  Please save this layout to your desktop if unable to complete the next
tutorial section.

In the next section, we will format multiple plots at the same time .

22.3.2 Formatting Multiple Plots

In the course of this example, we will:

· Duplicate a plot using the pop-up menu.

· Use the docked Formatting dialog from the previous section  to format

multiple plots simultaneously.

1. Right-click the plot to bring up the popup menu.

2. Select Duplicate from the popup menu (Figure T3.7).
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Figure T3.7  Duplicating Plot from Right-Click Popup Menu

A duplicate copy of the plot should appear on top of the original plot as the plot
in selected mode  below (Figure T3.8).1684
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Figure T3.8  Duplicated Plot

3. Move the mouse over the top border of the duplicate plot, the cursor
should change to a four-headed arrow.

4. Hold down the left mouse button while moving the duplicate plot down the
page.

5. Release the mouse button when the duplicate plot is at a desired location.

There should now be two identical plots on the page as shown in Figure T3.9.
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Figure T3.9  Duplicated Plots on a Layout Page

6. Select both plots on the layout (see the tutorial on selecting multiple
objects ).

7. Select Border/Line from category in Formatting dialog (Figure T3.10).
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We will format the border/line of both plots at the same time.

Figure T3.10  Border/Line Category in Format Navigator

8.  Select a solid line (second option) for the Style.

9.  Select Blue as the Color (Figure T3.11).

Figure T3.11  Formatting Border/Line Dialog

Both plots will now have a blue border (Figure T3.12).
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Figure T3.12  Plots with a Blue Border
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12. Click Undo two times from the Quick Access Toolbar  to undo the
formatting changes to the plots (Figure T3.13).

Figure T3.13  Undo

The plots now are restored to their original formatting with no border.

There are many options available for formatting objects using the Format tab
(Figure T3.14). If you hover your mouse over a command on the Format tab, a
brief description of the command’s actions appears.

Figure T3.14  Format Tab

In the next section, we will format plot titles .

22.3.3 Formatting Plot Titles

In the course of this example, we will use the layout from the previous section
to:

· Acquire an overview of formatting plot titles.

· Change the title text.

· Change the title font.

· Change the shadow size.

· Change the alignment of the title.

· Change the footer properties.

· Insert keywords.

To change the plot title:

1. Select top plot.
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2. Click on the Titles from category drop down in Formatting dialog (Figure
T3.15).

Figure T3.15  Selecting Title Category

The Title category options appear.

3. Select Header from the Header/Footer list box (Figure T3.16, ) if

necessary.

4. Press the Font button (Figure T3.16, ) and increase the font size to 12
pt. 

5. Click OK in the Font dialog.

6. Replace the existing title with the text "Light Scatter" (Figure T3.16, ).

7. Change the Shadow Size to 0 to remove the shadow from the

background of the header (Figure T3.16, ).  

8. Select Right from the Alignment list to right align the title (Figure T3.16,

).
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Figure T3.16  Formatting Title Options

The plot now resembles Figure T3.17.



Tutorials 1725

© 2023 De Novo Software

Figure T3.17  Plot After Updating Title Properties

Now, we will change the footer properties:

1. Select Footer (Figure T3.18, ).

2. Check the Visible check box (Figure T3.18, ) to enable the visibility of
the footer.

3. Delete the $FIL keyword (grey highlighted text in edit box) (Figure T3.18,

.
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Figure T3.18  Deleting $FIL Keyword from Footer Title

4. Click the Insert Token button and select Keyword from Data from the

drop down list (Figure T3.19, ). The Create Keyword dialog will appear.
This allows you to insert any keyword available in the header of the FCS
File as the footer for the plot. As the value of the keyword changes with
data files changing, the plot will update automatically to display the correct
value.

5. Click ellipsis button (Figure T3.19, red outline).
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6. Select the $Date keyword (Figure T3.19, ) in the Please select a
keyword dialog. This will be the information displayed in the footer -
acquisition date - and click OK. Click OK to close Create Keyword dialog.

7. Uncheck the box next to Background visible(Figure T3.19, ).

7.  Select Right from Alignment to right-align the footer (Figure T3.19, ).
 Click OK to accept changes.

Figure T3.19  Adding $DATE Keyword to Footer of Plot

The Formatting dialog should resemble Figure T3.20.
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Figure T3.20  Title Options after Editing Footer

The plot should resemble Figure T3.21.



Tutorials 1729

© 2023 De Novo Software

Figure T3.21  Changing the Footer Properties

Note:  Please save this layout to your desktop if unable to complete the next
tutorial section.

Next, we will format the plot axes .

22.3.4 Formatting Plot Axes

FCS Express has many axis formatting options, which allow you to customize
the appearance of the axes as necessary. You have full control over the axis
text, font, colors, and many other aspects of its appearance.

In order to demonstrate modifying the axis properties, we will continue with the
layout we were using previously .

In the course of this example, we will:

· Acquire an overview of formatting axes.

· Modify the axis font properties.

· Add grid lines to a plot.
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· Change the angle of the axis labels.

To format the axes:

1.  Select the Axes category in the Formatting dialog (Figure T3.22).

Figure T3.22  Selecting Axes Category

2.  Click on the Y Axis (Figure T3.23, ) if necessary to set the properties
for the Y axis. 

3.  Click on the Font button under Title (Figure T3.22, ) and change the

font to Bold (Figure T3.23, ). 

4.  Click OK in the Font dialog.

5.  Check the box next to Visible under Grid lines (Figure T3.23, ).
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Figure T3.23  Formatting Y Axis of Plot

6.  Click X Axis (Figure T3.24, ) to set the properties for the X axis.

7.  Click on the Font button under Title (Figure T3.24, ) and change the
font to Bold. 

8.  Press OK on the Font dialog to accept the font changes.

9.  Change the Angle under Title (Figure T3.24, ) to 10. 
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Figure T3.24  Formatting X Axis of Plot 

The axes of the plot are modified now, and it should resemble Figure T3.25.
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Figure T3.25  Plot after Formatting Axes

In addition to changing the parameters displayed on the axis or axes of a plot via
the Format window, you may use these keyboard or mouse commands .

Note:  Please save this layout to your desktop if unable to complete the next
tutorial section.

In the next section, we will format the plot background .

22.3.5 Formatting Plot Background

FCS Express also allows complete flexibility in formatting the background of your
plots. Almost every object in FCS Express has the same background options as
the ones we describe below. The background of any object can display any solid

371
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color, a gradient of colors, or an image. Many objects can also be set to be
transparent. The plot background options are unique in that they also allow you
to adjust the plot margins.

In order to demonstrate modifying the background properties, we will continue
with the layout from the previous section . In the course of this example, we
will:

· Acquire an overview of formatting the background.

· Modify the background gradient.

· Modify the plot margins.

To format the background:

1. Select Fill category in the Formatting dialog (Figure T3.26, ).

2. Click the Gradient radio button (Figure T3.26, ).

3. Change the Right Margin to 8% (Figure T3.26 ). This will move the
right plot margin, allowing you to see the last axis label that is cut off in
Figure T3.21 .
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Figure T3.26  Formatting Fill Options
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The plot background now has been modified to display a gradient background as
shown in Figure T3.27.

Figure T3.27  Plot after Formatting Fill

Next, we will format the legend .

22.3.6 Formatting the Legend

Legends are useful to describe the data presented in your plots and to help
distinguish between several data files that are overlaid onto a single plot.

In the course of this example, we will:

· Learn how to add an overlay to a histogram.

· Acquire an overview of legend formatting.

· Change the legend font.

· Change the legend position.
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Note: If the When inserting a plot or displaying information from a data
file, always display the selection dialog preference is selected all inserted
plots or displaying information from a data file will open a dialog box.   To disable
this feature uncheck the box next to When inserting a plot or displaying
information from a data file, always display the selection dialog (Figure
T2.14, red outline).

In order to format the legend, we will first create a histogram with an overlay.

1. Open a new layout.

2. Insert a histogram and choose the data file ApoMono.001 in the Select
data file dialog. If you do not know how to insert a histogram, see the
Inserting Plots  chapter of this tutorial.

3. Right-click the histogram.

4. Select Add Overlay from the pop-up menu.

5. Choose the ApoMono.002 data file without changing any other property.

6. Press OK to add the overlay.

The histogram should resemble Figure T3.28. If the legend is already on your
plot, your preferences may be set to add legends automatically.

Figure T3.28  Histogram with Two Overlays
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To format the legend:

1. Double-click the histogram. The Formatting dialog appears, displaying the
General category, and is docked to the right of the layout.

2. Select the Legend category.

3. Check box next to Visible if necessary (Figure T3.29, ).

4. Click the Font button (Figure T3.29, ).

5. Change the Font to Times New Roman, Font style to Bold, and Size to
10 in Font dialog.

6. Press OK in the Font dialog to accept the changes.

7. Change the Position drop-down to Top (Figure T3.29, ).

Figure T3.29  Formatting Legend Properties

The plot should resemble like Figure T3.30.
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Figure T3.30  Histogram with Formatted Legend

Note:  Please save this layout to your desktop if unable to complete the next
tutorial section.

Overlays can be formatted either as stacked or overlaid .

22.3.7 Formatting Histogram Overlays

In the course of this example, we will learn how to change histogram overlays to
stacked.

For convenience, we will use the same layout from the previous section . 

1.  Select the histogram if necessary.

2.  Choose the Specific Options category in the docked Formatting dialog.
Alternatively, you can click the Format tab group
Options command (Figure T3.31, red outline). 

Figure T3.31  Format Tab and Specific Options Command from Ribbon
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A Formatting Histogram Specific Options dialog will appear (Figure T3.32).

3. Click radio button next to Stacked under Display Multiple Overlay Data
option (Figure T3.32, red outline).
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Figure T3.32  Formatting Specific Options
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The histogram will change to stacked (Figure T3.33).

Figure T3.33   Stacked Histograms

Use Undo to change the histogram overlays back to overlaid by pressing Ctrl+Z
on your keyboard.

The histogram will change back to the overlaid style (Figure T3.28 ).

Note:  Please save this layout to your desktop if unable to complete the next
tutorial section.

Certain plots can be formatted in 3D .
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22.3.8 Formatting 3D Options

FCS Express also allows you to view your histogram in 3D, which will be
completed using the layout from the previous section .

In the course of this example ,we will:

· Acquire an overview of the 3D options.

· Turn 3D on.

· Change the 3D percent.

We will use the histogram shown in Figure T3.30 .

1. If Formatting dialog is not open, double-click histogram.

a. If open, select 3D category (Figure T3.34, blue highlighted text).

Figure T3.34  Selecting 3D Category

2. Check box next to View in 3 Dimensions (Figure T3.35, ).

3. Change the 3D % to 100% (Figure T3.35, ). Use arrow keys if needed
after clicking slider to adjust more easily.

4. Adjust the Zoom slider to 85% (Figure T3.35, ). Use arrow keys if
needed after clicking slider to adjust more easily.

5. Adjust the Vertical offset slider to approximately 10% (Figure T3.35, 
). Use arrow keys if needed after clicking to adjust more easily.
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Figure T3.35  Formatting 3D Options

The plot before modification Figure T3.36.
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Figure T3.36 Histogram with two Overlays
before using 3D feature.

The plot should now resemble Figure T3.37.

Figure T3.37  Histogram with 3D Overlays
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22.4 Gating

In FCS Express, you can use various gate types as tools for flow cytometry data
analysis: ellipse, rectangle, polygon, freeform, marker, quadrants , well , and
combination gates. This tutorial will demonstrate how to create, manipulate, and
apply gates. More information on gates can be found in the Analysis of FCS Data
chapter of the manual .

The first section, will introduce creating gates .

22.4.1 Creating Gates

In the course of this example, we will:

· Open a previously created layout.

· Create four gates - rectangle, ellipse, polygon, and freeform.

· Change the data file displayed in plots.

· Create a 1D gate on a 2D plot.

· Convert a 1D gate from a marker.

· Convert a quadrant to a gate.

Although any data files of your own can be used to follow along in this tutorial,
you have the option of using the same sample data files used in this tutorial. The
sample data files are located in the Tutorial Sample Data archive . The
section5.fey layout and the ApoMono.001 and ApoMono.002 data files will be
used here.

To Open a Layout:

1. Select File tab (Figure T3.1 ).

2. Select the section5.fey layout file located in the Tutorial Sample Data
archive  from the Load Layout dialog.

3. Select the Data tab group and click
Select button to insert a data file into the plot (Figure T4.1, red outline).
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Figure T4.1  Select Command to Change Data on All Objects from Ribbon

4.  Select the ApoMono.001 FCS file located in the Tutorial Sample Data
archive . 

5.  Click Open file.

The layout should resemble Figure T4.2.
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Figure T4.2  Section5 layout after loading ApoMono.001

We will create four different gates, making one on each of the different plots on
Page 1 of the layout.

While using the commands from the Create Gates groups on the Gating tab
(Figure T4.3) may be the most convenient way to create gates, all gates, except
markers and well gates, can be created using Create Gate from the 2D plot
pop-up menu (right-clicking on a plot brings up a pop up menu). The Gating
commands are shown in Figure T4.3 and described in the table below.
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Note: Gating of data obtained from multiwell plates with Well Gates will be
discussed in a subsequent tutorial (see Analyzing Data in Heat Maps  section).

Figure T4.3  Gating Commands

Symbol Description

Insert an elliptical gate

Insert a rectangular gate

Insert a polygonal gate

Insert a freeform gate

Insert a marker

Insert a quadrant

If you hover your mouse briefly over any of the commands in the Create Gates
group, a hint describing the command is shown.

To see the gating command hint (Figure T4.4):

6. Move the mouse over the Rectangle gate button.

7. Pause briefly.

Figure T4.4  Viewing Gate Hint

To create a Rectangular Gate:

8. Click the Gating Create Gates group  command (Figure

T4.3, ).

2236
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You will know it is selected because it will have a darker grey background

. 

We will create the rectangular gate on the upper left density plot (referred to as
"Create the Rectangle gate on this plot") (Figure T4.5).

Figure T4.5  Density Plot for First Gating
Excercise

9.   Move the cursor on the plot wherever you would like the gate to begin.

10. Click and hold the left mouse button.

11. While holding, drag cursor across events to gate. (Figure T4.6).

12. Release the mouse button.

Create the rectangular gate on this plot.
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Figure T4.6 Creating a Rectangular Gate

The Create New Gate dialog will appear (Figure T4.7). We can now give the
gate a name.

13. Enter "Whole Cells" in the Create a new gate named field.

14. Click OK to accept the name.

Figure T4.7  Create New Gate Dialog
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The gate and a text box displaying the gate name and the % of gated cells will
appear in the plot (Figure T4.8).

Figure T4.8  Newly Created Rectangular Gate

Note: You can cancel the creation of gates anytime during actions outlined in
steps 7-12 by pressing ESC on the keyboard. This technique applies to all types
of gates.

To create an Ellipse Gate:

15.Select the Gating  command (Figure T4.3, 
).

You will know it is selected because it will have a darker grey background

.

We will create the elliptical gate on the upper right density plot (referred to as
"Create the elliptical gate on this plot").

16.Follow steps 8-11 above to create the elliptical gate.

17. Enter "Cells in ellipse" in the Create a new gate named field of the
Create New Gate dialog.
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18. Press OK to accept the name.

The gate and a text box displaying the gate name and the % of gated cells will
appear in the plot (Figure T4.9).

Figure T4.9 Newly Created Elliptical Gate

To create a Polygon Gate:

We will create the polygon gate on the lower left  density plot (referred to as
"Create the polygon gate on this plot").

19. Select the  command (Figure T4.3, ).

You will know it is selected because it will have a darker grey background

.

20. Move the cursor on the plot wherever you would like the add the first
point of your polygon gate.

21. Click the left mouse button. The first point of your gate is created.

22. Move the cursor on the plot wherever you would like the add the second
point of your polygon gate and click.

23. Repeat steps 19-21 until you want to close the polygon.
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24. Close the polygon gate by clicking on the first point created in step 20.
Alternatively, you can press the space bar to close the polygon.

A Create New Gate dialog will appear, similar to Figure T4.6. We can now give
the gate a name:

25. Enter "Cells in polygon" in the Create a new gate named edit field.

26. Click OK to accept the name.

The gate and a text box displaying the gate name and the % of gated cells will
appear in the plot (Figure T4.10).

Figure T4.10   Newly Created Polygon
Gate

To create a Freeform Gate:

We will create the freeform gate on the lower right density plot (referred to as
"Create the freeform gate on this plot").

27. Select the  command (Figure T4.3, 
).

You will know it is selected because it will have a darker grey background

.

28. Move the cursor to the place where you want to start the gate.
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29. Click and hold down the left mouse button.

30. Move the cursor while holding the mouse button down to create the
shape of the gate. A line will follow the cursor showing where the gate will
appear.

31.Release the mouse to finish creating the gate.

A Create New Gate dialog will appear, again similar to Figure T4.7.  We will
name the gate:

32. Enter "Cells in freeform" in the Create a new gate named edit field.

33. Click OK to accept the name.

The gate and a text box displaying the gate name and the % of gated cells will
appear in the plot (Figure T4.11).

Figure T4.11  Newly Created Freeform Gate

Note:  Please save this layout to your desktop if unable to complete the next
tutorial section.

In the next section, we will create a 1D gate on a 2D plot .1756
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22.4.2 Creating a 1D Gate on a 2D Plot

1D gates, markers, can be applied to 2D plots as well as single parameter
histograms. 1D gates are unique in the respect that they only gate on data in a
single dimension. We will continue using the same section5.fey layout we were
using in the previous section.

We will now create a 1D gate on the 2D plot underneath where it says "Create
the elliptical gate on this plot" (Figure T4.9 ).

To create a 1D Gate on a 2D plot:

1. Click the Gating tab command, or right-
click on the plot and select from the pop up menu. 

If using the first method from above, you will know the Create Marker

command is selected because it will have a darker grey background .

2. Place the cursor on the 2D plot at the location you want to start the
marker.

3. Press and hold down the left mouse button.

4. While holding the mouse button down, move the cursor from the left to
the right to create a 1D gate in the horizontal direction.  

Note: Moving the cursor from the right to left, or left to right, will create a 1D
gate along the x-axis. Moving the cursor in the vertical direction, either up or
down, will create a 1D gate along the y-axis. In this example, we will create a
gate along the x-axis.

5. Release the mouse button when at the desired location (Figure T4.12).

Create the elliptical gate on this plot.

1746



Tutorials 1757

© 2023 De Novo Software

Figure T4.12  Creating a 1D Gate on a 2D Plot

A Create a new gate dialog will appear, as previously shown (Figure T4.7 ).

6. Enter "Cells in marker" in the Create a new gate named edit field.

7. Choose Orange for Gate Color.

8. Click OK to accept selections.

A 1D gate now appears on the 2D plot (Figure T4.13).

Figure T4.13 1D Gate on a 2D Plot

1746
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Note:  Please save this layout to your desktop if unable to complete the next
tutorial section.

Next, we will create a gate from a marker .

22.4.3 Creating a Gate from a Marker

We will continue using the same layout we were using above in the previous
section.

To create a Gate from a Marker on a 1D plot:

1. Click the Page 2 tab from the Layout Navigation Toolbar (lower left of
the window). You will see a histogram and dot plot displaying the
ApoMono.001 data file. 

2. Select both the histogram and the 2D plot contained in this page by
pressing Ctrl+A on your keyboard.

3. Select the Data tab group
command to display a different data file in the plot (Figure T4.14, red
outline).

Figure T4.14  Changing Data for Plots on Page 2 Using Select Command from
Ribbon

4.  in the Select data file dialog, browse to and select the ApoMono.002
FCS file located in the Tutorial Sample Data archive . 

5.  Click Open file.

The histogram and 2D plot should resemble Figure T4.15.

1758
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Figure T4.15  Histogram and 2D Plot Displaying ApoMono.002

6. Right-click on the histogram to access the pop up menu.

7. Select 
from the pop-up menu (Figure T4.16, blue highlighted text).
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Figure T4.16  Convert Marker to Gate

The Create New Gate dialog will appear (Figure T4.7 ). 

8.  Enter "Marker Gate" in the Create a new gate named field.

9. Press OK to accept the name.

The gate is now linked to the marker because we selected Convert and link in
step 7. When we move the marker, the linked gate will move to reflect the new
marker position. Note you can track gate creation and hierarchy through the
Gate View and Gate Navigator :

To open a Gate View object:

10. Select the Gate View button in the Insert bar (Figure T4.17)

Figure T4.17  Inserting the Gate View Object

11. Click the left mouse button on layout where you want to insert the Gate
View.

1746
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The Gate View will appear (Figure T4.18).  Note the presence of the new
"Marker gate" gate.

Figure T4.18  Gate
View

Note:  Please save this layout to your desktop if unable to complete the next
tutorial section.

In the next section, we will create a gate from a quadrant .

22.4.4 Creating a Gate from a Quadrant

It also is possible to create a gate from a quadrant. It does not matter if the
quadrant is standard, floating, or percentile (for an in-depth description of the
different types of quadrants, see the section on Using Quadrants ). Creating a
quadrant gate is very similar to creating a marker gate.

We will continue using the same layout we were using above in the previous
section.

On the bottom of Page 2 of the layout, you should see a dot plot with
quadrants.

1. Right-click on the dot plot to access the pop up menu.

2. Select  from
the pop-up menu (Figure T4.19, blue highlighted text).

1761

745



FCS Express 7 Manual1762

© 2023 De Novo Software

Figure T4.19  Converting a Quadrant to a Gate

The Create New Gate dialog will appear (Figure T4.7 ).

3. Enter "Quadrant Gate" in the Create a new gate named field.

4. Press OK to accept the name.

The gate now is linked to the lower right quadrant because we selected Convert
and Link above. This means whenever we move the quadrants, the gate also
moves to reflect the new quadrant position.

Note:  Please save this layout to your desktop if unable to complete the next
tutorial section.

It is also possible to create combination gates .

1746
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22.4.5 Creating Combination Gates

Combination gates consist create new gates by combining existing gates with
Boolean operators, which describe how the gates should be combined and follow
the rules of Boolean algebra.

We will continue using the same layout as we were using previously .

As a first step, we will insert a gate view object to keep track of the new gates
we are going to create.

To insert a Gate View:

1. Go to Page 1 of layout if necessary. 

2. Click Insert tab group command (Figure T4.17 ).

3.  Click the left mouse button on the layout where you want to insert the
Gate View.

4.  The Gate View now appears on the layout (Figure T4.20).

Figure T4.20  Gate View on a Layout Page
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To create a Combination Gate:

1. Right-click on the Gate View to access its pop up menu.

2. Select Add Combination Gate (Figure T4.21, blue highlighted text).

                                              

Figure T4.21  Add a Combination Gate

3. The Create Gate dialog will appear (Figure T4.22).

4. Type "My Combination Gate" in the Name field ( ).

5.  Click in the formula field and type "m" ( ).

Notice that the text "marker Gate" is filled in for you. That is because FCS
Express knows that is the only gate that starts with the letter "m".

6.  Type <SPACE> to accept the "marker gate" choice.

7.  Type "o".

8.  Type <SPACE> to accept the "or" operator.
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9.  Type "q".

10. Type <SPACE> to accept the "quadrant Gate" choice.

11. Change the color to Plum ( ).

Figure T4.22  Create Combination Gate Dialog

12. Press the OK button to create the combination gate.

More information about creating combination gates and all the different possible
operators can be found in the section on Creating Gates  in the main part of
the manual.

Note:  Please save this layout to your desktop if unable to complete the next
tutorial section.

Next, we will learn how to move a gate .
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22.4.6 Moving Gates

In the course of this example, we will:

· Activate a gate

· Move a gate

We will continue using the same layout as we were using previously .

1. Click inside the "Whole Cells" gate. This will activate the gate. You know
the gate is activated when there are resizing anchors on the corners
(Figure T4.23, blue circles).

Figure T4.23  Gate Activation after Clicking Inside Gate Shape

2. Press and hold down the left mouse button anywhere inside the gate.

3. While holding the mouse button, move the mouse to reposition the gate.

4. Release the mouse button when the gate is in the preferred position.

Note: You can press Esc on the keyboard while moving a gate (Steps 1-3) to
cancel the action.

Note:  Please save this layout to your desktop if unable to complete the next
tutorial section.
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The next topic is resizing a gate .

22.4.7 Resizing Gates

In the course of this example, we will:

· Resize a gate.

· Resize a gate with multiple vertices proportionally.

· Resize a vertex of a gate with multiple vertices independently.

We will continue using the same layout as we were using previously.

1. Activate the "Whole Cells" gate by clicking inside it (Figure T4.22 ).

2. Move the mouse to the top right resizing anchor of the gate. You will
know you are in the correct place when the mouse cursor changes to a
two-headed arrow. Click and hold down the left mouse button.

3. Move the mouse while holding down the mouse button. An outline of the
gate will move as you move the mouse.

4. Release the mouse button when the gate is in the new, desired position.

Note: You can press Esc on the keyboard while resizing a gate (Steps 1-3) to
cancel the action.

Polygon and freeform gates can be resized proportionally by accessing the outer
set of resizing vertices.

 

Proportional Resizing of Polygon Gates

1. Activate the "Cells in polygon" gate by clicking inside it.

2. Move the mouse to the top right large outer resizing handle of the gate
(Figure T4.24, blue circle). You will know you are in the correct place when
the mouse cursor changes to a two-headed arrow.
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Figure T4.24  Proportional Resizing of Polygon Gate
by Clicking and Dragging Upper Right Resizing Anchor

3. Press and hold down the left mouse button.

4. Move the mouse while holding down the mouse button.  An outline of the
gate will move as you move the mouse.  The gate will change height as
you move the mouse up or down, width, as you move the mouse right or
left, and overall size as you move the mouse in a diagonal direction.

5. Release the mouse button when the gate is sized appropriately.

Resizing Polygon Gate Vertices Independently

1. Activate the Polygon Gate by clicking inside the gate.

2. Move the cursor over the upper left vertex of the polygon gate (Figure
T4.25, blue circle on "Before" plot). You will know you are in the correct
place when the mouse cursor changes to a two-headed arrow.

3. Press and hold down the left mouse button.

4. Move the mouse while holding down the left mouse button. As you move
the mouse, the one vertex will move and all the other vertices of the
polygon gate will remain fixed.



Tutorials 1769

© 2023 De Novo Software

5. Release the mouse button when the vertex of the gate is in the
appropriate location (Figure T4.25, blue circle on "After" plot).

Figure T4.25 - Resizing Polygon Gate Vertices Independently by Clicking and
Dragging a Single Vertex.

Note:  Please save this layout to your desktop if unable to complete the next
tutorial section.   

In the next example, we will delete a gate .

22.4.8 Deleting Gates

In the course of this example we will:

· Delete a gate on Page 1

We will continue using the same layout as we were using previously .

1. Click Page 1 tab

2. Activate the "Whole Cells" gate by clicking in the gate (Figure T4.22 ).
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3. Press the Delete button on the keyboard. A dialog will appear asking if
you want to delete or hide the "Whole Cells" gate (Figure T4.26).

4. Click Delete to delete the "Whole Cells" gate.

Figure T4.26  Deleting Whole Cells Gate

The "Whole Cells" gate has now been deleted from the layout and thus
disappears from the plot.

Note:  Please save this layout to your desktop if unable to complete the next
tutorial section.   

Once gates are created, they can be applied to a plot .

22.4.9 Applying Gates

In the previous sections, we created several gates. We will now learn how to
apply them to a plot.

In the course of this example, we will:

· Apply a gate from the Formatting dialog.

· Apply a gate from the Gating tab.

· Apply a gate from the Gate Navigator.
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We will continue using the same layout from the previous section .

1. Double-click the upper left plot on which the "Whole Cells" gate was
displayed previously.

2. Select the Overlays category in the Formatting dialog (Figure T4.27).

3. Change the Gate drop-down to "Cells in ellipse" (Figure T4.27, red
outline).

1769
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Figure T4.27  Changing Gate Applied from Overlays Category in Format window
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The plot should resemble Figure T4.28; your plot may not be identical because
you may have placed your ellipse gate in a slightly different position.

Figure T4.28  Plot Now Gated on Ellipse
Gate

4. In the upper right plot move the ellipse gate. You will see the plot that is
gated on "Cells in ellipse" update as the gate is moved.

5. Click on the plot that you have gated to place it in edit mode. You will
know it is in edit mode because there will be a green border around the
plot.

The Current Gate field on the left side of the Create Gates group of the Gating
tab will display "Cells in ellipse" (see Figure T4.29), indicating that the current
plot is gated on "Cells in ellipse".
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Figure T4.29  Changing Gate Applied from Ellipse to Polygon

6.  Click on the arrow next to "Cells in ellipse" to drop down the list of
available gates (Figure T4.29, red outline).

7. Select the "Cells in polygon" gate (Figure T4.29, red arrow).

Your plot should only display cells that are in the "Cells in polygon" gate (Figure
T4.30). The plot may not be identical to Figure T4.30 because you may have
placed your polygon gate in a slightly different position.



Tutorials 1775

© 2023 De Novo Software

Figure T4.30  Plot After Changing
from Ellipse to Polygon Gate

8.  Click the View tab gate  command.

9.  The Gate Navigator will appear (Figure T4.31). The Gate Navigator
displays all the current gates and indicates which gate is applied to a plot.

10. Adjust and reposition the Gate Navigator to the side of the layout in
order to have a complete view of your plots.

Figure T4.31  Opening Gate Navigator in Layout

11. Drag and drop the "Cells in freeform" gate onto the 2D plot labeled
"Create the rectangular gate on this plot" (Figure T4.32).
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Figure T4.32  Dragging and Dropping Gate from Gate Navigator to Plot

The "Cells in freeform" gate now is applied to the plot as indicated on the
updated Gate Navigator (Figure T4.33).

Figure T4.33  Gate Navigator Updated

Note: you can also drag and drop a gate from the Gate View (Figure T4.13 )
onto any plot in exactly the same way we did here using the Gate Navigator
above.
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22.4.10 Data Specific Gates

Data Specific Gates (DSGs)  in FCS Express allow you to assign gates to
specific data files that have been loaded in the data list.  Different 2D gate
positions, sizes, and shapes are allowed among data files using DSGs.  These are
stored and used automatically when displaying the associated files or making
calculations when using the Data Specific Gate feature.  

In the subsequent sections of this tutorial, you will learn how to create, access,
delete, and group DSGs within the provided layout using default settings of FCS
Express.

22.4.10.
1

Creating Data Specific Gates

In this section, you will learn the various ways to create a Data Specific Gate. 
This tutorial will show you how to adjust a gate's position, size, and shape to be
separate from the universal placement and specific to the data file(s) of interest. 
The layout used has three plots displaying three different data files and using
Gate 1 to identify a subset of interest:

Plot 1 - TCellSample1.fcs compensated
Plot 2 - TCellSample2.fcs compensated
Plot 3 - TCellSample3.fcs compensated
 
1.  Open the DataSpecificGates.fey layout from the Tutorial Sample Data

folder.
2.  Move Gate 1.  While moving the gate, observe the other two gates move as

well. The default behavior is 2D gates are universal for all samples of the
layout.  Review Moving Gates  for additional information.

3.  On Plot 2, click inside Gate 1.
4.  Click Gating tab Data Specific Gate command (Figure T4.34, red outline).

Figure T4.34  Data Specific Gate Command from Ribbon

5.  Click and drag upper-left anchor of Gate 1 on Plot 2 to resize and make it
smaller.  Release mouse button.  It should resemble Figure T4.35.
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Figure T4.35  Resizing Gate 1 for Plot 2
after Activating Data Specific Gate

Command from Ribbon

6.  Move Gate 1 on Plot 2; it should move independently (i.e. the gate should
not move on plots 1 and 3).  Data file TCellSample2.fcs now has Gate 1 as
a Data Specific Gate.

7.  Click once on Plot 3.
8.  Hold Shift on keyboard and click to move Gate 1 on Plot 3. Release mouse

button and Shift key. Gate 1 will become data specific for TCellSample3.fcs.
 

9.  Click Gating tab Polygon command and create new gate shape on Plot 3,
resembling Figure T4.36, black vertices.

Figure T4.36  Creating New Shape for
Gate 1 on Plot 3



Tutorials 1779

© 2023 De Novo Software

10. Choose Replace an existing gate in Create New Gate dialog and click OK.
11. Click and drag Gate 1 from Plot 1 to white space below it, and then release

mouse button. A new plot should appear, resembling Figure T4.37

Figure T4.37  New Plot from Dragging and
Dropping Gate 1 from Plot 1

12. Change X-axis to FITC-A by clicking axis label and selecting FITC-A from
pop up list.

13. Double-click plot and choose Title category in Formatting dialog and change
"Plot 1" to "Plot 4" (Figure T4.38, red outline).
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Figure T4.38  Editing Plot Title

14. Click Gating tab Rectangle command and create new gate on plot.
15. Enter FITC+ in Create a new gate named field, expand the Gate

Properties section of the dialog and check the check box next to Always
create a Data Specific Gate when moving this gate in Create New Gate
Dialog (Figure T4.39).
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Figure T4.39  Making Data Specific Gate from Create New Gate
Dialog   

Plot 4 should now resemble Figure T4.40.
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Figure T4.40  New Plot after Creating
FITC+ Gate, which is Data Specific Once

Moved

Note:  Please save this layout to your desktop if unable to complete the next
tutorial section. 

22.4.10.
2

Accessing Data Specific Gates

To review accessing Data Specific Gates, we will use the layout from the
previous section , continuing from the last step.  In this section, we will access
Data Specific Gates (DSGs) via the Gate Navigator .

1.  Click View tab Gate Navigator command (Figure T4.41).

Figure T4.41  Gate Navigator from Ribbon

2.  Click + (plus sign) to expand Gate 1 node.  There are nodes for: plots gated
from this gate, Data Specific Gates, and children gates.

3.  Click + next to Data Specific Gates to view data files using the DSGs (Figure
T4.42).
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Figure T4.42  Gate Navigator Displaying Data
Specific Gates for Gate 1

Note: only two DSGs exist for Gate 1 (TCellSample2.fcs and
TCellSample3.fcs data files) because TCellSample1.fcs is using Gate 1's
master position - the universal gate placement as it was drawn initially.

4. To remove a Data Specific Gate and revert to using the master position for
TCellSample3.fcs, right-click the data file name in the Gate Navigator under
Data Specific Gates under Gate 1 and choose Delete (Figure T4.43).  

Alternatively, you may click Gate 1 on the Plot 3 and click Gating tab Data
Specific Gate command to deactivate or remove the data specific gate.

Figure T4.43  Deleting a Data Specific Gate from Gate Navigator

Plots 1-3 should now resemble Figure T4.43.
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Figure T4.43  Master Gate for Plots 1 and 3 While Using Data Specific Gate for
TCellSample2.fcs on Plot 2

Note:  Please save this layout to your desktop if unable to complete the next
tutorial section. 

22.4.10.
3

Grouping Data Specific Gates

If multiple files within a layout should share a unique gate placement distinct from
the universal master position, the files may be grouped within the same Data
Specific Gates(s) rather than creating individual data specific gates for each
sample.

1.  Click Data tab Data List command (Figure T4.44).

Figure T4.44  Data List from Data Tab on Ribbon

2.  Click and drag TCellSample3.fcs from File Name column in Data List and
drop onto TCellSample2.fcs in Gate Navigator (Figure T4.45).



Tutorials 1785

© 2023 De Novo Software

Figure T4.45  Dragging and Dropping File from Data List to Group Data Specific
Gates

A Group will be created for TCellSample2.fcs and TCellSample3.fcs

3. Click + next to Group to view two data files using Data Specific Gate for
Gate 1 (Figure T4.46).  Note the file(s) dropped will become the follower(s) of
the existing Data Specific Gate file (e.g. TCellSample3.fcs will use the placement
of Gate 1 for TCellSample2.fcs).
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Figure T4.46  Displaying Files for New DSG Group

Plots 1-3 should now resemble Figure T4.47.

Figure T4.47  Plots 1-3 with Data Specific Gates Grouped for TCellSample2.fcs and
TCellSample3.fcs

Note: there are no limits to the number of groups created, and groups or
individual files within groups may be removed at any time.  Also, DSG groups
may be renamed in the Gate Navigator by right-clicking Group to be renamed,
choosing Rename, and entering preferred name (Figure T4.48).
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Figure T4.48  Renaming DSG Group

22.5 Text Boxes and Tokens

Text boxes allow you to enter any text in your layout. They support many of the
features found in modern word processing software (i.e. text formatting, tables,
bullets, numbering, and many other advanced features). Text Boxes can also use
hyperlinks  to connect to an existing layout file, URL, and/or a place in the
layout. In addition to standard word processing features, FCS Express also
supports adding tokens to a text box. Tokens  are dynamic pieces of
information that update as gates move or data change. For instance, if you
insert a statistics token in your text box, the value of the token will change as
the data change or when you move a gate.

In the first section, we will cover inserting text boxes .

22.5.1 Inserting Text Boxes

There are several ways to insert a text box, but the two most common
methods are: inserting a default-sized text box, or a custom-sized text box. You
can also add a text box directly into a 2D plot or histogram so that when you
move the plot, the text box will also move.

In the course of this example, we will:
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· Insert a text box.

· Insert a custom-sized text box.

· Insert a text box into a plot.

To insert a default-sized text box:

1. Select File tab group  to create a new layout.

2. Select the Insert tab  command (Figure T5.1).

3. Click anywhere on the layout to place the text box.

Figure T5.1  Selecting the Insert Text Box Command

By default, a text box of 1-inch by 1-inch will appear where you place your
mouse pointer and click your left mouse button on the layout. Note: To change
this default size setting, select File tab and adjust Width
and Height under Default Size section.

The text box will appear in edit mode (green border) with a blinking mouse
cursor (Figure T5.2). This means you now may enter text into the text box.
Entering text is similar to typing in a text box in Microsoft PowerPoint™.
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Figure T5.2 
Empty Text Box

To insert a custom-sized text box:

1. Select the Insert tab group  command.

2. Place the mouse on the layout where you would like the top left corner of
the text box to begin.

3. Press and hold down the left mouse button.

4. Move the mouse while holding down the mouse button. A dashed outline
showing the dimensions of the object will appear as you move the mouse
(Figure T5.3).

5. Release the mouse button once you have enlarged the dashed outline to
the desired size. An empty text box will appear in edit mode (green
border) at that position.

Figure T5.3  Inserting a Custom-sized Text Box

To insert a text box into a 2D plot or histogram:

1. Select  to close the layout from above without saving.

2.  .

3. Browse to and open the layout TextBoxInsertion.fey found in the
Tutorial Sample Data folder.

This layout contains a density plot of APC-A vs. PE-A.
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4. Right-click on the plot. A green border will appear indicating that the plot is
selected and the pop-up menu will appear.

5. Select Add text box (Figure T5.4) from the pop up menu.

Figure T5.4  Adding a Text Box to a Plot

A small text box will appear in the upper left-hand corner of the plot (Figure
T5.5). You can now begin entering text.
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Figure T5.5  Text Box Added to a Plot

The text box now is embedded within the plot. Moving the plot you will also
move the text box. You can also move the text box anywhere within the plot.
For help with moving objects, please see the tutorial on Using Objects .

Select  to close this layout with or without saving as you prefer.

In the next section, we will format the text in a text box .

22.5.2 Formatting Text in a Text Box

The text within a text box can be formatted similar to formatting text in
Microsoft Word™.

In the course of this example, we will:

· Change the font.

· Change the font size.

1685
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· Change the paragraph alignment.

1. Select File tab (Figure T3.1 ).

2. Open the layout TextBoxFormat.fey found in the Tutorial Sample Data
archive .

This layout contains a single text box in the center of the page with the text "This
is a text box" (Figure T5.6). The default settings for text are Arial, 10 pt., and left
alignment.

Figure T5.6 Text
Box

You can change the text by selecting the Text tab on the ribbon (Figure T5.7).
The Text editing commands are very similar to those in Microsoft Word™.

Figure T5.7  Text Formatting Commands

3. Highlight the text in the text box.

4. Change the Font to Courier New.

5. Increase the Font Size to 16pt.

6. Change the Font Alignment to Right.

The text should now look like Figure T5.8 (right panel).

1712
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Figure T5.8  Formatting a Text Box

Next, we will change the text box properties .

22.5.3 Formatting Text Box Properties

In addition to formatting the text within a text box, the properties of the text
box itself (e.g., size, background color, and border style) can also be formatted.

In the course of this example, we will:

· Change the border.

· Change the size.

· Change the background.

We will continue using the same layout we were using in the previous section .

To format the Text Box properties:

1. Right-click in the text box from Figure T5.6 .

2. Select Format from the pop-up menu (Figure T5.9).

1793
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Figure T5.9  Selecting Format from
the Pop-up Menu

The Formatting dialog will appear docked to right of layout.  There are five
categories:

A. General – To change the name of a text box.

B. Size – To change the size of a text box.

C. Fill – To change the background of the text box.

D. Border/Line – To change or add a border to a text box.

E. Authorizations  – To control when objects may be selected or edited.653
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Figure T5.10 Formatting Text Box Dialog

To Modify the Border:

1. Select the Border/Line category in the Formatting dialog (Figure
T5.11). 

2. Select 1.00 points from the Width spin control (Figure T5.11, ).

3. Select Solid Line (second option) from the Style drop-down list (Figure

T5.11, ).

4. Select Black from the Color drop-down list if necessary (Figure T5.11, 
).

Figure T5.11  Formatting Text Box Border

5. Click on the layout to remove the selection highlighting from the text box.

The text box should now look like Figure T5.12 (Right panels).
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Figure T5.12  Text Box with Border

To Modify the Size: 

1. Select the Size category in the Formatting dialog (Figure T5.10). From
this category, you can change you can change the dimensions of the text
box.

2.  Check box next to Lock Aspect Ratio (Figure T5.13, ). This will
maintain the ratio of the text box size relative to the original text box. 

3. Change the Height to 2.00 inches (Figure T5.13, ).

Figure T5.13  Formatting Text Box Size

4. Click on the layout to remove the selection highlighting from the text box.

The text box should now look like the 'After' image on the right of Figure T5.14.
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Figure T5.14  Modified Text Box Size

To Modify the Background of a text box: 

1. Select the Fill category of the Formatting dialog (Figure T5.10).  You can
change the background of the text box here. The default is a solid white
background.

2. Select Gradient for the background (Figure T5.15, ).

3. Change the Start Color to Blue (Figure T5.15, ).

4. Change the End Color to Sky Blue (Figure T5.15 ).

5. Change the Direction to Right to Left (Figure T5.15 ).
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Figure T5.15  Formatting Text Box Fill

The resulting image should now look like the image on the right of Figure T5.16.

Figure T5.16  Text Box with New Background

Select File tab  to close this layout with or without saving as you prefer.
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Next, we will insert and modify a table .

22.5.4 Inserting and Modifying a Table

Tables are another way to insert and organize data in a layout. FCS Express
supports a wide variety of formatting options for tables.

In the course of this example, we will:

· Insert a table into a text box.

· Modify table properties.

To insert a table:

1.  to open a new layout.

2. Insert a text box and have it open in edit mode (green border). For help
with inserting a text box, see "Inserting Text Boxes" .

3. Click the Text tab group  command (Figure
T5.17). (You can also right-click within a text box and select

 from the pop-up menu.)

Figure T5.17  Insert Table Command

The Insert Table dialog will appear (Figure T5.18).

1799
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Figure T5.18  Insert Table Dialog

Here you can select the properties of the new table. The default settings are two
columns and two rows.

4. Press OK to accept the default properties. 

A new table will appear in the text box (Figure T5.19).

Figure T5.19  Table Inserting in a
Text Box

To Modify a Table:
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1. Click inside the table to select it.

2. Select the Text tab group  command (Figure
T5.20) or right-click on the table and select 
from the pop up menu.

Figure T5.20  Table Properties Command

A Properties dialog will appear (left side of Figure T5.21).

Figure T5.21  Table Properties and Default Cells Border Dialogs

3. Select the color Sky Blue from the Fill Color drop-down list (Figure T5.21

). 

4. Click on the Cell Borders… button (Figure T5.21 ). The Default Cells
Borders dialog will appear (Figure T5.21 right panel).

5. Change the cell border Color to Yellow (Figure T5.21 ). 

6. Change Width to 3 (Figure T5.21 ).

7. Press the OK button  on the Default Cells Borders dialog (Figure T5.21

).
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8. Press the OK button  on the Table Properties dialog to accept the

changes (Figure T5.21 ).

The resulting table should now look like the one on the right of Figure T5.22.

Figure T5.22  Formatted Table

Select File tab  to close this layout with or without saving as you
prefer.

We will now proceed to inserting and modifying a token .

22.5.5 Inserting and Modifying a Token

 Tokens can represent items of many types including: statistics, classifiers, file
information, or customized values. You can insert tokens in text boxes. For the
following three sections on tokens, the file we will be using is ApoMono.002
found in the Tutorial Sample Data archive .

In the course of this example, we will:

· Insert a token into a text box.

· Modify the formatting of a token.

To insert a token:

1. Select File tab (Figure T3.1 ).

2. Open the layout TokenInsertion.fey found in the Tutorial Sample Data
archive .

3. Left-click after the word "contains" in the text box containing the
incomplete sentence "The Gate 'Whole Cells' contains." The text box
should change to have a green border, indicating it is in edit mode, and the
cursor should be flashing after the word contains.  Add a space.

1802
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We will be completing this sentence with the statistic # of Cells for Whole Cells
gate.

4. Right-click inside the selected text box where the cursor has been placed
at the end of the phrase from step 3 above.  

5. Select Insert Token from the pop-up menu (Figure T5.23).

Figure T5.23  Inserting a Token

You can also insert a token using the Text tab group
Token command from the Ribbon Bar.

The Insert a Token dialog will appear (Figure T5.24).
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Figure T5.24  Insert a Token Dialog

6. Click Statistic to select if necessary. 

7. Click Insert button at the bottom of the dialog.

A Create Statistic dialog will appear with the Data Source category displayed
(Figure T5.25). There is no need to change the data source since it is already
showing the source as the FSC vs. SSC plot for ApoMono.002 data file.
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Figure T5.25 Create Statistic Dialog--Data Source Category

8. Click on the Statistic Category of the Create Statistic dialog (Figure
T5.26). 

The Statistic page of the Create Statistic dialog will now appear.



FCS Express 7 Manual1806

© 2023 De Novo Software

Figure T5.26  Create Statistic Dialog from Right-Click and Insert Token
Command-Statistic Category

We will select the statistic we want the token to display (Figure T5.26).

9.  Select # of Events in the Statistic list box (Figure T5.26).

10. Select Whole Cells from the Gate list box (Figure T5.26).

11. Click OK.

The statistic (# of events) appears in the text box after the text 'The Gate
Whole Cells contains' and will be highlighted in grey whenever the text box is in
edit mode (green border). The grey background is to show that the text is a
token, not free text, and cannot be directly edited.

12. Push the "space" bar key and type 'events.' in the text box after the
token to complete the sentence.

The text box should now resemble Figure T5.27. The token will appear with the
same text settings as the text already in the box.
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Figure T5.27  Text Box with Token

Note: Tokens can also be inserted into tables.

You can format the font of a token identically to the way you format the font for
normal text, described above. Figure T5.28 shows the same text box as Figure
T5.27 except the font was changed to Courier New, 15pt, and Bold. For more
help on changing text in text boxes, see the section on Formatting Text in a Text
Box .

Figure T5.28  Formatted Token Font

Tokens can also be inserted by dragging and dropping the plot onto the text box.

1791
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To insert a Token by Drag and Drop:

First, we need to delete the token in the text box.

13. Highlight "7525 events." in the text box.

14. Hit the Delete key to delete the token.

15. Left-click on the border of the SSC-H v FSC-H ApoMono.002 plot. The
border of the plot should turn green.

16. Left-click on the green border. The border of the plot should turn red to
indicate it is in selected mode.

17. Click and hold the red border. While holding down the left mouse button,
drag the cursor (Figure T5.29) to the space after the word "contains" in
the text box. 

18. Release the mouse button to drop the plot into the text box.

 

Figure T5.29 Dragging Token from Plot onto Text Box

The Paste Special dialog will appear (Figure T5.30).

19. Select Statistic Token from the Paste Special dialog (Figure T5.30).
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Figure T5.30 Paste Special Dialog

20. Click OK

The Create Statistic dialog will now appear with the Statistic category open
(Figure T5.31)
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Figure T5.31  Create Statistic Dialog from Drag and Drop-Statistic Category

21. Select Whole Cells in the Gate list box (Figure T5.31).

22. Select # of Events from the Statistic list box (Figure T5.31).

23. Select OK.

The number of events will now be inserted as a token, highlighted in grey, after
the word "contains" in the text box (Figure T5.29).

24. Click after the number of events token (highlighted in grey) in the text
box.

25. Push the space bar key and type "events." to complete the sentence in
the text box.

The text box will appear as in Figure T5.32.
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Figure T5.32  Completion of Inserting Token

Select File tab  to close this layout with or without saving as you prefer.

In the next example, we will creating a custom token .

22.5.6 Creating a Custom Token

Tokens can also be customized to create any kind of statistic that you like. In
this example, we will calculate the Apo(+)/Apo(-) ratio in the positive sample file
ApoMono.002. This is calculated by taking the % of positive cells and dividing
them by the % of negative cells.

To insert a Custom Token:

1. Select File tab

2. Open the layout TokenCustom.fey found in the Tutorial Sample Data
archive . 

The layout, shown in Figure T5.42, contains two 2D plots a text box containing
the text "Apo(+)/Apo(-) ratio: ." We will insert a custom token statistic here
(Figure T5.42).

1811
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Figure T5.42  Custom Token Layout (TokenCustom.fey)

3. Click in the text box at the end of the incomplete phrase "Apo(+)/Apo(-)
Ratio: ." 

4. Select the View tab group command (Figure
T5.43).

Figure T5.43  Selecting the Custom Tokens Command

 The Custom Tokens window should now appear (Figure T5.44).

5. Right-click inside the upper half of the Custom Tokens window and select
New Custom Token from the pop-up menu (Figure T5.44). Alternatively,

click on the  button within the Custom Tokens window.
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Figure T5.44  Creating a New Custom Token

7. Type Apo(+)/Apo(-) Ratio into the Name field of the New Custom
Token (Figure T5.45).

8. Press Enter to accept the new name.

9. The Custom Token "Apo(+)/Apo(-) Ratio" should now be highlighted in
blue (Figure T5.45).
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Figure T5.45  Custom Tokens Dialog

To calculate the ratio for this example, we will take the number of events in the
positive population (upper right quadrant) and divide it by the number of events
in the negative population (lower quadrants).

9. Left-click in the lower half of the Custom Tokens window and enter an
equals sign "=" (Figure T5.46).

10. Right-click immediately after the "=" sign to bring up the associated pop
up menu.

11. Select Insert Token from the pop up menu (Figure T5.46).
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Figure T5.46  Entering a Custom Token Formula

An Insert a Token dialog will appear as in Figure T5.24 .

12. Click on Statistic.

13. Click on Insert.

A Create Statistic dialog will appear with the Data Source Category open as in
Figure T5.38.

14. Select 10 - Density - ApoMono.002 (FL1-H vs. FL2-H) as the data
source.

15. Click the Statistic Category (on the left).

The Statistic Category of the Create Statistic Window will appear as in Figure
T5.38. We will now select the statistic that will define the numerator of our
custom token.

16. Select Upper Right in the Select a quadrant drop-down list (Figure
T5.38).

1802
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17. Select Whole Cells in the Gate: drop-down list (Figure T5.38).

18.Select % of Gated Cells from the Statistic: list box (Figure T5.38). 

19. Press OK.

The Custom Tokens Editor  (Figure T5.47) will show the statistic in the formula
field highlighted in light blue. This is the numerator for our custom token. We will
now define the operator and the denominator of our custom token. 

20. Enter the division symbol "/" immediately following the statistic we
inserted in the last steps (Figure T5.47).

21. Right-click after the "/" symbol to bring up the pop-up menu.

22. Select Insert Token from the pop-up menu (Figure T5.47).  

Figure T5.47  Inserting Statistic for Numerator of Ratio in
Custom Tokens 

The Insert a Token dialog box will appear (Figure T5.24 ).

23.Click Statistic

1802
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24.Click Insert

A Create Statistic window will appear with the Data Source Category open .
We will now define the denominator of our custom statistic token.

25. Select 10 - Density - ApoMono.002 (FL1-H vs. FL2-H) as the data
source .

26. Click on the Statistic Category (Figure T5.37).

The Statistic Category of the Create Statistic Window will appear as in Figure
T5.37. We now will select the statistic that will define the denominator of our
custom token.

27. Select Lower in the Select a quadrant drop-down list (Figure T5.48).

28. Select % of Gated Cells from the Statistic: list box (Figure T5.48). 

29. Select Whole Cells in the Gate: drop-down list (Figure T5.48).

30. Press OK.

Figure T5.48  Defining the Denominator for the Custom Token
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30. Click OK. 

The Custom Tokens window (Figure T5.49) will show the upper right quadrant
statistic divided by the lower quadrants statistics in the formula field. The tokens
are highlighted in blue to indicate that they are being treated as numbers rather
than text.

Figure T5.49  Final Custom Token Formula

Now that we have created the custom token for the ratio, we must insert it into
the text box. 

31. Position the cursor to the end of the text "Apo(+)/Apo(-) Ratio: "
within the text box (Figure T5.50). 

32. Select Text tab group  command from the
ribbon (Figure T5.50). Alternatively, right-click after the "Apo(+)/Apo(-)
Ratio: " text to bring up the pop up menu and select Insert Token.
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Figure T5.50  Inserting Token from Text Tab on Ribbon

The Insert a Token dialog will appear with the new custom token
Apo(+)/Apo(-) Ratio:  listed (Figure T5.51).

33. Click Apo(+)/Apo(-) Ratio under Custom to select it as the token to
be inserted.

34. Click Insert to insert the token into the text box.
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Figure T5.51  Selecting the Custom Token

The Apo(+)/Apo(-) Ratio: value of "3.67" will appear highlighted in grey in the
text box (Figure T5.52).
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Figure T5.52  Displaying the Custom Token in the
Text Box

We will now delete the Custom Token and then insert it by dragging it from the
Custom Tokens window.

35. Select the custom token we inserted after the "Apo(+)/Apo(-) Ratio:"
text (you can easily recognize it since it is grey highlighted) (Figure T5.53).

36. Press the Delete on you keyboard to remove the custom token.

The Custom Tokens window should still be on the layout as shown in Figure
T5.53.

37. Click and hold the left mouse button down on the Apo(+)/Apo(-) Ratio
custom token highlighted in blue in the Custom Tokens window (Figure
T5.54).

38. Drag the mouse, while holding the left mouse button down, to the spot
after the Apo(+)/Apo(-) Ratio: text in the text box on the layout page.
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Figure T5.53  Dragging Custom Token onto Text Box

39. Release the mouse button to drop the custom token into the text box.  

The custom token is now reinserted in the text box as shown in Figure T5.54.

Figure T5.54  Reinserted Custom Token

22.5.7 Using Custom Token Display Types

FCS Express has Custom Token display types  which allow you to insert an
interactive Edit box , Check box , or Dropdown list  directly in a layout. 
These new display types provide increased flexibility for Custom Token
appearance and functionality.

In the course of this tutorial you will learn how to:

· Create and use an Edit Box Custom Token.

· Create an use a Check Box Custom Token.

· Create and use a Dropdown List Custom Token.

22.5.7.1 Creating an Edit Box Custom Token

Edit Box  Custom Token display types are used to create an editable box
directly in the layout where you can change Custom Token values, which will
update the original custom token and subsequently any other instance of the
custom token. Values can be numeric or text. In the steps below we will describe
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how to view a token as an Edit box, how to modify the token value, and how to
adjust the width of the Edit Box.

1.  Navigate to the Tutorial Sample Data folder from the File tab .

2.  Open the layout EditBoxTutorial.fey.

The layout contains a table at the top that contains the # of Lymphs token from
the "Lymphs" gate, a user-defined division factor, and a Custom Token value for
the # of Lymphs divided by the division factor (Figure T5.55). The values are all
dependent on Custom Tokens  that were previously created for use in this
tutorial. In the following steps, we will adjust the division factor token to be an
Edit Box that will update the token value immediately in other tokens.

Figure T5.55 - The EditBoxTutorial.fey layout. The Division factor will be adjusted to
be an editable box within the layout in the tutorial.

3.  Double-click the token value "5.00" in the Division Factor column. 

4.  Choose Edit Box from the Display category drop down menu
(Figure T5.56). 

5.  Click OK.
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Figure T5.56  Choosing the Edit box custom token display type.

6.  Click on the text box in the layout to select it. 

Notice that the Division Factor value is now surrounded by a blue box (Figure
T5.57). The blue box represents an editable field for the token value. 

Figure T5.57  Token display type for the division factor is
now an editable box denoted by the blue box surrounding

the token value.
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7.  Delete the value "5" from the edit box.

8.  Enter the value "10" in the edit box. 

Notice that the token value in the "Lymphs /" column header has changed as
well as the token value in the cell underneath the header. Any tokens that are
dependent on the token in the Edit Box will update in real time as the value is
adjusted.

You may also notice that the division factor Edit Box is quite large for the table
size. We will now format the size of the edit box to more appropriately fit the
table (Figure T5.58). 

Figure T5.58  Value in the Edit box has been changed to
10, which modifies the original Custom Token value and

updating any other token or displayed location in the
layout.

9.  Right-click on the division factor edit box in the table. 

10. Choose Format token. 

11. Enter "10" in the Width dialog under the Display category (Figure T5.59).

12. Click OK.  

Figure T5.59  Adjusting the width of the Edit box.
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13. Click on the text box to select it. 

Notice that the edit box size has decreased to a width of 10, thus fitting the table
cell correctly (Figure T5.60).

Figure T5.60  Edit box has been adjusted to a width of 10
to fit within the table cell.

In the next section we will create a Check Box Custom Token display type.

22.5.7.2 Creating a Check Box Custom Token

Check box  Custom Token display types create a check box directly in the
layout that displays the name of the Custom Token. Checking the box returns a
"TrueValue", also equivalent to -1, entry for the Custom Token while unchecking
the box returns a "FalseValue", also equivalent to 0, entry for the Custom
Token. The True or False value of the token can then be used to control any
number of true or false dependent actions such as displaying pages. In the
course of this tutorial we will create a check box Custom Token and use it to
display 

1.  Navigate to the Tutorial Sample Data folder from the File tab .

2.  Open the layout CheckBoxCustomToken.fey.

The layout only contains a Custom Tokens window (Figure T5.61). We will use
the predefined Custom Tokens in the window to work with the Check box
feature. 
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Figure T5.61  Custom Token window with
two custom tokens

 
3.  Drag and drop the Check Box Custom Token by its name from the Custom

Token window onto the layout to insert it.

A text box containing the text "This will be our check box custom token" will
appear as in Figure T5.62 below:

Figure T5.62  Check box custom
token inserted in the layout.

4.  Double-click on the token text of "This will be our check box custom token"
to open the Edit Token dialog.

5.  Choose Check box from the Display type drop down menu within the
Display category (Figure T5.63). 
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Figure T5.63  Choosing the Check box display type from the drop down list.

6.  Click OK. 

A Check box will appear within the text box in the layout where the token was
inserted that displays the name of the Custom Token (Figure T5.64). 

Figure T5.64  When the Custom
Token display type is set to Check
Box, a check box will appear in the
layout displaying the name of the

Custom Token.
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7.  Check the check box in the text box. 

Notice that the value of the token in the Custom Tokens window now changed
to "=TrueValue"

8.  Uncheck the check box in the text box.

Notice that the value of the token in the Custom Tokens window now changed
to "=FalseValue"

The True and False values returned through using the Custom Token display type
of check box can be used elsewhere in the layout. Before we continue using the
True and False values, we will rename the token which will in turn rename the
value in the check box. 

9.  Click on the Check Box Custom Token name within the Custom Tokens
window

10. Press F2, which is the short-cut for the Rename command . Alternatively,
right-click on the token and choose Rename.

11. Enter the text "A New Check Box"
12. Press Enter

Figure T5.65  Renaming the Check box token to rename the text
in the Check box display.
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Once renamed, the token name will appear in the Custom Tokens window with
the new name, and the check box text within the text box will also be renamed
(Figure T5.65). 

We will now utilize the Check box token to display a message when checked /
unchecked. 

13. Drag and drop the Message to Display Custom Token from the Custom
Token window onto the layout to insert it.

14. Check the check box in the first text box containing the Check Box Custom
Token, which was inserted onto the Layout in Step 3.

Notice that the message updates as the Check box is changed. The action
occurs because the Message to Display Custom Token uses an IF Then Else
Custom Token format that evaluates the status of the Check Box Custom
Token (Figure T5.66). If the value equals "-1" (the numeric representation of
"TrueValue"), then "The Check Box Has Been Checked" is returned in the field. If
the value equals "0" (the numeric representation of "FalseValue"), then "The
Check Box Has NOT Been Checked" is returned in the field. The messages
between quotations can be any custom text or can be replaced with any token
or Custom Token values from your layout and analysis. 

Figure T5.66  The message to display custom token uses an IF THEN
ELSE Custom Token format to return values based on the status of the

Check box Custom Token.

In the next section we will create a drop down list Custom Token display type.

22.5.7.3 Creating a Dropdown list Custom Token

Drop down list  Custom Token display types create a drop down list of
comma separated choices entered in the Choices section of the Edit custom
token dialog Display category. The drop down list is useful to choose and display
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a value from a list of predefined entries. In the steps below we will describe how
to create a drop down list for use in a layout.

1.  Navigate to the Tutorial Sample Data folder from the File tab .

2.  Open the layout Dropdownlist Custom Token.fey.

The layout only contains a Custom Tokens window. We will use the predefined
Custom Tokens in the window to work with the Drop down feature. 

 
3.  Drag and drop the Drop Down List Custom Token from the Custom Token

window onto the layout to insert it.

A text box containing the text "This will be our Drop down List Custom Token"
will appear as in Figure T5.68 below:

Figure T5.68  The Dropdown list Custom Token
inserted in the layout.

4.  Double-click on the token text of "This will be our Drop down List Custom
Token" to open the Edit Token dialog.

5.  Choose Drop down list from the Display type drop down menu within the
Display category (Figure T5.69). 
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Figure T5.69  Choosing the Dropdown list display type from the drop down list.

6.  Type "Option 1, Option 2, Option 3" in the Choices (comma separated):
field (Figure T5.70). 

The Edit Drop Down List Custom Token dialog should look like figure 3. Notice
that our choices for "Option 1 - Option 3" are separated by commas. Any text,
tokens, or Custom Tokens may be entered in the dialog as drop down choices
as long as they are separated by commas. 
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Figure T5.70  The Edit Drop Down List Custom Token dialog after entering a comma
separated list of options to display in the Dropdown list.

7.  Click OK. 
8.  Click on the drop down arrow within the text box to reveal the Drop down

choices. 
 
We will now place the Custom Token elsewhere on the layout and observe how
making a choice from the Drop down list updates the token value. 

9.  Drag and drop the Drop Down List Custom Token from the Custom Token
window onto the layout to insert it.

10. Click on the drop down arrow within the text box containing the Drop down
list to reveal the Drop down choices.

11. Choose Option 2. 
12. Choose Option 3.

Notice that the newly inserted text box containing the token from Step 9 now
reflects the value selected from the Drop down list Custom Token display type
(Figure T5.71).
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Figure T5.71  The text "Option 3" appears
underneath the selected Dropdown list Custom

Token display type because "Option 3" is selected
from the list.

22.6 Quadrants and Markers

FCS Express has powerful quadrant and marker features.

For example, quadrants can be set as "standard" rectangular quadrants, as well
as floating quadrants and percentile quadrants. This allows you to analyze your
data with the flexibility that you need.

Markers can easily be created on histogram and markers boundaries can also be
linked to either other markers boundaries or to any other statistics within your
layout.

In the first section, we will set up rectangular and floating quadrants .

In the second section, we will set up percentile quadrants .

Finally, we will create markers on histograms .

22.6.1 Rectangular and Floating Quadrants

In the course of this example, we will:

· Learn how to create rectangular quadrants and move them.

· Learn how to create floating quadrants and move them.

To place a rectangular quadrant and move it:

1. Select File tab .

2. Open the layout QuadTut.fey found in the Tutorial Sample Data archive
. 
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Two density dot plots now appear on the layout.

3. Select the Gating tab group  command
(Figure T6.1).

Figure T6.1  Selecting the Quadrants Command on the Gating Tab

4. Click in the middle of the left density dot plot.

A rectangular or "standard" quadrant now appears on the plot with the center of
the quadrant located where you clicked in the plot. Note that the quadrant is
selected, as indicated by the rectangular symbol in the center of the quadrant
where the lines cross (the central vertex), indicated by the cursor in Figure T6.2.
Also note the quadrants' percentages are placed automatically in the corners of
the plot (Figure T6.2).
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Figure T6.2  Plot with Quadrants

If the quadrant is currently selected, then skip to step 6.

5. Click in the middle of the quadrant at the central vertex to select the
quadrant (Figure T6.2).

6. Hover the mouse over the central vertex of the quadrant; the cursor
should change to a four-headed arrow.

We now will move the position of the central vertex of the quadrant to redefine
the quadrant.

7. Press the left mouse button when the cursor is a four-headed arrow.

8. Continue to hold the left mouse button and move the central vertex to the
desired location.

9. Release the mouse when the quadrants properly define the three
populations in the plot.

Notice that when you move the central vertex, the percentages of the quadrants
change accordingly. The final plot should resemble Figure T6.3.
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Figure T6.3  Redefined Quadrants

We now will insert quadrants on the right plot. In this case, if we try to use a
standard rectangular quadrant, we will not be able to separate the three
populations in the plot, as demonstrated in Figure T6.4.
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Figure T6.4  Improperly Defined Regions Using
Standard Quadrants

To surmount this problem, we will create a floating quadrant on this plot.

1. Select the Gating tab group  command
(Figure T6.1). 

2. Click in the middle of the right plot. 

A standard quadrant will appear similar to Figure T6.4. If the quadrant in right plot
is not already selected then select it.

3. Click the Format tab group  command (Figure
T6.5). 

Figure T6.5  Selecting the Format Quadrants Command

The Formatting dialog will appear, docked to the right, and displaying the
Quadrants category (Figure T6.6).

4. Change the Type of the quadrant from Standard to Floating, second
option in drop-down (Figure T6.6). 
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Figure T6.6  Formatting Dialog Showing Quadrants
Category

5. Click on the right plot in the middle of the quadrant, on the central vertex,
to activate the quadrant.
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Notice that not only does the central vertex show a small square, but also the
ends of the quadrant lines have small squares as well, indicated by the red circles
on (Figure T6.7). The ends of the quadrant lines are now movable vertices.

Figure T6.7  Activated Floating Quadrant

6.  Place the cursor over the small square on the central vertex; the cursor
should change to a four-headed arrow.

7.  Hold down the left mouse button and move the central vertex into the
middle of the three populations on the plot.

8.  Release the mouse button when the central vertex is in the desired
location.

9.  Place the cursor over the end vertex one of the quadrant lines; again, the
cursor should change to a four-headed arrow.

10. Hold down the left mouse button and move the vertex of the quadrant
line along the axes to separate the three populations. 

11. Release the mouse button when the quadrant line node is in the desired
location.

Repeat steps 9 through 11 until all of the vertices of the quadrant lines have
been moved. The final result should resemble Figure T6.8.



Tutorials 1841

© 2023 De Novo Software

Figure T6.8  Floating Quadrants

Next, we will set up percentile quadrants .

22.6.2 Percentile Quadrants

FCS Express allows you to set quadrants according to percentages instead of
manual positioning.

In the course of this example, we will:

· Learn how to set rectangular quadrants using percentiles.

For convenience, we are going to start with the same layout as before. If you
have the previous layout still open, please skip to Step 3.

1. Select File tab .

2. Open the layout QuadTut.fey found in the Tutorial Sample Data archive
. 

3. Select the Gating tab group  command
(Figure T6.1).

4. Click in the middle of the left density dot plot.
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Two density dot plots now appear on the layout with quadrants appearing on the
left plot.

To set a quadrant with percentages:

5. Click once on the left plot to select it.

6. Click the Format tab group  command (Figure
T6.5 ).

The Formatting dialog will appear, docked to the right, and displaying the
Quadrants category (Figure T6.6 ).

7. Change the Type of the quadrants listed in the drop-down menu
from Standard to Both Percentile (Figure T6.9, red arrow). 

Notice the X Percentile and Y Percentile options on the Formatting Quadrants
dialog are now enabled (Figure T6.9, red outline).
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Figure T6.9  Formatting Quadrants Dialog - Setting Type to Both Percentile
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8. Enter "80" in  X Percentile field (Figure T6.9, red outline).

9. Enter "20" in the Y Percentile field (Figure T6.9, red outline).

The quadrants have adjusted automatically and appear similar to Figure T6.10.
The sum of the Upper Left and Lower Left quadrants is approximately 80% (±
rounding errors), and the sum of the Upper Right and Lower Right quadrants is
approximately 20% (± rounding errors).

Figure T6.10  Percentile Quadrants of 80% and
20%

Percentile quadrants are very useful when you have a plot that has a control
population. You can have the quadrants automatically adjust to ensure that a
specific fraction of the cells are in the lower left quadrant. You can then link the
quadrants on the control plot to the quadrants on the sample plots, and all of the
quadrants will update appropriately.

22.6.3 Creating Markers

In the course of this example, we will:

· Open a previously created layout.

· Create a marker on a histogram.

· Resize the marker by acting on the marker boundaries with the mouse.
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Although any data files of your own can be used to follow along in this tutorial,
you have the option of using the same sample data files used in this tutorial. The
sample data files are located in the Tutorial Sample Data archive . The
markers.fey layout and the ApoMono.001 data file will be used here.

To Open a Layout:

1. Select File tab (Figure T3.1 ).

2. Select the section5.fey layout file located in the Tutorial Sample Data
archive  from the Load Layout dialog. A density plot with an Ellipse gate
on it, and an histogram will be displayed on the page (see Figure T6.11
below) 

Figure T6.11 The content of the markers.fey layout.

We will now create a marker on the histogram.

3. Click the Gating Create Gates group  command (Figure

T4.3 , ).
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You will know the button is selected because it will have a darker grey

background . 

We will create the marker on the histogram (i.e. rightmost plot).

9.   Move the cursor on the plot wherever you would like the gate to begin.

10. Click and hold the left mouse button.

11. While holding, drag cursor across the histogram. (Figure T6.12 below).

12. Release the mouse button.

Figure T6.12

13. A marker will now appear on the histogram2D plot (Figure T6.13
below).
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Figure T6.13

22.7 Quadrant/Marker to Gate Linking

One of the many time saving features that FCS Express offers is the ability to
use a quadrant to define a gate. This is useful if you want to use your quadrants
to define a negative (or positive) population and then have your plots show only
cells in the gated population. Markers can also be used to define a gate.

In the first exercise, we will link a quadrant to a gate .

22.7.1 Quadrant to Gate Linking

In the course of this example, we will:

· Link a quadrant to a gate.

· Move a quadrant with a linked gate and watch the gate automatically

update.
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To link a region to a quadrant: 

1. Select File tab .

2. Open the layout Quad2RegionLink.fey found in the Tutorial Sample Data
archive . 

This layout contains three 2D Color Dots of the file TCellSample1.fcs (Figure
T7.1). The left plot is of SSC-A vs PerCP-Cy5.5-A with a gate on Lymphs,
which are colored Red. The upper right plot is of FITC-A vs APC-A gated on
Lymphs with quadrants. The lower plot is a 2D Color Dot Plot looking at PE-Cy7
vs APC and gated on Lymphs.

Figure T7.1  Quad2RegionLink.fey Layout
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3. Right-click the upper right 2D plot of FITC-A vs. APC-A with quadrants
(Figure T7.1, green border).

This will bring up the associated pop up menu (Figure T7.2).

4. Select  from the pop up menu
(Figure T7.2).

Figure T7.2  Converting and Linking the Lower Right Quadrant to a Gate

A Create New Gate dialog will appear (Figure T7.3). Here, we will name the new
gate that will be linked to the lower right quadrant.
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Figure T7.3  Create New Gate Dialog

5. Enter FITC+ in the Create a new gate named field.

6. Change the Gate Color to Green.

7. Click OK.

We will now apply the newly created FITC+ gate, that is linked to the lower right
quadrant, to the lower right 2D plot.

7. Click the lower right 2D plot of PE-Cy7-A vs APC-Cy7-A without the
quadrants. The border will appear green (Figure T7.4).

8. Select the Gating tab (Figure T7.4).

9. Select FITC+ from the Current Gate drop-down list (Figure T7.4, red
arrow).
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Figure T7.4  Selecting the FITC+ Gate for the Lower Right 2D Plot

The 2D plot on the lower right will now appear with only the events found in the
lower right quadrant (Figure T7.5).
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Figure T7.5  Lower Right Plot Gated on FITC+

Because the lower right quadrant is linked to the gate, changing the quadrant
position will also change the FITC+ gate. We will move a quadrant to
demonstrate how the linked gate will also change.

To move a quadrant:

10. Click inside the 2D plot of FITC-A vs APC-A with the quadrants on the
upper right of the layout (Figure T7.6).

11. Click on the central vertex of the quadrant. You will know you have
selected the quadrant for editing because the mouse pointer will change to
a four-headed arrow.

12. While holding the mouse button, move the mouse to the right to
decrease the size of the lower right quadrant (Figure T7.6, red arrow
indicating direction of cursor movement).
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13. Release the mouse button.

The lower right 2D plot PE-Cy7-A vs APC-Cy7-A will update to reflect events
within lower right quadrant and FITC+ gate (Figure T7.6).

Figure T7.6  FITC+ Gate Updated after Quadrant Move

15. Select File tab .

In the next section, we will link a marker to a gate .

22.7.2 Marker to Gate Linking

In the course of this example, we will:

· Link a marker to a gate.
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· Move a marker with a linked gate and watch the gate automatically

adjust.

A marker can also be created directly on a 2D plot by selecting the
 command. For more information on

creating a 1D gate on a 2D plot, please refer to the appropriate section in the
tutorial on Using Gates .

1. Select File tab .

2. Open the layout Marker2RegionLink.fey found in the Tutorial Sample
Data archive . 

This layout contains one 2D plot and two histograms of the file GFPsample.002
(Figure T7.7). The upper left plot is of FSC vs SSC with a gate on Whole Cells.
The upper histogram is of FL1 gated on Whole Cells with a marker M1. The
lower histogram is also a histogram of FL1 but without a marker.

Figure T7.7  Marker2RegionLink.fey Layout

3. Right-click the upper right histogram of FL1 with the M1 marker.
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This will bring up the associated pop up menu.

4. Select  from the pop up
menu (Figure T7.8, blue highlighted text).

Figure T7.8  Converting the Marker M1 to a Gate

A Create New Gate dialog will appear as shown in Figure T7.3 . Here, we will
name the new gate that is linked to the marker.

5. Enter "GFP+" in the Create a new gate named field.

6. Choose Green for Gate Color.

7. Click OK (Figure T7.3 ). 

8. Click inside the histogram of FL1 on the lower right without the marker.
The border will appear green (Figure T7.9).

9. Select the Gating tab as previously shown in Figure T7.4 .

· Alternatively, select the Home tab (Figure T7.9).

9.   Select GFP+ from the Current Gate drop-down list (Figure T7.9, red

arrow).
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Figure T7.9  Applying the GFP+ Gate to the Lower Right Histogram

The histogram on the lower right will now appear with only the events within the
marker M1 (Figure T7.10).
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Figure T7.10  Lower Right Histogram Gated on GFP+

Because the marker M1 is linked to the GFP+ gate, changing the marker
position also updates the gate.

10. Click inside the histogram of FL1 with the marker M1, located in the
upper right of the layout. The border will appear green.

11. Click the left mouse button anywhere on the marker M1 to select it. The
marker will have vertices (left/lower bound, central vertex, and right/upper
bound) when it has been selected for editing (Figure T7.11).
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Figure T7.11  Active Marker M1 with Vertices Indicated by Arrows

12. Move the mouse over the central resizing rectangle. You will know you
are in the correct place because the cursor will change to a four-headed
arrow.

We now will move the entire marker M1 to a new location on the histogram.
Alternatively, we could resize the marker by selecting and moving one or both of
the lower and upper bounds of the marker.

13. Click and hold down the left mouse button on central vertex.

14. While holding down the mouse button (Figure T7.12).

Arrows pointing down will appear indicating the location of the ends of the
marker on the x-axis. On top of the marker will be the channel numbers
indicating the end boundaries of the marker (Figure T7.12).

15. Release the mouse button when the marker is in the desired position
(Figure T7.12).
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16. Figure T7.12  Moving Marker M1

The histogram of FL1 located on the lower right will update to reflect the changes
made to the marker M1 (Figure T7.13).



FCS Express 7 Manual1860

© 2023 De Novo Software

Figure T7.13  Histogram Gated on GFP+ Updated to Reflect Changes made to
Marker M1 Position

22.8 Compensation

Typically, FCS Express imports the compensation matrix that was used when
acquiring the sample. However, you may need to make your own compensation
matrix.
There are two ways to create your own compensation definition in FCS Express:

· The Manual  method allows you to adjust the compensation levels using

sliders that allow you to adjust the amount of compensation.
· The Automatic  method allows you to take single stained controls and

automatically calculate the appropriate compensation values.

FCS Express allows you to quickly and easily set up either compensation
method.  Sometimes, compensation may also introduce digitization errors,
which will be discussed in the Compensation Digitization Error  tutorial. In the
following examples, we will be opening two layouts in FCS Express, which already
have a gate defined on the compensation population of interest.

The first example will show Manual Compensation . 
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22.8.1 Manual Compensation

To adjust the compensation manually: 

1. Select File tab .

2. Open the layout ManualComp.fey found in the Tutorial Sample Data
archive . 

This layout contains two plots. The dot plot of FSC-H vs. SSC-H is showing a
gate based on size (gate 1). The right plot of CD95 PC5 (PE CY5) vs. CD8a PC7
(PE CY7) is gated on gate 1 (Figure T8.1).

Figure T8.1  Uncompensated Plots

3. Right-click on the right density plot of CD95 PC5-A vs. CD8a-PC7-A to
bring up the associated pop up menu.

4. Select  from the pop up menu (Figure T8.2).
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Figure T8.2  Selecting Create New Compensation

A Create a new Compensation dialog will appear (Figure T8.3). 

5. Type "ManualComp" in the Compensation Name field. 

6. Uncheck the box next to "Mark this as the default compensation [...]".

7. Click OK.

Figure T8.3  Create a new Compensation Dialog

An Edit Compensation dialog will now appear (Figure T8.4).
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Figure T8.4  Edit Compensation Dialog

8. Adjust the sliders shown in Figure T8.4 until the 2D plot looks like Figure
T8.5. Note that moving the slider to the right causes the population to
move in the direction of the arrow in the image to the left of the slider.

Be careful not to overcompensate! Proper compensation will require
around 6.0% of CD95 PC5-A - % of CD8a PC7-A and 18.0% of CD8a
PC7-A - % of CD95 PC5-A. 

9. Click OK to select the manual compensation settings.
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Figure T8.5  Manual Compensation using Edit
Compensation Sliders

Manual compensation of the file is now complete.

Note: Sometimes when working with your own data digitization errors
may occur (i.e. picket-fencing). If you wish to correct for the digitization
errors, please see the brief Compensation Digitization Errors  tutorial.

Note: Existing compensations may also be adjusted on a 2D plot. Please
see the Adjusting Compensation Definitions  section of the manual for
more details. 

In the next section, we will use Automatic Compensation .

22.8.2 Automatic Compensation

To create a Compensation Definition automatically from single stained controls: 

1. Select File Open (Figure T3.1 ).

2. Open the layout AutoComp.fey found in the Tutorial Sample Data
archive . 

This is the layout that we are going to use to illustrate how to set up automatic
compensation (Figure T8.6). Typically you would start with a blank layout but we
have inserted plots so you can more easily see your data for the purposes of
this tutorial. The top-left most plot is of FSC vs. SSC data with a gate based on a
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bead population. In order to use the automatic compensation, you need a single-
stained control for every parameter that you wish to compensate as well as an
unstained sample. 

 (Note: The unstained control can be a universal negative, a negative population
defined by a gate, or the negative population with the tube of the positive
control. In this case, we will use an unstained sample)

The following data set contains an Unstained Control, All Color Control, and five
single-stained controls for the following parameters: FITC, PE, PC5 (PE Cy5),
PC7 (PE Cy7), and APC. All of the histograms are gated on the Beads gate and
display the data file and parameter for each control. For example, the top-right
most histogram is the Compensation Controls_FITC Stained Control.fcs file and
the FITC-A parameter is being displayed on the X-axis.
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Figure T8.6  Autocomp.fey Layout

In this example, we are setting compensation for all five single-stained controls.
However, you can set compensation for as many channels as you like, provided
you have a single-stained control for each channel. 

3. Click on the Tools tab group Compensation and
Unmixing command to open the Compensation and Unmixing
navigator (Figure T8.7).
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The Compensation and Unmixing navigator can be moved anywhere on the
screen; it is dockable and pinnable . Please feel free to move it around the
screen or close and reopen as needed while working on this tutorial. 

4. Click on the blue plus button, , to Add a new compensation (Figure
T8.7, red outline).

A text box highlighted in blue will appear with the text New Compensation
(Figure T8.7).

Figure T8.7  Compensation and Unmixing navigator: use to add new
compensations, edit definitions, create Automatic Compensations, and unmix

spectral signatures
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5. Click on the Add data for compensation button, , in the Automatic
Compensation Setup Step 1 - Select single-stained controls window
(Figure T8.7, red arrow).

6. The Standard Open Data Dialog will appear (Figure T8.8).

Note: based on your User Options , the Advanced Open Data Dialog  may
appear. If the Advanced Open Data dialog appears, please select the

 button to access the Standard Open Data Dialog.

Multiple-select the following six files from the Tutorial Sample Data archive
(Figure T8.8):

a. Compensation Controls_APC Stained Control.fcs

b. Compensation Controls_FITC Stained Control.fcs

c. Compensation Controls_PC5 Stained Control.fcs

d. Compensation Controls_PC7 Stained Control.fcs

e. Compensation Controls_PE Stained Control.fcs

f. Compensation Controls_Unstained Control.fcs

1642 1645
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Figure T8.8 - Use the Select Data File window to select all of the files for use in
the Automatic Compensation Setup.

7. Click Open file.

Notice all of the single-stained control files and the unstained control file have
been brought into the Select single-stained control window and have been
assigned the correct parameter and assigned a negative.  You may correct the
Parameters and define the Negative Control used per control as necessary. 
When loading a universal negative, or unstained sample, it is assigned
automatically as the Negative control for each single-stained control (Figure
T8.9).
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Figure T8.9  Files for controls have been added to Step 1 in the Automatic
Compensation Setup and are matched automatically to their respective

parameters.

8. FCS Express will automatically create a page for Scatter Plot and also for
each individual Single Stained control.  

Six new pages will be created (Figure T8.10):

· Scatter Plot

· APC-A control

· FITC-A control

· PC5-A control

· PC7-A control

· PE-A control
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Figure T8.10  Tabs for new pages created from Step 3

The Scatter Plot page contains a plot based on the parameters selected in
Step 2, while the rest of the pages (single-stained control pages) contain a
scatter plot and two histograms for each parameter compensated. The top
histogram shows the positive population from the single stain control for the
parameter, while the bottom histogram shows the negative population from
the universal negative control. A histogram marker has been created
automatically for each positive and negative population. All of the histogram
markers are children of the Scatter Gate, which means adjusting the
Scatter Gate will cause the histogram markers to update in real-time.

We now will adjust the Scatter Gate to refine the single-stained and negative
populations.

To better appreciate plot adjustments, turn on the Multiple Page view by:

9.  Clicking on the View tab group
command.

10. Selecting the Scatter Plot page for the left page.

11. Selecting the FITC-A control page for the right page.  Your screen now
should resemble Figure T8.11.
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Figure T8.11  Clicking the Build Histograms button results in a Scatter Plot page
and a new page for every single-stained control.

12.  Click the Gating tab group command.

13. Draw a gate around the beads population on the bottom plot titled
"Compensation Controls_Unstained Control" of Scatter Plot page;
gate should resemble one on plot in Figure T8.12.

A Create New Gate dialog appears.

14. Chose the Replace an existing gate radio button (Figure T8.12).
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15. Choose Scatter Gate from the bottom of the drop-down list (Figure
T8.12).

Figure T8.12  Creating a gate around the bead population on the plot and
choosing to replace the Scatter Gate with the newly created gate.

16. Click OK. 

Notice that the original scatter gate has been replace with the new one you
defined. It is convenient to replace the original scatter gate because all the
single stained control histograms in the layout are already using that gate. If
we had created a new gate, we would have had to apply that new gate to all
the single stained control histograms. Notice that the subsequent single stain
control histogram pages have updated to use this new gate.

User may also decide to refine markers position in the following pages of the
layout (the ones containing single staining control histograms).

17.The Compensation Matrix and the Spillover Matrix will be created after
introducing the single stained controls into Step 1.

Description of steps performed automatically by FCS Express that can be
adjusted by the user as needed.  
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Note: Individual steps can be modified manually by the user.  Any changes will
result in the Compensation Matrix and Spillover Matrix being automatically
recalculated.

Step 2 - Select Scatter Gate Parameters  (Figure T8.13).

A user can change parameters as preferred by clicking the down arrows to
access drop down lists (Figure T8.13).  FCS Express will automatically
select the X Parameter for Scatter Gate and the Y Parameter for
Scatter Gate.  A user can modify the auto-selected parameters as
needed.

Figure T8.13  Step 2 - Select Scatter Gate Parameters of Automatic
Compensation Setup

Step 3 - View Errors and Warnings (T8.14).

Any errors or warnings that prevent histograms being built in Step 1 for the
AutoCompensation will be found in this step (T8.14). If there was
something wrong with the files or parameters you selected in the previous
step, an error message will appear here to let you know what the problem
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was.  If there are no Errors and Warnings the following message will
appear - Successfully built histograms for AutoCompensation.

Figure T8.14  The View Errors and Warnings in Step 3 alert the user to any
errors that prevented a new page for scatter parameters and a new page

containing a positive control and negative control histogram for each individual
stain.

Steps 4 and 5 of the Automatic Compensation Setup are optional, and we
will them in the next section of this tutorial .

18.Click on Step 6 - Calculate matrices in the Compensations navigator. 
This step allows the user to determine the statistic to use for calculating
the matrices.  The Median is selected by default. Making adjustments to
the statistic will result in recalculating of the matrices.

1880
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*Note: The checkbox next to Recalculate matrix automatically every
time something changes allows FCS Express to modify calculations
based on changes made by the user.  If this box is not checked, the
matrices will not automatically be recalculated and the button Calculate
Matrices will need to be used after any changes are made.

Figure T8.15  Click the Calculate Matrices button to complete your automatic
compensation setup.

Then compensation and spillover matrices will be calculated automatically and
displayed in the Compensation Matrix and Spillover Matrix tabs of the
Compensations navigator. The Editor view (highlighted in red in Figure T8.16
below) can be changed from Matrix Editor to List Editor to view the
compensation definitions in matrix or list form. This may also be done in the
Spillover Matrix tab.

Note: Your values may differ slightly from figure T8.16 due to differences in
how the scatter gate was positioned in steps 15-20 of this tutorial.
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Figure T8.16  The Spillover Matrix created from the Automatic Compensation
Setup. The red box indicates you can change from Matrix Editor to List Editor

view. The Spillover Matrix tab will display the spillover matrix for your
compensation definition.

 We will now switch back to a one page view and apply our new automatic
compensation to a multicolor control.

19. Click on the View tab .

20. Click on the Compensation Samples page tab to move on the first page
of the layout (Figure T8.6).

21. Click on the New Compensation compensation in the Compensation
and Unmixing navigator to select it (Figure T8.17).

22. Drag and drop (by click and holding the left mouse button) the New
Compensation on top of the Compensation Controls_All Colors.fcs plot in
the upper right of the layout (see red arrow in Figure 8.17).
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Figure T8.17  Dragging the New Compensation definition from the
Compensation and Unmixing navigator and dropping it on a plot will apply that

compensation definition to the plot.

The plot will update and show the data properly compensated as in figure
T8.18 below.

Figure T8.18  The All Colors control plot
with the compensation defined in the

Automatic Compensation Setup feature
applied.

Compensation and Spillover matrices also may be added anywhere in your
layout or Microsoft Excel.
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23. Click Compensation Matrix within the New Compensation definition to
select it (Figure T8.19).

24. Drag the Compensation Matrix to an empty space in the layout and
drop it (FigureT8.19).

Figure T8.19  Drag and drop the Compensation Matrix to a blank space in the
layout (red arrow) to insert a text displaying all of the matrix values.
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The compensation matrix now will be displayed in a text box (Figure T8.19).
Steps 27 and 28 can be repeated with a drag and drop to Microsoft Excel if you
would like the matrices displayed there.

At this point the Automatic Compensation Setup is complete although Step 4
- Adjust parameters (optional)  and Step 5 - Add extra spillover
targets (optional)  may also be used to refine your single stain
populations (Adjust parameters ) or to have other targets defined
without defining a source (Add extra spillover targets ). If you would like
to learn more about these advanced features please see the Automatic
Compensation- Optional Steps 4 and 5  tutorial.

Please see the Manual Compensation  tutorial or the Compensation  section
of the manual for more details on compensation in FCS Express.

22.8.2.1 Automatic Compensation - Optional Steps 4 and 5

Please note this tutorial section is for optional steps associated with
compensation and is designed with more advanced FCS Express users in mind.

To adjust parameters and extra spillover targets:

Once you have completed Step 1 of the Automatic Compensation Setup, you
can go through Steps 4 and/or 5. This tutorial will walk you through a sample
compensation setup using these optional steps. If you are not yet familiar with
automatic compensation in FCS Express, please complete the Automatic
Compensation  tutorial before starting this section.

· Step 4 - Adjust parameters (optional)  allows you to define your single-

stained controls on gates other than the default markers created during the
automatic compensation setup.

o  Adjust parameters  is useful when you would like to refine the

populations that are used for calculating compensation. For instance, if the
Automatic Compensation Setup does not make a good estimate of the
population, or if you would like to use a population from another file, gate,
gating hierarchy, or plot Step 4 would prove very useful. Parameters may be
adjusted or changed all together by dragging and dropping a plot or gate onto
the parameter for the Stained and Unstained columns. If a gate is dropped
the compensation definition will be based on that gate and plot it originated
from (keep in mind any gating hierarchy you have defined with a gate will be
used) . If a plot is dropped, the compensation definition will be based on the
plot that you just dropped, with the gating being unchanged. Dragging and
dropping new plots, files, or gates in this section will allow you to override the
automatic setup and use gates and plots of your choice. 

·  Step 5 - Add extra spillover targets (optional)  will allow you to have

other fluorescence targets defined without defining a source fluorescence. 
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o Adding extra spillover targets  is useful if you would like to have an idea

of what spillover would look like if an extra parameter was added in future
experiments. To add an extra spillover target, check the box next to the
extra target you would like to add. Note extra spillover targets will only
appear for parameters that were acquired with the data.  If the detector was
off, the target will not be available.

The layout that will be used for this section of the tutorial is
AutoCompAdditionalSteps.fey and it can be found in the Tutorial Sample Data
archive . In this layout, an automatic compensation setup definition (named
New Automatic Compensation) has already been created using the standard
default setup described in the previous section .  The layout contains 6 pages
as follows:

· Gating Strategy and Sample page: The Gate View on this page shows

the gating strategy that was created automatically by the compensation
setup (purple gates) and the one that we would like to use (red and blue
gates). The plots are arranged starting from the top left to show how the
gating hierarchy has been applied. Follow the green arrows next to each
plot to see how the gates have been applied and defined. The plot labeled
SAMPLE COMPENSATION has the New Automatic Compensation
definition applied to it. The plot off the page to the right is labeled Data
for New Compensation Gates and has no compensation applied to it.
The Data for New Compensation Gates plot has gates drawn on the PE
positive, PerCPCy5-5 positive, and negative populations. These gates will
be used later in the tutorial for the adjust parameters steps.

· Spillover Spreading Matrix page: This page was created automatically

by the Automatic Compensation Setup tool and displays fluorescence
signal interactions.

· Cross Stain Index Matrix page: This page was created automatically by

the Automatic Compensation Setup tool and quantifies the spread of a
given dye into another dye.

· Scatter Plot page: This page was created by the Automatic

Compensation Setup tool and displays the stained and unstained
populations used to calculate the compensation matrix.

· CD 62L YG PE-A control page: This page was created by the Automatic

Compensation Setup tool and displays the current gate used to calculate
the compensation matrix for the PE parameter.

· CD 4 PerCP-Cy5-5-A control page:  This page was created by the

Automatic Compensation Setup tool and displays the stained and
unstained populations used to calculate the compensation matrix for the
PerCPCy5-5 parameter.

866
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In the following steps, we will:

· Adjust the parameters to define new gates for the single stained and

unstained controls.

· Add an extra spillover target to view the potential spillover of another

target.

1.  Select File Open (Figure T3.1 ).

2.  Open the layout AutoCompAdditionalSteps.fey found in the Tutorial

Sample Data archive .

3. Click Tools tab group

command to open Compensation and Unmixing navigator.

4.  Click the + ("plus" sign) to expand the Created manually folder

tab in the

Compensation and Unmixing navigator.

5.  Click the Add data for auto compensation button  in the Automatic

Compensation Setup Step 1 - Select single-stained controls window.

6.  Multiple-select the following files (Figure T8.20) from the Tutorial Sample

Data archive :

· Specimen_001_PE_CD62L.fcs

· Specimen_001_PerCP Cy5-5 CD4.fcs

· Specimen_001_PE_unstained.fcs

1712
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Figure T8.20  Select Data Files to be used in Automatic Compensation Setup

7.  Click Open file.

8. After the data files are added in Step 1 - Select single stained controls FCS
Express will automatically create Spillover Spreading Matrix, Cross Stain
Index Matrix, Scatter Plot, CD 62L control, and CD 4 control pages.

9. Confirm Parameter and Negative control match the Data File as expected
for each control in Step 1 - Select single-stained controls (Figure T8.21)
and table below. If Parameters do not match the data file choose the
appropriate parameter to match the data file from the Parameter drop down
selection.   

Data File Parameter Negative Control

Specimen_001_PE CD62L.fcs 9 - CD 62L Specimen_001_unstained.fcs

Specimen_001_PerCP Cy5-5
CD4.fcs

10 - CD 4 Specimen_001_unstained.fcs

Specimen_001_unstained.fcs Negative
Control

Controls may be matched to itself or an unstained control.  If an unstained
control is loaded with single-stained controls, FCS Express will set it as the
negative control to be used for each single-stained control automatically.  
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Figure T8.21  Parameters set to match data files for controls

Note: Step 2 in Automatic Compensation Setup defaults to FSC-A and SSC-A,
which are the preferred parameters for the scatter plot in this example.

10. Click on Step 4 - Adjust parameters (optional) (Figure T8.22).
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Figure T8.22 Step 4 - Adjust parameters (optional) of Automatic Compensation
Setup

We now will replace the gates that were defined in the Automatic Compensation

Setup with gates we have defined manually. These manually defined gates

represent the following:

· A gating hierarchy has been defined with all of the FSC and SSC parameters

and a Dapi Negative gate. This hierarchy is used to exclude debris and other

unwanted events.

o Negative Control Gate: This gate is a child of the Dapi Negative Gate

hierarchy. It defines a negative or unstained control population.

o PE Positive Control gate: This gate is a child of the Dapi Negative Gate

hierarchy. It defines a PE single color control only population.
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o PerCP CY5-5 Positive Control gate: This gate is a child of the Dapi

Negative Gate hierarchy. It defines a PerCP CY5-5 single color only

population.

11. Click and hold on the Negative Control gate in the gate view (Figure

T8.23).

12. Drag and drop the Negative Control gate onto the cell for Unstained

column in the CD62L YG PE-A row.

13. Click and hold on the Negative Control gate in the gate view.

14. Drag and drop the Negative Control gate onto the cell for the Unstained

column in the CD4 PerCP-Cy5-5-A row.

Figure T8.23  Dragging the Negative Control gate from the gate view to the
Unstained column for both parameters.

Now, the Step 4 - Adjust parameters (optional) section should resemble
Figure T8.24, lower panel.
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Figure T8.24  Paramters in Step 4 section before and after the drag and drop

We previously dragged and dropped the Negative Control gate from the Gate
View. We will now use a plot a source for the drag and drop (Figure T8.25).
 
15. Click and hold on the PE Positive Control gate in the Data for New
Compensation Gates plot (off the right hand side of page).

16. Drag and drop it onto the cell for the Stained column in the CD62L YG PE-
A row.

17. Click and hold on the PerCPCY5-5 Positive Control gate in the Data for
New Compensation Gates plot (off the right hand side of page) (Figure T8.25).

18. Drag and drop it onto the cell for the Stained column in the CD4 PerCP-
Cy5-5-A row.
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Figure T8.25 - Dragging and dropping gates from a plot to the Stained column in
step 3 for each parameter.

Now, the Step 4 - Adjust parameters (optional) section should resemble in
Figure T8.26, lower panel.
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Figure T8.26 Step 4 - Adjust parameters (optional) after dragging and dropping
gates from the Gate View and plot to define the stained and unstained population

columns.

19. The Spillover matrix and Compensation Matrix will automatically be
updated after making these changes.

Notice the spillover matrix for the New Automatic Compensation definition has
changed (see Figure T8.27 below) to reflect the new gating changes. You can
drag and drop any gate or an entire plot to the Stained and Unstained columns
in this fashion to customize your Automatic Compensation Setup. 
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Figure T8.27 The original Automatic Compensation Setup definition (left) compared
to one generated using gates manually defined gating hierarchy from the steps

above.

Another useful trick is to make the Scatter Gate and its children (defined by the
Automatic Compensation Setup) children of another gate that you have defined.
In the following steps we will make the Scatter Gate a child of the Dapi Negative
gate. When the matrix is recalculated the manually entered gating hierarchy for
debris exclusion will be taken into account with the Automatic Compensation
Setup. We will first close the layout and open it again to reset the changes we
have made to the compensations.

20. Select File tab . (Do not save any changes).

21. Select File tab .

22. Open the layout AutoCompAdditionalSteps.fey found in the Tutorial
Sample Data archive .

23. Click Tools tab group
command to open Compensation 

24. Click on + to expand the Created manually folder
 in the Compensation and

Unmixing navigator (Figure T8.22, red box).

25. Click on the Add data for auto compensation button  in the Automatic
Compensation Setup Step 1 - Select single-stained controls.

 Multiple-select the following files (Figure T8.20):

· Specimen_001_PE_CD62L.fcs

· Specimen_001_PerCP Cy5-5 CD4.fcs

· Specimen_001_PE_unstained.fcs

26. Confirm Parameter matches the Data File as expected for Step 1 - Select
single-stained controls as in the table below.

1682
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  Note: Step 2 defaults to FSC-A and SSC-A, which are preferred parameters for
the scatter plot in this example. 

Data File Parameter Negative Control

Specimen_001_PE CD62L.fcs 9 - CD 62L Specimen_001_unstained.fcs

Specimen_001_PerCP Cy5-5
CD4.fcs

10 - CD 4 Specimen_001_unstained.fcs

Specimen_001_unstained.fcs Negative
Control

We will now use Step 5 - Add extra spillover targets (optional) to determine
the theoretical spillover for the FITC parameter.

27. Click on Step 5 - Add extra spillover targets (optional).

28. Check the CD 44 FITC-A check box (Figure T8.28).
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Figure T8.28  Adding extra spillover target in Step 4.

29. Click the Calculate Matrices button in Step 6 - Calculate matrices.

The Spillover Matrix tab will now display all of your original parameters along
with the CD44 FITC-A parameter that you selected in Step 5- Add extra
spillover targets (optional) (Figure T8.29). The column for FITC-A in the
matrix is displaying the theoretical compensation needed against all other
targets.  
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Figure T8.29 The Spillover matrix displaying the extra spillover target that was
added. The compensation values for CD 44 FITC-A vs other sources/targets is the

theoretical value.

This brings us to the end of the tutorial for Automatic Compensation Optional
Steps 4 and 5. Please see the Manual Compensation  tutorial or the
Compensation  section of the manual for more details about compensation in
FCS Express.

22.8.2.2 Automatic Compensation and Batch Processing

In FCS Express, you may define a post-acquisition compensation matrix using
single-stained controls, apply it to your experimental samples, and batch process
your results to Microsoft PowerPoint, PDF, and Word, all within a single layout. 
There is no need to export and import compensation into separate layouts.

In this section, we will:

· Change our default options to use a post-acquisition compensation matrix

as default
· Set an automatic compensation as default for the entire layout

· Insert plots of experimental files in the same layout

· Batch process the results to Microsoft Office PowerPoint

We will begin with a layout in which an automatic compensation was already
defined, using single-stained controls.

1861
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1. Select File Open.

2. Open the layout AutoCompWithBatchProcess.fey from the Tutorial
Sample Data archive . 

An automatic compensation already has been defined in this layout, according to
Steps 1-27 of this section  of this tutorial.  We will set this compensation as
default for the entire layout.

3. Select File Options.

4. If necessary, select Compensation Default, then FCS File from the
Default Compensation to Use drop-down list and click OK (Figure
T8.33).  Learn more about Compensation Default Options .

Figure T8.33  Changing the Default User Option for Compensation

5. Click to expand the Created manually node within the Compensations

window (Figure T8.34, ).
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Figure T8.34  Setting a compensation matrix as default for the layout

6. Right-click on the New Compensation name and choose Set As Default

(Figure T8.34, ).  This matrix will now be marked as default (Figure
T8.34, right).

We will now insert plots of experimental files in the same layout, and watch as
the Compensation Default matrix is automatically applied.

7. Drag the first file from the Data List to an empty spot on the layout

(Figure T8.35, ).
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Figure T8.35  Inserting a plot on the layout

8. Click OK (Figure T8.35, ).

9. Click and change the X- and Y-axis labels to change the parameters

displayed on the newly-inserted plot to "CD95 PC5-A" (Figure T8.36, )

and "CD8a PC7-A" (Figure T8.36, ), respectively.
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Figure T8.36  Changing axis parameters

The Compensation Default matrix has been applied automatically to the plot. 
You may verify this is true in the following ways:

· Manually changing the values in the Compensation Matrix from the

Compensations window and watching the events update (Figure T8.37, cell in
matrix for PC5-A vs PC7-A)
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Figure T8.37  Editing a compensation matrix manually

· Right-clicking the plot to see the name of the compensation applied (Figure

T8.38)

Figure T8.38  Compensation Name Applied to Plot

· Double-clicking the plot or right-clicking it and choosing Format to view the

Compensation in the Overlays category of Formatting dialog (Figure T8.39)
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Figure T8.39  Compensation Information from Formatting dialog
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We now will perform a Batch Process to export the results from all the files in
our Data List to PowerPoint.  The Batch Process Action has already been set up
for convenience.  To learn more about this functionality, see the Batch
Processing tutorial  or the short Batch Processing video on YouTube.

10.  Click Batch Run command (Figure T8.40).

Figure T8.40  Running a Batch Process from
Ribbon

A PowerPoint file with the results from all the files in your Data List has now
been saved on your Desktop.  If the PPT file does not open automatically, please
change the Export to PowerPoint's Output file options save path to a valid one
for your computer.  See the PowerPoint section of the Batch Processing
tutorial  for details.

22.8.3 Compensation Digitization Error

Sometimes, compensation will introduce a digitization error as seen in the red
box in Figure T8.41. The digitization error of the FL1-H (+) population in the
lower right quadrant after compensation (figure T8.30) can be corrected easily
by adding a range of random values. Digitization errors and adding a range of
random values is further discussed in Editing a Compensation Definition  topic.
Please follow the steps below to learn how to correct for digitization errors.
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Figure T8.41  Digitization errors can be seen highlighted in the red box.

1.  Select File tab .

2.  Open the layout ManualComp.fey found in the Tutorial Sample Data
archive . 

3.  Click on the Digitization Errors page tab.

Notice the digitization error of the FL1-H (+) population in the lower right-hand
quadrant after compensation. To correct for the digitization error: 

4.  Select the 

command.

5.  Select the Create Manually folder compensation

definition (figure T8.42).

1682
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Figure T8.42  Selecting the DigitizationError compensation definition

6.  Type 2.0 in the Range of random value to add when converting log data

field (indicated by red box in Figure T8.43). 
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Figure T8.43  Updating value to 2.0 for Range of random value to add when
converting log data field

The plot will update in real-time to reflect the change and the FITC(+) population
in the lower right quadrant will now appear without the digitization error (Figure
T8.44). The random value entered above was added to visually correct the data
displayed in the 2D plot.
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Figure T8.44  Changing the Range of random value to add when converting log
data to 2.0.

22.8.4 NxN Plots

In this tutorial, we will utilize the multi plot feature in FCS Express to create NxN
plots for parameters involved in the compensation matrix.  A plot will be created
displaying the fully-stained sample in two overlays, black and red, to compare
compensations created in the software or on the instrument during acquisition,
respectively.

1. Click File tab Open and select NxNComp.fey layout from the Tutorial
Sample Data folder.

2. Drag and drop CompensationControls_AllColors.fcs by its File Name from

the Data List to the plot on Page 1 (Figure T8.42).

https://s3.amazonaws.com/fcsexpressdownloads/TutorialSampleDataV7.zip
https://s3.amazonaws.com/fcsexpressdownloads/TutorialSampleDataV7.zip
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Figure T8.42  Dragging and Dropping Second Data File to Overlay with Negative on
Plot  from Data List
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3. Click radio button next to add the files to the plot as new overlays and

click OK in Select Drag and Drop Action window.

4. Click plot to place it in edit mode  (green border).

5. Click Plot tab NxN Plots Compensated command (Figure T8.43, grey).

Figure T8.43  Plot Tab from Ribbon

5. Click and drag resizing anchors to enlarge NxN plot.  It should now resemble
Figure T8.44.

Figure T8.44  Resized NxN Plot

Note: The black overlay represents the software compensation (called New
Compensation), while the red overlay represents the compensation created and
written to the file during acquisition, which can be confirmed by reviewing the
Compensation selected for each overlay in the Formatting dialog's Overlays
category (Figure T8.45).  To access this information, double-click or right click
the plot from Step 2 and choose Format.

1684
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Figure T8.45  Overlays Category for Parent Plot Used
to Create NxN Plots

22.9 Snapshots

Snapshots  provide a convenient way to easily save multiple gate, quadrant, or
marker positions and to apply these positions for quick access across samples in
your analysis.

1207
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Snapshots can be applied during Batch Processing , Iteration Navigation , and
independently through the Snapshots window .

These tutorials will highlight these tools and how they can be utilized during
analysis.

· Snapshot Window Tutorial

· Iteration Snapshots Tutorial

· Batch Processing Snapshots Tutorial

We will start by focusing on the Snapshot Window .

22.9.1 Snapshots Window

In this tutorial:

· We will learn how to take Snapshots through the use of the Snapshots

window.

· We will learn how to apply Snapshots to the data in the layout.

· Although any data files of your own can be used to follow along in this

tutorial, you have the option of using the same sample data files used in this
tutorial. The sample data files are located in the Tutorial Sample Data
archive .

1.  Navigate to the Tutorial Sample Data folder from the File tab

2.  Open the layout SnapshotWindow.fey.

This layout contains 2 color dot plots, 2 density plots and a 1D histogram.  Three
data files are loaded into the Data List, which is docked  to the right side of the
layout.  We will navigate and analyze through these 3 files and make
adjustments to the gates, quadrants, and markers used to analyze the data. 
Once we adjust the various gates, we will take a snapshot.

3.  Open the Snapshots navigator from Tools tab
group  command (Figure T9.1).
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Figure T9.1  Snapshots from Tools Tab on Ribbon  

We will begin by taking a snapshot of the current state of the layout.  

4.  Click on the Create a new Snapshot button ( ) in the Snapshots
navigator.

5.  Replace the text "New Snapshot" with "Baseline" in the Snapshot name
text area.

Once the snapshot is taken, FCS Express will show a time stamp for that
snapshot (Figure T9.2).
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Figure T9.2  Baseline Snapshot with a Timestamp

6.  Navigate to the next iteration by clicking on Iteration 2 in the Data List, as
seen in Figure T9.3.
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Figure T9.3  Navigate to the Next Iteration By
Clicking on Iteration Number 2

The steps below are highlighted in Figure T9.4.

7.  Adjust the Red gate to include the majority of the cells in the cluster. (Figure

T9.4, )

8.  Right-click the BV605 vs BV421 plot. (Figure T9.4, )

9.  Select Show Quadrants.

10. Move the quadrant in the APC-H7 vs APC plot to a new position. (Figure

T9.4, )

11. Adjust the Marker on the 1D histogram of APC. (Figure T9.4, )
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Figure T9.4  Before Adjusting Gates

After adjustments, the layout should resemble Figure T9.5.
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Figure T9.5  After Adjusting Gates

12. Repeat Step 4 to record a new Snapshot. 

13. Replace the text "New Snapshot" with "Adjusted" in the Snapshot name text
area.

14. Navigate to the next iteration by clicking on Iteration Number 3 in the Data
List.

We will now apply the Baseline snapshot from step 5 to Iteration 3.

15. Click and hold the text "Baseline" in the Snapshots navigator to select the
snap shot.

16. Drag the "Baseline" Snapshot from the Snapshots window to the layout, as
seen in Figure T9.6. 

          Alternatively, you may apply the snapshot by selecting the snapshot as in

step 15 and clicking on the Apply Snapshot button  in the Snapshots
navigator.
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Once the snapshot has been applied, all gates and coordinates captured by that
snapshot will be applied to the data. Repeating steps 15 and 16 with the
"Adjusted" snapshot will apply that snapshot to the layout (Figure T9.7).

Figure T9.6  Dragging and Dropping the Baseline Snapshot to Apply It to Iteration 3
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Figure T9.7  Layout after Dragging and Dropping Baseline Snapshot to Apply to
Iteration 3

In the next section, we discuss on how to automatically apply snapshots while
navigating through each iteration .

22.9.2 Iteration Snapshots

In this tutorial:

· We will learn how to take Snapshots through the use of the Apply

Iteration Snapshot tool.

· We will learn how to navigate through our data by using the

Previous/Next buttons or through the Iteration drop down list on the
Data tab.

· We will learn how to Flag an iteration for review later on during analysis.

· Although any data files of your own can be used to follow along in this

tutorial, you have the option of using the same sample data files used in this
tutorial. The sample data files are located in the Tutorial Sample Data
archive .

1915
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1.  Navigate to the Tutorial Sample Data folder from the File tab

2.  Open the layout IterationSnapshots.fey.  

This layout contains 4 density plots and a 1D histogram and is currently
displaying the first iteration of three loaded into the Data List.

3.  Select the Tools tab  button (Figure
T9.8).

Figure T9.8  Apply Iteration Snapshot Command from Tools on Ribbon

 

4.  Click the Next button (double-headed right arrow) in the Data tab
Data on All Objects category to advance to the next iteration.

Alternatively, you can advance to the next iteration by selecting 2 from
the Data tab  drop down
menu, or by clicking 2 from the Iteration column in the Data List.

The content of the layout should now be similar to Figure T9.9.

We now will make the adjustments for the 2nd iteration according to the steps
below and as seen in Figure T9.9:

5.  Adjust the red gate around the cluster on the SSC vs V500 plot (Figure T9.9,

 ).

6.   Adjust the purple gate around the cluster in the right of the BV421 vs

BV605 plot (Figure T9.9, ).

7.  Right-click the FITC vs BV605 plot (Figure T9.9, ).

8.  Choose Show Quadrants.



Tutorials 1917

© 2023 De Novo Software

9.  Adjust the M1 marker to capture entirely the peak on the APC 1D histogram

(Figure T9.9, ).

Figure T9.9  Steps for Iteration 2

After these adjustments, the layout should resemble Figure T9.10.
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Figure T9.10  The layout after adjusting gates as instructed in steps 5-9

We now will Flag the iteration for use later in the tutorial.

10. Click the Flag this Iteration button in the Data tab
Objects group (Figure T9.11, red outline).

Figure T9.11  Flagging Second Iteration via Data Tab on
Ribbon

Once the 2nd iteration is flagged, you will see a new icon within the Data List,
next to the 2nd iteration: .
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We will come back to the Flagged iteration in the next tutorial section, Batch
Processing Snapshots .

11. Click the Next button (double-headed right arrow) in the Data tab
Data on All group to advance to the third iteration.

We now will make the adjustments for the third iteration according to the steps
below and as seen in Figure T9.12:

12. Adjust the red gate around the cluster on the SSC vs V500 plot (Figure

T9.12, )

13. Adjust the purple gate around the cluster in the lower right of the BV421 vs

BV605 plot (Figure T9.12, )

14. Move the floating quadrant on the PE vs PerCPCy5.5 plot to a new position

(Figure T9.12, )

15. Move the quadrant on the FITC vs BV605 plot to a new position (Figure

T9.12, )

16.  Move the M1 marker on the APC 1D histogram (Figure T9.12, ).

17. Create a new marker  to accommodate the second peak on the APC 1D

histogram (Figure T9.12, ).

1922
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Figure T9.12  Steps for Iteration 3

The layout should now appear similar to Figure T9.13:
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Figure T9.13  The layout after adjusting gates through Steps 12-17.

We will navigate back through our data to observe the Iteration Snapshot
feature in effect.

18. Click the Previous button (double left hand arrow) in the Data tab
Data on All Objects group to move back to the second iteration.

19. Click the Previous button (double left hand arrow) in the Data tab
Data on All Objects group to move back to the first iteration.

 Notice that FCS Express has automatically saved and applied a snapshot for
each iteration.

20. Click on File tab to save your work.

21. Navigate to your desktop.

22. Name the layout file a name of your choice.

23. Choose Linked as the Data Link Style.

24. Click Save. 
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You can now double click on the layout file you saved in steps 20-24 to open
and pick up your analysis where you left off.  After opening the saved layout you
will notice clicking the Previous/Next buttons automatically applies the iteration
snapshots saved with the layout.

In the next section, we will further investigate how Snapshots are integrated with
Batch Processing .

22.9.3 Batch Processing Snapshots

In this tutorial:

· We will learn how to analyze data and take Snapshots through Batch

Processing.

· We will learn how to Run, Rerun and Review the analysis during batch

processing.

o Run  - will run batch processing and perform all batch actions

that are selected for each iteration.  Snapshots for each
iteration will be taken automatically.

o Rerun  - will rerun the previous batch process and perform all

batch actions that are selected for each iteration.  Any
Snapshots previously saved by FCS Express will be re-applied
automatically during Rerun.  This will also be the opportunity for
you to regate and have FCS Express overwrite the previously
saved Snapshot(s) with the new gating.

o Review  - will rerun the previous batch process without

performing any batch actions that were created and selected
for each iteration.

· We will learn about the new Batch Processing Options  that are available

and how they are used to play back the snapshots taken during analysis.

· We will learn how to Flag  an iteration for further review after batch

processing has been completed.

· The layout used in this tutorial contains a batch action to Save to

PowerPoint .  This course assumes that the user knows how to create
Batch Processing Actions  to be performed each iteration of data.

To Run Batch Processing and Automatically Save Snapshots

1.  Navigate to the Tutorial Sample Data folder from the File tab

1922
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2.  Open the layout BPSnapshots.fey.

The layout contains 3 iterations of data already in the Data List.  The layout also
contains a Save to PowerPoint  batch action that is designated to save to the
Desktop of the Current Windows User .  For this tutorial, we will focus on how
to set up the Batch Processing Options in order to optimize gates per sample (or
iteration) during the batch process.

3.  Click on the Batch tab group command (Figure
T9.14).

Figure T9.14  Batch Processing Options from Batch Tab on Ribbon

In the Batch Processing Options window, there are several pause options that
can be enabled to determine at which iteration(s) FCS Express will pause during
batch processing.  

4.   Select Unconditionally pause between iterations (Figure T9.15).

5.  Click OK. 

779
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Figure T9.15  Batch Processing Options - Unconditionally Pause Between Iterations
Enabled
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6.  From the Batch tab Batch Processing group, click the Run button. A
warning message will appear (Figure T9.16).  Click Yes.

Figure T9.16  Dialog warnning the iteration snapshots will be cleared when using
Run mode

Microsoft PowerPoint will open automatically.  You can minimize PowerPoint
while the batch process completes. The Batch Processing window will also
appear showing the status of the current action, current iteration progress, and
overall progress. 

At the first pause, make the following adjustments for Iteration 2 (Figure T9.17):

7.  Aadjust the Red gate  around the cluster of cells in the SSC vs V500 plot.

(Figure T9.17, ).

8.  Adjust the Purple gate around the cluster of cells on the right side of the

BV421 vs BV605 plot. (Figure T9.17, ).

9.  Add a Quadrant  to the FITC vs BV605 plot (Figure T9.17, ).

10. Adjust the Marker  around the peak in the APC 1D histogram (Figure

T9.17, ).

11. Click on the Flag  icon in the Batch Processing progress window (Figure

T9.17, ).
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Figure T9.17  Steps for Analysis of Iteration 2

12. In the Batch Processing progress window, click Continue (Figure T9.18).
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Figure T9.18  Continuing with Batch Processing

At the second pause, make the following adjustments for Iteration 3 (Figure
T9.19):
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13.  Aadjust the Red gate around the cluster of cells in the SSC vs V500 plot

(Figure T9.19, ).

14.  Adjust the Blue gate around the cluster of cells in the upper left portion, and
the Purple gate around the cluster of cells in the lower right portion of the

BV421 vs BV605 plot (Figure T9.19, ).

15. Adjust the floating quadrant as seen in figure 5 in the PE vs PerCP Cy5.5

plot (Figure T9.19, ).

16. Adjust the quadrant as seen in the image in the FITC vs BV605 plot (Figure

T9.19, ).

17. Adjust marker M1 around one peak and create a new marker, M2, around

the 2nd peak in the APC 1D histogram (Figure T9.19, ).

18. Click Continue within the Batch Processing progress window. At the
conclusion of the batch process, the PowerPoint export will open (Figure

T9.19 ).

Figure T9.19  Steps for Analysis of Iteration 3

FCS Express has automatically taken Snapshots of each iteration analysis.

a.  To view the Snapshots that were taken, you must either Rerun  the
batch process or Review  the data.

1929
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b.  Using the Previous/Next buttons will remove whatever Snapshots
were taken during batch processing.

c.  The following steps will detail how to view the Snapshots that were taken
during batch processing.

Rerunning Batch Processing

1.  From Batch tab group, click the Rerun button (Figure
T9.20).

Figure T9.20  Rerunning the Batch Process

§  The same process as before will occur.  Since we still have the Batch
Processing Pause Option set to Unconditionally pause between iterations,
FCS Express will continue to pause after each iteration.  However, if you
would like to experiment with different options, you can find a summary of
the Batch Processing Options here .  Please note that FCS Express will still
process all iterations.  FCS Express will only pause for the iterations that are
determined in Options.

2.  Click Continue with the progress window to continue with the Rerun
process.  

     Make any changes to gates, markers and quadrants that you deem
necessary.  If you do not wish to make any changes, click Run to end.

§ If any changes were made to gating, marker and/or quadrant placement,
FCS Express will record a new Snapshot for that iteration and will overwrite
any previously existing Snapshot for that iteration.

§ During the Rerun process, FCS Express will also perform any batch actions
that were set up as part of any process.

Reviewing Data

Review will give the user the opportunity to look at their data and make any
necessary changes to gate, marker or quadrant positions for each iteration. 

817
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However, FCS Express will not perform any batch processing actions that were
set up when in review mode.

As before, the user can control when FCS Express pauses during batch
processing.  For the earlier exercise, we chose the option to have FCS Express
unconditionally pause between each iteration.  This time, we will tell FCS Express
that we only want to review any iterations that were flagged during analysis.  In
this exercise, we flagged the 2nd iteration, so FCS Express will pause only for
that iteration.

1.  From Batch tab Batch Processing group, click the Options button.

2.  Deselect Unconditionally pause between iterations (if selected).

3.  Select the option to Pause on flagged iterations (the list is below) (Figure
T9.21).

         FCS Express will automatically add any iterations that were flagged by the
user during batch processing.  In our example, you should the number 2 listed for
that pause option.
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Figure T9.21  Pause on Flagged Iterations
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We now will review the data and the snapshots that were taken at the time of
analysis without completing any of the batch actions through the Review
command., go to Batch Batch Processing.

4.  From Batch tab group, click the Review button (Figure
T9.22).

Figure T9.22  Reviewing Batch Process

5.  Once the Review process begins, another Batch Processing progress window
will appear.

6.  Make any changes that you would like to make.  Click Continue or Run to
end to complete the process.

22.10 Batch Processing

Batch processing allows you to analyze many data files consecutively, without
having to set up the plots for each file. Batch processing also gives you the ability
to export your layout and statistics in many different formats, including: printing,
saving, and exporting to PowerPoint, PDF, Excel, a text file or Microsoft Word.

In the first example, we will export plots to a PowerPoint file .

22.10.1 Exporting Plots to PowerPoint

In the course of this example, we will:

· Create a Data List of files to be batch processed.

· Export plots to a PowerPoint file.

To Run a Batch Processing Action:

1. Click the File tab .

2. Open the layout BatchProcess.fey found in the Tutorial Sample Data
archive . 

1932
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This layout contains two 2D density plots and a histogram of the file
TCellSample1.fcs (Figure T10.1). The left plot is of SSC-A vs PerCP-Cy5.5-A
with a gate on Lymphs. The right plot is of PE-A vs. APC-A gated on Lymphs
with quadrants. The histogram of FITC-A is also gated on Lymphs.

Figure T10.1  Batch Layout (BatchProcess.fey)

In order to run a batch process, you need to load files into the Data List. 

3. Select the Data tab group  command
(Figure T10.2).
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Figure T10.2  Selecting the Data List Command from Data Tab on Ribbon

A Data List window will appear (Figure T10.3).

Figure T10.3  Data List Window

4. Click the blue plus sign to add files  and select Add Data File.

The Select data file dialog will appear (Figure T10.4).
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Figure T10.4  Select Data File Dialog

5. Navigate to the location where the tutorial sample data are saved and
select the file: TCellSample2.fcs. 

6. Click Open file. 

The Data List window will show the two files (Figure T10.5).
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Figure T10.5  Data List with Two
Files

Note: files are processed during a batch process in the order they appear in the
Data List. 

In this layout, we have defined gates to be used in the analysis of two files:
TCellSample1.fcs and TCellSample2.fcs. The next step is to tell FCS Express
what we want to create during the batch process for these two files. 

7. Select the Batch tab group  command
(Figure T10.6).

Figure T10.6  Selecting the Batch Actions Command from Batch Tab on Ribbon

A Batch Actions window will appear (Figure T10.7). This is where you define
which actions you want completed during the batch process. We will now add
Save To PowerPoint, which will save a slide for each iteration during the batch
process.
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Figure 10.7  Adding Save to Powerpoint action in Batch Actions

8. Click Save To PowerPoint, the third option under the Add Action
category (Figure T10.7, red outline).

A Create Export To PowerPoint Action dialog will appear (Figure T10.8).



FCS Express 7 Manual1938

© 2023 De Novo Software

Figure T10.8  Create Export to PowerPoint Action Dialog
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9. Check the box next to Open presentation after saving (Figure T10.8,

).

10. For Output file options, click the folder icon to choose where to save file

and name it (Figure T10.8, ).

11. Click OK 

The Batch Actions window will be update to reflect the export to PowerPoint

has been added under Batch Process Actions (Figure T10.9).

Figure T10.9  Batch Actions Window Updated with Export to PowerPoint Action
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13. Select the Batch tab  command (Figure
T10.10).

Figure T10.10  Selecting the Run Batch Process Command

FCS Express now will run the batch process. After a series of automated steps,
PowerPoint will launch and open the TCellAnalysis.pptx. The file will consist of
two slides: the first will be a slide showing the layout with the data file
TcellSample1.fcs (Figure T10.11) and the second the layout with the data file
TcellSample2.fcs (Figure T10.12).

Note about ungrouping objects in PowerPoint for PC versus PowerPoint
for Mac

Once exported to PowerPoint, layout objects can be further ungrouped into
single components in the PC version of Microsoft PowerPoint. Ungrouping
objects saved by FCS Express in PowerPoint for Mac is not supported. However,
presentations saved on a Mac may be opened on a PC and ungrouped. 

Figure T10.11  Slide 1 in PowerPoint



Tutorials 1941

© 2023 De Novo Software

Figure T10.12  Slide 2 in PowerPoint

The next section will continue using this layout, so you can keep it open. 
Otherwise, please feel free to save it in order to resume at a later time.

 In the next section, we will export to an Excel report (Cell Mode ).

22.10.2 Excel Report (Cell Mode)

In the course of this example, we will: 

· Create an Excel – Cell Mode Report.

· Export the $FIL keyword.

· Export the $DATE keyword.

· Export a Statistic.

· Export a Picture.

· Run a batch process.

For convenience, we are going to start with the same layout as before. The
images contained within this section will continue with the layout from the
previous section.  However, you can add reports to layouts that already have
actions defined.  If you have the previous layout still open, please jump to Step
5.

1. Select the File tab and click on Open.

1941
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2. Open the layout BatchProcess.fey found in the Tutorial Sample Data
archive . 

To Perform an Excel Report Batch Process:

3. Add TCellSample1.fcs and TCellSample2.fcs as necessary (see the
previous section ).

4. Select the Batch tab group  command
(Figure T10.6 ). 

A Batch Actions window will appear (Figure T10.7 ).

5. Click Export to Excel (Cell Mode) from the Add Report category (Figure
T10.13, red outline).
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Figure T10.13  Adding Export to Excel (Cell Mode) to Batch Actions

An Excel (Cell Mode) Options dialog will appear (Figure T10.14). We will use
this dialog to set up the batch export of files in the Data List to Excel.
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Figure T10.14  Excel (Cell Mode) Options Dialog

6. Click the folder icon in the Template Document: field (Figure 10.14, ).

7. Select T Cell Analysis Template.xlsx from FCS Express Tutorial Sample
Data folder.

T Cell Analysis Template.xlsx is an Excel file that contains the background for
your report. (The Excel template we are using is shown in Figure T10.15.)

8.  For Iteration Options, click the radio button next to Combine all

iterations in the same document (Figure T10.14, ).

9.  For Output file options, click the folder icon for Save to a new file field

to designate where to save and name it (Figure T10.14, ).

10.  Check box to Open file after saving (Figure T10.14, ).
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11.  Click OK (Figure T10.14, ).

Figure T10.15  Cell Analysis Excel Template

The Batch Actions window will show the export to Excel (Cell Mode) action
listed (Figure T10.16, red outline).  Note the Save To PowerPoint Batch Action
may be present if you saved and reopened this layout to continue from the
previous section .1932
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Figure T10.16  Batch Actions Window with the Export To Excel (Cell Mode) Action

12. Click Keyword Token from the Add Item to Report category (Figure
T10.16, red arrow).

An Excel (Cell Mode) field "Keyword" options dialog will appear showing the
Data Source category (Figure T10.17). This is where we will define the
"keywords" to export to Excel. 
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13. For the Data Source category, select 4 - Histogram -
TCellSample1.fcs compensated (FITC-A).

Figure T10.17  Defining Data Source for Keyword

14. Click on the Keyword category. (Figure T10.18, red arrow).

15. Click the ellipsis (…) button to the right of the Select a keyword field
(Figure T10.18, red outline).
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Figure T10.18  Excel (Cell Mode) field "Keyword" options Dialog - Keyword
Category

The Please select a keyword dialog will appear (Figure T9.18). This dialog
displays the keywords found in the FCS file.

Figure T10.19  Dialog Displaying Keywords Found in the FCS File
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16. Select the keyword $FIL (Figure T10.19), which is the file name keyword
stored in the FCS File.

17. Click OK.

18. Click on the Field category of the Excel (Cell Mode) field "Keyword"
options dialog (Figure T10.20, red arrow).

The Field page of the Excel (Cell Mode) field "Keyword" options dialog will
appear. Here, we identify the Excel cell address to which the $FIL keyword data
will be batch exported.

19. Type B27 in the Cell Address field (Figure T10.20, red outline) of the
template Excel file (Figure T10.15 above).

Figure T10.20  Defining Cell Address for the Filename Keyword in the Excel Report

20. Click OK.

The Batch Actions window will show the action Keyword: $FIL added (Figure
T10.21, blue highlighted text). 
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Figure T10.21  Filename Added to Excel (Cell Mode) Report 

You also can select a token associated with a plot to batch export to Excel by
dragging and dropping the plot or gate of interest from the layout page onto the
Batch Process Actions section of the Batch Actions dialog.

21. Click on the histogram.

22. Position cursor on green or red outline of plot to switch to four-headed
arrow.
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23. Click and hold the left mouse button while in four-headed state and drag
the histogram to the Batch Process Actions section of the Batch
Actions dialog (Figure T10.22).

24. Release the mouse button when the cursor is on top of the Excel (Cell
Mode) text inside the Batch Process Actions section (Figure T10.22).  A
Paste Special dialog box will appear (Figure T10.23).

Figure T10.22  Dragging and Dropping a Histogram onto the Batch Actions Window
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Figure T10.23  Paste Special Dialog

24. Select the Keyword token and click OK (Figure T10.23).

25. The Keyword category page will appear, which is similar to Figure
T10.18.

26. Click on the ellipsis (…) button to the right of the field Select a keyword.

A Please select a keyword dialog will again appear (Figure T10.24).

Figure T10.24  Inserting the $DATE Keyword

28. Select the keyword $DATE (Figure T10.24). 
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29. Click OK (Figure T10.24).

30. Click OK to close Keyword Options dialog.

31. Double-click on newly-added $DATE keyword token or right-click it and
click Properties from submenu (Figure T10.25). 

Figure T10.25  Accessing Token Properties by Right-Click

32. Click the Field category from the Excel (Cell Mode) field "Keyword"
options dialog (Figure T10.26, red arrow).

The Field page of the Excel (Cell Mode) field "Keyword" options dialog will
appear again. 

31. Type D27 in the Cell Address field (Figure T10.26, red outline).
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Figure T10.26  Defining Cell Address for $DATE Keyword Excel (Cell Mode) Report

32. Click OK (Figure T10.26).

The Batch Actions window will show the action Keyword: $DATE added. If the
batch analysis were run now, using the files in the Data List, the file name, saved
in the FCS keyword $FIL, and the date, saved in the FCS keyword $DATE, would
be exported to cells B27 and D27, respectively,of the Excel file previously
specified in Figure T10.14 above.

We are now going to select a Statistic to batch export to the Excel file.

33. Select Statistic Token from the Add Item to Report category of the
Batch Actions window (Figure T10.27).
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Figure T10.27  Adding Statistic Token to Excel (Cell Mode) Report

An options dialog will appear. 

34. Click on the Data Source category (Figure T10.17 above).

35. Select 4 - Histogram - TCellSample1.fcs compensated (FITC-A)
from the Select a plot field (Figure T10.17 above). 

36. Click on the Statistic Category. The Statistic page of the Excel (Cell
Mode) field "Statistics" options dialog will appear. From this dialog, we
will define to statistic to add (Figure T10.28).
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Figure T10.28  Selecting a Statistic to Export

37. Select the marker M1 from the Plot Information - Select a marker list

box (Figure T10.28, ).

38. Select the Gate Lymphs from the Gate list box (Figure T10.28, ).

39. Select the Statistic % of gated cells from the Statistic list box (Figure

T10.29 ).

40. Click on the Field category. The Field category of the Excel (Cell Mode)
field "Statistics" options dialog will appear (Figure T9.25). This is where
we define the Excel cell address to which the statistic data will be batch
exported.

41.Type F27 in the Cell Address field (Figure T10.29).
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Figure T10.29  Defining Cell Address of Statistic for Excel (Cell Mode) Report

42. Click OK to accept the changes.

The Batch Actions window will show the action Statistic: % of Gated Cells
added (Figure T10.30, blue highlighted text).
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Figure T10.30  Batch Actions with Statistic % of Gated Cells to be Exported to Excel

We will now select a picture to batch export to the Excel file.

42. Click Picture from the Add Item to Report section (Figure T10.31).
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Figure T10.31  Adding Picture to Excel (Cell Mode) Report

An Excel (Cell Mode) field "Picture" options dialog will appear (Figure
T10.32). In this dialog, we will define the details of the picture to be exported to
Excel.

43. Select 4 - Histogram – TCellSample1.fcs compensated (FITC-A) in
the Select a Plot field (Figure T10.32, blue highlighted text).
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Figure T10.32  Selecting Plot for Picture in Excel (Cell Mode) Export

44. Click on the Field category (Figure T10.33, red arrow).

The Field category of the Excel (Cell Mode) field "Picture" options dialog will
appear (Figure T10.33, red arrow). Here, we define the Excel cell address to
which the picture will be batch exported.

45. Type A8 in the Cell Address field (Figure 10.33, red outline).

46. Click OK. 
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Figure T10.33  Defining Cell Address for Picture of Excel (Cell Mode) Report

We have instructed FCS Express to export a picture of 4 - Histogram –
TCellSample1.fcs compensated (FITC-A) to cell A8 of the Excel report
template. 

The Batch Actions window will show the action Picture added (Figure T10.34).
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Figure T10.34  Picture Added to List of Items for Excel (Cell Mode) Report
Picture

47. Click the Close button (red x) in the upper right corner of the window to
close the Batch Actions window (Figure T10.34).

We will now return to the layout page and run the Batch Processing.

48. Click Batch tab  command
(Figure T10.10 ).

FCS Express will now execute the Batch Process. When the Batch Process is
complete, an Excel file will be created (Figure T10.35) at the location you
specified, with two worksheets, one for each of the two files TCellSample1.fcs
and TCellSample2.fcs.

1932
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Figure T10.35  First Sheet of the Final Excel Report from the Batch Processing

We will continue to use this same layout in the next exercise.

Next, we will batch process an Excel report in column mode .

22.10.3 Excel Report (Column Mode)

A Column Mode batch analysis report can be created in a similar fashion as the
Cell Mode.  

In this exercise we will:

· Create an Excel Column Mode batch analysis report.

· Add a statistic token to the report.

1963
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· Add a keyword token to the report.

· Add a picture to the resulting Excel spreadsheet.

For convenience, we are going to use the same layout from the previous
sections. The images contained within this section will continue with the layout
from the previous section.  However, you can add reports to layouts that
already have actions defined.  If you have the previous layout still open, please
jump to Step 5.

1. Select the File tab and click on Open.

2. Open the layout BatchProcess.fey found in the Tutorial Sample Data
archive . 

To Perform an Excel Report Batch Process:

3. Populate Data List with files TCellSample1.fcs and TCellSample2.fcs as
necessary (see Steps 4-6 of the previous section ).

4. Select the Batch tab group  command
(Figure T10.6 ). 

A Batch Actions window will appear (Figure T10.7 ). Please note if you
progressing immediately from both or either of the previous two sections or
using the layout saved from the previous sections, Batch Processing Actions
will list PowerPoint and/or Excel (Cell Mode).

We will dock the Batch Actions window to the left side of the layout. Docking
the Batch Actions dialog makes it easier to drag and drop plots and tokens
while the rest of the layout remains in view, allowing you to set up the batch
process actions very quickly.  Please refer to the Docking Tutorial  for more
details on using the docking feature in FCS Express.

5. Click and hold mouse button on the title bar to move the Batch Actions
window.  While holding button, move cursor to four-headed icon of
docking zone sectors in the center of the FCS Express window (Fig.
T10.36, left, red arrow indicating cursor movement).

6. Release the mouse on the left sector, which will become highlighted (Fig.
T10.36, upper pane, red outline). The Batch Actions window is now
docked to the left side of the FCS Express window (Fig. T10.36, lower
pane).

1682
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Figure T10.36, upper pane. Docking the Batch Actions window.

Figure T10.36 The Batch Actions window docked.

7. Select Export to Excel (Column Mode) from the Add Report category
(Figure T10.37, red outline).  
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An Excel (Column Mode) Options dialog appears (Figure T10.37).

Figure T10.37  Excel (Column Mode) Options Dialog

8. In the Save to a new file field, click on the Folder icon (Figure T10.37, )
to specify where you would like to save your file and name it (e.g.
"TCellStats" saved on the Desktop).

9. Click OK (Figure T10.37, ).  

An Excel (Column Mode) process will now appear in the Batch Process
Actions section of the window (Figure T10.38). We will now add three items to
the report (a keyword token, a statistic token, and a picture of a plot from our
layout).

10. Drag and drop the border of the upper-left plot on the layout onto the
text of Excel (Column Mode) under Batch Process Actions (Figure
T10.38).
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Figure T10.38  Dragging and dropping a plot to be data source when adding a token
to the report

11. Double-click Keyword token from the Paste Special dialog (Figure
T10.39).

Figure T10.39  Selecting Keyword Token in Paste Special Dialog

12. Click on the ellipsis in the Excel (Column Mode) field "Keyword..."
options dialog (Figure T10.40, red outline).
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Figure T10.40  Accessing Keywords in Create Keyword Dialog

13. Scroll to and select $FIL in the Please select a keyword dialog (Figure

T10.41, ).

14. Click OK in the Please select a keyword dialog (Figure T10.41, ).

Figure T10.41  Selecting $FIL Keyword to Be Added to Excel (Column Mode) 
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15. Click OK in the Excel (Column Mode) field "Keyword..." options
dialog.  The Keyword token is added as an item to the Excel (Column
Mode) report (Figure T10.42, blue highlighted text).

16. Drag and drop the border of the histogram on the layout onto the Excel
(Column Mode) action (similar to Figure T10.38, but we are dragging a
different plot).

17. Double-click Statistic token from the Paste Special dialog (Figure
T10.42).

Figure 10.42  Selecting Statistic Token in Paste Special Dialog

18. Select M1 from the Plot Information - Select a marker list box (Figure

T10.43, ).

19. Select Lymphs from the Gate list box (Figure T10.43, ).

20. Select % of gated cells from the Statistic list box (Figure T10.43, ).

21. Click OK in the Excel (Column Mode) field "Statistic..." options dialog

(Figure T10.43, ).  The Statistic token has now been added as an item
to the Excel (Column Mode) report.  
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Figure T10.43  Defining Options for Statistic Token to Be Added to Excel (Column
Mode) Report

Note: you can also drag and drop gates directly from plots onto the Excel
Batch Action.

22. Deselect the check boxes next to the Export to PowerPoint and Excel
(Cell Mode) batch actions, if these exist on your layout.

Now we are ready to run the Batch Processing to export to Excel (Column
Mode).

22. Select the Batch tab  command (Figure
T10.10 ).  

An Excel (Column Mode) report will appear with the results of the batch
process (Figure T10.44).
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Figure T10.44  Excel (Column Mode) Report

We now will insert the image of a plot from FCS Express onto the Excel
spreadsheet using drag and drop.

23. Drag and drop the border of the histogram on the layout onto an empty
part of the Excel spreadsheet (Figure T10.45). 

Figure T10.45  Dragging and Dropping a Plot Image from FCS Express to an Excel
Spreadsheet
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An image of the histogram plot will now appear in the Excel spreadsheet (Figure
T10.46). You can drag and drop items from FCS Express to Word and
PowerPoint in a similar manner.

Figure T10.46  Excel (Column Mode) Report with a Plot Image Added

22.11 Creating and Using Panels

It is very common in the day-to-day work with flow cytometry to use the same
analysis layout to analyze many different data files (for example, CD3-CD4-CD8
determinations in a clinical setting, where this panel of stains is repeated for
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different patients, or to test for the expression of the same surface markers
after different treatments). In order to facilitate this type of analysis, FCS
Express has the Panels option. Panels allow you to rapidly change all of the data
on a particular layout to a new set of data.

In order to use the panels feature in FCS Express, you will first set up the number
of tubes that you are working with, and then create the plots and other elements
on the layout. Once that is done, you will be able to load another set of data with
just a few mouse clicks.

You can also set up a panel  after the layout has already been created.

In the first section, we will set up the panel .

22.11.1 Setting Up the Panel

In the course of this example, we will:

· Learn how to set up a panel.

· Learn how to set up a file list with the experimental files to be analyzed.

In this tutorial we will be analyzing 2 samples, each comprised of a set of 2
tubes. The panel will consist of the tubes that comprise the "set", which will
repeat itself. 

We will begin by defining the panel and then setting up the data list.

1. File tab .

2. Select the Batch tab  command (Figure
T11.1). Alternatively, select the Data tab
command.

Figure T11.1  Selecting the Panels Command

686
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The Panel Information dialog appears as shown in Figure T11.2.

3. Click the Add button (Figure T11.2, red arrow).

Figure T11.2  Adding New Panel

The Add Panel dialog will appear as shown in Figure T11.3.

4. Enter "My Panel" in the Panel Name field (Figure T11.3, ).

5. Click on the upward triangle twice in the Number of Tubes spin control or

enter 2 (Figure T11.3, ).

6. In the Name column, name Tube #1 "T Cell markers" and Tube #2 "B

Cell markers" (Figure T11.3, ).

7. Click OK to close the Add Panel dialog (Figure T11.3, ).
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Figure T11.3  Setting up a Panel using the Add Panel Dialog

The Panel Information dialog will now appear updated with the newly added
panel information, as shown in Figure T11.4.
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Figure T11.4  Updated Panel Information Dialog

8. Click OK to close the Panel Information dialog (Figure T11.4).

The next step consists of using the Data List to set up a list of the files we want
to analyze using the panel.

9. Select the Data tab group  command
(Figure T11.5). Alternatively, select the 

 command.

Figure T11.5  Selecting the Data List Command

A Data List window opens.

10. Click the Add  button on top of the Data List window and choose
Add Data File to add files (Figure T11.6).
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Figure T11.6  Adding Data Files to Data
List

The Select data file dialog opens (Figure T11.7).

11. Navigate to where the Tutorial Sample Data folder is located.

12. Multiple-select the 4 files named: Normal2_Tube1, Normal2_Tube2,
Normal3_Tube1 and Normal3_Tube2 as shown in Figure T11.7. 

13. Click Open file (Figure T11.7).
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Figure T11.7  Selecting Data Files to load into the Data List

The Data List window now lists the data files selected, each with its Iteration
number, Tube from the panel, and File Name displayed. The Data List should
appear as shown in Figure T11.8.
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Figure T11.8  Updated Data List with
Corresponding Tubes for the Panel

As shown in Figure T11.8, the Data List window shows the tubes from the panel
you created in the left column, and the files you added in the right column. This
greatly helps to organize your files into the corresponding tubes for further
analysis. To further aid organizing the data files, FCS Express allows you to add
keywords from the FCS file to the information displayed in the Data List.
Keywords that are descriptive indicators of sample identification can be added to
the Data List to easily  identify which data files corresponds to each entry in the
Data List.  There are many keywords that can be used to help identify the data
files within the Data List.  In this tutorial, we will add the keyword $SRC to the
Data List.

14. Click on the Format button at the top of the Data List (Figure T11.9).
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Figure T11.9  Clicking Format to Add
Keyword to Data List

15.Select Add from the Format Data List dialog (Figure T11.10, red
outline).
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Figure T11.10  Format File List Dialog

The Please select one or more keywords dialog appears, as shown in Figure
T11.11. This is where we will select the keyword $SRC to display in the Data
List.

17. Click on the down arrow to scroll down to the bottom of the list.

18. Click on $SRC, highlighted in Figure T11.11. If you want to display more
than one keyword, you can select multiple adjacent keywords by holding
down the Shift key on the keyboard or by selecting multiple non-adjacent
keywords by holding down the Ctrl key while clicking on each keyword.
For this example, we will only select $SRC.

19. Click OK (Figure T11.11). 
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Figure T11.11  Selecting an FCS Keyword to use in the Data List

The Format File List dialog will be updated with $SRC in the Selected
Keywords field, as shown in Figure T11.11.  The Data List can also be formatted
to display your data in Groups.

20.  Select OK in the Format Data List dialog.

The Data List dialog will now appear updated showing the grouping of the data
files, the file name without the full path and with the column $SRC, as shown in
Figure T11.12.   
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Figure T11.12  Data List Window Updated with
Groups, File Names and $SRC Column.

    21.  Proceed to the next section to create a layout or save this layout to be
used at a later time.

You can use the icons at the top of the Data List dialog, (Figure T11.12) to
manipulate the data files in the list. 

As previously demonstrated, you can add more files to the Data list by selecting

the Add button  and you can format the list to include FCS keywords by

selecting the Format button . To move a file up or down in the Data List

select the data file and then select the Up  or Down  arrows. To change a

file, select the Change File button ,  and to search for a file select the Search

button . To delete a file from the list, select the file, and then select the Delete

button .  In addition to manually organizing the list or using a single column to

sort data files, you may use the Sort on All Keywords button  to sort on all
keywords displayed across the columns.

In a previous version, FCS Express 4, any changes made to the order of the
tubes in the Data List would automatically change in which plots those data files
were being viewed as they are being moved.  If your files are large, it could take
some time for your layout to refresh as each tube is moved up or down the
Data List. However, in FCS Express, the user can now defer those changes until
the files have been moved and placed in the required order. By clicking the Defer

Layout Changes icon , the user can makes changes to the order of tubes,
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then, deselect the icon and the data would automatically refresh in the analysis
layout.

We will now proceed to creating the layout .

22.11.2 Creating the Layout

In the course of this example, we will:

· Create a layout to use for our panel.

We now will proceed to create a layout for the analysis of our experiment using
the panel we created. We will be using plots and gates. Please refer to previous
tutorials for more information on inserting plots , formatting plots , and using
gates .

Using the layout we started in the previous section, Setting Up the Panel , we
will create four plots for our first set of samples.

1. Open the Data List window if it is not already open.

2. Select the first two files from the list (click on the first file, press the Ctrl or
Shift key and click on the second file).

3. Drag the selected files by the file name from the Data List and release the
mouse button onto the white space of the layout. 

The Select Plot Types… dialog will now resemble Figure T11.13.

4. Check the Color Dot option and confirm all other plot types are
unchecked (Figure T11.13, blue highlighted text).

5. Check the Use this selection for all files option (Figure T11.13, red
outline).

6. Click OK (Figure T11.13).

1984
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Figure T11.13  Select Plot Types... Dialog

7. Click and drag plots by red outline to position in a column with plot
displaying Normal2_Tube1.fcs compensated at top on left side of white
space.

8. Click to select  the plots by holding down the Ctrl button on the
keyboard and click each plot. Alternatively, click and hold the mouse
button down and drag a box that encompasses all four edges of both
plots, or select the Home tab group  command.  You
also may use Ctrl +A to choose both plots.

9. Click Home tab group  command
category  (Figure T11.14, red outline).  This tool will help align and
distribute your objects by arranging them according to the first object that
was selected in step 8.

1684
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Figure T11.14  Aligning Plots

The Alignment window will appear (Figure T11.15).

10. Under the Horizontal column, select Left Sides.  Under the Vertical
Column, select No Change. 

11. Click OK.
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Figure T11.15  Aligning Plots on the Left Side

12. Select the plots.  Right click them and select Duplicate. (Figure T11.16,
blue highlighted text).
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Figure T11.16  Duplicating Plots

The duplicated plots will appear.

13. Rearrange the duplicated plots by placing them to the right of the original
plots.

14. Use the Align tool if needed.

The page of the layout should now resemble Figure T11.17.  For more
information on manipulating objects in FCS Express, please refer to the Using
Objects  tutorial. 1685
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Figure T11.17  Plots Arranged on Page

We will now adjust the X and Y axis parameters , create gates , create
statistics  and create a 1D histogram  to which we will add an overlay .

16. On the 1st plot in the upper left corner, click on the X axis label and
choose V-500-A.  Click on the Y axis label and choose SSC-A.

17. On the 2nd plot in the upper right corner, click on the X axis label and
choose V450-A.  Click on the Y axis label and choose PerCP-Cy5-5-A.

18. For the 3rd plot, in the lower left, set the X axis to APC-H7-A and the Y
axis to V450-A.

227 701
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19. For the 4th plot in the lower right, set the X axis to APC-A and the Y axis
to PE-A.

20. The layout should resemble Figure T11.18.

Figure T11.18 Plots after Changing Parameters on X- and Y- Axes

We will format the titles of the plot to display the Current Gate for that plot.

21. Click upper left plot to select it.  

22. Click Format tab command.
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23. Click inside edit box to place cursor after grey highlighted text, which will
resemble "Keyword: $FCSE_FILENAMENOPATH for plot text box is
on (#2), overlay #1)." 

24. Key Enter/Return key to create a second line of text if necessary.

25.Click Insert Token button (Figure T11.19, red outline).  

26.Select Current Gate from the drop-down list (Figure T10.19, blue
highlight).
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Figure T11.19  Selecting Current Gate Token for Plots' Titles

 

27.Repeat steps 21, 23-26 for remaining three plots.
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Plots should resemble Figure T11.20.

Figure T11.20  Plots Displaying File Name and Current Gate Tokens in Titles

We will now create gates .  On the SSC/V500-A plot, we will create a polygon
gate around the lymphocytes.  

28. Click Gating tab group  command.  Click on
plot to place vertices of gate around the lymphocytes.

29. Click on first vertex or key space bar to create gate.

30. In Create New Gate dialog, enter Lymphs in Create a new gate
named field (Figure T11.21, red outline).
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Figure T11.21  Creating and Naming Lymphs Gate

31. We will apply the Lymphs gate to the 2nd plot in the upper right by
dragging and dropping the Lymphs gate on top of the 2nd plot.  The
Before and After is below (Figure T10.22).
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Figure T11.22  Before (upper) and After (lower) Dragging and Dropping the
Lymphs Gate

32. Select the 2 plots at the bottom of the page.  Click Gating tab
Gate drop down list  (Figure T11.23).
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Figure T11.23  Applying Lymphs from the Current Gate Dropdown on Ribbon to
Lower Two Plots

33. On the lower left plot, create a Rectangle gate around the cluster of cells
that are APC-H7/V450 dual positive. 

34. In Create New Gate dialog, name the gate Cells of Interest and click
OK.

35. Drag and drop the Cells of Interest gate from the lower left plot to the
lower right plot.

36. Multiple-select  the top two plots

37. In the Formatting dialog docked to the right of layout, choose Gates to
Display category.

38. Select Only the gates checked below option (Figure T11.24, red
arrow).

39. Check box next to Lymphs (Figure T11.24).

40. Select the option Only if the gate was create on a plot showing the
same data file as this plot (Figure T11.24, red outline).  

1688
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Figure T11.24  Editing the Gates to Display
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41. Your layout should resemble Figure T11.25.

Figure T11.25  Layout After Editing Gates to Display

We will now add Quadrants to the upper right and lower right plots.  

42. Click Gating tab group command; then,
click on the V450 vs PerCPCy5.5 (upper right) plot.  Quadrants can be
moved by clicking on the central vertex of the quadrant and moving it to
the desired position.

43. Repeat step 42 for the APC vs PE (lower right) plot.

44. Your layout should resemble Figure T11.26.
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Figure T11.26  Layout after Creating Quadrants on Upper and Lower Right Plots

We now will add quadrant statistics for the 2 plots that contain quadrants.

45. Right-click the V450 vs PerCP-Cy5.5 (upper right) plot and click
 from pop up menu (Figure T11.27).  
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Figure T11.27  Accessing Quadrant Statistics for Plot

46. Click on statistics grid. 

47. In Formatting dialog, select Statistics category if necessary, check
boxes only next to Gate, # of Events, % of Gated Cells, and % of All
Cells (Figure T11.28, red outlines), and click OK.
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Figure T11.28  Formatting Statistics

48. Repeat steps 45-47 for the APC vs PE (lower right) plot.

49. You can also edit  the FCS Express User Options to reflect these
changes, so each element does not need to edited manually for every
analysis.

We now will add another page and add a 1D histogram to this page.

1622
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50. Click the Home tab group command.  We also can
add a new page by selecting the "+" sign next to the Page 1 tab at the

bottom of the layout ( ).

51. On Page 2, drag and drop the second tube of the first iteration
(Normal2_Tube2.fcs) from the Data List to the blank, white space.

52. In Select Plot Types... dialog, check box only next to Histogram and
click OK.

53. Change the X axis to PE-A and change the Current Gate to Lymphs.

54. Right-click the histogram and select Add Overlay using Advanced Open
Data Dialog (Figure T11.29).

Figure T11.29  Adding an Overlay

55. In the Advanced Open Data File window, click the Data List tab and
choose the second file: Normal2_Tube2.fcs.  Click OK (Figure T11.30).
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Figure T11.30  Selecting a Data File for Overlay

56. In the Add Overlay(s) dialog for the Parameter section, select APC-A.
 If not already chosen, select the Lymphs gate.  Click OK (Figure
T11.31).

Figure T11.31  Adding Overlay
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57. Your histogram should look similar to Figure T11.32.

Figure T11.32  Histogram with Overlay

58. At this point, we will save the layout.  Click File tab and select Save As. 
Once you have chosen a location where you can save your layout, choose
Layout Files (with unlinked data) for the Save as type: field (Figure
T11.33, blue highlighted text).  This will save your layout as an empty
template, remembering only plots, gates, and other existing objects,
except for data files. Click Save.
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Figure T11.33  Saving Layout Unlinked

59. Close the layout.

In the next section, we will use the panel .

22.11.3 Using the Panel

In the course of this example, we will:

· Load new data into the layout we just created.

· Use the panel to analyze the other similar samples.

· Extend the layout easily using the panel set up in the previous steps.

1. Open the layout that you created in the previous section .

2. Open the Data List  window if it is not already open.

3. Click on the blue plus icon  in the Data List toolbar and select Add
Data File to add data files to be analyzed.

2005
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4. Navigate to the tutorial sample folder and select file called
Normal2_Tube1 (Figure T11.34, red arrow).  Confirm FCS files (*.*;
*.fcs; *.lmd) is selected for Files of Type drop down (Figure T11.34, red
outline).  

5. Select Open file.

Figure T11.34  Selecting Data for the Data List with Panel On

6. Since the Panel created for this layout was defined as a two-tube panel,
FCS Express will prompt you to whether or not you would also like to add
the next tube to the Data List to complete the 2-tube panel, as seen in
Figure T11.35. Click Yes.
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Figure T11.35  Prompt to Automatically Add Data File to Data List

7. FCS Express will load the 2 tubes, Normal2_Tube1 and Normal2_Tube2
into the Data List.  FCS Express also automatically populates all the plots
in the layout with the appropriate data files that were assigned to each
plot during the creation of the layout, including the histogram that contains
the overlay on Page 2.

8. To analyze another set of samples that fit the Panel criteria, click on the
blue "+" icon in the Data List toolbar and choose Add Data File.

9. Navigate to the tutorial sample folder and, while holding the Ctrl key,
select files Normal3_Tube1 and Normal3_Tube2.

10. Because you have selected 2 tubes, FCS Express will not prompt whether
you would like to automatically add the next data files to the Data List. 
The same would hold true if all four data files were selected initially for
addition to the Data List.  This also is true for any multiple of two, the
number of tubes defined in the panel (i.e. six data files or 60 data files).

11. After adding the four data files, the Data List should resemble Figure
T11.36.
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Figure T11.36  Data List Containing More Than One
Iteration with Panel On

12.Keep the Data List open.  Feel free to dock  and pin the Data List.  Later
in this section, we will review how to rearrange data files within the Data
List.

Advancing Through Panel Iterations in the Data List

13.To advance from one iteration to another iteration to be analyzed, click
Data tab  command (Figure
T11.37, red outline).

Figure T11.37  Change Data on All Objects Using Next from Ribbon

14.Alternatively, select the Iteration number from the drop down list under
the Data tab, as seen in Figure T11.38.

Figure T11.38 Navigating through Data Fiels by Using
the Iteration Dropdown List from Data Tab on Ribbon

2017
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15.The number of iterations available will match the number of iterations seen
in the Data List, as seen in Figure T11.36.

16. Another way to navigate through data files is by clicking the Iteration
number within the Data List, as seen in Figure T11.39.

17.The iteration that is currently displayed within the plots of the layout will be
highlighted in aqua within the Data List.

Figure T11.39  Displaying Different Iterations with Panel On

Rearranging Data Files within the Data List
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18.Tubes must be loaded in the correct order for every iteration (or set of
two files here).  In this example, the first tube of each iteration must
always be the data file for T Cell Markers, while the second must be B Cell
Markers.

19.If data files are loaded in the incorrect order, the tubes can be moved up
or down the Data List manually to reorder them properly.  Click the File
Name to select the file(s); then, click the Up or Down arrow within the
Data List toolbar until the iteration is in proper order.

20.In Figure T11.40, the tubes of the first iteration are in the wrong order.  As
a result, incorrect data is being displayed in the incorrect plots.

Figure T11.40   Incorrect Order Of Tubes Within the Data List - Tube 2 is Before
Tube 1.

By selecting a tube in the first iteration and using the Up or Down arrow from the
Data List toolbar, we can correct the ordering. (Figure T11.41).  While reordering
the tubes in the Data List, the data displayed in the plots and objects will refresh
and statistics will be recalculated automatically.  

21. Click the File Name (Figure T11.41, ).

22. Click Up arrow in Data List toolbar (Figure T11.41, ). 
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Figure T11.41  Correcting Tube Order in Data List

However, if the files are large, there may be a noticeable delay in the refresh
time as the tubes are moved within the Data List.  Users can defer the layout

changes by selecting the Defer Layout Changes button  in the Data List
toolbar.

23. To defer the changes while reordering data files, click Defer Layout

Changes button (Figure T11.42, ).

24.Select the file to be moved (Figure T11.42, ).

25.Click the Up or Down arrow (Figure T11.42, ).

26. To apply changes, click the blue play icon  (Figure T11.42, ).
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Figure T11.42  Deferring Layout Changes - Before and After

Adding plots to the layout

27.After a Panel has been added to a layout, the layout can be edited easily. 

28.On Page 1, click to select the following plots while holding the Ctrl key:

a. V450 vs PerCP Cy5.5

b. APC-H7 vs V450
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c. APC vs PE

29.Right-click the selected plots and click Copy.  Also, the keyboard shortcut
Ctrl+C will work.

30.Go to Page 2.  Right-click the page and click Paste.  Also, the keyboard
shortcut Ctrl+V will work.

31.Rearrange the plots around the 1D histogram with the overlay.

32.Change the parameters for these pasted plots if interested.

33.Add a Quadrant to the plot that was previously the APC-H7 vs V450
plot.

34.Save your layout by clicking File tab  command or by clicking the

Save button  in the layout toolbar at the top of your computer screen.

Finally, we will see examples of saving and loading panels .

22.11.4 Saving and Loading Panels

In the course of this example, we will:

· Work with the layout that was created in Creating the Layout  section.

· Learn how to save and load panels for future use.

We now will proceed to saving and loading the panel we created for future use.

1. Click the Data tab group  command.
Alternatively, click the Batch tab group
command. 

The Panel Information dialog appears with My Panel listed and checked to be
active (Figure T11.43).

2. Click the Save button on the Panel Information dialog (Figure T11.43,
red arrow).

2013

1984
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Figure T11.43  Saving a Panel

The Save As dialog appears (Figure T11.44).

3. Navigate to the Tutorial Sample Data folder and enter "My Panel" in the
File name field (Figure T11.44, blue highlighted text in red outline).

4. Click Save in the Save As dialog.
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Figure T11.44  Save As Dialog

We have saved My Panel. We will now save the current layout, and then load
the saved panel into a new layout.

5. Click on Cancel to close the Panel Information dialog.

6. Select the File tab , to save the current layout. Alternatively, select
the Save icon located in the Quick Access Toolbar .

If you have not saved the layout previously, then the Save Layout dialog
appears.  If you have saved it previously, please skip to step 9 to continue.

7. Navigate to the Tutorial Sample Data folder and enter "Panel Demo
Layout" in the File Name field.

8. Click Save on the Save Layout dialog.

9. Select the File tab , to open a new blank layout. 
Alternatively, you may use Ctrl+N to open new layout.

A new blank layout will appear.

49
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10. Select the Data tab group  command.
Alternatively, select the Batch tab group
command. 

The Panel Information dialog will appear, and it will be empty.

11. Click the Load button on the Panel Information dialog (Figure T11.45,
red arrow).

Figure T11.45  Loading a Panel

The Open dialog will appear.

12. Navigate to the Tutorial Sample Data folder and select the
"MyPanel.PanelInfo" file.

13. Click Open.

The Panel Information dialog will show My Panel. Saving a panel allows you to
avoid having to redefine a panel repeatedly for every new layout you create.
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14. Click on OK to activate My Panel and close the dialog.

My Panel is now active on this layout and you could choose to create a new
layout of plots to analyze with this panel.

22.12 Docking

Many of the functional windows within FCS Express are dockable. This means
that they can be embedded within the layout and becoming a more permanent
fixture within the layout.  Docked windows can also be Pinned, which enables an
Auto Hide feature for that docked window.  

The docking feature allows you to place any of the Navigator windows (Layout,
Data and Gate), the Token windows (Custom Token, Canned Comments, and
Alerts), and the Data List window, onto the layout and then "dock" the window,
or windows, to a specific fixed location on the outside of the layout page.
Docking has many powerful features which we will explore in this tutorial.

Note: We are going to open a lot of interesting Navigators in this tutorial, but will
only focus on the docking functionality. For more information on how these
Navigators work, please see the tutorials on  the Layout Navigator , Data
Navigator , and Gate Navigator .

In the course of this example, we will:

· Learn how to dock a window.

· Learn how to use the many docking features.

· Learn how to use docking features with multiple windows.

· Learn how to undock a window.

To Dock a window:

1. Select File tab .

2. Open the layout Docking.fey found in the Tutorial Sample Data folder.

The following layout will appear, shown in Figure T12.1. This layout is similar to
the one used in the Tokens tutorial .

2036

2057 2076

1787
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Figure T12.1  Docking Layout

3. Select the View tab  command (Figure
T12.2).

Figure T12.2  Selecting the Gate Navigator Command

The Gate Navigator window will appear on the layout. 

4. Place the mouse on the top title bar of the Gate Navigator window.

5. Click and hold the left mouse button. While holding the left mouse button,
move the mouse. Continue holding the mouse button and drag the Gate
Navigator towards the central docking icon (Figure T12.3, red outline).
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Figure T12.3  Docking Zone Sectros in the Center of the Layout

6.  Move the Gate Navigator towards the right arrow of the docking arrow.

7.  Continue to hold down the mouse button and place the cursor over the
right arrow (Figure T12.4, red outline).  When cursor is on sector icon, a
blue pane, representing the corresponding side of the layout to which the
floating window will be docked, will appear (Figure T12.4, red arrow).



FCS Express 7 Manual2020

© 2023 De Novo Software

Figure T12.4  Docking to Right Preview Pane

8.  While holding mouse button, move to left docking zone sector and
release mouse button.  Gate Navigator will be docked to left side of
layout.

The Gate Navigator is docked on the left side of the layout (Figure T12.5).

Figure T12.5  Gate Navigator Docked on the Left Side of the Layout

In the next section, we will learn the features of a docked window . 2021
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22.12.1 Features of a Docked Window

Once a window is docked it can be resized, undocked, redocked to a new
location. You also set it to Auto Hide. Note when a layout is saved, the
corresponding docking configuration is saved with the layout as well.  This means
the docked windows will appear when reopening the layout. We will explore the
various features of a docked window in this section.

1. Place the cursor on the top border of the docked Gate Navigator.

2. Click and hold left mouse button on top title bar. While holding, drag the
Gate Navigator to a new location on the layout.

As you move the Gate Navigator on the layout (Figure T12.6, red arrow),
docking zone icons appear at the edges of layout (Figure T12.6, red outlines). If
you continue to move the Gate Navigator towards the middle of the layout, the
central docking icon will re-appear, as previously shown in Figure T12.3 .

Figure T12.6  Four Outer Docking Zone Icons

3. Continue to hold down the mouse button and move the Gate Navigator
towards the bottom docking arrow.  Once on the icon, notice a blue
rectangle appears at the bottom of the layout, indicating the proposed
docking location for the window.

4. Release the mouse button when the cursor is on bottom docking arrow.

The Gate Navigator is now docked at the bottom of the layout, as shown in

Figure T12.7. However, the current size of the docked Navigator is too large and

covers part of the plots on the layout. We will resize the docked window to a

more appropriate size.

2017
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Figure T12.7  Gate Navigator Docked at the Bottom of the Layout

5. Place the cursor between the top border of the docked Gate Navigator
and Page navigation bar.  A double-headed cursor will appear.  Click and
drag down; a dark grey line will appear, indicating where new upper border
will be placed for navigator when the mouse button is released. (Figure
T11.7). 

6. Release the mouse button when the docked Gate Navigator is no longer
covering the plots on the layout.

Rather than resize the docked Navigator, we could use the Auto Hide feature.
Auto Hide allows the window to remain docked, but hidden, except for a visible
tab with the name of the docked window on it. When the cursor is placed on the
tab the docked window re-appears and remains visible as long as the cursor
remains on the docked window. If the cursor is moved off the docked window
then the window is again hidden.

9. Click on the Auto Hide icon  in the upper right corner of the docked
Gate Navigator.

10. Move the cursor off and away from the docked Gate Navigator.

The docked Gate Navigator will hide from the layout with only a tab displayed
on the bottom of the layout, indicated by a red outline in Figure T12.8.

7

Figure T12.8  Gate Navigator Tab Displayed When Auto Hide Feature Enabled



Tutorials 2023

© 2023 De Novo Software

11. Move the cursor over the Gate Navigator tab and pause.  The Gate
Navigator will appear again.

12. To disable the Auto Hide feature, click the Auto Hide icon  located in
the upper right corner of the docked Gate Navigator.

Note that the Auto Hide icon has rotated 90 degrees from its original
orientation. The Auto Hide orientation at the beginning of step 12 indicates that
the Auto Hide feature is on. However, after clicking on the Auto Hide icon, it will
return to its the original position in step 9, indicating the Auto Hide feature is off.
The Gate Navigator is now visible, docked at the bottom of the layout.

In the next section, we will continue using the Docking.fey layout and cover
docking features with multiple windows docked .

22.12.2 Docking Features (Multiple Windows)

We now will open more Navigators and the Custom Tokens window; dock them
to demonstrate the features of docking with multiple windows. Please refer to
the previous section  for details on docking and open Docking.fey if
necessary.

1. Click the View tab group  command.

The Data Navigator window will appear on the layout.

2. Dock the Data Navigator window to the left of the layout.

The layout now has two windows docked, Gate Navigator on the bottom and
Data Navigator on the left (Figure T12.9).

2023

2021
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Figure T12.9  Layout with Gate Navigator and Data Navigator Docked

3. Click the View tab group  command.

The Layout Navigator appears on the layout. We will dock the Layout
Navigator to the left side of the layout.

4. Drag the Layout Navigator by its title bar toward the left side of the
layout.

When you first start to drag the Layout Navigator, the four docking zone
sectors appear in the center of the layout as well as the centers of the Gate and
Data Navigators (Figure T12.10, red outlines).  The individual docking icons
(Figure T12.10, orange outlines) at the edges appear also. Once the Layout
Navigator is moved away from the center set and toward the left edge, the
sets in the navigators disappear.  Once the cursor reaches the Data Navigator,
the center set disappears and the set in the Data Navigator appears (Figure.
T12.10, blue outline).
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Figure T12.10  All Docking Icons When Moving Layout Navigator Initially

As you move the Layout Navigator towards the left side of the layout, the
four-headed arrow docking icon appears at the left docking site, indicated by the
red circle in Figure T11.14. The four-headed arrow docking icon indicates the
possible docking locations for the Layout Navigator. The single docking arrow
on the far left indicates that the window can be docked all the way to the left of
the currently docked Data Navigator. 

5. Release the mouse button when the Layout Navigator is over the right
arrow (Figure T12.11, red outline).
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Figure T12.11  Docking Layout Navigator

The Layout Navigator is now docked to the right of the Data Navigator, on

the left side of the layout (Figure T12.12). Note that it was docked inside the

previous Data Navigator, i.e., both new docked windows take up the same

amount of space as the Data Navigator did.
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Figure T12.12  Layout Navigator Docked to Right of the Data Navigator

Note the commands on the ribbon for the windows docked within the layout are
highlighted in a darker shade of grey (Figure T12.12). We now will dock the
Custom Tokens window on the layout. However, this time we will dock it on
top of the Layout Navigator.

7.  Select the View tab group  command.

The Custom Tokens window appears on the layout.

8.  Click and drag the Custom Tokens window by its title bar toward the left
side of the layout.

9.  Continue to hold down the left mouse button and drag the Custom
Tokens window towards the middle of the docked Layout Navigator.

When the Custom Tokens is on top of the Layout Navigator, the docking
zone sectors appear (Figure T12.13, red outline).

10. Release the mouse button when the cursor is on top of the central area
of the docking icon on top of Layout Navigator (Figure T12.13 red
arrow). You will know you are in the correct place because the blue
rectangle indicates the proposed docking location.
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Figure T12.13  Docking Custom Tokens on top of the Layout Navigator

The Custom Tokens window is now docked on the left side of the layout, on

top of the Layout Navigator (Figure T12.14). Notice that at the bottom of the

docked Custom Tokens window there is a tab labeled Custom Tokens.

However, we want to see the tabs for both docked windows, so we will now

resize the docked windows to make them wider.
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Figure T12.14  Custom Tokens Docked on top of the Layout
Navigator



FCS Express 7 Manual2030

© 2023 De Novo Software

11. Place the mouse over the outer right border of the docked Custom

Tokens.

12. Move the mouse slightly over the border until the resizing icon appears, a

double-headed arrow.

13. Click and hold down the left mouse button; then, drag the border to the

right (Figure T12.14, red arrow indicating direction).

14. Release the mouse button when the docked window is large enough to

show the both tabs for Custom Tokens and Layout Navigator at the

bottom (Figure T12.15, red outline).
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Figure T12.15 Custom Tokens and
Layout Navigator Tabs
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We now will explore the benefits of using Auto Hide when multiple windows are
docked in one location.

15. Select the docked Data Navigator.

16. Click and drag the Data Navigator by its title bar to dock it on top of
Custom Tokens.

The Data Navigator is now docked on top of both Custom Tokens and
Layout Navigator (Figure T12.16). If you cannot see all three tabs, then resize
the docked windows to make them wider.
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Figure T12.16  Data Navigator
Docked on top of Custom Tokens

and Layout Navigator

17. Click on the Auto Hide icon  in the upper right corner of Data
Navigator, which was demonstrated in previous section .2021
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18. Move the cursor off and away from the docked Data Navigator.

The Auto Hide feature is now applied to all three docked windows, and only the
tabs for the docked windows are visible (Figure T12.17). To see a docked
window, move the cursor over the respective tab of the window you wish to
see.

Figure T12.17 
Docked Windows
using Auto Hide

Feature

In the last section, we will undock a window .2035
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22.12.3 Undocking a Window

We will use the same layout used in previous sections.  Please begin in Features
of a Docked Window  if necessary to update the Docking.fey layout.

To undock a window:

1. Place the cursor on the top title bar of the docked Gate Navigator, which
is docked on the bottom of the layout.

2. Click and hold the left mouse button while dragging the Gate Navigator
up and away from its current docked location.

3. Release the mouse button when the Gate Navigator is at the desired
location. Be sure the cursor is not on any of the docking icons.

To undock docked windows using Auto Hide, we need to first turn off the Auto
Hide feature; there are two ways of doing this.

4. Move the cursor over the Data Navigator tab to make the docked Data
Navigator visible.

5. Click on the Auto Hide icon  in the upper right corner of the docked
Data Navigator to turn off the Auto Hide feature. Alternatively, 

· Place the cursor on the top title bar of the docked Data Navigator.

· Right-click to bring up the associated pop up menu.

· Click to deselect Auto Hide from the pop up menu, (Figure T12.18, red

outline).

2021
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Figure T12.18  Disabling Auto Hide Using the Popup Menu

The Auto Hide feature has now been turned off for all three docked windows,
and they can be undocked.

6. Right-click on the top border of the docked Data Navigator to bring up
the associated pop-up menu.

7. Select Undock from the pop-up menu.

Alternatively, the docked windows can be undocked by dragging and dropping
them back as described in steps 1-3 above.

22.13 Layout Navigator

The Layout Navigator is designed to give you a useful overview of your entire

layout. It shows you a hierarchical view of all the pages in your layout along with

which plots and data files are displayed on each page. The Layout Navigator

also allows you to manipulate the plots and their associated gates and data files
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within the layout. For example, plots can be moved from one page to another by

simply dragging and dropping the plot icons within the Layout Navigator.

In the course of this example, we will:

· Access the Layout Navigator.

· Learn about the Layout Navigator features and how to use them.

Specifically, we will use the Layout Navigator to:

o Apply a gate to a plot.

o Add an overlay to a histogram.

o Insert a new plot.

o Move a plot from one page to another.

In the first exercise, we will open and dock the Layout Navigator .

22.13.1 Opening and Docking

To begin, we will open a saved layout that already has plots and gates on
multiple pages.

1. Select File tab .

2. Open the layout LayoutNavigator.fey found in the Tutorial Sample Data
archive .

The layout appears. However, part of the layout is not visible, so we will now use
zoom to view the whole layout page on the screen.

3. Click on the Zoom icon located in the Zoom Toolbar at the lower left
corner of the screen (Figure T13.1, red outline).

Figure T13.1  Zoom Icon

The Zoom dialog appears (Figure T13.2).  Please note that the Percent number
in the field at the bottom of the dialog window will be dependent on your screen
and screen resolution.

4. Select Full Page (Figure T13.2, red outline).

2037
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5. Click OK.

Figure T13.2  Zoom Dialog

The layout page will update to display the full page of layout (Figure T13.3).
Notice the tabs at the bottom of the screen indicate there are two pages in the
layout (Figure T13.3, red outline).
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Figure T13.3  Layout Navigator - Page 1 Plots and Page Tabs

We will now open the Layout Navigator. 

6. Select the View tab  command (Figure
T13.4, red outline).

Figure T13.4  Layout Navigator Command from View Tab on Ribbon

The Layout Navigator appears; we will now dock it to the right side of the
layout. For more information on docking please refer to the Docking tutorial . 
The Layout Navigator is now docked on the right side of the layout. However,
not all the text is visible, so widen by dragging its left border to the left.

7. Right-click within the Layout Navigator and select Expand All.

2017
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8.  If necessary, use the scroll bar on the right side of the docked window to
scroll up and down the Layout Navigator.

The docked Layout Navigator should resemble Figure T13.5.

Figure T13.5  Docked Layout Navigator

In the next section, we will learn the features of the Layout Navigator .2041
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22.13.2 Layout Navigator Features

The Layout Navigator is organized by the Pages of the layout. Notice the
current page, Page 1, is highlighted in yellow (Figure T13.6). Under the Page, all
the plots on that page are listed. Under each plot, the file name, gating, and
other information are listed. A very powerful feature of the Layout Navigator is
the ability to drag and drop plots, gates, or data within the Layout Navigator or
directly onto the layout. We now will explore the many features of the Layout
Navigator.

1. Hover the mouse over the Page 2 listing on the Layout Navigator
(Figure T13.6, red arrow).

A thumbnail image of the actual layout page will appear (Figure T13.6, red
outline). This is a helpful, quick reminder of the layout of plots on a page that
may be visible presently. This feature also applies to the plot listings in the
Layout Navigator. If you hover the mouse over any of the plot listings in the
Layout Navigator, a thumbnail of the respective plot will appear.
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Figure T13.6  Image of Page 2 on the Layout Navigator

2. Click on Page 2 in the Layout Navigator.
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Page 2 of the layout now appears with five plots (Figure T13.7). This
demonstrates another way of changing pages within the layout. This page is
identical to its thumbnail from step 1 shown in Figure T13.6. Also notice Page 2 is
now highlighted in yellow within the Layout Navigator, indicating it is displayed
currently.

Figure T13.7  Page 2 of the Layout Displayed

3. Select the TCellSample2.fcs APC-A vs PE-A color dot plot in the lower
left of the layout (Figure T13.8). Notice that the listing for the 13 - Color
Dot - TCellSample2.fcs compensated (APC-A vs PE-A) is now
highlighted in the Layout Navigator, as shown in Figure T13.8.
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Figure T13.8  TCellSample2.fcs Color Dot Plot Selected

This plot is currently gated using the Lymphs gate. We will now use the Layout
Navigator to apply the FITC- gate to 13 - Color Dot - TCellSample2.fcs
compensated (APC-A vs PE-A).

4. Place the cursor over the FITC- gate under 7 - Color Dot -
TCellSample1.fcs compensated (APC-A vs PE-A) on Page 1 of the
Layout Navigator.

5. Click the left mouse button and drag FITC- gate to 13 - Color Dot -
TCellSample2.fcs compensated (APC-A vs PE-A), on Page 2 of the
Layout Navigator.

6. Release the mouse button when the cursor is over the 13 - Color Dot -
TCellSample2.fcs compensated (APC-A vs PE-A) (Figure 13.9, red
arrow).
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Figure T13.9  Dragging and Dropping FITC- Gate from Plot 7 on Page 1 to Plot 13
on Page 2 in Layout Navigator
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7. Click Undo  in upper left of window to remove the FITC- gate.  You
may use the keyboard shortcut CTRL+Z to undo as well.

Alternatively, you can directly drag the gate from the Layout Navigator onto
the plot on the layout.

A.  Click on Page 2 in the Layout Navigator to display that layout page.

B.  Place the cursor over the FITC- gate, listed under 7 - Color Dot -
TCellSample1.fcs compensated (APC-A vs PE-A) on Page 1 of the
Layout Navigator, highlighted in blue in Figure T14.10.

C.  Click and hold the left mouse button.

D.  While holding the mouse button, drag the FITC- gate onto the plot 13 -
Color Dot - TCellSample2.fcs compensated (APC-A vs PE-A) that is
visible on Page 2.

E.  Release the mouse button when the FITC- gate is on the plot 13 - Color
Dot - TCellSample2.fcs compensated (APC-A vs PE-A).

13 - Color Dot - TCellSample2.fcs compensated (APC-A vs PE-A) updates
to reflect the application of the FITC- (FigreT13.10). The Layout Navigator
also updates to reflect the FITC- gate on the 13 - Color Dot -
TCellSample2.fcs compensated (APC-A vs PE-A).
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Figure T13.10 Plot 13 on Page 2 Updated with FITC- Gate from Plot 7
on Page 1

We have illustrated two ways you can apply a gate to a plot using the Layout
Navigator. Now, we will use the Layout Navigator to add an overlay to a
histogram.

9.  Click on Page 2 in the Layout Navigator to display that layout page if
necessary.

10. Place the cursor over the listing for the TCellSample1.fcs data from any
plot on Page 1.
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Figure T13.11  Dragging and Dropping TCellSample1.fcs Data File from Layout
Navigator to FITC-A Histogram

11. Press and hold the left mouse button.

12. Continue to hold down the mouse button and drag the TCellSample1.fcs
data onto the layout to the histogram TCellSample2.fcs compensated
(FITC-A) on Page 2 until blue outline appears around plot (Figure
T13.11, red arrow).

13. In Select Drag and Drop Action window, choose add the files to the
plot as new overlays and click OK (Figure T13.12).

Figure T13.12  Selecting to Add File as New
Overlay for Drag and Drop from Data List to

Histogram

14. Histogram will resemble Figure 13.13.
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Figure T13.13  Histogram After
Adding New Overlay

TCellSample1.fcs Data File

Alternatively, you can drag and drop the data within the Layout Navigator.

A. Press Undo  to remove overlay added from steps 9-14 above.

B. Place the cursor over any listing for the TCellSample1.fcs data on Page 1
 in the Layout Navigator.

C. Click and hold the left mouse button.

D. While holding the mouse button, drag the TCellSample1.fcs data file in
the Navigator Layout to plot 8 - Histogram - TCellSample2.fcs
compensated (FITC-A).

E. Release the mouse button when the cursor is over 8 - Histogram -
TCellSample2.fcs compensated (FITC-A) (Figure T13.14, red arrow).
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Figure T13.14  Dragging and Dropping TCellSample1.fcs Data File within the Layout
Navigator

The Select Drag and Drop Action dialog appears (Figure T13.12).

14. Select add the files to the plot as new overlays.

15. Click OK.

The 8 - Histogram - TCellSample2.fcs compensated (FITC-A) plot now
updates to reflect the overlay of the TCellSample1.fcs data as shown in Figure
T13.13.  The Layout Navigator also updates to show that there is now overlay
data on 8 - Histogram - TCellSample2.fcs compensated (FITC-A) (Figure
T13.15).
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Figure T13.15  Layout Navigator Showing Two
Overlays for Plot 8 on Page 2

16. Click on the Undo icon  on the Quick Access Toolbar.

The 8 - Histogram - TCellSample2.fcs compensated (FITC-A) updates to
reflect the removal of the overlay.

We will now use the Layout Navigator to insert a new plot onto page 2 of the
layout (Figure T13.16).

17. Click on Page 2 in the Layout Navigator if page 2 is not already being
displayed.

18. Place the cursor over any listing for the TCellSample2.fcs data in the
Layout Navigator.

19. Drag and drop TCellSample2.fcs data onto blank, white space of Page 2
in the layout (Figure T13.16, red arrow).

Figure T14.16  Dragging and Dropping TCellSample2.fcs onto the Layout
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The Select Plot Types… dialog appears (Figure T14.17).

22. Check box next to Density only (Figure T14.17, blue highlighted text).

23. Click OK.

Figure T14.17  Select Plot Types... Dialog

A density plot of the TCellSample2.fcs data now appears on the layout, with

Time vs FSC-H as the default parameters. The Layout Navigator also updates

to reflect the insertion of the 2D plot on page 2 of the layout (Figure T14.18).

Figure T14.18  Density plot of TCellSample2.fcs with Updated Layout Navigator

We now will undo the insertion of the 2D plot.

24. Click the Undo icon  in the Quick Access Toolbar.
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We now will use the Layout Navigator to move a plot from one page to
another.

25. Place the cursor over the listing for 7 - Color Dot - TCellSample1.fcs
compensated (APC-A vs PE-A) (Figure T14.19).

26. Press and hold the left mouse button.

27. Continue to hold down the mouse button and drag the 2D plot down the
Layout Navigator.

28. Release the mouse button when the cursor is over Page 2 on the
Layout Navigator (Figure T14.19, red arrow).

Figure T14.19  Moving a Plot from Page 1 to Page 2 in the Layout Navigator

Both the layout and the Layout Navigator update to reflect the new location of
the color dot plot.

29. Click on Page 1 in the Layout Navigator (Figure T14.20, yellow
highlighted text).



FCS Express 7 Manual2054

© 2023 De Novo Software

Page 1 of the layout appears (Figure T14.20). Notice 7 - Color Dot -
TCellSample1.fcs compensated (APC-A vs PE-A) is no longer in the lower
left of the page 1 since it was moved to its same location on page 2 of the
layout.

Figure T14.20  Page 1 of the Layout without the Plot 7

30. Click on Page 2 in the Layout Navigator.

Page 2 of the layout appears (Figure T14.21). Notice that 7 - Color Dot -
TCellSample1.fcs compensated (APC-A vs PE-A) is now added to the
bottom left corner of the layout (in selected  mode), and the Layout
Navigator now reflects the addition of this plot to page 2.  You can move the
new plot to an open part of the layout.

1684
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Figure T14.21  Page 2 of the Layout with the Addition of the new 2D
Color Dot Plot

Alternatively, the 2D plot could have been moved by dragging and dropping the
plot listing in the Layout Navigator directly onto page 2 of the layout.

All of the previous manipulations of data, gates, and plots with the Layout
Navigator involved dragging and dropping the items. However, another way to
accomplish these actions would have been to use the pop-up menu associated
with the different items in the Layout Navigator. Just like all the other pop-up
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menus, the Layout Navigator pop-up menus are accessed by right-clicking
when the cursor is located over an item in the Layout Navigator. We will now
use the Layout Navigator to move the 2D plot from page 2 back to page 1 of
the layout.

31. Select 7 - Color Dot - TCellSample1.fcs compensated (APC-A vs PE-
A) on Page 2 of the Layout Navigator.

32. Right-click red border of the color plot on Page 2 of the layout to bring up
the submenu.

33. Select Cut from the submenu (Figure T14.22, blue highlighted text).

Figure T14.22  Layout Navigator 2D Plot Pop-up Menu

The color dot plot is cut from page 2 of the layout.

34. Right-click Page 1 on the Layout Navigator to bring up the Layout
Navigator pop up menu.

35. Select Paste from the menu (Figure T14.23, blue highlighted text).

Figure T14.23  Paste 2D Plot Menu Item
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Alternatively, after following steps 31 through 33 to cut the color dot plot, you
can place the cursor directly onto page 1 of the layout, right-click to bring up the
pop-up menu and select Paste to paste the color dot plot.  You also may use
keyboard shortcuts  to cut and paste the plot from page 2 to page 1.

The color dot plot is now pasted back onto page 1 of the layout and the Layout
Navigator updates to reflect this change.

22.14 Data Navigator

The Data Navigator is designed to give you a useful overview of all the data
files used in the entire layout. It shows you a hierarchical view of all the data, as
all the plots using that data. The Data Navigator also allows you to manipulate
the data and plots on the layout. For example, by simply dragging and dropping
the data icon on the Data Navigator you can replace or overlay the data on a
plot.

In the course of this example, we will:

· Open and dock the Data Navigator.

· Learn about the Data Navigator features and how to use them.

Specifically we will use the Data Navigator to:

o Explore the use of the thumbnail image of a plot associated with a

data file.

o Insert new data onto a plot.

o Add an overlay to a histogram.

o Insert a new plot onto the layout.

In the first exercise, we will open and dock the Data Navigator .

22.14.1 Opening and Docking

To begin, we will open a saved layout that already has plots and gates on two
pages.

1. Select File tab .

2. Open the layout DataNavigator.fey found in the Tutorial Sample Data
archive .

The first page of the layout appears (Figure T14.1).

1678
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Figure T14.1  Page 1 of the Data Navigator Layout (DataNavigator.fey)

We will now open the Data Navigator. 

3. Select the View tab  command (Figure
T14.2).

Figure T14.2  Selecting the Data Navigator Command

The Data Navigator appears, as shown in Figure T14.3. Right click within the
Data Navigator and select Expand All or click on the "+" sign next to each file to
expand the view.  Under each file, you will see a list of plots that are currently
showing data from that file.  

We will now dock it to the left side of the layout. For more information on
docking, please refer to the Docking tutorial .2017
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Figure T14.3  Data Navigator

4. Place the mouse on the top border of the Data Navigator window.

5. Press and hold the left mouse button and move the Data Navigator
window. 

As soon as you start moving the Data Navigator window the four-headed
arrows of the docking icon appears in the center of the layout, as shown in
Figure T14.4.

6. Continue to hold the mouse button and move the Data Navigator toward
the left arrow of the docking icon.

7. Release the mouse button when the cursor is over the left arrow of the
docking icon, indicated by the cursor in Figure T14.4. You will know you
are in the correct place because the blue rectangle, indicating the proposed
docking location, will appear on the left side of the layout.
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Figure T14.4  Docking the Data Navigator to the Left Side

The Data Navigator is now docked on the left side of the layout. However, all
the text might not be visible so we will now resize the docked window it to
make it wider.

8.  Place the mouse over the outer right border of the docked Data
Navigator.

9.  Move the mouse slightly over the border until the resizing icon appears,
indicated by the red square in Figure T14.5.
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Figure T14.5  Resizing the Data Navigator

10. Press and hold down the left mouse button and continue to hold it while
dragging the border to the right.

11. Release the mouse button when the docked window is large enough to
show all the text of the Data Navigator.

The docked Data Navigator should appear similar to Figure T14.6.
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Figure T14.6  Docked Data Navigator

In the next section, we will explore the features of the Data Navigator .

22.14.2 Data Navigator Features

As shown in Figure T13.6 , the Data Navigator is organized by the data files in
the layout. Under each data filename, is the list of the plots which are using that
data file. We will now explore the many features of the Data Navigator.

1. Hover the mouse over the 9 - Density – TCellSample3.fcs
compensated (APC-Cy7-A vs PE-Cy7-A), under the data file listing for
TCellSample3.fcs, within the Data Navigator, as indicated by the cursor
in Figure T14.7.

A thumbnail image of the actual 2D plot will appear, as shown in Figure T14.7.
This is a helpful quick reminder of which plot is associated with a data file,
particularly if that plot is not currently visible. This feature applies to any of the
plots listed in the Data Navigator.

2062
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Figure T14.7  Thumbnail Image of a 2D Plot on the
Data Navigator

We will use the Data Navigator to change the data displayed in a 2D plot. We
will replace the TCellSample1.fcs data in the 1D plot in the lower right of the
layout with the TCellSample2.fcs data using just the Data Navigator.

2. Place the cursor over data file TCellSample2.fcs in the Data Navigator,
highlighted in blue in Figure T14.8.

3. Press and hold the left mouse button.

4. Drag the TCellSample2.fcs data file up to the plot listing 7 – Histogram
– TCellSample1.fcs compensated (FITC-A), indicated by the cursor
and highlighted in blue in Figure T14.8.

5. Release the mouse button when the TCellSample2.fcs data file is on top
of the listing 7 – Histogram – TCellSample1.fcs compensated (FITC-
A).
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Figure T14.8  Dragging TCellSample2.fcs data file onto a
1D plot in the Data Navigator

The Select Drag and Drop Action dialog appears, as shown in Figure T14.9.

6. Select replace the existing overlays in the plot (Figure T12.9).

7. Click OK.

Figure T14.9  Select Drag and Drop Action Dialog

The 1D histogram in the lower right of the layout is now selected and updates to

reflect the TCellSample2.fcs data, outlined in green in Figure T14.10.
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Figure T14.10  Selected and Updated 1D Histogram with TCellSample2.fcs Data

The Data Navigator is also updated to reflect the changes, as shown in Figure

T14.11. The plot 7 – Histogram – TCellSample2.fcs compensated (FITC-A)

appears under the TCellSample2.fcs data file listing, as indicated by the cursor

and the thumbnail image in Figure T14.11.

Figure T14.11  Data Navigator Updated to Reflect
TCellSample2 Plot Changes
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We now will use drag and drop in the Data Navigator to overlay data on a
histogram.

8.  Place the cursor over data file TCellSample2.fcs in the Data Navigator,
highlighted in blue in Figure T14.12.

9.  Press and hold the left mouse button.

10. Drag the TCellSample2.fcs data file up to the histogram plot listing 4 –
Histogram – TCellSample1.fcs compensated (FITC-A), indicated by
the cursor and highlighted in blue in Figure T14.12.

11. Release the mouse button when the TCellSample2.fcs data file is on top
of the histogram listing.

Figure  T14.12  Dragging TCellSample2 onto a Histogram
Plot in the Data Navigator

The Select Drag and Drop Action dialog appears, as previously shown in Figure
T14.9. However, this time we will change the selection on the dialog to allow the
data to be overlaid on the histogram.

12. Select "add the files to the plot as new overlays".

13. Click OK.

The histogram in the upper right of the layout is now updated to reflect the
overlay of the TCellSample2.fcs data. The histogram plot is shown outlined in
green and the new overlay data is shown in red in Figure T14.13.
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Figure T14.13  Histogram Updated to Show the Overlay of TCellSample2 Data

Again, the Data Navigator also updates to reflect the changes as shown in
Figure T14.14. Under the data file listing for TCellSample2.fcs, a listing now
appears for 4 – Histogram – TCellSample1.fcs compensated (FITC-A), as
indicated by the cursor and the thumbnail image in Figure T14.14. The sub-listing
Overlay 2 also appears under the histogram listing to indicate that the data file
TCellSample2.fcs is the second overlay on the TCellSample1.fcs histogram.
Note that under the TCellSample1.fcs data file listing, the histogram 4 –
Histogram – TCellSample1.fcs compensated (FITC-A) listing has also been
updated with the sub-listing Overlay 1 to indicate that the data ApoMono.001 is
the base data.
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Figure T14.14  Updated Data Navigator with Overlay of
TCellSample2 Data

All the previous actions of dragging and dropping data in the Data Navigator
could also have been done using the Data Navigator pop up menu. We will now
use the Data Navigator pop up menu to add data as another overlay to the
histogram in the upper right of the layout.

14. Place the cursor over the TCellSample3.fcs data file listing on the Data
Navigator, shown highlighted in blue in Figure T14.15.

15. Right-click to bring up the associated pop up menu.

16. Select Copy from the pop up menu, indicated by the red arrow in Figure
T14.15.
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Figure T14.15  Copy Using Data Navigator Popup Menu

17. Place the cursor over the listing 4 – Histogram – TCellSample1.fcs
compensated (FITC-A) listed under TCellSample1.fcs data on the
Data Navigator, shown highlighted in blue in Figure T14.16.

18. Right-click to bring up the associated pop up menu.

19. Select Paste from the pop up menu, indicated by the red arrow in Figure
T14.16.
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Figure T14.16  Paste Using Data Navigator Popup Menu

The Select Drag and Drop Action dialog appears, as previously shown in Figure
T14.9. However, we will change the selection on the dialog to allow the data to
be overlaid on the histogram.

20. Select "add the files to the plot as new overlays".

21. Click OK.

The histogram in the upper right of the layout is now updated to reflect the
overlay of the ApoMono.003 data. The histogram is shown outlined in green and
the new overlay data is shown in blue in Figure T14.17.
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Figure T14.17  Histogram Updated to Show the Overlay of TCellSample3 Data

Again, the Data Navigator updates to reflect the changes as shown in Figure
T14.18. Under the data file listing for TCellSample3.fcs, a listing now appears
for 4 – Histogram – TCellSample1.fcs compensated (FITC-A), as indicated
by the cursor and the thumbnail image in Figure T14.18. The sub-listing Overlay
3 also appears under the histogram listing to indicate that the data file
TCellSample3.fcs is the third overlay on the TCellSample1.fcs histogram.
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Figure T14.18  Updated Data Navigator with Overlay of
TCellSample3 Data

We also can drag and drop data from the Data Navigator to either replace or
overlay data within the plots on the pages of our layout.

We will drag a data file from the Data Navigator onto a plot on the layout. On
the layout, the dot plot of SSC-A vs. PerCP Cy5.5-A, in the lower left corner of
Page 1, is using the data TCellSample2.fcs. We will overlay that with
TCellSample1.fcs data.

22. Place the cursor over data file TCellSample1.fcs in the Data Navigator,
highlighted in blue in Figure T14.19.

23. Press and hold the left mouse button.

24. Drag the data file TCellSample1.fcs onto the layout.

25. Release the mouse button when TCellSample1.fcs is on top of the dot
plot of SSC-A vs. PerCP Cy5.5-A, in the lower left corner of Page 1,
indicated by the cursor and outlined in blue in Figure T14.19.

26. In the Select Drag and Drop Action window, select add the files to the
plot as new overlays.
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Figure T14.19  Dragging and Dropping TCellSample1 from the Data Navigator onto
the Dot Plot on the Layout

Both the dot plot on the layout, in the lower left, and the Data Navigator have

updated to reflect the data change, as shown in Figure T14.20. The cursor and

thumbnail image, shown in Figure T14.20 indicate the changes in the Data

Navigator.

Figure T14.20  Updated Layout and Data Navigator with TCellSample1 Overlay

In addition to dragging the data file from the Data Navigator and dropping it
onto the dot plot on the layout, we could have used the Data Navigator pop-up
menu to copy the data object, and then used the pop-up menu on the layout to
paste the data onto the dot plot. Just like all the other pop-up menus, the Data
Navigator pop-up menus are accessed by right-clicking when the cursor is
located over an item in the Data Navigator. We will now use the Data
Navigator pop-up menu to insert a new data plot onto the layout.
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27. Place the cursor over TCellSample3.fcs in the Data Navigator.

28. Right-click to bring up the associated pop-up menu.

29. Select Copy from the pop-up menu, as previously shown in Figure
T14.15.

30. Click on Page 2 at the bottom of the layout, as shown in Figure T14.21.

Figure T14.21  Selecting Page 2

Page 2 of the layout will now appear as shown in Figure T12.22.

31. Place the cursor on an empty part of the layout.

32. Right-click to bring up the associated pop up menu, shown in Figure
T14.22. 

33. Select Paste from the pop up menu.

Figure T14.22  Page 2 of the Layout with the Popup Menu

The Select Plot Types… dialog appears, as shown in Figure T14.23.

34. Select Density as the types of plots to open (Figure T14.23).

35. Click OK.
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Figure T14.23  Select Plot Types... Dialog

A density plot of TCellSample3.fcs appear, using the default parameters of 
Time vs. FSC-H, as shown in Figure T14.24.  Feel free to format this plot any
way you wish.

Figure T14.24  Contour Plot of TCellSample3.fcs Data
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22.15 Gate Navigator

The Gate Navigator is designed to give you a useful overview of all the gates
used in the layout. It shows a hierarchical view of the gates and the plots
associated with those gates. The Gate Navigator also allows you to manipulate
the gates and plots on the layout. For example, by simply dragging and dropping
the gate icon on the Gate Navigator you can change the gate a plot is gated
on.

In the course of this example, we will:

· Open and dock the Gate Navigator.

· Learn about the Gate Navigator features and how to use them.

Specifically, we will use the Gate Navigator to:
o Apply gates to plots on the layout.

o Insert a plot onto the layout.

In the first exercise, we will open and dock the Gate Navigator .

22.15.1 Opening and Docking

To begin, we will open a saved layout that already has plots and gates on two
pages.

1. Select File tab .

2. Open the layout GateNavigator.fey found in the FCS Express Sample
Data folder.

The layout appears, as shown in Figure T15.1.

2076
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Figure T15.1  Gate Navigator Layout (GateNavigator.fey)

We now will open the Gate Navigator. 
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3. Select the View tab group  command
(Figure T15.2).

Figure T15.2  Selecting the Gate Navigator Command

The Gate Navigator appears, as shown in Figure T15.3. We will expand the
menu to view all the plots using these gates.

Figure T15.3  Gate Navigator Window

4. Click on the "+" icon to the left the Lymphs gate, indicated by the red
outline in Figure T15.3, to expand the menu. 
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5. Continue to click on the "+" icons until all gate listings are expanded.

Alternatively, you can use the pop-up menu to expand the Gate Navigator
menu.

· Place the cursor on the Gate Navigator.

· Right-click to bring up the pop-up menu (Figure T15.4).

· Select Expand All, the blue highlighted text in Figure T15.4.

Figure T15.4  Gate Navigator Popup Menu

The Gate Navigator should now resemble Figure T15.5.
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Figure  T15.5  Gate Navigator with Listings Expanded

We will now dock the Gate Navigator to the left side of the layout. For more
information on docking, please refer to the Docking tutorial .

6. Place the mouse on the title bar at the top of the Gate Navigator
window.

7. Press and hold the left mouse button and move the Gate Navigator
window. 

As soon as you start moving the Gate Navigator window, the four-headed
arrows of the docking icon appears in the center of the layout, as shown in
Figure T15.6.

8. Continue to hold the left mouse button and move the Gate Navigator
toward the left arrow of the docking icon, indicated by the red outline in
Figure T15.6.

9. Release the mouse button when the cursor is over the left docking zone
sector. You will know you are in the correct place because the blue
rectangle, indicating the proposed docking location, will appear on the left
side of the layout.

2017
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Figure T15.6  Docking the Gate Navigator to the Left Side of the Layout

The Gate Navigator now is docked on the left side of the layout. Docked
windows may be resized.  We will resize the docked window it to make it
wider.

10. Place the mouse over the outer right border of the docked Gate
Navigator.

11. Move the mouse slightly over the border until the resizing icon appears,
indicated by the red outline in Figure T15.7.

12. Press and hold down the left mouse button and continue to hold it while
dragging the border to the right.

13. Release the mouse button when the docked window is large enough to
show all the text of the Gate Navigator, as shown in Figure T15.7.
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Figure T15.7  Resizing the Gate Navigator

In the next section, we will explore the features of the Gate Navigator .

22.15.2 Gate Navigator Features

As shown in Figure T13.7 , the Gate Navigator is organized by the gates used
in the layout. Under each gate, is the list of the plots gated on this gate.  As you
move the cursor over the plots listed in the Gate Navigator, thumbprint images
of the plots appear. This is a helpful quick reminder of which plot is gated on a
gate, and is particularly useful if that plot is not currently visible.

We will now explore the features of the Gate Navigator, beginning with applying
a gate to a plot on the layout using the Gate Navigator. Specifically, we will
apply the CD3 gate and then the FL2+ gate to 2D plots on the layout.

1. Place the cursor over the CD3 gate in the Gate Navigator, highlighted in
blue in Figure T15.8.

2. Press and hold the left mouse button.

2082
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3. Drag and drop the CD3 gate onto the layout, moving the mouse cursor
from the Gate Navigator to the 2D density plot of CD3-FITC (FITC
fluorescence vs. SSC-H), in the second row and left column, outlined in
blue and indicated by the cursor in Figure T15.8.

Figure T15.8  Dragging and Dropping the CD3 Gate from the Gate Navigator onto a
Density Plot on the Layout

The 2D density plot of CD3-FITC (FITC vs. SSC-H) will now update to reflect that
is gated on the CD3 gate, as shown in Figure T15.9. The Gate Navigator also
updates, and under the CD3 gate is a new listing for the 2D density plot CD3-
FITC (FL1-H vs. SSC-H), indicated by the thumbnail image with a red outline in
Figure T15.9.
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Figure T15.9  CD3 Gate Applied to the 2D Density Plot of CD3-FITC (FL1-H vs.
SSC-H)

We will now use drag and drop to apply the CD3 gate from the Gate Navigator
to the other FITC Fluorescence vs. SSC-H 2D plots on the layout.

4. Repeat steps 1 and 2.

5. Drag and drop the CD3 gate onto the layout, moving the mouse cursor
from the Gate Navigator to the 2D density plot of CD4-PE (FITC
fluorescence vs. SSC-H), in the second row and middle column. 

Both the 2D plot and the Gate Navigator update to reflect the application of the
CD3 gate to the CD4-PE (FITC fluorescence vs. SSC-H) plot, as shown in Figure
T15.10.
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Figure T15.10  CD3 Gate Applied to the 2D Density Plot of CD4-PE (FL1-H vs.
SSC-H)

7. Repeat steps 1 and 2.

8. Release the left mouse button when the CD3 gate is on top of the 2D
density plot of CD3-FITC+CD4-PE (FITC fluorescence vs. SSC-H), located
in the second row and right column.

Both the 2D plot and the Gate Navigator update to reflect the application of the
CD3 gate to the CD3-FITC+CD4-PE (FITC fluorescence vs. SSC-H) plot, as
shown in Figure T15.11.
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Figure T15.11  CD3 Gate Applied to the 2D Density Plot of CD3-FITC+CD4-PE (FL1-H
vs. SSC-H)

We will now apply the FL2+ gate to the 2D plots of PE Fluorescence vs. SSC-H
in the third row of the layout. 

9.  Place the cursor over the FL2+ gate in the Gate Navigator.

10. Press and hold the left mouse button.

11. Drag and drop the FL2+ gate onto the layout from the Gate Navigator
to the 2D density plot of CD3-FITC (PE fluorescence vs. SSC-H), located in
the third row and left column.

Both the 2D plot and the Gate Navigator update to reflect the application of the
FL2+ gate to the CD3-FITC (PE Fluorescence vs. SSC-H) plot. We will now apply
the FL2+ gate to the other 2D plots of PE Fluorescence vs. SSC-H).

12. Repeat steps 9 and 10.

13. Release the mouse button when the FL2+ gate is on top of the 2D
density plot of CD4-PE (PE fluorescence vs. SSC-H), located in the third
row of the middle column of the layout.

14. Repeat steps 9 and 10.

15. Release the mouse button when the FL2+ gate is on top of the 2D
density plot of CD3-FITC+CD4-PE (PE fluorescence vs. SSC-H), located in
the third row of the right column of the layout.

The 2D plots on the layout and Gate Navigator should now look similar to
Figure T15.12.
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Figure T15.12  2D Plots and Gate Navigator Updated to Reflect FL2+ Applied to
Third Row of Plots

Now that we have several 2D plots using gates, we can drag and drop gates on
the Gate Navigator itself to change how plots are gated. We will now apply the
Lymphs gate to a 2D plot that is currently being gated on the CD3 gate using
only the Gate Navigator.

16. Place the cursor on the Lymphs gate, shown highlighted in blue in Figure
T15.13.

17. Press and hold the left mouse button.

18. Drag and drop the Lymphs gate down the Gate Navigator from its
name to the listing for 2 - Density – CD3 FITC.002 compensated
(FL1-H vs. SSC-H), indicated by the red arrow and highlighted in yellow
in Figure T15.13.
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Figure T15.13  Dragging and Dropping the Lymphs Gate on the Gate
Navigator

The Lymphs gate now has been applied to the 2D plot of the CD3-FITC.002
(FL1-H vs. SSC-H) by simply dragging and dropping the gate on the Gate
Navigator. The updated 2D plot is shown highlighted in green, and the updated
Gate Navigator listing of the plot is indicated by the cursor in Figure T15.14.
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Figure T15.14  Updated Gate Navigator and Layout to
Show Lymphs Gate Applied

Instead of dragging and dropping the Lymphs gate onto the plot, we could have
used the associated pop up menu.

We now will use the Gate Navigator to move a plot onto a new page in the
layout. First, we will insert a new page on the layout. 

19. Click on the new page icon , which is in the secondary tool bar near
the bottom of the window, to insert a new page.

Alternatively, you can insert a new Page using the Insert command.

· Select the Insert tab group  command, indicated by

the red arrow in Figure T15.15.

Figure T15.15  Selecting the Insert New
Page Command

A new blank page appears on the layout.

20. Place the cursor over the listing for 2D density plot CD3FITC.002 (FL1-
H vs. FL2-H) listed under the Lymphs gate on the Data Navigator,
shown highlighted in blue in Figure T15.16.
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21. Press and hold the left mouse button.

22. Continue to hold down the mouse button and drag the plot listing from
the Gate Navigator onto page 2 of the layout.

23. Release the mouse button when the plot listing is on page 2, indicated by
the cursor in Figure T15.16.

Figure T15.16  Dragging and Dropping a 2D Density Plot Listing onto Page 2 of the
Layout

A new density plot, 19 - CD3FITC.002 compensated (FL1-H vs. FL2-H),
appears under the Lymphs gate and on the new page of the layout, similar to
Figure T15.17.

Figure T15.17  2D Plot on Page 2 of the Layout
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22.16 HLA Cross Matching - Spreadsheets Use Case 1

FCS Express provides a number of tools that allow you to create and use
spreadsheets to graph your data. Your spreadsheets can contain data from
many sources including, but not limited to, tokens such as keyword, statistics,
custom tokens, and token classifiers. In previous versions of FCS Express,
custom data grids were used to create and graph data sets. However, since FCS
Express version 6, the custom data grid is replaced with the new spreadsheet
function . The advantage of creating a spreadsheet containing tokens is that
when your layout changes (e.g., by making a gate or displaying a new set of
data) your data within that spreadsheet will change as well. The use of a
spreadsheet allows you to easily demonstrate the important results from your
experiments using a spreadsheet very similar to excel, by graphing the results
using a bar chart  or scatter plot. In this tutorial, we will focus on creating and
using spreadsheets.

Note: Spreadsheets replace Custom Data Grids  from previous versions of
FCS Express but have the same and more advanced capabilities. If you have
Custom Data tables saved from previous versions of FCS Express in your
layout, then FCS Express will allow you to open them for use and formatting .
New custom data may not be created as Spreadsheets will replace all functions
of the previous Custom Data grid functionality.

We will create a custom spreadsheet to aid in the analysis of an HLA cross-
match experiment. Flow cytometry is frequently used to predict how much
soluble IgG, from a potential recipient's serum, will bind to the cells of an
engrafted organ. The assumption is that most of the IgG binding is directed
against the HLA molecules on the donor cells. A negative cross-match means
that the soluble IgG in the potential recipient's serum did not bind to a significant
number of lymphocytes from the donor cells. This negative cross-match
correlates with an improved graft survival. Specifically, we will examine the T-
and B-cells from the donor to determine the amount of IgG binding from the
potential recipient using an anti-human FITC labeled IgG.

In the course of this example, we will:

· Load and examine a layout with all the plots needed to perform an HLA

cross-match.

· Create and insert various kinds of tokens and data into a new

Spreadsheet.

· Explore various ways of entering information into a Spreadsheet.

· Create Conditional Formatting in Spreadsheet cells.

400

400

400
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First, we will load a layout in preparation for creation of a custom dataset .

22.16.1 Loading a layout for analysis

In this section, we will:

1. Load and examine a layout with all the plots needed to perform an HLA
cross-match.

We will begin by loading a two page layout of HLA cross-match data. The layout
contains data plots from two different negative controls, a positive control, and
serum from a possible recipient patient. 

2. Select File tab .

3. Open the layout HLA Custom Data.fey found in the Tutorial Sample Data
archive  folder.

The two pages of the layout should appear as shown in Figure T16.1, with both
pages being displayed next to each other.

2092
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Figure T16.1  HLA Custom Data.fey

Let's begin by examining the first four plots on the top of Page 1, all labeled 'PBS
NEGATIVE CONTROL', shown in Figure T16.2. The plot in the upper left corner is
of the cells from the donor; a gate has been drawn around the lymphocyte
population and labeled Lymphs. The density plot in the upper right is gated on
only the lymphocyte population and displays the CD3 positive T-cells, in the
lower right quadrant (blue) and the CD19 positive B-cells, in the upper left
quadrant (red). The two quadrants for the T- and B-cells have been converted to
gates and are sub-gates, or children, of the Lymphs gate, as shown by the Gate
View window. The two histograms on the bottom, from left to right, are gated
on the B-cell population (red) and T-cell population (blue), respectively. The
numbers inside the histograms are the median MESF values of the IgG FITC
parameter of the T- and B-cells.

The other plots on the layout are duplicates of these four plots displaying the
data from three other data files.
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Figure T16.2  Layout of PBS NEGATVE CONTROL Plots and Gate View 

Rather than using arbitrary channel values, the layout uses a Channel Calibration

regression that was previously created from FITC MESF beads. This means the

IgG FITC histograms use a calibrated FITC MESF scale. For more information on

using beads in this way, please refer to the tutorial on Calibrating Fluorescence

Using Beads .  As shown in Figure T16.2, the median value from the PBS NEG

CONTROL histogram of the B-cells is 2619.03. This means that the median

intensity of the IgG FITC signal, from the soluble IgG bound to the B-cells of the

donor cells, is approximately 2,619 MESF (Molecules of Equivalent Soluble

Fluorochrome) of fluorescein.

Next, we will create a spreadsheet .

22.16.2 Creating a Spreadsheet for analysis

In this section, we will:

· Create a Spreadsheet.

2385
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· Create and insert tokens and data into the Spreadsheet.

Because the IgG histogram scales are calibrated, we can use the MESF median
values from the B- and T-cell histograms to construct a custom data set.
Ultimately, we want the custom data set to tell us if serum from a patient
sample is considered a "positive", "negative" or "weak" positive cross-match
against the donor cells. To be able to do this, we have to define what is
considered 'positive' or 'negative'. To aid in these definitions, multiple negative
control serum samples are analyzed against the donor cells to determine the
average FITC MESF value. The standard deviation is used to determine a
significant "cut-off" value to use. We will assume that the FITC MESF values that
define 'positive', 'negative' and 'weak' positive have already been determined.

We will begin by inserting a new blank page in the HLA Custom Data.fey layout
from the previous "loading a layout for analysis" tutorial section, and then
inserting a spreadsheet.

1. Select the Home tab group  command. Alternatively,

click on the New Page icon  next to the Page 2 tab at the bottom of
the layout.

A new blank page appears.

2. Select the Insert tab group  command (Figure

T16.3).

Figure T16.3  New Spreadsheet Command

The Create new spreadsheet dialog appears (Figure T16.4).

3. Type "HLA Cross-match" in the Name field.

4. Click OK.
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Figure T16.4  Create New Spreadsheet Dialog

An empty spreadsheet will appear on Page 3 of the layout, as shown in Figure

T16.5. If the spreadsheet appears on another page, you can cut and paste it

onto Page 3 of the layout.

Figure T16.5  Empty Spreadsheet

In the next exercise, we will Populate the spreadsheet for analysis .

22.16.3 Populating a Spreadsheet with data

In this section, we will:

· Insert keyword and statistic tokens into the Spreadsheet.

2096
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· Explore various ways of entering information into the Spreadsheet.

We will insert a keyword token in the cells of Column A of the HLA Custom
Data.fey can be found in the Tutorial Sample Data archive  folder. The
keyword $SRC will be used because it has a good description of the sample. The
plots' titles have been modified to display the $SRC keyword rather than the file
name.

1. Click inside cell A1, shown with blue outline in Figure T16.6.

We are now going to insert the keyword token into the cell.  Find the
Spreadsheet Tab Group. 

2. Click on the Spreadsheet tab group tab group
 Token command, indicated by the red arrow in Figure T16.6.
Alternatively, you can right-click inside cell A1 and choose Insert Token
from the pop up menu.

Figure T16.6  Insert Token from Spreadsheet Tab Group on Ribbon

1682
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The Insert a Token dialog appears, as shown in Figure T16.7.

3. Select Keyword.

4. Click Insert.

Figure T16.7  Insert a Token Dialog

The Create Keyword dialog appears, with the Data Source category displayed,
similar to Figure T16.8.

5. Select any of the plots associated with the data file XM110210-201.001
(PBS NEGATIVE CONTROL), shown highlighted in blue in Figure T16.8.

6. Select the Keyword category on the left (Figure 16.8, red arrow).
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Figure T16.8  Create Keyword Dialog

The Keyword category of the Create Keyword dialog appears, similar to Figure
T16.9.

7. Type "$SRC" in the Select a keyword text field.

8. Click OK.

Figure T16.9  Create Keyword Dialog - Keyword Category

Alternatively, click on the ellipsis ... button. The Please select a keyword dialog
appears, as shown in Figure T16.10.

· Scroll down and select $SRC, shown highlighted in blue in Figure T16.10
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· Click OK.

· Click OK in the Create Keyword dialog.

Figure T16.10  Please Select a Keyword Dialog

The Spreadsheet updates to reflect the insertion of the keyword in the 'A1' cell. 

We now will fill in the rest of the "A" Column of the spreadsheet. However,
rather than repeating all the previous steps, we will simply drag and drop the
appropriate plot into the correct cell in the data grid.

10. Click on one of the "AB HUMAN NEGATIVE SERUM" 2D plots from the
lower half of page 1, shown highlighted in red in Figure T16.11.

11. Press and hold the left mouse button and drag the plot towards the
Spreadsheet, shown in Figure T16.11.

12. Release the left button when the plot is over cell A2, indicated by the
cursor in Figure T16.11.
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Figre T16.11  Dragging and Dropping the AB NEGATIVE HUMAN SERUM Plot onto
the Spreadsheet

The Paste Special dialog appears, similar to Figure T16.12.

13. Select Keyword token, shown highlighted in blue in Figure T16.12.

14. Click OK.

Figure T16.12  Paste Special Dialog

The Create Keyword dialog appears, similar to the Keyword category of the
Create Keyword dialog, shown previously in Figure T16.9.

15. Type "$SRC" in the Select a keyword field.

16. Click OK.
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Note: Dragging a plot onto a place in your layout that can accept a token is a
very convenient way of creating that token since you do not have to select the
data source for the token as done in step 5 above.

The second cell of the A column updates to reflect the addition of the keyword
for the AB NEGATIVE HUMAN SERUM plot. We will now fill the rest of the cells in
the A column. 

17. Repeat steps 10 through 16 for the cell A3 using a POSITIVE SERUM plot
from page 2.

For the 4th cell in the A column, we will manually type in the sample information.
  

18. Type "PATIENT SERUM."  Key Enter/Return on the keyboard.
Alternatively, you can click anywhere outside the Spreadsheet to accept
the entry into that particular cell. If you do not wish to save the data typed
in the editor, you can select the Delete icon, or hit Esc on the keyboard
and the changes will be canceled. 

Column A of the Spreadsheet is now filled in with sample information and should
appear similar to Figure T16.13.

Figure T16.13  Sample Column
Completed

We now will insert the respective median statistics into Columns B and C for the
B Cell and T cell subpopulations from each sample. Because these median values
are displayed as tokens on the histograms, we will copy and paste them from
the plots into the appropriate cells of the spreadsheet.  

The B Cell histograms display a RED overlay, while the T Cell histograms display
a BLUE overlay.

19. Place the cursor at the beginning of the B-Cell token value in the PBS
NEGATIVE CONTROL histogram (page 1) in red on the layout.

20. Select the B-Cell token text. You will know it is selected because the text
will be white, indicated by the cursor in Figure T16.14.
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Figure T16.14  Token Value Selected

21. Copy the text using Ctrl+C on the keyboard.

Alternatively, after Step 21, the B-cell token text can be copied using the pop-up
menu.

· Right click to bring up the pop up menu.

· Select Copy  from the pop up menu, shown highlighted and indicated by the

cursor in Figure T16.15.

Figure T16.15  Copying a Token Using the Popup Menu

We will now paste the B-cell token into the appropriate cell of the 'B' column of
the Spreadsheet.

22. Click inside cell B1.

23. Paste the text using Ctrl+V on the keyboard.

Alternatively, after Step 24, the token text can be pasted using the pop up
menu.
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· Right-click inside cell B1 column to bring up the pop up menu.

· Select Paste Text from the pop up menu.

· Click anywhere outside the Spreadsheet to accept the entry.

24. Click anywhere outside the Spreadsheet to accept the entry.

To complete populating cells in Columns B and C, we will drag and drop the entire
text box from each of the remaining histograms:

· Click the statistic in the histogram.

· Drag and drop text box containing statistic by its border (will be green or

red outline) into appropriate spreadsheet cell.

All the cells of the 'B' and 'C' columns of the Spreadsheet should be filled in and
appear similar to Figure T16.16.

Figure T16.16  Spreadsheet with B- and
T-Cell Median Values, in Column B and

Column C, Respectively

In the next section, we will create and use custom tokens in a spreadsheet .

22.16.4 Working with Custom Tokens and Formula References in
spreadsheets

In this section, we will:

· Creating a custom token and insert it in a spreadsheet.

· Learn how to use spreadsheet formulas to replace custom token formulas.

(Jump to this section )

We will begin by using the HLA Spreadsheet.fey layout found in the Tutorial
Sample Data archive  folder. 

The layout contains plots and statistics related to an HLA cross matching data
set. In this tutorial we will first learn how to create a custom token formula and
insert the result in a spreadsheet. We will then learn how to use spreadsheets to
create the formula in spreadsheet cells to contrast the two different methods for
calculating custom statistics in FCS Express. Using spreadsheets for custom
calculations (rather than custom tokens) allows for quick access to additional
chart types for the data sets of interest and may also be more efficient for
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calculating certain formulas. For instance, with the particular data set we are
using it would take an additional amount of effort to create the necessary
custom token formula(s) whereas using a spreadsheet allows you to quickly
copy and paste cells to derive statistics and use the copy down feature to
calculate formulas for multiple cells. 

To begin, we will first complete a series of custom tokens that normalize a
'samples' median fluorescence values based on a 'negative' value. We will use
the median MESF FITC values from the B cells of the PBS NEGATIVE CONTROL as
the 'negative' value and subtract this value from the median MESF FITC value of
the corresponding samples. We will begin by inserting the Custom Tokens
window.

1.  Select File tab .

2.  Load the HLA Spreadsheet.fey layout from the Tutorial Sample Data
archive .

The layout will appear with the Custom Tokens window docked on the left side
of the layout. For more information on docking, please see the Docking
tutorial .

Three custom tokens used to calculate the shift in median fluorescent values
between a negative control and a corresponding sample are already created in
the Custom Token window as seen in Figure T16.17.  We will create a final
custom token that represents the MESF channel shift of a "patient" sample
relative to the PBS NEGATIVE CONTROL sample.  Then, the custom token will be
placed into a spreadsheet table. The following steps serve as an example of how
to create and use a custom token formula in a spreadsheet. Later in the tutorial,
we will examine how to define this formula only using a spreadsheet.

Note: For more information on creating custom tokens, refer to the Custom
Token Tutorial .

3.  Click on the  symbol on the top border of the Custom Tokens
window, indicated by the red box in Figure T16.17.
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Figure T16.17  Adding New Custom Token

4. Type "BShift Patient" for the Custom Token name.

5. Click in the empty field of the Custom Token window under Enter the
Custom Token formula below. 

6. Type "=" in this Custom Token definition area.

7. Right-click to the right of the "=" sign. 

8. Choose Insert Token. 

9. Double-click the Statistic category. 

10. Choose 20-Histogram XM110210-210.001 (IgG FITC) in the Select
a Plot dialog, as in Figure T16.18.
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Figure 16.18  Create Statistic Dialog - Defining Data Source

11. Click on the Statistic category, orange highlight in Figure T16.18.

12. Choose the B Cells gate from the Gate area.

13. Click on Median under Statistic.

The Create Statistic dialog should resemble Figure 16.19.
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Figure 16.19  Creating Statistic Dialog - Selecting Statistic

14. Click OK. 

The median token value will appear in the custom token definition.

We now will complete the complete the BShift Patient custom token, shown in
Figure T16.20.

15. Type '-' after the token defined in the previous steps (Figure T16.20, red
arrow).

16.Repeat steps 8-15 after the minus sign choosing 4-Histogram
XM110210-210.001 (IgG FITC) instead of 20-Histogram
XM110210-210.001 (IgG FITC).

 The Custom Token formula will appear as in Figure 15.26 below. Notice the
custom token formula is defined as the median for plot 20 minus the median for
plot 4. 
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Figure T16.20  Creating the B-cell Median Shift Custom Token Definition

We now will populate cell B4 with the respective cell shift custom token in the
spreadsheet on Page 3 by dragging and dropping the BShift Patient Custom
Token into the spreadsheet.

17.Click on the Page 3 page tab.

18. Click and hold the BShift Patient Custom Token, shown highlighted in
blue (Figure T16.21, left panel).

19. Drag the BShift Patient Custom Token to cell B4 in the spreadsheet.

20. Release the mouse button when the cursor is over cell B4 in the
spreadsheet, (indicated by the cursor and the red arrow in Figure T16.21).
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Figure T16.21  Dragging and Dropping the "BShift Patient" Custom Token into the
Spreadsheet.

The spreadsheet now should resemble Figure T16.22.

Figure T16.22  Spreadsheet with BShift Custom Tokens in Column B

We will now complete a series of custom tokens for corresponding T cell median
fluorescent shift values by using tokens and formulas in the spreadsheet. The
method described below will contrast the method of using custom tokens. The
TShift Negative Control Tokens that we will bring into Column 'D', will be
subtracted from the TShift Median Tokens in Column 'C'. The result will be
returned from a formula Column 'E' which can serve to replace a series of
custom token values such as the previous way we defined the BShift custom
token series in the steps above. 

Let's start with Dragging and Dropping the Histogram from the Data Navigator to
Column 'C'. First Open up the Data Navigator. We have more information about
the Data Navigator in our Tutorials and Manuals. 

21. Click on the View tab group  Navigator.

22. Expand the XM110210-201.001 node (first listed). 

23. Click 5-Histogram-XM110210-201.001 (IgG FITC) in Data
Navigator and click Page 3 tab.

24. Drag and drop 5-Histogram-XM110210-201.001 (IgG FITC) to cell
C1 (Figure T16.23).
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Figure T16.23  Drag and Drop to Add Statistic Token to Spreadsheet Cell

A Paste Special Dialog will appear.

25. Click on Statistic Token in the Paste Special as in Figure T16.24 below.

Figure T16.24  Paste Special Dialog

26. Select the T Cells gate from the Gate area.

27. Select Median from the Statistic list. 

28. Click OK.

We will repeat the steps above to insert the rest of the TShift Median values by
dragging and dropping the histograms from the Data Navigator to cells C2, C3,
and C4, respectively. 

29. Expand the XM110210-202.001 node in the Data Navigator. 
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30. Drag and Drop 6-Histogram-XM110210-201.001 (IgG FITC) to cell
C2 and repeat steps 24-30.

31. Expand the XM110210-203.001 node in the Data Navigator. 

32. Drag and Drop 14-Histogram-XM110210-201.001 (IgG FITC) to cell
C3 and repeat steps 24-30.

33. Expand the XM110210-204.001 node in the Data Navigator. 

34. Drag and Drop 21-Histogram-XM110210-201.001 (IgG FITC) to cell
C4 and repeat steps 24-30.

We now will use copy and paste to copy the baseline TShift Negative Control
value to the corresponding cells in Column D. The value will be subtracted from
the Column C median values in a subsequent formula resulting in the TShift series
of values within Column E of the Spreadsheet.

35. Click cell C1 to select it. 

36. Press Ctrl+C to Copy cell C1. Alternatively, right-click and choose Copy
as in Figure T16.25.

Figure T16.25  Using Copy Command to Copy Cells of Spreadsheet

37. Multiple-select cells D1-D4 by clicking and holding mouse button with
cursor over cell D1 and move cursor down to D4 while holding mouse
button. 

38. Press Ctrl+V to Paste to cells D1-D4. 

The spreadsheet should resemble Figure T16.26.

Figure T16.26  Using Multiple Select and Paste Commands in Spreadsheet 
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We now will complete the spreadsheet by defining the formula of the TShift
series in column in E using a spreadsheet formula reference and using the copy
down feature to quickly complete the formula for all rows. 

39. Click cell E1.

40. Enter an "=" sign.

41. Click on cell C1. 

42. Enter a "-" sign.

43. Click on cell D1. 

The formula should be identical to Figure T16.27

44. Press Enter.  The formula for C1 minus D1 will result in the value of 0 in
cell E1.

Figure T16.27  Defining Formula in Spreadsheet

We now will use the copy down feature to quickly copy the formula down to
through the remaining cells and complete the spreadsheet. 

45. Click cell E1.

46. Click and drag small blue square in lower right corner of cell outline down
to cell D4. The formula will be copied down the range of cells selected.  

The spreadsheet should appear as Figure T16.28.

Figure T16.28  Spreadsheet Complete

Next, we will create and use token classifiers in the spreadsheet  for IVD use.

22.16.5 Create Token Classifiers

Classifier Tokens are only available in the Clinical Edition (IVD version) of FCS
Express. Please contact support@denovosoftware.com if you would like more

2113

mailto:support@denovosoftware.com


FCS Express 7 Manual2114

© 2023 De Novo Software

information on FCS Express Clinical Edition and access to the Creating Token
Classifiers tutorial. 
 

22.16.6 Using Conditional Formatting to Classify Data

· Create Conditional Formatting using custom tokens.

· Insert Conditional Formatting into the new Spreadsheet.

Using the 'BShift' and Custom Token data created in the previous section , we
will now define conditional formatting ('NEG', 'POS', and 'WEAK') in the
Spreadsheet. We will use conditional formatting to classify our samples and
ultimately determine the status of the patient serum cross-match. To begin, we
will insert a new Spreadsheet.

1. Open the HLA Conditional Formatting.fey found in the Tutorial Sample
Data archive  folder.

We will begin by defining conditional formatting to classify the results for each
sample in the spreadsheet. 

2.  Click on the Page 3 tab.  

3.  Click on the header cell of the spreadsheet's Column B.

4.  Click the Spreadsheet tab group Tab
group command.

5.  Mouse over Icon Sets.

6.  Mouse in-line of arrow point to right to the right to reveal the available
icon sets. 

7.  Click the first set of arrows icons in the first row (Figure T16.37, red
outline). 

2113
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Figure T16.37  Selecting First Icon Set from
Ribbon

You will notice that the data set has now been conditionally formatted based to
use the icon set based on the default rules. We will now adjust the rules to
perform a custom classification using the icon sets. 

6. Click on the Spreadsheet tab group Tab
Sorting group

7. Click the Managing Rules drop-down (Figure T16.38, red outline).
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Note: Here, we will define the rules for the conditional formatting seen in Figure
T16.39. Before using the Manage Rules feature, confirm the column containing
the data set to classify in the spreadsheet is selected. For example; in this
tutorial, it will be Column B. 

Figure T16.38  Managing Conditional
Formatting Rules

8. Click on the words Icon Set underneath the Rule column (Figure T16.39).

9. Click on the Edit Rule... button (shown with the cursor on it in Figure
T16.39). 

Note: while using conditional formatting, we can add additional rules. In this
particular case, we will edit the rule as it is already started in this particular layout
(shown by the cursor). This rule will apply to cells B1-B4.



Tutorials 2117

© 2023 De Novo Software

Figure T16.39  Conditional Formatting Rules Manager Dialog

10. Click on Format all cells based on their values via icon set (Figure
T16.40, blue highlighted text). 

Note: Here you will add values according to each rule displayed by the icon set.
Make sure you choose the rule type. In this tutorial, we are using Format all
cells based on their values via icon set.
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Figure T16.40  Conditional Formatting Rule Range Definitions

11. Click on the percent drop-down in the Up Arrow category (Figure
T16.41).

12. Choose value (Figure T16.41, blue highlighted text in drop-down).

13. Click the 0 in order to enter a new value.

14. Enter the value of 40000 to replace 0. 

Note: in this case, we entered 40000 which defines greater than or ">" 40000
for the green arrow.

In order to define the second line for the right facing yellow arrow in the Display
each icon according to these rules: window,

15. Click on percent in the second row.

16. Choose value from the drop-down. 

17. Click on the "0" from the second line in the Display each icon according
to these rules: window.
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18. Enter 8000 as the numerical value for the yellow arrow.

Note: The yellow rule is defined by less than or "<" 40000 but greater than of
">" 8000.

Also Note: The red arrow is then automatically defined as less than or "<"
8000. 

19. Click OK. The formatting rules dialog will appear.

20. Click Apply.

21. Click OK.

Figure T16.41  Conditional Formatting Rules Dialog

Note: you will see the conditional formatting displayed in the spreadsheet (Figure
T16.42). To see the changes in real-time, you may type in a different value in
column B or update the Lymphs gate on Page 1 or Page 2. The conditional
formatting will change due to the spreadsheet cell values updating.
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Figure T16.42  Spreadsheet with Conditional Formatting

22.17 Antibody Titration - Spreadsheets Use Case 2

FCS Express allows you to easily create summary data and plots that show your
entire experimental results using Spreadsheets . Your spreadsheet(s) can
contain information from data files, plots, or gates. When your gates change, so
will the data in spreadsheets and any plot derived from them. Formulas  can be
used also to calculate custom data as well.  

In this tutorial, we will use spreadsheets and plots to aid in the visualization of
data from antibody titration experiments.  This tutorial will demonstrate, by
selecting the ideal antibody concentration the best separation between positive
and negative cells will be achieved. 

We will examine data from a titration experiment where seven different amounts
of CD64 were used to stain peripheral blood mononuclear cells. Because CD64 is
constitutively expressed on only macrophages and monocytes, we will examine
the ratio of the intensity of fluorescence staining on the monocyte versus
lymphocyte population. The negative population will be defined by the
lymphocytes and the positive population by the monocytes.

In the course of this example, we will:

· Create a new spreadsheet and populate it by manually entering

information as well and dragging and dropping statistics from gates and
data files and calculate a CD64 signal to noise ratio.

· Insert a scatter plot displaying the data calculated within the spreadsheet.

In the first exercise, we will create a spreadsheet .

22.17.1 Creating an analysis Spreadsheet

For this tutorial, we will be using a layout file that has 2D density plots with
defined gates from seven data files, each having a different amount of CD64
antibody.  Please note you may skip ahead to the next section to insert a scatter
with regression plot  using a completed spreadsheet.

1. Select the File tab dialog.
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2. Open the layout Titration.fey found within the Tutorial Sample Data
archive  in a subfolder called Spreadsheet and Titration.

The following layout should appear as shown in Figure T17.1.

1682
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Figure T17.1  Titration Layout
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In the upper left corner of the layout, a dot plot displays SS Lin (side scatter)
versus FS LIN (forward scatter) with a scatter gate, drawn in red. The Scatter
gate has been defined to exclude very low and very high scatter signals. All the
other plots on the layout are gated using this Scatter gate. Seven different
volumes of CD64 were added to peripheral blood mononuclear cells and are
shown in the seven color dot plots. To define the negative population for this
titration experiment, a gate has been drawn on the lymphocyte population,
shown in blue as the Lymphs gate, in the 2D plot of Side Scatter (SS Lin) versus
CD64 (FL 8 Log). The positive population is the monocyte population which is
defined in purple as the Monos gate. In the lower left corner of the layout is the
Gate View window showing that the Lymphs and Mono gates are children of the
Scatter gate, meaning the data is first gated using the Scatter gate and then the
Lymphs and Mono gates are applied.

We will use a spreadsheet to calculate the values of CD64 signal to noise ratio
for each of the seven volumes of CD64 used. The values will be defined as the
ratio of the median CD64 fluorescent intensity of the monocyte population (the
positive population) divided by the median CD64 fluorescent intensity of the
lymphocyte population (the negative population).

3. Select the Insert tab group  command (Figure
T17.2).

Figure T17.2  Opening new spreadsheet
from ribbon

The Create new spreadsheet window now appears on the layout.

4. Enter "Titration" in Name field. 

5. Click OK to close window.

The new spreadsheet appears on the layout.

6. Click and drag spreadsheet border to reposition.

7. Release the button when spreadsheet is positioned where desired.

For this exercise, we will populate the spreadsheet with the following
information: 

Column A - amount of antibody added, 
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Column B - median CD64 fluorescent intensity of the monocyte population, and

Column C - median CD64 fluorescent intensity of the lymphocyte population.

8.  Click cell A1 of spreadsheet.

9.  Type "Ab Added".

10. Press Enter. Cell A2 will be outlined in blue (Figure T17.3).

Figure T17.3  Populating Spreadsheet Cell A1

11. Type "0.156".

12. Press Enter. Cell A3 will be outlined in blue.

13. Type "0.313". 

14. Press Enter. Cell A4 will be outlined in blue.

15. Type "0.625".

16. Press Enter. Cell A5 will be outlined in blue.

17. Type "1.25". 

18. Press Enter. Cell A6 will be outlined in blue.

19. Type "2.5".
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20. Press Enter. Cell A7 will be outlined in blue.

21. Type "5". 

22. Press Enter. Cell A8 will be outlined in blue.

23. Type "10".

24. Press Enter. Cell A9 will be outlined in blue.

Cells A2-8 should be populated with antibody amounts (Figure T17.4).

Figure T17.4  Column A Complete

To populate cells from columns B, we will drag and drop the SS Lin vs FL8 Log
Color Dot plots for each respective antibody amount.

25. Type "Monos Median".

26. Press Enter. Cell B2 will be outlined in blue. 

27. Click plot for 0.156 ul CD64. 

28. Click border of plot to cell B2 of spreadsheet (Figure T17.5).
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Figure T17.5   Drag and Drop Plot to Spreadsheet Cell B2

29. Release mouse button.

30. Select Statistic token from Paste Special window (Figure T17.6).

Figure T17.6   Paste Special Window

The Statistic page of the Create Statistic dialog now appears (Figure T17.7).
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Figure T17.7  Edit Statistic Infromation for Monos

31. Click OK.

32. Select Monos from the Gate area.

33. Select Y Median from the Statistics list box.

34. Select OK.

35. Repeat Steps 27 - 34 for the following color dot plots and spreadsheet
cells: 

0.313 ul CD64 to B3, 0.625 ul CD64 to B4, 1.25 ul CD64 to B5, 2.5 ul
CD64 to B6, 5 ul CD64 to B7, and 

10 ul CD64 to B8.

The spreadsheet should now appear as in Figure T17.8.
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Figure T17.8  Columns A and B Complete

Column C will be populated by dragging and dropping data files from the data list
onto the spreadsheet.  

36. Click Data tab group  command.

37. Press Ctrl+A to select all data files.

38. Click and hold mouse button on any data file in data list.

39. Drag data files to cell C1 in spreadsheet (Figure T17.9).
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Figure T17.9   Drag and Drop Files from Data List to
Spreadsheet

40. Release mouse button.

41. Choose Statistic token.



FCS Express 7 Manual2130

© 2023 De Novo Software

The Statistic category of the Create Statistic dialog now appears.

42. Select FL Log 8 from Parameter list under Data File Information.

43. Select Lymphs from Gate area.

44. Select Median from Statistic list box.

45. Click OK (Figure T17.10).

Figure T17.10   Edit Statistic Dialog for Lymphs

46. Click cell C1.

47. Type "Lymphs Median".

48. Press Enter.

The spreadsheet should appear similar to Figure T17.11 below.
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Figure T17.11  Columns A, B, and C Complete

Alternatively, gates may be dragged and dropped from each dot plot to the
spreadsheet.

· Click gate of interest from plot and drop onto appropriate cell.

o For example, click and drag purple Monos gate from color dot plot -

0.156 ul CD64 SS Lin vs FL 8 Log to cell B2 of spreadsheet.

· Release mouse.

· Select Y Median from Statistic list box.

· Click OK.

Values in the spreadsheet will update in real-time as gating is changed.

· Click and hold red Scatter gate in upper left plot on layout - 10 ul CD64

SS Lin vs FS Lin.

· Move mouse and observe values changing in spreadsheet as Scatter gate

is moved.

· Release mouse.

· Press Ctrl+Z to undo gate move.
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To resize column width(s), follow one of the two commands below:

·  Hover mouse cursor over right border of column header until resizing

cursor appears ( ) double click (left in Figure T17.13 below).

·  Spreadsheet tab group Layout tab Format drop-down list AutoFit

Column Width (right in Figure T17.12 below). 

Figure T17.12  Resizing single column width (left) or autofitting widths for entire
spreadsheet (right)

We will now calculate the ratios of the CD64 staining for the Monocyte and
Lymphocyte populations within the spreadsheet.

49. Add page to layout by using Home tab group
command.

50. Use View tab group  command to open
Layout Navigator.

51. Drag and drop spreadsheet "Titration" from Page 1 to Page 2 within
Layout Navigator (Figure T17.13).
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Figure T17.13  Moving Spreadsheet to Page 2

52. Select the View tab group
command.

53. Go to Page 2 of layout.

54. Select the spreadsheet.

55. Click cell D1.

56. Type "M/L Ratio".

57. Press Enter. Type "=" into cell D2.

58. Click cell B2.

59. Type "/".

60. Click cell C2. 

61. Press Enter.

62. Click cell D2.

63. Hold Shift and click cell D8.
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64. Release mouse button.

65. Ctrl+C. 

66. Ctrl+D.

The spreadsheet should now appear similar to Figure T17.14.

Figure T17.14  Columns A, B, C, and D Complete

In the next section, we will create a regression curve from a spreadsheet .

22.17.2 Creating a regression curve from a Spreadsheet

The remainder of this tutorial will focus on creating a regression analysis of the
data by using a scatter plot with regression plot with Spreadsheet based data. 
You can use the layout you created in the previous section or open Titration
with Complete Spreadsheet.fey in Tutorial Sample Data archive  within the
sub folder called Spreadsheet and Titration.

1. Click on spreadsheet. 

2. Insert tab tab .

3.  Click on blank space on page 2 of layout.

Plot should now appear and resemble Figure T17.15 below.

2134
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Figure T17.15   Scatter Plot with
Regression Unedited

The 2D scatter with regression plot using the titration data in the spreadsheet
appears. Notice that the plot contains points in black that represent the points
from Columns A (X-axis) and B (Y-axis) of the spreadsheet. The red line overlay
is a regression overlay. The default regression fit for all scatter with regression
plots is a linear fit. In the following steps we will adjust the plot to display the
correct data from the spreadsheet and a more appropriate Michaelis-Menten
regression fit. We will also start by adjusting the axis range to more appropriately
fit the points within the plotted region.

4. Double-click plot to open Formatting dialog, which will appear docked to
right of layout and display General category.

5. From the Overlays category, change Y Parameter to D for 2D
Unbinned Overlay Options.  This will change the data used from Column
A "Monos Median" to Column D "M/L Ratio"(Figure T17.16).



FCS Express 7 Manual2136

© 2023 De Novo Software

Figure T17.16  Changing Y Parameter
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6.  Select the Axes category.

7.  Select Y Axis (Figure T17.17). 

8.  Enter "150" in the Minimum Range and "750" in the Maximum Range
fields (Figure T17.17, red outline). 

Figure T17.17  Updating Y-Axis Range Values

9.  Select X Axis (Figure T17.18). 

10. Enter "12" in the Maximum Range window (Figure T17.118, red
outline). 



FCS Express 7 Manual2138

© 2023 De Novo Software

Figure T17.18  Changing X-Axis Range Maximum

11. Select Regression Fit category.

12. Choose MichMenten from Regression Type drop-down list under
Regression Model Options.

13. Confirm Number of regression dots is set to 30 (Figure T17.19).
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Figure T17.19  Regression Fit Settings

The scatter plot should resemble Figure T17.20

Figure T17.20  Scatter with Regression
Plot after Modifications
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14.Type into "Monos CV" cell E1.

15. In Data List, Ctrl+A.

16. Drag and drop data files to E2 (Figure T17.21).

17.Choose Statistic Token from the Paste Special dialog.

Figure T17.21  Drag and Drop Data Files to E2

The Statistic page of the Create Statistic dialog now appears.

18. Select FL 8 Log from the Parameter list under Data File Information.

19. Select Monos from the Gate area.

20. Select CV from Statistic list box.

21. Click OK (Figure T17.22).
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Figure T17.22  Edit Statistic Information for Monos CV

The spreadsheet should now resemble Figure T17.23.
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Figure T17.23  Columns A, B, C, D, and E Complete

22. Click to select scatter with regression plot.

23. Select the Overlays category.

24. Select E from the Error Bar Param drop-down list.  This will change the
data used from Column A "Monos Median" to Column E "Monos CV".
(Figure T17.24).
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Figure T17.24  Adding Error Bar from Overlays
Category

The titration Scatter with Regression plot updates to reflect the addition of black
error bars using the Monos CV data, shown in Figure T17.25. Note: that as you
adjust any of the gates in the layout the raw data points, regression line, and
error bars will all update accordingly and in real-time. 

Figure T17.25  Scatter with Regression
Plot with Error Bars



FCS Express 7 Manual2144

© 2023 De Novo Software

We now will add a Regression Parameter Statistics default window to obtain the
Vmax (Vm in Figure T17.26) and summarize the fit.

25. Right-click the Scatter with Regression plot.

26. Select Statistics> Regression Parameter Statistics from the pop up
menu.

A Regression Parameter Statistics window now is inserted on the layout (Figure
T17.26).

Figure T17.26  Regression Parameter Statistics Window Inserted to
Summarize Fit of Scatter with Regression Plot

22.17.3 Interpolating values from the regression

In this section, we will interpolate the X-value for the Vmax calculated from the
Scatter with Regression Plot in the previous section , using the
"RegressionPlotYToX" Custom Token function.

Please ensure that the previous section of the tutorial has been completed
before proceeding.

1. Select the View tab command.

2. Click on the blue plus in the Custom Tokens window to Create a new

Custom Token (Figure T17.27, ).

3. Type "X from Vmax" to descriptively title the new Custom Token (Figure

T17.27, ).

4. Type an equals sign ("=") in the Custom Token formula pane of the

Custom Tokens window (Figure T17.27, ).

5. Right-click and select Insert Function> Regression >

RegressionPlotYtoX from the pop up menu (Figure T17.27, ). 

2134
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Figure T17.27  Inserting a Custom Token Function to Interpolate an X Value from
the Regression

The Custom Token formula pane now appears as in Figure T17.28.

Figure T17.28  "RegressionPlotYtoX" Interpolation Custom Token Formula

We will replace the components of this Custom Token with specific information
from our layout.

6. Highlight the "Plot Number" text of the Custom Token (Figure T17.29, ).
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7. Right-click on Plot ID and select Insert Token (Figure T17.29, ).

8. Select Plot Information from the Plot node of the Insert a Token dialog

(Figure T17.29, ).

9. Click Insert (Figure T17.29, ). 

Figure T17.29  Identifying Components for Formula of the Custom Token

10.Scroll to and select the Regression plot under the Select a Plot box of the

Edit Plot Information Token dialog window (Fig. T17.30, ).  A
thumbnail image at right aids in selection of the correct plot.

11.Select the Plot Elements category at left (Figure T17.30, ).

12.Select Plot Number from the Select a Plot Token Element box (Figure

T17.30, ).

13.Click OK (Figure T17.30, ). 

Figure T17.30  Completing Information for Components of Custom Token
Formula
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14.Highlight the "Overlay Number" text of the Custom Token (Figure T17.30,
above).

15.Type "2", as the Regression line is the second overlay in the Scatter with
Regression Plot.

16.Highlight the "Y value" text of the Custom Token (Figure T17.30, above).

17.Type a value close to the Vmax, e.g., "500".  

Note: typing in a value too close or equal to the Vmax will result in a non-useful,
very high X-value, as the Michaelis-Menten equation asymptotically
approaches the Vmax.  As an alternative to typing in an arbitrary free text
value, you could create a Custom Token  that is equal to a percentage
(e.g., 90%) of the Vmax regression token , and enter this Custom Token in
place of the "Y value" text.

The "X from Vmax" Custom Token formula now appears as below (Figure
T17.31, left).  We will now insert the result as a Custom Token onto our
layout.

18.Drag and drop the "X from Vmax" Custom Token from the upper pane of
the Custom Tokens window to an empty spot on your layout, or to the
Scatter with Regression plot.  

The Custom Token's mathematically calculated value is now displayed in a Text
Box (Figure T17.31, center).  We will now add descriptive free text to the
Text Box.

19.Click inside the Text Box so that it enters edit mode  (its border appears
green as in Figure T17.31, right).

20.Type "The amount of antibody to use is" before the Custom Token, and
"uL" or "microliters" for units after the Custom Token.

The interpolated X-value for the close-to-Vmax Y-value chosen in Step 17 is now
displayed on the layout (Figure T17.31, right).

Figure T17.31   Inserting the Custom Token for the Interpolated X Value from
the Regression
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22.18 Calibration via Regression Analysis - Spreadsheets
Use Case 3

FCS Express provides the user with many mathematical functions to create
custom tokens and custom data sets that can be plotted in Scatter with
Regression and Scatter Plots to provide live updating regression curves and fit
statistics as gates or data files change.

In this tutorial, we will complete a Spreadsheet , insert a scatter with
regression plot, and derive model fit statistics from the data. You will also learn
how to create a regression overlay on a scatter plot, how to apply a regression
fit to an FCS file, as well as how to save a regression fit for later use. 

As an example, we will be performing our analysis on a FITC MESF bead data set
in order to obtain an equation that returns the FITC MESF value for a data
channel value. Because FCS Express also provides the user with an easy to use
Channel Calibration Tool  that uses MESF data from a set of beads to calibrate
the axes to MESF values, this tutorial is most useful in demonstrating the ways in
which custom tokens and custom data sets can be created and plotted and how
you can use regression analysis to fit your data in real time right within FCS
Express. 

In the course of this example, we will:

· Load a layout of MESF beads with histogram markers to complete a

Spreadsheet for regression fitting.

· Insert a Scatter with Regression Plot of the Spreadsheet values and

automatically generated best-fit regression curve.

· Add a regression fit token to the Scatter with Regression Plot.

· Apply the linear regression to an .fcs data file to obtain MESF data.

· Save the linear regression formula in a text file usable by other .fcs data

files and layouts.

First, we will complete the Spreadsheet  and insert a scatter with regression
plot.

22.18.1 Complete a Spreadsheet and Insert a Scatter with Regression
Plot

For this tutorial, we will be using a layout file with plots of FITC MESF beads and a
custom data set, with custom tokens.
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1. Open the layout FITC MESF Beads.fey found in the Calculating MESF
From Regression folder of the Tutorial Sample Data archive .

The following layout should appear as shown in Figure T18.1.

Figure T18.1  FITC MESF Beads.fey Layout

In the upper left corner of the layout, is a Color Dot plot of the FITC beads with a
gate around the single bead events. To the right of this plot, is the FITC
histogram plot, gated with the 'FITC Beads' gate, with markers defining each of
the five FITC bead populations. 

Under both plots, is a spreadsheet, named 'FITC MESF'. For more details on how
to create a spreadsheet, please see our creating a spreadsheet for analysis
tutorial .

Please take a moment and double click on an entry in each column of the
spreadsheet and examine the data entry. The first column is the marker name
and is a manually entered data value. The second column is the median value for
each of the defined markers on the histogram, and is defined using a statistics
token (see the Inserting a Token or Custom Token in a cell  chapter of the
manual to learn more about this topic).
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The third column is the MESF FITC value assigned to each of the bead
populations, and is a manually entered data value. The fourth and fifth columns
are the Log values of the median and MESF bead populations, and are defined by
formula inserted directly in the spreadsheet. In this case, the formula for
calculating the Log, using log base 10, is =LOG(num), where num can be both
a manually inserted number, a numeric token or, as in this case, a cell reference.

Notice that the bottom right cell of the spreadsheet (Cell E6), under the
'LogMESF' column, is empty. We will now fill this cell with the required value by
copy-pasting the content of one of the other cells in that column.

2. Click cell E3, as shown in Figure T18.2, . Please note that any cells
among E2 and E5 can be used to copy content in this step. 

Figure T18.2  Copying and Pasting Content from Spreadsheet Cell E3 to E6

3. Press Ctrl+C to copy the cell content.

4. Click cell E6 as show Figure T18.2, .

5. Press Ctrl+V to paste the cell content .

We have now completed the spreadsheet as shown in Figure T18.3.
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Figure T18.3  Spreadsheet Complete

Now, we will insert a Scatter with Regression plot using the FITC bead data in the
spreadsheet.

4. Select the spreadsheet; it should now have a green border.

5. Select the Insert tab group  with Regression
command.

6. Click on a blank area of the layout below the spreadsheet to insert the
Scatter with Regression plot.

An empty plot using the data from the first two columns, 'A' and 'B', of the
custom spreadsheet appears. 

We will format the Scatter with Regression plot to display the Median and MESF
data from the spreadsheet (i.e. columns 'B' and 'C' respectively).

7. Place the cursor over the Y-axis 'B' label.

8. Press and hold the left mouse button and the list of columns from the
spreadsheet appears, as shown in Figure T18.4.
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9. Release the button when the cursor is over 'C', shown highlighted in blue in
Figure T18.4.

10. Repeat steps 7 through 9 for X-axis, selecting 'B' as column to display.

Figure T18.4  Selecting Colukmn C or
'LogMESF' Data for the Y-axis

The empty plot is now populated with the data from column B and C of the
spreadsheet in black, along with a best-fit regression curve in red, as shown in
Figure T18.5.

Note:  The regression curve type has defaulted to the first option (Linear), which
is appropriate for this dataset.  When working with other datasets, the
Regression Type can be chosen from the Formatting options of the Scatter with
Regression plot.  The smoothness of the curve can also be adjusted.  See this
section of the manual  for details.612
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Figure T18.5  Scatter with Regression
Plot of Median and MESF Data from the

Data Grid

We now will format the Scatter with Regression plot to display the 'Log
MESF' (i.e. column 'E') data of the spreadsheet on the Y-axis.

11. Place the cursor over the Y-axis 'C' label.

12. Press and hold the left mouse button and the list of columns from the
Spreadsheet appears.

13. Release the button when the cursor is over 'E'.

The Scatter with Regression plot now updates to reflect the selection of the 'Log
MESF' (i.e. column 'E') data for the Y-axis.

We now will change the X-axis parameter to the 'LogMedian' (i.e. column 'D')
data of the spreadsheet on the X-axis.

10. Place the cursor over the X-axis 'B' label.

11. Press and hold the left mouse button and the list of columns from the
Spreadsheet appears.

12. Release the button when the cursor is over 'D'.

The Scatter with Regression plot now updates to reflect the selection of the
'LogMedian' (i.e. column 'D') data for the X-axis and appears as in Figure T18.6.
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Figure T18.6  Scatter with Regression
Plot with Log Median and Log MESF

Values from the Spreadsheet.

We will format the Scatter with Regression plot to better visualize the five data
points.

13. Double-click the Scatter with Regression Plot. The Formatting dialog will
appear, docked to the right side of layout.

14. Choose the Axes category in the Formatting dialog (Figure T18.7).

15. Change the Y Axis Range Minimum to 3 and Maximum to 7 (Figure
T18.7, red outline). 
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Figure T18.7  Formatting Y-Axis Range

16. Click on X Axis under Select Axis (Figure T18.8, red arrow).

17. Change the X Axis Range Minimum to 1 and Maximum to 4 (Figure
T18.8, red outline).
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Figure T18.8  Formatting X-Axis Range

18. Click on the Overlays category (Figure T18.9, ).

19. Click on the second overlay ("2-Linear") from the 2D Unbinned

Overlays list (Figure T18.9, ).

20. Choose Connecting Lines from the Line Options for drop-down menu

(Figure T18.9, ).

21. Set the line with to 1.5 (Figure T18.9, ).
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Figure T18.9  Formatting Line Options for Linear
Overlay
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The Scatter with Regression plot will resemble Figure T18.10. It has been
formatted to bring all of the data points into range and to increase the width of
the red regression curve.

Figure T18.10  Scatterwith Regression
Plot Formatted

Next, we will insert and view a linear regression token  for the data set.

22.18.2 Working with Regression Tokens and Fit Equations

To learn working with regression we will pick up from where we left off in the
previous section of this tutorial.

If you did not complete the previous section , you may begun this section by
opening the FITC MESF Beads - Part2.fey layout stored in the Calculating
MESF From Regression folder  of the Tutorial Sample Data archive .

As a first step, we will display a regression token on the Scatter with Regression
Plot.

1. Right-click the Scatter with Regression plot and select Add text box from

the pop up menu (Figure T18.11, ).

2. Right-click inside the text box on the plot and select Insert Token from

the pop up menu (Figure T18.11, ).

3. Double-click Statistic in the Insert a Token dialog (Figure T18.11, ).
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Figure T18.11  Adding a Text Box to a Plot and Inserting a Token

4. Click the Statistic category in the Create Statistic dialog (Figure T18.12,

).

5. Select Regression Parameter Statistics from the Select a Statistic

drop-down list (Figure T18.12, ).

6. Select m (slope) from the Statistic list (Figure T18.12, ).

7. Click OK (Figure T18.12, ).  The slope, m, of the regression curve now
is displayed on the plot.  
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Figure T18.12  Adding Slope of Linear Regression

8. Click inside the text box to put it into edit mode.  The border will be green.

9.  Use the arrow keys on the keyboard, or click within the text box to move
the cursor to the left of the token.

10. Type "m = " (Figure T18.13).  The token has now been annotated with
this descriptive freetext within the text box.  Note: if necessary, the text
box can be enlarged by dragging its border's anchors, so all the text fits on
one line and repositioned by dragging its border to better resemble the
figure.
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Figure T18.13  Scatter with
Regression Plot Displaying Slope of

Linear Regression, m

We now will create a Custom Token for the linear regression equation, so we can
apply it to other .fcs files, including those in other layouts.  Each token in the
Regression Parameter Statistics list (Figure T18.12 above) will be used as a
component of this Custom Token.

11. Open the Custom Token window by clicking on View tab
group command.

12. Click the blue plus ( ) in the Custom Tokens window (Figure 18.14, 
).

13. Highlight the "New Custom Token" text in the Custom Tokens window

(Figure T18.14, ).

14. Type "LinFitLogMedMESF" (Figure T18.14, ).

15. Type "m=,b=,r2=" in the formula (lower) pane of the Custom Tokens

window (Figure T18.14, ).

16. Click the Scatter with Regression plot, so its border becomes highlighted.

17. Drag and drop the border of the Scatter with Regression plot to the
position after the "m=" and before the "," (comma) in the formula pane of

the Custom Tokens window (Figure T18.14, ).
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Figure T18.14  Creating Custom Token for Linear Regression Fit Parameters

18. Double-click Statistic token from the Paste Special dialog (Figure
T18.15, left).

Figure 18.15  Inserting a Regression Parameter Token as a Component of the
Linear Regression Fit Custom Token

19. Choose Regression Parameter Statistics from the Select a Statistic

drop down menu (Figure T18.15, ).

20. Choose m from the Statistic list (Figure T18.15, ).

21. Click OK (Figure T18.15, ).  

22. Repeat Steps 17-21, with the following modifications:
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· Step 17:  Drop the plot after the "b=" in the formula pane of the

Custom Tokens window

· Step 20:  Choose b from the Statistic list

23. Repeat Steps 17-21, with the following modifications:

· Step 17:  Drop the plot after the "r2=" in the formula pane of the

Custom Tokens window

· Step 20:  Choose r2 from the Statistic list

24. Drag the LinFitLogMedMESF Custom Token from the Custom Token
window onto a blank area of the layout. A new text box containing the
linear regression fit token will be automatically created. 

Note:  an r2 value of exactly 1 denotes a perfect fit, which is rarely attained with
experimental data.  The Custom Token initially displays a value of 1.00 for r2

because its value here is greater than 0.995, and statistics in FCS Express
are rounded to two decimal places by default.  

We will now edit the r2 component of the Custom Token to display five digits
after the decimal point.

25.  Double-click the component r2 token in formula pane of the Custom
Tokens window.

26.  Click the Number Format category in the Edit Statistic dialog (Figure
T18.16).

27.Increase the Number of decimals to 5 (Figure T18.16).

28.Click OK.
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Figure T18.16  Increasing the Number of Decimal Places for R-Squared
Component of Linear Regression Fit

The linear fit token will be displayed as in Figure T18.17.  

Figure T18.17  LinFitLogMedMESF Custom Token
Displayed in a Text Box after Editing Number of

Decimals for R-Squared Component

Once a linear regression is calculated it can be used as model for fitting unknown
samples. This can be done directly within the same layout in which the regression
has been calculated (see the Apply Regression to an FCS File  section of this
tutorial) or in any new layout. To use the regression in a new layout see the
Save a Regression  topic of this tutorial.

22.18.3 Apply Regression to an FCS File

We will use the linear regression formula calculated in the previous section  to
calculate MESF data for four unknown samples (i.e. four FCS files). The goal of
this analysis is to assess the amount of IgG present in the patient's serum that is
binding to the B- and T-cells of the potential donor.

2164
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The layout we will be using contains five pages. The first page displays the linear
regression calculated in the previous section using beads. Page 2 and 3 define
the negative and positive controls along with the patient sample. The MESF
Calculations page is where we will be working to complete the linear regression
and MESF data. The Bar Plots page will be used to easily visualize the data once
it is complete.

1. Open the HLA CrossMatch.fey layout from the Calculating MESF From
Regression subfolder in the Tutorial Sample Data archive .

2. Click on the MESF Calculations page tab of the layout.

This page contains two spreadsheets (Table 1 and Table 2), one for calculating
MESF for B cells and one for calculating MESF for T cells. Each spreadsheet
contain the "m" and "b" regression parameters calculated on Page 1 (Figure
T18.18). This way, both parameter will be available in each spreadsheet using
cell reference. Moreover, since they have been inserted as statistic tokens, they
will automatically update if the linear regression change. 

Note: as we will see in the Save a Regression  section of this tutorial, linear
regression parameters can be added to the data files as a keyword. This allows
to use the regression parameter even in a brand new layout.

Figure T18.18   Inserting Linear Regression Fit
Parameters - b and m - into Spreadsheet

Spreadsheets on MESF Calculations page also contain the Name, the Median
fluorescence intensity and the log10-transformed Median fluorescence intensity
of each of the four sample.

To calculate the MESF for the said unknown samples using the linear regression
model previously calculated we will need to:

· Use the log10-transformed Median intensity (i.e. the X variable of the linear

regression) to calculate the log10MESF value (i.e. the Y variable of the linear
regression) following the linear regression formula Y=mX+b;

· Elevate the log10MESF value to the tenth in order to calculate the actual MESF

value.

3. Select the G2 cell of Table 1 (i.e. the first available cell of the B Cell Log
MESF column).

1682
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4. Type "=$B$2*F2+$B$3" (without quotes), where $B$2 is an absolute
cell reference for the "m" parameter, F2 is a relative cell reference for the
"X" parameter and $B$3 is an absolute reference for the "b" parameter.

Note: A cell reference can also be inserted in the formula by mouse selection for
the cell of interest. Please see the referencing cells in a spreadsheet section of
the manual.

5. Press Return on your keyboard. The formula is calculated in real time and
the spreadsheet resembles Figure T18.19.

Figure T18.19  Calculating MESF Value for PBS Negative Control

Note: if you double click on cell G2, cell references will highlight as displayed in
Figure T18.20.

Figure T18.20  Formula Used to Calculate MESF Value for PBS Negative 

6. Select the H2 cell of Table 1 (i.e. the first available cell of the B Cell MESF
column).

7. Type "=10^G2" (without quotes), where G2 is the relative reference to
the B Cell Log MESF of the PBS NEGATIVE CONTROL SAMPLE.

8. Press Return on your keyboard. The formula is calculated in real time.

We will now fill the remaining cells of column G and H by copy-pasting the
content of cells G2 and H2.

9. Multiple-select both cells G2 and H2.

10.Press Ctrl+C on your keyboard or, alternatively, right click and select
Copy from the right-click menu.

11.Multiple select cells from G3 to H5 as shown in Figure T18.21.

426
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Figure T18.21  Selecting Cells G3 - H5

12. Press Ctrl+V on your keyboard or, alternatively, right click and select
Paste from the right-click menu. The cell are filled with the corresponding
value and the spreadsheet looks like the one displayed in Figure T18.22.

Figure T18.22  B Cell Table Complete

 We will now fill the T Cell Log MESF and the T Cell MESF columns of Table 2 by
copy/pasting the content of the content of the B Cell Log MESF and the B Cell
MESF columns respectively from Table 1.

13. Multiple-select cells from G2 to H5 as shown in Table 1 (i.e. the B cell
Table).

14. Select the G2 cell in Table 2 (i.e. the T Cell table).

15. Press Ctrl+V on your keyboard or, alternatively, right click and select
Paste from the right-click menu.

Table 2 is now completed and looks like Figure T18.23.

Figure T18.23  T Cell Table Complete

To see the results of the table expressed in a bar plot (Figure T18.24), please
click on the Bar Plots page tab (for instructions on creating bar plots, please visit
the Bar and Scatter Plots tutorial ). You will see that the B-Cell MESF values for
the Patient Serum are slightly elevated over negative controls yet well below the
positive control. The T-Cell MESF values for the Patient Serum fall within the
negative control range and are also well below the positive control value.

2172
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Figure T18.24  Bar Plots Displaying the FITC MESF HLA Cross Match Data from B-
and T-cells

Next, we will save a previously created regression for use in another layout .

22.18.4 Save a Regression

Once a formula for a linear regression has been defined, we can display it in our
layout, use it to overlay a line fit on the scatter plot, and even save the formula
as a keyword for use in future experiments and analysis. Since it is typical to
have one layout for calibration and another for analysis, it is useful to save a
regression for use in any layout. In this section, you will learn how to save a
regression formula as a keyword for use in any layout.

1. Load the FITC MESF Beads Completed.fey layout located in the
Regression Analysis folder within the Tutorial Sample Data archive . 

2. Drag the LinFitLogMedMESF custom token from the Custom Tokens
window onto a blank area of the layout.

A new text box will be automatically created and the linear fit token will be
inserted in it. The linear fit token will be displayed as in Figure T18.25.

Figure T18.25  LinFitLogMedMESF Custom Token Formula
Output Displayed in a Text Box

2168
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3. Right-click on the text box.

4. Choose Copy from the pop up menu.

5. Open a text editor application such as Notepad for Microsoft Windows.

6. Paste the text box in the text editing software.

7. Enter a '$' symbol followed by the name you would like the keyword
displayed as before the formula followed by an equals sign (Figure
T18.26). In this case, use: '$FITCMESFCalib='

Figure T18.26  Creating an Extra Keyword for the Regression Formula in Notepad

8. Save the text document as FITCMESFCalib.AllExtraKeywords.txt (Figure
T18.27) in a location that will be easy to access,, such as your Desktop.

Figure T18.27  Saving the Keyword Text Document

FCS Express has the capability to load keywords from external files as part of
loading a data file . These keywords are treated within FCS Express as if they
were originally part of the data file itself. This is a convenient way to introduce
externally derived data into your analysis template. We will make the regression
keyword available for use in another layout in the following steps.

9. Copy the FITCMESFCalib.AllExtraKeywords.txt file you just created and
paste it into the Regression Analysis folder within the FCS Express
Sample Data directory (Figure T18.28).

1426
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Figure T18.28  Paste the
FITCMESFCalib.AllExtraKeywords.txt File
into the Linear Regression Analysis Folder

10. Load the HLA CrossMatch Keyword Regression.fey layout located in
the Regression Analysis folder within the FCS Express Sample Data
Directory. 

This layout contains sample files and a page for MESF Calculations. We will now
use the regression formula saved as a keyword to complete the table.

11. Click the Tcell LogMESF Patient Custom Token to select it.

12. Right-click in Enter the Custom Token formula below area of the
Custom Tokens window.

13. Choose 
[modelParameters]) from the pop-up menu.

14. Highlight the text 'x' in the formula brackets.

15. Right-click on the highlighted text.

16. Chose Insert Token from the pop up menu.

17. Double-click the Tcell LogPatient token from the Custom category.

18. Highlight the text [modelParameters] in the formula (Note: the
brackets must be selected in this instance).
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19. Right-click on the highlighted text.

20. Choose Insert Token from the pop up menu.

21. Double-click on Keyword. 

The Create Keyword dialog opens.

22. Choose the Keyword category in the Create Keyword dialog (Figure

T18.29, ).

23. Click on the ellipsis (Figure T18.29, ).

24. Scroll to and click on the $FITCMESFCALIB keyword (Figure T18.29, 
).

26. Click OK in the Please select a keyword dialog (Figure T18.29, ).

27. Click OK in the Create keyword dialog (Figure T18.29, ).

Figure T18.29  Choosing the $FITCMESFCALIB Keyword Token

28. Enter an "=" sign before the formula.

The formula will now look like Figure T18.30.
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Figure T18.30  Completed Custom Token Formula for Tcell
LogMESF Patient

Tables or spreadsheets for your analysis may now be populated using the
custom tokens you have defined. The formulas use the regression stored as a
keyword in the data.

In summary, when trying to create any kind of calibration regression to apply to
your sample data, the best practice is to have a layout that is used for creating
the regression. This will contain all of your controls. You then save the final
regression as an "allextrakeywords.txt" file. Create another analysis layout that
is used to analyze the actual data and apply the regression you created. The
analysis layout will get the regression from the keyword that you defined in the
"allextrakeywords.txt" file. By placing the "allextrakeywords.txt" file into the
folder with the appropriate data files, you ensure that all the data files actually
contain the regression that you wish to use.

22.19 Working with Bar, Pie, and Scatter Charts -
Spreadsheets Use Case 4

In FCS Express, data can be displayed in Bar, Pie, or Scatter Charts that update
in real-time as you advance through your dataset or adjust your gates.  This
eliminates intermediate steps in your workflow such as creating tables, exporting
and reassembling data in a spreadsheet, and manually generating new graphs to
evaluate additional data or a change in your gating positions or hierarchy.  Bar,
Pie, and Scatter Charts can be formatted and exported to PowerPoint and PDF
as with any other plot type in FCS Express, so you can summarize your results
and generate publication-quality graphics in record time.

In the course of this tutorial, you will learn how to: 

· Plot your data in a Bar, Pie, or Scatter Chart

· Create tokens for use in Bar, Pie, or Scatter Charts

· Manually enter values for Bar, Pie, or Scatter Charts

· Use tokens for creating error bars on your plots

· Create conditional formulas to emphasize interesting data sets

· Display additional datasets (as Overlays on Bar and Scatter Charts or a Ring

on Pie Charts)
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· Format the appearance of Bar, Pie, and Scatter Charts

Please see the table below for an overview of the options for working with each
plot type.

Add Data by Formatting Feature

Drag
and
Drop

Spreads
heet

Error
Bars

Data Emphasis
(according to
user-defined

criteria)

Display
Additional
Datasets

Bar Charts ü ü ü

ü

(Highlight)
ü

(as Overlay)

Pie Charts ü ü

ü

(Explode)
ü

(as Ring)

Scatter Charts ü ü ü

ü

(Highlight)
ü

(as Overlay)

In the first exercise, we will create bar and scatter charts .

22.19.1 Creating Bar and Scatter Plots and Pie Charts

Bar, Pie, and Scatter Charts graph data from spreadsheets.  The cells of the
spreadsheet can contain statistical tokens based on your plotted data, or free
text. You may want to familiarize yourself with spreadsheets prior to beginning
this tutorial by visiting the spreadsheet tutorial .

Note the charts can be populated by drag-and-drop directly, but the spreadsheet
must be accessed to add formatting elements, such as Error Bars and Data
Emphasis features (i.e., Highlighting and Exploding).  

In this section of the tutorial, we will learn to:

· Insert a spreadsheet onto the layout and populate it with free text and

statistical tokens.

· Create a Bar Chart .

· Create a Pie Chart .

· Create a Scatter Chart  (also see the Regression Analysis tutorial  for

more details on creating live updating regression analysis).
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22.19.1.
1

Creating Bar Charts

In this section we will learn to populate a Bar Chart with data from a
spreadsheet. Please also see our Bar Charts web page for additional videos
and tips.

1. Select File Open.

2. Open the layout titled "Bar Pie Scatter begin.fey" within the Tutorial
Sample Data archive. 

The layout contains Color Dot Plots and a spreadsheet from which the Bar
Chart will be derived (Figure T19.1).  See this section of the manual to see
how the Spreadsheet was added to the layout .  

Figure T19.1   Spreadsheet on the Layout

We will fill the spreadsheet with both free text and live-updating tokens.  First, we
will manually enter free text values that will be used for our bar chart axis labels.

3. Click cell A1.

4. Type "live" (Figure T19.2).

5. Press Enter on the keyboard.

418
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6. Repeat steps 3-5 for cells A2 and A3 in the Spreadsheet, typing in "apo"
and "necro", respectively.  The spreadsheet will now appear as below
(Figure T19.2).

Figure T19.2   Entering Freetext into a Spreadsheet

We now will select statistic tokens to plot in the Bar Plot or Pie Chart and place
them in the Spreadsheet. Using tokens will allow live-updating of plots as you
adjust your gates or advance through your dataset.

7.  Drag and drop the blue "live" gate from the 6 hr treatment plot at upper
left into cell B1 of the spreadsheet.  While dragging, the gate outline will

move (Figure T19.3, ).

Figure T19.3  Dragging and Dropping Statistic into B1
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8.  Select % of gated cells from the Statistic list box in the Edit Statistic
dialog (Figure T19.3).

9.  Click OK.  

The B1 cell of the Spreadsheet will now contain the %-gated statistic for the
"live" gate.

10. Repeat steps 7 though 9 for the green "apo" and purple "necro" gates of
the 6 hr treatment plot with cells B2 and B3, respectively.  

The spreadsheet will resemble Figure T19.4.

Figure T19.4  Columns A with Axis Labels and B with % of
Gated Statistic Tokens

Note: Steps 1-10 can also be accomplished via drag-and-drop of statistics,
gates, or plots directly to the Bar Chart , without using a spreadsheet. 
Please see this section of the manual for a pictorial guide .

11. Select the Insert tab group command (Figure T19.5, red
outline).

Figure T19.5  Inserting a Bar Chart

12. Click on blank, white space of the layout to insert a Bar Chart (Figure
T19.6).

577
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Figure T19.6   Bar Chart Inserted

We now will rename the Bar Chart axes.

13. Double-click the Bar Chart.  The Formatting dialog will appear, docked to
the right.

14. Choose the Axes category (Figure T19.7).

15. Click the The specified text under Title radio button (Figure T19.7, ).

16. Type "%-gated" into the Text box under Title (Figure T19.7, ).
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Figure T19.7  Formatting Y Axis Title

17. Click X Axis under Select Axis (Figure T19.8, ).

18. Type "subset" into The specified text box under Title (Figure T19.8, ).
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Figure T19.8  Formatting X Axis Title

The Bar Chart will resemble Figure T19.9.
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Figure T19.9  Bar Chart with Updated
Axis Titles

Note:  Bar color, style, and other attributes of a Bar Plot can be customized. 
See the Formatting Bar Plots  section of the manual for details.

19. Optional:  

· Click the Data tab group  Next/Previous

commands to advance through the set of files in the Data List and watch
as the Bar Chart updates with the new data.

· Adjust the gates on the plots and watch the Bar Chart update in real-time.

Go on to the next section to create a Pie Chart  from the same raw data, or
skip to the section on Formatting Bar Charts .

22.19.1.
2

Creating Pie Charts

Creating Pie Charts in FCS Express is much like creating Bar Charts - they can be
populated via a spreadsheet or by drag-and-drop.  

1. Select File Open.

2. Open the layout titled "Pie begin.fey" within the Tutorial Sample Data
archive. 

This layout contains Color Dot Plots and a spreadsheet with free text and a
statistic token in cells A1 and B1, respectively.  
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3. Click the Insert tab group command (Figure T19.10, red
outline).

Figure T19.10  Inserting a Pie Chart

4. Click on the blank, white space of the layout  to insert a Pie Chart (Figure
T.19.11).

Figure T19.11  Inserted Pie Chart

We will use the drag-and-drop functionality of FCS Express to add new sectors
(slices) and replace old ones to the Pie Chart.

5. Type "apo" and "necro" into cells A2 and A3, respectively.

6. Drag and drop the green "apo" gate from the 6 hr treatment plot at left to an
empty spot on the Pie Chart (not on the pie itself) (Figure T19.12).
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Figure T19.12  Dragging and Dropping Gate to Pie Chart to Add New Slice

7. Select "% of gated cells" from the Statistic box in the Edit Statistic dialog
(Figure T19.13, red outline).



Tutorials 2183

© 2023 De Novo Software

Figure T19.13  Choosing to Plot after Drag and Drop

8. Click OK.  A new sector (slice) displaying this statistic now appears as in
Figure T19.14.
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Figure T19.14  Updated Pie Chart

9. Repeat steps 6 through 8 for the purple "necro" gate of the 6 hr treatment
plot at left, so that the Pie Chart will have a total of three sectors (slices).

We now will format the Pie Chart.

10. Double-click the Pie Chart.  The Formatting dialog will appear, docked to the
right.

11. Choose the Legend category (Figure T19.15).

12. Check the Visible box (Fig. 19.15, red outline).
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Figure T19.15  Adding Legend to Pie Chart

13. Choose the Overlays category (Figure T19.16).

The Name Parameter is derived by default from the first column of the Custom
Data Grid on your layout.  It appears as "subset" or as "A", depending on the
appearance of your Custom Data Grid.  The Value parameter is derived by
default from the second column of the Custom Data Grid.  It appears as "%-
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gated" or as "B", depending on the appearance of your Custom Data Grid. It is
displayed by default as a Caption for each slice of the Pie Chart (Fig 18, upper
right).  The Caption can be formatted to display any combination of Name,
Value, or Percentage for each sector (slice) of the Pie.

14. Check any combination of boxes next to Value, Percentage, and Name
from the Caption Style section of the Overlays category to customize with
the desired information (Figure T19.16, red outline).

Figure T19.16  Editing the Caption Style of the Pie Chart
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Note:  Pie shadow, donut vs. pie appearance, color scheme, and other attributes
can also be customized.  See the Formatting Pie Charts  section of the manual
for details.

15. Optional:  

· Click the Data tab group  Next/Previous

commands to advance through the set of files in the Data List and watch
as the Pie Chart updates with the new data.

· Adjust the gates on the plots and watch the Pie Chart update in real-time.

Optional:  Go to the Formatting section of this tutorial  to learn how to
Explode slices for emphasis and display an additional dataset as a Ring at the
periphery of the Pie. 

16.Select Modern from the Color Schemes drop down list (Figure T19.17, red
outline).  

Note: there are many predefined color schemes that may be chosen for display.

572
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Figure T19.17  Changing the Color Scheme
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The Pie Chart colors have now been reformatted with the Modern color scheme
(Figure T19.18).

Figure T19.18  Updated Color Scheme of
Pie Chart

Go on to the next section to create a Scatter Chart  from the same Color Dot
Plots on this layout.  Or, jump to the Formatting section of this tutorial  to
learn how to Explode Pie slices for emphasis and display an additional dataset
as a Ring at the periphery of the Pie. 

22.19.1.
3

Creating Scatter Charts

Creating Scatter Charts in FCS Express is similar to creating Bar Charts - they
can be populated via a spreadsheet or by drag-and-drop.  

1.  Click File Open.

2.  Open the layout titled "Bar Pie Scatter begin.fey" within the Tutorial
Sample Data archive. 

The layout contains color dot plots and a spreadsheet from which the Scatter
Chart will be derived (Figure T19.19).  See more about how the spreadsheet
was added to the layout . We will fill the spreadsheet with both free text and
live-updating tokens.  First, we will enter the independent parameters for the
Scatter Plot.  Note, in contrast to Bar and Pie Charts, the x-axis values in a
Scatter Chart must be numeric.  We will enter the hours of treatment indicated in
the title for each Color Dot Plot as this parameter.

3.  Enter "0" in cell A1 of the spreadsheet (Figure 19.19)
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4.  Press Enter on the keyboard.

5.  Repeat steps 3 and 4 for cells A2 and A3 in the spreadsheet, typing in "6"
and "12", respectively.  

The spreadsheet should match the one in Figure T19.19

Figure T19.19  Adding Freetext to Spreadsheet

We will insert tokens into the spreadsheet to display on the Scatter Chart.

6.  Drag the blue "live" gate from the 6 hr treatment plot into cell B2 of the
spreadsheet.  While dragging the gate, its outline will move (Figure T19.20,

).

7.  Select % of gated cells from the Statistic list box in the Edit Statistic

dialog (Figure T19.20, ).

8.  Click OK. Cell B2 will contain the %-gated statistic for the "live" gate of
the 6 hr treatment Color Dot Plot.
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Figure T19.20  Dragging and Dropping a Statistic Token into a Spreadsheet

9.  Repeat steps 6 through 8 for the Control (no treatment) and 12 hr
treatment color dot plots, dragging the blue "live" gate from each plot into
cells B1 and B3, respectively.  

The Spreadsheet will resemble Figure T19.21.

Figure T19.21  Spreadsheet Complete

10. Select the Insert tab group command (Figure T19.22,
red outline).

Figure T19.22  Inserting a Scatter Chart

11. Click on blank, white space of the layout to insert a Scatter Chart (Figure
T19.23).
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Figure T19.23  Inserted Scatter Chart

We now will rename the Scatter Chart axes.

12. Double-click the Scatter Chart.  The Formatting dialog will appear,
docked to the right.

13. Choose the Axes category (Figure T19.24).

14. Click the The specified text radio button under Title (Figure T19.24, red
outline).

15. Type "%-gated" into the edit field (Figure T19.24, red outline).
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Figure T19.24  Renaming Y-Axis of Scatter Chart

16. Click X Axis under Select Axis in Formatting dialog (Figure T19.25, red
arrow).

17. Type "treatment time (hr)" into the The selected text edit field under
Title (Figure T19.25, red outline).
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Figure T19.25  Renaming X-Axis of Scatter Chart

The Scatter Chart will resemble Figure T19.26.
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Figure T19.26  Scatter Chart with Axes
Renamed

We now will adjust the range of the Scatter Plot so that the points are more
readily visible.

18. Click Y Axis under Select Axis if necessary in Formatting dialog (Figure
T19.27, red arrow).

19. Enter "100" in the Maximum field under Range (Figure T19.27, red
outline).
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Figure T19.27  Adjusting Range Maximum for Y Axis of Scatter Chart

20. Click X Axis under Select Axis (Figure T19.28, ).

21. Enter "-4" as the Minimum (Figure T19.28, ).

22. Enter "16" as the Minimum (Figure T19.28, ).

23. Increase the # Ticks to 5 (Figure T19.28, ).
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Figure T19.28  Adjusting Range Settings for X Axis of Scatter Chart

The Scatter Chart should resemble Figure T19.29.



FCS Express 7 Manual2198

© 2023 De Novo Software

Figure T19.29  Scatter Plot Complete

Note:  Point color, shape, connecting lines, and other attributes of a Scatter Plot
can be customized.  See the Formatting Scatter Plots  section of the
manual for details.

24.Optional:  

· Click the Data tab group  Next/Previous

commands to advance through the set of files in the Data List and watch
as the Scatter Plot updates with the new data.

· Adjust the gates on the Color Dot Plots and watch the Scatter Plot update

in real-time.

22.19.2 Formatting Bar and Scatter Plots and Pie Charts

As with any other plot in FCS Express, the axes, titles, legends, backgrounds,
and more are fully formattable  for Bar, Pie, and Scatter Charts.  In this tutorial
section, we will focus on learning how to apply the special formatting features
listed below.  Please click on the links below or in the table to jump to a tutorial
topic.

· Adding Error Bars to Bar and Scatter Charts

· Formatting Highlighting and Explode data emphasis features

· Adding an additional dataset to a Spreadsheet

· Creating Overlays on Bar and Scatter Charts

· Creating a Ring on a Pie Chart  

594
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Add Data by Formatting Feature

Drag
and
Drop

Spreadshe
et

Error
Bars

Data
Emphasis
 (according to
user-defined

criteria)

Display
Additional

Datasets

Bar Charts ü ü ü

ü

(Highlight )

ü

(as
Overlay )

Pie Charts ü ü

ü

(Explode )
ü

(as Ring )

Scatter
Charts

ü ü ü

ü

(Highlight )

ü

(as
Overlay )

22.19.2.
1

Adding Error Bars

Error Bars and Highlighting can be added to Bar and Scatter Charts.  In this
example, we will add these features to a Bar Chart.

1.  Select File Open.

2.  Open the "Error Bars.fey" layout within the Tutorial Sample Data archive. 

A spreadsheet and its associated Bar Chart without Error Bars or Highlighting
already exist on the layout.  The Bar Chart will graph the means of the "apo"
and "necro" %-gated statistic for each of the three Color Dot Plots.  This is
accomplished through the use of an array formula  within the spreadsheet,
which can be seen when double-clicking cell E1 (Figure T19.30).  

2199

2205

2211

2205

2212

2205 2216

2205

2212

1357

https://s3.amazonaws.com/fcsexpressdownloads/TutorialSampleDataV7.zip
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Figure T19.30  Using Array Formula to Calculate Mean of Spreadsheet Cells B1-D1

We also will employ an array formula  to calculate standard deviation for the
error bars in this example; however, error bars also may be derived from
standard statistic tokens or from free text.

3.  Click cell F1 to select it (Figure T19.31, ).

4.  Click the Formulas tab, which is revealed in the formerly-hidden

Spreadsheet tab group (Figure T19.31, ).

5.  Click the Statistical command (Figure T19.31, ).

6.  Scroll down through the menu of statistical formulas by hovering cursor
over down arrow at bottom of the list until "STDEVA" is visible (Figure

T19.31, ).

7.  Select "STDEVA" from the menu (Figure T19.31, ).

1357



Tutorials 2201

© 2023 De Novo Software

Figure T19.31  Inserting Function into Spreadsheet Cell

We now will enter cells B1-D1 as components of the StdDev array formula.

8.  Click cell B1 (Figure T19.32, ), while the cursor is within the parentheses
of the "STDEVA" formula, as shown by the green arrow.

9.  Enter a comma (Figure T19.32, ).
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10. Repeat steps 8 and 9 for cells C1 and D1 without entering a comma after
adding D1.  When complete, the filled-in formula will appear as the bottom
spreadsheet in Figure T19.32.

Figure T19.32  Entering Components for Standard Deviation Array Formula

The "apo" row now contains a complete StdDev array formula for the error bar,
which has been evaluated and is showing the result in cell F1 (Figure T19.33).

Figure T19.33  Array Formula's Numerical Result in F1 of Spreadsheet

We will enter the corresponding mean and error bar formulas for the "necro" row
by dragging the appropriate cells E1 and F1 into E2 and F2, respectively.

11. Multiple-select cells E1 and F1, the first of which contains the complete
AVERAGE array formula that was created for you in the layout previously.

12. Hover the mouse pointer over the lower-right corner of cell F1 in the

Spreadsheet until the cursor forms a cross hair (Figure T19.34, ).

13. Drag the mouse to the lower-right corner of cell F2 while keeping the

mouse button pressed (Figure T19.34, ).

14. Release the mouse button (Figure T19.34, ).  A numerical value
appears in cells E2 and F2 as a result of filling the series.
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15. Double-click cell E2 or F2 to view the formula and its components (Figure

T19.34, ).  

Note the cell references in the array formula were updated correctly - the
"necro" %-gated values from Row 2 are used.

Figure T19.34  Copying Array Formulae into Row 2 of Spreadsheet

We will format the Bar Chart to display the error bars from the appropriate
column in the Spreadsheet.

16. Double-click the Bar Chart. The Formatting dialog will appear, docked to
the right.

17. Select the Overlays category in the Formatting dialog (Figure T19.35).

18. Choose "F" from the Error Bar Param drop-down list, which refers to
the column F of the Spreadsheet, under 2D Bar Overlay Options (Figure

T19.35, ).

19. Select red from the Color drop-down list for the Error Bar Properties

section (Figure T19.35, ).
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Figure T19.35  Adding Error Bars to Bar Chart
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The Bar Chart will resemble Figure T19.36.

Figure T19.36  Bart Chart with Error Bars

 Optional:  

· Click the Data tab group  Next/Previous

commands to advance through the set of files in the Data List and watch
as the Bar Chart updates with new data.

· Adjust the gates on the plots and watch the Bar Chart update in real-time.

In the next section, we will add highlighting and exploding parameters to Bar,
Scatter, and Pie Charts .

22.19.2.
2

Adding Highlighting or Exploding

In this section, we will add a Highlight parameter to a Bar Chart and an Explode
parameter to a Pie Chart.  The Highlight/Explode parameter must be a formula in
the Spreadsheet evaluating to "TRUE" or "FALSE." When "TRUE," the bar will
be highlighted in a selected color or the pie sector (slice) will explode away from
the Pie for emphasis.  The layout used in this section contains a spreadsheet and
an associated Bar and Pie Charts to which we will add a Highlight or Explode rule,
respectively. 

Note:  Highlighting may be added to Scatter Charts in the same method outlined
below for the Bart Chart although it is not demonstrated in these tutorials.

2205
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1. Select File Open.

2. Open the layout titled "Highlighting and Exploding.fey" within the Tutorial
Sample Data archive.  The Bar Plot and Pie Chart are graphing the mean of
the three subsets ("live", "apo", and "necro") for the three replicates in the
Dot Plots.

3. Click cell D3 of the Spreadsheet (Figure T19.37, ).

4. Click the Formulas tab, which is now revealed in formerly hidden

Spreadsheet tab group (Figure T19.37, ).

5. Click the Logical command (Figure T19.37, ).

6. Select "IF" from the menu (Figure T19.37, ).  The Spreadsheet will now
appear as below (Figure T19.37, bottom below blue arrow).

https://s3.amazonaws.com/fcsexpressdownloads/TutorialSampleDataV7.zip
https://s3.amazonaws.com/fcsexpressdownloads/TutorialSampleDataV7.zip
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Figure T19.37  Inserting "IF" Logical Formula into Cell D3 of Spreadsheet. 

We now will enter cell B3 as a component of the highlighting formula.

7. Click cell B3 (Figure T19.38, ) while the cursor is within the parentheses
of the "IF" formula, as shown by the green arrow in top spreadsheet.

8. Type ">5.5" (Figure T19.38, ) as indicated in bottom spreadsheet.
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Figure T19.38  Completing "IF" Logical Formula for Cell D3

9.  Key Enter, or click on the layout outside of the spreadsheet. The result of
the Logical formula will appear as "TRUE" (Figure T19.39).
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Figure T19.39  Result for "IF" Logical Formula in Cell D3 

If desired, an analogous procedure to steps 3 through 9 could be followed to
create a Highlight or Explode rule for the "live" and "apo" rows of the
spreadsheet.

We now will format the Bar and Pie Charts to derive the Highlight or Explode rule
from the appropriate column of the Spreadsheet.

10. Double-click the Bar or Pie Chart. The Formatting dialog will appear,
docked to the right.

11. Choose the Overlays category in the Formatting dialog (Figure
T19.40).

12. Choose "D" from the Highlight Param (Figure T19.40, left, red outline)
or Explode Parameter (Figure T19.40, right, red outline) drop-down list in
the Formatting dialog for the Bar or Pie Chart, respectively.

Figure T19.40  Adding Highlight Parameter for Bar Chart (left) and Explode
Parameter for Pie Chart (right)
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The Bar or Pie Chart should resemble Figure T19.41, left and right, respectively.

Figure T19.41  Bar Chart after Adding Highlight Parameter (left) and Pie Chart after
Adding Explode Parameter (Right) for "Necro" Population

 

Note the following changes:

· in the Bar Chart, the "necro" bar is highlighted.  The Highlight Color and

other visual formatting elements of the Bar Chart may be customized
from the Overlays category of the Formatting dialog. See this section of
the manual  for details.

· the Pie Chart, the yellow "necro" sector (slice) has exploded away from

the rest of the Pie for emphasis.  Sector (slice) Color and other visual
formatting elements of the Pie Chart may be customized from the
Overlays category of the Formatting dialog. See this section of the
manual  for details. 

13. Optional:  

· Click the Data tab group  Next/Previous

commands to advance through the set of files in the Data List and watch
as the Bar and Pie Charts update with new data.

· Adjust the gates on the plots and watch the Bar and Pie Charts update in

real-time.

Go on to the next section to learn how to display additional data sets  as
Overlays on Bar and Scatter Plots or as a Ring on a Pie Chart.

587
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22.19.2.
3

Displaying Additional Datasets

Additional datasets and parameters can be displayed on Bar, Pie, and Scatter
Charts.  Bar and Scatter Charts can display multiple additional datasets as
Overlays while Pie Charts can display a single additional dataset as a Ring.

In this section of the tutorial, we will enter an additional dataset into a
spreadsheet, which can be displayed on the Bar, Pie, and Scatter Charts.

1.  Select File Open.

2.  Open the "displaying additional datasets.fey" layout within the Tutorial
Sample Data archive. 

The layout a contains a Spreadsheet and its associated Bar, Pie, and Scatter
Charts.  The %-gated statistic for the green "apo" gate is being plotted.  

We now will add a %-gated statistic for the purple "necro" gate to the
Spreadsheet.

3.  Drag and drop the purple "necro" gate from the 6 hr treatment Color Dot
Plot to cell C1 of the spreadsheet.  While holding down mouse button and

dragging the gate, its outline will move (Figure T19.42, ).

4.  Select % of gated cells from the Statistic list box in the Edit Statistic

dialog (Figure T19.42, ).

Figure T19.42  Entering the %-gated Statistic for the Additional Dataset

5.  Click OK. Cell C1 will contain the %-gated statistic for the "necro" gate.

6.  Repeat steps 3 through 5 for the purple "necro" gate of the 12 hr
treatment plot.  

https://s3.amazonaws.com/fcsexpressdownloads/TutorialSampleDataV7.zip
https://s3.amazonaws.com/fcsexpressdownloads/TutorialSampleDataV7.zip
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The spreadsheet should resemble (Figure T19.43, spreadsheet right of blue
arrow).

Figure T19.43  Populating the Spreadsheet with Statistics from the 12-hr Treatment
Plot

We will now format the Bar Plot, Scatter Plot , and/or Pie Chart  to display
this additional dataset from the appropriate column of the spreadsheet.

22.19.2.3.1  Overlays on Bar and Scatter Plots

In this section of the tutorial, we will display an additional dataset as an Overlay
to a Bar and/or Scatter Chart.  Please complete the preceding section of the
tutorial (Displaying Additional Datasets ) if necessary.

1.  Click on the border of the Spreadsheet so it is highlighted in red.

2.  Drag and drop the Spreadsheet onto the Bar or Scatter Chart (Figure

T19.44, ).

3.  Click the add the files to the new plot as new overlays radio button

(Figure T19.44, ).

4.  Click OK in Select Drag and Drop Action dialog (Figure T19.44, red
outline). 

2212 2216

2211
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Figure T19.44  Adding Overlay to Bar or Scatter Chart by Dragging and Dropping
Spreadsheet

 The Bar Plot or Scatter Plot should resemble Figure T19.45.
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Figure T19.45  Bar and Scatter Charts with New Overlays
The new Overlay has defaulted to display the second ("apo") column of the
Spreadsheet for its values.  We will reformat the plot to derive the values from
Column C instead of B in order to plot the "necro" gate-derived values.

5.  Double-click Bar or Scatter Chart.  The Formatting dialog will appear,
docked to the right.

6.  Choose the Overlays category (Figure T19.46, left for Bar Chart, right for
Scatter Chart).  

7.  Click 2- New spreadsheet from the 2D Bar Overlays or 2D Unbinned

Overlays list (Figure T19.46, , left or right for Bar or Scatter Chart,
respectively).

8. Choose "C" from the Bar Values for 2D Bar Overlay Options or from the
 Y Parameter drop-down list for 2D Unbinned Overlay Options (Figure

T19.46 2, , left or right for Bar or Scatter Chart, respectively).
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Figure T19.46  Updating Source Column for Data Display in New Overlay

The Bar Plot or Scatter Plot should resemble Figure T19.47.

Figure T19.47  Bar and Scatter Charts after Updating Source for New Overlays

Note:  Color, style, size, and other attributes of bars on a Bar Chart and points
on a Scatter Chart can be customized independently for each overlay.  See the
following sections of the manual for details:

· Formatting Bar Charts

· Formatting Scatter Charts

9.  Optional:  

· Click the Data tab group  Next/Previous

commands to advance through the set of files in the Data List and watch
as the Bar, Pie, and Scatter Charts update with the new data.

· Adjust the gates on the plots and watch the Bar, Pie, and Scatter Charts

update in real-time.

585
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22.19.2.3.2  Ring on Pie Chart

In this section of the tutorial, we will display an additional dataset as a Ring on a
Pie Chart.  Please complete the Displaying Additional Datasets  section of
the tutorial before proceeding.

1. Double-click the Pie Chart.  The Formatting dialog will appear, docked to the
right.

2. Choose the Overlays category (Figure T19.48).  

Figure T19.48  Displaying Additional Dataset as a Ring on a Pie Chart

3. Choose "C" from the Ring Parameter drop down list of the Formatting Pie
dialog (Figure T19.48, red outline).  

2211
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The Pie Chart now appears with the "necro" dataset as a ring at the periphery of
the pie (Figure T19.49).

Figure T19.49  Pie Chart Updated to
Display "Necro" Population as Ring

4. Optional:  

· Click the Data tab group  Next/Previous

commands to advance through the set of files in the Data List and watch
as the Bar, Pie, and Scatter Charts update with the new data.

· Adjust the gates on the plots and watch the Bar, Pie, and Scatter Charts

update in real-time.

22.20 High Content Flow

FCS Express continues a legacy of innovation in the field by providing analysis
capabilities for multiwell plate format flow cytometry data. In the course of this
tutorial, you will learn how to:

· Load data as an FCS plate folder file

· Insert plate heat maps

· Format plate heat maps

· Gate on plate heat maps

· View plots from multiple and individual wells

· Create overlays from well data

· Batch process for multiple plates
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· Use the Z-Prime function to calculate the Z-Factor for screening

In the first exercise, we will load, insert, and format plate heat map data .

22.20.1 Load, Insert, and Format Plate Heat Maps

In this section, we will learn how to:

· Load data in the FCS plate folder format

· Insert a Plate Heat Map

· Change the orientation of the Plate Heat Map

· Choose the statistic/parameter to display in the wells

· Change the color levels of the Plate Heat Map

· Adjust the style of display

· Show only events gated on a plot in the Plate Heat Map 

We will use the HighContentFormatting.fey layout for this section which is
located in the Tutorial Sample Data archive . This layout contains one 2D Plot
that will be used towards the end of this section.

In this section, you also will learn how to load a folder that contains data from a
96 well-plate. FCS Express can accommodate any number wells in any plate
format. The data that we will be using is located in the Tutorial Sample Data
archive . For convenience, only one row plus one well of data has been
included. 

In order to load most types of multiwell plate data, you must choose the folder
that contains all the data files from the plate rather than the individual FCS files.

1. Click File tab .

2. Browse to and select the "HighContentFormatting.fey" layout from the
Tutorial Sample Data archive .

3. Select the Data Organize Data Sets group  command.

4. Click the  symbol (first icon in Data List toolbar) and choose Add Data
File.

2218

1682

1682

1682



Tutorials 2219

© 2023 De Novo Software

5. Choose FCS Plate folder from the Files of type: drop-down list (Figure
T20.1, outlined in red).

Figure T20.1  Choosing FCS Plate Folder from the Files of Type: Drop-down List

5. Navigate to the High Content Flow Plate Data folder in the Tutorial

Sample Data archive  (Figure T20.2).1682
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Figure T20.2  Choosing the High Content Flow Plate Data Folder

6. Select the folder and click Open folder.

7. Select any .fcs data file within the folder and click Open Folder.

The folder now will appear in the Data List as a single file. This single file contains
the .fcs files and data from all wells in the plate.

Note, in order for FCS Express to know the plate format used (i.e., 96 wells),
the folder must contain a file, which defines the plate design. For this example,
the file has been included in the High Content Flow Plate Data folder and is
named "plate.AllExtraKeywords.txt" (Figure T20.3). This uses a special
feature of FCS Express that allows you to add extra keywords to a data file
without modifying the file. Please see the Extra Keywords  section of the
manual for more details.

1426
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Figure T20.3  Content of "plate.AllExtraKeywords.txt" File

8.  Drag and drop the "High Content Flow PlateData" from the Data List to a

blank spot on the page within the layout (Figure T20.4, ).  

9.  Check the Plate Heat Map box in the Select Plot Types... dialog (Figure

T20.4, ). 

10. Click OK (Figure T20.4, ).

Figure T20.4  Dragging and Dropping a Data File from the Data List Tab and
Choosing Plate Heat Map as Plot Type
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A plate heat map will appear (Figure T20.5). The plate heat map is only displaying
wells A1-12 and B1 because we have only included these wells in the sample
data. 

Figure T20.5  Inserted Plate Heat Map

We now will change the axis to display this parameter.

11. Click on the Y-axis parameter label along the row labels (Figure T20.6).

12. Choose FL2-A (Figure T20.6, blue highlighted text).
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Figure T20.6  Changing the Plate Heat Map
Parameter

Note: The colors in the plot above reflect the Arithmetic mean statistic for the
FL2-A channel of each well displayed on the plate heat map. We will show how to
change the statistic plotted later in the tutorial.

We now will duplicate the plate heat map and change the orientation of the newly
created plate heat map.

13. Select the plate heat map.

14. Choose Home tab group  command (Figure
T20.7). Alternatively, use the Ctrl+D command.

Figure T20.7  Duplicate Command from Ribbon
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A copy of the original plate heat map will appear on the layout. Drag the plots by
their green or red borders and use Align  commands, so they resemble Figure
T20.8.

Figure T20.8  Duplicate Plate Heat Maps

15. Double-click the plate heat map on the right.  The Formatting dialog will
appear, docked to the right (Figure T20.9).

16. Choose the Specific Options category.

17. Change the Orientation from Landscape to Portrait (Figure T20.9, red
outline). 

1692
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Figure T20.9  Changing Orientation from Landscape to Portrait

The two plate heat maps should resemble Figure T20.10. Changing the

orientation of the plate heat map may be useful depending on the layout of your

experiment or your display or publication needs.

Figure T20.10  Plate Heat Maps Displayed in Landscape and Portrait Modes

We now will change the statistic represented by colors on the plate heat maps.

18. Key Ctrl+Z to undo the orientation change.

19. Click the left plate heat map.
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20. Choose the Overlays category in the Formatting dialog.

The plate heat maps are currently displaying the "Arithmetic Mean" of all the
events in the well as indicated in the "Statistic to show" field.

21. Change the Statistic to show to Median from the drop-down list (Figure
T20.11, red outline). 
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Figure T20.11  Changing the Statistic to Show in the Plate Heat Map
p
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The layout should resemble Figure T20.12. Notice how the plate heat map on
the left now shows a very positive, or red, well at position A4. In this example,
the median provides better discrimination between hot (red) and cold (green)
wells than Arithmetic Mean (heat map on right) for the FL2-A parameter.

Figure T20.12  Plate Heat Maps Displaying Statistics for Median (Left) and
Arithmetic Mean (Right).

We now will adjust the color levels of the plate heat maps to identify which
settings are useful for display purposes and to further discriminate positive from
negative samples.

22. Click the left plate heat map if necessary.

23. Choose the Color Levels category in the Formatting dialog.

24. Change the Selected Color Level from the drop-down list to Rainbow
(Figure T20.13, red outline, blue highlighted text).



Tutorials 2229

© 2023 De Novo Software

Figure T20.13  Changing the Color Level of a Plate Heat Map

Try changing and previewing the color levels for Green-Red, Green-Blue,
Greyscale, and Inverse Greyscale, to see the differences. The Threshold color
level assigns a color to any wells above the defined threshold level. We will enter
a threshold value to view this feature as in Figure T20.14.

25. Change the Color Level from the drop-down list to Threshold (Figure

T20.14, ).

26. Enter "1000" in the Threshold Value field (Figure T20.14, ).

27. Change the Below Threshold Color to Yellow (Figure T20.14, ).
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28. Change the Above Threshold Color to Orange (Figure T20.14, ).

Figure T20.14  Defining a Threshold to Display as a Color Level in a Plate Heat Map

The plate heat map will resemble Figure T20.15. Wells in which the median FL2-A
value is above 1000 are displayed as orange and wells which are less than 1000
are displayed in yellow.
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Figure T20.15  Plate Heat Map with
Threshold Color Level

Note: See Choosing a Color Scheme  for additional information about coloring
plate heat maps.

We now will change the Color Level Style. The Style refers to the method of
assigning colors to different values in the plate heat map. The default style is
"mean +/-SD". This assigns wells whose values are the mean of all the values on
the plate to be the color black. Wells whose values deviate from the mean are
colored one of two colors, depending on whether they are above or below the
mean. The degree to which a well is shaded towards a particular color depends
on the user defined standard deviation value, which defaults to 3.5 SD. For the
Red-Green Color level, wells that are 3.5 SD lower than the mean are green, and
wells that are 3.5 SD above the mean are red. There are three other choices in
this dialog; fixed range, percentile, and threshold. 

29. Multiple-select  both plate heat maps on the layout.

30. Choose Overlays category in the Formatting dialog.

31. Change the Statistic to show to Median (Figure T20.16). 

322
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Figure T20.16  Formatting Overlays

32. Select only the left plot.

33. Choose the Color Levels category (Figure T20.17).

34. Change the Selected Color Level drop-down list to Green-Red (Figure

T20.17, ).

35. Change the Style to Percentile from the drop-down list (Figure T20.17,

).
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Figure T20.17  Changing the Style of the Plate Heat Map Color Levels

36. Repeat steps 32 through 35 for the plate heat map on the right.

37. Change the Style to Fixed Range (on the right plot).

38. Change the Color Scaling to Logarithmic from the drop-down list (on
the right plot).

The plate heat maps will resemble Figure T20.18. Notice how the color levels
have changed as a result of changing the color level Style from Mean +/- SD to
Percentile, and Fixed Range.



FCS Express 7 Manual2234

© 2023 De Novo Software

Figure T20.18  Adjusting Color Styles

We will load the FCS Plate folder data into the 2D plot on the layout, gate the
plot, and apply the gates to the plate heat map to display only the gated events.

39. Click to select the "2D Plot for Gating" at the bottom of the page.

40. Choose the Data tab group
command down arrow and choose Select using Advanced Open Data
Dialog.

41. Click the Data List tab.

42. Select High Content Flow Plate Data.

43. Click Open.

Note: Alternatively, you can drag and drop the "High Content Flow Plate Data"
from the Data List directly onto the "2D Plot for Gating" (Figure T20.19).
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Figure T20.19  Dragging and Dropping from Data List to 2D Plot

44. Create two gates  on the 2D plot as in Figure T20.20 below.

Figure T20.20  2D Plot Created from the High
Content Flow Plate Data with Two Gates

Note: Since the plot above is ungated, it is showing all the events from all the
wells in the data file.

701
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45. Select the Plate Heat Map on the left.

45. Choose Gate 1 from the Gating tab group
Gate drop-down list (Alternatively, you can drag and drop Gate 1 from the
2D Plot directly onto the plate heat map).

46. Select the Plate Heat Map on the right.

47. Choose Gate 2 from the Gating tab group
Gate drop-down list (Alternatively, you can drag and drop Gate 2 from the
2D Plot directly onto the plate heat map).

Notice how the plate heat map updates to only display cells that fall within the
gate you applied. Try moving the gates and watch the plate heat maps update.

Next, we will analyze data in a plate heat map .

22.20.2 Analyzing Data in Heat Maps

In this section you will learn how to:

· Create a gate on a plate heat map

· Use well gates to view events in 2D plots from single and multiple wells

· Create plate heat map overlays to view events from multiple wells on a

single plot as an overlay

We will use a data set, screening for "hits" that are positive in the FL2-A channel.
We will be using the HighContentAnalysis.fey layout and the
HighContent96wellData.dns data file (.dns is special file format created by FCS
Express), which are both located in the Tutorial Sample Data archive . The
original data set contains 96 FCS Files acquired on a plate-based acquisition
system.

1. Load the HighContentAnalysis.fey layout.

2. Choose the Data tab group  command.

3. In the Data List, click the  symbol and choose Add Data File.

4. Choose DNS data Stream files (*.dns) from the Files of type: drop-
down list (Figure T20.21, red outline).

2236
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Figure T20.21  Choosing DNS Data Stream Files

5. Navigate to the FCS Express Tutorial Sample Data directory (Figure

T20.21 above, red arrow).

6. Choose the file "HighContent96wellData.dns" 

7. Click Open file.

The file will appear in the data list as a file. This file contains data from all 96 wells
stored in .dns format. We will now load the data into the plots on the layout
before we insert a plate heat map.

8.  Choose the Data tab group down
arrow  using Advanced Open Data Dialog command (Figure
T20.22, red arrow).
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Figure T20.22  Select Using Advanced Open Data Dialog Command

9.  Choose the Data List tab in the resulting Change Data File dialog.

10. Highlight the HighContent96wellData.dns file and click OK.

Note: Alternatively, you can select the "HighContent96wellData.dns" item in
the Data List and click "Change Data On All Plots" (Figure T20.23).

Figure T20.23  Change Data On All Plots Button in
Data List

The layout will resemble Figure T20.24.
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Figure T20.24  High Content Analysis Layout after Loading
HighContent96wellData.dns File

The color dot plot in the layout is showing all the events within the .dns file
(Figure T20.24). The Live Cells gate is applied to the plate heat map, so it will
only display cells falling within the gate, which is defined on the 2D plot. 

Wells that are "hot" for FL2-A are displayed in red and wells that are "cool" for
FL2-A are displayed in green. Varying degrees of heat are represented by the
transition from Red to Black to Green.

We now will create gates on the plate heat map. 

12. Right-click the plate heat map.

13. Choose  from the pop up menu. 

14. Click in the white space surrounding the plate but within the green border
as in Figure T20.25 (Clicking directly on a well will immediately select the
well for gating).
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Figure T20.25  Creating a Well Gate

The Editing New Well Gate window will appear (Figure T20.26).

Figure T20.26  Editing a New Well Gate

15. Click the well in position H12. 

The Create New Gate dialog will appear (Figure T20.27).

16. Enter "Negative Control" for the Create a new gate named edit field

(Figure T20.27, ).

17.Change the Gate color to "Green" (Figure T20.27, ).

18. Click OK (Figure T20.27, ).
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Figure T20.27  Create New Gate Dialog

We now will create a second gate into the plate heat map called "Experimental."
For training purposes, we will use an alternative procedure to steps 12 through
18.

19. Choose the Gating tab group  command (Figure
T20.28).

Figure T20.28  Selecting the Create Well Gate Command

20. Click directly on Well A4. The Create New Gate dialog will appear (similar
to Figure T20.27).

21. Enter "Experimental" for the gate name, change the Gate color to
"Blue" (similar to Figure T20.27). 

22. Click OK (similar to Figure T20.27).

The layout and gate view should resemble Figure T20.29.
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Figure T20.29  Layout with Gate View Indicating Hierarchical Gating of the Negative
Control and Experimental Gates

We now will create a histogram overlay to view data from separate wells.

23. Drag and drop the entire Plate Heat Map to the plot labeled Histogram
for Plate Heat Map data on the layout (Figure T20.30).
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Figure T20.30  Creating New Overlay by Dragging and
Dropping

The Select Drag and Drop Action dialog appears (Figure T20.31).

Figure T20.31  Select Drag and Drop Action Dialog

24.Select the option to Add the files to the plot as new overlays and click
OK (Figure T20.31, red arrows).

25. Double-click the histogram.  The Formatting dialog will appear, docked
to the right.

24. Select the Overlays category (Figure T20.32).

Two overlays for the same FCS Plate folder file will be displayed in the Overlay
List.

25. Select the first overlay, 1 - Highcontent96wellData.dns, in the

Overlay List if necessary (Figure T20.32, ).
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26. Change the Gate drop-down list to "Negative Control" (Figure T20.32,

).

27. Change the Color under Line Options to Green (Figure T20.32, ).

28. Highlight the second overlay in the list (Figure T20.32, ).

29. Change the Gate drop-down option to "Experimental" (Figure T20.32,

).

29.Change the Color under Line Options to Blue (Figure T20.32, ).

Figure T20.32  Formatting Overlays of Histogram for Plate Heat Map Data

The histogram should resemble Figure T20.33, displaying the cells in the
"Negative Control" well gate as green, and the cells from the "Experimental"
well gate as blue.
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Figure T20.33  Histogram Displaying Events from Well Gates

We now will edit the well gates to select different wells.

30. Right-click the plate heat map.

31. Choose  from the pop up menu. The Editing
well gates window will appear, and well A4 will be highlighted in blue (Figure
T20.34).
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Figure T20.34  Editing the Experimental Well Gate (A4)

32. Click the well in position C12. Notice how the experimental histogram
peak shifts showing only the cells in the newly selected well (Figure
T20.35). Well C12 shows heterogeneous staining for FL-2A while "cooler"
wells, such as G9. Click well G9 to view) overlap with the negative control. 

33. Click Close in Editing Experimental window above plate heat map.

We now will select multiple "Negative" wells to create a better representation of
the negative population displayed on the histogram.
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Figure T20.35  Experimental Well Gate Changed to C12

34. Key Ctrl+Z to undo the gate change.

35. Right-click the plate heat map.

36. Choose  from the pop-up menu.

37. Press and hold down the Ctrl button to allow multiple non-consecutive
selection.

38. Click wells C1 and F1 (Figure T20.36).

39. Release the Ctrl button.



FCS Express 7 Manual2248

© 2023 De Novo Software

Figure T20.36  Selecting Multiple Non-consecutive Wells (C1, F1, and H12)

Multiple non-consecutive wells can be chosen in this manner. Notice how the
histogram updates to reflect selection of the multiple wells (C1, F1, and H12 in
Figure T20.36). 

We will now select multiple wells using a selection box.

40. Left-click and hold the mouse button down slightly above and to the right
of well B1.

41. Drag the mouse down and to the left to select wells B1-F1. Notice how
the selection box appears and indicates which wells are being selected
(Figure T20.37).
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Figure T20.37  Selecting Multiple Continuous
Wells

42. Release the mouse button to select the wells. 

Multiple wells can also be selected by a combination of using the selection box
and Ctrl+Clicking.

43. Hold down the Ctrl key.

44. Select wells B1-F1.

45. Click on well G9 to select it (continue holding down the Ctrl key).

46. Create a new selection box (with the Ctrl key still being held down) to
encompass wells A8-A11.

47. Release the Ctrl key.

48. Click Close from the Editing  Negative Control window above plate
heat map.

Wells B1-F1, A8-A11, and G9 are now selected and contributing to the Negative
Control histogram peak (Figure T20.38).
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Figure T20.38  Multiple Well Selection for Negative Control Gate

Gates also may be deselected from the well gating dialog in a similar manner.

49. Right-click the plate heat map.

50. Choose  from the pop-up menu.

51. Ctrl+Click on well A8. Notice how the well gate is removed.

52. Repeat step 51 for wells B1-F1. The continuous column well gates will be
removed.

53. Click Close in Editing Negative Control window above plate heat map.

Although selecting wells for gating and displaying them in histograms or 2D plots
is useful, some users may be only interested in which wells contain the highest
channel values.  In the following steps, we will format the plate heat map to
display wells above a defined threshold value.

54. Choose Color Levels category in the Formatting dialog (Figure T20.39).

55. Change the Style to Threshold from the drop-down list (Figure T20.39,

).

56. Change the Below Threshold Color to Black (Figure T20.39, ) and

Above Threshold Color to Red (Figure T20.39, ). 
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57.Click on the  symbol in the Threshold Value field to insert a token

(Figure T20.39, ).

58. Double-click Statistic from the Insert a Token dialog (Figure T20.39, 
).

Figure T20.39  Formatting Style and Colors Used in Threshold for Color Levels of
Plate Heat Map

59. Choose the "Histogram for Creating Threshold Value" in the Select a

plot list box (Figure T20.40, ).

60. Choose the Statistic category on the left of the Create Statistic dialog

(Figure T20.40, ).

61. Set the Gate to Live Cells from the drop-down list (Figure T20.40, ).

62. Highlight Median in the Statistic list box (Figure T20.40, ).

63. Click OK (Figure T20.40, ). 
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Figure T20.40  Selecting the Plot and Statistic to Be Used for Threshold Value of
Color Level Settings
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The plate heat map should resemble T20.41. The red wells indicate those with a
median value for FL2-A fluorescence above the median FL2-A fluorescence of
the entire plate.

Figure T20.41  Threshold Defined as Median
Value for Plate Heat Map

In the next section, we will use batch analysis to analyze multiple plates . 

22.20.3 Using Batch Analysis

In this tutorial, we will cover how to setup a batch process to analyze data from
multiple plates. The batch functions for plate heat maps are the same as for any
other plot in FCS Express. For a more detailed introduction to batch processing,
we recommend viewing the Batch Processing tutorial  before you begin.

We will use the HighContentBatch.fey layout, along with the
HighContent96wellData.dns and HighContentNewPlate.dns data files. The
.dns is an extension created in FCS Express that allows for special compression
of the data.

1.  Open the HighContentBatch.fey layout located in the Tutorial Sample
Data  directory.

The layout is saved as unlinked and we must load our plate data into the Data
List before we can begin adding batch actions.

2.  Select the Data tab group  command.

3.  Click the  symbol to add data files to the data list. The Select data file
window appears.
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4.  Choose DNS data Stream files (*.dns) from the Files of type: drop-
down list (Figure T20.42, red outline).

5.  Multiple-select the files HighContent96wellData.dns and
HighContentNewPlate.dns (Figure T20.42).

6.  Click Open file (Figure T20.42).

Note: you can select multiple files by keying down the Ctrl on the keyboard while
clicking files.

Figure T20.42  Multiple File Selection in Select Data File Window

7.  Choose the Data tab group down
arrow  using Advanced Open Data Dialog command (Figure

T20.43, left, ). The Change Data File window appears (Figure T20.43,
right).
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Figure T20.43  Selecting .dns File in the Advanced Open Data Dialog

8.  Click the Data List tab (Figure T20.43, ).

9.  Choose HighContent96wellData.dns and click OK (Figure T20.43, ). 
Alternatively, you make click the first data file
HighContent96wellData.dns in the Data List and choose Change data
on all plots from the Change data (fifth icon in Data List).

The layout will resemble Figure T20.44. There are three differently styled views
of the plate heat map data and a table containing the statistics for each well in
the plate heat map. We will define batch actions to export for the two plate files
in the data list.
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10.Choose the Batch tab group
command. The Batch Actions window appears.

11. Choose Save to PDF, the fourth option from the Add Action category. 

The Create Export to PDF Action window appears (Figure T20.45).

12. Click folder icon  to define a file name and location for saving the PDF to
right of the Save to a new file field for Output File Options(Figure

T20.45, ).

13. Click directly after the file name and before the extension ".pdf" to place

cursor (Figure T20.45, ).

14. Click on the  symbol to insert a token (Figure T20.45, ).

15. Open arrow to left of Batch Processing folder to open it (Figure T20.45,

)

16. Double-click Current batch iteration in the Insert a Token dialog

(Figure T20.45, ).
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Figure T20.45  Saving PDF Action with Token Inserted into File Name

The Create Export To PDF Action dialog should resemble Figure T20.46.
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Figure T20.46  Create Export To PDF Action Dialog after Adding Current
Batch Iteration Token to File Name

17. Click OK.
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18. Choose Save to PowerPoint from the Add Action category in the

Batch Actions window (Figure T9.7 , ). 

The Create Export to PowerPoint Action window appears (Figure T9.8 ).

19. Click folder icon  to define a file name and location for saving the
PowerPoint to right of the Save to a new file field for Output File

Options(similar to Figure T20.45, ).

The Create Export To PowerPoint Action dialog should resemble Figure
T20.47.

1932
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Figure T20.47  Create Export To Powerpoint Action Dialog

20. Click OK.

The Batch Actions window will match Figure T20.48.
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Figure T20.48  Batch Actions Window

21. Choose the Batch tab group  command.

22. Choose Yes in warning dialog about overwriting Iteration Snapshots to
continue.

The batch process will iterate through each data file in the Data List and export
the actions we have added to the directory you selected. Since there are only
two files in the data list, there should be:

- Two PDF files containing one iteration each (since we choose to Save the
output of each iteration separately). File names contain a common part
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("BatchProcessExperiment") and a variable part (the token referring to the
iteration number). The latter allow you to distinguish among the different PDF
files generated by the batch process.

- One PowerPoint file containing all the iterations; since file name is unique and
contains all the data files, the PowerPoint does not need any tokens.

In the last exercise, we will use the Z-Prime function .

22.20.4 Using the Z-Prime Function

In high-throughput screens, experimenters often compare a large number
(hundreds of thousands to tens of millions) of single measurements of unknown
samples to positive and negative control samples. Large screens are expensive in
time and resources. Therefore, prior to starting a large screen, smaller test (or
pilot) screens are used to assess the quality of an assay, in an attempt to predict
if it would be useful in a high-throughput setting. The Z-factor is an attempt to
quantify the suitability of a particular assay for use in a full-scale, high-throughput
screen.

FCS Express provides two ways to calculate the Z-Prime function easily: using
Custom Tokens  or Spreadsheets . 

We will use the HighContent_CalculatingZPrime.fey layout, which has
embedded data for the positive and negative control .fcs files. We will utilize
tokens and custom tokens in this section. For a more detailed explanation of
tokens, please view the Using Text Boxes and Tokens tutorial .

1. Open the HighContent_CalculatingZPrime.fey layout located in the
Tutorial Sample Data  directory.

The layout will resemble T20.49. It contains a negative control file on the left and
a positive control file on the right. There is also a text box where we will place
the formula for the Z-Factor and a classification.

2263

1337 416

1787

1682



FCS Express 7 Manual2264

© 2023 De Novo Software

Figure T20.49  High Content Calculating Z-Prime Layout

2. Click the  symbol in the Custom Tokens window.

3. Name the new custom token "Z Factor."

4. Click in the Enter the Custom Token formula below field.

5. Enter an equals sign ("=").

6. Right-click after =.

7. Choose .

8. Choose ZPrime(mean negative, SD negative, mean positive, sd
positive) from the Statistics list (Figure T20.50).
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Figure T20.50  Choosing the ZPrime function from the Functions List for a Custom
Token

9.  Highlight "mean negative" text in the formula field (Figure T20.51, blue
highlighted text).

10. Right-click with the text highlighted and choose Insert Token (Figure
T20.51, indicated by cursor).
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Figure 20.51  Inserting Token

11. Double-click Statistic in the Insert a Statistic dialog. 

The Create Statistics window appears (Figure T20.52).

12. For the Data Source category, choose Negative Control for the Select
a Plot subcategory (Figure T20.52, red arrow).
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Figure T20.52  Create Statistics Dialog

13. Choose Statistic category.

14. Choose Negative Control Gate from the Gate list (Figure T20.53, ).

15. Select X Arithmetic Mean from the Statistic list (Figure T20.53, ).

16. Click OK (Figure T20.53, ).
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Figure T20.53  Choosing Token Properties

17. Highlight "SD negative" text in the formula field.

17. Right-click with the text highlighted and choose Insert Token.

18. Double-click Statistic in the Insert a Token dialog.

19. Choose the Negative Control plot under Select a Plot subcategory for
the Data Source category.

20. Click the Statistic category.

21. Choose the Negative Control Gate from the Gate list.

22. Choose X Standard Deviation from the Statistic list.

23. Click OK.
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24. Repeat steps 9-24 with "mean positive" and "SD positive" using the
Positive Control plot as Data Source and the Positive Control Gate for
the Statistic.

The formula for the Z Factor custom token match Figure T20.54, where each of
the four original text placeholders have been replaced with the representative
tokens.

Figure T20.54  Z Factor Represented by the Z-Prime Function in Custom
Token

25. Right-click after "The Z-Factor =" in the text box on the layout.

26. Choose Insert Token.

27. Double-click on Z Factor under Custom in the Insert a Token dialog.
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The Z-Factor custom token will appear in the text box with a value of 0.00. 

To interpret the Z-factor, we will use the guidelines from Zhang JH, Chung TD,
Oldenburg KR, A Simple Statistical Parameter for Use in Evaluation and Validation
of High Throughput Screening Assays. J Biomol Screen. 1999;4(2):67-73.

· A Z-factor of 1, ideal. Z-factors can never be greater than 1.0. 

· A Z-factor between 0.5 and 1.0 is an excellent assay. 

· A Z-factor between 0 and 0.5 is marginal. 

· A Z-factor less than 0 means that the signal from the positive and

negative controls could overlap, rendering the assay impractical for
screening purposes. 

A Custom Classification Token has been defined already in this layout to classify
the Z-Factor. To enable the classification token:

28. Right-click on ##ERROR## next to "The Assay Classification is".

29. Choose Format Token from the pop-up menu. The Edit Statistic
Classifier window appears.

30. Choose the Classification category.

31. Click on the  symbol in the Enter a value to classify field.

32. Double-click on Z Factor under Custom.

The Edit Statistic Classifier dialog should resemble T20.55.
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Figure T20.55  Changing the Classification Token to Z Factor

33. Click OK.

The layout will resemble Figure T20.56. The Assay Classification will read
Marginal since the value is 0.00.
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Figure T20.56  Calculating Z-Prime Layout with the Classification Token

Adjusting the Positive Control gate to contain different portions of the sample
will cause the Z Factor and Assay Classification to update in real-time (Figure
T20.57).
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Figure T20.57  Gating on the Sample Data Causes the Z Factor and Classification to
Update in Real-Time

22.21 DNA Analysis

In this tutorial, you will learn how to use MultiCycle to analyze different types of
cell cycle histograms. There are ten different histogram files named ASCII1.fcs
through ASCII10.fcs, located in the FCS Express Sample Data folder, that show
different DNA cell cycles to explore MultiCycle.

The true strength of MultiCycle is its ability to analyze cell cycle histograms with
multiple models coupled with the batch processing ability of FCS Express.

FCS Express includes a basic version of MultiCycle. The basic version will fit a
single cycle model to your data without background or aggregate/debris
correction. A single cycle analysis means only one population of cells will be
modeled. The advanced version can fit up to two aneuploid populations
(considered a 3-cycle model) as well as apply sophisticated background and
aggregate/debris correction. The advanced version must be purchased
separately.

In the course of this example, we will:

· Use gating to exclude doublets.
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· Use Autofit in MultiCycle to analyze a DNA histogram.

· Format MultiCycle histograms.

· Use MultiCycle without Autofit to analyze a DNA histogram.

In the first exercise, we will use autofit selection for a single cycle analysis .

22.21.1 Autofit Selection (1 Cycle Analysis)

In order to exclude doublets, we will examine a 2D dot plot of the DNA
fluorescence height versus the DNA fluorescence area signal and draw a gate on
the single cell events. Many times, users will use the plot of the DNA fluorescence
width signal versus the DNA fluorescence area signal. The Height signal
corresponds to the peak intensity of fluorescence pulse from the DNA dye. The
Area signal is the calculated area under the fluorescence pulse emitted by the
DNA dye. The Width signal represents the length of time of the fluorescence pulse
emitted by the DNA dye. The specific geometry of the laser beam and other
instrument factors determine which parameters are best suited to discriminate
single cell events from doublets. In our example, DNA fluorescence area signal is
the FL2-A parameter, DNA fluorescence width is the FL2-W parameter, and DNA
fluorescence height is the FL2-H parameter.

If a new blank layout is already open, then proceed to step 2.

1. Select the File tab .

2. Select the Insert tab command.

3. Click anywhere on the blank, white space of layout.

The Select data file dialog appears (Figure T21.1).

4. Navigate to the Tutorial Sample Data  directory.

5. Make sure that FCS files (*.*, *.fcs, *.lmd) is chosen for Files of Type.

6. Select the file BD.LMD (Figure T21.1).

7. Click Open file.
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Figure T21.1  Select Data File Dialog

A dot plot appears on the layout

8. Click the x-axis label and select FL2-H from the pop up menu.

9. Click the y-axis label and select FL2-A from the pop up menu. 

The dot plot should resemble Figure T21.2.

Figure T21.2  Dot Plot of FL2-H vs
FL2-A
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We will create a gate on the 2D plot to exclude the doublets as well as to exclude
what appear to be tetraploid amounts of DNA. We are excluding these cells with
higher amounts of DNA because we want to perform a single cycle DNA analysis.
For more information on creating gates, please refer to the Gating tutorial .

10. Select the Gating tab group command.

11. Create a polygon gate similar to the gate shown in Figure T21.3.

The Create a New Gate dialog appears.

12. Name the gate "singlets HA" in the Create a new gate named field.

The plot should resemble T21.3.

Figure T21.3  Gate to Exclude Doublets
and Cells with High DNA Content

We now are ready to use the Autofit function in MultiCycle to perform a DNA cell
cycle analysis.

Inserting a MultiCycle DNA Plot:

13. Select the Insert tab group command
(Figure T21.4).

14. Click on a blank area of the layout.

1746



Tutorials 2277

© 2023 De Novo Software

Figure T21.4  Selecting the Insert Muticycle DNA Command

The Select DNA parameter dialog appears, as shown in Figure T21.5

15. Select FL2-A as the Parameter, shown highlighted in blue.

16. Click OK.

Figure T21.5  Select DNA Parameter Dialog
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17. Click singlets HA gate and hold mouse button.

18. While holding mouse button down, drag gate from dot plot to Multicycle
plot.

19. Release mouse button once Multicycle DNA plot has light blue border.

The histogram of FL2-A, gated on singlets HA, is analyzed by MultiCycle using

the Autofit function and appears on the layout (Figure T21.6). Note that your

plot may differ from the figure depending on your singlets gate shape. 

Figure T21.6  MultiCycle Analysis of
FL2-A Using Singlets HA Gate

We now will zoom into the region of interest on the Multicycle plot to improve

the fit.

20. Right-click on the Multicycle plot and select Magnify (Resolution) from
the pop up menu.

21. Click and drag the cursor, which is now a crosshair, around the region of
interest as shown (Figure T21.7, left).

22. Release the cursor after drawing around region of interest.  The Multicycle
plot's fit has updated, and only one cycling population is now detected,
depicted in red (Figure T.21.7, right).
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Figure T21.7  Magnifying Resolution to Improve Fit of Multicycle Model

We now will display the legend information associated with the MultiCycle DNA
analysis.

23. Double-click the Multicycle plot. The Formatting dialog will appear,
docked to the right side of layout.

24. Select the Legend category (Figure T21.8).

25. Check the box next to Visible (Figure T21.8, red outline).



FCS Express 7 Manual2280

© 2023 De Novo Software

Figure T21.8  Formatting the DNA histogram to Display the Legend Associated with
MultiCycle Analysis

The legend associated with the MultiCycle DNA analysis will appear on right side
of plot (Figure T21.9). 

Note: the plot size  and position of the legend may be adjusted to better
accommodate the legend.

1684
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Figure T21.9  MultiCycle DNA Histogram Cell Cycle Analysis with Associated Legend

From the legend, it is noted only diploid cells are present and therefore a single
cycle analysis was performed by the Autofit function of MultiCycle. We can
confirm this by examining the MultiCycle information on the ribbon.

26. Click to select the Multicycle plot; it should be outlined in green (Figure
T21.9).

27. Select the MultiCycle tab (Figure T21.10).

Figure T21.10  Multicycle Tab

Notice that Autofit and Model 1 are highlighted in darker grey (Figure T21.10).
This indicates that the MultiCycle Autofit function and that Model 1 are being used
to analyze this DNA histogram. Also notice that 1 Cycle under Cycle, was used in
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the analysis. For an explanation of the differences between all the models, please
see the De Novo Software DNA/Multicycle AV knowledgebase page.

We now will view all the different statistics for the DNA analysis of Multicycle plot.

28. Right-click the Multicycle plot.

29. Select  from the pop up menu (Figure
T21.11, blue highlighted text).

Figure T21.11  DNA Cycle Statistics Popup Menu Item

The DNA Cycle Statistics window of the current model (Model 1) will now
appear (Figure T21.12). Note that you will have slightly different values for the
statistics depending on how your singlet gate was drawn.

https://denovosoftware.com/full-access/features/cell-cycle-analysis/
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30. Move  the DNA Cycle Statistics window beneath the plot (Figure
T21.12).

Figure T21.12  DNA Cell Cycle Statistics from the MultiCycle Model 1 Analysis of
the Histogram

31. Right-click the Multicycle plot.

32. Select , previously shown in
Figure T21.11.

The DNA Model Summary Statistics window, showing all of the six defined
MultiCycle models applied to the current histogram, appears. The six models
shown in the DNA Model Summary Statistics window correlate respectively
with the six models shown in the group (Figure
T21.10). The DNA Model Summary Statistics displays the default statistics set
in FCS Express preferences which we will change later in the tutorial.

33. Move the DNA Model Summary Statistics window under the DNA Cell
Cycle Statistics window (Figure T21.13).

1685
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34. Right-click the Multicycle plot.

35. Select  from the pop-up menu,
previously shown in Figure T21.11.

The DNA Experiment Statistics window with the interpretation of the DNA
model and the experiment statistics will appear.

36. Move the DNA Experiment Statistics window next to the DNA Model
Summary Statistics window (Figure T21.13).

Figure T21.13  DNA Histogram with All of the MultiCycle
Statistics Windows

In the next section, we will perform an expanded analysis with Autofit .2285
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22.21.2 Expanded Analysis with Autofit

We will now adjust the 'singlet HA' gate to include the cells with higher DNA
content. Autofit in the basic version of MultiCycle will continue to perform a one
cycle analysis. However, Autofit in the advanced version of MultiCycle, will
mathematically decide whether to apply a one, two, or three cycle fit to the
histogram data.

Please refer to Figure T21.14 for the final location of the gate.

1. Activate the "singlet HA" gate for editing by clicking inside the gate.

2. Move the cursor to the top upper right resizing handle of the gate; you will
know you are in the correct place when the cursor changes to a two-
headed arrow.

3. Press and hold down the left mouse button while dragging the corner of
the gate upwards.

4. Release the button when the corner of the gate is in the desired location
(Figure T21.14).

5. Repeat steps 2 through 4 for the top upper left corner of the gate.

The gate should resemble Figure T21.14, modified to include cells with higher
content DNA, but still excluding most of the doublets.

Figure T22.14  Gate Modified to Include
Cells with Higher DNA Content

The Autofit function of MultiCycle updates the cell cycle analysis, as shown in
Figure T21.15. Note: Figure T21.15 shows the MultiCycle analysis using the
advanced version of Multicycle. The basic version of MultiCycle will continue to
apply a one cycle model to the histogram.
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· Right-click the Multicycle DNA plot and choose UnMagnify (Resolution) to

improve display and fit if necessary.

For the rest of this tutorial, we will use the advanced version of MultiCycle for the
DNA analysis. However, all the formatting features of the DNA histogram and
related statistics are also available in, and operate in the same way, the basic
version of MultiCycle.

Note that the DNA analysis now shows an aneuploid population, shown in blue in
Figure T21.15. In fact, the MultiCycle Interpretation suggests that this is most
likely a tetraploid population. Also of note is that a 2-cycle model was used. This
information is shown in the Experiment Statistics window and can also be found
by selecting the DNA histogram and then selecting the Multicycle tab.

Figure T21.15  Autofit MultiCycle Analysis with Modified gate
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We will select the specific statistics we want to display in the DNA Model
Summary Statistics table. There are multiple ways of selecting the statistics
shown in the table, and these same methods can be used to select which
statistics are shown for any of the DNA-associated statistics shown in the pop up
menu on Figure T21.11 . For more information on formatting, please see the
tutorial on Formatting Plots . 

First, we will close the DNA Experiment Statistics window so that we have
room to expand the DNA Model Summary Statistics window. 

6.  Hover the mouse over the border of the DNA Experiment Statistics
window.

7.  Left-click when the cursor changes to a four-headed arrow; you will know
it is selected for editing because it will have a red border.

8.  Press Del on the keyboard or select delete from Home tab
group.

9.  Left-click inside the DNA Model Summary Statistics window to select it.

10. Select the Format tab  command.

The Formatting Stats Options dialog appears (Figure T21.16).

2282
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Figure T21.16  Formatting Stats Options Dialog for DNA Model Summary Statistics

11. Select the down arrow on the scroll bar.

12. Continue to hold down the left mouse button to scroll down to the
bottom of the list.

13. Click on the box next to Clump and Debris as shown in Figure T21.17.
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Figure T21.17  Selecting Clump and Debris from the Formatting Stats
Options Dialog

The DNA Model Summary Statistics table will now update to show the
selected statistics as shown in Figure T21.18.
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Figure T21.18  DNA Model Summary Statistics
Table Updated to Show to Clump and Debris

Alternatively, you can use the DNA Model Summary Statistics associated pop-
up menu to select, or De-select, the specific statistics to display. 

· Right-click on the DNA Model Summary Statistics window to bring the

associated pop-up menu.

The DNA Model Summary Statistics pop-up menu appears (Figure T21.19).
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Figure T21.19  DNA Model Summary
Statistics Pop-up Menu
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· Select the arrow in the lower left corner of the menu to scroll down,

indicated by the cursor in Figure T21.19.

· Continue to hold down the left mouse button until the menu scrolls all the

way down (Figure T21.19).

· Left-click next to Clump, as indicated by the cursor on Figure T21.20, to

de-select the item.

The pop-up menu will now close and the DNA Model Summary Statistics table
will update to reflect the removal of the item Clump.

· Repeat the above steps to de-select Debris, located under Clump in Figure

T21.20.

The pop-up menu will now close and the DNA Model Summary Statistics table
will update to reflect the removal of the item Debris.
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Figure T21.20  Deselecting Clump
from the DNA Model Summary

Statistics Pop-up Menu
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You can select different DNA cell cycle models in the Multicycle Model to
Display group, and the DNA cell cycle statistics window will update to reflect the
model selected. Try selecting different models from the Multicycle tab using
Autofit and observe how the results change in the DNA cell cycle statistics
window. When using the full version of MultiCycle, the histogram display will also
update to reflect the fit to the model selected. The different models vary by the
complexity of the model (applying constraints, or not, on the CV or G2/G1 mean
ratio) and the inclusion of software aggregate compensation. For more
information on the different models refer to the MultiCycle documentation.

A quick visual examination of the DNA Model is often useful. However, the model
with the lowest Chis (Chi-square) value is usually the best fit, shown circled in
red in Figure T21.21. In this case Model 2 (SL CL S0) has the lowest Chis;
however, two other models have very similar low Chis values.

Figure T21.21  DNA Cell Cycle Model
with the Lowest Chis (Chi-square)

Value

In the next section, we will format a DNA histogram .

22.21.3 Formatting Multicycle DNA Plot

There are many formatting features in FCS Express to aid in the visual
assessment of a MultiCycle analysis of a DNA histogram. The different cell cycle
populations can be shaded in different ways and markers can be displayed
indicating the location of the mean of a specific population. In addition, the user
can zoom in on a specific area on the histogram for a more detailed view of the
analysis.

We will continue using the layout from the previous section to format the
Multicycle plot.

1. Click inside the MultiCycle plot to select it.

2294
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2. Choose the Overlays category in the Formatting dialog.

3. Select 4 - Diploid G1 from the Overlays List (Figure T21.21, blue
highlighted text).

4. Select the solid fill pattern(first option) from the Fill Style drop-down list
(Figure T21.21, red outline).
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Figure T21.21  Formatting Overlays Multicycle DNA Plot

The Multicycle plot will update to reflect the changes (Figure T21.22).
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Figure T21.22  MultiCycle DNA Histogram Updated with Solid
Fill on the Diploid Peak

We now will add a marker on the histogram to indicate the location of the
aneuploid G2 peak.

5. Click the Multicycle plot to select it if necessary.

6. Select Position Markers category in the Formatting dialog.

7. Multiple select A1 Mean and A2 Mean from the Position Markers list
(Figure T21.23, blue highlighted text).

8. Check the box next to Show position marker on the plot under
Position Marker Options (Figure T21.23, red outline).  The plot will
update automatically to show the two markers.
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Figure T21.23  Adding Position Markers to Multicycle Plot

Alternatively, the DNA Position Markers can be accessed from right-click pop up
menu to select or deselect them individually.

· Right-click inside the histogram to bring up the pop-up menu.

· Select to deselect it.
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Figure T21.24  Deselecting DNA Position Marker from the Popup
Menu

A vertical line marking the location of the mean of the aneuploid G2 peak
remains on the Multicycle plot (Figure T21.25).

Figure T21.25  MultiCycle Histogram Updated with a DNA Position Marker on the
Aneuploid G2 Mean

We will zoom into the Multicycle plot to more closely examine the aneuploid
population.
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9. Right-click inside the DNA histogram to bring up the pop-up menu.

10.Select Magnify (Axis) (Figure T21.26).

11. Place the cursor to the left of the aneuploid G1 peak on the DNA
histogram, shown by left arrow.

12. Press and hold the left mouse button and move the mouse to the right
while holding.

13. Release the left button when the right arrow is to the right of DNA
Position Marker (Figure T21.26, indicated by the crosshair cursor).

Figure T21.26  Selecting an Area on the X-axis to Zoom

The Multicycle plot updates to zoom in on the area of the x-axis drawn in the
previous steps (Figure T21.27).
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Figure T21.27  Multicycle Plot Zoomed along X-Axis

We now will change the y-axis scale on the histogram.

14. Click Multicycle plot to select it.

15. Choose the Axes category in the Formatting dialog.

15. Select Y-Axis (Figure T21.28, ).

16. Uncheck the box next to Automatic under the Range subcategory

(Figure T21.28, ).

17. Enter "300" in the Maximum field under the Range subcategory (Figure

T21.28, ).
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Figure T21.28  Formatting Axes Dialog

The MultiCycle plot updates with the new y-axis scaling (Figure T21.29).
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Figure T21.29  MultiCycle Plot with Rescaled Y-Axis

Next, we will perform MultiCycle analysis of 3 cycle data .

22.21.4 Analysis of 3 Cycle Data

Analysis of DNA histogram containing multiple cycling populations requires the
advanced Multicycle version, which must be purchased separately. We will begin
by opening a new blank layout page and inserting a Multicycle DNA plot to view
multiple cycles within the data.

1. Select File tab .

2. Select the Insert tab group command.

3. Click on a white, blank area of the layout.

The Select data file dialog appears, previously shown in Figure T21.1 .

4. Navigate to the Tutorial Sample Data  directory.

5. Select the file ASCII4.fcs.

6. Click Open.

The Multicycle DNA plot now appears (Figure T21.30). Note the two aneuploid
populations, shown in blue and green, comprise the majority of this histogram.

2303

2274

1682



FCS Express 7 Manual2304

© 2023 De Novo Software

Figure T21.30  MultiCycle DNA Histogram with Two Aneuploid Populations

You could insert the DNA Cycle, DNA Model Summary, and DNA Experiment
Statistics windows as previously shown to further study this histogram.
However, it is apparent that this DNA histogram has multiple cycling populations,
which MultiCycle appears to have identified correctly. 

We now will look at a histogram that is more difficult to analyze. Due to the
aneuploid populations overlapping, the Autofit function of MultiCycle does not
correctly identify the two aneuploid populations, requiring us to use manual
settings. We will begin by inserting a histogram.

7. Select the Insert tab command.

8. Click on a blank area of the layout.

A histogram of the current data file appears  on the layout.  We will now
change the data in the plot.

9. Right-click the histogram and select Change file.

10. Select the file ASCII8.fcs from the Select a Data File dialog which
appears.

11. Click Open.

The histogram changes to display the ASCII8.fcs data file (Figure T21.31). Note
there is an aneuploid peak (Figure 21.31, red circle). However, upon closer
examination, it appears there may be two aneuploid peaks with very similar
amounts of DNA. We will use the Autofit function of MultiCycle to analyze this
DNA histogram and show that it does not yield correct results in this case.

368
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Figure T21.31  ASCII8.fcs Histogram

12. Select the Insert tab command (Figure
T21.4 ).

13. Click on a blank area of the layout.

The Multicycle DNA plot now appears as shown in Figure T21.32. The Autofit
function of MultiCycle has analyzed this histogram using a two cycle model,
thereby assuming there is one aneuploid population, shown in blue. We will now
use Multicycle to analyze the DNA histogram without using Autofit.

Figure T21.32 Autofit MultiCycle Analysis of ASCII8.fcs

2275
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14. Double-click the Multicycle plot. The Formatting dialog will appear,
docked to the right.

15. Select the DNA Fit category.

16. Uncheck the box next to Detect fit type automatically (Figure T21.33,

). This turns off Autofit.

17.Select 3 Cycle from the Fit Type drop-down list (Figure T21.33, ).

18. Check the box next to Diploid CV = Aneuploid CV (Figure T21.33, ).
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Figure T121.33  Formatting Fit Model Options
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We have turned off Autofit and updated Multicycle to apply a 3 Cycle model. We
also have specified the additional constraint on the model that the CV of the
diploid peak should equal the CV of the aneuploid peaks. The Multicycle analysis
using the manual fit options appears below (Figure T21.34). 

Alternatively, you can turn off Autofit and specify a 3 Cycle model from the
Multicycle tab:

· Click the Multicycle plot to select it.

· Click the Multicycle tab group command to

turn off Autofit.

· Click Multicycle tab group  option from the

Cycle drop-down list.

Figure T21.34  Manual MultiCycle Fit

22.22 Proliferation

One of the most common methods used to study cell proliferation  induced by
different treatments is the dye dilution technique. In this technique, the cells of
interest (usually T-cells) are labeled uniformly with tracking dyes such as CFSE or
the CellTrace and PKH series of dyes. With each generation, the dye content of
the cells decreases by half as the dye is equally divided among the daughter cells.
Thus, as time progresses, cell populations that have divided can be identified by
their characteristic distribution of peaks with diminished fluorescence as
compared to the undivided control. The proliferation module in FCS Express
performs sophisticated curve fitting in order to quantify the proliferation
characteristics of your population. This allows for the easy determination of the
proportion of cells that proliferated, as well as other derived statistics.

171
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In this tutorial, we will learn how to apply such algorithms, create proliferation
statistics, format the plotted data, and generate publication quality reports in a
batch process.

Layout Design and Gating Strategy Notes:
     
The layouts for use in this tutorial are listed below can be found in the
Proliferation Tutorial folder within the Tutorial Sample Data folder.

· Proliferation Tutorial Fitting Proliferating Cells Section.fey

· Proliferation Tutorial Formatting Section.fey

· Proliferation Tutorial for Batch Processing.fey

The layouts have been optimized for ease of use while assuming that you are
familiar with the basics of data analysis in FCS Express. The samples for the data
set are listed below and were stained with SYTOX AADvanced (live/dead
marker), CD4 Alexa 488, and CellTrace Violet (proliferation dye).

· Unstained Control.fcs

· 10 uM CellTrace Violet Control.fcs 

· 10 uM CellTrace Violet Stimulated Control.fcs 

· 10 uM CellTrace Violet Stimulated Sample.fcs 

     In the Gating page of the layouts, the top two plots define the live cells in the
assay using a hierarchy of gates from the SSC-H, FSC-H, and SYTOX
AADvanced-H parameters. The plots in the middle row of the Gating page are an
inverse greyscale density plot (left) and a color dot plot (right). These plots are
used to help visualize generational data and are useful for further downstream
analysis of the proliferation data. The final plots for the analysis are two
histograms of the CellTrace Violet-H parameter:  one which contains a marker
that is linked to the Non Proliferating Control gate (M1) and is labeled
Proliferation Histogram in the title;  the other, "Background Noise Histogram,"
contains a marker for Background Noise. (Note: The Background Noise
histogram is only visible in the Proliferation Tutorial Fitting Proliferating Cell.fey
while in the other layouts it can be found on a hidden page ). The Proliferation
Data page contains a pre-inserted proliferation plot of the data. The Proliferation
Tutorial for Batch Processing.fey layout has completed all of the steps from the
first three sections of the proliferation tutorial so you may proceed directly to
batch processing the data.

We will begin by learning how to insert a proliferation plot and how to convert a
histogram to a proliferation plot .

98

2310
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22.22.1 Inserting Proliferation Plots

A proliferation plot can be created just like any other plot in FCS Express, and
regular histograms  can easily be changed to a proliferation plot. 

In the course of this section, we will:

· Insert a new proliferation plot 

· Change a histogram to a proliferation plot

1.  Open the "Proliferation Tutorial Fitting Proliferation Cells Section.fey"
layout in the Proliferation Tutorial subfolder within the Tutorial Sample
Data  folder.

2.  Click the Proliferation Data page tab in the lower left of layout.

3.  Click the Insert Tab group  command (Figure
T22.1).

Figure T22.1  Inserting a Proliferation Plot

4.  Click below the existing proliferation plot to insert the new one. The new
plot will resemble Figure T22.2a, and we must change the X Axis
parameter and gate applied to display the data correctly.

1698
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Figure T22.2a  Proliferation Plot
before Formatting the X Axis

Parameter and Applying the Sytox
Gate

Figure T22.2b  Proliferation Plot after
Formatting the X Axis Parameter and

Applying the Sytox Gate

5.  Double-click the newly inserted proliferation plot.  The Formatting dialog
will appear, docked to the right (Figure T22.3).

6.  Select the Overlays category.

7.  Change the X Parameter drop-down list to CellTrace Violet-H VL1-H

(Figure T22.3, ).

8.  Change the Gate to Sytox Live Cells Gate (Figure T22.3, ).
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Figure T22.3  Formatting Overlay Options for Proliferation Plot
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The proliferation plot for the sample is now present on the page and has been
formatted to display the correct parameter, gate, and scaling (Figure T22.2b
above).

We will change the histogram on the Gating page to a proliferation plot.

9.  Click the Gating page tab at the bottom of the program to make the
Gating page visible.

10. Click on the histogram labeled Proliferation Histogram in the title, located
towards the bottom of the Gating page, to select it.

11. Click the Format tab  drop-
down  command (Figure T22.4, red arrow).

                                          

Figure T22.4 Changing
plot type from a
histogram to a

proliferation plot.

   
You may notice the histogram changed instantly to a proliferation plot and is
ready for analysis.
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Please close the layout without saving changes before proceeding to the next
section. In the next section , we will learn how to modify the default fit for use
with the data.

22.22.1.
1

Formatting a Proliferation Histogram

In the course of this section, we will :

· Learn how to adjust the proliferation overlays to better visualize the

populations of interest.

· Learn how to produce the curve fitting statistics.

· Learn how to smooth the proliferation histogram.

· Learn how to use a batch process for analyzing multiple proliferation

samples.

1. Open the "Proliferation Tutorial Formatting Section.fey" layout in the
Proliferation Tutorial folder within the Tutorial Sample Data  folder.

2. Click on the "Proliferation Data" page tab.

3. Double-click the proliferation plot. The Formatting dialog will appear,
docked to the right (Figure T22.11).

4. Select 3 - Noise from the Overlay List (Figure T22.11, blue highlighted
text).

5. Uncheck the box next to Visible (Figure T22.11, red outline).

2323
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Figure T22.11  Removing Noise Overlay from Proliferation Plot
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6. Select 10 - Generation 6 from the Overlay List (Figure T22.12, ).

7. For the Fill Style drop-down, select the first option for a completely filled

rectangle (Fig. T22.12, ).

8. Change the Color to Blue (Figure. T22.12, )
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Figure T22.12  Changing Fill Style and Line Color for Generation 6 in Proliferation
Plot
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9. Select the 12 - Generation 8 from the Overlay List (Figure T22.13, ).

10. For the Fill Style drop-down, select the first option for a completely filled

rectangle (Figure T22.13, ).
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Figure T22.13  Changing Fill Style for Generation 8 in Proliferation Plot
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The proliferation histogram now appears without displaying the noise, with the
peak corresponding to generation 6 filled in blue, and the peak corresponding to
generation 8 filled in green (Figure T22.14). This allows for easier confirmation
and visualization of each generation and fitted peak. You can change the
formatting of any and all of the different fitted elements and overlays in this
way. 

Figure T22.14  Proliferation Plot after Removing
Noise and Changing Fill Style and Color for Two

Generations in Overlays

Both the RMS error and R-Chi Square are measures of the goodness of the fit.
When setting the proliferation model fit parameters, it is important to check how
changing these parameters affect these two statistics. The combination of
settings that provides the least RMS error and R-Chi Square is mathematically
the best fit. We will now show the associated statistics for this proliferation
model.

12. Right-click the proliferation plot.

13. Select  from the popup menu.

The Proliferation Fit Statistics window will now appear.

14.  Right-click the proliferation plot.

15.  Select .

The Proliferation Population Statistics window will now appear.

16.  Move both statistic tables so that the proliferation histogram and tables
are all visible as in Figure T22.15.
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Figure T22.15  Proliferation Histogram with the Proliferation Fit
Statistics and Proliferation Population Statistics

We now will smooth the proliferation histogram.

19. Click the proliferation plot to select it.

20. In Formatting dialog, select 1 - 10um CellTrace Violet Stimulated
Control.fcs from the Overlay List.

21. Increase the Smoothing to 6.

The Proliferation histogram and associated statistics are updated immediately to
reflect the smoothing (Figure T22.16). The black contour of the raw data is
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much smoother, but the fit changes significantly (note that the proliferation fit
and proliferation population statistics have changed). Although this provides for a
nicer visual presentation, this option should be used with caution since it affects
the statistics obtained when using the raw data, and can thus affect the
interpretation of the data.  Note that the R-Chi Square  value has increased
from 4.82 to 17.76 as a result of smoothing the raw data, indicating an inferior
fit.  Thus it is advisable to cull statistics from an unsmoothed (raw) proliferation
plot, while applying smoothing to a duplicate Proliferation plot or regular
histogram for visual presentation only, if desired. 

Figure T22.16  Proliferation Histogram and Associated Statistics with
Smoothing
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Now, we have formatted our plots for the experiment and inserted proliferation
statistics, so we will create a batch process  in the next section  to
summarize the three-sample experiment.

22.22.1.1.1  Fitting Proliferating Cells

In the course of this tutorial, we will: 

· Learn how the curve fitting algorithm and parameters are fitted to a

histogram.

· Use tokens to define a Fixed Starting Generation and Background.

· Insert proliferation position markers.

We will begin by navigating through the data to get an idea of what the
experiment looks like and what the color coded overlays represent.

1.  Open the "Proliferation Tutorial Fitting Proliferating Cells Section.fey"
layout in the Proliferation Tutorial folder within theTutorial Sample Data
folder.

2.  Navigate to the Proliferation Data page tab.

You will notice a proliferation plot on the Proliferation Data page tab for the 10
uM CellTrace Violet Stimulated Control.fcs sample (Figure T22.17a). This is the
curve fitting result on the positive control, proliferating cells. There are four
samples in the Data List. 

We will switch to our control sample in which cells are not proliferating. 

3.  Select the Data tab group command to

load the previous file in the Data List, such as 10 uM CellTrace Violet

Control.fcs (Figure T22.17b).

Notice that the 10 uM CellTrace Violet Control.fcs file represents the stained yet

undivided control sample and can serve as our starting generation peak.

We will switch to our Stimulated Sample.

4.  Select the Data tab group command to

advance two files to 10 uM CellTrace Violet Stimulated Sample.fcs

(Figure T22.17c)

768 2332

1682



FCS Express 7 Manual2324

© 2023 De Novo Software

Notice that the 10 uM CellTrace Violet Stimulated Sample.fcs file represents

our stimulated (dividing) sample in which we would like to measure the degree

of proliferation.

We now will switch to our final Unstained Control sample.

5.  Select the Data tab command to the end of

the Data List to Unstained Control.fcs (Figure T22.17d).

Notice that the Unstained Control.fcs file represents the sample as it appears
without any proliferation staining and can serve as our background noise peak.
Please note FCS Express is fitting the background peak as it was a population of
proliferating cells. We will modify the fitting parameters later to define how to
treat these as background.

Figure T22.17a  Proliferation
Positive Control Figure T22.17b  Proliferation Negative

Control

Figure T22.17c  Proliferation
Stimulated Sample Figure T22.17d  Proliferation Unstained

Control

You will notice many different color overlays on the different proliferation
samples. The default colors for the proliferation curve fitting are as follows:



Tutorials 2325

© 2023 De Novo Software

Black – Raw histogram contour. This includes all the data and does not
represent an output of the fitting algorithm and would be the same histogram
you would see if you plotted the data on a regular histogram.

Red – Overall contour of the fitted data. This excludes what the algorithm
determines to be noise.

Light blue – Noise. This is the data that the algorithm determines to be noise,
and is not included in the statistics.

Green – Modeled populations of proliferating cells. These are the actual curves
fitted to the data, representing the parent, undivided population, and all of the
proliferating generations. 

Note that there are cells in the proliferation stimulated sample (Figure T22.17c)
in the 106 to 107 range, shown in light blue, that have been determined by the
model to be noise. We will now modify the Proliferation Fit Parameters to see
if we can improve the model's fit by specifying where the starting generation is
located. Notice on the Gating page there is a histogram with the marker M1
visible. M1 defines the starting generation based on the negative control and we
will use a token representing the geometric mean of the data under the marker
to define our starting generation more accurately.  

6.  Change the data using the Data tab
group  commands until you display the 10 uM CellTrace
Violet Stimulated Control.fcs sample. 

7.  Double-click the proliferation plot.

The Formatting dialog now appears (Figure T22.18).

9. Choose Proliferation Fit category (Figure T22.18).

10. Check the Use Fixed Starting Generation check box (Figure T22.18, 
). 

11. Delete the numbers in the edit field for the Use Fixed Starting

Generation option (Figure T22.8, ).  With the empty field, a warning will
appear at the bottom of the Formatting dialog, this (nothing) is not a
valid number (Figure T22.18, red outline). 

12. Click on the  token symbol next to the text box (Figure T22.18, ).
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Figure T22.18  Formatting Proliferation Fit Options

The Insert a Token dialog will appear.

13. Double-click Statistic from the Insert a Token dialog.

14. Choose Plot 4 - Histogram - 10 um CellTrace Violet Stimulated
Control.fcs [...] from the Select a Plot subcategory under the Data

Source category (Figure T22.19, ).

15. Click the Statistic category on the left (Figure T22.19, ).

16. Choose M1 from Plot Information - Select a marker list box (Figure

T22.19, ).

17. Select Geometric Mean from the Statistic list box(Figure T22.19, ).
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18. Click OK (Figure T22.19, ).
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Figure T22.19  Defining Data Source and Statistic for Starting Generation Used in
Proliferation Plot



Tutorials 2329

© 2023 De Novo Software

19. Select the Position Markers category in the Formatting dialog (Figure
T22.20).

20. Check the box next to Show position marker on the plot with
Undivided cells peak highlighted in blue (Figure T22.20, red outline).

Figure T22.20  Showing Position Marker for Undivided Cells Peak on Proliferation
Plot

The proliferation histogram should resemble Figure T22.21.  
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Figure T22.21  Proliferation Plot Using Defined
Starting Generation and Showing Position Marker

for Undivided Cells Peak

Notice on the Gating page there is a histogram labeled "Background Noise" with
a marker of the same name. The area under this marker has been defined as the
background noise based on the Unstained Control.fcs sample which is being
displayed in the histogram. We will now use steps similar to those above for
defining a starting generation to define the background noise.

21.  Go to the Proliferation Fit category in the Formatting dialog.

22. Check the Use Background Noise check box. 

23. Delete the numbers in the white text box next to the Use Background

Noise option.

24. Click on the  token symbol next to the edit field for Use Background

Noise.

The Insert a Token dialog will appear.

25. Double-click Statistic from the Insert a Token dialog.

26. Choose 30 - Histogram - 10uM CellTrace Violet Stimulated

Control.fcs [...] from the Select a Plot subcategory under the Data

Source category.

27. Click the Statistic category in the left pane.

28. Choose Background Noise for Plot Information - Select a marker list

box.

29. Select Geometric Mean from the Statistic list.
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30. Click OK.

31. Select Position Markers category in the Formatting dialog.

32. Click Background in Position Markers list box.

33. Check the box next to Show position marker on the plot while

Background is highlighted in blue. 

The proliferation histogram should now look like Figure T22.22a with the Starting
Generation and Background noise based on the markers from the histogram in
Figure T22.22b.

Figure T22.22a  Proliferation Plot with
Background Noise Position and Starting

Generation Markers Defined

Figure T22.22b Histogram with Marker Used
to Define Background on Proliferation Plot

Now, the fit is better since the starting generation and background noise (now
indicated by the green vertical lines on the right and left respectively) are based
on cells that fall within the Sytox Live Cells gate in M1 or the Background Noise
marker. Notice how the red, fitted contour, more closely follows the black, raw
data contour towards the high end of the data; the R-Chi Square value  is also
lower. Although the fit is better for the high end of the data you can see for most
of the curve it has changed very little. That is because the curve fitting algorithm
correctly found a good approximation of the starting generation before adding
the more correct token value for the starting generation. Nevertheless, in some
cases, it is important to manually set the starting generation and background
from control samples. On the other hand, sometimes in proliferation
experiments, the control sample can have a slightly different peak fluorescence
value than the undivided cells from the experimental samples. These differences
can be enough to preclude the use of control histograms to set the position of
the undivided cells. 

You may notice if you adjust the markers' widths or positions, the proliferation
plot fit will update in real-time since the starting generation and background noise
are now based on the statistics for the geometric mean under the M1 and
Background noise markers. For a description of how the fit is being calculated
please see the technical note below. 
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Technical Note: This is a brief technical note to describe how the fitting
process works. This information is to help you have an understanding of how
adjusting the parameters affects your data. If you wish to skip this, you may
do so.

· The fitting process starts by determining where the population of cells

that have not divided is located. The fitting process attempts to find this
peak automatically, although you can specify it manually, as described
above. In some cases, you have to specify it manually because your cell
population may no longer include cells that have not divided.

· Once the undivided population is found, the model attempts to find

populations that have decreased in fluorescence by 50% from each
other. Since not all experiments work according to theory, the model
starts looking at the 50% point but can move left or right to find the
true peak. You can control this by selecting the Same Peak Ratio for
All Peaks option (Figure T20.6).

· In order to find a peak, the model makes certain assumptions about the

width of each peak compared to the undivided control. You can also
control these settings, selecting or deselecting the Same CV for All 
Peaks option, as shown above (Figure T20.6).

· The model can also subtract background fluorescence from all the

calculations, if you provide a value for the background fluorescence.
· Since the algorithm uses the actual histogram contour to model the fit,

the histogram data should not be smoothed. Only in special cases,
when the original data is very noisy, should a little smoothing be applied
to allow the model to better fit the data.

· These options exist in order to accommodate the wide range of data

sources and biological behaviors that the model has to encompass.
Thus, in order to obtain the best fit, it is important that the correct initial
settings be selected. In practice, this is usually performed by trial and
error until the settings providing the best fit are found.

· There are two ways to assess the goodness of the fit; the first is visual

inspection, which gives a rough measure, and the second is fit statistics,
which are discussed here .

22.22.2 Batch Processing Proliferation Data

In the previous sections, we have inserted proliferation plots , optimized the
proliferation fit , formatted the proliferation plot , and inserted proliferation fit
and population statistics . We will use the "Proliferation Tutorial for Batch
Processing.fey" layout, which incorporates all of the steps from the previous
three sections to allow us focus on the batch process.

177
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1.  Open the "Proliferation Tutorial for Batch Process.fey" layout from the

Proliferation Tutorial subfolder in the Tutorial Sample Data  folder.

2.  Click on the Batch tab Batch Processing group Batch Actions

command.

The Batch Actions window will open.

3.  Click on Save to PowerPoint in the Add Action category.

The Create Export To PowerPoint Action dialog will open (Figure T22.23).

4.  Check box next to Open presentation after saving under PowerPoint

Options (Figure T22.23, ).

5.  Click the folder icon  next to the edit field for Save to a new file: under

the Output file options category (Figure T22.23, ).

1682



FCS Express 7 Manual2334

© 2023 De Novo Software

Figure T22.23  Editing the Options for Create Export to Powerpoint Action
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6.  Choose a location and a file name for the PowerPoint file to be created.

7.  Click Save to close Save As dialog.

8.  Click OK to close the Create Export to PowerPoint Action dialog.

9.  Click the Export to Excel (Column Mode) in the Add Report category in

the Batch Actions window.

The Excel (Column Mode) Options dialog will open, which will be similar, but

not identical, to Figure T22.23.

10. Click the folder icon  next to the edit field for Save to a new file: under

the Output file options category.

11. Choose a location and a file name for the Excel file that will be created.

12. Click Save to close Save As dialog.

13. Click OK to close Export (Column Mode) Options dialog. 

14. Drag the text box containing the Sample ID from the top of the Gating

page by clicking its border and drop it on top of the Excel (Column Mode)

text in the Batch Process Actions window (Figure T22.24).

Figure T22.24  Dragging and Dropping Text Box with Sample ID to Excel (Column
Mode) Batch Action

 

15. Select all the statistics in the Proliferation Fit Statistics Table, so they

appear highlighted in blue. Click inside table and key CTRL+A.

16. Click a single blue-highlighted cell of statistics table; drag and drop on top

of the Excel (Column Mode) icon in the Batch Process Actions window

(Fig. T22.25).
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Figure T22.25  Dragging and Dropping the Proliferation Fit Statistics Table to the
Excel (Column Mode) Batch Action

Dragging and dropping the sample ID text box and table data to the Batch

Process Actions window Excel (Column Mode) icon has added the sample ID

and all of the statistics from the table to the excel report.

17. Click the Batch tab Batch Processing Run button to begin the batch
process.

The batch process will proceed through the four data files in the data list and

generate an 8-slide PowerPoint file, which will include two slides per sample, and

an Excel document, which will have four rows of data - one row with columns

showing the Sample ID and statistics per sample. 

22.23 Kinetics

Many flow cytometers are capable of recording a time parameter in the .fcs file,
allowing for kinetics experiments to be performed. Kinetics experiments are
particularly useful for examining changes in DNA content, antibody binding, and
calcium flux over time. By adding a compound (usually a drug) to a sample and
monitoring influx, efflux, or binding of your probe over time, unique information
can be gathered. FCS Express offers the capability to display and analyze kinetics
data in an easy and user friendly manner while updating your plots as your
analysis changes.

In the course of this tutorial we will show how to:

· Create parameter math formulas to view ratios between two parameters.

· Create gates and display statistics for Kinetics Plots.

· Plot Mean, Geometric Mean, Median, % Above Threshold, and Count. 

· Overlay multiple Kinetics Plots.
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· Format a Kinetics Plot to view the data at the correct resolution.

In the first exercise, we will create parameter math formulas for use in kinetics
plots .

22.23.1 Using Parameter Math

Often, it is useful to define a ratio when examining kinetics data. This can be a
ratio of two different dyes or the ratio of the same dye in two different emission
wavelengths. The parameter math feature of FCS Express allows the user to
define mathematical operations from simple ratios to complex formulas. Unlike
some other software programs, FCS Express will calculate and display the actual
ratio values rather than an arbitrarily scaled multiplied integer.

In this section, you will learn how to create parameter math formulas for use in
Kinetics Plots. 

Although any kinetics data files of your own can be used to follow along in this
tutorial, you have the option of using the same sample data files used in this
tutorial. The sample data files are located in the  Tutorial Sample Data archive .
The KineticsTutorial.fey,  kinetics10.010, and kinetics25.025 data files have
been embedded and will be used here.

1.  Select File tab .

2.  Select the "KineticsTutorial.fey" layout file located in the Tutorial Sample
Data  folder.

In the KineticsTutorial. fey layout, the two samples (kinetics10.010 and
kinetics25.025) are displayed in kinetics plot .

The following steps open the transformation window and create a new
Parameter Math transformation:

3.  Open the Transformation window by selecting the Tools
tab group Transformations command (Figure T23.1,

). 

4.  Click on the down arrow adjacent to the blue plus  button in the

Transformations dialog (Figure T23.1, ).

5.  Click on Parameter Math in the drop-down list (Figure T23.1, ).
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Figure T23.1  Selecting the Parameter Math Transformation

A New Parameter Math transformation is created and listed in the upper part of
the Transformation Window. The Parameter Math dialog now appears in the
lower part of the Transformation window as seen in Figure T23.2. Note that the
kinetics10.010 sample has been automatically selected as template file in this

example. However, this can be changed by clicking the ellipsis icon  to the
right of the Template File field.

6.  Click New button in the Parameter Math dialog to define a new formula
(Figure T23.2, red outline). 
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T23.2  Creating Parameter Math in Transformations Dialog

A Create New Sequence Item window will appear (Figure T23.3).

7.  Enter Ca++ Ratio in the Output Parameter Name box (Figure T23.3,

).

8.  Change the First Input Parameter to Fluo 3 (Figure T23.3, ).

9.  Change the mathematics operator to "/" for division (Figure T23.3, ).

10. Change the Second Input Parameter to Fura Red (Figure T23.3, ).

11. Click OK (Figure T23.3, ).
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Figure T23.3  Defining a Parameter Math Sequence Item Formula

The Parameter Math dialog in the Transformation window now displays the

formula sequence we defined (Figure T23.4). Please note, although in this

example the New Parameter Math transformation contains only the Ca++

Ratio formula, a Parameter Math transformation can contain more than one

formula.
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Figure T23.4  Parameter Math Sequence Dialog with
Formula Displayed

The Parameter Math transformation has been defined and now can be applied to

plots for display and analysis. 

We now will apply the New Parameter Math transformation (containing the

Ca++ Ratio formula) to the histograms displayed in the layout.

Please note that the New Parameter Math transformation has been created

using the kinetics10.010 sample as Template File. Since the kinetics25.025

data file has the exact same parameters in the same exact order, we can apply

the New Parameter Math transformation to this sample as well.



FCS Express 7 Manual2342

© 2023 De Novo Software

10. Click the New Parameter Math text in the Transformation window and
hold mouse button down.

11. While holding mouse button down, drag the New Parameter Math
transformation out of the Transformation window and release button
when on top of each of the 1D plot (Figure T23.5).

12. Release mouse button when plot has light blue outline.

Figure T23.5  Applying the Parameter Math for Ca++ Ratio to Plots by Drag and
Drop

The two 1D plots should resemble Figure T23.6. Note the suffix Parameter
Math applied was added automatically to the plots' titles.
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Figure T23.6  Kinetics Plots after Applying New Parameter Transformation for
Ca++ Ratio

The newly-calculated Ca++ Ratio parameter can be accessed as a standard
parameter from the axis labels.

We now will display the Ca++ Ratio parameter on the y-axis of both 1D plots
simultaneously via the formatting windows.

13. Key Ctrl+A to select all plots.

14. Choose the Format tab group  command.

15. Change the Y Parameter to Ca++ Ratio, the new parameter created in
steps above, in the drop-down list (Figure T23.7)
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Figure T23.7  Changing the Y Axis to the Ca++ Ratio Defined by the Parameter
Math
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The plots on the layout should resemble Figure T23.8. Since the first parameter

of the parameter math calculation was a logarithmic parameter, FCS Express

assumed the new parameter should be a log parameter as well. While this is

typically as-expected, it is not correct in this scenario. Since the plots display the

real ratio value, we will have to adjust the axis settings to display the data on a

linear scale.

Figure T23.8  Ca++ Ratio vs Time

16. Key Ctrl+A to select all plots.

17. Choose Axes category in the Formatting dialog (Figure T23.9).

18. Under the Select Axis section, confirm Y Axis is selected (Figure T23.9,

).

19. Under the Scale section, uncheck the box next to Automatic (Figure

T23.9, ).

20. Change the Scale to Linear (Figure T23.9, ).

21. Under the Range section, uncheck the box next to Automatic (Figure

T23.9, ).

22. For Minimum, enter 0 (Figure T23.9, ).

23. For Maximum, enter 1 (Figure T23.9, ).
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Figure T23.9  Formatting Axes Dialog

The plots should resemble Figure T23.10.
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Figure T23.10  Plots Scaled Correctly to Display the Ca++ Ratio

In the next section, we will apply gating and statistics to kinetics plots .

22.23.2 Applying Gating and Statistics

In this section, you will learn how to apply a gate to a kinetics plot and view
kinetics statistics for the gate.

Although any kinetics data files of your own can be used to follow along, you
have the option of using the same sample data files used in this tutorial. The
sample data files are located in the  Tutorial Sample Data archive . The
KineticsTutorial.fey, kinetics10.010, and kinetics25.025 data files will be
used here. Please complete the steps in the Using Parameter Math  section
before beginning.

1.  Choose the Gating tab group  command(Figure
T23.11).

Figure T23.11  Creating a Marker

2.  Create a 1D (marker) gate on sample kinetics25.025, similar to the one
in Figure T23.12, so its left boundary defines the baseline and its right
boundary is after the peak has subsided.
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3.  Enter "Marker Gate 1" in the Create a new gate named edit field in the
Create New Gate dialog.

4.  Click OK to accept.

5.  Choose the Gating tab group  command.

6.  Create a 1D (marker) gate on sample kinetics10.010, similar to the one
in Figure T23.12, so its left boundary defines the baseline and its right
boundary is after the peak has subsided.

7.  Enter "Marker Gate 2" in the Create a new gate named edit field in the
Create New Gate dialog.

8.  Click OK.

Figure T23.12  Kinetics Plots with 1D Gates Applied

9.  Right-click the kinetics25.025 plot.

10. Choose . 

A Kinetics Statistics window will appear on the layout.

11. Move the Kinetics Statistics window to a convenient position on the
layout.

12. Right-click the kinetics10.010 plot.

13. Choose .  

A Kinetics Statistics window will appear on the layout.
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14. Move the Kinetics Statistics window to a convenient position on the
layout.

The layout should resemble Figure T23.13. 

Figure T23.13  Plots with Kinetics Statistics Windows

By right-clicking the Kinetics Statistics window, you may choose to view up to
14 different kinetics statistics (Figure T23.14). These values will change
dynamically gate adjustments or changes in data displayed.
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Figure T23.14  Kinetics
Statistics Right-Click Popup

Menu

Next, we will explore different plotting values .

22.23.3 Plotting Values

The default parameter for plotting kinetics data is Median, but often times it is
useful to look at other values such as Mean, Geometric Mean, Count, and
percentage of events above a threshold. In this section, you will learn how to
change these plotting values and define a threshold based on gates/tokens.

The sample data files for this section are located in the  Tutorial Sample Data
archive . The KineticsTutorialParameterSection.fey layout will be used here.
The layout is embedded with the kinetics10.010, and kinetics25.025 sample
data, and has a Ca++ Ratio parameter math formula applied.

1. Double-Click the kinetics10.010 plot.  The Formatting dialog appears,
so reposition it to see both plots.

2. Select the Overlays category.
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3. Change the Plotting Value from Median to Mean (Figure T23.15, red
arrow).
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Figure T23.15  Changing the Plotting Value
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The plot will change to display the Mean Ca++ Ratio on the Y-Axis. 

4. Change the Plotting value to Count.

Steps 3 and 4 may be repeated to view any of the plotting values.

Selecting Count will plot the number of events acquired per unit time. This is very
useful to ensure that the event rate over time is consistent for quality control.
Notice how there are many peaks and valleys due to low cell numbers. We will
change the resolution to view the #Events/Time at the appropriate resolution.

5.  Choose the  Specific Options category in the Formatting dialog.

6.  Change the Plot Resolution to 32x32 from the Resolution drop-down
list.

7. Select the Overlays category.

The plot should resemble Figure T23.16. Count vs. Time is a useful way to view
the flow rate of your sample (it can reveal when a sample was removed or
placed on the instrument, or if the flow rate decreased or increased for any
reason). Note the large valley during the beginning of acquisition in this example
when the sample was removed to add a drug.

Figure T23.16  Kinetics Plot Displaying
Count vs. Time

We now will assign a threshold to view % Above Threshold as a plotting value
on a new page and plot.

8.  Choose % Above Threshold from the page tabs.
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You will see a Kinetics Plot and a Density Plot for kinetics10.010 with gates
applied to the Density Plot (Figure T23.17). The gates are applied such that the
Baseline Gate encompasses events before addition of a drug. Statistics derived
from the gate will serve as baseline values for plotting % Above Threshold. The
Post Treatment Gate includes events after the addition of a drug. We will plot
the percentage of cells within this gate that responded with a fluorescence signal
above the baseline.

Figure T23.17  Kinetics and Density Plots with Thresholding Gates Applied

9.  Click the Kinetics Plot on the left to select it.

10. Choose the Overlays category.

11. Select "Post Treatment Gate" from the Gate drop-down list.

12. Choose % Above Threshold from the Plotting Values drop-down list.

13. Click on the Token Symbol  after the Threshold field.

14. Choose "Y Median + 2 * SD" from Custom in the Insert a Token
dialog (Figure T23.18). (The Y Median + 2* SD custom token represents
the Y median of the baseline gate plus two standard deviations of the Y
median in the baseline gate.)
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Figure T23.18  Choosing a Custom Token as a Threshold
Value

The plots in the layout should now look like Figure T23.19. The kinetics plot on
the left is displaying the percentage of events in the Post Treatment Gate that
are above the Y-Median plus two standard deviations of the baseline gate for the
Ca++ Ratio parameter.
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Figure T23.19  Kinetics Plot Displayed as % Above Threshold

In the next exercise, we will overlay and format kinetics plots .

22.23.4 Overlay and Format Kinetics Plots

Often, it is useful to view many samples on the same plot to see sample
variation and to compare experimental samples against a control.  In this
tutorial, you will learn how to overlay multiple kinetics samples, apply parameter
math to the overlays, and format the overlays to make the data easier to view.

Although any kinetics data files of your own can be used to follow along, you
have the option of using the same sample data files used in this tutorial. The
sample data files are located in the Tutorial Sample Data archive . The
KineticsTutorialFormatting.fey,  kinetics8.008, kinetics9.009,
kinetics10.010, and kinetics25.025 data files will be used here.

1.  Select File tab .

2.  Select the KineticsTutorialFormatting.fey layout file located in the
Tutorial Sample Data directory. 

3. Load the data files when prompted by the Select the Data Directory
dialog.

The layout contains one kinetics plot displaying Time vs Fluo 3 for sample
kinetics25.025. We will now add the other three samples to the kinetics plot as
overlays.

4.  Ctrl+Click on samples kinetics8.008, kinetics9.009, and
kinetics10.010 to select them in the data list.
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5.  Click and hold the mouse button while hovering over file name of the files
in the Data List.  While holding mouse button down, drag from the data list
and drop onto the Kinetics plot.

6.  Release the mouse button to drop them on the plot.

7. Choose add the files to the plot as new overlays option in the Select
Drag and Drop Action dialog.

8. Click OK.

The four samples are displayed simultaneously in the kinetics plot. Though, the
Parameter Math transformation is not yet applied to the plot. We will now apply
the Parameter Math transformation to the plot via drag and drop.

The plot now contains overlays for all samples and should resemble T23.20.

Figure T23.20  Multiple Kinetics Overlays

We now will format the plot to make it more visually appealing. 

9. Click and hold the mouse button on the New Parameter Math
transformation from the Transformation window.

10.While holding mouse button, drag the New Parameter Math
transformation out of the Transformation window and drop it on top of 
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the kinetics plot (Figure T23.5 ). The Parameter Math applied suffix will
be added to the plot title as a confirmation of this action.

11. Change the Y-Axis parameter on the Kinetics Overlay plot to Ca++
Ratio.

12. Select the Live Cells gate from Gating tab
group drop-down list on ribbon.

13. Double-click the kinetics plot.  The Formatting dialog will appear, docked
to the right.

14. Choose the Overlays category.

15. Enter Ctrl+Click on all the overlays in the Overlays List.

16. Change  to 1.50.

17. Choose the Legend category.

18. Click on the Visible check box to select it.

19. Change the Position from Right to Bottom.

The plot should resemble Figure T23.21.

Figure T23.21  Kinetics Plots Formatted
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Finally, we will change the resolution of a kinetics plot .

22.23.5 Format to Change Resolution

Occasionally, your kinetics data files may not be displayed suitably with the
default settings from the preferences.  In this section, you will learn how to
adjust resolution to view your data correctly, and how to show the standard
deviation of your kinetics curves.

Although any kinetics data files of your own can be used to follow along, you
have the option of using the same sample data files used in this tutorial. The
sample data files are located in the Tutorial Sample Data archive . The
KineticsTutorialScaling.fey, kinetics10.010, and kinetics25.025 data files
will be used here.

1. Select File tab .

2. Select the KineticsTutorialScaling.fey layout file located in the FCS
Express Sample Data directory from the Load Layout dialog.

The layout should look like Figure T23.22 below. The red highlighting is showing
the standard deviation of the sample while the black line is displaying the Median
of Fluo 3. Sample kinetics10.010 is scaled correctly and is not showing
standard deviation. Notice how sample kinetics25.025 has a very jagged black
line and is displaying standard deviation. The jagged black line is occurring
because the resolution on the plot is set too high. We will now format the
kinetics25.025 plot to remove the standard deviation highlighting and adjust
resolution to display the plot correctly.

Figure T23.22  Kinetics Tutorial Layout After Adding Sample Data
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3. Double-click the kinetics25.025 plot.  The Formatting dialog will appear;
reposition it in order to see the plots.

4. Select the Overlays category.

5. Uncheck the box next to Show Standard Deviation (Figure T23.23, red
outline).
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Figure T23.23  Unchecking Show Standard Deviation
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The red standard deviation highlighting will now be removed as seen in Figure
T23.24.

Figure T23.24  Sample Plots with Standard
Deviation Highlighting Removed

We will now change the resolution of sample kinetics25.025 to display the plot
properly.

6.  Choose the Specific Options category in the Formatting dialog.

7.  Select the 64 x 64 resolution option from the Resolution drop-down list
for Plot Resolution. (Figure T23.25, red outline).
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Figure T23.25  Changing the Resolution on a Kinetics Plot
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The plot will updated and be scaled properly as seen in Figure T23.26, right.

Figure T23.26  Changing the Resolution: 256x256 (Left) to 64x64 (Right) 

After following the instructions above, the layout should resemble Figure T23.27.

Figure T23.27  Kinetics Plots Scaled Properly

We will now apply a gate and the standard deviation highlighting to both of the

plots. 

8.  Key Ctrl+A to select all plots.

9.  Choose the Overlays category in the Formatting dialog.
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10. Choose Gate 1 from the Gate drop-down.

11. Check the box next to Show Standard Deviation.

The layout should now resemble Figure T23.28.

Figure T23.28  Kinetics Plots with Standard Deviation Highlighting Applied

22.24 Cell Concentration

FCS Express can calculate the absolute concentration of the cells in a sample.
FCS Express does so by automatically calculating the volume of the sample that
was used during acquisition. The volume can be calculated by a) using beads that
were present in the sample tube at a known concentration, b) using the sample
flow rate and acquisition time, or c) using the volume keyword from FCS 3.1
files, or the equivalent in Amnis DAF files, if available. FCS Express can display the
concentration as a one time calculation, in a statistics table, or as a token.

The Cell Concentration tutorials are most effective when completed in order and
in entirety before moving to the next tutorial.

To begin, we will set up the bead gates .

22.24.1 Setting up the Bead Gates

In the course of this example, we will:

· Learn how to gate beads using hierarchical gating.

For more information about inserting a plot , see the tutorial on that subject.
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1. Open a new, blank layout.

2. Insert a forward (FSC-H) vs side scatter (SSC-H) dot plot  of the file
Monocytes.002 found in the Tutorial Sample Data  folder.

3. Create a polygonal gate around the monocytes, calling it Monocytes
(Figure T24.1).

4. Create a rectangular gate around the beads, calling it Beads1 (Figure
T24.1).

The gates should look similar to the ones shown in the plot on the left side of
Figure T24.1. For more information on creating gates, please refer to the Gating
tutorial .

5. Drag and drop the Beads1 gate outside of plot on blank, which space to
create a second dot plot. 

6. Change X- and Y-Axis to FL1-H vs SSC-H, respectively (Figure T24.1). 

7. Draw a new rectangular gate around the beads in the new plot, calling it
Beads2, as shown on the plot on the right side of Figure T24.1.

Figure T24.1  Gates for Monocytes and Beads

The Beads2 gate allows for added discrimination between the cells and the
beads. Depending on how well separated the beads are from your sample, you
can use an approach consisting of only one gate, but applying two gates
generally allows for cleaner isolation of the bead events to exclude doublets and
higher order aggregates.
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Note:  Please save this layout to your desktop if unable to complete the next
tutorial section.

In the next section, we will use the Concentration Calculator  tool.

22.24.2 Concentration Calculator (Beads)

In the course of this example, we will:

· Identify the variables needed for the concentration calculation.

· Set up the concentration calculator using beads.

· Obtain a one time result.

In order to calculate the concentration, we need the following four parameters:

A. The file to be analyzed.

B. The cells of interest.

C. The gate containing the beads that were added to the sample tube.

D. The concentration of the beads in the sample tube. 

Now, the gating strategy for the cells and beads is ready, we will proceed to do
the actual calculations. Note this and the following sections continue from steps
1 through 7 in the Setting up the Beads Gates chapter .

1. Select the Tools tab group
command (Figure T24.2, red outline).

Figure T24.2  Concentration Calculator Command

The Concentration Calculator dialog now appears as shown in Figure T24.3.

2. Select the File to analyze, in this case Monocytes.002, from the drop-

down list (Figure T24.3 ).

3. Select Monocytes as the Gate to analyze, from the drop-down list

(Figure T24.3, ).
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4. Select the Reference Beads radio button to specify the Volume

Calculation type (Figure T24.3, ). 

5. Select Beads2 for the Bead Gate (Figure T24.3, ).

6. Input the concentration of the beads in the sample tube. In this case we

will use a value of 100,000 beads/ml (Figure T24.3, ). 

7. Click the Calculate button.

In the Results section of the Concentration Calculator, the volume of the

sample analyzed appears in the Volume Analyzed (Figure T24.3, ) field and
the concentration of the cells in the Monocytes gate appears in the Sample

Concentration field (Figure T24.3, ).
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Figure T24.3  Concentration Calculator Dialog Using Beads

8. Click Cancel to close the Concentration Calculator dialog.
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Note:  The volume and concentration values may differ due to gate

placements.  Minor variances in the numerical values that are represented

in the tutorial images are expected. Please save this layout to your

desktop if unable to complete the next tutorial section.

In the next example, we will calculate the concentration using time and flow

rate .

22.24.3 Concentration Calculator (Time/Flow Rate)

In the course of this example, we will:

· Set up the concentration calculator using the time of acquisition and the

flow rate.

· Obtain a one time result.

(Note that the following sections build upon steps 1 through 7 in the Setting
up the Beads Gates chapter )

1. Select the  command.

The Concentration Calculator dialog appears again as shown in Figure T24.4.

2. Select the File to analyze, in this case Monocytes.002, from the drop-

down list (Figure T24.4, ).

3. Select Monocytes as the Gate to analyze, from the drop-down list

Figure T24.4, ).

4. Select the Time radio button to specify the Volume Calculation type

(Figure T24.4, ).

The start and end times embedded in the FCS data file appear by default, and the
Total Time is calculated automatically. You can change the start or end time
manually, or enter a specific Total Time directly.

5. Input the Flow Rate used when acquiring the sample. In this case, since
the data was collected on a cytometer that used a flow rate of 60 µ l/min,

we will use a value of 0.06 mL/min (Figure T24.4, ).

6. Click the Calculate button. 

The Results section now displays the volume of the sample (Figure T24.4, )

analyzed and the concentration of cells in the Monocytes gate (Figure T24.4, 
).
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Figure T24.4  Concentration Calculator Dialog Using Time and Flow
Rate

7. Click Cancel to close the Concentration Calculator dialog.
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Note:  The volume and concentration values may differ due to gate

placements.  Minor variances in the numerical values that are represented

in the tutorial images are expected. Please save this layout to your

desktop if unable to complete the next tutorial section.

In the next example, we will calculate the concentration using volume ($VOL)

keyword . 

22.24.4 Concentration Calculator ($VOL keyword)

In the course of this example, we will:

· Set up the concentration calculator using the volume ($VOL) keyword in

the data.

· Obtain a one time result.

(Note that the following sections build upon steps 1 through 7 in the Setting up
the Beads Gates chapter )

1. Select the  command.

The Concentration Calculator dialog appears again as shown in Figure T24.5. 

2. Select the File to analyze, in this case Monocytes.002, from the drop-

down list (Figure T24.5, ).

3. Select Monocytes as the Gate to analyze, from the drop-down list

(Figure T24.5, ).

4. Select the Volume keyword in the data radio button to specify the

Volume Calculation type (Figure T24.5, ).

5. Click the Calculate button.

In the Results section of the Concentration Calculator, the volume of the

sample analyzed appears in the Volume Analyzed (Figure T24.5, ) field and
the concentration of the cells in the Monocytes gate appears in the Sample

Concentration  field (Figure T24.5, ).
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Figure T24.5  Concentration Calculator Dialog Using the $VOL
keyword

8. Click Cancel to close the Concentration Calculator dialog.
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Note:  The volume and concentration values may differ due to gate

placements.  Minor variances in the numerical values that are represented

in the tutorial images are expected. Please save this layout to your

desktop if unable to complete the next tutorial section.

Next, we will show the calculated concentration in a statistics window .

22.24.5 Showing the Concentration in a Statistics Window

In the course of this example, we will:

· Set up the concentration calculator for displaying the results in the layout

using beads or time and flow rate.

· Show the concentration calculated as a statistic in a statistics window.

We have learned how to obtain one-time calculations of the cell concentration in
a sample. We will now learn how to present these results in the layout using the
statistics window.

1. Right-click in the forward vs. side scatter plot containing the Beads1 and
Monocytes gates to bring up the its pop up menu.

2. Select  from the pop-up menu.

 A Gate Statistics window should appear (Figure T24.6). Move it to a
convenient place in the layout.

Figure T24.6  Statistics Window

3. Right-click Statistics table and choose Format.  The Formatting dialog
will appear, docked to the right.

4. Choose the Statistics category.

5. Check boxes only next to the following ones in the Formatting Statistics
dialog (Figure T24.7): 

· Gate

· Number of Events
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· % of Gated Cells

· % of All Cells

· Concentration

Figure T24.7  Formatting Statistics Dialog

The statistics window should resemble Figure T24.8.

Figure T24.8  Statistics Window after
Formatting

There are two other ways to format the statistics window to show only the
statistics you want:



FCS Express 7 Manual2376

© 2023 De Novo Software

· Choosing or removing the statistics one at a time to be displayed using

the statistics window pop-up menu:

A. Right-click on the statistics window to bring up the associated pop up
menu (Figure T24.9).

B. Click the individual statistic you want displayed or removed.
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Figure T24.9  Statistics
Window Popup Menu

· Choosing the statistics to be displayed using the statistics window

Format dialog:

A. Clicking Format tab Statistic Options group Statistics command
from the ribbon.  The Formatting dialog will appear.
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B. Checking and unchecking boxes next to statistics to display or remove,
respectively, under Select Statistics

As you can see in Figure T24.8, the statistics window has a Concentration
column, but it is undefined and shows only n/a. We will now setup FCS Express
to calculate these concentrations.

6. Select the Tools tab group
command (Figure T24.2 ).

The Concentration Calculator dialog appears as previously shown in Figure
T24.4 .

7. Click on the second tab titled Stats Window Setup (Figure T24.10).

There are three ways to calculate the concentration: a) specifying a beads gate
and giving the concentration of the beads in the sample, b) using time together
with the sample's flow rate when acquired, or c.) using the volume keyword
from FCS 3.1 files or the equivalent in Amnis DAF files. We are going to use the
first option and select Reference Beads as shown in Figure T24.10.

8.  Select the Reference Beads radio button.

9.  Select Beads2 in the Bead Gate drop-down list.

10. Enter 100000 in the Bead Concentration field.

11. Click OK (Figure T24.10).
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Figure T24.10  Concentration Calculator Dialog - Stats
Window Setup Tab

Now, the statistics window will show the results in the Concentration column
for every gate in the plot using the parameters you specified in the previous step
(Figure T24.11). This setup will apply to the whole layout and will be used for the
concentration statistics of every plot in the layout.
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Figure T24.11  Statistics Window with
Concentration Results by Gate

Note:  The volume and concentration values may differ due to gate

placements.  Minor variances in the numerical values that are represented

in the tutorial images are expected. Please save this layout to your

desktop if unable to complete the next tutorial section.

Now, we will show the concentration as a token .

22.24.6 Showing the Concentration as a Token

In the course of this example, we will:

· Show the concentration as a token.

In, FCS Express, you can use tokens to insert statistics in a text box to present
your results. For more information, see the tutorial on using text boxes and
tokens . If you have not set up a concentration calculation, please follow the
steps in the Concentration Calculator for Beads tutorials .

1. Insert a text box on the layout.

2. Enter the following text: "Beads were added to this sample at a final
concentration of 100,000 beads per mL. The final concentration of
Monocytes in the sample is <blank space>." in the text box.

3. Right-click on the blank space you left in the text box to bring up the
associated pop-up menu (Figure T24.12).

4. Select Insert Token from the pop-up menu (Figure T24.12).

2380

1787

2367



Tutorials 2381

© 2023 De Novo Software

Figure T24.12  Inserting a Token in a Text Box

The Insert a Token dialog now appears (Figure T24.13).

5. Select Statistic from the Insert a Token dialog.

6. Click Insert (Figure T24.13).
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Figure T24.13  Insert a Token Dialog

The Create Statistic dialog now appears with the Data Source category
displayed (Figure T24.14). This is where you choose which plot the token will
refer to; that is, which plot’s data will be used for the concentration calculation. If
the plot contains multiple overlays, you can also pick the specific overlay you
want to use for the calculation. Since we have created a very simple layout
during this tutorial, there is nothing to change for Data Source in this dialog.
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Figure T24.14  Create Statistic Dialog - Data Source Category

7.  Click the Statistic category in the left pane (Figure T24.15).

8.  Select Monocytes from the Gate list.

9.  Select Concentration from the Statistic list. 

10. Click OK.
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Figure T24.15  Selecting Concentration as the Statistic Token

The text box is updated with the concentration of the monocytes using the
token we defined, shown highlighted in grey in Figure T24.16.
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Figure T24.16  Text Box with the Concentration Token Value

The value for the inserted statistic token is the same for the one in the statistic

window for the "Monocytes" gate. You have specified the four parameters

needed for calculating the cell concentration , in two separate places: the

volume was determined in the Stats Window Setup of the Concentration

Calculator, and the number of cells was determined in the token setup itself.

Note:  The volume and concentration values may differ due to gate

placements.  Minor variances in the numerical values that are represented

in the tutorial images are expected. 

22.25 Channel Calibration

FCS Express can ease the task of determining the absolute fluorescence values
of your samples using calibration particles. Using the integrated Channel
Calibration tool, you can setup FCS Express, using calibration particles, to have
your plots and statistics display corresponding MESF fluorescence values.

We will start by setting up the bead gates and markers .

22.25.1 Setting Bead Gates and Markers

In the course of this example, we will:

· Learn how to gate the beads.

· Learn how to apply markers to the fluorescence peaks of the beads.

· Set up channel calibration defaults for FCS Express.

1. Open a new, blank layout.

2. Insert a dot plot of the file ChannelCalibration.001 located in the Tutorial
Sample Data archive . For information on how to do this, please see the
tutorial on Inserting Plots .

3. Create a Polygon gate around the beads. 

The gate should resemble the one in Figure T25.1. For more information on
creating gates, please refer to the Gating tutorial .
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Figure T25.1  Polygon Gate for
Beads

4. Insert a new histogram of the same file.

5. Set it to show channel FL3-H.

6. Apply the Beads gate to the new histogram. 

The histogram should resemble Figure T25.2.

Figure T25.2  Histogram of FL3-H with Beads Gate
Applied

The histogram shows the five fluorescent peaks, plus a "negative", of the
calibration particles. We will now proceed to delineate the peaks by setting
individual markers on each peak.

7.  Select the Gating tab group  command.

8.  Place the cursor inside the histogram and to the left of the brightest peak.
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9.  Press and hold the left mouse button down and drag the mouse to the
right side of the peak. 

10. Release the mouse button when you are on the right side of the brightest
peak. Take care to avoid the "tail" which represents the doublets, indicated
by the red circle in Figure T25.3. 

You can move and resize the marker freely once it has been created by selecting
the marker and moving either the ends of the marker or the whole marker. For
more information on resizing markers, please refer to the tutorial section
explaining Marker to Gate Linking .

Repeat steps 7 through 10 for each of the other four peaks, moving from the
brightest to the dimmest peak, excluding the lowest peak associated with the
"blank" beads. You should now have five markers, one for each fluorescent
peak, shown in Figure T25.3.

Figure T25.3  Markers M1-M5 for the Five Fluorescent
Peaks 

(Red Circles Indicate Doublets)

Note: The default setting for FCS Express is to use channel calibration on the
axes. Therefore, before we set up the channel calibration, it is important to set
the histogram, showing the beads, to not use channel calibration, since that is
our original reference. 

11. Double click the histogram.  The Formatting dialog will appear, docked to
the right.

12. Select the Specific Options category in the Formatting dialog.

14. Uncheck the box next to Use channel calibration on axis option under
Channel Calibration (Figure T25.4, red outline).
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Figure T25.4  Formatting Dialog - Deselecting "Use channel
calibration on axis"
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In the next section, we will set up the channel calibration tool .

22.25.2 Channel Calibration Tool Setup

In the course of this example, we will:

· Identify the variables needed for calibrating the channels.

· Set up the Channel Calibration tool using the beads and markers prepared

in the previous section.

· Obtain the calibration information.

Before we can begin our setup, it is important to clarify a detail on how flow
cytometry FCS data files are formatted. Typically, in an FCS file, the first
parameter described is Forward scatter, followed by Side scatter, and then the
fluorescent channels in order – FL1, FL2, FL3, etc. Some instruments embed the
name of the parameter directly in the FCS file and you can see it in the Channel
Calibration tool (see instructions below). In the file we will be using for this
tutorial, that is not the case. Nevertheless, we know that "Parameter 5"
corresponds to FL3, which is the channel we want to calibrate. In case you do
not know which parameter corresponds to a fluorescent channel, you can view
the FCS text header information by selecting the Data tab
group  command.  A dialog displaying the FCS data file header
information will appear displaying all the parameter information in a grid.

We will proceed to set up the Channel Calibration tool.

1. Select the Tools tab group  command
(Figure T25.5).

Figure T25.5  Selecting the Channel Calibration Tool Command

The Channel Calibration dialog appears (Figure T25.6).
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Figure T25.6  Channel Calibration Dialog

2. Click the Add button in the Channel Calibration dialog (Figure T23.6).

A New Calibration dialog now appears, similar to Figure T25.7.

3. Select FL3-H from the Create calibration for drop-down list (Figure

T25.7, ).

4. Select the Histogram - ChannelCalibation.001 (FL3) with the
calibration beads from the Calculate regression from drop-down list

(Figure T25.7, ).

Note: If there are multiple overlays in your histogram, you can select which one
to use in the Overlay option. In this case it is a simple histogram. Therefore,
there are no other overlays and nothing has to be changed.

5. Enter "5" in the Number of peaks to use for regression field (Figure

T25.7, ).

Typically, it is best to use all available peaks (except the blank one); however, if
for some reason you want to omit one of the peaks, you may. Yet, you must
use a minimum of three peaks to calculate a regression.

6. Enter the following respective fluorescence values for each peak, in the
Molecules/Bead column beginning with Marker 1; 77100, 22100,

6900, 2100, 750 (Figure T25.7 ).

These values are provided by the manufacturer of the beads, usually quoted as
MESF – Mean Equivalent of Soluble Fluorochrome. In this case, the reported
MESF are for PE-Cy5 molecules.
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If you specified fewer peaks than the number of markers in the histogram, for
example, four peaks out of five markers, make sure you select the correct
markers in the left column.

7. Click the Calculate button (Figure T25.7, ).

Figure T25.7  New Calibration Dialog
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The New Calibration dialog and Results (Slope, Y intercept, and Correlation
coefficient) should resemble Figure T25.7. FCS Express calculates the
regression using the logarithmic values. The minimal detection threshold is the
fluorescence obtained by setting the channel to "1" in the regression equation.
The number of decades, or the dynamic range of the machine, is calculated as
the inverse of the slope.

8. Click OK to close the New Calibration dialog.

The Channel Calibration dialog will resemble Figure T25.8. The channel
calibration is now ready for use.

As you define calibrations for more parameters, they will all appear here. If the
Active option is set, then that calibration set will be used in the layout in those
plots that have the Use channel calibration on axis checked. You can only
have one active calibration per parameter.

Figure T25.8  Updated Channel Calibration Dialog

Notes: 

· Although we do not show it here, you also may edit existing calibrations for a

particular parameter by selecting the parameter in the Channel Calibration list
and pressing the Edit button. 

· Calibration Information for a specific plot or layout may be reported directly in

your layout by using the Channel Calibration Information Custom Token
Formula reference . 

9. Click OK to close the Channel Calibration dialog and return to the layout.

Next, we will demonstrate channel calibration .
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22.25.3 Channel Calibration Demonstration

In the course of this example, we will:

· Demonstrate the effect of channel calibration on the data display.

We will now insert a new histogram to show how the calibration affects how the
data is displayed in the layout created in the previous section .

1. Insert a new histogram using the file Monocytes.002 in the Tutorial
Sample Data archive . 

2. Change the x-axis to FL3-H. 

3. Make sure the histogram is ungated.

The histogram should resemble T25.9. Note that the x-axis extends from less

than 102 to more than 105. The axis is shown as calibrated, expressing the
mean equivalent number of soluble PE-Cy5 molecules. This is because the default
setting for all plots is to use calibrated axes.

Figure T25.9  Histogram with Calibrated Axis

4. Right-click on the histogram to bring up the associated pop up menu.

5. Select Histogram Statistics from the pop up menu. 
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The Statistics window associated with the histogram will appear.

6. Move the Statistics window under the histogram.

7. Click inside the Statistics window, so it is selected; it should have a green
border.

8. Choose the Statistics category in the Formatting dialog (Figure T25.10).

9.  Select the following items on the Statistics dialog: Median, Geometric
Mean, Arithmetic Mean, and CV.

10. Deselect all other items from the Statistics dialog.

Figure T25.10  Selecting Statistics to Display

The Statistics window should resemble Figure T25.11.
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Figure T25.11  Statistics
Window for Histogram with

Calibrated Axis

11. Click to select new histogram.

12. Select Specific Options category in Formatting dialog, as previously
shown in Figure T25.4 .

Notice that the Use channel calibration on axis is checked.

16. Uncheck the box next to the Use channel calibration on axis option
under Channel Calibration (Figure T25.4 ). 

Note the histogram curve itself does not change, but the x-axis changes to one

ranging from 100 to 104 uncalibrated scale. Also, the values in the statistics
window change when the axis changes from calibrated to uncalibrated. When
calibration is active, the units represent the MESF of PE-Cy5. When calibration is
not used, the units are the arbitrary values obtained from the raw data in the
FCS file.

In the next section, we will cover saving and loading channel calibrations .

22.25.4 Saving/Loading Channel Calibrations

In the course of this example, we will:

· Learn how to save and load channel calibration sets.

Now that you have set up this calibration (or in the future, multiple calibration
sets), you can save them in order to use them for other layouts. For example, if
you acquired multiple samples which you are analyzing in separate layouts, you
can set up the calibration in one layout, save it, and then load it in all the other
layouts. That way you avoid the need to repeat the calibration process in every
layout. Bear in mind that the calibration is applicable only to the samples acquired
during the same experimental run using the exact same cytometer setup.

We will proceed to save the calibration setup using the layout from the previous
section .

1. Select the Tools tab group  command
(Figure T25.5 ).

2385

2385

2395

2393

2389



FCS Express 7 Manual2396

© 2023 De Novo Software

The Channel Calibration dialog will appear as previously shown in Figure
T25.8 .

2. Select the calibration you created. There should only be one.

3. Click the Save button.

The Save As dialog appears.

4. Navigate to the Tutorial Sample Data folder and enter "CalibDemo".

5. Click Save.

We now will load the calibration setup into a new layout.

6. Click on Cancel to close the Channel Calibration dialog.

7. Select Save icon  in the upper left of window to save your current
layout.

8. Key Ctrl+N on the keyboard, to open a new blank layout.

9. Select the Tools tab group  command.

The Channel Calibration dialog appears empty, with no calibrations defined, as
previously shown in Figure T25.6 .

10. Click the Load button. 

The Open dialog appears where we can select the calibration file to load.

11. Navigate to the Tutorials Sample Data folder and select the "CalibDemo"
file that you saved from steps 1 through 5 above.

12. Click Open.

The Channel Calibration dialog will resemble Figure T25.8 , with the same
calibration information you saved in the other layout.

13. Click on Cancel to close the Channel Calibration dialog.

14. Close the current blank layout to return to the original layout we were
working on before.

Finally, we will set up channel calibration defaults .

22.25.5 Channel Calibration Defaults

In the course of this example, we will:
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· Learn how to change channel calibration default settings for FCS Express

plots.

As previously mentioned, the default setting for FCS Express is to use channel
calibration on all plots. However, you have the option of turning the channel
calibration option off, or on, for a specific plot type. We will now show how you
can turn the channel calibration option off for all 2D dot plots.

1. Select File tab .

The FCS Express User Options dialog now appears (Figure T25.12).

2. Expand the Plots category by clicking the "+" sign in the left pane.

3. Expand the Dot Options subcategory and select Binned Dots Specific
Options in the left pane under Plots.

4. Uncheck the box next to Use channel calibration on axes box (Figure
T25.12, red outline in right pane).

5. Click OK to accept changes and close the FCS Express User Options
dialog.

Figure T25.12 FCS Express User Options Dialog - Deselecting "Use channel
calibration on axes" for 2D Dot Plots 

This setting ensures all new 2D dot plots created will not use channel calibration.
If we would like to remove the channel calibration for other types of 2D plots, we
would need to repeat steps 2 through 4 for the respective plot subcategory
under the Plots category on the FCS Express User Options dialog.

Note you always have the option of applying or removing the channel calibration
for a specific plot, rather than for all plots, using the Formatting dialog via the
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Format tab on the ribbon or right-clicking plot and choosing Format from the
pop up menu as shown in the previous steps. When the Formatting dialog
associated with the plot appears, remember to select 
Specific Options for 2D dot plots or 
for histograms. Then, check or uncheck the box next to the Use channel
calibration on axes option under Channel Calibration to apply or remove
calibration, respectively.

Remember, it is important to uncheck the box next to Use channel calibration

on axes option on any histograms used to set up a new bead channel

calibration.

22.26 CellProfiler Export

CellProfiler is free, open-source software designed to enable biologists to
quantitatively measure cell phenotypes from thousands of images. CellProfiler
can automatically find all the cells within a given image and measure parameters
from each cell. De Novo Software has teamed up with the developers of
CellProfiler to allow analysis of high throughput imaging data in FCS Express.
Once your data is properly exported from CellProfiler, FCS Express can import
the data and allow visualization of your data set with all of our familiar 2D plots
and new plotting features such as picture plots and heat maps.

   In the first two sections of this tutorial you will learn:

· How to export CellProfiler data from a 96 well plate imaging experiment.

· How to import the data into FCS Express.

Note: This tutorial will not focus on how to create and use pipelines in
CellProfiler; please refer to CellProfiler manual for extensive information in
building pipelines. The focus of this tutorial will be how to modify an existing
pipeline in CellProfiler 3.0 in order to export the data in a format that FCS
Express can read. If you are using CellProfiler 2.2 or earlier, please visit this page
and download the 3.0 release and follow the steps outlined here in this tutorial. 
If you are unfamiliar with CellProfiler please review this section CellProfiler for FCS
Express Knowledge Base .   

First, we will setup to export 96 well data from CellProfiler .

2495
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22.26.1 Exporting 96 Well Format Images

In addition to extracting metadata from the image files and providing names for

different channels (if applicable), the following CellProfiler analysis modules are

required or must be amended in the pipeline order for export to FCS Express:

Convert Objects to Images, Save Images, and Export to Spreadsheet. The

completed pipeline for this example can be found in the Tutorial Sample Data

archive  and is named Section1pipelineCOMPLETED.cpproj. The completed

pipeline is meant to be used as a template for comparison to your pipeline and

represents the finished product of this tutorial.

This tutorial will use representative files from the Broad Institute example data

set quantifying features of interest, Human cytoplasm-nucleus translocation

assay (SBS Vitra), which is available in the Example Vitra Images folder within

Tutorial Sample Data archive.  More details about this experiment can be found

here.

The steps for exporting data from CellProfiler have been outlined by illustrating

how to add images, extract metadata from files, and modify the required

modules according to the Section1pipeline.cpproj. After loading the

Section1pipeline.cpproj, follow the steps below to amend the pipeline to

prepare for export to FCS Express.

Selecting Default Output Folder

To organize your data correctly for FCS Express, ensure the Default Output
Folder is the same folder where your images are stored and used for the
Default Input Folder (Figure T26.1).  

Note: The DefaultOUT.mat file will also be exported to the Output Folder. This file
is for use in MATLAB. If you do not wish to use this file, you can select Do not
write MATLAB or HDF5 files from the Output file format drop-down menu.

Figure T26.1  Set the Default Input and Output Folders to the Same Location

A.   Loading Images, Extracting Metadata, Assigning Names

In order for FCS Express to recognize your data is in 96 well format,
metadata from the image file names must be extracted. A Regular Expression
must be defined to find the metadata in the file name or path of the data by
following these steps in CellProfiler (Figure T26.2):
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1. Click Images category in left column of CellProfiler window.

2. Drag and drop Example Vitra Images folder into designated area.

3. Click Apply filters to the file list to remove non-image files.  Font for
Experiment.ini should become gray.

4. Click Metadata category directly below Images.

5. Click Yes radio button in the Extact metadata? box.

6. Confirm Metadata extraction drop-down list is set to Extract from
file/folders.

7. Confirm Metadata source drop-down list is set to File name.

8. Click the magnifying glass icon to the right of Regular Expression to field.

9. Erase all text from Regex: field.

10. Copy and paste following text into Regex: field, which will define the
Channel Number, Well Number, Row of the plate with a letter, and Column
of the plate with a number:

Channel (?P<ChannelNumber>[0-9]{1,2})-(?P<WellNumber>[0-9]{2})-
(?P<Row>[A-H]{1})-(?P<Column>[0-9]{2})-00.Bmp

11. Click Submit in Regular expression editor window.

12. Click Update button in lower portion to see information extracted for
each of the images.

13. Click NamesandTypes directly below Metadata.

14. Change Assign a name to drop-down list to Image matching rules.

15. Enter Channel 2- in blank field to right of Contain drop-down list.

16. Confirm DNA is entered in Name to assign these field.

17. Click Add another image button.

18. For second image set, enter Channel 1- in blank field to right of Contain
drop-down list.

19. Replace GFP in Name to assign these field with Cytoplasm.

20. Click Update button in lower portion. 

21. Screen should resemble Figure T26.2 below for Metadata module.
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Figure T26.2  Setting up a Regular Expression in the LoadImages Module for a 96
Well Plate Experiment

Notes: 

· Follow these links for a tutorial on "Regular Expressions" and how to

translate regular expressions.

· The regular expression output names: Well, Row, Column, and Col may

only be used with plate based or montage imaging experiments. Using
any of these names for a single image experiment will result in a non-
working export.

B.  ConvertObjectsToImage Modules

In these modules, the objects you have defined through the "Identify
Primary/Secondary Objects" module will be converted to image masks that
FCS Express will use during import and analysis. See Figure T26.3 for an
example of the module window.

1. Select the first ConvertObjectsToImage module in the pipeline.

2. Choose Nuclei from Select the input objects drop-down list.

3. Enter Nuclei in the Name the output image field.

4. Select uint 16 from the Select the color type drop-down list (Figure
T26.3 below). 

5. Select the second ConvertObjectsToImage module in the pipeline.

6. Choose Cells from Select the input objects drop-down list.

7. Enter Cells in the Name the output image field.

8. Select uint 16 from the Select the color type drop-down list. 

Note: Repeat steps 5-8 for as many objects you have defined through the
Identify Primary/Secondary Objects module when defining your own pipeline.

http://gnosis.cx/publish/programming/regular_expressions.html
http://docs.python.org/library/re.html
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Note: In order for FCS Express to properly import the data the Name the
output image name must be the same as the Select the input objects
name and is case sensitive.

Figure T26.3  ConvertObjectsToImage Module: Defining Nuclei and Cells Image
Masks

C.  SaveImages Module

The image masks that were defined in the ConvertObjectsToImage
modules must now be saved and related to the original images/data. 

1. Select the first SaveImages module in the pipeline.

2. Set the Select the type of image to save drop-down list to Image.

3. Choose Cells for the Select the image to save drop-down list.

a. Note: when defining your own pipeline, select the appropriate image
you defined in the ConvertObjectsToImage module.

4. Set the Select method for constructing file names drop-down list to
Single name.

5. Enter CellLabel_ in the Enter single file name field.

6. Right-click after CellLabel_, choose Row, and enter an underscore
"_"after it.

7. Right-click after Row_ and choose Column.

8. Select the second SaveImages module in the pipeline.

9. Set the Select the type of image to save drop-down list to Image.

10. Choose Nuclei for the Select the image to save drop-down list.

a. Note: when defining your own pipeline, select the appropriate image
you defined in the ConvertObjectsToImage module.

11. Set the Select method for constructing file names drop-down list to
Single name.

12. Enter NucleiLabel_ in the Enter single file name field.
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13. Right-click after NucleiLabel_, choose Row, and enter an underscore
"_"after it.

14. Right-click after Row_ and choose Column.

a. Note: Row and Column are values you defined as regular expressions
for the load images module. Using regular expressions allows every
output file to be assigned a unique file name based on the text from
the input file name. This will prevent output file names from
overwriting each other and allow FCS Express to identify the unique
image mask associated with each image file.

b. Perform steps 15-22 on both SaveImages modules set up for
CellLabel and NucleiLabel.

15. Confirm tiff from the Saved file format drop-down list.

16. Set Image bit depth drop-down list to 16-bit integer.

17. Choose Default Output Folder from Output file location drop-down
list.

18. Click Yes radio button in the Overwrite existing files without warning?
box.

19. Set When to save as Every cycle from the drop-down list.

20. Click Yes radio button in Record the file and path information to the
saved image? box.

The SaveImages module for CellLabel should now look like Figure T26.4.

Figure T26.4  Defining the SaveImages Module

D.  ExportToSpreadsheet Module

Now all of the images and object image masks have been defined and saved
for analysis, you must setup CellProfiler to export the measurements you
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wish to view in FCS Express. For this example, we will export all
measurements.

(Note: If you would like to only export certain parameters please see the
Selecting Individual Parameters for CellProfiler Export section)

1.  Select the ExportToSpreadsheet module.

2.  Confirm the Select the column delimiter drop-down list is set to
Comma (",").

3.  Choose Default Output Folder from the Output file location drop-down
list.

4.  Click No radio button in the Add a prefix to file names? box.

5.  Click No radio button in the Export all measurement types? box.

6.  Choose Image from the first Data to export drop-down list.

7.  Click No radio button in the Use the object name for the file name?
box.

8.  Replace DATA.csv with Image.cptoc in File name field.

9.  Click Add another data set button.

10. Choose Nuclei from the second Data to export drop-down list.

11. Click No radio button in the Use the object name for the file name?
box.

12. Replace DATA.csv with nuclei.cpout in File name field.

13. Click Add another data set button.

14. Repeat steps 10-12 for "Cells" and set the file name as cells.cpout.

The ExportToSpreadsheet module options should resemble Figure T26.5 when
you are done.

Note 1: on file extensions: ".cptoc" stands for CellProfiler Table of Contents and
".cpout" stands for CellProfiler Output. The "Image.cptoc" file stores information
about the location and number of images for all objects processed in the
pipeline, while the separate "Nuclei.cpout" and "Cells.cpout" store the actual
listmode data associated with individual objects and analysis. There should be a
separate ".cpout" file defined for each object mask defined in CellProfiler. Only
one "Image.cptoc" file is needed.

2455
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Note 2:The name of your .cpout file must begin with the name of the object
data you are exporting and may only be include the object name and regular
expressions. For example: the file names nuclei.cpout and nuclei_<regular
express>.cpout will result in a proper export while dataset1nuclei.cpout or
<regularexpression>_nuclei.cpout will resulting in a non-working export. 
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Figure T26.5  ExportToSpreadsheet Module Set Up to Export Image.cptoc,
nuclei.cpout, and cells.cpout

15. Click Analyze Images to run the pipeline. The folder where your images
are stored will now contain the cells.cpout, nuclei.cpout and Image.cptoc files
(Figure T26.6). 
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Note: Analyzing Images will open multiple windows.  Select Window Tab and
select Hide All Windows On Run to avoid having multiple window opened.

Figure T26.6  cells.cpout, nuclei.cpout, and Image.cptoc Files were Created.
Experiment.ini was Downloaded.

There also will be a CellLabel and NucleiLabel image associated with every original
image/well from the plate (Figure T26.7).
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Figure T26.7  NucleiLabel and CellLabel image mask .tiff Have Been Created for
Every Well of the Plate. The File Names Reflect the Row and Column Numbers for

the CellLabels (red rectanglel) and Channels (blue rectangle).

In the next section, we will import and analyze the 96 well image data .

22.26.2 Import and Analyze 96 Well Images

After adjusting the export settings in CellProfiler and running your pipeline, you
may proceed to import the data into FCS Express. FCS Express only needs one
additional piece of information regarding the setup of your experiment.
CellProfiler currently does not export the plate format that was used for your
experiment. A series of standard plate format definitions can be downloaded
from the FCS Express website. For this example, we will be using a 96 well
template which can found in the Tutorial Sample Data archive  and is labeled
Experiment.ini. The plate format definition file must be called Experiment.ini
and placed into the Default Output Folder you defined in CellProfiler.

2408
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Importing the 96 Well Plate Imaging Experiment to FCS Express

Note on FCS Express Preferences before starting these steps of the tutorial:

The File selection dialog must be enabled:

A.  Open the FCS Express User Options by choosing .

B.  Selct the Files/Directories category.

C.  Check the box next to When inserting a new plot or displaying
information from a data file, always display the selection dialog.

(Enabling this feature is not a requirement of FCS Express, it has been selected
for convenience in this tutorial.)

1.  Load the Section1pipelineCOMPLETED.cpproj pipeline into CellProfiler
3.0.

2.  Drag and drop the folder called Example Vitra Images into Images
module and click Apply filters to file list button.

3.  Confirm the default input and output folders in CellProfiler to load and
store the data are set as shown in Figure T26.1 .

4.  Click the Analyze Images button in the lower left of the in CellProfiler
window.

5.  Open FCS Express.

6.  Click New Layout from Startup Screen.

7.  Open the FCS Express User Options by choosing .

8.  Select Cell Profiler Options from the Data Loading category (Figure
T26.8).

9.  Select csv from the delimiter drop-down list.

10. Check the Load Images check box.

11. Uncheck the box next to Load path names from Cell Profiler table of
contents file.

12. Click OK to close the FCS Express User Options dialog.

2399
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Figure T26.8  CellProfiler Data Loading Options for a 96 Well Plate Experiment with
Images

13.  Select File tab if needed to open a new, blank layout.

14. Select the Insert tab group command
(Figure T26.9).

Figure T26.9  Inserting Plate Heat
Map from Ribbon

15. Click anywhere on the layout and the Select data file dialog will appear.

16. Browse to the Default Output Folder where you stored your output data
from CellProfiler.

17. Change the Files of type: drop-down list to Cell Profiler (*.cpout)
(Figure T26.10). Icons for the documents output by CellProfiler will appear.
For this example, they will be labeled cells.cpout and nuclei.cpout.
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Figure T26.10  Choosing CellProfiler Files

18. Select cells.cpout. 

19. Click Open. 

Note: For this example, we will use cells.cpout file, which will display data from
objects classified in the IdentifySecondaryObjects module of CellProfiler,
corresponding to the entire cell area. The file, nuclei.cpout, will display data from
objects classified in the IdentifyPrimaryObjects module of CellProfiler, which
corresponds only to the nuclear area of the cells.
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18. Highlight the Y-Axis Parameter you wish to view in the heat map from
the Open 2D Plots dialog. For this example, choose
Intensity_MeanIntensity_Cytoplasm (Figure T26.11).

19. Click OK.
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Figure T26.11  Opening a Heat Map and Choosing the Y-Axis
Parameter from the Open 2D Plots Dialog

A plate heat map will appear on your layout, indicating that the data were

imported successfully (Figure T26.12). 
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Figure T26.12  Example of a Heat Map Generated from CellProfiler
Data

Gates can be created on the Plate Heat Map can be gated using the
command.

Tips: to display the Well Gate border around the gated wells (e.g. red circle
around Well A01 in the picture below), select the Show Gate option after right-
clicking on the Plate Heat Map, then check the gate of interest.

Inserting a new 2D plot based on the well gate will allow you to view the data
within that gate (e.g. a single, or multiple wells) in familiar dot plots (see picture
below).

Image can be accessed using a picture plots (Figure T26.13).
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Figure T26.13  Plate Heat Map from CellProfiler Data with Corresponding Dot and
Picture Plots

 

Note about panning and zooming (please refer the working with picture plots

chapter  for more details)

By default, Picture plots display images at their original zoom starting from their

top-right corner. 

When the original size of the picture exceed the size of the plot, to see a larger

part of the picture the user can:

267
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· enlarge the plot itself and/or (Figure T26.13a below)

· change the zoom of the Picture plot by selecting Specific Options from the

Format tab of the ribbon bar (Figure T26.13b below). Should the zooming not

being enough, the plot can be resized in addition. 

Figure T26.13a
The picture plot (left) has been resized in order to display teh full picture (right) 
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Figure T26.13b

The picture plot (top) has been zoomed through the Specific Options dialog in order
to display a larger part of the picture (bottom).
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If a different region of the image should be displayed within the picture plot,
please change the panning (please refer the working with picture plots chapter
for more details).

Next, we will export single images from CellProfiler .

22.26.3 Exporting Single Images

In the next two sections, you will learn:

· How to export CellProfiler data from a set of single images that were not

obtained from a 96 well plate.

· How to import the data into FCS Express.

This section pertains to data from a set of single images that were not obtained
from a 96 well plate such as images obtained from a slide.

In addition to extracting metadata from the image files and providing names for

different channels (if applicable), the following CellProfiler analysis modules are

required or must be amended in the pipeline order for export to FCS Express:

Convert Objects to Images, Save Images, and Export to Spreadsheet. The

completed pipeline for this example can be found in the Tutorial Sample Data

archive  and is named Section2pipelineCOMPLETED.cpproj. The completed

pipeline is meant to be used as a template for comparison to your pipeline and

represents the finished product of this tutorial.

The sample images in the example data set we will be using can be found in the
Tutorial Sample Data archive  and are the 5 and 10 minute time point
images folder. These images are based on the "Human cytoplasm-nucleus
translocation assay (Vitra Image)" from the previous module.

The steps for exporting data from CellProfiler have been broken down by

module. After loading the Section2pipeline.cpproj, follow the steps below to

amend the pipeline to prepare for export to FCS Express.

Selecting Default Output Folder

To organize your data correctly for FCS Express, ensure the Default Output
Folder is the same folder where your images are stored and used for Default
Input Folder (example in Figure T26.14 below).  

267
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Note: The DefaultOUT.mat file will also be exported to the Output Folder. This file
is for use in MATLAB. If you do not wish to use this file, you can select Do not
write MATLAB or HDF5 files from the Output file format drop-down menu.

Figure T26.14  Set the Default Input and Output Folders to the Same Location

A.   Loading Images, Extracting Metadata, Assigning Names

In order for FCS Express to recognize your data is in 96-well format,
metadata from the image file names must be extracted. A Regular Expression
must be defined to find the metadata in the file name or path of the data by
following these steps in CellProfiler (Figure T26.15):

1. Click Images category in left column of CellProfiler window.

2. Drag and drop 5 and 10 minute time point images folder from archive
folder into designated area in CellProfiler.

3. Click Metadata category directly below Images.

4. Click Yes radio button in the Extract metadata? box.

5. Confirm Metadata extraction drop-down list is set to Extract from
file/folders.

6. Confirm Metadata source drop-down list is set to File name.

7. Click the magnifying glass icon to the right of Regular Expression to field.

8. Erase all text from Regex: field.

9.  Copy and paste following text into Regex: field, which will define the
Channel Number and time with a number: 

Channel(?P<ChannelNumber>[0-9]{1,2})-(?P<time>[0-9]{2})-min.tif

10. Click Submit in Regular expression editor window.

11. Click Update button in lower portion to see information extracted for
each of the four images.

12. Click NamesandTypes directly below Metadata.

13. Change Assign a name to drop-down list to Image matching rules.

14. Enter Channel2- in blank field to right of Contain drop-down list.

15. Confirm DNA is entered in Name to assign these field.

http://en.wikipedia.org/wiki/Regular_expression
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16. Click Add another image button.

17. For second image set, enter Channel1- in blank field to right of Contain
drop-down list.

18. Replace GFP in Name to assign these field with Cytoplasm.

19. Click Update button in lower portion. 

Notes: 

· Follow these links for a tutorial on "Regular Expressions" and how to

translate regular expressions.

· Setting up metadata and regular expressions only has to be done for one

image in the set. For this example, it has been set up for channel 2.

· The regular expression output names: Well, Row, Column, and Col may

only be used with plate based or montage imaging experiments. Using any
of these names for a single image experiment will result in a non-working
export.

Figure T26.15  Setting Up a Regular Expression in the LoadImages Module

B.  ConvertObjectsToImage Modules

http://gnosis.cx/publish/programming/regular_expressions.html
http://docs.python.org/library/re.html
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In these modules, the objects you have defined through the "Identify
Primary/Secondary Objects" module will be converted to image masks that FCS
Express will use during import and analysis. See Figure T26.16 for an example of
the module window.

1. Select the first ConvertObjectsToImage module in the pipeline.

2. Choose Nuclei from Select the input objects drop-down list.

3. Enter Nuclei in the Name the output image field.

4. Select uint 16 from the Select the color type drop-down list. 

5. Select the second ConvertObjectsToImage module in the pipeline.

6. Choose Cells from Select the input objects drop-down list.

7. Enter Cells in the Name the output image field.

8. Select uint 16 from the Select the color type drop-down list. 

Note: Repeat steps 4-7 for as many objects you have defined through the
Identify Primary/Secondary Objects module when defining your own pipeline.

Note: In order for FCS Express to properly import the data the Name the
output image name must be the same as the Select the input objects
name and is case sensitive.

C.  SaveImages Module

The image masks that were defined in the ConvertObjectsToImage module
must now be saved and related to the original images/data. 

1. Select the first SaveImages module in the pipeline.

2. Set the Select the type of image to save drop-down list to Image.

3. Choose Cells for the Select the image to save drop-down list.

a. Note: when defining your own pipeline, select the appropriate image
you defined in the ConvertObjectsToImage module.

4. Set the Select method for constructing file names drop-down list to
Single name.

5. Enter CellLabel_ in the Enter single file name field to replace OrigBlue.

6. Right-click after immediately after the underscore of CellLabel_ and
choose time.
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7. Select the second SaveImages module in the pipeline.

8. Set the Select the type of image to save drop-down list to Image.

9.  Choose Nuclei for the Select the image to save drop-down list.

a. Note: when defining your own pipeline, select the appropriate image
you defined in the ConvertObjectsToImage module.

10. Set the Select method for constructing file names drop-down list to
Single name.

11. Enter NucleiLabel_ in the Enter single file name field to replace
OrigBlue.

12. Right-click after immediately after the underscore of NucleiLabel_ and
choose time.

a. Perform steps 13-18 on both SaveImages modules set up for
CellLabel and NucleiLabel.

13. Confirm tiff from the Saved file format drop-down list.

14. Set Image bit depth drop-down list to 16-bit integer.

15. Choose Default Output Folder from Output file location drop-down
list.

16. Click Yes radio button in the Overwrite existing files without warning?
box.

17. Set When to save as Every cycle from the drop-down list.

18. Click Yes radio button in Record the file and path information to the
saved image? box.

The SaveImages module for CellLabel should now look like Figure T26.16

below.

Figure T26.16  ConvertObjectsToImage Module: Defining Nuclei and Cells Image
Masks

D.  ExportToSpreadsheet Module
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Now that all of the images and object image masks have been defined and
saved for analysis, you must now ask CellProfiler to export the
measurements you wish to view in FCS Express. For this example, we will
export all measurements.

(Note: If you would like to only export certain parameters please see the
Selecting Individual Parameters for CellProfiler Export section)

1.  Select the ExportToSpreadsheet module.

2.  Confirm the Select the column delimiter drop-down list is set to
Comma (",").

3.  Choose Default Output Folder from the Output file location drop-down
list.

4.  Click No radio button in the Add a prefix to file names? box.

5.  Click No radio button in the Export all measurement types? box.

6.  Choose Image from the first Data to export drop-down list.

7.  Click No radio button in the Use the object name for the file name?
box.

8.  Replace DATA.csv with Image_.cptoc in File name field.

9.  Right-click between the underscore and period; click time.

10. Click Add another data set button.

11. Choose Nuclei from the second Data to export drop-down list.

12. Click No radio button in the Use the object name for the file name?
box.

13. Replace DATA.csv with nuclei_.cpout in File name field.

14. Right-click between the underscore and period; click time.

15. Click Add another data set button.

16. Repeat steps 10-12 for "Cells" and set the file name as cells_.cpout.

17. Right-click between the underscore and period; click time.

The ExportToSpreadsheet module options should look like Figure T26.17 when
you are done.

Note 1: on file extensions: ".cptoc" stands for CellProfiler Table of Contents and
".cpout" stands for CellProfiler Output. The "Image.cptoc" file stores information
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about the location and number of images for all objects processed in the
pipeline, while the separate "Nuclei.cpout" and "Cells.cpout" store the actual
listmode data associated with individual objects and analysis. There should be a
separate ".cpout" file defined for each object mask defined in CellProfiler. Only
one "Image.cptoc" file is needed.

Note 2:The name of your .cpout file must begin with the name of the object
data you are exporting and may only be include the object name and regular
expressions. For example: the file names nuclei.cpout and nuclei_<regular
express>.cpout will result in a proper export while dataset1nuclei.cpout or
<regularexpression>_nuclei.cpout will resulting in a non-working export. 
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Figure T26.17  ExportToSpreadsheet Module

18. Click Analyze images to run the pipeline. The folder where your images
are stored will now contain the cells.cpout, nuclei.cpout and Image.cptoc
files for each time point. There will also be a CellLabel and NucleiLabel
image associated with every original image from the experiment (Figure
T26.18).
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Figure T64.18  Example of Output Folder once CellProfiler Analysis is Complete

In the next section , we will import the single image experiment into FCS
Express.

22.26.4 Importing Single Image Data

This section pertains to data from a set of single images that were not obtained
from a 96 well plate, such as images obtained from a slide.

After adjusting the export settings in CellProfiler and running your pipeline, you
may proceed to analyze your images and import the data into FCS Express. 

Importing the Single Image Experiment to FCS Express

Note on FCS Express Preferences before starting these steps of the tutorial:

The File selection dialog must be enabled:
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A. Open the FCS Express User Options by choosing .

B. Check the When creating a new plot, always display the selection
dialog box in the Files/Directories category.

(Enabling this feature is not a requirement of FCS Express, it has been selected
for convenience in this tutorial.)

1.  Load the Section2pipelineCOMPLETED.cpproj pipeline into CellProfiler
3.0.

2.  Drag and drop the folder called 5 and 10 minute time point images
folder into Images module.

3.  Confirm the default input and output folders in CellProfiler to load and
store the data as shown in Figure T26.14 .

4.  Click the Analyze Images button in the lower left of the in CellProfiler
window.

5.  Open FCS Express.

6.  Open the FCS Express User Options by choosing 

7.  Select CellProfiler Options from the Data Loading category (Figure
T26.19, orange highlighted text).

8.  Select csv from the delimiter drop-down list.

9.  Check the Load Images check box.

10. Uncheck the Load path names from Cell Profiler table of contents
file check box.

11. Click OK to close the FCS Express User Options dialog.
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Figure T24.19  CellProfiler Data Loading Options

 

12. Select the Insert tab groups command
(Figure T26.20).

Figure T26.20  Inserting Picture
Plot Insert Tab on Ribbon

13. Click anywhere on the layout and the Select data file dialog will appear.

14. Browse to the Default Output Folder where you stored your output data
from CellProfiler.

15. Change the Files of type: drop-down list to CellProfiler (*.cpout)
(Figure T26.21). Icons for the documents outputted by CellProfiler will
appear. For this example, they will be labeled cells_05.cpout and
nuclei_05.cpout.

16.Highlight cells_05.cpout and click Open.
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Figure T26.21  Select Data File Dialog

Note: For this example, we will use cells_05.cpout which will display data from
the 5 minute time point objects classified in the IdentifySecondaryObjects
module of CellProfiler which corresponds to the entire cell area. Nuclei_05.cpout
will display data from the 5 minute time point objects classified in the
IdentifyPrimaryObjects module of CellProfiler which corresponds only to the
nuclear area of the cells.

17. Highlight Cytoplasm from the Image Parameter list box of the Open
2D Plots dialog (Figure T26.22) to view the cytoplasmic image. 
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18. Click OK.

Figure T26.22  Choosing Image Parameters from the Open 2D Plots
Dialog

A Picture Plot will appear on your layout, indicating that the data was
successfully imported (Figure T26.23). 
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Figure T26.23  Example of the Cells (5
Minute Time Point) Picture Plot

Note about panning and zooming (please refer the working with picture plots

chapter  for more details)

By default, Picture plots display images at their original zoom starting from their

top-right corner. When the original size of the picture exceeds the size of the

plot, to see a larger part of the picture the user can:

· enlarge the plot itself and/or (Figure T26.23a below)

· change the zoom of the Picture plot by selecting Specific Options from the

Format tab of the ribbon bar (Figure T26.23b below). Should the zooming not

being enough, the plot can be resized in addition.

If a different region of the image should be displayed within the picture plot,
please change the panning (please refer the working with picture plots chapter
for more details).
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Figure T26.23a
The picture plot (left) has been resized in order to display the full picture (right) 
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Figure T26.23b
The picture plot (top) has been zoomed through the Specific Options dialog in order

to display a larger part of the picture (bottom).
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19. Repeat steps 13-18 but highlight DNA as Image Parameter in the
Open 2D Plots dialog.

Note: alternatively, you can duplicate the 2D plot previously created and then

change the visualized parameter by clicking on the X axis and choosing DNA

instead of Cytoplasm. 

Zoom out on the plot or resize the plot area to display the entire picture in each
plot, the layout should resemble Figure T26.24.

Figure T26.24  Picture Plots for cells_05.cpout for Cytoplasm and DNA Channels

Any type of 2D plot can be created by following the previous step. For training

purpose, the user can try opening two Color Dot Plots of the same file (i.e.

cell_05.cpout) depicting:

· AreaShape_Area with Intensity_MeanIntensity_Cytoplasm
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· AreaShape_Area with Intensity_MeanIntensity_DNA

Tips: dot size on Dot plots and Color Dot plots, can be adjusted via the
Overlay formatting dialog.

The layout should resemble Figure T26.25.

Figure T26.25  Picture and Color Dot Plots for cell_05.cpout
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Any 2D gate can easily be created on the Picture Plots and on the Color Dot

Plots as well. Inserting a new 2D plot gated on the picture plot gate will allow

you to view the data as familiar dot plots, or view gated portions of the image

(Figure T26.26).

Figure T26.26  Example of Gating on a Picture Plot and Backgating from a Color Dot
Plot to a Picture Plot

In the next exercise, we will export numeric data only from a 96 well plate .

22.26.5 Exporting Numeric Data (96 Well)

In this section of the tutorial, you will learn:

· How to export only the numeric data from a 96 Well Plate CellProfiler

pipeline.
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In addition to extracting metadata from the image files and providing names for

different channels (if applicable), the Export to Spreadsheet module must be

amended. The completed pipeline for this example can be found in the Tutorial

Sample Data archive  and is named Section3pipeline.cpproj. The completed

pipeline is meant to be used as a template for comparison to your pipeline and

represents the finished product of this tutorial.

The example data set we will be using can be downloaded from the CellProfiler

Examples website and is labeled "Human cytoplasm-nucleus translocation

assay (Vitra Image)".

The steps for exporting data from CellProfiler have been outlined by module

according to the Section3pipeline.cp. After loading the

Section3pipeline.cpproj, follow the steps below to amend the pipeline to

prepare for export to FCS Express.

Selecting Default Output Folder

To organize your data correctly for FCS Express, ensure the Default Output
Folder is the same folder where your images are stored and used for the
Default Input Folder (Figure T26.27).  

Note: The DefaultOUT.mat file will also be exported to the Output Folder. This file
is for use in MATLAB. If you do not wish to use this file, you can select Do not
write MATLAB or HDF5 files from the Output file format drop-down menu.

Figure T26.27  Seting the Default Input and Output Folders to the Same Location

A.   Loading Images, Extracting Metadata, Assigning Names

In order for FCS Express to recognize your data is in 96-well format, metadata
from the image file names must be extracted. A Regular Expression must be
defined to find the metadata in the file name or path of the data by following
these steps in CellProfiler (Figure T26.2 ):

1. Click Images category in left column of CellProfiler window.

2. Drag and drop Example Vitra Images folder from archive folder into
designated area.
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3. Click Apply filters to the file list to remove non-image files.  Font for
Experiment.ini should become gray.

4. Click Metadata category directly below Images.

5. Click Yes radio button in the Extact metadata? box.

6. Confirm Metadata extraction drop-down list is set to Extract from
file/folders.

7. Confirm Metadata source drop-down list is set to File name.

8. Click the magnifying glass icon to the right of Regular Expression to field.

9. Erase all text from Regex: field.

10. Copy and paste following text into Regex: field, which will define the
Channel Number, Well Number, Row of the plate with a letter, and Column
of the plate with a number:

Channel (?P<ChannelNumber>[0-9]{1,2})-(?P<WellNumber>[0-9]{2})-
(?P<Row>[A-H]{1})-(?P<Column>[0-9]{2})-00.Bmp

11. Click Submit in Regular expression editor window.

12. Click Update button in lower portion to see information extracted for
each of the images.

13. Click NamesandTypes directly below Metadata.

14. Change Assign a name to drop-down list to Image matching rules.

15. Enter Channel 2- in blank field to right of Contain drop-down list.

16. Confirm DNA is entered in Name to assign these field.

17. Click Add another image button.

18. For second image set, enter Channel 1- in blank field to right of Contain
drop-down list.

19. Replace GFP in Name to assign these field with Cytoplasm.

20. Click Update button in lower portion. 

21. Screen should appear as Figure T26.2  for Metadata module.

Notes: 

· Follow these links for a tutorial on "Regular Expressions" and how to

translate regular expressions.
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· The regular expression output names: Well, Row, Column, and Col may

only be used with plate based or montage imaging experiments. Using any
of these names for a single image experiment will result in a non-working
export.

B.  ExportToSpreadsheet Module

Now that all of the images and object image masks have been defined and saved
for analysis, you must now ask CellProfiler to export the measurements you
wish to view in FCS Express. For this example, we will export all measurements.

(Note: If you would like to only export certain parameters please see the
Selecting Individual Parameters for CellProfiler Export section.)

1.  Select the ExportToSpreadsheet module.

2.  Confirm the Select the column delimiter drop-down list is set to
Comma (",").

3.  Choose Default Output Folder from the Output file location drop-down
list.

4.  Click No radio button in the Add a prefix to file names? box.

5.  Click No radio button in the Export all measurement types? box.

6.  Choose Image from the first Data to export drop-down list.

7.  Click No radio button in the Use the object name for the file name?
box.

8.  Replace DATA.csv with Image.cptoc in File name field.

9.  Click Add another data set button.

10. Choose Nuclei from the second Data to export drop-down list.

11. Click No radio button in the Use the object name for the file name?
box.

12. Replace DATA.csv with nuclei.cpout in File name field.

13. Click Add another data set button.

14. Repeat steps 10-12 for "Cells" and set the file name as cells.cpout.

The ExportToSpreadsheet module options should resemble Figure T26.5
when you are done.
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Note 1: on file extensions: ".cptoc" stands for CellProfiler Table of Contents and
".cpout" stands for CellProfiler Output. The "Image.cptoc" file stores information
about the location and number of images for all objects processed in the
pipeline, while the separate "Nuclei.cpout" and "Cells.cpout" store the actual
listmode data associated with individual objects and analysis. There should be a
separate ".cpout" file defined for each object mask defined in CellProfiler. Only
one "Image.cptoc" file is needed.

Note 2:The name of your .cpout file must begin with the name of the object
data you are exporting and may only be include the object name and regular
expressions. For example: the file names nuclei.cpout and nuclei_<regular
express>.cpout will result in a proper export while dataset1nuclei.cpout or
<regularexpression>_nuclei.cpout will resulting in a non-working export. 

15. Click Analyze images to run the pipeline. The folder where your images
are stored will now contain the cells.cpout, nuclei.cpout and Image.cptoc
files (Figure T24.66). There will also be a CellLabel and NucleiLabel image
associated with every original image/well from the plate (Figure T26.28).

Figure T26.28  Data Only Output
Files

Next, we will import and analyze the numeric data .

22.26.6 Importing Numeric Data (96 Well)

In this section you will learn: 

· How to import the data into FCS Express to view Heat Maps, 2D Plots,

and 1D plots.
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After adjusting the export settings in CellProfiler and running your pipeline, you
may proceed to import the data into FCS Express. FCS Express only needs one
additional piece of information regarding the setup of your experiment.
CellProfiler currently does not export the plate format that was used for your
experiment.  A series of standard plate format definitions can be downloaded the
FCS Express website. For this example, we will be using a 96 well template which
can found in the Tutorial Sample Data archive  and is labeled Experiment.ini.
The plate format definition file must be called Experiment.ini and placed into the
Default Output Folder you defined in CellProfiler.

Importing 96 Well Plate Numeric Data Only

Note on FCS Express Preferences before starting these steps of the tutorial:

The File selection dialog must be enabled:

A. Open the FCS Express User Options by choosing .

B. Check the When creating a new plot, always display the selection
dialog box in the Files/Directories category.

(Enabling this feature is not a requirement of FCS Express, it has been selected
for convenience in this tutorial)

1.  Load the Section3pipelineCOMPLETED.cpproj pipeline into CellProfiler
3.0.

2.  Drag and drop the folder called Example Vitra Images into Images
module and click Apply filters to file list button.

3.  Confirm the default input and output folders in CellProfiler to load and
store the data as shown in Figure T26.1 .

4.  Click the Analyze Images button in the lower left of the in CellProfiler
window.

5.  Open FCS Express.

6.  Open the FCS Express User Options by choosing 

7.  Select Cell Profiler Options from the Data Loading category (Figure
T26.29).

8.  Select csv from the delimiter drop-down list.

9.  Uncheck the Load path names from Cell Profiler table of contents file
check box.

10. Click OK to close the FCS Express User Options dialog.
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Note: In this example there are no images associated with the data so the Load

Images check box must remain unchecked.

The dialog should resemble Figure T26.29 when you are done.

Figure T26.29  CellProfiler Data Loading Options for Numeric Data Only

11. Select the Insert tab group command
(Figure T26.30).

Figure T26.30  Inserting Plate Heat
Map from Ribbon

12. Click anywhere on the layout and the Select data file dialog will appear.

13. Browse to the Default Output Folder where you stored your output data
from CellProfiler.

14. Change the Files of type: drop-down list to Cell Profiler (*.cpout)
(Figure T26.31). Icons for the documents output by CellProfiler will appear.
For this example, they will be labeled cells.cpout and nuclei.cpout.
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Figure T26.31  Choosing CellProfiler Files

15. Highlight cells.cpout and click Open. 

Note: For this example, we will use cells.cpout which will display data from
objects classified in the IdentifySecondaryObjects module of CellProfiler which
corresponds to the entire cell area. The file, nuclei.cpout, will display data from
objects classified in the IdentifyPrimaryObjects module of CellProfiler which
corresponds only to the nuclear area of the cells.
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16. Highlight the Y-Axis Parameter you wish to view in the heat map from
the Open 2D Plots dialog. For this example, choose
Intensity_MeanIntensity_Cytoplasm (Figure T26.32).

17. Click OK.
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Figure T26.32  Opening a Heat Map and Choosing the Y-Axis
Parameter from the Open 2D Plots Dialog

A plate heat map will appear (Figure T26.33). 
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Figure T26.33  Example of a Heat Map Generated from CellProfiler
Data

In the next exercise, we will export single image numeric data only .

22.26.7 Exporting Single Image Numeric Data

In this section, you will learn:

· How to export CellProfiler data from a set of single images that were not

obtained from a 96 well plate in numeric form.

This section pertains to data from a set of single images that were not obtained
from a 96 well plate such as images obtained from a slide.

In addition to extracting metadata from the image files and providing names for

different channels (if applicable), the following CellProfiler analysis modules are

required or must be amended in the pipeline order for export to FCS Express:

Convert Objects to Images, Save Images, and Export to Spreadsheet. The

completed pipeline for this example can be found in the Tutorial Sample Data

archive  and is named Section4pipeline.cpproj. The completed pipeline is

meant to be used as a template for comparison to your pipeline and represents

the finished product of this tutorial.
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The sample images in the example data set we will be using can be found in the
Tutorial Sample Data archive  and are the 5 and 10 minute time point
images folder. These images are based on the "Human cytoplasm-nucleus
translocation assay (Vitra Image)" from the previous module.

The steps for exporting data from CellProfiler have been broken down by

module. After loading the Section4pipeline.cpproj, follow the steps below to

amend the pipeline to prepare for export to FCS Express.

Selecting Default Output Folder

To organize your data correctly for FCS Express, ensure the Default Output
Folder is the same folder where your images are stored and used for Default
Input Folder (Figure T26.14 ).  

Note: The DefaultOUT.mat file will also be exported to the Output Folder. This file
is for use in MATLAB. If you do not wish to use this file, you can select Do not
write MATLAB or HDF5 files from the Output file format drop-down menu.

Loading Images, Extracting Metadata, Assigning Names

In order for FCS Express to recognize your data is in 96 well format, metadata
from the image file names must be extracted. A Regular Expression must be
defined to find the metadata in the file name or path of the data by following
these steps in CellProfiler:

1.  Click Images category in left column of CellProfiler window.

2.  Drag and drop 5 and 10 minute time point images folder from archive
folder into designated area in CellProfiler.

3.  Click Metadata category directly below Images.

4.  Click Yes radio button in the Extact metadata? box.

5.  Confirm Metadata extraction drop-down list is set to Extract from
file/folders.

6.  Confirm Metadata source drop-down list is set to File name.

7.  Click the magnifying glass icon to the right of Regular Expression to field.

8.  Erase all text from Regex: field.

9.  Copy and paste following text into Regex: field, which will define the
Channel Number and time with a number:
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Channel(?P<ChannelNumber>[0-9]{1,2})-(?P<time>[0-9]{2})-min.tif

10. Click Submit in Regular expression editor window.

11. Click Update button in lower portion to see information extracted for
each of the four images.

12. Click NamesandTypes directly below Metadata.

13. Change Assign a name to drop-down list to Image matching rules.

14. Enter Channel2- in blank field to right of Contain drop-down list.

15. Confirm DNA is entered in Name to assign these field.

16. Click Add another image button.

17. For second image set, enter Channel1- in blank field to right of Contain
drop-down list.

18. Replace GFP in Name to assign these field with Cytoplasm.

19. Click Update button in lower portion. 

Notes: 

· Follow these links for a tutorial on "Regular Expressions" and how to

translate regular expressions.

· Setting up metadata and regular expressions only has to be done for one

image in the set. For this example, it has been set up for channel 2.

· The regular expression output names: Well, Row, Column, and Col may

only be used with plate based or montage imaging experiments. Using any
of these names for a single image experiment will result in a non-working
export.

ExportToSpreadsheet Module

Now that all of the images and object image masks have been defined and saved
for analysis, you must now ask CellProfiler to export the measurements you
wish to view in FCS Express. For this example, we will export all measurements.

(Note: If you would like to only export certain parameters please see the
Selecting Individual Parameters for CellProfiler Export section)

1.  Select the ExportToSpreadsheet module.
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2.  Confirm the Select the column delimiter drop-down list is set to
Comma (",").

3.  Choose Default Output Folder from the Output file location drop-down
list.

4.  Click No radio button in the Add a prefix to file names? box.

5.  Click No radio button in the Export all measurement types? box.

6.  Choose Image from the first Data to export drop-down list.

7.  Click No radio button in the Use the object name for the file name?
box.

8.  Replace DATA.csv with Image_.cptoc in File name field.

9.  Right-click between the underscore and period; click time.

10. Click Add another data set button.

11. Choose Nuclei from the second Data to export drop-down list.

12. Click No radio button in the Use the object name for the file name?
box.

13. Replace DATA.csv with nuclei_.cpout in File name field.

14. Right-click between the underscore and period; click time.

15. Click Add another data set button.

16. Repeat steps 10-12 for "Cells" and set the file name as cells_.cpout.

17. Right-click between the underscore and period; click time.

The ExportToSpreadsheet module options should look like Figure T26.17
when you are done.

Note 1: on file extensions: ".cptoc" stands for CellProfiler Table of Contents and
".cpout" stands for CellProfiler Output. The "Image.cptoc" file stores information
about the location and number of images for all objects processed in the
pipeline, while the separate "Nuclei.cpout" and "Cells.cpout" store the actual
listmode data associated with individual objects and analysis. There should be a
separate ".cpout" file defined for each object mask defined in CellProfiler. Only
one "Image.cptoc" file is needed.

Note 2:The name of your .cpout file must begin with the name of the object
data you are exporting and may only be include the object name and regular
expressions. For example: the file names nuclei.cpout and nuclei_<regular
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express>.cpout will result in a proper export while dataset1nuclei.cpout or
<regularexpression>_nuclei.cpout will resulting in a non-working export. 

18. Click Analyze images to run the pipeline. The folder where your images
are stored will now contain the cells.cpout, nuclei.cpout and Image.cptoc
files for each time point. There will also be a CellLabel and NucleiLabel
image associated with every original image from the experiment (Figure
T26.34).

Note: The DefaultOUT.mat file will also be exported to the Output Folder. This file
is for use in MATLAB, if you do not wish to use this file we recommend deleting it
to conserve disk space.

Figure T26.34  Example of CellProfiler
Output Folder When Analysis is

Complete

In the next exercise, we will import and analyze single image numeric data .

22.26.8 Import Single Image Numeric Data

In this section, you will learn:

· How to import the data into FCS Express to view 1D and 2D plots.

This section pertains to data from a set of single images that were not obtained
from a 96 well plate, such as images obtained from a slide.

After adjusting the export settings in CellProfiler and running your pipeline, you
may proceed to analyze your images and import the data into FCS Express.

Importing the Single Image Experiment to FCS Express

Note on FCS Express Preferences before starting these steps of the tutorial:
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The File selection dialog must be enabled:

A. Open the FCS Express User Options by choosing .

B. Check the When creating a new plot, always display the selection
dialog box in the Files/Directories category.

(Enabling this feature is not a requirement of FCS Express, it has been selected
for convenience in this tutorial.)

1.  Load the Section4pipelineCOMPLETED.cpproj pipeline into CellProfiler
3.0.

2.  Drag and drop the folder called 5 and 10 minute time point images
folder into Images module and click Apply filters to file list button.

3.  Confirm the default input and output folders in CellProfiler to load and
store the data as shown in Figure T26.14 .

4.  Click the Analyze Images button in the lower left of the in CellProfiler
window.

5.  Open FCS Express.

6.  Open the FCS Express User Options by choosing .

7.  Select Cell Profiler Options from the Data Loading category (Figure
T26.35).

8.  Select csv from the delimiter drop-down list.

9.  Uncheck the Load path names from Cell Profiler table of contents file
check box.

10. Click OK to close the FCS Express User Options dialog.

Note: In this example, since there are no images associated with the data, the

Load Images check box must remain unchecked.

The dialog should resemble T26.35 when you are done.
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Figure T26.35  Data Loading Options for Numeric Data Only Importing

11. Select the Insert tab command (Figure T26.36).

Figure T26.36  Inserting a Dot Plot from Ribbon

12. Click anywhere on the layout and the Select data file dialog will appear.

13. Browse to the Default Output Folder where you stored your output data
from CellProfiler.

14. Change the Files of type: drop-down list to CellProfiler (*.cpout).  For
this example, they will be labeled cells_05.cpout and nuclei_05.cpout
(Figure T26.37).

15. Highlight cells_05.cpout.

16. Click Open. 
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Figure T26.37  Select Data File Dialog

Note: For this example we will use cells_05.cpout which will display data from
the 5 minute time point objects classified in the IdentifySecondaryObjects
module of CellProfiler which corresponds to the entire cell area. The file,
nuclei_05.cpout, will display data from the 5 minute time point objects classified
in the IdentifyPrimaryObjects module of CellProfiler which corresponds only to
the nuclear area of the cells.

17. Select AreaShape_Area for the X-Axis parameter (Figure T26.38).

18. Select Intensity_MeanIntensity_Cytoplasm for the Y-Axis
parameter (Figure T26.38).
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19. Click OK.

Figure T26.38  Open 2D Plots Dialog

A dot plot will appear (Figure T26.39).

Note: you can easily change dot size by selecting  within
the Format ribbon bar. 
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Figure T26.39  Dot Plot Created for
cells_05.cpout

Note: you can easily change Dot Size property by double-clicking the dot plot
and then selecting Overlays category the Formatting dialog to access this
setting.

In the next exercise, we will Select Individual Parameters for CellProfiler Export
.

22.26.9 Selecting Individual Parameters for CellProfiler Export

In this section, you will learn:

· How to export a selected number of parameters of interest from

CellProfiler rather than all of the measured values.

In the previous export sections, we have chosen to export all of the object size,
shape, and intensity parameters that are generated by CellProfiler. While some of
these parameters may be useful for your experiment not every parameter
defined by CellProfiler is useful for every experiment. In order to specifically
choose which parameters you would like to export you must split the export
process into two modules: one for the Image.cptoc and one for the selected
parameters in the .cpout files. This tutorial will guide you through the process by
modifying the Section5pipeline.cpproj pipeline located in the Tutorial Sample
Data archive . The pipeline as been designed for use with the Exporting Single
Images  tutorial which should be completed before beginning this tutorial.

2455
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1.  Load the Section5pipeline.cpproj pipeline in CellProfiler from the FCS

Express Tutorial Sample Data folder.

2.  Confirm the default input and output folders in CellProfiler to load and

store the data as shown in Figure T26.14 .

3.  Right click on ExportToSpreadsheet module.

4.  Choose Duplicate from the dialog.

5.  Click on the first ExportToSpreadsheet module to select it.

6.  Click on the Remove this data set button in the Data to export Nuclei

(nuclei_time.cpout) data set.

7.  Click on the Remove this data set button in the Data to export Cells

(cells_time.cpout) data set.

Note: Only the Data to export Image (Image_time.cptoc) data set will be

remaining in this module as in Figure T26.40.

Figure T26.40  First ExportToSpreadsheet Module for Only Image Data to Export
Remaining

8.  Click the second ExportToSpreadsheet module to select it.

2426
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9.  Click the Remove this data set button in the Data to export Image

(Image_time.cpout) data set.

Note: Only the  Data to export Nuclei (nuclei_time.cpout) data set and Data

to export Cells (cells_time.cpout) data set will be remaining in this module as in

Figure T26.41.

Figure T26.41  Second ExportToSpreadsheet module with Image Data to Export
Removed

10. Click Yes radio button in the Select the measurements to export

(Figure T26.42).

11. Click the Press button to select measurements (Figure T26.42).

12. Expand the  categories (Figure T26.42).

13. Check the box for Area (Figure T26.42).
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14. Check the box for the  category

(Figure T26.42).

Figure T26.42  Selecting Measurements to Export

15.  Expand the  categories

16. Check the box for Area.

17. Expand the  category.

18. Check the box for Cytoplasm.

19. Check the box for DNA.

20. Click OK.

21. Click Analyze images to run the pipeline.

The original ExportToSpreadsheet module is split into two: one for the

Image.cptoc and a second for the cells.cpout and nuclei.cpout. The Image.cptoc

will use the default export process to export all the information FCS Express

needs to import your data. The .cpout files will contain only the parameters for

AreaShape_Area, Intensity_MeanIntensity_Cytoplasm, and

Intensity_MeanIntensity_DNA. After analysis is complete, you may open the
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cells.cpout and nuclei.cpout files in FCS Express to view the new data set as you

did in the Importing Single Image Data section .

22.26.1
0

Exporting Tiled Images From CellProfiler

Often, high resolution imaging of large objects or specimens is accomplished by
tiling many smaller images to create a single large high-resolution image (also
referred to as a montage image). These small images are provided from the
acquisition instrument or software in two ways: automatically stitched together
or exported individually.  If the former, they must be broken into smaller images
for CellProfiler to analyze (due to memory limitations of CellProfiler) and then
FCS Express will reassemble the larger image. If the latter, CellProfiler can
analyze the smaller images as they are, and FCS Express can reassemble them
into a single larger image.

In the course of this tutorial, we will explain:

· Image naming conventions needed for FCS Express to import the tiled data

processed by CellProfiler.

· How to split large images into tiles for segmentation in CellProfiler.

· Exporting tiled images in CellProfiler for use in FCS Express

Naming Conventions for Tiled Images

When reconstructing a series of tiled images FCS Express will use information

stored in the filename to piece the images back together. In particular the words

"row" and "col" followed by a number indicate the position of the tile in the

image. Below are a few examples of this naming convention:

· mytiledimage_row00_col00.tif

· mytiledimage_row00_col01.tif

· mytiledimage_row00_col02.tif

The above file names represent the first three tiles (from left to right) of a tiled

image as indicated by their "row" and "col" positions. The words "row" and "col"

and the associated tile position should be added at the time of acquisition if

possible or post acquisition by manually renaming the files or using a file

renaming program.  

Starting with a Large Image

2426
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Large images may also be analyzed by Cell Profiler and FCS Express. Due to the

memory limits of most computers these images must first be "split" into smaller

images for image segmentation. We recommend splitting larger images using

Total Image Slicer to 500 x 500 pixel squares and setting the File name template

as: [name]_row%row_col%col.tiff . (Total image slicer will simultaneously

and automatically split the image to discrete squares and rename them with the

"rowXX" "colXX" naming convention).

Exporting Tiled Images in CellProfiler for use in FCS Express

The CellProfiler modules that will be discussed in this section are Load Images,

Convert Objects to Images, Save Images, and Export to Spreadsheet. The

completed pipeline for this example can be found in the Tutorial Sample Data

archive  within the Exporting Tiled Images in CP folder is named

CellProfilerTiledExportCOMPLETED.cpproj. The completed pipeline is meant

to be used as a template for comparison to your pipeline and represents the

finished product of this tutorial.

The example data set we will be using can be found in the Tutorial Sample Data

archive  within the Exporting Tiled Images in CP folder is named

"In_Situ_Cerebellum_Staining". The sample data set (kindly provided by

Dragan Maric, Ph.D) represents a 3 color + bright field experiment in which a

portion of a rat cerebellum was imaged. To access the final product of the

pipeline and a layout of the data please visit our Applications Examples web page.

The steps for exporting data from CellProfiler have been broken down by module

according to the CellProfilerTiledExport.cp pipeline. After loading the

CellProfilerTiledExport.cpproj pipeline in CellProfiler, follow the steps below to

amend the pipeline to prepare for export to FCS Express.

Selecting Default Output Folders

To organize your data correctly for FCS Express, ensure the Default Output
Folder is the same folder where your images are stored and used for the
Default Input Folder (Figure T26.43).  

Note: The DefaultOUT.mat file will also be exported to the Output Folder. This file
is for use in MATLAB. If you do not wish to use this file, we recommend deleting
it to conserve disk space.
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Figure T26.43  Set the Default Input and Output Folders to the Same Location

A.  Loading Images, Extracting Metadata, Assigning Names

In order for FCS Express to recognize your data in 96-well format, metadata
from the image file names must be extracted. A Regular Expression must be
defined to find the metadata in the file name or path of the data by following
these steps in CellProfiler (Figure T26.2 ):

1.  Click Images category in left column of CellProfiler window.

2.  Drag and drop In_Situ_Rat_Cerebellum_Staining subfolder of
Exporting Tiled Images in CP into designated area.

3.  Click Metadata category directly below Images.

4.  Click Yes radio button in the Extact metadata? box.

5.  Confirm Metadata extraction drop-down list is set to Extract from
file/folders.

6.  Confirm Metadata source drop-down list is set to File name.

7.  Click the magnifying glass icon to the right of Regular Expression to field.

8.  Erase all text from Regex: field.

9.  Copy and paste following text into Regex: field, which will define the row
tile and column tile:

_0000_350_DAPI_row(?P<rowtile>[0-9]{1,3})_col(?P<coltile>[0-9]
{1,3}).tiff

10. Click Submit in Regular expression editor window.

11. Click Update button in lower portion to see information extracted for
each of the images.

12. Click NamesandTypes directly below Metadata.

13. Change Assign a name to drop-down list to Image matching rules.

14. Confirm CellMask in blank field to right of Contain drop-down list.

15. Confirm CellMask is entered in Name to assign these field.

2399
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16. Click Add another image button.

17. For second image set, enter GLAST in blank field to right of Contain
drop-down list.

18. Confirm GLAST in Name to assign these field.

19. Click Add another image button.

20. For third image set, enter Bright in blank field to right of Contain drop-
down list.

21. Confirm Bright in Name to assign these field.

22. Click Add another image button.

23. For fourth image set, enter DAPI in blank field to right of Contain drop-
down list.

24. Confirm DAPI in Name to assign these field.

25. Click Update button in lower portion. 

26. Screen should resemble Figure T26.44 below for Metadata module.

Notes: 

· Follow these links for a tutorial on "Regular Expressions" and how to

translate regular expressions.

· Setting up metadata and regular expressions only has to be done for one

image in the set. For this example, it has been set up for the DAPI channel.

· The regular expression output names: Well, Row, Column, and Col may only be

used with plate based or montage imaging experiments. Using any of these
names for a single image experiment will result in a non-working export.

http://gnosis.cx/publish/programming/regular_expressions.html
http://docs.python.org/library/re.html
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Figure T26.44  Setting up a Regular Expression in the LoadImages Module

B.  ConvertObjectsToImage Modules

In these modules, the objects you have defined through the "Identify
Primary/Secondary/Tertiary Objects" modules will be converted to image
masks that FCS Express will use during import and analysis. See Figure
T26.45 for an example of the module window.

1.  Select the first ConvertObjectsToImage module in the pipeline.

2.  Choose Nuclei from Select the input objects drop-down list.

3.  Enter Nuclei in the Name the output image field.

4.  Select uint 16 from the Select the color type drop-down list (see Figure
T26.45 below). 

5.  Select the second ConvertObjectsToImage module in the pipeline.

6.  Choose Cells from Select the input objects drop-down list.

7.  Enter Cells in the Name the output image field.

8.  Select uint 16 from the Select the color type drop-down list. 

9.  Select the third ConvertObjectsToImage module in the pipeline.

10. Choose Cytoplasm from Select the input objects drop-down list.

11. Enter Cytoplasm in the Name the output image field.

12. Select uint 16 from the Select the color type drop-down list.

Note: Repeat steps 1-4 for as many objects you have defined through the
Identify Primary/Secondary Objects module when defining your own pipeline.



FCS Express 7 Manual2464

© 2023 De Novo Software

Note: In order for FCS Express to properly import the data the Name the
output image name must be the same as the Select the input objects name
and is case sensitive.

Figure T26.45  ConvertObjectsToImage Module: Defining Nuclei and Cells Image
Masks

C.  SaveImages Module

The image masks that were defined in the ConvertObjectsToImage
modules must now be saved and related to the original images/data. 

1.  Select the first SaveImages module in the pipeline.

2.  Set the Select the type of image to save drop-down list to Image.

3.  Choose Cells for the Select the image to save drop-down list.

a. Note: when defining your own pipeline, select the appropriate
image you defined in the ConvertObjectsToImage module.

4.  Set the Select method for constructing file names drop-down list to
Single name.

5.  Enter CellLabel_ in the Enter single file name field.

6.  Right-click after CellLabel_, choose rowtile, and enter an underscore
"_"after it.

7.  Right-click after rowtile_ and choose coltile.

8.  Select the second SaveImages module in the pipeline.

9.  Set the Select the type of image to save drop-down list to Image.

10. Choose Nuclei for the Select the image to save drop-down list.

11. Set the Select method for constructing file names drop-down list to
Single name.

12. Enter NucleiLabel_ in the Enter single file name field.

13. Right-click after NucleiLabel_, choose rowtile, and enter an underscore
"_"after it.

14. Right-click after rowtile_ and choose coltile.
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15. Select the third SaveImages module in the pipeline.

16. Set the Select the type of image to save drop-down list to Image.

17. Choose Cytoplasm for the Select the image to save drop-down list.

18. Set the Select method for constructing file names drop-down list to
Single name.

19. Enter CytoplasmLabel_ in the Enter single file name field.

20. Right-click after CytoplasmLabel_, choose rowtile, and enter an
underscore "_"after it.

21. Right-click after rowtile_ and choose coltile.

Perform steps 22-27 on both SaveImages modules set up for CellLabel,
NucleiLabel, and CytoplasmLabel .

22. Confirm tiff from the Saved file format drop-down list.

23. Set Image bit depth drop-down list to 16-bit integer.

24. Choose Default Output Folder from Output file location drop-down
list.

25. Click Yes radio button in the Overwrite existing files without warning?
box.

26. Set When to save as Every cycle from the drop-down list.

27. Click Yes radio button in Record the file and path information to the
saved image? box.

Note: rowtile and coltile are values you defined as regular expressions for the
load images module. Using regular expressions allows every output file to be
assigned a unique file name based on the text from the input file name. This
will prevent output file names from overwriting each other and allows FCS
Express to identify the unique image mask associated with each image file.

The SaveImages module for CellLabel should now look like Figure T26.46.
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Figure T26.46  Defining the SaveImages Module

D.  ExportToSpreadsheet Module

Now that all of the images and object image masks have been defined and saved
for analysis, you must now ask CellProfiler to export the measurements you
wish to view in FCS Express. For this example, we will export all measurements.

Note: If you would like to only export certain parameters please see the
Selecting Individual Parameters for CellProfiler Export section.

1.  Select the first ExportToSpreadsheet module.

2.  Confirm the Select the column delimiter drop-down list is set to
Comma (",").

3.  Choose Default Output Folder from the Output file location drop-down
list.

4.  Click No radio button in the Add a prefix to file names? box.

5.  Click No radio button in the Export all measurement types? box.

6.  Choose Image from the first Data to export drop-down list.

7.  Click No radio button in the Use the object name for the file name?
box.

8.  Replace DATA.csv with Image.cptoc in File name field.

9.  Select the second ExportToSpreadsheet module.

10. Confirm the Select the column delimiter drop-down list is set to
Comma (",").

11. Choose Default Output Folder from the Output file location drop-
down list.

12. Click No radio button in the Add a prefix to file names? box.
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13. Click No radio button in the Export all measurement types? box.

Note: In this case, measurements have already been chosen for you and the
nuclei.cpout file has been setup. Click on the Press to select measurements
button to review which measurements have been selected.

14. Click Add another data set button.

15. Choose Cells from the second Data to export drop-down list.

16. Click No radio button in the Use the object name for the file name?
box.

17. Replace DATA.csv with cells.cptoc in File name field.

18. Click Add another data set button.

19. Repeat steps 14-18 for "Cytoplasm" and set the file name as
cytoplasm.cpout.

The second ExportToSpreadsheet module options should look like Figure
T26.47 when you are done.

Note 1: on file extensions: ".cptoc" stands for CellProfiler Table of Contents and
".cpout" stands for CellProfiler Output. The "Image.cptoc" file stores information
about the location and number of images for all objects processed in the
pipeline, while the separate "Nuclei.cpout" and "Cells.cpout" store the actual raw
data associated with individual objects and analysis. There should be a separate
".cpout" file defined for each object mask defined in CellProfiler. Only one
"Image.cptoc" file is needed.

Note 2:The name of your .cpout file must begin with the name of the object
data you are exporting and may only be include the object name and regular
expressions. For example: the file names nuclei.cpout and nuclei_<regular
express>.cpout will result in a proper export while dataset1nuclei.cpout or
<regularexpression>_nuclei.cpout will resulting in a non-working export. 
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Figure T26.47  Second ExportToSpreadsheet Module

20. Select Analyze images to run the pipeline. The folder where your images
are stored will now contain the cells.cpout, nuclei.cpout, cytoplasm.cpout and
Image.cptoc files. There will also be a CellLabel, NucleiLabel, and
CytoplasmLabel image associated with every original image/well from the
tiled data set.

In the next section, we will import and analyze the Tiled or Montage Image .2469
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22.26.1
1

Importing Tiled Images

This section pertains to importing data that was exported from CellProfiler and
generated from a set of tiled images. Please see Exporting Tiled Images  for
instructions how to export the data from CellProfiler.

After adjusting the export settings in CellProfiler and running your pipeline, you
may proceed to analyze your images and import the data into FCS Express. 

Importing the Tiled Images Experiment to FCS Express

Note on FCS Express Preferences before starting these steps of the tutorial:

The File selection dialog must be enabled:

A. Open the FCS Express User Options by choosing .

B. Check the When creating a new plot, always display the selection
dialog box in the Files/Directories category.

(Enabling this feature is not a requirement of FCS Express, it has been selected
for convenience in this tutorial.)

1.  From the Exporting Tiled Images in CP folder, load the
CellProfilerTiledExportCOMPLETED.cpproj pipeline in CellProfiler.

2.  Select the default input and output folders in CellProfiler to load and store
the data as in the Exporting Tiled Images  tutorial.

3.  Drag and drop In_Situ_Rat_Cerebellum_Staining subfolder of
Exporting Tiled Images in CP folder into the designated area.

4.  Click the Analyze Images button in the lower left of the in CellProfiler
window.

5.  Open FCS Express.

6.  Open the FCS Express User Options by choosing 

7.  Select Cell Profiler Options from the Data Loading category (Figure
T26.48).

8.  Select csv from the delimiter drop-down list.

9.  Check the Load Images check box.

10. Uncheck the Load path names from Cell Profiler table of contents file
check box.

11. Click OK to close the FCS Express User Options dialog.

2459
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Figure T26.48  CellProfiler Data Loading Options

12. Select the Insert tab group command
(Figure T26.49).

Figure T26.49  Choosing a Picture
Plot to Insert

13. Click anywhere on the layout and the Select data file dialog will appear.

14. Browse to the Default Output Folder where you stored your output data
from CellProfiler.

15. Change the Files of type: drop-down list to CellProfiler (*.cpout)
(Figure T26.50). Icons for the documents outputted by CellProfiler will
appear. For this example, they will be labeled cell.cpout, cytoplasm.cpout,
and nuclei.cpout.
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Figure T264.50  Select Data File Dialog

16. Highlight cells.cpout and click Open.

Note: For this example, we will use cells.cpout which will display data from the
cellular objects classified in the IdentifySecondaryObjects module of CellProfiler
which corresponds to the entire cell area. Nuclei.cpout will display data from the
objects classified in the IdentifyPrimaryObjects module of CellProfiler which
corresponds only to the nuclear area of the cells. The Cytoplasm.cpout file will
display data from the objects classified in the IdentifyTertiaryObjects module of
CellProfiler which corresponds to the area between the nuclear object and the
cell boundary.
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17. Highlight CellMask from the Image Parameter list box of the Open 2D
Plots dialog (Figure T26.51) to view the cellular image. 

18. Click OK.
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Figure T26.51  Choosing Image Parameters from the Open 2D Plots
Dialog

A picture plot will appear on the layout (Figure T26.52). 
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Figure T26.52  Cells.cpout Picture Plot

Note about panning and zooming (please refer the working with picture plots

chapter  for more details)

By default, Picture plots display images at their original zoom starting from their

top-right corner. When the original size of the picture exceeds the size of the

plot, to see a larger part of the picture the user can:

· enlarge the plot itself and/or (Figure T26.52a below)

· change the zoom of the Picture plot by selecting Specific Options from the

Format tab of the ribbon bar (Figure T26.52b below). Should the zooming not

being enough, the plot can be resized in addition.

If a different region of the image should be displayed within the picture plot,
please change the panning (please refer the working with picture plots chapter
for more details).

267
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Figure T26.52a
The picture plot (left) has been resized in order to display teh full picture (right) 
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Figure T26.52b

The picture plot (top) has been zoomed through the Specific Options dialog in
order to display a larger part of the picture (bottom).
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Notice the image is only displaying the object "cut-outs" since we have decided

to not load the background images. To make the display look more appropriate,

we will select the background (or fill) color.

19. Double-click the picture plot. The Formatting dialog will appear.

20. Choose the Fill category (Figure T26.53).

21. Choose Black from the Solid Color drop-down box (Figure T26.53).

Figure T26.53  Formatting Background of Picture
Plot

The picture plot will now have a black background as the original image did

(Figure T26.54).
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Figure T26.54  Picture Plot with Black
Background

To continue exploring image data analysis, please visit the Picture Plots  or

Introduction to FCS Express Image Cytometry  tutorials, which describe

working with your data in FCS Express.

22.26.1
2

Exporting Plate Based Data That Contains Multiple Fields Per
Well

Exporting Plate Based Data That Contains Multiple Fields Per Well

Often, images of multiple fields within a single well of a plate format experiment
are taken. CellProfiler can segment all of the individual field images and pool the
data as a single well for export to FCS Express Image Cytometry. The resulting
data sets may then be opened in FCS Express to review and analyze the data in
Plate Heat Maps, Picture Plots, Dot Plots, and Histograms.

In the course of this tutorial we will explain:

· Image naming conventions needed for FCS Express to import the multi well,

multi field, imaging data processed by CellProfiler.

· Exporting Multiple Well, Multiple Field Location, Imaging data in CellProfiler for

use in FCS Express.

Naming Conventions for Plate Based Multiple Field Location Image Data

Sets

2544
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When reconstructing a series of plate based data containing multiple fields per

well, FCS Express will use information stored in the file name to assign well

locations and digitally merge the multiple field images into a single image. In

particular, the regular expression names Row and Column, well locations, and

rowtile and coltile, the field location within the well, should be used when

exporting plate-based data with multiple image locations per well. These names

define the plate location of the well by Row Letter and Column Number and the

location of the field within the well by rowtile and coltile position. To successfully

use regular expressions for processing the data in CellProfiler and analyzing the

data in FCS Express, the information for Well numbers and field locations must

be stored somewhere within the file name of the image. In Figure T26.55 below,

the image file name is: Channel1-01-A-01_00_00. The red box highlights the

Row and Column information (well A01), and the blue box highlights the field

location (position 00,00). 

Figure T26.55   Well Row and
Column Information (Red Outline),

Field Location (Blue Outline) 

Exporting Multiple Field Location Plate Imaging Data in CellProfiler for use
in FCS Express

The CellProfiler modules that will be discussed in this section are Load Images,

Save Images, and Export to Spreadsheet. The completed pipeline for this

example can be found in the Tutorial Sample Data archive  within the Multiple

Field Location Plate Imaging folder is named

MultipleFieldLocationPipelineCOMPLETED.cpproj. The completed pipeline is

meant to be used as a template for comparison to your pipeline and represents

the finished product of this tutorial.

1682
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The example data set we will be using can be found in the Tutorial Sample Data

archive  within the Multiple Field Location Plate Imaging folder. The

example data set contains 16 images  which are broken down into two channels

of images (channel 1 and channel 2) and two wells (A1 and A2) with 4 fields per

well. 

The steps for exporting data from CellProfiler have been broken down by module

according to the MultipleFieldLocationPipeline.cpproj pipeline. After loading

the MultipleFieldLocationPipeline.cpproj pipeline in CellProfiler, follow the steps

below to amend the pipeline to prepare for export to FCS Express.

Selecting Default Output Folder

To organize your data correctly for FCS Express, ensure the Default Output
Folder is the same folder where your images are stored and used for the
Default Input Folder (Figure T26.56).  

Note: The DefaultOUT.mat file will also be exported to the Output Folder. This file
is for use in MATLAB. If you do not wish to use this file, you can select Do not
write MATLAB or HDF5 files from the Output file format drop-down menu.

Figure T26.56  Set the Default Input and Output Folders to the Same Location

A.  Loading Images, Extracting Metadata, Assigning Names

In order for FCS Express to recognize your data is in 96 well format,
metadata from the image file names must be extracted. A Regular Expression
must be defined to find the metadata in the file name or path of the data by
following these steps in CellProfiler (Figure T26.2 ):

1.  Click Images category in left column of CellProfiler window.

2.  Drag and drop Multiple Field Location Plate Imaging folder into
designated area.

3.  Click Apply filters to the file list to remove non-image files.  Font for
Experiment.ini should become gray.

4.  Click Metadata category directly below Images.

5.  Click Yes radio button in the Extact metadata? box.
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6.  Confirm Metadata extraction drop-down list is set to Extract from
file/folders.

7.  Confirm Metadata source drop-down list is set to File name.

8.  Click the magnifying glass icon to the right of Regular Expression to field.

9.  Erase all text from Regex: field.

10. Copy and paste following text into Regex: field, which will define the
Channel Number, Well Number, Row of the plate with a letter, Column with
a number, Row Tile with a number, and column tile with a number:

Channel1-[0-9]{2}-(?P<Row>[A-H])-(?P<Column>[0-9]{2})_(?
P<rowtile>[0-9]{1,2})_(?P<coltile>[0-9]{1,2}).tif

11. Click Submit in Regular expression editor window.

12. Click Update button in lower portion to see information extracted for
each of the images.

13. Click NamesandTypes directly below Metadata.

14. Change Assign a name to drop-down list to Image matching rules.

15. Enter Channel2- in blank field to right of Contain drop-down list.

16. Confirm DNA is entered in Name to assign these field.

17. Click Add another image button.

18. For second image set, enter Channel1- in blank field to right of Contain
drop-down list.

19. Replace GFP in Name to assign these field with Cytoplasm.

20. Click Update button in lower portion. 

21. Screen should resemble Figure T26.57 below for Regular expression
editor window of Metadata module.

Notes: 

· Follow these links for a tutorial on "Regular Expressions" and how to

translate regular expressions.

· Setting up metadata and regular expressions only has to be done for one

image in the set. For this example, it has been set up for Channel2.

· The regular expression output names: Well, Row, Column, rowtile and

coltile may only be used with plate based or montage imaging experiments.

http://gnosis.cx/publish/programming/regular_expressions.html
http://docs.python.org/library/re.html
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These output names are reserved, and should not be used for anything
aside from denoting the well and/or field positions.

Figure T26.57  Setting up a Regular Expression in the LoadImages Module

B.  SaveImages Module

The image masks that were defined in the ConvertObjectsToImage
modules must now be saved and related to the original images/data. 

1.  Select the first SaveImages module in the pipeline.

2.  Set the Select the type of image to save drop-down list to Image.

3.  Choose Cells for the Select the image to save drop-down list.

a.  Note: when defining your own pipeline, select the appropriate
image you defined in the ConvertObjectsToImage module.

4.  Set the Select method for constructing file names drop-down list to
Single name.

5.  Enter CellLabel_ in the Enter single file name field.

6.  Right-click after CellLabel_, choose Row, and enter an underscore
"_"after it.

7.  Right-click after Row_ and choose Column.

8.  Right-click after Column_, choose rowtile, and enter an underscore
"_"after it.

9.  Right-click after rowtile_ and choose coltile.

10. Select the first SaveImages module in the pipeline.

11. Set the Select the type of image to save drop-down list to Image.

12. Choose Nuclei for the Select the image to save drop-down list.

13. Set the Select method for constructing file names drop-down list to
Single name.

14. Enter NucleiLabel_ in the Enter single file name field.
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15. Right-click after NucleiLabel_, choose Row, and enter an underscore
"_"after it.

16. Right-click after Row_ and choose Column.

17. Right-click after Column_, choose rowtile, and enter an underscore
"_"after it.

18. Right-click after rowtile_ and choose coltile.

Note: Row, Column, rowtile and coltile are values you defined as regular
expressions for the load images module. Using regular expressions allows every
output file to be assigned a unique file name based on the text from the input
file name. This will prevent output file names from overwriting each other and
allows FCS Express to identify the unique image mask associated with each
image file.Perform steps 15-22 on both SaveImages modules set up for
CellLabel and NucleiLabel.

19. Confirm tiff from the Saved file format drop-down list.

20. Set Image bit depth drop-down list to 16-bit integer.

21. Choose Default Output Folder from Output file location drop-down
list.

22. Click Yes radio button in the Overwrite existing files without warning?
box.

23. Set When to save as Every cycle from the drop-down list.

24. Click Yes radio button in Record the file and path information to the
saved image? box.

 The SaveImages module for CellLabel should now match Figure T26.58.

Figure T26.58  Defining the SaveImages Module

C.  ExportToSpreadsheet Module
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Now that all of the images and object image masks have been defined and saved
for analysis, you must now ask CellProfiler to export the measurements you
wish to view in FCS Express. For this example, we will export all measurements.

Note: If you would like to only export certain parameters please see the
Selecting Individual Parameters for CellProfiler Export section.

1.  Select the ExportToSpreadsheet module.

2.  Confirm the Select the column delimiter drop-down list is set to
Comma (",").

3.  Choose Default Output Folder from the Output file location drop-down
list.

4.  Click No radio button in the Add a prefix to file names? box.

5.  Click No radio button in the Export all measurement types? box.

6.  Choose Image from the first Data to export drop-down list.

7.  Click No radio button in the Use the object name for the file name?
box.

8.  Replace DATA.csv with Image.cptoc in File name field.

9.  Click Add another data set button.

10. Choose Nuclei from the second Data to export drop-down list.

11. Click No radio button in the Use the object name for the file name?
box.

12. Replace DATA.csv with nuclei.cptoc in File name field.

13. Click Add another data set button.

14. Repeat steps 10-12 for "Cells" and set the file name as cells.cpout.

The ExportToSpreadsheet module options should look like Figure T26.59 when
you are done.

Note 1: on file extensions: ".cptoc" stands for CellProfiler Table of Contents and
".cpout" stands for CellProfiler Output. The "Image.cptoc" file stores information
about the location and number of images for all objects processed in the
pipeline, while the separate "Nuclei.cpout" and "Cells.cpout" store the actual raw
data associated with individual objects and analysis. There should be a separate
".cpout" file defined for each object mask defined in CellProfiler. Only one
"Image.cptoc" file is needed.

2455
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Note 2:The name of your .cpout file must begin with the name of the object
data you are exporting and may only be include the object name and regular
expressions. For example: the file names nuclei.cpout and nuclei_<regular
express>.cpout will result in a proper export while dataset1nuclei.cpout or
<regularexpression>_nuclei.cpout will resulting in a non-working export. 

Figure T26.59  ExportToSpreadsheet Module

15. Select Analyze images to run the pipeline. The folder where your images
are stored will now contain the cells.cpout, nuclei.cpout, and Image.cptoc
files. There will also be a CellLabel  and NucleiLabel image associated with
every original image from the data set.
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In the next section, we will import and analyze the plate based multiple field
location imaging data

22.26.1
3

Importing Plate Based Multiple Field Location Imaging Data

After adjusting the export settings in CellProfiler and running your pipeline, you
may proceed to import the data into FCS Express. FCS Express only needs one
additional piece of information regarding the setup of your experiment.
CellProfiler currently does not export the plate format that was used for your
experiment. A series of standard plate format definitions can be downloaded
from the FCS Express website. For this example, we will be using a 6 well
template which can found in the Tutorial Sample Data archive  within the
Multiple Field Location Plate Imaging folder and is labeled Experiment.ini. The
plate format definition file must be called Experiment.ini and placed into the
Default Output Folder you defined in CellProfiler.

Importing the Plate Based Multiple Field Location Imaging Experiment to FCS
Express

Note on FCS Express Preferences before starting these steps of the tutorial:

The File selection dialog must be enabled:

A. Open the FCS Express User Options by choosing .

B. Check the When creating a new plot, always display the selection
dialog box in the Files/Directories category.

(Enabling this feature is not a requirement of FCS Express, it has been selected
for convenience in this tutorial.)

1.  Download the example data from the Tutorial Sample Data archive
within the Multiple Field Location Plate Imaging folder.

2.  Load the MultipleFieldLocationPipelineCOMPLETED.cpproj pipeline into
CellProfiler.

3.  Select the default input and output folders in CellProfiler to load and store
the data as shown in Figure T26.56 .

4.  Drag and drop Multiple Field Location Plate Imaging folder into the
designated area of the Images module. 

5.  Click the Analyze Images button in the lower left of the in CellProfiler
window.

2486
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6.  Ensure the Experiment.ini file, located in the Tutorial Sample Data
archive  within the Multiple Field Location Plate Imaging folder, is placed in
the folder containing your exported CellProfiler data.

7.  Open FCS Express.

8.  Open the FCS Express User Options by choosing 

9.  Select Cell Profiler Options from the Data Loading category (Figure
T26.60).

10. Select csv from the delimiter drop-down list.

11. Check the Load Images check box.

12. Uncheck the Load path names from Cell Profiler table of contents
file check box.

13. Click OK to close the FCS Express User Options dialog.

Figure T26.60  CellProfiler Data Loading Options for Importing Plate Based Multiple
Field Location Imaging Data

14. Select the Insert tab group command
(Figure T26.61).

Figure T26.61  Inserting Plate Heat
Map from Ribbon

1682
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15. Click anywhere on the layout and the Select data file dialog will appear.

16. Browse to the Default Output Folder where you stored your output data
from CellProfiler.

17. Change the Files of type: drop-down list to Cell Profiler (*.cpout)
(Figure T26.62). Only documents output by CellProfiler will appear. For this
example, they will be labeled cells.cpout and nuclei.cpout.

Figure T26.62  Choosing CellProfiler Files

18. Highlight cells.cpout. 
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19. Click Open. 

Note: For this example, we will use cells.cpout which will display data from
objects classified in the IdentifySecondaryObjects module of CellProfiler which
corresponds to the entire cell area. The file, nuclei.cpout, will display data from
objects classified in the IdentifyPrimaryObjects module of CellProfiler which
corresponds only to the nuclear area of the cells.

20. Highlight the Y-Axis Parameter you wish to view in the heat map from
the Open 2D Plots dialog. For this example, choose
Intensity_MeanIntensity_Cytoplasm (Figure T26.63).
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Figure T26.63  Opening a Plate Heat Map and Choosing the Y-Axis
Parameter from the Open 2D Plots Dialog

21. Click OK.

A plate heat map will appear on the layout (Figure T26.64). 
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Figure T26.64  Example of a Plate Heat Map Generated from a 6
Well Plate Based Multiple Field Location Imaging Data

22. Right-click the plate heat map. 

23. Choose .

24. Create a well gate on Well A-A1 (first well on the left) named Gate 1.

25. Choose the 

26. Click anywhere on the layout to insert a picture plot.

27. Choose the cells.cpout file from the Select data file dialog.

28. Click Open.

29. Select Gate 1 from the Gate drop-down list.

30. Click OK.

The picture plot will display the four fields from well A-A1 as defined by the well
gate named Gate 1 (Figure T26.65). 
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Figure T26.65  Picture Plot for Four Images
from Well A01, Gated on Gate 1

Note about panning and zooming (please refer the working with picture plots

chapter  for more details)

By default, Picture plots display images at their original zoom starting from their

top-right corner. When the original size of the picture exceeds the size of the

plot, to see a larger part of the picture the user can:

· enlarge the plot itself and/or (Figure T26.65a below)

· change the zoom of the Picture plot by selecting Specific Options from the

Format tab of the ribbon bar (Figure T26.65b below). Should the zooming not

being enough, the plot can be resized in addition.

If a different region of the image should be displayed within the picture plot,
please change the panning (please refer the working with picture plots chapter
for more details).
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Figure T26.65a
The picture plot (left) has been resized in order to display teh full picture (right)
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Figure T26.65b
The picture plot (top) has been zoomed through the Specific Options dialog in order

to display a larger part of the picture (bottom).
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Finally, we will discuss frequently asked questions in the CellProfiler FCS Express
Knowledge Base .

22.26.1
4

CellProfiler for FCS Express Knowledge Base

We understand it can be difficult to learn new software such as CellProfiler. Below
are some of the common questions and export errors that users may
experience when exporting for FCS Express Image Cytometry. If you have
specific questions related to creating pipelines in CellProfiler please see the
CellProfiler website at http://www.cellprofiler.org/ or visit their user support
forum at http://cellprofiler.org/forum/. You may also find a webinar covering the
specifics of CellProfiler segmentation at: CellProfiler Webinar

File Output and Organization:
 

File extensions:

· The file extension ".cptoc" stands for CellProfiler Table of Contents and ".cpout"

stands for CellProfiler Output. The "Image.cptoc" file stores information about
the location and number of images for all objects processed in the pipeline,
while the separate "xxxxxx.cpout" files store the actual raw data associated
with individual objects and analysis. 

· There should be a separate ".cpout" file defined for each object mask defined in

CellProfiler and only one "Image.cptoc" file.

Folder Structure: 

After images are processed in CellProfiler, FCS Express must be able to access
the original images (Figure T26.66 below).

·  The original image files should be stored in the same folder that contains your

.cptoc, cpout, and image mask files.

· An Experiment.ini file must be found in the same data folder as described

immediately above if you wish to view the multiwell plate data using the Heat
Maps  feature in FCS Express.  This file describes the plate format. 
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Figure T26.66  CellProfiler Data Loading Options

Loading Images and IdentifyPrimaryObjects Module:

· Please note the value entered in Name to Assign these field for

NamesandTypes cannot be the same as the value entered in the Name the
primary objects field for the Identify Primary Objects module.

Using the ConvertObjectsToImage Module:

· In order for FCS Express to properly import image masks from the

ConvertObjectsToImage module the Name the output image name must
be the same as the Select the input objects name and is case sensitive as in
Figure T26.67 below. 

Figure T26.67  ConvertObjectsToImage Module: Naming the output image the
same as the input object.

Naming Files and Regular Expressions:

· The regular expression output names: Well, Row, Column, and Col may only be

used with plate based or montage imaging experiments. Using any of these
names for a single image experiment will result in a non-working export. Follow
these links for a tutorial on "Regular Expressions" and how to translate regular
expressions.

http://gnosis.cx/publish/programming/regular_expressions.html
http://docs.python.org/library/re.html
http://docs.python.org/library/re.html
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· The name of your .cpout file must begin with the name of the object data you

are exporting and may only be include the object name and regular
expressions. For example: the file names nuclei.cpout and nuclei_<regular
express>.cpout will result in a proper export while dataset1nuclei.cpout or
<regularexpression>_nuclei.cpout will resulting in a non-working export.

· Working with Plate Based Data

o The regular expression names Row and Column should be used when

exporting plate based data. These names define the plate location of the
image by Row Letter and Column Number found in the image name. In Figure
T26.68 below the original image name is found in the blue circle while the
image mask name, based on the Row and Column regular expressions, can
be found in the red circle.  

o

Figure T26.68  NucleiLabel and CellLabel Image Mask .tiff File (Red Oval) for
Respective Raw Image Field (Blue Oval)

· Working with Tiled Images:
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o When reconstructing a series of tiled images FCS Express will use information

stored in the filename to piece the images back together. In particular the

words "row" and "col" followed by a number indicate the position of the tile in

the image. Numbering for tiled images must begin at 0_0, for instance

row00_col00. Below are a few examples of this naming convention:

mytiledimage_row00_col00.tif

mytiledimage_row00_col01.tif

mytiledimage_row00_col02.tif

The above file names represent the first three tiles (from left to right) of a tiled

image as indicated by their "row" and "col" positions. The words "row" and "col"

and the associated tile position should be added at the time of acquisition if

possible or post acquisition by manually renaming the files or using a file

renaming program.  

· Working with Plate Based Data That Contains Images from Multiple

Field Locations Within the Well
o The regular expression names Row and Column (for the well locations) and

row and col (for the well image location)  should be used when exporting
plate based data with multiple image locations per well. These names define
the plate location of the well by Row Letter and Column Number and the
image location within the well by row and col found in the image name. In
Figure T26.69 below, the original image name is found in the blue circle while
the image mask name, based on the Row, Column, row and col regular
expressions, can be found in the red circle. Numbering for multiple well image
locations must begin at 0_0, for instance row00_col00.
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Figure T26.69  CellLabel Image Mask .tiff File (Red Oval) for
Respective Raw Image Field (Blue Oval) 

22.27 ImageJ Export

ImageJ is free open-source software designed to process and analyze images.
Through the use of macros and plugins users can automate tasks and create
custom tools. De Novo Software has created macros and plugins for ImageJ
that allow you to export many types of imaging experiments from ImageJ to
FCS Express Version  (see our Example Web page for specific examples). Once
your data is properly exported from ImageJ, FCS Express Image Cytometry will
allow you to perform a flow cytometry style data analysis on your data with all
of our familiar 2D plots and new plotting features  such as picture plots and
heat maps.

The tutorial will use sample data to:

· Export a single image from ImageJ to FCS Express

· Create a .ijx Analysis Configuration file

· Use a .ijx Analysis Configuration file to export a group or set of images from

ImageJ to FCS Express
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For an overview and further descriptions regarding the De Novo Software
ImageJ Macros please see the links below: 

· General workflow for exporting ImageJ data to FCS Express

· ImageJ Macros for FCS Express General Overview

· Overview for the DNSMacroExample.ijm macro used to export data from

ImageJ to FCS Express

· Overview for the DNSAnalysisCreator.ijm macro to create an .ijx Analysis

Configuration File  

· ImageJ for FCS Express Knowledge Base

Note: The tutorials will not focus on how to create macros or use ImageJ but will
focus on the macros De Novo Software has provided. For more help with ImageJ
please see the ImageJ website at http://rsbweb.nih.gov/ij/index.html or write to
the very helpful and informative ImageJ Mailing List.

22.27.1 ImageJ Macros Overview

De Novo Software has provided two ImageJ macros that will help you export
your image analysis from ImageJ to FCS Express Image Cytometry. The macros
can be downloaded from the De Novo Software website at
https://denovosoftware.com/faq/kb-how-do-i-use-imagej-with-fcs-
express/#macros.

General Overview:

The macros provided by De Novo Software are used for the following:

· DNS Macro Example Macro: 

o  The DNSMacroExample.ijm macro  will process your images and export

your segmentation and single cell image analysis results in a way that FCS
Express Image Cytometry can read. The macro will process images and
generate:

1.  Object by object numerical results 
2.  Mask images of the segmented objects
3.  An *.ijout file that FCS Express Image Cytometry will load to examine

the object by object data while relating results back to the original image
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The macro can analyze images from many use case listed below (please see full
details on use cases in the DNS Macro Example Overview)

·  A set of single standalone images 

·  An image with multiple channels (ie. Red, Green, and Blue, or DAPI, CD4,

and Protein X etc.) 
·  Images from multiple wells in multi well plate format (ie. 96 well plate)

·  Images from multiple fields of view (ie. multiple fields of one well in a

multi-well format or a tiled/montage image)
·  Any combination of multiple channels, multiple wells, and multiple fields of

view

·  DNS Analysis Creator Macro: 

o Creates an *.IJX analysis configuration file that ImageJ can use to order,

group, and process images in the above mentioned sets. (please see full
details on use cases in the DNS Analysis Creator Overview)

    When images belong to a grouping the user must generate an Analysis
Configuration file with an .IJX extension. The Analysis Configuration file tells FCS
Express how the different images are related to each other. For example, if two
images represent channel 1 and channel 2 from a single field or if 96 separate
images make up the contents of a 96 well plate based experiment. The
DNSAnalysisCreator.ijm macro has been designed to assist the user in creating
the Analysis Configuration file. 

In the next section, we will give a general overview of the DNS Macro Example
 

22.27.1.
1

DNS Macro Example Overview

The DNS Macro Example Macro will process your images and export your
segmentation and single cell image analysis results in a way that FCS Express
Image Cytometry can read. The macro can process and export images from
ImageJ in the five use cases listed below.

A.  A set of single standalone images:

1.  A set of single standalone images in a folder: For
example, a series of single images (one channel) from
different samples. If the user selects a folder, this macro will
generate one .ijout file per valid image file in that folder.   (If
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you would like to add any other image format that ImageJ
supports please check and/or update the "function
validImageFileName" and "function MaskImageFile" sections of
the macro) This means one subfolder with masks/results per

file. The name of the .ijout file will be the name of each of the
original image files. This is the only use case that does NOT
require an analysis configuration file.

2.  A set of single standalone images where the image
locations are defined by an .IJX file. For example, a
series of single images from different samples. If the user
selects an .IJX analysis configuration file, which contains ONLY
filenames (may be only one), then same as A above, but only
for the files in the .IJX file.

B.  A set of images with multiple channels. For example, a series
of images from different samples that contain more than one
channel, ie DAPI and FITC stains. If the user selects an .IJX file
that has multiple groups of channels, with NO wells, then this macro
will generate one IJOUT file per group, named with the same name as
the selected mask. This macro will ask for the channel to use to
create the masks.

C.  A set of images from a multiple well plate based assay. The
.IJX file can accommodate multiple channel images and
multiple field locations. For example, a 96 well plate with two
channel images and four fields per well.  If the user selects an .IJX
file with multiple wells of a plate, which has to include the channels,
then this macro will generate only one .IJOUT file for the entire plate,
using the same name as the .IJX file for the .IJOUT file. This macro
will ask for the channel to use to create the masks.

D.  A set of images that makes up a larger tiled or montage
image. For example, a large thin section that has been imaged
in many 20x fields. If the user selects an .IJX file with multiple
channels, but no wells. This is the case when a large image has been
sliced into smaller segments (or originates from an unstitched 
group of montage image tiles), to perform the analysis on each of

them.

If this macro file is installed in ImageJ (Plugins Macros Install), a red rectangle
with three color blobs button with the hint  "De Novo Software Exporter" will
be shown in the toolbar (Figure T27.1).
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Figure T27.1  ImageJ Toolbar with the DnsExampleMacro.ijm (De Novo Software
Exporter) Installed

The functions to customize the macro are at the last lines of the macro following
the text:
 // - - - - - - - - - The functions below this line are the ones that the user

can customize - - - - - - - - - - -

In the next section, we will give a general overview of the DNS Analysis Creator
Macro  

22.27.1.
2

DNS Analysis Creator Macro Overview

The DNS Analysis Creator Macro creates an *.ijx analysis configuration file that
ImageJ can use to order, group, and process images in sets described in the DNS
Macro Example Overview . 

The analysis configuration file is a comma separated value (.csv) text file, with an
.ijx extension. The first line of this file must contain a column header(s). For
example: Filename, Channel. 

The valid column headers for the .ijx file are:

Filename: It must be the first field, and must be the fully qualified path to the
file, this is, including the full path to it. It can not be empty. For example, c:
\image data\img004.jpg.

Channel: (Optional) If present, it must be the second field. It can not be empty.
For example, it can be: green. The channels can be any name you like but must
repeat for different wells, fields of view etc..

Well: (Optional) If present, it must be the third field. It can not be empty. The
format is one or two letters, in the range a..z, A..Z, followed by at most four
digits in the range 0..9. For example, it can be B07.

FOV_row: (Optional) This is the number of the row for the field of view or
tile/stitch position in a montage image. Fields of view are reassembled into a grid
according to your specifications. If present, it must be the fourth field if "wells"
are present, or the third field if "wells" are not present. It can not be empty. It
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must be an integer number, denoting the row of the field of view, starting at 0
(zero). For example, 0

FOV_col:  (Optional) This is the number of the column for the field of view or
tile/stitch position in a montage image. Fields of view are reassembled into a grid
according to your specifications. If present, it must be the fifth field if wells are
present, or the fourth field if "wells" are not present. It can not be empty. If
FOV_row column is present, this column must be present, too. It must be an
integer number, denoting the column of the field of view, starting at 0 (zero).
For example, 2

These are examples of headers:
Filename
Filename,Channel
Filename,Channel,Well
Filename,Channel,FOV_row,FOV_col
Filename,Channel,Well,FOV_row,FOV_col

Additional Notes: 
a. There must be at least one column for the image file name with full path. If

subsequent columns are present, all intervening columns must be also
present. For example, if you choose Filename and Well you must also
have a column for Channel present, resulting in Filename,Channel,Well. 

b. Header keywords are case-sensitive. 
c. There are no default values for the fields. This means that two consecutive

delimiters are not allowed.

How to create an .lJX file

The analysis configuration file (*.IJX file) may be created by:

·  Using the DNS Analysis Creator Macro

·  Using the DNS IJX writer in Excel utilizing Excel based macros   

·  Manually editing the .IJX file in ImageJ  or Excel 

In the next section, we will complete the Creating a .ijx Analysis Configuration
File section  of the tutorial 

22.27.2 Creating a .ijx Analysis Configuration File

Introduction:
When images belong to a set or group the user must generate an analysis
configuration file with an .ijx extension. The analysis configuration file (.ijx file) will
allow ImageJ to determine how different images are related to each other. For
example, if two images represent channel 1 and channel 2 from a single field of
view or if 96 separate images make up the contents of a 96 well plate based
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experiment. A full list of possible sets and use cases that can be represented with
an .ijx file can be found in the DNS Macro Example Overview . 

We will be using the macros and images from the Tutorial Sample Data archive
within the ImageJ Tutorial folder. The following files and folders will be used to
create the analysis configuration file in the tutorial:

·  The DNS-IJXwriter.xlsm Excel macro

·  The DNSAnalysisCreator.ijm macro 

·  Images found in the Multi Channel Image Experiment folder

The images for the data set represent a two color (two channel) imaging
experiment where nuclei were stained with DAPI and a cytoplasmic protein was
stained with FITC.  

We will begin the tutorial by creating an .ijx file from the DNS-IJXwriter.xlsm Excel
Macro* (click below to continue). 

· DNS-IJXwriter.xlsm, a macro-enabled Excel file that reads your filenames

and generates an .ijx file automatically  (recommended).

Or go to the section for creating an .ijx file using the DNS Analysis Creator:

· DNSAnalysisCreator.ijm, a macro that has been designed to assist the

user in creating the Analysis Configuration file  

Note: This tutorial will not focus on how to create macros or use ImageJ The
focus of this tutorial will be on how to use the macros De Novo Software has
provided. For more help with ImageJ please see the ImageJ website at
http://rsbweb.nih.gov/ij/index.html or write to the very helpful and informative
ImageJ Mailing List.

*DNS-IJXwriter.xlsm Excel macro written by Peter Haub

In the next section , we will use the DNS-IJXwriter.xlsm macro-enabled Excel
file to automatically generate an .ijx Analysis Configuration file.

22.27.2.
1

Macro-enabled Excel method for creating ijx file

In this section, you will learn how to use the DNS-IJXwriter.xlsm Excel macro to
automatically generate an .ijx analysis configuration file. The DNS-IJXwriter.xlsm
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Excel macro is an Excel file containing a macro, written by Peter Haub, that will
automatically read filenames and generate an .ijx file from a folder of images.   
 

1.  Open the DNS-IJXwriter.xlsm macro-enabled Excel file, located in the
ImageJ Tutorial ImageJ DNS Macros folder of the Tutorial Sample Data
Archive.

2.  Click on Enable Content button if not already enabled (Figure T27.2)

Figure T27.2  Enabling Macros in Microsoft Excel

3.  Click the Read File Names button (Figure T27.3).

Figure T27.3  Clicking Read File Names Macro Button

4.  Navigate to the Multi Channel Image Experiment folder within ImageJ
tutorial subfolder for the Tutorial Sample Data archive .  

5.  Click OK (Figure T27.4).

1682
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Figure T27.4  Navigating to the ImageJ Tutorial folder within the Tutorial Sample
Data Archive

6.  Type the corresponding channel name (i.e., "DAPI" or "FITC") for each
image into the "Channel" column (Column D) of the spreadsheet.  

Your spreadsheet should now resemble Figure T27.5. 

Figure T27.5  DNS-IJXwriter.xlsm Excel File after Adding Data Files

7.  Click the Write IJX File button (Figure T27.5, red outline).

"DeNovo.IJX" an Analysis Configuration file has been written to the
TutorialSampleData/ImageJ Tutorial/Multi Channel Image Experiment directory
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folder.  This .ijx file now may be processed in ImageJ using the DNS
MacroExample.ijm macro  in order to render the .ijout files which are readable
by FCS Express.  

In the next section, we will use the newly created .ijx file to analyze and export
results from ImageJ to FCS Express  

22.27.2.
2

Creating an analysis configuration file using the DNS Analysis Creator Macro

In this section, you will learn how to create an .ijx Analysis Configuration file using
the DNSAnalysisCreator.ijm macro.  For an in depth description of this macro
please see the De Novo Software ImageJ Macro General Overview .

1.  Open ImageJ.
2.  Install the DNSAnalysisCreator.ijm macro in ImageJ.

Note when this macro file is installed in ImageJ  (Plugins Macros Install), the
De Novo Software Analysis Configuration File Creator button (a blue
rectangle with the hint  "De Novo Software Analysis Configuration File Creator")
will be shown in the toolbar (Figure T27.6).

Figure T27.6   ImageJ Toolbar with the DNSAnalysisCreator.ijm Macro Installed

3.  Click on the  De Novo Software Analysis Configuration File Creator
button (Figure T27.7).

4.  Choose the Multi Channel Analysis folder within the Tutorial Sample
Data ImageJ Tutorial Multichannel Image Experiment
folder (Figure T27.7). This selects the folder in which the original images
are found. 

5.  Click Select.
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Figure T27.7  Selecting the Multi Channel Analysis Folder

6.  Choose the Multichannel Image Experiment folder within the Tutorial
Sample Data ImageJ Tutorial folder. This chooses a directory to
save the resulting Analysis Configuration File. 

7.  Click Select.

At this point a file named FileListForDnsExporter.ijx will be found in the Multi
Channel Image Experiment folder. The .ijx file is the analysis configuration file that
is needed to define grouping of multiple images. For more details on the different
types of groupings and conventions for defining them please see the DNS
Analysis Creator .

You must edit the analysis configuration file to define how the images have been
grouped for an export to FCS Express Image Cytometry. For this experiment,
we have two images that both contain two channels (DAPI and FITC) The .ijx file
is simply a comma separated value file (.csv) with an .ijx extension. We will now
edit the file to define the file path and channel for each of the images in the .ijx
file.
  
There are many ways to edit the .IJX file and we will cover two in this section:

· Editing directly in ImageJ

2503
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· Editing in Microsoft Excel 

22.27.2.2.1  Editing an .IJX f ile in ImageJ

ImageJ can be used to directly edit a .IJX file created by the DNS Analysis
Creator Macro . 

Editing the .ijx file in ImageJ

1.  

2.  Navigate to the Multichannel Image Experiment folder within the
Tutorial Sample Data ImageJ Tutorial folder. 

3.  Double-click the FileListForDnsExporter.ijx file to open it.

The FileListForDnsExporter.ijx file will open in the ImageJ text editor (Figure
T27.8). The default file that is created automatically creates column headers for
all possible situations and rows with place holders (represented as text between
less than and equal to symbols/brackets, ie. <WellID>) for the information. You
will also notice a section in line 6 (at the bottom) that contains information for
plate based assays if needed. We now need to edit the file so it only contains
Filename and Channel as column headers and the relevant channel information in
each row.

Figure T27.8  FileListForDnsExporter.ijx File

4.  Delete Well, FOV_row, and FOV_col from line 1.

5.  Delete #Plate Info, Rows, <rows>, Columns, <cols> from the last
line..

6.  Delete all instances of <WellID>, <FOV_row>, and <FOV_col>.

7.  Replace the text <Channel_Name> in each row with the respective
channel name from the image name.

2511
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For instance: in row 2 the image name is Image1DAPI.jpg. In this case replace
<Channel_Name> with DAPI. Similarly, replace the <Channel_Name> in the
alternate rows with FITC.

When you have completed the editing the FileListForDnsExporter.ijx, it should
resemble Figure T27.9.

Figure T27.9  FilelistForDnsExpoter.ijx File in ImageJ after Editing

8.  Click on  in the ImageJ text editor.

You now have edited and saved the analysis configuration file for this two
channel two image experiment. 

In the next section, we will use the newly created .ijx file to analyze and export
results from ImageJ to FCS Express  

22.27.2.2.2  Editing an .IJX f ile in Excel

Microsoft Excel can be used to directly edit a .IJX file created by the DNS Analysis
Creator Macro . 

Editing the .ijx file in Excel

To edit the .ijx file in Excel you have two options:

A.  The file can be renamed with a .csv extension (this is the option we will
use for the tutorial and it is outlined in step 16 below).

B.  Choose Excel as the default program to open the .ijx file. Right click on the
.ijx file and choose open with>choose default program. From the list of
available programs choose Excel, or use the Browse button to navigate to
Excel. When Excel is chosen check the Always use the selected
program to open this kind of file box. From now on, any time you
double click on a .ijx file it will open with Microsoft Excel. (Please note these
instructions are for Windows 7. (Please see the Microsoft Windows website
for instructions for other Windows Operating Systems) 
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1.  Rename the FileListforDnsExporter.ijx file to
FileListforDnsExporter.csv. (Right-click the file in a windows browser and
choose Rename.)

2.  Open the FileListforDnsExporter.csv file with Microsoft Excel.

The file will open, and the excel document will resemble Figure T27.10.

Figure T27.10  FileListforDnsExporter.csv Opened in Excel

3.  Delete the columns for Well, FOV_row, and FOV_col.

4.  Delete row 6 that contains #Plate Info, Rows, <rows>, Columns,
<cols>.

5.  Replace the text <Channel_Name> in each row with the respective
channel name from the image name.

For instance: in row 2 the image name is Image1DAPI.jpg. In this case replace
<Channel_Name> with DAPI.

When you have completed the editing the FileListForDnsExporter.csv should
resemble Figure T27.11.

Figure T27.11  FilelistForDnsExpoter.csv in Excel after Editing

There are many ways to automate the task of pulling the channel name from the
path of your file name in Excel. We will not be covering these methods in the
tutorial but an example may be found below where the "MID" function was used
to automatically pull out the word DAPI from the file name from cell A2 in figure
T28.111 above. The formula "=MID(A2,106,4)" indicates perform the MID
function (get characters from the middle of a text string), text is located in cell
A2, starting at character 106, and is 4 characters long (Figure T27.12).
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Figure T27.12  Using Excel Functions to Populate Columns in Analysis Configuration
File

6.  Save the FileListForDnsExporter.csv file now.

7.  Within a Windows Explorer window, rename the
FileListforDnsExporter.csv file to FileListforDnsExporter.ijx

If you would like to create a .ijx file for other groupings such as multiple field
based data, montage/tile imaging, plate based data, or multiple field plate based
data please edit your .ijx file as in the steps above but applying the formatting for
each particular type of grouping defined in the ImageJ Macro  help topic. 

In the next section, we will use the newly created .ijx file to analyze and export
results from ImageJ to FCS Express  

22.27.3 Analyzing and Exporting Individual Image Results with ImageJ

In this section, you will learn how to analyze and export individual image results
from ImageJ using the DNSMacroExample (a set of single standalone images in a
folder  use case) . We will be using the macros and images from the Tutorial

used along with the image found in the Single Image Analysis folder
(DNAImage1.jpg and DNAImage2.jpg).

Note: This tutorial will not focus on how to create macros or use ImageJ. The
focus of this tutorial will be on how to use the macros De Novo Software has
provided. For more help with ImageJ, please see the ImageJ website at
http://rsbweb.nih.gov/ij/index.html or write to the very helpful and informative
ImageJ Mailing List.
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1.  Open ImageJ.

2.  Install the DNSMacroExample in ImageJ.

When this macro file is installed in ImageJ  (Plugins Macros Install), the De
Novo Software Exporter button (a red rectangle with three colored circles
button with the hint  "De Novo Software Exporter") will be shown in the toolbar
(Figure T27.13).

Figure T27.13  ImageJ Toolbar with the DNSMacroExample.ijm Macro Installed

3.  Click on the De Novo Software Exporter button (Figure T27.13,
indicated by cursor).

4.  Open the Source drop-down list in the Images to process: window
(Figure T27.14).

5.  Choose From a folder option (Figure T27.14, blue highlighted text).

6. Click OK.

Figure T27.14  Selecting Data Sources for
Images to Process

7.  In Select Source Images Folder window, navigate to the DNA
Experiment folder within Single Image Analysis folder for ImageJ Tutorial
subfolder of the Tutorial Sample Data archive . 

8.  Click Select (Figure T27.15).
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Figure T27.15  Selecting the DNA Experiment Folder

ImageJ will now automatically process all of the images within the Single Image
Analysis folder. The images will be process based on the functions to customize
the macro in the last lines of the macro following the text:

 // - - - - - - - - - The functions below this line are the ones that the user
can customize - - - - - - - - - - -

This will include thresholding and object identification/segmentation. For more
information on customizing macros and adjusting settings in ImageJ please see
the ImageJ website at http://rsbweb.nih.gov/ij/index.html or write to the very
helpful and informative ImageJ Mailing List.

The exported .ijout files will be named DNAImage1.ijout and DNAImage2.ijout.
Two folders that contain other exported information that are named according to
the original file name will be present also (Figure T27.16).

Note: that the name of the .ijout file and the folder that contains the results
must always be the same. Multiple segmentations, and therefore multiple .ijout
and results folders may also be generated from the same images. In the case of
running multiple segmentations the same set of original images may be used
without duplicating the image data set.

http://rsbweb.nih.gov/ij/index.html
http://rsbweb.nih.gov/ij/list.html
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Figure T27.16  Single Image Analysis Folder after Processing Images

We now will open the exported data with FCS Express. 

9.  Open FCS Express.

10. Click on the .

11. Click anywhere on the layout to insert the Dot plot.

12. Choose ImageJ Files (*ijout) from the Files of type drop down menu.

13. Navigate to the 
Image Analysis folder.   

14. Choose DNAImage1.ijout.

15. Click Open.

16. Click on the .

17. Click anywhere on the layout to insert the picture plot.
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The layout should now contain a Dot plot and Picture Plot for the data exported
from ImageJ (Figure T27.17). Using the  Next and Previous buttons from the

 section will change between the data
from the first and second DNA images that were processed. Please see the
further resources section below for more information about working with plots
and imaging data in FCS Express.  

Figure T27.17  Dot and Picture Plots Displaying Data from  DNAImage1.ijout

Note about panning and zooming (please refer the working with picture plots

chapter  for more details)

By default, Picture plots display images at their original zoom starting from their

top-right corner. When the original size of the picture exceeds the size of the

plot, to see a larger part of the picture the user can:

· enlarge the plot itself and/or (Figure T27.17a below)

· change the zoom of the Picture plot by selecting Specific Options from the

Format tab of the ribbon bar (Figure T27.17b below). Should the zooming not

being enough, the plot can be resized in addition.

If a different region of the image should be displayed within the picture plot,
please change the panning (please refer the working with picture plots chapter
for more details).

267
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Figure T27.17a
The picture plot (left) has been resized in order to display teh full picture (right)
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Figure T27.17b
The picture plot (top) has been zoomed through the Specific Options dialog

in order to display a larger part of the picture (bottom).
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Further Resources:

· Introduction to FCS Express Image Cytometry Tutorial

· Picture Plots Tutorial

· ImageJ for FCS Express Knowledge Base

22.27.4 Analyzing and Exporting Multi Channel Image Results with an
.ijx file

In this section, you will learn how to analyze and export a group of multi channel
image results from ImageJ using the DNSMacroExample and an .ijx analysis
configuration file, which was created in the previous section  with the macro-
enabled Excel worksheet * or manually edited in ImageJ  or Excel . 

We will be using the macros and images from the tutorial sample data

with the images found in the Multi Channel Analysis folder (Images 1 and 2 for
the DAPI and FITC channels).

1.  Open ImageJ.

2.  Install the DNSMacroExample in ImageJ (Note: if the DNSMacroExample
has already been installed, you may skip step 2).

When this macro file is installed in ImageJ (Plugins Macros Install), a red
rectangle with three color blobs button with the hint  "De Novo Software
Exporter" will be shown in the toolbar (Figure T27.19).

Figure T27.19  ImageJ Toolbar with the DNSMacroExample.ijm Macro Installed  

2577

2544

2525

2504

2505 2510 2511

2526



Tutorials 2521

© 2023 De Novo Software

3.  Click on the De Novo Software Exporter button (Figure T27.19,
indicated by cursor).

4.  In Images to process: window, choose From an Analysis
Configuration File (.ijx) (Figure T27.20).

Figure T27.20  Choosing an .ijx to Process
Images

5.  Click OK.

6.  Choose either DeNovo.ijx (if your .ijx file was created with the macro-
enabled Excel worksheet ) or FileListForDnsExporter.ijx (if your .ijx file
was manually edited in ImageJ  or Excel ) from the Multi Channel
Image Experiment folder within ImageJ Tutorial subfolder of the Tutorial
Sample Data archive .

7.  Click Open.

8.  Choose dapi as the Channel.

Choosing the channel in step 8 will define which channel should be used for image
segmentation. In this case we are using the dapi stain which is defining the
nuclear area of the cells for segmentation.

9.  Click OK.

ImageJ will process all of the files listed in the .ijx Analysis Configuration file and
create a .ijout file for each set of two channel images and a folder for each of the
matching .results.txt and .mask.tif files. 

We now will open the exported data with FCS Express. 

10. Open FCS Express.

11. Click the Insert tab group command.

12. Click anywhere on the layout to insert the dot plot.

13. Choose ImageJ Files (*ijout) from the Files of type drop-down list in
the Select data file dialog.

2505

2510 2511

1682



FCS Express 7 Manual2522

© 2023 De Novo Software

14. Navigate to the Multi Channel Image Experiment folder in the ImageJ
Tutorial subfolder of the Tutorial Sample Data archive .   

15. Choose Image1DAPI1.ijout.

16. Click Open.

17. Click on the Insert tab group command.

18. Click anywhere on the layout to insert the picture plot.

The layout should contain both a dot plot and a picture plot displaying the data
exported from ImageJ (Figure T27.21). Using the  Next and Previous buttons
from the Data tab  group will change the data
displayed from the first and second images. By clicking Dapi on the x-axis of the
picture plot, you will be able to choose between the DAPI and FITC channels
(Figure T27.21, right). Please see additional resources listed below for more
information about working with plots and imaging data in FCS Express.  

Figure T27.21  Dot and Picture Plots Display Data from .ijout File

Note about panning and zooming (please refer the working with picture plots

chapter  for more details)

By default, Picture plots display images at their original zoom starting from their

top-right corner. When the original size of the picture exceeds the size of the

plot, to see a larger part of the picture the user can:

· enlarge the plot itself and/or (Figure T27.21a below)

1682
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· change the zoom of the Picture plot by selecting Specific Options from the

Format tab of the ribbon bar (Figure T27.21b below). Should the zooming not

being enough, the plot can be resized in addition.

If a different region of the image should be displayed within the picture plot,
please change the panning (please refer the working with picture plots chapter
for more details).

Figure T27.21a
The picture plot (left) has been resized in order to display teh full picture (right)

267
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Figure T27.21b
The picture plot (top) has been zoomed through the Specific Options dialog in

order to display a larger part of the picture (bottom).
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Further Resources:

· Introduction to FCS Express Image Cytometry Tutorial

· Picture Plots Tutorial

· ImageJ for FCS Express Knowledge Base

*macro written by Peter Haub

22.27.5 ImageJ for FCS Express Knowledge Base

Workflow for analyzing ImageJ data in FCS Express

The flowchart below indicates how the DNSMacroExample.ijm macro can be
used to export ImageJ data as .ijout files readable by FCS Express (Figure
T27.22). The DNS-IJXwriter.xlsm macro (written by Peter Haub) can be used to
define the relationship between grouped images.
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Figure T27.22  Workflow for Analyzing Single or Grouped Images Processed in
ImageJ within FCS Express

Installing an ImageJ Macro

ImageJ Macros for use with FCS Express can be downloaded from
https://denovosoftware.com/faq/kb-how-do-i-use-imagej-with-fcs-
express/#macros. 

Macros are installed in ImageJ with the following steps:

1.  Open ImageJ

2.  Click on Plugins or press control+shift+M

3.  Navigate to the location of the macro

4.  Click Open. 

https://denovosoftware.com/faq/kb-how-do-i-use-imagej-with-fcs-express/#macros
https://denovosoftware.com/faq/kb-how-do-i-use-imagej-with-fcs-express/#macros
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The macro will now be installed in the ImageJ tool bar. For more help with
ImageJ Macros, please see the ImageJ website at
http://rsbweb.nih.gov/ij/index.html.

Folder Structure and File Naming

File Names

The DNSExampleMacro will name any exported file names (.ijout files) and folder
names with the name of the original image. For instance, if your original image
was named DapiImage#1.tif, the resulting ImageJ export file will be named
DapiImage#1.ijout and a folder will be created name DapiImage#1 that contains
a .results.txt file named DapiImage#1.results.txt and a mask image named
DapiImage#1.mask.tif. Note that the name of the .ijout file and the folder that
contains the results must always be the same. 

Loading Files (Folder Structure)

Access user options for how to load data from File tab expand Data
Loading category (Figure T27.23).

Figure T27.23  ImageJ Data Loading Options in FCS Express
Image Cytometry or Plus

Choosing Load images will determine if you want to load just raw data (Load
images unchecked), or raw data plus the original images (Load images
checked). 

"Load path names from ImageJ table of contents file" indicates that you
would like to load the data files with the absolute file path that was determined at
the time of exporting the data from ImageJ. If you have subsequently moved
the data files or folder containing the data you will need to uncheck this button.
To work with data without loading the path names from the ImageJ table of
contents file, the following files must be within the same folder at the same level
as in Figure T27.24 below:

· The original image (DNAImage1.jpg below)

· The exported .ijout file (DNAImage1.ijout below)

http://rsbweb.nih.gov/ij/index.html


FCS Express 7 Manual2528

© 2023 De Novo Software

· The folder containing the .results.txt file and the .mask.tif file (DNAImage1

folder below)

Figure T27.24  All Files Which Must Be Kept within Same Folder as
.ijout File: Original Image, .txt Results, and .tif Mask Files

Note that the name of the .ijout file and the folder that contains the results must
always be the same. Multiple segmentations, and therefore multiple .ijout and
results folders may also be generated from the same images. In the case of
running multiple segmentations the same set of original images may be used
without duplicating the image data set.

Working with Plate Based Data:

If the .ijx file represents a plate, the lines of the file that are related to a well
must be grouped consecutively. For example, if the file is about a plate with wells
D05 and H04, all the channels for well D05 must be in a group of lines, followed
by another group of lines with the channels of well H04.

If the ijx file represents a plate, the last line must have the plate information,
starting at column 1 with a # and the words "Plate Info." Then, it is expected a
field with the constant 'Rows', the number of rows in the plate, the constant field
'Columns', and the number of columns of the plate. For example, #Plate
Info,Rows,8,Columns,12 . See Figure T27.25 for an example.

Figure T27.25  .IJX Analysis Configuration File for 96-Well Plate Assay - Two
Wells and Two Image Channels Per Well

The name of the .ijx schema can be customized. At the bottom of the
DnsAnalysisCreator.ijm you will find: 

// This function returns the name of the automatically generated .ijx
file.  

function getExporterFilename() {  
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  return "FileListForDnsExporter";

Modify the text in "return "XXXX"; where the X's represent the desired file
name to be entered, similar to above.

If this macro file is installed in ImageJ (Plugins Macros Install), a blue rectangle
with the hint  "De Novo Software Analysis Configuration File Creator" will be
shown in the toolbar (Figure T27.26).

Figure T27.26  ImageJ Toolbar with the DnsAnalysisCreator.ijm Macro Installed

22.28 Exporting from Image Xpress Velos

The ImageXpress VelosTM Imaging Cytometer enables robust real-time assays

for microarray, bead, cell, and colony classification and enumeration in user-

defined or commercially available formats. The ImageXpress Velos Imaging

Cytometer is ideally suited for high throughput screening of many cell-based

assays which makes for a great pairing with the high content and batch

processing abilities of FCS Express. De Novo Software has teamed up with

Molecular Devices to allow analysis of high throughput imaging in FCS Express.

Once your data is properly saved within the ImageXpress Velos software, FCS

Express can import the data and allow visualization of your data set with all of

our familiar 2D plots and new plotting features, such as picture plots and heat

maps.

In the first exercise, we will export an experiment from ImageXpress VelosTM .

22.28.1 Export an Image Xpress Velos Experiment

In the course of this tutorial, you will learn:

· How to save ImageXpress Velos data with images from an experiment.

· How to import the data into FCS Express.
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ImageXpress Velos Setup – Saving Images and Object Data

1. Select Instrument Setup from the menu bar.

2. Click on the Analysis Tab.

3. Click the Produce individual iso files check box. This saves the analyzed
object data for each well.

4. Click the Produce MDCStore Compatible files check box. This saves the
raw tiff image from each well.

5. Ensure the Auto. Correct Saturated Data check box is checked.

6. Click OK.

The Instrument Setup window should match Figure T28.1.

Figure T28.1  Instrument Setup for ImageXpress VelosTM
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7. Analyze your experiment in ImageXpress Velos.

8. Save your experiment in ImageXpress Velos.

In the next section, we will import ImageXpress VelosTM Data with images into

FCS Express .

22.28.2 Import Image Xpress Velos Data with Images

After adjusting the export settings and analyzing your data in ImageXpress
Velos, you may proceed to import the data into FCS Express.

The ImageXpress Velos files used for this section are located in the Tutorial
Sample Data archive .

1. Select File tab expand Data Loading category choose
ImageXpress Velos Options.

2. Check the Load images check box.

3. Check the Load as Plate check box.

4. Click OK.

The ImageXpress Velos options page of the Data Loading preferences should
match Figure T28.2.

Figure T28.2  Setting up ImageXpress Velos Data Loading Preferences in FCS
Express

5. Select File tab  to open a new layout if necessary.

6. Select the Insert tab group  command

(Figure T28.3).

2531
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Figure T28.3  InsertingP Plate Heat
Map from Ribbon

6. Click anywhere on the layout.

7. Choose ImageXpress Velos files (*.iso) from the files of type: drop-

down list in the Select data file dialog (Figure T28.4).
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Figure T25.4  Choosing an ImageXpress Velos file for a Heat Map

8.  Navigate to the 
 folder.

9.  Highlight the Live_dead_96_A01.iso file in the list.

10. Click Open.

A plate heat map containing your data set will appear indicating your import was

successful (Figure T28.5). The data set we are using in this section only contains

one row of samples.
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Figure T28.5  Plate Heat Map Generated from ImageXpress
Velos Data

To view the images associated with each well"

11. Insert a Picture Plot by choosing Insert tab
group command (Figure T28.6).

Figure T28.6  Inserting Picture Plot
from Ribbon

12. Click anywhere on the layout.

A picture plot will appear on the layout (Figure T28.7). The picture plot is now
displaying all the image from the first well in the plate. We will now create a well
gate and apply it to the picture plot to display the image associated with a
particular well.
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Figure  T28.7  Picture Plot Displaying
Image from Well A01

13. Create a Well Gate  for well A6 on your plate heat map (Figure T28.8).

Figure T28.8  Creating a Well Gate on Plate Heat Map
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14. Apply the Well Gate from the last step to the Picture Plot (Figure
T28.9). For more information about applying gates, see the Gating
tutorial .

The picture plot should resemble Figure T28.9, right.

Figure T28.9  Picture Plot Before (left) and After (right) Applying Well Gate

The image displayed in the picture plot now is based on the well gate that was

defined. Editing the Well Gate and selecting different wells will change the image

in the picture plot.

In the next section, we will set up ImageXpress Velos to export an experiment

in numeric form  (data only).

22.28.2.
1

Import Numeric Form Data

After adjusting the export settings and analyzing in ImageXpress Velos, you
may proceed to import the data into FCS Express. 

The ImageXpress Velos files used for this section are located in the Tutorial
Sample Data archive . 

1770
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1. Select File tab expand Data Loading group choose
ImageXpress Velos Options.

2. Unchecked the Load images check box.

3. Click OK.

Note: In this example, there are no images associated with the data. Therefore,
the Load Images check box can remain checked or unchecked without affecting
the import.

The options should match Figure T28.10.

Figure T28.10  IsoCyte Data Loading Options for Numeric Data Only

4. Select File tab  to open a new layout if necessary.

5. Select the Insert tab group command
(Figure T28.11).

Figure T28.11  Inserting Plate Heat
Map from Ribbon

5. Click anywhere on the layout.

6. Choose ImageXpress Velos files (*.iso) from the files of type: drop-
down list in the Select data file dialog (Figure T28.12).
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Figure T28.12  Choosing an .iso File for the  Plate Heat Map

7. Navigate to the 
 folder.

8. Highlight the Live_dead_96_A01.iso file in the list.

9. Click Open.

A plate heat map containing your data set will appear indicating your import was
successful (Figure T28.13).
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Figure T28.13  Plate Heat Map for 96-Well Plate

To view the data associated with each well:

10. Choose Insert tab group command (Figure T28.14). 

Note: Histogram, Dot, Density, Color Dot, Contour, and other plot types may be
inserted.

Figure T28.14  Inserting Dot Plot from Ribbon

11. Click anywhere on the layout.

A dot plot containing all of the events in the data set will appear (Figure T28.15).
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Figure T28.15  Dot Plot Displaying All
Events from All Wells of 96-Well Plate

Note: The plot is defaulting to display PID vs LBL because those are the first two
parameters in the data file.

In our example, we will change the parameters displayed on the x- and y-axes to
I-MEAN1 vs I-MEAN3 to view relevant data (Figure T28.16).

12. Click y-axis label to select IMEAN-1 parameter.

13. Click x-axis label to select IMEAN-3 parameter.
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Figure T28.16  Dot Plot after Changing
Parameters Displayed on Axes

14. Create a Well Gate  for well C3 on the plate heat map (Figure T28.17).289
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Figure T28.17  Creating Well Gate on Plate Heat Map

15. Apply  the well gate from the last step to the dot plot.

The data displayed on the dot plot now is based on the data within the well you

gated, C3 (Figure T28.18). Editing the well gate and selecting different wells or

multiple wells will change the data displayed automatically.
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Figure T28.18  Dot Plot after Applying
Well Gate

22.28.3 Export in Numeric Form (Data Only)

ImageXpress Velos Setup – Saving Object Data

1. Select Instrument Setup from the main menu in the ImageXpress Velos
software.

2. Click on the Analysis Tab.

3. Click the Produce individual iso files check box. This saves the analyzed
object data for each well.

4. Ensure the Auto. Correct Saturated Data check box is checked.

The Instrument Setup dialog should look like Figure T28.19.
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Figure T28.19  Instrument Setup for Data Only Exporting

5. Click OK.

6. Analyze your experiment in ImageXpress Velos.

7. Save your experiment in ImageXpress Velos.

Next, we will import ImageXpress Velos data in numeric form into FCS

Express .

22.29 Picture Plots

FCS Express now supports picture plots, which allow the user to import images
for analysis. Picture plots display the imported images and allows the user to
gate directly on an image to perform any downstream analysis available in FCS
Express. Individual cells identified in a plot can further be isolated in a cell gallery,
allowing the user to perform single cell analysis.
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In the course of this tutorial, you will learn how to:

· Insert and format a picture plot

· Create multi-channel overlays to merge images

· Use gates with picture plots

· Generate statistics from picture plots

· Use cell galleries for gating and viewing individual cells

In the first exercise, we will insert and format picture plots .

22.29.1 Insert and Format Picture Plots

In the course of this section, you will learn how to:

· Define settings for viewing picture plots

· Choose the channel to display

· Create multi-channel overlays to create a merged image

Note: In this section we will be using files ending in the .dns file format in a new
layout. Picture plots may be inserted using a variety of file formats depending on
your analysis instrument and export format.

1. Click File tab .

2. Choose the Data tab group  command.

A Data List window will appear (Figure T10.3 ).

3. Click the blue plus to add files  and choose Add Data File.

4. Choose DNS data Stream files (*.dns) from the Files of type: drop-

down list.

5. Navigate to the FCS Express Tutorial Sample Data archive .

6. Select pictureplotsample1.dns and pictureplotsample2.dns and click Open

to load them into the Data List.  

Now, the Data List should resemble Figure T29.1.

2545
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Figure T29.1  Data List after Loading File

5. Drag and drop pictureplotsample1.dns by its file name from the Data List
to the blank, white space of the layout.

6. Select Picture Plot in the Select Plot Types... dialog and uncheck any
other boxes (Figure T29.2).

7. Click OK.
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Figure T29.2  Choosing to Insert a Picture Plot

A Picture Plot will appear in the layout as in Figure T29.3.

We will now change the view background options to display only the masks for
the individual cells and not the background.

Note: The labels on the axes reflect the pixel coordinates. You can turn these off
by changing the axis formatting options.
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Figure T29.3  Picture Plot for
pictureplotsample1.dns Inserted in the

Layout

8.  Double-click the picture plot. The Formatting dialog will appear, docked
to the right side of layout.

9.  Choose the Overlays category.

10. Uncheck Show Background Image (Figure T29.4, red outline).
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Figure T29.4  Deselecting the Show Background Images Option

Notice how the black background has been removed and only individual cells are

now displayed (Figure T29.5).
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Figure T29.5  Picture Plot after
Removing the Background Image

We now will look at the other channel associated with the image and create a
two channel merged image.

11. In the Formatting dialog, check the box next to Show Background
Image under the Overlays category.

12. Click picture plot to select it and key CTRL+D to duplicate plot.  Note you
may use copy and paste commands to create second picture plot.

13. Click and drag duplicated plot by the red outline to position it to the right
of the first picture plot.

14. Click the x-axis label of the new picture plot (Figure T29.6).

15. Choose DNA to view the image of the DNA channel (Figure T29.5, blue
highlighted text).
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Figure T29.6  Selecting DNA Channel

The picture plot will resemble Figure T29.7, displaying the DNA image associated
with the picture plot.

Figure T29.7  DNA Channel Displayed in
Second Picture Plot

16. Drag and drop the right picture plot displaying the DNA channel by its
outline to the left picture plot displaying the Cytoplasm channel after it is
outlined in blue (Figure T29.8).



FCS Express 7 Manual2552

© 2023 De Novo Software

Figure T29.8  Dragging and Dropping Right Picture Plot on Left Picture Plot

17. Double-click the 2D Plot Overlay(s) option from the Paste Special
dialog.

The left picture plot should resemble Figure T29.9, displaying both Cytoplasm and
DNA channels as a merged image.

Figure T29.9  Picture Plot Overlay
Displaying the Cytoplasmic and DNA

Channels as a Merged Image

Data files in the Data List may be iterated through the picture plots.

19. Select the newly overlaid picture plot by clicking on it.
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20. Choose the Data tab group
command (Figure T29.10).

Figure T29.10  Next
on Selection
Command

Note: The picture plot will change to display the next file in the Data List. FCS
Express can handle color and greyscale images, as seen with the greyscale
images associated the pictureplotsample2.dns).

In the next section, we will learn about gating with picture plots .

22.29.2 Gating with Picture Plots

In the course of this section, you will learn how to:

· Gate on a picture plot

· Adjust picture plot options for viewing gates

· Backgate from picture plots to scatter plots and from scatter plots to

picture plots

· View statistics from picture plot gates

Note: In this section we will be using files ending in the .dns file format in a new
layout. Picture plots may be inserted using a variety of file formats depending on
your analysis instrument and export format.

Gating on and applying a gate to a picture plot is are the same behaviors for
other plot types used in FCS Express. For an introduction to gating, please
see the Gating tutorial .

1. Click File tab .

2. Choose the Data tab group  command.

A Data List window will appear.

3. Click the blue plus to add files  to select Add Data File.

2553
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4. Choose DNS data Stream files (*.dns) from the Files of type: drop-

down list.

5.  Navigate to the FCS Express Tutorial Sample Data archive .

6.  Select pictureplotsample1.dns.

7.  Choose DNS data Stream files (*.dns) from the Files of type: drop-

down list.

8.  Click Open to load it into the Data List.

9.  Drag and drop pictureplotsample1.dns by the file name from the Data List

to the blank, white space of layout.

10. Select Color Dot and Picture Plot in the Select Plot Types... dialog

(Figure T29.11).

11. Click OK.
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Figure T29.11  Choosing to Insert a Picture Plot and Color
Dot Plot

A color dot plot and a picture plot for the file will appear on the layout. Click and
drag borders of the plots to arrange them side-by-side as in Figure T29.12
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Figure T29.12  Arrangement of the Picture and Color Dot Plots

12. Create a rectangle gate on the picture plot, similar to the one in Figure

T29.13 and name it Picture Plot Gate 1 in the Create New Gate dialog.

13. Create another gate (ellipse gate) on the picture plot similar to the one in

Figure T29.13, and name it Picture Plot Gate 2 in the Create New Gate

dialog.

Figure T29.13  Creating Gates on the
Picture Plot 

Notice, on the picture plot, how the events are highlighted the same color as the
gate in which they are contained by its bounds (Figure T29.13). Also, note that
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the color dot plot is now displaying the events within picture plot gates in
different colors. At times, it may be difficult to differentiate colors or events on
the dot plot due to the nature of a single image experiment having a limited
number of events. 

We will format the dot plot to make it easier to view and analyze.

14. Double-click the color dot plot.  The Formatting dialog will appear,

docked to the right.

15. Choose the Overlays category in the Formatting dialog.

16. Change the Dot size to 5 (Figure T29.14, red outline).
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Figure T29.14  Formatting Dot Size for Color Dot Plot
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The dot plot will resemble Figure T29.15.

Figure T29.15  Color Dot Plot with
Larger Dots

We now will format the picture plot to only highlight cells contained within bounds
of only one gate.

17. Click the picture plot to select it.

18. In the Formatting dialog, select the Display Gates Options category.

19. Choose the radio button next to All gates except those checked

below option (Figure T29.16, red arrow).

20. Check the box next to Picture Plot Gate 2 (Figure T29.16, red outline).
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Figure T29.16  Choosing to Display All Gates Except Picture Plot Gate 2

The picture plot will resemble Figure T29.17.
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Figure T29.17  Picture Plot
Highlighting Only Cells Contained

Within Bounds of Picture Plot Gate 1

We will apply the Picture Plot Gate 1 gate to the color dot plot.

21. Click inside Picture Plot Gate 1 and hold mouse button down.

22. While holding mouse button down, drag gate from picture plot to color

dot plot and release mouse button when color dot plot is outlined in blue

(Figure T29.18).

Figure T29.18  Applying Picture Plot Gate 1 to Color Dot Plot
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Note how the color dot plot has changed to only display events that fall within
the gate defined on the picture plot (Figure T29.19).

Figure 29.19  Color Dot Plot Displaying
Cells from Picture Plot Gate 1

We will create a gate on the color dot plot and apply it to the picture plot.

23. Key Ctrl+Z to undo the gating change, so the plot resembles Figure

T29.15.

24. Create a rectangle gate on the color dot plot similar to Figure T29.20 and

name it Dot Plot Gate in the Create New Gate dialog.

Figure T29.20  Creating Dot Plot Gate
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Note how the picture plot is highlighting cells in the color of the Dot Plot Gate

now (Figure T29.21). Adjust the Dot Plot Gate and observe the highlighting

changes on the picture plot to indicate events in the gate with its movement.

This gating strategy may be particularly useful for identifying interesting

populations of cells in an image based on numerical results.

Figure T29.21  Picture Plot Displaying
the Dot Plot Gated Events in Purple

The individual cells that fall within the dot plot gate can also be shown in the
picture plot by removing the background image.

25. Click the picture plot.

26. Choose the Overlays category in the Formatting dialog.

27. Uncheck the box next to Show Background Image option (Figure

T29.3 ). 

28. Click Gating tab category drop-down

and choose Dot Plot Gate.

The picture plot will resemble Figure T29.22, displaying only the cells found within
the Dot Plot Gate.
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Figure T29.22  Picture Plot with Dot
Plot Gate Applied

Next, we will use data grids for image analysis .

22.29.3 Using Data Grids for Analysis

FCS Express allows the user to insert a data grid for any plots. Data grids
typically display cell-by-cell parameter data. In the context of image cytometry,
the data grid can be used as an image gallery to view images of individual cells
and their associated parameters.

In the course of this section, you will learn how to:

· Insert a data grid/cell gallery

· Format a data grid/cell gallery to display individual cell images and

parameters

· Apply gates to a data grid/cell gallery

· Create gates in a data grid/cell gallery

1.  Click File tab to open a new layout.

2.  Choose the Data tab tab  command. A

Data List window will appear.

3.  Click the blue plus to add files  to choose Add Data File.
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4.  Choose DNS data Stream files (*.dns) from the Files of type: drop-

down list.

5.  Navigate to the FCS Express Tutorial Sample Data archive .

6.  Select pictureplotsample1.dns.

7.  Click Open to load it into the Data List.

8.  Drag and drop pictureplotsample1.dns by its file name from the Data List

to the blank, white space of the layout.

9.  Select only the Color Dot, Picture Plot and Data Grid in the Select Plot

Types... dialog (Figure T29.23).

10. Click OK.

Figure T29.23  Inserting a Data Grid and Two Plots

A color dot plot, data grid, and picture plot will appear on the layout. Arrange
these plots and grid to resemble Figure T29.24. 
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Figure T29.24 Picture Plot, Data Grid, and Color Dot Plot Arranged on the Layout for
Analysis

The data grid can be used as a cell gallery to view individual cells from the picture
plot and gates. 

We will format the grid to show cell cutouts, a few parameters, and gates from
the data.

11. Right-click on the data grid.

12. Choose Format from the pop up menu. The Formatting dialog will
appear, docked to the right.
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13. Choose the Parameters to Display category (Figure T29.25). 

14. Click the Only the items check below radio button (Figure T29.25).

15. Check the following boxes found by scrolling to the bottom of the list
(Figure T29.25):

a. Intensity_UpperQuartileIntensity_DNA

b. Number_Object_Number

c. Cytoplasm

d. DNA

Figure T29.25  Formatting the Parameters to Display
for the Data Grid

16. Choose the Gates to Display Category.

17. Click the All gates radio button.

The data grid is now displaying parameter values, images, and column for Gates
for all events (Figure T29.26). 
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We will create gates on the dot plot and picture plot, and use these gates to view
individual events within the data grid.

Figure T29.26  Data Grid Displaying a Gate Column, Chosen
Parameters, and Individual Cell Images

18. Create a rectangle gate on the picture plot, similar to the one in Figure
T29.27, and name it Picture Plot Gate in the Create New Gate dialog.

19. Create a rectangle gate on the dot plot, similar to the one in Figure
T29.27, and name it Dot Plot Gate in the Create New Gate dialog.

Figure T29.27  Gates Created on the Picture and Dot Plots
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Scroll down the data grid and notice it is now displaying colored rectangular
boxes in the gates column (Figure T29.28). These boxes represent which gates
the individual cells fall within. If a cell falls into multiple gates, then multiple colored
bars will appear next to the cells in the "Gates" column.  If the "Gates" column is
empty, then the cell does is not found in any gates currently being displayed. 

Figure T29.28  Data Grid Displaying Dot Plot and Picture
Plot Gates as Colored Rectangular Boxes

We will apply the Picture Plot Gate and Dot Plot Gate to the data grid to view
the individual cells that fall within these gates.

20. Click on the data grid to select it.

21. Navigate to Gating tab group drop-down
list and choose Picture Plot Gate (Figure T29.29). Alternatively, you can
drag and drop the Picture Plot Gate directly from the Picture Plot onto the
Data Grid.

22. Adjust the Picture Plot Gate to select fewer cells as shown in Figure
T29.29.
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Figure T29.29  Apply Picture Plot Gate to the Data Grid

Notice how the cell gallery updates in real-time to display only the events found
within the chosen Picture Plot Gate. This is an example of "drilling down" to
cells of interest.

23. Click on the data grid to select it.

24. Navigate to  and choose the Dot
Plot Gate from the Current Gate drop-down list (Figure T29.30).
Alternatively, you can drag and drop the Dot Plot Gate directly from the
Dot Plot onto the Data Grid.

25. Adjust the Dot Plot Gate to select fewer cells as shown in Figure T29.30.
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Figure T29.30  Apply Dot Plot Gate to Data Grid

We now will create on the data grid to display those events in the picture plot
and scatter plot.

26. Click on the data grid to select it.

27. Navigate to  and choose No Gate
from the Current Gate drop-down list.

28. Right-click on the data grid.

29. Choose Create Gate from the pop up menu. A Range Gate selection
area will appear as shown in Figure T29.31.

30. Click on Range.

31. Select Add Range to Gate... from the drop-down list (Figure T29.31).
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Figure T29.31  Range Gate Selection

32. Enter the range as From 1 To 100 in order to select the first 100 cells of
the sample (Figure T29.32).

33. Click OK.

Figure T29.32  Select a Range Dialog
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34. After the Select a range window closes, click OK in the Range Gate
Selection window above the data grid (figure T29.33, red outline).

FIgure T29.33 Range Gate Selection Window

35. Name the new gate Range Gate in the Create New Gate dialog.

36. Click OK.

The new gate is now visible in the Gates column of the Data Grid (Figure
T29.34).

Figure T29.34   Before (Left) and After (Right) Creating a Range Gate
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We now will add more events to the Range Gate.

37. Right-click the data grid and select .

38. Click Range in the Range Gate Selection window above the data grid.

39. Select Add Range to Gate... from the drop-down list.

40. Enter the range as From 180 To 250.

41. Click OK.

42. Click OK in the Range Gate selection area.

Note the Range Gate contains cells 1-100 and cells 180-250 now.

Notice that the picture plot and scatter plot are now displaying the events that
were selected in the range gate as dots or cells highlighted by the range gate
color, purple in this example (Figure T26.30).

Figure T29.35  Picture Plot Displaying
the Events in the Range Gate as

Purple Highlighted Cells

 Individual cells may also be selected in a range.

43. Right-click the data grid.

44. Choose Create Gate. 

45. Select cells 5 through 10 in the data grid by checking the respective

boxes in the New Gate column (Figure T29.36, red outline  ).
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46. Click OK in the Range Gate Selection window (Figure T29.36, red

outline ).

Figure T29.36  Selecting Individual Cells for Gating by
Checking the Boxes in the New Gate Column

47. Name the gate "Selected Cells" in the Create New Gate dialog.

48. Click OK.

A new range gate will be created for these cells (Figure T29.37).

Figure T29.37  Selected Cells Range Gate Displayed
as a Green Box in the Gates Column
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To view the individual cells in this gate on the picture plot and dot plot, we will

format both plots to make it easier to view a small number of cells.

49. Click the picture plot.

50. Choose the Overlays category in the Formatting dialog.

51. Uncheck the Show Background Image box.

52. Click the color dot plot.

53. In the Formatting dialog, change the Dot size to 5 under the Overlays

category.

We now will apply the Selected Cells gate to view only these events in each

plot.

54. Multiple-select both the dot plot and picture plot.

55. Click Gating tab group  drop-down list and

choose Selected Cells.

The dot plot and picture plot will display only cells that fall within the manually

checked range boxes (Figure T29.38). A new range or individual cells may be

added to the gate at any time.

Figure T29.38  Plots Displaying Only Events from the Range Gate

56.Right-click the data grid.

57. Choose . 
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58. Click on Range.

59. Select Add Range to Gate from the drop-down list.

60. Enter the range as From 1 To 50.

61. Click OK.

62. Click Apply in the Range Gate Selection window to see the changes to

the gate in real-time.

63. Click OK in the Range Gate Selection window.

The picture plot and dot plot will now display the newly edited range that was
entered (Figure T29.39). Also notice since events are now falling within the Dot
Plot Gate, the percent gated statistic updates automatically.

Figure T29.39  Picture Plot and Dot Plot After Adding a New Range to the Selected
Cells Gate

22.30 Introduction to FCS Express Image Cytometry

A Flow Cytometry environment for Image Cytometry Data

FCS Express Image Cytometry contains exciting and unique tools for working
with Image Cytometry data.  

This tutorial is designed to provide an overview of many powerful new tools that
allow you to work with image data in much the same way as flow cytometry
data. Now you can combine population based analysis and single cell
interrogation of your image cytometry results in one software package!  
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This three section tutorial is designed to take you through prepared examples
demonstrating the use of FCS Express Image Cytometry. 

· Getting Started with Image Cytometry

· Using the High Content Module with Image Data

· Batch Processing and Reporting for Image Data

In the course of the tutorial, you will load and review image datasets, establish
and modify gating strategies, view individual cells in cell galleries, and use the High
Content Add-on  to optimize and view a 96-well plate nuclear translocation
assay.  The High Content Add-on enables review of multiparametric results and
images from an entire plate.  

A brief example of batch analysis and FCS Express reporting tools will be
provided. This tutorial will not expand on the details of many common features
and tools in FCS Express for which there are existing detailed tutorials .  When
relevant, tutorials designed to drill down and teach those commonly-used 
functions will be referenced.

In the course of this multi-part tutorial, we will specifically:

· Demonstrate loading image cytometry data and working with images

· Review gated populations in data grid with cell image galleries

· Review analysis and reporting tools for image cytometry

· Optimize the assay settings for a nuclear translocation assay

· Use the "High Content Analysis" module to work with an image-based

assay in a 96-well plate
· Review batch analysis and reporting option for image cytometry data

Due to the large size of image data, we have only worked with a several
example images for each part of the tutorial. The images are embedded in the
example layouts.  We do not provide the image data from an entire 96-well
plates in our Tutorial Sample Data Archive for examples using the High Content
Add-on.  If you would like to move beyond this introductory tutorial and work
with data from the whole study, please use our CellProfiler Export Tutorial .

Proceed to the next section  to begin.

22.30.1 Getting Started with Image Cytometry

In this section, we will learn how to:

· Understand the required components for importing image data

· Load a layout with image data
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· Modify and insert new data plots and images using picture plots

· Apply example image gating approaches

· Create a data grid to and include cell images to create a "cell gallery"

· Visually examine and optimize control settings for a Nuclear Translocation

assay

· Modify settings and gating for the data grid displaying a cell gallery 

Important note before starting: With the release of FCS Express 7.18, Picture
plots display images at their original zoom originating from the top-right corner
of the image. Both the zoom and region of the image displayed in the Picture
plot can be customized (please refer to the Zooming/Panning Specific
Options for Picture Plots  section of the Working with Picture Plots  chapter
for more details). Depending on the release of FCS Express you are using,
screenshots in the section below may differ from what you see in FCS Express
but the results will be the same. Zooming/panning settings may be adjusted as
needed by the end user at anytime in the tutorial. 

Understanding Image Data Import with FCS Express Image Cytometry

When working with image data, we have several components of data to
consider: the raw image data, the segmentation maps used to specify individual
objects within the image, and derived object-based multi-parametric results. 
Ideally, the data you will work with has all of these components available to FCS
Express.  With only the cell-by-cell multiparametric data, you can still review
results with all of the familiar flow analysis tools without interactive image
options. 

If the images and segmentation maps are available, FCS Express can link your
multiparametric results back to the source images.  The individual cells then can
be highlighted in Picture Plots , images of single cells can be extracted and
displayed in cell galleries, and meaningful multiparametric data can be reviewed
on a cell by cell basis.  FCS Express Image Cytometry is able to import data from
a number of imaging platforms so you can easily import and work with your
data.

Section 1: Working with Image Cytometry Data (If you have completed
Section 1, please skip to Section 2 . If you have completed Sections 1 and 2,
please skip to Section 3 .)

We will use the IntroToImage1.fey layout for this section, which is located in
the Intro to Imaging Tutorial subfolder of the Tutorial Sample Data archive .
This layout contains a detailed pre-formatted approach to working with image
data.  As an introduction to use of the image cytometry features we will not go
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into detail for operations that are detailed in our other general tutorials.  Relevant
detailed tutorials will be referenced as applicable. 

1.  Load the IntroToImage1.fey layout from within the "Intro to Imaging
Tutorial" folder within the Tutorial Sample Data archive.  The
multiparametric data and images are embedded in this layout.

This is a 2-page layout, please confirm you are viewing page Example page.
This page contains three Picture Plots  and a Color Dot Plot  of the cellular
data (Figure T30.1).  It also has the Data List indicating data used in the layout,
and a Data Grid  displaying single cell information to the right side of the work
area on the page.  You can place plots and grids anywhere in the layout on the
Example page.  The layout also contains a Blank page. 

Figure T30.1  Overview of the IntroToImage1.fey layout
 

The Color Dot Plot displays two of the many parameters measured and saved
by CellProfiler plotted against each other on the x- and y-axes.  You can change
the parameters displayed on the Color Dot Plot easily. We will proceed by
changing the X-Axis parameter.

2.  Click the x-axis label of the color dot plot. You will see a list of parameters
appear (Figure T30.2).

3.  Scroll through the list of parameters or begin typing the name of the
parameter in the empty field at the top of the list.

2544 1697
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4.  Click to select any parameter you wish to display. 

The newly-selected parameter will be displayed on the x-axis. 

Figure T30.2  Selecting New Parameter to Display on X-Axis
of 2D Plot

Undo is a powerful feature in FCS Express.  Note, once you have made a change
or performed an action in FCS Express, you can use Ctrl+Z to undo the actions
as necessary.  FCS Express supports unlimited undo and redo commands
although the default is set to 15 actions.

5.  Key Ctrl+Z to undo the new parameter displayed on the x-axis. 

Alternatively, you may click the Undo icon  in the upper left corner of the
window.

There is another way to change x- and y- axis parameters displayed as well as
accessing other plot properties to change:
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6.  Double-click the color dot plot.  The Formatting dialog will appear, docked
to the right side of the layout.

7.  Choose the Overlays category (Figure T30.3). X and Y Parameters can
be changed easily here via their respective drop-down lists.

8.  Change the Dot Size to 8 (Figure T30.3, red outline).
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Figure T30.3  Formatting Dot Size for Color Dot Plot
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9.  Click the Gating tab group command. (Figure
T30.4)

Figure T30.4   Selecting Rectangle Gate from Ribbon

10. Click and hold the mouse button down in the center of the color dot
plot.  

11.While holding the left mouse button down, drag to the right and down to
draw a rectangular gate on the color dot plot (Figure T30.5).

12. Release the mouse button when the gate is the desired size.

Figure T30.5  Drawing a Rectangle Gate

13. Enter the name "Cells Gate 1" in Create a new gate named field of the
Create New Gate dialog (Figure T30.6).
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Figure T30.6  Naming New Rectangle Gate

14. Click OK.  Notice the cells included in the gate change to appear in red in
both picture plots (Figure 30.7).

Figure T30.7  Highlighting Cells within Cells Gate 1

15. Type Ctrl+Z to undo the addition of Cells Gate 1. 

16. Type Ctrl+Y to redo the addition of Cells Gate 1. 

17. Click inside the Cells Gate 1. This selects the gate.  In a selected
rectangle gate, the corners will appear with resizing anchors; you can click
and drag each one to change the gate's dimensions.
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18. Press and hold the left mouse button over one of the lower-left resizing
anchor of Cells Gate 1.

19. While holding, the mouse button, move the cursor down and left, as
indicated by the blue arrow in Figure T30.8, until the gate is similar in size.

Figure T30.8  Increasing the Size of Cells Gate 1

20. Release the mouse button. Notice the increased gate size include more
cells in the gate which also means more cells become highlighted in red in
the images (Figure T28.9).

21. Click and hold the mouse button inside the gate (Figure T30.9). 

22. While holding down the mouse button, move the mouse to reposition the
gate.

23. Release the mouse button when the gate is in the desired position.
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Observe the cells in the picture plots becoming highlighted in red or not as you
modify and move gates.  The highlighting indicates which cells are in the gate on
the color dot plot.

Figure T30.9 Moving Cells Gate 1

24. Close the layout without saving changes.

Section 2: Building an Analysis from a New, Blank Layout

25. Open IntroToImage1.fey.  We will recreate the Example Page.

26. Click the Blank Page page tab in the lower left of window (Figure
T30.10).

Figure T30.10   Selecting the Blank Page Tab

27. Click Insert tab group  command (Figure
T30.11).  
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Figure T30.11  Inserting Picture
Plot from Ribbon

28. Click on blank, white space of layout. This will insert a Picture Plot  with
images of the cells (Figure T30.12). 

29. Click the pictureplotsample1.dns picture plot to select it. 

The picture plot will be called pictureplotsample1.dns. 

Figure T30.12  Inserted Picture Plot

30. Duplicate (Ctrl+D) the pictureplotsample1.dns picture plot, and
reposition  the duplicated plot below the original on the same page.  Use
Align  commands if needed.

31. Change the x-axis to DNA on the duplicate picture plot.

You will have two identical plots one above the other as shown in Figure T30.13.
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Figure T30.13  Duplicated Picture Plot

You should now have the Cytoplasm (green channel) displayed on the top
picture plot and Nuclear (blue channel) displayed on the bottom picture plot as in
Figure T30.14 below.
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Figure T30.14  Changing the Image
Parameter of a Picture Plot

32. Duplicate the top plot again. 

33. Position the new duplicate to the right of the original.

34. Drag and drop the lower left picture plot displaying the DNA image by its
green outline to the upper right picture plot. 

35. Release mouse only when upper right picture plot is outlined in blue and
cursor has + ("plus") sign shown (Figure T30.15).  
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Figure T30.15  Adding New Overlay by Drag and Drop

A Paste Special dialog will appear as see in Figure T30.16 below.

36. Select "2D Plot Overlay(s)" option. 

37. Click OK.
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Figure T30.16  Selecting 2D Plot Overlay(s) Option in the Paste
Special Dialog

This will create a two channel overlay (Figure T30.17).

Figure T30.17  Two Image Channel
Overlays

Notes:

To learn other ways of loading new image data and inserting picture plots, see
the Picture Plots  tutorial.

To learn more ways to modify the data and image plots, see the Formatting
Plots  tutorial.
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We now will insert a 2D Color Dot Plot.

38. Click the Insert tab group command (Figure
T30.17).

Figure T30.18  Selecting the Color Dot Plot
Command

39. Click on blank, white space of layout to left of DNA picture plot and below
two channel overlaid picture plot.  Use Align  commands as necessary.

The color dot plot should resemble Figure T30.19.

Figure T30.19  Inserted Color Dot Plot

40. Double-click the color dot plot.  The Formatting dialog will appear,
docked to the right side of layout. 

41. Choose the Overlays category.

42. Select Intensity_IntegratedInstensity_Cytoplasm from the X

Parameter drop-down list (Figure T30.20, ).

43. Select AreaShape_Area for the Y Parameter drop-down list (Figure

T30.20, ).

1692
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44. Change the Dot Size from 1 to 10 (Figure T30.20, ).
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Figure T30.20  Formatting Color Dot Plot Overlay
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The color dot plot will resemble Figure T30.21.

Figure T30.21   Formatted Color Dot Plot

45. Create a rectangle gate on the color dot plot as done previously in steps
9 through 14 above in Section 1. 

Your Blank Page should resemble the Example Page (Figure T30.22).  
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Figure T30.22  Completed Blank Page

46. Close the layout without saving changes.

Section 3: Image Gating Strategies

When analyzing image cytometry data, it can be very useful to apply gates to
traditional 1D and 2D plots representing cellular data and review the gated cells in
the original images.  Reviewing the actual images of cell confirms whether the
gated populations represent the expected changes in cell morphology. 

In this section, we will:

· Gate on cells in picture plots
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· Gate on traditional 2D plots

47. Load the IntroToImage2.fey layout from the Intro to Imaging Tutorial
subfolder in the Tutorial Sample Data archive . 

This layout has two Picture Plots  and two color Dot Plots  of the cellular data
from a nuclear translocation assay. The images represent the nuclear and
cytoplasmic stains of the same cells.  Notice the gates on the cytoplasm imaged.
 They are called Green Square and Red Ellipse.  Notice the red and green dots
in the color dot plot below the image indicate from which gate the cells are found
the Picture Plot .  Note also we have included a Gate View  and Cell Gallery
(Data Grid) in the layout.  These will help us keep track of activity in the layout. 
The complete layout is represented in Figure T30.23.

Figure T30.23  IntroToImage2.fey Layout

48. Move  the Green Square and Red Ellipse gates.  Observe the red and
green dots updating in real-time on the Cellular Image color dot plot
(Figure T30.24).  
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Figure T30.24  Events from Green Square and Red Ellipse
Gates Displayed in Respective Colors on Color Dot Plot

Notice the Cyan Square gate on the Nuclear Image color dot plot on the lower
right.  Notice how the cells in the nuclei_05.cpout Picture Plot  are highlighted
in cyan when they are in the Cyan Square gate (Figure T30.25).

2544
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Figure T30.25  Events from the Cyan Square Gate Displayed
in Respective Color on Picture Plot

49. Move  or resize  the Cyan Square Gate on the plot. Notice then
events updating in real-time on the picture plot displaying the DNA channel.
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50. Drag and drop the Cyan Square gate from the Nuclear Image color dot
plot onto the DNA picture plot to reset the gate applied to be Cyan
Square.  Only events in the Cyan Square Gate are highlighted in cyan,
while the rest are highlighted in white (Figure T30.28).  

Figure T30.28  Cells within Cyan Gate Highlighted in Same
Color on Picture Plot

Notice the Data Grid  displaying cell images.  The images display in this object
provide a "Cell Gallery" view on the right side of the layout by displaying all cells
in the image for the selected parametric data.  Notice in the Gates column, each
event (See Figure T30.30 below).

51. Drag and drop the Cyan Square gate from the Nuclear Image dot plot
onto the Data Grid .  

Notice the cell gallery component of the Data Grid  now only displays the cells
in the Cyan Square gate. Note that depending on the last position of the gates
in the demo layout your Data Grid  may not appear exactly as in Figure
T30.29.
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Figure T30.29   Example of Data Grid with
Cyan Gate Applied

52. Move the Cyan Square gate to a new location on the DNA picture plot
and watch the cells in the gallery and picture plot update.

53. Click the Data Grid displaying the cell gallery to select it.

54. Right-click the Data Grid and select Format.  The Formatting dialog will
appear, docked to the right.

55. Choose the Parameters to Display category. 

56. Scroll down the list and check the boxes next to Location_Center_X
and Location_Center_Y (Figure T30.30).
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Figure T30.30   Selecting Parameters to Display
in Data Grid

Note the cell gallery is displaying the selected variables.  Expand the size of the
data grid to see everything.  You may expand column headers, too.  The cell
images are displayed as a result of selecting the check boxes for the image
names Cytoplasm and DNA at the bottom of the parameters list (Figure
T30.31).  We will refer to adding cell images to a data grid as "creating a cell
gallery."

Figure T30.31   Formatted Data Grid With Added Parameters

57. Close the layout without saving changes.

Notes: To learn more about gating options, see the "Gating " tutorial.701
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Continue to the next topic - Using the High Content Module with Image Data.

22.30.2 Using The High Content Module with Image Data

In this section, we will learn how to:

· Load a layout form a nuclear translocation assay run on a 96-well plate

· Review layouts and examine control well results with picture plots and dot

plots

· Use Plate Heat Maps to review key variables measured on cells in a plate

view

· Use multiple plate heat maps and data grids to display results in a report

· Optimize gate settings for the nuclear translocation assay

· See how tokens can be used to enhance reporting

· Create and manipulate a Data Grid to display a "Cell Gallery"

Important note before starting: With the release of FCS Express 7.18, Picture
plots display images at their original zoom originating from the top-right corner
of the image. Both the zoom and region of the image displayed in the Picture
plot can be customized (please refer to the Zooming/Panning Specific
Options for Picture Plots  section of the Working with Picture Plots  chapter
for more details). Depending on the release of FCS Express you are using,
screenshots in the section below may differ from what you see in FCS Express
but the results will be the same. Zooming/panning settings may be adjusted as
needed by the end user at anytime in the tutorial

Section 1: Image Gating Strategies for Data Analysis with the High
Content Module (If you have completed Section 1, please skip to Section 2 .
If you have completed Sections 1 and 2, please skip to Section 3 .)

Image cytometry often is analyzing many images acquired from slides or
multiwell plates to interrogate various conditions, compounds, or multiple sample
sources.  Cellular imaging studies performed under multiple conditions are called
"High Content Analysis" typically.  The High Content Add-on for FCS Express
enables working with and viewing data from multiple samples in plate heat
maps .  These data are typically from multiwell plates (6- to 1536-well plates).
 Plate heat maps can display multiple parameters or samples per well position
with a variety of color mapping. 

We have not provided data for all wells in the plate in the examples used here
due to the large size of the original data set.  If you would like to work with the
full data set, or create your own data set, please visit the Exporting 96 Well
Format Images  section of the CellProfiler Export tutorial. The instructions
there will provide you with a link to the original data set, a completed CellProfiler
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pipeline for analysis, and instructions for importing and viewing the data in FCS
Express Image Cytometry or Plus.

1.  Load the IntroToImage3.fey layout from the Intro to Imaging Tutorial
subfolder in the Tutorial Sample Data archive .

Confirm you are viewing the Experiment Design page (Figure T30.32).  This
page contains the results for a nuclear translocation assay from a 96-well plate. 
A Plate Heat Map  displays a representation of wells in the plate along with a
measured parameter as the Y-Axis (Intensity_IntegratedIntensity_Cytoplasm in
this case) on a green (low) to red (high) color scale.  

Below the plate heat map is a plate map of the compounds added to each well,
which was inserted as an image.  Column 1 contains replicates of four negative
and four positive control wells.  The Picture Plot  in the upper right displays an
image of the cytoplasmic stain from well A-01, and the Dot Plot  below it
displays the integrated cytoplasmic intensity plotted against area for the cells in
that image. To the far left, the Gate View  shows a summary of all of the
existing gate hierarchy used in this layout. We will not address all of the gates in
this tutorial, but you may investigate them further on your own.

Figure T30.32  Experiment Design Page 

2.  Double-click the plate heat map.  The Formatting dialog will appear,
docked to the right side of the layout.

3.  Choose the Overlays category (Figure T30.33).  
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Notice you can plot any parameter that was measured for cells in each well by
changing the Statistic parameter drop-down and update the selected statistic
of the parameter with the Statistic to show drop-down list.  In this example,
we are plotting the Median value for all of the cells.  Review the available
options, but do not change Statistic parameter and Statistic to show (Figure
T30.33, red outline).
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Figure T30.33  Plate Heat Map Overlay Options

4.   Select the Color Levels category (Figure T30.34).

5.  Change the Selected Color Level drop-down list to Green-Blue (Figure
T30.34, blue highlighted text).
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Figure T30.34  Formatting Color Level of Heat Map

The plate heat map should resemble Figure T30.35.

 
Figure T30.35  Green-Blue Color Level  

6.  Right-click the plate heat map.

7.  Select . 

This will allow us to edit the "Single Well" gate created previously. Notice an
orange circle appears to highlight well A-01 on the plate heat map (Figure
T30.36a), indicating this well is the only member of the "Single Well" gate.
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Review the plate map of compounds; you will notice this is one of four negative
control wells (Figure T30.36b). 

Figure T30.36a  Activating Single Well Gate on Plate Heat Map

 Figure T30.36b   Compound Map For 96-Well Plate

8.  Click on well B-01, which is another negative control well. 
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By clicking on well B-01, you have changed the events within the "Single Well"
gate to contain only well B-01 data and not the well A-01 data. 

Notice the picture plot and dot plot on the page updates to display image and
measured data from well B-01 (Figure T30.37, left column of plots).

9.  Click on well E-01, which is a positive control well. 

Notice the picture plot and dot plot on the page update to display image and
measured data from well E-01 (Figure T30.37, right column of plots). Note the
image of well E-01 displays a more concentrated morphology of the nucleus
and the events in the dot plot distribution are concentrated toward the lower
left, indicating smaller areas and dimmer cytoplasmic staining. This is consistent
with the fluorescence moving from the cytoplasm to the nucleus. These changes
in distribution can be used to help establish gates.

Figure T30.37   Comparison of Negative and Positive Control Wells, B-01 and
E-01, in the Left and Right Plots, Respectively 
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10. Click the Choosing Parameters page tab in the lower left of window.

Notice there are three 2D plots on this page.  The "All Cells No Gate" top plot
displays the distribution of all cells by plotting
Intensity_IntegratedIntensity_Cytoplasm against
Intensity_IntegratedIntensity_DNA.  On this plot, cells tend to be a loosely
clustered distribution (Figure T30.38).

Figure T30.38  All Cells No Gate Dot Plot

11. Click the "All Cells No Gate" plot to select it.

12. Select the Overlays category in the Formatting dialog.

13. Choose Intensity_IntegratedIntensityEdge_Cytoplasm from the X
Parameter drop-down list.

The plot should resemble Figure T30.39.
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Figure T30.39  Changing X-Axis Parameter

Notice this plot is a distribution of all cells in the first column of the plate.  This is
optimal for creating gates because of the significant separation of cells
throughout positive and negative control conditions.  The positive control cells
are clustered toward the origin of the plot. We have now identified two
parameters that provide good separation of the positive and negative controls. 
At the onset of protein translocation from the cytoplasm to the nucleus, the
outer edge of the cytoplasm changes most rapidly.  Thus, comparing the
fluorescence of the outer edge of cytoplasm to the whole cytoplasm is a
sensitive indicator of the redistribution of the protein toward the nucleus. We will
proceed using this combination of parameters for the rest of the tutorial.

Note since the lower two dot plots (Figure T30.40) are displaying cells from the
positive control wells only or the negative control wells only, we see very
different population distributions.  These have been used previously to help define
gates for the tutorial.
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Figure T30.40  Comparison of Distributions for Positive and Negative Control
Cells in Left and Right Plots, Respectively

14. Click the Applying Gates page tab. 

Notice the picture plots are displayed for both a positive and negative control well
with corresponding dot plots below them (Figure T30.41).  Gates have been
applied to all plots. Events in the red Non-Translocated Cells gate are shown in
red, and those in the blue Translocated Cells gate are shown in blue.
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Figure T30.41   Display of Gates on Apply Gates Page

Examine the picture plots. You can see the distinct morphological differences
between cells highlighted in blue and red.  Review the dot plots. You can see
single positive and single negative control well dot plots with gates applied for
Translocated Cells and Non-Translocated Cells, respectively. The gating was
completed with guidance from viewing distributions in the Choosing Parameters
page and reviewing the picture plots to be sure the gates selected for the right
morphology on this page.  The picture plots are set to highlight cells within the
Translocated Cells and Non-Translocated gates as blue and red, respectively.
Notice  the percentage of cells in each gate is displayed in a text box on each
plot.  93.44% of cells are Translocated Cells (blue) in the Positive Control picture
plot on the left and only 2.19% cells are Non-Translocated Cells (red).  The cells
in the Non-Translocated Cells gate still have significant cytoplasmic edge staining
and have not translocated, even though they are in the positive control well.  

In the Non-Translocated picture plot, 82.64% of the cells reside in the Non-
Translocated gate. In the image, they primarily exhibit cytoplasmic staining with
an absence of nuclear staining. 15.97% of the cells reside in the Translocated
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Cells gate. This is the expected behavior for the controls, because the compound
driving the translocation can be nearly 100% effective.  Since there is always
some automatic activation in the negative control condition, the resulting
noticeable presence of translocated cells is expected.  Using this gating strategy,
we can account for the auto-activation in negative controls in subsequent
analysis on a cell-by-cell basis.  Accounting for these cellular subpopulations can
improve the assay quality.

Note: In this example, the Translocated Cells and Non-Translocated gate names
are displayed on the dot plots as well as the specific percentage of cells within a
gate.  This is accomplished easily by using tokens in FCS Express.  Tokens  are
very powerful and allow you to insert a statistic (and many other pieces of
information) in a text box either on a page or on plots.  Tokens  can be used in
many locations in a layout to display information from other locations in the
layout. The values or text of Tokens  update automatically as gates are
repositioned or new data sets are loaded.  We will not discuss Tokens  in detail
here.  For more information on creating and using tokens, see the tutorial  Text
Boxes and Tokens  or review Using Tokens .

15. Click inside the blue Translocated Cells gate on either 2D plot to select
it.  

16. Click inside gate and hold mouse button down; while holding the mouse
button down, drag the cursor to move the gate a small amount to the
right (Figure T30.42).

17. Release the mouse when the gate is in the desired position.
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Figure T30.42  Moving the Translocated Cells Gate

Notice the gating display to show the cells in colors updates based on the new
position of the gate (Figure T30.43).  Any cells not residing in either gate have no
color.  Note all plots and statistics displayed for gates update. Your layout may
not appear exactly at in Figure T30.43 because your gate position change may
be slightly different.
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Figure T30.43   All Plots Updated after Moving Translocated Cells Gate

18. Undo the gate repositioning by keying Ctrl+Z.

Section 2: Using Data Grids To Create a Cell Gallery View

19. Click the Insert tab group command (Figure
T30.44).

Figure T30.44  Inserting a Data
Grid
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20. Click anywhere on the layout where you have space to insert the data
grid.

21. Click the Data Grid to select data grid if necessary.

22. Select the General category in the Formatting dialog.

23. Select the Translocated Cells gate from the Gate drop-down list under
Data Options (Figure T30.45, blue highlighted text). Observe data grid as
a cell gallery updates to show only the translocated cells.

Figure T30.45  Applying Translocated Cells Gate to
Cell Gallery   
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24. Select the Non-translocated Cells gate from the Gate drop-down list
under Data Options.  Observe the cell gallery updates to show only the
non-translocated cells. 

25. Select the Parameters to Display category in the Formatting dialog.

26. Select the radio button next to "Only the items checked below"
option. 

27. Scroll down to the bottom of the parameter list and check the boxes next
to Cytoplasm, DNA, and Well options (Figure T30.46).

Figure T30.46  Selecting Parameters Displayed to
Create a Cell Gallery

The data grid should resemble Figure T30.47.  It will be referred to as a cell
gallery throughout the rest of this tutorial.
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Figure T30.47  Data Grid Configured to
Display Cell Images as a Cell Gallery

28. Close the layout and do not save changes.

Section 3:  Reviewing an Assay with the High Content Module

29. Open the IntroToImage3.fey layout.

30. Click the Overall Review page tab.

Notice this page is a summary of the entire assay.  The Plate Heat Map on the
left shows the plate format and the 8 wells of data we have loaded for it (Figure
T30.49). There is a dot plot depicting results from well A-01 and the
Translocated Cells  and Non-Translocated Cells gates. There are picture plots
from the same well and a Data Grid with a cell gallery displaying all cells in the
well with parametric data.  Last, there is a Gate View , which is showing all of
the saved gates used in the template.  Note some of the gates displayed in the
Gate View  may not have been used in the examples we have walked through
in this tutorial.  We will use this page to review the assay as a whole and get a
sense of what is happening in each well.
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Figure T30.49  Review Page

31. Right-click the plate heat map.

32. Select .

Well A01 will be outlined in orange since it is the only well in the "Single Well"
gate.  You now can click on any well and all plots will update for the selected well.
 Note if you click on any other plot you will have to repeat the edit gate process
to change well displays.

33. Starting with well A01 click on the various wells moving down toward
well H01.  Observe the changes in the plots.

Give the layout time to update when selecting a well.  You will find wells A01-
D01 are negative controls and have higher percentage of non-translocated cells.
Notice, in the picture plots, most of the cells are red, indicating they are not
translocating.  In the dot plot, see the large distribution in the plot, and that cells
reside in both gates.  In the data grid, displaying a cell gallery, you can see in
which gates individual cells reside, and the corresponding morphology in their
respective images matching their translocated or non-translocated designation.

34. Multiple-select wells E01-H01 and observe the dot plots and picture plots
for each well.  These are the positive control wells. 

Notice the change in the images to predominantly nuclear staining in blue, the dot
plot depicts cells clustered predominantly within the positive control gate.  The
Data Grid with a cell gallery indicates translocated morphology with staining
predominantly in the nucleus.  The gate display in the data grid indicates all cells in
the positive control gate.  It is easy to review your data for the whole plate in
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this layout page and view analytical results combined with images and other
relevant information from the original data all in one place!

35. Close the layout without saving changes.

22.30.3 Batch Processing and Reporting for Image Data

In this section, we will learn how to:

· Open a layout and configure a batch process for several wells in a 96-well

plate 

· Configure the Batch Processing Actions to export the batch results as

reports

· Pause between wells to confirm the current iteration of the batch is being

analyzed correctly

· Reconfigure the batch to run in an automated fashion

· Export a high resolution image from the layout for publication purposes

· Export the layout to a PowerPoint

· Export the layout to .PDF 

Important note before starting: With the release of FCS Express 7.18, Picture
plots display images at their original zoom originating from the top-right corner
of the image. Both the zoom and region of the image displayed in the Picture
plot can be customized (please refer to the Zooming/Panning Specific
Options for Picture Plots  section of the Working with Picture Plots  chapter
for more details). Depending on the release of FCS Express you are using,
screenshots in the section below may differ from what you see in FCS Express
but the results will be the same. Zooming/panning settings may be adjusted as
needed by the end user at anytime in the tutorial

We will use the IntroToImage4.fey layout, which is located in the Intro to
Imaging Tutorial subfolder found in the Tutorial Sample Data archive . This
layout contains a detailed per-formatted approach to batch processing and
report generation with image data.

For this section, we will use data generated on the Molecular Devices
ImageXpress Velos system (previously called "IsoCyte"). The ImageXpress Velos
System is a high-speed cytometer, which performs whole well imaging for an
entire multiwell plate. Cells are typically 10-20 pixels each and appear as small
dots within a whole well image. This system can scan plates in as little as 3
minutes enabling high throughput image-based cytometry. It is ideal for

267 267
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cytometric analysis of adherent cells that are difficult to study in suspension with
Flow Cytometers.

The ImageXpress Velos data is fully compatible with FCS Express 6 Image
Cytometry. As we will show in this tutorial, preferences can be set to
immediately import and open data from the ImageXpress Velos into FCS
Express. You will see images and 2D plots from an Live/Dead experiment run in a
96-well plate.  We will review one row of data from the plate for this experiment
using a previously saved layout for the tutorial.  This single row includes a dilution
series of a compound that results in a range of all live to all dead across the
wells. Live cells are stained with a dye identified as "IMEAN-1," and dead cells
with another dye identified as "IMEAN-3."  

We first will check the user options and then open the IntroToImage4.fey
layout to learn how to import and load data into the Data List.

Section 1: Checking User Options and Preparing a Batch Analysis (If you
have completed Section 1, please skip to Section 2 .  If you have completed
Sections 1 and 2, please skip to Section 3 .  If you have completed Sections 1,
2, and 3, please skip to Section 4 .)

1.   Click File tab (Figure T30.49, indicated by cursor near the
bottom).

2634
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Figure T30.49 
Options from File

Tab

2.  Expand the Data Loading category by click the + ("plus" sign) and
choose the ImageXpress Velos options subcategory in the left pane of
FCS Express User Options dialog (Figure T30.50, orange highlight text).

3.  Confirm the only box checked is next to "Load images" option under
IsoCyte Reader Options.  It is only necessary to load data as a plate
when working with the High Content module .  Do not load data as a
plate when planning to run a batch analysis for individual wells of a plate.  If
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batch processing through multiple multiwellplates, check the box next to
"Load as Plate" option and do not set to load images, unless you need
them.

Figure T30.50 Correct Data Loading Settings

4.  Click OK.

5.  Select File tab .

6.  Browse to and select IntroToImage4.fey layout from the Intro to
Imaging Tutorial subfolder of the Tutorial Sample Data archive .

You will see a template for analysis and reporting of data from Live/Dead Assays
run on the ImageXpress Velos.  The Batch Setup page of the layout will have an
empty Data List, four unpopulated plots, an empty summary data table at the
top, a Gate View , and a date stamp in the lower right for Analysis Date
(Figure T30.51).

1682
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Figure T30.51  Empty Layout

7.  Click the  button in the Data List to choose Add Data File (Figure
T30.52).

Figure T30.52  Adding Data to Empty Data List

8.  Choose ImageXpress Velos files (*.iso) from the Files of Type: drop-
down list in the Select data file dialog (Figure T30.53, red outline).

9.  Open the ImageXpress Velos With Image subfolder to open
Live_dead_96.well.iso subfolder within the Tutorial Sample Data archive
(Figure T30.53).

10. Select all the Live_dead_96[...] files.

11. Click Open file.
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Figure T30.53  Selecting the Data Files

The Data List now will contain data from the 12 wells (A01-A12) of the
Live/Dead Assay (Figure T30.54).

Figure T30.54 Data List showing Data Files

12. Click to select the first file in the Data List (Figure T30.55, blue highlighted
text).
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13. Click on the Change data drop-down in the Data List (Figure T30.55,
fifth icon).

14. Select Change Data On All Plots (Figure T30.55, light-blue highlighted
second option).

Figure T30.55  Loading First Data File into Layout

All the objects on the layout should be populated with data from
Live_dead_96_A01.iso (first file in the Data List) as shown in Figure T30.56).
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Figure T30.56  Well A01 Displayed in Layout

We will review the entire Batch Setup page of IntroToImage4.fey again.  Notice
the page is configured with a summary table at the top and four plots (Figure
T28.60).  Two dot plots  on the top indicate the Live and Dead cell channels,
respectively for the given well.  The left and right picture plots  at the bottom
of the page are the live and dead images, respectively.  Live Cells and Dead
Cells gates have been created prior to this tutorial.  Tokens  on the dot plots
calculate and show the percentage of live and dead cells. Additional gates (#
Cells in Live/Dead) count total number of events in each of the fluorescent
channels. Observe in the data table at the top of the page is showing data from
well A01 as noted in the left-most column of the table (Figure T30.57). 

Figure T30.57  Data Summary Table

Now, we will increment through the samples in the data list.

201

123

1284



FCS Express 7 Manual2630

© 2023 De Novo Software

15. Click the blue number 2 from the Iteration column in the data list.

16. Repeat step 15 for Iterations 3 through 12.  Observe how all the objects
on the layout update to display the selected iteration.

17. Click the blue Iteration number 1 in the data list to return to displaying
the first data file.

Next, we will learn how to close and reopen the Data List window.

18. Close the Data List by clicking the "X" in the upper right corner of it. 

19. Reopen the Data List by clicking the Data tab
group  List command on the ribbon (Figure T30.58).

FIgure T30.58  Opening Data List from Data Tab on Ribbon

We now will demonstrate creating a summary table.

20. Click the Insert tab group  Box command on the ribbon
(Figure T30.59).

Figure T30.59  Text Box
Command from Insert Tab on

Ribbon

21. Click anywhere on the layout to insert the new text box.

22. Right-click inside the text box.

23. Select (Figure T30.60).
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Figure T30.60  Inserting a Table into Text Box

The Insert Table dialog will appear, allowing you to create a table of any size
and dimension (Figure T30.61).

24. Enter 5 in the edit field for Number of columns:.    

25. Click Cancel to avoid creating a new table since steps 20 through 24
illustrate adding a new table. 

Figure T30.61  Insert Table Dialog

26. Delete  the text box added from steps 20 and 21.

27. Click on the "Well ID" text in the cell in the upper left hand corner of the
summary table (Figure T30.62).

Figure T30.62  Summary Data Table
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28. Edit the "Well ID" text as you would in Word, Excel or PowerPoint.

29. Undo your edits with Ctrl+Z commands until the "Well ID" text is
restored.

30. Select the A01 text in the lower left hand box of the summary data table
using standard Windows selection techniques. The grey background of the
A01 text indicates it is a Token . Notice the text turns white when
selected (Figure T30.63).

Figure T30.63  Selecting a Token

31. Double-click on the A01 Token . 

The Edit Keyword dialog will appear (Figure T30.64).

32. Select the Keyword category to choose a token displaying a Keyword
from the data set (Figure T30.64, orange highlighted text).

33. Click on the ellipsis  button (Figure T30.64, red outline).

Figure T30.64   Edit Keyword Dialog

 The list of the available keywords appears in the Please select a keyword
dialog (Figure T30.65).

34. Select Well ID from the Please select a keyword dialog (Figure T30.65,
blue highlighted text) and click OK.

35. Click OK to close the Edit Keyword dialog. 

1802
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You have confirmed the Well ID as keyword to be printed in the Well ID column
of our Summary table.

Figure T30.65  Confirming WellID Keyword is Used in Summary Data Table

Optional: You may repeat steps 31 through 35 to edit the token used for "Laser
Line," replacing it with "Master Channel" keyword in the second column, to
gain more experience with keyword tokens. Please undo any these optional
steps if performed before continuing.

In this report layout, all of the values in the lower row of the Summary Data
Table are Tokens , which have been placed in the cells to add dynamic data
into the table.  We have inserted the keywords for Well Name and Laser Name
from the ImageXpress Velos data into the first 2 cells.  

Note we can label the columns of the summary data table as preferred since
they are free text. We use these rather than the default names from the
metadata, "Well Name" and "Laser Name," respectively for added clarity in the
report.  The other values in the table are tokens to report calculated values from
specific gates.

For example, the % Live cells and % Dead cells values are tokens displaying
the percentage of cells residing in the respective Live Cells and Dead Cells
gates.  The Live/Dead Ratio Token  is a  "custom token"  to create a ratio
of two existing values (% live / % dead) that are derived from the gates.  We will
not discuss Custom Tokens  in detail here.  For a complete tutorial on using
Tokens , please see "Text Boxes and Tokens " or review the "Using
Tokens " section of the manual.  We will not make any additional changes to
Tokens used in the table.

36. Select all of the text in the Summary Data Table by clicking and dragging
over all the cells of the entire table.  Alternatively, click in any cell of the
table and use Ctrl+A to select all text in the table (Figure T30.66).
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Figure T30.66  Selecting all Text in the Summary Data Table

37. Select the Text tab as shown in Figure T30.67.

Figure T30.67  Editing Font Properties from Text Tab
on Ribbon

38. Change the size of the font in the table from 10pt to 12pt as shown in
Figure T30.67 above.

39. Click on the "B" (bold) button to change all the text to Bold as shown in
Figure T30.67 above.

Notice you have similar options for editing text in a layout page as you would
expect in any Microsoft product.  This allows layouts to be customized in any
way you require for custom reporting.

40. Click anywhere on the summary data table to remove the highlighting for
the selection and view changes (Figure T30.68).

Figure T30.68   Summary Data Table All Cells Modifed to Bold and 12pt Font

Section 2:  Configuring a Batch Analysis for Image Data

We now will configure a batch analysis and run through it to create a report to
export from FCS Express.  In this example, the settings for the batch were setup
previously. We will review them, and then run the batch several ways. Please see
the tutorial on Batch Processing  for detailed instructions on setting up a batch
process and configuring advanced reports.

41. Click on the Batch tab group
command(Figure T30.69, red outlines).
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Figure T30.69   Opening the Batch Actions Window from Ribbon

The Batch Actions window will appear as shown in Figure T30.70.

Figure T30.70   Batch Process Actions for Layout
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Notice in the Batch Actions menu that there are many actions and reports that
can be set up in a batch process (Figure T30.70).  We will not review setting up a
new batch process in this tutorial.  Once configured, batch processing of data and
report generation occur simultaneously and can be exported in a variety of
formats.  For additional information on creating reports, refer to the Batch
Processing  tutorial.

Observe in the Batch Process Actions window that it is pre-configured to run
batch analysis for each well in the Data List, and export information to both a
PDF and an Excel spreadsheet.  The PDF will show what we see in the Batch
Setup Page, and the Excel file has been configured to log specific values to the
spreadsheet automatically during the batch run. Items to be exported to Excel
are listed.

To demonstrate the ease of configuring batch output, we will add one additional
variable to the output for the Excel spreadsheet using drag and drop capabilities
for tokens.

42. Select the token for Total Events in the summary data table on the Batch
Setup page of the layout. Recall from that the token will appear in white
when selected properly (Figure T30.71).

Figure T30.71
Selecting the Token

for Total Events

43. Click the highlighted token and hold mouse button down.

44. While holding mouse button down, drag it onto the Excel (Column
Mode) text in the Batch Process Actions window (Figure T30.72, indicated
by arrow).  

45. Release the mouse button when you see a "+" sign on the cursor (Figure
T30.72).
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Figure T30.72  Drag and Drop to Add Token to Excel (Column Mode) Batch Action

Note a new item has been added to the Excel (Column Mode) report in the Batch
Process Action section (Figure T30.73, blue highlighted text).

FIgure T30.73  Newly Added Report Item for Excel (Column Mode)
Batch Action

Please note that the newly-added keyword is a duplicate since the exact same
item was added to the list previously. In order to avoid duplicates, remove the
first Keyword: Counts for Plot #2, overlay #1 (the one directly above the
one highlighted in blue in Figure. T30.73 above) by clicking it and keying Delete
on your keyboard.

Now, we will modify the token added from steps 42 through 45..

46. Double-click on the last item in the list, Keyword: Counts for Plot #2,
overlay #1. 

The Excel (Column Mode) field [...] dialog will appear (Figure T30.74).
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47. Select the Field category (Figure T30.74, orange highlighted text).

The Column Name edit field will be empty 

48. Enter "Total Events" into Column Name field (Figure T30.74).  

49. Click OK.  You have named the respective column header for the Excel
file export as "Total Counts."

Figure T30.74   Editing the Column Name Field

This token has now been added to the excel export report.  For each well, the
actual values will be logged into an Excel table, and we have edited the column
header that will appear as "Total Events" in the report.  You may turn off any
Batch Action by unchecking the box next to the item to not participate in the
batch process.  We will not discuss configuring batch analysis in more detail in
this overview tutorial. For a more detailed tutorial on Batch Processing, please
see the tutorial titled Batch Processing . There also is a detailed section in the
manual on Batch Processing .  

We now define the paths to save our PDF and Excel reports to the desktop when
the batch process runs.  

50. Double-click on Export to PDF in the Batch Actions window (Figure
T30.75, blue highlighted text).

Figure T30.75  Editing the PDF Export Settings
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The Edit Export to PDF Action dialog will appear (Figure T30.76). 

51. Click the folder icon  next to the Save to a new file: edit field under
the Output file options to select where to save and name the file (Figure
T30.77, red outline).
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Figure T30.77   Editing the PDF Export Saving Path
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52. In the Save As dialog, select your desktop and enter "MyBatchReport"
in the File name field.

53. Click Save and the path will appear in the once-empty Save to a new
file: field under Output file options.

54. Click OK.

55. Double-click the Excel (Column Mode) in the Batch Actions window.

The Excel (Column Mode) Options dialog will appear (Figure T30.78). 

Figure T30.78   Editing the Excel Export Saving Path

56. Repeat steps 51 through 54.

Section 3: Running the Batch and Reviewing Reports

57. Click the Batch tab  group command. 

The Batch Processing Options dialog will appear (Figure T30.79).

Notice you have many options when configuring a batch process.  Do not change
any of the settings already configured.  However, notice that we have selected
the check box to Unconditionally pause between iterations.  This way we do not
need to run all wells to test a batch run.  In this case, we have only 12 wells and
will allow the batch to run completely without pausing.  While pausing between
iterations is a great way to test a batch run through several steps without
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committing to a complete run, it will be ignored in this example. For a
comprehensive view of all the options, please refer to the Batch Processing
Options  manual.

58. Uncheck the box for Unconditionally pause between iterations (Figure
T30.79, red outline).

59. Click OK.

817
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Figure T30.79  Configuring Batch Processing Options
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60. Click on Batch group  command.

The batch process should complete in under one minute. A status window will
appear during the batch process showing how the progress (Figure T30.80).

Figure T30.80  Batch Processing Status Window

When finished a PDF file called MyBatchReport.pdf will open automatically with
the report.  Similarly, an Excel file called MyBatchReport.xls will open.  

61. Review the PDF document and confirm there are 12 pages of data -one
for each well processed (Figure T28.81)



Tutorials 2645

© 2023 De Novo Software

Figure T30.81  "MyBatchReport" PDF Report from Batch Actions

62. Review the Excel spreadsheet; it will have 12 rows of data set exported
with the designated column labels. Notice the  "Total Events" custom
column title is displayed in the header cell G1 (Figure T30.82, red outline).
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Figure T30.82  "MyBatchReport" Excel Spread Sheet Report from Batch Actions

63. Close the PDF and Excel files. You do not need to save the reports.

64. Return to FCS Express and close the Batch Actions window.

Section 4: Exporting a high-resolution picture from FCS Express

You can save any layout page or plot as a high-resolution image or
publication figure.

65. Select the Live Cells Live_dead_96_A01.iso picture plot as shown in
Figure T30.83. 

Note the picture plot will have a green border if you click inside to select it.  It will
have a red border if you click the edge of the plot or click the green border. 
Either state of selection is fine for exporting an image.
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Figure T30.83   "Live_dead_96_A01.iso
compensated" Picture Plot 

66. Right-click the green or red border of the plot and choose Save selection
As Picture (Figure T30.84)

Figure T28.84 Saving a Selected Plot as a Picture
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67. Select the Desktop as a destination and enter "MyExportedImage" in
the File name: field of the Save Selection as Picture dialog.

65. Select TIF (*.tif) format from the Save as type: field of the Save
Selection as Picture dialog.

66. Click Save.

67. Review the .tiff image on your Desktop.  Notice it is a high resolution
image. You can change the default resolution in the FCS Express User
Options.

68. Close the layout without saving changes.

This concludes the Introduction to Image Cytometry tutorial.

22.31 Immunophenotyping

FCS Express makes it easy for you to analyze your flow cytometry data and
generate reports.  In this Immunophenotyping Tutorial, rather than going into
depth on any particular procedure, we'll touch on a variety of software features
in the context of a natural work flow for analyzing flow cytometry data.  

In the course of completing this tutorial, you will insert  and format plots ; 
create gates , markers , and quadrants ;  add default  and custom
statistics  to your layout;  and, batch export  your results to PowerPoint™
and Excel™.  After completing the tutorial, you will have become familiar with
many of the basic yet powerful features of FCS Express.

This tutorial is organized into the three sections, listed below, which together
comprise one complete work flow.  Each section stands as an independent
exercise, so you may complete each section of the tutorial separately if you
wish.

· Section 1: Begin building your layout  with plots and other analysis

elements (e.g., gates, markers, quadrants), on the next page. 
· Section 2: Add default and custom statistics  to your layout, or to

the provided layout.
· Section 3: Batch process your results to PowerPoint and Excel ,

using your own layout or the provided layout.

You may also view the Immunophenotyping Analysis recorded webinar
which accompanies this tutorial.  
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22.31.1 Building your layout

In this section, we will:

· Load an .fcs file  into the plots on the layout.

· Insert  and format plots .

· Create  and apply gates , markers , and quads .

· Change our axis labels .

Note:  There are three Save Points in this section of the tutorial, so that you
may save your progress and return to these Save Points in the tutorial later:

· Save Point #1 (Step 21)

· Save Point #2 (Step 39)

· Save Point #3 (Step 69, end of this section)

1. Select File Open.

2. Open the layout Immunophenotyping Tutorial.fey found in the
"Immunophenotyping Tutorial" folder within the Tutorial Sample Data
archive.    

The layout has been saved unlinked  to any .fcs files, so the plots will appear
empty (Figure T31.1).  Unlinked .fey files (layouts) are convenient to use as
templates for similar experiments in the future.  Learn more about the three
options for saving layouts . 
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Figure T31.1  Immunophenotyping Tutorial.fey. Note that plots appear
empty because the layout is saved as "unlinked".
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We first will change our Default Options  in order to display Stain and Name
keywords  on our plot axes .

3. Follow the directions in the Changing Axis Labels section  of the Changing
Common Default Options tutorial  if necessary.

Now, your plots' axes  for .fcs files subsequently loaded into this layout
will be labeled with these descriptive keywords  that were saved with your .fcs
files at the time of acquisition.

We will now load an .fcs file into the plots .

4. Select the Data tab  from the

Ribbon (Figure T31.2, ).

5. Navigate to the "Immunophenotyping Tutorial" folder within the Tutorial
Sample Data archive , in the Select a Data File dialog box which

appears (Figure T31.2, ).

Figure T31.2  Loading .fcs files into the plots

6. Select "Sample 1.fcs" in the Select a Data File dialog (Figure T31.2, ).

7.  Click Open (Figure T31.2, ).

The plots now display the data from the Sample 1.fcs file with a predefined
"scatter" gate  and quadrants  (Figure T31.3).
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Note  the Experiment keyword  derived from the .fcs file is now displaying in
the text box  at the top of the layout, as are the Current Windows User and
Current Date.  All of these were inserted into a text box  as live-updating
tokens . 
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Figure T31.3  2D plots after changing file
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8.  Press and hold anywhere inside the boundaries of the red "scatter" gate
(Figure T31.4).

9.  Drag the "scatter" gate out of the plot to the empty space at right while

continuing to hold the mouse button down (Figure T31.4, ).   

Figure T31.4  Dragging and dropping the "scatter" gate out of a plot to make a
new plot gated on "scatter"

10. Release the mouse button when your cursor is on an empty part of the
layout to the right of the original plot.

A new plot gated on this gate will appear at the conclusion of the drag and drop

action commenced in Step 8 (Figure T31.4, ).

11. Click the X-axis of the new plot.

12. Click "CD45 V800-A" to select it as the parameter  from the pop-up
list.  You may also type CD45 V800-A in the empty field at the top of the
list (Figure T31.5).

The X-parameter of the plot has now been changed to "CD45 V800".  Note
that Step 3 of this tutorial permitted both the Stain (CD45) and Name
(V800-A) keywords  to appear on the axis.  This change in your
Preferences will affect all future layouts made under the current FCS
Express User Profile . 
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Figure T31.5  Changing the
X-parameter of a plot

13. Repeat steps 11 and 12 for the Y-axis of the new plot, selecting "CD19
V655-A" as the new parameter. 

The plot will now appear as in Figure T31.6.
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Figure T31.6  Plot with X- and
Y-parameters changed to CD45

V800-A vs CD19 V655-A

14. Select the Gating tab  Gates group  command from
the Ribbon (Figure T31.7).

Figure T31.7  Selecting a gate shape from the
Gating tab of the ribbon

15. Click around the periphery of the CD45+CD19+ population to create
vertices of the gate in the right color dot plot (Figure T31.8).
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Figure T31.8  Drawing a polygon gate

16. Close the gate by clicking on the first vertex you defined (Figure T31.9, 
).

The Create New Gate dialog appears in which the gate name, color, and other
properties may be defined.

Figure T31.9  Closing and naming a polygonal gate
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17. Type "B cells" in the Create a new gate name field (Figure T31.9, )  

18. Select bright green from the Gate color drop down menu. (Figure T31.9,

).

19. Click OK (Figure T31.9, ). 

20. Select File Save As and save the layout linked  (first option from
drop down menu shown in Fig. 4.2) .  You may then return to this Step
in the tutorial at a later time by clicking on Save Point #1 at the top of this
page. 

Save Point #1 (Step 21)

We now will examine the phenotype of the B-cell population in more detail by
gating the plot  in the lower-left corner on the "B cells" gate.

21. Click and hold anywhere inside the boundary of the green "B cells" gate
(Figure T31.10).  

22. While holding, drag the gate toward the lower left plot.  You will start to
see a "ghost" of the gate outline move along the dragging path (Fig.

T31.10, ).
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Figure T31.10  Gating a plot by dragging and dropping a gate from another plot

23. Release the mouse button when the recipient plot outline turns blue

(Figure. T31.10, ).

The recipient plot now is gated on "B cells" and appears similar to Figure T31.10,

.

Note: dragging and dropping the "B cells" gate from the Gate View  to the
recipient plot would achieve the same action.

24. Select Format tab group command from
the ribbon (Figure T31.11) while the lower-left plot is still selected.

391



FCS Express 7 Manual2660

© 2023 De Novo Software

Figure T31.11  Changing Plot Type 

25. Click on Contour (Fig. T31.11).

We now will examine the phenotype of the IgD/IgM-double-negative and -
double-positive populations of B-cells in more detail.

26. Click and drag the central Quadrant vertex, as shown in Figure. T31.12,
to adjust its position so that the double-positive and double-negative
populations are better divided.

Note:  Outer vertices of these Floating Quadrants  may also be adjusted, if
desired.
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Figure T31.12  Adjusting the central quadrant
vertex

27. Right-click the contour plot (Figure. T31.13).

28. Select Convert Quads to Gates Upper Right Convert and Link
(Figure T31.13, indicated by cursor).

Fig. T31.13  Converting and linking the upper right quadrant to a gate

 The Create New Gate dialog appears.
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29. Repeat steps 18-20  but name the gate "Double Positive" and assign
it a turquoise color to match the pre-formatted text table in the lower right
corner of the layout. 

30. Repeat steps 27-28 in order to Convert and Link the Lower Left
Quadrant to a Gate.  

31. Repeat steps 18-20  but name the gate "Double Negative" and assign it
a pink color to match the pre-formatted text table in the lower right corner
of the layout. 

32. Select File Save As and save the layout linked , or simply press
Ctrl+S on your keyboard if you already saved this layout linked  as in
Save Point #1.  You may return to this step in the tutorial at a later time
by clicking on Save Point #2 at the top of this page.

Save Point #2 (Step 39)

33. Select Insert tab group Histogram command from the
Ribbon (Figure T31.14, outlined in red).

Figure T31.14  Selecting histogram from the
Insert tab of the Ribbon

34. Press and hold on the blank space of the layout above the pre-formatted
table (Figure T31.15).

35. Drag the cursor until the histogram is of the desired size, while continuing

to hold the mouse button (Figure T31.15, ).

Note:  Any plot, text box, or other object  on your layout may be resized  at
any time.
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Figure T31.15  Inserting a Histogram

36. Release the mouse button.  A new histogram  appears, similar to Fig.

T31.15, .

We now will overlay  the "double-positive" and "double-negative" populations
onto the histogram to compare their CD20-expression.

37. Right-click the histogram  (Figure T31.16).

38. Select Add overlay in the associated pop-up menu (Figure T31.16). 

Figure T31.16  Adding an overlay to the histogram by right clicking on the
plot and choosing "Add Overlay"

186

186

186



FCS Express 7 Manual2664

© 2023 De Novo Software

39. Repeat Steps 5-7  as in Figure T31.2  to add "Sample 1.fcs" from the
Data List tab as a second overlay  to the histogram . 

40. Click OK on the additional dialog box that appears (Figure T31.17). 

Figure T31.17  Adding Overlays Dialog

41. Right-click the histogram again.

42. Select Format in the associated pop up menu (Figure T31.18).
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Figure T31.18  Right-clicking on the 1D-plot to access Format options

43. Select Overlays from the drop down list (Figure T31.19).

Figure T31.19  Formatting histogram overlays
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44. Select both overlays by clicking on each while holding down Ctrl on the
keyboard (Figure T31.19).

45. Select "CD20 G710-A" from the X Parameter drop-down menu (Figure
T31.19).

46. Increase Smoothing  to "5" (Fig. 31.19).

47. Click on the first overlay ("1-Sample 1.fcs compensate...") so it alone
is selected (Fig. 31.20).
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Figure T31.20  Formatting histogram overlays,
continued

48. Select "double positive" from the Gate drop-down menu (Fig. 31.20).

49. Select turquoise as the Color under Line Options (Fig. 31.20).
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50. Repeat Steps 47-49, but this time click instead on the second overlay
("2-Sample 1.fcs compensate..."), and choose "double negative" as the
Gate and pink as the Color, respectively.

The histogram should resemble Figure T31.21.

Figure T31.21  Preview of gates, colors,
and smoothing applied to both histogram

overlays

Optional:  Normalize the histogram, in Steps 51-59.  Otherwise,
proceed to Step 54 . 

51. Select the Specific Options category in the Formatting dialog. 

52. Select Peak Value from the Normalize to drop-down list (Figure
T31.22).

53. Select the Based on Value radio button (Figure T31.22).

Figure T31.22  Normalizing a histogram
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 Post-normalization, the histogram will resemble T31.27, right;  if you chose not
to normalize, it should resemble Figure T31.21.  

We now will look at the differences in CD20-expression between the IgD/IgM-
double-positive and -double-negative populations by creating a marker on the
CD20-positive population.

54. Right-click on the histogram (Figure T31.26).

55. Select Create marker in the associated pop up menu (Figure T31.26).

Figure T31.26 Right-clicking on the histogram to add a marker

56. Press and hold on the histogram to the left of the positive population
peak (Figure T31.27).

57. Drag the mouse pointer to the right until the marker spans the peak

(Figure T31.27, ).

Figure T31.27  Creating a marker
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58. Release the mouse.  The marker  ("M1") now hsa been added to the

plot (Figure T31.27, ).

59.  Select File Save As and save the layout linked , or simply press
Ctrl+Son your keyboard if you already saved this layout linked  as in
Save Point #1 or #2.  You may return to this step at a later time by
clicking on Save Point #3 at the top of this page.

Save Point #3 (Step 69,
end of this section)

We now have created a layout with 2D plots, histograms, gates, quadrants, and
markers.  Next, we will add summary statistics to our layout .

22.31.2 Adding statistics to your layout

In this section, we will:

· Add a default statistics table to our layout.

· Fill a custom text-table  with selected statistics .

· Define a custom ratio using a Custom Token .

It is easy to add default statistics tables as well as custom-made tables and
statistics to your FCS Express Layout.  We will now add one example of each
to this Immunophenotyping Tutorial Layout.

1. Select File Open.

2. Open the layout Immunophenotyping Tutorial Ready for Summary
Statistics.fey found in the "Immunophenotyping Tutorial" folder within the
Tutorial Sample Data archive.    

The layout has been saved linked  to the .fcs files in the same folder, and
should resemble your layout after completing the previous section of the
tutorial .  You may use this layout or your own layout to proceed to Step 3.

3. Right-click  the contour plot in the lower-left corner of the Layout (Figure
T31.28;  note:  the plot pictured is from the provided layout for this
section and shows red outlier dots added as in optional Steps 27-32 from
Section 1 .  If you are using your own layout from the previous section
and skipped those steps, your plot will look slightly different.)

4. Select Quadrant statistics from Statistics on the associated pop-up
menu (Figure T31.28).
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Figure T31.28   Adding a default quadrant statistics window to the layout

A quadrant statistics window appears, similar to Figure T31.28.  Note: you may
move  this statistics window to a convenient part of your layout, such as below
the contour plot.

Note:  Default statistics windows may also be similarly added for gates,
markers, and histograms.  You may right-click on the quadrant statistics window
to add or remove various statistics.

A Default statistics window is a convenient way to quickly display summary
statistics  for a given plot.  Summarizing the results of your entire experiment,
however, often requires data from multiple plots on the layout.  This is easily
accomplished in FCS Express by adding statistical and keyword tokens  to
custom-made tables in a text box. We will now add statistical tokens to the text
table  in the lower-right corner of the layout, which was custom designed
within a text box .  The chief advantages of these custom tables are
statistics  from multiple plots may be displayed, the endless combination of
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statistics  including user-defined statistics  may be shown, and the
appearance of the table itself is fully formattable .  

5. Click on the border of the histogram to select it (Figure T31.29)  

Note: the histogram pictured is from the provided layout for this section
and shows a normalized histogram as formatted in optional Steps 59-62
from the previous section .  If you are using your own layout from the
previous section and skipped those steps, your histogram will instead
resemble Figure T31.23 .)

6. Drag the plot toward the upper-right cell in the table (Figure T31.29, ).

  

Figure T31.29 Dragging and dropping a
marker-derived statistical token into a text

table

7. Release the mouse when the cursor is visible within the upper-right,

turquoise cell in the table (Figure T31.29, ).  Go on to Step 8 or to Step
11  if you were referred here from a more advanced point in this tutorial.
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8. Double-click Statistic token in the Paste Special dialog (Figure T31.30,

 ).

9.  Select "M1" in the Select a marker category of the Edit Statistic dialog

box that appears (Figure T31.30, ).

Figure T31.30  Selecting a marker-derived statistical token

10. Select % of gated cells in the Statistic category (Figure T31.30, ).

11. Click OK (Figure T31.30, ).

12. Repeat Steps 5-9 , but drag the marker into the pink cell reserved for
the double-negative, CD20-positive population (immediately below the cell
indicated in Figure T31.30).

13. Click on Data Source in the category at left (Figure T31.31, ).
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Figure T31.31  Defining the second overlay in the histogram as the data source
for a statistical token

14. Click on the second overlay to select it as the Data Source for this

statistic (Figure T31.31, ).

15. Click Statistic and select % of gated cells in the Statistic category.

16. Click OK (Figure T31.31, ).  The two tokens now appear in the text
table  as shown in Figure T31.32.  Note: exact values may vary in your
layout due to your placement of gates, markers, and quadrants.   You may
adjust any of these and watch the tokens update accordingly.

17. Press and hold the mouse button inside the boundaries of the red
"scatter" gate in the upper-left color dot plot (Figure T31.32).

18. Drag it toward the table (Figure T31.32, ).  

1799
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Figure T31.32  Dragging and dropping a gate-derived statistical token into a
text table

19. Release the mouse when the cursor is visible inside the turquoise cell

pictured in Figure T31.32, .

20. Select "double positive" from the Gate list of the Edit Statistic dialog

(Figure T31.33, ).

21. Select X Arithmetic Mean in the Statistic category (Figure T31.33, ).
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Figure T31.33  Selecting a gate-derived statistical token

22. Click on the Number Format category and reduce the Number of

decimals to "0" (FigureT31.34, ).

Figure T31.34   Reducing Number of Decimals for Statistic

23. Click OK (Figure T31.34, ).
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24. Repeat Steps 16-22 , but drag the "scatter" gate into the pink cell
reserved for the double-negative population (immediately below the cell
indicated in Figure T31.32), and select "double negative" in the Gate drop-
down menu.

We will now define a ratio between the CD20-positive populations of the
IgD/IgM-double-positive and -double-negative B cells using Custom Tokens ,
which we will subsequently enter into the lower-right blue cell in the table
reserved for "ratio +/+ : -/-".

25. Select the View Tokens Custom Tokens command (Figure
T31.35, red arrow).

Figure T31.35  Opening the Custom Tokens window

26. Move the floating Custom Tokens window to the side of the page, so
the plots are visible.

27. Click the blue Plus button ( ) for (Create a new Custom Token)

(Figure T31.36, ).

Figure T31.36  Defining a new custom token as a ratio between two regular
statistical tokens

28. Type "CD20 ratio" as a descriptive name for the Custom Token (Figure

T31.36, ).

We now will define the formula for a simple ratio, using a procedure similar to
that used in Microsoft Excel.  However, instead of typing static numbers into the

Formula, we will enter the tokens we defined in the text table  on the layout. 
Thus, as the values of the tokens  change among different samples in our
experiment, the value of the "CD20 ratio" Custom Token  will update
accordingly.
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29. Type an equals sign ("=") in the Enter the Custom Token formula

below pane of the Custom Tokens window (Figure T31.36, ).

30. Highlight the Token in the upper right, turquoise cell of the layout (Figure

T31.36, ).

31. Drag it toward the Enter the Custom Token formula below pane, while
keeping the mouse button pressed.

32. Release the mouse when the cursor appears after the equals sign ("=")

(Figure T31.36, ).  The Token Description will appear there, highlighted in
blue.

33. Type a division sign ("/") in the Enter the Custom Token formula

below pane of the Custom Tokens window (Figure T31.36, ).

34. Repeat Steps 29-31 for the Token in the pink cell corresponding to the
CD20-positive, IgD/IgM double-negative population.  The complete "CD20
ratio" Custom Token Formula is pictured in Figure T31.37, extreme right. 

We will now drag and drop this "CD20 ratio" Custom Token into the appropriate
cell, to complete the "CD20+" column of the text table on our Layout.

35. Press and hold on the "CD20 ratio" Custom Token in the Custom

Tokens Window (Figure T31.37, ).
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Figure T31.37  Dragging and dropping a custom token from
the custom tokens window into the summary text table on

the layout

36. Drag it toward the lower-right cell in the text table.

37. Release the mouse when the cursor is visible in the appropriate cell
(Figure T31.37, dashed arrowhead).  The value of the "CD20 ratio"

Custom Token will appear as in (Figure T31.37, ).  Note:  the value may
differ slightly from that shown, depending on your placement of gates,
markers, and quadrants.  You may adjust these to watch the value of the
"CD20 ratio" Custom Token update in real-time.
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You now have added a default statistics table to your layout, and have filled a
custom text table  with selected statistics , including a custom ratio between
two statistics .  

Learn even more about using text boxes and tokens to take advantage
of the powerful statistical features in FCS Express by viewing a recorded
webinar and completing a separate tutorial  dedicated to this topic.  

In the final section of this tutorial, we will batch process our data  to generate
Microsoft PowerPoint™ and Excel™ reports.

22.31.3 Batch processing your analysis

In this final section of the tutorial, we will create Microsoft PowerPointä and

Excelä exports using the powerful Batch Processing  function of FCS Express.

1. Select File Open.

2. Open the layout Immunophenotyping Tutorial Ready for Batch
Processing.fey found in the "Immunophenotyping Tutorial" folder within
the Tutorial Sample Data archive .    

The layout has been saved linked  to the .fcs files in the same folder,
and should resemble your own layout after completing the previous
section of the tutorial .  You may use this provided layout or your own
layout to proceed to Step 3.

3. Select the Batch tab  Actions (Figure T31.38).

Figure T31.38  Openning Batch Actions from Ribbon

4. Move the Batch Actions window to the side of the page so that your
plots are visible.

5. Click Save to PowerPoint in the Add Action category of the Batch

Actions window (Figure T31.39, ).
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Figure T31.39  Batch actions window

6. Check the Open presentation after saving box in the Create Export to
PowerPoint Action dialog box which opens automatically (Figure T31.40,

left, ).

Figure T31.40  Adding a PowerPoint action to Batch Process Actions
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7. Click the Combine the output from all iterations into the same
presentation radio button in the Iteration options section (Figure

T31.40, left, ).  Note: the first radio button, if selected, would result in
each sample being saved to its own .PPT file.

8. Click on the Folder icon under Save to a new file in the Output file

options section (Figure T31.40, left, ). 

9. Navigate to the directory folder to which the exported file will be saved

(e.g., Desktop), in the Save As dialog window (Figure T31.40, right, ).

10. Type "immunophenotyping study" in the File name field (Figure T31.40,

right, ).

11. Click Save (Figure T31.40, right, ).

12. Click OK in the Create Export to PowerPoint Action dialog box (Figure
T31.40, left, cursor).

13. Click on Export to Excel (Column Mode) in the Add Report category

of the Batch Actions window (Figure T31.39, ).

14. Click the folder icon  under Save to a new file in the Output file
options section of the Excel (Column Mode) Options dialog box (Figure

T31.41, ). 

Figure T31.41  Adding an Excel (Column Mode) report to Batch Process Actions

15. Navigate to the directory folder to which the exported file will be saved,

such as the Desktop, in the Save As dialog window (Figure T31.41, ).

16. Type "immunophenotyping study" in the File name field (Figure T31.41,

).

17. Click Save (Figure T31.41, ).
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18. Click OK in the Excel (Column Mode) Options dialog box (Figure

T31.41, ).

We now must choose which tokens to include in our Excel export.

19. Click on the text table in the lower-right corner of the layout to select it

(Figure T31.42, ).

Figure T31.42  Dragging and Dropping a Table within a Text Box to Add Tokens
to Excel (Column Mode) Export in Batch Actions

Note:  the layout pictured has had the optional steps completed for adding red
outlier dots to the contour plot, and for normalizing the histogram.  If you are
using your own layout from the previous section and skipped those steps, those
two plots will look slightly different.

20. Drag the text table by the green or red outline toward the Batch Actions
window, while keeping the mouse button pressed.

21. Release the mouse when the cursor is on the Excel (Column Mode) icon

in the list of Batch Process Actions (Figure T31.42, ).  You may notice
a ghost of the table appearing in the Batch Process Actions before you
release the mouse.  All of the statistical tokens in the text table have now

been added to the Excel (Column Mode) export (Figure T31.42, ).

Note:  You may also add tokens to your Excel exports  by dragging and
dropping plot elements, including gates, gate/marker/quadrant text boxes, and
entire plots;  individual tokens from default Statistics Windows and text tables
may be added in the same manner as well.  We will now add a Token to the
report by dragging and dropping a plot. 

22. Click on the upper-left plot to select it (Figure T31.43, ).

1941
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Figure T31.43  Dragging and dropping a plot-derived element into the Excel
export of the Batch Process Actions window

23. Drag the plot toward the Batch Actions window, while keeping the
mouse button pressed.

24. Release the mouse when the cursor is on the Excel (Column Mode) icon

in the list of Batch Process Actions (Figure T31.43, ).  You may notice
a ghost of the plot appearing in the Batch Process Actions before you
release the mouse.  

25. Click on Keyword Token in the Paste Special dialog box (Figure

T31.44, ).
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Figure T31.44  Selecting a keyword token

26. Click OK (Figure T31.44, ).

27. Click on the ellipsis in the Select a keyword dialog box (Figure T31.45,

).

Figure T31.45  Selecting a specific keyword token

28. Scroll to and select $FIL in the Please select a keyword dialog box

(Figure T31.45, ).
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29. Click OK in the Please select a keyword dialog box (Figure T31.45, ).

30. Click OK in the Excel (Column Mode) field "Keyword..." dialog box

(Figure T31.45, ).

Several statistical  and keyword tokens  are now ready to export to Excel. 
We will now reorder the list so the keyword token is exported to the first column
in your Excel worksheet.

31. Press and hold on the "Keyword: $FIL for Plot#..." token (Figure

T31.46, ).

Figure T31.46  Reordering the tokens in the list to be exported to Excel

32. Drag this token to be directly below the Excel (Column Mode) icon

(Figure T31.46, ).

33. Release the mouse when the blue bar spanning the window width is at the

position shown in Figure T31.46, .  The tokens have now been re-
ordered as in Figure T31.46, right.  Note: if the token does not move to
the new position in the list, expand the width of the Batch Process
Actions window (simply by dragging its border to be wider, so there is
white space beyond the end of each token descriptor) and try again.

Although we can Batch Process  our analysis, let's first take a look at all of our
samples within the layout itself.  This is easily accomplished in FCS Express; there
is no need to make replicate plots and tables for each of our samples.  Since, in
FCS Express "what you see is what you get," you could even print the layout
now or add a Print action  to the list of Batch Process Actions, and the printout
would appear exactly as the layout does on the screen for all the samples.

34. Select the Data tab group command
(Figure T31.47).  The Data List  appears, which contains the four .fcs
files in the directory folder from which "Sample 1.fcs" was loaded.  When
we run the Batch Process, there will be four iterations, and we will have
four slides in our PowerPoint file and four rows of data in our Excel export.

Note: If you generally prefer to define a list of .fcs files to work with at the start
of your analysis, you may add  your files to the Data List before beginning to
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build your layout.  In this tutorial, we simply loaded "Sample 1.fcs" into our plots
and allowed the other three files in the directory folder to be added to the Data
List automatically. 

Figure T31.47  Opening the Data List

35. Select the Data Change Data on All Objects Next (Figure
T31.48).  Watch as each of the plots and statistics tables on your layout
update to the next file every time Next is clicked.  When "Sample 4.fcs" is
displaying on the plots, it will no longer be possible to click Next, as it is
the last file in the Data List.   

Figure T31.48 Changing data on all objects to the next iteration in the Data
List
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36. Click on the Data tab (Figure
T31.48, to the left of Next) until "Sample 1.fcs" is displaying on the layout
again.

As you click Next to advance through your Data List , you may notice that the
populations shift in position, and you may wish to adjust gates, markers, or
quadrants accordingly.  We will now add a pause between iterations to our Batch
Options  so that the software will pause before exporting the data for each
sample.  During this pause, we can adjust the "B cells" gate for "Sample
2.fcs" (for example), before the PowerPoint and Excel exports are generated for
that sample and prior to the layout advancing to the "Sample 3.fcs" iteration . 
Note:  you need not access Batch Options (as described in Steps 41-44 and 46-
48) for batch processing  FCS Express layouts in which no adjustment between
iterations  is required.

37. Select the Batch tab (Figure T31.49).

Figure T31.49  Accessing Batch Processing
Options

38. Check the Unconditionally pause between iterations box in the Batch

Processing Options dialog (Figure T31.50, ).

660

817

817

768

817



Tutorials 2689

© 2023 De Novo Software

Figure T31.50  Adding a pause between iterations to our batch
process

39. Click the Restore the state of the layout radio button (Figure T31.50,

).

40. Click OK (Figure T31.50, ).

41. Select the Batch tab (Figure T31.51).  
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Figure T31.51  Running the batch process

The Batch Processing status window appears (Figure T31.52), indicating that 2
of 2 actions  (i.e., one PowerPoint slide + one Excel row of statistics) have
been completed for 1 of 4 iterations  in the Data List .

Figure T31.52  Status of the batch process (currently in
progress)

42. Adjust the "B cells" gate, quadrants on the contour plot, and/or the
marker "M1", if desired.  You may also make other changes to your layout
during this pause, such as rescaling plot axes, or reformatting, adding, or
deleting plots, text boxes, or any other object. 

43. Click Continue (at the bottom of the window pictured in Figure T31.52).
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44. Repeat Steps 42-43 until the end of the Batch Process;  alternatively,
click Run to End (at the bottom of the window pictured in Figure T31.52)
if no more changes need be made.

45. Examine your PowerPoint export, noting that each of the four slides looks
exactly like your layout in FCS Express in which you performed your
analysis, and that the adjustments made to gates, markers, and quadrants
are recorded in the slides.  Each plot and statistics window on the slide is
exported as a high-resolution object which can be moved and re-sized as
you wish.   

Note about ungrouping objects in PowerPoint for PC versus PowerPoint
for Mac

Once exported to PowerPoint, layout objects can be further ungrouped into
single components in the PC version of Microsoft PowerPoint. Ungrouping
objects saved by FCS Express in PowerPoint for Mac is not supported. However,
presentations saved on a Mac may be opened on a PC and ungrouped. Note:  an
example PowerPoint export of this layout is saved in the "Immunophenotyping
Tutorial" folder within the Tutorial Sample Data archive.   

46. Examine your Excel export and note that the exported statistics for each
of the four samples reflect the adjustments made to gates, markers, and
quadrants which were recorded in the PowerPoint export.  Note:  an
example Excel export of this layout is saved in the "Immunophenotyping
Tutorial" folder within the Tutorial Sample Data archive.   

View the Immunophenotyping Analysis recorded webinar accompanying
this tutorial.  

22.32 Cluster Analysis

FCS Express provides users with many different cluster analysis tools which are

referred to as Transformations  to help you in analyzing high dimensional data.

Example of these tools are k-means Clustering , Principal Component

Analysis  and the R integration  tool.

In this tutorial we will:

· create a k-means clustering

· apply a k-means clustering

· work with a k-means clustering
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As an example we will be performing our analysis on a sample of Peripheral Blood

stained for different surface markers. However, please note that transformations

can be performed and applied on any type of sample.

22.32.1 Defining a k-means clustering

For this tutorial, we will be using a layout file that has 2D density plots with a
defined gate. The layout contain a single FCS data file obtained from Peripheral
Blood stained for different surface markers. The sample has two physical
parameters (FSC-H and SSC-A) and six fluorescence parameters.

To open the layout 

1. Select the File tab .

2. Navigate to the Tutorial Sample Data folder and open the Defining k-
means.fey layout stored in the k-means tutorial subfolder.

The layout should appear as shown in Figure T33.1.
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Figure T33.1 - The Defining k-means.fey analysis layout.

The aim of this tutorial is to create k-means clustering on Gate 1, events are
based on 3 out of the 6 fluorescence parameters (i.e. CD3, CD4 and CD8).

The following steps open the transformation window and create a new k-means
transformation:

1. Open the Transformation window by selecting the Tools

tab Transformations command .

2.  Click on the drop down arrow adjacent to the blue plus  button .

3.  Click on Kmeans in the drop down list  (Figure T33.2).
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Figure T33.2. k-means transformations are created via the Transformation
navigator.

The Kmeans dialog will now appear in the Transformation window as seen in

Figure T33.3.
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Figure T33.3. The Trasnformation window as it appears after creating a new
K-means transformation.
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Note: the Template File  field already contains the TCellSample1.fcs file,

thus the file already loaded into the layout. When a transformation is created

before any file is loaded into the layout, a template file will need to be selected by

the user via the ellipsis button ( ) at the right of the Template File  field.

We will now rename the new k-means transformation as My first k-means

clustering:

4.  Select the New Kmeans in the Transformation window.

5.  Select the  button from the Transformation window.

6. Type My first k-means clustering as the new name.

Please Note: other ways of renaming a k-means transformation are listed in the

Defining a k-means cluster analysis  topic of the manual.

We will now have to define the k-means clustering arguments. We will start by

selecting the parameters the cluster will be based on, and the gate containing the

events we want to cluster. Then we will specify additional required arguments

such as the number of clusters, the maximum number of iterations, and the

cluster minimum size. For a detailed description of each argument, please refer

to the Defining a k-means cluster analysis  topic of the manual.

7.  Select Gate 1 from the gate drop down menu of the Transformation dialog.

8.  Flag CD3, CD4 and CD8 parameters in the parameter list of the

Transformation dialog.

    Please note that a scale can be specified for each parameter via the

Parameter Scaling Options section of the Transformation Dialog.

As for all Transformations in FCS Express, a Downsampling Algorithm  can

be selected. We will use all events in this tutorial (i.e. Downsampling Algorithm

set to None).
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9.  Type 3 in the Number of Clusters field. This is the number of centroids and

thus the number of clusters that will be created.

10. Type 100 in the Maximum Iterations field. This is the maximum number of

iterations FCS Express will perform upon quitting the clustering algorithm.

11. Type 10 in the Min Percent Cells Per Cluster field.  Iterations ending up

with clusters containing less then 1% of events will be discharged and

recalculated. This applies to all iterations except the last one. 

At this point, the Transformation dialogue should appear as in the following Figure

T33.4:
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Figure T33.4. The Transforamtion dialogue partially filled for a new k-means
clustering transformation.
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Now that the input parameters are selected we need to define the output style

we want to use for the clustering result. FCS Express provides two output

styles: Cluster Assignment and Clustering Statistics.

In this tutorial we will select the Cluster Assignment output style, which allows

several graphical representations of the clustering results. For more details about

the two different output styles, please refer to the Defining a k-means cluster

analysis  topic of the manual.

13. Select Cluster Assignment.

14. Flag Cluster Assignments, Gaussian CV SSE Scaled, Gaussian Y Data

from the list located below the output styles. These will be the new clustering

parameters that will be directly available in a 1D/2D plot and in Heat Maps. 

The Transformation dialogue should now appear as in the following Figure T33.5:

957
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Figure T33.5. The Transformation dialogue filled for a new k-means trasnformation.
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The k-means clustering has now been defined and automatically calculated. k-

means clustering can now be applied to plots for display and analysis. Please

proceed to the next part of this tutorial to see how to apply the k-means

transformation to plots and plate heat maps .

22.32.2 Applying a k-means clustering

Once k-means clustering has been performed, results can be accessed as 1D
plots, 2D plots , Heat Maps  and Data Grids  depending on the selected
output style (see the Defining a k-means cluster analysis  topic of the manual
for details). In the previous part of this tutorial, we selected Cluster
Assignment as the output style that allowed us to create three clustering
parameters; Cluster Assignments, Gaussian CV SSE Scaled,  and Gaussian
Y Data. These new parameters  may be accessed on plots on which the
transformation has been applied. 

In this tutorial we will apply the k-means transformation to 1D plots, 2D plots
and Plate Heat Maps.

Please Note: although different methods can be exploited in applying a
transformation to plots, (please refer to the Applying a k-means Cluster
Analysis  topic of the manual for further info on this subject), in this tutorial, we
will use the drag & drop method.

To open the layout required for this tutorial:

1. Select the File tab .

2. Navigate to the Tutorial Sample Data folder and open the Applying k-
means.fey layout stored in the k-means tutorial subfolder.

The layout should appear as shown in Figure T33.6. A Transformation window
with the My first k-means clustering should also been opened.

2701
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Figure T33.6. The Applying k-means.fey layout as it appear after opening it.

Since we selected Cluster Assignments among the new clustering parameters,
we will be able to display clusters using Plate Heat Maps. Thus, let's open a new
plate heat map in the layout.

3. From the ribbon bar select .

4. Click in the place on the layout where you wish to insert the Plate Heat
Map.

5. A message saying, there is no parameter compatible with Heat Maps
available..., will open (Figure T33.7). Click Continue.



Tutorials 2703

© 2023 De Novo Software

Figure T33.7. The message saying that no heat map compatible parameter is
currently available.

6. Select the Plate Heat Map and then select Gate 1 from the
 drop down menu. The Plate Heat

Map where the cluster is displayed, will be gated on Gate 1, thus the same
gate used for the k-Means clustering.

We will now apply the k-means transformation to all the plots present in the
layout by drag & drop (Figure T33.8):

7. Left click and hold on k-means clustering from the Transformation
window.

8. Drag the k-means transformation out of the Transformation window and
release it on top of each of the 2D plot.

9. Repeat step 7 and release the transformation on top of the newly created
Plate Heat Map.

10. Repeat step 7 and release the transformation on top of the histogram.
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Figure T33.8. Use Drag & Drop to apply the k-means transformation to the
objects of the layout.

The k-means is now applied to all the objects in the layout and the title of the
plot will now include the text "Kmeans clustered"  to indicate the
transformation has been applied (Figure T33.9).

969
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Figure T33.9. When a k-means transformation is applied to plots, the suffix
"Kmeans clustered" is automatically added to the title.

Please Note: When a k-means transformation with Cluster Assignments
parameter is applied to a Plate Heat Map, the latter automatically displays the
Cluster Assignments parameter by plotting each cluster as a well. When a k-
means transformation with parameters other than Cluster Assignments is
applied to 1D or 2D plots, the clustering parameters can be accessed as standard
flow cytometry parameters.

In the next section we will see how to work with clustering parameters .2711
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22.32.3 Working with k-means using 1D-2D plots

When a k-means transformation includes parameters other than Cluster

Assignments, and these are applied to 1D or 2D plot, the clustering parameters

can be accessed as standard flow cytometry parameters.

In this tutorial we will access clustering parameters on 1D and 2D plots, and we

will use gates and markers to select clustered events. These gates and markers

will then be available for downstream analysis.

For this tutorial we will use the k-means on plots.fey layout stored in the k-

means tutorial subfolder of the Tutorial Sample Data folder.

To open the layout required for this tutorial:

1. Select the File tab .

2. Navigate to the Tutorial Sample Data folder and open the k-means on
plots.fey layout stored in the k-means tutorial subfolder.

The layout should appear as shown in Figure T33.10:
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Figure T33.10. The k-means on plots.fey layout as it appear after opening it.

In this layout a k-means transformation has been created  and applied  to a

histogram and to 2 color dot plots, (please note the Kmeans clustered suffix in

the plot title). In order to simplify gate visualization, and to create a cluster gate

with the correct hierarchy, Gate 1 (thus the gate on which the clustering has

been performed), has already been applied to all this objects.

In this example, the following clustering parameters have been selected, and thus

automatically created as output results for the k-means clustering: Cluster

Assignments (which is suitable for Heat Maps, see the next section of this

tutorial ), Gaussian CV SSE Scaled and Gaussian Y Data (which can be both

accessed on 1D and 2D plots). To learn more about the available clustering

parameters, please refer to the Defining a k-means cluster analysis  topic of

the manual.

We will now select clustered events using markers on 1D plots.
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3.  Change the parameter displayed on the 1D plot to be Kmeans 3 Gaussian

CV SSE Scaled. Three peaks will appear in the 1D plot, one for each clusters

(Figure T33.11).

4.  Select the peak on the left (i.e. cluster 1) by creating a marker .

5.  Convert the marker to a gate, by right clicking on it and selecting Convert

Marker to gate Marker #1 (M1)  Convert and Link. A Create a new

gate dialogue opens.

6.  Replace Gate 2 with Marker on Cluster as gate name and click OK.

Figure T33.11. A 1D plot displaying a clusering
parameter.

The content of the layout should now be similar to Figure T33.12. Please note

that the new gate is now listed in the gate view, and that the events belonging to

Marker on Cluster are now shown in green in both of the color dot plots.

750
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Figure T33.12. A marker has been created to select cluster 1. The marker has then
been converted and linked to be a gate. The gate view and the color dot plots

reflect this change.

7.  Move marker M1 to select a different peak in the histogram, thus a different

cluster. Please take note that the color dot plot is updated based on these

changes.

Also, please note: Since the M1 marker has been converted to a gate, now it

can also be applied to a plot  and to other objects in the layout. The M1 gate

will have the same functionality as any other gate.

We will now select clustered events using gates on 2D plots.

8.  Change the parameter displayed on the 2D color dot plot in the upper part of

the layout to be Kmeans 3 Gaussian CV SSE Scaled on the X axis, and

Kmeans 3 Gaussian Y Data on the Y axis (Please also note that clustering

parameters can be used together with any other non-clustering parameter as

well on 2D plots).

739
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The content of the plot will be similar to the one displayed in Figure T33.13.

Please note that the coloring may be different depending on the position of

marker M1 (see step 7).

Figure T 33.13. A 2D plot displaying two
clustering parameters.

9.  Select one of the blue clusters by creating a 1D Gate  (select

Gating Create Gates Markers from the ribbon bar) around it. A Create

New Gate dialogue opens.

Note: although any type of gate can be used to select clustered events on 2D

plots, 1D Gates are particularly useful in this cases as they automatically extend

from the bottom to the top of the 2D plot.

10. Replace Gate 2 with Gate on Cluster as gate name, change color to be red

and click OK.

701
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The layout should now appear similar to the one displayed in Figure T33.14.

Please note that the new gate (i.e Gate on Cluster) is now listed in the gate

view, and that the events belonging to it are now red, in both of the color dot

plots.

Figure T33.14. A gate has been created to select cluster 2. The gate view and the
color dot plots reflect this change.

11. Move the Gate on Cluster gate to select a different cluster. Note that the

color dot plots update their content based on these changes. Note: the Gate

on Cluster gate can also be applied to a plot  and to other objects in the

layout. The Gate on Cluster gate will have the same functionality as any

other gate.

22.32.4 Working with k-means parameters

When a k-means transformation with a Cluster Assignments parameter is

applied to a Plate Heat Map, it automatically displays the Cluster Assignments

739
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parameter by plotting each cluster as a well. The k-means transformation

available in this layout is defined by three clusters, thus 3 wells are displayed in

the Plate Heat Map.

In this tutorial we will access the clustering parameter on the Plate Heat Map, and

we will use the well gates to select clustered events. These well gates will then be

available for downstream analysis.

For this tutorial we will use the k-means on heatmap.fey layout stored in the

k-means tutorial subfolder of the Tutorial Sample Data folder.

To open the layout required for this tutorial:

1. Select the File tab .

2. Navigate to the Tutorial Sample Data folder and open the k-means on
heatmap.fey layout stored in the k-means tutorial subfolder.

The layout should appear as shown in Figure T33.15:
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Figure T33.15. The k-means on heatmap.fey layout as it appear after opening it.

In this layout a k-means transformation has been created  and applied  to a

Plate Heat Map and to a color dot plot. In order to simplify the gate visualization,

and to create a cluster gate with the correct hierarchy, Gate 1 (thus the gate on

which the clustering has been performed) has already been applied to the color

dot plot.

In this example, the following clustering parameters have been selected and thus

automatically created as output results for the k-means clustering; Cluster

Assignments (which is suitable for Plate Heat Maps), Gaussian CV SSE Scaled

and Gaussian Y Data (which can be both accessed on 1D and 2D plots, see the

previous section of this tutorial ). To read more about the clustering

parameters, please refer to the Defining a k-means cluster analysis  topic of

the manual.
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We will now select clustered events using well gates on Plate Heat Map.

3.  Right click on the Plate Heat Map and select Create gate Well from the right

click menu.

4.  Select cluster 1 by left clicking on it. A Create New Gate dialog opens.

5.  Create Gate 2 and name it as Cluster 1 on Heat Map as gate name, and

have Gate 1 as the Parent Gate and click OK.

6.  Click Close in the Edit new gate dialogue. The new gate named Cluster 1

on Heat Map is now listed in the gate view.

7.  Right click on the Heat Map and select Show Gates Cluster 1 on Heat Map

from the right click menu. The gate is now visible on the Plate Heat Map as a

border around cluster 1.

The content of the layout should now be similar to the one displayed in Figure

T33.16. Please note that the new gate is now listed in the gate view, and that

the events belonging to cluster 1 are now green in the color dot plot.
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Figure T33.16. A well gate has been created to select cluster 1. The gate view and
the color dot plot reflect this change.

Note: The Cluster 1 on Heat Map gate can also be applied to a plot , and to

other objects in the layout just as any other gate.
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22.33 Changing Common Preferences

FCS Express provides many options that allow you to completely customize
your working environment.  The settings for these preferences are called User
Options . You can save time by creating a new user name  to save your
common options rather than changing the default settings each time you start
the program.

This tutorial explains step-by-step how to change the following commonly edited
preferences:

· Displaying filenames without path in the Data List

· Changing axis labels to stain and name

· Creating gates hierarchically and adding a %-gated statistic to

gate text boxes

22.33.1 Displaying Filenames Without Path in Data List

Here we will change our FCS Express User Options  so that only the .fcs
filenames will appear by default in our Data List .

1. Select File Options (Figure T32.1, outlined in red).
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Figure T32.1  Accessing Preferences from the File Tab on
Ribbon

2. Click on Data List in the category at left (Figure T32.2, ).

3. Uncheck Show Full Path (Figure T32.2, ).

4. Click OK.
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Figure T32.2  Data List preferences

Note: the current Option for showing or hiding file paths may be overridden on a
per-layout basis at any time.  In addition, keywords may be added to the Data
List and the files may be sorted on these keywords by Formatting the Data
List .

22.33.2 Changing Axis Labels

Here we will change our User Options  so that data file-derived Stain and
Name keywords appear on our plot axes .

1. Select File Options (Figure T32.3, outlined in red).
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Figure T32.3  Accessing Preferences from the File Tab on
Ribbon

2. Click on the Data Loading FCS File Options Instrument

Specific Settings at the left (Figure T32.4, ).
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Figure T32.4  Selecting Stain and Name as the Parameter Name Displayed on
Plot Axes

3. From Instrument Specific Settings select Default FCS 3.0 (Figure

T32.4, )

Note:  The correct FCS file type or instrument will need to be selected for
the change to be effective. 

4. Select Stain and Name from the Keyword to Use as Parameter Name

drop-down menu (Figure T32.4, ).

5. Click OK.

Now, as you load in new data files, your plot axes  in FCS Express will be
labeled with the values for the keywords that you have selected.  These
keywords values were saved with your data at the time of acquisition, however,
you can edit keywords  in FCS Express.

§ Please note that different manufacturers will use different bits of information
for each keyword value.

§ For example:

· on a BD analog instrument (FACScan, FACSCalibur)

o Stain keyword = CD3 FITC, Name Keyword = FL-H
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· on a BD digital instrument (anything which uses BD FACSDiva)

o Stain keyword = CD3, Name keyword = FITC-A

Go back to Immunophenotyping Tutorial.

22.33.3 Creating Gates Hierarchically and Adding Statistics to Gate Text
Boxes

Here, we can change our User Options  to define if gates  are created
hierarchically. In FCS Express, gates are created hierarchically by default.  From
this category of preferences, you also may choose to display and select a
preferred statistic within the gate text box.  With this option selected, a
statistic  is automatically added to gate text boxes  upon creation of that
gate.

1. Select File Options (Figure T32.5, outlined in red).

Figure T32.5  Accessing Preferences from the File Tab on
Ribbon
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2. Click on the Gate category at the left (Figure T32.6, ).

3. To de-select the option for hierarchical gating, uncheck the "When a new

gate is created, create it hierarchically" box (Figure T32.6, ).

4.  Check the "Insert a gate stat in text box" box (Figure T32.6, ). 
Note:  You may choose a different statistic from the drop-down menu to
be added by default to gate text boxes;  see gate  preferences  for
more details.

5.  Click OK.

Figure T32.6  Adjusting Gate Preferences

Go back to Immunophenotyping Tutorial.

22.34 Cytek Aurora Spectral Data

Spectral data from the Cytek Aurora instrument may be analyzed in FCS Express
with direct linking from standard flow cytometry results to the raw and unmixed
spectral results.  In this two-part tutorial, we will use sample Cytek Aurora data
to create a basic flow cytometry style analysis as well as delving into detail with
the Spectrum plot functionality in FCS Express.  Please also see the following
topics in our main manual sections for useful background information, specific
options, and data management considerations.

· Supported Data Formats and File Structure

· Inserting Spectrum Plots
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· Formatting Spectrum Plots

· Gating and Backgating on Spectrum Plots

Continue to Tutorial - Loading Cytek Spectral Data and Creating Plots,
Gates, and Statistics

22.34.1 Loading Data and Creating Plots, Gates, and Statistics

In this section, we will create a standard flow cytometry data analysis workflow
with Cytek Aurora data files.  We will load data into the layout, create plots,
gates, statistics, and batch process the results to PowerPoint. The following
section of the tutorial is meant to help familiarize yourself with the standard flow
cytometry analysis tools in FCS Express. Please jump to the Working with
Spectrum Plots tutorial section  if you are already familiar with FCS Express
and would like to learn more about working directly with spectral data sets and
spectrum plots.  

To begin:

1.  Open a new layout in FCS Express by clicking New Layout on the Startup
Screen or by choosing the File  New  New command from the
Ribbon  (Fig. T34.1).

Fig. T34.1. Opening a new layout from the Startup Screen

2.  Access the Data List  via the Batch (or Data) tab Organize Data
Sets  List command to bring up the Data List window. The Data List
is a dockable window .

3.  Drag and drop the two unmixed data files (files ending with the suffix
"_Unmixed" from the tutorial sample data Cytek spectral data analysis
folder in Windows File Explorer or Mac Finder to the Data List, or use the blue

plus ( ) to add them to the Data List (Fig. T34.2, top).  When the files have
been added, they will be visible in the Data List window (Fig. T34.2, bottom). 
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Note: In this tutorial we will be working with files generated from
SpectroFlow 1.0 software. If your data files are generated by SpectroFlow
2.0 or greater please also see our additional information regarding the file
structure for accessing unmixed data sets  when working with your own
data. 

Fig. T34.2. Adding files to the Data List

4.  Drag and drop the first filename from the Data List to the blank page on the
layout.  A Select Plot Types... dialog window will appear (Fig. T34.3). 
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Fig. T34.3. The Select Plot Types dialog window

5.  Check "Density" from the list of choices.
6.  Click OK.  A new plot will have been inserted on the layout.  This plot is an

object  in FCS Express and as such, may be moved around  and resized
.

7.  Click on the X- and Y-axes to change the parameters to FSC-A and SSC-A,
respectively (Fig. T34.4).
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Fig. T34.4. Changing the plot axis to another
parameter.

We will now create gates for multiple populations. 

8.  Choose the Gating  Create Gates  Ellipse command from the Ribbon

(Fig. T34.5, ).
9.  Use the mouse to click-drag on the density plot you created in Step 5 to

draw a gate around the population shown below (Fig. T34.5, ).
10. Name the gate "monocytes" in the Create New Gate dialog window (Fig.

T34.5, ).
11. Click OK.
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Fig. T34.5. Drawing an ellipse gate around "monocytes"

12. Choose the Gating  Create Gates  Polygon command from the
Ribbon.

13. Use the mouse to click once on each desired vertex of the polygon on the
same plot to draw a gate around the SSC-low population shown below (Fig.

T34.6, ).  You may click again on the first vertex or press the Space Bar on
your keyboard to close the shape and cause the Create New Gate dialog
window to appear.

14. Name the gate "lymphocytes" (Fig. T34.6, ).
15. Click OK.  The plot will now resemble that shown in Fig. T34.6, right.
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Fig. T34.6. Drawing a polygon gate around "lymphocytes"

We will now draw a child gate of the "lymphocytes" gate.

16. Press and hold anywhere inside the boundaries of the red "lymphocytes"

gate (Fig. T34.7, ).
17. Drag the "lymphocytes" gate out of the plot to an empty space in the layout

while continuing to hold the mouse button down.
18. Release the mouse button when your cursor is on an empty part of the

layout to the right of the original plot.  A new plot gated on "lymphocytes" will

have been inserted (Fig. T34.7, ).

Fig. T34.7. Dragging and dropping the "lymphocytes" gate out of a plot to make a
new plot gated on "lymphocytes" 

19. Click on the X-axis to change the parameter to CD3 on the new plot.
20. Choose the Gating  Create Gates  Rectangle command from the

Ribbon.
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21. Use the mouse to draw two rectangular gates, around the CD3-low and
CD3-high populations, naming the gates "CD3-" and "CD3+", respectively. 
The plot will now resemble that shown in Fig. T34.8.

Fig. T34.8. CD3-positive and -negative
gates defined on the new plot

We will now create one last plot on our layout.

22. Repeat Steps 16-18 for the "CD3+" gate (to drag and drop the CD3+ gate
onto a blank spot in the layout).  A new plot gated on "CD3+" will have been
inserted.

23. Click on the X- and Y-axes to change the parameters to CD4 and CD8,
respectively.

24. Choose the Gating  Create Gates  Quadrants command from the

Ribbon (Fig. T34.9, ).
25. Click on the plot to place the quadrants such that the four populations are

delineated (Fig. T34.9, ).
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Fig. T34.9. Placing quadrants to delineate
CD4 and CD8-positive and -negative

populations

We will now add a Gate View , which is an interactive legend of our gates. 
Though it will not be covered in this tutorial, you may rename gates, redefine the
gating hierarchy, and more using this object.

 Note:  The quadrants defined above will not appear in the Gate View unless
they are first converted or converted & linked to gates .

26. Choose the Insert  General  Gate View command from the Ribbon

(Fig. T34.10, ).
27. Click once on an empty spot on the layout to insert the Gate View object

(Fig. T34.10, ).
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Fig. T34.10. Inserting a Gate View, an
interactive legend of your gates

We will now add statistics to an Integrated Spreadsheet  our layout.

28. Choose the Insert  Spreadsheet  New command from the Ribbon

(Fig. T34.11, ).
29. Click OK. 

A spreadsheet will be present on the screen as in Fig. T34.11. We will now edit
the spreadsheet to include statistics and labels. 

30. Type "lymphocytes", "CD3+", and "CD4+" into cells A2-A4 of the

Spreadsheet, respectively, and "%-gated" into cell B1 (Fig. T34.11, ).
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Fig. T34.11. Inserting and preparing a
Spreadsheet for the addition of statistics

31. Press and hold anywhere inside the boundaries of the "lymphocytes" gate.
32. Drag the "lymphocytes" gate out of the plot while continuing to hold the

mouse button down, and drop it into cell B2 of the Spreadsheet (Fig. T34.12,

).
33. Select % of gated cells from the Statistic box in the Create Statistic

pop-up dialog (Fig. T34.12, ).

34. Click OK (Fig. x, ).  The appropriate statistic will have been inserted (Fig.
T34.12, bottom).
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Fig. T34.12. Dragging and dropping a plot-based statistic to the Spreadsheet.

35. Repeat Steps 31-34 for the "CD3+" gate, dropping it into cell B3 of the
Spreadsheet. 

36. Drag the text box for the lower-right quadrant %-gated statistic from the
last plot out of the plot and drop it into cell B4 of the Spreadsheet. 

 Note:  Drag and drop the quadrant text box by its border when it is selected,
as shown below (Fig. T34.13, top).  The Spreadsheet will now contain the
statistics pictured below (T34.13, bottom).  
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Fig. T34.13. Dragging and dropping a quadrant statistic to the
Spreadsheet

We will now set up a Batch Process to PowerPoint. 

 Note:  it is also possible to Batch Process  your results to PDF and Excel,
though in the interest of brevity, we will not do so in this tutorial.

37. Select the Batch  Batch Actions command from

the Ribbon (Fig. T34.14, ).
38. Move the Batch Actions window to the side of the page so that your plots

are visible.  

Note:  You may also dock the Batch Actions window .

39. Click Save to PowerPoint in the Add Action category of the Batch

Actions window (Fig. T34.14, ).
40. Click on the yellow folder under Output File Options> Save to a New File

in the Create Export to PowerPoint Action pop-up window (Fig. T34.14, 
).

41. Navigate to a convenient save location on your computer and type a

filename for the PPT file in the pop-up Save As dialog window (Fig. T34.14, 
).
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42. Click Save in the pop-up Save As dialog window (Fig. T34.14, ).
43. Click OK in the Create Export to PowerPoint Action pop-up window(Fig.

T34.14, ).

Fig. T34.14. Setting up a Batch Action to PowerPoint

44. Select the Batch  Run command from the Ribbon
(Fig. T34.15).  

A progress window titled "Run" will appear below.  When it disappears, you may
open the PowerPoint file from the location you chose to save it to view the
summarized results in visual form, for both files in the Data List.  The PowerPoint
slides will exactly resemble your FCS Express layout.
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Fig. T34.15. Running the Batch Process

Continue to the Working with Spectrum Plots tutorial section  to learn more
about working directly with spectral data sets and spectrum plots.

22.34.2 Working with Spectrum Plots

In this section, we will now learn how to insert, format, and overlay Spectral
plots with Cytek Aurora data files.  We will use data that has already been loaded

2736
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into an existing layout so you can focus on the features of spectrum plots. If you
are new to FCS Express, please see the previous section of the tutorial for
Loading Data and Creating Plots, Gates, and Statistics  before you begin. 

We will now learn how to insert, format, and overlay Spectral plots.

1.  Open the Cytek Tutorial Part 2.fey layout from the "Cytek spectral data
analysis" folder within the Tutorial Sample Data archive .  

2.  Choose the Insert tab Other Plots  command from the
Ribbon (Fig. T34.16).

Fig. T34.16. Inserting a Spectrum plot

3.  Click on a blank spot of the layout to insert the Spectrum plot.  Like other
plots in FCS Express, this is an object  and as such, may be moved
around  and resized .

4.  Change the x-axis to the Violet \ Blue \ Red-A parameter.  The plot will now
appear as shown in Fig. T34.17.

Fig. T34.17. Changing the axis
parameter on the Spectrum plot

5.  Double-click on the newly inserted Spectrum plot to bring up the Formatting
dialog.  

6.  Choose Specific Options from the Category dropdown menu (Fig. T34.18,

).

7.  Check the Interpolate Values box (Fig. T34.18, ).

8.  Enter "8" or a similar value in the Interpolation Points field (Fig. T34.18, 
).  

The plot will now have a smoother appearance (Fig. T34.18, left) due to the
graphical interpolation of points between each detector channel.  

2723
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Note:  Choosing a large number of interpolation points is computationally
intensive, so use only the minimum required to achieve the desired plot
appearance.

Fig. T34.18. Interpolating values on a Spectrum plot to achieve a smoother
appearance

When inserting a Spectrum plot, the Display Mode defaults to Density as shown
above.  We will now explore the alternative Display Mode.

9.  Click on the border of the plot so that it appears selected with a red border.
10. Press Ctrl+D on your keyboard to duplicate the plot.  Move the new plot

below or next to the original plot so that they do not overlap.
11. Click on the new plot to select it.
12. Choose "Color on Gated/Overlays" from the Display Mode dropdown

menu of the Formatting dialog Specific Options (Fig. T34.19, ) that you
opened in Step 5. 

 The plot will now appear in as many colors as are defined for gates in the
layout;  spectra belonging to each gate are assigned that gate's color.

13. Check the Shade Based on Density box (Fig. T34.19, ).  The plot will
now appear as in Fig. T34.19, where areas of high event density are shaded in
white. 



Tutorials 2739

© 2023 De Novo Software

Fig. T34.19. Changing the Display Mode to Color on Gated/Overlays

We will now choose to show only colors from the gate(s) of interest on the plot.

14. Choose Gates to Display from the Formatting Category dropdown menu

(Fig. T34.20, ).

15. Choose the Only the gates checked below radio button (Fig. T34.20, ). 
16. Expand the gates by clicking on the down arrow next to lymphocytes.
17. Check the "CD3+" box.  The plot will now appear as in Fig. T34.20, where

the spectra belonging to the "CD3+" gate appear in green.  The spectra from
these events are easier to see now that colors from gates with more
abundant events are no longer being displayed.
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Fig. T34.20. Formatting the Gates to Display to show colors only from the gate of
interest

We will now choose to show only the average of all spectra, as opposed to the
current setting of all spectra.

18. Choose Overlays from the Formatting Category dropdown menu (Fig.

T34.21, ).
19. Choose "Average" from the Overlay to show dropdown menu (Fig.

T34.21, ).  The plot will now appear as in Fig. T34.21, where all spectra
have been averaged into one line. 

Note:  The line appears smooth due to the interpolation added in Steps 7-8. 
You may uncheck the Interpolate Values box if you wish to display the data
as it was       acquired in discrete detector channels. 
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Fig. T34.21. Showing the average of all events on the Spectrum plot

We will now add an overlay on the Spectrum plot to compare two gated
populations from the same datafile.

20. Drag and drop the second filename from the Data List (Whole Blood Donor

2_Unmixed.fcs) to the Spectrum plot (Fig. T34.22, ) pictured in Step 19
above.

21. Choose add the files to the plot as new overlays from the Select Drag

and Drop Action pop-up window (Fig. T34.22, ).

22. Click OK (Fig. T34.22, ).  
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Fig. T34.22. Creating an overlay on the Spectral plot

23. Select both overlays in the Spectrum Overlays list box in the formatting

dialog (Fig. T34.23, ).
24. Choose "Average" from the Overlay to show dropdown menu (Fig.

T34.23, ). If Average is already selected, drop the window down and select
it again to apply the choice. 
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Fig. T34.23. Showing the average of all spectra on
both overlays

25. Select the first overlay in the Spectrum Overlays list box (Fig. T34.24, ).

26. Choose "CD3+" from the Gate dropdown menu (Fig. T34.24, ). 
27. Select the second overlay in the Spectrum Overlays list box (Fig. T34.24,

). 

28. Choose "CD3-" from the Gate dropdown menu (Fig. T34.24, ). 

 The plot will now appear as shown in Fig. T34.24, bottom.
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Fig. T34.24. Gating the two overlays for comparison of the "CD3+" and "CD3-"
populations

We will now format the plot to display the Legend.

29. Select both overlays in the Spectrum Overlays list box (Fig. T34.25, ).

30. Click on the ellipsis beside the Legend text field (Fig. T34.25 ). 

31. Choose Gate from the dropdown menu (Fig. T34.25, ). 
32. Choose Legend from the Formatting Category dropdown menu (Fig.

T34.25, ). 

33. Check the Visible box (Fig. T34.25, ).  

The plot will now appear with a Legend as shown in Fig. T34.25, bottom.  The
Spectrum plot will update in real-time as you move your gates, like any other
plots in FCS Express.  Try adjusting the "lymphocytes", "CD3+", or "CD3-" gates
to see.
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Fig. T34.25. Adding a legend to the Spectrum plot

Note:  You may also create an overlay of both files.  Though we will not
perform the multiple file overlay workflow in this tutorial, the general
procedure is to insert a new Spectrum plot and then drag and drop the other
file from the Data List to this new plot to add a new overlay.

We saw above how to apply gates that were defined on a standard 2D plot to a
Spectrum plot.  We will now do the reverse:  creating a gate on a Spectrum plot
and applying it to a standard 2D plot.  Learn more about bidirectional gating and
backgating of spectral data in FCS Express .

34. Choose the Gating  Rectangle command from the
Ribbon.

35. Use the mouse to click-drag on the Density-style Spectrum plot you made in
Steps 2-4 to draw a gate around the population shown below (Fig. T34.26).
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Fig. T34.26. A "spectral gate" drawn on the Spectrum plot

36. Name the gate "spectral gate" in the Create New Gate dialog window.
37. Click OK.
38. Select the three standard 2D density plots at the top of the layout by

Ctrl+Clickthem, or by click-dragging your mouse cursor around them (Fig.

T34.27, ).
39. Choose "spectral gate" in the Gating  Current Gate

dropdown menu from the Ribbon (Fig. T34.27, ). 

Notice that these three plots are now displaying a subset of their original events
which corresponds to the "spectral gate".  As you move this gate around, the
three plots will update accordingly in real time on your layout.
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Fig. T34.27. Applying the spectral gate to standard 2D plots on the layout

We will now export the layout as a PDF file.

40. Choose the File tab Export  command (Fig. T34.28,

).

41. Choose a destination directory and filename  (Fig. T34.28, ). 

42. Click OK (Fig. T34.28, ). 

 The PDF file will be generated and will exactly resemble your FCS Express layout.
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Fig. T34.28. Exporting the layout as a PDF file

As you continue to analyze your own Cytek Aurora spectral data files, make sure
to contact support@denovosoftware.com if you need help.  Please also see our
full suite of Cytek spectral data resources on the De Novo Software website at
https://denovosoftware.com/about-us/partnerships/partnership-
cytek/cytekfcsexpress/.  

22.35 Spectral Unmixing

FCS Express allows users of spectral cytometers to perform Spectral Unmixing
from single-stained controls. There are two ways to create an unmixing definition
in FCS Express:

· The Automatic  method allows you to take single stained controls and

automatically calculate the appropriate endmembers of the unmixing definition.
· The Import  method allows you to import an unmixing table or single

endmembers previously created in FCS Express. 
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FCS Express allows you to quickly and easily setup either method. In the
following example, we will be creating an unmixing definition from single-stained
controls.

 

22.35.1 Unmixing from Single Stained Controls

In this section we will learn how to create an Unmixing Definition automatically
from single stained controls. The raw spectral flow cytometry data files used for
this section are located in the Tutorial Sample Data archive  in the Unmixing
Example folder. The example data set contains files for an Unstained Control,
Multicolor Control, and seven single-stained controls for the following
parameters: BV711, BUV737, BV650, PerCP-Cy5.5, PE-Cy5.5, APC-Cy7, and
BV785.

1.  Open a new layout in FCS Express by clicking New Layout on the Startup
Screen or by choosing the File  New  New command from the
Ribbon  (Figure T35.1).

Figure T35.1  Opening a new layout from the Startup Screen

In this blank layout we are going to illustrate how to set up automatic unmixing.
In order to use the automatic unmixing, you will need a single-stained control for
every parameter that you wish to unmix as well as an unstained sample. 

2. Select the File tab Options
. In the list of Instrument Specific

Settings, select Cytek - SpectroFlo. This section of the User Options contains
the settings for working with Cytek spectral data. For a more detailed
explanation of these settings, please see our manual .

1682
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In this tutorial, we will be referring to Spectral Parameters by their Parameter
Names. This is the default setting for FCS Express. However, if instead your
version of FCS Express displays the Spectral Parameters as Wavelengths, you
can manually change this User Option. In the Cytek Specific Options, change
the Spectra Parameter Label to Parameter Names. Click OK to apply the
changes. 

3. Select the Tools tab Transformations section Compensations and
Unmixing command to open the Compensations and Unmixing window. To

add a new Unmixing definition, click the black down Arrow  next to the Add
 button (Figure T35.2) then click Unmixing. 

Figure T35.2  Add a new Unmixing definition.

The bottom pane of the Compensation and Unmixing window will
automatically display the Automatic Unmixing Setup tab, and a text box in
blue will appear with text New Unmixing (Figure T35.3). 
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Figure T35.3  The Automatic Unmixing Setup tab.

4. Click on Step 1 - Select single-stained controls from the Automatic
Unmixing Setup tab. 

5. Click on the Add data for auto unmixing button,  in the expanded window.
The Standard Open Data Dialog will appear (Figure T35.4).

Multiple-select the following eight files from the Controls folder located within
the Unmixing Example folder in the Tutorial Sample Data Archive:
a. CD3 BV711 (Cells).fcs
b. CD4 BUV737 (Cells).fcs
c. CD8 BV650 (Cells).fcs
d. CD16 PerCP-Cy5.5 (Cells).fcs
e. CD19 PE-Cy5.5 (Cells).fcs
f. CD45 APC-Cy7 (Cells).fcs
g. CD56 BV785 (Cells).fcs
h. Unstained (Cells).fcs
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Figure T35.4  Use the Select Data File window to select all of the files for use in
the Automatic Unmixing Setup.

6. Click Open file.

Notice all of the single-stained control files and the unstained control file have
been loaded into the Select single-stained control window and have been
assigned a Label, Sample Type, and Negative Control.  You may change the
Label and Sample Type per control as necessary.  Changing the Label will result
in the new label being displayed in all subsequent downstream steps of the
Unmixing Setup, including as the parameter name in the Unmixing table and as
the unmixed parameter name on plots. 

When loading a universal negative, or unstained sample, the Sample Type is
assigned automatically as Negative control and that negative is assigned for
each single-stained control in the Negative control column (Figure T35.5). The
Negative control can be adjusted manually by clicking within the cell and then
on the downward arrow. A list of options will appear in the drop down window.

Note: The unstained control can be a universal negative, a negative population
defined by a gate, or the negative population within the tube of the positive
control. 
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For a more detailed explanation of the different Sample Types and Negative
control options available, such as use self as negative controls, Autofluorescence
controls, and no negative controls, please refer to the Unmixing section of the
manual . 

Figure T35.5  Step 1 -  Files for controls have been added to the Automatic
Unmixing Setup and are matched automatically to their respective parameters.

7. Click on Step 2 - Select Scatter Gate Parameters (Figure T35.6).

8. (Optional Step) Change parameters by clicking the down arrows to access
drop down lists. By default, FCS Express will attempt to auto match to FSC-A

872



FCS Express 7 Manual2754

© 2023 De Novo Software

and SSC-A.  In this example, we will use the defaults of FSC-A for X Parameter
for Scatter Gate and SSC-A for Y Parameter for Scatter Gate.

Figure T35.6  Step 2 - Select Scatter Gate Parameters for Automatic Unmixing
Setup.

9. Click on Step 3 - Select Spectral Parameter (Figure T35.7). 
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Figure T35.7  Step 3 - Select Spectral Parameter to Unmix.

10. Change the Parameter to unmix to UV\Violet\Blue\YellowGreen\Red-
A by clicking the down arrow to access the drop down list. In this example, we
will use the merged spectrum but any individual spectrums may be used when
unmixing your own data sets.  

Nine new pages will be created (Figure T35.8).
· Scatter Plot

· CD4 BUV737 control

· CD8 BV650 control

· CD3 BV711 control

· CD56 BV785 control

· CD16 PerCP-Cy5.5 control

· CD19 PE-Cy5.5 control

· CD45 APC-Cy7 control

· Unstained control

Figure T35.8  Tabs for new pages automatically created from Step 3.
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The Scatter Plot page contains two plots displaying the parameters selected in
Step 2 - Select Scatter Gate Parameters of the unmixing wizard, while the
rest of the pages (single-stained and unstained control pages) contain a density
plot, a histogram, and a spectrum plot for each parameter to unmix. On the
histograms, a marker has been created automatically for each positive
population. 

Note that all of the histogram markers are children of the Scatter Gate, which
means adjusting the Scatter Gate will cause the histogram markers to update in
real-time. To view the gating hierarchy for your Scatter Gate and histogram
markers, you may insert a Gate View .

On each histogram, the software will automatically detect and display the
detector with the brightest peak. This detector is referred to as the brightest
detector (red box, Figure T35.9). The wavelength or detector name (depending
on the instrument specific settings ) for the brightest detector will be reported
on the X-axis title in parentheses and can be changed at any time by clicking on
detector (Figure T35.9). Depending on your panel, you may need to change the
brightest detector to match the instrument or dye manufacturer's
recommendations. 

Figure T35.9  Changing the brightest detector for unmixing.

We will now adjust the Scatter Gate to refine the single-stained and unstained
populations. Since FCS Express utilizes universal gating, meaning the gates
belong to the parameters and not the files by default, updating the Scatter
Gate's position on any plot will result in that gate updating its position on all other
plots.

Note: The initial unmixing matrix is built from the default positions of gates and
markers and any changes made will result in the unmixing matrix automatically
updating.  
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11. Select the Scatter Plot page.

12. Click on the Scatter Gate (bottom left plot, see Figure T35.10). This plot
shows data for Unstained (Cells).fcs, as indicated in the plot title. Adjust the gate
position so that it resembles the plot on the right of Figure T35.11. Notice that
the subsequent single stained control pages have updated to use this gate
position.

Figure T35.10  Adjusting the Scatter Gate to capture lymphocyte population
stained by single stained controls.

Users may also decide to refine the marker positions in the following pages of
the layout containing single stained control histograms. In the next few steps, we
will be adjusting the marker positions for CD4 and CD8 to capture the brightest
staining populations.

13. Select the CD8 BV650 control page.

On this page, the center histogram displays the positive population marker for
CD8 BV650 (Figure T35.11, top left). Note the brightest detector for CD8 BV650
is V11-A, and was automatically displayed at the bottom of the histogram.
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Figure T35.11  Adjusting the histogram marker for CD8 BV650 to best capture the
positive staining population for spectral unmixing. (Left) Histogram and spectrum
plot before marker adjustment. (Right) Histogram and spectrum plot after marker

adjustment. Note the uniform and single spectrum.

On the spectrum plot beneath the histogram (Figure T35.11, bottom left), the
spectrum is being displayed for the positive population captured by the CD8
BV650 marker. This spectrum plot is gated on the marker to allow you to check
the quality of the automatically generated scatter gate and markers for each of
your controls, as well as to check any custom gating strategy used for the
unmixing. Spectrum that are unique and homogenous in their distribution across
each detector are considered ideal for unmixing (i.e. clear single spectrum line).

14. Click and drag the lower marker boundary for CD8 BV650 - stained to the
right so that it resembles the histogram at the top right of Figure T35.11. 

Note the spectrum plot at the bottom right of Figure T35.11 is now a single
unique nearly homogenous line.

15. Select the CD4 BUV737 control page.

16. Click and drag the lower marker boundary for CD4 BUV737 - stained marker
to the right so that it resembles the histogram on the top right of Figure T35.12.
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Figure T35.12  Adjusting the histogram marker for CD4 BUV737 to best capture the
positive staining population for spectral unmixing. (Left) Histogram and spectrum
plot before marker adjustment. (Right) Histogram and spectrum plot after marker

adjustment. Note the uniform and single spectrum.

17. Select the CD16 PerCP-Cy5.5 control page. 

CD16 is a marker present on the granulocytes population. As we have adjusted
the Scatter Gate to capture only the lymphocyte population in Step 13, the
CD16-positive granulocyte population is not represented in our Scatter Gate
and thus not available to use as the positive staining population for our CD16
PerCP-Cy5.5 control. 

For this example, we will be using the Data Specific Gate feature and show that
by using the Spectral Plots we can properly unmix.  In FCS Express, we can
address moving gates between control samples with the use of the Data Specific
Gate  feature.  Data Specific Gates allow you to adjust the gate size, position,
and vertex coordinates for any gate on a file specific basis. For this tutorial, we
will be adjusting the Scatter Gate for the CD16 PerCP-Cy5.5 control only, while
leaving the Scatter Gate position intact for all other files.

18. Click on the Scatter Gate in the density plot at the top of the page. This plot
shows data for CD16 PerCP-Cy5.5 (Cells).fcs, as indicated in the plot title (Figure
T35.13, top left density plot) 
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19. While pressing and holding the Shift button, move the Scatter Gate so that
it captures the granulocyte population (see Figure T35.13, top right density plot).
The keyboard shortcut creates a Data Specific Gate. Notice that the histogram
and spectral plots have updated on the page to use the new Scatter Gate
position, while on all other pages of the layout the Scatter Gate remains on the
lymphocyte population.

Figure T35.13  Using Data Specific Gates to adjust the Scatter Gate size, shape, and
position for the CD16 PerCP-Cy5.5 single stained control only.

Note: After you perform step 19, the spectral signature still has an AF
component (see Figure T35.14). If you move the histogram marker to the
brightest tail of the histogram, the AF is somewhat removed and the end result
will then look better.
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Figure T35.14 Changing the Scatter gate, Autofluorescence can be seen in the
spectral signature.

20. Click on Step 4 - View Errors and Warnings (Figure T35.15). 

If errors are found with the files or parameters you selected in the previous
steps, an error message will appear here to indicate what the problem was,
and the Scatter Plot and the single stained control layout pages will not be
created until the error is corrected.

If there were no errors, the Successfully built histograms for
AutoUnmixing message appears in the View Errors and Warnings dialog
window. 
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Figure T35.15  Step 4 - View Errors and Warnings will automatically display any
errors that prevented the creation of new pages for each control containing a
histrogram, spectrum plot, and density plot which allow the user to define the

positive and negative populations to be used for the unmixing.

Step 5 of the Automatic Unmixing Setup is optional and will be skipped for this
tutorial. Note that Step 5 allows users to manually define the stained and
unstained populations to use for unmixing . Step 5 also allows users to change
the detector assigned to a control / channel if needed . 

21. Click on Step 6 - Calculate matrices (Figure T35.16). The Unmixing Matrix
will be calculated automatically and displayed in the Unmixing Matrix tab of the
Compensation and Unmixing editor after selecting spectral parameters to
unmix in Step 3 - Select Spectral Parameter. A new Visualized Matrix  page
will also be automatically generated. 
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Note:  If the checkbox next to Recalculate matrix automatically every time
something changes is checked any changes made to gate or marker
placements will automatically modify the resultant unmixing matrix.  If this is
unchecked click the Calculate matrices button (red box - Figure T35.16) to
update the unmixing matrix after making changes.

Figure T35.16  Step 6 - Calculate matrices

By default, each single stained control selected in Step 1 - Select single-
stained controls will be included in the matrix, along with each detector. To
exclude the contribution of any detector or control from your Unmixing Matrix,
simply uncheck the box next to it.

Note: Your values may differ slightly from Figure T35.17 due to differences in
how the Scatter Gate was positioned in previous steps of this tutorial.
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Figure T35.17  The Unmixing Matrix created from the Automatic Unmixing Setup.

We will now apply our new unmixing to a multicolor control. 
22. Select the Data tab Organize Data Sets  command to open

the Data List window. To add a new data file, click the Add button  then
click Add Data File (Figure T35.18).
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Figure T35.18  Add Data File from the
Data List.

23. The Standard Open Data Dialog will appear. Navigate to the Multicolor.fcs
file from the Multicolor folder located within the Unmixing Example folder in the
Tutorial Sample Data Archive (Figure T35.19).
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Figure T35.19  Use the Select Data File window to load the multicolor control file
Multicolor.fcs

24. Click Open file. 

25. Select the blue double left arrow icon  at the bottom of the page and then
click on the tab Page 1. 

26. Select Multicolor.fcs on the Data List. Next, drag and drop (by click and
holding the left mouse button) Multicolor.fcs onto a blank space on the page.
The Select Plot Types ... window will appear (Figure T35.20). 
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Figure T35.20  Select Plot Types... window.

27. Check the box for Density and ensure no other plot types are selected.  

28.Click OK. A new density plot will appear on the page. 

29. Select the New Unmixing from the Compensation and Unmixing window,
then drag and drop (by click and holding the left mouse button) the New
Unmixing on top of the Multicolor.fcs plot on the layout (see red arrow, Figure
T35.21).
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Figure T35.21  Apply the New Unmixing table to the Density Plot by drag and drop
(red arrow). Once applied, the text "Unmixing transformed" will be appended to

the title.

The plot will update with new text appended to the end of the title ("Unmixing
transformed") and allow access to the properly unmixed parameters (see
bottom right plot of Figure T35.21, red arrow).

30. Select the Density plot.
31. Click on the Gating tab. 
32. Select Scatter Gate in the Create Gates  dropdown list to
apply the gate to the plot.
33. Click on the X-Axis title and scroll down to the bottom to view the unmixed
parameters available (Figure T35.22). 
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Figure T35.22  View the unmixed parameters by clicking on
the axes titles and scrolling to the bottom. The unmixed
parameters will be displayed as labeled in Step 1 of the

Automatic Unmixing Setup.

Unmixed parameters will be indicated in the parameter list by the label provided
in Step 1  (Label column) of the Automatic Unmixing Setup with the text " -
Ordinary Least Squares" appended to the end. 

In Figure T35.23, the unmixed parameters CD4 BUV737 - Ordinary Least
Squares and CD8 BV650 - Ordinary Least Squares as displayed on the plot. Note
that the new parameter suffix "Ordinary Least Squares" can be changed from the
Options tab , along with the suffix added to Unmixed data in the plot title (see
Figure T35.18).

2752
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Figure T35.23  Unmixed Parameters for
CD4 BUV737 and CD8 BV650 are displayed

on the Density Plot.

We can also export our new unmixing table to archive and save it for later use.
Note the recommended workflow for Automatic Unmixing is to perform the
Unmixing in a separate layout, then export that matrix and load it into a new
data analysis layout.

34. To export a new unmixing matrix definition, click the Save icon  button
(Figure T35.3) in the Compensation and Unmixing window. Unmixing definition
files will be saved with the *.unmixing file extension.

35. Type "UnmixingExample1" as the filename for the exported unmixing. 

36. Click Save.

To import and use the new Unmixing defintion following the recommended
workflow:

37. Open a new Blank layout (see Step 1 ).

38. Open the Compensation and Unmixing window from the Tools tab on the
Ribbon.

39. Click the Import a transformation from a file  button (Figure T35.3) in the
Compensation and Unmixing window. The Load a Compensation window will
appear.
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40. Click on the dropdown at the bottom right of the window and change to
Unmixing (*.unmixing) to view all Unmixing definition files in the folder (Figure
T35.24). Select the file UnmixingExample1.unmixing and click Open. 

Figure T35.24  Importing an unmixing definition into a layout using the
Compenation and Unmixing window.

The new unmixing will appear in the Created manually folder labeled as "New
Unmixing" (Figure T35.25, red arrow). In FCS Express, an unmixing definition can
be set as the Default for the layout. Setting an unmixing definition as the default
will result in that unmixing definition being applied automatically to any new data
file(s) or plot(s) added to the layout
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Figure T35.25  Imported Unmixing definition

41. Right-click on New Unmixing and select the option to Set As Default (Figure
T35.26). The unmixing will now be labeled as New Unmixing (default) and will be
applied to new data added to the layout as indicated above and specified in your
Layout Options . 911
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Figure T35.26  Setting an Unmixing Definition as the Default for the layout.

22.36 Fluidigm CyTOF Data Analysis

FCS Express provides data analysis solutions for high-parameter data files
generated by mass cytometry.

In this tutorial, we will use a pre-built template containing a Standard Operating
Procedure (SOP) to demonstrate the basic features of FCS Express for data
analysis using CyTOF mass cytometry data generated with the Fluidigm MaxPar
Human Peripheral Blood Basic I Phenotyping Panel Kit. All steps in the tutorial will
be contained within the SOP-based template and run in FCS Express. A download
for the template is available in step 2 of the next section.  

The SOP-based template includes a comprehensive pre-gated cleanup strategy
and step-by-step instructions for:
· Creating plots 

· Adding gates and creating gating hierarchies

· Adding summary statistics 

· Exporting a report to MS PowerPoint via batch processing. 
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To begin the exercise, we will first Run the SOP .

22.36.1 Fluidigm 7 color (7C) kit demonstration

In the course of this example, we will:

· Learn how to Run an SOP

· Create plots 

· Add gates and create gate hierarchies

· Add summary statistics 

· Export a report to MS PowerPoint via batch processing. 

To begin, we will open a saved layout that contains the SOP and pre-gated
cleanup strategy. 

1.  Select File Open (Figure 36.1). 

Figure 36.1  File Tab and Open Command

2.  Open the folder titled Fluidigm 7C SOP Demonstration located in the
Tutorial Sample Data archive .  

3.  Select the 7C human kit analysis_SOP-template.fey file from the Load
Layout dialog (Figure 36.2).

2774
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Figure 36.2  Load Layout Dialog

The layout will open to Page 1 as in Figure 36.3 below.
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Figure 36.3  7C Human Kit Analysis SOP Template - Page 1

4.  Click the Quality Standard Operating Procedures Run SOP
(Figure 36.4).

Figure 36.5  The Quality tab contains the Standard Operating Procedure (SOP)
operations

The SOP dialog will launch as in Figure 36.6 below.
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Figure 36.6  Run SOP window

Note that you may adjust the size and location of the Run SOP dialog. The Run
SOP window is also a dockable window  and can be docked to the sides of the
software user interface (Figures 36.7).

117
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Figure 36.7  The Run SOP window has been docked to the right-side of the FCS
Express User Interface

Read the Description for Step 1 presented in the Run SOP window. Follow the
instructions provided to complete Step 1.

Note: You will not be able to continue to the next step in the SOP until the Step
1 instructions have been completed. 

When the instructions for SOP Step 1 have been completed, the text at the
bottom of the Run SOP window will indicate "The condition for advancing to
the next step is satisfied" (Figure 36.8, green arrow).

Figure 36.8  The conditions for advancing to the next step have been satisfied

5.  Click the forward arrowhead (Figure 36.9, blue arrow) to continue to the
next step in the SOP.

The Cleanup page will now display data in all plots (Figure 36.10).

Note: Gate percentages in plot text boxes for all subsequent figures will vary,
depending on your specific gate adjustments.
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Figure 36.10  Successful completion of Step 1 in the Fluidigm 7C SOP
Demonstration

6.  Complete the remaining steps of the SOP. 

When the SOP has been completed, the Cleanup page will appear as in Figure
36.11.
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Figure 36.11 Successful completion of the Fluidigm 7C SOP Demonstration
(Cleanup page)

The 7C analysis page will appear as in Figure 36.12. 

Note: The 2D plots in Figure 36.12 have been formatted to move events off of
the X and Y axis lines. To format your plots in this manner, right-click on the
desired plot(s) and select Format. In the dropdown menu select Specific
Options . In the Resolution Options , set a custom value for the
Resolution Minimum and/or Maximum for each Axis. This will set the plot to
start and end at the desired value(s).

236 239
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Figure 36.12  Successful completion of the Fluidigm 7C SOP Demonstration (7C
analysis page)

The Batch Export to PowerPoint will appear as in Figure 36.13. Note there are
PowerPoint slides for both the Cleanup and 7C analysis pages for each file in the
Data List. 
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Figure 36.13  Successful completion of the Batch Export to PowerPoint
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